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Complete 31
Non-Responsive/Refused 0
In Progress 0

Count of Datasets by Status 31
Total Unique Providers Represented 23

Provider Name Platform Status

NDA 
Execution 

Date Notes

Alaska Communications Systems Holding, Inc.  (ACDSL Data Added to Statewide Inventory 6/2/2011

[SEP-1-11 Brian Dudek] Correction: New 
provider for October 2011 submission that 
previously refused to participate.

Alaska Communications Systems Holding, Inc.  (ACMobile Wireless Data Added to Statewide Inventory 6/2/2011

[AUG-15-11 Brian Dudek] Correction: New 
provider for October 2011 submission that 
previously refused to participate.

Alaska Power & Telephone, Inc. Fixed Wireless Data Added to Statewide Inventory 2/26/2010

[AUG-17-11 Brian Dudek] Correction: Provider 
indicated they do not meet broadband 
requirements in their five WiFi towns.  Were 
previously stated as download speed tier 3, but in 
actuality are speed tier 2.

Alaska Power & Telephone, Inc. DSL Data Added to Statewide Inventory 2/26/2010
[AUG-18-11 Brian Dudek]Change: Provider 
upgraded infrastructure to higher speeds.

AT&T Corp, Inc. Mobile Wireless Data Added to Statewide Inventory 12/16/2009
[AUG-30-11 Brian Dudek] Change: Provider 
expanded mobile territory in old and new regions.

Copper Valley Telephone Cooperative, Inc. DSL Data Added to Statewide Inventory 1/11/2010

[AUG-30-11 Brian Dudek] Change: Previously 
underserved area now meets speed 
requirements.  The provider's entire infrastructure 
can now reach the top advertised speeds.

Copper Valley Telephone Cooperative, Inc. Mobile Wireless Data Added to Statewide Inventory 1/11/2010

[AUG-30-11 Brian Dudek] Change: Provider 
added three additional transmission points and 
removed one.

Ketchikan Public Utilities Fiber Data Added to Statewide Inventory 1/8/2010

[AUG-31-11 Brian Dudek] Correction: Provider 
indicated they were incorrectly reporting their 
max download/upload business speed tier for the 
past submissions.  Corrected this speed tier 5 
download and 3 upload.  

Matanuska Telephone Association, Inc. DSL Data Added to Statewide Inventory 6/15/2010
[AUG-31-11 Brian Dudek] Change: Provider 
upgraded speed capabilities. 

SPITwSPOTS LLC Fixed Wireless Data Added to Statewide Inventory

[AUG-18-11 Brian Dudek] Change: Provider 
added additional transmission points and 
upgraded infrastructure to higher speeds.

Yukon Tech Inc Cable Data Added to Statewide Inventory 6/23/2010

[AUG-16-11 Brian Dudek] Change: Provider 
upgraded some infrastructure to max download 
speed tier 3.  Previously all cable was 
underserved.

Alaska Communications Systems Holding, Inc.  (ACBackhaul
Backhaul Provider Only Processing 
Complete 6/2/2011

ATCONTACT COMMUNICATIONS Backhaul
Backhaul Provider Only Processing 
Complete

GCI Internet Backhaul
Backhaul Provider Only Processing 
Complete 2/25/2010

Ace Tekk Wireless Internet Fixed Wireless No Update to Provide
Adak Eagle Enterprises, LLC DSL No Update to Provide 12/22/2009

AlasConnect, Inc. Fixed Wireless No Update to Provide

[SEP-7-11 Brian Dudek]  Although generalized, 
according to provider representative, service 
area is derived from a real-world wireless 
propagation and real work combined.

American Broadband Communications DSL No Update to Provide 6/7/2010
Borealis Broadband Inc. Fixed Wireless No Update to Provide 2/1/2010
Borealis Broadband Inc. Backhaul No Update to Provide 2/1/2010

Clearwire Corporation Fixed Wireless No Update to Provide 3/3/2010

[SEP-7-11 Brian Dudek] Correction: Provider 
service area is now a real-world propagation 
unlike prior submissions.

Cordova Telephone Cooperative, Inc. DSL No Update to Provide
Craig Cable TV, Inc. Cable No Update to Provide 7/27/2010
GCI Internet Cable No Update to Provide 2/25/2010

GCI Internet Mobile Wireless No Update to Provide 2/25/2010

[SEP-6-11 Brian Dudek] Connected Nation was 
unable to acquire real-world wireless 
propagations or the needed data to develop them 
for this submission.

Hughes Network Systems, LLC Satellite No Update to Provide 2/5/2010

[SEP-16-11 Brian Dudek] Correction: Satellite 
data is being submitted and was not included in 
the April 2011 submission. While coverage is 
currently the entire state boundary, work 
continues on having more granular data 
available.

Broadband Provider Log



Ketchikan Public Utilities DSL No Update to Provide 1/8/2010
Kodiak Kenai Cable Company Backhaul No Update to Provide 2/7/2011
MCI Communications Services, Inc. Backhaul No Update to Provide 12/14/2009
OTZ Telephone Cooperative, Inc. DSL No Update to Provide
Yukon Tech, Inc. Fixed Wireless No Update to Provide 6/23/2010
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Overview 
 

The following documentation provides an overview of how the fourth required data set was collected 

and processed for the State Broadband Initiative (SBI) in the states of Alabama, Idaho, Wisconsin, and 

Wyoming.   

Although we could separate this draft into state-specific deliverables, the majority of methodology 

remains intentionally consistent among the states.  As one important validation test is comparability 

across states, we find value in this cross-state approach.  This cross-state approach also helps the 

LinkAMERICA team focus on comparable outcomes across the four states, where appropriate.  Our 

intent is not to make the states look and be the same, rather it is to leverage economies of scope and 

scale among the business processes. 

As expected, this document rests heavily on the prior drafts, but has also been updated and expanded. 

Significant changes include additions covering: 

1. Trends in provider inputs  

2. Expansion in retrieval of WISP coverage  

3. Requested changes based upon NTIA guidance 

a. Modification of Satellite providers as a Type 1 Broadband provider; 

b. Discontinuation of estimating Community Anchor Institution coverage and speed; 

c. Review of submitted speed with respect to NTIA supplied frequency table 

4. Transition planning with respect to capacity building within the State for Broadband map 

development 

5. Development and posting of a provider Type classification rubric 

Treatment of the following subjects has been expanded: 

1. Community anchor institutions and survey methodology 

2. Verification and validation 

3. Data production methods 

4. Conversion to Census 2010 

As anticipated, the SBI program continues to mature and evolve.  Technical leadership and strong 

program office guidance has been appreciated.  We continue to focus resources on establishing stable 

business processes to track submissions, verify received and processed data, test for temporal stability 

and provide reporting deliverables consistent with NTIA expectations. 

In our view,  the mapping deliverable reflects (1) a good faith effort, which results in a reasoned 

response to the NOFA, Technical Appendix A,  as well as supplementary program office guidance and 

modifications offered in phone calls, emails, and webinars, (2) a stable foundation for improvement and 

prioritization of both NTIA and state needs and interests , (3) a valid data processing model to support 
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online mapping, consumer feedback, provider verification and reporting, and finally, (4) a valid use of 

the evolving data transfer model and its intrinsic validation methods.  More importantly, the resulting 

data and online coverage maps that follow from this work are providing good input and context for the 

Broadband planning teams working across the states we have the pleasure to serve. 

We close this methodology document with two Appendices.   Appendix One describes Data Collection 

Challenges.  This section describes some of the open issues, challenges and questions we are exploring.  

Our hope is to receive clarification and counsel from NTIA in how best to confront some of these issues, 

which are likely common across states.  Appendix Two describes the confidentiality framework 

explained by NTIA.   

Purpose of This Manual 
This technical document was developed to provide transparency in our data production process.   

Our goal is to illustrate a thoughtful process designed to meet the intent of the submission.  Our hope is 

that we have developed a process that is reasonable, with respect to the data it deals with, as well as 

flexible enough to change with evolving NTIA requirements and lessons learned from the Broadband 

mapping community.  

Data Sources 

Developing the Provider List 

Provider lists for all states were developed at project inception from the following sources: 

 State lists of regulated telecommunications, cable and wireless service providers 

 State and national industry organizations (i.e. cable associations, wireless service provider 

organizations, telecommunications associations) 

 FCC Form 477 respondents 

 Independent web searches 

 Prior comparable mapping/research efforts 

 Interviews with key state staff members and important community influencers 

After the April 1, 2011 “Round 3” submission, we continued our research and added new providers to 

the program as discovered.  As one would expect in a dynamic marketplace, provider identification is an 

ongoing and important component of our work.  Mergers and acquisitions, the use of multiple regional 

DBAs, the lack of any universal identity management attribute, and the generally complex parent-

subsidiary structure of many telecommunications companies, make provider identification and tracking 

very challenging.   

In early July 2011, we once again initiated an email and telephone outreach campaign to contact all 

known providers. This is an extremely time consuming process, but it is necessary to ensure that the list 

of contact persons remains current, and that providers are aware of data request changes and deadlines 
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associated with each round.  Where necessary, we execute new NDAs with providers.  In “Round 4”, this 

effort continued on a daily basis until we reached our final data submission deadline on August 19, 

2011.   After August 19, we continued to work with providers who were not able to meet the deadline.  

In most cases were able to “crash” our process to accommodate this extra data, but late submissions 

continue to create inefficiencies and add costs to the overall program.  In Round 4 providers that 

responded too late to be included in the final dataset will be included in our Round 5 submission. Once 

again, as contact is made in each round, we verbally qualify each provider by asking a series of questions 

regarding the type of service and speeds offered.  If the provider does not meet the minimum 

specifications for a Broadband provider (as defined in the NOFA) we make a note of their status and 

remove them from the data submitted to NTIA.1  We continue to reach out to them in future rounds in 

the event that their service is upgraded or expanded. 

Provider Outreach 

To meet the program’s aggressive deadlines and participation goals, LinkAMERICA believes it is critical to 

maintain rapport with providers.  To do this, we continued to reach out to providers with regular project 

communications, including a program newsletter and links to the various state mapping websites.  As 

described above, individual e-mails and/or telephone calls were made to all providers explaining the 

status of the program and requesting their continued support in Round Four. We’ve also had the 

opportunity to support providers in their BTOP / BIP applications in certain cases. Through these 

collective outreach initiatives, and our engagement with various industry associations, we continue to 

enjoy a healthy and appropriate relationship with Broadband service providers. 

NDA 

To provide protection for all parties involved, LinkAMERICA continues to honor the terms of our NDA.  If 

providers did not execute the NDA in previous rounds they were offered the opportunity to do so in this 

collection round.   New providers were of course also supplied with a copy of the NDA. 

To facilitate the execution of NDA’s, LinkAMERICA continues to use the DocuSign online document 

management solution.  This system allows providers to review and digitally sign the NDA in a legally 

binding manner, and has been instrumental in achieving rapid approval and execution of NDAs with the 

majority of providers.  In some cases, NDA’s were individually negotiated to address specific provider 

concerns.  In all cases, minimum standards established by the NOFA are honored.  In other cases, 

providers chose to submit data without executing an NDA. 

Provider Survey 

Since three prior rounds of data collection had been completed, the LinkAMERICA team had a solid base 

of coverage and speed information with which to begin Round 4.  This allowed us to provide two 

response options to providers.  The first was for them to review check maps of their coverage and speed 

data – submitting only corrections and additions to the existing dataset.  (For provider convenience the 

                                                           
1
 As with other Grantees, we struggle with appropriate and consistent classification for service providers who 

opportunistically provision Broadband services.  In this submission we continue to bring them into the analysis as a 
provider type “other”.  As the inclusion of this category isn’t our primary goal, we are working to process data as 
we can.  We are similarly categorizing and retaining reseller information.  Our datapackage.xls illustrates the 
categorization of non Broadband providers within our provider tracking and verification systems.  
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check maps were created in both PDF and Google Earth (.KMZ) formats.) The second was to allow 

submittal of completely new datasets, either in tabular form or in multiple other digital formats.  For 

those without sophisticated CAD or GIS systems, we continued to allow the submittal of 

printed/scanned maps and other written materials.    

Survey Methods 

Once again, we used a secure digital survey process (via our provider portal websites) to collect and 

display information for providers.   The Round 4 survey process was designed to accommodate both 

new and returning providers, and the different types of information they would be submitting.  The 

following is a summary of the process encountered by each group: 

New providers:  New providers were routed directly to our standard survey where they were provided 

with templates for uploading data in tabular NTIA-compliant formats.   As in previous rounds,  if 

providers could not supply information in the requested format, alternatives were offered.  These 

alternatives included uploading service-area boundary maps, exchange area maps, CAD drawings or 

customer address lists.  From that information, the LinkAMERICA team developed a geographic 

representation of coverage and was able to build coverage features for each provider.    

Returning providers:  For Round 4 we continued to work with participating providers to improve their 

datasets.  The change in Census Data vintage was explained to providers and links to appropriate files 

were provided to assist with the transition to the new vintage data.   

Check maps continue to be a useful tool to show providers how their area would be displayed on the 

resulting interactive state map and to get constructive feedback regarding corrections and changes that 

need to be made to their coverage and speed data.   Generating these customized documents in each 

round is an extremely time consuming verification process, but it allows us to close many of the gaps 

that might have otherwise persisted. 

Follow Up 

After the release of the Round 4 survey in early July 2011, LinkAMERICA launched an extensive effort to 

encourage responses.  Every known provider was contacted at least twice during the months of July and 

August.  The initial data submission deadline was set for August 19, but, as previously noted, we 

continued to accept “straggler” submissions into September.  

No Response Policy 

As mentioned above, every effort was made to contact each provider who appeared on our initial list.  

However, if no current information could be found on the company (i.e. no website, no valid phone 

number, no contact person identified) they were removed from the list of “known providers”.  We 

believe the vast majority of those we were unable to reach were providers who have simply ceased to 

exist2.  

                                                           
2
The list of known providers and important submission statistics are contained in the datapackage.xls file. 
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Summary 

In summary, an intensive 45-60 day provider outreach and data collection process is initiated at the 

beginning of each round.  In Round 4, given the data vintage of June 30, 2011, we began this process in 

July and the last submissions were accepted in September, 2011.    

While we continue to successfully engage the majority of providers in each round, the amount of 

manpower required to solicit complete and timely responses should not be underestimated.  This 

process is one of the most costly and complex within the entire SBI program.  

Third Party Data Used 
Beyond the data obtained from providers, we acquired the following commercial data products: 

 American Roamer, Coverage Right Advanced Services. This data served two purposes.  The first 

was to verify the provider list and help find Broadband service providers not on other lists.  The 

second was to verify the reasonableness of the Broadband service provider’s submission. 

 MapInfo ExchangeInfo, Professional.  This data was used in the verification of telephone 

Broadband provider data.  Where a public domain exchange boundary wasn’t available, the 

MapInfo boundary was used for coverage containment tests.  

 Media Prints Cable boundaries.  This data was used in the verification of Cable/HFC Broadband 

provider data.  It was used to research valid providers and discover if that provider was offering 

Internet service.  In very rough terms the contained boundaries were used to test the location of 

some provider data.  

 FCC 477 restricted use data were analyzed to find valid providers within a given area. 

We have included third party data sources, which touch on each of the three major technologies 

analyzed within the SBI program.  Each of these data sources tie back to a public domain data source, 

which provides a cross-verification mechanism for the commercial data product. 

Although there are a large number of third party licensed data sources available, we remain 

conservative in our acquisition plans.  From our limited analysis we are concerned about the ability to 

cross-verify additional third party licensed sources against public domain data.  Further, we are unsure 

of how we may be able to integrate another data provider’s view of valid Broadband providers within 

the definitions used by the NOFA (eg. Are they using an FRN/DBA identity view or a marketing view?  

Can the provider supply in a 7-10 day window?  Are they facilities based or not?).  This leads us back to a 

statement we made in a ‘lessons learned’ Webinar (April 2010) about exploring a consortia to lower the 

cost of data acquisition and allow multiple entities to peer review the quality and methodologies behind 

licensed data products.3  

Beyond these commercial data sources, we used a number of public domain sources.  These included: 

a. Geographic Data Files  

                                                           
3
 We also suggested forming a technical standards committee and a consistent system for confidence reporting. 



SBI Mapping Methodology Page 10 
 

i. US Census TIGER data4 

b. Sources that helped isolate providers, identity management or provider service areas 

i. NECA Tariff 4 

ii. State produced exchange boundaries  

iii. Carrier produced wirecenter boundaries 

iv. FCC Coals reports (321/325) 

v. FCC FRN API lookup tool 

vi. FCC/FAA Antenna Registration System 

vii. FCC FRN Lookup Tool (plain text search) 

viii. USAC High Cost FCC Filing Appendices 

c. Sources that helped isolate anchor institutions 

i. USAC Grant lookup tool 

ii. USAC High-Cost FCC Filing Appendices 

iii. HRSA data warehouse 

iv. NCES data lookup 

v. State managed lists of schools (K-12), post-secondary institutions and libraries 

vi. List of museums,  conventions, and visitors bureaus from www.onlineatlas.us 

Finally, challenges exist when dealing with the inevitable conflicts between provider-submitted data and 

third party sources (public or commercial).  There is no guarantee third party sources are more accurate 

or timely than the providers’ own reports.   Indeed, some third party sources are based upon different 

standards than those specified in the NOFA, perhaps making them less reliable than information 

collected directly from providers.  At the very minimum, provider data has a lineage and temporal status 

that we can identify.  A concern we have with increasing use of third party data is that we have no way 

to verify its quality or development methodology.  In other words, we may hit a wall in which we can’t 

determine how the commercial source derived its coverage conclusion.  To us this means that third 

party data sources are beneficial, but represent a supplementary view, not an authoritative one, of the 

NOFA defined Broadband market. 

In short, we have chosen to use provider data as the baseline.  We will challenge provider reports when 

third party data shows major anomalies, when submitted data conflict with prior submissions or when a 

consistent volume of consumer feedback points to a potential error.   

As the program evolves it is also our intention to provide tools that allow end users to evaluate the 

accuracy of the data in their own way.  A confidence score or the presentation of multiple (and 

potentially competing) reports for the same location may be made available. This notion is discussed 

further in the “Validation” section.   

                                                           
4
 Census data were derived from < http://www.census.gov/cgi-bin/geo/shapefiles2010/main>, Census 2010 files.  

Roads were derived from the county faces and edges file downloaded at the same location and tiled for a full state. 
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Confidentiality and the Use of Licensed Materials 
As a mapping vendor, we are reliant upon the cooperation of Broadband service providers.  In large 

part, what underlies this cooperation is trust that we will not violate the proprietary and confidential 

nature of the data provided to us.   

We are thankful for the confidentiality clarification that NTIA shared with us (included as Appendix Two).  

We intend to use this as a guiding document to help us communicate with providers about what 

information NTIA considers to be confidential.  Our suggestion is that NTIA publish this, or something 

comparable, to ensure a consistent interpretation of the NOFA and how it guides NDAs. 

As some providers are non-responsive to requests for information, or lack resources necessary to put 

data into NTIA compliant formats, we have fallen back to the use of commercial data sources in several 

places.   

For instance, some mobile wireless providers were unable to submit coverage information to us.  In 

these circumstances we have generalized the American Roamer coverage.  For incumbent telephone 

providers we have used commercial wirecenter boundary products to filter Census Blocks that are 

clearly out of their exchange areas.   

Public Engagement:   Crowd Sourcing, Surveys and Social Media 
Crowd sourcing (i.e., an intentional and carefully designed effort to tap into the collective intelligence of 

the public at large to expand our knowledge base) continues to be an important element of our data 

collection and validation process. In addition to the various opportunities the public has to provide input 

via the online service coverage maps and the related ‘Broadband story’ process, our crowd sourcing 

efforts are grounded in a time tested telephone survey approach focused on the consumer market. In 

addition, we continue to advance our process to include certain initiatives centered in two social media 

outlets – Facebook and Twitter. These initiatives are discussed below. 

Consumer Surveys 
Working under contract for the state of Alabama in 2009, our initial consumer survey was performed 

before the NTIA SBI grant was in place. Subsequent consumer surveys funded by the SBI grant were 

hosted in 2010 for the states of Idaho, Wisconsin and Wyoming and then again in 2011 for Alabama (as 

noted below). These surveys will be repeated after two years to establish and evaluate trends. To this 

end, in August/September 2011 we are wrapping up a second-round survey in Alabama designed to 

expand our understanding of important adoption issues and to establish important local trends from the 

initial 2009 survey. Survey results from this effort are currently under evaluation. These primarily 

telephone based surveys include two distinct and carefully scripted tracks: one for Internet users and 

one for non-users. The telephone survey approach allows us to reach the non-Internet user group as 

well as the current Internet user. A secondary online approach is also used to augment input from 

current Internet users. In the most recent Alabama survey we added a third tier to our approach as we 

equipped local field survey teams with an iPad-based survey tool and targeted their time to reaching the 

younger market. For non-users, the surveys help determine why they don’t have or don’t use 
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Broadband. For current Broadband users, the survey helps determine the nature of their Broadband 

access and how they use that connectivity in their daily lives. In addition to our state-specific surveys a 

nation-wide survey was also hosted to provide a broader view of consumer views for comparison 

purposes. State-specific surveys are, where possible, framed to match the state’s regional Broadband 

planning structure (e.g., the updated consumer survey in Alabama was designed to produce results 

relevant to the state’s twelve Broadband planning regions). 

The resulting data is helpful on a number of fronts in the SBI’s mission to advance the access and 

adoption to Broadband. Survey data provides an important, albeit broad, gauge for assessing coverage 

information obtained by providers. For example, areas with widely available coverage (according to 

provider information), but lower consumer subscription levels (according to survey results), or perhaps 

where survey results suggest Broadband is not available, can be examined in more detail. Survey results 

are also very important to the Broadband planning (and capacity building) components of the SBI 

program in that they help inform and formulate Broadband advancement priorities. Survey results also 

help inform Broadband policy discussions on both the local and state levels. Finally, survey results 

provide important information to the service provider community regarding market demand and 

specific Internet use in specific communities (i.e., regions).  

Our ongoing consumer survey process adheres to a consistent process. For example, consistent with 

prior practice the 2011 Alabama survey was launched in June 2011 with a test number of survey calls to 

confirm (and adjust as needed) the structure of the survey and the underlying survey process. Our 

surveys typically run for three to four months.  All telephone surveys are completely random beginning 

with the acquisition of a list of state-specific, randomly selected landline telephone numbers.  Mobile 

phones are not typically included in the surveys. Upon evaluation of the survey statistics, auxiliary 

surveys are executed to ensure appropriate representation is achieved on both demographic and 

geographic fronts. For example and as noted above, the recent Alabama survey was augmented with a 

field effort to ensure the younger demographic  (i.e., age 18 – 25) was adequately represented. This 

secondary step is required because of the continued migration (by younger markets) to non-landline 

based communications. This younger market is also surveyed by reaching out through social media 

outlets to encourage their participation in an online survey process. 

Survey statistics from the Alabama update survey are currently being developed and evaluated. Survey 

statistics from our initial surveys in Idaho, Wisconsin and Wyoming were summarized in our last filing.  

Survey volumes are designed to achieve statistical validity.  

As noted above, our telephone survey process is augmented by providing online access to the survey. 

Participation in the online survey is promoted on all of our state-specific public web sites and selected 

social media. 

As a final relevant point with respect to the consumer survey process the length of the survey is 

noteworthy. By survey standards, these tend to be long surveys. The surveys typically average just over 

fifteen minutes.  While this clearly contributes to the number of survey call attempts that were required 

to reach the level of statistical validity, it is not insurmountable.  
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Social Media 
The phenomenon of social media is widely documented and yet still emerging as an effective access 

point for public engagement. We continue to explore appropriate ways to use a variety of social media 

venues in our SBI efforts. All of our efforts are informed by and consistent with relevant state statues 

and guidelines. Different states have different perspectives on if and how the state will participate in the 

use of social media. Some state requirements are well defined and some are still being formed. Where 

appropriate, we use LinkedIn, Facebook and Twitter to support our work. A central focus is on 

promoting awareness. As noted above, we are able to promote additional input on the consumer 

surveys through a social media outreach program aimed at our younger market segments.  

In addition, we continue to evaluate how Facebook and Twitter can be used to drive public input on two 

important crowd sourced issues: online speed tests and input on map accuracy. Based on data obtained 

through our web site traffic monitoring process and readily available social media tracking processes, 

our most recent results are promising.   

Capacity Building and Transitioning to State Partners 
A foundational goal of LinkAMERICA has always been to transfer knowledge and capacity to our State 

partners.  As we move into program year 3, distinct tasks are migrating to the responsibility of our State 

partners.   

Within each State, transition planning and responsibility for specific activities is on a slightly different 

timeline.  Much of this is driven by resource availability and partner identification within the State.  For 

example in round 3, the State of Alabama used interns to validate Community Anchor Institution (CAI)  

data.  In this submission Alabama took on greater responsibility for the CAI submission.  To support this 

LinkAMERICA developed a detailed transition document describing the current CAI efforts. 

Other States are looking more towards program year 3 and the in-State hire of a Broadband Coordinator 

as the initiation point to support their transition efforts. 

Data Production Process 
To support our objective of transitioning the data development process to our State partners, we 

continue to model and document our data production process.   We find this to be a very beneficial step 

for two purposes.  

First, it helps us understand why (and if) a task is being done, and if it is being done efficiently.  Much of 

this program started so quickly that it was difficult to plan logical integration and hand off points among 

the various workgroups.  Further, we are currently in the process of consolidating much of the process 

data (check-ins, check-outs, metadata) and we can use this process model to efficiently plan a cohesive 

information architecture. 

Second, our process documentation and modeling helps explain why resources are being consumed in a 

particular way.  This helps our State partners plan for in-sourcing specific tasks as their time and 
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budgetary constraints allow.   It also helps our LinkAMERICA team better plan and cross-train members 

to deal with the work surge that occurs 30-45 days prior to submission. 

Finally, documenting and modeling our process helps us to take advantage of increasing specialization 

and proficiency with certain types of data and management responsibilities.   In submission 3, we had 

identified data “czars” responsible for check-in and check-out of data.  That data czar helped to bridge 

the gap among receipt functions, provider feedback, production and DBA.  

 

Figure 1—SBI Data Development Business Process Diagram 

 

Data Production Methods 
As raw data were received from the provider community, attention turned to normalizing the disparate 

submission formats5.  The team considered each submission with respect to the following criteria.  

These criteria are important because they perform the basis for our verification and quality assurance 

                                                           
5
 In line with NTIA Best Practices we continue to request and receive a large number of data input formats.  This 

ranges from tabular Block lists to hand drawn maps. 
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process.  In other words, we have to appropriately scale our data verification efforts to match the scale 

or ambiguity of the following: 

 Locational certainty 

 Speed certainty 

 Temporal certainty 

 provider and network ownership certainty 

The team’s goal was NOT to quantify a particular degree of precision with respect to any of these 

criteria.  Rather, we are working to attribute the above “certainty attributes” to each submission, and 

will continue to implement quality assurance and verification mechanisms that are resource-appropriate 

for each. 

Deriving Broadband Coverage Information 
Broadband Coverage6 was normalized into four formats:  

1. Coverage in Census Blocks (2010) of 2.00 or less square miles 

2. Covered Street Segments (2010) in Census Blocks greater than 2 square miles7 

3. Address Level Coverage (point data) 

4. Wireless Service Areas (SHP file format) 

With each submission, the team went through a series of steps to normalize and categorize the data. 

Since data arrived in many different formats, and at many levels of granularity, the following 

normalization procedures were used:  

1. Determining the nature of service being provisioned (who is providing service and what 

technologies are in use) 

2. Planning an attack strategy for the submission –understanding the data and assigning team 

members to various tasks 

3. Geo-referencing the data; QA the geo-referenced data  

4. Geoprocessing the geo-referenced response 

5. Segregating the submission into the correct NOFA-compliant submission formats. 

6. Apply appropriate source metadata8 

                                                           
6 Speed, Anchor institutions and Middle Mile facilities are discussed in later sections. 

7
 To help clarify issues relating to Census block area and vintages in use, our team published a technical paper to 

the Grantee workspace.  Because we were unsure if this standard should be implemented uniformly, this 
document was never distributed to the provider community. 
 
8
 When our team logs a submission into the staging database we record at least two attributes.  One records the 

method used to derive the coverage, the other records the method by which speed was attributed to that object.  
Other attributes carried to NTIA carry source meta values as well. 

https://sbdd-granteeworkspace.pbworks.com/w/file/33293657/Technical%20Reference%20Document%20Final.doc
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Figure 2-Broadband Coverage Process 

Impact of Program Change 
There were several important program changes that impacted how Broadband coverage was developed 

and submitted to NTIA in Round 4. 

Census Conversion 

The first and most obvious change in submission 4 was the conversion to a Census 2010 coverage 

baseline.  This impacted all wireline providers, the data submitted, the appearance of the mapped 

information and the baseline coverage metric comparisons against prior submissions.   

Release of the June 30 Grantee guidance document, allowed LinkAMERICA to communicate this change 

with providers.  LinkAMERICA provided by FTP access appropriately formatted and sized9 TIGER 2010 

Census blocks and Tiger Road Segments.  Given the relatively late release date, we received a mix of 

responses from Broadband providers.  Some easily produced Census 2010 information.  Others 

requested that we do the translation from their supplied blocks and segments.  Others requested that 

we translate their engineering data into appropriate formats.  A small number of providers committed 

to producing Census 2010 data but struggled internally with the conversion in this rapid time frame. 

Census 2010 has significantly more Blocks than Census 2000.  For the most part there are far more small 

Census 2010 blocks (less than 2.0 sq mi) than Census 2000.  As our team worked through the QA 

process, this presented a significant challenge in comparing our converted results to prior submissions.  

We use a block count metric as our first test of consistency across submissions.  Since the block count 

                                                           
9
 In Submission 3 we released a technical note describing how we measure Census block area. Although there 

remains no consensus on this, we used the same process as outlined in the paper. 
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increased it was hard to distinguish coverage area changes from coverage chances resulting only from a 

change in Census shapes.   

The converse side of this challenge was even more precarious to work through.  Because many road 

segments dropped out due to the covered area now being in a small block area it was difficult to 

determine how effective our covered segment process was given the fact that many segments naturally 

dropped out due to changes in Census shapes. 

The tendency for large blocks becoming small was not universal.  We note in some of our very rural 

areas of Wyoming and Idaho, small block covered areas become large.  This created a contrary situation 

where small blocks become road segment areas. The image below shows a coverage area change 

between submission 3 and 4.  The covered number of blocks is comparable but the appearance of the 

coverage is different as a manifestation of the Census change. 

 

Figure 3--Coverage Change across submissions 

This somewhat indeterminate process required our QA analysts to examine a number of submissions in 

detail.  The conclusion was that although the appearance of coverage was significantly different, the 

underlying engineering data was the same (or very similar) but how the coverage was manifested was a 

product of the Census conversion. 
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Census Conversion Practices 

Although we had hoped there would be a single process we could follow for all Census conversions our 

experience has been that it is necessary to be flexible and base the Census conversion process upon the 

data received.   

On a subjective level, we felt the most comfortable converting into Census 2010 where we had facility or 

demand data to guide the block and segment selection process.  In these circumstances we used 

geoprocessing methods like intersections or network analysis Analyst to make an objective 

determination.  The geoprocessing methods mirrored those discussed in the next section.   This was 

probably the majority of our submitted data. 

In circumstances where we were provided Tiger 2010 blocks or segments, we used those as given and 

performed our standard validation process.   Some providers used the TIGER blocks and segments which 

we supplied them and made their own selections. 

Finally, in circumstances where we had either a Census 2000 block list or a geographic file containing 

Census 2000 geographies and were told there was no coverage change for this submission, we used the 

Census crosswalk tables10 to derive a list of candidate blocks.   The output of a conversion process is 

shown below. 

 

                                                           
10

 See http://www.census.gov/geo/www/2010census/rel_blk.html 

http://www.census.gov/geo/www/2010census/rel_blk.html
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Figure 4—Block Conversion Process, Census 2000 black outline, no fill.  Green is 2010 large blocks, so any shading without an 
outline is 2010 block area not covered in 2000 

For the most part it is difficult to discern the impact of a conversion into Census 2010.  We don’t see vast 

changes in areas covered.  Nonetheless because the block shapes do change the overall coverage area 

will look different.  

As the 2010 data gets pushed into public deliverables, our sense is we will receive questions about the 

appearance of the new data.  

Speed Examination 

Given recent concerns about the depiction of speed and what that mapped speed represents, 

LinkAMERICA invested considerable time requesting detailed information on speed which appeared to 

be beyond normal speeds for a given Technology of Transmission given the NTIA supplied frequency 

tables. 

Based upon these conversations we learned 

A) For a large incumbent telephone provider; the speeds beyond the normal DSL range 

represent significantly shortened copper loops. 

B) For a large national cable provider the intermixing of Docsis 3.0 and non 3.0 systems in a 

market area is typical and sometimes reflects a circumstance where segments of plant cannot 
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be upgraded to Docsis 3.0.  This variance can be at a level below the Census block. In these cases 

the maximum advertised speeds remain to represent the market area but the plant variance is 

typical.  This same provider expressed concern with moving reported advertised speeds below 

the market  level. 

C) We have a minority of providers who submit a theoretical speed that is unmatched by their 

web advertising.  In these cases we request clarification from the provider on the inconsistency.  

Our experience has been that providers will modify the speed to be consistent with their web 

coverage. 

Provider Definitions 

Within our provider verification process we work to derive a state level provider match against third 

party data sources.  As discussed in the early pages of this manual, there is no guarantee that a third 

party data source is any more accurate than submitted data, nor does it necessarily reflect the provider 

ecosystem specified in the NOFA, Technical Appendix A.  We devote significant resources to matching 

our submitted data against three, third party data sources.  In many cases this becomes a judgment call 

trying to match provider names across systems.  It is a difficult and somewhat arbitrary process.  

Nonetheless we do believe it has value because it forces a re-examination of who we believe is an 

appropriate provider within a non-NOFA context11. 

The use of a provider match system, as well as the webinar comments (3/17/11) directing grantees to 

estimate, wherever possible, non-participating providers have made us back away from one of our 

fundamental assumptions in data collection.  As discussed in the prior draft of this manual, we had 

developed a certain “hold-out” class of data when a provider’s data wasn’t of sufficient quality to verify, 

or we were unable to put it into the data model (eg. address points submitted for a wireless).  In this 

submission, much of this hold-out data has been included12.  In some cases this means we are using 

simple polygons to capture a wireless ISPs serving area.  Other times, if we are confident in the 

coverage, but can get little clarification on the submitted speeds or frequencies, we release the 

coverage and note in our internal metadata the source issues with the other attributes.   

Finally, we have used the new provider type classification of ‘other’ to bring some aspect of the 

provider’s data into our submission.  There still seems to be confusion on how to handle provider types 

where a provider offers multiple paths to provision Broadband for typically business customers.  Rather 

than waiting for certainty on the answer, we bring the provider in and list them as provider Type 

“other”.  Our sense is provider Type “other” will continue to expand in subsequent submissions.   

                                                           
11

 We have requested from NTIA information on how provider matching is done within their QA process; beyond 
the relatively short whitepaper posted with the national map <http://www.broadbandmap.gov/blog/wp-
content/uploads/2011/02/DataComparison_Methodology2.pdf>, we have not received any more detailed 
information on how providers are cross verified between submitted and third party sources at the national level.  
Our understanding is licensing concerns are holding the release of this information. 
12

 We continue to process older submission data looking for information and methods by which we can estimate 
coverage information.  This will be an ongoing process. 

http://www.broadbandmap.gov/blog/wp-content/uploads/2011/02/DataComparison_Methodology2.pdf
http://www.broadbandmap.gov/blog/wp-content/uploads/2011/02/DataComparison_Methodology2.pdf
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Clearly one challenge is the data, but an equally significant challenge is appropriate messaging around 

this “other” provider type category.  We do not want to leave consumers with the impression that they 

can get a high capacity fiber or microwave link despite the fact that the hospital next to them in the 

same Census block can get this service. 

After the Grantee conference, LinkAMERICA submitted a paper describing our provider classification 

system13.  It is our feeling that understanding the type of provider is essential to appropriate verification 

methods.   

Coverage Geoprocessing Methods 
The next section discusses how data were georeferenced and geoprocessed given a particular 

submission format.  We have yet to find a particular method that works across all submissions.  Rather 

we tend to tailor our geoprocessing to meet the specifics of the service provider and data submitted. 

In most cases, in Round 4 we were still not provided with street segment level information for Blocks 

greater than two square miles (large Blocks).  This necessitated subsidiary geoprocessing.  As stated 

before, our first goal was to derive block level coverage.  Then, for Blocks greater than 2.00 square 

miles, we moved to a segment gathering processing.  The segment process will be described in the last 

section.14  

Block Level Coverage Derivation Using Service Point Data 

A number of providers submitted point level customer data.   

In some cases the submissions themselves were not internally consistent.  For example, in the image 

below, unprojected points are shown, while the Census block polygon to which the points are supposed 

to “belong” is highlighted.  In this case, one of the following scenarios has occurred:  block attribution is 

wrong, the points are not in the location to which they are attributed, or different block shapes were 

used than what is assumed. 

 

                                                           
13

 https://sbdd-granteeworkspace.pbworks.com/w/file/42309493/provider%20ClassificationFINAL.docx 
14

 As has been discussed previously, we note inconsistency in how providers are supplying information at the block 
and segment level.  Beyond the temporal differences, we see that providers are computing area differently, as well 
as including or excluding water areas.  This provides an inconsistent measure across providers for the 2.00 sq mile 
cut off.  Our preference would be to provide guidance to service providers within our states, but our concern is 
that we will inconsistently message this with grantees in other states.  We would appreciate consistent guidance 
from FCC/NTIA on this topic. 
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Figure 5-Internal inconsistency in submitted data 

In other circumstances, we found that inconsistent geocoding standards may produce misleading 

results.  The next image shows point level data, and the Blocks are colored based upon the counts of 

points intersecting Blocks.  The challenge this presents is that if geocoding was performed on a different 

dataset than the block boundaries (the road traces are not coincident with block boundaries) and/or 

geocoding was done without an offset, it becomes problematic to assign coverage to a Census block 

based upon only the point locations. 
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Figure 6-Block Coverage 

For this reason, where we were provided address point data and asked to generate covered  Census 

blocks, we elected to use a 200-foot buffer to select Census Blocks that intersect our points.   

We are also starting to see a number of providers submit customer data and facility data.  Their intent is 

to allow us to have two primary sources from which to derive the most accurate coverage.  In these 

cases we tend to look for clusters of customers in areas where we see no facility based coverage. 

With respect to deriving Block level speed from sub-Block data, we have instituted a business rule where 

the predominant speed in a Block is the speed we attribute to the Block. 

Block Level Coverage Derivation Using Customer Facing Plant Level Point Data 

In other circumstances, providers submitted point level plant data.  From what we could gather, these 

points tended to be customer-dedicated terminals.  Typically, these providers were high speed 

Broadband producers—which may somewhat strain the definition of Broadband as other providers 

supplying comparable services specifically disclaimed the ability to provide high-capacity Broadband 

services in the required 7-10 day interval.  In these plant point data submissions, we had similar 

concerns to the point level customer data, but two factors tended to make us use a more conservative 

intersection buffer.  First, we tended to have far fewer points to work from, so our concern was 

grabbing too many covered Blocks as the Blocks tended to be much smaller in these urban areas.  
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Second, these plant points tended to be dedicated to distinct customers, but it was difficult to know 

which element of the customer’s campus to attach coverage to. 

In the case of the image below, given a small shift to the left, it would be easily possible to gather 1 to 3 

Census Blocks from this point.  Although orthoimagery is helpful in a circumstance such as this, it is still 

indeterminate.   

Thus, in the circumstance of plant level point data, we used a 100-foot intersection buffer. 

 

Figure 7-Plant Point level data 

Coverage Derivation Using Linear Facilities Data 

A number of providers submitted facilities data.  We handled this data in different ways depending upon 

what we believed the facility data represented. 

Most telecommunications networks are divided into two components.  Feeder supplies higher capacity 

nodes (eg. DSLAMs, Fiber Nodes).  Distribution usually supplies customer premises (NIDs, Pedestals, 

Taps, ONTs).  Where we could discern what strand we were provided, we used different methods. 

The next image demonstrates a geo-referenced CAD image as given to us by a Broadband service 

provider.  Note the light and dark green shading.  We would infer that the lighter segments represent 

distribution and the dark green represents the feeder network. 

In the case of a combined strand map, we used a relatively tight buffer of 200 feet to gather covered 

Census Blocks.  Our intersection tolerance is based upon an assumption that our data likely represent a 
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situation comparable to customer point level submission in that we have most of the network footprint 

captured. 

 

Figure 8-Georeferenced CAD information supplied by Broadband provider 

 

In other circumstances, we were provided engineering information that we inferred to be feeder only.  

This inference was typically based upon the presence of fiber optic equipment only.  In these cases, we 

used a more generous 2,000 meter Census block intersection.  The 2,000 meter criteria was based upon 

an informal survey of population in proximity to the geo-referenced strand data, but it could be varied 

based upon a more complete survey. 

Coverage Derivation Using Covered Street Segment Data 

In some cases we were provided with covered street segment data.  Covered segments tended to come 

from two sources. 

In some circumstances, providers gave us CAD data, which was not drawn in a projected manner.  This is 

relatively common for older engineering data derived from hand drawn records.  This meant that our 
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team geo-registered the image into an approximate position.  In this case, the boundary streets were 

selected, and an enclosing polygon was derived.  The intersection of this polygon and the Blocks within 

became the geoprocessing method to derive Blocks. 

 

Figure 9-Coverage derived from street segments 

In a second circumstance, street segment data was developed during coverage estimation.  Handling the 

estimated data is discussed below. 

Coverage Derivation Using Serving Area Point Submission Data 

In other cases we worked with providers to derive service areas based upon point plant data.  In these 

cases we were given a serving node and an appropriate road length service boundary. There is an 

important distinction from the plant data discussed above. In this specific case, the data submitted was 

a node that served many locations--such as a Central Office or DSLAM.  This is contrasted with the 

earlier example in which the point represents a node serving only a few customers.   
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When trying to derive coverage from Central Office or DSLAM nodes, the team used ESRI Network 

Analyst to derive covered road segments honoring these road engineering parameters. 

The figure below shows street level coverage derived from Central Office and remote DSLAM point data.  

 

Figure 10-Coverage derived through road paths 

In response to Provider feedback we revised this process to include a larger variety of TIGER road types.  

In Round 1, unimproved roads were not used.  In the current submission -- particularly to improve 

estimates in areas bordering parks and public lands -- a wider class of TIGER roads was used.15 

The segment level coverage is easily extendable to derivations of Census block level speed.  The figure 

below shows the attributions of block level speed based upon the Maximum Advertised Speed available 

from a DSLAM.  Although the methodology isn’t perfect, it does provide insight into the value of 

granular infrastructure data. 

                                                           
15

Only TIGER features of MTFCC type S1100 and S1200 were excluded from use. 
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Over time we have seen an increase in the number of providers submitting this type of data for our use.  

Our sense is some providers find plant level data easier to generate and are satisfied with the results of 

derived coverage. 
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Coverage Derivation Using Polygon/Polyline Serving Areas 

Broadband service providers sometimes submitted coverage in terms of served areas.  This was either in 

direct geospatial formats, CAD files, or paper maps.  The image below reflects a carrier’s service area.   

Within that service area, there are variations in technology of transmission and served speeds.  When 

polygons with speed data and technology of transmission were available, we used a spatial intersection 

to gather covered Census Blocks.  In many cases, using covered Census Blocks resulted in a loss of the 

speed variation (sometimes the speed variation was at a level smaller than a Block and did not get 

picked up within a spatial query).. 

 

Figure 11-Coverage derived through serving area polygons 

Although we cannot directly solve the loss of speed granularity due to Block shapes, we honor a 

business rule wherein we always select Blocks from the highest speed areas first, and then allow the 

lower speeds to select from the remaining Blocks.  This is an arbitrary rule, but our feeling was that it 

should be a consistent selection, rather than an unordered selection. 

Street Segment Derivation, Large Blocks 

For those calculated Blocks greater than 2.00 square miles (large Blocks), we provided coverage in terms 

of covered street segments and corresponding geography.   

With respect to segments we had four sources of data: 

1. Covered large Blocks 

2. Tabular street segments and address ranges for large Blocks 
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3. Geographic segments either with street attributes or without 

4. Service area boundaries 

A number of providers only provided a list of covered large Blocks without corresponding segment 

information beneath the block.  This provided the dichotomy of either selecting all segments in the 

block, or none.  Because we had little information from which to make the selection, we elected to be 

conservative and did NOT pass any covered segments to NTIA from this submission format.  Some 

Broadband providers submitted covered street names and street ranges.  In these cases we performed a 

manual analysis trying to link to specific segment names and address ranges within covered Blocks.  

Sometimes this was a simple process because a provider used a TIGER derived street database.  In other 

cases we could not determine the source of the provider’s street data.  Street and Address matching 

tended to yield a relatively good result (typically between 30% and 100% of possible segments in the 

Block), but was very time consuming.  Where yield rates were low, our result was a shredded segment 

coverage pattern, like the image shown 
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below.16

 

Figure 12-Blue road segments adjacent to peach covered small Blocks 

A number of providers submitted geographic objects. In this case, our manual process was directed 

toward a conflation of data sources.  The goal was to take provider submitted segments and put these 

segments in terms of our TIGER 2010 basemap.  Although there is a trade-off in the accuracy using non-

provider submitted segments, we felt it was more important to have a road set that would edgematch 

our Block features and remain consistent with the Block size standards we used for other providers.  This 

is important for the appearance of the online maps, as well as potential verification work where we are 

attempting to judge a feature based upon its attachment to a covered small Census block.  The figure 

below shows street segment input data. 

                                                           
16

 We continue to hear providers expressing concern that our request for either a geographic object or TIGER Line 
ID is beyond the scope of the NOFA clarification. Therefore, they cannot supply additional information to us. 
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Figure 13-provider Submitted Street Segment Objects.  The segments don’t edge match the Blocks nor are they continuous. 

The figure following demonstrates the same area after the conflation process.  Blue segments are the 

conflated TIGER roads which will be passed to NTIA. 
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Figure 14-provider submitted segments in gold, selected TIGER  in blue—Conflation result; in many cases what was a 
continuous segment is made discontinuous because even with a distance buffer the TIGER segment doesn’t always intersect 
the provider segment 

 

The final segment process was used when we were supplied with a Broadband covered area polygon.  In 

this case, we found the segments within covered areas and eliminated those segments inside of Blocks 

less than or equal to 2.00 square miles. 

Because there was more control over the format of the inputs (we knew we had a boundary and were 

working with TIGER segments), this was an automated process that followed this general format: 

1. Select large covered Blocks by provider ID (from updated Large Block table) 
2. Select TIGER 2010 road segments (MTFCC like 'S%') that face (CB = CBLeft2010 or CB = 

CBRight2010) covered large Blocks for provider 
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4. Select segments as distinct records, max speed with corresponding technology, join in 
feature names, export selected records to temporary DBMS table  

5. Join TIGER roads feature class to temporary table on TLID 
6. Select covered segments (Python script)  
7. Select service area polygons for provider 
8. Clip selected facing segments with selected service area 
9. Export clipped segments to staging feature class, keyed by providerID 

In this figure, orange represents covered small Blocks; black lines are covered segments in large Census 

Blocks (light blue).  The service area boundary is shown in grey. Based upon feedback from providers, we 

have elected to clip segments at the end of a coverage boundary.17 

 

Figure 15-Output of the Segment Process 

Wireless Coverage Process 

In general, most providers of mobile Broadband submitted coverage information in a NOFA-compliant 

format.  Other than attributions for spectrum and speed, little was done to this coverage.18 

                                                           
17

 An outcome not discussed here is how to handle address ranges on segments.  As NTIA is asking for a Min and 
Max on the segment, deriving theses values for clipped segments is very problematic.  Also the prevalence of 
alphabetic characters in addresses makes the min/max selections very arbitrary.  We are grateful that addresses 
are nullable data elements. 
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LinkAMERICA continues to make aggressive efforts to bring additional WISP coverage into the NTIA 

dataset.  For the most part, our outreach was with providers who were unable to supply sufficiently 

granular data in the past or those that could only submit wireless address points which is no longer a 

valid submission format. 

In Round 4 fixed wireless providers generally either supplied coverage information or infrastructure 

from which coverage estimates could be derived.  Many allowed us to use their tower locations, 

antenna heights and direction/spread of coverage to derive a line of sight coverage estimate.  In our 

experience, this is a conservative and reasonable derivation of coverage. 

Some wireless providers submitted RF studies.  When this was done, there was a request that the signal 

strength be removed from coverage data.  The request was honored.  

Other fixed providers were able to supply us with hand drawn maps or polygons/polylines drawn in 

Google Earth format.  In these cases we did our best to georeference and verify the coverage areas with 

the WISP. 

When we received coverage information in KML format, like the image below, we accepted the data as 

it was presented to us.   

 
                                                                                                                                                                                           
18

 Some polygon data did exceed the node count threshold.  In these cases, data was rasterized to 100m cells and 
then converted back to polygons.  The polygons were dissolved to multi-part geometry.  This addressed the node 
count concern. 
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As the image above shows, in some cases we were provided hand-drawn coverage, as well as 

infrastructure.  Instead of estimating their coverage using a line of sight or RF study, we elected to stick 

with the provider’s supplied information.  Our decision was guided by two primary factors: 

 If the provider is advertising using this coverage they must have specific confidence in its 

accuracy. 

 If the provider can supply coverage, as well as infrastructure that reasonably supports the 

coverage, there is a very high likelihood in the accuracy of the information.   

The downside, of course, is the polygon shown on the map may not represent our notion of how 

wireless coverage should appear.  

In general we note several interesting trends in the wireless data.  First, we can be successful in 

increasing the amount of WISP coverage when we aggressively pursue WISPs.  This means we have to be 

willing to accept data on their terms and convey it into SBI formats.  Some of our WISP submissions have 

taken over 12 hours to normalize into SBI formats.  Second, we have to accept that some WISPs will not 

be able to supply FRNs.  There remains a minority of WISP providers who are not aware of the FCC FRN.  

Third, there appears to be some variation on how the NOFA coverage definition is met.  In other words, 

there seems to be a disparity on the necessary strength (e.g. -80 dB, -98 db, -120 dB, etc) to provide the 

appropriate quality of service for data services.  Fourth, it was very difficult getting providers to identify 

spectra used for Broadband data services19.  We are unsure if this is a competitive concern, or if the 

same coverage pattern is yielded for multiple frequencies.  Typically, the spectra returned were those 

that a provider was licensed for.  At this point, we have no reliable way to locally determine what set of 

frequencies are used to provide Broadband data services in a local area. 

Service Address Point Process 

A handful of providers have requested that customer level, service address point data be submitted to 

NTIA.  In these circumstances we have done minimal processing to preserve the provider’s intent with 

this deliverable and not bias downstream NTIA use. 

Our verification included checks against commercial or Public Utility/Public Service Commission 

exchange boundary maps.  Points not contained within one mile of a boundary are not submitted to 

NTIA.   The percentage of excluded data variesacross providers. 

We retain from the provider the provided latitude and longitude, as well as Census block.  For some 

coverage data, if a provider is unable to supply a longitude, latitude or Census block, we fill in these 

attributes.  In those circumstances where we do not have a Census block, but we do have a longitude 

                                                           
19 One provider responded by email, “This mapping program is to provide the coverage area for 

Broadband provided by a company. Not to keep a detailed account of every aspect of a companies (sic) 

network.” 
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and latitude, we accept the given longitude and latitude and use that as the basis for our Census block 

assignment. 

With point data we have tested for comparable geocoding success rates but do not overwrite provider 

information.20  From this type of analysis we note the amount (usually little more than 10%) of 

addresses that seem to locate with less than street segment certainty.  Deriving a thematic 

representation of the points on speed also illustrates some of the locational certainty issues in this point 

level data.   

Coverage Estimation Process 

Although the derivation of Broadband coverage into Census Blocks, street segments, or wireless 

coverage files is, in itself, a bit of an estimation process, there was an explicit estimation process 

required in cases where a Broadband provider either refused to participate in our survey, or provided 

such a threadbare submission that no carrier-based coverage information could be gleaned21.   

We typically resorted to three possible estimation paths. 

For Cable (HFC) providers who did not provide any coverage information, we fell back to Media Prints 

data.  Rather than using the entire Census Block Group gathered by Media Prints, we used only those 

Census Designated Places carrying the same or similar names to the Media Prints p_com field.  Our 

reasoning was that Cable systems tend to be franchised on a municipal or at least administrative basis 

so the coverage will likely follow a governmental boundary.  As a general rule, cable infrastructure is not 

available in the public domain22 and what could be found was poor in quality and difficult to ascertain 

for validity.  

For DSL providers who did not provide any coverage information, we estimated road-based coverage 

from their Central Offices23.  We only used Central Offices that showed evidence of DSL or fiber-based 

services in the NECA 4 tariff.  Road-based engineering areas were derived via ESRI Network Analyst to 

18kft.  These segments/boundaries were clipped to commercial wirecenter boundary edges.   

For mobile Broadband providers who were non-responsive to our requests, we fell back to American 

Roamer coverage patterns.  We generalized the American Roamer coverage to ½ km in order to protect 

the licensed information. 

For fixed wireless providers who provided no coverage information, we relied on their public websites to 

derive coverage maps.  When these maps were available, we georeferenced them and tried to use the 

                                                           
20

 We will make a second geocoding pass on locations with no longitude or latitude from provider.  We typically 
pick up ~5% from our second geocoding pass.  Typically the issue is address quality but also difficulties in 
geocoding in very rural areas. 
21

 We report estimated submissions to NTIA as a non-responsive provider but we have data in the submission for 
them.  This is the reason for datapackage.xls entries which are non responsive but contain submitted data. 
22

 The team tried to use data from the FCC Coals system and 321/325 fillings but this seemed to be a bit non-
uniform in quality. 
23

 Central Office location was derived from MapInfo ExchangeInfo Professional.  Wirecenter boundaries also came 
from this commercial product. 
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outer polygon boundary to represent their serving area.  In other cases, when only a tower could be 

provided, we used a view shed analysis and estimated coverage at 10mi per tower24.  Because much 

wireless propagation is driven far below the Census Block and much engineering information isn’t 

known (frequency in use, polarization of the signal, coverage pattern of antenna(s), local terrain/land 

cover) this was the most complicated group to estimate.   

Speed 

Speed attributes are reported both at the block (typical) and higher levels (maximum advertised and 

subscriber weighted).  We note that in many cases, providers did not supply typical or subscriber-

weighted speeds.  In some cases, it appears--although we cannot verify--that their maximum advertised 

speeds were used to populate typical speed columns. 

We do have limited testing data on reported speeds, but we have been careful to not use our typical 

reported values with carrier-provided information.  If we do not have a speed value from a provider, we 

report an empty value.   

Several service providers claim they do not have data on typical speeds available, but estimate a 20% 

overhead factor between the advertised speed and what may be experienced by an end user. 

We continue to request advertised speed at the block level.  Nevertheless we appear to be getting 

speeds that do not vary over a large geographic area – leading us to believe that providers may still be 

submitting the maximum speed advertised in local media for the entire market.  For the most part, we 

have been unsuccessful in messaging that advertised speed should not correspond to a market area, but 

instead, the maximum speed, which can be provided to a household—what some may describe as a 

‘qualified speed.’25 

As a general rule, in circumstances where a provider supplies a range of speed attributes, we assign 

NTIA categories based upon the midpoint of the range. We follow this rule unless we can determine 

other grantees are handling the same submitted information differently. 

To support NTIA program office requests, we have also modified the structure of the Service Overview 

table.  Even if Maximum Advertised Speed is supplied at the market or county level, we push that speed 

down to the contained Blocks.  The only records that remain in this table, will be those wireline records 

with either a non NULL nominal weighted speed or ARPU value. 

                                                           
24

 In some cases we had an approximate radius of coverage but no height.  In this case we used a 50’ height 
estimate and then clipped the coverage to the provided coverage range.  We also clipped wireless coverage to 
honor state boundaries but did not look for providers serving coverage with out of study state facilities. 
25

 As an example of a response to our request for Block level advertised speeds, we received the following 
comment from one anonymous provider, “This is and of itself does not require anything new of us – just states the 
NTIA supports efforts focused on getting that information on the CB level.”  It would be helpful to have broader 
messaging so that providers understand this new direction.  
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Community Anchor Institutions 
In the first submission, the Community Anchor Institution (CAI) process was referred to in terms of a 

learning curve.  This continues to be an appropriate metaphor.  The mapping team continues to focus on 

data that will support and help inform policy makers and the SBI planning process. 

In the first submission, the team gathered information on what data was available and what resources 

will be required to engage these categories of important institutions.  In the second submission we 

continued to obtain additional connectivity information.  For the Spring 2011 collection, the team began 

a survey process to directly engage these important organizations.  As the October 2011 submission 

represents a transitional phase, much of the CAI effort encompassed getting this dataset stabilized for 

work outside the LinkAMERICA team.26   

 In the current submission we worked to achieve four goals 

1) Modify the source data so as to no longer pass NTIA any connectivity estimates 

2) Propagate administrative capabilities in our Community Anchor Verification System (CAVS) systems to 

the Regional Planning Teams 

3) Verify the available connectivity information based upon new survey information 

4) Update the Federal record identifiers (NCES codes, etc). 

CAI Philosophy 

Our work with CAIs is guided by three principles. 

First, CAIs are important stakeholders within the planning process.  Our goal is to engage participants in 

regional planning that have strong ties into the CAI categories identified by NTIA.  This has a direct 

benefit of engaging an established stakeholder community.   It also allows Broadband planning to tie 

into existing organizational and planning networks.  In each of our states, key relationships with 

education, public safety, libraries, and economic development sectors are being identified and 

developed. 

Second, we believe that CAIs will likely be one of the primary beneficiaries of targeted Broadband 

funding.  Our belief stems from the sense that many of the benefits of Broadband will extend from these 

community ‘anchor points’.  In other words, it isn’t solely the existence of Broadband at a library that 

provides a benefit.  It is people using applications that work only on a Broadband network to upgrade 

their skills (e.g., online training) and gain access to online content (e.g., job postings, goods and 

services), etc.  The targeted use of a specific application--that can only take place with Broadband 

networks-- is what produces the priority benefit.  Put another way, there seems to be a realization that 

                                                           
26

 LinkAMERICA began transitioning the CAI data collection effort in the state of Alabama to ConnectingALABAMA 
in Round 3.   For Round 4 ConnectingALABAMA assumed full responsibility for the CAI data collection effort in 
Alabama.  To facilitate the reporting process, the ConnectingALABAMA team continued to use the Community 
Anchor Verification System (CAVS) to store CAI data collected or modified.  CostQuest maintained responsibility for 
the CAI data submission for Alabama for round 4. 
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things are less about pure connectivity (for the sake of connectivity) than about connectivity in terms of 

an application (for the sake of the benefit obtained through the application). 

Third, we continue to use a rational and targeted approach to derive information.  This means we will 

utilize our planning teams for as much ground work as possible.  This also means that a goal of our CAI 

process is not an exhaustive Census of anything that could be a CAI; rather, it is the discovery, inventory 

and integration of Broadband planning activities into those CAIs that stand to produce the greatest 

synergies with the SBI planning process.   

The above implies two significant points.  First, the team’s goal is to document community anchor 

institution connectivity within a broader context of regional and statewide planning objectives.  Second, 

if a particular category of CAI has an independent Broadband planning effort underway, we will 

encourage that organization to take the lead, and we will provide relevant expertise and support as 

warranted.  For example, in one of our states, the public safety community is already engaged in a 

mobile Broadband survey effort.  We have aligned our CAI data collection process with that effort and 

are sharing information and expertise (e.g., hosting a survey) to support their mission.  In another state 

we are attempting to glean connectivity information from a municipal government survey.  There may 

be some downside to this collaborative approach in that we may have to work with data spanning 

different times or we may not have all of the location-specific information we need, but this does 

prevent the same user from receiving multiple inquiries. 

 

Anchor Institution Survey  
During the third submission period we designed and developed a simple on-line survey system called 

CAVS (Community Anchor Verification Survey).  The intent of the survey was to both verify received 

connectivity information and garner additional connectivity information from CAIs.  For round 4 we 

continued the use of the on-line survey process.    Although we have found that reaching out to central 

contacts, for specific institution groups, is the most fruitful way of collecting connectivity data we find 

value in inviting individual anchor institutions to participate through means of a survey.  From our 

perspective this approach gives the individual institutions an opportunity to become engaged in the 

broadband planning process.  The link for the survey is housed on the Home Page of the website 

developed for each state, thus providing the added opportunity for responding institutions to learn 

more about activities  in their state.   

The survey remains open between collection periods to provide opportunity for the Regional Planning 

Teams to update information as they engage with the community and to allow responding institutions 

to update their data as necessary.   
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Anchor Institution Trends  
At this point we have focused our CAI attention on schools and libraries, with respect to connectivity.  

We benefit from strong relationships throughout the education sector (K-12 and Post-Secondary).  We 

have also found excellent resources within State librarians in all States. 

To supplement the education and library information we have formed organizational relationships with 

the major hospital associations within each state.  Our goal with this relationship is to cull information 

from their planning process.  We continue to formalize/advance this relationship.   

As in the prior submissions, we rely on public domain sources of information for the public safety-

category .  Collecting connectivity data for this group continues to be one of our most significant 

challenges.  Our hope is that in subsequent submissions, we will reduce the size of this category and 

connectivity information specific to root nodes of the public safety network--such as County Emergency 

Operation Centers.27  At this point we have had minimal success gaining this information. 

Because we have a wide ranging population of CAIs in our data set we have a variety of Broadband 

services that don’t always fit NOFA parameters.  Services like PRI or T1 are classified into “other copper,” 

We also had difficulty obtaining both the upstream and downstream channel capacities.  In most 

instances, when it was logical to do so, we made the speeds symmetrical, but this is an assumption on 

our part.    If a site records bandwidth across several services (eg. video and data), we record the total 

bandwidth to give a picture of available site bandwidth.  We are also working to standardize our 

response to NTIA in circumstances where an entity shares a Broadband connection among a campus 

which is fiber fed.  In this case we use the total campus bandwidth and use the primary campus Internet 

connection. 

As a final verification step, we attempt to screen the CAI data for duplicate values.  Because many CAI 

are closely clustered together we perform the de-duplication based upon the ANCHORNAME within the 

ZIP5. 

Middle Mile 
Middle Mile information was collected directly from providers via survey or interview.  Middle Mile is a 

“chicken or egg” type of challenge in that it is possible to verify that the infrastructure exists, but 

extremely difficult to know what is the site is doing without engineering level assistance.  Although most 

providers submitted “something,” there was a significant variance in what that “something” 

represented.   

The purpose of this section is to record some of the comments and questions we have received about 

Middle Mile.  We hope this provides better context for our data submission. 

                                                           
27

 Within the public safety category, it is also very difficult to derive precise locations as many CAI are addressed to 
PO boxes. 
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Within the NOFA, Middle Mile was defined as (a) a service provider’s network elements (or segments) 

or (b) between a service provider’s network and another provider’s network, including the Internet 

backbone. (Collectively, (a) and (b) are “middle-mile and backbone interconnection points.”)28 

Given the existence of the “or” in this definition, providers submitted a variety of information.  Based 

upon the NOFA example, several fixed wireless providers interpreted Middle Mile in terms of the 

connection points from their towers to their own serving backhaul location.  The topology was 

commonly Microwave from their distribution towers to their NOC.  The NOC and towers were listed as 

the Middle Mile points. This seems to be consistent with the first definition clause (a). 

Telephone, Mobile Wireless, and Cable providers tended to remain either silent on the question, or 

would provide a single location in which Internet peering occurred (clause b).  A number of participants 

explained that the NOFA was quite ambiguous with data traffic moving back and forth over both TDM 

and IP networks--it was unclear where the distinction should be drawn.  As a general rule it seemed like 

many providers listed a single location where Internet Peering occurred. 

A number of providers refused to answer the question on grounds of confidentiality29.  Others would not 

disclose as their Middle Mile points are not owned--another company provides the physical and 

electronic connection to their network.  In other words, the entity providing Broadband is not the entity 

providing Middle Mile. 

Additionally, based upon the new Provider Type classification of “other,” we have started to integrate 

points provided by Broadband service providers not meeting the NOFA definition.  This includes POP 

locations and aggregation points for public / private networks.30 Within a given submission there were 

two final attributes that tended to concern respondents.  First, speed should be measured in terms of 

only data capacity and what exactly is “data” (e.g., can/should you segregate out voice or video), and is 

the relevant capacity of the physical connection, channelized to a specific virtual circuit on their 

network.   

Finally, a number of other providers were unsure of the height above grade measure (is this their floor, 

the street outside, etc).  We seem to have a combination of height above or below grade, as well as 

heights above mean sea level (AMSL).   

To the extent possible in our timeframe, we verified the location of a sample of Middle Mile points.  

Where we could see infrastructure that appeared to be consistent in location with other provider 

                                                           
28

 From http://broadbandusa.gov/files/BroadbandMappingNOFA(FederalRegisterVersion).pdf at 54, visited March 
28, 2010 
29  As received in email 9/30/10, “Due to security concerns and the risk of public disclosure of highly sensitive data, 

whether inadvertent or otherwise, ***REDACT***response to the Middle Mile and backbone interconnection 

request is limited to publicly available information available on {remainder not included}” 

 
30

 As discussed in our readme.txt file, a number of middle mile points were lost in validation due to their location in 
adjacent state.  This will cause a decrease in some providers relative to prior submission. 

http://broadbandusa.gov/files/BroadbandMappingNOFA(FederalRegisterVersion).pdf
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infrastructure, we felt that the location was accurate.  In some cases, the point provided seems sensible 

(is on a road, near other equipment), but using imagery, we couldn’t find a place where this type of 

connection could occur.  This wouldn’t be unforeseen, in that Middle Mile connectivity likely takes place 

in a protected environment much smaller than a standard Central Office installation.  

Mobile Wireless Coverage 
We have received mobile wireless coverage from most mobile Broadband providers in each state.  At 

this point we have cleaned the geometry of the data and attributed it with spectra and FRN as required. 

Provider derived coverage has been reviewed against the commercial licensed product for consistency.  

To a limited extent we also use licensing locations and tower infrastructure to spot-check supplied 

coverage.  This mode of verification remains complex, given the lack of facility-based information with 

mobile wireless. 

Finally with respect to mobile Broadband services, we note several trends. 

First LinkAMERICA used the NTIA supplied frequency tables to report speeds consistent with other 

grantees.  In circumstances where a provider supplied a range of experienced speeds, we used the 

portion of the range consistent with the most frequently reported Grantee value. 

Second where a provider reports multiple frequency bands in use but doesn’t distinguish these bands by 

submitted SHP file, we submit identical geometries but attribute one geometry to each submitted 

spectrum value. 

Third we are seeing a trend toward increasing Broadband speed.  As of this writing, there is not 

consistency across providers in how they attribute the advertised 4G speed values.  In other words, for 

some providers 4G means advertised speed categories increase.  For other providers, the speed value 

did not change. 

Verification 
Almost by definition, data verification is an ongoing and evolving process. Clearly, with each new data 

submission there will be a validation process at hand and at the same time, our team continues to 

expand and improve the efficiency and effectiveness our data verification routines. Consistent with the 

movement toward an fGDB export database and use of a data receipt script, much of our validation 

effort was spent in supporting the ETL processes into the required formats.  In future data submissions 

we will continue our work to stabilize and improve the business process that normalizes provider 

submissions into NOFA formats and expands in more depth on the confidence analysis within the data.  

Verification Standard 
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Our overall verification standard is focused on the level at which we supply processed data to NTIA.  This 

means that the vast majority of our verification process will be focused on ascertaining coverage for 

Census block’s less than 2 square miles and covered road segments. 

We are learning that Verification has multiple dimensions. 

Provider verification is finding providers who supply Broadband and discriminate out providers not 

meeting Technical Appendix A’s definition of Broadband.  

Identity verification is taking the provider’s categorized in the first step and ensuring that the provider 

either has a valid FRN or is assigned a default FRN.  Identity verification is very complicated because of 

the Technical Appendix A’s mandate to record data at the FRN, provider Name and DBA level.  Each of 

these attributes could be unique for a single provider going to market under different or the same 

names.  As a result, rolling up each provider into an identity collection that matches either the FCC data 

integration team or a third party Broadband provider’s data view, is very, very time intensive.  Identity 

verification is discussed in the earlier section-- Developing the provider List. 

Coverage verification is a broad term, but in our definition it boils down to determining if Broadband 

coverage is in the right place.  For a given provider, the question is whether the coverage is assigned to 

appropriate Census Blocks, road segments or area features.  Coverage verification can be further broken 

out into two distinct classes: 

 Technology verification, which is determining if the provider is listed with a technology 

consistent with their marketing information.   

 Speed verification, which is determining if the speed supplied for that block, road segment, 

point area file or market area is consistent with the technology and the marketing information 

received. 

The final verification dimension is consumer feedback and crowd-source verification.  This is a dynamic 

set of steps we are beginning to implement.  One side of this is responding to consumer concerns.  The 

second is using the crowd sourced data to validate provider claims and, if appropriate, update the map 

and the underlying data. 

At this stage, our working hypothesis (confirmed by our experience) is that there will not be a single 

dispositive measure to indicate Broadband coverage availability in a Census block or along a segment.  

From prior work, and examining our current provider submissions, we believe that there is too much 

variation below the submitted record to make a single binary yes/no indication.  Rather, there will be a 

series of measures that combine to provide qualitative confidence (a classification scheme) in our 

indication of Broadband availability at the block, segment, or wireless polygon level. We believe such a 

qualitative confidence scheme is both relevant to and supportive of NTIA interests, as well as the 

interests of our end-user community – that is, the states and citizens we serve through this program. 
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The intent of this section is to illustrate why we are moving toward a particular verification 

methodology.  Our team is learning as we go along, and will adjust and improve this thinking. But given 

our experience to date, this is where we are heading. As stated above: 

 First, coverage verification is at the level of data submitted to NTIA. 

 Second, coverage verification is enhanced when there is a secondary measure of availability 

(such as infrastructure presence or serving area boundaries) 

 Third, given the limited resources of this effort, the most important coverage verification 

process to implement is the erroneous dispersion of coverage.  These are the “islands” of 

coverage isolated by significant distance from other covered areas.  .  In other words, Broadband 

Internet likely doesn’t exist far away from other areas with Broadband Internet access. 

Before explaining our overall verification thought process, we have several examples, which illustrate 

the complexity of coverage verification. 

The first example is taken from a gentleman who requested a map change in Alabama.  His home is near 

the yellow dot.  The darker grey Blocks are covered Census Blocks.  The black lines are covered road 

segments.  He cannot receive DSL from his incumbent provider, although his neighbors can.  The 

incumbent carrier does have at least one structure in that block from which Broadband services can be 

provided; unfortunately his home is not served.   

 

Figure 16--Sub block variation 
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Because the SBI program requires the depiction of coverage at the block level, the above map has been 

correctly generated.  However, from the customer’s point of view, the map is inaccurate.  This requires 

us to explain that the maps are not intended to be a structure-level qualification, at which point some 

consumers question the value of the maps when seeking service information.  Of course, we also share 

this information with the incumbent carrier in the area so they are aware of a potential customer 

market. 

Beyond this type of one-off structure-level qualification, sometimes, as shown below, we have even 

larger gaps in provided coverage.  The image here shows an “outlier” block that could be an error, or it 

could indicate missing Blocks along a major road that should have been filled in.  In this figure, the 

outlier block is highlighted in turquoise. 

 

Figure 17--Dispersion in Submitted Data 

 

In this particular case, we are faced with a different verification question.  Based upon the properties of 

the neighbors, we believe this block should likely be covered (coverage interpolation,) but supplied data 

from the incumbent says otherwise.  

The next example shows where an interpolation process could require some adjustment.  The figure 

below shows a town level.  There are some smaller Blocks that are likely covered by interpolation logic, 

but we also do not want to extend coverage beyond a franchise boundary as in the areas shown in a box 

on the bottom of the map. 
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Figure 18-Where do you stop interpolating? 

From what we can gather from some providers, the submitted data—data with consistently high 

degrees of dispersion or coverage holes—tends to come from geocoded billing records.  In this 

paradigm, this means where there are no customers; service is not identified on a map.  The 

interpolation verification question then takes on two dimensions. 

First, if a provider has no customers in an area, how can we know if they would be able to 

provide service in a 7-10 day interval? 

Second, if we use the properties of neighboring Blocks to interpolate coverage, when should we 

stop (e.g., at a franchise boundary, at a certain distance, etc.)? 

We continue to work with providers to get additional information to help us better understand and 

contend with this type of circumstance.  However, we have not been entirely successful at getting 

franchise boundaries that would address much of the issue. 

The final map shows this dispersion problem, but to an even larger degree.  This solitary large block is 

likely the result of a bad geocode, but we don’t know, given the data that has been submitted by the 

provider and the “single customer in a block standard” set by the NOFA clarification. 
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Figure 19-Dispersion in covered Blocks 

Due to the fact that this situation is quite obvious in display, this type of problem is one that we are 

more aggressively trying to resolve.  Where a single block has no neighbor offering comparable coverage 

and is a specified distance beyond an exchange boundary, our approach has been to filter these Blocks 

out.  As of now, this filter is limited to incumbent DSL providers because we have a good source of 

exchange boundaries.   

The exchange boundary dispersion verification method breaks down when examining smaller providers 

who are more likely to CLEC into neighboring territory. In the figure below, the black line represents the 

exchange boundary, while the continuity in the DSLAMs likely points to coverage extending along a road 

into another provider’s territory. 

 

Figure 20--DSL Coverage outside of exchange boundary 
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In sum, the variability in our source data continues to suggest that our dynamic verification process is 

relevant, appropriate and evolving in a manner consistent with the overall program.  And, as noted 

above, we believe the more meaningful outcome of our verification processes will likely be a series of 

qualitative indicators or expressed confidence levels.  Our concern, as with the development of any sort 

of classification process, is how rigid we should make this classification given the variation in our input 

data and the varied perceptions of service providers, map viewers and down-stream data consumers.   

Verification Work Process 
To support our dynamic multi-factor verification process, we have implemented the following steps. 

First, when data is received, an analyst reviews the submission and any immediate questions or 

concerns are sent back to the provider as quickly as possible.  We have found this gatekeeping step very 

helpful in making sure we understand the intent of the submission.   

Second, for all providers who submitted data to us in the third round, they received both a tabular data 

summary and mapped output31.  Prior to releasing the “check maps” to providers, we had a team of 

analysts visually inspect each provider’s coverage area.  The focus on this QC effort has been to identify 

and flag suspect Blocks.  After this in-house review, we solicited a second level of feedback from 

providers and received a number of requested changes and corrections used in the development of the 

October, 2011 round 4 dataset. 

For those providers who submit only block or segment level coverage (i.e., in those cases where we have 

no infrastructure to test with) we test for coverage containment within known service boundaries.  The 

intent of this validation step is to remove Blocks that are obviously erroneous.  We also verify the 

submitted speeds against the typical speed ranges in the NTIA frequency tables.  If we note a value 

outside of typical range, we ask the provider for clarification. 

As mentioned in the sections above, we have implemented a check on dispersed Blocks, but we have 

implemented less with respect to coverage interpolation (holes in coverage). We continue to work on a 

series of mechanical tools to assist with the inspection process but have run into challenges related to 

geographic basemap and timing. 

As our submissions have moved online, we have also begun to benefit from crowd source feedback.  In 

some cases this has helped us identify and fix errors in our underlying data. In other cases, as we have 

shared with NTIA, we have encountered some perceptual issues rooted in how the data are developed 

and modeled to comply with the NOFA.  Depiction of uniform coverage in small Census Blocks continues 

to be a challenge. Despite our best efforts to explain the full block coverage requirement, we continue 

to receive complaints that the coverage shown on the map is not accurate for a particular location 

within that block.  

                                                           
31

 For the verification of round 3 data, we submitted both PDF and KMZ (Google Earth) format check maps.  Some 
providers prefer to work with the Google format as it supports easier modification.  Others continue to submit 
marked up PDFs. 
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Consumer and Provider Responses to Deliverables 
Here, we segue from internal verification to external verification.  We view responses to our work 

product as a form of validation and verification.  On the one hand, this gives us the opportunity to fix 

mistakes and then generate QA steps to make sure that the problem does not reoccur.  We also learn 

how to improve what we are doing or better explain what we are doing to a community not always 

familiar with the NOFA and program office framework.  On the other hand, listening and learning from 

this feedback helps us better target our mapping deliverable to meet the needs of our external 

customers.  In this second case, external feedback not only provides feedback on perceived qualities (or 

lack of quality) in the data, it helps us to learn if we are developing data that is truly helpful to 

downstream users. 

At this point, our external deliverables take three forms: State Broadband Maps, data transfer to NTIA 

used for the National Broadband Map, and text format data requested by outside parties. 

Online Map Experiences 

With our State maps are online, we continue to harvest viewer feedback and comments.  Because an 

online map allows someone to zoom in far below the scale of the data, a large number of comments 

reflect sub-Census block concerns. While important to the citizens reporting these issues and to our 

Broadband planning teams, this level of data is outside the scope of our core validation process, which 

as noted above, is focused on the level of data submitted to NTIA.  

There are several other themes that our team believes are important to share.  These comments are 

actually quite helpful because they also improve our data processes to better meet the needs of map 

viewers.  For example, we have invested significant time in harvesting more segments from provider 

data.  Because the appearance of segments is so important, we are putting time into ensuring a visually 

appropriate edge match between the roads we harvest and the Blocks/roads we will show online.  On a 

technical level, we also believe that a good segment process will help us understand more about 

dispersion in the data, and what is valid versus what is not valid. 

Online Display of Consumer Feedback 

We have completed development of a consumer feedback layer for our online maps. 

The intent of the new layer is to show viewers the feedback of other map viewers.  We anticipate the 

feedback layer will go live when the Round 4 data is posted on our state maps.  We expect this to be 

prior to the end of October, 2011. 
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Figure 21--Consumer Feedback Layer 

To gather feedback, we use a survey wizard which asks the end users to categorize their concerns.  The 

survey went through several iterations of design and usability testing.  Our experience has been unless 

we get a way to constrain the user feedback into manageable categories, it becomes very difficult to act 

upon. 
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As mentioned by other Grantees we struggle with how to use all of the feedback we receive.  The 

qualified data points seem to fall below a volume in which we can infer significant modifications to the 

map data. Nevertheless, we believe it is important to gather structure and display the feedback  to 

support project transparency.   

Perception of Unfair Treatment Across Technologies 

Several Broadband service providers have expressed strong concerns regarding how wireline services 

are displayed, as contrasted to how wireless coverage is displayed.  This is an artifact of the SBI data 

model. As an example, consider the figure below. 
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Figure 22--Multi Network Coverage portrayal 

In this image, covered Census Blocks are light gold.  Covered road segments are a darker gold and 

wireless coverage is purple.  The concern seems to come down to how a wireline provider’s coverage is 

shown in the large Census Blocks (greater than 2.0 sq mi).  Some wireline providers have expressed 

dissatisfaction because their coverage is only tied to road geography, which leads to a visual “hole” in 

their coverage map.  At the same time, they feel that it is unfair that the wireless provider’s coverage is 

shown to be uniform in the same area.  Put another way, if our maps show wireline in terms of Blocks 

and segments, why don’t our maps show wireless the same way?  

 Perceptions of Carrier of Last Resort (COLR) Obligations 

Some wireline providers have also expressed dissatisfaction because online maps limit the distance of 

coverage from a road segment.  In our current online maps we buffer a wireline carrier’s service 300’ 

from road centerline.  A number of providers have expressed that they are mandated to provide voice 

coverage (which Broadband will accompany) anywhere in the Exchange.  There seem to be many 

dimensions to this argument, but the basic concern comes down to not being able to accurately reflect 

the scope of their COLR obligation within the mixed block/segment view.  Their ability (or lack thereof) 

to actually provision such services for new users within a 7-10 day period adds yet another level of 

complexity when attempting to fairly portray their coverage capabilities. 
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Intentions of Coverage Mapping 

When a viewer of an online map clicks on the map (or zooms to an address), they are provided with a 

pop-up of service provider coverage in the area.  The critical question is this: what is the area to which 

that pop-up window responds to?  In the past, we reported back to the specific Census block, or 

buffered road segment intersected by the user click.  As far as the map was concerned, once we move 

off of that road, or out of that segment, we have a new area to examine.   

Our sense, given feedback received, is that our provider view should be a bit more tilted toward finding 

providers in a general area, rather than finding providers at a single-click location.  If the goal of the map 

is to get someone to call a provider for service, our bias should be to include all of the potential 

providers in the general area, rather than giving potential customers a method to self-disqualify.  That is, 

we want to cast a wider coverage net, rather than one too narrow.  The problem with this approach is 

that it will create a number of false positive Broadband reports.  As of this date we cannot determine if 

the claims of inaccurate coverage in online maps are due to the looser provider view standard or not.  

We keep this looser standard in place to minimize the likelihood of self-disqualifications. 

CAI Survey Fatigue 

We are beginning to note an increase in survey fatigue among CAIs.  Sometimes, as part of a direct 

survey process an end user will tell us how unhappy they are with the repeated Broadband survey 

efforts.  Within several states BTOP grants are in effect that also survey Community Anchor Institutions.. 

As stated earlier we will defer to other Grantees when there are overlapping survey efforts. 
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Appendix One  

Data Collection Challenges 
This section summarizes some of the challenges we have experienced with data collection and 

processing.  The team believes it is important to categorize these challenges as they help inform the 

geoprocessing and verification methods used.  It is also our hope that some of the more global issues 

can be discussed and decided within the Grantee community.  

We begin with several global issues and then continue toward more granular challenges. 

Global Data Collection Issues 

Census Block and Road Standards are not clear 

We receive a variety of Census data.  Some were able to supply 2010 Census blocks.  Others continued 

to provide Census 2000.  Managing this set of heterogeneous inputs has proved to be a challenge. 

There seem to be several methods by which providers are calculating the Census block area.  So the 

distinction between at 2.00 square miles can be uniform, it would be ideal to articulate an operational 

area calculation definition as early as possible. 

Providers Not Wishing for Block Level Aggregation of Their Data 

Both ***REDACT*** have supplied address point level data.  Both carriers want NTIA to have the point 

level information, and they have asked CostQuest/LinkAMERICA not to aggregate their coverage to 

Blocks.  Other than a verification to make sure that point data were contained within, or fell within 1 

mile of exchange boundaries, the only other processing was normalization into NTIA formats. 

Broadband providers not Meeting the NOFA  “provider” Definition 

PBWorks appears to reflect a concern among a number of grantees about what a Broadband provider is-

-and how that definition impacts mapping. 

If the 7-10 day provisioning rule is to be strictly enforced, it would seem to eliminate a number of 

prominent Broadband providers32.  Further, the need for clarification around a facilities-based provider, 

versus the reseller, has injected even more ambiguity into the mix.  Right now we are unclear on how 

strictly to interpret either of these important distinctions, but we are concerned that we are beginning 

to create an NTIA exclusion criteria that is going to confuse downstream consumers of the data.   

                                                           
32

 By email ***REDACT*** informed us they could not provision in 7-10 days, but they also supply information on 
qualified locations to the address point level.  Therefore, we draw a distinction between an incumbent provider 
owning the facility--which terminates at a customer premise--who cannot turn up service at a qualified location, 
versus a provider not reporting any specific qualified locations in which they cannot turnup service in the 7-10 day 
window.  In the first case we have a sense of where service can be offered and verified.  In the second, we have no 
evidence that a service could exist there until a specific location becomes a customer. 
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Again, we do not want to exclude a service provider, but we believe there needs to be further 

clarification around the 7-10 day ”rule,” the definition of a “reseller,” and better interpretation of 

facility-based providers, versus equipping UNEs, SpA or leased lines. 

We have used the provider Type of ”Other” to classify a number of providers who offer Broadband 

services, but we do not offer them in a manner consistent with Technical Appendix A definitions. 

To What Extent Should We Begin “Classifying” the Data and Maps? 

The question immediately preceding gets to the intent of a Broadband provider.  This question gets to 

the intent of the Data and Maps. 

Earlier in this document we discussed the question of what type of bias we should introduce to our 

online map messaging.  In an online environment, do we want to more likely create an overstatement of 

coverage for a provider than an understatement?   In other words, is the larger problem allowing a 

consumer to self-disqualify, versus calling a number of neighboring providers?  There is a related issue 

to this.  Clearly in our maps there is a lot of scatter in data that we believe should be more continuous.  

These are the islands of coverage from an incumbent provider33.  There are a number of processes that 

could be put in place to deal with this type of scatter, but without more information from the service 

provider-- essentially the last mile facilities-- it will be difficult to perform this clean up in an informed 

manner.  On the one hand, we can aesthetically clean the maps up and reduce the scatter, but we have 

little sub-block engineering information upon which to make this decision.  Right now our preference is 

to put out a somewhat aesthetically messier deliverable and work with providers to get better 

information to clean their submission.  If that isn’t forthcoming, we are limited in what can be done 

given the lack of facility level information.  In summary this yields two questions 

1. In our online maps should we error on overstating coverage to prevent consumer self-

disqualification? 

2. In our online maps should we work to clean up a lot of the scatter that we see without having 

facility-based evidence from which to remove it? 

Granular Data Collection Issus 

Non-Uniform Submission Standards  

It is clear among providers that there isn’t a consistent method used to derive Broadband coverage.  

Some providers appear to be use a geocoding approach and then point in polygon or point on segment 

process.  Others may be using GPS locations.  In some cases, it is difficult to infer what reference data 

was used to georeference plant (is it the carrier’s roadbase?).  This leads to uncertainty regarding the 

input data scale or accuracy relative to other base layers.  Although we may be trading off absolute 

                                                           
33

 For a provider who sells opportunistically (not within a franchise area) it becomes even more problematic to 
classify their coverage because the points are more related to the type of consumer purchasing the service than a 
bounded offering.  In a matter of speaking, the ProviderType is more determined by the technology and/or 
location than a type of business.  The core intent of the NOFA and our grant application was centered around the 
7-10 day providers but we believe maintaining information on provider Type “Other” and  “Reseller” is important 
to assist in validation and market segment analysis as resources are available. 
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accuracy, our standard has been to conflate submitted data to TIGER 2010 Blocks and TIGER 2010 roads.  

We perform our verification against this conflated data product. 

Temporal 

We are unsure of how well the data are temporally consistent.  Some providers gave us their best effort 

to control to June 30, 2011. We note that some providers were clear that the submission was as of 

extract date without any way to move back in time.  They have no means to control for time and cannot 

provide any audit support beyond when the data are released to us.  Some data-especially loop 

qualification data-may change from day to day. It will be very difficult to clarify why something was 

changed from a given point in time. 

Perceived Inaccuracy with Respect to Internal Standards 

The NOFA is clear on submitting a list of Blocks in which a provider delivers Broadband service.  This is a 

different objective than perfectly reflecting service territories.  If a firm’s accuracy standard is a 

reflection of their service area, then the data created under the NOFA will not meet their perception of 

accuracy.  This leads to two other issues:  First, using Census Blocks rather than serving area may 

overstate or understate a particular provider’s Broadband serving area.  This was a significant concern of 

***REDACT*** who specifically required us to submit only address-level qualification data.  The second 

issue this brings up is how or if, there should be some standard on how much of a Census Block needs to 

be covered to call it covered.    

Confidentiality  

Several providers have noted concerns with CPNI-related issues and have stated this as a reason for 

non-participation.  We have also heard expressions of comparable concern regarding identifiable 

responses to Anchor Institution information. 

Unclear on Definitions  

As discussed earlier, several providers claimed confusion on several key terms involved in Middle Mile.  

We note a consistent stream of questions around the interpretation of Maximum Advertised Speed.  

Some providers understand this to be the most common speed package bought within the mass market, 

while others view this as a speed that can be purchased for an additional cost above a mass market 

offering (eg. a Turbo option for an additional fee per month).  Others interpret this as the fastest speed 

that is available for that particular location--in terms of xDSL, a structure qualified speed, for example.   

Perception of Data Use 

There seems to be some hesitancy releasing speed information because no one is sure of how the 

information will be used, or what the speed is intended to reflect.  A number of providers have verbally 

indicated that typical speed will be about (on average) 80% of purchased speed due to overhead.  But 

there are many other factors (such as a user’s home network) that influence speeds measures.  

Providers are concerned about introducing statistics without a clear understanding of how those 

statistics are derived and will then be used.  Also, as advertised speed is pushed down to a block level, 

we sense more trepidation to report speed values.  This quickly begins to touch on parity across network 

types (why is wireline down at the block when wireless is half the state, etc.).   Finally we note a 
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significant increase in speed reported to us.  This may be due to network upgrades or competitive 

concerns to match the theoretical network speed. 

Location Uncertainty In Source Data 

Within this document we have noted concerns about the impact of source data accuracy.  Our 

geoprocessing methodology provided what we believe is a relatively conservative tolerance to account 

for the scale issue in the source data, but we are unsure of how this may impact downstream users.  

Clearly, it also impacts the verification process because we can’t attempt to verify received data beyond 

a scale at which it was developed. 

Covered Segment Process 

Deriving those Broadband covered segments in Census Blocks greater than 2 square miles has proved to 

be a challenge.   Moving from a NOFA specified tabular deliverable to a requested  geographic 

deliverable also increases the complexity of the effort.   

Record Level Metadata 

It would be helpful to have one or two additional fields in each feature class transmitted to NTIA.  One 

User Defined field could be helpful as an expression of record level confidence.  The second field could 

be used as a Key between the transfer geodatabase and our systems.  Ideally, both fields could be large 

text fields (50 char) so the Grantee can use them to express a variety of attributes. 

Miscellaneous Data Collection Notes 

 We note the following important observations regarding our data submission: 

1. There are Middle Mile plant records for providers who are not present in the Census block, 

segment or wireless area feature classes.  This is due to classification as non-NOFA Broadband 

providers. 

2. In some cases, we have trimmed wireless coverage estimates to honor state boundaries. 

3. We believe some providers are trimming their coverage to honor license area boundaries. 

4. As a departure from past practice, where a provider submitted Middle Mile points out of state, 

we are no longer passing those points to NTIA as they fail the validation script.  We experienced 

validation errors for BroadbandServed=N records in the CAI table.  These records were 

attributed a Technology of Transfer=0.  This cleared validation. 

5. In tables with mandatory Street and Zip5 attributes(Service Address), if the value is unavailable 

it is filled with N/A. was not available, we have inserted ‘N/A 

6. As with submission three, there remains a tension between the Data Model, Data Model Default 

Values and the Python Validation Script.  As an example the data model allows a NULL for the 

Maximum Advertised speeds in a Census block record.  A default ‘zz’ is available for this 

condition as well but zz will fail the validation script.  In the case where we have data which is 

missing Maximum Advertised Speeds, we are holding that data back to prevent downstream 

validation problems. 

7. We have a significant amount of VDSL, ADSL 2 and ADSL 2+ coverage categorized into the xADSL 

category.  This introduces a variance in speed availability as some providers are using VDSL, 

shortened loops and/or pair bonding to increase speed over 10 Mbps. 
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8. We have left in the data Middle Mile locations with above grade elevations that appear to be 

unreasonable, given review of orthoimagery.  This seems to be confusion between above grade 

request and above sea level readings. 

9. All fGDB have passed validation except in cases where attributed speeds did not agree with 

domains associated with technology of transmission (eg Upstream Speed of 2 with ADSL).  We 

have modified the Python script to allow for conditions in the CAI table in which default data 

model values are disallowed in the Python submission script. 

10. We note a few providers who have speeds seemingly inconsistent with their technology of 

transmission.  This is either very low speeds with optical fiber, or very high speeds with non 

DOCSIS 3.0 systems.  We have verified on provider websites that the reported speeds are 

available in the area but these speeds will fall out of the NTIA frequency table analysis. 

11. We have a small number of providers who serve an area with both a residential and business 

speed tier.  In cases where we cannot distinguish which speed tier offering to use, we use the 

lower of the speed tiers. 

12. Per NTIA request we have modified the manner in which we handle Wireless coverage polygons.  

If a Provider submits a single geometry but specifies multiple spectrum codes in use in that 

polygon, we duplicate the polygon for each spectrum code.  In other words the geographic 

object is identical but the attribute data for the object is unique. 

13. In point level data submissions (Service Address and CAI) we note points that are spatially 

coincident.  With respect to Service Address points our thought is these represent multi-unit 

dwellings or businesses but we don’t have enough address detail to determine if these are 

multi-unit structures or duplicated customers.  Because we cannot determine the reason for the 

duplication we leave spatially coincident records in our submission.  We also leave in our CAI 

submission points which may be the same physical structure but have slight variations in 

addressing. 

14. In point level middle mile data, we are finding a variance in the quality of the geocoded 

longitude and latitude returned.  Given the data received we are unsure if this is an issue where 

the plant address is difficult to geocode or if the longitude and latitude provided to us  is 

different than what would be returned in geocoding. 

15. We note two important issues in our datapackage.xls.  First the number of records in the 

provider tab will not sum up to the total record count.  This is due to the requested grouping 

within the Excel table..  Second for estimated broadband coverage, we internally mark that 

coverage as an estimate but the provider is described as non-responsive within the 

datapackage.xls. 

16. We made one modification to the NTIA supplied verification script.  For the CAI layer we The 

query to check the TRANSTECH field now includes: "AND TRANSTECH <> -9999" 
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Appendix Two 
This appendix contains the confidentiality clarification supplied in a series of emails between CostQuest and NTIA. 

Feature Class Metadata NOFA 
Confidential? 

Online Map Public 
Disclosure 

Exemption 

Last Mile Constraints on accessing and using the data Yes No No None 

  Access constraints: None      

  Use constraints:       

  This data is confidential as defined in the 
NOFA. 

     

            

Middle Mile  Constraints on accessing and using the data Yes No No None 

  Access constraints: None      

  Use constraints:       

  This data is confidential as defined in the 
NOFA. 

     

            

Service Address Constraints on accessing and using the data No No Yes   

  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users.  

     

            

CAI Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 
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  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users.  

     

            

Census Block Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 

  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users. 

     

            

Service Overview Constraints on accessing and using the data No Yes Yes The only 
provider 
who may 
not show 
up this 
table is a 
provider 
who has 
provided 
only 
confidential 
data (last 
mile, 
Middle 
Mile, 
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address 
point with 
provider 
name) 

  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users. 

     

            

Road Segment Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 

  Access constraints: None.      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users. 

     

            

Wireless Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 

  Access constraints: None      

  Use constraints:       
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  There are no restrictions on distribution of 
the data by users 
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Connect Arkansas 
Connect Arkansas, a private, non-profit, is implementing a community-based initiative to promote 

internet access and education. The Connect Arkansas Broadband Act was signed into law by 

Governor Beebe on March 28, 2007, to ensure the creation of a competitive broadband, or high 

speed internet, infrastructure that will not only improve personal lives, but also the economic 

capabilities and of all Arkansans. 

To facilitate statewide broadband access, Connect Arkansas, a "delivery platform neutral" entity 

focuses on three major components: Determination of existing broadband infrastructure in Arkansas, 

Education, and Accessibility to computer devices. The first of these components, determining 

existing infrastructure, facilitates the requirements of the SBDD Program adequately. 

Identification of Broadband Providers 
As of September 1st, 2011, Connect Arkansas has identified by Holding Company name Eighty-Two 

(82) Broadband Providers in the state of Arkansas. These providers are identified as having 

infrastructure in the state and are not identified as being resellers. Of these providers, Seventy-Four 

(74) submitted to Connect Arkansas at least partial data to map coverage. Of the remaining eight (8) 

Broadband Providers, three (5) have agreed to provide data in the future. HortonTv and Batesville 

Computing are two (2) fixed wireless providers discovered following the Spring 2011 Data 

Submission.  

Data Collection and Processing 
For the Fall 2011 data set all providers were contacted first via mail, then email, and finally with 

telephone calls to the point of contact for each company. Thirty (30) companies updated coverage 

information as far as speed or coverage area. The other Forty-Four (44) participating Broadband 

providers chose to display data as unchanged from the Spring 2011 NTIA Data Submission. 

The format of data collected has been in various formats as listed below: 

ArcGIS Shape files 
Tab delimited files of Address Ranges 
Tab delimited files of Addresses 
Physical maps of coverage 
Tower information for propagation 
 
Shape files were easily formatted to conform with standards in the SBDD Data Model. 

All census blocks and tigerlines (used for address range and address points) are based on the 2010 

U.S. Census. 



All tab delimited address files were geocoded using the ESRI geocoding engine in ArcGIS. These 

geocoding passes were used against the standard ESRI database, as well as U.S. Census Tigerline 

data, and Arkansas Geographic Information Office's Street Centerline and Address Points. In the 

rural areas of Arkansas the accuracy of geocoding is much lower than in urban areas. To help 

remedy this, Connect Arkansas reviewed the geocoding results with each provider, giving each the 

opportunity to correct any issues. Note: any geocoding results that fell outside of a providers existing 

telephone exchange or know service areas were discarded. From these results, nearest road 

centerlines or census blocks (less than 2 square miles) containing the geocoded points, were 

selected to represent the Broadband Providers Coverage. Note: only two (2) Broadband Providers 

provided data at the address level.  

Any physical maps of coverage (including those submitted in pdf format) were used as a basis to 

manually select line segments from existing road centerlines in the state (based on U.S. Census 

Tigerline data). From these results census blocks (less than 2 square miles) that contained the 

digitized road centerlines were selected along with the road centerlines in areas of larger census 

blocks, to represent the Broadband Providers Coverage. 

Beginning with this submission, in census blocks greater than 2 square miles, that also have had 

address points have been completed by Arkansas Geographic Information Office, Connect extracted 

and submitted the address points that corresponded to the adjacent street segments as produced 

based on the Broadband Provider's submitted data. 

Fixed Wireless tower information (including Latitude, Longitude, Frequency, Power, Height) were 

gather and entered in to EDX Signal software to model signal propagation. This software also took 

into consideration terrain elevation as well as ground clutter to accurately model the Broadband 

signal, in most cases to a twenty (20) meter degree of accuracy. These raw propagation models 

were processed in ArcGIS into more organically smooth shapes to conform with standards in the 

SBDD Data Model. 

The results of the processes above were loaded into the SBDD Data Model and the latest 

CheckSubmission script was run. All resulting failed processes were analyzed and addressed to 

result in No Fails in Census Blocks, Road Segments, Addresses, or Wireless Coverage data sets. 

Middle Mile information that was received (most Broadband Providers view Middle Mile as 

proprietary information and elected not to submit) as tab delimited text files or as a spread sheet in 

Microsoft Excel. This information was brought into ArcGIS, processed, then formatted to conform 

with standards in the SBDD Data Model and uploaded. 

Community Anchor Institution data is information received from 3rd party sources in regards to 

institutions as outlined in the NOFA. Most of the data collected is from phone surveys to each 

location. In some cases difficulties were presented in finding a suitable technical point of contact to 

collect information. Arkansas Department of Information Systems has agreed to help provide 

information for public schools as well as HITArkansas for Health Systems, in future submissions. 

Only Community Anchor Institutions that could be geolocated were included. Arkansas Department 

of Information Systems has also informed Connect Arkansas that every K-12 school in Arkansas is 

connected with at least a T1 ADSL connection. In cases where phone surveys found additional 

connections or higher speeds this was submitted. Connect Arkansas is also including commercial 

locations with publically available broadband (typically via WiFi).  



Verification Processes 
Connect is currently using several methods to verify data collected. The format of data collected has 

been in various formats as listed below: 

Telephone surveys 
FCC released Form 477 data 
Telephone Exchange Boundaries 
Data collected from feedback on maps.connect-arkansas.org 
Data collected from speed tests on www.connect-arkansas.org 
Speed test data released from Broadband.gov 
Spot field validation of Wireless technology 

General Notes 
All Census Block data is 2010 vintage, and all Road Segments are based on Tigerline 2010.  

Connect continues to identify small providers, in particular fixed wireless providers that do not 

advertise or have a web presence. It is possible that several more of these providers will be 

identified in future data submissions. 

It should be noted that in some cases relating to Cable Companies in Arkansas several of these 

described their Broadband Coverage area as "all streets within XX city limits".  

Several Cable companies in Arkansas currently report technology of DOCSIS 3.0, although the max 

speeds offered are well below the capabilities of the technology. The reason for this is the lack of 

demand for higher speed tiers in their locations. The providers that fall in this category are Clinton 

Cable Inc., Conway Corporation, Fusion Media, Ritter Communications, and Suddenlink. 

The majority of Broadband Providers Submitted Maximum Advertised Speeds at the MSA/RSA level, 

or overall coverage areas which in some cases represent a large portion of land, in some cases 

several counties. At the direction of Andrew MacRae with NTIA, Connect Arkansas has pushed 

these speeds down to the census block and road segment level. Some inaccuracies can be seen in 

the data as actual Maximum Advertised Speeds in some cases vary from zipcode to zipcode in 

some cases. Also at the direction of Andrew MacRae, in the case of large providers, Connect 

Arkansas attempted to obtain the max advertised speeds from the Broadband Providers' websites; 

the results of which follows: 

CenturyLink 

CenturyLink provide a system to check availability and speeds at address level. CenturyLink’s 

system allows users to select city, street, and address in sequence via drop down lists. After making 

these selections the user is brought to page that display Max Available Download speeds for that 

address. Upload speeds are not mentioned. The download speed is then recorded in the 

spreadsheet that has been provided for this purpose. 

This process captured roughly half the cells. The remaining cells were then checked to see if there 

were duplicates in the spreadsheet and then filled in by researching the city associated with the ZIP 

code and checking it against the list of cities CenturyLink provides and filled accordingly. This 

process still leaves some ZIP codes with the appearance of being unserved. The speeds for these 

remaining areas were then based on speeds submitted on the MSA/RSA level. 



AT&T 

AT&T has a way to enter your ZIP code on their website while looking at the services they offer. 

However, changing the ZIP code doesn’t actually change the displayed services resulting in the 

premium U-Verse package being displayed for all areas including those that outside AT&T’s wireline 

service. As such, any data extracted from AT&T’s website is far less accurate than the speeds 

submitted on the MSA/RSA level. At the direction of Andrew MacRae, Connect also approached the 

mapping contact with ATT about more granular data, which the response was that all states received 

the same format of data and no additional data would be provided. 

 

Windstream 

Windstream’s method for changing geographic location while browsing service packages on their 

website is quite easy to use, but it doesn’t change any plan offerings. That is to say, the exact same 

3, 6, and 12 Mbps packages are listed for every city chosen from their provided drop down menu. 

The data provided to Connect Arkansas by Windstream is considerably more accurate than that of 

the website. The speeds for these areas were then based on speeds submitted on the MSA/RSA 

level for Spring 2011, as Windstream declined to send new data at this time.  

 

Cox 

The location mechanism on the Cox website would not respond in any attempts to change it. That 

being said, the only download speed shown was done so in a general overview of all plans offered. 

No actual location dependant information was shared. The speeds for these areas were then based 

on speeds submitted on the MSA/RSA level. 

Allegiance 

Allegiance provides a list of all the cities they serve on their website, which then shows you the 

offered services for those areas. Download/Upload speeds were recorded for the areas that had 

internet services available. 
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OVERVIEW 

This white paper highlights the Submission Summary for this deliverable, as well as describes the Data Gathering, 
Data Integration, Data Validation and Verification and Quality Control processes used to create the Broadband 
Mapping Project’s October 1, 2011 data submission. To support varying levels of technical and program 
knowledge, both a high-level summary and a detailed process review are supplied. 
 

SUBMISSION SUMMARY 

PROVIDER DETAILS 

PROVIDER PARTICIPATION 

 Providers Included 

 ASTCA 

 Blue Sky 
 

 New Providers Since Last Data Submission 

 None 
 

 Non-Responsive/Non-Cooperative Providers  

 None 
 

 

 

 

COVERAGE AREA CHANGES 

 Provider Expansion 

 Blue Sky Communications:  Expanded their TT-41 coverage 

 ASTCA:  Expanded coverage into the Manuʻa islands 

 

 Coverage Footprint Reductions/Map Refinement -  
o None 

 

 

DATA CORRECTIONS 

 There were no data corrections required for this data submission 
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COMMUNITY ANCHOR INSTITUION (CAI) DETIALS 

OVERALL STATISTICS 

Community Anchor Institution - Categories 
Overall 
Count 

Transmission 
Technology 

Advertised 
Speed Down 

Advertised 
Speed Up 

Category 1 - School K through 12 49 0 0 0 

Category 2 - Library  1 1 1 1 

Category 3 - Medical/Healthcare 2 0 0 0 

Category 4 - Public Safety 4 0 0 0 

Category 5 - Universities/Colleges 1 1 1 1 

Category 6 - Other:  Government 26 7 7 7 

Category 7 - Other:  Non-Government  33 0 0 0 

Total 116 9 9 9 

 

 
 

CAI CHANGES 

 

 The only change for this data submission was the inclusion of the CAIID extracted from the three 
databases communicated by NTIA.  They are as follows: 
 

 For K-12 institutions (CAI type 1) please add the NCES ID CCD ID value found here: 

http://nces.ed.gov/ccd/bat/  

 

 For Higher Education (CAI type 5) please add the NCES IPEDS ID value found here: 

http://nces.ed.gov/ipeds/datacenter/  

 

 For Libraries (CAI  type 2) please. Combine (do not add) “FSCSKey” and “FSCs_SEQ” from the 

“puout08av2000” file and place them here: 

http://harvester.census.gov/imls/data/pls/index.asp (FYI the LIBID is your state’s unique ID 

for libraries) 

 

  

http://nces.ed.gov/ccd/bat/
http://nces.ed.gov/ipeds/datacenter/
http://harvester.census.gov/imls/data/pls/index.asp
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SUBMISSION RECEIPT 

SUBMISSION RECEIPT RESULTS 

 Attached are the results from the NTIA data submission receipt quality script. 
  

 
 Error Report 

 No errors were reported 
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HIGH-LEVEL SUMMARY 

DATA GATHERING 

BROADBAND SERVICE AREAS, MIDDLE MILE AGGREGATION POINTS AND 
BROADBAND SERVICE OVERVIEW 

The collection of Broadband Service Areas, Middle Mile Aggregation Points and Broadband Service 
Overview information is handled through the following Provider Outreach Process: 

 Build and maintain an inventory of Broadband providers through research and State inputs. 

 Update provider material that describes the data requirements and logistics for data transfer. 

 Update Non-Disclosure Agreement (NDA) for use in project, where applicable. 

 Maintain multiple protocols for the provider to submit data, including Secure File Transfer 
Protocol (SFTP) technology when desired. 

 Conduct one-on-one informational discussions with each provider to communicate the following: 
o Requirements of this project; 

o Broadband data required to support the product data model; 

o Submission protocols available; 

o Capability to validate how the supplied data is aggregated. 

 Download/receive provider data. 

 Establish a repeatable process with provider. Maintain provider communication, transaction and 
data handling records throughout the project (dates contacted, data received, etc.).  

 

COMMUNITY ANCHOR INSTITUTION (CAI) 

The collection of CAI information is handled through the following CAI Collection Process: 

 Collect and maintain inventory of CAIs through data mining, research and State inputs. 

 Maintain web-based CAI portal for institutions to add or confirm attribution, location and enter 
broadband-specific information. 

 Upload web-based data to Core Database for standardization. 

 Perform internal cleansing, such as removing duplicate records, identifying gaps in broadband 
attribution and verifying category. 

 Geocode CAI locations. 

 Translate Core Database data to deliverable-ready format. 

 Continue engagement with non-responsive institutions. 
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DATA INTEGRATION PROCESS 

The data integration and processing mechanisms currently used allow for multiple types of inputs and result in 
a standardized output that meets the NTIA deliverable requirements. This flexible process supports data 
model changes and project-requested enhancements. 

 Receive inputs from providers via submission protocols; upload into Sourcing Database and catalog 
with provider information. 

 Review provider-supplied data for completeness and for potential discrepancies that require 
resolution prior to processing and flag as necessary. 

 Categorize input into data-type category (addresses, block lists, paper maps, etc.). 

 Standardize input based on data type within Staging Database. 

 Create Compact Polygons (CP)—(internal methodology for generating area-based feature for 
coverage in Staging Database). 

 Apply broadband attribution to CP; apply metadata to CP. 

 Perform quality analysis of the CP against the source supplied to identify any completeness or 
accuracy issues. 

 Request additional information from the provider if elements of coverage are missing or contain 
discrepancies. This is a second manual quality check to ensure data is complete. 
o Process coverage area to build the required NTIA data model layers.  

 Process CAI data input into internal standardized format, as discussed above in the Community 
Anchor Institution (CAI) subsection, based on NTIA and State-level requirements. 

 

DATA VALIDATION AND VERIFICATION 

Following the creation of the product, process steps within Data Validation and Verification occur. To ensure 
the data collected and processed is as accurate and comprehensive as possible, provider validation and 
internal verification activities are employed. After the initial mapping of providers’ coverage areas and 
serviceability claims, additional reviews are performed using the methods described in the subsections below 
(Third-Party Data Verification, Broadband Provider Validation, Confidence Values). 
 

THIRD-PARTY DATA VERIFICATION 

The coverage is visually and programmatically compared against third-party data. Pitney Bowes and 
American Roamer data are used in cases where a coverage area is questionable. All anomalies identified 
during this analysis are reviewed with the providers. 

 

BROADBAND PROVIDER VALIDATION—PROVIDER PORTAL APPLICATION 

Providers are trained on and requested to use a secure interactive web application to review their current 
coverage area(s) and supporting broadband attribution and validate their data or submit change requests 
to update their data. All provider change requests go through the Data Integration Process and are 
reviewed with the provider to complete validation. 
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CONFIDENCE VALUES 

All verification, validation and manual quality review results are tracked by provider/technology type and 
stored and maintained within a Validation table. A confidence value is assigned, based on internal 
assessments of the collected information, to highlight the provider coverage areas and/or attributions 
that would benefit from further investigation and/or enhancements. 

 

QUALITY CONTROL 

Following collection, processing and analysis of the provider and CAI data, the product is checked manually 
and algorithmically against the NTIA data model. Some of the items included within these checks are: 

 Format correctness; 

 Table and field structure; 

 Valid values, including default values, where applicable; 

 Geographic extent and topology errors. 
 
Prior to data submission, another quality control script supplied by NTIA is run. This script, 
SBDD_CheckSubmission.py, creates an output in text form that is required to be submitted along with the final 
deliverable. All errors must come up clean, unless otherwise specified by NTIA. Exceptions to the script as 
noted by NTIA on the SBDD Workspace on 03/25/11 can be found at the following link: https://sbdd-
granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions  

 Longitude values for States outside the lower 48 (any table); 

 CAI results for Transtech, MaxAdUp, MaxAdDown if BBService is “No” or “Unknown”; 

 Overview MaxAdDown, MaxAdUp if 100% of record-level data has MaxAdDown or MaxAdUp 
populated. 
  

https://sbdd-granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions
https://sbdd-granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions
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DETAILED PROCESS REVIEW 

A detailed review of the data collection, integration and quality control points within the broadband data gathering 
and mapping process are discussed in the subsections that follow. In addition, a diagram showing the overall 
process can be seen below. 

 
 

PROVIDER OUTREACH 

For the October 2011 data submission, an e-mail notification was sent to all providers with supporting 
deliverable dates. The providers mainly used the Provider Portal web application to submit changes to and/or 
validate their current coverage area(s). 

 
In support of the data collection effort, providers that did not timely respond to the outreach were contacted 
by phone. 
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OUTREACH MATERIALS 

The original provider packet sent via e-mail to the providers included the following documents and files: 

 Letter from the State inviting them to participate in the program; 

 Copy of the Non-Disclosure Agreement (NDA); 

 Copy of the Mapping NOFA from the NTIA; 

 Copy of the NOFA Clarification from the NTIA; 

 Broadband service address example file in CSV format; 

 Word document describing service address example file; 

 Broadband service block example file in CSV format; 

 Word document describing service block example file; 

 Broadband service street example file in CSV format; 

 Word document describing service street example file; 

 Broadband subscriber example file in CSV format; 

 Word document describing subscriber example file; 

 Broadband wireless coverage area sample shapefile; 

 Word document describing wireless coverage area sample shapefile; 

 Instructions for downloading, installing and using the WinSCP SFTP application. 
 

OUTREACH PROCESS 

The provider outreach process is comprised of the following general steps: 

 Send the provider package and introduction letter to the main point of contact for the provider. 

 Follow up with e-mail and telephone to verify that the main point of contact is correct. 

 If necessary, discuss the NDA further and resolve any redlines. 

 Once the correct primary contact is established, set up a telephone call, if necessary, to learn more 
about the provider’s offerings and direct them to the appropriate outreach materials. 

 If providers are unable to be contacted (non-responsive) or indicate that they are not interested in 
participating (non-cooperative), mark them as such on the provider tracking sheet. These providers 
will be escalated to the State for further action. 

 As the providers are collecting the required data, provide instructions on downloading, installing and 
using the WinSCP SFTP application, if required. 

 Arrange with the providers to transfer the data in whatever way they are comfortable: some 
providers will find regular email acceptable; others will want to use the SFTP application. 

 After data is received and reviewed, it may be necessary to contact a provider for clarification or to 
address incomplete datasets. In the interest of building and maintaining relationships, care is given 
not to push the provider but to work with it to obtain accurate data in the best possible format. 
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DATA COLLECTION 

DATA TRANSFER PROCEDURES 

There are three primary ways data is collected from providers. These are: 

 Secure FTP (SFTP) using the WinSCP application; 

 Regular e-mail; 

 Mail. 
 

INITIAL DATA REVIEW AND QUALITY ASSURANCE 

The initial data review and quality assurance process consists of the following general steps: 
1) Access the data from the SFTP site or e-mail. 

a. If e-mailed, place copy of original dataset in the appropriate provider folder on the SFTP site. 
2) Place copy of raw data on local computer in a working directory. 
3) Review data and determine course of action based on type of data received. 
4) Ensure data is complete and contact provider to address any gaps. 

 

NOTE: 
The goal is to get as many providers as possible to provide subscriber address data in the correct format. 
Obviously, this will not be possible with all providers so we will continue to have to process various types of 
provider-supplied data. 

 

DATA INGESTION 

DATA INGESTION OVERVIEW 

The following subsections outline the process steps taken based on the type of input supplied by the data 

provider: 

 Point Data: 
o Subscriber location; 
o DSLAM location; 
o Central Office location; 
o Broadcast Tower location. 

 Linear Data: 
o TIGER® street segments. 

 Polygonal Data: 
o Census Blocks; 
o Coverage Area. 

Overall, the process is geared toward taking the provider data supplied and creating polygon shapes to 
append to the bb_cov feature class. The bb_cov feature class is the interim dataset that is then processed 
using the makeDeliverable.py Python script to create the MapConnect

TM
 data layers that will be delivered 

to the State and, ultimately, to the NTIA. Detailed instructions used in this process can be found in the 
subsections below. 
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POINT DATA 

SUBSCRIBER LOCATION—ADDRESS DATA 

In the event that the data provider supplies subscriber address data, the steps are as follows: 
1) First, convert the address data to a clean Excel spreadsheet in an appropriate address data 

format. 
a. Usually, this has the following columns: street address (number, pre-directional, pre-

modifier, street name, street type, post-directional and post-modifier concatenated), city, 
state, ZIP. 

2) Configure the ArcGIS® geocoding tool to use the TIGER® 2009 streets dataset. 
a. In ArcCatalog®, create a new Address Locater by right-clicking in the white space of the 

appropriate directory and selecting New>Address Locater from the dropdown menu. 
b. Select US Streets with Zone and click OK. 

 

NOTE: 
It is likely that multiple Address Locators will have to be set up to handle the variety of provider address data 
received. 
 

c. Navigate to the TIGER Streets 2009 file and click OK. 
d. Fill in the dialog box, as shown below: 
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e. Click OK. 
3) Open ArcMap® and add the Excel spreadsheet with the address information. 
4) Right-click on the Excel spreadsheet and select Geocode Addresses from the dropdown menu. 
5) Select the appropriate address locator by clicking Add…, then OK. 

 

6) Fill out the Geocode Addresses dialog box, as shown below: 

 

7) Geocode the list in batch mode using the geocode service set up in Step 2 above, accepting all 
the default parameters. 

8) Review results. See example below. 
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9) Adjust geocoding parameters accordingly and repeat batch to resolve issues. 
10) Manually geocode unmatched addresses until target hit rate achieved, generally 90%. 
11) Visually inspect the data, as shown below: 

 

12) Follow the steps detailed in Subscriber Location—GIS Data below. 
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SUBSCRIBER LOCATION—XY DATA 

If the provider supplies a list of subscriber data with accompanying XY data such as latitude and 
longitude, the steps are as follows: 

1) Refine the format in Excel so that the data can be opened easily using ArcMap®. 

a. Remove all font color, highlighting, cell colors and borders, clean up column headers and 
make certain there are no merged cells. 

b. Make certain that XY locations are in decimal degrees. 
(i.) To convert from degrees, minutes, seconds (39º 26’ 45.67”) to decimal degrees, use the 

following formula: DD + (MM/60) + (SS.SSS/3600). 
 

NOTE: 
If XY locations from some other coordinate system are provided, you can use those in the process below but you 
must know what the coordinate system is. 
 

2) Open the Excel worksheet in ArcMap®. 

3) From the menu bar, select Tools>Add XY Data… 

 

4) Supply the appropriate fields for the X and Y coordinates, choose the appropriate coordinate 
system and click OK. 

5) Results are an event layer, not a true spatial layer. Export the data by right-clicking the event 
layer and selecting Data>Export Data… from the dropdown menu. 

6) Follow the steps detailed in Subscriber Location—GIS Data below. 
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SUBSCRIBER LOCATION—GIS DATA 

If the provider supplies subscriber location in GIS format, the only process step is to load that data 
into the appropriate data schema and it will be ready for processing. 
1) First, load the data into the Point Address database schema using an empty feature class in that 

schema. 

2) In ArcCatalog®, right-click on the empty feature class and select Load from the dropdown menu. 

3) Navigate to the provider address GIS dataset and then map the attribute fields accordingly, as 
shown below: 

 

4) Once you have successfully loaded the provider address data into the temporary database with 
the correct schema, you now will append that data to the overall Point Address database. 

5) In ArcToolbox®, use the Append command (Data Management Tools>General> Append) to add 
the features into the overall Point Address database, as shown below: 
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6) Since the data is already in the Point Address database schema, there is no need to alter the Field 
Map in the Append tool. 

7) After appending, calculate metadata reflecting geometry source and representation values. 
8) Break provider-specific points into separate county feature classes and perform the following 

steps per county feature class: 
a. Within ArcGIS®: 

(i.) Summarize download and upload speeds [first,last] to determine all speeds available for 
county. 
(1) This will save as a DBF table. Keep track of location for future reference. 

(ii.) Buffer county address point featureclass to 150’. 
(1) During buffer command, dissolve on ad_down; ad_up; provider; dba; frn; tt; all 

metadata fields; stctyfips. Save as…. county_fastestdown_fastestup.  
(2) Example using Qwest data: boulder_40128_20128, where boulder=county; 

40128=ad_down; 20128=ad_up. 
 

NOTE: 
These attribute fields are specific to the Point Address database. 
 

(iii.) Select the features that represent the lowest speeds. 
b. Using XtoolsPro (http://www.xtoolspro.com/): 

(i.) In the XTools Pro toolbar, select XTools Pro>Layer Operations>Erase Features. 
(ii.) Use the same feature class for Input and Overlay. 
(iii.) Check Use selected features on the Input feature, as shown below. 
(iv.) Repeat and erase slowest speeds one speed at a time. Save each new feature class as 

the next slowest speed, using the same naming convention as shown in a.(ii.)(1) above. 
A general example is shown below: 
  

http://www.xtoolspro.com/
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c. Return to ArcGIS®: 
(i.) Edit/delete speeds from the attribution table of each feature class, so each remaining 

feature class has only one speed value. 
(ii.) Merge individual speed feature classes using the Merge command in ArcToolbox® (Data 

Management Tools>General>Merge). The dialog box is shown below:  

 

(iii.) Merge individual county feature classes using the Merge command in ArcToolbox (Data 
Management Tools>General>Merge). 

(iv.) Since the county files are all in the same schema, DO NOT alter the Field Map portion of 
the command interface. 
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(v.) When all the county files are merged into one dataset, use the Append command in 
ArcToolbox® (Data Management Tools>General>Append) to add the features to the 
bb_cov interim dataset. Use the Field Map portion of the Append tool to map the 
appropriate field values to their corresponding fields in the bb_cov feature class. 

DSLAM OR CENTRAL OFFICE LOCATION—ADDRESS DATA 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central 
Office address data, the steps are as follows: 
1) Follow the process for geocoding points in Subscriber Location—Address Data above. 
2) Follow the steps detailed in DSLAM or Central Office Location—GIS Data below. 

DSLAM OR CENTRAL OFFICE LOCATION—XY DATA 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central 
Office XY data, the steps are as follows: 
1) Follow the process for creating points from XY data in Subscriber Location—XY Data above. 
2) Follow the steps detailed in DSLAM or Central Office Location—GIS Data below. 

DSLAM OR CENTRAL OFFICE LOCATION—GIS DATA 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central 
Office GIS data, the steps are as follows: 
1) Buffer the DSLAM/Central Office points feature class. 

a. Add the point feature class to ArcMap®. 

b. Open the ArcToolbox® and go to Analysis Tools>Proximity>Buffer. 

c. Set the buffer distance to 5 miles. 
d. Set the dissolve type to ALL. 
e. Name the output feature class. 
f. Typical Buffer tool is shown below: 
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g. Click OK. 

2) Use the resulting buffer feature class to clip the TIGER® street layer: 

a. Add TIGER® street layer to ArcMap®. 

b. Open the ArcToolbox® and go to Analysis Tools>Extract>Clip. 

c. Complete the dialog box as shown below: 

 

d. Click OK. 

3) Using ArcCatalog® and within the file geodatabase: 

a. Right-click and create a new Feature Dataset.  
(i.) For the Feature Dataset settings: 

(1) Name the feature dataset accordingly. 
(2) Select horizontal coordinate system by importing the coordinate system associated 

with the clipped TIGER® street layer by selecting Import and navigating to the 

location of that feature class. 
(3) No vertical coordinate system needed. 
(4) Leave all x,y,z,m values at default. 
(5) Click Finish. 

4) Import previously created street feature class into new Feature Dataset. 
5) Right-click Feature Dataset and create new Network Dataset—accept all default setting for the 

Network Dataset. 
 

NOTE: 
The Network Analyst extension must be turned on. 
 

6) In ArcMap® turn on the Network Analyst Toolbar by going to View>Toolbars>Network Analyst. 

7) Add the Network Dataset created in Step 5 to ArcMap. 
8) Using the Network Analyst Toolbar dropdown, create New Service Area. 

9) Open the Network Analyst Window by selecting the  button. See below. 
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10) Right-click Facilities layer, select Load Locations and navigate to the DSLAM/Central Office 
facilities feature class. 

 

11) Click OK. 

12) Click the Service Area Properties button . 
13)  For the following tabs, change the following properties: 

a. Polygon Generation tab:  
(i.) Select Merge by break value.  
(ii.) Also disable the Trim Polygons option. 

b. Analysis Settings tab—using and converting the specified DSLAM buffer distance from feet 
to meters—input buffer distance value in meters into the Default Breaks location. 
(i.) Generally, 18,000 feet (5486 meters) from DSLAM or Central Office location is used as 

the buffer distance. See below. 



                                                                                   

       Version 2.0         September 2011 Author: Kristin Rousseau 
       Page 24 

 

c. Click OK. 

14) On the Network Analyst Toolbar, click the Solve button  to create service area polygons. 
15) Right-click on the created service area polygon in the layer list, and select Data>Export Data from 

the dropdown list. 
16) Export to a feature class in the file geodatabase you created earlier. 

17) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the feature class created in Step 16 into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click the Add button, then click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 
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e. Click Next, then Next again, then Finish. 

18) In ArcToolbox®, go to Data Management Tools>General>Append. 

19) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 

 

20) Leave the Schema Type as TEST. 
21) Click OK. 

22) In ArcMap®, open bb_cov for editing and manually input associated attribution. 
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BROADCAST TOWER LOCATION—ADDRESS DATA 

In the event that the provider supplies wireless broadcast tower location address data, the steps are 
as follows: 
1) Follow the process for geocoding points in Subscriber Location—Address Data above. 
2) Follow the steps detailed in Broadcast Tower Location—GIS Data below. 

BROADCAST TOWER LOCATION—XY DATA 

In the event that the provider supplies wireless broadcast tower location XY data, the steps are as 
follows: 
1) Follow the process for creating points from XY data in Subscriber Location—XY Data above. 
2) Follow the steps detailed in Broadcast Tower Location—GIS Data below. 

BROADCAST TOWER LOCATION—GIS DATA 

In the event that the provider supplies wireless broadcast tower location GIS data, the steps are as 
follows: 
1) Download the required software (Radio Mobile) from the website: 

http://www.cplus.org/rmw/english1.html  
2) Install the software according to the standard directions, found here: 

http://www.cplus.org/rmw/download/download.php?S=1  
3) Open the application. 
4) Load the broadcast tower location and elevation information by selecting File>Unit properties. 

The following dialog box appears: 

 

5) Add the information for all the towers supplied by the WISP data provider, including the 
elevation. If provider does not supply elevation, this information can be obtained from Google 
Earth. 
a. If available, use the Import button to import a Google Earth KML of the tower locations. 

6) Go to the National Map Seamless Server (http://seamless.usgs.gov/) and download elevation 
data sufficient to contain the tower locations. 

http://www.cplus.org/rmw/english1.html
http://www.cplus.org/rmw/download/download.php?S=1
http://seamless.usgs.gov/
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a. At least the 1/3” NED data is needed. Select this by clicking the Download button in the 
upper right of the website and checking the box next to 1/3“ NED. 

b. Zoom to the area of interest and use the Download tools to define the area to download: 

 

c. Click the Modify Data Request button to request the data in BIL_16INT format, not ESRI 
GRID, as shown below: 

 

d. Download the data and unzip it. 
7) Select File>Map Properties to define the map. 
8) Enter a latitude and longitude in the center of the tower locations. 
9) Set the size (in pixels) and the size (in kilometers) of the map. 
10) Set the directory path leading to the BIL elevation data just downloaded. 
11) The dialog box is shown below: 
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12) Click Extract. 
13) The elevation data is rendered as a hill shade, as shown below: 

 
14) Select File>Network properties from the main menu. 
15) Create a new network and enter in the frequency range under the Parameters tab, as shown 

below: 
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16) Leave all the other values as they appear, and select the Systems tab. 
17) Create enough systems to cover all the varieties of equipment in the provider network. This will 

include the antenna type, height and line loss, as shown below: 

 
 

18) Now click on the Membership tab, and assign the individual towers to their respective systems, 
providing the azimuth for non-omnidirectional antennas, as shown below: 
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19) Click OK. 
20) Select Tools>Radio Coverage>Combined Cartesian from the main menu. 
21) Complete the dialog box as shown below, providing the Maximum Range from the highest tower 

beam radius supplied by the provider. 
22) Set the Pixel Size at 5 (experiment depending on the area covered to get the right level of 

granularity), as shown below: 

 
23) Set the Signal range to draw to S-Unit and type 5 in the From (>=) box. 
24) Click on Draw. See below. 
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25) Save the resulting image as a TIF by selecting File>Save Picture as. 
26) Open ArcMap® and load the BIL elevation data you used in Radio Mobile. 
27) Load the TIF image you created and georeference it using the corners of the BIL data. 

a. The corners of the data can be seen in the TIF image. 
28) Follow the georeferencing directions from the Coverage Area—PDF/JPG/Other Image Format 

section below. 
29) Use the Georeferencing Toolbar to Update the Georeferencing for the TIF dataset. 
30) In ArcToolbox®, select Data Transformations>From Raster>Raster to Polygon and input the 

georeferenced TIF you just created, as shown below: 
31) Open the resulting polygon feature class for editing using the Editing toolbar in ArcMap® and 

clean up as necessary. 
32) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the feature class created above into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click the Add button, then click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 
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e. Click Next, then Next again, then Finish. 

33) In ArcToolbox®, go to Data Management Tools>General>Append. 
34) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 

 
35) Leave the Schema Type as TEST. 
36) Click OK. 

37) In ArcMap®, open bb_cov for editing and manually input associated attribution. 
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LINEAR DATA 

TIGER® STREET SEGMENTS—LIST, SPREADSHEET OR GIS DATA 

In the event that the provider supplies TIGER® street segments in list or spreadsheet format, the 
steps are as follows: 
1) Join TIGER® road segments to 2000 census blocks feature class using one of two methods based 

on how the data is provided: 
a. If the TIGER® data is provided with a Census Block ID, then join the segments to the Census 

Block geometry based on that ID: 
(i.) Load both datasets into ArcMap®; 
(ii.) In the layer list, right-click on the 2000 census block feature class and select Joins and 

Relates>Join; 
(iii.) In the dialog box, select the TIGER® road segments data and the proper attribute fields 

for joining, as shown below: 

 
(iv.) Click OK. 

b. If the data provided is a list containing TLIDs, then join to the TIGER®/Line data using the 
TLID, and use a spatial join to associate the TIGER® segment with the coterminous block 
based on the block ID: 
(i.) Load both datasets into ArcMap®; 
(ii.) In the layer list, right-click on the 2000 census block feature class and select Joins and 

Relates>Join; 
(iii.) Select Join data from another layer based on spatial location from the dropdown 

menu; 
(iv.) Complete the dialog box, as shown below and click OK. 
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2) Export joined records into a temporary feature class. 
3) If joined Census Block geometry is confined to one specific area, then dissolve blocks into one 

record. If joined Census Block geometry is distributed throughout a particular State, then dissolve 
sub-selections of census blocks for each county. 
a. Use the County FIPS code to dissolve by county. 

b. In ArcToolbox®, select Data Management Tools>Generalization>Dissolve. 

c. Complete the Dissolve dialog box, as shown below: 
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d. Click OK. 

4) For each dissolved region, open the feature class for editing using the Editing tool in ArcMap® 

and remove unnecessary slivers and other small holes. For general guidance on editing features 

in ArcMap®, see http://webhelp.esri.com/arcgisdesktop/9.3/pdf/Editing_Tutorial.pdf  

5) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the feature class created above into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click on the Add button, then click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 
 

http://webhelp.esri.com/arcgisdesktop/9.3/pdf/Editing_Tutorial.pdf
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e. Click Next, then Next again, then Finish. 

6) In ArcToolbox®, go to Data Management Tools>General>Append. 
7) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 

 
8) Leave the Schema Type as TEST. 
9) Click OK. 
10) In ArcMap®, open bb_cov for editing and manually input associated attribution if necessary. 
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POLYGONAL DATA 

COVERAGE AREA—PDF/JPG/OTHER IMAGE FORMAT 

In the event that the provider supplies coverage area data in some image format such as PDF or JPG 
format, the steps are as follows: 
1) If in PDF format, open in Adobe Acrobat and Save As… JPG format. 

2) Open the JPG image in ArcMap®. 

3) Add the required base map vector data for georeferencing. 

a. This generally will be either the CDOT data or TIGER® data. 

4) Change the coordinate system of the data frame to the desired end coordinate system. 
5) Zoom to the general location of the JPG map image. 

a. This is the location based on the vector data, not the JPG image itself. For example, if you 
know that the JPG image represents an area around the town of Limon, zoom to the town of 
Limon in your vector data. 

6) Open the Georeferencing toolbar by selecting View>Toolbars>Georeferencing from the main 
menu bar. 

7) Using the Georeferencing toolbar, select Fit to Display; results are shown below: 

 

8) Use the Control Point button  to add control points to the map. 
9) Use common points in the base dataset and the JPG image. 

a. For example, find major street intersections, county/city boundaries, etc. 
b. Try to distribute the points more or less in the four corners on the image for the best 

transformation. 
10) Click on the location on the image first, then click on the corresponding location on the vector 

database map, as shown in the image below: 
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11) After placing each control point, the image transformation will update automatically.  
12) Repeat until satisfied with the transformation. 

 

NOTE: 
The transformation may take up to four points, although sometimes only two are necessary. 
 

13) When satisfied with the transformation, select Update Georeferencing from the Georeferencing 
toolbar dropdown. 
a. This will create a “world” file (.jgw in the case of JPGs) in the same directory as the image 

file. 

14) In ArcCatalog®, create a new polygon shapefile with the appropriate data schema for a provider 

coverage area, which can be found in Appendix D. 

15) Add the shapefile to ArcMap®. 

16) Using the Editor toolbar, select Start Editing. Set the Task to Create New Feature. 

17) Use the Sketch Tool  to digitize a new coverage polygon using the coverage area outline 
from the georeferenced JPG and add the required attributes manually. 

18) Repeat the above steps for all subscriber speed coverage areas provided. 
19) Follow the steps detailed in Coverage Area—GIS Data below. 

COVERAGE AREA—KML/KMZ 

In the event that the provider supplies coverage area data in Google Earth KML or KMZ format, the 
steps are as follows: 

1) Use a KML to SHP converter to translate file into an Esri® format. 

2) http://arcscripts.esri.com/details.asp?dbid=15603  

3) Download the script and follow the provided instructions for installing it in ArcToolbox®. 

4) Double-click on the script in ArcToolbox® and navigate to the location of the KML file, as shown 

below: 
 

http://arcscripts.esri.com/details.asp?dbid=15603
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5) Add the new shapefile to ArcMap®. Repeat for all KML files provided. 

6) Follow the steps detailed in Coverage Area—GIS Data below. 

COVERAGE AREA—CAD DATA 

In the event that the provider supplies coverage area data in GIS format, the steps are as follows: 

1) Transform the CAD dataset into an Esri® format. 

2) http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datase
ts 

3) It may be necessary to contact the provider first to determine the coordinate system of the CAD 
data. 

4) If the CAD data is not in a standard coordinate system, it may be necessary first to use ArcMap® 

to georeference the CAD data to a known coordinate system. 
a) To do so, follow the instructions provided above in Coverage Area—PDF/JPG/Other Image 

Format. 

5) In ArcCatalog®, create a new polygon shapefile with the appropriate data schema for a provider 

coverage area, which can be found in Appendix D. 

6) Add the shapefile to ArcMap®. 

7) Using the Editor Toolbar, select Start Editing. Set the Task to Create New Feature. 

8) Use the Sketch Tool  to digitize a new coverage polygon using the coverage area outline 
from the georeferenced CAD file and add the required attributes manually. 

9) Follow the steps detailed in Coverage Area—GIS Data below. 

COVERAGE AREA—GIS DATA 

In the event that the provider supplies coverage area data in GIS format, the steps are as follows: 

1) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the GIS feature class either created above or supplied by the provider into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click on the Add button, then click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 

 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datasets
http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datasets
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e. Click Next, then Next again, then Finish. 

2) In ArcToolbox®, go to Data Management Tools>General>Append. 

3) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 

 
4) Leave the Schema Type as TEST. 
5) Click OK. 

6) In ArcMap®, open bb_cov for editing and manually input associated attribution, if necessary. 

COMPACT POLYGON FROM SUBSCRIBER POINTS  

1) Geocode address list using latest State Composite Locator.  
2) Verify that your geocoded file has only one TT (Technology Type). If not, export individual 

geocoded layers for each Technology Type. 
3) For each TT, check for differences in speed values or speed tiers and create separate layers for 

each speed value/tier. 
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4) Clean your geocoding results: remove any points that geocode to accuracy levels below ZIP+4 
(ZIP centroids, carrier route centroids, etc). Also, verify that outliers with acceptable accuracy 
levels are legitimate, i.e., fall in correct city and Zip. 

5) Perform spatial join between county polygons (using stcnyfips field) and the cleaned geocoded 
subscriber points in order to carry the county name and stcnty fips. 

6) Summarize the number of subscribers by county and use the subscriber counts by county to 
populate the Rate Tier table. 

7) Un-join the county data from the geocode subscribers list. 
8) Create Compact Polygon using cleaned geocoded layer or sub-selection of XtoolsPro—

ConvexHull-DetailedHull option. A sub-selection of geocoded points will be used in areas where 
more than one polygon will need to be created for one provider’s service area. 

9) Evaluate output Hull carefully, looking for areas that should not be covered by hull polygon. 
a. If it is determined that an area or areas should not be represented in coverage area, 

manually reshape hull polygon until coverage area is adequate. 
b. When not obvious and as a general rule, manually resolve compact polygon when the 

distance between the subscriber points used to define the outer boundary of the compact 
polygon exceeds 5 miles . When reshaping the hull polygon, snap to the outermost 
geocoded points. See the three figures below for examples. 

      Compact Hull: Manual Resolution Required            
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Compact Hull: Manual Resolution Required                                        Compact Hull: After Manual Resolution        

                      
10) To attribute the compact polygon, perform a spatial join where your Target Feature Class is the 

compact polygon and the Join Feature Class is your geocoded point layer. Export compact hull 
with joined attributes and name file appropriately. 

11) Append attributed compact polygon to Broadband TT template Feature Class and, if required, 
manually input any provider attribution that may not have carried over in the append process. 

12) Intersect compact polygon with county boundaries to create unique records by county and use 
the state-county-fips field to populate stcty_fips field. Also use the county name field to populate 
the BBCov_Name field. 
a. Exception: where a provider’s coverage is distributed throughout more than one area of any 

given county where the BBcov_Name should be populated using an appropriate city or other 
logical name based on geographical location. 

13) Export/load into appropriate BB TT model dataset. 

CENSUS BLOCKS—LIST OR SPREADSHEET 

In the event that the provider supplies census block data in a list or spreadsheet, the steps are as 
follows: 
1) Ensure block polygons supplied by the provider are 2000 currency. 
2) If other currency, convert to 2000 currency before proceeding. 

a. To do this, remove the trailing letter (a, b, etc.) from the block ID. 
b. You will now have two blocks that equate to one block in the 2000 block geometry. 
c. Delete duplicate block IDs, retaining the higher service tier in each case. 

3) Prepare the block list in clean Excel format, removing all Excel-only formatting, merged cells, 
colors, borders, etc. 

4) Import the spreadsheet into ArcMap®. 

5) Right-click on the 2000 census block feature class in the layer list in ArcMap® and select Joins 

and Relates>Join from the dropdown menu. Join the census block list to the 2000 census blocks 
feature class using the block ID and export joined records in a new feature class. The Join dialog 
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box and process can be seen above in the TIGER® Street Segments—List, Spreadsheet or GIS 

Data subsection. 
6) Follow the steps in Census Blocks—GIS Data below. 

CENSUS BLOCKS—GIS DATA 

In the event that the provider supplies census block GIS data, the steps are as follows: 
1) Ensure that the blocks supplied by the provider are in the required data schema and are 

complete as far as required attribution. 
a. If not, manually enter the required attribution or contact the provider to fill gaps. 

2) If census block geometry is distributed throughout more than one county, then select Data 
Management Tools>Generalization>Dissolve in ArcToolbox® and dissolve based on 
County/Provider/TT/Speed Tier so that unique records are created for each unique combination. 
a. The Dissolve dialog box is shown above in the TIGER® Street Segments—List, Spreadsheet 

or GIS Data section. 
b. Two examples of undissolved census block polygons are shown below: 

 
Undissolved census block polygons 

 
Census block polygons dissolved by county 

3) For each dissolved region use the Editing toolbar in ArcMap® to remove unnecessary slivers and 

other small holes. 
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4) In ArcToolbox®, select Data Management Tools>General>Merge and merge the processed 

polygons into a single layer. 
5) The merged census blocks will need to have the subscriber’s frn field added and populated. 

6) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the GIS feature class either created above or supplied by the provider into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click the Add button, the click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 

 
e. Click Next, then Next again, then Finish. 

7) In ArcToolbox®, go to Data Management Tools>General>Append. 

8) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 
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9) Leave the Schema Type as TEST. 
10) Click OK. 

11) In ArcMap®, open bb_cov for editing and manually input associated attribution, if necessary. 

 

METADATA TRANSACTIONS 

Following any updates or changes completed within the file geodatabase (fGDB) stored on the GIS-Analysts 
staging environment, the GIS-Analyst runs transactions to compare that fGDB with the one stored on the Core 
server to ensure metadata on all changes is recorded. 

 
The steps taken to run transactions on the updated Core database are outlined below: 

1) Open a command line window and run generateTransactions.py:  
a. Usage: generateTransactions.py  [Core fGDB] [Staging Environment fGDB]  
b. Example of command line:  

<path>generateTransactions.py <path>ST_BB_POLY_SRV_AREAS.gdb <path>ST_BB_POLY_SRV_AREAS.gdb  
2) Shown below is an example of the output screen that will be displayed: 
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3) After the process has completed, results can be found in the ST_BB_POLY_SRV_AREAS_HIST.gdb:  

a. The transactions scripts records changes at a feature level. 
b. Shown below is a screenshot supporting the directory structure of the historical fGDB. 

 
c. Attribution associated with each added/removed/changed feature is tracked, including the 

following additional columns appended to the end of each: 
(i.) Commit_by 
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(1) Records the GIS-Analyst who committed the changes to the historical fGDB. 
(ii.) Commit_date 

(1) Records the date and time stamp on which the changes were committed. 
(iii.) Trans_type 

(1) This field reflects the type of change recorded; 
(2) Categorized by: Adds/Change/Deletes. 

(iv.) New_values 
(1) Records the new values when a change was completed on a feature. Example: 

Name or speed change. 
d. MD_Process also is transferred from the edited fGDB to the historical fGDB, which states the 

actions completed by the GIS-Analyst. 

 

 

DATA PROCESSING 

DATA PROCESSING OVERVIEW 

The following subsections detail the steps and layout required to process the service provider data further 
to meet NTIA requirements: 

 Weighted Nominal Speed; 

 Middle Mile; 

 Broadband Coverage Template. 
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WEIGHTED NOMINAL SPEED 

The weighted nominal speed is populated in one of the following two ways: subscriber data supplied by 
provider or value supplied by provider. 

SUBSCRIBER DATA SUPPLIED BY PROVIDER 

Where the data provider supplies subscriber speed information, the following formula from the NOFA 
is used: 

(speed tier-1 in kbps × no. of tier-1 subscribers) + (speed tier-2 in kbps × no. of tier-2 subscribers) + (etc.) 
Total average monthly subscribers 

 
Data is initially broken up in the following order: 
1) Stcty_fips; 
2) Transmission technology type; 
3) Subscriber tiers. 

VALUE SUPPLIED BY PROVIDER 

Some providers will supply their weighted nominal speed. In these cases, the data supplied will be 
populated instead of using the NOFA formula. These obtained or calculated values are used to update 
the service overview layer. 
 
This can be done manually or by creating a table with the provider’s FRN and average weighted speed 

and joining it to the service overview table in ArcMap®. 

1) To join, right-click on the layer to join to and select Joins and Relates>Join from the dropdown 
menu. 

2) Then navigate to the table to join to and select the join fields from the dropdown list. 

3) Then open the source table (the table in ArcMap®) and right-click on the header of the Average 

Weighted Speed field and select Calculate Field from the dropdown menu. 
4) Use the value of the average weighted speed from the joined table. 

 

MIDDLE MILE 

Middle mile information generally is provided in spreadsheet or text file format. The process is to take 
what is supplied by the provider and translate it into the required data schema. 

1) If the data is supplied with address information, follow the process outlined above in Subscriber 
Location—Address Data. 

2) If the data is supplied with associated XY coordinates, follow the process outlined above in 
Subscriber Location—XY Data. 

3) Once the data is in GIS format, use the Append (Data Management Tools>General>Append) 

command in ArcToolbox® to append the data to the overall middle mile dataset. 

4) Set the schema type to NO_TEST and use the Field Map to map the attribute fields from the 
source to the target dataset. 
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BROADBAND COVERAGE TEMPLATE 

The table below lists descriptions of the fields within the bb_cov layer, which is the interim dataset used 
to create the final product deliverable. 
 

NAME ALIAS DESCRIPTION 

objectid OBJECTID Internal Object ID 

shape SHAPE Internal Shape storage 

prov_id PROVIDER_ID Unique numeric identifier for each provider 

prov_name PROVIDER_NAME Unique name for each provider 

dba_name DOING_BUSINESS_AS An alternative "Doing-Business-As" name for the provider 

frn FCC_REGISTRATION_NUMBER Provider FCC Registration Number 

bbcov_name BBCOV_NAME BroadMap Broadband Coverage name 

trans_code TRANSMISSION_CODE Unique code for the transmission technology type described by 

this layer 

trans_name TRANSMISSION_NAME Name for the transmissions technology type 

trans_desc TRANSMISSION_DESC Description for the transmissions technology type 

spect_code SPECTRUM_CODE Unique code for the spectrum [WIRELESS ONLY] 

spect_name SPECTRUM_NAME Name for the spectrum [WIRELESS ONLY] 

spect_desc SPECTRUM_DESC Description for the spectrum [WIRELESS ONLY] 

mad_dwn_t MAX_AD_DOWN_TIER Maximum advertised downstream speed available within given 

area (speed tier) 

mad_up_t MAX_AD_UP_TIER Maximum advertised upstream speed available within given area 

(speed tier) 

typ_dwn_t TYPICAL_DOWN_TIER Typical downstream speed available within given area (speed tier) 

typ_up_t TYPICAL_UP_TIER Typical upstream speed available within given area (speed tier) 

mad_dwn_k MAX_AD_DOWN_KBPS Maximum advertised downstream speed available within given 

area (kbps) 

mad_up_k MAX_AD_UP_KBPS Maximum advertised upstream speed available within given area 

(kbps) 

typ_dwn_k TYPICAL_DOWN_KBPS Typical downstream speed available within given area (kbps) 

typ_up_k TYPICAL_UP_KBPS Typical upstream speed available within given area (kbps) 

subs SUBSCRIBERS Total average monthly subscribers for this provider for this 

technology for this coverage polygon 

md_geom MD_GEOMETRY Metadata: Comma separated list of source ids from which the 

polygon extent was produced 

md_exists MD_EXISTS Metadata: Comma-separated list of source ids used in 

understanding and editing the provider data for this polygon 
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NAME ALIAS DESCRIPTION 

md_who MD_WHO Metadata: Name of the editor who last edited this feature at the 

time in md_when 

md_when MD_WHEN Metadata: Date/time that this feature was last edited 

md_process MD_PROCESS Metadata: Comma-separated list of processes used to create 

and/or modify this layer 

stcty_fips STATE_COUNTY_FIPS State/County FIPS code 

rec_id RECORD_ID Compound Key formed from 

STCTY_FIPS+"|"+Provider_ID+"|"+Trans_Code+"|"+BBCov_Name 

st_area ST_AREA(SHAPE) Area in square decimal degrees  

st_length ST_LENGTH(SHAPE) Length in decimal degrees  

Provider_Type Type of Provider Has Subtype (1:Broadband provider as described in the 

NOFA,2:Reseller,3:Unknown), default value=1 (New 04/11 Model) 

 

VERIFICATION AND VALIDATION 

PROVIDER VALIDATION—PROVIDER PORTAL/PDF MAP REVIEW 

Following the collection and aggregation of provider data, the aggregated data is validated by the 
provider to ensure it is an accurate representation of their coverage area and supporting broadband 
information. 

 This validation is completed through the Provider Portal web application, which is a secure 
interactive map that displays the provider’s coverage areas and allows the provider to 
validate, submit feedback or request changes. 
o If changes are requested, then the features on the portal are updated and an automatic 

request is sent to the provider to complete the validation process. 

 Providers that did not use the Provider Portal are asked to validate a PDF map displaying 
their coverage area(s). This is accomplished via e-mail notification. 

PROVIDER VERIFICATION—THIRD PARTY SOURCE REVIEW 

After the provider has validated its coverage areas, a third-party source comparison and analysis is 
performed. 

 Where anomalies or discrepancies are identified, a “SCAN” point is dropped and descriptive 
comments are applied to be reviewed later with the provider. 

 During the provider review, the map is displayed along with the “SCAN” points and potential 
refinement is completed based on input from the provider. 

The table below shows third-party sources used: 

THIRD-PARTY SOURCE NAME SOURCE TYPE VERIFICATION TYPE 

InfoUSA Consumer and 
Business Listings 

Community Anchor Institutions; 
Can also be used for demographic information 
supporting the State websites. 

Pitney Bowes (PBBI) Exchange Info Plus 
(Central Office 
Locations) 

Exchange datasets are used to verify the following 
Transmission Technologies (TT): 
Asymmetric xDSL (10), Symmetric xDSL (20), Other 
Copper Wireline (30), and Optical Carrier/Fiber to the 
End User (50). 
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THIRD-PARTY SOURCE NAME SOURCE TYPE VERIFICATION TYPE 

Media Prints Cable Boundaries Used to verify the following TT: 
Cable Modem—DOCSIS 3.0 (40) and Cable Modem—
Other (41). 

American Roamer  Wireless Coverage 
Patterns (EVDO, 
GPRS, WISP, HSPA) 

Used to verify the following TT: 
Terrestrial Fixed Wireless—Unlicensed (70), Terrestrial 
Fixed Wireless—Licensed (71) and Terrestrial Mobile 
Wireless (80). 

ComSearch Wireless Spectrum 
Holdings and Tower 
Data 

Used to verify the following TT: 
Terrestrial Fixed Wireless—Unlicensed (70), Terrestrial 
Fixed Wireless—Licensed (71) and Terrestrial Mobile 
Wireless (80). 

ASSIGNING CONFIDENCE VALUES 
All findings and results from the abovementioned validation and verification activities, plus internal 
peer quality reviews, are captured and tracked in a Validation table (see example on the following 
page) and form the basis of the confidence value assigned for each provider and then each 
technology. 

CONFIDENCE VALUE DESCRIPTION 

    0 Coverage area has not been reviewed. 

  10 Extremely Low: 
Single Source QC.   

  20 Very Low: 
Needs additional validation\verification. 

  30 Low: 
Even with validation\verification, coverage still is suspect. 

  40 Acceptable: 
Confirm with State prior to shipment. 

  50 Meets requirements to be included in shipment. 

  60 Moderate: 
Meets NTIA/State’s standards, representative of Technology Type (TT). 

  70 High: 
Accurate representation of coverage based upon TT. 

  80 Very High: 
Multiple validation\verification with most third-party sources. 

  90 Extremely High: 
Multiple validation\verification sources. 

100 Perfect: 
Multiple validation\verification sources, with complete alignment with 
sources and ground truth verification activities. 

 

The Validation table is maintained as updates or changes occur for each provider, down to 
technology type, with the overall goal to improve the confidence values and overall map 
representation. An example of the Validation table is shown below: 
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COMMUNITY ANCHOR INSTITUTION (CAI) DATA 

DATA COLLECTION 

The CAI data was initially collected from the State to create the baseline inventory. All location 
information and broadband coverage data supplied also was ingested into the data deliverable. 
Additional collection of CAI information was done via data mining and/or webscraping to build out 
the inventory further. For example: Collection of additional CAIs and location information. 
 
The State-agency-provided CAI inventory was comprehensive but the challenge is collecting 
broadband related data: service provider(s), technology and speed data for each CAI. Availability of 
the CAI portal has not significantly increased submission of this data. Additional promotion to CAIs to 
use the CAI portal will be needed to increase this data for subsequent deliverables. 

INSTITUTION DATA 

Institution data is obtained from a variety of sources and almost always provided in Excel spreadsheet 
format. The general process for incorporating this data is as follows: 
1) If the data is provided in Excel or some similar format: 

a. Clean and standardize the Excel spreadsheet, removing any cell formats, merged cells, etc. 
b. Standardize the address format as defined in the staging CAI database. 
c. If the spreadsheet includes X and Y values, such as latitude and longitude, use the Add XY 

Data tool in ArcMap® to create a spatial data layer. 

d. If there are only addresses, then follow the geocoding steps outlined above to create spatial 
data points for each of the institutions. 

(i.) Institutions that do not geocode based on the TIGER® 2009 dataset will have to be 

located manually using Google Maps, Google Earth or some other information source. 
2) If the CAI source data is in GIS format, add the Latitude and Longitude fields and use the 

Calculate Geometry tool to populate them, using the WGS 84 coordinate system. 

3) Using ArcCatalog®, load the new data into the staging CAI database. 

4) This database is ready for the makeDeliverable.py script to process the information into the final 
State and NTIA deliverables. 
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COMMUNITY ANCHOR INSTITUTION (CAI) PORTAL UPDATES 

A web application has been released to allow for further data collection and validation of anchor 
institution location information, broadband coverage and speed test data. Information collected from 
the CAI Portal is then ingested into the overall inventory and will be compared later against the 
provider coverage areas mapped to locate any potential discrepancies. 

 

PRODUCT EXTRACT 

PYTHON SCRIPTS 

The following subsections make use of Python scripts. In general, to use a Python script you must have 
Python installed on your computer. To download the latest version of Python, go to 
http://www.python.org/download/ and download the latest stable version. As of August 2010, this was 
version 2.7. Once this is installed, the general way to run a script is to type the following at a command 
prompt: C:\Python27\python.exe C:\<location of script>. Many of the scripts provided have environment 
variables that must be set before they can be run. 
 
The Python code for BroadMap’s product extract has been incorporated into a Hudson CI System, which is 
detailed in the Process Operation and Monitoring section of this document. This was a process 
improvement activity so that all processes can be monitored, controlled and will contain historical 
tracking on each process. 

 

PRODUCT EXTRACT PROCESS 

NOTE: 
Specific Python scripts are called out in red font in the subsections below. 
 

The MapConnect
TM

 product extract process, makeDeliverable.py, uses the BB_Cov and 
BROADMAP_POINTS interim datasets to create the following layers according to the current 
specifications: 

 BB_Service_Road_Segment 
o This layer contains all broadband services associated with specific street segments for census 

2000 blocks larger in area than two square miles. 

 BB_ServiceCensusBlock 
o Contains all broadband services associated with census blocks of no greater than two square 

miles. 

 BB_Service_Wireless 
o This layer contains all wireless services not associated with specific addresses. 

 BB_ServiceOverview 
o This layer contains subscriber-weighted nominal speed for each provider's service area at a 

county level and is meant to act as a summarized view. 

 BB_ConnectionPoint_MiddleMile 
o This layer contains middle-mile and backbone interconnection points. 

 BB_Service_CAInstitutions 
o Broadband Service at Community Anchor Institutions (CAI). 
o Community Anchor Institutions consist of schools, libraries, medical and healthcare 

providers, public safety entities, community colleges and other institutions of higher 
education as well as other community support organizations and entities. 

http://www.python.org/download/
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Because of a NTIA model change for the October 2010 data deliverable, an addition to this code was 
created to support both models in case a comparison is later desired or a request is made to revert to the 
original model. This script name is bdia2ntia.py and creates the following layers in addition to the layers 
mentioned above, rolled up to NATL_Broadband_Map. 

 BB_ConnectionPoint_LastMile 
o This layer contains last mile infrastructure points, which is populated only if data cannot be 

provided at a more granular level. 

 BB_Service_Address 
o Represents broadband availability for service address points. Address Point availability refers 

to those individual addresses at which each facilities-based provider of broadband service 
can provide broadband services of minimal characteristics within 7-10 business days. 

 State_Boundary 
o State boundary supporting topological validation of point feature classes. 

 NATL_Broadband_Topology 
o Supports basic topology quality checking. Example: No CAIs or Middle Mile points outside of 

the State boundary. 
 
The following process flow provides a view of how the Core fGDB is extrapolated to the NTIA final 
deliverable via the makeDeliverable.py script. Following that, the bdia2ntia.py script is run, which limits 
what is placed in the final layers based on the NTIA modeling standards. 
 
The product scripts and supporting extract were originally created separately per request, in case data 
model comparisons were to be completed. 

 

PRODUCT STATISTICS 

Following the completion of a product extract, the product statistics script (BDIA_ReleaseNotesStats.py) 
extracts the following information supporting that product deliverable. 

 Provider Statistics: 
o Collects all provider information, listing by Provider Name. 
o Provides output of FRN. 
o Counts the number of features supported within the following layers: 

 Census Block; 
 Street Segment; 
 Max Upstream; 
 Wireless Services; 
 Infrastructure Points. 

o These updates were made to support the Data Package required to accompany every NTIA 
product deliverable. 

 Community Anchor Institution (CAI) Statistics: 
o Breaks down CAI to the eight categories: 

 1: School: K through 12; 
 2: Library; 
 3: Medical/Healthcare; 
 4: Public Safety; 
 5: University/College; 
 6: Other Government; 
 7: Other Community non-government; 
 None: Unknown Category. In cases where this occurs, further investigation is completed 

prior to product shipment to ensure all CAIs are categorized accurately. 
o Reports out the following counts: 
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 Total CAIs within that category; 
 Total CAIs that contain partial BB coverage. Contains any of the following information for a 

given CAI: BB Subscriber, Transmission Technology, Speed Down Speed Up; 
 Total CAIs that contain full BB coverage. Contains all of the abovementioned BB information 

for a given CAI. 
The output of this script is two CSV files: AnchorInstitutions.csv and Providers.csv. These files then can be 
inspected to ensure that there are the expected number of CAIs and providers for every release. 

 

QUALITY ASSURANCE 

Quality assurance is supported manually and algorithmically on the interim data, BB_Cov file geodatabase and 
on the final product. For scheduled product releases, a test product extract and subsequent manual and 
algorithmic QC run is completed along with a release review. The product specifications, project status reports 
and previous product release notes are used as references throughout this review. 
 
The following parameters are tested using the methodology listed below each: 

 Product Deliverable Format:  
o Correct names and format of data deliverables. 

 BDIA_QC_SUITES (please see below for details). 
o Correct Projections/Datum. 

 Manual interaction with product. 
o Metadata Present and Correct. 

 Manual interaction with product. 

 Table Structure: 
o All required tables included. 

 BDIA_QC_SUITES. 
o Extraneous tables identified. 

 BDIA_QC_SUITES. 

 Field Structure: 
o All fields included. 

 BDIA_QC_SUITES. 
o Extraneous fields identified. 

 BDIA_QC_SUITES. 
o Correct field names, types and widths. 

 BDIA_QC_SUITES. 

 Field Domains: 
o Values in all tables are constrained to the specified values specified: 

 This action is accomplished via BDIA_QC_SUITES and manual review of the product; 
 This tends to identify project completeness issues as fields with a null value are identified. 

 Geometric Representation: 
o Identify if all layers have the correct geometric representation: 

 Manual review of the BB_ServiceOverview layer; 
 Dependent on NTIA and client requirements. 

 Geographic Extent: 
o Product includes the necessary Geography associated with Product? 

 Manual Review—ArcGIS®. 
o Is there extraneous geography included in Product? 

 Manual Review—ArcGIS®. 

 Completeness: 
o Products contain the expected amount of data? 
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 Manual review of product statistics relative to weekly State reports and defined expectations. 

 Accuracy: 
o Product meets the stated accuracy requirements for the deliverable? 

 Sampling procedure to manually review source material to resulting product; 
 Provider Validation; 
 Verification using Third-Party Data; 
 Verification against reality, where applicable. 

 Data Regression: 
o Any unexplainable data loss or change? 

 This action is accomplished by comparing results within product statistics script 
(BDIA_ReleaseNotesStats.py) from previous releases, as well as manual review of the product. 

 Confidentiality: 
o Any unauthorized confidential information included in the delivery? 

 Review of NDAs and delivery expectations. 

 Prior Issues Resolved:  
o Have expected internal issues been resolved? 

 Manual review of data against previous product release notes. 
o Have agreed-upon customer issues been resolved? 

 Manual review of data against previous product release notes, status report and client feedback. 

 Delivery Medium: 
o Has the product medium been verified? 

 Manual review. 
o All files present. 

 Manual review of SFTP site to ensure all files are copied correctly, including file/directory size. 
o Correct location. 

 Manual review—confirmation of SFTP link, username and password. 
 

QC SUITE 

The BDIA_QC_SUITES consists of four main types of scripts supporting the overall QC process. These 
scripts are all run in concert and are called from the test_runner script and the test_BDIAProductGDB 
script. 

CONFIGURATION  

These scripts establish the configuration for the test_BDIAProductGDB script, which is the core of the 
QC Suite. 
update_test_config 
active_config 
config_PROCESS01_automated 
config_PROCESS01_manual 
set_active_config 

LIBRARIES 

These scripts provide additional functionality that is called from with the test_BDIAProductGDB 
script. 
bb_unittest_fixture 
bbcov_structure 
BC_XmlWriter 
file_folder 
search_and_replace 
unittst_fixture 
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validate_BB_DB 
validate_BB_GDB 
xmlrunner_gui 

QC SUITE 

This is the core script for performing automated QA/QC on the interim and final data deliverables. 
test_BDIAProductGDB 

OTHER  

These scripts perform other functions detailed below: 
test_runner—this is the main script that runs all the other QC scripts and imports all the necessary 
scripts and libraries. 
which_build—this determines the current build and passes information to the configuration scripts. 

 

PROCESS OPERATION AND MONITORING 

Product Extract, makeDeliverable.py and bdia2ntia.py, is run within BroadMap using a platform called Hudson 
that has been enhanced to support BDIA product extraction, process monitoring, as well as product validation. 
The same platform can be planned for implementation for the State, if desired. 
 
Below are examples of the product create, product validation, product statistics and monitoring processes 
that are managed within the BroadMap Hudson CI-System. All of the abovementioned Python scripts, with 
the exception of metadata transactions script, are run via this system. 

 

BDIA PRODUCT CREATE 

Below is an example of the main page where the type of product build can be selected. 
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Selecting based on the type of process that will be initiated is shown below: 

 

  
The Console Output can be reviewed to see the progress of product create. Following the completion of 
each product creation process, an e-mail notification is automatically sent to the team. 

 
All processes run via the BroadMap Hudson CI-System are stored for historical reporting. Each process can 
be reviewed, including the Console Output and Build Artifacts from that run. 
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PRODUCT VALIDATION AND STATISTICS 

Once the product creation process is complete, Product Validation and Statistics are then initiated. These 
support the BDIA_ReleaseNotesStats.py script and the BDIA_QC_SUITES scripts detailed above. 

 
All statistics and reports are stored for historical review with the capability to place violation criticality on 
each quality control check, allowing the identification of errors because of project status/completeness 
verses project correctness. Example: Typical Speeds populated. 

 

Below is an example of the report provided based on various control points running over a specified 
period: 

 
Similar to the Product Create process, all results from the process are maintained: 
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Results are then reviewed manually to ensure no errors reported are critical or in violation of the NTIA 
data model or project completion statements. Any errors of concern are communicated ahead of product 
delivery and included within the product release notes. Further detail on the Hudson-CI System 
environment can be found by navigating to the following link: 
http://wiki.hudson-ci.org/display/HUDSON/Meet+Hudson 

 
 

PRODUCT EXTRACT DATA DELIVERY 

Product delivery for MapConnect
TM

 Broadband is handled two ways, depending on client requirements: 
1) State Submittal: 

a. Data is submitted via SFTP site; 
b. Product Release Notes and QC Test Report accompany the delivery. 

2) NTIA Submittal: 
a. Directions for using the NTIA State Broadband Data file submission tool: 

(i.) Go to the following website: https://esupport.fcc.gov/statedata; 
(ii.) Enter your username and password as provided to you from the NTIA program 
administrator; 

 
(iii.) Click in Upload a file field; 
(iv.) Browse to local file for submission using the Browse button. Select file, then select 

ATTACH FILE. See example below. 

http://wiki.hudson-ci.org/display/HUDSON/Meet+Hudson
https://esupport.fcc.gov/statedata
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(v.) Logout/Receipt using the Logout button in the top right of the screen; 
(vi.) A receipt of submission is e-mailed to username e-mail address. 
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California Public Utilities Commission  
NTIA State Broadband Initiative 

September 29th, 2011 

Data Processing Methods 

Primary Data Collection 
The California Public Utilities Commission (CPUC) sent out a Data Request to broadband providers to 

initiate the Round 4 data collection.  Potential providers were widely encouraged to submit broadband 

service availability data to the CPUC. We expressed our preference for providers to use a file 

geodatabase format when possible while tabular data was also accepted. Data submittal instructions 

were posted to assist providers with the process, template files, sample shapefiles and record formats 

on the CPUC Broadband Mapping Website at: 

http://www.cpuc.ca.gov/PUC/Telco/Information+for+providing+service/BroadBand+Mapping.htm 

The data submittal instructions guide each provider to wireless and/or wireline datasets which are 

separated into sections for those with GIS data (shapefiles/FGDB) and those without GIS data (text/excel 

files). For providers with GIS capabilities, statewide census block and TIGER/Line shapefiles were 

provided on the CPUC website for download and use for their data submission. The square mileage of 

each block was calculated in advance in the sample census block shapefile. Providers could then easily 

determine which blocks in their footprint were less than two square miles and which were two square 

miles or greater and therefore needed to be represented using the road segment shapefile. For 

providers without GIS capabilities, excel spreadsheets were provided incorporating record field formats 

adhering to the NOFA data submittal requirements. 

Community Anchor Institutions (CAI) 
CAI data initially came from the eligible entries of California Teleconnect Fund (CTF) program.  The CTF 

program provides 50% discounts on telecommunications bills for qualifying schools, libraries, 

government-owned and operated hospitals and health clinics, and other community based 

organizations, thus providing a good initial list of CAIs.  The CAI addresses were geocoded to point 

locations and loaded into the file geodatabase.  Technology of transmission and speeds data were 

included and identified either through information received from the Institutions themselves (as in the 

case of libraries) or from those service providers who responded to our request for such information.  To 

provide CAI ID information (as in the case of schools), the California Department of Education search 

engine website (http://www.cde.ca.gov/re/sd/) was utilized. 

Provider Participation 
A total of 71 providers participated in Round 4 data collection.  These providers comprise over 99.9% of 

the total broadband connections in California reported to the FCC on form 477, which constitutes a very 

complete set of data 

http://www.cpuc.ca.gov/PUC/Telco/Information+for+providing+service/BroadBand+Mapping.htm
http://www.cde.ca.gov/re/sd/
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CPUC Initial Data Verification 
After obtaining files submitted by the providers, a data inventory spreadsheet was used to reflect the 

assigned GIS team member and record count. Each file was reviewed against the GIS data model posted 

in the SBDD Network website to see if mandatory fields were filled in, and each field was checked for 

the appropriate range of values. Where possible, team members loaded the submitted data into the 

corresponding geodatabase table to make certain that appropriate field headers were used and that 

each field contained the correct data type. When data was found to be missing or incorrect, the provider 

was contacted and the issue was documented in a separate provider spreadsheet.  Some providers 

submitted nearly perfect data sets while others gave incomplete, unexpected, or incorrect data.  New 

information, correspondence with the providers, and fixes made by the CPUC were also documented in 

each provider spreadsheet.  

Chico GIC Geoprocessing   
 After the initial CPUC review, data was transferred to the Geographical Information Center (GIC) at CSU 

Chico for geocoding, geomatching, propagation of wireless service by antenna, and validation of 

geographic data. In those cases where the CPUC had received street address level data from broadband 

providers, such addresses were assigned a point location, (geocoded) and then geomatched to census 

blocks and street segments.  

Providers who offer wireless service but could not submit a shapefile or geographic representation of 

their service area gave tabular antenna information.  Wireless antenna parameters were used to model 

a service area and shapefiles were created for each provider. The wireless propagation model is based 

on the Longley-Rice, Irregular Terrain propagation model.  Individual unit specifications are used to 

measure performance based on frequency, transmit power, receiver sensitivity, antenna gain, and 

height.  Signal coverage patterns are produced for each individual unit taking into account terrain and 

vegetation features that may hinder signal dispersion. 

CPUC Final Data Verification 
The resulting datasets were delivered from Chico to the CPUC in the SBDD transfer model geodatabase 

for final review and verification. Data sets were checked again and reviewed for unexpected changes 

resulting from the geocoding /geomatching process. Geoprocessed data was visually reviewed using 

ArcGIS to verify service area footprints, and the SBDD check submission Python script was run on each 

dataset to identify unexpected values.  

Deliverable Data 
The final dataset is delivered to the NTIA/FCC in file geodatabase format with the following feature 

classes: 

BB_ConnectionPoint_LastMile – not required per Clarification to the NOFA. 
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BB_ConnectionPoint_MiddleMile – Point between the local “last mile” network and the middle mile 

network which goes on to connect to the internet backbone. This is a confidential dataset.  

BB_Service_Address  –  not included per the CPUC NDA.  

BB_Service_CAInstitutions – Community Anchor Institutions: points geocoded from address lists 

BB_Service_CensusBlock – Broadband availability polygons for areas less than 2 square miles 

BB_Service_Overview – Service overview by County including Subscriber Weighted Nominal Speed 

BB_Service_RoadSegment – Broadband availability line segments for areas 2 square miles and greater 

BB_Service_Wireless – Wireless service area polygons. 

Planned Validation Methods 
The following validation methods will be conducted on Round 4 data. Detailed maps showing submitted 

service area footprints and areas that could not be validated will be distributed to each provider for 

feedback. 

FCC Form 477 
FCC Form 477 collects information about broadband connections to end user locations, wired and 
wireless local telephone services, and interconnected Voice over Internet Protocol (VoIP) services, in 
individual states, at the Census Tract level. A shape file was created for each provider reflecting the 
presumed availability of broadband service at each census tract where the provider reported customers 
to their fixed broadband service.  These layers were used to cross reference ISP data submissions to the 
CPUC. 

ID Insight, BroadBand Scout  
BroadBand Scout is a third party comprehensive and unbiased data specifically designed to show the 
carriers, connectivity, speed and usage details of the national broadband landscape.  ID Insight’s patent-
pending process analyzes hundreds of millions of internet transactions that link a consumer's physical 
address to their internet carrier.  BroadBand Scout data is provided as tabular point locations and 
geomatched to the census block level where less the two square miles in area and to the street segment 
level where census blocks are greater than two square miles in area.  A shape file was created for each 
provider reflecting the presumed availability of broadband service at each census block or street 
segment where Broadband Scout reported online customer transactions. These layers were used to 
cross reference ISP data submissions to the CPUC. 

TeleAtlas Wire Center  
The Wire Center Premium product is a comprehensive database for mapping and analyzing wire center 
service areas. It forms the backbone of the Tele Atlas® Telecommunication Products line. This product 
lists every Local Exchange Carrier (LEC) landline wire center in the United States.  The term “wire center” 
refers to the location where the telephone company terminates the local lines; this is usually the same 
location as a central office, although a wire center might house one or more central offices. Buffers were 
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created at 12,000 feet and 18,000 feet from provided Wire Center point datasets to cross reference ISP 
data submissions to the CPUC. 

TeleAtlas Wire Center Region 
The Wire Center Premium product is a comprehensive database for mapping and analyzing wire center 

service areas. It forms the backbone of the Tele Atlas® Telecommunication Products line. This product 

lists every Local Exchange Carrier (LEC) landline wire center in the United States.  The wire center 

boundary is a representation of the area served by all of the switching equipment housed at that 

physical location. Wire Center Region polygon GIS layers were provided and used for cross referencing 

ISP data submissions to the CPUC. 

FCC Consumer Broadband Test (Non-Mobile App) 
The FCC offers an Online Consumer Broadband Test.  FCC’s Online Consumer Broadband Test collects 

information regarding the location of the client, the engine used to provide the speed test, download 

speed, upload speed, latency, jitter, packet loss, minimum round trip time, maximum round trip time, 

and average round trip time at a specified point location.  A shape file was created to represent each 

location at which speed tests were performed based on geocoded address records.  All point locations 

were then geomatched to the census block level where less the two square miles in area and to street 

segment level where census blocks are greater than two square miles in area.  These layers were used to 

cross reference ISP data submissions to the CPUC where sub-broadband speeds were reported and/or 

where there were no tests performed. 

FCC Consumer Broadband Test (Mobile App) 
The FCC offers a Mobile Consumer Broadband Test for the Apple iPhone and Android mobile platforms. 

The official name of the App is the FCC Broadband Test.  This tool can be downloaded to an Apple or 

Android enabled device by accessing the App Store or App Market on a handheld phone.  FCC’s Mobile 

Consumer Broadband Test collects information regarding the location of the client, the client’s 

operating system, the engine used to provide the speed test (always OOKLA for mobile tests), download 

speed, upload speed, and latency, at a specified point location.  A shape file was created to represent 

each location at which speed tests were performed based on latitude and longitude coordinate pairs.  

All point locations were then geoprocessed to the census block level where less the two square miles in 

area and to street segment level where census blocks are greater than two square miles in area.  These 

layers were used to cross reference ISP data submissions to the CPUC where sub-broadband speeds 

were reported and/or where there were no tests performed. 

FCC Broadband Dead Zone Reporting Form 
The FCC offers a Broadband Dead Zone Reporting Form for recording address or city level queries 

against the National Broadband Map, that failed to return any providers at the specified location, or 

alternately, where a user may know that no service is provided at a specific address.  FCC’s Broadband 

Dead Zone Form collects information regarding the location of the client, whether the client has internet 

access at their home, what type of internet access the client has at their home, and whether or not the 

client would be interested in purchasing broadband internet if service options were available.  A shape 

file was created to represent each location for which dead zone forms were filled out based on 
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geocoded address records.  All point locations were then geomatched to the census block level, where 

less than two square miles in area, and to street segment level, where census blocks are greater than 

two square miles in area. These layers were then used to cross reference ISP data submissions to the 

CPUC where dead zones and/or no services provided were reported. 

California State Map Broadband Service Survey Feedback 
The CPUC offers the Broadband Service Survey within its interactive map. The survey records user 

feedback based on address, city, or zip code level queries against the State’s Broadband Availability.  It 

collects information regarding the location of the client, whether the client is accessing the internet 

from their home, place of business, or any other location, whether or not the client purchases 

broadband service, and if not, why they choose not to purchase broadband service.  A shape file based 

on geocoded address records was created to represent each location for which service surveys were 

submitted where the respondent indicated non-subscription because of no broadband availability.  All 

such point locations were then geomatched to the census block level, where less than two square miles 

in area and to the street segment level, where census blocks are greater than two square miles in area. 

These layers were then used to cross reference ISP data submissions to the CPUC 

Chico GIC Data Validation Processes  
Each individual provider’s submitted and/or created data was validated independently to all applicable 

validation methods. The following fields were added to each individual provider’s data tables, where 

appropriate; FCC_477 (FCC Form 477), BBSCOUT (ID Insight BroadBand Scout), TA_WC_REG (TeleAtlas 

Wire Center Region), WC_VAL_12K (TeleAtlas Wire Center 12,000 foot buffer), WC_VAL_18K (TeleAtlas 

Wire Center 18,000 foot buffer), VAL12k_18k (TeleAtlas Wire Center 12,000 to 18,000 foot buffer ring), 

DEGRAD_FT (TeleAtlas Wire Center distance), (FCC_TST) FCC Consumer Broadband Test Non-Mobile 

App, (FCC_MOBL) FCC Consumer Broadband Test Mobile App, (FCC_DZ) FCC Broadband Dead Zone 

Reporting Form, and (CA_SRVY) State Map Broadband Service Survey Feedback to record validation 

results and to allow symbology of discrepancies based on validation methods for further interaction 

with each provider to refine their data submissions. The final step was a summary statistics report of all 

validation results for all submitted providers. Summary statistics include validity counts and percentages 

for all validation methods, specific to provider and technology. 

 Wireline Census Block Validation 
A spatial selection was performed on Census Block data, either submitted by provider, or created from 

submitted address records through a geocoding/spatial selection process, to derive only those blocks 

which intersect polygons in a given validation layer.  Counts are recorded as number of unique blocks 

which share geographic area with any given validation layer, compared to the total number of unique 

blocks submitted by, or created for, a given provider.  Percentages are recorded as percentage of the 

total number of unique blocks which share geographic area with any given validation layer, compared to 

the total number of unique blocks submitted by, or created for,  a given provider. 

Wireline Street Segment Validation 
A spatial selection was performed on Street Segment data, either submitted by provider, or created 

from submitted address records through a geocoding/spatial selection process, to derive only those 
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segments which intersect polygons in a given validation layer.  Counts are recorded as number of unique 

segments which share geographic area with any given validation layer, compared to the total number of 

unique segments submitted by, or created for, a given provider.  Percentages are recorded as 

percentage of the total number of unique blocks which share geographic area with any given validation 

layer, compared to the total number of unique segments  submitted by, or created for,  a given provider. 

Wireless Validation 
A spatial selection was performed on Wireless Availability data, either submitted by provider, or created 

from antenna location and specification information, to select only those polygons which intersect a 

given validation layer.  Results are recorded as a percentage of the total geographic area of wireless 

coverage sharing geographic area with any given validation layer, compared to the total coverage area 

submitted by, or created for, a given provider. 
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Colorado Broadband Data & Development Program  
October 1, 2011 Data Delivery Report  
 
For details about the Colorado Broadband Data and Development Program (CBDDP), please see our web 
site at www.colorado.gov/oit/broadband or visit the National Broadband Map at 
www.broadbandmap.gov. The Colorado interactive broadband map is available at 
http://maps.co.gov/ColoradoBroadband. 

Purpose of this Report 
 
This report provides details about the data set delivered to the NTIA on October 1, 2011 to support the 
National Broadband Map and to meet the requirements of the State Broadband Data and Development 
Program  grant to the Governor’s Office of Information Technology (OIT). The report describes the 
various processes used to verify this data set and the results of those processes. It also describes, in 
general terms, how the CBDDP collects and validates information about broadband availability in the 
State of Colorado. 
 

Status of Data Collection 
 
The Colorado Broadband Data and Development Program has continued the data collection effort 
begun with a third party contractor through a data collection contract signed on March 22, 2010.  The 
contractor has collected data from almost all service providers of significant size, but effort will continue 
to capture data from those not yet reporting.   
 
The following table categorizes all possible broadband service providers in Colorado known to the 
CBDDP, and indicates the status of their participation in the program.   The table also shows progress 
made over the first four data deliveries to the National Telephone and Information Administration 
(NTIA).   See the Data Delivery Report at the end of this document for more details on the data. 
 

Service Providers 
May 21, 
2010 

October 1, 
2010 

April 1, 
2011 

October 1, 
2011 

Identified 102 158 161 161 
Duplicates 0 14 14 14 

Not a BB Provider 15 24 29 31 

Working Universe of SP’s 87 120 118 116 

Multiple Contact Efforts, Have Chosen Not 
to Participate So Far, May Not Be a Provider 

5 17 50 46 

Data Sets Delivered to NTIA  39 59 65* 71** 

Broadband Provider Status Not Yet Known 43 44 0 0 

http://www.colorado.gov/oit/broadband�
http://www.broadbandmap.gov/�
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* Data Received but Not Included in Data Set: 1 Provider that Missed the Cutoff, and 2 Satellite 
Providers that Report They Cover the Entire State 
** Data Received but Not Included in Data Set: 2 Providers that Missed the Cutoff, and 2 Satellite 
Providers that Report They Cover the Entire State 

 
 
The following table describes how many service providers updated their data between the prior and 
current data delivery. Three dataset were also removed the previous delivery: 1) Alltel Wireless-was 
acquired by AT & T, 2) Big Sandy Telecom, Inc. speeds did not meet broadband requirements and 3) 
Town of Timnath stopped providing broadband service. 
 

Service Provider Updates October 1, 2011 
New in Data Set 1 
Updated Data 26 
Responded "No Data Change" 43 
Data Sets Delivered to NTIA 63 

 
The following table shows the number of community anchor institutions that have been identified in the 
state, and how many CAIs for which some broadband information has been collected and included in 
this data set.  In addition, the “Includes Speed Tests” column shows how much of the data in the 
“Collected” column are actual speed tests. 
 
The CBDDP is very pleased with the progress that has been made in promoting speed tests among 
reporting CAIs.  As shown below, 44%, or 1,662 of 3,768, of the data collected for CAI’s is from speed 
tests.  The CBDDP has not significantly expanded the number of CAIs submitting speed test information 
between April 2011 and this delivery. However, with the hiring of new GIS staff within OIT, we expect to 
make a more concerted effort to collect additional CAI information or update the data collected last 
year.   
 

Community Anchor Institutions October 1, 2011 

 Identified Collected Includes 
Speed Test 

Cat. 1 - School K -12 2109 1987 974 

Cat. 2 - Library 252 241 14 

Cat. 3 - Medical/Healthcare 709 346 143 

Cat. 4 - Public Safety 1779 673 305 

Cat. 5 - University/College 55 44 42 
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Cat. 6 - Other Government 601 315 179 

Cat. 7 - Other non-Government 10 7 6 

 
5515 3613 1663 

 

 
Validation and Verification Processes for the April 2011 Data Set 
 
1.  Automated Validation. The CBDDP has been developing and improving automated validation scripts 
since its first data delivery in May 2010. The CBDDP runs both the scripts it has developed as well as the 
script provided by the NTIA on a monthly basis. The data delivery includes proof that the data passed 
the NTIA validation script as required. 
 
In addition to testing all of the issues covered by the NTIA script, the CBDDP’s automated script: 

• Verifies that the Geodatabase has metadata, is in the correct projection, and that the feature 
classes are properly named 

• Verifies all columns are properly named and defined 
• Verifies all table value domains are adhered to  
• Captures the required information to accurately complete the Records Count and Provider Table 

tabs for the SDBB Data Package 
• Cross references and creates statistical tables of technology type and valid speed combinations 

for both Service Provider and CAI data 
• Compares FRNs to provider names to ensure consistency across the data set 
• Ensures consistency in provider names 
• Identifies possible duplicates among CAIs   
• Tests  all feature classes to ensure they are within the State’s boundaries 
•  Creates a statistical table for all features classes including records details, service provider 

information and  attribution frequencies  
• Ensures the data model, business rules and schema are in compliance 

 
2.  Analysis of Changes.  This data delivery uses the 2010 census block geography which is different from 
the 2000 geography used for the April 1, 2011 data delivery.  As a result it is impossible to perform a 
straight comparison and enumerate changes in census features for each provider between the April 
2011 and October 2011 deliveries. However, to obtain a rough assessment of the providers that may 
have submitted significant changes to their data, the CBDDP first calculated the increase in the number 
of census blocks from 2000 to 2010 (29.5%). There was also a decrease in the number of blocks greater 
than two square miles that had provider provider data in them (-32.7%). If a provider’s census block 
coverage increased by more than 31%, it become a higher priority provider to scrutinize. In these cases, 
CBDDP staff looked closely at the data, visually inspecting all of the blocks in the provider’s data set to 
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determine if there were any apparently erroneous changes. No significant corrections to the resulting 
data were necessary as a result of this process. 
 
3.  Visual review.   
The CBDDP also routinely reviews the coverage areas for new service providers and those with changes 
to their coverage areas as part of preparing data for delivery. We found no unusual coverage areas.   
 
4.  Third Party Data Validation.  For the October 1, 2011 data delivery, OIT has compared 100% of the 
service provider coverage areas to third party data sets. These data sets include American Roamer, 
ComSearch, Pitney Bowes, MediaPrints, and SpectrumView. In 21 instances, multiple third party data 
sets were used to validate a single service provider/technology type combination.   The CBDDP records 
comments about coverage areas, geometry and attribution provided for the technology type and assigns 
a categorical assessment of the match between the CBDDP data and the third party data. This 
assessment is necessarily subjective because the third party data sets are sometimes very crude in their 
spatial resolution so it is difficult to make precise comparisons. 
  
5.  Feedback loop.  The CBDDP provides all service providers the opportunity to review the final 
geospatial representation of their data as a routine part of the work flow. In addition, when updates to 
data were solicited, providers were questioned as to the accuracy of the geospatial display of their 
coverage areas. 
 
6.  Speed Test Analysis.  There are several issues to consider when comparing speed test data to service 
provider advertized maximum speeds.  Many speed tests do not collect the name of the service provider 
being tested.  In areas where more than one service provider offers varying maximum service speeds, it 
is not possible to know who is providing the service to the CAI.  Also, even if a speed test result is 
directly tied to a certain service provider, it is unknown if the customer has chosen to purchase the 
maximum available speed offered by the service provider.   
 
The speed test information that the CBDDP collects from CAIs requests the name of the service provider, 
but of the 1,662 speed tests collected from CAIs only 1048 of those tests specifically identified the 
service provider. In the past, the CBDDP used only the tests that included provider information, but for 
this delivery, we used all of the speed tests. We think this gives a more comprehensive perspective of 
the comparison between the speeds at each institution and the potential advertised service in their 
area. Service providers report data by speed test tier, and the following table compares how the speed 
tier for the CAI speed test compares to the maximum advertized speed tier provided by the service 
provider. A similar test also compared the CAI tests to the minimum advertised speed for among all of 
the providers that reported service in that area, and the table with those results are below as well. 
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CAI Speed Test Compared  to Maximum Download speed by Census Block. 

    Speed Test Slower  
Same 
Tier Speed Test Faster     

Total  
Tests 

Number of 
Speed Tiers 

Slower or 
Faster -7 -6 -5 -4 -3 -2 -1 0 1 2 3 4 5 6 7   

School K - 12 2 1 23 51 117 118 277 249 78 35 17 6       974 
Library   3 1     3 3 3   1           14 

Healthcare   7 7 21 25 19 28 22 9 4           142 
Public Safety   1 8 31 64 61 44 79 12 5           305 

University, 
college   1   1 5 1 5 13 6 3 4 3       42 
Other 

Government   1 4 18 25 24 25 47 28 3 4         179 
Other Non-
Government       1 1 3   1               6 

Totals 2 14 43 123 237 229 382 414 133 51 25 9       1662 
Totals   1030 414 218     1662 

 
 

CAI Speed Test Compared  to Minimum Download speed by Census Block. 

    Speed Test Slower  
Same 
Tier Speed Test Faster     

Total  
Tests 

Number of 
Speed Tiers 

Slower or Faster -7 -6 -5 -4 -3 -2 -1 0 1 2 3 4 5 6 7   

School K - 12     2 14 44 76 104 209 149 185 156 22 9 4   974 
Library       1 2 4 2 4       1       14 

Healthcare     3 6 18 20 36 24 15 10 5 3 1 1   142 
Public Safety     3 10 28 42 47 94 35 22 14 10       305 

University, 
college           1 4 4 4 5 11 4 6 2 1 42 
Other 

Government     1 11 17 19 29 42 32 8 13 7       179 

Other Non-
Government       1 1 1 2 1               6 

Totals     9 43 110 163 224 378 235 230 199 47 16 7 1 1662 
Totals   549 378 735     1662 

 
 
7.  Drive Testing Mobile Coverage Areas. The CBDDP tested the mobile wireless coverage areas 
reported by the service providers. The CBDDP has completed drive testing for over  5,000 miles of roads. 
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This testing followed a test scheme that started with primary test points along major highways followed 
by secondary points from one half to one mile away from the primary point to confirm the result of the 
primary point. Up to four additional secondary points farther from the primary points were then tested 
or until at least two tests fail with test speeds of less than 768 Kbps. The primary points were generally 
10 to 15 miles apart, and the derived points were clustered around the primary points within 2 to 3 
miles. The tests all used commercially available wireless air cards, identical laptops, and the same FCC 
speed test site. The tests checked only the major national mobile providers and were all performed 
between March and May of 2011.  
 
 
The following graphic is a general depiction of the routes used for the drive testing. 
 

 
 
The following table presents the results of drive testing completed. The number of test results shown for 
each provider reflect only the test points that fell within the coverage area provided by that service 
provider to the CBDDP. In addition, some providers had overlapping areas of mobile coverage with 
differing speed tier information. All of these overlapping areas were included in the comparison for each 
point that fell in those areas. For example, if at a specific point a provider had four different overlapping 
regions each with its own speed tier, the test point there was compared to each one, and the results 
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added to the total for the appropriate tier difference and a increased the total number of tests by four 
for that provider.  

MOBILE WIRLESS COVERAGE TESTING 
All Points Tested Including Primary and Secondary 

Combined Result for Three Providers Tested 
    Tiers Slower   Same Tier   Tiers Faster   Total Tests 

Number of Speed 
Tiers Slower or 

Faster 

< 
768 
Kbps -3 -2 -1 0 1 2 3   

  302   60 29 111 14 1   517 
Totals 391 111 15 517 

ATT 
    Tiers Slower Same Tier   Tiers Faster   Total 

Number of Speed 
Tiers Slower or 

Faster 

< 
768 
Kbps -3 -2 -1 0 1 2 3   

  79     29 11       119 
Totals 108 11 0 119 

Sprint 

      
Tiers 

Slower   Same Tier   Tiers Faster   Total 
Number of Speed 
Tiers Slower or 

Faster 

< 
768 
Kbps -3 -2 -1 0 1 2 3   

  85   1   100 14 1   201 
Totals 86 100 15 201 

Verizon 

      
Tiers 

Slower   Same Tier   Tiers Faster   Total 
Number of Speed 
Tiers Slower or 

Faster 

< 
768 
Kbps -3 -2 -1 0 1 2 3   

  138   59           197 
Totals 197 0 0 197 

 
 

Planned Data Verification and Analysis 
 
The CBDDP has prepared a survey for residences and businesses querying them about their broadband 
availability and their use of broadband. The survey process has collected over 150 responses in the 
southwest portion of the state, which met the sample requirements for that region as defined  by the 
CBDDP Quality Assurance specialist. The survey is also under way in the northeast, southeast and central 
southern areas of Colorado as well.  



8 | P a g e  
 

 
The CBDDP is currently analyzing the data from the southwestern region survey responses. Similar to 
the data verification shown above, these results will provide sense of the actual speeds in use or 
available to residents and businesses across the state. The CBDDP expects to represent these results to 
the broadband service providers as a feedback and potential data improvement process for future data 
deliveries.  

 
Summary of Process 
 
The CBBDP follows a data collection process outlined on the National Broadband Map in the “Technical 
Overview” of the “About” section at www.broadbandmap.gov. If you would like a more detailed, 
procedural description of the process, please contact the CBDDP via email at COBroadband@state.co.us. 
  
The data gathering process begins by contacting the potential broadband providers. Although 
participation is voluntary, many providers choose to support this effort. The success of this program 
rests, in part, on that support, and we appreciate their efforts to participate in this program. 
Broadband providers submit data in a variety of formats, and in a number of cases the CBDDP also 
conducts technical assistance to support the efforts of smaller providers to participate. For census 
blocks less than two square miles, the entire census block is presumed to have coverage if any service 
provider reports broadband anywhere in the census block. For census blocks greater than two square 
miles, the CBDDP reports service along road segments. Before submitting data to the NTIA, the CBDDP 
integrates the data from each provider into a single dataset using a data model  specified by the NTIA. 
The NTIA and FCC then integrate the CBDDP’s dataset along with those from all other states into the 
single National Broadband Map dataset. 
 
An earlier section in this report titled “Data Verification and Analysis”, describes the specific steps that 
the CBDDP took, and the results of those steps, to verify the data before transmission to the NTIA.   
 
The CBDDP has implemented the following data collection and ingestion processes which may vary from 
other state programs. 
 
1.  The CBDDP implemented the following process to spatially transform broadband service to census or 
road geography where the service provider has given the CBDDP address specific information. A 150 
foot buffer is drawn around each point. Any census block touched by the buffered area is selected.  For 
census blocks greater than two square miles, any road segment touched by the buffer is selected.  The 
CBDDP has met with the largest service provider in the state that provided address specific data, and 
they agree that the 150 foot buffer process is reasonable and creates an accurate representation of 
their service area. 
 

http://www.broadbandmap.gov/�
http://www.broadbandmap.gov/about/technical-overview/data-model�
http://www.broadbandmap.gov/about/technical-overview/layers-in-the-map�


9 | P a g e  
 

2.  Based on clarifications from the NTIA, the CBDDP did not provide any features in the 
BB_Service_Overview feature class since more granular speed information was provided in the 
BB_Service_CensusBlock, BB_Service_RoadSegment and BB_Service_Address feature classes. 
 
3.  The CBDDP is not currently collecting pricing information. 
 
4.  Reference layers include the U.S Census Bureau 2010 census blocks and 2010 Tiger data for roads. 
 
5.  The CBDDP made a significant adjustment to the data set starting with the October 2010 data 
delivery. Very few of Colorado’s service providers have reported both their maximum advertized speed 
and the typical speeds a user might encounter. During an in-person meeting, previous to the October 
2010 deliver, Qwest stated their advertised speeds are the typical speeds and there is no potential for 
degraded service during peak periods of use or distance from central office. Based on this information 
from the service provider, the CBDDP is using Qwest advertised as typical speed. 
 
5.  The CBDDP has created an exception table that will record unusual areas or pockets were coverage 
may or may not exist. The table will be persistent through provider updates, so these exceptions will not 
have to be rediscovered with each update. 
 
6.  The CBDDP reports wireless towers in the middle mile where they are being used for backhaul.  
When service providers have submitted central office locations, they are included in the middle mile.  
Qwest and CenturyLink did not provide such information, and have requested the CBDDP not include 
publicly available central office locations in the data set.   
 
7.  The CBDDP is utilizing a data collection contractor during the first two years of the program.  Starting 
in October 2011 (i.e., for the April 1, 2012 delivery), and through the remainder of the program to 
October 31, 2014, the CBDDP will bring this process in-house. The CBDDP has worked closely with the 
contractor, and has developed skills and experience in validating the information and working with the 
data sets. Consequently, this transition should be seamless. 
 
8.  For CAIs, multiple data sources are compared where available. However, speed test data is reported 
in preference to other types of data such as surveys, reports or speeds for which the CAI is paying.   
 
9.  Addresses and names that appear to be duplicates are validated. The CBDDP chooses to report 
multiple CAIs at the same address as distinct entities.  For example, a county sheriff’s office and a 911 
call center at the same address are reported as two distinct entities.  
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Data Summary and Feature Class Statistical Tables 
 

      Data Summary       

      File Summary       

    
File 
Type         

Number of 
Records   

Total Records in all Files     508522 
Census Block < 2 sq. miles     392973 
Street Segments       108607 
Wireless Shape 
File       40 
Service Address       466 
BB Service 
Overview       0 
Community Anchor 
Instituions     5515 
Middle Mile       921 
Metadata Provided for Geospatial 
Data   Yes 

         
      Provider Information       

    
File 
Type         

Number of 
Records   

Number of ISPs Provided     63 
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Data Delivery Report 

Census Blocks < 2 sq. miles 
Data 
Type Code Data Element Count %   Data Type Code Data Element Count % 

Re
co

rd
s D

et
ai

ls
 

  Total Records 392973     

Ty
pi

ca
l D

ow
nl

oa
d 

Sp
ee

d 

3 
>= 768 kbps. < 1.5 
mbps. 12784 3.3% 

  
Census Blocks < 2 sq. miles with 
Broadband 134578     4 >= 1.5 mbps. < 3 mbps. 46716 11.9% 

  
Census Blocks  < 2 sq. miles in 
State  (with & without broadband) 192101     5 >= 3 mbps. < 6 mbps. 100977 25.7% 

  

Census Blocks > 2 sq. miles in 
the State (with & without 
broadband) 8961     6 >= 6 mbps. < 10 mbps. 55553 14.1% 

  
Total Census Blocks in the State 
(with & without broadband) 201062     7 >= 10 mbps. < 25 mbps. 32373 8.2% 

            8 >= 25 mbps. < 50 mbps. 74168 18.9% 

Se
rv

ic
es

 
Pr

ov
id

er
 

De
ta

ils
   Number of Distinct Providers 36     9 > 50 mbps, < 100 mbps. 0 0.0% 

  
Number of Distinct "Doing 
Business As" 34     10 > 100 mbps, < 1 gbps. 0 0.0% 

  Number of Distinct FRN 35     11 > 1 gbps. 0 0.0% 

              ZZ "null" 70402 17.9% 

Te
ch

no
lo

gy
 

10 Asymmetric xDSL 192540 49.0%             
20 Symmetric xDSL 58679 14.9%   

 M
ax

. A
dv

er
tis

ed
 U

pl
oa

d 
Sp

ee
d 

2 >200 kps, < 768 kps. 19754 5.0% 

30 Other Copper Wireless 77033 19.6%   3 
>= 768 kbps. < 1.5 
mbps. 155787 39.6% 

40 Cable Modem-DOCSIS 3.0 0 0.0%   4 > 1.5 mbps, < 3 mbps. 66471 16.9% 

41 Cable Modem-Other 61690 15.7%   5 > 3 mbps, < 6 mbps. 85076 21.6% 

50 Optical Carrier/Fiber   3031 0.8%   6 > 6 mbps, < 10 mbps. 39270 10.0% 

60 Satellite 0 0.0%   7 > 10 mbps, < 25 mbps. 25485 6.5% 

70 
Terrestrial Fixed Wireless-
Unlicensed 0 0.0%   8 > 25 mbps, < 50 mbps. 114 0.0% 

71 
Terrestrial Fixed Wireless-
Licensed 0 0.0%   9 > 50 mbps, < 100 mbps. 40 0.0% 

80 Terrestrial Mobile Wireless 0 0.0%   10 > 100 mbps, < 1 gbps. 941 0.2% 

90 Electrial Power Line 0 0.0%   11 > 1 gbps. 35 0.0% 

0 Other 0 0.0%             
            

Ty
pi

ca
l U

pl
oa

d 
Sp

ee
d 

2 >200 kps, < 768 kps. 38546 9.8% 

M
ax

. A
dv

er
tis

ed
 

Do
w

nl
oa

d 
Sp

ee
d 

3 > 768 kps, < 1.5 mbps. 3930 1.0%   3 > 768 kps, < 1.5 mbps. 71240 18.1% 

4 > 1.5 mbps, < 3 mbps. 47436 12.1%   4 > 1.5 mbps, < 3 mbps. 74031 18.8% 

5 > 3 mbps, < 6 mbps. 87395 22.2%   5 > 3 mbps, < 6 mbps. 75175 19.1% 

6 > 6 mbps, < 10 mbps. 127856 32.5%   6 > 6 mbps, < 10 mbps. 38206 9.7% 

7 > 10 mbps, < 25 mbps. 51112 13.0%   7 > 10 mbps, < 25 mbps. 25319 6.4% 

8 > 25 mbps, < 50 mbps. 74228 18.9%   8 > 25 mbps, < 50 mbps. 54 0.0% 

9 > 50 mbps, < 100 mbps. 40 0.0%   9 > 50 mbps, < 100 mbps. 0 0.0% 
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10 > 100 mbps, < 1 gbps. 941 0.2%   10 > 100 mbps, < 1 gbps. 0 0.0% 

11 > 1 gbps. 35 0.0%   11 > 1 gbps. 0 0.0% 

              ZZ "null" 70402 17.9% 

Provide
r Type 

1 Provider 392005 99.8%             
2 Reseller 968 0.2%   

                 
     End 

User 
Name 

1 Residential 390893 99.5%   
     

2 Governmental 2080 0.5%   
                 
     

           Street Segment 
Data 
Type Code Data Element Count % 

  
Data Type Code Data Element Count % 

Record 
Details   Total Records 108607     

Ty
pi

ca
l D

ow
nl

oa
d 

Sp
ee

d 

3 > 768 kps, < 1.5 mbps. 7730 7.1% 

            4 > 1.5 mbps, < 3 mbps. 26360 24.3% 

Se
rv

ic
es

 
Pr

ov
id

er
 

De
ta

ils
   Number of Distinct Providers 35     5 > 3 mbps, < 6 mbps. 5653 5.2% 

  
Number of Distinct "Doing 
Business As" 33     6 > 6 mbps, < 10 mbps. 17685 16.3% 

  Number of Distinct FRN 34     7 > 10 mbps, < 25 mbps. 13820 12.7% 

            8 > 25 mbps, < 50 mbps. 5870 5.4% 

Te
ch

no
lo

gy
 

10 Asymmetric xDSL 68760 63.3%   9 > 50 mbps, < 100 mbps. 0 0.0% 

20 Symmetric xDSL 15188 14.0%   10 > 100 mbps, < 1 gbps. 0 0.0% 

30 Other Copper Wireless 4592 4.2%   11 > 1 gbps. 0 0.0% 

40 Cable Modem-DOCSIS 3.0 0 0.0%     ZZ "null" 31486 29.0% 

41 Cable Modem-Other 16317 15.0%             
50 Optical Carrier/Fiber   3750 3.5%   

M
ax

. A
dv

er
tis

ed
 U

pl
oa

d 
Sp

ee
d 

2 >200 kps, < 768 kps. 21838 20.1% 

60 Satellite 0 0.0%   3 > 768 kps, < 1.5 mbps. 45409 41.8% 

70 
Terrestrial Fixed Wireless-
Unlicensed 0 0.0%   4 > 1.5 mbps, < 3 mbps. 19812 18.2% 

71 
Terrestrial Fixed Wireless-
Licensed 0 0.0%   5 > 3 mbps, < 6 mbps. 6024 5.5% 

80 Terrestrial Mobile Wireless 0 0.0%   6 > 6 mbps, < 10 mbps. 15326 14.1% 

90 Electrial Power Line 0 0.0%   7 > 10 mbps, < 25 mbps. 196 0.2% 

0 Other 0 0.0%   8 > 25 mbps, < 50 mbps. 0 0.0% 

            9 > 50 mbps, < 100 mbps. 0 0.0% 

M
ax

. A
dv

er
tis

ed
 

Do
w

nl
oa

d 
Sp

ee
d 3 > 768 kps, < 1.5 mbps. 6553 6.0%   10 > 100 mbps, < 1 gbps. 2 0.0% 

4 > 1.5 mbps, < 3 mbps. 27471 25.3%   11 > 1 gbps. 0 0.0% 

5 > 3 mbps, < 6 mbps. 8480 7.8%             
6 > 6 mbps, < 10 mbps. 20847 19.2%   

Ty
pi

ca
l 

U
pl

oa
d 

Sp
ee

d 2 >200 kps, < 768 kps. 22185 20.4% 

7 > 10 mbps, < 25 mbps. 39384 36.3%   3 > 768 kps, < 1.5 mbps. 16702 15.4% 

8 > 25 mbps, < 50 mbps. 5870 5.4%   4 > 1.5 mbps, < 3 mbps. 19612 18.1% 
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9 > 50 mbps, < 100 mbps. 0 0.0%   5 > 3 mbps, < 6 mbps. 3235 3.0% 

10 > 100 mbps, < 1 gbps. 2 0.0%   6 > 6 mbps, < 10 mbps. 15188 14.0% 

11 > 1 gbps. 0 0.0%   7 > 10 mbps, < 25 mbps. 196 0.2% 

            8 > 25 mbps, < 50 mbps. 0 0.0% 

Provide
r Type 

1 Provider 108584 
100.0

%   9 > 50 mbps, < 100 mbps. 0 0.0% 

2 Reseller 23 0.0%   10 > 100 mbps, < 1 gbps. 0 0.0% 

            11 > 1 gbps. 0 0.0% 
End 
User 

Name 

1 Residential 108551 99.9%     ZZ "null" 31486 29.0% 

2 Governmental 56 0.1%             
            

     
           Wireless 

Data 
Type Code Data Element Count %   Data Type Code Data Element Count % 

Record 
Details   Total Records 40     

Ty
pi

ca
l D

ow
nl

oa
d 

Sp
ee

d 

2 >200 kps, < 768 kps. 0 0.0% 
            3 > 768 kps, < 1.5 mbps. 8 20.0% 

Se
rv

ic
es

 
Pr

ov
id

er
 

De
ta

ils
   Number of Distinct Providers 31     4 > 1.5 mbps, < 3 mbps. 6 15.0% 

  
Number of Distinct "Doing 
Business As" 30     5 > 3 mbps, < 6 mbps. 7 17.5% 

  Number of Distinct FRN 28     6 > 6 mbps, < 10 mbps. 3 7.5% 

            7 > 10 mbps, < 25 mbps. 0 0.0% 

Te
ch

no
lo

gy
 

10 Asymmetric xDSL 0 0.0%   8 > 25 mbps, < 50 mbps. 0 0.0% 

20 Symmetric xDSL 0 0.0%   9 > 50 mbps, < 100 mbps. 0 0.0% 

30 Other Copper Wireless 0 0.0%   10 > 100 mbps, < 1 gbps. 0 0.0% 

40 Cable Modem-DOCSIS 3.0 0 0.0%     ZZ "null" 16 40.0% 

41 Cable Modem-Other 0 0.0%             
50 Optical Carrier/Fiber   0 0.0%   

M
ax

. A
dv

er
tis

ed
 U

pl
oa

d 
Sp

ee
d 

2 >200 kps, < 768 kps. 6 15.0% 

60 Satellite 0 0.0%   3 > 768 kps, < 1.5 mbps. 17 42.5% 

70 
Terrestrial Fixed Wireless-
Unlicensed 13 32.5%   4 > 1.5 mbps, < 3 mbps. 9 22.5% 

71 
Terrestrial Fixed Wireless-
Licensed 13 32.5%   5 > 3 mbps, < 6 mbps. 6 15.0% 

80 Terrestrial Mobile Wireless 14 35.0%   6 > 6 mbps, < 10 mbps. 2 5.0% 

90 Electrial Power Line 0 0.0%   7 > 10 mbps, < 25 mbps. 0 0.0% 

0 Other 0 0.0%   8 > 25 mbps, < 50 mbps. 0 0.0% 

            9 > 50 mbps, < 100 mbps. 0 0.0% 

M
ax

. 
Ad

ve
rt

is
ed

 
Do

w
nl

oa
d 

Sp
ee

d 

3 > 768 kps, < 1.5 mbps. 8 20.0%   10 > 100 mbps, < 1 gbps. 0 0.0% 

4 > 1.5 mbps, < 3 mbps. 9 22.5%   11 > 1 gbps. 0 0.0% 

5 > 3 mbps, < 6 mbps. 16 40.0%             
6 > 6 mbps, < 10 mbps. 7 17.5%   al
 

U
pl oa d Sp

 

2 >200 kps, < 768 kps. 3 7.5% 
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7 > 10 mbps, < 25 mbps. 0 0.0%   3 > 768 kps, < 1.5 mbps. 16 40.0% 

8 > 25 mbps, < 50 mbps. 0 0.0%   4 > 1.5 mbps, < 3 mbps. 2 5.0% 

9 > 50 mbps, < 100 mbps. 0 0.0%   5 > 3 mbps, < 6 mbps. 2 5.0% 

10 > 100 mbps, < 1 gbps. 0 0.0%   6 > 6 mbps, < 10 mbps. 1 2.5% 

11 > 1 gbps. 0 0.0%   7 > 10 mbps, < 25 mbps. 0 0.0% 

            8 > 25 mbps, < 50 mbps. 0 0.0% 

 S
pe

ct
ru

m
 

1 800 Mhz Spectrum Used 2 5.0%   9 > 50 mbps, < 100 mbps. 0 0.0% 

2 700 Mhz Spectrum Used 5 12.5%   10 > 100 mbps, < 1 gbps. 0 0.0% 

3 1900 Mhz Spectrum Used 4 10.0%     ZZ "null" 16 40.0% 

4 1700 Mhz Spectrum Used 5 12.5%             
5 2500 Mhz Spectrum Used 4 10.0%   

     6 Unlicensed Spectrum Used 18 45.0%   
     7 Specialist Mobile Radio Service 2 5.0%   
     

8 
Wireless Communication 
Service 0 0.0%   

     9 Satilite 0 0.0%   
                 
     

           Community Anchor Insititution 
Data 
Type Code Data Element Count %   Data Type Code Data Element Count % 

Record 
Details   Total Records 5515     

 M
ax

. A
dv

er
tis

ed
 U

pl
oa

d 
Sp

ee
d 

1 < 200 kps. 0 0.0% 

            2 >200 kps, < 768 kps. 125 2.3% 

An
ch

or
 C

at
eg

or
y 

1 School-K through 12 2109 38.2%   3 > 768 kps, < 1.5 mbps. 195 3.5% 

2 Library 252 4.6%   4 > 1.5 mbps, < 3 mbps. 1297 23.5% 

3 Medical/healthcare 709 12.9%   5 > 3 mbps, < 6 mbps. 516 9.4% 

4 Public safety 1779 32.3%   6 > 6 mbps, < 10 mbps. 391 7.1% 

5 
University, college, other post-
secondary 55 1.0%   7 > 10 mbps, < 25 mbps. 660 12.0% 

6 
Other community support-
/gov't 601 10.9%   8 > 25 mbps, < 50 mbps. 90 1.6% 

7 
 Other community support-non-
/gov't 10 0.2%   9 > 50 mbps, < 100 mbps. 8 0.1% 

            10 > 100 mbps, < 1 gbps. 54 1.0% 

 T
ec

hn
ol

og
y 

10 Asymmetric xDSL 340 6.2%   11 > 1 gbps. 70 1.3% 

20 Symmetric xDSL 6 0.1%     ZZ "null" 2109 38.2% 

30 Other Copper Wireless 1591 28.8%             

40 Cable Modem-DOCSIS 3.0 0 0.0%   

Y/
N

 B
ro

ad
ba

nd
 

Se
rv

ic
e Y 

Yes-Subscribers to 
Service 3406 61.8% 

41 Cable Modem-Other 133 2.4%   N 
No-Does Not 
Subscribers to Service 2109 38.2% 

50 Optical Carrier/Fiber   1248 22.6%   U Unknown 0 0.0% 

60 Satellite 14 0.3%             
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70 
Terrestrial Fixed Wireless-
Unlicensed 27 0.5%   

La
t/

Lo
ng

 
Ac

cu
ra

cy
 

1 
Lat/Long thT Flls within 
the State 5515   

71 
Terrestrial Fixed Wireless-
Licensed 77 1.4%   2 Total Lat/Long 5515 100% 

80 Terrestrial Mobile Wireless 0 0.0%             

90 Electrial Power Line 0 0.0%   

An
ch

or
 

N
am

es
 

  
Total Count Anchors 
Names 5515   

0 Other 0 0.0%     
Disticnt Count of Anchor 
Names 5368   

  ZZ "null" 2109 38.2%             
                  Count BB Info 

 M
ax

. A
dv

er
tis

ed
 D

ow
nl

oa
d 

Sp
ee

d 

1 < 200 kps. 0 0.0%   

Co
m

m
un

ity
 A

nc
ho

r I
ns

tit
ut

io
n 

Ca
te

go
ry

 C
ou

nt
 w

ith
 B

ro
ad

ba
nd

 
In

fo
rm

at
io

n 

1 School-K through 12 2109 1950 

2 >200 kps, < 768 kps. 0 0.0%   2 Library 252 209 

3 > 768 kps, < 1.5 mbps. 209 3.8%   3 Medical/healthcare 709 327 

4 > 1.5 mbps, < 3 mbps. 1292 23.4%   4 Public safety 1779 566 

5 > 3 mbps, < 6 mbps. 421 7.6%   5 
University, college, 
other post-secondary 55 43 

6 > 6 mbps, < 10 mbps. 280 5.1%   6 
Other community 
support-/gov't 601 305 

7 > 10 mbps, < 25 mbps. 913 16.6%   7 
 Other community 
support-non-/gov't 10 6 

8 > 25 mbps, < 50 mbps. 157 2.8%     Totals 5515 3406 

9 > 50 mbps, < 100 mbps. 10 0.2%             
10 > 100 mbps, < 1 gbps. 54 1.0%   

Public WI IF 1 Y 0   
11 > 1 gbps. 70 1.3%   2 N 5515   

  ZZ "null" 2109 38.2%             
            

     
           Middle Mile 

Data 
Type Code Data Element Count %   Data Type Code Data Element Count % 

Record 
Details   Total Records 926     

Fa
ci

lit
y 

Ty
pe

 1 Fiber 480 51.8% 

            2 Copper 5 0.5% 

Se
rv

ic
es

 
Pr

ov
id

er
 

De
ta

ils
 

  

Number of Distinct Providers 37     3 Hybrid Fiber Coax (HFC) 1 0.1% 
Number of Distinct "Doing 
Business As" 33     4 Wireless 440 47.5% 
Number of Distinct FRN 36       N/A "null" 0 0.0% 

                      
  

Owners
hip 

0 Owned 112 12.1%   

La
t /

 
Lo

ng
   # of Lat/Long in State 926 100% 

1 Leased 814 87.9%     Total Lat/Long 926 

  

                    

 F
ac

ili
ty

 
Ca

pa
ci

ty
 

1 
Multiple T1's and less than 40 
mbps. 409 44.2%           

2 
Greater than 40 mbps. and less 
than 150 mbps.  87 9.4%   El

ev
at

io n   Number of Data Points 425 
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3 
Greater than 150 mbps. and less 
than 600 mbps.  43 4.6%     Lowest Elevation 5 

4 
Greater than 600 mbps. and less 
than 2.4 gbps.  15 1.6%     Highest Elevation 225 

5 
Greater than 2.4 gbps. and less 
than 10 gbps.  2 0.2%             

6 Greater than 10 gbps 370 40.0%   
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Services Providers 

Ce
ns

us
 

Ro
ad

s 

W
ire

le
ss

 

M
id

 M
ile

 

  Broadband Services Providers Submitted 

# FRN Company Name Doing Business As 

1 0004311627 
Agate Mutual Telephone 
Cooperative Association Prairie Networks, LLC 31 214     

2 0004496774 AT&T Inc. AT&T Corp, Inc.     2 1 

3 0014860522 Baja Broadband Holding Company 
Baja Broadband Operating Company, 
LLC 995 138     

4 0003728292 Beulahland Communications, Inc., Beulahland Communications, Inc.,     1 1 

5 0003754652 
Bijou Telephone Co-op Association, 
Inc. 

Bijou Telephone Cooperative 
Association, Inc. 424 845 1 3 

6 0003766201 Blanca Telephone Company Blanca Telephone Company 2922 3252     
7 0017108747 Brainstorm Internet Brainstorm Internet     1   
8 0014778781 BySky, Inc. BySky, Inc.     1   
9 0018626853 CenturyTel, Inc. CenturyTel, Inc. 9884 30951   2 

10 0001621127 City of Glenwood Springs 
City of Glenwood Springs, 
Community Broadband Network 630 37 1   

11 0019898303 Cogent Communications, Inc.                                                                                                                                                                               Cogent Communications, Inc.                                                                                                                                                                               91       
12 9999 Colorado Mobile Inet,  LLC Colorado Mobile Inet,  LLC     1   
13 0002147098 Columbine Telecom Company FairPoint Communications 252 695   10 
14 0004441663 Comcast Cable Communications, LLC Comcast 46718 2987     
15 0007001977 CSC Holdings, LLC                                                                                                                                                                                         Bresnan Communications                                                                                                                                                                                    12117 12123     
16 0001617281 Delta County Tele-comm, Inc. TDS Telecom 825 753   1 
17 0003753753 DIECA Communications, Inc. Covad Communications Company 126221 4532   3 
18 0001629781 Dubois Telephone Exchange, Inc., DTE 62 153   3 
19 0013339973 Eagle Communications, Inc. Eagle Cable TV And Internet 237 29   1 

20 0004317731 
Eastern Slope Rural Telephone 
Association,  Inc. 

Eastern Slope Rural Telephone 
Association,  Inc. 1998 6511   12 

21 0003767852 Eschelon Telecom of Colorado, Inc.                                                                                                                                                                        Integra Telecom                                                                                                                                                                                           81507 20724     
22 0004338489 Farmers Telephone Company Farmers Telephone Company 179 907   1 
23 0005059092 Farmers Telephone Company Farmers Telecommunications                                                                                                                                                                                    1   
24 0015575285 Front Range Internet, Inc. Front Range Internet, Inc. 795 2   1 
25 0016084683 Grand County Internet Services, Inc.                                                                                                                                                                      Grand County Internet Services                                                                                                                                                                                1 1 
26 0001616200 Haxtun Telephone Haxtun  1023 1328     
27 0019794643 HighSpeed4U HighSpeed4U     1 1 
28 0002157550 IHateToWait.com, LLC IHateToWait     1 2 
29 0015866460 Internet Colorado Internet Colorado 364 54 1 10 
30 9999 Irish & Reynolds, Inc. Nednet     1   
31 0014175673 JAB Broadband Skybeam, Inc.     1 418 
32 0003766623 Jade Communications, LLC Jade Communications, LLC     1   
33 0002748044 James Cable LLC CommuniComm Services 692 3   1 
34 0003728284 J.e.d. Enterprises, Inc. J.e.d. Enterprises, Inc. 174 1499     
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35 0003723822 Level 3 Communications, LLC Level 3 Communications, LLC       365 
36 0002963528 Leap Wireless International, Inc. Cricket Communications, Inc.,     2   
37 0018769547 Magnolia Road Internet Coop MRIC     2 3 
38 9999 Nedernet, Inc. Nedernet, Inc.     1   
39 0003720471 New Edge Holding Company New Edge Networks, Inc. 968 23     
40 0004312187 Nucla-Naturita Telephone Company                                                                                                                                                                          Nucla-Naturita Telephone Company                                                                                                                                                                          187 190     
41 0004311809 Nunn Telephone Company Nunn Commuicatio, LLC 199 679   1 
42 0015246895 Open Range Communications Inc. Open Range Communications Inc.     1   
43 9999 OurayNet OurayNet     1 1 
44 0004314316 Phillips County Telephone Company PCTelecom     1 2 

45 0001615889 
Plains Cooperative Telephone 
Association, Inc., 

Plains Cooperative Telephone 
Association, Inc., 1171 3726 1 47 

46 0011099520 Qwest Corporation Qwest Corporation 97927 11461     
47 0005059092 Rico Telephone Company Rico Telephone Company 80 99   1 

48 0014705602 
Roggen Telephone Cooperative 
Company Roggen Telephone Enterprises, Inc.     1 1 

49 0001615665 Rye Telephone Company, Inc. ghValley.net 403 337 2 2 
50 0005061775 San Isabel Telecom, Inc. San Isabel Telecom, Inc.     1 5 

51 0004310769 
S&T Telephone Coop Association. 
Inc. S&T Telephone Coop Assoc Inc 22 29     

52 0016136327 SECOM SECOM     1   
53 0005070933 South Park Telephone Company, LLC ghValley.net     1 1 
54 0003774593 Sprint Nextel Corporation Sprint     2 1 
55 0001616390 Strasburg Telephone Company TDS Telecom 114 183   1 
56 0003723236 Sunflower Telephone Company FairPoint Communications 193 357   12 
57 0006945950 T-Mobile USA, Inc. T-Mobile     2 3 
58 0013430244 Time Warner Cable Time Warner Cable 931 1037     
59 0004351086 tw telecom inc.  tw telecom inc.  1050 3   2 
60 0003290673 Verizon Wireless Verizon Wireless     4   
61 0015360456 Viaero Wireless                                                                                                                                                                                           Viaero Wireless                                                                                                                                                                                               1   
62 0001616192 Wiggins Telephone Association Wiggins Telephone 648 2693   1 

63 0006275945 XO Communications, LLC 
XO Communications Services, Inc. 
(Affiliated Entity) 839 53     

 
NOTE 

          
 

0003723822 Level 3 Communications, LLC Level 3 Communications, LLC 466 Service Address   
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Distinct Speed Tiers Provided 

    
Allowable   

          Technology Codes   Down  Up 
 

  Speed Tier Codes   
 10 Asymmetric xDSL   3 to 8 2 to 7 

 
1 < 200 kps.     

 20 Symmetric xDSL   3 to 8 3 to 8 
 

2 >200 kps, < 768 kps.   
 30 Other Copper Wireless   3 to 8 2 to 8 

 
3 > 768 kps, < 1.5 mbps.   

 40 Cable Modem-DOCSIS 3.0   3 to 7 2 to 7 
 

4 > 1.5 mbps, < 3 mbps.   
 41 Cable Modem-Other   3 to 9 2 to 9 

 
5 > 3 mbps, < 6 mbps.   

 50 Optical Carrier/Fiber to End User 3 to 11 2 to 11 
 

6 > 6 mbps, < 10 mbps.   
 60 Satellite     3 to 6 2 to 6 

 
7 > 10 mbps, < 25 mbps.   

 70 Terrestrial Fixed Wireless-Unlicensed 3 to 6 2 to 6 
 

8 > 25 mbps, < 50 mbps.   
 71 Terrestrial Fixed Wireless-Licensed 3 to 6 2 to 6 

 
9 > 50 mbps, < 100 mbps.   

 80 Terrestrial Mobile Wireless   3 to 6 2 to 6 
 

10 > 100 mbps, < 1 gbps.   
 90 Electric Power Lines   3 to 6 2 to 6 

 
11 > 1 gbps.     

 0 All Other     3 to 11 2 to 11 
       

Distinct Speed Tiers Provided 

Maximum Advertised Speed   Typical Speed 

Technology Download Upload Freq.   Technology Download Upload Freq. 

10 3 2 1915   10 3 2 11514 
10 3 3 7250   10 3 3 7248 
10 4 2 25453   10 4 2 19852 
10 4 3 29412   10 4 3 25582 
10 4 4 80   10 5 2 27237 
10 5 2 4431   10 5 3 8250 
10 5 3 10617   10 6 2 2128 
10 5 4 240   10 6 3 17716 
10 5 5 295   10 7 3 26899 
10 6 2 9793   10 7 4 18915 
10 6 3 36535   10 8 4 8457 
10 7 3 37785   10 8 5 8457 
10 7 4 18915   10 8 7 23997 
10 8 4 46125   10 ZZ ZZ 17380 
10 8 5 8457   20 3 3 1749 
10 8 7 23997   20 4 4 62721 
20 3 3 851   20 6 6 53358 
20 4 4 10646   20 ZZ ZZ 16 
20 5 5 9012   30 3 3 3 
20 6 6 53358   30 4 4 8898 
30 3 3 452   30 5 5 69953 
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30 4 4 9312   30 6 6 36 
30 5 5 70076   30 7 7 113 
30 6 6 90   30 8 7 1405 
30 7 7 194   30 8 8 54 
30 8 7 1405   30 ZZ ZZ 1163 
30 8 8 96   41 5 4 695 
41 5 4 695   41 7 4 266 
41 6 3 49705   41 ZZ ZZ 77046 
41 6 6 1133   50 5 3 263 
41 7 3 26208   50 11 11 466 
41 7 4 266   50 ZZ ZZ 2768 
50 3 3 15   70 4 3 2 
50 4 4 4   70 5 2 1 
50 5 3 263   70 5 3 2 
50 5 5 14   70 5 4 1 
50 6 6 15   70 5 5 1 
50 7 3 996   70 6 6 1 
50 7 5 605   70 ZZ ZZ 5 
50 7 7 85   71 3 3 4 
50 8 8 18   71 4 3 2 
50 9 9 40   71 5 3 1 
50 10 10 941   71 ZZ ZZ 6 
50 11 11 35   80 3 2 1 
70 3 3 1   80 3 3 3 
70 4 3 2   80 4 2 1 
70 5 2 1   80 4 3 1 
70 5 3 4   80 5 3 1 
70 5 4 1   80 6 4 1 
70 5 5 2   80 6 5 1 
70 6 2 1   80 ZZ ZZ 5 
70 6 6 1 

 

71 3 3 4 
71 4 3 1 
71 4 4 2 
71 5 3 2 
71 5 5 2 
71 6 3 1 
71 6 6 1 
80 3 2 1 
80 4 2 1 
80 4 3 1 
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80 4 4 2 
80 5 3 1 
80 5 4 3 
80 6 4 1 
80 6 5 2 
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CONNECTICUT PROGRAM OVERVIEW 

 

In response to the Notice of Funds Availability published in the Federal Register on July 
8, 2009 (NOFA), the State of Connecticut Department of Public Utility Control (CT DPUC) 
submitted a grant application for consideration under the National Telecommunications and 
Information Administration’s (NTIA) State Broadband Initiative Grant Program (SBI), for 
broadband mapping. The CT DPUC, pursuant to Executive Order 32-A, was designated as the 
single Connecticut state entity eligible to apply for funds under this program.  

 In July of 2011, the CT DPUC was merged with the CT Department of Environmental 
Protection to form a new agency called the Department of Energy and Environmental Protection 
(CT DEEP). CT DEEP will now be the lead agency coordinating with NTIA on this program.  

The State has long been committed to regarding broadband delivery and enhanced use 
as a fundamental goal.  The State has developed a planning strategy to marshal the State’s 
resources and stakeholders and establish Connecticut as a leader in broadband usage, in 
addition to being a leader in “e-Government” and other broadband-dependent endeavors. 

 The State entered its SBI initiative not possessing any data related to broadband service, 
availability, or infrastructure that could readily support the requirements of the Broadband Data 
and Development grant program.  Due to technical considerations, DEEP has partnered with 
Applied Geographics Inc., to support the data collection and mapping efforts. 

 So far CT has been very successful in acquiring the requested information from the 
broadband service providers, and is utilizing this information on our own http://CT.gov/Broadband  
website as well as providing the needed information up to NTIA to support the national map. 

 

FALL 2011 SUBMISSION OVERVIEW 

For the fall 2011 submission (S4), roughly 75% of our providers submitted either entirely new or 
significantly revised data sets. This is a change from the last submission where half the providers just told 
us to reuse their existing data.  

In general, the submission 4 processes followed the same basic approach that was used in earlier 
submissions. This document summarizes the following: 

• Submission 4 Processing Assumptions 

• Reference Data Creation 

• Processing of new provider data 

• Conversion from Census 2000 to Census 2010 format 

• NTIA Submission Data Model Schema Changes 

SUBMISSION 4 PROCESSING ASSUMPTIONS 

http://ct.gov/Broadband
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Based on NTIA feedback and information provided in NTIA webinar sessions, the submission 4 data 
processing workflow is based on the following assumptions to meet NTIA submission requirements.  

1. All census blocks and road segments are mapped based on 2010 census data set.  Any data 
submitted in 2000 or 2009 format was converted to 2010 for submission.   

2. Overview was removed completely from this submission data due to the fact that all maximum 
advertised up/down speeds are being reported in blocks, roads, and wireless features. In 
addition, none of the providers were willing to submit detailed pricing information. 

3. Due to our NDA restrictions, last mile points will not be submitted to NTIA. 

4. Due to NDA restrictions and our inability to accurately flag service by “category of end user”, 
address points were not submitted to NTIA for any commercial provider.  

5. Some providers did not submit middle mile elevation.  Wherever possible, we went back to 
providers to obtain their middle mile elevation information, but it is not available for every 
record. 

6. Terrestrial Mobile Wireless and Terrestrial Fixed Wireless (licensed and unlicensed) were treated 
as wireless coverage and were delivered as a shape.  In cases where a provider served the same 
technology and spectrum with different speeds, overlapping areas were removed and the higher 
speed was assigned. 

7. If a cable based wireline provider can provide both DOCIS 2.0 and DOCIS 3.0 service to the same 
area, the block or road was listed only once with a technology code of 40. 

8. Providers were only willing to indicate on a general level if they severed business, residential or 
both, so we did not get any providers that broke down the type of service by block. Only if the 
provider stated they only serve business to business customers did we fill in the “category of end 
user” with a code of 2, otherwise this field was left blank. 

9. The submission 4 Provider data model is currently based on the NTIA data model as of 6/30/11.   



4 | P a g e  
 

SUBMISSION 4: REFERENCE DATA  

This section describes the reference data used in submission 4.   

BLOCK REFERENCE SETUP 

For s4, Census 2010 data was utilized.  The data was set up as follows: 

• Block size (AREA) is calculated combining the 2000 land area (ALAND) and water area (AWATER) 

• AREA is converted from square meters to square miles to calculate square mileage (SMI). 

• If the SMI of a block is less than or equal to 2, then the less than or equal to 2 square mile indicator 
(LE2SMI) is set to true. 

ROAD REFERENCE SETUP 

2010 Tiger Line IDs (TLID) were used for data processing in s4.   The data was set up as follows: 

• The GT2SMI (Greater Than 2 Square Mile) indicator is set to True when: 
o The 2010 road segment is completely within a block that is NOT less than 2 square miles 

• Only minimum and maximum address ranges and a single zip code for each road segment is 
maintained.   
 

SUBMISSION 4: PROCESSING OF NEW DATA  

For submission 4, AppGeo started data collection on July 6th 2011 by sending out data update requests and 
technical data specifications to all providers. This incorporated all the NTIA changes released on June 30th, 
2011.  These were sent to a large list of companies which were compiled from past collection efforts, and the 
revised FCC 477 list.   The technical document highlighted the changes from Submission 3 to Submission 4. 
Due to the change in census geography all new data was requested whenever possible.  

We then actively followed up with the providers. As we had discovered in the past, many of the providers 
listed on the FCC 477 list are either resellers, or not involved in the actual delivery of broadband. (Many are 
VOIP or teleconference service providers that utilize existing broadband connections.)  

In our solicitation for data updates, we told known past providers that if we didn’t hear from them by a certain 
date, we would default to using their data from Submission 3.  We contacted them after the due date a few 
times but for two providers, we eventually had to just reuse Submission 3 data. 

All data received went through the following processing steps: 

1. Triage: All new data was quickly reviewed to understand what was received, and in what format. We 
also made sure we had all the required components for NTIA’s data model, such as their FRN and 
advertised speed information. We also screened for any known issues that we might have seen 
before (such as Excel 2003 spreadsheets that cut off at 32k rows.) 

2. Ingest: At this time the data is actually brought into our systems. Each provider is set up with a 
unique file geodatabase to store their information. Record counts of what was received is logged so 
that we can validate we did not drop anything in processing.  

3. Data Processing: This is where the data goes through a number of ETL routines to convert the raw 
proprietary information into a format similar to the NTIA format. The exact routine utilized depends 
on how the data is received: 
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a. When a wireline provider submits a service boundary, we select all the blocks and roads 
inside that shape. 

b. If a wireline provider submits a customer address list, the points are geocoded, and then the 
appropriate block or road segment is selected. 

c. If a wireline provider submits block and road information using Census data, we just make 
sure everything is formatted to the appropriate specifications 

d. If the wireline provider submits any type of road or line data that does not direct correlate to 
the TIGER data set, we convert the lines to TIGER by selecting the road centroid and spatially 
selecting the closed segment in our data set. If the road is in a block less than 2sqmi, than 
the block is selected. Some manual cleanup is also applied to make sure we do not 
accidentally drop any road segments that should have been processed. 

e. Wireless provider data is formatted to ensure that there are no any overlapping polygons 
with the technology type. In addition the data is cropped to the state boundary. 

f. After each round of processing, we make sure that we only keep unique records. A unique 
record is defined as having a one of a kind combination of FRN, Block/Road ID, and 
technology type. If there are multiple records with different speeds, but all else is equal, 
than we select the maximum of the advertised speeds. 

4. QC Review: All data is then sent to a different analyst to perform a through quality control review on 
the processed data set. Record counts are compared to what was submitted. The QC staff also make 
sure the ETL scripts and routines populated all of the right fields. 

5. QA Review: Data is then sent to another team for Quality Assurance Review. In this step the data is 
not only double checked against what was originally submitted, but it also brought up inside 
standardized MXD templates that allow us to make sure our results make sense. This often involves 
comparing the new data set with prior submissions, as well as looking for any possible technology or 
speed anomalies. At this stage we also start in on our validation process. This includes looking at the 
provider data in comparison to things such as speed test results, franchise boundaries, siting 
information, and feedback from the planning surveys. 

6. Provider Review: Processed data is all posted to a customized web application we refer to as our 
Provider Portal. All providers were notified once their data was available in the site, and they were 
always given at least ten business days to review the data and respond. In this site, providers can log 
on and visually see their processed data in a map format. It also allows them to overlay their raw data 
to help them validate that we did indeed process things correctly. The provider portal also has a suite 
of markup tools that will allow the providers to edit their data, including adding or removing service 
areas, and making changes to the data attributes.  

7. Comment Processing:  All comments and feedback received from the provider portal, is then 
reviewed and applied to the processed data set. This updated data set goes back through our QA and 
QC processes, and if time allows, back out to the Provider Portal, for the provider to review and sign 
off on. 

8. Data Append: After all of the individual data sets are processed and approved, we run an append 
process which merges all of the individual provider data sets into one geodatabase. This is also the 
point where our team will do any final transformations to get our working data model into the latest 
NTIA publishing format.  

9. Final QA/QC:  A series of quality checks are run on the final appended data sets to ensure it is ready 
for submission to NTIA. We also run the NTIA receipt tool at this time. Any last issues are corrected, 
and the data is sent to the state for their review. 

10. Submission to NTIA 

 

As with the third data submission, we followed the following protocols: 



6 | P a g e  
 

1. We did not collect data from resellers  
2. We collected data from satellite providers, only if they were able to provide to us all 

of the required information we need to pass onto NTIA: including spectrum, FRN, 
and advertised speeds. 
   

COMMUNITY ANCHOR INSTITUTIONS DATA 

The community anchor institutions data was primarily populated through State resources, in particular the 
CEN database which services many schools, colleges, and libraries. We also were able to get a connection 
survey results for all the libraries through the state library association. Location information for all other CAI 
points, notably, police, fire, and town halls, were obtained through the Department of Public Safety.  All of this 
information was then populated into an online data gathering and validation web based application. Each 
town was contacted and asked to update their respective site information. While the web based responses 
have not been as high as we would like, we do feel that we are fortunate to have a good base set of data from 
the state.  

SUBMISSION 4: 2000 TO 2010 DATA CONVERSION PROCESS 

Due to the changes in census geography, all providers were asked to submit new data. In those instances 
when a provider A) submitted new data in Census 2000 format, or B) instructed us to reuse their last data 
submission, we had to convert the blocks and roads into 2010 format. 

Basic 2000 to 2010 Conversion Process:   

1. For the blocks, take the 2000 block ID, and select all the corresponding 2010 block id’s  
a. using census crosswalk table – not an actual spatial process, since this was faster 

2. Look at the new 2010 block ids, and filter on greater than or less than 2 sq miles. 
a. If less than or equal to 2 --> bring in the 2010 geometry and add that record to the blocks 

table 
b. If greater than 2 --> select any roads in that area – spatial select (using roads gt2 table) 

3. For the roads, take the 2000 or 2009 TLID and try to match it to the 2010 TLID’s 
a. If there is a match,  add that record to the roads table 
b. If there is not a match, select centroid of existing 2000/2009 segment, and select closest 

2010 road 
c. If the road is now in a block LT2, select the block(s) instead and drop the road 

4. Remove any duplicate records in both tables 
5. Run some automated checks to catch missed features (i.e. add le2smi blocks surrounded by roads 

that have not already been added) 
6. Manual review (QC) and corrections.  

a. There will be some blocks that are selected inappropriately (especially at town edges for CT 
providers, where we know their franchise ends at a town line.) 

b. There are some holes in the census crosswalk table 
c. The road conversion process may only select one portion of the road if it has now been 

broken into multiple segments 

 

Assumptions 

1. If a road was in an area greater than 2smi in s3, and due to census re-drawing, is now in an area less than 
2smi, we will grab blocks (le2smi) on both sides of that road and add them to the provider data: 

2.  If a new 2010 block, that is less than 2smi, is completely surrounded by roads and/or blocks served by that 
provider, than we will add the block to the provider service area. 
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SUBMISSION 4: NTIA DATA MODEL SCHEMA CHANGES  

 

The data model released on June 30, 2011 contained the following changes to the s3 data model: 

• The Category of End user field was added back in to the block and road tables. In addition the domain 
values were changed. 1 still represents residential, but a 2 now represents all non-residential uses.  

o This field is not required, and for many providers, was left blank since the data was not 
provided. 

 

CONNECTICUT SPECIFIC INFORMATION  

 
  
Due to Connecticut’s geography and population, 99.75% of the census blocks in the state are less than two 
square miles. The need for us to break apart coverage based on blocks versus roads leads to a lot of 
unnecessary confusion as well as creates some distorted pictures when you try to visualize this information on 
a map.  For this reason, all of the maps available on the CT.gov/broadband website are published after we 
convert all of the data to just use blocks.  
 
 In the documentation form NTIA there has been a lot of discussion about making sure that a provider 
uses the same DBA and FRN consistently across all feature classes. We mentioned this to the providers, but 
there was some push back. Most providers complied with this request, but a few providers pointed out that 
while they may share a common name, they actually operate as separate organizations. Also, due to 
regulatory implications of the different FRN’s a few providers did insist that their records not be combined.  

 The State of Connecticut has built and maintains the Connecticut Educational Network (CEN) which is 
a mostly fiber backbone connecting educational facilities all across the state to the internet. The way this 
network is set up, it is difficult to accurately identify who the final provider is and at what speeds. In particular, 
the CEN network will typically install one fiber uplink in each town, and then it is the town’s responsibility to 
provide connection between facilities. So for example CEN may supply the board of education’s office with a 
10mb connection, but then the board of education will run lines to each of the schools in the district. So towns 
are reluctant to report speed information as there may technically be 10mb available to the school, but 
reporting that speed at each school would grossly overestimate how much connectivity they have in total, 
when in fact there may be 15 schools sharing that same uplink. 

 Comcast cable has reported that they market their speed offerings based on MSA areas, which do not 
necessarily match up with their technology available in the field. So what this means is that there are some 
areas that may in fact have DOCIS 3.0 technology available, but the market they are in is still offering packages 
and speeds based on the older technology. This means you will see areas with technology type of 40, and 
advertised speed tiers of 7 or 8. We did work with the provider to make sure that any area that has technology 
type of 41 is not using the DOCIS 3.0 speed offerings. 

 One Communications Corporation has a few locations where they offer what they called stacked DSL 
service, and they confirmed in writing that these locations can offer aDSL with speeds in tiers 7 or 8. 

 We have already noted that PAETEC has listed most of their locations with an advertised speed of tier 
10, but in many cases are reporting typical speeds in tier 2. We have contacted the provider and they have 
simply responded that we should use the data as it was submitted. 
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Introduction 
The National Telecommunications and Information Administration (NTIA), a division of the U.S. 
Department of Commerce, through the Broadband Data Improvement Act (BDIA), has sponsored the 
State Broadband Data and Development Grant Program. This Program is designed to fund projects that 
gather comprehensive and accurate state‐level broadband mapping data, develop state‐level broadband 
maps, aid in the development and maintenance of a national broadband map, and fund statewide 
initiatives for broadband planning. 
 
The following white paper describes the data integration and verification processes employed by the 
District of Columbia in preparation of the Broadband Availability data set submitted to NTIA on October 
1, 2011. This data collection is to be conducted on a semi‐annual basis over a five‐year period.  The “Fall 
2011 Technical White Paper” will be the fourth of ten semi‐annual submissions by the District of 
Columbia and attempts to reflect conditions in the field as of June 30, 2011 or later. 
 
The paper is divided into seven sections: 
 

Section 1 ‐ Data Description: describes October 1, 2011 deliverables to NTIA. 
 
Section 2 ‐ Provider Participation: summarizes provider cooperation. 
 
Section 3 ‐ Data Collection: describes outreach and collection efforts. 
 
Section 4 ‐ DC geospatial data: describes the role of DC GIS data in broadband data processing. 
 
Section 5 ‐ Data integration and processing: describes data manipulation steps. 
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Section 6 ‐ Data validation: describes efforts to validate the data received. 
 
Section 7 – Documentation and Submittal: Includes the NTIA final checklist steps.  
 

SECTION 1 ‐ DATA SUBMISSION DESCRIPTION 

The District of Columbia’s fall 2011 submission consists of the following files: 

DC_SBDD_20111001.zip – Consolidates all other files for the purpose of data transfer. 

DC_SBDD_2011_10_01.gdb – An ESRI file based geodatabase that conforms to the data model 
distributed by NTIA.  It contains primary data and metadata. The District provides NTIA with five 
data sets: 

• Community Anchor Institutions – The location of community serving institutions and 
information about their broadband connections – if known. 

• Middle Mile Connections – The locations and attributes of infrastructure that 
interconnects broadband networks.    

• Wireless Broadband Availability – The service territories and attributes of wireless 
broadband providers including terrestrial fixed wireless and satellite.  

• Wireline Broadband Availability – The territories and attributes of wireline broadband 
providers with 2010 Census Block geography. 

• Metadata – Information about the data sets described above. 

DC_DataPackage_2011_10_01.xls –A report on broadband providers contacted and the status 
of their submissions. 

DC_2011_10_01.txt – An analysis of DC_SBDD_2011_10_01.gdb known as the “data submission 
receipt.” This file is created by an automated script supplied by NTIA. 

DC_Methodology_2011_10_01.pdf – An electronic version of the following document. 

DC_Readme_2011_10_01.txt – A reduced file with the same information found in the header 
and section 1 of this white paper. 

SECTION 2 ‐ PROVIDER PARTICIPATION 

• The PSC contacted 122 prospective broadband providers. 

• Of those, 38 are believed to be providing broadband service in the District and are listed in 
DC_DataPackage_2011_10_01.xls.  

• Of those, 27 meet the NOFA definition of available (either wireline and or wireless). 

• Eleven providers do not provide service in District within 10 days or are non‐responsive. 

• Ten provided middle mile data. 
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SECTION 3 ‐ DATA COLLECTION 

Collection of Broadband Availability Data 
The District of Columbia Office of the Chief Technology Officer (“OCTO”) was awarded a grant from NTIA 
to map the availability of broadband services in the District of Columbia (“District”).  OCTO has 
delegated to the District of Columbia Public Service Commission (“PSC”) the responsibility for all 
interaction, including data collection, with the broadband service provider community.  

 

Process Steps 

• Identifying and Contacting Broadband Providers ‐ The work of identifying providers is 

conducted by the PSC.  The PSC reviewed its own records and those of the FCC.  The initial 

identification of providers took place prior to the spring 2010 data call and has been refined for 

each NTIA submission.  Firms identified as providers were: 

o All firms in PSC records as providing any kind of telecommunications service in the 

District. 

o All firms identified by the FCC having filed a form 477 for broadband service in the 

District. 

o Satellite providers were also contacted.  

• Contacting providers ‐ The PSC requested the assistance and cooperation of all commercial 

broadband service providers that provide service to any residential, business, institutional, or 

government entity located within the District, to provide the PSC with broadband service 

location data. Whenever possible, providers are initially contacted by email. The package of 

material sent by the PSC to providers: 

o A letter from the Chairman of the District of Columbia Public Service Commission.  

Sample letters can be found in Appendix 1.  Providers receive one of three letters based 

upon their previous submission: 

 Providers that submitted Round 3 data, met the NOFA broadband service and 

availability definitions and were provided a Broadband Provider Portal account. 

 Providers that submitted Round 3 data and but did not meet the NOFA 

definitions. 

 Providers that did not submit Round 3 data or are new BSPs. 

o Non‐Disclosure Agreement (NDA) The PSC offers every provider opportunity to enter 

into a NDA between OCTO and the Provider.  The standard OCTO NDA is shown in 

Appendix 2.  The NDA explains how OCTO will handle the submitted data; including 

what portions of the data will be submitted to the NTIA and what derived products will 

become part of the public website on broadband services available within the District 

that is maintained by OCTO.  Key provisions of the District’s standard NDA include: 
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 OCTO will give the data to NTIA for the National Broadband Map. 

 The service territories of individual providers will not be made public by OCTO, 

but OCTO has created a public web site that allows users, including potential 

broadband service subscribers, to enter any valid address in the District of 

Columbia and be referred to all the broadband service providers offering service 

to that location. 

 Form 477 subscriber count data from all companies will be aggregated by OCTO 

at the Census Tract level.  OCTO will use this information to estimate the 

residential broadband adoption rate by Census Tract. Estimated broadband 

service adoption rates will be made public, but the market share of individual 

broadband service providers will not be revealed. 

o Provider submission form ‐ For fall 2011, OCTO and PSC revised the data request form.   

The form is a Microsoft Excel based questionnaire which is accompanied by a glossary. 

Appendix 3 contains a copy of the form and glossary. The form collects information on: 

 The Provider (Includes: business name, DBA name, FRN#, URL, etc.) 

 Transmission Technology 

 Business type (facility based or reseller) 

 Service Territory 

 Maximum advertised and typical upload and download speeds 

 Wireless spectrum 

 Middle mile connection points 

 

• Handling providers – While we hope that all providers complete our forms, not all do. In 

practice OCTO will accept a variety of submission types and our policy is to work with 

providers interactively via email and phone whenever we or they have questions. 
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SECTION 4 ‐ THE ROLE OF DC GEOSPATIAL DATA 

DC GIS maintains several datasets that are integral to processing provider submissions. Each dataset and 
how it is employed is described below: 

DC GIS Data Set 
(Click link to view 
and double click and 
zoom) 

Description   How the data is used in broadband processing  

Imagery   6” resolution 2010 
ortho corrected 
imagery  

GIS analysts superimpose provider service territory on 
imagery to ensure that submission fit the ground in a 
credible way. For example, do we have wireline service 
over water or parks?  

DC Base Map 1” to 100’ planimetric 
map. 

Used similarly to imagery. 

Master Address 
Repository 

A precisely located 
point for every address 
in the District 

Used to process address lists submitted by broadband 
providers. Also used to locate and map Community Anchor 
Institutions. 

Education 
Libraries 
Health 
Public Safety 
Recreation 

A variety of GIS layers 
that include 
Community Anchor 
Institutions locations  

Used to identify and survey as many Community Anchor 
Institutions as possible.  

Real Property Ownership data with 
use codes 

Used to ensure that broadband providers who provide to 
business are not shown as providing service in residential 
areas. 

InfoUSA ISP 
Connectivity 
Database 

Connectivity provider 
and connection type 
records by IP 

Used to verify provider service area. 
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SECTION 5 ‐ DATA INTEGRATION  

• Broadband Provider Data Submission Check‐in  

o Provider data submissions are received in several ways 

 Providers send email file attachments to the PSC. 

 Providers submit data by means of a USB drive. 

 Providers upload the data to a secure OCTO FTP site. 

 Provider mails the data to PSC or OCTO.  If data is received directly by OCTO, a 

GIS analyst will then check‐in the data, make a copy and submit the original to 

the PSC. 

 Provider notifies the PSC that data has not changed since last submission 

o PSC will then contact OCTO that new data has been received. 

o Scanned for viruses. 

o Entered into a submission tracking database. 

o Give an initial review to ensure that each major component is present.    

 

• OCTO Data Ingestion – The District of Columbia implemented new data submission and data 

processing tracking software developed by Applied Geographics for the fall 2011 data collection.  

After the submission has been checked in by the PSC and received by OCTO, the provider 

submission status is entered into a data tracker database to reflect the current status of receipt 

and contents of the submitted data package.     

 

• Wireline Data Processing ‐ The following information was collected. 

o Provider Name 

o Doing Business As 

o FRN (Federal Registration Number) 

o Census Tract and Block number 

o Technology of Transmission (DSL, Cable, etc.) 

o Maximum Download speed (greater than 768 kbps) 

o Maximum Upload Speed (greater than 200 kbps) 

o Typical Download Speed 

o Typical Upload Speed 

 

• Wireline Data Processing ‐ Geographic 

o Service territory description ‐ In order for a provider to be eligible and have their data 

processed, the Company’s service territory must offer broadband service to new 
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customers within 10 days of a service order without extraordinary effort.   Note: A 

Company can have multiple service territories within the District of Columbia, and those 

territories need not be contiguous.  NTIA requires that the service territory be mapped 

to the nearest Census Block.  Companies have several options for describing their 

service territory: 

o District‐wide broadband service provider.  The Company must offer broadband service 

to all customers of the entire District of Columbia.  If the Company meets the definition, 

the description of the Company’s service territory is complete.  This mainly applies to 

non‐residential only providers.  The following definitions apply: 

 “Broadband service” is the provision to end users of two‐way data transmission 

to and from the Internet with advertised speeds of at least 768 kilobits per 

second (Kbps) downstream and greater than 200 Kpbs upstream. 

 “Offer” means that the Company can provide broadband service to end users (a 

residential, business, institutional or government entity) within 10 business days 

of a service order without an extraordinary commitment of additional 

resources. It also interprets “offer” to be a commercial service.  We are not 

mapping free services such as Wifi hotspots at this time. District of Columbia 

Government free Wifi hotspots are included in the Community Anchor Data. 

 The “entire District of Columbia” means that a wireline company offers service 

to residential, business, institutional, or government end users in every Census 

Block in the District.  This definition expressly excludes parkland, cemeteries, 

institutional campuses, bodies of water, and military bases.  The definition also 

excludes real estate complexes where the landlord, condominium association, 

or similar entity controls the provision of wireline service.  Even if the firm 

doesn’t offer service in categories, it can still be a District‐wide provider, which 

simplifies the submission.  This caused some problems with OCTO’s fall 2010 

submission where we now believe some service territories where overstated.  

Any firm claiming to be a citywide provider received greater scrutiny, in 

particular, providers that service businesses only were restricted to reporting 

service to commercial, high density residential, and industrial areas as defined 

by property use codes. 

o Non District‐wide broadband service provider.   Any of the following may be attached 

to the e‐mail to describe the Company’s service territory: 

 A Detailed Map(s) – Submitted maps should delineate the service area 

boundaries and label all DC streets within those boundaries.  The map may be a 
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PDF file.  Geographic Information System (GIS) or Computer Aided Design files 

may be submitted in lieu of a map.   

 A List of Census Blocks – The Company may provide a list of Census Blocks in 

which they offer service.  The list should be provided in a Microsoft Excel File or 

Text File with each Census Block listed on a separate row.  

 
 

 A Written Description – The Company may describe one or more polygons.  For 

example, a service territory in part of downtown could be described as “East of 

23rd Street NW, South of K Street NW, West of 17th Street NW, North of 

Constitution Ave NW. “  Alternatively, the territories can be described by using 

buffers,  for example, “Within 500 feet of 441 4th Street NW Washington DC 

20001.”   

 Address File ‐ If service is only offered to certain addresses, a list of those 

addresses may be submitted.   Address lists (whether for buffering or not) 

should be submitted in a Microsoft Excel table or text file with each address on 

a separate row. Address lists are geocoded to the structure using the District’s 

Master Address Repository. OCTO encourages providers to submit all addresses 

where service can be provided within 10 days not just the address of current 

subscribers.     

 Form 477 – The Form 477 already includes a list of Census Tracts where the firm 

has existing customers.  Census Blocks nest within Census Tracts.  Optionally, 

the Company may indicate that it wishes to use the Census Tracts already listed 

within its Form 477, minus a list of Census Blocks within those Tracts in which it 

does not offer service. 
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• Wireless Data Processing – Wireless providers often provide a polygon shapefile of their 

coverage area(s) and if they were an existing provider they communicate if the coverage 

information has changed.  The majority of wireless provider’s service areas are District‐wide.  

The following information was collected. 

o Provider Name 

o Doing Business As 

o FRN (Federal Registration Number) 

o Technology of Transmission (DSL, Cable, etc.) 

o Spectrum 

o Maximum Download speed (greater than 768 kbps) 

o Maximum Upload Speed (greater than 200 kbps) 

o Typical Download Speed 

o Typical Upload Speed 

 

• Middle Mile Data Processing ‐ Broadband service providers were also asked to list “middle‐mile and 

backbone interconnection points” in the District of Columbia.  Interconnection points are facilities 

that provide connectivity between (a) a service provider’s network elements (or segments) or (b) 

between a service provider’s network and another provider’s network, including the Internet 

backbone. Collectively, (a) and (b) are middle‐mile and backbone interconnection points.  The 

following information was collected. 

o Provider Name 

o Dosing Business As Name 

o FCC Registration Number 

o Ownership Status 

o Serving Facility Capacity 

o Serving Facility Type 

o Location 

o Elevation 

 

• Community Anchor Institutions ‐ As part of the reporting requirements for the grant, OCTO is 
required to collect a list of Community Anchor Institutions (CAI) and report broadband service 
available at these institutions.  The dataset consists of schools, libraries, medical and healthcare 
providers, public safety entities, institutions of higher education, and other community support 
entities.  Data is compiled from various district agencies and by contacting institutions directly.  Non‐
government community anchors were contacted individually to complete an online survey. The 
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survey requested the internet service type and service speed at the institution's location(s). 
Appendix 4 contains a copy of the Community Anchor Survey online form. 
 

• Data Review and Consultation with Providers 
o If a component of the submission is missing, the OCTO GIS analyst will contact PSC for assistance 

to receive the missing data from the provider. 

o PSC and OCTO will schedule several meetings before final submittal: to review what providers 

have submitted data and who has not, discuss action points that need to be addressed, and 

review the process for areas of improvement. 

o As a result of inquiries from NTIA about DC’s round 2 data, we are spending more time talking to 

providers, particularly those who claim to offer citywide service.  Most providers respond openly 

and are willing to make changes to their submissions when questions are raised.  

o The NTIA receipt script is run against each provider submitted dataset separately. Repairs and 

reruns are iterated until the dataset successfully passes. 
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SECTION 6 ‐ DATA VALIDATION 

During this stage, data from providers are compared with data from other sources. Discrepancies are 

noted and sent to the contributing provider for comment. Validation techniques vary by the type of data 

submitted [wireless, wire line, or middle‐mile].   The following steps were taken to validate the data 

submitted:   

 

• Wireless Validation ‐ The District completed drive testing of major wireless providers.  Drive test 

were completed in a single vehicle employing multiple laptops and GPS.  This was accomplished by 

installing computer and GPS hardware and software in a vehicle and testing and mapping upstream 

and downstream transmission speeds.  At this time, DC has not shown the drive test data to 

providers nor discussed our collection techniques with them.  This data was collected with public 

funds and is not covered by NDAs, but DC has not made a decision to release it publically at this 

time.  All providers who claim to be providing citywide wireless service are providing it, and to that 

end DC will declare all providers who submitted service territories to be "valid”.  That said, speed of 

service does drop below the definition of broadband, and does vary across providers, place, and 

time.  The District did not conduct new drive testing for fall 2011. The fall 2010 drive testing results 

can be found in Appendix 5.  

 

• Wireline Validation 

• The District, through PSC, has made extensive use of FCC Form 477 data.  The Form 477 is used 

to, verify that we have contacted the correct providers, compare the technology of transmission 

and speed of transmission between what was reported to the FCC and what was submitted by 

the provider, compare the geography reported to the FCC by census tracts with the areas 

submitted to the District by census blocks.  When discrepancies are found, the providers are 

asked for more information.  

• The District purchased a database of broadband subscribers from a commercial mailing list 

company InfoUSA.  The dataset is used to crosscheck data coming from providers.  The 

commercial mailing is not definitive.   When discrepancies are found, the providers are asked for 

more information.  

 

• Middle Mile Validation – To date the district has not attempted to validate middle mile data other 

than checking locations against GIS base data to be sure they are plausible.  

 

• Final Review ‐ All data undergoes a standup review conducted jointly by OCTO and PSC staff. Do 

service territories seem plausible? Do speeds seem realistic? How do speeds compare to other 

11 
 



providers using similar technologies? What is the total DSL, Cable, Fiber coverage and does it seem 

plausible?    

 

• Amalgamation and documentation ‐ Unless a provider's submission is conclusively invalidated 

(which hasn’t happened) and the issue cannot be resolved with the contributing provider, it is 

included in the amalgamation phase. Until this stage, OCTO handles each submission separately. 

During this stage, all successful submissions are appended to the latest version of the NTIA/NSGIC 

geodatabase model, and requested transmittal forms are prepared. 

o The data is appended to the NTIA geodatabase model. 

o The amalgamated data is given a final quality review by the GIS Analysts involved in the 

broadband grant program. 

o FGDC Compliant metadata is prepared and included in the geodatabase. 

o The NTIA provided script is run for the last time on the data set as a whole. 
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SECTION 7 ‐ DOCUMENTATION AND SUBMITTAL 

Once past the quality review, the data sets are submitted to NTIA/FCC via secure FTP. FCC data package 

documents are included. The checklist provided by NTIA is below: 

 

Number  Question 

1 
Have you obtained a new clean Transfer Data 
Model? 

2 
Have you followed the instructions for loading 
data into the Transfer Data Model? 

3 
Have you run the receipt process 
(SBDD_CheckSubmission) and resolved all data 
integrity issues? 

4 
Have you included your receipt text file as part of 
the package? 

5  Have you populated the metadata fields? 

6  Have you exported the metadata as .xml files?

7 
Have you obtained a new data_package.xls and 
filled it out appropriately? 

8  Have you included methodological description?

9 
Have you followed the required naming 
conventions of all the files? 

10 

If you are resubmitting any data for the current 
collection, have you (a) deleted your previous 
submission (b) informed the Program Office or 
the FCC of your resubmission and (c) resubmitted 
your entire data package (e.g., the Program Office 
is not accepting an partial submissions)? 
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Appendix 1 
Sample Letters 

From 
DC Public Service Commission 

To 
Prospective Broadband Providers 
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PSC Letter to Providers that submitted Round 3 data, meet the NOFA requirements and 
assigned a Provider Portal account. 

 

Dear (Insert Name of BSP contact): 

The District of Columbia (“District”) Office of the Chief Technology Officer (“OCTO”)  and the Public 
Service Commission (“Commission”) would like to thank you for your continued participation in the 
District’s Broadband Service Mapping Program.   To meet the objectives under the National 
Telecommunications and Information Administration (“NTIA”) State Broadband Data and Development 
Grant Program, the Commission requests the assistance and cooperation of all broadband service 
providers that enable a residential, business, institutional, or government entity located within the 
District to use broadband Internet services.  At this time, the Commission is now requesting broadband 
service availability data current as of June 30, 2011 for processing and review before submittal to NTIA 
for the Fall 2011 National Broadband Map and database update. 

As a means to improve data updates and validation, the District is pleased to announce a new online 
Broadband Provider Portal (“Portal”) for participating broadband service providers.  This new mapping 
application allows broadband service providers to view the dataset for their company from the last data 
submission and make edits to reflect current service availability in the District through a secure login 
account.  A user manual and video demonstration are available on the Portal for your review.  A secure 
login account has been created for your use and is provided at the end of this letter.  Using the 
Broadband Provider Portal to provide us with updated service availability data eliminates any need for 
you to complete a Questionnaire such as what we have sent you in previous data request rounds.   

Please note that the NTIA has requested that data should be submitted using the Census 2010 
geography.  To allow an adequate time period for OCTO to convert the submitted data to the Census 
2010 geography, the Commission requests broadband service providers to submit their data updates 
on the Portal by Friday, August 19, 2011.   

Due to the new Broadband Provider Portal application and conversion to a new Census geography, a list 
of data submission options is outlined below. 

1. Please help us by using the Portal to provide: 

a. Changes that have occurred in your company’s service areas, technologies, speeds, 
infrastructure, etc. since the last data submission.  

i. The Portal’s map application displays the processed data from your last 
submission.  Please note the data is currently being displayed with the Census 
2000 geography.  After you make the edits to the Portal page for your company, 
OCTO will process the data to the Census 2010 geography.  At that time, we will 
ask you to help resolve any discrepancies that arise from the conversion as well 
as to validate the data.  

ii. New full dataset. 
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1. If you are providing NTIA ready data, please make sure you have 
converted your data to the Census 2010 geography. 

2. If you are providing address points, OCTO will geo‐code and process the 
data to the Census 2010 geography. 

3. Use one the data formats below for your company’s service area.  Each 
data format should include: technology of transmission; maximum 
advertised download and upload speed; and typical download and 
upload speed. 

a. GIS or CAD file(s); 
b. Text file or Excel Spreadsheet listing existing and potential 

customer addresses; or 
c. Text file or Excel Spreadsheet with a list of Census Blocks with 

Census Tract numbers 
b. For wireless service providers, the change in the Census 2010 geography does not have 

any impact on your data.   
c.  

2. If the data has not changed since the last submission, please send an e‐mail to Mr. Virgil J. 
Young, Jr., Senior Telecommunications Analyst, at vyoung@psc.dc.gov and OCTO will use the 
data from the previous submission.  Please note that your data will require validation even if 
there are no changes in your service to ensure the conversion from the Census 2000 to the 
Census 2010 geography is correct. 
 

3. If your company is primarily a non‐residential broadband service provider, please let Mr. Young 
know that as well – NTIA has requested this specific information for the Fall 2011 data 
submission. 
 

4. Also, please send an email to Mr. Young if your company has merged, sold, or bought another 
broadband service provider in the District or if your company has ceased operations in the 
District, as that can have an impact on the data submitted to the NTIA. 

 
5. If your company does not currently provide broadband Internet access services to a 

residential, business, institutional, or government entity located within the District, please 
send an email confirming your company’s non‐provider status to Mr. Young. 

The District’s Broadband Provider Portal login page can be accessed at the following URL:  

 

http://host.appgeo.com/DistrictofColumbiaProviderPortal/ 

 

Your secure login account is provided as follows: 

 

Username: 

Password: 
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To help OCTO identify any improvements or changes in the adoption rates for broadband services within 
the District, I request that you also provide us with a copy of your company’s Broadband Service Report 
for the District of Columbia (Form 477) filed with the Federal Communications Commission (“FCC”) on or 
before September 1.  A PDF copy of the Form 477 for the District should be submitted by email to Mr. 
Young as soon as possible after the FCC’s September 1 filing deadline.   A secure FTP site is available for 
companies that prefer that method of transmittal. 

If your company submitted, in association with a previous broadband data submission, a Non‐Disclosure 
Agreement (“NDA”) with OCTO, it is still effective and will be honored.  If your company would like to 
sign a NDA with OCTO please email your request to Mr. Young.  (The NDA explains how OCTO will 
handle the submitted data; including what portions of the data will be submitted to the NTIA and what 
derived products will become part of OCTO’s website on broadband services available in the District.) 

Thank you in advance for completing this data request.  We have attempted to make the process 
minimally burdensome, but understand that questions may arise.  Should you have any questions 
regarding this data request, please contact my Policy Advisor, Cary B. Hinton, at chinton@psc.dc.gov or 
202‐626‐9186. 

  

Thank you for your assistance, 

Betty Ann Kane 

Chairman 

District of Columbia Public Service Commission 

 

Attachments: 

1. Broadband Data Definitions – Fall 2011 
2. Provider Data Validation ‐ Instruction Manual 
 
 

NTIA Definition of Terms 

 “Broadband service” is the provision of data transmission technology that provides two‐way data 
communication with the Internet with advertised speeds of at least 768 kilobits per second (kbps) 
downstream and greater than 200 kbps upstream to end users.  
Internet Service Providers (ISPs) are not “end users” for this purpose. An entity is a “facilities‐based” 
provider of broadband service connections to end user locations if any of the following conditions are 
met: (1) it owns the portion of the physical facility that terminates at the end user location; (2) it obtains 
unbundled network elements (UNEs), special access lines, or other leased facilities that terminate at the 

17 
 

mailto:chinton@psc.dc.gov


end user location and provisions/equips them as broadband; or (3) it provisions/equips a broadband 
wireless channel to the end user location over licensed or unlicensed spectrum.  
Service is “available” at an address if the provider currently provides service to a location, or if 
broadband service could be established, without an extraordinary commitment of resources, in a 7 to 10 
business day period. 
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PSC Letter to Providers that submitted Round 3 data and didn’t meet the NOFA requirements 

 

Dear (Insert Name of Group #2 BSP contact): 

The District of Columbia (“District”) Office of the Chief Technology Officer (“OCTO”)  and the Public 
Service Commission (“Commission”) would like to thank you for your continued participation in the 
District’s Broadband Service Mapping Program.   To meet the objectives under the National 
Telecommunications and Information Administration (“NTIA”) State Broadband Data and Development 
Grant Program, the Commission requests the assistance and cooperation of all broadband service 
providers that enable a residential, business, institutional, or government entity located within the 
District to use broadband Internet services.  At this time, the Commission is now requesting broadband 
service availability data current as of June 30, 2011 for processing and review before submittal to NTIA 
for the Fall 2011 National Broadband Map and database update.   

The completed broadband service data submission document, see attached “DC Broadband Mapping 
Questionnaire ‐ Fall 2011” (“Questionnaire”), should be submitted to the Commission as an attachment 
to an e‐mail response to Virgil J. Young, Jr., Senior Telecommunications Analyst, at vyoung@psc.dc.gov.  
Please note that the NTIA has requested that data should be submitted using the Census 2010 
geography.  The Commission requests broadband service providers to submit the questionnaire and 
data by Friday, August 19, 2011.   

A list of data submission options is outlined below. 

1.  New full dataset. 
a. If you are providing NTIA ready data, please make sure you have converted your data to the 

Census 2010 census block geography. 
b. If you are providing address points, OCTO will geo‐code and process the data to the Census 

2010 geography. 
c. Use one the data formats below for your company’s service area.  Each data format should 

include: technology of transmission; maximum advertised download and upload speed; and 
typical download and upload speed. 

a. GIS or CAD file(s); 
b. Text file or Excel Spreadsheet listing existing and potential customer 

addresses; or 
c. Text file or Excel Spreadsheet with a list of Census Blocks with 

Census Tract numbers 
 

2. If the data has not changed since the last submission, please send an e‐mail to Mr. Young and OCTO 
will use the data from the previous submission. Please note: If a service area was provided last 
submission, your data will require validation to ensure the conversion from the Census 2000 to the 
Census 2010 geography is correct.  Even if there are no changes in your service. 
 

3. Also, please send an email to Mr. Young if your company has merged, sold, or bought another 
broadband service provider in the District or if your company has ceased operations in the District, 
as that can have an impact on the data submitted to the NTIA. 
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4. If your company does not currently provide broadband Internet access services to a residential, 

business, institutional, or government entity located within the District, please send an email 
confirming your company’s non‐provider status to Mr. Young. 

To help OCTO identify any improvements or changes in the adoption rates for broadband services within 
the District, I request that you also provide us with a copy of your company’s Broadband Service Report 
for the District of Columbia (Form 477) filed with the Federal Communications Commission (“FCC”) on or 
before September 1.  A PDF copy of the Form 477 for the District should be submitted by email to Mr. 
Young as soon as possible after the FCC’s September 1 filing deadline.   A secure FTP site is available for 
companies that prefer that method of transmittal. 

If your company submitted, in association with a previous broadband data submission, a Non‐Disclosure 
Agreement (“NDA”) with OCTO, it is still effective and will be honored.  If your company would like to 
sign a NDA with OCTO please email your request to Mr. Young.  (The NDA explains how OCTO will 
handle the submitted data; including what portions of the data will be submitted to the NTIA and what 
derived products will become part of OCTO’s website on broadband services available in the District.) 

Thank you in advance for completing this data request.  We have attempted to make the process 
minimally burdensome, but understand that questions may arise.  Should you have any questions 
regarding this data request, please contact my Policy Advisor, Cary B. Hinton, at chinton@psc.dc.gov or 
202‐626‐9186. 

 

Thank you for your assistance, 

Betty Ann Kane 

Chairman 

District of Columbia Public Service Commission 

 

Attachments: 

3. DC Broadband Mapping Questionnaire – Fall 2011 
4. Broadband Data Definitions – Fall 2011 
 
 

NTIA Definition of Terms 

 “Broadband service” is the provision of data transmission technology that provides two‐way data 
communication with the Internet with advertised speeds of at least 768 kilobits per second (kbps) 
downstream and greater than 200 kbps upstream to end users.  
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Internet Service Providers (ISPs) are not “end users” for this purpose. An entity is a “facilities‐based” 
provider of broadband service connections to end user locations if any of the following conditions are 
met: (1) it owns the portion of the physical facility that terminates at the end user location; (2) it obtains 
unbundled network elements (UNEs), special access lines, or other leased facilities that terminate at the 
end user location and provisions/equips them as broadband; or (3) it provisions/equips a broadband 
wireless channel to the end user location over licensed or unlicensed spectrum.  
Service is “available” at an address if the provider currently provides service to a location, or if 
broadband service could be established, without an extraordinary commitment of resources, in a 7 to 10 
business day period. 
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PSC Letter to Providers that did not submit Round 3 data or are new BSPs 

 

Dear (Insert Name of Group #3 BSP contact): 

The District of Columbia Office of the Chief Technology Officer (“OCTO”) has been awarded a grant from 
the U. S. Department of Commerce, National Telecommunications and Information Administration 
(“NTIA”) to map the availability of broadband services in the District of Columbia (“District”).  Pursuant 
to a Memorandum of Understanding, OCTO has delegated to the District of Columbia Public Service 
Commission (“Commission”) the responsibility for all interaction, including data collection, with the 
broadband service provider community.  To meet the objectives under the NTIA’s State Broadband Data 
and Development Grant Program, the Commission requests the assistance and cooperation of all 
broadband service providers that enable a residential, business, institutional, or government entity 
located within the District to use broadband Internet services.  At this time, the Commission is now 
requesting broadband service availability data current as of June 30, 2011 for processing and review 
before submittal to NTIA for the Fall 2011 National Broadband Map and database update.   

The completed broadband service data submission document, see attached “DC Broadband Mapping 
Questionnaire ‐ Fall 2011” (“Questionnaire”), should be submitted to the Commission as an attachment 
to an e‐mail response to Virgil J. Young, Jr., Senior Telecommunications Analyst, at vyoung@psc.dc.gov.  
Please note that the NTIA has requested that data should be submitted using the Census 2010 
geography.  The Commission requests broadband service providers to submit the questionnaire and 
data by Friday, August 19, 2011.   

A list of data submission options is outlined below. 

 

1.  New full dataset. 
a. If you are providing NTIA ready data, please make sure you have converted your data to 

the Census 2010 block geography. 
b. If you are providing address points, OCTO will geo‐code and process the data to the 

Census 2010 block geography. 
c. Use one the data formats below for your company’s service area.  Each data format 

should include: technology of transmission; maximum advertised download and upload 
speed; and typical download and upload speed. 

a. GIS or CAD file(s); 
b. Text file or Excel Spreadsheet listing existing and potential 

customer addresses; or 
c. Text file or Excel Spreadsheet with a list of Census Blocks with 

Census Tract numbers 
2. Also, please send an email to Mr. Young if your company has merged, sold, or bought another 

broadband service provider in the District or if your company has ceased operations in the 
District, as that can have an impact on the data submitted to the NTIA. 
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3. If your company does not currently provide broadband Internet access services to a 
residential, business, institutional, or government entity located within the District, please 
send an email confirming your company’s non‐provider status to Mr. Young. 

To help OCTO identify any improvements or changes in the adoption rates for broadband services within 
the District, I request that you also provide us with a copy of your company’s Broadband Service Report 
for the District of Columbia (Form 477) filed with the Federal Communications Commission (“FCC”) on or 
before September 1.  A PDF copy of the Form 477 for the District should be submitted by email to Mr. 
Young as soon as possible after the FCC’s September 1 filing deadline.   A secure FTP site is available for 
companies that prefer that method of transmittal. 

If your company would like to sign a Non‐Disclosure Agreement (“NDA”) with OCTO, please email your 
request to Mr. Young.  (The NDA explains how OCTO will handle the submitted data; including what 
portions of the data will be submitted to the NTIA and what derived products will become part of 
OCTO’s website on broadband services available in the District.) 

Thank you in advance for completing this data request.  We have attempted to make the process 
minimally burdensome, but understand that questions may arise.  Should you have any questions 
regarding this data request, please contact my Policy Advisor, Cary B. Hinton, at chinton@psc.dc.gov or 
202‐626‐9186. 

  

Thank you for your assistance, 

Betty Ann Kane 

Chairman 

District of Columbia Public Service Commission 

 

Attachments: 

5. DC Broadband Mapping Questionnaire – Fall 2011 
6. Broadband Data Definitions – Fall 2011 
 
 

NTIA Definition of Terms 

 “Broadband service” is the provision of data transmission technology that provides two‐way data 
communication with the Internet with advertised speeds of at least 768 kilobits per second (kbps) 
downstream and greater than 200 kbps upstream to end users.  
Internet Service Providers (ISPs) are not “end users” for this purpose. An entity is a “facilities‐based” 
provider of broadband service connections to end user locations if any of the following conditions are 
met: (1) it owns the portion of the physical facility that terminates at the end user location; (2) it obtains 
unbundled network elements (UNEs), special access lines, or other leased facilities that terminate at the 
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end user location and provisions/equips them as broadband; or (3) it provisions/equips a broadband 
wireless channel to the end user location over licensed or unlicensed spectrum.  
Service is “available” at an address if the provider currently provides service to a location, or if 
broadband service could be established, without an extraordinary commitment of resources, in a 7 to 10 
business day period. 
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Appendix 2 
Standard Non‐Disclosure Agreement 
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NON-DISCLOSURE AGREEMENT 

(District of Columbia Broadband Service Mapping) 

This Non-Disclosure Agreement (“Agreement”) is between the Office of the Chief 
Technology Officer of the District of Columbia (“OCTO”) and __________________ 
(“Company”), a corporation having a business address at ____________________ 
__________________________________________________________________. 

RECITALS 

A. Company wishes to disclose and OCTO wishes to receive certain information from 
Company represented by Company to be confidential and commercial / proprietary 
information (hereinafter collectively, “Information”) pertaining to _________________.  
This exchange includes all communication of Information between the parties in any 
form whatsoever, including oral, written and machine readable form, pertaining to the 
above. 

B. OCTO wishes to receive and Company wishes to disclose the Information for the 
sole purpose of participating in national broadband service mapping activities.  OCTO 
will disclose the information only in the following ways:  

To The public: 

- The service territories of individual providers will not be made public, but OCTO 
will create a public web site that allows users, including potential broadband 
service subscribers, to enter any valid address in the District of Columbia and be 
referred to all the broadband service providers offering service to that location.  
 

- Form 477 subscriber count data from all companies will be aggregated by OCTO 
at the Census Tract level.  OCTO will use this information to estimate the 
residential broadband adoption rate by Census Tract. Estimated broadband 
service adoption rates will be made public, but the market share of individual 
broadband service providers will not be revealed. 

 
To the U.S. Department of Commerce, National Telecommunications and Information 
Administration (NTIA): 
 

- The broadband service data required by the NTIA in the Notice of Funds Availability; 
clarification published in the Federal Register; August 7, 2009 (74 FR 40569).     
 

To the Metropolitan Police Department and the District of Columbia Homeland Security and 
Emergency Management Agency: 
 

- Middle-mile connection points will be added to the District’s critical infrastructure data 
base.   This critical infrastructure database is used only for public safety purposes.  
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These data will not be shared outside law enforcement and homeland security 
communities. 

 

AGREEMENTS 

Therefore, OCTO and Company agree as follows: 

1. That the disclosure of Information by Company is in confidence and thus OCTO 
agrees to: 

a. (1) Not disclose the Information to any other person, and (2) use at least the same 
degree of care to maintain the Information confidential as OCTO uses in maintaining as 
confidential its own confidential information, but always at least a reasonable degree of 
care; 

b. Use the Information only for the above purpose; 

c. Restrict disclosure of the Information solely to those employees or contract staff of 
OCTO having a need to know such Information in order to accomplish the purposes 
stated above; The District Government operates an in-house broadband service 
provider known as DC Net, accordingly, the Information expressly will not be shared by 
OCTO with DC Net as an organization or its employees.  

d. Advise each such individual, before he or she receives access to the Information, of 
the obligations of OCTO under this Agreement, and require each such individual to 
maintain those obligations. 

2. This Agreement imposes no obligation on OCTO with respect to any portion of the 
Information received from Company which:  (a) was known to OCTO prior to disclosure 
by Company, (b) is lawfully obtained by OCTO from a third party under no obligation of 
confidentiality, (c) is or becomes generally known or publicly available other than by 
unauthorized disclosure, (d) is independently developed by OCTO or (e) is disclosed by 
Company to a third party without a duty of confidentiality on the third party. 

3. This Agreement imposes no obligation on OCTO with respect to any portion of the 
Information unless such portion is: (a) disclosed in a written document or machine 
readable media marked as “COMMERCIAL / PROPRIETARY INFORMATION” at the 
time of disclosure, or (b) disclosed in any other manner and summarized in a 
memorandum mailed to OCTO within thirty (30) days of the disclosure. Information 
disclosed by Company in a written document or machine readable media and marked  
“COMMERCIAL / PROPRIETARY INFORMATION” includes, but is not limited to, the 
items, if any, set forth in the request for broadband service data from the District of 
Columbia Public Service Commission (“Commission”); attached hereto. The 
Commission’s request for broadband service data is incorporated herein by reference. 
OCTO hereby acknowledges receipt of the items listed in the Commission’s request for 
broadband service data, if any. 
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4. The Information shall remain the sole property of Company. 

5. In the event of a breach or threatened breach or intended breach of this Agreement 
by either party, the other party shall be entitled to preliminary and final injunctions, 
enjoining and restraining such breach or threatened breach or intended breach. 

6. OCTO agrees it will not export, directly or indirectly, any technical data acquired from 
Company or any product utilizing any such data to any country for which the U.S. 
Government or any agency thereof at the time of export requires an export license or 
other governmental approval, without first obtaining such license or approval. 

7. The validity, construction, and performance of this Agreement are governed by the 
laws of the District of Columbia, and suit may be brought in the District to enforce the 
terms of this Agreement. 

8. The rights and obligations of the parties under this Agreement may not be sold, 
assigned or otherwise transferred. 

This Agreement is binding upon OCTO and Company and upon the directors, officers, 
employees and agents of each. This Agreement is effective as of the later date of 
execution and will continue indefinitely.  

Office of the Chief Technology Officer of the District of Columbia 

By 

Name:_______________________________ 

Title:________________________________ 

Date:________________________________ 

(Company) 

By: 

Name:_______________________________ 

Title:________________________________ 

Date:__________________________________ 
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Appendix 3 
Provider Questionnaire and Glossary 

Microsoft Excel 
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Figure 1. Contact and Broadband Service 

 
 

Business Type

Districtwide* 
Code  Description  Yes/No Upload Speed 

(Ex.1) Yes  768 kbps to 1.49 mbps
1
2
3
4
5

Length of time to 
provide service

50 Optical Carrier (Fiber to end user)   0 All Other

40 Cable Modem -  DOCSIS 3.0    80 Mobile Wireless
41 Cable Modem - Other   90 Electric Power Line

20 Symmetric  (xDSL)   70 Terrestrial Fixed Wireless - Unlicensed
30 Other Wireline   71 Terrestrial Fixed Wireless - Licensed

Technology  Length of time to
 provide service

Technology

10 Asymmetric  (xDSL)   60 Satellite

       
* Districtwide Definition : The Company must be able to “offer broadband service” to the “entire District of Columbia”, (residential, business, institutional or government 
entity within 10 business days  of a service order without an extraordinary commitment of additional resources.) with advertised speeds of at least 768 kilobits per 
second (Kbps) downstream and greater than 200 Kpbs upstream .

1.5  For each Technology of Transmission that was selected in 1.2 how long does it take to provide service to a customer after service has been ordered? 
(Click on the cell next to each Technology you provide and select the length of time from a drop-down list).

       
       

   
       

Download Speed Upload Speed Download Speed 
10 Asymmetric  768 kbps to 1.49 mbps 201 to 767 kbps 1.5 to 2.9 mbps

1.3  If your company is a resller, who is the facility based provider(s)?

 

1.4 Complete the following dropdown table  for each Technology of Transmission that your company provides.
(One row for each Technology of Transmission - click on the cell to view a list of selections per column).

Technology 
Transmission 

Maximum Advertised Speed Typical Speed 

41 Cable-Other   90 Electric Power Line
50 Optical Carrie

30 Other Wireline   71 Terrestrial Fixed Wireless - Licensed
40 Cable DOCSIS 3.0   80 Mobile Wireless

10 Asymmetric    60 Satellite
20 Symmetric    70 Terrestrial Fixed Wireless - Unlicensed

Contact City, State Zip code:   
1.1 Provide a URL of the Company's website to which the District should refer potential broadband service subscribers.

 

1.2 Is your Company a facility based provider or a reseller?  Please select the cell next to the technology that you provide and choose from the dropdown 
menu which business type applies. 

Technolog

Contact Email:   
Contact Address1:  
Contact Address2:  

Doing Business As:  
FRN #:  
Contact Name:  

District of Columbia - Mapping Questionnaire Fall 2011
This questionnaire is directed to providers that have not qualified for participation in the National Broadband map. Each sheet collects a 
different type of information.  Tabs at the bottom of the workbook allow users to switch among the three sheets.

Date Submitted:<mm/dd/yyyy>  
Company Name:   

y  Business Type Technology

r   0 Other
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1.8 Can you provide this service within 10 business days of a service order without extraordinary commitment of additional resources?

1.9  If you provide broadband service and can offer it to customers (residential, business, institutional, or government entity) in the District of Columbia 
within 10 business days of a service order without extraordinary commitment of additional resources, the District of Columbia Public Service Commission 
encourages your participation in the State Broadband Mapping Program.  We will be happy to discuss the benefits of participation with you.

1.10  Please provide a copy of your most recent filing of Form 477 to the FCC.  Provide attachment filenames below.

1.6 For each Technology of Transmission that was selected in questions 1.2, please provide your service area in any of the following data formats (each 
data format should include technology of transmission, maximum advertised download and upload speed, typical download and upload speed): 
 - GIS or CAD file(s)
 - Text file or Excel Spreadsheet listing service addresses
 - Text file or Excel Spreadsheet with a list of Census Blocks with Tract numbers
See graphics below of sample data formats

1.7 Does your company primarily make your service available to residential or non-residential (i.e. business) customers?

Proceed to Sheet 2.

Ex. of Spreadsheet - Includes Census Tract and Block; Maximum Download and Upload Speeds; Typical Download and Upload 
Speed; Total Users; and Percent Residential.

Ex. Text File with Service Address - Includes Provider Name; FRN#; End-User Address; Technology of Transmission; Maximum 

Ex. of Form 477 by Census Tract - Includes Technology of Transmission; Census Tract; Transfer Rate; Number of Users; and 

Proceed to Sheet 2 if you provide wireless broadband service.Number of  users
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Figure 2. Wireless Spectrum 

 
 
 

Proceed to Sheet 3.

Provider Name
Wireless Spectrum Questions (Wireline only companies may skip this sheet.)

2.1 What spectrum(s) do you use to provide service? See table in Broadband Data Definitions guide for 
spectrum codes and descriptions.
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Figure 3. Middle Mile Facility Points 

 *Serving Facility 
Capacity Code

**Serving Facility 
Type  Code

*** Latitude         
(Optional if address 

provided)

*** Longitude         
(Optional if address 

provided)

Elevation (in feet from 
grade. Negative numbers 

are below grade)

(1-6) See below (1-4) See below 38° 53' 43.6" N 77° 0' 56.35" W                                     15 

* Serving 
Facility 

Capacity Code 
** Serving Facility

Type Code Description
1 Multiple T1s and less than 40 mbps 1 Fiber
2 Greater than 40 mbps and less than 150 mbps 2 Copper
3 Greater than 150 mbps and less than 600 mbps 3 Hybrid Fiber Coax (HFC)
4 Greater than or equal to 600 mbps and less than 2.4 gbps 4 Wireless
5 Greater than or equal to 2.4 gbps and less than 10 gbps
6 Greater than or equal to 10 gbps

*** Coordinates must be expressed using the WGS 1984 geographic coordinate system.

…add rows as needed

Data Rate

Owned or Leased
Facility Address In DC                

(Street#, Street Name, Street Type, 
Quadrant)

Owned/Leased 123 Main Street NW

Broadband service providers shall provide a list of “middle-mile and backbone interconnection points” in the District of Columbia.  Interconnection points are facilities that provide connectivity between (a) a service 
provider’s network elements (or segments) or (b) between a service provider’s network and another provider’s network, including the Internet backbone. (Collectively, (a) and (b) are middle-mile and backbone 
interconnection points.   Middle-mile and backbone interconnection points typically enable relatively fast data rates, are built to handle substantial capacities, and may be service-quality assured.   Examples might include: 
points of interconnection enabling communications between an incumbent local exchange carrier’s central office and the Internet, between a cable aggregation point (headend) and the Internet, or between a wireless base 
station and the provider’s core network elements that connect to other networks, including the Internet.

3.1 Do you have any Middle Mile Facilities located in the District of Columbia?
"Yes" or "No"

3.2 If no, do you have Middle Mile Facilities in other states that serve customers within the District of Columbia?

3.3 Please list all Middle Mile Facilities that serve customers within the District of Columbia in the table below
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Appendix 4 
Community Anchor Institution 

Data Request Letter and Survey Form 
   

34 
 



Dear <Community Anchor Institution / Contact>: 
 

The District of Columbia Government’s Office of  the Chief Technology Officer  (OCTO)  is  in  the  fourth 
round  of  data  collection  as  directed  by  the  National  Telecommunications  and  Information 
Administration’s  (NTIA)  State  Broadband  Data  and  Development  Program  (SBDD).  The  SBDD  is 
supported by a grant awarded by  the United  States Department of Commerce and NTIA  to map  the 
availability and adoption of broadband services in the District of Columbia (District). 
 

A  critical  component of  this  grant  requirement  is  to  identify Community Anchor  Institutions,  such  as 
<Community  Anchor  Institution>,  in  the  District  and  to  survey  the  availability  of  broadband  service 
offered there, respectively.  Community Anchor Institutions (CAI) consist of schools, libraries, health care 
providers,  public  safety  entities,  institutions  of  higher  education,  and  other  community  supported 
organizations and entities. 
 

Participation in the survey is strongly encouraged so as to develop a more accurate and comprehensive 
dataset of broadband availability in the District and to assist in the planning of District‐wide broadband 
initiatives.  
OCTO has developed a simple, one page web‐based survey form that can be accessed and completed at 
this link: DC ‐ Community Anchor Institutions Survey (web form) 
NOTE: OCTO  requests  that  the  survey be completed on or before Friday, September 17, 2011. Thank 
you. 
 

If you have any questions, please feel free to contact me. 
 
Sincerely, 

<Sender>

35 
 

http://www2.ntia.doc.gov/SBDD
http://www2.ntia.doc.gov/SBDD
https://docs.google.com/spreadsheet/viewform?formkey=dDY5WDB4Uk9mbkhNaTlRaGFLNzEzckE6MA


36 
 



   

37 
 



38 
 

 

Appendix 5 
Wireless Validation 

 



1 
 

 

 

 

Mobile Broadband Mapping 

Commercial Cellular Networks 

District of Columbia 

 

Bob Pavlak 

Chris San-Gaspar 

 

September 29, 2010 

 

 

 



2 
 

Mobile Broadband Mapping of Commercial Cellular Networks: District of Columbia 

Executive Summary 

The outdoor downlink and uplink throughput speeds of the commercial cellular networks serving the 

District of Columbia were measured in September 2010, and compared with measurements made in 

September 2009. In addition to the three networks tested in 2009 (Verizon Wireless, Sprint, AT&T), our 

2010 measurements also include Cricket and T-Mobile. 

 

The results of the drive test measurements are shown in the two attached files (2010 results, and 2009 

results), and a qualitative analysis of the results is presented here. A more detailed quantitative analysis 

will be prepared later.  

 

All five of the service providers deliver broadband service (minimum 768 kbps downlink and 200 kbps 

uplink) in some areas of the District. However, there is a wide variation in coverage performance. 

Throughput speeds may be above the “broadband” thresholds in some areas and below the 

“broadband” thresholds in other areas. This variation in performance is shown by the color codes on the 

attached citywide maps. 

 

There is also a significant variation in performance between the cellular service providers. The downlink 

speeds of the AT&T and T-Mobile networks are substantially above the broadband threshold of 768 

kbps, with many areas above 1.5 Mbps. The speeds on AT&T’s network are substantially higher in 2010 

compared to 2009, which we believe is attributed to the 3G upgrade of the AT&T network to HSPA (High 

Speed Packet Access), a more recent version of 3G. Both AT&T and T-Mobile operate network 

infrastructure based on the 3GPP (3rd Generation Partnership Project) set of standards. 

 

The uplink speeds on the AT&T network is by far the highest of any of the commercial service providers. 

We believe this is due to the more advanced version of the 3GPP standard used by AT&T. Uplink speeds 

on AT&T’s network exceed 768 kbps and 1.5 Mbps in all but a few areas of the drive route. 

 

The downlink speeds on Verizon’s network, between 2009 and 2010, appear about the same. The uplink 

performance has improved, with many areas in 2010 above 768 kbps. Many areas in 2009 were above 

200 kbps uplink (but less than 768 kbps). Similarly, Sprint’s downlink performance appears about the 

same between 2009 and 2010, and their uplink performance in 2010 is slightly improved from 2009, but 

not as high as any of the other service providers. 

 

Sprint, via Clearwire, now offers 4G WiMax broadband service in the District. This network was not 

included in our broadband drive tests because the mobility performance of WiMax is poor. Sessions are 

frequently dropped during handoffs and the tool used for drive test measurements is unable to 

accommodate a high dropped session rate. 
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The authors wish to thank Felix Igbedior for his assistance in performing the drive tests with Chris San-

Gaspar. 
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Complete 62
Non-Responsive/Refused 29
In Progress 8

Count of Datasets by Status 99
Total Unique Providers Represented 75

Provider Name Platform Status
NDA Execution 

Date Notes

AT&T Inc. Mobile Wireless Data Added to Statewide Inventory 12/16/2009

[SEP-02-11 Amanda Bentley]  Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

AT&T Inc. DSL Data Added to Statewide Inventory 12/16/2009

[SEP-02-11 Amanda Bentley]  Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Bright House Networks, LLC Cable Data Added to Statewide Inventory 4/26/2010
[SEP-14-11 Amanda Bentley]  Change:  System 
upgrade to DOCSIS 3.0.

Broadband South Fixed Wireless Data Added to Statewide Inventory

[SEP-16-11 Ashley Littell] Correction: Provider 
offered service prior to this submission, but this 
is the first time data has been submitted.

CenturyLink DSL Data Added to Statewide Inventory 12/4/2009

[AUG-17-11 Amanda Bentley]  Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Clearwire Corporation Mobile Wireless Data Added to Statewide Inventory 3/3/2010

[AUG-11-11 Amanda Bentley]  Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Comcast Cable Communications, LLC Cable Data Added to Statewide Inventory 12/7/2009

[AUG-29-11 Amanda Bentley]  Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

CoxCom Inc. Cable Data Added to Statewide Inventory 1/29/2010

[SEP-02-11 Amanda Bentley]  Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

GTC, Inc. DSL Data Added to Statewide Inventory 1/28/2010

[AUG-25-11 Amanda Bentley]  Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

ITS Telecommunications Systems, Inc. Fiber Data Added to Statewide Inventory 4/28/2010
[SEP-02-11 Amanda Bentley]  Change: Upgrade 
to network, expansion of service area.

ITS Telecommunications Systems, Inc. DSL Data Added to Statewide Inventory 4/28/2010
[SEP-02-11 Amanda Bentley]  Correction:  
Boundary for DSL coverage was revised.

Knology of Florida, Inc. Cable Data Added to Statewide Inventory 7/13/2011

[AUG-25-11 Amanda Bentley] Correction: 
Provider was included for the first time in the 
October 2011 submission because we did not 
have their participation previously.

Long Hammock Wireless, Inc. Fixed Wireless Data Added to Statewide Inventory

[SEP-16-11 Ashley Littell] Correction: Provider 
was in service prior to this submission, but this 
is the first time data has been submitted.

Northeast Florida Telephone Company Fiber Data Added to Statewide Inventory 4/16/2010
[SEP-02-11 Amanda Bentley]  Correction:  
Boundaries for FTTH coverage were revised.

Northeast Florida Telephone Company DSL Data Added to Statewide Inventory 4/16/2010
[SEP-02-11 Amanda Bentley]  Correction:  
Boundary for DSL coverage was revised.

Quincy Telephone Company DSL Data Added to Statewide Inventory 1/27/2010

[AUG-18-11 Amanda Bentley]  Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Sprint Nextel Corporation Mobile Wireless Data Added to Statewide Inventory 1/14/2010

[AUG-11-11 Amana Bentley]  Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

T-Mobile USA, Inc. Mobile Wireless Data Added to Statewide Inventory 1/8/2010

[AUG-11-11 Amanda Bentley]  Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

The Hometown Network, Inc. Fixed Wireless Data Added to Statewide Inventory 5/5/2010

[SEP-02-11 Amanda Bentley]  Correction:  Fixed 
wireless coverage changed to actual 
propagations to replace the concentric circle 
polygon used previously.

Verizon Florida LLC Fiber Data Added to Statewide Inventory 12/14/2009

[AUG-24-11 Amanda Bentley]  Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Verizon Florida LLC DSL Data Added to Statewide Inventory 12/14/2009

[AUG-24-11 Amanda Bentley]  Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Verizon Florida LLC Mobile Wireless Data Added to Statewide Inventory 12/14/2009

[AUG-11-11 Amanda Bentley]  Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Broadband Provider Log



Windstream Communications DSL Data Added to Statewide Inventory 1/19/2010

[AUG-26-11 Amanda Bentley]  Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

CenturyLink Backhaul
Backhaul Provider Only Processing 
Complete 12/4/2009

EarthLink Business Backhaul
Backhaul Provider Only Processing 
Complete 2/16/2010

Fort Pierce Utilities Authority Backhaul
Backhaul Provider Only Processing 
Complete 5/27/2011

Level 3 Communications, LLC Backhaul
Backhaul Provider Only Processing 
Complete 12/14/2009

Sago Networks, Inc. Backhaul
Backhaul Provider Only Processing 
Complete

Southern Light Backhaul
Backhaul Provider Only Processing 
Complete 6/16/2010

T-Mobile USA, Inc. Backhaul
Backhaul Provider Only Processing 
Complete 1/8/2010

Windstream Communications Backhaul
Backhaul Provider Only Processing 
Complete 1/19/2010

PDMNet Fixed Wireless
Approval for Update Not Received – Data 
Still Submitted 4/20/2010

[SEP-8-11 Amanda Bentley]  Correction:  
Provider is being submitted for the first time with 
the October 2011 submission.  Data was 
received for prior submissions but never 
received approval; October 2011 provider was 
non-responsive.

Smart City Telecommunications LLC Fiber
Approval for Update Not Received – Data 
Still Submitted 6/24/2010

[SEP-8-11 Amanda Bentley]  Correction:  
Provider is being submitted for the first time with 
the October 2011 submission.  Data was 
received for April 2011 submission but never 
received approval; October 2011 provider was 
non-responsive.

Smart City Telecommunications LLC DSL
Approval for Update Not Received – Data 
Still Submitted 6/24/2010

[SEP-8-11 Amanda Bentley]  Correction:  
Provider is being submitted for the first time with 
the October 2011 submission.  Data was 
received for April 2011 submission but never 
received approval; October 2011 provider was 
non-responsive.

airPowered Fixed Wireless No Update to Provide 2/17/2011
AT&T Inc. Backhaul No Update to Provide 12/16/2009
Cellular South, Inc. Mobile Wireless No Update to Provide 4/12/2010
CenturyLink Backhaul No Update to Provide 12/4/2009
City of Leesburg, Florida Backhaul No Update to Provide
CoxCom Inc. Backhaul No Update to Provide 1/29/2010

DISH Network Corporation Satellite No Update to Provide 1/27/2010

[SEP-16-11 Amanda Bentley]  Correction: 
Satellite data is being submitted and was not 
included in the April 2011 submission. While 
coverage is currently the entire state boundary, 
work continues on having more granular data 
available.

Florida LambdaRail LLC Backhaul No Update to Provide 4/29/2010
FPL FiberNet LLC Backhaul No Update to Provide 6/3/2010
Frontier Communications Corporation DSL No Update to Provide 1/22/2010
Frontier Communications Corporation Backhaul No Update to Provide 1/22/2010
Gainesville Regional Utilities Backhaul No Update to Provide

Hughes Network Systems, LLC Satellite No Update to Provide 2/5/2010

[SEP-16-11 Amanda Bentley]  Correction: 
Satellite data is being submitted and was not 
included in the April 2011 submission. While 
coverage is currently the entire state boundary, 
work continues on having more granular data 
available.

Mediacom Southeast LLC Cable No Update to Provide 1/12/2010
MegaPath Inc. Backhaul No Update to Provide 2/15/2010
Nextlink Wireless, Inc. Backhaul No Update to Provide 2/12/2010
Quincy Telephone Company Backhaul No Update to Provide 1/27/2010
Quincy, City of Fiber No Update to Provide
Sprint Nextel Corporation Backhaul No Update to Provide 1/14/2010
tw telecom of florida, l.p. Backhaul No Update to Provide 4/22/2010
Velocity Online Backhaul No Update to Provide 4/8/2010
Verizon Florida LLC Backhaul No Update to Provide 12/14/2009

WildBlue Communications, Inc. Satellite No Update to Provide 1/8/2010

[SEP-16-11 Amanda Bentley]  Correction: 
Satellite data is being submitted and was not 
included in the April 2011 submission. While 
coverage is currently the entire state boundary, 
work continues on having more granular data 
available.

XO Communications, LLC Backhaul No Update to Provide 2/12/2010

Advanced Cable Communications Cable
No Update Provided - Use Last Submission 
Data 4/16/2010

Cogent Communications, Inc. Backhaul
No Update Provided - Use Last Submission 
Data

Home Town Cable TV, LLC Fiber
No Update Provided - Use Last Submission 
Data 4/21/2010

Orlando Telephone Company, Inc. Fiber
No Update Provided - Use Last Submission 
Data

Orlando Telephone Company, Inc. Cable
No Update Provided - Use Last Submission 
Data

Orlando Telephone Company, Inc. Backhaul
No Update Provided - Use Last Submission 
Data

T3 Communications Backhaul
No Update Provided - Use Last Submission 
Data 6/3/2010

ClearSurf Broadband Fixed Wireless Provider Gathering Data 5/3/2010

MegaPath Inc. Backhaul Solicited Initial Data 2/15/2010

[SEP-08-11 Wes Kerr] Still working to 
understand post merger network and if any data 
will be provided in the future.



Clearwire Corporation Fixed Wireless Other 3/3/2010

[AUG-11-11 Terry Holmes] Clearwire converted 
their last fixed wireless network in Florida to 
mobile wireless during the last reporting cycle.  
There is no remaining fixed wireless in Florida to 
report.

Nature Coast Networks Fixed Wireless Other

[JUN-18-11 Chip Spann]  Due to current 
litigation, provider is embargoed from providing 
data at this time.  

PAETEC Communications, Inc. Backhaul Other

[SEP-08-11 Wes Kerr] Multiple outreach 
attempts were conducted but no response was 
received. Paetec was bought out during the 
collection phase of this round by Windstream 
and we intend to be able to include the Paetec 
coverage as a part of the Windstream footprint 
during the next round.

PAETEC Communications, Inc. DSL Other

[SEP-08-11 Wes Kerr] Multiple outreach 
attempts were conducted but no response was 
received. Paetec was bought out during the 
collection phase of this round by Windstream 
and we intend to be able to include the Paetec 
coverage as a part of the Windstream footprint 
during the next round.

PAETEC Communications, Inc. Fixed Wireless Other

[SEP-08-11 Wes Kerr] Multiple outreach 
attempts were conducted but no response was 
received. Paetec was bought out during the 
collection phase of this round by Windstream 
and we intend to be able to include the Paetec 
coverage as a part of the Windstream footprint 
during the next round.

PAETEC Communications, Inc. Backhaul Other

[SEP-08-11 Wes Kerr] Multiple outreach 
attempts were conducted but no response was 
received. Paetec was bought out during the 
collection phase of this round by Windstream 
and we intend to be able to include the Paetec 
coverage as a part of the Windstream footprint 
during the next round.

Birch Communications, Inc. DSL Refused to Participate

[JUN-22-11 Daryl Coffey] a company 
representative sent an e-mail stating they are 
still not interested in participating.

Birch Communications, Inc. Backhaul Refused to Participate

[JUN-22-11 Daryl Coffey] a company 
representative sent an e-mail stating they are 
still not interested in participating.

CyberStreet Inc. Fixed Wireless Refused to Participate

[APR-14-10 Jill Lindgren] Provider relayed his 
wishes not to participate and requested we not 
call again.

561net Fixed Wireless Non-Responsive to Multiple Attempts
4 contact attempts were made between May 25, 
2011 and August 5, 2011.

AreYouOnline.Net Fixed Wireless Non-Responsive to Multiple Attempts
4 contact attempts were made between May 25, 
2011 and August 11, 2011.

Break Free Wireless Corporation Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between May 25, 2010 and February 4, 2011, 3 
additional attempts were made this period.

Brevard Wireless Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between May 6, 2010 and March 8, 2011, 3 
additional attempts were made this period.

Cablevision of Marion County LLC Cable Non-Responsive to Multiple Attempts

In addition to contact attempts made between 
July 1, 2010 and January 13, 2011, 3 additional 
attempts were made this period.

CommFunction, LLC Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between October 9, 2010 and February 18, 
2011, 3 additional attempts were made this 
period.

CommFunction, LLC DSL Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between October 9, 2010 and February 18, 
2011, 3 additional attempts were made this 
period.

Desoto Life Fixed Wireless Non-Responsive to Multiple Attempts

In addition to contact attempts made between 
August 17, 2010 and January 5, 2011, 3 
additional attempts were made this period.

FiberLight LLC Backhaul Non-Responsive to Multiple Attempts 4/19/2010

In addition to multiple contact attempts made 
between May 26, 2010 and February 15, 2011, 
5 additional attempts were made this period.

GBS Online Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between May 12, 2010 and February 18, 2011, 
3 additional attempts were made this period.

Global Crossing Telecommunications, Inc. Backhaul Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between July 1, 2010 and February 17, 2011, 3 
additional attempts were made this period.

James Cable LLC Cable Non-Responsive to Multiple Attempts 1/11/2010

In addition to contact attempts made between 
July 1, 2010 and January 5, 2011, 3 additional 
attempts were made this period.

KissimmeeWeb Fixed Wireless Non-Responsive to Multiple Attempts

In addition to contact attempts made between 
June 22, 2010 and February 18, 2011, 3 
additional attempts were made this period.

Litestream Holdings, LLC Cable Non-Responsive to Multiple Attempts
4 contact attempts were made between May 14, 
2011 and August 13, 2011.

Marco Island Cable, Inc. Cable Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between June 30, 2010 and January 13, 2011, 3 
additional attempts were made this period.

Omnispring LLC Backhaul Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between May 11, 2010 and January 13, 2011, 3 
additional attempts were made this period.

Palm Coast-Flagler Internet, LLC Cable Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between July 1, 2010 and February 15, 2011, 3 
additional attempts were made this period.



Rapid Systems Corporation Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between June 11, 2010 and February 15, 2011, 
3 additional attempts were made this period.

Reliance Globalcom Services, Inc. Backhaul Non-Responsive to Multiple Attempts

In addition to contact attempts made between 
November 18, 2010 and February 3, 2011, 3 
additional attempts were made this period.

SkyNet360 Fixed Wireless Non-Responsive to Multiple Attempts
4 contact attempts were made between May 4, 
2011 and August 11, 2011.

Sling Broadband Fixed Wireless Non-Responsive to Multiple Attempts

In addition to contact attempts made on July 1, 
2010, Jaunary 5, 2011, and January 13, 2011, 3 
additional attempts were made this period.
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OVERVIEW 

This white paper highlights the Submission Summary for this deliverable, as well as describes the Data Gathering, 
Data Integration, Data Validation and Verification and Quality Control processes used to create the Broadband 
Mapping Project’s October 1, 2011 data submission. To support varying levels of technical and program 
knowledge, both a high-level summary and a detailed process review are supplied. 
 

SUBMISSION SUMMARY 

PROVIDER DETAILS 

PROVIDER PARTICIPATION 

 Providers Included 
 

Abovenet Communications Inc 

 

Cox Communications 

 

Open Range Communications 

Advanced Technology Group Cricket Communications Inc. Pembroke Telephone Company Inc 

AL-GA Wireless Broadband LLC Darien Telephone Company Inc. Pineland Telephone Company Inc. 

AllTel DeltaCom Inc. Plantation Cablevision, Inc. 

AT&T Georgia Depot Street Communications, Inc.  Planters Rural Telephone Cooperative 

Brantley Telephone Inc. ETC Communications LLC Progressive Rural Telephone 

Bright House Networks LLC FairPoint Communications Quitman Wireless 

Bulldog Cable Georgia, LLC Flint Cable Television Ringgold Telephone Company 

Bulloch County Rural Telephone 
Cooperative Inc. Frontier Communications of Fairmount LLC SGRITA 

CenturyLink Frontier Communications of Georgia LLC Shentel Converged Services, Inc.  

Charter Communications Inc. Glenwood Telephone Company Southeastern Services Inc. 

Chickamauga Telephone Corporation Hargray Sprint 

Citizens Hart Telephone Company StarBand Communications Inc. 

CITY OF CAIRO Hughes Network Systems T-Mobile 

CITY OF CAMILLA Kings Bay Communications TDS Telecom 

City of Dublin KitePilot Wireless Internet tw telecom of georgia l.p. 

City of Moultrie Knology of Georgia Inc 
University Corporation for Advanced 
Internet Development 

CITY OF THOMASVILLE Level 3 Communications LLC Verizon Wireless 

Clearwire MainStreet Broadband Waverly Hall Telephone LLC 

Cogent Communications Inc. Mediacom WildBlue Communications Inc. 

Columbia Country Information 
Technology Department Megapath Wilkes Telephone and Electric Co. 

Comcast 
New Edge Network, Inc., d/b/a New Edge 
Networks Windstream 

Communicom Nextlink Wireless Inc. 
XO Communications Services Inc. 
(Affiliated Entity) 

Covad Communications Company 
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 New Providers Since Last Data Submission 

 AboveNet Communications Inc 

 Bulldog Cable Georgia, LLC 

 City of Dublin 

 Glenwood Telephone Company 

 New Edge Networks, Inc. 

 Plantation Cablevision, Inc. 

 Public Service Telephone Company 

 Hughes Network Systems 

 Open Range Communications Inc. 

 Quitman Wireless 

 StarBand Communications 
 

 Non-Responsive/Non-Cooperative Providers  

 Kennedy CableVision Inc. 

 NuLink Digital 

 Smartresort Co, LLC dba Beyond Communications 

 Airimba and Windchannel Communications 

 Georgia Business Net 

 VectorLink 
 

COVERAGE AREA CHANGES 

 Coverage Footprint Reductions/Map Refinement - Resulting from Validation (Provider Portal) 

 AT&T Mobility LLC (TT-80) 

 AL-Call (TT-10 and TT-40) 

 Bright House Networks, LLC (TT-41) 

 Camden Telephone &Telegraph Company, Inc. (TT-50) 

 CenturyLink (TT-10) 

 Charter Communications Inc.  (TT-41) 

 Citizens Telephone Company   (TT-10 and TT-40) 

 City of Camilla  (TT-40 and TT-50) 

 City of Moultrie  (TT-41 and TT-50) 

 City of Thomasville  (TT-40 and TT-50) 

 Cogent Communications, Inc. (TT-50) 

 Comcast Cable Communications, LLC (TT-40 and TT-41) 

 ComSouth Corporation  (TT-10 and TT-50) 

 Cox Communications, Inc (TT-40) 

 Darien Telephone Company, Inc.    (TT-10 and TT-41) 

 Depot Street Communications Inc (TT-41) 

 DIECA Communications, Inc. (TT-10 and TT-20) 

 Ellijay Telephone Company  (TT-50) 

 Frontier Communications of Georgia, LLC   (TT-10) 

 Hart Telephone Company   (TT-40) 

 Level 3 Communications, LLC  (TT-50) 

 Nelson-Ball Ground Telephone Company  (TT-50) 

 Plant Telephone Company  (TT-50) 
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 Coverage Footprint Expansion –  

 ATC Broadband LLC  (TT-40) 

 BellSouth Telecommunications, Inc. (TT-10) 

 Blue Ridge Telephone Company   (TT-10 and TT-50) 

 Bulloch County Rural Telephone Cooperative, Inc. (TT-50) 

 Camden Telephone &Telegraph Company, Inc. (TT-10) 

 Chickamauga (TT-10) 

 Citizens Telephone Company (TT-50) 

 City of Cairo (TT-40 and TT-50) 

 City of Elberton, Ga. (TT-41) 

 ComSouth Corporation (TT-40) 

 Darien Telephone Company, Inc.  (TT-50) 

 DIECA Communications, Inc. (TT-30) 

 Ellijay Telephone Company (TT-10 and TT-40) 

 Fort Valley Utility Commission (TT-50) 

 Frontier Communications of Fairmount, LLC (TT-10) 

 Glenwood Telephone Company (TT-20) 

 Hargray Of Georgia (TT-41) 

 Hart Telephone Company (TT-10) 

 James Cable, LLC (TT-41) 

 Kings Bay Communications (TT-50) 

 Knology, Inc (TT-40 and TT-50) 

 Mediacom Southeast LLC (TT-41) 

 Nelson-Ball Ground Telephone Company  (TT-10) 

 NuLink Digital (TT-41) 

 Pembroke Telephone Company, Inc (TT-10 and TT-50) 

 Pineland Telephone Company, Inc. (TT-10, TT-20 and TT-50) 

 Plant Tifnet (TT-40 and TT-50) 

 Planters Rural Telephone Cooperative (TT-10 and TT-50) 

 Progressive Rural Telephone (TT-10) 

 Public Service Telephone Company (TT-10) 

 Ringgold Telephone Company (TT-10 and TT-50) 

 tw telecom of georgia l.p. (TT-30 and TT-50) 

 Waverly Hall Telephone, LLC (TT-30) 

 Waycross Cable Co. (TT-41) 

 Windstream (TT-10) 

 XO Communications, LLC  (TT-30) 

 Wilkes Telephone and Electric Co. – (TT-10 and TT-50) 

 Supporting Business coverage footprint as well 
 

DATA CORRECTIONS 

 No corrections were required for this data round 
 

 

 

 



                                                                              

       Version 2.0         September 2011 Author: Kristin Rousseau 
       Page 8 

DATA VALIDATION & VERIFICATION 

 Prior to data collection for Data Set 4, GTA established a set of maximum speeds by Technology 
Type that reflects the local practices of the state.  

 For Dataset 3 and to follow up on NTIA’s request, Georgia produced a summary of changes 
that details the specific coverage increases in miles by each operator who submitted 
significant changes from Dataset 2 to 3.  This thorough process helped Georgia know where 
to focus in Dataset 4 and to watch for continued growth in Dataset 4.   
Overall we have seen Dataset 4’s coverage reduce due to the improved census granularity of 
Census 2010 and diligence described below. 

 

 Georgia introduced a service provider portal in Year 2 that allows service providers to both 
verify and update GIS maps of their respective coverage areas.  Providers can submit CAD or 
GIS coverage maps to BroadMap to review in the portal or draw their own coverage shapes 
and streets through the portal.  Over 60 of Georgia’s providers used this portal in Year 2 and 
it allowed them to make sure we have represented their areas accurately.  The portal was 
particularly valuable for providers that offer services over many technology types including 
DSL, Cable, and Fiber. These providers could make sure that, for instance, the fiber footprint 
was limited to downtown while cable modem services were available throughout the 
suburbs. 

 

 Georgia used the Form 477 data for the first time in its verification activities for Dataset 4.  
This data has allowed Georgia to understand the context within which providers give their 
data to Georgia, and has allowed us to validate the consistency between the two data 
sources. 
Georgia has explored the purchase of MediaPrints and Pitney Bowes third party data.  
Georgia has not purchased MediaPrints due to accuracy concerns and has been unable to 
reach an agreement with Pitney Bowes.  Georgia does use all central offices to evaluate the 
likelihood of DSL coverage. 

 

 Georgia has introduced a new process of manual verification for Dataset 4.  Using Dataset 3, 
Georgia identified the top providers by technology type.  As Dataset 4 submissions arrived 
over two months, BroadMap, GTA, and Civitium met each week to examine the submissions 
and determine the impact of any changes.  The figure below illustrates AT&T’s changing 
wireless broadband coverage map. 

  

Figure1 AT&T Pink is Data Set 4, Blue is Data Set 3 
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COMMUNITY ANCHOR INSTITUTION (CAI) DETIALS 

OVERALL STATISTICS 

Community Anchor Institution - Categories 
Overall 
Count 

Broadband 
Subscriber 

(1 or 2) 

Trans 
Tech 

Advertised 
Speed Down 

Advertised 
Speed Up 

Category 1 - School K through 12 2065 2055 2055 2055 2055 

Category 2 - Library  451 383 383 382 382 

Category 3 - Medical/Healthcare 2633 0 0 0 0 

Category 4 - Public Safety 2656 0 0 0 0 

Category 5 - Universities/Colleges 202 99 99 99 99 

Category 6 - Other:  Government 747 0 0 0 0 

Category 7 - Other:  Non-Government  0 0 0 0 0 

Total 8754 2537 2537 2536 2536 

 

 

CAI CHANGES 

 

 There were 2515 CAIIDs added to the CAI Inventory for Category 1: K-12 Schools, Category 2: 
Libraries and Category 5: Colleges, which were extracted from the three databases 
communicated by NTIA.  These databases are as follows: 
 

 For K-12 institutions (CAI type 1) please add the NCES ID CCD ID value found here: 

http://nces.ed.gov/ccd/bat/  

 

 For Higher Education (CAI type 5) please add the NCES IPEDS ID value found here: 

http://nces.ed.gov/ipeds/datacenter/  

 

 For Libraries (CAI type 2) please. Combine (do not add) “FSCSKey” and “FSCs_SEQ” from the 

“puout08av2000” file and place them here: 

http://harvester.census.gov/imls/data/pls/index.asp (FYI the LIBID is your state’s unique ID 

for libraries) 

 

  

http://nces.ed.gov/ccd/bat/
http://nces.ed.gov/ipeds/datacenter/
http://harvester.census.gov/imls/data/pls/index.asp
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SUBMISSION RECEIPT 

SUBMISSION RECEIPT RESULTS 

 Attached are the results from the NTIA data submission receipt quality script. 

  
 

 Error Report 

 The only items flagged in the submission receipt output are as follows, which has been 
verified as correct entries within the data submission.   
 

 Field Check:     FAILED      CAInstitutions_TRANSTECH has 6217 UNEXPECTED VALUES for 
query: TRANSTECH <> 0 AND TRANSTECH <> 10 AND TRANSTECH <> 20 AND TRANSTECH <> 
30 AND TRANSTECH <> 40 AND TRANSTECH <> 41 AND TRANSTECH <> 50 AND TRANSTECH 
<> 60 AND TRANSTECH <> 70 AND TRANSTECH <> 71 AND TRANSTECH <> 80 AND 
TRANSTECH <> 90 AND TRANSTECH <> 0 

 

 This was flagged due to an inconsistency between the data model and the submission 
receipt script, which has also been communicated by other Grantees on PBWorks.  

 
 

 Speed Tier:      FAILED      Go check data and keep only Maximum Advertised Speeds  

 Speed Tier:      FAILED      Go check data at: 
d:\hudson\workspace\BDIA_SBBD_QC\SBDD_TRANSFER.gdb\/Speed_FRQ 
 

 These two errors were flagged as the submission receipt script does not take the 
EndUserCat field into consideration, which differentiates between Residential and 
Business coverage footprints.  This has also been communicated by other Grantees on 
PBWorks.  

 
 

Hyperlink to Grantee Workspace in which the same issues were identified by other Grantees: 
https://sbdd-granteeworkspace.pbworks.com/w/page/42442088/Data%20Model%20Issues-June2011  

  

https://sbdd-granteeworkspace.pbworks.com/w/page/42442088/Data%20Model%20Issues-June2011
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HIGH-LEVEL SUMMARY 

DATA GATHERING 

BROADBAND SERVICE AREAS, MIDDLE MILE AGGREGATION POINTS AND 
BROADBAND SERVICE OVERVIEW 

The collection of Broadband Service Areas, Middle Mile Aggregation Points and Broadband Service 
Overview information is handled through the following Provider Outreach Process: 

 Build and maintain an inventory of Broadband providers through research and State inputs. 

 Update provider material that describes the data requirements and logistics for data transfer. 

 Update Non-Disclosure Agreement (NDA) for use in project, where applicable. 

 Maintain multiple protocols for the provider to submit data, including Secure File Transfer Protocol 
(SFTP) technology when desired. 

 Conduct one-on-one informational discussions with each provider to communicate the following: 
o Requirements of this project; 

o Broadband data required to support the product data model; 

o Submission protocols available; 

o Capability to validate how the supplied data is aggregated. 

 Download/receive provider data. 

 Establish a repeatable process with provider. Maintain provider communication, transaction and data 
handling records throughout the project (dates contacted, data received, etc.).  

 

COMMUNITY ANCHOR INSTITUTION (CAI) 

The collection of CAI information is handled through the following CAI Collection Process: 

 Collect and maintain inventory of CAIs through data mining, research and State inputs. 

 Maintain web-based CAI portal for institutions to add or confirm attribution, location and enter 
broadband-specific information. 

 Upload web-based data to Core Database for standardization. 

 Perform internal cleansing, such as removing duplicate records, identifying gaps in broadband 
attribution and verifying category. 

 Geocode CAI locations. 

 Translate Core Database data to deliverable-ready format. 

 Continue engagement with non-responsive institutions. 
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DATA INTEGRATION PROCESS 

The data integration and processing mechanisms currently used allow for multiple types of inputs and result in 
a standardized output that meets the NTIA deliverable requirements. This flexible process supports data 
model changes and project-requested enhancements. 

 Receive inputs from providers via submission protocols; upload into Sourcing Database and catalog 
with provider information. 

 Review provider-supplied data for completeness and for potential discrepancies that require 
resolution prior to processing and flag as necessary. 

 Categorize input into data-type category (addresses, block lists, paper maps, etc.). 

 Standardize input based on data type within Staging Database. 

 Create Compact Polygons (CP)—(internal methodology for generating area-based feature for 
coverage in Staging Database). 

 Apply broadband attribution to CP; apply metadata to CP. 

 Perform quality analysis of the CP against the source supplied to identify any completeness or 
accuracy issues. 

 Request additional information from the provider if elements of coverage are missing or contain 
discrepancies. This is a second manual quality check to ensure data is complete. 
o Process coverage area to build the required NTIA data model layers.  

 Process CAI data input into internal standardized format, as discussed above in the Community 
Anchor Institution (CAI) subsection, based on NTIA and State-level requirements. 

 

DATA VALIDATION AND VERIFICATION 

Following the creation of the product, process steps within Data Validation and Verification occur. To ensure 
the data collected and processed is as accurate and comprehensive as possible, provider validation and 
internal verification activities are employed. After the initial mapping of providers’ coverage areas and 
serviceability claims, additional reviews are performed using the methods described in the subsections below 
(Third-Party Data Verification, Broadband Provider Validation, Confidence Values). 
 

THIRD-PARTY DATA VERIFICATION 

The coverage is visually and programmatically compared against third-party data. For this data 
submission, Form 477 data was used; however we are reviewing other sources for further verification. All 
anomalies identified during this analysis are reviewed with the providers. 

 

BROADBAND PROVIDER VALIDATION—PROVIDER PORTAL APPLICATION 

Providers are trained on and requested to use a secure interactive web application to review their current 
coverage area(s) and supporting broadband attribution and validate their data or submit change requests 
to update their data. All provider change requests go through the Data Integration Process and are 
reviewed with the provider to complete validation. 
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CONFIDENCE VALUES 

All verification, validation and manual quality review results are tracked by provider/technology type and 
stored and maintained within a Validation table. A confidence value is assigned, based on internal 
assessments of the collected information, to highlight the provider coverage areas and/or attributions 
that would benefit from further investigation and/or enhancements. 

 

QUALITY CONTROL 

Following collection, processing and analysis of the provider and CAI data, the product is checked manually 
and algorithmically against the NTIA data model. Some of the items included within these checks are: 

 Format correctness; 

 Table and field structure; 

 Valid values, including default values, where applicable; 

 Geographic extent and topology errors. 
 
Prior to data submission, another quality control script supplied by NTIA is run. This script, 
SBDD_CheckSubmission.py, creates an output in text form that is required to be submitted along with the final 
deliverable. All errors must come up clean, unless otherwise specified by NTIA. Exceptions to the script as 
noted by NTIA on the SBDD Workspace on 03/25/11 can be found at the following link: https://sbdd-
granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions  

 Longitude values for States outside the lower 48 (any table); 

 CAI results for Transtech, MaxAdUp, MaxAdDown if BBService is “No” or “Unknown”; 

 Overview MaxAdDown, MaxAdUp if 100% of record-level data has MaxAdDown or MaxAdUp 
populated. 
  

https://sbdd-granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions
https://sbdd-granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions
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DETAILED PROCESS REVIEW 

A detailed review of the data collection, integration and quality control points within the broadband data gathering 
and mapping process are discussed in the subsections that follow. In addition, a diagram showing the overall 
process can be seen below. 

 
 

PROVIDER OUTREACH 

For the October 2011 data submission, an e-mail notification was sent to all providers with supporting 
deliverable dates. The providers mainly used the Provider Portal web application to submit changes to and/or 
validate their current coverage area(s). 

 
In support of the data collection effort, providers that did not timely respond to the outreach were contacted 
by phone. 
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OUTREACH MATERIALS 

The original provider packet sent via e-mail to the providers included the following documents and files: 

 Letter from the State inviting them to participate in the program; 

 Copy of the Non-Disclosure Agreement (NDA); 

 Copy of the Mapping NOFA from the NTIA; 

 Copy of the NOFA Clarification from the NTIA; 

 Broadband service address example file in CSV format; 

 Word document describing service address example file; 

 Broadband service block example file in CSV format; 

 Word document describing service block example file; 

 Broadband service street example file in CSV format; 

 Word document describing service street example file; 

 Broadband subscriber example file in CSV format; 

 Word document describing subscriber example file; 

 Broadband wireless coverage area sample shapefile; 

 Word document describing wireless coverage area sample shapefile; 

 Instructions for downloading, installing and using the WinSCP SFTP application. 
 

OUTREACH PROCESS 

The provider outreach process is comprised of the following general steps: 

 Send the provider package and introduction letter to the main point of contact for the provider. 

 Follow up with e-mail and telephone to verify that the main point of contact is correct. 

 If necessary, discuss the NDA further and resolve any redlines. 

 Once the correct primary contact is established, set up a telephone call, if necessary, to learn more 
about the provider’s offerings and direct them to the appropriate outreach materials. 

 If providers are unable to be contacted (non-responsive) or indicate that they are not interested in 
participating (non-cooperative), mark them as such on the provider tracking sheet. These providers 
will be escalated to the State for further action. 

 As the providers are collecting the required data, provide instructions on downloading, installing and 
using the WinSCP SFTP application, if required. 

 Arrange with the providers to transfer the data in whatever way they are comfortable: some 
providers will find regular email acceptable; others will want to use the SFTP application. 

 After data is received and reviewed, it may be necessary to contact a provider for clarification or to 
address incomplete datasets. In the interest of building and maintaining relationships, care is given 
not to push the provider but to work with it to obtain accurate data in the best possible format. 
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DATA COLLECTION 

DATA TRANSFER PROCEDURES 

There are three primary ways data is collected from providers. These are: 

 Secure FTP (SFTP) using the WinSCP application; 

 Regular e-mail; 

 Mail. 
 

INITIAL DATA REVIEW AND QUALITY ASSURANCE 

The initial data review and quality assurance process consists of the following general steps: 
1) Access the data from the SFTP site or e-mail. 

a. If e-mailed, place copy of original dataset in the appropriate provider folder on the SFTP site. 
2) Place copy of raw data on local computer in a working directory. 
3) Review data and determine course of action based on type of data received. 
4) Ensure data is complete and contact provider to address any gaps. 

 

NOTE: 
The goal is to get as many providers as possible to provide subscriber address data in the correct format. 
Obviously, this will not be possible with all providers so we will continue to have to process various types of 
provider-supplied data. 

 

DATA INGESTION 

DATA INGESTION OVERVIEW 

The following subsections outline the process steps taken based on the type of input supplied by the data 

provider: 

 Point Data: 
o Subscriber location; 
o DSLAM location; 
o Central Office location; 
o Broadcast Tower location. 

 Linear Data: 
o TIGER® street segments. 

 Polygonal Data: 
o Census Blocks; 
o Coverage Area. 

Overall, the process is geared toward taking the provider data supplied and creating polygon shapes to 
append to the bb_cov feature class. The bb_cov feature class is the interim dataset that is then processed 
using the makeDeliverable.py Python script to create the MapConnect

TM
 data layers that will be delivered 

to the State and, ultimately, to the NTIA. Detailed instructions used in this process can be found in the 
subsections below. 
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POINT DATA 

SUBSCRIBER LOCATION—ADDRESS DATA 

In the event that the data provider supplies subscriber address data, the steps are as follows: 
1) First, convert the address data to a clean Excel spreadsheet in an appropriate address data 

format. 
a. Usually, this has the following columns: street address (number, pre-directional, pre-

modifier, street name, street type, post-directional and post-modifier concatenated), city, 
state, ZIP. 

2) Configure the ArcGIS® geocoding tool to use the TIGER® 2009 streets dataset. 
a. In ArcCatalog®, create a new Address Locater by right-clicking in the white space of the 

appropriate directory and selecting New>Address Locater from the dropdown menu. 
b. Select US Streets with Zone and click OK. 

 

NOTE: 
It is likely that multiple Address Locators will have to be set up to handle the variety of provider address data 
received. 
 

c. Navigate to the TIGER Streets 2009 file and click OK. 
d. Fill in the dialog box, as shown below: 
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e. Click OK. 
3) Open ArcMap® and add the Excel spreadsheet with the address information. 
4) Right-click on the Excel spreadsheet and select Geocode Addresses from the dropdown menu. 
5) Select the appropriate address locator by clicking Add…, then OK. 

 

6) Fill out the Geocode Addresses dialog box, as shown below: 

 

7) Geocode the list in batch mode using the geocode service set up in Step 2 above, accepting all 
the default parameters. 

8) Review results. See example below. 
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9) Adjust geocoding parameters accordingly and repeat batch to resolve issues. 
10) Manually geocode unmatched addresses until target hit rate achieved, generally 90%. 
11) Visually inspect the data, as shown below: 

 

12) Follow the steps detailed in Subscriber Location—GIS Data below. 
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SUBSCRIBER LOCATION—XY DATA 

If the provider supplies a list of subscriber data with accompanying XY data such as latitude and 
longitude, the steps are as follows: 

1) Refine the format in Excel so that the data can be opened easily using ArcMap®. 

a. Remove all font color, highlighting, cell colors and borders, clean up column headers and 
make certain there are no merged cells. 

b. Make certain that XY locations are in decimal degrees. 
(i.) To convert from degrees, minutes, seconds (39º 26’ 45.67”) to decimal degrees, use the 

following formula: DD + (MM/60) + (SS.SSS/3600). 
 

NOTE: 
If XY locations from some other coordinate system are provided, you can use those in the process below but you 
must know what the coordinate system is. 
 

2) Open the Excel worksheet in ArcMap®. 

3) From the menu bar, select Tools>Add XY Data… 

 

4) Supply the appropriate fields for the X and Y coordinates, choose the appropriate coordinate 
system and click OK. 

5) Results are an event layer, not a true spatial layer. Export the data by right-clicking the event 
layer and selecting Data>Export Data… from the dropdown menu. 

6) Follow the steps detailed in Subscriber Location—GIS Data below. 
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SUBSCRIBER LOCATION—GIS DATA 

If the provider supplies subscriber location in GIS format, the only process step is to load that data 
into the appropriate data schema and it will be ready for processing. 
1) First, load the data into the Point Address database schema using an empty feature class in that 

schema. 

2) In ArcCatalog®, right-click on the empty feature class and select Load from the dropdown menu. 

3) Navigate to the provider address GIS dataset and then map the attribute fields accordingly, as 
shown below: 

 

4) Once you have successfully loaded the provider address data into the temporary database with 
the correct schema, you now will append that data to the overall Point Address database. 

5) In ArcToolbox®, use the Append command (Data Management Tools>General> Append) to add 
the features into the overall Point Address database, as shown below: 
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6) Since the data is already in the Point Address database schema, there is no need to alter the Field 
Map in the Append tool. 

7) After appending, calculate metadata reflecting geometry source and representation values. 
8) Break provider-specific points into separate county feature classes and perform the following 

steps per county feature class: 
a. Within ArcGIS®: 

(i.) Summarize download and upload speeds [first,last] to determine all speeds available for 
county. 
(1) This will save as a DBF table. Keep track of location for future reference. 

(ii.) Buffer county address point featureclass to 150’. 
(1) During buffer command, dissolve on ad_down; ad_up; provider; dba; frn; tt; all 

metadata fields; stctyfips. Save as…. county_fastestdown_fastestup.  
(2) Example using Qwest data: boulder_40128_20128, where boulder=county; 

40128=ad_down; 20128=ad_up. 
 

NOTE: 
These attribute fields are specific to the Point Address database. 
 

(iii.) Select the features that represent the lowest speeds. 
b. Using XtoolsPro (http://www.xtoolspro.com/): 

(i.) In the XTools Pro toolbar, select XTools Pro>Layer Operations>Erase Features. 
(ii.) Use the same feature class for Input and Overlay. 
(iii.) Check Use selected features on the Input feature, as shown below. 
(iv.) Repeat and erase slowest speeds one speed at a time. Save each new feature class as 

the next slowest speed, using the same naming convention as shown in a.(ii.)(1) above. 
A general example is shown below: 
  

http://www.xtoolspro.com/
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c. Return to ArcGIS®: 
(i.) Edit/delete speeds from the attribution table of each feature class, so each remaining 

feature class has only one speed value. 
(ii.) Merge individual speed feature classes using the Merge command in ArcToolbox® (Data 

Management Tools>General>Merge). The dialog box is shown below:  

 

(iii.) Merge individual county feature classes using the Merge command in ArcToolbox (Data 
Management Tools>General>Merge). 

(iv.) Since the county files are all in the same schema, DO NOT alter the Field Map portion of 
the command interface. 
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(v.) When all the county files are merged into one dataset, use the Append command in 
ArcToolbox® (Data Management Tools>General>Append) to add the features to the 
bb_cov interim dataset. Use the Field Map portion of the Append tool to map the 
appropriate field values to their corresponding fields in the bb_cov feature class. 

DSLAM OR CENTRAL OFFICE LOCATION—ADDRESS DATA 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central 
Office address data, the steps are as follows: 
1) Follow the process for geocoding points in Subscriber Location—Address Data above. 
2) Follow the steps detailed in DSLAM or Central Office Location—GIS Data below. 

DSLAM OR CENTRAL OFFICE LOCATION—XY DATA 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central 
Office XY data, the steps are as follows: 
1) Follow the process for creating points from XY data in Subscriber Location—XY Data above. 
2) Follow the steps detailed in DSLAM or Central Office Location—GIS Data below. 

DSLAM OR CENTRAL OFFICE LOCATION—GIS DATA 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central 
Office GIS data, the steps are as follows: 
1) Buffer the DSLAM/Central Office points feature class. 

a. Add the point feature class to ArcMap®. 

b. Open the ArcToolbox® and go to Analysis Tools>Proximity>Buffer. 

c. Set the buffer distance to 5 miles. 
d. Set the dissolve type to ALL. 
e. Name the output feature class. 
f. Typical Buffer tool is shown below: 
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g. Click OK. 

2) Use the resulting buffer feature class to clip the TIGER® street layer: 

a. Add TIGER® street layer to ArcMap®. 

b. Open the ArcToolbox® and go to Analysis Tools>Extract>Clip. 

c. Complete the dialog box as shown below: 

 

d. Click OK. 

3) Using ArcCatalog® and within the file geodatabase: 

a. Right-click and create a new Feature Dataset.  
(i.) For the Feature Dataset settings: 

(1) Name the feature dataset accordingly. 
(2) Select horizontal coordinate system by importing the coordinate system associated 

with the clipped TIGER® street layer by selecting Import and navigating to the 

location of that feature class. 
(3) No vertical coordinate system needed. 
(4) Leave all x,y,z,m values at default. 
(5) Click Finish. 

4) Import previously created street feature class into new Feature Dataset. 
5) Right-click Feature Dataset and create new Network Dataset—accept all default setting for the 

Network Dataset. 
 

NOTE: 
The Network Analyst extension must be turned on. 
 

6) In ArcMap® turn on the Network Analyst Toolbar by going to View>Toolbars>Network Analyst. 

7) Add the Network Dataset created in Step 5 to ArcMap. 
8) Using the Network Analyst Toolbar dropdown, create New Service Area. 

9) Open the Network Analyst Window by selecting the  button. See below. 
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10) Right-click Facilities layer, select Load Locations and navigate to the DSLAM/Central Office 
facilities feature class. 

 

11) Click OK. 

12) Click the Service Area Properties button . 
13)  For the following tabs, change the following properties: 

a. Polygon Generation tab:  
(i.) Select Merge by break value.  
(ii.) Also disable the Trim Polygons option. 

b. Analysis Settings tab—using and converting the specified DSLAM buffer distance from feet 
to meters—input buffer distance value in meters into the Default Breaks location. 
(i.) Generally, 18,000 feet (5486 meters) from DSLAM or Central Office location is used as 

the buffer distance. See below. 



                                                                              

       Version 2.0         September 2011 Author: Kristin Rousseau 
       Page 27 

 

c. Click OK. 

14) On the Network Analyst Toolbar, click the Solve button  to create service area polygons. 
15) Right-click on the created service area polygon in the layer list, and select Data>Export Data from 

the dropdown list. 
16) Export to a feature class in the file geodatabase you created earlier. 

17) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the feature class created in Step 16 into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click the Add button, then click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 
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e. Click Next, then Next again, then Finish. 

18) In ArcToolbox®, go to Data Management Tools>General>Append. 

19) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 

 

20) Leave the Schema Type as TEST. 
21) Click OK. 

22) In ArcMap®, open bb_cov for editing and manually input associated attribution. 

  



                                                                              

       Version 2.0         September 2011 Author: Kristin Rousseau 
       Page 29 

BROADCAST TOWER LOCATION—ADDRESS DATA 

In the event that the provider supplies wireless broadcast tower location address data, the steps are 
as follows: 
1) Follow the process for geocoding points in Subscriber Location—Address Data above. 
2) Follow the steps detailed in Broadcast Tower Location—GIS Data below. 

BROADCAST TOWER LOCATION—XY DATA 

In the event that the provider supplies wireless broadcast tower location XY data, the steps are as 
follows: 
1) Follow the process for creating points from XY data in Subscriber Location—XY Data above. 
2) Follow the steps detailed in Broadcast Tower Location—GIS Data below. 

BROADCAST TOWER LOCATION—GIS DATA 

In the event that the provider supplies wireless broadcast tower location GIS data, the steps are as 
follows: 
1) Download the required software (Radio Mobile) from the website: 

http://www.cplus.org/rmw/english1.html  
2) Install the software according to the standard directions, found here: 

http://www.cplus.org/rmw/download/download.php?S=1  
3) Open the application. 
4) Load the broadcast tower location and elevation information by selecting File>Unit properties. 

The following dialog box appears: 

 

5) Add the information for all the towers supplied by the WISP data provider, including the 
elevation. If provider does not supply elevation, this information can be obtained from Google 
Earth. 
a. If available, use the Import button to import a Google Earth KML of the tower locations. 

6) Go to the National Map Seamless Server (http://seamless.usgs.gov/) and download elevation 
data sufficient to contain the tower locations. 

http://www.cplus.org/rmw/english1.html
http://www.cplus.org/rmw/download/download.php?S=1
http://seamless.usgs.gov/
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a. At least the 1/3” NED data is needed. Select this by clicking the Download button in the 
upper right of the website and checking the box next to 1/3“ NED. 

b. Zoom to the area of interest and use the Download tools to define the area to download: 

 

c. Click the Modify Data Request button to request the data in BIL_16INT format, not ESRI 
GRID, as shown below: 

 

d. Download the data and unzip it. 
7) Select File>Map Properties to define the map. 
8) Enter a latitude and longitude in the center of the tower locations. 
9) Set the size (in pixels) and the size (in kilometers) of the map. 
10) Set the directory path leading to the BIL elevation data just downloaded. 
11) The dialog box is shown below: 
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12) Click Extract. 
13) The elevation data is rendered as a hill shade, as shown below: 

 
14) Select File>Network properties from the main menu. 
15) Create a new network and enter in the frequency range under the Parameters tab, as shown 

below: 
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16) Leave all the other values as they appear, and select the Systems tab. 
17) Create enough systems to cover all the varieties of equipment in the provider network. This will 

include the antenna type, height and line loss, as shown below: 

 
 



                                                                              

       Version 2.0         September 2011 Author: Kristin Rousseau 
       Page 33 

18) Now click on the Membership tab, and assign the individual towers to their respective systems, 
providing the azimuth for non-omnidirectional antennas, as shown below: 

 
19) Click OK. 
20) Select Tools>Radio Coverage>Combined Cartesian from the main menu. 
21) Complete the dialog box as shown below, providing the Maximum Range from the highest tower 

beam radius supplied by the provider. 
22) Set the Pixel Size at 5 (experiment depending on the area covered to get the right level of 

granularity), as shown below: 

 
23) Set the Signal range to draw to S-Unit and type 5 in the From (>=) box. 
24) Click on Draw. See below. 
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25) Save the resulting image as a TIF by selecting File>Save Picture as. 
26) Open ArcMap® and load the BIL elevation data you used in Radio Mobile. 
27) Load the TIF image you created and georeference it using the corners of the BIL data. 

a. The corners of the data can be seen in the TIF image. 
28) Follow the georeferencing directions from the Coverage Area—PDF/JPG/Other Image Format 

section below. 
29) Use the Georeferencing Toolbar to Update the Georeferencing for the TIF dataset. 
30) In ArcToolbox®, select Data Transformations>From Raster>Raster to Polygon and input the 

georeferenced TIF you just created. 
31) Open the resulting polygon feature class for editing using the Editing toolbar in ArcMap® and 

clean up as necessary. 
32) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the feature class created above into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click the Add button, then click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 
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e. Click Next, then Next again, then Finish. 

33) In ArcToolbox®, go to Data Management Tools>General>Append. 
34) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 

 
35) Leave the Schema Type as TEST. 
36) Click OK. 

37) In ArcMap®, open bb_cov for editing and manually input associated attribution. 
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LINEAR DATA 

TIGER® STREET SEGMENTS—LIST, SPREADSHEET OR GIS DATA 

In the event that the provider supplies TIGER® street segments in list or spreadsheet format, the 
steps are as follows: 
1) Join TIGER® road segments to 2000 census blocks feature class using one of two methods based 

on how the data is provided: 
a. If the TIGER® data is provided with a Census Block ID, then join the segments to the Census 

Block geometry based on that ID: 
(i.) Load both datasets into ArcMap®; 
(ii.) In the layer list, right-click on the 2000 census block feature class and select Joins and 

Relates>Join; 
(iii.) In the dialog box, select the TIGER® road segments data and the proper attribute fields 

for joining, as shown below: 

 
(iv.) Click OK. 

b. If the data provided is a list containing TLIDs, then join to the TIGER®/Line data using the 
TLID, and use a spatial join to associate the TIGER® segment with the coterminous block 
based on the block ID: 
(i.) Load both datasets into ArcMap®; 
(ii.) In the layer list, right-click on the 2000 census block feature class and select Joins and 

Relates>Join; 
(iii.) Select Join data from another layer based on spatial location from the dropdown 

menu; 
(iv.) Complete the dialog box, as shown below and click OK. 
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2) Export joined records into a temporary feature class. 
3) If joined Census Block geometry is confined to one specific area, then dissolve blocks into one 

record. If joined Census Block geometry is distributed throughout a particular State, then dissolve 
sub-selections of census blocks for each county. 
a. Use the County FIPS code to dissolve by county. 

b. In ArcToolbox®, select Data Management Tools>Generalization>Dissolve. 

c. Complete the Dissolve dialog box, as shown below: 
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d. Click OK. 

4) For each dissolved region, open the feature class for editing using the Editing tool in ArcMap® 

and remove unnecessary slivers and other small holes. For general guidance on editing features 

in ArcMap®, see http://webhelp.esri.com/arcgisdesktop/9.3/pdf/Editing_Tutorial.pdf  

5) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the feature class created above into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click on the Add button, then click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 
 

http://webhelp.esri.com/arcgisdesktop/9.3/pdf/Editing_Tutorial.pdf
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e. Click Next, then Next again, then Finish. 

6) In ArcToolbox®, go to Data Management Tools>General>Append. 
7) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 

 
8) Leave the Schema Type as TEST. 
9) Click OK. 
10) In ArcMap®, open bb_cov for editing and manually input associated attribution if necessary. 
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POLYGONAL DATA 

COVERAGE AREA—PDF/JPG/OTHER IMAGE FORMAT 

In the event that the provider supplies coverage area data in some image format such as PDF or JPG 
format, the steps are as follows: 
1) If in PDF format, open in Adobe Acrobat and Save As… JPG format. 

2) Open the JPG image in ArcMap®. 

3) Add the required base map vector data for georeferencing. 

a. This generally will be either the CDOT data or TIGER® data. 

4) Change the coordinate system of the data frame to the desired end coordinate system. 
5) Zoom to the general location of the JPG map image. 

a. This is the location based on the vector data, not the JPG image itself. For example, if you 
know that the JPG image represents an area around the town of Limon, zoom to the town of 
Limon in your vector data. 

6) Open the Georeferencing toolbar by selecting View>Toolbars>Georeferencing from the main 
menu bar. 

7) Using the Georeferencing toolbar, select Fit to Display; results are shown below: 

 

8) Use the Control Point button  to add control points to the map. 
9) Use common points in the base dataset and the JPG image. 

a. For example, find major street intersections, county/city boundaries, etc. 
b. Try to distribute the points more or less in the four corners on the image for the best 

transformation. 
10) Click on the location on the image first, then click on the corresponding location on the vector 

database map, as shown in the image below: 
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11) After placing each control point, the image transformation will update automatically.  
12) Repeat until satisfied with the transformation. 

 

NOTE: 
The transformation may take up to four points, although sometimes only two are necessary. 
 

13) When satisfied with the transformation, select Update Georeferencing from the Georeferencing 
toolbar dropdown. 
a. This will create a “world” file (.jgw in the case of JPGs) in the same directory as the image 

file. 

14) In ArcCatalog®, create a new polygon shapefile with the appropriate data schema for a provider 

coverage area. 

15) Add the shapefile to ArcMap®. 

16) Using the Editor toolbar, select Start Editing. Set the Task to Create New Feature. 

17) Use the Sketch Tool  to digitize a new coverage polygon using the coverage area outline 
from the georeferenced JPG and add the required attributes manually. 

18) Repeat the above steps for all subscriber speed coverage areas provided. 
19) Follow the steps detailed in Coverage Area—GIS Data below. 

COVERAGE AREA—KML/KMZ 

In the event that the provider supplies coverage area data in Google Earth KML or KMZ format, the 
steps are as follows: 

1) Use a KML to SHP converter to translate file into an Esri® format. 

2) http://arcscripts.esri.com/details.asp?dbid=15603  

3) Download the script and follow the provided instructions for installing it in ArcToolbox®. 

4) Double-click on the script in ArcToolbox® and navigate to the location of the KML file, as shown 

below: 
 

http://arcscripts.esri.com/details.asp?dbid=15603
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5) Add the new shapefile to ArcMap®. Repeat for all KML files provided. 

6) Follow the steps detailed in Coverage Area—GIS Data below. 

COVERAGE AREA—CAD DATA 

In the event that the provider supplies coverage area data in GIS format, the steps are as follows: 

1) Transform the CAD dataset into an Esri® format. 

2) http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datase
ts 

3) It may be necessary to contact the provider first to determine the coordinate system of the CAD 
data. 

4) If the CAD data is not in a standard coordinate system, it may be necessary first to use ArcMap® 

to georeference the CAD data to a known coordinate system. 
a) To do so, follow the instructions provided above in Coverage Area—PDF/JPG/Other Image 

Format. 

5) In ArcCatalog®, create a new polygon shapefile with the appropriate data schema for a provider 

coverage area. 

6) Add the shapefile to ArcMap®. 

7) Using the Editor Toolbar, select Start Editing. Set the Task to Create New Feature. 

8) Use the Sketch Tool  to digitize a new coverage polygon using the coverage area outline 
from the georeferenced CAD file and add the required attributes manually. 

9) Follow the steps detailed in Coverage Area—GIS Data below. 

COVERAGE AREA—GIS DATA 

In the event that the provider supplies coverage area data in GIS format, the steps are as follows: 

1) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the GIS feature class either created above or supplied by the provider into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click on the Add button, then click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 

 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datasets
http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datasets
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e. Click Next, then Next again, then Finish. 

2) In ArcToolbox®, go to Data Management Tools>General>Append. 

3) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 

 
4) Leave the Schema Type as TEST. 
5) Click OK. 

6) In ArcMap®, open bb_cov for editing and manually input associated attribution, if necessary. 

COMPACT POLYGON FROM SUBSCRIBER POINTS  

1) Geocode address list using latest State Composite Locator.  
2) Verify that your geocoded file has only one TT (Technology Type). If not, export individual 

geocoded layers for each Technology Type. 
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3) For each TT, check for differences in speed values or speed tiers and create separate layers for 
each speed value/tier. 

4) Clean your geocoding results: remove any points that geocode to accuracy levels below ZIP+4 
(ZIP centroids, carrier route centroids, etc). Also, verify that outliers with acceptable accuracy 
levels are legitimate, i.e., fall in correct city and Zip. 

5) Perform spatial join between county polygons (using stcnyfips field) and the cleaned geocoded 
subscriber points in order to carry the county name and stcnty fips. 

6) Summarize the number of subscribers by county and use the subscriber counts by county to 
populate the Rate Tier table. 

7) Un-join the county data from the geocode subscribers list. 
8) Create Compact Polygon using cleaned geocoded layer or sub-selection of XtoolsPro—

ConvexHull-DetailedHull option. A sub-selection of geocoded points will be used in areas where 
more than one polygon will need to be created for one provider’s service area. 

9) Evaluate output Hull carefully, looking for areas that should not be covered by hull polygon. 
a. If it is determined that an area or areas should not be represented in coverage area, 

manually reshape hull polygon until coverage area is adequate. 
b. When not obvious and as a general rule, manually resolve compact polygon when the 

distance between the subscriber points used to define the outer boundary of the compact 
polygon exceeds 5 miles . When reshaping the hull polygon, snap to the outermost 
geocoded points. See the three figures below for examples. 

      Compact Hull: Manual Resolution Required            
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Compact Hull: Manual Resolution Required                                        Compact Hull: After Manual Resolution        

                      
10) To attribute the compact polygon, perform a spatial join where your Target Feature Class is the 

compact polygon and the Join Feature Class is your geocoded point layer. Export compact hull 
with joined attributes and name file appropriately. 

11) Append attributed compact polygon to Broadband TT template Feature Class and, if required, 
manually input any provider attribution that may not have carried over in the append process. 

12) Intersect compact polygon with county boundaries to create unique records by county and use 
the state-county-fips field to populate stcty_fips field. Also use the county name field to populate 
the BBCov_Name field. 
a. Exception: where a provider’s coverage is distributed throughout more than one area of any 

given county where the BBcov_Name should be populated using an appropriate city or other 
logical name based on geographical location. 

13) Export/load into appropriate BB TT model dataset. 

CENSUS BLOCKS—LIST OR SPREADSHEET 

In the event that the provider supplies census block data in a list or spreadsheet, the steps are as 
follows: 
1) Ensure block polygons supplied by the provider are 2000 currency. 
2) If other currency, convert to 2000 currency before proceeding. 

a. To do this, remove the trailing letter (a, b, etc.) from the block ID. 
b. You will now have two blocks that equate to one block in the 2000 block geometry. 
c. Delete duplicate block IDs, retaining the higher service tier in each case. 

3) Prepare the block list in clean Excel format, removing all Excel-only formatting, merged cells, 
colors, borders, etc. 

4) Import the spreadsheet into ArcMap®. 

5) Right-click on the 2000 census block feature class in the layer list in ArcMap® and select Joins 

and Relates>Join from the dropdown menu. Join the census block list to the 2000 census blocks 
feature class using the block ID and export joined records in a new feature class. The Join dialog 
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box and process can be seen above in the TIGER® Street Segments—List, Spreadsheet or GIS 

Data subsection. 
6) Follow the steps in Census Blocks—GIS Data below. 

CENSUS BLOCKS—GIS DATA 

In the event that the provider supplies census block GIS data, the steps are as follows: 
1) Ensure that the blocks supplied by the provider are in the required data schema and are 

complete as far as required attribution. 
a. If not, manually enter the required attribution or contact the provider to fill gaps. 

2) If census block geometry is distributed throughout more than one county, then select Data 
Management Tools>Generalization>Dissolve in ArcToolbox® and dissolve based on 
County/Provider/TT/Speed Tier so that unique records are created for each unique combination. 
a. The Dissolve dialog box is shown above in the TIGER® Street Segments—List, Spreadsheet 

or GIS Data section. 
b. Two examples of undissolved census block polygons are shown below: 

 
Undissolved census block polygons 

 
Census block polygons dissolved by county 

3) For each dissolved region use the Editing toolbar in ArcMap® to remove unnecessary slivers and 

other small holes. 
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4) In ArcToolbox®, select Data Management Tools>General>Merge and merge the processed 

polygons into a single layer. 
5) The merged census blocks will need to have the subscriber’s frn field added and populated. 

6) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the GIS feature class either created above or supplied by the provider into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click the Add button, the click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 

 
e. Click Next, then Next again, then Finish. 

7) In ArcToolbox®, go to Data Management Tools>General>Append. 

8) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 
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9) Leave the Schema Type as TEST. 
10) Click OK. 

11) In ArcMap®, open bb_cov for editing and manually input associated attribution, if necessary. 

 

METADATA TRANSACTIONS 

Following any updates or changes completed within the file geodatabase (fGDB) stored on the GIS-Analysts 
staging environment, the GIS-Analyst runs transactions to compare that fGDB with the one stored on the Core 
server to ensure metadata on all changes is recorded. 

 
The steps taken to run transactions on the updated Core database are outlined below: 

1) Open a command line window and run generateTransactions.py:  
a. Usage: generateTransactions.py  [Core fGDB] [Staging Environment fGDB]  
b. Example of command line:  

<path>generateTransactions.py <path>ST_BB_POLY_SRV_AREAS.gdb <path>ST_BB_POLY_SRV_AREAS.gdb  
2) Shown below is an example of the output screen that will be displayed: 
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3) After the process has completed, results can be found in the ST_BB_POLY_SRV_AREAS_HIST.gdb:  

a. The transactions scripts records changes at a feature level. 
b. Shown below is a screenshot supporting the directory structure of the historical fGDB. 

 
c. Attribution associated with each added/removed/changed feature is tracked, including the 

following additional columns appended to the end of each: 
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(i.) Commit_by 
(1) Records the GIS-Analyst who committed the changes to the historical fGDB. 

(ii.) Commit_date 
(1) Records the date and time stamp on which the changes were committed. 

(iii.) Trans_type 
(1) This field reflects the type of change recorded; 
(2) Categorized by: Adds/Change/Deletes. 

(iv.) New_values 
(1) Records the new values when a change was completed on a feature. Example: 

Name or speed change. 
d. MD_Process also is transferred from the edited fGDB to the historical fGDB, which states the 

actions completed by the GIS-Analyst. 

 

 

DATA PROCESSING 

DATA PROCESSING OVERVIEW 

The following subsections detail the steps and layout required to process the service provider data further 
to meet NTIA requirements: 

 Weighted Nominal Speed; 

 Middle Mile; 

 Broadband Coverage Template. 
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WEIGHTED NOMINAL SPEED 

The weighted nominal speed is populated in one of the following two ways: subscriber data supplied by 
provider or value supplied by provider. 

SUBSCRIBER DATA SUPPLIED BY PROVIDER 

Where the data provider supplies subscriber speed information, the following formula from the NOFA 
is used: 

(speed tier-1 in kbps × no. of tier-1 subscribers) + (speed tier-2 in kbps × no. of tier-2 subscribers) + (etc.) 
Total average monthly subscribers 

 
Data is initially broken up in the following order: 
1) Stcty_fips; 
2) Transmission technology type; 
3) Subscriber tiers. 

VALUE SUPPLIED BY PROVIDER 

Some providers will supply their weighted nominal speed. In these cases, the data supplied will be 
populated instead of using the NOFA formula. These obtained or calculated values are used to update 
the service overview layer. 
 
This can be done manually or by creating a table with the provider’s FRN and average weighted speed 

and joining it to the service overview table in ArcMap®. 

1) To join, right-click on the layer to join to and select Joins and Relates>Join from the dropdown 
menu. 

2) Then navigate to the table to join to and select the join fields from the dropdown list. 

3) Then open the source table (the table in ArcMap®) and right-click on the header of the Average 

Weighted Speed field and select Calculate Field from the dropdown menu. 
4) Use the value of the average weighted speed from the joined table. 

 

MIDDLE MILE 

Middle mile information generally is provided in spreadsheet or text file format. The process is to take 
what is supplied by the provider and translate it into the required data schema. 

1) If the data is supplied with address information, follow the process outlined above in Subscriber 
Location—Address Data. 

2) If the data is supplied with associated XY coordinates, follow the process outlined above in 
Subscriber Location—XY Data. 

3) Once the data is in GIS format, use the Append (Data Management Tools>General>Append) 

command in ArcToolbox® to append the data to the overall middle mile dataset. 

4) Set the schema type to NO_TEST and use the Field Map to map the attribute fields from the 
source to the target dataset. 
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BROADBAND COVERAGE TEMPLATE 

The table below lists descriptions of the fields within the bb_cov layer, which is the interim dataset used 
to create the final product deliverable. 
 

NAME ALIAS DESCRIPTION 

objectid OBJECTID Internal Object ID 

shape SHAPE Internal Shape storage 

prov_id PROVIDER_ID Unique numeric identifier for each provider 

prov_name PROVIDER_NAME Unique name for each provider 

dba_name DOING_BUSINESS_AS An alternative "Doing-Business-As" name for the provider 

frn FCC_REGISTRATION_NUMBER Provider FCC Registration Number 

bbcov_name BBCOV_NAME BroadMap Broadband Coverage name 

trans_code TRANSMISSION_CODE Unique code for the transmission technology type described by 

this layer 

trans_name TRANSMISSION_NAME Name for the transmissions technology type 

trans_desc TRANSMISSION_DESC Description for the transmissions technology type 

spect_code SPECTRUM_CODE Unique code for the spectrum [WIRELESS ONLY] 

spect_name SPECTRUM_NAME Name for the spectrum [WIRELESS ONLY] 

spect_desc SPECTRUM_DESC Description for the spectrum [WIRELESS ONLY] 

mad_dwn_t MAX_AD_DOWN_TIER Maximum advertised downstream speed available within given 

area (speed tier) 

mad_up_t MAX_AD_UP_TIER Maximum advertised upstream speed available within given area 

(speed tier) 

typ_dwn_t TYPICAL_DOWN_TIER Typical downstream speed available within given area (speed tier) 

typ_up_t TYPICAL_UP_TIER Typical upstream speed available within given area (speed tier) 

mad_dwn_k MAX_AD_DOWN_KBPS Maximum advertised downstream speed available within given 

area (kbps) 

mad_up_k MAX_AD_UP_KBPS Maximum advertised upstream speed available within given area 

(kbps) 

typ_dwn_k TYPICAL_DOWN_KBPS Typical downstream speed available within given area (kbps) 

typ_up_k TYPICAL_UP_KBPS Typical upstream speed available within given area (kbps) 

subs SUBSCRIBERS Total average monthly subscribers for this provider for this 

technology for this coverage polygon 

md_geom MD_GEOMETRY Metadata: Comma separated list of source ids from which the 

polygon extent was produced 

md_exists MD_EXISTS Metadata: Comma-separated list of source ids used in 

understanding and editing the provider data for this polygon 
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NAME ALIAS DESCRIPTION 

md_who MD_WHO Metadata: Name of the editor who last edited this feature at the 

time in md_when 

md_when MD_WHEN Metadata: Date/time that this feature was last edited 

md_process MD_PROCESS Metadata: Comma-separated list of processes used to create 

and/or modify this layer 

stcty_fips STATE_COUNTY_FIPS State/County FIPS code 

rec_id RECORD_ID Compound Key formed from 

STCTY_FIPS+"|"+Provider_ID+"|"+Trans_Code+"|"+BBCov_Name 

st_area ST_AREA(SHAPE) Area in square decimal degrees  

st_length ST_LENGTH(SHAPE) Length in decimal degrees  

Provider_Type Type of Provider Has Subtype (1:Broadband provider as described in the 

NOFA,2:Reseller,3:Unknown), default value=1 (New 04/11 Model) 

 

VERIFICATION AND VALIDATION 

PROVIDER VALIDATION—PROVIDER PORTAL/PDF MAP REVIEW 

Following the collection and aggregation of provider data, the aggregated data is validated by the 
provider to ensure it is an accurate representation of their coverage area and supporting broadband 
information. 

 This validation is completed through the Provider Portal web application, which is a secure 
interactive map that displays the provider’s coverage areas and allows the provider to 
validate, submit feedback or request changes. 
o If changes are requested, then the features on the portal are updated and an automatic 

request is sent to the provider to complete the validation process. 

 Providers that did not use the Provider Portal are asked to validate a PDF map displaying 
their coverage area(s). This is accomplished via e-mail notification. 

PROVIDER VERIFICATION—THIRD PARTY SOURCE REVIEW 

After the provider has validated its coverage areas, a third-party source comparison and analysis is 
performed. 

 Where anomalies or discrepancies are identified, a “SCAN” point is dropped and descriptive 
comments are applied to be reviewed later with the provider. 

 During the provider review, the map is displayed along with the “SCAN” points and potential 
refinement is completed based on input from the provider. 

The table below shows third-party sources used: 

THIRD-PARTY SOURCE NAME SOURCE TYPE VERIFICATION TYPE 

InfoUSA Consumer and 
Business Listings 

Community Anchor Institutions; 
Can also be used for demographic information 
supporting the State websites. 

Pitney Bowes (PBBI) Exchange Info Plus 
(Central Office 
Locations) 

Exchange datasets are used to verify the following 
Transmission Technologies (TT): 
Asymmetric xDSL (10), Symmetric xDSL (20), Other 
Copper Wireline (30), and Optical Carrier/Fiber to the 
End User (50). 
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THIRD-PARTY SOURCE NAME SOURCE TYPE VERIFICATION TYPE 

Media Prints Cable Boundaries Used to verify the following TT: 
Cable Modem—DOCSIS 3.0 (40) and Cable Modem—
Other (41). 

American Roamer  Wireless Coverage 
Patterns (EVDO, 
GPRS, WISP, HSPA) 

Used to verify the following TT: 
Terrestrial Fixed Wireless—Unlicensed (70), Terrestrial 
Fixed Wireless—Licensed (71) and Terrestrial Mobile 
Wireless (80). 

ComSearch Wireless Spectrum 
Holdings and Tower 
Data 

Used to verify the following TT: 
Terrestrial Fixed Wireless—Unlicensed (70), Terrestrial 
Fixed Wireless—Licensed (71) and Terrestrial Mobile 
Wireless (80). 

ASSIGNING CONFIDENCE VALUES 
All findings and results from the abovementioned validation and verification activities, plus internal 
peer quality reviews, are captured and tracked in a Validation table (see example on the following 
page) and form the basis of the confidence value assigned for each provider and then each 
technology. 

CONFIDENCE VALUE DESCRIPTION 

    0 Coverage area has not been reviewed. 

  10 Extremely Low: 
Single Source QC.   

  20 Very Low: 
Needs additional validation\verification. 

  30 Low: 
Even with validation\verification, coverage still is suspect. 

  40 Acceptable: 
Confirm with State prior to shipment. 

  50 Meets requirements to be included in shipment. 

  60 Moderate: 
Meets NTIA/State’s standards, representative of Technology Type (TT). 

  70 High: 
Accurate representation of coverage based upon TT. 

  80 Very High: 
Multiple validation\verification with most third-party sources. 

  90 Extremely High: 
Multiple validation\verification sources. 

100 Perfect: 
Multiple validation\verification sources, with complete alignment with 
sources and ground truth verification activities. 

 

The Validation table is maintained as updates or changes occur for each provider, down to 
technology type, with the overall goal to improve the confidence values and overall map 
representation. An example of the Validation table is shown below: 
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COMMUNITY ANCHOR INSTITUTION (CAI) DATA 

DATA COLLECTION 

The CAI data was initially collected from the State to create the baseline inventory. All location 
information and broadband coverage data supplied also was ingested into the data deliverable. 
Additional collection of CAI information was done via data mining and/or webscraping to build out 
the inventory further. For example: Collection of additional CAIs and location information. 
 
The State-agency-provided CAI inventory was comprehensive but the challenge is collecting 
broadband related data: service provider(s), technology and speed data for each CAI. Availability of 
the CAI portal has not significantly increased submission of this data. Additional promotion to CAIs to 
use the CAI portal will be needed to increase this data for subsequent deliverables. 

INSTITUTION DATA 

Institution data is obtained from a variety of sources and almost always provided in Excel spreadsheet 
format. The general process for incorporating this data is as follows: 
1) If the data is provided in Excel or some similar format: 

a. Clean and standardize the Excel spreadsheet, removing any cell formats, merged cells, etc. 
b. Standardize the address format as defined in the staging CAI database. 
c. If the spreadsheet includes X and Y values, such as latitude and longitude, use the Add XY 

Data tool in ArcMap® to create a spatial data layer. 

d. If there are only addresses, then follow the geocoding steps outlined above to create spatial 
data points for each of the institutions. 

(i.) Institutions that do not geocode based on the TIGER® 2010 dataset will have to be 

located manually using Google Maps, Google Earth or some other information source. 
2) If the CAI source data is in GIS format, add the Latitude and Longitude fields and use the 

Calculate Geometry tool to populate them, using the WGS 84 coordinate system. 

3) Using ArcCatalog®, load the new data into the staging CAI database. 

4) This database is ready for the makeDeliverable.py script to process the information into the final 
State and NTIA deliverables. 
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COMMUNITY ANCHOR INSTITUTION (CAI) PORTAL UPDATES 

A web application has been released to allow for further data collection and validation of anchor 
institution location information, broadband coverage and speed test data. Information collected from 
the CAI Portal is then ingested into the overall inventory and will be compared later against the 
provider coverage areas mapped to locate any potential discrepancies. 

 

PRODUCT EXTRACT 

PYTHON SCRIPTS 

The following subsections make use of Python scripts. In general, to use a Python script you must have 
Python installed on your computer. To download the latest version of Python, go to 
http://www.python.org/download/ and download the latest stable version. As of August 2010, this was 
version 2.7. Once this is installed, the general way to run a script is to type the following at a command 
prompt: C:\Python27\python.exe C:\<location of script>. Many of the scripts provided have environment 
variables that must be set before they can be run. 
 
The Python code for BroadMap’s product extract has been incorporated into a Hudson CI System, which is 
detailed in the Process Operation and Monitoring section of this document. This was a process 
improvement activity so that all processes can be monitored, controlled and will contain historical 
tracking on each process. 

 

PRODUCT EXTRACT PROCESS 

NOTE: 
Specific Python scripts are called out in red font in the subsections below. 
 

The MapConnect
TM

 product extract process, makeDeliverable.py, uses the BB_Cov and 
BROADMAP_POINTS interim datasets to create the following layers according to the current 
specifications: 

 BB_Service_Road_Segment 
o This layer contains all broadband services associated with specific street segments for census 

2000 blocks larger in area than two square miles. 

 BB_ServiceCensusBlock 
o Contains all broadband services associated with census blocks of no greater than two square 

miles. 

 BB_Service_Wireless 
o This layer contains all wireless services not associated with specific addresses. 

 BB_ServiceOverview 
o This layer contains subscriber-weighted nominal speed for each provider's service area at a 

county level and is meant to act as a summarized view. 

 BB_ConnectionPoint_MiddleMile 
o This layer contains middle-mile and backbone interconnection points. 

 BB_Service_CAInstitutions 
o Broadband Service at Community Anchor Institutions (CAI). 
o Community Anchor Institutions consist of schools, libraries, medical and healthcare 

providers, public safety entities, community colleges and other institutions of higher 
education as well as other community support organizations and entities. 

http://www.python.org/download/
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Because of a NTIA model change for the October 2010 data deliverable, an addition to this code was 
created to support both models in case a comparison is later desired or a request is made to revert to the 
original model. This script name is bdia2ntia.py and creates the following layers in addition to the layers 
mentioned above, rolled up to NATL_Broadband_Map. 

 BB_ConnectionPoint_LastMile 
o This layer contains last mile infrastructure points, which is populated only if data cannot be 

provided at a more granular level. 

 BB_Service_Address 
o Represents broadband availability for service address points. Address Point availability refers 

to those individual addresses at which each facilities-based provider of broadband service 
can provide broadband services of minimal characteristics within 7-10 business days. 

 State_Boundary 
o State boundary supporting topological validation of point feature classes. 

 NATL_Broadband_Topology 
o Supports basic topology quality checking. Example: No CAIs or Middle Mile points outside of 

the State boundary. 
 
The following process flow provides a view of how the Core fGDB is extrapolated to the NTIA final 
deliverable via the makeDeliverable.py script. Following that, the bdia2ntia.py script is run, which limits 
what is placed in the final layers based on the NTIA modeling standards. 
 
The product scripts and supporting extract were originally created separately per request, in case data 
model comparisons were to be completed. 

 

PRODUCT STATISTICS 

Following the completion of a product extract, the product statistics script (BDIA_ReleaseNotesStats.py) 
extracts the following information supporting that product deliverable. 

 Provider Statistics: 
o Collects all provider information, listing by Provider Name. 
o Provides output of FRN. 
o Counts the number of features supported within the following layers: 

 Census Block; 
 Street Segment; 
 Max Upstream; 
 Wireless Services; 
 Infrastructure Points. 

o These updates were made to support the Data Package required to accompany every NTIA 
product deliverable. 

 Community Anchor Institution (CAI) Statistics: 
o Breaks down CAI to the eight categories: 

 1: School: K through 12; 
 2: Library; 
 3: Medical/Healthcare; 
 4: Public Safety; 
 5: University/College; 
 6: Other Government; 
 7: Other Community non-government; 
 None: Unknown Category. In cases where this occurs, further investigation is completed 

prior to product shipment to ensure all CAIs are categorized accurately. 
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o Reports out the following counts: 
 Total CAIs within that category; 
 Total CAIs that contain partial BB coverage. Contains any of the following information for a 

given CAI: BB Subscriber, Transmission Technology, Speed Down Speed Up; 
 Total CAIs that contain full BB coverage. Contains all of the abovementioned BB information 

for a given CAI. 
The output of this script is two CSV files: AnchorInstitutions.csv and Providers.csv. These files then can be 
inspected to ensure that there are the expected number of CAIs and providers for every release. 

 

QUALITY ASSURANCE 

Quality assurance is supported manually and algorithmically on the interim data, BB_Cov file geodatabase and 
on the final product. For scheduled product releases, a test product extract and subsequent manual and 
algorithmic QC run is completed along with a release review. The product specifications, project status reports 
and previous product release notes are used as references throughout this review. 
 
The following parameters are tested using the methodology listed below each: 

 Product Deliverable Format:  
o Correct names and format of data deliverables. 

 BDIA_QC_SUITES. 
o Correct Projections/Datum. 

 Manual interaction with product. 
o Metadata Present and Correct. 

 Manual interaction with product. 

 Table Structure: 
o All required tables included. 

 BDIA_QC_SUITES. 
o Extraneous tables identified. 

 BDIA_QC_SUITES. 

 Field Structure: 
o All fields included. 

 BDIA_QC_SUITES. 
o Extraneous fields identified. 

 BDIA_QC_SUITES. 
o Correct field names, types and widths. 

 BDIA_QC_SUITES. 

 Field Domains: 
o Values in all tables are constrained to the specified values specified: 

 This action is accomplished via BDIA_QC_SUITES and manual review of the product; 
 This tends to identify project completeness issues as fields with a null value are identified. 

 Geometric Representation: 
o Identify if all layers have the correct geometric representation: 

 Manual review of the BB_ServiceOverview layer; 
 Dependent on NTIA and client requirements. 

 Geographic Extent: 
o Product includes the necessary Geography associated with Product? 

 Manual Review—ArcGIS®. 
o Is there extraneous geography included in Product? 

 Manual Review—ArcGIS®. 
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 Completeness: 
o Products contain the expected amount of data? 

 Manual review of product statistics relative to weekly State reports and defined expectations. 

 Accuracy: 
o Product meets the stated accuracy requirements for the deliverable? 

 Sampling procedure to manually review source material to resulting product; 
 Provider Validation; 
 Verification using Third-Party Data; 
 Verification against reality, where applicable. 

 Data Regression: 
o Any unexplainable data loss or change? 

 This action is accomplished by comparing results within product statistics script 
(BDIA_ReleaseNotesStats.py) from previous releases, as well as manual review of the product. 

 Confidentiality: 
o Any unauthorized confidential information included in the delivery? 

 Review of NDAs and delivery expectations. 

 Prior Issues Resolved:  
o Have expected internal issues been resolved? 

 Manual review of data against previous product release notes. 
o Have agreed-upon customer issues been resolved? 

 Manual review of data against previous product release notes, status report and client feedback. 

 Delivery Medium: 
o Has the product medium been verified? 

 Manual review. 
o All files present. 

 Manual review of SFTP site to ensure all files are copied correctly, including file/directory size. 
o Correct location. 

 Manual review—confirmation of SFTP link, username and password. 
 

QC SUITE 

The BDIA_QC_SUITES consists of four main types of scripts supporting the overall QC process. These 
scripts are all run in concert and are called from the test_runner script and the test_BDIAProductGDB 
script. 

CONFIGURATION  

These scripts establish the configuration for the test_BDIAProductGDB script, which is the core of the 
QC Suite. 
update_test_config 
active_config 
config_PROCESS01_automated 
config_PROCESS01_manual 
set_active_config 

LIBRARIES 

These scripts provide additional functionality that is called from with the test_BDIAProductGDB 
script. 
bb_unittest_fixture 
bbcov_structure 
BC_XmlWriter 



                                                                              

       Version 2.0         September 2011 Author: Kristin Rousseau 
       Page 60 

file_folder 
search_and_replace 
unittst_fixture 
validate_BB_DB 
validate_BB_GDB 
xmlrunner_gui 

QC SUITE 

This is the core script for performing automated QA/QC on the interim and final data deliverables. 
test_BDIAProductGDB 

OTHER  

These scripts perform other functions detailed below: 
test_runner—this is the main script that runs all the other QC scripts and imports all the necessary 
scripts and libraries. 
which_build—this determines the current build and passes information to the configuration scripts. 

 

PROCESS OPERATION AND MONITORING 

Product Extract, makeDeliverable.py and bdia2ntia.py, is run within BroadMap using a platform called Hudson 
that has been enhanced to support BDIA product extraction, process monitoring, as well as product validation. 
The same platform can be planned for implementation for the State, if desired. 
 
Below are examples of the product create, product validation, product statistics and monitoring processes 
that are managed within the BroadMap Hudson CI-System. All of the abovementioned Python scripts, with 
the exception of metadata transactions script, are run via this system. 

 

BDIA PRODUCT CREATE 

Below is an example of the main page where the type of product build can be selected. 
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Selecting based on the type of process that will be initiated is shown below: 

  
 

  
The Console Output can be reviewed to see the progress of product create. Following the completion of 
each product creation process, an e-mail notification is automatically sent to the team. 

 
All processes run via the BroadMap Hudson CI-System are stored for historical reporting. Each process can 
be reviewed, including the Console Output and Build Artifacts from that run. 
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PRODUCT VALIDATION AND STATISTICS 

Once the product creation process is complete, Product Validation and Statistics are then initiated. These 
support the BDIA_ReleaseNotesStats.py script and the BDIA_QC_SUITES scripts detailed above. 

 
All statistics and reports are stored for historical review with the capability to place violation criticality on 
each quality control check, allowing the identification of errors because of project status/completeness 
verses project correctness. Example: Typical Speeds populated. 

 

Below is an example of the report provided based on various control points running over a specified 
period: 

 
Similar to the Product Create process, all results from the process are maintained: 
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Results are then reviewed manually to ensure no errors reported are critical or in violation of the NTIA 
data model or project completion statements. Any errors of concern are communicated ahead of product 
delivery and included within the product release notes. Further detail on the Hudson-CI System 
environment can be found by navigating to the following link: 
http://wiki.hudson-ci.org/display/HUDSON/Meet+Hudson 

 
 

PRODUCT EXTRACT DATA DELIVERY 

Product delivery for MapConnect
TM

 Broadband is handled two ways, depending on client requirements: 
1) State Submittal: 

a. Data is submitted via SFTP site; 
b. Product Release Notes and QC Test Report accompany the delivery. 

2) NTIA Submittal: 
a. Directions for using the NTIA State Broadband Data file submission tool: 

(i.) Go to the following website: https://esupport.fcc.gov/statedata; 
(ii.) Enter your username and password as provided to you from the NTIA program 
administrator; 

 
(iii.) Click in Upload a file field; 
(iv.) Browse to local file for submission using the Browse button. Select file, then select 

ATTACH FILE. See example below. 

http://wiki.hudson-ci.org/display/HUDSON/Meet+Hudson
https://esupport.fcc.gov/statedata
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(v.) Logout/Receipt using the Logout button in the top right of the screen; 
(vi.) A receipt of submission is e-mailed to username e-mail address. 
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OVERVIEW 

This white paper highlights the Submission Summary for this deliverable, as well as describes the Data Gathering, 
Data Integration, Data Validation and Verification and Quality Control processes used to create the Broadband 
Mapping Project’s October 1, 2011 data submission. To support varying levels of technical and program 
knowledge, both a high-level summary and a detailed process review are supplied. 
 

SUBMISSION SUMMARY 

PROVIDER DETAILS 

PROVIDER PARTICIPATION 

 Providers Included 

 Docomo Pacific 

 GTA  

 IT& E 

 MCV 

 PDS (Pacific Data Systems) Guam 
 

 New Providers Since Last Data Submission 

 Docomo Pacific 

 GTA  
 

 Other Provider Comments 

 iConnect 

 Currently not a broadband service provider; however they are researching further on 

entering the Terrestrial Fixed Wireless market 

 

 

COVERAGE AREA CHANGES 

 Coverage Footprint Reductions/Map Refinement –  

 No significant refinement required for this data submission 

 

 Coverage Footprint Expansion –  

 Pacific Data Systems  
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DATA CORRECTIONS 

 There were no data corrections required for this data submission 
 

 

 

 

 

 

SUBMISSION RECEIPT RESULTS 

 Attached are the results from the NTIA data submission receipt quality script. 

  
 

 Error Report 

 The only item flagged in the submission receipt output is the following error, which has been 
verified as a correct entry within the data submission.  

 

 Field Check:     FAILED      MiddleMile_LONGITUDE has 70 UNEXPECTED VALUES for query: 
LONGITUDE Is Null OR (LONGITUDE < -170 OR LONGITUDE > -60) 

 

 

COMMUNITY ANCHOR INSTITUION (CAI) DETIALS 

OVERALL STATISTICS 

Community Anchor Institution - Categories 
Overall 
Count 

Broadband 
Subscriber 

Trans 
Tech 

Advertised 
Speed Down 

Advertised 
Speed Up 

Category 1 - School K through 12 56 0 0 0 0 

Category 2 - Library  9 5 5 5 5 

Category 3 - Medical/Healthcare 8 6 6 6 6 

Category 4 - Public Safety 28 19 19 19 19 

Category 5 - Universities/Colleges 5 0 0 0 0 

Category 6 - Other:  Government 79 0 0 0 0 

Category 7 - Other:  Non-Government  69 0 0 0 0 

Total 254 30 30 30 30 
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CAI CHANGES 

 A new CAI was added to this data submission: 

 Pacific Islands University 
 

 The only other change for this data submission was the inclusion of the CAIID extracted from the 
three databases communicated by NTIA.  They are as follows: 
 

 For K-12 institutions (CAI type 1) please add the NCES ID CCD ID value found here: 

http://nces.ed.gov/ccd/bat/  

 

 For Higher Education (CAI type 5) please add the NCES IPEDS ID value found here: 

http://nces.ed.gov/ipeds/datacenter/  

 

 For Libraries (CAI  type 2) please. Combine (do not add) “FSCSKey” and “FSCs_SEQ” from the 

“puout08av2000” file and place them here: 

http://harvester.census.gov/imls/data/pls/index.asp (FYI the LIBID is your state’s unique ID 

for libraries) 

 

  

http://nces.ed.gov/ccd/bat/
http://nces.ed.gov/ipeds/datacenter/
http://harvester.census.gov/imls/data/pls/index.asp
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HIGH-LEVEL SUMMARY 

DATA GATHERING 

BROADBAND SERVICE AREAS, MIDDLE MILE AGGREGATION POINTS AND 
BROADBAND SERVICE OVERVIEW 

The collection of Broadband Service Areas, Middle Mile Aggregation Points and Broadband Service 
Overview information is handled through the following Provider Outreach Process: 

 Build and maintain an inventory of Broadband providers through research and State inputs. 

 Update provider material that describes the data requirements and logistics for data transfer. 

 Update Non-Disclosure Agreement (NDA) for use in project, where applicable. 

 Maintain multiple protocols for the provider to submit data, including Secure File Transfer Protocol 
(SFTP) technology when desired. 

 Conduct one-on-one informational discussions with each provider to communicate the following: 
o Requirements of this project; 

o Broadband data required to support the product data model; 

o Submission protocols available; 

o Capability to validate how the supplied data is aggregated. 

 Download/receive provider data. 

 Establish a repeatable process with provider. Maintain provider communication, transaction and data 
handling records throughout the project (dates contacted, data received, etc.).  

 

COMMUNITY ANCHOR INSTITUTION (CAI) 

The collection of CAI information is handled through the following CAI Collection Process: 

 Collect and maintain inventory of CAIs through data mining, research and State inputs. 

 Maintain web-based CAI portal for institutions to add or confirm attribution, location and enter 
broadband-specific information. 

 Upload web-based data to Core Database for standardization. 

 Perform internal cleansing, such as removing duplicate records, identifying gaps in broadband 
attribution and verifying category. 

 Geocode CAI locations. 

 Translate Core Database data to deliverable-ready format. 

 Continue engagement with non-responsive institutions. 
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DATA INTEGRATION PROCESS 

The data integration and processing mechanisms currently used allow for multiple types of inputs and result in 
a standardized output that meets the NTIA deliverable requirements. This flexible process supports data 
model changes and project-requested enhancements. 

 Receive inputs from providers via submission protocols; upload into Sourcing Database and catalog 
with provider information. 

 Review provider-supplied data for completeness and for potential discrepancies that require 
resolution prior to processing and flag as necessary. 

 Categorize input into data-type category (addresses, block lists, paper maps, etc.). 

 Standardize input based on data type within Staging Database. 

 Create Compact Polygons (CP)—(internal methodology for generating area-based feature for 
coverage in Staging Database). 

 Apply broadband attribution to CP; apply metadata to CP. 

 Perform quality analysis of the CP against the source supplied to identify any completeness or 
accuracy issues. 

 Request additional information from the provider if elements of coverage are missing or contain 
discrepancies. This is a second manual quality check to ensure data is complete. 
o Process coverage area to build the required NTIA data model layers.  

 Process CAI data input into internal standardized format, as discussed above in the Community 
Anchor Institution (CAI) subsection, based on NTIA and State-level requirements. 

 

DATA VALIDATION AND VERIFICATION 

Following the creation of the product, process steps within Data Validation and Verification occur. To ensure 
the data collected and processed is as accurate and comprehensive as possible, provider validation and 
internal verification activities are employed. After the initial mapping of providers’ coverage areas and 
serviceability claims, additional reviews are performed using the methods described in the subsections below 
(Third-Party Data Verification, Broadband Provider Validation, Confidence Values). 
 

THIRD-PARTY DATA VERIFICATION 

The coverage is visually and programmatically compared against third-party data. Pitney Bowes and 
American Roamer data are used in cases where a coverage area is questionable. All anomalies identified 
during this analysis are reviewed with the providers. 

 

BROADBAND PROVIDER VALIDATION—PROVIDER PORTAL APPLICATION 

Providers are trained on and requested to use a secure interactive web application to review their current 
coverage area(s) and supporting broadband attribution and validate their data or submit change requests 
to update their data. All provider change requests go through the Data Integration Process and are 
reviewed with the provider to complete validation. 
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CONFIDENCE VALUES 

All verification, validation and manual quality review results are tracked by provider/technology type and 
stored and maintained within a Validation table. A confidence value is assigned, based on internal 
assessments of the collected information, to highlight the provider coverage areas and/or attributions 
that would benefit from further investigation and/or enhancements. 

 

QUALITY CONTROL 

Following collection, processing and analysis of the provider and CAI data, the product is checked manually 
and algorithmically against the NTIA data model. Some of the items included within these checks are: 

 Format correctness; 

 Table and field structure; 

 Valid values, including default values, where applicable; 

 Geographic extent and topology errors. 
 
Prior to data submission, another quality control script supplied by NTIA is run. This script, 
SBDD_CheckSubmission.py, creates an output in text form that is required to be submitted along with the final 
deliverable. All errors must come up clean, unless otherwise specified by NTIA. Exceptions to the script as 
noted by NTIA on the SBDD Workspace on 03/25/11 can be found at the following link: https://sbdd-
granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions  

 Longitude values for States outside the lower 48 (any table); 

 CAI results for Transtech, MaxAdUp, MaxAdDown if BBService is “No” or “Unknown”; 

 Overview MaxAdDown, MaxAdUp if 100% of record-level data has MaxAdDown or MaxAdUp 
populated. 
  

https://sbdd-granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions
https://sbdd-granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions
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DETAILED PROCESS REVIEW 

A detailed review of the data collection, integration and quality control points within the broadband data gathering 
and mapping process are discussed in the subsections that follow. In addition, a diagram showing the overall 
process can be seen below. 

 
 

PROVIDER OUTREACH 

For the October 2011 data submission, an e-mail notification was sent to all providers with supporting 
deliverable dates. The providers mainly used the Provider Portal web application to submit changes to and/or 
validate their current coverage area(s). 

 
In support of the data collection effort, providers that did not timely respond to the outreach were contacted 
by phone. 
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OUTREACH MATERIALS 

The original provider packet sent via e-mail to the providers included the following documents and files: 

 Letter from the State inviting them to participate in the program; 

 Copy of the Non-Disclosure Agreement (NDA); 

 Copy of the Mapping NOFA from the NTIA; 

 Copy of the NOFA Clarification from the NTIA; 

 Broadband service address example file in CSV format; 

 Word document describing service address example file; 

 Broadband service block example file in CSV format; 

 Word document describing service block example file; 

 Broadband service street example file in CSV format; 

 Word document describing service street example file; 

 Broadband subscriber example file in CSV format; 

 Word document describing subscriber example file; 

 Broadband wireless coverage area sample shapefile; 

 Word document describing wireless coverage area sample shapefile; 

 Instructions for downloading, installing and using the WinSCP SFTP application. 
 

OUTREACH PROCESS 

The provider outreach process is comprised of the following general steps: 

 Send the provider package and introduction letter to the main point of contact for the provider. 

 Follow up with e-mail and telephone to verify that the main point of contact is correct. 

 If necessary, discuss the NDA further and resolve any redlines. 

 Once the correct primary contact is established, set up a telephone call, if necessary, to learn more 
about the provider’s offerings and direct them to the appropriate outreach materials. 

 If providers are unable to be contacted (non-responsive) or indicate that they are not interested in 
participating (non-cooperative), mark them as such on the provider tracking sheet. These providers 
will be escalated to the State for further action. 

 As the providers are collecting the required data, provide instructions on downloading, installing and 
using the WinSCP SFTP application, if required. 

 Arrange with the providers to transfer the data in whatever way they are comfortable: some 
providers will find regular email acceptable; others will want to use the SFTP application. 

 After data is received and reviewed, it may be necessary to contact a provider for clarification or to 
address incomplete datasets. In the interest of building and maintaining relationships, care is given 
not to push the provider but to work with it to obtain accurate data in the best possible format. 
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DATA COLLECTION 

DATA TRANSFER PROCEDURES 

There are three primary ways data is collected from providers. These are: 

 Secure FTP (SFTP) using the WinSCP application; 

 Regular e-mail; 

 Mail. 
 

INITIAL DATA REVIEW AND QUALITY ASSURANCE 

The initial data review and quality assurance process consists of the following general steps: 
1) Access the data from the SFTP site or e-mail. 

a. If e-mailed, place copy of original dataset in the appropriate provider folder on the SFTP site. 
2) Place copy of raw data on local computer in a working directory. 
3) Review data and determine course of action based on type of data received. 
4) Ensure data is complete and contact provider to address any gaps. 

 

NOTE: 
The goal is to get as many providers as possible to provide subscriber address data in the correct format. 
Obviously, this will not be possible with all providers so we will continue to have to process various types of 
provider-supplied data. 

 

DATA INGESTION 

DATA INGESTION OVERVIEW 

The following subsections outline the process steps taken based on the type of input supplied by the data 

provider: 

 Point Data: 
o Subscriber location; 
o DSLAM location; 
o Central Office location; 
o Broadcast Tower location. 

 Linear Data: 
o TIGER® street segments. 

 Polygonal Data: 
o Census Blocks; 
o Coverage Area. 

Overall, the process is geared toward taking the provider data supplied and creating polygon shapes to 
append to the bb_cov feature class. The bb_cov feature class is the interim dataset that is then processed 
using the makeDeliverable.py Python script to create the MapConnect

TM
 data layers that will be delivered 

to the State and, ultimately, to the NTIA. Detailed instructions used in this process can be found in the 
subsections below. 
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POINT DATA 

SUBSCRIBER LOCATION—ADDRESS DATA 

In the event that the data provider supplies subscriber address data, the steps are as follows: 
1) First, convert the address data to a clean Excel spreadsheet in an appropriate address data 

format. 
a. Usually, this has the following columns: street address (number, pre-directional, pre-

modifier, street name, street type, post-directional and post-modifier concatenated), city, 
state, ZIP. 

2) Configure the ArcGIS® geocoding tool to use the TIGER® 2009 streets dataset. 
a. In ArcCatalog®, create a new Address Locater by right-clicking in the white space of the 

appropriate directory and selecting New>Address Locater from the dropdown menu. 
b. Select US Streets with Zone and click OK. 

 

NOTE: 
It is likely that multiple Address Locators will have to be set up to handle the variety of provider address data 
received. 
 

c. Navigate to the TIGER Streets 2009 file and click OK. 
d. Fill in the dialog box, as shown below: 
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e. Click OK. 
3) Open ArcMap® and add the Excel spreadsheet with the address information. 
4) Right-click on the Excel spreadsheet and select Geocode Addresses from the dropdown menu. 
5) Select the appropriate address locator by clicking Add…, then OK. 

 

6) Fill out the Geocode Addresses dialog box, as shown below: 

 

7) Geocode the list in batch mode using the geocode service set up in Step 2 above, accepting all 
the default parameters. 

8) Review results. See example below. 
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9) Adjust geocoding parameters accordingly and repeat batch to resolve issues. 
10) Manually geocode unmatched addresses until target hit rate achieved, generally 90%. 
11) Visually inspect the data, as shown below: 

 

12) Follow the steps detailed in Subscriber Location—GIS Data below. 
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SUBSCRIBER LOCATION—XY DATA 

If the provider supplies a list of subscriber data with accompanying XY data such as latitude and 
longitude, the steps are as follows: 

1) Refine the format in Excel so that the data can be opened easily using ArcMap®. 

a. Remove all font color, highlighting, cell colors and borders, clean up column headers and 
make certain there are no merged cells. 

b. Make certain that XY locations are in decimal degrees. 
(i.) To convert from degrees, minutes, seconds (39º 26’ 45.67”) to decimal degrees, use the 

following formula: DD + (MM/60) + (SS.SSS/3600). 
 

NOTE: 
If XY locations from some other coordinate system are provided, you can use those in the process below but you 
must know what the coordinate system is. 
 

2) Open the Excel worksheet in ArcMap®. 

3) From the menu bar, select Tools>Add XY Data… 

 

4) Supply the appropriate fields for the X and Y coordinates, choose the appropriate coordinate 
system and click OK. 

5) Results are an event layer, not a true spatial layer. Export the data by right-clicking the event 
layer and selecting Data>Export Data… from the dropdown menu. 

6) Follow the steps detailed in Subscriber Location—GIS Data below. 
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SUBSCRIBER LOCATION—GIS DATA 

If the provider supplies subscriber location in GIS format, the only process step is to load that data 
into the appropriate data schema and it will be ready for processing. 
1) First, load the data into the Point Address database schema (please see Appendix D for an 

example of the Point Address database schema.) using an empty feature class in that schema. 

2) In ArcCatalog®, right-click on the empty feature class and select Load from the dropdown menu. 

3) Navigate to the provider address GIS dataset and then map the attribute fields accordingly, as 
shown below: 

 

4) Once you have successfully loaded the provider address data into the temporary database with 
the correct schema, you now will append that data to the overall Point Address database. 

5) In ArcToolbox®, use the Append command (Data Management Tools>General> Append) to add 
the features into the overall Point Address database, as shown below: 
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6) Since the data is already in the Point Address database schema, there is no need to alter the Field 
Map in the Append tool. 

7) After appending, calculate metadata reflecting geometry source and representation values. 
8) Break provider-specific points into separate county feature classes and perform the following 

steps per county feature class: 
a. Within ArcGIS®: 

(i.) Summarize download and upload speeds [first,last] to determine all speeds available for 
county. 
(1) This will save as a DBF table. Keep track of location for future reference. 

(ii.) Buffer county address point featureclass to 150’. 
(1) During buffer command, dissolve on ad_down; ad_up; provider; dba; frn; tt; all 

metadata fields; stctyfips. Save as…. county_fastestdown_fastestup.  
(2) Example using Qwest data: boulder_40128_20128, where boulder=county; 

40128=ad_down; 20128=ad_up. 
 

NOTE: 
These attribute fields are specific to the Point Address database. 
 

(iii.) Select the features that represent the lowest speeds. 
b. Using XtoolsPro (http://www.xtoolspro.com/): 

(i.) In the XTools Pro toolbar, select XTools Pro>Layer Operations>Erase Features. 
(ii.) Use the same feature class for Input and Overlay. 
(iii.) Check Use selected features on the Input feature, as shown below. 
(iv.) Repeat and erase slowest speeds one speed at a time. Save each new feature class as 

the next slowest speed, using the same naming convention as shown in a.(ii.)(1) above. 
A general example is shown below: 
  

http://www.xtoolspro.com/
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c. Return to ArcGIS®: 
(i.) Edit/delete speeds from the attribution table of each feature class, so each remaining 

feature class has only one speed value. 
(ii.) Merge individual speed feature classes using the Merge command in ArcToolbox® (Data 

Management Tools>General>Merge). The dialog box is shown below:  

 

(iii.) Merge individual county feature classes using the Merge command in ArcToolbox (Data 
Management Tools>General>Merge). 

(iv.) Since the county files are all in the same schema, DO NOT alter the Field Map portion of 
the command interface. 
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(v.) When all the county files are merged into one dataset, use the Append command in 
ArcToolbox® (Data Management Tools>General>Append) to add the features to the 
bb_cov interim dataset. Use the Field Map portion of the Append tool to map the 
appropriate field values to their corresponding fields in the bb_cov feature class. 

DSLAM OR CENTRAL OFFICE LOCATION—ADDRESS DATA 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central 
Office address data, the steps are as follows: 
1) Follow the process for geocoding points in Subscriber Location—Address Data above. 
2) Follow the steps detailed in DSLAM or Central Office Location—GIS Data below. 

DSLAM OR CENTRAL OFFICE LOCATION—XY DATA 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central 
Office XY data, the steps are as follows: 
1) Follow the process for creating points from XY data in Subscriber Location—XY Data above. 
2) Follow the steps detailed in DSLAM or Central Office Location—GIS Data below. 

DSLAM OR CENTRAL OFFICE LOCATION—GIS DATA 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central 
Office GIS data, the steps are as follows: 
1) Buffer the DSLAM/Central Office points feature class. 

a. Add the point feature class to ArcMap®. 

b. Open the ArcToolbox® and go to Analysis Tools>Proximity>Buffer. 

c. Set the buffer distance to 5 miles. 
d. Set the dissolve type to ALL. 
e. Name the output feature class. 
f. Typical Buffer tool is shown below: 
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g. Click OK. 

2) Use the resulting buffer feature class to clip the TIGER® street layer: 

a. Add TIGER® street layer to ArcMap®. 

b. Open the ArcToolbox® and go to Analysis Tools>Extract>Clip. 

c. Complete the dialog box as shown below: 

 

d. Click OK. 

3) Using ArcCatalog® and within the file geodatabase: 

a. Right-click and create a new Feature Dataset.  
(i.) For the Feature Dataset settings: 

(1) Name the feature dataset accordingly. 
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(2) Select horizontal coordinate system by importing the coordinate system associated 

with the clipped TIGER® street layer by selecting Import and navigating to the 

location of that feature class. 
(3) No vertical coordinate system needed. 
(4) Leave all x,y,z,m values at default. 
(5) Click Finish. 

4) Import previously created street feature class into new Feature Dataset. 
5) Right-click Feature Dataset and create new Network Dataset—accept all default setting for the 

Network Dataset. 
 

NOTE: 
The Network Analyst extension must be turned on. 
 

6) In ArcMap® turn on the Network Analyst Toolbar by going to View>Toolbars>Network Analyst. 

7) Add the Network Dataset created in Step 5 to ArcMap. 
8) Using the Network Analyst Toolbar dropdown, create New Service Area. 

9) Open the Network Analyst Window by selecting the  button. See below. 

 

10) Right-click Facilities layer, select Load Locations and navigate to the DSLAM/Central Office 
facilities feature class. 
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11) Click OK. 

12) Click the Service Area Properties button . 
13)  For the following tabs, change the following properties: 

a. Polygon Generation tab:  
(i.) Select Merge by break value.  
(ii.) Also disable the Trim Polygons option. 

b. Analysis Settings tab—using and converting the specified DSLAM buffer distance from feet 
to meters—input buffer distance value in meters into the Default Breaks location. 
(i.) Generally, 18,000 feet (5486 meters) from DSLAM or Central Office location is used as 

the buffer distance. See below. 
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c. Click OK. 

14) On the Network Analyst Toolbar, click the Solve button  to create service area polygons. 
15) Right-click on the created service area polygon in the layer list, and select Data>Export Data from 

the dropdown list. 
16) Export to a feature class in the file geodatabase you created earlier. 

17) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the feature class created in Step 16 into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click the Add button, then click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 
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e. Click Next, then Next again, then Finish. 

18) In ArcToolbox®, go to Data Management Tools>General>Append. 

19) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 

 

20) Leave the Schema Type as TEST. 
21) Click OK. 

22) In ArcMap®, open bb_cov for editing and manually input associated attribution. 
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BROADCAST TOWER LOCATION—ADDRESS DATA 

In the event that the provider supplies wireless broadcast tower location address data, the steps are 
as follows: 
1) Follow the process for geocoding points in Subscriber Location—Address Data above. 
2) Follow the steps detailed in Broadcast Tower Location—GIS Data below. 

BROADCAST TOWER LOCATION—XY DATA 

In the event that the provider supplies wireless broadcast tower location XY data, the steps are as 
follows: 
1) Follow the process for creating points from XY data in Subscriber Location—XY Data above. 
2) Follow the steps detailed in Broadcast Tower Location—GIS Data below. 

BROADCAST TOWER LOCATION—GIS DATA 

In the event that the provider supplies wireless broadcast tower location GIS data, the steps are as 
follows: 
1) Download the required software (Radio Mobile) from the website: 

http://www.cplus.org/rmw/english1.html  
2) Install the software according to the standard directions, found here: 

http://www.cplus.org/rmw/download/download.php?S=1  
3) Open the application. 
4) Load the broadcast tower location and elevation information by selecting File>Unit properties. 

The following dialog box appears: 

 

5) Add the information for all the towers supplied by the WISP data provider, including the 
elevation. If provider does not supply elevation, this information can be obtained from Google 
Earth. 
a. If available, use the Import button to import a Google Earth KML of the tower locations. 

6) Go to the National Map Seamless Server (http://seamless.usgs.gov/) and download elevation 
data sufficient to contain the tower locations. 

http://www.cplus.org/rmw/english1.html
http://www.cplus.org/rmw/download/download.php?S=1
http://seamless.usgs.gov/
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a. At least the 1/3” NED data is needed. Select this by clicking the Download button in the 
upper right of the website and checking the box next to 1/3“ NED. 

b. Zoom to the area of interest and use the Download tools to define the area to download: 

 

c. Click the Modify Data Request button to request the data in BIL_16INT format, not ESRI 
GRID, as shown below: 

 

d. Download the data and unzip it. 
7) Select File>Map Properties to define the map. 
8) Enter a latitude and longitude in the center of the tower locations. 
9) Set the size (in pixels) and the size (in kilometers) of the map. 
10) Set the directory path leading to the BIL elevation data just downloaded. 
11) The dialog box is shown below: 
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12) Click Extract. 
13) The elevation data is rendered as a hill shade, as shown below: 

 
14) Select File>Network properties from the main menu. 
15) Create a new network and enter in the frequency range under the Parameters tab, as shown 

below: 
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16) Leave all the other values as they appear, and select the Systems tab. 
17) Create enough systems to cover all the varieties of equipment in the provider network. This will 

include the antenna type, height and line loss, as shown below: 
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18) Now click on the Membership tab, and assign the individual towers to their respective systems, 
providing the azimuth for non-omnidirectional antennas, as shown below: 

 
19) Click OK. 
20) Select Tools>Radio Coverage>Combined Cartesian from the main menu. 
21) Complete the dialog box as shown below, providing the Maximum Range from the highest tower 

beam radius supplied by the provider. 
22) Set the Pixel Size at 5 (experiment depending on the area covered to get the right level of 

granularity), as shown below: 

 
23) Set the Signal range to draw to S-Unit and type 5 in the From (>=) box. 
24) Click on Draw. See below. 
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25) Save the resulting image as a TIF by selecting File>Save Picture as. 
26) Open ArcMap® and load the BIL elevation data you used in Radio Mobile. 
27) Load the TIF image you created and georeference it using the corners of the BIL data. 

a. The corners of the data can be seen in the TIF image. 
28) Follow the georeferencing directions from the Coverage Area—PDF/JPG/Other Image Format 

section below. 
29) Use the Georeferencing Toolbar to Update the Georeferencing for the TIF dataset. 
30) In ArcToolbox®, select Data Transformations>From Raster>Raster to Polygon and input the 

georeferenced TIF you just created, as shown below: 
31) Open the resulting polygon feature class for editing using the Editing toolbar in ArcMap® and 

clean up as necessary. 
32) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the feature class created above into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click the Add button, then click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 
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e. Click Next, then Next again, then Finish. 

33) In ArcToolbox®, go to Data Management Tools>General>Append. 
34) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 

 
35) Leave the Schema Type as TEST. 
36) Click OK. 

37) In ArcMap®, open bb_cov for editing and manually input associated attribution. 
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LINEAR DATA 

TIGER® STREET SEGMENTS—LIST, SPREADSHEET OR GIS DATA 

In the event that the provider supplies TIGER® street segments in list or spreadsheet format, the 
steps are as follows: 
1) Join TIGER® road segments to 2000 census blocks feature class using one of two methods based 

on how the data is provided: 
a. If the TIGER® data is provided with a Census Block ID, then join the segments to the Census 

Block geometry based on that ID: 
(i.) Load both datasets into ArcMap®; 
(ii.) In the layer list, right-click on the 2000 census block feature class and select Joins and 

Relates>Join; 
(iii.) In the dialog box, select the TIGER® road segments data and the proper attribute fields 

for joining, as shown below: 

 
(iv.) Click OK. 

b. If the data provided is a list containing TLIDs, then join to the TIGER®/Line data using the 
TLID, and use a spatial join to associate the TIGER® segment with the coterminous block 
based on the block ID: 
(i.) Load both datasets into ArcMap®; 
(ii.) In the layer list, right-click on the 2000 census block feature class and select Joins and 

Relates>Join; 
(iii.) Select Join data from another layer based on spatial location from the dropdown 

menu; 
(iv.) Complete the dialog box, as shown below and click OK. 
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2) Export joined records into a temporary feature class. 
3) If joined Census Block geometry is confined to one specific area, then dissolve blocks into one 

record. If joined Census Block geometry is distributed throughout a particular State, then dissolve 
sub-selections of census blocks for each county. 
a. Use the County FIPS code to dissolve by county. 

b. In ArcToolbox®, select Data Management Tools>Generalization>Dissolve. 

c. Complete the Dissolve dialog box, as shown below: 
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d. Click OK. 

4) For each dissolved region, open the feature class for editing using the Editing tool in ArcMap® 

and remove unnecessary slivers and other small holes. For general guidance on editing features 

in ArcMap®, see http://webhelp.esri.com/arcgisdesktop/9.3/pdf/Editing_Tutorial.pdf  

5) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the feature class created above into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click on the Add button, then click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 
 

http://webhelp.esri.com/arcgisdesktop/9.3/pdf/Editing_Tutorial.pdf
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e. Click Next, then Next again, then Finish. 

6) In ArcToolbox®, go to Data Management Tools>General>Append. 
7) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 

 
8) Leave the Schema Type as TEST. 
9) Click OK. 
10) In ArcMap®, open bb_cov for editing and manually input associated attribution if necessary. 
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POLYGONAL DATA 

COVERAGE AREA—PDF/JPG/OTHER IMAGE FORMAT 

In the event that the provider supplies coverage area data in some image format such as PDF or JPG 
format, the steps are as follows: 
1) If in PDF format, open in Adobe Acrobat and Save As… JPG format. 

2) Open the JPG image in ArcMap®. 

3) Add the required base map vector data for georeferencing. 

a. This generally will be either the CDOT data or TIGER® data. 

4) Change the coordinate system of the data frame to the desired end coordinate system. 
5) Zoom to the general location of the JPG map image. 

a. This is the location based on the vector data, not the JPG image itself. For example, if you 
know that the JPG image represents an area around the town of Limon, zoom to the town of 
Limon in your vector data. 

6) Open the Georeferencing toolbar by selecting View>Toolbars>Georeferencing from the main 
menu bar. 

7) Using the Georeferencing toolbar, select Fit to Display; results are shown below: 

 

8) Use the Control Point button  to add control points to the map. 
9) Use common points in the base dataset and the JPG image. 

a. For example, find major street intersections, county/city boundaries, etc. 
b. Try to distribute the points more or less in the four corners on the image for the best 

transformation. 
10) Click on the location on the image first, then click on the corresponding location on the vector 

database map, as shown in the image below: 
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11) After placing each control point, the image transformation will update automatically.  
12) Repeat until satisfied with the transformation. 

 

NOTE: 
The transformation may take up to four points, although sometimes only two are necessary. 
 

13) When satisfied with the transformation, select Update Georeferencing from the Georeferencing 
toolbar dropdown. 
a. This will create a “world” file (.jgw in the case of JPGs) in the same directory as the image 

file. 

14) In ArcCatalog®, create a new polygon shapefile with the appropriate data schema for a provider 

coverage area, which can be found in Appendix D. 

15) Add the shapefile to ArcMap®. 

16) Using the Editor toolbar, select Start Editing. Set the Task to Create New Feature. 

17) Use the Sketch Tool  to digitize a new coverage polygon using the coverage area outline 
from the georeferenced JPG and add the required attributes manually. 

18) Repeat the above steps for all subscriber speed coverage areas provided. 
19) Follow the steps detailed in Coverage Area—GIS Data below. 

COVERAGE AREA—KML/KMZ 

In the event that the provider supplies coverage area data in Google Earth KML or KMZ format, the 
steps are as follows: 

1) Use a KML to SHP converter to translate file into an Esri® format. 

2) http://arcscripts.esri.com/details.asp?dbid=15603  

3) Download the script and follow the provided instructions for installing it in ArcToolbox®. 

4) Double-click on the script in ArcToolbox® and navigate to the location of the KML file, as shown 

below: 

http://arcscripts.esri.com/details.asp?dbid=15603
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5) Add the new shapefile to ArcMap®. Repeat for all KML files provided. 

6) Follow the steps detailed in Coverage Area—GIS Data below. 

COVERAGE AREA—CAD DATA 

In the event that the provider supplies coverage area data in GIS format, the steps are as follows: 

1) Transform the CAD dataset into an Esri® format. 

2) http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datase
ts 

3) It may be necessary to contact the provider first to determine the coordinate system of the CAD 
data. 

4) If the CAD data is not in a standard coordinate system, it may be necessary first to use ArcMap® 

to georeference the CAD data to a known coordinate system. 
a) To do so, follow the instructions provided above in Coverage Area—PDF/JPG/Other Image 

Format. 

5) In ArcCatalog®, create a new polygon shapefile with the appropriate data schema for a provider 

coverage area, which can be found in Appendix D. 

6) Add the shapefile to ArcMap®. 

7) Using the Editor Toolbar, select Start Editing. Set the Task to Create New Feature. 

8) Use the Sketch Tool  to digitize a new coverage polygon using the coverage area outline 
from the georeferenced CAD file and add the required attributes manually. 

9) Follow the steps detailed in Coverage Area—GIS Data below. 

COVERAGE AREA—GIS DATA 

In the event that the provider supplies coverage area data in GIS format, the steps are as follows: 

1) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the GIS feature class either created above or supplied by the provider into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click on the Add button, then click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 

 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datasets
http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datasets
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e. Click Next, then Next again, then Finish. 

2) In ArcToolbox®, go to Data Management Tools>General>Append. 

3) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 

 
4) Leave the Schema Type as TEST. 
5) Click OK. 

6) In ArcMap®, open bb_cov for editing and manually input associated attribution, if necessary. 

COMPACT POLYGON FROM SUBSCRIBER POINTS  

1) Geocode address list using latest State Composite Locator.  
2) Verify that your geocoded file has only one TT (Technology Type). If not, export individual 

geocoded layers for each Technology Type. 
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3) For each TT, check for differences in speed values or speed tiers and create separate layers for 
each speed value/tier. 

4) Clean your geocoding results: remove any points that geocode to accuracy levels below ZIP+4 
(ZIP centroids, carrier route centroids, etc). Also, verify that outliers with acceptable accuracy 
levels are legitimate, i.e., fall in correct city and Zip. 

5) Perform spatial join between county polygons (using stcnyfips field) and the cleaned geocoded 
subscriber points in order to carry the county name and stcnty fips. 

6) Summarize the number of subscribers by county and use the subscriber counts by county to 
populate the Rate Tier table. 

7) Un-join the county data from the geocode subscribers list. 
8) Create Compact Polygon using cleaned geocoded layer or sub-selection of XtoolsPro—

ConvexHull-DetailedHull option. A sub-selection of geocoded points will be used in areas where 
more than one polygon will need to be created for one provider’s service area. 

9) Evaluate output Hull carefully, looking for areas that should not be covered by hull polygon. 
a. If it is determined that an area or areas should not be represented in coverage area, 

manually reshape hull polygon until coverage area is adequate. 
b. When not obvious and as a general rule, manually resolve compact polygon when the 

distance between the subscriber points used to define the outer boundary of the compact 
polygon exceeds 5 miles . When reshaping the hull polygon, snap to the outermost 
geocoded points. See the three figures below for examples. 

      Compact Hull: Manual Resolution Required            
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Compact Hull: Manual Resolution Required                                        Compact Hull: After Manual Resolution        

                      
10) To attribute the compact polygon, perform a spatial join where your Target Feature Class is the 

compact polygon and the Join Feature Class is your geocoded point layer. Export compact hull 
with joined attributes and name file appropriately. 

11) Append attributed compact polygon to Broadband TT template Feature Class and, if required, 
manually input any provider attribution that may not have carried over in the append process. 

12) Intersect compact polygon with county boundaries to create unique records by county and use 
the state-county-fips field to populate stcty_fips field. Also use the county name field to populate 
the BBCov_Name field. 
a. Exception: where a provider’s coverage is distributed throughout more than one area of any 

given county where the BBcov_Name should be populated using an appropriate city or other 
logical name based on geographical location. 

13) Export/load into appropriate BB TT model dataset. 

CENSUS BLOCKS—LIST OR SPREADSHEET 

In the event that the provider supplies census block data in a list or spreadsheet, the steps are as 
follows: 
1) Ensure block polygons supplied by the provider are 2000 currency. 
2) If other currency, convert to 2000 currency before proceeding. 

a. To do this, remove the trailing letter (a, b, etc.) from the block ID. 
b. You will now have two blocks that equate to one block in the 2000 block geometry. 
c. Delete duplicate block IDs, retaining the higher service tier in each case. 

3) Prepare the block list in clean Excel format, removing all Excel-only formatting, merged cells, 
colors, borders, etc. 

4) Import the spreadsheet into ArcMap®. 

5) Right-click on the 2000 census block feature class in the layer list in ArcMap® and select Joins 

and Relates>Join from the dropdown menu. Join the census block list to the 2000 census blocks 
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feature class using the block ID and export joined records in a new feature class. The Join dialog 

box and process can be seen above in the TIGER® Street Segments—List, Spreadsheet or GIS 

Data subsection. 
6) Follow the steps in Census Blocks—GIS Data below. 

CENSUS BLOCKS—GIS DATA 

In the event that the provider supplies census block GIS data, the steps are as follows: 
1) Ensure that the blocks supplied by the provider are in the required data schema and are 

complete as far as required attribution. 
a. If not, manually enter the required attribution or contact the provider to fill gaps. 

2) If census block geometry is distributed throughout more than one county, then select Data 
Management Tools>Generalization>Dissolve in ArcToolbox® and dissolve based on 
County/Provider/TT/Speed Tier so that unique records are created for each unique combination. 
a. The Dissolve dialog box is shown above in the TIGER® Street Segments—List, Spreadsheet 

or GIS Data section. 
b. Two examples of undissolved census block polygons are shown below: 

 
Undissolved census block polygons 

 
Census block polygons dissolved by county 
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3) For each dissolved region use the Editing toolbar in ArcMap® to remove unnecessary slivers and 

other small holes. 

4) In ArcToolbox®, select Data Management Tools>General>Merge and merge the processed 

polygons into a single layer. 
5) The merged census blocks will need to have the subscriber’s frn field added and populated. 

6) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the GIS feature class either created above or supplied by the provider into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click the Add button, the click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 

 
e. Click Next, then Next again, then Finish. 

7) In ArcToolbox®, go to Data Management Tools>General>Append. 

8) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 
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9) Leave the Schema Type as TEST. 
10) Click OK. 

11) In ArcMap®, open bb_cov for editing and manually input associated attribution, if necessary. 

 

METADATA TRANSACTIONS 

Following any updates or changes completed within the file geodatabase (fGDB) stored on the GIS-Analysts 
staging environment, the GIS-Analyst runs transactions to compare that fGDB with the one stored on the Core 
server to ensure metadata on all changes is recorded. 

 
The steps taken to run transactions on the updated Core database are outlined below: 

1) Open a command line window and run generateTransactions.py:  
a. Usage: generateTransactions.py  [Core fGDB] [Staging Environment fGDB]  
b. Example of command line:  

<path>generateTransactions.py <path>ST_BB_POLY_SRV_AREAS.gdb <path>ST_BB_POLY_SRV_AREAS.gdb  
2) Shown below is an example of the output screen that will be displayed: 
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3) After the process has completed, results can be found in the ST_BB_POLY_SRV_AREAS_HIST.gdb:  

a. The transactions scripts records changes at a feature level. 
b. Shown below is a screenshot supporting the directory structure of the historical fGDB. 
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c. Attribution associated with each added/removed/changed feature is tracked, including the 
following additional columns appended to the end of each: 
(i.) Commit_by 

(1) Records the GIS-Analyst who committed the changes to the historical fGDB. 
(ii.) Commit_date 

(1) Records the date and time stamp on which the changes were committed. 
(iii.) Trans_type 

(1) This field reflects the type of change recorded; 
(2) Categorized by: Adds/Change/Deletes. 

(iv.) New_values 
(1) Records the new values when a change was completed on a feature. Example: 

Name or speed change. 
d. MD_Process also is transferred from the edited fGDB to the historical fGDB, which states the 

actions completed by the GIS-Analyst. 

 

 

DATA PROCESSING 

DATA PROCESSING OVERVIEW 

The following subsections detail the steps and layout required to process the service provider data further 
to meet NTIA requirements: 

 Weighted Nominal Speed; 

 Middle Mile; 
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 Broadband Coverage Template. 
 

WEIGHTED NOMINAL SPEED 

The weighted nominal speed is populated in one of the following two ways: subscriber data supplied by 
provider or value supplied by provider. 

SUBSCRIBER DATA SUPPLIED BY PROVIDER 

Where the data provider supplies subscriber speed information, the following formula from the NOFA 
is used: 

(speed tier-1 in kbps × no. of tier-1 subscribers) + (speed tier-2 in kbps × no. of tier-2 subscribers) + (etc.) 
Total average monthly subscribers 

 
Data is initially broken up in the following order: 
1) Stcty_fips; 
2) Transmission technology type; 
3) Subscriber tiers. 

VALUE SUPPLIED BY PROVIDER 

Some providers will supply their weighted nominal speed. In these cases, the data supplied will be 
populated instead of using the NOFA formula. These obtained or calculated values are used to update 
the service overview layer. 
 
This can be done manually or by creating a table with the provider’s FRN and average weighted speed 

and joining it to the service overview table in ArcMap®. 

1) To join, right-click on the layer to join to and select Joins and Relates>Join from the dropdown 
menu. 

2) Then navigate to the table to join to and select the join fields from the dropdown list. 

3) Then open the source table (the table in ArcMap®) and right-click on the header of the Average 

Weighted Speed field and select Calculate Field from the dropdown menu. 
4) Use the value of the average weighted speed from the joined table. 

 

MIDDLE MILE 

Middle mile information generally is provided in spreadsheet or text file format. The process is to take 
what is supplied by the provider and translate it into the required data schema. 

1) If the data is supplied with address information, follow the process outlined above in Subscriber 
Location—Address Data. 

2) If the data is supplied with associated XY coordinates, follow the process outlined above in 
Subscriber Location—XY Data. 

3) Once the data is in GIS format, use the Append (Data Management Tools>General>Append) 

command in ArcToolbox® to append the data to the overall middle mile dataset. 

4) Set the schema type to NO_TEST and use the Field Map to map the attribute fields from the 
source to the target dataset. 
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BROADBAND COVERAGE TEMPLATE 

The table below lists descriptions of the fields within the bb_cov layer, which is the interim dataset used 
to create the final product deliverable. 
 

NAME ALIAS DESCRIPTION 

objectid OBJECTID Internal Object ID 

shape SHAPE Internal Shape storage 

prov_id PROVIDER_ID Unique numeric identifier for each provider 

prov_name PROVIDER_NAME Unique name for each provider 

dba_name DOING_BUSINESS_AS An alternative "Doing-Business-As" name for the provider 

frn FCC_REGISTRATION_NUMBER Provider FCC Registration Number 

bbcov_name BBCOV_NAME BroadMap Broadband Coverage name 

trans_code TRANSMISSION_CODE Unique code for the transmission technology type described by 

this layer 

trans_name TRANSMISSION_NAME Name for the transmissions technology type 

trans_desc TRANSMISSION_DESC Description for the transmissions technology type 

spect_code SPECTRUM_CODE Unique code for the spectrum [WIRELESS ONLY] 

spect_name SPECTRUM_NAME Name for the spectrum [WIRELESS ONLY] 

spect_desc SPECTRUM_DESC Description for the spectrum [WIRELESS ONLY] 

mad_dwn_t MAX_AD_DOWN_TIER Maximum advertised downstream speed available within given 

area (speed tier) 

mad_up_t MAX_AD_UP_TIER Maximum advertised upstream speed available within given area 

(speed tier) 

typ_dwn_t TYPICAL_DOWN_TIER Typical downstream speed available within given area (speed tier) 

typ_up_t TYPICAL_UP_TIER Typical upstream speed available within given area (speed tier) 

mad_dwn_k MAX_AD_DOWN_KBPS Maximum advertised downstream speed available within given 

area (kbps) 

mad_up_k MAX_AD_UP_KBPS Maximum advertised upstream speed available within given area 

(kbps) 

typ_dwn_k TYPICAL_DOWN_KBPS Typical downstream speed available within given area (kbps) 

typ_up_k TYPICAL_UP_KBPS Typical upstream speed available within given area (kbps) 

subs SUBSCRIBERS Total average monthly subscribers for this provider for this 

technology for this coverage polygon 

md_geom MD_GEOMETRY Metadata: Comma separated list of source ids from which the 

polygon extent was produced 
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NAME ALIAS DESCRIPTION 

md_exists MD_EXISTS Metadata: Comma-separated list of source ids used in 

understanding and editing the provider data for this polygon 

md_who MD_WHO Metadata: Name of the editor who last edited this feature at the 

time in md_when 

md_when MD_WHEN Metadata: Date/time that this feature was last edited 

md_process MD_PROCESS Metadata: Comma-separated list of processes used to create 

and/or modify this layer 

stcty_fips STATE_COUNTY_FIPS State/County FIPS code 

rec_id RECORD_ID Compound Key formed from 

STCTY_FIPS+"|"+Provider_ID+"|"+Trans_Code+"|"+BBCov_Name 

st_area ST_AREA(SHAPE) Area in square decimal degrees  

st_length ST_LENGTH(SHAPE) Length in decimal degrees  

Provider_Type Type of Provider Has Subtype (1:Broadband provider as described in the 

NOFA,2:Reseller,3:Unknown), default value=1 (New 04/11 Model) 

 

VERIFICATION AND VALIDATION 

PROVIDER VALIDATION—PROVIDER PORTAL/PDF MAP REVIEW 

Following the collection and aggregation of provider data, the aggregated data is validated by the 
provider to ensure it is an accurate representation of their coverage area and supporting broadband 
information. 

 This validation is completed through the Provider Portal web application, which is a secure 
interactive map that displays the provider’s coverage areas and allows the provider to 
validate, submit feedback or request changes. 
o If changes are requested, then the features on the portal are updated and an automatic 

request is sent to the provider to complete the validation process. 

 Providers that did not use the Provider Portal are asked to validate a PDF map displaying 
their coverage area(s). This is accomplished via e-mail notification. 

PROVIDER VERIFICATION—THIRD PARTY SOURCE REVIEW 

After the provider has validated its coverage areas, a third-party source comparison and analysis is 
performed. 

 Where anomalies or discrepancies are identified, a “SCAN” point is dropped and descriptive 
comments are applied to be reviewed later with the provider. 

 During the provider review, the map is displayed along with the “SCAN” points and potential 
refinement is completed based on input from the provider. 

The table below shows third-party sources used: 

THIRD-PARTY SOURCE NAME SOURCE TYPE VERIFICATION TYPE 

InfoUSA Consumer and 
Business Listings 

Community Anchor Institutions; 
Can also be used for demographic information 
supporting the State websites. 

Pitney Bowes (PBBI) Exchange Info Plus Exchange datasets are used to verify the following 
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THIRD-PARTY SOURCE NAME SOURCE TYPE VERIFICATION TYPE 

(Central Office 
Locations) 

Transmission Technologies (TT): 
Asymmetric xDSL (10), Symmetric xDSL (20), Other 
Copper Wireline (30), and Optical Carrier/Fiber to the 
End User (50). 

Media Prints Cable Boundaries Used to verify the following TT: 
Cable Modem—DOCSIS 3.0 (40) and Cable Modem—
Other (41). 

American Roamer  Wireless Coverage 
Patterns (EVDO, 
GPRS, WISP, HSPA) 

Used to verify the following TT: 
Terrestrial Fixed Wireless—Unlicensed (70), Terrestrial 
Fixed Wireless—Licensed (71) and Terrestrial Mobile 
Wireless (80). 

ComSearch Wireless Spectrum 
Holdings and Tower 
Data 

Used to verify the following TT: 
Terrestrial Fixed Wireless—Unlicensed (70), Terrestrial 
Fixed Wireless—Licensed (71) and Terrestrial Mobile 
Wireless (80). 

ASSIGNING CONFIDENCE VALUES 
All findings and results from the abovementioned validation and verification activities, plus internal 
peer quality reviews, are captured and tracked in a Validation table (see example on the following 
page) and form the basis of the confidence value assigned for each provider and then each 
technology. 

CONFIDENCE VALUE DESCRIPTION 

    0 Coverage area has not been reviewed. 

  10 Extremely Low: 
Single Source QC.   

  20 Very Low: 
Needs additional validation\verification. 

  30 Low: 
Even with validation\verification, coverage still is suspect. 

  40 Acceptable: 
Confirm with State prior to shipment. 

  50 Meets requirements to be included in shipment. 

  60 Moderate: 
Meets NTIA/State’s standards, representative of Technology Type (TT). 

  70 High: 
Accurate representation of coverage based upon TT. 

  80 Very High: 
Multiple validation\verification with most third-party sources. 

  90 Extremely High: 
Multiple validation\verification sources. 

100 Perfect: 
Multiple validation\verification sources, with complete alignment with 
sources and ground truth verification activities. 

 

The Validation table is maintained as updates or changes occur for each provider, down to 
technology type, with the overall goal to improve the confidence values and overall map 
representation. An example of the Validation table is shown below: 
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COMMUNITY ANCHOR INSTITUTION (CAI) DATA 

DATA COLLECTION 

The CAI data was initially collected from the State to create the baseline inventory. All location 
information and broadband coverage data supplied also was ingested into the data deliverable. 
Additional collection of CAI information was done via data mining and/or webscraping to build out 
the inventory further. For example: Collection of additional CAIs and location information. 
 
The State-agency-provided CAI inventory was comprehensive but the challenge is collecting 
broadband related data: service provider(s), technology and speed data for each CAI. Availability of 
the CAI portal has not significantly increased submission of this data. Additional promotion to CAIs to 
use the CAI portal will be needed to increase this data for subsequent deliverables. 

INSTITUTION DATA 

Institution data is obtained from a variety of sources and almost always provided in Excel spreadsheet 
format. The general process for incorporating this data is as follows: 
1) If the data is provided in Excel or some similar format: 

a. Clean and standardize the Excel spreadsheet, removing any cell formats, merged cells, etc. 
b. Standardize the address format as defined in the staging CAI database. 
c. If the spreadsheet includes X and Y values, such as latitude and longitude, use the Add XY 

Data tool in ArcMap® to create a spatial data layer. 

d. If there are only addresses, then follow the geocoding steps outlined above to create spatial 
data points for each of the institutions. 

(i.) Institutions that do not geocode based on the TIGER® 2009 dataset will have to be 

located manually using Google Maps, Google Earth or some other information source. 
2) If the CAI source data is in GIS format, add the Latitude and Longitude fields and use the 

Calculate Geometry tool to populate them, using the WGS 84 coordinate system. 

3) Using ArcCatalog®, load the new data into the staging CAI database. 

4) This database is ready for the makeDeliverable.py script to process the information into the final 
State and NTIA deliverables. 
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COMMUNITY ANCHOR INSTITUTION (CAI) PORTAL UPDATES 

A web application has been released to allow for further data collection and validation of anchor 
institution location information, broadband coverage and speed test data. Information collected from 
the CAI Portal is then ingested into the overall inventory and will be compared later against the 
provider coverage areas mapped to locate any potential discrepancies. 

 

PRODUCT EXTRACT 

PYTHON SCRIPTS 

The following subsections make use of Python scripts. In general, to use a Python script you must have 
Python installed on your computer. To download the latest version of Python, go to 
http://www.python.org/download/ and download the latest stable version. As of August 2010, this was 
version 2.7. Once this is installed, the general way to run a script is to type the following at a command 
prompt: C:\Python27\python.exe C:\<location of script>. Many of the scripts provided have environment 
variables that must be set before they can be run. 
 
The Python code for BroadMap’s product extract has been incorporated into a Hudson CI System, which is 
detailed in the Process Operation and Monitoring section of this document. This was a process 
improvement activity so that all processes can be monitored, controlled and will contain historical 
tracking on each process. 

 

PRODUCT EXTRACT PROCESS 

NOTE: 
Specific Python scripts are called out in red font in the subsections below. 
 

The MapConnect
TM

 product extract process, makeDeliverable.py, uses the BB_Cov and 
BROADMAP_POINTS interim datasets to create the following layers according to the current 
specifications: 

 BB_Service_Road_Segment 
o This layer contains all broadband services associated with specific street segments for census 

2000 blocks larger in area than two square miles. 

 BB_ServiceCensusBlock 
o Contains all broadband services associated with census blocks of no greater than two square 

miles. 

 BB_Service_Wireless 
o This layer contains all wireless services not associated with specific addresses. 

 BB_ServiceOverview 
o This layer contains subscriber-weighted nominal speed for each provider's service area at a 

county level and is meant to act as a summarized view. 

 BB_ConnectionPoint_MiddleMile 
o This layer contains middle-mile and backbone interconnection points. 

 BB_Service_CAInstitutions 
o Broadband Service at Community Anchor Institutions (CAI). 

http://www.python.org/download/
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o Community Anchor Institutions consist of schools, libraries, medical and healthcare 
providers, public safety entities, community colleges and other institutions of higher 
education as well as other community support organizations and entities. 

Because of a NTIA model change for the October 2010 data deliverable, an addition to this code was 
created to support both models in case a comparison is later desired or a request is made to revert to the 
original model. This script name is bdia2ntia.py and creates the following layers in addition to the layers 
mentioned above, rolled up to NATL_Broadband_Map. 

 BB_ConnectionPoint_LastMile 
o This layer contains last mile infrastructure points, which is populated only if data cannot be 

provided at a more granular level. 

 BB_Service_Address 
o Represents broadband availability for service address points. Address Point availability refers 

to those individual addresses at which each facilities-based provider of broadband service 
can provide broadband services of minimal characteristics within 7-10 business days. 

 State_Boundary 
o State boundary supporting topological validation of point feature classes. 

 NATL_Broadband_Topology 
o Supports basic topology quality checking. Example: No CAIs or Middle Mile points outside of 

the State boundary. 
 
The following process flow provides a view of how the Core fGDB is extrapolated to the NTIA final 
deliverable via the makeDeliverable.py script. Following that, the bdia2ntia.py script is run, which limits 
what is placed in the final layers based on the NTIA modeling standards. 
 
The product scripts and supporting extract were originally created separately per request, in case data 
model comparisons were to be completed. 

 

PRODUCT STATISTICS 

Following the completion of a product extract, the product statistics script (BDIA_ReleaseNotesStats.py) 
extracts the following information supporting that product deliverable. 

 Provider Statistics: 
o Collects all provider information, listing by Provider Name. 
o Provides output of FRN. 
o Counts the number of features supported within the following layers: 

 Census Block; 
 Street Segment; 
 Max Upstream; 
 Wireless Services; 
 Infrastructure Points. 

o These updates were made to support the Data Package required to accompany every NTIA 
product deliverable. 

 Community Anchor Institution (CAI) Statistics: 
o Breaks down CAI to the eight categories: 

 1: School: K through 12; 
 2: Library; 
 3: Medical/Healthcare; 
 4: Public Safety; 
 5: University/College; 
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 6: Other Government; 
 7: Other Community non-government; 
 None: Unknown Category. In cases where this occurs, further investigation is completed 

prior to product shipment to ensure all CAIs are categorized accurately. 
o Reports out the following counts: 

 Total CAIs within that category; 
 Total CAIs that contain partial BB coverage. Contains any of the following information for a 

given CAI: BB Subscriber, Transmission Technology, Speed Down Speed Up; 
 Total CAIs that contain full BB coverage. Contains all of the abovementioned BB information 

for a given CAI. 
The output of this script is two CSV files: AnchorInstitutions.csv and Providers.csv. These files then can be 
inspected to ensure that there are the expected number of CAIs and providers for every release. 

 

QUALITY ASSURANCE 

Quality assurance is supported manually and algorithmically on the interim data, BB_Cov file geodatabase and 
on the final product. For scheduled product releases, a test product extract and subsequent manual and 
algorithmic QC run is completed along with a release review. The product specifications, project status reports 
and previous product release notes are used as references throughout this review. 
 
The following parameters are tested using the methodology listed below each: 

 Product Deliverable Format:  
o Correct names and format of data deliverables. 

 BDIA_QC_SUITES (please see below for details). 
o Correct Projections/Datum. 

 Manual interaction with product. 
o Metadata Present and Correct. 

 Manual interaction with product. 

 Table Structure: 
o All required tables included. 

 BDIA_QC_SUITES. 
o Extraneous tables identified. 

 BDIA_QC_SUITES. 

 Field Structure: 
o All fields included. 

 BDIA_QC_SUITES. 
o Extraneous fields identified. 

 BDIA_QC_SUITES. 
o Correct field names, types and widths. 

 BDIA_QC_SUITES. 

 Field Domains: 
o Values in all tables are constrained to the specified values specified: 

 This action is accomplished via BDIA_QC_SUITES and manual review of the product; 
 This tends to identify project completeness issues as fields with a null value are identified. 

 Geometric Representation: 
o Identify if all layers have the correct geometric representation: 

 Manual review of the BB_ServiceOverview layer; 
 Dependent on NTIA and client requirements. 
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 Geographic Extent: 
o Product includes the necessary Geography associated with Product? 

 Manual Review—ArcGIS®. 
o Is there extraneous geography included in Product? 

 Manual Review—ArcGIS®. 

 Completeness: 
o Products contain the expected amount of data? 

 Manual review of product statistics relative to weekly State reports and defined expectations. 

 Accuracy: 
o Product meets the stated accuracy requirements for the deliverable? 

 Sampling procedure to manually review source material to resulting product; 
 Provider Validation; 
 Verification using Third-Party Data; 
 Verification against reality, where applicable. 

 Data Regression: 
o Any unexplainable data loss or change? 

 This action is accomplished by comparing results within product statistics script 
(BDIA_ReleaseNotesStats.py) from previous releases, as well as manual review of the product. 

 Confidentiality: 
o Any unauthorized confidential information included in the delivery? 

 Review of NDAs and delivery expectations. 

 Prior Issues Resolved:  
o Have expected internal issues been resolved? 

 Manual review of data against previous product release notes. 
o Have agreed-upon customer issues been resolved? 

 Manual review of data against previous product release notes, status report and client feedback. 

 Delivery Medium: 
o Has the product medium been verified? 

 Manual review. 
o All files present. 

 Manual review of SFTP site to ensure all files are copied correctly, including file/directory size. 
o Correct location. 

 Manual review—confirmation of SFTP link, username and password. 
 

QC SUITE 

The BDIA_QC_SUITES consists of four main types of scripts supporting the overall QC process. These 
scripts are all run in concert and are called from the test_runner script and the test_BDIAProductGDB 
script. 

CONFIGURATION  

These scripts establish the configuration for the test_BDIAProductGDB script, which is the core of the 
QC Suite. 
update_test_config 
active_config 
config_PROCESS01_automated 
config_PROCESS01_manual 
set_active_config 
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LIBRARIES 

These scripts provide additional functionality that is called from with the test_BDIAProductGDB 
script. 
bb_unittest_fixture 
bbcov_structure 
BC_XmlWriter 
file_folder 
search_and_replace 
unittst_fixture 
validate_BB_DB 
validate_BB_GDB 
xmlrunner_gui 

QC SUITE 

This is the core script for performing automated QA/QC on the interim and final data deliverables. 
test_BDIAProductGDB 

OTHER  

These scripts perform other functions detailed below: 
test_runner—this is the main script that runs all the other QC scripts and imports all the necessary 
scripts and libraries. 
which_build—this determines the current build and passes information to the configuration scripts. 

 

PROCESS OPERATION AND MONITORING 

Product Extract, makeDeliverable.py and bdia2ntia.py, is run within BroadMap using a platform called Hudson 
that has been enhanced to support BDIA product extraction, process monitoring, as well as product validation. 
The same platform can be planned for implementation for the State, if desired. 
 
Below are examples of the product create, product validation, product statistics and monitoring processes 
that are managed within the BroadMap Hudson CI-System. All of the abovementioned Python scripts, with 
the exception of metadata transactions script, are run via this system. 

 

BDIA PRODUCT CREATE 

Below is an example of the main page where the type of product build can be selected. 
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Selecting based on the type of process that will be initiated is shown below: 

 

  
The Console Output can be reviewed to see the progress of product create. Following the completion of 
each product creation process, an e-mail notification is automatically sent to the team. 

 
All processes run via the BroadMap Hudson CI-System are stored for historical reporting. Each process can 
be reviewed, including the Console Output and Build Artifacts from that run. 
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PRODUCT VALIDATION AND STATISTICS 

Once the product creation process is complete, Product Validation and Statistics are then initiated. These 
support the BDIA_ReleaseNotesStats.py script and the BDIA_QC_SUITES scripts detailed above. 

 
All statistics and reports are stored for historical review with the capability to place violation criticality on 
each quality control check, allowing the identification of errors because of project status/completeness 
verses project correctness. Example: Typical Speeds populated. 

 

Below is an example of the report provided based on various control points running over a specified 
period: 

 
Similar to the Product Create process, all results from the process are maintained: 
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Results are then reviewed manually to ensure no errors reported are critical or in violation of the NTIA 
data model or project completion statements. Any errors of concern are communicated ahead of product 
delivery and included within the product release notes. Further detail on the Hudson-CI System 
environment can be found by navigating to the following link: 
http://wiki.hudson-ci.org/display/HUDSON/Meet+Hudson 

 
 

PRODUCT EXTRACT DATA DELIVERY 

Product delivery for MapConnect
TM

 Broadband is handled two ways, depending on client requirements: 
1) State Submittal: 

a. Data is submitted via SFTP site; 
b. Product Release Notes and QC Test Report accompany the delivery. 

2) NTIA Submittal: 
a. Directions for using the NTIA State Broadband Data file submission tool: 

(i.) Go to the following website: https://esupport.fcc.gov/statedata; 
(ii.) Enter your username and password as provided to you from the NTIA program 
administrator; 

 
(iii.) Click in Upload a file field; 
(iv.) Browse to local file for submission using the Browse button. Select file, then select 

ATTACH FILE. See example below. 

http://wiki.hudson-ci.org/display/HUDSON/Meet+Hudson
https://esupport.fcc.gov/statedata
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(v.) Logout/Receipt using the Logout button in the top right of the screen; 
(vi.) A receipt of submission is e-mailed to username e-mail address. 

 

 



 HAWAII WHITEPAPER Page 1 of 6 

 

Methodology Guidance  
The white paper should:  

1. Effectively describe the deliverable data;  
2. Effectively describe the data collection process;  
3. Effectively describe the verification process.  

 

1. Data Description Provide a general description / summary of data submission including file 
names and a brief description of each dataset.  
 
Contents of the data submission folder:  
 
1. Final Geodatabase (HI_SBDD_2011_10_01.gdb)  
 
Description: This data submission follows FCC/NTIA guidelines including Metadata for the project.  
The SBDD File Geodatabase contains the following layers:  

BB_Service_Address                                   12 Records  
BB_Service_Road_Segment         11,160 Records  
BB_Service_CensusBlock   19,720 Records  
BB_Service_CAInstitutions      1,173 Records  
BB_Service_Wireless            12 Records  
BB_Service_Overview              0 Records  
BB_ConnectionPoint_LastMile              1 Records  
BB_ConnectionPoint_MiddleMile        110 Records  

 
2. Submission Receipt (HI_2011_9_26.txt) 
 
Description: This is the submission receipt from the NTIA receipt tool.  
 
3. Data Package (HI_DataPackage_2011_10_01.xlsx)  
 
Description: This is the NTIA “datapackage.xls” spreadsheet that is used to document the data 
submission.  
 
4. Changes and Corrections (HI_2011_10_01_Changes_and_Corrections.pdf)  
 
Description: This is the NTIA “Changes and Corrections” document that is used to describe the changes 
and corrections to the data submission.  
 
5. Whitepaper (HI_WhitePaper_2011_10_01.pdf)  
 
Description: This is the methodology guidance document requested by NTIA to document the data 
submission. Page 1 of 6 (this document) 
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2. Provider Participation Provide a summary of provider cooperation (datapackage.xls).  
 
The project team has been collecting and processing broadband data from eleven (11) providers 
(Oceanic Time Warner Cable, Hawaiian Telcom Communications, Inc., Clearwire Corp., TW Telecom 
Holdings, Inc., Verizon Communications, Inc., Sprint Nextel, AT&T Inc., MOBI PCS, T-Mobile USA, Inc., 
Sandwich Isles Communications, Inc., and TrexBroadband, Inc. ). These eleven (11) providers account for 
the overwhelming majority of actual broadband subscribers in Hawaii. The project team has identified a 
12th provider as Pacific Light Net, Inc. dba/Wavecom Solutions, but the team has not yet received any 
data from Pacific Light Net, Inc.  
 
Hawaii Department of Commerce and Consumer Affairs (“DCCA”) has encountered challenges in fully 
executing NDAs with providers and subcontracts under the grant. This has affected the signing of certain 
NDAs with data providers as well as subcontracts dealing with data processing and delivery. 
Subsequently, throughout this term, DCCA has experienced some delays in obtaining necessary 
information. However, to-date DCCA has been able to process data representing the overwhelming 
majority of broadband providers in the State of Hawaii. – DCCA continues to overcome these challenges 
through cooperation between the parties and improving process expediency. Nine (9) of the twelve (12) 
Providers identified have executed confidentiality agreements for data sharing.  
 
Hawaiian Telcom Communications, Inc. and Oceanic Time Warner Cable: Last-mile and middle-mile 
facility capacity and more specifically backhaul from the facilities has been deemed proprietary. Further, 
providers maintain that they do not have information documented in a form that they would be able to 
easily provide. No information regarding this has been shared to-date by these providers. DCCA is 
working to compel these Providers to furnish more detailed information.  
 
Hawaiian Telcom Communications, Inc., Clearwire Corp., TW Telecom and MOBI PCS did not provide 
new data updates for the Fall 2011 data delivery. However, TW Telecom and MOBI PCS verified the 
existing coverage was accurate and there was no need for Fall 2011 data update. 
 
The project team continues to verify these coverage areas and broadband speed claims as well as to 
collect data from other providers as they are identified.  
 
The most recent iteration of updated and verified mapping data was submitted to NTIA on October 1, 
2011 in accordance with the latest FCC/NTIA broadband data model.  
 

3. Data Collection and Integration 
 
a. Primary Data Collection describes the data collection process and list any surveys 
distributed to retrieve data.  
Data was obtained by working with Providers (phone conference calls and email) to get the latest 
information at the most detailed level possible. The team furnished Providers with a data request 
including the latest table specifications via email that included the specific information needed for the 
project.  All other terrestrial broadband Providers maintained census block level detail. Wireless 
providers submitted RF propagation polygons illustrating coverage.  
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Broadband coverage data for Hawaiian Telcom Communications has been extrapolated as a three-mile 
buffer from each Central Office location. For every other provider, the DCCA has obtained census block 
level information and coverage footprints from the wireless providers. Since the data is being provided 
at the census block level or via a coverage footprint from wireless providers, exact levels of service 
provided within these boundaries in some cases has been limited to a single tier of service per census 
block or wireless footprint. TW Telecom has furnished customer addresses which have been geocoded 
and inserted into the FCC file geodatabase model as appropriate.  
 
No address level detail from any Providers has been submitted for this data submission. For wireless 
providers, the project team is requesting more detailed RF propagation maps, tower locations, and 
greater detail on wireless service coverage and technology. Further, the project team will be analyzing 
and adjusting existing census block data to fit within Tax Map Key (TMK) boundaries in an effort to 
increase the accuracy of the stated data coverage areas for use on the State’s broadband website and 
for planning purposes.  
 

b. Community Anchor Institutions Summarize Community Anchor Institutions by type, 
describe your data collection process, and list any surveys distributed to retrieve data.  
The baseline Community Anchor Institutions database has been amended, updated and verified. The 
Community Anchor Institutions database is composed of 1173 points that include:  
 

Schools – K through 12  (public and private)       367  
Libraries              56  
Medical/Healthcare           212  
Public Safety              95  
Universities, Colleges, other Post-Secondary  (public and private)      44  
Other Community Support – Nongovernmental (Hotels,Resorts)      399  
 

The data was collected from various State databases (i.e. Schools, Libraries, Public Safety), and from 
InfoUSA data downloads. Data was verified by personal telephone calls and information collected from 
websites. No surveys were distributed. The project team plans to include restaurant lounges, malls and 
coffee shops with advertised free Wi-Fi in the next deliverable, as well as, continue with telephone 
verification to obtain more information from CAI’s.  
 
For this data submission we collected additional information (speed and provider information) from 
each CAI. However, individual Public Schools were not able to verify who their provider is or speeds, we 
were able to obtain this information from the Department of Education.  Thus far, all CAI’s contacted 
have been very cooperative in providing information.   
 

 
4. Validation  
 

a. Overview Provide a general summary of the validation process and methodology 
used.  
See below. 
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b. Business Logic Rules Define the business logic related to data validation including a 
clear structure or methodology used. 
Data Excluded by Business Rules (Organized by layer) 

Broadband_Service_CensusBlock - Total Excluded: 15,586 Census Blocks 
 Excluded by Business Rule 

 The block must contain population 
 8,362 Census Blocks – Hawaiian Telecom 
 5,823 Census Blocks – Time Warner Cable 
 414 Census Blocks – TW Telecom 
 984 Census Blocks  – Sandwich Isles Communications 

 Combination business rule for transmission technology speed 
combinations 
 3 Census Blocks – TW Telecom 

   
Broadband_Service_RoadSegment - Total Excluded: 823 Segments 

 Excluded by Business Rule 
o The block must contain population 

 734 Segments – Hawaiian Telecom 
 47 Segments – Sandwich Isles Communications 
 42 Segments – Time Warner Cable 

 

c. Feedback Loop Describe any outreach to Broadband Providers after you processed 
their data. 
Working with Providers on an ongoing basis to rectify data including the provision of coverage 
maps. 
 

d. Statistical Models List and describe any statistical models used to compile and analyze 
the data.  
None used to date. 
 

e.  3rd Party Publicly Available Data identify all 3rd party datasets used and describe how 
they were used to validate the data. (3rd party datasets include American Roamer, 
Form 477, Form 325, etc. 
Info USA used for address validation of CAI’s. 

Used updated Hawaiian Homelands boundaries. 

f. Crowd Sourced Data Identify whether or not crowd sourced data was used and how 
the data was used for validation.  
Hawaii broadband website Ookla tools and FCC Ookla/MLabs speed test results are being 
collected on a monthly basis. 
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The project team is implementing the following verification activities:  
 
• Coverage Verification via Website: DCCA launched a dedicated website (hibroadbandmap.org) that 
contains the latest information on the project as well as a speed and line test application and database 
for consumers to use. Additionally, consumers are able to report unserved areas on the website. – 
December 1, 2010.  
 
• CAI Verification by Telephone: DCCA will independently verify access to broadband services by 
Community Anchor Institutions ("CAI") where no data currently exists via personal contact by telephone. 
– October 1, 2011.  
 
• CAI Verification by External Data Source Comparison: The project team will be collecting data from 
InfoUSA to verify the completeness of the CAI inventory. – October 1, 2011.  
 
• Provider Verification via Map Products: DCCA will present the data to the individual providers in the 
form of a map product, ask them to verify the results visually, and, if necessary, ask them to provide 
more accurate information if available. – October 1, 2011.  
 
• Speed Test Verification via Website: DCCA will announce the speed and line test application and 
website for consumers via press releases and newspaper articles to encourage subscriber participation. 
The database will be maintained throughout the course of the project. –  by December 1, 2011.  
 
• Speed Test Verification via FCC Ookla/MLabs: FCC databases are being collected on a monthly basis 
and integrated into a coverage verification layer that will also appear on the website.  – October 1, 2011.  

 
• Provider Verification via Website: Providers will also be able to access the maps of their data through a 
secure portal on the website. – Ongoing  
 
 
The project team’s status on implementing the following verification activities:  
 
• Coverage Verification via Website: The dedicated website (hibroadbandmap.org) was launched on 
December 1, 2010 and includes a customized Ookla speed test application and database for consumers 
to use, as well as, ESRI's BBStat application. – In Progress.  
 
• CAI Verification by Telephone: DCCA has and will continue to verify Community Anchor Institution data 
via telephone. – In Progress.  
 
• CAI Verification by External Data Source Comparison: InfoUSA data is being downloaded to augment 
and verify the completeness of the CAI inventory. – In Progress.  
 
• Provider Verification via Map Products: Maps that illustrate coverage gaps are being prepared for 
provider review. – In Progress.  
 
• Speed Test Verification via Website: The dedicated website (hibroadbandmap.org) launched on 
December 1, 2010 includes a customized Ookla speed test application and database for consumers to 
use, as well as, ESRI's BBStat application.– In Progress.  
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• Speed Test Verification via FCC Ookla/MLabs: FCC speed test data is also being integrated into an 
independent map layer. – In Progress.  
 

• Provider Verification via Website: Providers will also be able to access the maps of their data through a 
secure portal on the website. – In Progress.  
 

Note: These verification activities and direct updates from providers are anticipated to continue through 

the next data delivery date. 

In addition, the project team is participating in a program sponsored by Akaku: Maui Community 

Television on Broadband.  Our website Hibroadbandmap.org will be listed on their site and they will be 

requiring all students to perform daily speed tests using our Site to test as well as theirs.  The team will 

be talking about broadband, the national and state programs and the importance of speed test 

accuracy.  This will be starting in November 2011. 
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Complete 344
Non-Responsive/Refused 9
In Progress 5

Count of Datasets by Status 358
Total Unique Providers Represented 204

Provider Name Platform Status

NDA 
Execution 

Date Notes

Alliance Communications Cooperative, Inc. Fiber Data Added to Statewide Inventory 1/28/2010
[SEPT-15-11 Matthew Brunt] Change:  Provider 
expanded fiber service area.

Alpine Communications, LC DSL Data Added to Statewide Inventory 2/24/2010

[SEPT-15-11 Matthew Brunt] Change: Provider 
upgraded infrastructure and can now provide 
speed tier 7 download speeds.

AT&T Inc. Mobile Wireless Data Added to Statewide Inventory 12/16/2009

[AUG-26-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Atkins Telephone Company Fiber Data Added to Statewide Inventory 5/14/2010

[SEPT-15-11 Matthew Brunt] Change: Provider 
upgraded infrastructure and can now offer 
speed tier 8 download speeds.

Aventure Communications Fixed Wireless Data Added to Statewide Inventory 4/8/2010
[SEPT-15-11 Matthew Brunt] Change: Provider 
expanded fixed wireless service area.

Baldwin Nashville Telephone Company, Inc. Fiber Data Added to Statewide Inventory 2/3/2010

[SEPT-15-11 Matthew Brunt] Change: Provider 
upgraded infrastructure and can now provide 
fiber broadband to parts of their service area.

Bernard Telephone Company, Inc. Fiber Data Added to Statewide Inventory 5/19/2010

[SEPT-15-11 Matthew Brunt] Change: Provider 
updated infrastructure and can now provide fiber 
broadband to their entire service area.

Bernard Telephone Company, Inc. Fixed Wireless Data Added to Statewide Inventory 5/19/2010

[SEPT-15-11 Matthew Brunt] Change: Provider 
expanded a portion of their fixed wireless 
coverage area.

Cable ONE Inc. Cable Data Added to Statewide Inventory 12/7/2009

[AUG-26-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Cedar Falls Utilities Fiber Data Added to Statewide Inventory 6/16/2010
[SEPT-15-11 Matthew Brunt] Change: Provider 
expanded fiber service area.

CenturyLink DSL Data Added to Statewide Inventory 12/4/2009

[AUG-26-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Chat Mobility Mobile Wireless Data Added to Statewide Inventory 1/19/2010

[AUG-26-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Colo Telephone Company Fiber Data Added to Statewide Inventory 1/28/2010

[SEPT-15-11 Matthew Brunt] Change: Provider 
upgraded infrastructure and can now offer 
speed tier 7 download speeds.

Communications 1 Network, Inc. Fiber Data Added to Statewide Inventory 4/14/2010

[SEPT-15-11 Matthew Brunt] Change: Provider 
upgraded infrastructure and can now offer 
speed tier 10 download speeds.

Corn Belt Telephone Company Fiber Data Added to Statewide Inventory 2/15/2010
[SEPT-15-11 Matthew Brunt] Change: Provider 
expanded their fiber service area.

CoxCom Inc. Cable Data Added to Statewide Inventory 1/29/2010

[AUG-26-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

East Buchanan Telephone Cooperative Fixed Wireless Data Added to Statewide Inventory 4/30/2010

[AUG-26-11 Matthew Brunt] Correction: Provider 
submitted initial data for October 2011 
submission.

Farmers & Merchants Mutual Telephone Company Fixed Wireless Data Added to Statewide Inventory 5/7/2010
[SEPT-15-11 Matthew Brunt] Change: Provider 
has two new fixed wireless towers in operation.

Farmers Cooperative Telephone Company-Dysart DSL Data Added to Statewide Inventory 3/12/2010
[SEPT-15-11 Matthew Brunt] Change: Provider 
expanded their DSL service area.

Frontier Communications Corporation DSL Data Added to Statewide Inventory 1/22/2010
[AUG-26-11 Matthew Brunt] Change: Provider 
expanded coverage area.

Grand Mound Cooperative Telephone Association Fiber Data Added to Statewide Inventory
[SEPT-15-11 Matthew Brunt] Change: Provider 
expanded their fiber service area.

Grand River Mutual Telephone Corporation DSL Data Added to Statewide Inventory 2/5/2010
[SEPT-15-11 Matthew Brunt] Change: Provider 
expanded their DSL service area.

HickoryTech Corporation DSL Data Added to Statewide Inventory 2/2/2010

[SEPT-15-11 Matthew Brunt] Correction: 
Provider had indicated speed tier 6 in a small 
portion of their service area, but this has been 
changed to a tier 4 download speed across their 
entire service area.

Kalnet Fixed Wireless Data Added to Statewide Inventory 5/21/2010

[AUG-26-11 Matthew Brunt] Correction: Provider 
reduced speeds to more accurately represent 
their infrastructure.

Knology of the Plains, Inc. Cable Data Added to Statewide Inventory 7/13/2011

[SEPT-15-11 Matthew Brunt] Correction: 
Provider submitted initial data for the October 
2011 submission.

Leap Wireless International, Inc. Mobile Wireless Data Added to Statewide Inventory 4/6/2010

[AUG-26-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Loganet Fixed Wireless Data Added to Statewide Inventory
[SEPT-15-11 Matthew Brunt] Change: New fixed 
wireless tower in operation.

Lone Rock Cooperative Telephone Company DSL Data Added to Statewide Inventory 2/15/2010

[SEPT-15-11 Matthew Brunt] Change: Provider 
upgraded speeds but they fell within the same 
speed tier, so provider still offers speed tier 5 
download speeds.

Broadband Provider Log



MidIowa Net Fixed Wireless Data Added to Statewide Inventory

[SEPT-15-11 Matthew Brunt] Change: Provider 
sent frequency change, but it fell within the 
previously submitted frequency range that was 
included in the April 2011 submission. 

Miles Cooperative Telephone Association DSL Data Added to Statewide Inventory 5/17/2010

[SEPT-15-11 Matthew Brunt] Change: Provider 
upgraded infrastructure and can now offer 
speed tier 5 download speeds.

NetConX, Inc. Fixed Wireless Data Added to Statewide Inventory 4/6/2010
[AUG-30-11 Matthew Brunt] Change: New 
wireless tower in operation.

New Ulm Telecom, Inc. DSL Data Added to Statewide Inventory 3/10/2010

[SEPT-15-11 Matthew Brunt] Change: Provider 
upgraded infrastructure and can now offer 
speed tier 5 download speeds.

North English Cooperative Telephone Company DSL Data Added to Statewide Inventory 5/12/2010

[SEPT-15-11 Matthew Brunt] Change: Provider 
upgraded infrastructure and can now offer 
speed tier 4 download speeds.

Panora Communications Cooperative Fiber Data Added to Statewide Inventory 1/29/2010

[SEPT-15-11 Matthew Brunt] Change: Provider 
expanded their fiber service area while also 
upgrading their infrastructure, and can now offer 
speed tier 7 download speeds.

Partner Communications Cooperative Fiber Data Added to Statewide Inventory 5/15/2010

[SEPT-15-11 Matthew Brunt] Change: Provider 
upgraded infrastructure and can now provide 
fiber broadband to portions of their service area.

Prairieburg Telephone Company, Inc. DSL Data Added to Statewide Inventory 3/25/2010

[SEPT-15-11 Matthew Brunt] Correction: 
Provider previously submitted a technology of 
transmission code 20, but it was corrected to a 
technology of transmission code 10 for the 
October 2011 submission.

Preston Telephone Company DSL Data Added to Statewide Inventory 2/5/2010

[SEPT-15-11 Matthew Brunt] Change: Provider 
upgraded infrastructure and can now offer 
speed tier 6 download speeds.

SpeedNet, LLC Fixed Wireless Data Added to Statewide Inventory
[SEPT-15-11 Matthew Brunt] Change: Four new 
fixed wireless towers in operation.

Sprint Nextel Corporation Mobile Wireless Data Added to Statewide Inventory 1/14/2010

[AUG-26-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

T-Mobile USA, Inc. Mobile Wireless Data Added to Statewide Inventory 1/8/2010

[AUG-26-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

United States Cellular Corporation Mobile Wireless Data Added to Statewide Inventory 2/15/2011

[AUG-26-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Verizon Communications, Inc. Mobile Wireless Data Added to Statewide Inventory 12/14/2009

[AUG-26-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Walnut Telephone Company DSL Data Added to Statewide Inventory 4/14/2010

[SEPT-15-11 Matthew Brunt] Correction: To 
more accurately represent the provider's DSL 
service area, the service area was reduced in 
certain location.

Walnut Telephone Company Cable Data Added to Statewide Inventory 4/14/2010

[SEPT-15-11 Matthew Brunt] Correction: To 
more accurately represent the provider's cable 
service area, the service area was expanded in 
certain location.

Walnut Telephone Company Fiber Data Added to Statewide Inventory 4/14/2010

[SEPT-15-11 Matthew Brunt] Correction: To 
more accurately represent the provider's fiber 
service area, the service area was expanded in 
certain location.

West Liberty Telephone Company Fixed Wireless Data Added to Statewide Inventory 1/25/2010
[SEPT-15-11 Matthew Brunt] Change: New 
wireless tower in operation.

West Liberty Telephone Company DSL Data Added to Statewide Inventory 1/25/2010

[SEPT-15-11 Matthew Brunt] Change: Provider 
upgraded speeds but they fell within the same 
speed tier, so provider still offers speed tier 5 
download speeds.

Windstream Communications DSL Data Added to Statewide Inventory

[SEPT-15-11 Matthew Brunt] Change: 
Windstream Iowa Communications acquired 
Iowa Telecom.

Ace Telephone Association Backhaul Backhaul Provider Only Processing Complete 3/8/2010

Aventure Communications Backhaul Backhaul Provider Only Processing Complete 4/8/2010

Level 3 Communications, LLC Backhaul Backhaul Provider Only Processing Complete 12/14/2009

Mediacom Iowa, LLC Backhaul Backhaul Provider Only Processing Complete 1/12/2010

Northeast Iowa Telephone Company Backhaul Backhaul Provider Only Processing Complete 4/13/2010

Sprint Nextel Corporation Backhaul Backhaul Provider Only Processing Complete 1/14/2010

Internet Solver, Inc. DSL
Estimated Coverage Submitted for Non-
Participating Provider

[AUG-22-11 Jill Lindgren] Received e-mail 
stating, "The owner of our company is not 
interested."
[AUG-24-11 Matthew Brunt]  Correction: 
Coverage not submitted in previous datasets; 
coverage created from data found on provider 
website.

360networks Backhaul No Update to Provide 1/19/2010
Ace Telephone Association DSL No Update to Provide 3/8/2010
Algona Municipal Utilities Cable No Update to Provide 2/9/2010
Algona Municipal Utilities Fiber No Update to Provide 2/9/2010
Alliance Communications Cooperative, Inc. DSL No Update to Provide 1/28/2010
Alliance Communications Cooperative, Inc. Backhaul No Update to Provide 1/28/2010
Alpine Communications, LC Fiber No Update to Provide 2/24/2010
Alta Municipal Utilities Cable No Update to Provide 5/18/2010
Andrew Telephone Company DSL No Update to Provide 1/19/2010
Arcadia Telephone Cooperative DSL No Update to Provide 5/6/2010
AT&T Inc. Backhaul No Update to Provide 12/16/2009
Atkins Telephone Company DSL No Update to Provide 5/14/2010
Ayrshire Farmers Mutual Telephone Company DSL No Update to Provide 2/17/2010
Ayrshire Farmers Mutual Telephone Company Fixed Wireless No Update to Provide 2/17/2010
Baldwin Nashville Telephone Company, Inc. DSL No Update to Provide 2/3/2010



Bellevue Municipal Utilities Fiber No Update to Provide 5/20/2010
Bernard Telephone Company, Inc. DSL No Update to Provide 5/19/2010
Bernard Telephone Company, Inc. Backhaul No Update to Provide 5/19/2010
BEVCOMM DSL No Update to Provide 6/16/2010
BitWind Communications, LLC Fixed Wireless No Update to Provide
Board of Water Electric & Communication Trustees of the City of 
Muscatine DSL No Update to Provide 5/14/2010
Board of Water Electric & Communication Trustees of the City of 
Muscatine Cable No Update to Provide 5/14/2010
Board of Water Electric & Communication Trustees of the City of 
Muscatine Fiber No Update to Provide 5/14/2010
Brooklyn Mutual Telecommunications Cooperative DSL No Update to Provide 4/21/2010
Butler-Bremer Communications DSL No Update to Provide 4/20/2010
Butler-Bremer Communications Fiber No Update to Provide 4/20/2010
Butler-Bremer Communications Cable No Update to Provide 4/20/2010
Cascade Communications Company DSL No Update to Provide 1/23/2010
Cascade Communications Company Fiber No Update to Provide 1/23/2010
Casey Mutual Telephone Company DSL No Update to Provide 5/3/2010
Casey Mutual Telephone Company Backhaul No Update to Provide 5/3/2010
Cedar Falls Utilities Cable No Update to Provide 6/16/2010
Center Junction Telephone Company DSL No Update to Provide 3/12/2010
Central Scott Telephone Company, Inc. Fixed Wireless No Update to Provide 4/22/2010
Central Scott Telephone Company, Inc. DSL No Update to Provide 4/22/2010
CenturyLink Backhaul No Update to Provide 12/4/2009
Circle Computer Resources Fixed Wireless No Update to Provide 7/6/2010
Citizens Mutual Telephone Cooperative DSL No Update to Provide 2/26/2010
Citizens Mutual Telephone Cooperative Fiber No Update to Provide 2/26/2010
City of Hawarden Cable No Update to Provide 5/20/2010
Clarence Telephone Company, Inc. Fiber No Update to Provide
Clear Lake Independent Telephone Company DSL No Update to Provide 5/6/2020
Clear Lake Independent Telephone Company Fiber No Update to Provide 5/6/2020
CML Telephone Cooperative, Association of Meriden, Iowa Fiber No Update to Provide 1/25/2010
Comelec Services, Inc. Fixed Wireless No Update to Provide 5/7/2010
Community Cable Television Agency of O'Brien County Cable No Update to Provide 5/5/2010
Community Cable Television Agency of O'Brien County Fixed Wireless No Update to Provide 5/5/2010
Community Digital Wireless, LLC Fixed Wireless No Update to Provide 5/6/2010
Complete Communication Services Cable No Update to Provide 6/17/2010
Complete Communication Services Fiber No Update to Provide 6/17/2010
Coon Rapids Municipal Utilities Cable No Update to Provide 4/22/2010
Coon Valley Co-op Telephone Association, Inc. DSL No Update to Provide
Coon Valley Co-op Telephone Association, Inc. Fixed Wireless No Update to Provide
Cooperative Telephone Company DSL No Update to Provide 2/2/2010
Cooperative Telephone Company Fixed Wireless No Update to Provide 2/2/2010
Cooperative Telephone Exchange Backhaul No Update to Provide 2/2/2010
Cooperative Telephone Exchange Fiber No Update to Provide 2/2/2010
Corn Belt Telephone Company DSL No Update to Provide 2/15/2010
Corn Belt Telephone Company Fixed Wireless No Update to Provide 2/15/2010
Cumberland Telephone Company DSL No Update to Provide 4/27/2010
Cumberland Telephone Company Fixed Wireless No Update to Provide 4/27/2010
Danville Mutual Telephone Company DSL No Update to Provide

DISH Network Corporation Satellite No Update to Provide 1/27/2010

[SEPT-16-11 Matthew Brunt] Correction: 
Satellite data is being submitted and was not 
included in the April 2011 submission. While 
coverage is currently the entire state boundary, 
work continues on having more granular data 
available.

Dixon Telephone Company Cable No Update to Provide 5/5/2010
Dumont Telephone Company DSL No Update to Provide 2/25/2010
Dumont Telephone Company Fiber No Update to Provide 2/25/2010
Dunkerton Telephone Cooperative DSL No Update to Provide 4/15/2010
East Buchanan Telephone Cooperative DSL No Update to Provide 4/30/2010
Eastlight, LLC Fixed Wireless No Update to Provide
Ellsworth Cooperative Telephone Association DSL No Update to Provide 1/25/2010
Evertek Enterprises Cable No Update to Provide 2/3/2010
Evertek Enterprises Fiber No Update to Provide 2/3/2010
Evertek Enterprises Fixed Wireless No Update to Provide 2/3/2010
F&B Communications, Inc. DSL No Update to Provide 2/19/2010
F&B Communications, Inc. Fixed Wireless No Update to Provide 2/19/2010
Farmers & Merchants Mutual Telephone Company Fiber No Update to Provide 5/7/2010
Farmers Mutual Cooperative Telephone Company - Harlan DSL No Update to Provide 2/5/2010
Farmers Mutual Cooperative Telephone Company - Harlan Cable No Update to Provide 2/5/2010
Farmers Mutual Cooperative Telephone Company - Harlan Fiber No Update to Provide 2/5/2010
Farmers Mutual Cooperative Telephone Company - Harlan Fixed Wireless No Update to Provide 2/5/2010
Farmers Mutual Cooperative Telephone Company-Moulton Fiber No Update to Provide 5/21/2010
Farmers Mutual Telephone Company - Jesup DSL No Update to Provide 4/20/2010
Farmers Mutual Telephone Company - Nora Springs DSL No Update to Provide 1/26/2010
Farmers Mutual Telephone Company - Nora Springs Cable No Update to Provide 1/26/2010
Farmers Mutual Telephone Company - Nora Springs Fiber No Update to Provide 1/26/2010
Farmers Mutual Telephone Company - Nora Springs Fixed Wireless No Update to Provide 1/26/2010
Farmers Mutual Telephone Company of Stanton, Iowa DSL No Update to Provide 4/9/2010
Farmers Mutual Telephone Company of Stanton, Iowa Cable No Update to Provide 4/9/2010
Farmers Mutual Telephone Company of Stanton, Iowa Backhaul No Update to Provide 4/9/2010
Farmers Mutual Telephone Company of Stanton, Iowa DSL No Update to Provide 4/9/2010
Farmers Telephone Company-Essex DSL No Update to Provide 1/27/2010
Farmers Telephone Company-Essex Fixed Wireless No Update to Provide 1/27/2010
FiberComm L.C. DSL No Update to Provide 2/15/2010
FiberComm L.C. Fixed Wireless No Update to Provide 2/15/2010
FiberComm L.C. Backhaul No Update to Provide 2/15/2010
Fibernet Communications, LLC Backhaul No Update to Provide 3/9/2010
Frontier Communications Corporation Backhaul No Update to Provide 1/22/2010
Goldfield Access Network, L.C. DSL No Update to Provide 1/22/2010
Goldfield Access Network, L.C. DSL No Update to Provide 1/22/2010
Grand Mound Cooperative Telephone Association DSL No Update to Provide
Grand Mound Cooperative Telephone Association Fixed Wireless No Update to Provide
Grand River Mutual Telephone Corporation Fixed Wireless No Update to Provide 2/5/2010
Grand River Mutual Telephone Corporation DSL No Update to Provide 2/5/2010
Griswold Cooperative Telephone Company DSL No Update to Provide 4/21/2010
Grundy Center Municipal Utilities Cable No Update to Provide
Grundy Center Municipal Utilities Fixed Wireless No Update to Provide
Harlan Municipal Utilities Cable No Update to Provide 5/5/2010
Harmony Telephone Company Fiber No Update to Provide 1/12/2010
Hawkeye Telephone Company DSL No Update to Provide 2/12/2010
Heart of Iowa Communications Cooperative DSL No Update to Provide 1/7/2010
Heart of Iowa Communications Cooperative Fiber No Update to Provide 1/7/2010
Heart of Iowa Communications Cooperative Backhaul No Update to Provide 1/7/2010



Hospers Telephone Exchange, Inc. DSL No Update to Provide 1/11/2010
Hospers Telephone Exchange, Inc. Cable No Update to Provide 1/11/2010
Hubbard Cooperative Telephone Association and Cable DSL No Update to Provide 5/14/2010

Hughes Network Systems, LLC Satellite No Update to Provide 2/5/2010

[SEPT-16-11 Matthew Brunt] Correction: 
Satellite data is being submitted and was not 
included in the April 2011 submission. While 
coverage is currently the entire state boundary, 
work continues on having more granular data 
available.

Huxley Communications Cooperative Backhaul No Update to Provide 1/25/2010
Huxley Communications Cooperative DSL No Update to Provide 1/25/2010
Huxley Communications Cooperative Fiber No Update to Provide 1/25/2010
I-35 Telephone Company DSL No Update to Provide 2/2/2010
I-35 Telephone Company Fiber No Update to Provide 2/2/2010
I-35 Telephone Company Fixed Wireless No Update to Provide 2/2/2010
IAMO Telephone Company DSL No Update to Provide 1/25/2010
IAMO Telephone Company Fixed Wireless No Update to Provide 1/25/2010
ImOn Communications, LLC Cable No Update to Provide
ImOn Communications, LLC Fiber No Update to Provide
ImOn Communications, LLC Backhaul No Update to Provide
Independence Telecommunications Utility Cable No Update to Provide 4/9/2010
Internet Consulting Services, LLC Fixed Wireless No Update to Provide 5/19/2010
Iowa Connect, Inc. Fixed Wireless No Update to Provide 5/12/2010
Iowa Network Services Backhaul No Update to Provide 3/5/2010
Jefferson Telephone Company DSL No Update to Provide 1/22/2010
Jefferson Telephone Company Fiber No Update to Provide 1/22/2010
Kalona Cooperative Telephone Company DSL No Update to Provide 1/20/2010
Kalona Cooperative Telephone Company Fiber No Update to Provide 1/20/2010
KDSC, Inc. Fixed Wireless No Update to Provide 5/18/2010
KeyOn Communications, Inc. Fixed Wireless No Update to Provide 10/15/2009
KeyOn Communications, Inc. DSL No Update to Provide 10/15/2009
KeyOn Communications, Inc. Fixed Wireless No Update to Provide 10/15/2009
Keystone Farmers Cooperative Telephone Company DSL No Update to Provide 4/12/2010
Killduff Telephone Company DSL No Update to Provide
La Motte Telephone Company, Inc. DSL No Update to Provide 2/16/2010
La Motte Telephone Company, Inc. Fixed Wireless No Update to Provide 2/16/2010
La Porte City Telephone Co DSL No Update to Provide 2/22/2010
Laurens Municipal Communications Utility Cable No Update to Provide 6/2/2010
Lehigh Valley Cooperative Telephone Association Fiber No Update to Provide 4/16/2010
Lenox Municipal Utilities Cable No Update to Provide 4/20/2010
LISCO Wireless DSL No Update to Provide 1/28/2010
LISCO Wireless Fiber No Update to Provide 1/28/2010
LISCO Wireless Backhaul No Update to Provide 1/28/2010
Long Lines DSL No Update to Provide 5/4/2010
Long Lines Cable No Update to Provide 5/4/2010
Long Lines Backhaul No Update to Provide 5/4/2010
Long Lines Backhaul No Update to Provide 5/4/2010
Long Lines Backhaul No Update to Provide 5/4/2010
Long Lines Backhaul No Update to Provide 5/4/2010
Long Lines Backhaul No Update to Provide 5/4/2010
Long Lines Backhaul No Update to Provide 5/4/2010
Lost Nation-Elwood Telephone Company Fiber No Update to Provide 4/13/2010
Lynnville Telephone Company, Inc. DSL No Update to Provide
Mabel Cooperative Telephone Company DSL No Update to Provide 4/8/2010
Mahaska Communication Group Fiber No Update to Provide 5/10/2010
Mahaska Communication Group Fixed Wireless No Update to Provide 5/10/2010
Manning Municipal Communication & Television System Utility Cable No Update to Provide 4/22/2010
Manning Municipal Communication & Television System Utility Fixed Wireless No Update to Provide 4/22/2010
Marne & Elk Horn Telephone Company DSL No Update to Provide 2/11/2010
Marne & Elk Horn Telephone Company Fixed Wireless No Update to Provide 2/11/2010
Marne & Elk Horn Telephone Company Backhaul No Update to Provide 2/11/2010
Martelle Cooperative Telephone Association Cable No Update to Provide 5/5/2010
Martelle Cooperative Telephone Association DSL No Update to Provide 5/5/2010
Massena Telephone Company Backhaul No Update to Provide 6/18/2010
Massena Telephone Company DSL No Update to Provide 6/18/2010
Mediacom Iowa, LLC Cable No Update to Provide 1/12/2010
Mediapolis Telephone Company DSL No Update to Provide 4/14/2010
MidIowa Net DSL No Update to Provide
Midwest Broadband LLC Fixed Wireless No Update to Provide 7/6/2010
Milford Cable TV Inc. Cable No Update to Provide 4/21/2010
Minburn Communications DSL No Update to Provide 4/7/2010
Minburn Communications Fiber No Update to Provide 4/7/2010
Minburn Communications DSL No Update to Provide 4/7/2010
Minburn Communications Fiber No Update to Provide 4/7/2010
Minerva Valley Telephone Cablevision, Inc. DSL No Update to Provide 4/7/2010
Modern Cooperative Telephone Company Inc. DSL No Update to Provide
Monarc Technologies Fiber No Update to Provide 2/16/2011
Mutual Telephone Company DSL No Update to Provide 1/25/2010
Mutual Telephone Company Fiber No Update to Provide 1/25/2010
Mutual Telephone Company of Morning Sun, Iowa DSL No Update to Provide 5/5/2010
Mutual Telephone Company of Morning Sun, Iowa DSL No Update to Provide 5/5/2010
Nexgen Integrated Communications, LLC DSL No Update to Provide
Nexgen Integrated Communications, LLC Fiber No Update to Provide
Northeast Iowa Telephone Company DSL No Update to Provide 4/13/2010
Northeast Iowa Telephone Company Fixed Wireless No Update to Provide 4/13/2010
Northern Iowa Telephone Company DSL No Update to Provide 1/25/2010
Northwest Telephone Cooperative Association DSL No Update to Provide 2/17/2010
Northwest Telephone Cooperative Association Fixed Wireless No Update to Provide 2/17/2010
Northwest Telephone Cooperative Association Backhaul No Update to Provide 2/17/2010
Ogden Telephone Company DSL No Update to Provide 3/17/2010
Ogden Telephone Company Backhaul No Update to Provide 3/17/2010
Olin Telephone Company, Inc. DSL No Update to Provide 2/23/2010
Onslow Cooperative Telephone Association DSL No Update to Provide 2/3/2010
Oran Mutual Telephone Company DSL No Update to Provide 2/8/2010
Osage Municipal Communications Utility Cable No Update to Provide 5/18/2010
Osage Municipal Communications Utility Fixed Wireless No Update to Provide 5/18/2010
Palmer Mutual Telephone Company DSL No Update to Provide 1/21/2010
Palo Cooperative Telephone Association DSL No Update to Provide 5/19/2010
Panora Communications Cooperative Fixed Wireless No Update to Provide 1/29/2010
Panora Communications Cooperative Fixed Wireless No Update to Provide 1/29/2010
Panora Communications Cooperative Fiber No Update to Provide 1/29/2010
Panora Communications Cooperative Cable No Update to Provide 1/29/2010
Panora Communications Cooperative Cable No Update to Provide 1/29/2010
Partner Communications Cooperative DSL No Update to Provide 5/15/2010
Partner Communications Cooperative Cable No Update to Provide 5/15/2010



Prairieburg Telephone Company, Inc. Fixed Wireless No Update to Provide 3/25/2010
Premier Communications Cable No Update to Provide 1/25/2010
Radcliffe Telephone Company, Inc. Fiber No Update to Provide 4/26/2010
Radcliffe Telephone Company, Inc. Backhaul No Update to Provide 4/26/2010
Readlyn Telephone Company DSL No Update to Provide 2/23/2010
Readlyn Telephone Company Fiber No Update to Provide 2/23/2010
Reasnor Telephone Company, LLC DSL No Update to Provide
RingTel Communications DSL No Update to Provide 2/17/2010
River Valley Telecommunications Coop DSL No Update to Provide 3/23/2010
River Valley Telecommunications Coop Fiber No Update to Provide 3/23/2010
River Valley Telecommunications Coop Fixed Wireless No Update to Provide 3/23/2010
Rockwell Cooperative Telephone Association DSL No Update to Provide 5/12/2010
Rockwell Cooperative Telephone Association Fiber No Update to Provide 5/12/2010
Rockwell Cooperative Telephone Association Backhaul No Update to Provide 5/12/2010
Royal Telephone Company Fiber No Update to Provide 2/12/2010
Sac County Mutual Telephone Co. DSL No Update to Provide 2/15/2010
Sac County Mutual Telephone Co. Backhaul No Update to Provide 2/15/2010
Scranton Telephone Company DSL No Update to Provide 2/1/2010
Scranton Telephone Company Backhaul No Update to Provide 2/1/2010
Searsboro Telephone Company DSL No Update to Provide
Sharon Telephone Company DSL No Update to Provide 5/20/2010
Sharon Telephone Company Fiber No Update to Provide 5/20/2010
Sharon Telephone Company Fixed Wireless No Update to Provide 5/20/2010
Sharon Telephone Company Backhaul No Update to Provide 5/20/2010
Sioux Valley Wireless Fixed Wireless No Update to Provide 6/7/2010
South Slope Cooperative Telephone Company DSL No Update to Provide 2/2/2010
South Slope Cooperative Telephone Company Fiber No Update to Provide 2/2/2010
Spencer Municipal Utilities Fiber No Update to Provide 2/18/2010
Spencer Municipal Utilities Backhaul No Update to Provide 2/18/2010
Spencer Municipal Utilities Cable No Update to Provide 2/18/2010
Spring Grove Cooperative Telephone Co. Fiber No Update to Provide
Springville Cooperative Telephone Association, Inc. DSL No Update to Provide 2/15/2010
Sully Telephone Association Inc. DSL No Update to Provide 4/28/2010
Sully Telephone Association Inc. Fiber No Update to Provide 4/28/2010
Superior Telephone Cooperative DSL No Update to Provide 5/24/2010
Swisher Telephone Company Fiber No Update to Provide 2/2/2010
Templeton Telephone Company DSL No Update to Provide 3/12/2010
Templeton Telephone Company Backhaul No Update to Provide 3/12/2010
Terril Telephone Cooperative DSL No Update to Provide 2/12/2010
Titonka Telephone Company DSL No Update to Provide 5/4/2010
Titonka Telephone Company Backhaul No Update to Provide 5/4/2010
Traer Municipal Utilities Fixed Wireless No Update to Provide 4/14/2010
USA Communications DSL No Update to Provide 1/27/2010
USA Communications Cable No Update to Provide 1/27/2010
USA Communications Fiber No Update to Provide 1/27/2010
Van Buren Telephone Co Inc. DSL No Update to Provide 1/26/2010
Van Horne Cooperative Telephone Company DSL No Update to Provide 5/18/2010
Van Horne Cooperative Telephone Company Fiber No Update to Provide 5/18/2010
Van Horne Cooperative Telephone Company Backhaul No Update to Provide 5/18/2010
Walnut Telephone Company Fixed Wireless No Update to Provide 4/14/2010
Walnut Telephone Company Backhaul No Update to Provide 4/14/2010
Webb-Dickens Telephone Corporation Fiber No Update to Provide 1/25/2010
Webster-Calhoun Cooperative Telephone Association Fiber No Update to Provide 5/21/2010
Wellman Cooperative Telephone Association DSL No Update to Provide 5/19/2010
Wellman Cooperative Telephone Association Fixed Wireless No Update to Provide 5/19/2010
West Iowa Telephone Company DSL No Update to Provide 1/27/2010
West Iowa Telephone Company Cable No Update to Provide 1/27/2010
West Liberty Telephone Company Fiber No Update to Provide 1/25/2010
West Liberty Telephone Company Backhaul No Update to Provide 1/25/2010
Western Iowa Networks DSL No Update to Provide 2/22/2010
Western Iowa Networks Fiber No Update to Provide 2/22/2010
Western Iowa Networks Fixed Wireless No Update to Provide 2/22/2010
Western Iowa Telephone Association DSL No Update to Provide 4/22/2010

WildBlue Communications, Inc. Satellite No Update to Provide 1/8/2010

[SEPT-16-11 Matthew Brunt] Correction: 
Satellite data is being submitted and was not 
included in the April 2011 submission. While 
coverage is currently the entire state boundary, 
work continues on having more granular data 
available.

Winnebago Cooperative Telecom Association DSL No Update to Provide 1/22/2010
Winnebago Cooperative Telecom Association Fiber No Update to Provide 1/22/2010
Winnebago Cooperative Telecom Association Fixed Wireless No Update to Provide 1/22/2010
Winnebago Cooperative Telecom Association Backhaul No Update to Provide 1/22/2010
Woolstock Mutual Telephone DSL No Update to Provide 5/19/2010
Woolstock Mutual Telephone Fixed Wireless No Update to Provide 5/19/2010
WTC Communications, Inc. DSL No Update to Provide 3/22/2010
WTC Communications, Inc. Fixed Wireless No Update to Provide 3/22/2010
WTC Communications, Inc. Cable No Update to Provide 3/22/2010
Wyoming Mutual Telephone Company DSL No Update to Provide 2/19/2010

Cogent Communications, Inc. Backhaul
No Update Provided - Use Last Submission 
Data

Fenton Co-Op Telephone Company DSL
No Update Provided - Use Last Submission 
Data 4/16/2010

Prairie iNet Fixed Wireless
No Update Provided - Use Last Submission 
Data 3/16/2010

Knology of the Plains, Inc. Backhaul Provider Gathering Data 7/13/2011
Netconnect Fixed Wireless Solicited Initial Data

Community Digital Wireless, LLC Backhaul Other 5/6/2010

[SEP-02-11 Matthew Brunt] Provider stated that 
they do not resell their backhaul, but that it's 
only for internal use.

PAETEC Communications, Inc. Backhaul Other

[SEP-08-11 Wes Kerr] Multiple outreach 
attempts were conducted but no response was 
received. PAETEC was bought out during the 
collection phase of this round by Windstream 
and we intend to be able to include the PAETEC 
coverage as a part of the Windstream footprint 
during the next round.

Panora Communications Cooperative DSL Other 1/29/2010

[AUG-08-11 Layne Wagner] I received an e-mail 
response from the provider stating that all of 
Panora Communications Cooperative DSL has 
been upgraded to FTTH.

Eastlight, LLC Fiber Refused to Participate

[JUL-19-11 Matthew Brunt] Provider stated that 
they do not wish to provide their fiber coverage 
at this time.



Mechanicsville Telephone Company DSL Refused to Participate

[AUG-04-11 Layne Wagner] I spoke with 
provider and they stated they refused to 
participate last year and they haven't changed 
their mind this year.

Mechanicsville Telephone Company Cable Refused to Participate

[AUG-04-11 Layne Wagner] I spoke with 
provider and they stated they refused to 
participate last year and they haven't changed 
their mind this year.

Amberwave Communications Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between June 22, 2010 and January 27, 2011, 6 
additional attempts were made this period.

Coon Creek Telecommunications Corp. DSL Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between July 30, 2010 and February 11, 2011, 5 
additional attempts were made this period.

Global Crossing Telecommunications, Inc. Backhaul Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between July 1, 2010 and February 17, 2011, 3 
additional attempts were made this period.

RuralWaves Wireless Internet DSL Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 5, 2010 and February 18, 2011, 
4 additional attempts were made this period.

RuralWaves Wireless Internet Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 5, 2010 and February 18, 2011, 
4 additional attempts were made this period.

Schaller Telephone Company DSL Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 3, 2010 and February 10, 2011, 
5 additional attempts were made this period.
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Overview 
 

The following documentation provides an overview of how the fourth required data set was collected 

and processed for the State Broadband Initiative (SBI) in the states of Alabama, Idaho, Wisconsin, and 

Wyoming.   

Although we could separate this draft into state-specific deliverables, the majority of methodology 

remains intentionally consistent among the states.  As one important validation test is comparability 

across states, we find value in this cross-state approach.  This cross-state approach also helps the 

LinkAMERICA team focus on comparable outcomes across the four states, where appropriate.  Our 

intent is not to make the states look and be the same, rather it is to leverage economies of scope and 

scale among the business processes. 

As expected, this document rests heavily on the prior drafts, but has also been updated and expanded. 

Significant changes include additions covering: 

1. Trends in provider inputs  

2. Expansion in retrieval of WISP coverage  

3. Requested changes based upon NTIA guidance 

a. Modification of Satellite providers as a Type 1 Broadband provider; 

b. Discontinuation of estimating Community Anchor Institution coverage and speed; 

c. Review of submitted speed with respect to NTIA supplied frequency table 

4. Transition planning with respect to capacity building within the State for Broadband map 

development 

5. Development and posting of a provider Type classification rubric 

Treatment of the following subjects has been expanded: 

1. Community anchor institutions and survey methodology 

2. Verification and validation 

3. Data production methods 

4. Conversion to Census 2010 

As anticipated, the SBI program continues to mature and evolve.  Technical leadership and strong 

program office guidance has been appreciated.  We continue to focus resources on establishing stable 

business processes to track submissions, verify received and processed data, test for temporal stability 

and provide reporting deliverables consistent with NTIA expectations. 

In our view,  the mapping deliverable reflects (1) a good faith effort, which results in a reasoned 

response to the NOFA, Technical Appendix A,  as well as supplementary program office guidance and 

modifications offered in phone calls, emails, and webinars, (2) a stable foundation for improvement and 

prioritization of both NTIA and state needs and interests , (3) a valid data processing model to support 
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online mapping, consumer feedback, provider verification and reporting, and finally, (4) a valid use of 

the evolving data transfer model and its intrinsic validation methods.  More importantly, the resulting 

data and online coverage maps that follow from this work are providing good input and context for the 

Broadband planning teams working across the states we have the pleasure to serve. 

We close this methodology document with two Appendices.   Appendix One describes Data Collection 

Challenges.  This section describes some of the open issues, challenges and questions we are exploring.  

Our hope is to receive clarification and counsel from NTIA in how best to confront some of these issues, 

which are likely common across states.  Appendix Two describes the confidentiality framework 

explained by NTIA.   

Purpose of This Manual 
This technical document was developed to provide transparency in our data production process.   

Our goal is to illustrate a thoughtful process designed to meet the intent of the submission.  Our hope is 

that we have developed a process that is reasonable, with respect to the data it deals with, as well as 

flexible enough to change with evolving NTIA requirements and lessons learned from the Broadband 

mapping community.  

Data Sources 

Developing the Provider List 

Provider lists for all states were developed at project inception from the following sources: 

 State lists of regulated telecommunications, cable and wireless service providers 

 State and national industry organizations (i.e. cable associations, wireless service provider 

organizations, telecommunications associations) 

 FCC Form 477 respondents 

 Independent web searches 

 Prior comparable mapping/research efforts 

 Interviews with key state staff members and important community influencers 

After the April 1, 2011 “Round 3” submission, we continued our research and added new providers to 

the program as discovered.  As one would expect in a dynamic marketplace, provider identification is an 

ongoing and important component of our work.  Mergers and acquisitions, the use of multiple regional 

DBAs, the lack of any universal identity management attribute, and the generally complex parent-

subsidiary structure of many telecommunications companies, make provider identification and tracking 

very challenging.   

In early July 2011, we once again initiated an email and telephone outreach campaign to contact all 

known providers. This is an extremely time consuming process, but it is necessary to ensure that the list 

of contact persons remains current, and that providers are aware of data request changes and deadlines 
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associated with each round.  Where necessary, we execute new NDAs with providers.  In “Round 4”, this 

effort continued on a daily basis until we reached our final data submission deadline on August 19, 

2011.   After August 19, we continued to work with providers who were not able to meet the deadline.  

In most cases were able to “crash” our process to accommodate this extra data, but late submissions 

continue to create inefficiencies and add costs to the overall program.  In Round 4 providers that 

responded too late to be included in the final dataset will be included in our Round 5 submission. Once 

again, as contact is made in each round, we verbally qualify each provider by asking a series of questions 

regarding the type of service and speeds offered.  If the provider does not meet the minimum 

specifications for a Broadband provider (as defined in the NOFA) we make a note of their status and 

remove them from the data submitted to NTIA.1  We continue to reach out to them in future rounds in 

the event that their service is upgraded or expanded. 

Provider Outreach 

To meet the program’s aggressive deadlines and participation goals, LinkAMERICA believes it is critical to 

maintain rapport with providers.  To do this, we continued to reach out to providers with regular project 

communications, including a program newsletter and links to the various state mapping websites.  As 

described above, individual e-mails and/or telephone calls were made to all providers explaining the 

status of the program and requesting their continued support in Round Four. We’ve also had the 

opportunity to support providers in their BTOP / BIP applications in certain cases. Through these 

collective outreach initiatives, and our engagement with various industry associations, we continue to 

enjoy a healthy and appropriate relationship with Broadband service providers. 

NDA 

To provide protection for all parties involved, LinkAMERICA continues to honor the terms of our NDA.  If 

providers did not execute the NDA in previous rounds they were offered the opportunity to do so in this 

collection round.   New providers were of course also supplied with a copy of the NDA. 

To facilitate the execution of NDA’s, LinkAMERICA continues to use the DocuSign online document 

management solution.  This system allows providers to review and digitally sign the NDA in a legally 

binding manner, and has been instrumental in achieving rapid approval and execution of NDAs with the 

majority of providers.  In some cases, NDA’s were individually negotiated to address specific provider 

concerns.  In all cases, minimum standards established by the NOFA are honored.  In other cases, 

providers chose to submit data without executing an NDA. 

Provider Survey 

Since three prior rounds of data collection had been completed, the LinkAMERICA team had a solid base 

of coverage and speed information with which to begin Round 4.  This allowed us to provide two 

response options to providers.  The first was for them to review check maps of their coverage and speed 

data – submitting only corrections and additions to the existing dataset.  (For provider convenience the 

                                                           
1
 As with other Grantees, we struggle with appropriate and consistent classification for service providers who 

opportunistically provision Broadband services.  In this submission we continue to bring them into the analysis as a 
provider type “other”.  As the inclusion of this category isn’t our primary goal, we are working to process data as 
we can.  We are similarly categorizing and retaining reseller information.  Our datapackage.xls illustrates the 
categorization of non Broadband providers within our provider tracking and verification systems.  
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check maps were created in both PDF and Google Earth (.KMZ) formats.) The second was to allow 

submittal of completely new datasets, either in tabular form or in multiple other digital formats.  For 

those without sophisticated CAD or GIS systems, we continued to allow the submittal of 

printed/scanned maps and other written materials.    

Survey Methods 

Once again, we used a secure digital survey process (via our provider portal websites) to collect and 

display information for providers.   The Round 4 survey process was designed to accommodate both 

new and returning providers, and the different types of information they would be submitting.  The 

following is a summary of the process encountered by each group: 

New providers:  New providers were routed directly to our standard survey where they were provided 

with templates for uploading data in tabular NTIA-compliant formats.   As in previous rounds,  if 

providers could not supply information in the requested format, alternatives were offered.  These 

alternatives included uploading service-area boundary maps, exchange area maps, CAD drawings or 

customer address lists.  From that information, the LinkAMERICA team developed a geographic 

representation of coverage and was able to build coverage features for each provider.    

Returning providers:  For Round 4 we continued to work with participating providers to improve their 

datasets.  The change in Census Data vintage was explained to providers and links to appropriate files 

were provided to assist with the transition to the new vintage data.   

Check maps continue to be a useful tool to show providers how their area would be displayed on the 

resulting interactive state map and to get constructive feedback regarding corrections and changes that 

need to be made to their coverage and speed data.   Generating these customized documents in each 

round is an extremely time consuming verification process, but it allows us to close many of the gaps 

that might have otherwise persisted. 

Follow Up 

After the release of the Round 4 survey in early July 2011, LinkAMERICA launched an extensive effort to 

encourage responses.  Every known provider was contacted at least twice during the months of July and 

August.  The initial data submission deadline was set for August 19, but, as previously noted, we 

continued to accept “straggler” submissions into September.  

No Response Policy 

As mentioned above, every effort was made to contact each provider who appeared on our initial list.  

However, if no current information could be found on the company (i.e. no website, no valid phone 

number, no contact person identified) they were removed from the list of “known providers”.  We 

believe the vast majority of those we were unable to reach were providers who have simply ceased to 

exist2.  

                                                           
2
The list of known providers and important submission statistics are contained in the datapackage.xls file. 
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Summary 

In summary, an intensive 45-60 day provider outreach and data collection process is initiated at the 

beginning of each round.  In Round 4, given the data vintage of June 30, 2011, we began this process in 

July and the last submissions were accepted in September, 2011.    

While we continue to successfully engage the majority of providers in each round, the amount of 

manpower required to solicit complete and timely responses should not be underestimated.  This 

process is one of the most costly and complex within the entire SBI program.  

Third Party Data Used 
Beyond the data obtained from providers, we acquired the following commercial data products: 

 American Roamer, Coverage Right Advanced Services. This data served two purposes.  The first 

was to verify the provider list and help find Broadband service providers not on other lists.  The 

second was to verify the reasonableness of the Broadband service provider’s submission. 

 MapInfo ExchangeInfo, Professional.  This data was used in the verification of telephone 

Broadband provider data.  Where a public domain exchange boundary wasn’t available, the 

MapInfo boundary was used for coverage containment tests.  

 Media Prints Cable boundaries.  This data was used in the verification of Cable/HFC Broadband 

provider data.  It was used to research valid providers and discover if that provider was offering 

Internet service.  In very rough terms the contained boundaries were used to test the location of 

some provider data.  

 FCC 477 restricted use data were analyzed to find valid providers within a given area. 

We have included third party data sources, which touch on each of the three major technologies 

analyzed within the SBI program.  Each of these data sources tie back to a public domain data source, 

which provides a cross-verification mechanism for the commercial data product. 

Although there are a large number of third party licensed data sources available, we remain 

conservative in our acquisition plans.  From our limited analysis we are concerned about the ability to 

cross-verify additional third party licensed sources against public domain data.  Further, we are unsure 

of how we may be able to integrate another data provider’s view of valid Broadband providers within 

the definitions used by the NOFA (eg. Are they using an FRN/DBA identity view or a marketing view?  

Can the provider supply in a 7-10 day window?  Are they facilities based or not?).  This leads us back to a 

statement we made in a ‘lessons learned’ Webinar (April 2010) about exploring a consortia to lower the 

cost of data acquisition and allow multiple entities to peer review the quality and methodologies behind 

licensed data products.3  

Beyond these commercial data sources, we used a number of public domain sources.  These included: 

a. Geographic Data Files  

                                                           
3
 We also suggested forming a technical standards committee and a consistent system for confidence reporting. 
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i. US Census TIGER data4 

b. Sources that helped isolate providers, identity management or provider service areas 

i. NECA Tariff 4 

ii. State produced exchange boundaries  

iii. Carrier produced wirecenter boundaries 

iv. FCC Coals reports (321/325) 

v. FCC FRN API lookup tool 

vi. FCC/FAA Antenna Registration System 

vii. FCC FRN Lookup Tool (plain text search) 

viii. USAC High Cost FCC Filing Appendices 

c. Sources that helped isolate anchor institutions 

i. USAC Grant lookup tool 

ii. USAC High-Cost FCC Filing Appendices 

iii. HRSA data warehouse 

iv. NCES data lookup 

v. State managed lists of schools (K-12), post-secondary institutions and libraries 

vi. List of museums,  conventions, and visitors bureaus from www.onlineatlas.us 

Finally, challenges exist when dealing with the inevitable conflicts between provider-submitted data and 

third party sources (public or commercial).  There is no guarantee third party sources are more accurate 

or timely than the providers’ own reports.   Indeed, some third party sources are based upon different 

standards than those specified in the NOFA, perhaps making them less reliable than information 

collected directly from providers.  At the very minimum, provider data has a lineage and temporal status 

that we can identify.  A concern we have with increasing use of third party data is that we have no way 

to verify its quality or development methodology.  In other words, we may hit a wall in which we can’t 

determine how the commercial source derived its coverage conclusion.  To us this means that third 

party data sources are beneficial, but represent a supplementary view, not an authoritative one, of the 

NOFA defined Broadband market. 

In short, we have chosen to use provider data as the baseline.  We will challenge provider reports when 

third party data shows major anomalies, when submitted data conflict with prior submissions or when a 

consistent volume of consumer feedback points to a potential error.   

As the program evolves it is also our intention to provide tools that allow end users to evaluate the 

accuracy of the data in their own way.  A confidence score or the presentation of multiple (and 

potentially competing) reports for the same location may be made available. This notion is discussed 

further in the “Validation” section.   

                                                           
4
 Census data were derived from < http://www.census.gov/cgi-bin/geo/shapefiles2010/main>, Census 2010 files.  

Roads were derived from the county faces and edges file downloaded at the same location and tiled for a full state. 
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Confidentiality and the Use of Licensed Materials 
As a mapping vendor, we are reliant upon the cooperation of Broadband service providers.  In large 

part, what underlies this cooperation is trust that we will not violate the proprietary and confidential 

nature of the data provided to us.   

We are thankful for the confidentiality clarification that NTIA shared with us (included as Appendix Two).  

We intend to use this as a guiding document to help us communicate with providers about what 

information NTIA considers to be confidential.  Our suggestion is that NTIA publish this, or something 

comparable, to ensure a consistent interpretation of the NOFA and how it guides NDAs. 

As some providers are non-responsive to requests for information, or lack resources necessary to put 

data into NTIA compliant formats, we have fallen back to the use of commercial data sources in several 

places.   

For instance, some mobile wireless providers were unable to submit coverage information to us.  In 

these circumstances we have generalized the American Roamer coverage.  For incumbent telephone 

providers we have used commercial wirecenter boundary products to filter Census Blocks that are 

clearly out of their exchange areas.   

Public Engagement:   Crowd Sourcing, Surveys and Social Media 
Crowd sourcing (i.e., an intentional and carefully designed effort to tap into the collective intelligence of 

the public at large to expand our knowledge base) continues to be an important element of our data 

collection and validation process. In addition to the various opportunities the public has to provide input 

via the online service coverage maps and the related ‘Broadband story’ process, our crowd sourcing 

efforts are grounded in a time tested telephone survey approach focused on the consumer market. In 

addition, we continue to advance our process to include certain initiatives centered in two social media 

outlets – Facebook and Twitter. These initiatives are discussed below. 

Consumer Surveys 
Working under contract for the state of Alabama in 2009, our initial consumer survey was performed 

before the NTIA SBI grant was in place. Subsequent consumer surveys funded by the SBI grant were 

hosted in 2010 for the states of Idaho, Wisconsin and Wyoming and then again in 2011 for Alabama (as 

noted below). These surveys will be repeated after two years to establish and evaluate trends. To this 

end, in August/September 2011 we are wrapping up a second-round survey in Alabama designed to 

expand our understanding of important adoption issues and to establish important local trends from the 

initial 2009 survey. Survey results from this effort are currently under evaluation. These primarily 

telephone based surveys include two distinct and carefully scripted tracks: one for Internet users and 

one for non-users. The telephone survey approach allows us to reach the non-Internet user group as 

well as the current Internet user. A secondary online approach is also used to augment input from 

current Internet users. In the most recent Alabama survey we added a third tier to our approach as we 

equipped local field survey teams with an iPad-based survey tool and targeted their time to reaching the 

younger market. For non-users, the surveys help determine why they don’t have or don’t use 
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Broadband. For current Broadband users, the survey helps determine the nature of their Broadband 

access and how they use that connectivity in their daily lives. In addition to our state-specific surveys a 

nation-wide survey was also hosted to provide a broader view of consumer views for comparison 

purposes. State-specific surveys are, where possible, framed to match the state’s regional Broadband 

planning structure (e.g., the updated consumer survey in Alabama was designed to produce results 

relevant to the state’s twelve Broadband planning regions). 

The resulting data is helpful on a number of fronts in the SBI’s mission to advance the access and 

adoption to Broadband. Survey data provides an important, albeit broad, gauge for assessing coverage 

information obtained by providers. For example, areas with widely available coverage (according to 

provider information), but lower consumer subscription levels (according to survey results), or perhaps 

where survey results suggest Broadband is not available, can be examined in more detail. Survey results 

are also very important to the Broadband planning (and capacity building) components of the SBI 

program in that they help inform and formulate Broadband advancement priorities. Survey results also 

help inform Broadband policy discussions on both the local and state levels. Finally, survey results 

provide important information to the service provider community regarding market demand and 

specific Internet use in specific communities (i.e., regions).  

Our ongoing consumer survey process adheres to a consistent process. For example, consistent with 

prior practice the 2011 Alabama survey was launched in June 2011 with a test number of survey calls to 

confirm (and adjust as needed) the structure of the survey and the underlying survey process. Our 

surveys typically run for three to four months.  All telephone surveys are completely random beginning 

with the acquisition of a list of state-specific, randomly selected landline telephone numbers.  Mobile 

phones are not typically included in the surveys. Upon evaluation of the survey statistics, auxiliary 

surveys are executed to ensure appropriate representation is achieved on both demographic and 

geographic fronts. For example and as noted above, the recent Alabama survey was augmented with a 

field effort to ensure the younger demographic  (i.e., age 18 – 25) was adequately represented. This 

secondary step is required because of the continued migration (by younger markets) to non-landline 

based communications. This younger market is also surveyed by reaching out through social media 

outlets to encourage their participation in an online survey process. 

Survey statistics from the Alabama update survey are currently being developed and evaluated. Survey 

statistics from our initial surveys in Idaho, Wisconsin and Wyoming were summarized in our last filing.  

Survey volumes are designed to achieve statistical validity.  

As noted above, our telephone survey process is augmented by providing online access to the survey. 

Participation in the online survey is promoted on all of our state-specific public web sites and selected 

social media. 

As a final relevant point with respect to the consumer survey process the length of the survey is 

noteworthy. By survey standards, these tend to be long surveys. The surveys typically average just over 

fifteen minutes.  While this clearly contributes to the number of survey call attempts that were required 

to reach the level of statistical validity, it is not insurmountable.  
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Social Media 
The phenomenon of social media is widely documented and yet still emerging as an effective access 

point for public engagement. We continue to explore appropriate ways to use a variety of social media 

venues in our SBI efforts. All of our efforts are informed by and consistent with relevant state statues 

and guidelines. Different states have different perspectives on if and how the state will participate in the 

use of social media. Some state requirements are well defined and some are still being formed. Where 

appropriate, we use LinkedIn, Facebook and Twitter to support our work. A central focus is on 

promoting awareness. As noted above, we are able to promote additional input on the consumer 

surveys through a social media outreach program aimed at our younger market segments.  

In addition, we continue to evaluate how Facebook and Twitter can be used to drive public input on two 

important crowd sourced issues: online speed tests and input on map accuracy. Based on data obtained 

through our web site traffic monitoring process and readily available social media tracking processes, 

our most recent results are promising.   

Capacity Building and Transitioning to State Partners 
A foundational goal of LinkAMERICA has always been to transfer knowledge and capacity to our State 

partners.  As we move into program year 3, distinct tasks are migrating to the responsibility of our State 

partners.   

Within each State, transition planning and responsibility for specific activities is on a slightly different 

timeline.  Much of this is driven by resource availability and partner identification within the State.  For 

example in round 3, the State of Alabama used interns to validate Community Anchor Institution (CAI)  

data.  In this submission Alabama took on greater responsibility for the CAI submission.  To support this 

LinkAMERICA developed a detailed transition document describing the current CAI efforts. 

Other States are looking more towards program year 3 and the in-State hire of a Broadband Coordinator 

as the initiation point to support their transition efforts. 

Data Production Process 
To support our objective of transitioning the data development process to our State partners, we 

continue to model and document our data production process.   We find this to be a very beneficial step 

for two purposes.  

First, it helps us understand why (and if) a task is being done, and if it is being done efficiently.  Much of 

this program started so quickly that it was difficult to plan logical integration and hand off points among 

the various workgroups.  Further, we are currently in the process of consolidating much of the process 

data (check-ins, check-outs, metadata) and we can use this process model to efficiently plan a cohesive 

information architecture. 

Second, our process documentation and modeling helps explain why resources are being consumed in a 

particular way.  This helps our State partners plan for in-sourcing specific tasks as their time and 
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budgetary constraints allow.   It also helps our LinkAMERICA team better plan and cross-train members 

to deal with the work surge that occurs 30-45 days prior to submission. 

Finally, documenting and modeling our process helps us to take advantage of increasing specialization 

and proficiency with certain types of data and management responsibilities.   In submission 3, we had 

identified data “czars” responsible for check-in and check-out of data.  That data czar helped to bridge 

the gap among receipt functions, provider feedback, production and DBA.  

 

Figure 1—SBI Data Development Business Process Diagram 

 

Data Production Methods 
As raw data were received from the provider community, attention turned to normalizing the disparate 

submission formats5.  The team considered each submission with respect to the following criteria.  

These criteria are important because they perform the basis for our verification and quality assurance 

                                                           
5
 In line with NTIA Best Practices we continue to request and receive a large number of data input formats.  This 

ranges from tabular Block lists to hand drawn maps. 
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process.  In other words, we have to appropriately scale our data verification efforts to match the scale 

or ambiguity of the following: 

 Locational certainty 

 Speed certainty 

 Temporal certainty 

 provider and network ownership certainty 

The team’s goal was NOT to quantify a particular degree of precision with respect to any of these 

criteria.  Rather, we are working to attribute the above “certainty attributes” to each submission, and 

will continue to implement quality assurance and verification mechanisms that are resource-appropriate 

for each. 

Deriving Broadband Coverage Information 
Broadband Coverage6 was normalized into four formats:  

1. Coverage in Census Blocks (2010) of 2.00 or less square miles 

2. Covered Street Segments (2010) in Census Blocks greater than 2 square miles7 

3. Address Level Coverage (point data) 

4. Wireless Service Areas (SHP file format) 

With each submission, the team went through a series of steps to normalize and categorize the data. 

Since data arrived in many different formats, and at many levels of granularity, the following 

normalization procedures were used:  

1. Determining the nature of service being provisioned (who is providing service and what 

technologies are in use) 

2. Planning an attack strategy for the submission –understanding the data and assigning team 

members to various tasks 

3. Geo-referencing the data; QA the geo-referenced data  

4. Geoprocessing the geo-referenced response 

5. Segregating the submission into the correct NOFA-compliant submission formats. 

6. Apply appropriate source metadata8 

                                                           
6 Speed, Anchor institutions and Middle Mile facilities are discussed in later sections. 

7
 To help clarify issues relating to Census block area and vintages in use, our team published a technical paper to 

the Grantee workspace.  Because we were unsure if this standard should be implemented uniformly, this 
document was never distributed to the provider community. 
 
8
 When our team logs a submission into the staging database we record at least two attributes.  One records the 

method used to derive the coverage, the other records the method by which speed was attributed to that object.  
Other attributes carried to NTIA carry source meta values as well. 

https://sbdd-granteeworkspace.pbworks.com/w/file/33293657/Technical%20Reference%20Document%20Final.doc
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Figure 2-Broadband Coverage Process 

Impact of Program Change 
There were several important program changes that impacted how Broadband coverage was developed 

and submitted to NTIA in Round 4. 

Census Conversion 

The first and most obvious change in submission 4 was the conversion to a Census 2010 coverage 

baseline.  This impacted all wireline providers, the data submitted, the appearance of the mapped 

information and the baseline coverage metric comparisons against prior submissions.   

Release of the June 30 Grantee guidance document, allowed LinkAMERICA to communicate this change 

with providers.  LinkAMERICA provided by FTP access appropriately formatted and sized9 TIGER 2010 

Census blocks and Tiger Road Segments.  Given the relatively late release date, we received a mix of 

responses from Broadband providers.  Some easily produced Census 2010 information.  Others 

requested that we do the translation from their supplied blocks and segments.  Others requested that 

we translate their engineering data into appropriate formats.  A small number of providers committed 

to producing Census 2010 data but struggled internally with the conversion in this rapid time frame. 

Census 2010 has significantly more Blocks than Census 2000.  For the most part there are far more small 

Census 2010 blocks (less than 2.0 sq mi) than Census 2000.  As our team worked through the QA 

process, this presented a significant challenge in comparing our converted results to prior submissions.  

We use a block count metric as our first test of consistency across submissions.  Since the block count 

                                                           
9
 In Submission 3 we released a technical note describing how we measure Census block area. Although there 

remains no consensus on this, we used the same process as outlined in the paper. 
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increased it was hard to distinguish coverage area changes from coverage chances resulting only from a 

change in Census shapes.   

The converse side of this challenge was even more precarious to work through.  Because many road 

segments dropped out due to the covered area now being in a small block area it was difficult to 

determine how effective our covered segment process was given the fact that many segments naturally 

dropped out due to changes in Census shapes. 

The tendency for large blocks becoming small was not universal.  We note in some of our very rural 

areas of Wyoming and Idaho, small block covered areas become large.  This created a contrary situation 

where small blocks become road segment areas. The image below shows a coverage area change 

between submission 3 and 4.  The covered number of blocks is comparable but the appearance of the 

coverage is different as a manifestation of the Census change. 

 

Figure 3--Coverage Change across submissions 

This somewhat indeterminate process required our QA analysts to examine a number of submissions in 

detail.  The conclusion was that although the appearance of coverage was significantly different, the 

underlying engineering data was the same (or very similar) but how the coverage was manifested was a 

product of the Census conversion. 
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Census Conversion Practices 

Although we had hoped there would be a single process we could follow for all Census conversions our 

experience has been that it is necessary to be flexible and base the Census conversion process upon the 

data received.   

On a subjective level, we felt the most comfortable converting into Census 2010 where we had facility or 

demand data to guide the block and segment selection process.  In these circumstances we used 

geoprocessing methods like intersections or network analysis Analyst to make an objective 

determination.  The geoprocessing methods mirrored those discussed in the next section.   This was 

probably the majority of our submitted data. 

In circumstances where we were provided Tiger 2010 blocks or segments, we used those as given and 

performed our standard validation process.   Some providers used the TIGER blocks and segments which 

we supplied them and made their own selections. 

Finally, in circumstances where we had either a Census 2000 block list or a geographic file containing 

Census 2000 geographies and were told there was no coverage change for this submission, we used the 

Census crosswalk tables10 to derive a list of candidate blocks.   The output of a conversion process is 

shown below. 

 

                                                           
10

 See http://www.census.gov/geo/www/2010census/rel_blk.html 

http://www.census.gov/geo/www/2010census/rel_blk.html
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Figure 4—Block Conversion Process, Census 2000 black outline, no fill.  Green is 2010 large blocks, so any shading without an 
outline is 2010 block area not covered in 2000 

For the most part it is difficult to discern the impact of a conversion into Census 2010.  We don’t see vast 

changes in areas covered.  Nonetheless because the block shapes do change the overall coverage area 

will look different.  

As the 2010 data gets pushed into public deliverables, our sense is we will receive questions about the 

appearance of the new data.  

Speed Examination 

Given recent concerns about the depiction of speed and what that mapped speed represents, 

LinkAMERICA invested considerable time requesting detailed information on speed which appeared to 

be beyond normal speeds for a given Technology of Transmission given the NTIA supplied frequency 

tables. 

Based upon these conversations we learned 

A) For a large incumbent telephone provider; the speeds beyond the normal DSL range 

represent significantly shortened copper loops. 

B) For a large national cable provider the intermixing of Docsis 3.0 and non 3.0 systems in a 

market area is typical and sometimes reflects a circumstance where segments of plant cannot 
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be upgraded to Docsis 3.0.  This variance can be at a level below the Census block. In these cases 

the maximum advertised speeds remain to represent the market area but the plant variance is 

typical.  This same provider expressed concern with moving reported advertised speeds below 

the market  level. 

C) We have a minority of providers who submit a theoretical speed that is unmatched by their 

web advertising.  In these cases we request clarification from the provider on the inconsistency.  

Our experience has been that providers will modify the speed to be consistent with their web 

coverage. 

Provider Definitions 

Within our provider verification process we work to derive a state level provider match against third 

party data sources.  As discussed in the early pages of this manual, there is no guarantee that a third 

party data source is any more accurate than submitted data, nor does it necessarily reflect the provider 

ecosystem specified in the NOFA, Technical Appendix A.  We devote significant resources to matching 

our submitted data against three, third party data sources.  In many cases this becomes a judgment call 

trying to match provider names across systems.  It is a difficult and somewhat arbitrary process.  

Nonetheless we do believe it has value because it forces a re-examination of who we believe is an 

appropriate provider within a non-NOFA context11. 

The use of a provider match system, as well as the webinar comments (3/17/11) directing grantees to 

estimate, wherever possible, non-participating providers have made us back away from one of our 

fundamental assumptions in data collection.  As discussed in the prior draft of this manual, we had 

developed a certain “hold-out” class of data when a provider’s data wasn’t of sufficient quality to verify, 

or we were unable to put it into the data model (eg. address points submitted for a wireless).  In this 

submission, much of this hold-out data has been included12.  In some cases this means we are using 

simple polygons to capture a wireless ISPs serving area.  Other times, if we are confident in the 

coverage, but can get little clarification on the submitted speeds or frequencies, we release the 

coverage and note in our internal metadata the source issues with the other attributes.   

Finally, we have used the new provider type classification of ‘other’ to bring some aspect of the 

provider’s data into our submission.  There still seems to be confusion on how to handle provider types 

where a provider offers multiple paths to provision Broadband for typically business customers.  Rather 

than waiting for certainty on the answer, we bring the provider in and list them as provider Type 

“other”.  Our sense is provider Type “other” will continue to expand in subsequent submissions.   

                                                           
11

 We have requested from NTIA information on how provider matching is done within their QA process; beyond 
the relatively short whitepaper posted with the national map <http://www.broadbandmap.gov/blog/wp-
content/uploads/2011/02/DataComparison_Methodology2.pdf>, we have not received any more detailed 
information on how providers are cross verified between submitted and third party sources at the national level.  
Our understanding is licensing concerns are holding the release of this information. 
12

 We continue to process older submission data looking for information and methods by which we can estimate 
coverage information.  This will be an ongoing process. 

http://www.broadbandmap.gov/blog/wp-content/uploads/2011/02/DataComparison_Methodology2.pdf
http://www.broadbandmap.gov/blog/wp-content/uploads/2011/02/DataComparison_Methodology2.pdf
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Clearly one challenge is the data, but an equally significant challenge is appropriate messaging around 

this “other” provider type category.  We do not want to leave consumers with the impression that they 

can get a high capacity fiber or microwave link despite the fact that the hospital next to them in the 

same Census block can get this service. 

After the Grantee conference, LinkAMERICA submitted a paper describing our provider classification 

system13.  It is our feeling that understanding the type of provider is essential to appropriate verification 

methods.   

Coverage Geoprocessing Methods 
The next section discusses how data were georeferenced and geoprocessed given a particular 

submission format.  We have yet to find a particular method that works across all submissions.  Rather 

we tend to tailor our geoprocessing to meet the specifics of the service provider and data submitted. 

In most cases, in Round 4 we were still not provided with street segment level information for Blocks 

greater than two square miles (large Blocks).  This necessitated subsidiary geoprocessing.  As stated 

before, our first goal was to derive block level coverage.  Then, for Blocks greater than 2.00 square 

miles, we moved to a segment gathering processing.  The segment process will be described in the last 

section.14  

Block Level Coverage Derivation Using Service Point Data 

A number of providers submitted point level customer data.   

In some cases the submissions themselves were not internally consistent.  For example, in the image 

below, unprojected points are shown, while the Census block polygon to which the points are supposed 

to “belong” is highlighted.  In this case, one of the following scenarios has occurred:  block attribution is 

wrong, the points are not in the location to which they are attributed, or different block shapes were 

used than what is assumed. 

 

                                                           
13

 https://sbdd-granteeworkspace.pbworks.com/w/file/42309493/provider%20ClassificationFINAL.docx 
14

 As has been discussed previously, we note inconsistency in how providers are supplying information at the block 
and segment level.  Beyond the temporal differences, we see that providers are computing area differently, as well 
as including or excluding water areas.  This provides an inconsistent measure across providers for the 2.00 sq mile 
cut off.  Our preference would be to provide guidance to service providers within our states, but our concern is 
that we will inconsistently message this with grantees in other states.  We would appreciate consistent guidance 
from FCC/NTIA on this topic. 
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Figure 5-Internal inconsistency in submitted data 

In other circumstances, we found that inconsistent geocoding standards may produce misleading 

results.  The next image shows point level data, and the Blocks are colored based upon the counts of 

points intersecting Blocks.  The challenge this presents is that if geocoding was performed on a different 

dataset than the block boundaries (the road traces are not coincident with block boundaries) and/or 

geocoding was done without an offset, it becomes problematic to assign coverage to a Census block 

based upon only the point locations. 
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Figure 6-Block Coverage 

For this reason, where we were provided address point data and asked to generate covered  Census 

blocks, we elected to use a 200-foot buffer to select Census Blocks that intersect our points.   

We are also starting to see a number of providers submit customer data and facility data.  Their intent is 

to allow us to have two primary sources from which to derive the most accurate coverage.  In these 

cases we tend to look for clusters of customers in areas where we see no facility based coverage. 

With respect to deriving Block level speed from sub-Block data, we have instituted a business rule where 

the predominant speed in a Block is the speed we attribute to the Block. 

Block Level Coverage Derivation Using Customer Facing Plant Level Point Data 

In other circumstances, providers submitted point level plant data.  From what we could gather, these 

points tended to be customer-dedicated terminals.  Typically, these providers were high speed 

Broadband producers—which may somewhat strain the definition of Broadband as other providers 

supplying comparable services specifically disclaimed the ability to provide high-capacity Broadband 

services in the required 7-10 day interval.  In these plant point data submissions, we had similar 

concerns to the point level customer data, but two factors tended to make us use a more conservative 

intersection buffer.  First, we tended to have far fewer points to work from, so our concern was 

grabbing too many covered Blocks as the Blocks tended to be much smaller in these urban areas.  
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Second, these plant points tended to be dedicated to distinct customers, but it was difficult to know 

which element of the customer’s campus to attach coverage to. 

In the case of the image below, given a small shift to the left, it would be easily possible to gather 1 to 3 

Census Blocks from this point.  Although orthoimagery is helpful in a circumstance such as this, it is still 

indeterminate.   

Thus, in the circumstance of plant level point data, we used a 100-foot intersection buffer. 

 

Figure 7-Plant Point level data 

Coverage Derivation Using Linear Facilities Data 

A number of providers submitted facilities data.  We handled this data in different ways depending upon 

what we believed the facility data represented. 

Most telecommunications networks are divided into two components.  Feeder supplies higher capacity 

nodes (eg. DSLAMs, Fiber Nodes).  Distribution usually supplies customer premises (NIDs, Pedestals, 

Taps, ONTs).  Where we could discern what strand we were provided, we used different methods. 

The next image demonstrates a geo-referenced CAD image as given to us by a Broadband service 

provider.  Note the light and dark green shading.  We would infer that the lighter segments represent 

distribution and the dark green represents the feeder network. 

In the case of a combined strand map, we used a relatively tight buffer of 200 feet to gather covered 

Census Blocks.  Our intersection tolerance is based upon an assumption that our data likely represent a 
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situation comparable to customer point level submission in that we have most of the network footprint 

captured. 

 

Figure 8-Georeferenced CAD information supplied by Broadband provider 

 

In other circumstances, we were provided engineering information that we inferred to be feeder only.  

This inference was typically based upon the presence of fiber optic equipment only.  In these cases, we 

used a more generous 2,000 meter Census block intersection.  The 2,000 meter criteria was based upon 

an informal survey of population in proximity to the geo-referenced strand data, but it could be varied 

based upon a more complete survey. 

Coverage Derivation Using Covered Street Segment Data 

In some cases we were provided with covered street segment data.  Covered segments tended to come 

from two sources. 

In some circumstances, providers gave us CAD data, which was not drawn in a projected manner.  This is 

relatively common for older engineering data derived from hand drawn records.  This meant that our 
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team geo-registered the image into an approximate position.  In this case, the boundary streets were 

selected, and an enclosing polygon was derived.  The intersection of this polygon and the Blocks within 

became the geoprocessing method to derive Blocks. 

 

Figure 9-Coverage derived from street segments 

In a second circumstance, street segment data was developed during coverage estimation.  Handling the 

estimated data is discussed below. 

Coverage Derivation Using Serving Area Point Submission Data 

In other cases we worked with providers to derive service areas based upon point plant data.  In these 

cases we were given a serving node and an appropriate road length service boundary. There is an 

important distinction from the plant data discussed above. In this specific case, the data submitted was 

a node that served many locations--such as a Central Office or DSLAM.  This is contrasted with the 

earlier example in which the point represents a node serving only a few customers.   
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When trying to derive coverage from Central Office or DSLAM nodes, the team used ESRI Network 

Analyst to derive covered road segments honoring these road engineering parameters. 

The figure below shows street level coverage derived from Central Office and remote DSLAM point data.  

 

Figure 10-Coverage derived through road paths 

In response to Provider feedback we revised this process to include a larger variety of TIGER road types.  

In Round 1, unimproved roads were not used.  In the current submission -- particularly to improve 

estimates in areas bordering parks and public lands -- a wider class of TIGER roads was used.15 

The segment level coverage is easily extendable to derivations of Census block level speed.  The figure 

below shows the attributions of block level speed based upon the Maximum Advertised Speed available 

from a DSLAM.  Although the methodology isn’t perfect, it does provide insight into the value of 

granular infrastructure data. 

                                                           
15

Only TIGER features of MTFCC type S1100 and S1200 were excluded from use. 
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Over time we have seen an increase in the number of providers submitting this type of data for our use.  

Our sense is some providers find plant level data easier to generate and are satisfied with the results of 

derived coverage. 
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Coverage Derivation Using Polygon/Polyline Serving Areas 

Broadband service providers sometimes submitted coverage in terms of served areas.  This was either in 

direct geospatial formats, CAD files, or paper maps.  The image below reflects a carrier’s service area.   

Within that service area, there are variations in technology of transmission and served speeds.  When 

polygons with speed data and technology of transmission were available, we used a spatial intersection 

to gather covered Census Blocks.  In many cases, using covered Census Blocks resulted in a loss of the 

speed variation (sometimes the speed variation was at a level smaller than a Block and did not get 

picked up within a spatial query).. 

 

Figure 11-Coverage derived through serving area polygons 

Although we cannot directly solve the loss of speed granularity due to Block shapes, we honor a 

business rule wherein we always select Blocks from the highest speed areas first, and then allow the 

lower speeds to select from the remaining Blocks.  This is an arbitrary rule, but our feeling was that it 

should be a consistent selection, rather than an unordered selection. 

Street Segment Derivation, Large Blocks 

For those calculated Blocks greater than 2.00 square miles (large Blocks), we provided coverage in terms 

of covered street segments and corresponding geography.   

With respect to segments we had four sources of data: 

1. Covered large Blocks 

2. Tabular street segments and address ranges for large Blocks 
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3. Geographic segments either with street attributes or without 

4. Service area boundaries 

A number of providers only provided a list of covered large Blocks without corresponding segment 

information beneath the block.  This provided the dichotomy of either selecting all segments in the 

block, or none.  Because we had little information from which to make the selection, we elected to be 

conservative and did NOT pass any covered segments to NTIA from this submission format.  Some 

Broadband providers submitted covered street names and street ranges.  In these cases we performed a 

manual analysis trying to link to specific segment names and address ranges within covered Blocks.  

Sometimes this was a simple process because a provider used a TIGER derived street database.  In other 

cases we could not determine the source of the provider’s street data.  Street and Address matching 

tended to yield a relatively good result (typically between 30% and 100% of possible segments in the 

Block), but was very time consuming.  Where yield rates were low, our result was a shredded segment 

coverage pattern, like the image shown 
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below.16

 

Figure 12-Blue road segments adjacent to peach covered small Blocks 

A number of providers submitted geographic objects. In this case, our manual process was directed 

toward a conflation of data sources.  The goal was to take provider submitted segments and put these 

segments in terms of our TIGER 2010 basemap.  Although there is a trade-off in the accuracy using non-

provider submitted segments, we felt it was more important to have a road set that would edgematch 

our Block features and remain consistent with the Block size standards we used for other providers.  This 

is important for the appearance of the online maps, as well as potential verification work where we are 

attempting to judge a feature based upon its attachment to a covered small Census block.  The figure 

below shows street segment input data. 

                                                           
16

 We continue to hear providers expressing concern that our request for either a geographic object or TIGER Line 
ID is beyond the scope of the NOFA clarification. Therefore, they cannot supply additional information to us. 



SBI Mapping Methodology Page 33 
 

 

Figure 13-provider Submitted Street Segment Objects.  The segments don’t edge match the Blocks nor are they continuous. 

The figure following demonstrates the same area after the conflation process.  Blue segments are the 

conflated TIGER roads which will be passed to NTIA. 
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Figure 14-provider submitted segments in gold, selected TIGER  in blue—Conflation result; in many cases what was a 
continuous segment is made discontinuous because even with a distance buffer the TIGER segment doesn’t always intersect 
the provider segment 

 

The final segment process was used when we were supplied with a Broadband covered area polygon.  In 

this case, we found the segments within covered areas and eliminated those segments inside of Blocks 

less than or equal to 2.00 square miles. 

Because there was more control over the format of the inputs (we knew we had a boundary and were 

working with TIGER segments), this was an automated process that followed this general format: 

1. Select large covered Blocks by provider ID (from updated Large Block table) 
2. Select TIGER 2010 road segments (MTFCC like 'S%') that face (CB = CBLeft2010 or CB = 

CBRight2010) covered large Blocks for provider 
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4. Select segments as distinct records, max speed with corresponding technology, join in 
feature names, export selected records to temporary DBMS table  

5. Join TIGER roads feature class to temporary table on TLID 
6. Select covered segments (Python script)  
7. Select service area polygons for provider 
8. Clip selected facing segments with selected service area 
9. Export clipped segments to staging feature class, keyed by providerID 

In this figure, orange represents covered small Blocks; black lines are covered segments in large Census 

Blocks (light blue).  The service area boundary is shown in grey. Based upon feedback from providers, we 

have elected to clip segments at the end of a coverage boundary.17 

 

Figure 15-Output of the Segment Process 

Wireless Coverage Process 

In general, most providers of mobile Broadband submitted coverage information in a NOFA-compliant 

format.  Other than attributions for spectrum and speed, little was done to this coverage.18 

                                                           
17

 An outcome not discussed here is how to handle address ranges on segments.  As NTIA is asking for a Min and 
Max on the segment, deriving theses values for clipped segments is very problematic.  Also the prevalence of 
alphabetic characters in addresses makes the min/max selections very arbitrary.  We are grateful that addresses 
are nullable data elements. 
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LinkAMERICA continues to make aggressive efforts to bring additional WISP coverage into the NTIA 

dataset.  For the most part, our outreach was with providers who were unable to supply sufficiently 

granular data in the past or those that could only submit wireless address points which is no longer a 

valid submission format. 

In Round 4 fixed wireless providers generally either supplied coverage information or infrastructure 

from which coverage estimates could be derived.  Many allowed us to use their tower locations, 

antenna heights and direction/spread of coverage to derive a line of sight coverage estimate.  In our 

experience, this is a conservative and reasonable derivation of coverage. 

Some wireless providers submitted RF studies.  When this was done, there was a request that the signal 

strength be removed from coverage data.  The request was honored.  

Other fixed providers were able to supply us with hand drawn maps or polygons/polylines drawn in 

Google Earth format.  In these cases we did our best to georeference and verify the coverage areas with 

the WISP. 

When we received coverage information in KML format, like the image below, we accepted the data as 

it was presented to us.   

 
                                                                                                                                                                                           
18

 Some polygon data did exceed the node count threshold.  In these cases, data was rasterized to 100m cells and 
then converted back to polygons.  The polygons were dissolved to multi-part geometry.  This addressed the node 
count concern. 
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As the image above shows, in some cases we were provided hand-drawn coverage, as well as 

infrastructure.  Instead of estimating their coverage using a line of sight or RF study, we elected to stick 

with the provider’s supplied information.  Our decision was guided by two primary factors: 

 If the provider is advertising using this coverage they must have specific confidence in its 

accuracy. 

 If the provider can supply coverage, as well as infrastructure that reasonably supports the 

coverage, there is a very high likelihood in the accuracy of the information.   

The downside, of course, is the polygon shown on the map may not represent our notion of how 

wireless coverage should appear.  

In general we note several interesting trends in the wireless data.  First, we can be successful in 

increasing the amount of WISP coverage when we aggressively pursue WISPs.  This means we have to be 

willing to accept data on their terms and convey it into SBI formats.  Some of our WISP submissions have 

taken over 12 hours to normalize into SBI formats.  Second, we have to accept that some WISPs will not 

be able to supply FRNs.  There remains a minority of WISP providers who are not aware of the FCC FRN.  

Third, there appears to be some variation on how the NOFA coverage definition is met.  In other words, 

there seems to be a disparity on the necessary strength (e.g. -80 dB, -98 db, -120 dB, etc) to provide the 

appropriate quality of service for data services.  Fourth, it was very difficult getting providers to identify 

spectra used for Broadband data services19.  We are unsure if this is a competitive concern, or if the 

same coverage pattern is yielded for multiple frequencies.  Typically, the spectra returned were those 

that a provider was licensed for.  At this point, we have no reliable way to locally determine what set of 

frequencies are used to provide Broadband data services in a local area. 

Service Address Point Process 

A handful of providers have requested that customer level, service address point data be submitted to 

NTIA.  In these circumstances we have done minimal processing to preserve the provider’s intent with 

this deliverable and not bias downstream NTIA use. 

Our verification included checks against commercial or Public Utility/Public Service Commission 

exchange boundary maps.  Points not contained within one mile of a boundary are not submitted to 

NTIA.   The percentage of excluded data variesacross providers. 

We retain from the provider the provided latitude and longitude, as well as Census block.  For some 

coverage data, if a provider is unable to supply a longitude, latitude or Census block, we fill in these 

attributes.  In those circumstances where we do not have a Census block, but we do have a longitude 

                                                           
19 One provider responded by email, “This mapping program is to provide the coverage area for 

Broadband provided by a company. Not to keep a detailed account of every aspect of a companies (sic) 

network.” 
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and latitude, we accept the given longitude and latitude and use that as the basis for our Census block 

assignment. 

With point data we have tested for comparable geocoding success rates but do not overwrite provider 

information.20  From this type of analysis we note the amount (usually little more than 10%) of 

addresses that seem to locate with less than street segment certainty.  Deriving a thematic 

representation of the points on speed also illustrates some of the locational certainty issues in this point 

level data.   

Coverage Estimation Process 

Although the derivation of Broadband coverage into Census Blocks, street segments, or wireless 

coverage files is, in itself, a bit of an estimation process, there was an explicit estimation process 

required in cases where a Broadband provider either refused to participate in our survey, or provided 

such a threadbare submission that no carrier-based coverage information could be gleaned21.   

We typically resorted to three possible estimation paths. 

For Cable (HFC) providers who did not provide any coverage information, we fell back to Media Prints 

data.  Rather than using the entire Census Block Group gathered by Media Prints, we used only those 

Census Designated Places carrying the same or similar names to the Media Prints p_com field.  Our 

reasoning was that Cable systems tend to be franchised on a municipal or at least administrative basis 

so the coverage will likely follow a governmental boundary.  As a general rule, cable infrastructure is not 

available in the public domain22 and what could be found was poor in quality and difficult to ascertain 

for validity.  

For DSL providers who did not provide any coverage information, we estimated road-based coverage 

from their Central Offices23.  We only used Central Offices that showed evidence of DSL or fiber-based 

services in the NECA 4 tariff.  Road-based engineering areas were derived via ESRI Network Analyst to 

18kft.  These segments/boundaries were clipped to commercial wirecenter boundary edges.   

For mobile Broadband providers who were non-responsive to our requests, we fell back to American 

Roamer coverage patterns.  We generalized the American Roamer coverage to ½ km in order to protect 

the licensed information. 

For fixed wireless providers who provided no coverage information, we relied on their public websites to 

derive coverage maps.  When these maps were available, we georeferenced them and tried to use the 

                                                           
20

 We will make a second geocoding pass on locations with no longitude or latitude from provider.  We typically 
pick up ~5% from our second geocoding pass.  Typically the issue is address quality but also difficulties in 
geocoding in very rural areas. 
21

 We report estimated submissions to NTIA as a non-responsive provider but we have data in the submission for 
them.  This is the reason for datapackage.xls entries which are non responsive but contain submitted data. 
22

 The team tried to use data from the FCC Coals system and 321/325 fillings but this seemed to be a bit non-
uniform in quality. 
23

 Central Office location was derived from MapInfo ExchangeInfo Professional.  Wirecenter boundaries also came 
from this commercial product. 
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outer polygon boundary to represent their serving area.  In other cases, when only a tower could be 

provided, we used a view shed analysis and estimated coverage at 10mi per tower24.  Because much 

wireless propagation is driven far below the Census Block and much engineering information isn’t 

known (frequency in use, polarization of the signal, coverage pattern of antenna(s), local terrain/land 

cover) this was the most complicated group to estimate.   

Speed 

Speed attributes are reported both at the block (typical) and higher levels (maximum advertised and 

subscriber weighted).  We note that in many cases, providers did not supply typical or subscriber-

weighted speeds.  In some cases, it appears--although we cannot verify--that their maximum advertised 

speeds were used to populate typical speed columns. 

We do have limited testing data on reported speeds, but we have been careful to not use our typical 

reported values with carrier-provided information.  If we do not have a speed value from a provider, we 

report an empty value.   

Several service providers claim they do not have data on typical speeds available, but estimate a 20% 

overhead factor between the advertised speed and what may be experienced by an end user. 

We continue to request advertised speed at the block level.  Nevertheless we appear to be getting 

speeds that do not vary over a large geographic area – leading us to believe that providers may still be 

submitting the maximum speed advertised in local media for the entire market.  For the most part, we 

have been unsuccessful in messaging that advertised speed should not correspond to a market area, but 

instead, the maximum speed, which can be provided to a household—what some may describe as a 

‘qualified speed.’25 

As a general rule, in circumstances where a provider supplies a range of speed attributes, we assign 

NTIA categories based upon the midpoint of the range. We follow this rule unless we can determine 

other grantees are handling the same submitted information differently. 

To support NTIA program office requests, we have also modified the structure of the Service Overview 

table.  Even if Maximum Advertised Speed is supplied at the market or county level, we push that speed 

down to the contained Blocks.  The only records that remain in this table, will be those wireline records 

with either a non NULL nominal weighted speed or ARPU value. 

                                                           
24

 In some cases we had an approximate radius of coverage but no height.  In this case we used a 50’ height 
estimate and then clipped the coverage to the provided coverage range.  We also clipped wireless coverage to 
honor state boundaries but did not look for providers serving coverage with out of study state facilities. 
25

 As an example of a response to our request for Block level advertised speeds, we received the following 
comment from one anonymous provider, “This is and of itself does not require anything new of us – just states the 
NTIA supports efforts focused on getting that information on the CB level.”  It would be helpful to have broader 
messaging so that providers understand this new direction.  
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Community Anchor Institutions 
In the first submission, the Community Anchor Institution (CAI) process was referred to in terms of a 

learning curve.  This continues to be an appropriate metaphor.  The mapping team continues to focus on 

data that will support and help inform policy makers and the SBI planning process. 

In the first submission, the team gathered information on what data was available and what resources 

will be required to engage these categories of important institutions.  In the second submission we 

continued to obtain additional connectivity information.  For the Spring 2011 collection, the team began 

a survey process to directly engage these important organizations.  As the October 2011 submission 

represents a transitional phase, much of the CAI effort encompassed getting this dataset stabilized for 

work outside the LinkAMERICA team.26   

 In the current submission we worked to achieve four goals 

1) Modify the source data so as to no longer pass NTIA any connectivity estimates 

2) Propagate administrative capabilities in our Community Anchor Verification System (CAVS) systems to 

the Regional Planning Teams 

3) Verify the available connectivity information based upon new survey information 

4) Update the Federal record identifiers (NCES codes, etc). 

CAI Philosophy 

Our work with CAIs is guided by three principles. 

First, CAIs are important stakeholders within the planning process.  Our goal is to engage participants in 

regional planning that have strong ties into the CAI categories identified by NTIA.  This has a direct 

benefit of engaging an established stakeholder community.   It also allows Broadband planning to tie 

into existing organizational and planning networks.  In each of our states, key relationships with 

education, public safety, libraries, and economic development sectors are being identified and 

developed. 

Second, we believe that CAIs will likely be one of the primary beneficiaries of targeted Broadband 

funding.  Our belief stems from the sense that many of the benefits of Broadband will extend from these 

community ‘anchor points’.  In other words, it isn’t solely the existence of Broadband at a library that 

provides a benefit.  It is people using applications that work only on a Broadband network to upgrade 

their skills (e.g., online training) and gain access to online content (e.g., job postings, goods and 

services), etc.  The targeted use of a specific application--that can only take place with Broadband 

networks-- is what produces the priority benefit.  Put another way, there seems to be a realization that 

                                                           
26

 LinkAMERICA began transitioning the CAI data collection effort in the state of Alabama to ConnectingALABAMA 
in Round 3.   For Round 4 ConnectingALABAMA assumed full responsibility for the CAI data collection effort in 
Alabama.  To facilitate the reporting process, the ConnectingALABAMA team continued to use the Community 
Anchor Verification System (CAVS) to store CAI data collected or modified.  CostQuest maintained responsibility for 
the CAI data submission for Alabama for round 4. 



SBI Mapping Methodology Page 41 
 

things are less about pure connectivity (for the sake of connectivity) than about connectivity in terms of 

an application (for the sake of the benefit obtained through the application). 

Third, we continue to use a rational and targeted approach to derive information.  This means we will 

utilize our planning teams for as much ground work as possible.  This also means that a goal of our CAI 

process is not an exhaustive Census of anything that could be a CAI; rather, it is the discovery, inventory 

and integration of Broadband planning activities into those CAIs that stand to produce the greatest 

synergies with the SBI planning process.   

The above implies two significant points.  First, the team’s goal is to document community anchor 

institution connectivity within a broader context of regional and statewide planning objectives.  Second, 

if a particular category of CAI has an independent Broadband planning effort underway, we will 

encourage that organization to take the lead, and we will provide relevant expertise and support as 

warranted.  For example, in one of our states, the public safety community is already engaged in a 

mobile Broadband survey effort.  We have aligned our CAI data collection process with that effort and 

are sharing information and expertise (e.g., hosting a survey) to support their mission.  In another state 

we are attempting to glean connectivity information from a municipal government survey.  There may 

be some downside to this collaborative approach in that we may have to work with data spanning 

different times or we may not have all of the location-specific information we need, but this does 

prevent the same user from receiving multiple inquiries. 

 

Anchor Institution Survey  
During the third submission period we designed and developed a simple on-line survey system called 

CAVS (Community Anchor Verification Survey).  The intent of the survey was to both verify received 

connectivity information and garner additional connectivity information from CAIs.  For round 4 we 

continued the use of the on-line survey process.    Although we have found that reaching out to central 

contacts, for specific institution groups, is the most fruitful way of collecting connectivity data we find 

value in inviting individual anchor institutions to participate through means of a survey.  From our 

perspective this approach gives the individual institutions an opportunity to become engaged in the 

broadband planning process.  The link for the survey is housed on the Home Page of the website 

developed for each state, thus providing the added opportunity for responding institutions to learn 

more about activities  in their state.   

The survey remains open between collection periods to provide opportunity for the Regional Planning 

Teams to update information as they engage with the community and to allow responding institutions 

to update their data as necessary.   
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Anchor Institution Trends  
At this point we have focused our CAI attention on schools and libraries, with respect to connectivity.  

We benefit from strong relationships throughout the education sector (K-12 and Post-Secondary).  We 

have also found excellent resources within State librarians in all States. 

To supplement the education and library information we have formed organizational relationships with 

the major hospital associations within each state.  Our goal with this relationship is to cull information 

from their planning process.  We continue to formalize/advance this relationship.   

As in the prior submissions, we rely on public domain sources of information for the public safety-

category .  Collecting connectivity data for this group continues to be one of our most significant 

challenges.  Our hope is that in subsequent submissions, we will reduce the size of this category and 

connectivity information specific to root nodes of the public safety network--such as County Emergency 

Operation Centers.27  At this point we have had minimal success gaining this information. 

Because we have a wide ranging population of CAIs in our data set we have a variety of Broadband 

services that don’t always fit NOFA parameters.  Services like PRI or T1 are classified into “other copper,” 

We also had difficulty obtaining both the upstream and downstream channel capacities.  In most 

instances, when it was logical to do so, we made the speeds symmetrical, but this is an assumption on 

our part.    If a site records bandwidth across several services (eg. video and data), we record the total 

bandwidth to give a picture of available site bandwidth.  We are also working to standardize our 

response to NTIA in circumstances where an entity shares a Broadband connection among a campus 

which is fiber fed.  In this case we use the total campus bandwidth and use the primary campus Internet 

connection. 

As a final verification step, we attempt to screen the CAI data for duplicate values.  Because many CAI 

are closely clustered together we perform the de-duplication based upon the ANCHORNAME within the 

ZIP5. 

Middle Mile 
Middle Mile information was collected directly from providers via survey or interview.  Middle Mile is a 

“chicken or egg” type of challenge in that it is possible to verify that the infrastructure exists, but 

extremely difficult to know what is the site is doing without engineering level assistance.  Although most 

providers submitted “something,” there was a significant variance in what that “something” 

represented.   

The purpose of this section is to record some of the comments and questions we have received about 

Middle Mile.  We hope this provides better context for our data submission. 

                                                           
27

 Within the public safety category, it is also very difficult to derive precise locations as many CAI are addressed to 
PO boxes. 
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Within the NOFA, Middle Mile was defined as (a) a service provider’s network elements (or segments) 

or (b) between a service provider’s network and another provider’s network, including the Internet 

backbone. (Collectively, (a) and (b) are “middle-mile and backbone interconnection points.”)28 

Given the existence of the “or” in this definition, providers submitted a variety of information.  Based 

upon the NOFA example, several fixed wireless providers interpreted Middle Mile in terms of the 

connection points from their towers to their own serving backhaul location.  The topology was 

commonly Microwave from their distribution towers to their NOC.  The NOC and towers were listed as 

the Middle Mile points. This seems to be consistent with the first definition clause (a). 

Telephone, Mobile Wireless, and Cable providers tended to remain either silent on the question, or 

would provide a single location in which Internet peering occurred (clause b).  A number of participants 

explained that the NOFA was quite ambiguous with data traffic moving back and forth over both TDM 

and IP networks--it was unclear where the distinction should be drawn.  As a general rule it seemed like 

many providers listed a single location where Internet Peering occurred. 

A number of providers refused to answer the question on grounds of confidentiality29.  Others would not 

disclose as their Middle Mile points are not owned--another company provides the physical and 

electronic connection to their network.  In other words, the entity providing Broadband is not the entity 

providing Middle Mile. 

Additionally, based upon the new Provider Type classification of “other,” we have started to integrate 

points provided by Broadband service providers not meeting the NOFA definition.  This includes POP 

locations and aggregation points for public / private networks.30 Within a given submission there were 

two final attributes that tended to concern respondents.  First, speed should be measured in terms of 

only data capacity and what exactly is “data” (e.g., can/should you segregate out voice or video), and is 

the relevant capacity of the physical connection, channelized to a specific virtual circuit on their 

network.   

Finally, a number of other providers were unsure of the height above grade measure (is this their floor, 

the street outside, etc).  We seem to have a combination of height above or below grade, as well as 

heights above mean sea level (AMSL).   

To the extent possible in our timeframe, we verified the location of a sample of Middle Mile points.  

Where we could see infrastructure that appeared to be consistent in location with other provider 

                                                           
28

 From http://broadbandusa.gov/files/BroadbandMappingNOFA(FederalRegisterVersion).pdf at 54, visited March 
28, 2010 
29  As received in email 9/30/10, “Due to security concerns and the risk of public disclosure of highly sensitive data, 

whether inadvertent or otherwise, ***REDACT***response to the Middle Mile and backbone interconnection 

request is limited to publicly available information available on {remainder not included}” 

 
30

 As discussed in our readme.txt file, a number of middle mile points were lost in validation due to their location in 
adjacent state.  This will cause a decrease in some providers relative to prior submission. 

http://broadbandusa.gov/files/BroadbandMappingNOFA(FederalRegisterVersion).pdf
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infrastructure, we felt that the location was accurate.  In some cases, the point provided seems sensible 

(is on a road, near other equipment), but using imagery, we couldn’t find a place where this type of 

connection could occur.  This wouldn’t be unforeseen, in that Middle Mile connectivity likely takes place 

in a protected environment much smaller than a standard Central Office installation.  

Mobile Wireless Coverage 
We have received mobile wireless coverage from most mobile Broadband providers in each state.  At 

this point we have cleaned the geometry of the data and attributed it with spectra and FRN as required. 

Provider derived coverage has been reviewed against the commercial licensed product for consistency.  

To a limited extent we also use licensing locations and tower infrastructure to spot-check supplied 

coverage.  This mode of verification remains complex, given the lack of facility-based information with 

mobile wireless. 

Finally with respect to mobile Broadband services, we note several trends. 

First LinkAMERICA used the NTIA supplied frequency tables to report speeds consistent with other 

grantees.  In circumstances where a provider supplied a range of experienced speeds, we used the 

portion of the range consistent with the most frequently reported Grantee value. 

Second where a provider reports multiple frequency bands in use but doesn’t distinguish these bands by 

submitted SHP file, we submit identical geometries but attribute one geometry to each submitted 

spectrum value. 

Third we are seeing a trend toward increasing Broadband speed.  As of this writing, there is not 

consistency across providers in how they attribute the advertised 4G speed values.  In other words, for 

some providers 4G means advertised speed categories increase.  For other providers, the speed value 

did not change. 

Verification 
Almost by definition, data verification is an ongoing and evolving process. Clearly, with each new data 

submission there will be a validation process at hand and at the same time, our team continues to 

expand and improve the efficiency and effectiveness our data verification routines. Consistent with the 

movement toward an fGDB export database and use of a data receipt script, much of our validation 

effort was spent in supporting the ETL processes into the required formats.  In future data submissions 

we will continue our work to stabilize and improve the business process that normalizes provider 

submissions into NOFA formats and expands in more depth on the confidence analysis within the data.  

Verification Standard 
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Our overall verification standard is focused on the level at which we supply processed data to NTIA.  This 

means that the vast majority of our verification process will be focused on ascertaining coverage for 

Census block’s less than 2 square miles and covered road segments. 

We are learning that Verification has multiple dimensions. 

Provider verification is finding providers who supply Broadband and discriminate out providers not 

meeting Technical Appendix A’s definition of Broadband.  

Identity verification is taking the provider’s categorized in the first step and ensuring that the provider 

either has a valid FRN or is assigned a default FRN.  Identity verification is very complicated because of 

the Technical Appendix A’s mandate to record data at the FRN, provider Name and DBA level.  Each of 

these attributes could be unique for a single provider going to market under different or the same 

names.  As a result, rolling up each provider into an identity collection that matches either the FCC data 

integration team or a third party Broadband provider’s data view, is very, very time intensive.  Identity 

verification is discussed in the earlier section-- Developing the provider List. 

Coverage verification is a broad term, but in our definition it boils down to determining if Broadband 

coverage is in the right place.  For a given provider, the question is whether the coverage is assigned to 

appropriate Census Blocks, road segments or area features.  Coverage verification can be further broken 

out into two distinct classes: 

 Technology verification, which is determining if the provider is listed with a technology 

consistent with their marketing information.   

 Speed verification, which is determining if the speed supplied for that block, road segment, 

point area file or market area is consistent with the technology and the marketing information 

received. 

The final verification dimension is consumer feedback and crowd-source verification.  This is a dynamic 

set of steps we are beginning to implement.  One side of this is responding to consumer concerns.  The 

second is using the crowd sourced data to validate provider claims and, if appropriate, update the map 

and the underlying data. 

At this stage, our working hypothesis (confirmed by our experience) is that there will not be a single 

dispositive measure to indicate Broadband coverage availability in a Census block or along a segment.  

From prior work, and examining our current provider submissions, we believe that there is too much 

variation below the submitted record to make a single binary yes/no indication.  Rather, there will be a 

series of measures that combine to provide qualitative confidence (a classification scheme) in our 

indication of Broadband availability at the block, segment, or wireless polygon level. We believe such a 

qualitative confidence scheme is both relevant to and supportive of NTIA interests, as well as the 

interests of our end-user community – that is, the states and citizens we serve through this program. 
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The intent of this section is to illustrate why we are moving toward a particular verification 

methodology.  Our team is learning as we go along, and will adjust and improve this thinking. But given 

our experience to date, this is where we are heading. As stated above: 

 First, coverage verification is at the level of data submitted to NTIA. 

 Second, coverage verification is enhanced when there is a secondary measure of availability 

(such as infrastructure presence or serving area boundaries) 

 Third, given the limited resources of this effort, the most important coverage verification 

process to implement is the erroneous dispersion of coverage.  These are the “islands” of 

coverage isolated by significant distance from other covered areas.  .  In other words, Broadband 

Internet likely doesn’t exist far away from other areas with Broadband Internet access. 

Before explaining our overall verification thought process, we have several examples, which illustrate 

the complexity of coverage verification. 

The first example is taken from a gentleman who requested a map change in Alabama.  His home is near 

the yellow dot.  The darker grey Blocks are covered Census Blocks.  The black lines are covered road 

segments.  He cannot receive DSL from his incumbent provider, although his neighbors can.  The 

incumbent carrier does have at least one structure in that block from which Broadband services can be 

provided; unfortunately his home is not served.   

 

Figure 16--Sub block variation 
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Because the SBI program requires the depiction of coverage at the block level, the above map has been 

correctly generated.  However, from the customer’s point of view, the map is inaccurate.  This requires 

us to explain that the maps are not intended to be a structure-level qualification, at which point some 

consumers question the value of the maps when seeking service information.  Of course, we also share 

this information with the incumbent carrier in the area so they are aware of a potential customer 

market. 

Beyond this type of one-off structure-level qualification, sometimes, as shown below, we have even 

larger gaps in provided coverage.  The image here shows an “outlier” block that could be an error, or it 

could indicate missing Blocks along a major road that should have been filled in.  In this figure, the 

outlier block is highlighted in turquoise. 

 

Figure 17--Dispersion in Submitted Data 

 

In this particular case, we are faced with a different verification question.  Based upon the properties of 

the neighbors, we believe this block should likely be covered (coverage interpolation,) but supplied data 

from the incumbent says otherwise.  

The next example shows where an interpolation process could require some adjustment.  The figure 

below shows a town level.  There are some smaller Blocks that are likely covered by interpolation logic, 

but we also do not want to extend coverage beyond a franchise boundary as in the areas shown in a box 

on the bottom of the map. 
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Figure 18-Where do you stop interpolating? 

From what we can gather from some providers, the submitted data—data with consistently high 

degrees of dispersion or coverage holes—tends to come from geocoded billing records.  In this 

paradigm, this means where there are no customers; service is not identified on a map.  The 

interpolation verification question then takes on two dimensions. 

First, if a provider has no customers in an area, how can we know if they would be able to 

provide service in a 7-10 day interval? 

Second, if we use the properties of neighboring Blocks to interpolate coverage, when should we 

stop (e.g., at a franchise boundary, at a certain distance, etc.)? 

We continue to work with providers to get additional information to help us better understand and 

contend with this type of circumstance.  However, we have not been entirely successful at getting 

franchise boundaries that would address much of the issue. 

The final map shows this dispersion problem, but to an even larger degree.  This solitary large block is 

likely the result of a bad geocode, but we don’t know, given the data that has been submitted by the 

provider and the “single customer in a block standard” set by the NOFA clarification. 
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Figure 19-Dispersion in covered Blocks 

Due to the fact that this situation is quite obvious in display, this type of problem is one that we are 

more aggressively trying to resolve.  Where a single block has no neighbor offering comparable coverage 

and is a specified distance beyond an exchange boundary, our approach has been to filter these Blocks 

out.  As of now, this filter is limited to incumbent DSL providers because we have a good source of 

exchange boundaries.   

The exchange boundary dispersion verification method breaks down when examining smaller providers 

who are more likely to CLEC into neighboring territory. In the figure below, the black line represents the 

exchange boundary, while the continuity in the DSLAMs likely points to coverage extending along a road 

into another provider’s territory. 

 

Figure 20--DSL Coverage outside of exchange boundary 

 



SBI Mapping Methodology Page 50 
 

In sum, the variability in our source data continues to suggest that our dynamic verification process is 

relevant, appropriate and evolving in a manner consistent with the overall program.  And, as noted 

above, we believe the more meaningful outcome of our verification processes will likely be a series of 

qualitative indicators or expressed confidence levels.  Our concern, as with the development of any sort 

of classification process, is how rigid we should make this classification given the variation in our input 

data and the varied perceptions of service providers, map viewers and down-stream data consumers.   

Verification Work Process 
To support our dynamic multi-factor verification process, we have implemented the following steps. 

First, when data is received, an analyst reviews the submission and any immediate questions or 

concerns are sent back to the provider as quickly as possible.  We have found this gatekeeping step very 

helpful in making sure we understand the intent of the submission.   

Second, for all providers who submitted data to us in the third round, they received both a tabular data 

summary and mapped output31.  Prior to releasing the “check maps” to providers, we had a team of 

analysts visually inspect each provider’s coverage area.  The focus on this QC effort has been to identify 

and flag suspect Blocks.  After this in-house review, we solicited a second level of feedback from 

providers and received a number of requested changes and corrections used in the development of the 

October, 2011 round 4 dataset. 

For those providers who submit only block or segment level coverage (i.e., in those cases where we have 

no infrastructure to test with) we test for coverage containment within known service boundaries.  The 

intent of this validation step is to remove Blocks that are obviously erroneous.  We also verify the 

submitted speeds against the typical speed ranges in the NTIA frequency tables.  If we note a value 

outside of typical range, we ask the provider for clarification. 

As mentioned in the sections above, we have implemented a check on dispersed Blocks, but we have 

implemented less with respect to coverage interpolation (holes in coverage). We continue to work on a 

series of mechanical tools to assist with the inspection process but have run into challenges related to 

geographic basemap and timing. 

As our submissions have moved online, we have also begun to benefit from crowd source feedback.  In 

some cases this has helped us identify and fix errors in our underlying data. In other cases, as we have 

shared with NTIA, we have encountered some perceptual issues rooted in how the data are developed 

and modeled to comply with the NOFA.  Depiction of uniform coverage in small Census Blocks continues 

to be a challenge. Despite our best efforts to explain the full block coverage requirement, we continue 

to receive complaints that the coverage shown on the map is not accurate for a particular location 

within that block.  

                                                           
31

 For the verification of round 3 data, we submitted both PDF and KMZ (Google Earth) format check maps.  Some 
providers prefer to work with the Google format as it supports easier modification.  Others continue to submit 
marked up PDFs. 
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Consumer and Provider Responses to Deliverables 
Here, we segue from internal verification to external verification.  We view responses to our work 

product as a form of validation and verification.  On the one hand, this gives us the opportunity to fix 

mistakes and then generate QA steps to make sure that the problem does not reoccur.  We also learn 

how to improve what we are doing or better explain what we are doing to a community not always 

familiar with the NOFA and program office framework.  On the other hand, listening and learning from 

this feedback helps us better target our mapping deliverable to meet the needs of our external 

customers.  In this second case, external feedback not only provides feedback on perceived qualities (or 

lack of quality) in the data, it helps us to learn if we are developing data that is truly helpful to 

downstream users. 

At this point, our external deliverables take three forms: State Broadband Maps, data transfer to NTIA 

used for the National Broadband Map, and text format data requested by outside parties. 

Online Map Experiences 

With our State maps are online, we continue to harvest viewer feedback and comments.  Because an 

online map allows someone to zoom in far below the scale of the data, a large number of comments 

reflect sub-Census block concerns. While important to the citizens reporting these issues and to our 

Broadband planning teams, this level of data is outside the scope of our core validation process, which 

as noted above, is focused on the level of data submitted to NTIA.  

There are several other themes that our team believes are important to share.  These comments are 

actually quite helpful because they also improve our data processes to better meet the needs of map 

viewers.  For example, we have invested significant time in harvesting more segments from provider 

data.  Because the appearance of segments is so important, we are putting time into ensuring a visually 

appropriate edge match between the roads we harvest and the Blocks/roads we will show online.  On a 

technical level, we also believe that a good segment process will help us understand more about 

dispersion in the data, and what is valid versus what is not valid. 

Online Display of Consumer Feedback 

We have completed development of a consumer feedback layer for our online maps. 

The intent of the new layer is to show viewers the feedback of other map viewers.  We anticipate the 

feedback layer will go live when the Round 4 data is posted on our state maps.  We expect this to be 

prior to the end of October, 2011. 
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Figure 21--Consumer Feedback Layer 

To gather feedback, we use a survey wizard which asks the end users to categorize their concerns.  The 

survey went through several iterations of design and usability testing.  Our experience has been unless 

we get a way to constrain the user feedback into manageable categories, it becomes very difficult to act 

upon. 
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As mentioned by other Grantees we struggle with how to use all of the feedback we receive.  The 

qualified data points seem to fall below a volume in which we can infer significant modifications to the 

map data. Nevertheless, we believe it is important to gather structure and display the feedback  to 

support project transparency.   

Perception of Unfair Treatment Across Technologies 

Several Broadband service providers have expressed strong concerns regarding how wireline services 

are displayed, as contrasted to how wireless coverage is displayed.  This is an artifact of the SBI data 

model. As an example, consider the figure below. 
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Figure 22--Multi Network Coverage portrayal 

In this image, covered Census Blocks are light gold.  Covered road segments are a darker gold and 

wireless coverage is purple.  The concern seems to come down to how a wireline provider’s coverage is 

shown in the large Census Blocks (greater than 2.0 sq mi).  Some wireline providers have expressed 

dissatisfaction because their coverage is only tied to road geography, which leads to a visual “hole” in 

their coverage map.  At the same time, they feel that it is unfair that the wireless provider’s coverage is 

shown to be uniform in the same area.  Put another way, if our maps show wireline in terms of Blocks 

and segments, why don’t our maps show wireless the same way?  

 Perceptions of Carrier of Last Resort (COLR) Obligations 

Some wireline providers have also expressed dissatisfaction because online maps limit the distance of 

coverage from a road segment.  In our current online maps we buffer a wireline carrier’s service 300’ 

from road centerline.  A number of providers have expressed that they are mandated to provide voice 

coverage (which Broadband will accompany) anywhere in the Exchange.  There seem to be many 

dimensions to this argument, but the basic concern comes down to not being able to accurately reflect 

the scope of their COLR obligation within the mixed block/segment view.  Their ability (or lack thereof) 

to actually provision such services for new users within a 7-10 day period adds yet another level of 

complexity when attempting to fairly portray their coverage capabilities. 
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Intentions of Coverage Mapping 

When a viewer of an online map clicks on the map (or zooms to an address), they are provided with a 

pop-up of service provider coverage in the area.  The critical question is this: what is the area to which 

that pop-up window responds to?  In the past, we reported back to the specific Census block, or 

buffered road segment intersected by the user click.  As far as the map was concerned, once we move 

off of that road, or out of that segment, we have a new area to examine.   

Our sense, given feedback received, is that our provider view should be a bit more tilted toward finding 

providers in a general area, rather than finding providers at a single-click location.  If the goal of the map 

is to get someone to call a provider for service, our bias should be to include all of the potential 

providers in the general area, rather than giving potential customers a method to self-disqualify.  That is, 

we want to cast a wider coverage net, rather than one too narrow.  The problem with this approach is 

that it will create a number of false positive Broadband reports.  As of this date we cannot determine if 

the claims of inaccurate coverage in online maps are due to the looser provider view standard or not.  

We keep this looser standard in place to minimize the likelihood of self-disqualifications. 

CAI Survey Fatigue 

We are beginning to note an increase in survey fatigue among CAIs.  Sometimes, as part of a direct 

survey process an end user will tell us how unhappy they are with the repeated Broadband survey 

efforts.  Within several states BTOP grants are in effect that also survey Community Anchor Institutions.. 

As stated earlier we will defer to other Grantees when there are overlapping survey efforts. 
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Appendix One  

Data Collection Challenges 
This section summarizes some of the challenges we have experienced with data collection and 

processing.  The team believes it is important to categorize these challenges as they help inform the 

geoprocessing and verification methods used.  It is also our hope that some of the more global issues 

can be discussed and decided within the Grantee community.  

We begin with several global issues and then continue toward more granular challenges. 

Global Data Collection Issues 

Census Block and Road Standards are not clear 

We receive a variety of Census data.  Some were able to supply 2010 Census blocks.  Others continued 

to provide Census 2000.  Managing this set of heterogeneous inputs has proved to be a challenge. 

There seem to be several methods by which providers are calculating the Census block area.  So the 

distinction between at 2.00 square miles can be uniform, it would be ideal to articulate an operational 

area calculation definition as early as possible. 

Providers Not Wishing for Block Level Aggregation of Their Data 

Both ***REDACT*** have supplied address point level data.  Both carriers want NTIA to have the point 

level information, and they have asked CostQuest/LinkAMERICA not to aggregate their coverage to 

Blocks.  Other than a verification to make sure that point data were contained within, or fell within 1 

mile of exchange boundaries, the only other processing was normalization into NTIA formats. 

Broadband providers not Meeting the NOFA  “provider” Definition 

PBWorks appears to reflect a concern among a number of grantees about what a Broadband provider is-

-and how that definition impacts mapping. 

If the 7-10 day provisioning rule is to be strictly enforced, it would seem to eliminate a number of 

prominent Broadband providers32.  Further, the need for clarification around a facilities-based provider, 

versus the reseller, has injected even more ambiguity into the mix.  Right now we are unclear on how 

strictly to interpret either of these important distinctions, but we are concerned that we are beginning 

to create an NTIA exclusion criteria that is going to confuse downstream consumers of the data.   

                                                           
32

 By email ***REDACT*** informed us they could not provision in 7-10 days, but they also supply information on 
qualified locations to the address point level.  Therefore, we draw a distinction between an incumbent provider 
owning the facility--which terminates at a customer premise--who cannot turn up service at a qualified location, 
versus a provider not reporting any specific qualified locations in which they cannot turnup service in the 7-10 day 
window.  In the first case we have a sense of where service can be offered and verified.  In the second, we have no 
evidence that a service could exist there until a specific location becomes a customer. 
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Again, we do not want to exclude a service provider, but we believe there needs to be further 

clarification around the 7-10 day ”rule,” the definition of a “reseller,” and better interpretation of 

facility-based providers, versus equipping UNEs, SpA or leased lines. 

We have used the provider Type of ”Other” to classify a number of providers who offer Broadband 

services, but we do not offer them in a manner consistent with Technical Appendix A definitions. 

To What Extent Should We Begin “Classifying” the Data and Maps? 

The question immediately preceding gets to the intent of a Broadband provider.  This question gets to 

the intent of the Data and Maps. 

Earlier in this document we discussed the question of what type of bias we should introduce to our 

online map messaging.  In an online environment, do we want to more likely create an overstatement of 

coverage for a provider than an understatement?   In other words, is the larger problem allowing a 

consumer to self-disqualify, versus calling a number of neighboring providers?  There is a related issue 

to this.  Clearly in our maps there is a lot of scatter in data that we believe should be more continuous.  

These are the islands of coverage from an incumbent provider33.  There are a number of processes that 

could be put in place to deal with this type of scatter, but without more information from the service 

provider-- essentially the last mile facilities-- it will be difficult to perform this clean up in an informed 

manner.  On the one hand, we can aesthetically clean the maps up and reduce the scatter, but we have 

little sub-block engineering information upon which to make this decision.  Right now our preference is 

to put out a somewhat aesthetically messier deliverable and work with providers to get better 

information to clean their submission.  If that isn’t forthcoming, we are limited in what can be done 

given the lack of facility level information.  In summary this yields two questions 

1. In our online maps should we error on overstating coverage to prevent consumer self-

disqualification? 

2. In our online maps should we work to clean up a lot of the scatter that we see without having 

facility-based evidence from which to remove it? 

Granular Data Collection Issus 

Non-Uniform Submission Standards  

It is clear among providers that there isn’t a consistent method used to derive Broadband coverage.  

Some providers appear to be use a geocoding approach and then point in polygon or point on segment 

process.  Others may be using GPS locations.  In some cases, it is difficult to infer what reference data 

was used to georeference plant (is it the carrier’s roadbase?).  This leads to uncertainty regarding the 

input data scale or accuracy relative to other base layers.  Although we may be trading off absolute 

                                                           
33

 For a provider who sells opportunistically (not within a franchise area) it becomes even more problematic to 
classify their coverage because the points are more related to the type of consumer purchasing the service than a 
bounded offering.  In a matter of speaking, the ProviderType is more determined by the technology and/or 
location than a type of business.  The core intent of the NOFA and our grant application was centered around the 
7-10 day providers but we believe maintaining information on provider Type “Other” and  “Reseller” is important 
to assist in validation and market segment analysis as resources are available. 
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accuracy, our standard has been to conflate submitted data to TIGER 2010 Blocks and TIGER 2010 roads.  

We perform our verification against this conflated data product. 

Temporal 

We are unsure of how well the data are temporally consistent.  Some providers gave us their best effort 

to control to June 30, 2011. We note that some providers were clear that the submission was as of 

extract date without any way to move back in time.  They have no means to control for time and cannot 

provide any audit support beyond when the data are released to us.  Some data-especially loop 

qualification data-may change from day to day. It will be very difficult to clarify why something was 

changed from a given point in time. 

Perceived Inaccuracy with Respect to Internal Standards 

The NOFA is clear on submitting a list of Blocks in which a provider delivers Broadband service.  This is a 

different objective than perfectly reflecting service territories.  If a firm’s accuracy standard is a 

reflection of their service area, then the data created under the NOFA will not meet their perception of 

accuracy.  This leads to two other issues:  First, using Census Blocks rather than serving area may 

overstate or understate a particular provider’s Broadband serving area.  This was a significant concern of 

***REDACT*** who specifically required us to submit only address-level qualification data.  The second 

issue this brings up is how or if, there should be some standard on how much of a Census Block needs to 

be covered to call it covered.    

Confidentiality  

Several providers have noted concerns with CPNI-related issues and have stated this as a reason for 

non-participation.  We have also heard expressions of comparable concern regarding identifiable 

responses to Anchor Institution information. 

Unclear on Definitions  

As discussed earlier, several providers claimed confusion on several key terms involved in Middle Mile.  

We note a consistent stream of questions around the interpretation of Maximum Advertised Speed.  

Some providers understand this to be the most common speed package bought within the mass market, 

while others view this as a speed that can be purchased for an additional cost above a mass market 

offering (eg. a Turbo option for an additional fee per month).  Others interpret this as the fastest speed 

that is available for that particular location--in terms of xDSL, a structure qualified speed, for example.   

Perception of Data Use 

There seems to be some hesitancy releasing speed information because no one is sure of how the 

information will be used, or what the speed is intended to reflect.  A number of providers have verbally 

indicated that typical speed will be about (on average) 80% of purchased speed due to overhead.  But 

there are many other factors (such as a user’s home network) that influence speeds measures.  

Providers are concerned about introducing statistics without a clear understanding of how those 

statistics are derived and will then be used.  Also, as advertised speed is pushed down to a block level, 

we sense more trepidation to report speed values.  This quickly begins to touch on parity across network 

types (why is wireline down at the block when wireless is half the state, etc.).   Finally we note a 
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significant increase in speed reported to us.  This may be due to network upgrades or competitive 

concerns to match the theoretical network speed. 

Location Uncertainty In Source Data 

Within this document we have noted concerns about the impact of source data accuracy.  Our 

geoprocessing methodology provided what we believe is a relatively conservative tolerance to account 

for the scale issue in the source data, but we are unsure of how this may impact downstream users.  

Clearly, it also impacts the verification process because we can’t attempt to verify received data beyond 

a scale at which it was developed. 

Covered Segment Process 

Deriving those Broadband covered segments in Census Blocks greater than 2 square miles has proved to 

be a challenge.   Moving from a NOFA specified tabular deliverable to a requested  geographic 

deliverable also increases the complexity of the effort.   

Record Level Metadata 

It would be helpful to have one or two additional fields in each feature class transmitted to NTIA.  One 

User Defined field could be helpful as an expression of record level confidence.  The second field could 

be used as a Key between the transfer geodatabase and our systems.  Ideally, both fields could be large 

text fields (50 char) so the Grantee can use them to express a variety of attributes. 

Miscellaneous Data Collection Notes 

 We note the following important observations regarding our data submission: 

1. There are Middle Mile plant records for providers who are not present in the Census block, 

segment or wireless area feature classes.  This is due to classification as non-NOFA Broadband 

providers. 

2. In some cases, we have trimmed wireless coverage estimates to honor state boundaries. 

3. We believe some providers are trimming their coverage to honor license area boundaries. 

4. As a departure from past practice, where a provider submitted Middle Mile points out of state, 

we are no longer passing those points to NTIA as they fail the validation script.  We experienced 

validation errors for BroadbandServed=N records in the CAI table.  These records were 

attributed a Technology of Transfer=0.  This cleared validation. 

5. In tables with mandatory Street and Zip5 attributes(Service Address), if the value is unavailable 

it is filled with N/A. was not available, we have inserted ‘N/A 

6. As with submission three, there remains a tension between the Data Model, Data Model Default 

Values and the Python Validation Script.  As an example the data model allows a NULL for the 

Maximum Advertised speeds in a Census block record.  A default ‘zz’ is available for this 

condition as well but zz will fail the validation script.  In the case where we have data which is 

missing Maximum Advertised Speeds, we are holding that data back to prevent downstream 

validation problems. 

7. We have a significant amount of VDSL, ADSL 2 and ADSL 2+ coverage categorized into the xADSL 

category.  This introduces a variance in speed availability as some providers are using VDSL, 

shortened loops and/or pair bonding to increase speed over 10 Mbps. 
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8. We have left in the data Middle Mile locations with above grade elevations that appear to be 

unreasonable, given review of orthoimagery.  This seems to be confusion between above grade 

request and above sea level readings. 

9. All fGDB have passed validation except in cases where attributed speeds did not agree with 

domains associated with technology of transmission (eg Upstream Speed of 2 with ADSL).  We 

have modified the Python script to allow for conditions in the CAI table in which default data 

model values are disallowed in the Python submission script. 

10. We note a few providers who have speeds seemingly inconsistent with their technology of 

transmission.  This is either very low speeds with optical fiber, or very high speeds with non 

DOCSIS 3.0 systems.  We have verified on provider websites that the reported speeds are 

available in the area but these speeds will fall out of the NTIA frequency table analysis. 

11. We have a small number of providers who serve an area with both a residential and business 

speed tier.  In cases where we cannot distinguish which speed tier offering to use, we use the 

lower of the speed tiers. 

12. Per NTIA request we have modified the manner in which we handle Wireless coverage polygons.  

If a Provider submits a single geometry but specifies multiple spectrum codes in use in that 

polygon, we duplicate the polygon for each spectrum code.  In other words the geographic 

object is identical but the attribute data for the object is unique. 

13. In point level data submissions (Service Address and CAI) we note points that are spatially 

coincident.  With respect to Service Address points our thought is these represent multi-unit 

dwellings or businesses but we don’t have enough address detail to determine if these are 

multi-unit structures or duplicated customers.  Because we cannot determine the reason for the 

duplication we leave spatially coincident records in our submission.  We also leave in our CAI 

submission points which may be the same physical structure but have slight variations in 

addressing. 

14. In point level middle mile data, we are finding a variance in the quality of the geocoded 

longitude and latitude returned.  Given the data received we are unsure if this is an issue where 

the plant address is difficult to geocode or if the longitude and latitude provided to us  is 

different than what would be returned in geocoding. 

15. We note two important issues in our datapackage.xls.  First the number of records in the 

provider tab will not sum up to the total record count.  This is due to the requested grouping 

within the Excel table..  Second for estimated broadband coverage, we internally mark that 

coverage as an estimate but the provider is described as non-responsive within the 

datapackage.xls. 

16. We made one modification to the NTIA supplied verification script.  For the CAI layer we The 

query to check the TRANSTECH field now includes: "AND TRANSTECH <> -9999" 
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Appendix Two 
This appendix contains the confidentiality clarification supplied in a series of emails between CostQuest and NTIA. 

Feature Class Metadata NOFA 
Confidential? 

Online Map Public 
Disclosure 

Exemption 

Last Mile Constraints on accessing and using the data Yes No No None 

  Access constraints: None      

  Use constraints:       

  This data is confidential as defined in the 
NOFA. 

     

            

Middle Mile  Constraints on accessing and using the data Yes No No None 

  Access constraints: None      

  Use constraints:       

  This data is confidential as defined in the 
NOFA. 

     

            

Service Address Constraints on accessing and using the data No No Yes   

  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users.  

     

            

CAI Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 
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  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users.  

     

            

Census Block Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 

  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users. 

     

            

Service Overview Constraints on accessing and using the data No Yes Yes The only 
provider 
who may 
not show 
up this 
table is a 
provider 
who has 
provided 
only 
confidential 
data (last 
mile, 
Middle 
Mile, 
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address 
point with 
provider 
name) 

  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users. 

     

            

Road Segment Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 

  Access constraints: None.      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users. 

     

            

Wireless Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 

  Access constraints: None      

  Use constraints:       



SBI Mapping Methodology Page 64 
 

  There are no restrictions on distribution of 
the data by users 
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COVER LETTER 
 
 
October 2011   
 
 
Ms. Anne W. Neville 
SBDD Grant Program Director 
National Telecommunications and Information Administration 
U.S. Department of Commerce 
1401 Constitution Avenue, NW Room 4716 
Washington, DC  20230 
 
Dear Ms. Neville: 
 
Please accept this submission from the Partnership for a Connected Illinois (PCI), the Designated 
Entity for Illinois.  
 
These artifacts should be found to be compliant with the October 1, 2011, deadline for the semi-
annual data update and in accordance with the terms of the July 1, 2009, Notice of Funds 
Availability (NOFA) and all subsequent clarifications. 
 
This cycle, PCI continued its full responsibility for the data-collection activities from broadband 
providers in the State. Assuming this role is vital to achieve the State’s goals with regard to 
improving broadband access and adoption – and which are in turn central objectives of the 
Partnership for a Connected Illinois. All facets of this data-collection transition, and the activities 
that flowed from it, are included in the narrative that follows. 
 
If you have any questions about this Data Narrative, please do not hesitate to contact me, at 217-
816-4151. 
 
Respectfully submitted, 
 

 
 
Drew Clark 
Executive Director 
Partnership for a Connected Illinois, Inc. 
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INTRODUCTION 
 
The data submission cycle ending on October 1, 2011 marks the first round that PCI has held the 
full responsibility of data collection and publishing for the entirety of the six months.  In this round, 
PCI used creative new strategies in its outreach to the carriers.  PCI continued to establish Non-
Disclosure Agreements (NDAs) with broadband providers for confidential information. The data 
that accompanies this narrative contains edited data for 57 out of the 122 carriers included in the 
submission.  The census block data that accompanies this narrative has also undergone a conversion 
from 2000 to 2010 census blocks in accordance with regulations laid forth by the NTIA.  This round 
gave PCI the opportunity to refine its data verification process through the use of GeoPDF maps 
and third party data sources.  PCI also improved its Community Anchor Institution database 
through the use of Illinois e-Rate databases in the State.   
 
In this round, the Partnership for a Connected Illinois (PCI) took major steps in its three-fold 
mission to collect and publish broadband data, to ensure broadband access throughout the State, 
and to maximize broadband’s impact. Assuming this data collection role is vital to achieve the State’s 
goals with regard to improving broadband access and adoption.  PCI appreciates the assistance 
provided by NTIA as PCI improved its collection, processing, and verification of broadband data 
for submission according to NTIA standards.   
 
PCI has continued to refine the Broadband Illinois web site. This consumer-friendly interface allows 
for residents of the State to intuitively access the information collected by PCI – and provides the 
ability to “crowdsource” the collection of price information, actual speed data, and to let consumers 
verify the data provided by broadband providers. Since the last submission cycle that ended on April 
1, 2011, PCI has included a range of maps not previously available.  The Broadband Illinois website 
contains county-level GeoPDFs for each of Illinois’s 102 counties.  These maps can be downloaded 
and edited using the TerraGo Technologies toolbar, which will be explained in great depth in 
various parts of this narrative.   
 
This narrative will summarize the carrier outreach, the data production methods, carrier data 
verification, and the community anchor institution data.  It will conclude with an examination of the 
Broadband Illinois website and the ways in which PCI is publishing carrier data in a user-friendly 
manner that allows for feedback from the consumer, and a significant report, “Supply Broadband in 
Illinois:  A Statewide Baseline Inventory,” published on August 15, 2011. 

CARRIER OUTREACH 
 
From June 30 to July 9, 2011, all providers currently in the PCI census block and wireless layers 
were sent GeoPDFs that displayed their coverage area in the State of Illinois.  The GeoPDFs were 
fully editable by the provider using the TerraGo technologies’ toolbar.  As part of this e-mail, PCI 
requested that updated data be submitted to PCI for its Cycle 4 submission to the NTIA and for the 
update to the Illinois Broadband map.  For those providers who had not previously established a 
Non-Disclosure Agreement with PCI, a copy of PCI’s draft version accompanied these maps.   
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This entire outreach process was tracked on Salesforce, PCI’s content management tool.  As maps 
were created, distributed, and verified, fields were populated in Salesforce to denote that a map that 
met the approval of the provider had been created.  For those providers who did not respond to 
their initial map request, multiple follow-up e-mail and phone call attempts were made.  PCI also 
tracked whether there would be an update to the data for this submission, what version number of 
the data PCI would be submitting, and the dates in which an NDA had been established.  
 
This section will explain the way in which PCI conducted its outreach to the carriers and the 
different ways in which it received data.  It will outline some of the major updates that were received 
in this round as well as describe both quantitatively and qualitatively the extent to which data was 
updated in this round.   
 

NDA 
PCI continues to offer and abide by the terms of our NDA.  If providers did not establish an NDA 
in a previous round, they were given the opportunity to do so in this round.  Since PCI assumed the 
data collection process in January 2011, there were still several providers who had not yet established 
an NDA with PCI, but who had done so in a previous round with PCI’s prior subcontractor.  A 
total of 15 providers did not feel the need for an NDA with PCI and worked to update their data in 
this round.  An additional 15 providers who had previously had an NDA with the previous 
subcontractor established one with PCI in this round of data collection.  In other instances, NDA’s 
were individually negotiated to address specific provider concerns.   
 
When an NDA was established with a provider, the date that the NDA was established was 
recorded on Salesforce. A field in Salesforce was also populated as to whether or not the provider 
would be submitting new data for this Cycle 4 submission. If a provider responded with no change 
to the data, PCI removed priority from that provider and refocused attention on those providers 
who reported that there was a change to their data as of July 31, 2010. PCI wanted to establish the 
NDAs by focusing on those providers with new data to submit. 
 
To date, PCI has established 89 NDA’s with the 122 providers in the database that accompanies this 
submission.  Many of the carriers who have chosen not to establish an NDA with PCI, never had 
one with the previous mapping contractor, and continue to work with PCI to refine the data.  The 
data package demonstrates that PCI is providing updated data for several providers with whom an 
NDA has not been established.   
 

UPDATES TO DATA 
Of these 122 providers submitted as part of the data package in this round, edited data has been 
submitted for 57 of them. This data comes in the form of new infrastructure, speed changes, and 
corrections from PCI’s previously submitted data.  Additionally, two new providers were added to 
the dataset: WideOpenWest Illinois and Sidera LLC. Two other providers, Hughes Network 
Systems, LLC & WildBlue Communications, Inc. provided satellite data. That satellite information 
was not included as part of the geodatabase. An additional two providers who submitted data in a 
previous round, AT Cyber and Avenue Broadband, were submitted by competitors, E-Vergent.com 
& Telecommunications Management, and their data has been merged with their purchasers.   



                                           
Partnership for a Connected Illinois 

Narratives and Methodologies 

 
 

 
October 2011   6 
 

 
Broadband service providers submitted coverage in terms of the areas that they served, either in 
edited GeoPDFs, direct geospatial formats, CAD files, or as paper maps. The submitted polygons 
were overlaid on the census block polygons and those blocks touching were selected and used. The 
proper speed tier categories were assigned as necessary.  
 
Throughout August and early September, the PCI data team formatted data as it was received. A 
cutoff date of August 26, 2011, was established for the acquisition of new data to include in this 
submission.  However, PCI continued to accept data after that date, and all providers who submitted 
updated coverage in this round is included in this submission.   
 
The table below summarizes the status of data among providers. 
 

Provider with no data, unresponsive in this round to PCI and previous rounds 43 

No update to coverage area/ verified previous data/previous data submitted 63 

Provider reported/provided an update to coverage area that was included in this cycle. 57 

          Provider provided update in the form of an edited GeoPDF 21 

          Provider provided update in shapefile format 7 

          Provider provided update in excel format 19 

          Provider provided update in other format 10 

New provider for this round 2 

Total number of providers included in this submission 122 

 

CHANGES AND CORRECTIONS 
 
On August 19, 2011, PCI along with the other SBDD’s designated entities submitted a changes and 
corrections document to the NTIA for the data that was submitted in Round 3.  PCI felt this was a 
very useful document, and would like to incorporate it into this narrative to demonstrate the extent 
to which PCI updated its data in this round.  While the last section quantitatively expressed how data 
was changed, this section qualitatively explains each of the updates that were made.  Some of the 
more extensive changes and corrections will be described in later sections.  
 

Provider Change Correction Description 

Telecommunications Management 

X X 

GeoPDF, Added DOCSIS 3.0 to Newton, 
as well as Lawrenceville, Mt. Carmel, 
Bridgeport, merged Avenue 
Broadband data due to recent 
purchase. 

Harrisonville Telephone Company 
X X 

GeoPDF, added fiber, increased 
speeds, asymmetric & symmetric DSL 

Grafton Telephone Company 
X X 

GeoPDF, Expanded footprint, added 
fiber, increased speeds  
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Flat Rock Telephone 
X X 

GeoPDF, filled holes in coverage & 
increased speeds 

New Windsor Telephone Company 
X X 

GeoPDF, increased speeds across 
coverage area & trimmed coverage 

Mediacom Communications 

X X 

GeoPDF, Increased speeds within city 
limits of Carbondale and removed 
areas of coverage outside East St. 
Louis. 

Frontier Communications 
X X 

GeoPDF, updated data to reflect 
recently purchased Verizon territory 

Qwest Communications X X New DBA name 

Covad Communications 
  X 

Added Census block data, provider 
previously only provided Middle Mile  

Fairpoint Communications 
  X 

Added Census block data, provider 
previously only provided Middle Mile  

Crossville Telephone Company   X GeoPDF,  to make slight changes 

Hamilton County Telephone   X GeoPDF, cut back on footprint 

Egyptian Internet Services   X GeoPDF, filled holes in coverage 

LaHarpe Telephone Company 
  X 

GeoPDF, filled holes in coverage & 
increased speeds across footprint 

Montrose Mutual Telephone 
  X 

GeoPDF, first submission to wireless 
layer.  

Moultrie Independent Telephone Company   X GeoPDF, increase speeds 

Viola Home Telephone Company   X GeoPDF, increase speeds 

Gridley Telephone Company 
  X 

GeoPDF, patched hole in coverage 
area 

Home Telephone Company   X GeoPDF, to change speeds  

Leaf River Telephone Company 
  X 

GeoPDF, to increase speeds and patch 
holes in footprint. 

Tonica Telephone Company 
  X 

GeoPDF, to remove census blocks from 
coverage area 

Comcast Cable Company   X included DOCSIS 3.0 

360networks   X Middle Mile reincluded 

Broadband Heaven   X Middle Mile reincluded 

Cogent Communications   X Middle Mile reincluded 

DeKalb Fiber Optic   X Middle Mile reincluded 

Fox Valley Internet   X Middle Mile reincluded 

XO Communications   X Middle Mile reincluded 

Zayo Group   X Middle Mile reincluded 

WideOpenWest Illinois   X New Cable Provider 
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Cass Communications X   1 new site 

Full Choice Communications X   1 new site & speed upgrades 

Cellular Properties X   1 new site with three sector antennas 

Heartland Cable X   2 new sites 

Bspeedy Wireless Inc. X   4 new sites 

Computer Dynamics 

X   

40 new sites added to network at 
various speed tiers, increased capacity 
and speeds. 

Jo-Carroll Energy X   6 new sites 

Cequel Communications X   Expanded coverage area 

Tel-Star Cablevision 
X   

GeoPDF, expanded coverage to 
Goodfield and Congerville 

Madison Telephone Company X   GeoPDF, increased speeds 

McNabb Telephone Company X   GeoPDF, increased speeds 

RCN Regulatory 
X   

Included DOCSIS 3.0, and corrected 
speeds in region  

Leap Wireless Inc. X   Mobile Wireless Update 

T-Mobile USA X   Mobile Wireless Update 

Sprint Nextel Corporation X   Mobile Wireless Update 

Verizon Communications X   Mobile Wireless Update 

Sidera LLC 
X   

New provider that had submitted data 
with RCN Regulatory previously 

One-Eleven Internet Services 
X   

New service area in old one that had 
new construction & speed upgrades 

Corn Belt Wireless 

X   

Old footprint had speed upgrades, new 
footprint overlays part of existing 
network with speed upgrades as well 

Charter Communications X   Speed upgrades across footprint 

Illinois Consolidated Telephone Company 
X   

Two new fiber to the home sites, 
increased speeds in select DSL areas 

Level 3 Communications X   Updated address & middle mile data 

Clearwire Corporation X   Updated census block layer 

CenturyLink X   Updated census block layer 

Time Warner Cable X   Updated data and coverage area 

E-Vergent.com, LLC 
X   

Updated data to reflect recently 
purchased AT Cyber territory 

AT&T 
X   

Updated mobile, middle mile, and 
census block data 
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SBDD DATA TRANSFER MODEL METHODOLOGY 
 
The submission of the broadband dataset for October 1, 2011 is contained within the SBDD Data 
Transfer Model. PCI has reviewed all literature that relates to the release and use of this data transfer 
model and recognizes that it does not replace or dictate how data is stored, processed, or displayed 
for the State, as it is meant primarily as a means to transfer the broadband data from all states and 
territories and populate the National Broadband Map in a seamless fashion. 
 
In addition to the narratives and methodologies contained herein, as well as the DataPackage.xls 
containing contact information, the data dictionary, and a provider summary table, the following 
feature classes are submitted within the SBDD Data Transfer Model for the state of Illinois.   
 
Inventory of Deliverables, Partnership for a Connected Illinois: October 1, 2011: 

 

NOFA Requirement Data Transfer Model Data Description 
Appendix A:  1(a)(i) BB_Service_CensusBlock Broadband Service Availability of 

Facilities-Based Providers in Census 
blocks of No Greater Than Two 
Square Miles in Area 

Appendix A:   1(a)(ii) BB_Service_RoadSegment Broadband Service Availability of 
Facilities-Based Providers by Road 
Segment in Census blocks Larger in 
Area Than Two Square Miles 

Appendix A:   1(b) BB_Service_Wireless Broadband Service Availability of 
Wireless Services Not Provided to a 
Specific Address 

Appendix A:   3(b) BB_ConnectionPoint_MiddleMile Broadband Service Infrastructure 
Middle-Mile and Backbone 
Interconnection Points 

Appendix A:   4 BB_Service_CAInstitutions Community Anchor Institutions-
Listing 

 
The provider data collected by PCI on behalf of the State of Illinois have been formatted per the 
given specifications and uploaded into the appropriate feature classes of the SBDD Data Transfer 
Model.  Wireline availability is contained within census blocks and road segments. Wireless 
availability is contained as polygons of coverage areas. Middle-mile connections and community 
anchor institutions are contained as point data. The subscriber weighted nominal speed (if available) 
is contained within the overview feature class. All speed data is contained at the census block, road 
segment, or wireless polygon level of availability. All efforts have been made to comply with 
formatting, domain, and metadata requirements to include as much information as possible.  
(Methodology Paper, April 2011) 
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DATA PRODUCTION METHODS 
 
As mentioned, data was received in a number of formats that required processing in order preparte 
the data for submission in accordance with NTIA requirements.  The PCI data team also went to 
great lengths to convert the 2000 census block data to 2010 as requested by the NTIA.  In this 
round the primary format in which updates were received were through the GeoPDFs submitted to 
the providers and the TerraGo Technologies toolbar.  This section will discuss the census block 
conversion and the various means in which PCI took as raw data were received from the provider, 
as well as how PCI assisted the provider in making the update process as easy as possible.  It will 
examine each layer and the steps PCI took in updating the data that NTIA is in receipt of. 

CENSUS BLOCK CONVERSION 
In this round, PCI made the conversion from 2000 to 2010 census blocks at the instruction of the 
NTIA.  Using existing 2000 coverage, PCI created coverage polygons based upon provider, 
transtech, and maximum advertised download speeds.  Using a spatial overlay, PCI selected census 
blocks in the 2010 layer with a centroid point in the carrier polygons.  These new census blocks then 
inherited the same attributes as they were previously recognized in the 2000 census block layer. 
 
PCI initially attempted to use the conversion table that was provided by the Census Bureau to make 
the conversion from 2000 to 2010 census blocks.  PCI noticed holes in the data when this process 
was used.  The images that follow demonstrate the difference in the conversion from 2000 census 
blocks to 2010 using the spatial overlay as opposed to the conversion table. 
 
Using the conversion table process, we had a total of only 605,038 census blocks covered. The all-
inclusive spatial overlay filled these holes and contained a more accurate 652,602 census blocks. 
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2000 Conversion using Conversion Table Conversion using all-inclusive spatial 
overlay 

 
  

 
 

 

 

 

 

 

GEOPDF AND TERRAGO TECHNOLOGIES TOOLBAR 
The GeoPDFs that PCI sent to the providers proved to be the single greatest improvement PCI 
made to its data collection and outreach process in this round.  In the initial outreach made to the 
provider from June 30 to July 9, they received both the GeoPDF and a letter describing how they 
could use the GeoPDF software to make their edits for this Round.   

The provider, upon opening the map was instructed to use the  icon to turn layers on and off.  
The images below show the intial map PCI sent to Harrisonville Telephone Company.  It 
demonstrates the map as layers are switched on and off to show varying levels of Harrisonville 
Telephone Company’s coverage area.   
 
The two maps on the left side display the wireline and wireless coverage areas respectively.  The map 
in the top right corner displays the Cycle 3 data with both layers turned on.  The images on the right 
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display the Cycle 3 and Cycle 4 data respectively.  This displays the flexibility of the TerraGo toolbar 
as data is turned on and off and edited. 
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The provider is also able to zoom into specific parts of their data as demonstrated by the image on 
the following page.  As the provider zooms into certain cities, the high resolution GeoPDF allows 
the provider to see exactly how their coverage looks at the address level.  This is extremely helpful 
for the provider in indicating fiber buildouts that may only cover a small number of census blocks.   

  
 
The provider was also instructed to download the TerraGo technologies’s toolbar at 
http://www.terragotech.com/products/terrago-toolbar.  This free adobe plug-in allows the 
provider to create geomarks on their maps which can be uploaded into ESRI software to assist in 
making the updates.   

 
 
This toolbar created several opportunities for the provider to really zoom in and edit their coverage 
area according to how their was actually represented.  When it comes to verifying carrier level data, 
PCI felt the GeoPDF and the virtual meetings where PCI and the provider started carving up the 
data were extremely useful.  The images on the next page demonstrate how DSL and Cable 
providers were able to use the toolbar to carve up coverage areas to update their data. 
 

http://www.terragotech.com/products/terrago-toolbar
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These images display how data was updated in this round using the toolbar.  The image at the top 
displays an image drawn by the provider that contains the actual speeds he promises in the indicated 
regions.  The images of McNabb Telephone Company displays how simple speed updates were 
made using the TerraGo toolbar.  A provider would attach a note to the map indicating the need for 
a speed change.  The image at the bottom shows a cable provider in this round who made speed 
upgrades in the city limits of Carbondale, IL.  The simple note they made to the map allowed for 
quick updates using a city limits layer on the map. 
 
When uploaded into ESRI software these geomarks were extremely useful in making quick updates 
to both a provider’s footprint and speeds.  These GeoPDFs proved to be a source of provider level 
verification, and there were a couple of instances where the GeoPDFs actually worked to verify 
speeds across a provider’s coverage area.  These instances will be discussed at depth in a later 
section. 

MOBILE WIRELESS COVERAGE 
PCI has collected mobile wireless coverage from most providers in the State.  These shapefiles were 
imported into the database and formatted to fit NTIA requirements.  Every mobile wireless 
provider submitted updated data in this round.  An example of this data is below. 
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WIRELESS METHODOLOGY 
 
In addition to the wireless approach deployed in 2010, for this cycle, many fixed wireless providers 
allowed us to use their tower locations, antenna heights and direction/spread of coverage to derive 
coverage areas. With the provided tower information, professionally prepared radio frequency 
coverage studies were conducted and converted to shape file format. These studies have proven to 
be very accurate and represent service areas where the maximum advertised speeds can be delivered. 
These studies take in to account full consideration for terrain and tree clutter data. 
 
We do note two interesting trends in the wireless data. First, there appears to be some variation on 
how the NOFA coverage definition is met. In other words, there seems to be a disparity on the 
necessary strength (e.g. -80 dB, -98 db, -120 dB, etc.) to provide the appropriate quality of service 
for data services and still be able to deliver the maximum advertised speeds. 
 

 
The images above show an increase in coverage for Bspeedy wireless.  The image on the left displays 
the data that was submitted in Cycle 3 and the image on the right displays the data for Cycle 4.  One 
is able to see an increase in coverage in the center and eastern parts of the map.  This came through 
the construction of additional towers that were not included in previous submittals.   
 

MIDDLE MILE 
 
In the last round, PCI did not submit any Middle Mile points that the previous mapping contractor 
had collected under the protection of a Non-Disclosure Agreement.  PCI made an effort to include 
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these Middle Mile points in this round as well as collect data from other providers who had semi-
annually be contributing this data.   
 
The NOFA defines Middle Mile as (a) a service provider’s network elements (or segments) or (b) 
between a service provider’s network and another provider’s network, including the Internet 
backbone.   A range of telephone, mobile wireless, and cable providers submitted data for this layer, 
while others remained silent on the question, or chose not to submit. 

METADATA 
 
Metadata, which literally means data about data, represent PCI’s attempt to document procedures, 
coding, and overall methodology used in managing broadband supply data.  Both short and long 
terms goals of developing PCI’s metadata are to improve communication on Geographic 
Information Systems (GIS) data management issues for both internal and external partners.  PCI’s 
metadata is organized and structured around Federal Geographic Data Committee (FGDC) 
standards associated with key information impacting the following issues: 
 

 What GIS data layers are managed by an organization? 

 How is data coded or classified in assisting outside partners or organization use the GIS data 
developed? 

 When was the data developed and how often is it updated? 

 Who developed the data layers and who should be contacted if anyone has questions? 
 

The net result of developing PCI’s metadata connects to the idea of communication and standards. 
When applied correctly over time PCI’s metadata will assist in educating other users on essential 
questions needed when applying GIS data.  In addition, it will assist PCI internally as metadata will 
help the organization identify and document critical developing issues shaping data development. 
Any new employee or organization will be pointed to metadata files when asking questions relating 
to methodology, attribute codes, dates of data edits or updates, and follow-up contact information 
within PCI’s data team. 

DATA VERIFICATION 
Verification has become an evolving and ongoing process at PCI.  The development of the 
Broadband Illinois website, along with the evolution of the GeoPDF process has created a feedback 
loop between provider and consumer and PCI that allows PCI to verify the carrier level data that it 
submits semi-annually to the NTIA.   PCI continues to develop eTeams throughout the state that 
are able to take county and provider level maps and visualize the data and begin indicating areas 
where the data may not be accurate.  PCI has also published a Supply Side Inventory, which is 
included in the appendix of this paper, in which PCI developed a system to rank Illinois’s counties 
by broadband connectivity and looked at two major sets of third-party data to verify the data it had 
collected.  Various means are as well being used to aggregate demand in parts of the state which 
indicate there is a need for better broadband and better data. 
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PROVIDER 
In this Round, PCI worked very closely with the provider sending back versions of the GeoPDF 
until the data was represented according to the provider.  PCI considers this process to be the first 
of five forms of verification PCI has and will continue to carry out to ensure the data that is 
submitted to the National Broadband Map is as accurately as possible.   
 
In this round, PCI purchased a set of wire center boundaries which PCI used to map out DSL 
coverage for a couple of providers.  Knowing that a DSL provider’s Central Office or Remote 
Terminal that fell in a certain wire boundary could not extend service outside that boundary allowed 
PCI to map out these locations and create buffers around these locations based upon the speed.  
PCI recognized that locations 7500 feet from a DSL C.O. or R.T. would not receive the same speeds 
as locations only 1000 feet from that location.  These buffers allowed PCI to make these changes.  
Due to confidentiality of these locations, maps that contain these locations with these buffers and 
boundaries are protected under the NDAs that have been established.   
 
However, the images below provide an example of how PCI would use a C.O. or R.T. location to 
map out the coverage that a provider is able to provide in that wire center boundary.  The image on 
the left shows two wire center boundaries that contain a C.O.  The buffers are indicating that the 
areas closest to the C.O. receive speeds that are in Tier 5 while areas outside that initial ring receive 
download speeds in Tier 4. The second image shows how the data beneath these buffers looks when 
the wire boundaries and buffers are removed.  The third image shows how this data would have 
been submitted in a previous round by the previous mapping contractor.  As you can see, the same 
flat speed is dispersed across the entire region surrounding C.O. and R.T. locations.  This is 
undoubtedly a form of verification. 

 

           
 
PCI has worked through this process for one of the two largest DSL providers in Illinois as well as a 
handful of small telephone companies throughout the State.  This is a process that PCI will focus on 
quite heavily in the next round.  In some instances, small telephone companies admittingly provided 
this data without sharing the locationsand the GeoPDFs made this possible.   The images of Home 
Telephone Company on the next page demonstrate how they used the TerraGo toolbar to reel back 
the previous data that was incorrectly submitted as DSL data with speeds across the region in Tier 9.   
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USER 
PCI views the user as the second form of verification and has developed a tool to allow feedback on 
the data that is on the Illinois Broadband Map and in the semi-annual submission to the NTIA. 
When a consumer clicks on Broadband Illinois’s search map they see the carriers that service that 
census block.  The widget below allows the consumer to give PCI feedback on the providers that 
service that location.  PCI is preparing to launch this tool in the upcoming round of data collection.  
The data that PCI receives from this tool will be used to start plotting points on a map that can be 
given to the provider to show areas the consumer is claiming does not have coverage. 
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TRUSTED USER 
The third form of verification comes from the Trusted User.  PCI has created GeoPDFs of all 102 
of Illinois’s counties that are available on the Broadband Illinois website.  It has also deployed 
eTeams throughout the state that are capable of editing these maps and returning them to PCI as a 
form of verification.  The map below shows an example of all the changes that PCI made to Jasper 
County in this round thanks to user feedback from eTeam members on the ground.  As you can see, 
New Wave Communications launched DOCSIS 3.0 technology to the city of Newton in this round.  
PCI had also not been including wireless data for Montrose Mutual Telephone Company.  PCI 
recognized this error and included this data in this round.  The county maps are currently available 
on the website, and the provider level GeoPDFs will soon be published and available for editing as 
well. 

 

 

THIRD PARTY DATA SOURCES 
On August 15, 2011, PCI published a Supply Baseline Study, “Broadband Access in Illinois:  A 
Baseline Snapshot”, that summarized the state of broadband supply in Illinois.  The report, a 
product of the data analysis by the PCI data team aims to quantify what is known about broadband 
data in Illinois and publish it along with an analysis of Third-Party data sources.   
 
The first method of third-party verification used in this examination was user speed test data 
through the broadbad.gov website. Through this website, the NTIA and the FCC solicited street 
address information with each speed test. They provided PCI with speed test data gathered over a 12 
month period. This has been mapped and some limited studies have been conducted.  These speed 
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tests were accompanied by mini surveys which allowed for some analysis. The users were asked to 
input their street address and the type of internet connection they were using.  
The second set of third-party data used for verification used in this study was gathered by the 
Gadberry Company.  The Gadberry data is a combination of various user/crowd sourced data sets.  
They indicate if there is broadband activity at the street address level and they then incorporate that 
information at the census block level. We have compared blocks showing coverage as stated by the 
carriers against the user reported information. There are some areas of the state where there are low 
or no user reported information. 
 
The maps below show these third party data sources projected on a map of Illinois.  The map on the 
left shows the location and results of the FCC speed tests, while the image on the right shows 
census blocks where the Gadberry dataset did not provide enough results for a significant analysis.  
On the Gadberry map, census blocks in blue indicate where there is a low sample rate, and census 
blocks in pink show where no samples were obtained.  For more information on these third party 
data analyses, the Supply Side Baseline has been included in the appendix of this paper. 
 
 

 

DEMAND RESEARCH 
PCI is undergoing efforts to develop a survey process to survey demand across the state of Illinois.  
This demand research is the fifth form of data verification that PCI is using to verify the data.  This 
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survey process once developed will identify current broadband adoption trends, applications, and 
barriers for community anchor institutions, businesses, and residents.  It will be referenced around 
critical geographic units for analysis. 
Connect SI, a regional broadband initiative in Southern Illinois, developed a tool called “I Want My 
Broadband” that surveyed consumers who felt they were underserved or unserved in terms of 
broadband service.  Working with eTeams, PCI has followed the Connect SI model to launch this 
tool in other regions around the State.  The images below demonstrate just how powerful this tool 
can be.  The image on the left shows the current broadband supply data sits in a given part of the 
state.  As you can see, the reported speeds fall in download tiers 3 &4.  The image on the right 
shows the same part of the state and displays locations where consumers have reported that they 
need better service.  While PCI continues to think of the best way to launch a similar effort state 
wide, this demand aggregation is an exceptional form of verification.   

 

 
 

ILLINOIS COMMUNITY ANCHOR INSTITUTIONS 
 

PCI has established an ongoing procedure for gathering data on the physical location and broadband 
connectivity of  Community Anchor Institutions (CAIs) in accordance with the data requirements of  
the SBDD NOFA Technical Appendix. 

As with the April 1, 2011, submittal, PCI identified existing, centralized sources for CAI connectivity 
data. PCI geocoded each submitted data point by using ESRI software and Google batch geocoding 
programs.  As opposed to previous rounds where PCI submitted secondary CAI’s that did not fit 
perfectly into NTIA parameters, PCI has decided to submit only those CAI’s that clearly and 
perfectly fall into the seven categories laid forth by the NTIA.  This has led to a significant decrease 
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in the total number of  CAI’s submitted, but a significant increase in the quality of  the data that is 
being submitted.  PCI continued to follow some of  the same outreach methods developed in 
previous rounds, but in this round made the greatest gains in terms of  data quality in the areas of  K-
12 schools and libraries.   

This section will describe the process used to build the foundation of  the Illinois CAI database in 
much the same way it has been described in previous rounds, but it will focus on how the dataset has 
been improved for this submission. 

PREVIOUS ROUNDS 
Outreach in Round 1 focused on collecting the point and address data while subsequent submissions 
in Rounds 2 & 3 focused heavily on survey development, web site database research and 
teleconferences. Together with the Illinois Department of  Commerce and Economic Opportunity 
(DCEO), PCI engaged in a process of  working with CAIs on an organized basis. Other state 
agencies and organizations have included the Illinois Commerce Commission, Illinois Board of  
Education, and the Illinois State Police. Additional Agencies and organizations have been referenced 
throughout this presentation. 

PCI created a survey using Survey Monkey and both carrier and price information were requested, 
and the speed test became a required item for completion of  the survey. The speed test(s) that was 
administered was the one on the Federal Communications Commission web site.  

PCI worked with a number of  organizations in gathering data for these submissions. We are 
encouraged that relationships with these organizations will continue to develop and facilitate our 
electronic data collection efforts in future filings. These organizations are listed below: 

K-12 Illinois Association of Regional School Superintendents, Illinois State 
Board of Education 

Libraries Illinois Library Association 

Healthcare Illinois Critical Access Hospital Network, Illinois Rural HealthNet, Illinois 
Healthcare Association 

Public Safety Existing Database 

Colleges & Universities Illinois Community Colleges Board 

Other Government Existing Database 

Other Non-Government Man-Tra-Con 

 

For Category 1, K-12, PCI worked with Gil Morrison of  the Illinois Association of  Regional School 
Superintendents. A cover letter and link was sent to each of  the Regional Superintendents with 
instructions to disseminate to the Technical Director for each their respective School Districts. From 
there, the Technical Director distributed the survey to each school location.  PCI also worked with 
Kathy Barnhart of  the Illinois State Board of  Education in distributing the survey.  Kathy 
distributed the survey to the fifteen Learning Technology Centers in the State of  Illinois who then 
distributed the survey to the various school districts.   

PCI had an existing database of  email contacts for Category 2, Libraries in Illinois. We worked with 
the Illinois Library Association and found that generally the libraries were receptive to taking the 
survey, given need for broadband in the library sciences. 
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In Category 3, Healthcare, PCI worked with Pat Schou of  the Illinois Critical Access Hospital 
Network and Alan Kraus of  the Illinois Rural Health Network. Both organizations were referenced 
in our cover letter, and the survey was sent from PCI’s email database.  David Voepel, of  the Illinois 
Health Care Association, also assisted in distributing the survey to Category 3 institutions which 
included long-term care facilities, nursing homes, and rehab facilities.  The data that has been 
acquired through these two methods have been added to the database of  community anchor 
institution data included in this submission. 

For Category 4, Public Safety, surveys were also sent via the PCI database. As with the Libraries, the 
response from this category was favorable. 

PCI worked with Elaine Johnson at the Illinois Community Colleges Board for Category 5, 
Universities and Colleges. A cover letter and link was sent to over 40 Community Colleges, with a 
very positive response. The remaining Category 5 surveys we sent via email. 

For Category 6, Community Support-Government, the survey was distributed electronically via 
PCI’s existing database. 

For Category 7, Community Support-Non Government, PCI worked with Kathy Lively at Man-Tra- 
Con to disseminate the survey to Illinois WorkNet Centers. The remaining surveys were sent via our 
exiting email database. 

ROUND 4 CORRECTIONS 
The total number of  CAIs stands at 12,334. Notwithstanding this relatively high number, PCI has 
made an effort to refine the survey process to identify priority CAIs within each category, and to 
collect connectivity data for these locations. 

As an example, of  the 26,869 locations submitted in October, there were 14,000 Category 3 
Healthcare locations which were geocoded, yet had no connectivity data. Many of  these were for 
actual practitioners as opposed to clinics, or what might be considered institutions. PCI has elected 
to remove this larger number for the October filing, we have also identified 1,327 priority Healthcare 
locations, which include hospitals, clinics and other significant facilities that are included in this 
filing.  PCI also removed duplicates where they existed in the other categories.  For instance, the 
previous mapping contractor included a record for each individual college and university in both the 
K-12 and Higher Education categories.  PCI felt it made sense to include only one record of  this 
category in only the Category 5 Higher Education category. 

In this Round, PCI enhanced the quality of  the data in the K-12 category through the use of  an 
eRate database that showed what schools had applied for the eRate and what providers were 
servicing their location.  This allowed PCI to populate the BBService and TransTech fields for those 
CAI’s.   

ROUND 4 GAINS 
In Round 4, PCI made the aforementioned corrections to the database, and continued to push the 
Survey Monkey tool designed to collect the required information.  The table on the following page 
indicates the improvements that have been made to the database over time, as well as shows the 
impact the removal of the 14000 category 3 locations made to the quality of the database.   
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While the significant increase in total number of anchor institutions with connectivity data comes 
from the removal of the secondary institutions, one can see that the total number of anchor 
institutions with connected points has increased substantially from 4,288 to 6,141.  This comes 
primarily from the use of the e-Rate data and the continued deployment of the survey.   

BROADBAND ILLINOIS WEBSITE 
On February 17, 2011, the Partnership for a Connected Illinois launched its new web site, featuring 
an easy graphical interface for accessing PCI data about broadband providers with a single mouse 
click or touch on a smart phone. In this first, initial version, the web site offered a broadband 
location finder with detailed service provider information and assessments of internet speeds, as well 
as locations of community broadband providers.  This map remains on the website along with other 
maps in the “Maps” section of the website.  The aforementioned county GeoPDFs have also been 
made available with the data current as of December 31, 2010.  Soon after this submission, county 
and provider maps will be posted on the website with the data currently being submitted.   

METHODOLOGY FOR THE BROADBANDILLINOIS.ORG WEB SITE 
 
Clicking on the home page map opens a side panel with broadband providers. Expanded results also 
show the libraries, schools, and public building in the area with broadband. As the State-designated 
entity under the NTIA’s State Broadband Data and Development, PCI provides, on 
http://broadbandillinois.org, the same data that it submits to the NTIA for inclusion in the national 
broadband map. Additionally, PCI has begun to collect actual speed and price information, using the 
new web site. 
 
The web site is built around open and transparent data-sharing tools. As with the national 
broadband map, PCI aims to encourage user feedback as a means of helping to improve and 
promote broadband in Illinois. For example, the site's "eTeam" section encourages citizens to get 
involved with Broadband Illinois eTeams. These community leadership groups are working to help 

  
Oct 2011 

  
Mar 2011 

  
Oct 2010 

 

Cat Total 
Connected 

Points 

% with 
connectivity 

data 
Total 

Connected 
Points 

% with 
connectivity 

data 
Total 

Connected 
Points 

% with 
connectivity 

data 

1 5,314 3236 60.90% 5,604 1,417 25.29% 5,651 1,165 20.62% 

2 1,422 721 50.70% 1,444 713 49.38% 1,505 633 42.06% 

3 1,327 138 10.40% 15,267 138 0.90% 15,358 96 0.63% 

4 2,319 449 19.36% 2,339 433 18.12% 2,360 384 16.27% 

5 271 115 42.44% 266 111 29.47% 307 116 37.79% 

6 1,446 1445 99.93% 1,449 1,449 100.00% 1,454 1,454 100.00% 

7 235 37 15.74% 230 27 11.74% 234 19 8.12% 

Totals 12,334 6,141 49.79% 26,599 4,288 16.12% 26,869 3,867 14.39% 

http://broadbandillinois.org/
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connect rural residents and others throughout Illinois. The site’s "Impact" section is beginning to 
assemble materials that pertain to broadband adoption. 
 
The image below shows the primary search map that the user is able to use to search for broadband 
providers at their location.  The other image displays locations that have been searched since PCI 
launched the map in Feburary 2011. 

 

 



                                           
Partnership for a Connected Illinois 

Narratives and Methodologies 

 
 

 
October 2011   27 
 

THE APPLICATION PROGRAMMING INTERFACE FOR BROADBAND ILLINOIS DATA 
 
PCI’s web site is built around an open source Application Program Interface. This free tool allows 
software developers to build upon, and add to, the data on the Broadband Illinois website.  
Documentation for the PCI’s API is available at http://developer.broadbandillinois.org. 

BROADBANDSTAT METHODOLOGY  
 
BroadbandStat is an online, interactive mapping tool for viewing, analyzing, and validating 
broadband data. Developed through a partnership with ESRI, the market leader in geographic 
information system (GIS) software, BroadbandStat is a multi-functional way for local leaders, 
policymakers, consumers, and technology providers to devise a plan for the expansion and adoption 
of broadband. The Partnership for a Connected Illinois re-launched BroadbandStat on 
http://broadbandillinois.org, and is also available under the “Maps” tab. 

CONCLUSION 
 
The data submission cycle ending on October 1, 2011, has been the first round that the Partnership 
for a Connected Illinois has conducted every facet of the data collection process.  .  Now that PCI 
has assumed full discretion over this process, it has brought the data “closer to home” for Illinois.  
PCI has taken major steps in its three-fold mission to collect and publish broadband data, to ensure 
broadband access throughout the State, and to maximize broadband’s impact, and the data has 
helped drive each of these steps. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://developer.broadbandillinois.org/
http://broadbandillinois.org/
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3. (Figure 1.9- Map showing census blocks without enough sample) 
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3. County Level Ranking & Baseline Measurements 
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i. Ranking by Geographic Area (Figure 3.1- Ranking by Geographic Map) 

ii. Ranking by Household Count (Figure 3.2- Ranking by Household Map) 

b. Geographic & Socio-economic Variables (Table 3.1- Top & Bottom 10) 

i. Geographic Discussion 

1. (Figure 3.3- Top & Bottom 10 Geographically) 

ii. Socioeconomic Discussion  

1. (Figure 3.4 - Unemployment & Poverty) 

2. (Figure 3.5 - Population per square mile) 

3. (Figure 3.6 - Median Household Income) 

4. (Figure 3.7 - Workforce Count) 

 

Conclusion 
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Scoping Broadband Access in Illinois: A Statewide 

Baseline Inventory for Supply  
 

Introduction 
 

The Partnership for a Connected Illinois Statewide Baseline Inventory for Supply of Broadband will 
highlight, introduce, and quantify the issues relating to broadband data submitted by providers within 
Illinois.  The purpose of this paper is to reveal some of our current findings at PCI, to drive forward 
toward the next stages in the work on collecting and publishing broadband data, and to help encourage 
the construction, promotion and use of higher-capacity broadband networks. Under the U.S. 
Department of Commerce’s State Broadband Initiative, and in collaboration with the Illinois Department 
of Commerce and Economic Opportunity, PCI is the non-profit entity charged with serving private and 
public stakeholders throughout Illinois in ensuring that Better Broadband leads to Better Lives. 
 
This inventory will summarize the following research outcomes for the PCI Statewide Baseline Inventory 
for Supply of Broadband: 

 Inventorying and quantifying the state of broadband access, and the advertised speeds of access, in 
Illinois, according to the best available information; 

 Defining and developing metrics against which to evaluate changes in broadband access across the 
State; 

 Introducing the concepts of ranking in assisting the State with assessing how different geographic 
units (i.e., counties, school districts, etc.) compare against each other relative to broadband supply, 
which particular reference to advertised speeds and availability. 
 

Assessing the lower-speed and less-served areas of the State is the first step in evaluating 
broadband supply.  In Part I of this study, our research will quantify the percentage of households and 
geographic that are served (to the best of our knowledge), at particular speeds. Three important points 
bear emphasis: 

1. PCI updates broadband information from providers on a semi-annual basis. Because 
of the large numbers of carriers providing information, and because of continual 
updates from providers, there may be errors in this information. As PCI and 
providers mutually improve our data-collection and validation processes, 
percentages of the State covered at particular speeds may change. 

2. Even if PCI has effectively captured the areas in which providers say they offer 
service at a particular advertised speed, PCI believes it is essential to verify the 
claims of services. We need to compare how actual broadband speeds compare to 
advertised speeds. Indeed, this report highlights some discrepancies between those 
two measurements. 

3. Even if the providers and PCI have accurately represented areas and households 
that receive broadband service at a particular speed, and verified the actual speeds 
of such services, the public’s understanding and expectation of broadband 
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capabilities continues to evolve. For many years, service greater than 200 kilobits 
per second (Kbps) was considered to be “broadband” by the Federal 
Communications Commission. Now, the FCC and the National Telecommunication 
and Information Administration define “broadband” as service of 768 Kbps or 
greater. But it is possible that many in the public do not accept service as that speed 
as actually representing “broadband” for the purposes of current-generation 
services – led along the high-performance applications of the future. This is why it is 
vital to consider service 1 Gigabit per second (Gbps), 100 Megabits per second 
(Mbps), as well as lesser speeds such as 50, 25, 10, and 6 Mbps. 

 
Results of PCI’s research into the supply of broadband and particular speeds will assist the State, 

and other stakeholders, in understanding the lay of the land relative to supply.   Outcomes of this 
research are to assist broadband stakeholders like eTeams, carriers, and other community action 
organizations in developing data-driven solutions in promoting adoption/access strategies for increasing 
broadband deployments.   

 
Part Two of this Baseline Inventory for Supply relates to evaluation and assessment.  PCI aims to 

develop a data-driven culture to assess the impact of broadband on citizens, businesses, and community 
anchor institutions (CAIs).  This research will serve a role to both capture State-wide and local county 
snapshots of current broadband supply side trends.  Using this approach, PCI will be able to assess, 
score, and benchmark how prepared the State of Illinois is to compete in the digital economy.  Simply 
put, these early scores will serve as a baseline in assessing how broadband deployments change over 
time.  PCI aims to target how geographic broadband coverage changes over time and how these changes 
impact households, CAIs, and businesses across the State of Illinois.  Capturing these changes over time 
will be critical in evaluating the social and economic benefits of broadband investments in Illinois.  

 
Part Three of the Baseline Inventory for Supply relates to the idea of scoring or ranking targeted 

geographic units on broadband access.  A ranking is a quick and easy way to compare areas against each 
other relative to set criteria. PCI’s goal for this research outcome is to introduce a ranking system for 
counties relative to each other and the state as a whole on carrier speeds available and geographic 
coverage.  This research introduces broadband stakeholders across the State of Illinois, an early ranking 
system to evaluate supply side data.  In addition, PCI hopes to engage other stakeholders on developing 
new methodologies or geographic units of measurement (i.e., educational districts, workforce zones, or 
other regional economic development authorities) that need to be ranked in evaluating the social or 
economic impacts of broadband.   
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Part 1:  Inventorying and Quantifying Broadband 
 
Speaking at John A. Logan College in Carterville, Illinois Governor Pat Quinn announced the federal 
government and state investment in the Illinois Broadband Opportunity Partnership – Southern Region, 
or a $45 million investment in fiber optic broadband infrastructure through an open network built by 
Clearwave. See http://broadbandillinois.org/Projects/Clearwave.html. Said Quinn: “We have a rare 
chance…to ensure every rural, underserved, unserved community in our state is connected to world-
class information and communication infrastructure.”  This baseline report will begin by defining the 
current supply-side status of broadband in Illinois. 
 
 With so many variables to consider, there has to be a measurement system established that is 
able to place a part of the state into one of these categories.  In this section we will attempt to define 
these areas, explain why we removed mobile broadband data for the purpose of this initial study, and 
explore the three methods of verification that were used in this analysis.  This verification process is 
crucial to ensuring the provider data is represented as accurately as possible.   
 
Defining Broadband Availability at Particular Speeds of Service 
 For the purpose of this paper, PCI modeled all speed tiers around the groupings defined by the 
National Telecommunications and Information Administration. The speed tiers are: 

o 1 gigabit per second and higher 
o 100 megabits per second to 1 gigabit per second 
o 50 megabits per second to 100 megabits per second 
o 25 megabits per second to 100 megabits per second 
o 10 megabits per second to 25 megabits per second 
o 6 megabits per second to 10 megabits per second 
o 3 megabits per second to 6 megabits per second 
o 1.5 megabits per second to 3 megabits per second 
o 768 kilobits per second to 1.5 megabits per second 
o No broadband service (i.e., internet service is at less than 768 kilobits per second) 

 
Removing Mobile Broadband 

Unless specifically noted, the mobile broadband (Technology of Transmission Code 80) data has 
been removed from the data sets under study for this report. There were a variety of reasons for doing 
so.  In looking at speed test results from all the cellular technologies, it was discovered that the typical 
real world speeds over a 12-month period were in many instances different than the maximum 
advertised speeds. It is also known that providers in the cellular technologies do not have different 
speed tier data plans, which might otherwise skew a reading of speed test results. In other words, all 
users have equal access to the maximum available cellular speeds offered – unlike, for example, digital 
subscriber line (DSL) or cable modem service. Another major factor against inclusion of mobile 
broadband in the same field of analysis are the data caps in place by carriers. These caps generally limit 
the ability for users to download more than 5 Gigabytes (GB) of data per month, without paying overage 
charges. This kind of cap can limit the ability of users to access the range of services traditionally 
associated with broadband.  

We made a conscious decision to put mobile broadband in a different category when assessing 
the broadband supply conditions for the State. It is not well suited for a primary internet connection in 

http://broadbandillinois.org/Projects/Clearwave.html
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the home or business. It does however, play a vital role in the mobility aspect of broadband throughout 
the State.  The net impact of this methodological change can be seen in Figure 1.1. These impact was, 
however, very diverse geographically. Simply put, some areas of Illinois were significantly affected by 
the removal of mobile broadband; whereas, other areas of the State were not impacted.  The maps and 
tables below highlight these geographic patterns for summarizing supply side patterns.  Table 1.1 shows 
the results of the Mobile Speed Test.  Figure 1.2 shows where these speed tests were taken in the state 
and Figure 1.3 shows the mobile speed test results by technology type and operating system. Finally, 
Figure 1.4 shows some of the results from this mobile speed test. 

 

Figure 1.1: Comparison of Broadband Coverage with and without Cellular 

Data  
Table 1.1:  Mobile Speed Test App Results. 

 

Mobile App Speed Test Data 
Summaries 

Download 
Average 

Mbps 

Download 
Median 
Mbps 

Download 
Min Mbps 

Download 
Max 

Mbps 

Upload 
Average 

Mbps 

Upload 
Median 
Mbps 

Upload 
Min 

Mbps 

Upload 
Max 

Mbps 

Latency 
Median 
(in ms) 

Latency 
minimum 

(in ms) 

Wi-Fi 7.248 5.445 1 58.398 2.316 1.679 1 37.255 82 331 

Cellular 1.734 1.275 1 42.403 1.435 0.456 1 67.5 189 -61219 

UMTS 1.504 0.912 1 15.472 0.595 0.423 1 15.472 161 18 

Edge 0.121 0.09 1 4.36 0.497 0.075 1 33.75 390 46 

GPRS 0.068 0.025 1 1.498 0.166 0.026 2 1.985 534 82 

Dates Gathered:  3-1-2010 through 3-31-2011 
37479 Tests over Wi-Fi = 44.14%   84909 records total 
42456 Tests over cellular = 50%   39421 test using Android operating system = 46.43% 
4319 Tests over UMTS = 5.08%   45501 test using Apple IPhone operating system = 53.59% 
634  Tests over Edge = .75% 
34   Test over GPRS = .0004% 
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Figure 1.2:  Map showing the locations of the mobile speed test results. 
 

 
 
Figure 1.3:  Mobile App speed tests by technology type and operating system 
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Figure 1.4: Mobile App speed test comparisons. 
 

 
 

Verification 
 Using separate data sets outside of the carrier submitted data, PCI has done some basic 
verification to begin to investigate the accuracy of the carrier maps. Verification is the process of finding 
other data sources outside of the carrier coverage submissions to indicate that there is some type of 
verified broadband activity or subscribers. From a national perspective, the broadband availability maps 
have been met with a certain amount of skepticism. Part of the problem lies in the fact that it has been 
difficult to check the carrier data against other sources. In this report we have started this process by 
examining two sets of information.  At PCI, we have also worked closely with the providers to ensure 
their data is represented as accurately as possible. 
 
Speed Test Verification 

The first method of verification is user speed test data through the NTIA and FCC’s National 
Broadband Map, which is available at the http://broadbandmap.gov website. Through this website, and 
through the FCC’s http://broadband.gov web site, the federal government solicited street address 
information with each speed test. They provided PCI with speed test data gathered over a 12-month 
period. This has been mapped and some limited studies have been conducted.  These speed tests were 
accompanied by mini-surveys which allowed for some analysis. The users were asked to input their 
street address and the type of internet connection they were using.  

http://broadbandmap.gov/
http://broadband.gov/
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In some cases, the outside sources of data can only show broadband activity and nothing more. 
Other sources show activity and speed, and then some also show an internet protocol address, or IP 
address, with the other data points. With an IP address, one can generally search to find out which ISP 
has control of the particular address thus giving you a reasonable assumption that a speed test is for a 
particular carrier. Some speed tests do not give physical street address data that matches with the IP 
address information. When that happens, it is impossible to show the data point at the proper location 
on a map for further study and compare it to carrier maps. The following tables and figures provide a 
summary of the findings from this speed test verification.  Table 1.2 shows a summary of the locations 
from which this survey was employed as well as the speed test method that was used.  Figure 1.5 gives a 
visual representation of the location in which these speeds tests were taken.  Figure 1.6 shows the 
locations from which the speed test was taken throughout the state.  Table 1.3 and Figure 1.7 each 
show the results of this speed test. 
 
Table 1.2:  User Speed Test Summary 

 

Total Tests 27,807 
 

OOKLA Tests 18,559 66.74% 

MLAB Tests 9,248 33.26% 

Testing From: 
  

Community Center, library, or school 1,318 4.74% 

Home 23,630 84.98% 

Large Business 308 1.11% 

Medium Business 639 2.30% 

Mobile Connection *not the same data as in the mobile app speed test summaries. 293 1.05% 

Other 213 0.77% 

Small Business 1,406 5.06% 

 
Source:  Broadband Speed Test Data 5/12/2010 - 5/01/2011 
Figure 1.5:  User Speed Test by Location 
 

 



                                           
Partnership for a Connected Illinois 

Narratives and Methodologies 

 
 

 
October 2011   37 
 

Figure 1.6:  Location of Speed Tests 

 
 

 
Table 1.3:  Speed Test Statistics 

Speed Statistics 

Accessing From: 
Download 
Average 
in Mbps 

Download 
Median in 

Mbps 

Download 
Minimum 
in Mbps 

Download 
Maximum 
in Mbps 

Upload 
Average 
in Mbps 

Upload 
Median 

in 
Mbps 

Upload 
Minimum 
in Mbps 

Upload 
Maximum 
in Mbps 

Statewide: 10 5 0 702 3 1 0 142 

Community Center, library, or school 15 5 0 195 7 3 0 142 

Home 10 5 0 485 2 1 0 97 

Large Business 26 5 0 174 12 6 0 97 

Medium Business 15 5 0 155 8 3 0 96 

Small Business 10 5 0 702 3 1 0 96 

Mobile Connection 3 5 0 158 1 1 0 74 

Other 8 5 0 95 3 1 0 68 
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Figure 1.7:  Speed Test Summary 

 

 
 
Gadberry Verification 

The second set of data was gathered by the Gadberry Company. This information is user-sourced 
through a variety of methods. The data indicates if there is broadband activity at the street address level 
and they then incorporate that information at the census block level. We have compared blocks showing 
coverage as stated by the carriers against the user reported information. There are some areas of the 
state where there are low or no user reported information. 

 
This company has a product that can show broadband activity at the census block level. The 

information is sourced from consumers through various means such as online surveys, consumer 
product registration systems, phone surveys and warranty registrations. They have a master database of 
more than 118 million occupied households nation-wide, of which over 20 million of the responses had 
data related specifically to broadband internet use. We have used this data as a source of first pass 
validation to at least show if there is broadband present in the census blocks the carriers say there is 
service. This data set cannot address any issues of who the carrier is or what price or speed can be 
offered. One nice feature of their data set is the flag that indicates 4 different categories if they did not 
show broadband service in the block. The first and most obvious is that there are no occupied 
households in the block, the next is that there were enough sample records in the block to have a high 
confidence that there is no broadband service available, the next category is that there were some 
responses in the census block but too low a sample rate to be sure there is broadband, and the last 
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category is that there were no address sample points in the block. Following are maps and summaries of 
this user-sourced validation process.  

To get a summary of validation data, a list of unique census blocks that are known to have one 
or more broadband provider serving the block (minus cellular coverage) was generated. These are the 
blocks that the carriers state have broadband service. The unique blocks are then compared to the 
Gadberry data set with these results.  Table 1.4 and Figure 1.8 below show the results of this 
categorization process based on the Gadberry data set.  As you can see, in 93.51 percent of census 
blocks in the State, providers report that they offer broadband, or internet connectivity at speeds of at 
least 768 Kbps. Approximately 44.19 percent of those census blocks have been verified through the 
Gadberry data as having broadband, while 24.90 percent of those blocks show there are no households 
within those blocks.  The Gadberry data set did not have user sourced address sampling in 9.03 percent 
of these blocks.  Also, 21.55 percent of these blocks contained too little sampling to make an absolute 
determination.  Figure 1.9 below shows where these 21.55 percent or 73,796 census blocks are 
throughout the state. Please note that these census blocks with sampling too low for a good 
determination are interleaved throughout the State’s 366,137 census blocks, yielding an image that 
looks a lot like Swiss cheese. 

 
Table 1.4:  Categorization of census blocks based upon Gadberry data set 

Total statewide census blocks 366,137 
 

Total unique blocks covered with some form of broadband as provided by carriers 342,363 93.51% 

Total of the unique blocks Gadberry shows has broadband (crowd sourced) 151,280 44.19% 

Number of unique blocks with no occupied households 85,238 24.90% 

Number of blocks with no user sourced address sampling 30,910 9.03% 

high enough sampling for accurate determination (likely does not have Broadband in Use) 1,139 0.33% 

some precise address sampling but too low to expect a good determination 73,796 21.55% 

 

Figure 1.8:  Gadberry Data Set Verification Results by Census block 
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Figure 1.9: Map showing the Gadberry census blocks with either a low or no sample rate. 

 
 

 
Provider Verification 
 
Another method of verification is with the broadband providers themselves. PCI has been and continues 
to be in the process of providing carriers with maps showing the data that PCI currently has on record 
for each of their particular service areas. These are fully editable maps, and the carriers are encouraged 
to submit comments, corrections and improvements in the next couple of months.  We believe that this 
verification process will prove to be quite valuable.  There may be instances in which providers offering 
both fiber to the home and DSL service may have inadvertently misrepresented coverage by stating that 
the same maximum speed is available to its entire DSL area as it is in their fiber footprint. Similar 
misunderstandings may have occurred with respect to the deployment of the modernized cable 
infrastructure technology known as DOCSIS 3.0. Hence, it is quite possible that subsequent data updates 
may change these supply numbers significantly, possibly even lowering the percentages of those higher 
speed tier availability numbers. PCI is working very closely with the provider community to ensure their 
data is represented as accurately as possible. Questions about the data process can be addressed to 
intake@broadbandillinois.org, or to 217-886-4044. 

mailto:intake@broadbandillinois.org
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Part 2:  Defining and Developing a Supply Baseline  
  

In creating a Statewide Baseline Inventory for Supply of Broadband, it is important to take into 
consideration the unique landscape of the State of Illinois.  There are significant disparities in the 
percentage of land-area that has access to particular forms of broadband at particular speeds of service. 
 
Mapping Broadband 

To develop a statewide master speed tier map, PCI did the following: separate maps were 
created for each specific maximum advertised download speed tier categories for both the wireless 
(minus mobile broadband) and the wireline technologies. These maps yielded wireless and wireline 
coverage areas. They were merged to create a master Statewide service area for each individual speed 
tier. These maps were then laid one over the other, and each of the highest speed tiers were used to 
trim the lower speed tier coverage areas beneath them. This process produced speed tier maps showing 
areas uniquely covered by the highest possible advertised speed as stated by all carriers. 

 
Using this unique state map, the area of each speed-tier was calculated and that result divided 

by the total land area of the state to produce the percentage of land area covered. To calculate the total 
households passed by each speed tier, the unique polygons were used to select the census block 
centroid points located within those bounded areas. The number of occupied households for each tier 
was then tallied. It is important to note that occupied household counts are current as of the end of 
2008.  This section will show the results of this Statewide analysis based upon total land-area and total 
household within the certain speed tiers. 

 

Analysis by Land Area & Households Covered 
 Analysis reveals that Illinois has distinct geographic patterns associated with underserved and 
un-served areas of Illinois. Using Figure 2.1, the PCI Data Team was able to inventory household counts 
and speed tier coverage by geographic area as shown in Table 2.1.   
 

Using this information, PCI calculates1 that zero percent of the State is served by Gigabit or 100 
Mbps broadband; that 65 percent of households in the State are served by broadband with advertised 
speeds of 50 Mbps and higher (for 8 percent of the land area); that 29 percent of households are served 
by broadband with advertised speeds of 10 Mbps to 50 Mbps (or 26 percent of the land area); that 2 
percent of households are served by broadband with advertised speeds of 6 Mbps to 10 Mbps (for 10 
percent of the land area); that 3 percent of households are served by broadband with advertised speeds 
of 3 Mbps to 6 Mbps (for 28 percent of land area); that half a percentage point are served by broadband 
with advertised speeds of 1.5 Mbps to 3 Mbps (for 6 percent of the land area); and that one-third a 
percentage point are served by broadband with advertised speeds of 768 Kbps to 1.5 Mbps (for 3 
percent of the land area). An additional 1 percent of households are served by internet at non-
broadband speeds, e.g. dial-up service (for 19 percent of land area). As Figure 2.1 shows, counties in 
southern, western, and southeastern Illinois are more at risk for access or meeting national goals for 
speed.  

                                                             
1
 Each of these calculations are subject to the three important points highlighted in the introduction: (1) ensuring that 

data from providers is correct and updated; (2) verifying advertised speeds against actual speeds measured by end-

users; and (3) understanding public expectations about the need for, and use of, ever-increasing broadband speeds. 
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Figure 2.1:  Statewide broadband coverage by maximum advertised download speed. 
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Table 2.1:   Speed Tiers by Household Counts and Geographic Coverage 
 

Maximum Advertised Download Speed Tier 
 Number of Occupied 

Households with access  
Percentage of State 

Occupied Households Total 
Percentage of Land Area Covered 

by Speed Tier 

50-100 mbps 
                                
3,161,172  65.15% 7.80% 

25-50 mbps 
                                                    
-    0.00% 0.00% 

10-25mbs 
                                
1,399,699  28.85% 25.78% 

6-10 mbps 
                                       
79,537  1.64% 10.14% 

3 - 6 mbps 
                                    
124,910  2.57% 28.47% 

1.5 mbps - 3 mbps 
                                       
23,703  0.49% 6.41% 

768 kbps - 1.5 mbps 
                                       
14,330  0.30% 2.57% 

Total occupied households without access 
(contained in 18,478 census blocks) 

                                       
48,471  1.00% 18.83% 

Statewide Total Occupied Households 
                                
4,851,822  

 

land area statewide 55,593 sq. 
mi. 

 
Examining speed tiers geographically helps in assessing potential long-term broadband goals for 

access. What is the implication of having only 7.80 percent of the State of Illinois with access up to 50 to 
100 Mbps, as shown in Figure 2.2?  Figure 2.3 shows the percentage of households who could access 
these speeds, this does not show the speed tiers actually subscribed to, nor does it show the percentage 
of households who have broadband internet services. 

 
Figure 2.2:  Speed Tiers by Geographic Coverage in Illinois 
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Figure 2.3:  Percentage of occupied households with access to particular speed tiers.  

 

 
  

This baseline demonstrates that the most significant investment in broadband occurs in areas 
where population is most dense.  Thus, the challenge for Illinois is to ensure that the investment in 
broadband becomes a priority throughout the entire State so that all citizens receive the benefits of 
broadband.  For example, how can all citizens benefit from advancements in telemedicine or distance 
learning that requires 25 Mbps or higher connection speeds?  Simply put, location matters just as much 
as the percentages, and this determines what type (and speed) of broadband access any given 
household, community anchor institutions, or business will have access to. What are the economic 
development and quality of life issues that are being impacted by the capacity of the current broadband 
networks within the State? PCI's goal is to assist stakeholders in identifying these disparities in 
broadband access, and to engage discussions on the economic/cultural impacts on such diverse access 
to supply in Illinois as well as the realities of improving the infrastructure over time. 
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Part 3:  County Level Rankings 
 

 One of the objectives of this report is to develop a ranking system to compare geographic units 
for broadband access.  In a state where the average household income is $82,835 at the high end in 
Kendall County and $28,370 at the low end in Alexander County, this ranking system based upon 
broadband connectivity is absolutely essential.  In this section, we will take a closer look at the 
methodology that was used to rank Illinois’s 102 counties based upon the level of broadband access 
within them.  We will conclude this discussion with a look at some of the socioeconomic variables that 
we have found to coincide with high and low levels of broadband connectivity.   
 
Ranking Methodology by Geographic Coverage and Household Count 

PCI’s data team targeted counties as an initial focus to demonstrate and produce maps using a 
ranking system ranging from (1-102).  Results indicated dynamic regional patterns across Illinois’ 102 
counties (Figure 3.1).  For this baseline inventory, ranking will be based on speed availability and the 
ratio of geographic coverage of each speed tier relative to the master geographic unit of study. Using 
weighted averages between the two variables produces a score, assisting PCI in evaluating counties 
against each other for broadband availability. In addition, it will assist in developing an index or score to 
assess an individual county over time for improvements on access.  

 
The geographic unit for the ranking and comparison is the county boundaries. This geographic 

unit is widely understood and relates to many levels of local government, economic development, and 
PCI eTeam efforts. Geographic coverage was defined as the maximum advertised download speed, 
based on NTIA speed tier codes, for all carriers at that speed within a county. These speed tiers were 
summarized for the percentage of the county's geographic area represented by each speed tier. A 
weighted average for each speed tier's coverage of the county as a percentage was multiplied by the 
speed tier value itself. In summarizing a county's overall score, each county’s speed tiers weighted 
averages were summarized resulting in the broadband score. The maximum value for the score would 
equal a value of nine for a given county. A value of nine would represent a county with 100 percent 
coverage at the fastest NTIA speed tier. Using these scores, a ranking from 1 to 102 was developed 
representing all Illinois counties and how they compared against each other relative to the percentage 
of households covered by NTIA speed tiers. 

 
 The map in Figure 3.1 indicates geographic trends associated with broadband access and supply.  
Using this ranking system PCI has established a baseline to evaluate broadband access over time.  Using 
the rank model any given county can assess their broadband access over time using simply metrics 
linking speed with geographic coverage, and also comparing that to other counties and regarding 
statewide results.  Geographic patterns suggest real strengths in the Chicago metro area as most of the 
counties rank the highest there. Areas in southern and western Illinois are behind relative to access and 
speed.  Goals and outcomes of this research are to assist broadband stakeholders to visually see these 
disparities at both state and local levels. At the minimum, each county now has a baseline to evaluate 
their position (Appendix A) in Illinois relative to broadband access, and can assess over time how they 
are improving or declining in relation to other counties.  
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Figure 3.1:  County Broadband Access Rank Map Weighted by Percent of Geographic Area Covered by 
NTIA Speed Tiers 

 

A similar system was used to rank Illinois’s 102 counties by household count.  As with Figure 3.1, a 
weighted average for each speed tier's coverage of the county’s occupied households as a percentage 
was multiplied by the speed tier value itself. In summarizing a county's overall score, each county’s 
speed tiers weighted averages are summarized, resulting in the occupied household broadband score. 
The maximum value for the score would equal a value of nine for a given county. A value of nine would 
represent a county with 100 percent coverage by household accessibility at the fastest NTIA speed tier.  
Using these scores, a ranking from 1 to 102 was developed representing all Illinois counties and how 
they compared against each other relative to the percentage of households covered by NTIA speed tiers. 
While there are some changes from the previous figure, the overall geographic picture remains the 
same. 
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Figure 3.2:  County Broadband Rank Map Weighted by Percentage of Households Covered by NTIA 
Speed Tiers 

 
 

 
 
Geographic patterns, socioeconomic factors & broadband deployment 

Another goal for this research was to begin exploring local socioeconomic factors shaping 
broadband deployments.  Examining the counties listed in Tables 3.1 (as well as the full list of counties 
listed in Appendix A), what factors or variables can be empirically connected to counties with higher or 
lower broadband ranks? Understanding this information will assist PCI and the broader research 
community in defining at risk populations both geographically and demographically.  This information 
will provide guidance in developing policies targeted in the correct areas and populations for 
improvements in broadband infrastructure, adoption and access.   
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Table 3.1:  Top 10 & Bottom 10 Broadband Ranked Counties 
 

County Ranking 
2010 

Workforce 
2010 

Unemployed 
% 

RATE 

 Resident 
total 

population 
2010  

 Median 
household 

income 
2009  

People of 
all ages in 
poverty - 
percent 

2009 

 Total 
number 
of firms 

2007  

 Land in 
farms 
2007 

(acres 
adjusted)  

 Land 
area in 
square 
miles 
2000  

Population 
per square 
mile 2010 

DUPAGE 1 524,521 43,516 8.3 
       
916,924  

 $    
73,554  6.7 

     
101,556  

            
7,948  

            
334  2748.5 

COOK 2 2,604,300 272,436 10.5 
   
5,194,675  

 $    
52,516  16 

     
511,023  

            
8,198  

            
946  5493.1 

LAKE 3 365,683 38,395 10.5 
       
703,462  

 $    
76,336  7.6 

        
68,447  

         
34,525  

            
448  1571.8 

WILL 4 367,626 38,339 10.4 
       
677,560  

 $    
72,478  7 

        
53,101  

      
220,851  

            
837  809.6 

KANE 5 271,334 27,947 10.3 
       
515,269  

 $    
66,604  9.4 

        
38,590  

      
192,372  

            
520  990.1 

KENDALL 6 60,201 5,914 9.8 
       
114,736  

 $    
82,835  4.2 

           
8,311  

      
166,872  

            
321  357.9 

MCHENRY 7 180,783 17,286 9.6 
       
308,760  

 $    
74,669  6.6 

        
28,523  

      
215,584  

            
604  511.6 

KANKAKEE 8 57,222 7,511 13.1 
       
113,449  

 $    
49,375  15.1 

           
8,399  

      
385,808  

            
677  167.6 

OGLE 9 27,915 3,778 13.5 
          
53,497  

 $    
52,197  10.9 

           
4,622  

      
366,470  

            
759  70.5 

GRUNDY 10 26,784 3,325 12.4 
          
50,063  

 $    
63,349  6.8 

           
3,673  

      
215,474  

            
420  119.2 

PIKE 93 8,780 776 8.8 
        
16,430   $   38,191  17.1 

        
1,444  

      
389,808  

                
830  19.8 

LAWRENCE 94 8,222 785 9.5 
        
16,833   $   36,587  18.1 

        
1,242  

      
194,035  

                
372  45.3 

ALEXANDER 95 2,982 351 11.8 
           
8,238   $   28,370  29.4 

            
383  

         
47,626  

                
236  34.9 

MASSAC 96 7,190 700 9.7 
        
15,429   $   38,302  16.4 

        
1,395  

         
89,693  

                
239  64.5 

GALLATIN 97 2,688 271 10.1 
           
5,589   $   34,319  19.3 

            
548  

      
185,753  

                
324  17.3 

UNION 98 8,351 1,011 12.1 
        
17,808   $   38,080  20 

        
1,451  

      
122,362  

                
416  42.8 

JOHNSON 99 5,229 573 11 
        
12,582   $   40,497  16.9 

            
713  

      
100,499  

                
345  36.5 

POPE 100 1,917 208 10.9 
           
4,470   $   37,177  18 

                  
-    

         
60,809  

                
371  12.1 

WABASH 101 6,112 609 10 
        
11,947   $   42,564  12.7 

        
1,104  

      
114,361  

                
223  53.5 

CALHOUN 102 2,524 274 10.9 
           
5,089   $   44,930  11.3 

                  
-    

         
87,938  

                
254  20 

 
 
 
 
 
 
 
 
 



                                           
Partnership for a Connected Illinois 

Narratives and Methodologies 

 
 

 
October 2011   49 
 

Figure 3.3:  Top & Bottom 10 Ranked Counties 

 

 
 

When looking at the extreme ranges for broadband access, spatial patterns between northern and 
southern Illinois are revealed in Figure 3.3.  However, the more interesting question begins with 
addressing what are the differences between these counties from a marketing and/or demographic 
perspective? Looking at local socioeconomic factors relating to economic development, employment, 
and population density begins to unravel the factors driving broadband markets in Illinois (Tables 3.1 
and Figures 3.4 through 3.7). 

 
This information indicates patterns or commonalties for counties with better broadband service. 

Counties associated with larger populations, high incomes, and greater numbers of businesses attract 
and get more broadband services. Likewise, smaller rural counties, with lower household incomes, and 
less businesses do not attract as many broadband services.  Knowing these and other variables 
impacting broadband deployments need to be more fully defined, measured, and empirically validated. 
This information will assist the broadband research community in assessing what viable markets look 
like, and also how to reposition underserved or un-served areas to attract new services. It is important 
to ask the question, does better broadband access drive these socio-economic factors or is the better 
broadband access an effect of the socio economic factors? 
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Figure 3.4 
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Figure 3.5 
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Figure 3.6 
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Figure 3.7 
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Conclusion 
 

 This report serves to start a discussion among the Illinois broadband stakeholder community.  
Simply put, this report poses and introduces some early results on scoping the current broadband access 
landscape across the State of Illinois.  In summary, this study concludes large geographic disparities for 
speeds across the state.  In particular, specific regions in southern and western Illinois have both access 
and speed deficiencies in relation to State averages. Fiber developments offering speeds of 1 Gigabit per 
second connectivity have been extremely limited – although that is likely to change with a variety of 
broadband projects funded by the American Recovery and Reinvestment Act, and by State capital fund 
dollars. Providers serving Chicago and the Collar counties report broadband at speeds in the 50-100 
Mbps range, as do providers serving the Kankakee area, and a few other limited areas. Connectivity in 
the 10-25 Mbps range appears to be available in most of the cities around the State, including the Quad 
Cities, Macomb, Peoria, Champaign, Danville, Springfield, Taylorsville, Charleston, Effingham, Metro East 
and Carbondale. Even these observations need to be qualified by the points stated in the introduction: 
the constant refinement of broadband information in partnership with the providers, and the need to 
verify actual speeds against advertised speeds; and in consumers’ evolving expectations of adequate 
speeds of broadband connectivity, particularly for engaging in typical home and business broadband use 
(and not, for example, applications and uses common mobile broadband users).  

 
How does the State of Illinois leverage and harness the full potential of broadband in economic 

development, business, and community service with this type of system?  This data suggest, at the most 
basic level, that broadband companies are attracted to the most viable markets for private sector 
investment and network sustainability. Our data suggest these early markets are defined by issues 
relating to population patterns, incomes, and business activity.  Again, this list is by no means 
exhaustive; however, it does represent an early attempt to define factors shaping broadband markets.   
 
 In summary, this reports looks for feedback on what steps are needed to move broadband 
research forward in Illinois.  PCI’s broader mission relates to using data to support and increased access 
and infrastructure, and enhancing the adoption, use and maximum impact of broadband by private and 
public sector entities across the State. In this process, PCI aims to capture and measure the social and 
economic impacts of broadband.  PCI’s data team is currently exploring external data sets to address 
these concerns relating to business activity, take rates and pricing information. One of primary goals is 
to assess in measurable ways how broadband impacts jobs and economic development.  These types of 
stories and measurable impacts will be critical in elevating demand, which in theory; will drive more 
carriers to produce supply. We look forward to feedback and engagement from other broadband 
stakeholders in addressing these research questions.  
 
Partnership for a Connected Illinois 
August 15, 2011 
 
413 West Monroe Street | Springfield, IL 62704 | 217-886-4228 | info@broadbandillinois.org 

 
 
 
 

mailto:info@broadbandillinois.org


                                           
Partnership for a Connected Illinois 

Narratives and Methodologies 

 
 

 
October 2011   55 
 

Appendix A – County Broadband Access Ranking Chart 

County Rank 
2010 

Workforce 
2010 

Unemployed 
% 

Rate 

 Resident 
total 

population 
2010  

 Median 
household 

income 
2009  

People 
of all 

ages in 
poverty  

2009 

 Total 
number of 
firms 2007  

 Land in 
farms 
2007 

(acres 
adjusted)  

 Land 
area in 
Sq. mi. 
2000  

Pop 
per 

square 
mile 
2010 

ADAMS 64 38,371 2,846 7.4          67,103   $    41,582  15.7             5,561      374,133             857  78.3 

ALEXANDER 95 2,982 351 11.8             8,238   $    28,370  29.4                 383         47,626             236  34.9 

BOND 35 8,636 870 10.1          17,768   $    45,520  13.7             1,350      224,760             380  46.7 

BOONE 12 26,452 4,194 15.9          54,165   $    60,425  8.9             3,425      137,162             281  192.6 

BROWN 75 3,572 181 5.1             6,937   $    42,134  15.9                 373      151,058             306  22.7 

BUREAU 48 19,555 2,222 11.4          34,978   $    47,015  12.8             2,918      478,389             869  40.3 

CALHOUN 102 2,524 274 10.9             5,089   $    44,930  11.3                       -           87,938             254  20 

CARROLL 24 8,424 954 11.3          15,387   $    41,578  13.2             1,669      265,153             444  34.6 

CASS 56 7,793 607 7.8          13,642   $    41,828  12.5             1,166      173,543             376  36.3 

CHAMPAIGN 22 106,393 9,567 9       201,081   $    42,101  19.9          13,525      550,481             997  201.7 

CHRISTIAN 14 18,266 1,819 10          34,800   $    43,182  14.7             2,949      449,512             709  49.1 

CLARK 80 8,260 1,041 12.6          16,335   $    43,003  13.4             1,452      238,706             502  32.6 

CLAY 67 6,631 805 12.1          13,815   $    37,055  14.7                 732      209,834             469  29.4 

CLINTON 21 18,730 1,552 8.3          37,762   $    53,873  8.4             2,876      268,441             474  79.6 

COLES 19 27,941 2,676 9.6          53,873   $    37,790  19.1             3,872      254,869             508  106 

COOK 2 2,604,300 272,436 10.5   5,194,675   $    52,516  16       511,023            8,198             946  5493.1 

CRAWFORD 72 9,789 934 9.5          19,817   $    40,572  15.2             1,597      205,356             444  44.7 

CUMBERLAND 58 5,628 586 10.4          11,048   $    41,962  11.4                 626      144,981             346  31.9 

DEKALB 11 60,076 5,831 9.7       105,160   $    51,087  17             7,815      370,772             634  165.8 

DEWITT 30 9,035 796 8.8          16,561   $    47,820  11.1             1,165      198,680             398  41.7 

DOUGLAS 27 10,281 955 9.3          19,980   $    49,916  8.7             1,871      261,513             417  47.9 

DUPAGE 1 524,521 43,516 8.3       916,924   $    73,554  6.7       101,556            7,948             334  2748.5 

EDGAR 62 10,360 1,122 10.8          18,576   $    40,560  16             1,251      352,535             624  29.8 

EDWARDS 90 3,186 292 9.2             6,721   $    40,030  11.3                 500      116,690             222  30.2 

EFFINGHAM 34 18,471 1,548 8.4          34,242   $    47,485  10.2             3,422      242,009             479  71.5 

FAYETTE 78 10,562 1,216 11.5          22,140   $    39,611  20.2             2,194      303,258             716  30.9 

FORD 54 7,130 718 10.1          14,081   $    45,821  9.9             1,500      270,720             486  29 

FRANKLIN 71 18,214 2,339 12.8          39,561   $    32,417  18.8             3,165      207,877             412  96 

FULTON 79 18,774 2,188 11.7          37,069   $    40,694  13.9             2,540      385,302             866  42.8 

GALLATIN 97 2,688 271 10.1             5,589   $    34,319  19.3                 548      185,753             324  17.3 

GREENE 88 6,976 671 9.6          13,886   $    39,226  14.3             1,080      273,088             543  25.6 

GRUNDY 10 26,784 3,325 12.4          50,063   $    63,349  6.8             3,673      215,474             420  119.2 

HAMILTON 55 4,115 400 9.7             8,457   $    39,337  14.2             1,013      219,873             435  19.4 

HANCOCK 61 9,584 1,104 11.5          19,104   $    43,774  11.6             2,125      392,898             795  24 

HARDIN 87 1,813 210 11.6             4,320   $    33,367  21.4                 446         34,733             178  24.2 

HENDERSON 91 3,820 389 10.2             7,331   $    43,041  12.2                 604      170,443             379  19.4 

HENRY 15 26,991 2,479 9.2          50,486   $    50,193  9.8             3,237      489,903             823  61.3 

IROQUOIS 44 17,138 1,720 10          29,718   $    46,419  12.2             2,722      677,803         1,116  26.6 

JACKSON 82 32,827 2,579 7.9          60,218   $    30,899  28.5             4,212      224,414             588  102.4 

JASPER 69 5,050 486 9.6             9,698   $    47,087  11.3             1,127      243,451             494  19.6 

JEFFERSON 66 20,760 1,994 9.6          38,827   $    38,326  18.9             2,846      232,531             571  68 

JERSEY 60 11,619 1,093 9.4          22,985   $    48,573  10             2,278      189,462             369  62.3 

JO DAVIESS 53 13,230 1,159 8.8          22,678   $    47,103  10.5             2,655      281,457             601  37.7 

JOHNSON 99 5,229 573 11          12,582   $    40,497  16.9                 713      100,499             345  36.5 

KANE 5 271,334 27,947 10.3       515,269   $    66,604  9.4          38,590      192,372             520  990.1 

KANKAKEE 8 57,222 7,511 13.1       113,449   $    49,375  15.1             8,399      385,808             677  167.6 

KENDALL 6 60,201 5,914 9.8       114,736   $    82,835  4.2             8,311      166,872             321  357.9 
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KNOX 43 26,206 2,498 9.5          52,919   $    40,056  13.2             3,333      362,951             716  73.9 

LAKE 3 365,683 38,395 10.5       703,462   $    76,336  7.6          68,447         34,525             448  1571.8 

LASALLE 20 60,381 7,880 13.1       113,924   $    52,208  12.5             8,452      643,291         1,135  100.4 

LAWRENCE 94 8,222 785 9.5          16,833   $    36,587  18.1             1,242      194,035             372  45.3 

LEE 17 18,496 2,034 11          36,031   $    46,901  10.5             2,448      395,624             725  49.7 

LIVINGSTON 36 19,206 1,996 10.4          38,950   $    50,173  11.2             2,551      628,502         1,044  37.3 

LOGAN 52 13,687 1,311 9.6          30,305   $    45,722  13.8             1,823      320,356             618  49 

MACON 26 55,274 6,502 11.8       110,768   $    44,407  15.1             7,843      290,603             581  190.8 

MACOUPIN 45 24,165 2,567 10.6          47,765   $    44,673  12.1             3,653      394,228             864  55.3 

MADISON 16 138,701 13,582 9.8       269,282   $    50,628  13.1          18,652      312,936             725  371.4 

MARION 63 18,341 2,222 12.1          39,437   $    37,277  19.4             3,236      260,679             572  68.9 

MARSHALL 49 7,137 688 9.6          12,640   $    46,526  10.4             1,057      204,584             386  32.7 

MASON 73 7,719 967 12.5          14,666   $    43,947  12.5                 651      273,362             539  27.2 

MASSAC 96 7,190 700 9.7          15,429   $    38,302  16.4             1,395         89,693             239  64.5 

MCDONOUGH 18 17,094 1,490 8.7          32,612   $    36,381  22.6             2,554      307,725             589  55.3 

MCHENRY 7 180,783 17,286 9.6       308,760   $    74,669  6.6          28,523      215,584             604  511.6 

MCLEAN 39 93,167 7,201 7.7       169,572   $    56,471  14.4          12,693      675,984         1,184  143.3 

MENARD 38 7,095 557 7.9          12,705   $    55,260  9.3             1,128      168,594             314  40.4 

MERCER 84 8,770 951 10.8          16,434   $    54,533  9.4             1,344      306,306             561  29.3 

MONROE 65 18,528 1,442 7.8 32,957  $    71,342 5 3,242  178,134  388  84.9 

MONTGOMERY 42 13,779 1,800 13.1          30,104   $    37,458  14.9             2,543      347,765             704  42.8 

MORGAN 51 17,750 1,660 9.4          35,547   $    42,672  14.1             2,795      320,512             569  62.5 

MOULTRIE 40 8,046 693 8.6          14,846   $    45,758  10.8             1,186      167,791             336  44.2 

OGLE 9 27,915 3,778 13.5          53,497   $    52,197  10.9             4,622      366,470             759  70.5 

PEORIA 57 98,594 10,610 10.8       186,494   $    47,330  16.8          13,461      259,204             620  301 

PERRY 76 9,514 1,135 11.9          22,350   $    40,276  17.8             1,445      200,354             441  50.7 

PIATT 25 8,952 753 8.4          16,729   $    58,519  6.7             1,407      267,265             440  38 

PIKE 93 8,780 776 8.8          16,430   $    38,191  17.1             1,444      389,808             830  19.8 

POPE 100 1,917 208 10.9             4,470   $    37,177  18                       -           60,809             371  12.1 

PULASKI 89 2,870 322 11.2             6,161   $    32,671  25.1                 264      101,189             201  30.7 

PUTNAM 81 3,267 393 12             6,006   $    56,372  8.5                 493         62,705             160  37.6 

RANDOLPH 46 15,424 1,409 9.1          33,476   $    43,160  13.3             2,250      252,926             578  57.9 

RICHLAND 47 7,388 742 10          16,233   $    40,037  15.1             1,481      202,860             360  45.1 

ROCK ISLAND 29 78,729 7,488 9.5       147,546   $    48,668  11.2             9,363      178,623             427  345.7 

SALINE 85 12,961 1,310 10.1          24,913   $    35,723  16.6             1,937      117,233             383  65 

SANGAMON 23 110,862 8,876 8       197,465   $    52,581  13.1          17,195      518,153             868  227.4 

SCHUYLER 68 4,271 318 7.4             7,544   $    44,814  13.3                 508      207,457             437  17.3 

SCOTT 92 2,756 266 9.7             5,355   $    49,450  10.4                 449      135,731             251  21.3 

SHELBY 37 11,266 1,146 10.2          22,363   $    44,956  10.9             1,699      387,288             759  29.5 

ST CLAIR 13 124,858 13,666 10.9       270,056   $    46,368  17.1          17,084      306,533             664  406.8 

STARK 70 2,887 313 10.8             5,994   $    46,211  11.5                       -        169,775             288  20.8 

STEPHENSON 74 24,641 2,886 11.7          47,711   $    44,307  13             3,662      337,932             564  84.6 

TAZEWELL 33 73,637 7,458 10.1       135,394   $    53,904  8.3             9,910      329,268             649  208.7 

UNION 98 8,351 1,011 12.1          17,808   $    38,080  20             1,451      122,362             416  42.8 

VERMILION 41 37,494 4,547 12.1          81,625   $    37,167  21.7             5,848      457,375             899  90.8 

WABASH 101 6,112 609 10          11,947   $    42,564  12.7             1,104      114,361             223  53.5 

WARREN 59 9,421 794 8.4          17,707   $    43,296  13.6             1,350      294,907             543  32.6 

WASHINGTON 28 8,341 656 7.9          14,716   $    50,299  9.6                       -        353,903             563  26.2 
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WAYNE 83 8,192 791 9.7          16,760   $    40,497  14.6             1,653      333,255             714  23.5 

WHITE 77 7,826 682 8.7          14,665   $    38,905  15.5             1,250      296,989             495  29.6 

WHITESIDE 32 30,246 3,280 10.8          58,498   $    45,359  11.8             4,063      405,333             685  85.4 

WILL 4 367,626 38,339 10.4       677,560   $    72,478  7          53,101      220,851             837  809.6 

WILLIAMSON 86 35,622 3,348 9.4          66,357   $    39,386  18.3             5,889         94,124             423  156.7 

WINNEBAGO 31 146,319 22,185 15.2       295,266   $    44,390  17.7          23,684      183,615             514  574.7 

WOODFORD 50 21,478 1,743 8.1          38,664   $    64,748  6.8             2,365      288,400             528  73.2 

 
About the Authors  
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Mike Rudibaugh is the Mapping and Analysis Director for PCI 
 
Dr. Rudibaugh’s career started as a faculty member instructing Earth Science and Geographic 
Information Systems courses at Lake Land College in 1996.  He has worked on numerous federal grants 
relating to STEM education and workforce development issues challenging the American economy.  Dr. 
Rudibaugh holds a B.A. from Eastern Illinois University (Psychology) and a M.A. (1996) and Ph.D. (2006) 
from Indiana State University in Economic Geography.  His dissertation research focused on assessing 
the impact of location (urban vs. rural) and resulting influence on strategic planning issues impacting 
community colleges. He currently serves as Director of Mapping and Analysis for the Partnership for a 
Connected Illinois. 

 
 
About Brian Webster   
Brian Webster is the Telecom Data Coordinator for PCI  
 
Brian Webster Consulting and Wirelessmapping.com were created to fill a need for affordable wireless 
engineering services for those unable to justify the cost of hiring and maintaining fulltime RF Engineering 
and mapping staff. Projects are approached with a creative eye, cost-conscious methodology and over 
21 years of telecommunications industry experience. The integration of Geographic Information Systems 
(GIS) helps present complex engineering and demographic information in clear, color diagrams that help 
the end user make actionable fact based decisions. These capabilities allow demographic data and 
market analysis information to be included as overlays to engineering diagrams, along with raw data for 
input to financial and/or analytical models. Brian has been conducting studies and mapping competitive 
broadband technologies at the census block level for over eight years. This data was used to assist 
broadband network operators as they work to cover un-served markets.  He currently serves as the 
Telecom Data Coordinator for the Partnership for a Connected Illinois. 
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Complete 152
Non-Responsive/Refused 10
In Progress 6

Count of Datasets by Status 168
Total Unique Providers Represented 100

Provider Name Platform Status NDA Execution Date Notes

American Broadband Acquisition Corporation Fiber Data Added to Statewide Inventory 11/20/2009

[SEP-8-11 Brian Dudek] Change: 
New provider in the fiber residential 
market for October 2011 submission.

AT&T Communications of Texas, Inc. DSL Data Added to Statewide Inventory 12/16/2009

[AUG-26-11 Brian Dudek] 
Change/Correction: possible service 
expansion or corrections to previous 
dataset; entirely new dataset for 
October 2011 submission.

AT&T Communications of Texas, Inc. Mobile Wireless Data Added to Statewide Inventory 12/16/2009

[AUG-19-11 Brian Dudek] Change: 
Provider greatly expanded mobile 
territory throughout the state.

Blue Valley Tele-Communications, Inc. Fiber Data Added to Statewide Inventory 11/17/2009

[SEP-8-11 Brian Dudek] Change: 
Provider expanded fiber territory into 
two exchanges.

Cable ONE Inc. Cable Data Added to Statewide Inventory 12/7/2009

[SEP-1-11 Brian Dudek] 
Change/Correction: possible service 
expansion or corrections to previous 
dataset; entirely new dataset for 
October 2011 submission.  Coverage 
change likely primarily a result of the 
2000-2010 census change.

CenturyLink DSL Data Added to Statewide Inventory 12/4/2009

[SEP-1-11 Brian Dudek] 
Change/Correction: possible service 
expansion or corrections to previous 
dataset; entirely new dataset for 
October 2011 submission.

Cequel Communications Cable Data Added to Statewide Inventory 12/15/2009

[SEP-1-11 Brian Dudek] 
Change/Correction: possible service 
expansion or corrections to previous 
dataset; entirely new dataset for 
October 2011 submission.  Coverage 
change likely primarily a result of the 
2000-2010 census change.

City of Coffeyville Fixed Wireless Data Added to Statewide Inventory

[AUG-24-11 Brian Dudek] Correction: 
New provider for October 2011 
submission that was previously 
gathering data, but had never 
submitted anything.

Clearwire Corporation Mobile Wireless Data Added to Statewide Inventory 3/17/2011
[SEP-1-11 Brian Dudek] Change: 
Provider expanded mobile territory.

Comcast Cable Communications, LLC Cable Data Added to Statewide Inventory 12/7/2009

[AUG-23-11 Brian Dudek] 
Change/Correction: possible service 
expansion or corrections to previous 
dataset; entirely new dataset for 
October 2011 submission. Coverage 
change likely primarily a result of the 
2000-2010 census change.

CoxCom Inc. Cable Data Added to Statewide Inventory 1/29/2010

[AUG-26-11 Brian Dudek] 
Change/Correction: possible service 
expansion or corrections to previous 
dataset; entirely new dataset for 
October 2011 submission. Coverage 
change likely primarily a result of the 
2000-2010 census change.

Craw-Kan Telephone Cooperative, Inc. DSL Data Added to Statewide Inventory 12/7/2009

[SEP-1-11 Brian Dudek] Change: 
Provider upgraded infrastructure to 
higher speeds.

Craw-Kan Telephone Cooperative, Inc. Fiber Data Added to Statewide Inventory 12/7/2009

[SEP-1-11 Brian Dudek] Change: 
Provider expanded fiber territory into 
Girard. 

Cunningham Communications, Inc. Fiber Data Added to Statewide Inventory 9/8/2009

[SEP-7-11 Brian Dudek] Change: 
Provider expanded fiber territory into 
two other exchanges that were 
previously DSL.

Eagle Communications, Inc. Cable Data Added to Statewide Inventory

[SEP-1-11 Brian Dudek] Correction: 
Maximum advertised speeds in 6 
towns were corrected to portray the 9 
speed tier.

Broadband Provider Log



Eagle Communications, Inc. Fiber Data Added to Statewide Inventory

[SEP-1-11 Brian Dudek] 
Change/Correction: Provider 
expanded fiber territory and corrected 
speeds to speed tier 9.

Fairpoint Communications, Inc. DSL Data Added to Statewide Inventory 1/22/2010

[AUG-26-11 Brian Dudek] 
Change/Correction: Provider 
expanded DSL territory in one area in 
western KS and corrected some 
coverage areas. 

Golden Belt Telephone Association, Inc. Cable Data Added to Statewide Inventory

[SEP-1-11 Brian Dudek] Change: 
Provider no longer offers cable 
service in Schoenchen anymore.  
Increased advertised upload speeds 
in all the cable towns.  

Golden Belt Telephone Association, Inc. DSL Data Added to Statewide Inventory

[SEP-1-11 Brian Dudek] Change: 
Provider converted some DSL 
infrastructure to fiber and upgraded 
infrastructure to higher speeds.

Golden Belt Telephone Association, Inc. Fiber Data Added to Statewide Inventory
[SEP-1-11 Brian Dudek] Change: 
Provider expanded fiber territory.

Home Communications, Inc. Cable Data Added to Statewide Inventory 11/5/2009

[SEP-6-11 Brian Dudek] Change: 
Provider upgraded download and 
upload speed capabilities.

Home Communications, Inc. Fiber Data Added to Statewide Inventory 11/5/2009

[SEP-8-11 Brian Dudek] Change: 
Provider expanded fiber territory into 
two exchanges.

Home Communications, Inc. DSL Data Added to Statewide Inventory 11/5/2009

[SEP-8-11 Brian Dudek] Change: 
Provider converted DSL 
infrastructure in two exchanges to 
fiber.

JBN Telephone Company, Inc. Fixed Wireless Data Added to Statewide Inventory 12/14/2009

[SEP-9-11 Brian Dudek] Change: 
Provider added additional 
transmission points in 3650 
spectrum.

JBN Telephone Company, Inc. Cable Data Added to Statewide Inventory 12/14/2009

[SEP-6-11 Brian Dudek] 
Change/Correction: New platform 
from provider. May have been in 
existence during prior submissions, 
but there is not any confirmation that 
this was in service previously.

Knology of Kansas Fixed Wireless Data Added to Statewide Inventory 7/13/2011

[AUG-22-11 Brian Dudek] Change: 
After purchase of Sunflower 
Broadband, provider altered wireless 
infrastructure to provide slightly more 
coverage. 

Knology of Kansas Cable Data Added to Statewide Inventory 7/13/2011
[AUG-22-11 Brian Dudek] Change: 
Provider expanded cable territory.

Knology of Kansas Fiber Data Added to Statewide Inventory 7/13/2011

[AUG-22-11 Brian Dudek] Change: 
New provider in the fiber residential 
market for October 2011 submission.

Leap Wireless International, Inc. Mobile Wireless Data Added to Statewide Inventory 4/6/2010

[AUG-19-11 Brian Dudek] 
Change/Correction: Entire new 
dataset submitted for October 2011 
submission.  Reduced outskirt 
coverage around Kansas City.

Pioneer Telephone Association, Inc. Cable Data Added to Statewide Inventory 12/7/2009

[SEP-6-11 Brian Dudek] Change: 
Provider upgraded infrastructure to 
higher speeds.

Pioneer Telephone Association, Inc. Fiber Data Added to Statewide Inventory 12/7/2009

[SEP-8-11 Brian Dudek] Change: 
New provider offering fiber services 
for the October 2011 submission.

Rainbow Telecommunications Association, Inc. Cable Data Added to Statewide Inventory 12/9/2009

[SEP-6-11 Brian Dudek] Change: 
Reduction in cable coverage as all 
cable towns in ILEC area are now 
fiber.

Rainbow Telecommunications Association, Inc. Fiber Data Added to Statewide Inventory 12/9/2009

[SEP-6-11 Brian Dudek] Change: 
Provider expanded fiber territory to 
entire exchange.  

Rural Telephone Service Company, Inc. Fiber Data Added to Statewide Inventory 11/16/2009
[AUG-16-11 Brian Dudek] Change: 
Provider expanded fiber territory.

Rural Telephone Service Company, Inc. DSL Data Added to Statewide Inventory 11/16/2009

AUG-16-11 Brian Dudek] Change: 
Provider converted some DSL 
infrastructure to fiber.

Southeast Nebraska Communications DSL Data Added to Statewide Inventory

[SEP-1-11 Brian Dudek] Correction: 
New provider for October 2011 
submission that previously refused to 
participate due to small presence in 
state.

Southern Kansas Telephone Company, Inc. Cable Data Added to Statewide Inventory 12/31/2009

[SEP-6-11 Brian Dudek] Change: 
Provider expanded cable territory 
north of Clearwater along with 
changing coverage in Clearwater.

Southern Kansas Telephone Company, Inc. DSL Data Added to Statewide Inventory 12/31/2009

[SEP-8-11 Brian Dudek] Change: 
Provider upgraded infrastructure to 
higher speeds.

Southern Kansas Telephone Company, Inc. Fiber Data Added to Statewide Inventory 12/31/2009

[SEP-8-11 Brian Dudek] Correction: 
Provider provided corrections that 
reduced their fiber territory.



Sprint Nextel Corporation Mobile Wireless Data Added to Statewide Inventory 1/14/2010

[SEP-1-11 Brian Dudek] 
Change/Correction: possible service 
expansion or corrections to previous 
dataset; entirely new dataset for April 
2011 submission.  Very comparable 
to prior submission besides some 
minor spectrum 5 differences.

Stouffer Communications Fixed Wireless Data Added to Statewide Inventory 8/17/2011

[SEP-1-11 Brian Dudek] Correction: 
New provider for October 2011 
submission that was previously 
unresponsive.

T-Mobile USA, Inc. Mobile Wireless Data Added to Statewide Inventory 1/8/2010

[SEP-1-11 Brian Dudek] Change: 
Provider expanded mobile territory 
eastern KS.  Upgraded speed 
capabilities with HSPA+ 42.

Time Warner Cable LLC Cable Data Added to Statewide Inventory 12/21/2009

[SEP-1-11 Brian Dudek] 
Change/Correction: possible service 
expansion or corrections to previous 
dataset; entirely new dataset for 
October 2011 submission.  Coverage 
change likely primarily a result of the 
2000-2010 census change.  Provider 
upgraded almost entire infrastructure 
with higher speed capabilities.

Totah Communications, Inc. DSL Data Added to Statewide Inventory 9/8/2009

[SEP-1-11 Brian Dudek] Correction: 
Maximum upload speed tier was 
corrected to speed tier 3.  Incorrectly 
reported as speed tier 2 in past 
submissions.

United Communications Association, Inc. Mobile Wireless Data Added to Statewide Inventory 11/23/2009

[SEP-9-11 Brian Dudek] Change: 
Provider upgraded infrastructure to 
allow for higher download speeds.

United States Cellular Corporation Mobile Wireless Data Added to Statewide Inventory 2/15/2011

[SEP-1-11 Brian Dudek] 
Change/Correction: possible service 
expansion or corrections to previous 
dataset; entirely new dataset for April 
2011 submission.  Minor changes 
throughout coverage area.

Valnet Holdings LLC Fixed Wireless Data Added to Statewide Inventory

[SEP-9-11 Brian Dudek] 
Change/Correction: Provider added 
additional transmission points and 
requested DBA name change.

Verizon Communications, Inc. Mobile Wireless Data Added to Statewide Inventory 12/14/2009

[SEP-1-11 Brian Dudek] Change: 
Provider expanded mobile territory. 
Upgraded speeds in 700 mhz 
spectrum.

Wheatland Broadband Services Fixed Wireless Data Added to Statewide Inventory 6/17/2010

[SEP-1-11 Brian Dudek] Change: 
Provider added an additional 
transmission point near Sharon 
Springs.

Wilson Telephone Company, Inc. Fiber Data Added to Statewide Inventory 9/29/2009

[SEP-7-11 Brian Dudek] Change: 
Provider expanded fiber territory into 
Lucas exchange.

Windjammer Communications, LLC Cable Data Added to Statewide Inventory 11/16/2009

[AUG-15-11 Brian Dudek] Correction: 
New provider for October 2011 
submission that was previously 
unresponsive.

Level 3 Communications, LLC Backhaul Backhaul Provider Only Processing Complete 12/14/2009
Sprint Nextel Corporation Backhaul Backhaul Provider Only Processing Complete 1/14/2010
Verizon Communications, Inc. Backhaul Backhaul Provider Only Processing Complete 12/14/2009
Zayo Group, LLC Backhaul Backhaul Provider Only Processing Complete

SwiftLink Communications Fixed Wireless Estimated Coverage Submitted for Non-Participating Provider

[SEP-1-11 Brian Dudek] Correction: 
New provider for October 2011 
submission that is still unresponsive.  
Connected Nation estimated 
coverage for this provider.

Allegiance Communications Holdings, Inc. Cable No Update to Provide 2/4/2010
American Broadband Acquisition Corporation DSL No Update to Provide 11/20/2009
Atwood Cable Systems, Inc. Cable No Update to Provide
Benson Tel Service Inc. Fixed Wireless No Update to Provide 12/15/2009
Blue Valley Tele-Communications, Inc. Cable No Update to Provide 11/17/2009
Blue Valley Tele-Communications, Inc. Fixed Wireless No Update to Provide 11/17/2009
BWTelcom DSL No Update to Provide 1/12/2010
BWTelcom Fiber No Update to Provide 1/12/2010
CenturyLink Backhaul No Update to Provide 12/4/2009
City of Chanute Fiber No Update to Provide
City of Chanute Backhaul No Update to Provide
Columbus Telephone Company Fiber No Update to Provide 10/2/2009
CoxCom Inc. Backhaul No Update to Provide 1/29/2010
Craw-Kan Telephone Cooperative, Inc. Fixed Wireless No Update to Provide 12/7/2009
CTC Wireless Internet Backhaul No Update to Provide 11/20/2009
Cunningham Communications, Inc. Cable No Update to Provide 9/8/2009
Cyber Lodge Internet Services, Inc. Fixed Wireless No Update to Provide 1/6/2010
Diller Telephone Company DSL No Update to Provide



DISH Network Corporation Satellite No Update to Provide 1/27/2010

[SEP-16-11 Brian Dudek] Correction: 
Satellite data is being submitted and 
was not included in the April 2011 
submission. While coverage is 
currently the entire state boundary, 
work continues on having more 
granular data available.

Eagle Communications, Inc. Backhaul No Update to Provide
Eagle Communications, Inc. Fixed Wireless No Update to Provide
Elkhart Telephone Company, Inc. Backhaul No Update to Provide 3/23/2010
Elkhart Telephone Company, Inc. Fiber No Update to Provide 3/23/2010
Elkhart Telephone Company, Inc. Fixed Wireless No Update to Provide 3/23/2010
Fairpoint Communications, Inc. Fixed Wireless No Update to Provide 1/22/2010
Golden Belt Telephone Association, Inc. Fixed Wireless No Update to Provide
Gorham Communications, Inc. DSL No Update to Provide 9/30/2009
Gorham Communications, Inc. Fiber No Update to Provide 9/30/2009
H&B Communications, Inc. Cable No Update to Provide 10/13/2009
H&B Communications, Inc. DSL No Update to Provide 10/13/2009
H&B Communications, Inc. Fiber No Update to Provide 10/13/2009
H&B Communications, Inc. Fixed Wireless No Update to Provide 10/13/2009
Haug Communications, Inc. Fixed Wireless No Update to Provide 12/4/2009
Haviland Telephone Company, Inc. DSL No Update to Provide 12/3/2009
Haviland Telephone Company, Inc. Fixed Wireless No Update to Provide 12/3/2009

Hughes Network Systems, LLC Satellite No Update to Provide 2/5/2010

[SEP-16-11 Brian Dudek] Correction: 
Satellite data is being submitted and 
was not included in the April 2011 
submission. While coverage is 
currently the entire state boundary, 
work continues on having more 
granular data available.

JBN Telephone Company, Inc. DSL No Update to Provide 12/14/2009
Kansas Broadband Internet, Inc. Fixed Wireless No Update to Provide 1/15/2010
Kansas Data Internet, Inc. Fixed Wireless No Update to Provide
KeyOn Communications, Inc. Fixed Wireless No Update to Provide 10/15/2009
LaHarpe Telephone Company, Inc. Fiber No Update to Provide 9/28/2009
Lawrence Freenet Fixed Wireless No Update to Provide 10/5/2009
Madison Telephone Company, LLC DSL No Update to Provide 11/17/2009
MCC Missouri LLC Cable No Update to Provide 1/12/2010
MCC Missouri LLC Backhaul No Update to Provide 1/12/2010
Midwest Mobile Radio Fixed Wireless No Update to Provide
Mokan Dial, Inc. DSL No Update to Provide 12/2/2009
Moundridge Telephone Company, Inc. DSL No Update to Provide 10/7/2009
Mutual Telephone Company Backhaul No Update to Provide 12/9/2009
Mutual Telephone Company Fiber No Update to Provide 12/9/2009
Mutual Telephone Company Fixed Wireless No Update to Provide 12/9/2009
Nautilus Net Fixed Wireless No Update to Provide
North Central Kansas Community Network Fixed Wireless No Update to Provide
Peoples Telecommunications, LLC DSL No Update to Provide 12/1/2009
Pioneer Telephone Association, Inc. DSL No Update to Provide 12/7/2009
Pixius Communications LLC Fixed Wireless No Update to Provide
Rainbow Telecommunications Association, Inc. Fixed Wireless No Update to Provide 12/9/2009
Rebeltec Communications LLC Fixed Wireless No Update to Provide
Rural Telephone Service Company, Inc. Fixed Wireless No Update to Provide 11/16/2009
S&T Telephone Cooperative Association DSL No Update to Provide 8/28/2009
S&T Telephone Cooperative Association Fiber No Update to Provide 8/28/2009
S&T Telephone Cooperative Association Fixed Wireless No Update to Provide 8/28/2009
South Central Telephone Association Backhaul No Update to Provide 12/17/2009
South Central Telephone Association DSL No Update to Provide 12/17/2009
South Central Telephone Association Fiber No Update to Provide 12/17/2009

Stelera Wireless, LLC Mobile Wireless No Update to Provide

[SEP-9-11 Brian Dudek] Correction: 
Provider service area is now a real-
world propagation unlike prior 
submissions.

Sumner Cable TV, Inc. Cable No Update to Provide
Sumner Cable TV, Inc. Fixed Wireless No Update to Provide
Superior iNET Fixed Wireless No Update to Provide 1/29/2010
SWKO, Inc. Fixed Wireless No Update to Provide 2/18/2011
The Computer Generation, Inc. Fixed Wireless No Update to Provide 1/8/2010
Tri-County Telephone Association, Inc. DSL No Update to Provide 12/1/2009
Tri-County Telephone Association, Inc. Fiber No Update to Provide 12/1/2009
Tri-County Telephone Association, Inc. Fixed Wireless No Update to Provide 12/1/2009
Tri-Rivers Internet Fixed Wireless No Update to Provide
Twin Valley Telephone, Inc. DSL No Update to Provide 10/12/2009
Twin Valley Telephone, Inc. Fiber No Update to Provide 10/12/2009
Twin Valley Telephone, Inc. Fiber No Update to Provide 10/12/2009
Twin Valley Telephone, Inc. Fixed Wireless No Update to Provide 10/12/2009
TwinMounds Fixed Wireless No Update to Provide
United Communications Association, Inc. Cable No Update to Provide 11/23/2009
United Communications Association, Inc. DSL No Update to Provide 11/23/2009
United Communications Association, Inc. Fixed Wireless No Update to Provide 11/23/2009
Wamego Telecommunications Company, Inc. DSL No Update to Provide 9/29/2009
Wamego Telecommunications Company, Inc. Fiber No Update to Provide 9/29/2009
Wave Wireless LLC Fixed Wireless No Update to Provide 2/19/2010
Wheat State Telephone, Inc. DSL No Update to Provide 12/7/2009
Wheat State Telephone, Inc. Fiber No Update to Provide 12/7/2009



WildBlue Communications, Inc. Satellite No Update to Provide 1/8/2010

[SEP-16-11 Brian Dudek] Correction: 
Satellite data is being submitted and 
was not included in the April 2011 
submission. While coverage is 
currently the entire state boundary, 
work continues on having more 
granular data available.

Wilson Telephone Company, Inc. DSL No Update to Provide 9/29/2009
Zito Midwest, LLC Cable No Update to Provide 2/17/2011
Cogent Communications, Inc. Backhaul No Update Provided - Use Last Submission Data

IdeaTek Systems, Inc. Fiber No Update Provided - Use Last Submission Data 3/4/2010

KanOkla Telephone Association, Inc. DSL No Update Provided - Use Last Submission Data 12/18/2009

KanOkla Telephone Association, Inc. Fixed Wireless No Update Provided - Use Last Submission Data 12/18/2009
Mercury Wireless, LLC Fixed Wireless No Update Provided - Use Last Submission Data 3/25/2010

JMZ CORPORATION Fixed Wireless Provider Gathering Data

Blue Valley Tele-Communications, Inc. DSL Other 11/17/2009

[SEP-16-11 Brian Dudek] Provider 
indicated that all DSL has been 
converted to fiber and is now 
inactive.

Cequel Communications Backhaul Other 12/15/2009

[SEP-16-11 Brian Dudek] Data was 
not received from this provider and 
was incorrectly reported as no update 
to provide in the April 2011 
submission.

Cunningham Communications, Inc. DSL Other 9/8/2009

[SEP-16-11 Brian Dudek] Provider 
indicated that all DSL has been 
converted to fiber and is now 
inactive.

PAETEC Communications, Inc. DSL Other

[SEP-08-11 Wes Kerr] Multiple 
outreach attempts were conducted 
but no response was received. 
PAETEC was bought out during the 
collection phase of this round by 
Windstream and we intend to be able 
to include the PAETEC coverage as 
a part of the Windstream footprint 
during the next round.

Rainbow Telecommunications Association, Inc. DSL Other 12/9/2009

[SEP-8-11 Brian Dudek] Provider 
indicated all DSL was converted to 
fiber and is now inactive.

arcplasma.com Fixed Wireless Refused to Participate

[JUN-08-11 John Determan]Spoke 
with ArcPlasma Representative who 
stated that we've called repeatedly 
and we don't seem to understand 
that they are NOT interested in 
participating and prefer not to be 
contacted anymore.

WISP-Router, Inc. Fixed Wireless Refused to Participate

[MAY-5-11 John Determan]  After 
sending out advance notice e-mail 
received return e-mail from provider 
stating "No thanks."

Ace Computers Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact 
attempts made between July 1, 2010 
and February 18, 2011, 8 additional 
attempts were made this period.

Midwest Connections, Inc. Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact 
attempts made between July 1, 2010 
and February 18, 2011, 9 additional 
attempts were made this period.

SCI Cable, Inc. Cable Non-Responsive to Multiple Attempts

In addition to multiple contact 
attempts made between July 1, 2010 
and February 7, 2011, 8 additional 
attempts were made this period.

SureWest Communications Cable Non-Responsive to Multiple Attempts

In addition to multiple contact 
attempts made between July 1, 2010 
and February 15, 2011, 8 additional 
attempts were made this period.



SureWest Communications Fiber Non-Responsive to Multiple Attempts

In addition to multiple contact 
attempts made between July 1, 2010 
and February 15, 2011, 8 additional 
attempts were made this period.

SureWest Communications DSL Non-Responsive to Multiple Attempts

In addition to multiple contact 
attempts made between July 1, 2010 
and February 15, 2011, 8 additional 
attempts were made this period.

SureWest Communications Backhaul Non-Responsive to Multiple Attempts

In addition to multiple contact 
attempts made between July 1, 2010 
and February 15, 2011, 8 additional 
attempts were made this period.

Utopian Wireless Corporation Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact 
attempts made between August 9, 
2010 and February 15, 2011, 3 
additional attempts were made this 
period.
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Introduction 
The following sections of this document provide an overview of the process used for the SBI Broadband 

Mapping data development for the Commonwealth of Kentucky. The following narrative is depicted in Appendix 

A, Commonwealth of Kentucky SBI Process Workflow, and Appendix B, State Broadband Data Validation 

Workflow, included at the end of this document. 

Broadband Provider Outreach 
The following outreach procedure provides the framework for communicating with Broadband Service Providers 

(Providers). The primary goals of the outreach approach documented herein are to:  

 Promote Provider understanding and acceptance of the Broadband Mapping process, results and benefits 

 Clarify NTIA Broadband Mapping requirements 

 Facilitate data confidentiality agreements as required 

 Minimize the submittal of invalid data 

 Enhance provider  understanding of the semi-annual update process   

 Work with Providers to evaluate submittal options to facilitate data submittals  

Data Submission Guidelines 
Guidelines for the Providers submission of of Broadband Mapping Data are documented in the “Data Submission 

Guidelines”. These Guidelines define technical requirements, submission, specifications, and coordination and 

documentation activities. 

Kentucky Broadband Providers Website 
A URL was deployed (http://www.bakergis.com/kyBroadbandProvider/) to communicate and distribute NTIA 

NOFA requirements to providers along with outreach and data submittal materials including: 

 NTIA NOFA and subsequent clarification 

 Outreach letters to providers 

 Non-Disclosure Agreement 

 Quick Start Guides 

 Data Submission Guidelines 

 Data Transmittal Letter 

 Broadband Data Submittal Templates 

 TIGER Data 

 Data Submittal Assistance Contact Information 

Outreach Delivery Vehicles 
 A State Broadband Mapping Initiative Call for Data letter from the Kentucky Commonwealth Office of 

Technology (COT) was emailed to all Broadband Service Providers in the Commonwealth. This initial 

provider contact letter described the program and the role of Michael baker Jr., Inc. (Baker) acting on behalf 

of the COT for Broadband Data Collection and Mapping. 

http://www.bakergis.com/kyBroadbandProvider/
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 Baker distributed a follow-up letter to all Providers describing the data submittal requirements and material 

and help available to aid with the data submittals. 

 Submittal assistance was provided to providers that needed help with data submittals. 

 Presentations were conducted with various broadband provider associations to present the data submittal 

requirements and answer questions. 

 Email communication and electronic transfer of data was encouraged to facilitate a faster delivery of data 

and information. 

 A URL was deployed and promoted to distribute outreach material and information concerning the 

Broadband Mapping Project. 

 A secure FTP URL was provided for submittal of broadband data by providers. 

Broadband Outreach Tracker Application 
The Tracker application (Figure 1) was utilized to collect all correspondence with Providers and feedback on the 

effectiveness of the outreach activities by tracking items such as:  

 The number and content of incoming e-mails and letters submitted from the Providers 

 The number and source of comments, questions, and suggestions made by Providers 

 The number and source of comments, questions, and suggestions made by attendees at Provider meetings 

and conference calls 

 Provider contact information and data submittal status. 
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Figure 1 Broadband Outreach Tracker 

Provider Submittal Validation 
When a data submittal is received from a broadband service provider it is updated in the Broadband Outreach 

Tracker and run through an initial validation process to assure that it meets the submittal guidelines.  

Validation Checklist 
The following items are part of this initial data validation process: 

 Verify the provider Transmittal Letter is complete and matches submitted data 

 Verify the file naming conventions 

 Verify each file is machine readable 

 Verify data is in the correct GIS or Tabular format/file type 

 Verify there are no duplicate records 

 Verify each field is populated and no empty or NULL values are present for mandatory fields 

 Verify all ID (record number points) are unique within the submittal 

 Verify all attribute data is formatted according to the submittal guidelines 

 Verify topology for all geospatial submissions 

 Verify Metadata for all submissions 

 Verify the required contact information is included 

 Verify adherence to Data Submittal Guidelines (see http://www.bakergis.com/kyBroadbandProvider/ to 
access Data Submittal Guidelines) 
Broadband Service Availability (at least one) 

 Individual Street Addresses (Sec 3.1 & 4.1) 

 Census Blocks < 2 sq mi (3.3 & 4.3) 

 Street Segments for Census Blocks > 2 sq mi (3.2 & 4.2) 

 Service Overview (Sec 3.4 & 4.4) 

 Polygonal Boundary Area(s) (Sec 3.8 & 4.8) 

http://www.bakergis.com/kyBroadbandProvider/
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Middle-mile Points (Sec 3.5 & 4.5) 

Community Anchor Institutions (Sec 3.7 & 4.7) 

Last Mile Connection Points (Sec 3.6 & 4.6) 

WISP Antennas (Sec 4.9) 

Data Usability Determination 
The validation results are evaluated by the outreach and aggregation persons to determine the usability of the 

data. If the data meets the submission specifications, it is forwarded on for data aggregation. If it is determined 

to be unusable, it is returned to the Broadband Service Provider for resolution. If the data can be manipulated to 

get it into a usable format, it is manipulated as required, and then forwarded on for data aggregation. 

SBI Data Development 
Data from the Broadband Service Providers may be submitted in various formats as defined in the Data 

Submittal Guidelines, or in some cases unspecified formats may be accepted to help facilitate provider 

participation. Depending on the format of the submitted data, it is processed through one of the following 

processes to upgrade it to the NTIA SDBB data standards. 

2000 to 2010 Census Data Translation 
Many providers indicated there were no changes to their previous data submission that was compiled to 2000 

census information and they did not have the capacity to upgrade their data to 2010 census information.  

Therefore, the Broadband Mapping team has translated the April 2011 data for these providers using the 

workflow shown in Appendix C. 

Spatial Data  
After validation and any required manipulation of any spatial data submitted by the Broadband Service 

Providers, it is georeferenced and simply loaded into the appropriate NTIA geodatabase feature class.  

Address Data Geocoding 
If not already in the standard address point template, the provider tabular address data is first loaded into that 

template. The data is then exported to a geodatabase table using the ArcGIS Conversion Tools. ArcGIS geocoding 

tools are then utilized geospatially locate the address points for the tabular records. Interactive address 

rematching is performed against two additional street centerline datasets as needed to increase geocoding 

matching results. The NTIA deliverable is the geocoded address point geodatabase table. The geocoded address 

points are also subsequently aggregated to the census block or road segment feature class for public web map 

display. 

Census Block Aggregation 
If not already in the standard census block template, the provider tabular census block data is first loaded into 

that template. The data is then exported to a geodatabase table using the ArcGIS Conversion Tools. The Provider 

tabular census block records are then joined to the geodatabase 2010 U.S. Census Block. This join is performed 

as many times as necessary for multiple Trans Tech values for each Provider/Census Block combination. The 

NTIA deliverable is the census block geodatabase table.  
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If the list of census blocks contains blocks > 2 sq. miles then these blocks are used to select all the 2010 U.S. 

Census TIGER centerlines that intersect those blocks.  The Census Block record data is aggregated to each Road 

Segment within the Census Block.  This process is performed as many times as necessary for multiple Trans Tech 

values for each Provider/Census Block combination. 

Road Segment Aggregation 
If not already in the standard road segment template, the provider road segment data is first loaded into that 

template. The data is then exported to a geodatabase table using the ArcGIS Conversion Tools. If the provider 

submittal included graphic centerline segments, these are migrated into the delivery geodatabase along with 

the linked attribute records. If the provider submittal was tabular road segment records only, they are then 

joined to the geodatabase 2010 U.S. Census TIGER centerline feature class. This join is performed as many times 

as necessary for multiple Trans Tech values for each Provider/Road Segment combination. The NTIA deliverable 

is the road segment geodatabase table.  

If the provider road segment data lie within census blocks <= 2 sq. miles then the road segment data is 

aggregated to the census block.  This process is performed as many times as necessary for multiple Trans Tech 

values for each Provider/Road Segment combination. The NTIA deliverable is the road segment geodatabase 

table. 

Overview Data Aggregation 
Provider Service Availability Areas submitted for entire county areas are loaded into the NTIA geodatabase 

Overview table. If not already in the standard template, the provider data is first loaded into that template. The 

data is then exported to a geodatabase table using the ArcGIS Conversion Tools. The Provider Overview records 

are then joined to the geodatabase 2010 U.S. Census County feature class. This join is performed as many times 

as necessary for multiple Trans Tech values for each Provider/County Area combination. 

Polygonal Boundary Aggregation/Integration 
Broadband Service Providers submitting polygonal service area data is handled in two ways. Wireline Provider 

data is aggregated to the census block feature class for areas where census blocks <= 2 sq. mi., or road segment 

feature class for areas where census blocks > 2 sq. mi. Wireless Provider Service Availability Areas submitted by 

polygonal area are simply loaded into the NTIA geodatabase Poly_Bndry feature class.  

Wireline Provider 

The polygonal data is georeferenced and loaded into the Poly_Bndry feature class. The polygon is then 

attributed, manually if necessary. Depending on the area, census blocks < or => 2 sq. mi., a selection set of either 

census blocks or road segments that intersect the polygon boundary is created. The attributed polygon 

boundary is then joined with census blocks or road segments table to attribute accordingly. This join is 

performed as many times as necessary for multiple Trans Tech values for each Provider/County Area 

combination.  The NTIA deliverable is the census block or road segment geodatabase table. 
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Wireless Provider 

The polygonal data is georeferenced and loaded into the Poly_Bndry feature class. The polygon is then 

attributed, manually if necessary. Multiple Poly_Bndry records are created for multiple Trans Tech values for 

each Provider. The NTIA deliverable is the polygon boundary geodatabase table. 

Middle/Last Mile Data Integration 
If not already in the standard template, the data is first loaded into that template. The data is then exported to a 

geodatabase table using the ArcGIS Conversion Tools. The point features are geo-located utilizing the lat/long 

information provided.  The NTIA deliverable is the middle or last mile geodatabase table. 

Community Anchor Institution Integration 
Broadband Service Providers provided some Community Anchor Institution (CAI) data with the data submittals. 

But the majority of the data was collected from existing GIS Layers maintained by the COT on their KYGEONET 

public website. Some of the data was collected by outreaching to CAIs through state agencies and their contacts, 

and having CAIs complete an online survey at http://www.bakerbb.com/ky_institution_survey/. 

Provider CAIs 

If not already in the standard template, the data is first loaded into that template. The data is then exported to a 

geodatabase table using the ArcGIS Conversion Tools. The point features are geo-located utilizing the lat/long 

information provided. Address data is used to geocode locations only when Lat/Long data is not provided. 

Commonwealth CAIs 

CAI shapefiles were downloaded from the KYGEONET website. The shapefiles were then exported to the NTIA 

geodatabase CAI feature class. Various sources for obtaining broadband information for the CAIs were utilized. 

Various state agencies provided some of the information, i.e.; Council on Post Secondary Education (CPE) 

provided tabular broadband information for schools and libraries and COT provided tabular broadband 

information for health departments. A CAI data survey website was also deployed and the URL distributed by 

various state agencies to the CAI contacts. Data from all of these sources were then aggregated into the CAI 

geodatabase table for the NTIA deliverable. 

Provider Validation 
After data development, service availability maps are generated and submitted to the providers to validate their 

mapping results.  This provides a “sign off” on the interpretation of the submitted data and extends the 

outreach efforts by providing a visual representation of the data to be delivered to the State and the NTIA. 

Types of Provider Maps 
Provider maps (Figure 2) generally consist of the following types. 

Outreach Maps 

Often time’s providers will send data which does not contain all the information needed for a NTIA compliant 

dataset.  In such cases, as an aid to the outreach communication, it may be necessary to produce a map to help 

the provider locate their service area or verify data they have provided.  These maps may take many forms, but 

generally are of two types: 

http://www.bakerbb.com/ky_institution_survey/
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 General Location Maps – these maps are often produced when the provider does not have a list of address 

or other standard submittal data and needs help defining their service area.  A typical map will show 

counties, major roads, and towns of the general area the provider has stated as their service area.  The 

intent of the map is to give the provider a way to markup or delineate their service area.  If a provider has 

not provided required attribute information such as Technology of Transmission, Speed Data, etc. then it 

may be necessary to add a visual clue to this data like an information stamp on the map that they can easily 

fill out.  If the provider sends the map back with a service area boundary, this can then be digitized and sent 

back to the provider for verification. 

 Verification of Provider Supplied Boundaries – these maps are produced when the provider has sent service 

area boundary information which is confusing or otherwise unclear.  Often these are produced when 

providers send CAD maps, hand drawn maps that need digitization, or lists of zip codes or counties served.  

A typical map will place the interpreted boundary over a location map so the provider can verify the service 

area.  As with the General Location Map, information stamps or other visual clues may be placed on the 

map. 

Initial Verification Maps 

Once the provider data has been processed and the census block and road segment feature classes created, an 

Initial Verification Map is produced to give the provider a visual representation of their service area by census 

block.  These maps enable the provider to verify their service area and make changes if necessary.  Initial 

Verification Maps are produced using a set of standards and produced at the highest resolution necessary to 

convey the map information to the provider.  Initial Verification Maps are also produced for Wireless Polygon 

areas. 

Detailed Verification Maps 

Providers who have questions about their service areas may request additional information to help clarify issues.  

In these cases it may be necessary to create a Detailed Verification Map to highlight the areas in question.  

Detailed Verification Maps provide the same information as Initial Verification Maps only at a higher resolution.  

Several maps may be needed to accurately portray an area in question. 

Revised Maps 

Revised maps take two forms: 

 Initial or Detailed Verification Maps which have been annotated or marked-up by the provider 

 Outreach produced Initial or Detailed Verification Maps incorporating provider changes 
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Figure 2  Provider Map 

Data Validation 
A critical component of the project is the validation of the data submitted by the broadband service providers. 

Data from various sources, as described in more detail in the following sections, is utilized to develop a level of 

confidence in the data received from the broadband providers.  

Validation Data Set Collection and Development 
This validation process employs data sets developed or acquired from different sources as described in the 

following sections.  
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Provider Feedback Loop:  Maps of completed Provider service areas and data are furnished back to the 

Providers for confirmation of the processed/aggregated information. Feedback is integrated into the each 

Provider’s dataset.  

Strategic Networks Group (SNG) Wireline Market Intelligence Data:  Data is extracted from internal and 

commercial databases defining geographic service areas of telephone and cable companies and locations of 

central office (CO) switches and areas upgraded with fiber.  The geographic areas are overlaid with Census 

demographic data on housing unit counts and density. The areas are then modified based on standard business 

practices for conducting service build-out and offering broadband service relative to housing density and other 

variables, such as distance from CO and other infrastructure elements, type of cable franchise (e.g., Census Place 

vs. Unincorporated County)  This represents the first pass conservative estimate of coverage.   

The above methods and data sources are supplemented by other data sources and methodologies, including:  1) 

connectivity data points acquired from InfoUSA that include ISP and type of connection (e.g., DSL, cable modem, 

dial-up, wireless, fiber) providing Internet service to specific geo-coded (i.e., by Latitude and Longitude) 

residential addresses;  2) web-based and telephone research, including address-level service-availability queries 

of web sites operated by service providers and independent entities.  This multi-sourced SNG dataset is used as 

a validation source for provider service area coverage, Technology of Transmission, and Speed. 

American Roamer Wireless Market Intelligence Data:  Commercially available dataset used as an independent 

source to verify information submitted by Providers of wireless broadband service. This dataset is used as a 

validation source for provider service area coverage. 

Strategic Networks Group (SNG) Targeted Online Surveys: Questionnaires (e-mail/web based) have been sent 

directly to businesses and households, including over-sampling in rural area and those where the above 

conservative estimate indicates are “unserved” and “underserved” areas. In addition to collecting broadband 

supply data on type of access, speeds, price, etc. questionnaires gather broadband service demand and usage 

data from businesses, organizations, and households.  Survey responses include geographic coordinates that 

allow mapping and cross-reference to census blocks or street segments. This dataset is used as a validation 

source for provider service area coverage, Technology of Transmission, and Speed. 

Online Public Survey and Speed Test: A Broadband Mapping Public Survey Site is deployed. Site visitors are 

requested to provide data on broadband availability, technology, service type (e.g., speed tier) service provider 

name; monthly prices paid and measured downstream and upstream speeds. In addition to State promotion via 

press releases to the general public, the State Council on Post Secondary Education (CPE) also promoting 

participation on this survey to the faculty and student population. This dataset is used as a validation source for 

provider service area coverage, Technology of Transmission, and Speed. 

Prior Broadband Mapping: Statewide coverage areas for Cable, DSL, and Fixed Wireless providers that were 

aggregated as part of a previous broadband mapping effort for the Commonwealth of Kentucky are used to 

validate against Provider submitted data.  In addition to the service areas, the DSL and Fixed Wireless layers 

contain general speed information that can be compared against Provider submitted data. 

FCC Speed Test: The FCC speed test data includes the IP addresses for each specific speed test conducted. This IP 

address is queried against a web search engine to determine the Provider assigned to that address and is used 

as a validation source for provider service coverage and typical speeds. 
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Field Data Acquisition: Broadband technicians visited a sampling of census block locations to gather broadband 

data to be used for validation. The following criteria were taken into account when developing the census block 

sampling dataset: 

 urban vs. rural census block characteristic 

 censes block grouping 

 land vs. water census block characteristic 

The overarching mission of the Federal broadband stimulus program is to expand Broadband service to areas 

that are currently unserved and underserved. Also, the market intelligence validation sources typically represent 

some rural, but more urban areas. Thus, our field data collection efforts were targeted more towards the rural 

areas; split 90% rural, 10% urban.   

Additionally, a study by Penn State University (Glasmeier 2002) notes that a large number of census block 

groups typically fit within any given cable or telephone company service areas. Therefore, our field sample was 

also based on selection of one census block per block group. The selected census block also had greater than 

50% land area, versus water.  There are a total of 3, 158 census block groups statewide. Using a statistical 

sample size calculator based upon the number of block groups in the state and +/- 4% margin of error at a 95% 

confidence level, the sample size is 529 census block locations (Figure 3).   

For the 529 census blocks that were visited, 2455 individual wired/wireless data elements were recorded and 

3024 pictures were taken at those locations. This field collected dataset is used as a validation source primarily 

for wireline and wireless technology of transmission and middle mile, and for wireless speed. 

 

Figure 3  Field Verification Sampling Locations 
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For each census block in the sample set, broadband technicians collected data using Panasonic Toughbook 

computers, loaded with MapPoint mapping software, and a customized Microsoft Access data collection form 

with the ability to automatically import GPS coordinates. The sample census blocks were pre-loaded and directly 

accessible from MapPoint.  Two types of data collection were conducted; infrastructure observation and 

wireless speed testing; and the results were recorded and linked to the corresponding field location coordinates 

within the designated sample census block.  The information collected by the field broadband technicians 

includes: 

Wireline: 

 GPS coordinates 

 circuit infrastructure feeding the area (copper, fiber, cable) 

 collect site pictures 

Wireless: 

 GPS coordinates 

 internet speed test 

This field collected dataset is used as a validation source primarily for wireline and wireless technology of 

transmission and middle mile, and for wireless speed. 

Independent 3rd Party Validation:  Murray State University coordinated the efforts of resources at the University 

of Louisville and the Kentucky Community and Technical College System (validation team) to validate the 

collection methods and collected data associated with the collection of broadband availability data. This 

validation data developed from this effort was subsequently integrated into the Statistical Evaluation and 

Assessment System (SEAS) to verify the data submitted by the broadband providers. 

The validation team review included: 

a. Validating the list of providers being used by the mapping vendor to make sure all providers are included. 

b. Validating the list of state-provided and Census Tiger Data to identify the location of health facilities, 

schools, libraries, hospitals, universities, public buildings, etc. 

c. Reviewing provider outreach methodology being used by the mapping vendor. 

d. Reviewing submission options, the Non-Disclosure Agreement and the timeframe for submission. 

e. Identifying Business Intelligence data sources to validate provider information.  

f. Reviewing mapping vendor’s website used to collect comment/survey forms from visitors to validate the 

broadband coverage in their area.   

g. Observing the data collection and data entry process and the ongoing steps in the development of the final 

products.   

Once data was collected, the validation team provided a review that included: 

a. Cross checking of data for accuracy  

b. Statistically representative and significant samples to validate data, especially in rural and potentially 

underserved. 
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Limited field census and telephone surveys were also used to validate data in situations where the data cross 
checks and statistical samples are not able to validate data provided by the mapping vendor. Faculty and 
students from campuses of the Kentucky Community and Technical and College System (KCTCS) conducted the 
field census work to validate local adoption rates.  KCTCS has 16 colleges and over 60 campuses to provide state-
wide coverage for field census work.   

The work performed, and being performed by the validation team can be summarized in four areas: (1) Audit, 
(2) Selective Surveys, (3) Reconcile Survey and Provider Data, and (4) Field Test to Resolve Discrepancies. 

Audit – At the beginning of the project it was decided that the best way to obtain quality data was to make sure 
that the initial data collection was of the highest quality that it could be.  The validation team concentration its 
initial efforts in working with the mapping vendor to get the best quality data and also the largest quantity of 
data that could be obtained.  Mapping vendor processes were reviewed and suggested improvements provided.  
Web sites and documents that were to be used for data collection were evaluated and improvements 
suggested.  Provider lists were reviewed and additional vendors or potential vendors were identified by the 
validation team.  Once data collection began, the validation team also worked with the mapping team to 
increase the amount of data collected.  KCTCS provided web survey sites to students and faculty across the state 
to increase participation.  Once the data was collected the validation team worked to identify data anomalies 
and locations where additional data collection was required. 

Selective Surveys – The data audits identified locations where there was insufficient data to make valid 
conclusions about broadband availability.  The validation team used a call center to place selective surveys in the 
targeted areas within the state.  In many cases the insufficient data was the result of the failure of vendors to 
provide data to the mapping vendor.  The selective surveys provide validation of the availability of broadband or 
the absence of broadband within a specific area.  This information allows the mapping vendor to concentrate 
their efforts to obtain the required data from the appropriate vendor. The call center efforts reached almost 
10,000 new households that had not been sampled by other methods.  The data indicated that 68.8% had 
computers, 64.7% has access to the Internet, and 56.7% has broadband access.  The new data points were 
located in rural areas of the state and were focused on areas that had been underrepresented in prior data 
collection efforts. 

Reconcile Survey and Provider Data – The mapping vendor survey data (from web surveys), the provider data, 
and the selective surveys done by the validation team provide an additional reconciliation of the data.  While the 
importance of knowing where broadband is available is critical, it is just as important to know where broadband 
is not available.  The comparison of the various data sources allow for a high confidence in identifying where 
broadband is available.  Additionally, the data reported on the web surveys and the phone surveys identify 
pockets of citizens of the Commonwealth that don’t have access to broadband. The validation team used the 
data reported by the providers, the data collected by the mapping vendor, and the validation survey data to 
identify areas of interest for the field data collection efforts.  The focus of the field data collection efforts are 
areas with no reported service, areas where individuals report no availability, and areas where only mobile 
wireless has been reported as being available for broadband service. 

Field Test to Resolve Discrepancies – The reported territory covered by wired broadband infrastructure is 

reliable.  However, the reported territory covered by wireless broadband infrastructure (especially mobile 

wireless) is less reliable.  Many factors can impact the availability of the wireless signal.  We simply have to think 

about our cell phone usage and the frequency of dropped calls or no service availability.  It is relatively easy for a 

vendor to say they provide service to an entire geographic area.  The validation team developed software to 

check on the level of mobile wireless availability and to make sure it is at broadband speeds.  The validation 

team drove mobile devices around the state collecting signal strength and doing periodic speed test to validate 
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the availability of broadband.  The initial focus was on areas reported to have no service and areas that only 

have mobile broadband reported. Test data was collected to validate the data collection process and identify 

required equipment.   

Provider Data Validation Process 
Provider Feedback Loop:  Feedback received from the providers is visually inspected and integrated directly into 

the mapping GIS database. 

Service Area Validation Data: The SNG wireline service area data is tabular and contains a separate record for 

each provider/technology of transmission combination with an associated census block or TIGER road segment, 

depending on the whether the size of the census block area (=/< or > 2 sq. mi.). This data is exported into an 

ArcGIS data format. The American Roamer and Prior Mapping service area data is already in and ArcGIS data 

format.  The validation data is then joined to the Provider service area data by census block or TIGER road 

segment ID. Any database records in the Provider or Validation tables that cannot be joined are output to a 

separate layer that indicates the areas of discrepancy between the two datasets. The joined tables are then 

queried to detect any speed discrepancies which are also output to a separate discrepancy layer. 

Online Surveys, Field and Independent 3rd Party Validation Data: The Public and Targeted Business/Household 

survey, field and independent 3rd party validation data are also collected in tabular database format, and 

represent a specific lat/long spatial location for each record.  This data is exported into ArcGIS data format, 

joined to the provider data, queried to validate pertinent attribution. Again, records not joined and or with 

detected attribution discrepancies are output to separate GIS layers. 

Topology: The ArcGIS Validate Topology Tool is used to flag any topology issues in the broadband data. Flagged 

issues are reviewed to identify false positives and update true errors as required.  

SBI Check Submission: The NTIA-provided SBI Check Submission tool is utilized to validate that the deliverable 

broadband data is consistent with the business logic rules set forth by the NTIA and a passing receipt is provided 

with the data submittal to NTIA. 

Stakeholder Feedback:  The state broadband mapping website includes a feedback function. Comments received 

from stakeholders are reviewed and used to validate provider data submissions. 

 Validation and Confidence Level Reporting 

To facilitate validation and confidence level reporting, Baker deployed a validation application called Statistical 

Evaluation and Assessment System (SEAS) which automatically compares the multiple independent validation 

datasets against the broadband service provider supplied information.  The SEAS uses statistical methodologies 

to report the confidence level in the spatial and attribute accuracy of the information.  Appendix B shows the 

validation workflow. 

The SEAS comparison is a three-part validation process: 

1. Comparison of the collected validation source against the aggregated broadband provider data. 

2. Match percentage calculation for each provider reported in the DataPackage.xls, “Provider Table” tab, 

“Comments” column. 

3.  Confidence score calculation displayed on the state broadband website.  
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Figure 4  Statistical Evaluation and Assessment System (SEAS) 

After completing all validation data source collections, SEAS is used to automatically compare the multiple 

validation datasets against the aggregated broadband data which came from the providers. Through the SEAS 

accumulation table, it produces a match percentage per broadband service record based upon the number of 

matches that record has against each validation source. The matched percentage for each record is the result of 

the total count of the matched validations for the record divided by the total validation source being compared 

against the record.  A validation confidence rating/score is then assigned on a scale of 1 to 5 based upon the 

percentage of validation source matches as per the following score results: 

 1 Star   = 0% - 19% Match 

 2 Stars = 20% - 39% Match 

 3 Stars = 40% - 59% Match 

 4 Stars = 60% = 79% Match 

 5 Stars = 80% - 100% Match 

 “No Analytics” = No validation source available for that provider 
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The Commonwealth’s public broadband mapping website (www.bakerbb.com/kybroadbandmapping/) is 

updated with the confidence level results at the record level based upon the queried geographic location and 

the following is an example of this representation. 

 
Provider Name Transmission 

Technology 

Max Download 

Speed 

Max Upload Speed  Confidence Score 

AT&T Mobility Mobile Wireless Greater than or e… Greater than or e… 

 
Verizon Asymmetric xDSL Greater than or e… Greater than or e… NO ANALYTICS 

Comcast Cable Modem – 

Other 

Greater than or e… Greater than or e… 

 

  

The matched percentage for the records for each provider are summarized and then divided by the total count 

of the records to create the final matched percentage for the specific provider. These percentages are included 

in DataPackage.xls on the Provider Table tab in the Comments column. 

Low Confidence Provider Feedback  
Provider data which is assigned a low confidence (1 or 2 stars) through the SEAS process is communicated back 

to the provider through a feedback loop. Generally, the low confidence feedback and reconciliation is a 

continuous refinement process and will occur between update cycles. The goal is to provide this feedback 

through the Provider Update Portal via a web connection that will be available and rolled out to provider in early 

2012. 

Changes and Corrections Documentation 
With each NTIA semiannual data submittal, changes and corrections documentation is provided. Significant 

changes in a provider’s status or data, corrections to previously supplied data, providers supplying data for the 

first time, etc. are specified by Provider name in the Changes and Corrections document. 

Future Validation 
Audit of Wireless Broadband Availability Reporting:  Wireless coverage will be evaluated using a contour 

calculation tool, with key inputs being transmitter location and, where available, data on spectrum power levels 

and other relevant transmission factors provided by carriers and/or supplemented by data available from public 

web sites and other sources.  Data will then be input to a contour calculation tool to provide estimates of fixed 

wireless broadband coverage areas. This dataset is used as a source to determine gaps in provider wireless 

service area coverage.  The Prior Mapping data is also used as a validation source for gap analysis. 

 

 

 

http://www.bakerbb.com/kybroadbandmapping/
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2000 to 2010 Census Data Translation Workflow 
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Introduction 
The following sections of this document provide an overview of the process used for the SBI Broadband 
Mapping data development for the State of Louisiana. The following narrative is depicted in Appendix A, State of 
Louisiana SBI Process Workflow, and Appendix B, State Broadband Data Validation Workflow, included at the 
end of this document. 

Broadband Provider Outreach 
The following outreach provides the framework for communicating with Broadband Service Providers 
(Providers). The primary goals of the outreach approach documented herein are to:  

• Promote Provider understanding and acceptance of the Broadband Mapping process, results and benefits 

• Clarify NTIA Broadband Mapping requirements 

• Facilitate data confidentiality agreements as required 

• Minimize the submittal of invalid data 

• Enhance provider  understanding of the semi-annual update process   

• Work with Providers to evaluate submittal options to facilitate data submittals  

Data Submission Guidelines 
Guidelines for the Providers submission of of Broadband Mapping Data are documented in the “Data Submission 
Guidelines”. These Guidelines define technical requirements, submission, specifications, and coordination and 
documentation activities. 

Louisiana Broadband Providers Website 
A URL was deployed (http://broadband.louisiana.gov/providers.asp) to communicate and distribute NTIA NOFA 
requirements to providers along with outreach and data submittal materials including: 

• NTIA NOFA and subsequent clarification 

• Outreach letters to providers 

• Non-Disclosure Agreement 

• Quick Start Guides 

• Data Submission Guidelines 

• Data Transmittal Letter 

• Broadband Data Submittal Templates 

• TIGER Data 

• Data Submittal Assistance Contact Information 

Outreach Delivery Vehicles 
• A State Broadband Mapping Initiative Call for Data letter from the State Office of Information Technology 

(OIT) was emailed to all Broadband Service Providers in the State. This initial provider contact letter 
described the program and the role of Michael baker Jr., Inc. (Baker) acting on behalf of the OIT for 
Broadband Data Collection and Mapping. 
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• Baker distributed a follow-up letter to all Providers describing the data submittal requirements and material 
and help available to aid with the data submittals. 

• Submittal assistance was provided to providers that needed help with data submittals. 

• Presentations were conducted with various broadband provider associations to present the data submittal 
requirements and answer questions. 

• Email communication and electronic transfer of data was encouraged to facilitate a faster delivery of data 
and information. 

• A URL was deployed and promoted to distribute outreach material and information concerning the 
Broadband Mapping Project. 

• A secure FTP URL was provided for submittal of broadband data by providers. 

Broadband Outreach Tracker Application 
The Tracker application (Figure 1) was utilized to collect all correspondence with Providers and feedback on the 
effectiveness of the outreach activities by tracking items such as:  

• The number and content of incoming e-mails and letters submitted from the Providers 

• The number and source of comments, questions, and suggestions made by Providers 

• The number and source of comments, questions, and suggestions made by attendees at Provider meetings 
and conference calls 

• Provider contact information and data submittal status. 
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Figure 1 Broadband Outreach Tracker 

Provider Submittal Validation 
When a data submittal is received from a broadband service provider it is updated in the Broadband Outreach 
Tracker and run through an initial validation process to assure that it meets the submittal guidelines.  

Validation Checklist 
The following items are part of this initial data validation process: 

• Verify the provider Transmittal Letter is complete and matches submitted data 

• Verify the file naming conventions 

• Verify each file is machine readable 

• Verify data is in the correct GIS or Tabular format/file type 

• Verify there are no duplicate records 

• Verify each field is populated and no empty or NULL values are present for mandatory fields 

• Verify all ID (record number points) are unique within the submittal 

• Verify all attribute data is formatted according to the submittal guidelines 

• Verify topology for all geospatial submissions 

• Verify Metadata for all submissions 

• Verify the required contact information is included 

• Verify adherence to Data Submittal Guidelines (see http://broadband.louisiana.gov/providers.asp to 
access Data Submittal Guidelines) 
Broadband Service Availability (at least one) 
- Individual Street Addresses (Sec 3.1 & 4.1) 
- Census Blocks < 2 sq mi (3.3 & 4.3) 
- Street Segments for Census Blocks > 2 sq mi (3.2 & 4.2) 
- Service Overview (Sec 3.4 & 4.4) 
- Polygonal Boundary Area(s) (Sec 3.8 & 4.8) 

http://broadband.louisiana.gov/providers.asp
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Middle-mile Points (Sec 3.5 & 4.5) 
Community Anchor Institutions (Sec 3.7 & 4.7) 
Last Mile Connection Points (Sec 3.6 & 4.6) 
WISP Antennas (Sec 4.9) 

Data Usability Determination 
The validation results are evaluated by the outreach and aggregation persons to determine the usability of the 
data. If the data meets the submission specifications, it is forwarded on for data aggregation. If it is determined 
to be unusable, it is returned to the Broadband Service Provider for resolution. If the data can be manipulated to 
get it into a usable format, it is manipulated as required, and then forwarded on for data aggregation. 

SBI Data Development 
Data from the Broadband Service Providers may be submitted in various formats as defined in the Data 
Submittal Guidelines, or in some cases unspecified formats may be accepted to help facilitate provider 
participation. Depending on the format of the submitted data, it is processed through one of the following 
processes to upgrade it to the NTIA SBI data standards. 

2000 to 2010 Census Data Translation 
Many providers indicated there were no changes to their previous data submission that was compiled to 2000 
census information and they did not have the capacity to upgrade their data to 2010 census information.  
Therefore, the Broadband Mapping team has translated the April 2011 data for these providers using the 
workflow shown in Appendix C. 

Spatial Data  
After validation and any required manipulation of any spatial data submitted by the Broadband Service 
Providers, it is georeferenced and simply loaded into the appropriate NTIA geodatabase feature class.  

Address Data Geocoding 
If not already in the standard address point template, the provider tabular address data is first loaded into that 
template. The data is then exported to a geodatabase table using the ArcGIS Conversion Tools. ArcGIS geocoding 
tools are then utilized geospatially locate the address points for the tabular records. Interactive address 
rematching is performed against two additional street centerline datasets as needed to increase geocoding 
matching results. The NTIA deliverable is the geocoded address point geodatabase table. The geocoded address 
points are also subsequently aggregated to the census block or road segment feature class for public web map 
display. 

Census Block Aggregation 
If not already in the standard census block template, the provider tabular census block data is first loaded into 
that template. The data is then exported to a geodatabase table using the ArcGIS Conversion Tools. The Provider 
tabular census block records are then joined to the geodatabase 2010 U.S. Census Block. This join is performed 
as many times as necessary for multiple Trans Tech values for each Provider/Census Block combination. The 
NTIA deliverable is the census block geodatabase table.  
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If the list of census blocks contains blocks > 2 sq. miles then these blocks are used to select all the 2010 U.S. 
Census TIGER centerlines that intersect those blocks.  The Census Block record data is aggregated to each Road 
Segment within the Census Block.  This process is performed as many times as necessary for multiple Trans Tech 
values for each Provider/Census Block combination. 

Road Segment Aggregation 
If not already in the standard road segment template, the provider road segment data is first loaded into that 
template. The data is then exported to a geodatabase table using the ArcGIS Conversion Tools. If the provider 
submittal included graphic centerline segments, these are migrated into the delivery geodatabase along with 
the linked attribute records. If the provider submittal was tabular road segment records only, they are then 
joined to the geodatabase 2010 U.S. Census TIGER centerline feature class. This join is performed as many times 
as necessary for multiple Trans Tech values for each Provider/Road Segment combination. The NTIA deliverable 
is the road segment geodatabase table.  

If the provider road segment data lie within census blocks <= 2 sq. miles then the road segment data is 
aggregated to the census block.  This process is performed as many times as necessary for multiple Trans Tech 
values for each Provider/Road Segment combination. The NTIA deliverable is the road segment geodatabase 
table. 

Overview Data Aggregation 
Provider Service Availability Areas submitted for entire county areas are loaded into the NTIA geodatabase 
Overview table. If not already in the standard template, the provider data is first loaded into that template. The 
data is then exported to a geodatabase table using the ArcGIS Conversion Tools. The Provider Overview records 
are then joined to the geodatabase 2010 U.S. Census County feature class. This join is performed as many times 
as necessary for multiple Trans Tech values for each Provider/County Area combination. 

Polygonal Boundary Aggregation/Integration 
Broadband Service Providers submitting polygonal service area data is handled in two ways. Wireline Provider 
data is aggregated to the census block feature class for areas where census blocks <= 2 sq. mi., or road segment 
feature class for areas where census blocks > 2 sq. mi. Wireless Provider Service Availability Areas submitted by 
polygonal area are simply loaded into the NTIA geodatabase Poly_Bndry feature class.  

Wireline Provider 
The polygonal data is georeferenced and loaded into the Poly_Bndry feature class. The polygon is then 
attributed, manually if necessary. Depending on the area, census blocks < or => 2 sq. mi., a selection set of either 
census blocks or road segments that intersect the polygon boundary is created. The attributed polygon 
boundary is then joined with census blocks or road segments table to attribute accordingly. This join is 
performed as many times as necessary for multiple Trans Tech values for each Provider/County Area 
combination.  The NTIA deliverable is the census block or road segment geodatabase table. 
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Wireless Provider 
The polygonal data is georeferenced and loaded into the Poly_Bndry feature class. The polygon is then 
attributed, manually if necessary. Multiple Poly_Bndry records are created for multiple Trans Tech values for 
each Provider. The NTIA deliverable is the polygon boundary geodatabase table. 

Middle/Last Mile Data Integration 
If not already in the standard template, the data is first loaded into that template. The data is then exported to a 
geodatabase table using the ArcGIS Conversion Tools. The point features are geo-located utilizing the lat/long 
information provided.  The NTIA deliverable is the middle or last mile geodatabase table. 

Community Anchor Institution Integration 
Broadband Service Providers provided some Community Anchor Institution (CAI) data with the data submittals. 
But the majority of the data was collected from existing GIS Layers from previous studies and commercial data 
packages. 

Provider CAIs 
If not already in the standard template, the data is first loaded into that template. The data is then exported to a 
geodatabase table using the ArcGIS Conversion Tools. The point features are geo-located utilizing the lat/long 
information provided. Address data is used to geocode locations only when Lat/Long data is not provided. 

State CAIs 
CAI shapefiles were downloaded from the commercial data packages. The shapefiles were then exported to the 
NTIA geodatabase CAI feature class. Various sources for obtaining broadband information for the CAIs were 
utilized including previous broadband studies.  

Provider Validation 
After data development, service availability maps are generated and submitted to the providers to validate their 
mapping results.  This provides a “sign off” on the interpretation of the submitted data and extends the 
outreach efforts by providing a visual representation of the data to be delivered to the State and the NTIA. 

Types of Provider Maps 
Provider maps (Figure 2) generally consist of the following types. 

Outreach Maps 
Often time’s providers will send data which does not contain all the information needed for a NTIA compliant 
dataset.  In such cases, as an aid to the outreach communication, it may be necessary to produce a map to help 
the provider locate their service area or verify data they have provided.  These maps may take many forms, but 
generally are of two types: 

• General Location Maps – these maps are often produced when the provider does not have a list of address 
or other standard submittal data and needs help defining their service area.  A typical map will show 
counties, major roads, and towns of the general area the provider has stated as their service area.  The 
intent of the map is to give the provider a way to markup or delineate their service area.  If a provider has 
not provided required attribute information such as Technology of Transmission, Speed Data, etc. then it 
may be necessary to add a visual clue to this data like an information stamp on the map that they can easily 
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fill out.  If the provider sends the map back with a service area boundary, this can then be digitized and sent 
back to the provider for verification. 

• Verification of Provider Supplied Boundaries – these maps are produced when the provider has sent service 
area boundary information which is confusing or otherwise unclear.  Often these are produced when 
providers send CAD maps, hand drawn maps that need digitization, or lists of zip codes or counties served.  
A typical map will place the interpreted boundary over a location map so the provider can verify the service 
area.  As with the General Location Map, information stamps or other visual clues may be placed on the 
map. 

Initial Verification Maps 

Once the provider data has been processed and the census block and road segment feature classes created, an 
Initial Verification Map is produced to give the provider a visual representation of their service area by census 
block.  These maps enable the provider to verify their service area and make changes if necessary.  Initial 
Verification Maps are produced using a set of standards and produced at the highest resolution necessary to 
convey the map information to the provider.  Initial Verification Maps are also produced for Wireless Polygon 
areas. 

Detailed Verification Maps 

Providers who have questions about their service areas may request additional information to help clarify issues.  
In these cases it may be necessary to create a Detailed Verification Map to highlight the areas in question.  
Detailed Verification Maps provide the same information as Initial Verification Maps only at a higher resolution.  
Several maps may be needed to accurately portray an area in question. 

Revised Maps 

Revised maps take two forms: 

• Initial or Detailed Verification Maps which have been annotated or marked-up by the provider 

• Outreach produced Initial or Detailed Verification Maps incorporating provider changes 
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Figure 2  Provider Map 

Data Validation 
A critical component of the project is the validation of the data submitted by the broadband service providers. 
Data from various sources, as described in more detail in the following sections, is utilized to develop a level of 
confidence in the data received from the broadband providers.  

Validation Data Set Collection and Development 
This validation process employs data sets developed or acquired from different sources as described in the 
following sections.  
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Provider Feedback Loop:  Maps of completed Provider service areas and data are furnished back to the 
Providers for confirmation of the processed/aggregated information. Feedback is integrated into the each 
Provider’s dataset.  

Strategic Networks Group (SNG) Wireline Market Intelligence Data:  Data is extracted from internal and 
commercial databases defining geographic service areas of telephone and cable companies and locations of 
central office (CO) switches and areas upgraded with fiber.  The geographic areas are overlaid with Census 
demographic data on housing unit counts and density. The areas are then modified based on standard business 
practices for conducting service build-out and offering broadband service relative to housing density and other 
variables, such as distance from CO and other infrastructure elements, type of cable franchise (e.g., Census Place 
vs. Unincorporated County)  This represents the first pass conservative estimate of coverage.   

The above methods and data sources are supplemented by other data sources and methodologies, including:  1) 
connectivity data points acquired from InfoUSA that include ISP and type of connection (e.g., DSL, cable modem, 
dial-up, wireless, fiber) providing Internet service to specific geo-coded (i.e., by Latitude and Longitude) 
residential addresses;  2) web-based and telephone research, including address-level service-availability queries 
of web sites operated by service providers and independent entities.  This multi-sourced SNG dataset is used as 
a validation source for provider service area coverage, Technology of Transmission, and Speed. 

American Roamer Wireless Market Intelligence Data:  Commercially available dataset used as an independent 
source to verify information submitted by Providers of wireless broadband service. This dataset is used as a 
validation source for provider service area coverage. 

Strategic Networks Group (SNG) Targeted Online Surveys: Questionnaires (e-mail/web based) have been sent 
directly to businesses and households, including over-sampling in rural area and those where the above 
conservative estimate indicates are “unserved” and “underserved” areas. In addition to collecting broadband 
supply data on type of access, speeds, price, etc. questionnaires gather broadband service demand and usage 
data from businesses, organizations, and households.  Survey responses include geographic coordinates that 
allow mapping and cross-reference to census blocks or street segments. This dataset is used as a validation 
source for provider service area coverage, Technology of Transmission, and Speed. 

Online Public Survey and Speed Test: A Broadband Mapping Public Survey Site is deployed. Site visitors are 
requested to provide data on broadband availability, technology, service type (e.g., speed tier) service provider 
name; monthly prices paid and measured downstream and upstream speeds.  

Prior Broadband Mapping: Statewide coverage areas for Cable, DSL, and Fixed Wireless providers that were 
aggregated as part of a previous broadband mapping effort for the State of Louisiana are used to validate 
against Provider submitted data.  In addition to the service areas, the DSL and Fixed Wireless layers contain 
general speed information that can be compared against Provider submitted data. 

FCC Speed Test: The FCC speed test data includes the IP addresses for each specific speed test conducted. This IP 
address is queried against a web search engine to determine the Provider assigned to that address and is used 
as a validation source for provider service coverage and typical speeds. 
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Field Data Acquisition: Broadband technicians visited a sampling of census block locations to gather broadband 
data to be used for validation. The following criteria were taken into account when developing the census block 
sampling dataset: 

• urban vs. rural census block characteristic 
• censes block grouping 
• land vs. water census block characteristic 

The overarching mission of the Federal broadband stimulus program is to expand Broadband service to areas 
that are currently unserved and underserved. Also, the market intelligence validation sources typically represent 
some rural, but more urban areas. Thus, our field data collection efforts were targeted more towards the rural 
areas; split 90% rural, 10% urban.   

Additionally, a study by Penn State University (Glasmeier 2002) notes that a large number of census block 
groups typically fit within any given cable or telephone company service areas. Therefore, our field sample was 
also based on selection of one census block per block group. The selected census block also had greater than 
50% land area, versus water.  There are a total of 3, 512 census block groups statewide. Using a statistical 
sample size calculator based upon the number of block groups in the state and +/- 4% margin of error at a 95% 
confidence level, the sample size is 557 census block locations (Figure 3).   

For the 557 census blocks that were visited, 3257 individual wired/wireless data elements were recorded and 
3410 pictures were taken at those locations. This field collected dataset is used as a validation source primarily 
for wireline and wireless technology of transmission and middle mile, and for wireless speed. 

 

Figure 3  Field Verification Sampling Locations 
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For each census block in the sample set, broadband technicians collected data using Panasonic Toughbook 
computers, loaded with MapPoint mapping software, and a customized Microsoft Access data collection form 
with the ability to automatically import GPS coordinates. The sample census blocks were pre-loaded and directly 
accessible from MapPoint.  Two types of data collection were conducted; infrastructure observation and 
wireless speed testing; and the results were recorded and linked to the corresponding field location coordinates 
within the designated sample census block.  The information collected by the field broadband technicians 
includes: 

Wireline: 

• GPS coordinates 

• circuit infrastructure feeding the area (copper, fiber, cable) 

• collect site pictures 

Wireless: 

• GPS coordinates 

• internet speed test 

This field collected dataset is used as a validation source primarily for wireline and wireless technology of 
transmission and middle mile, and for wireless speed. 

Provider Data Validation Process 
Provider Feedback Loop:  Feedback received from the providers is visually inspected and integrated directly into 
the mapping GIS database. 

Service Area Validation Data: The SNG wireline service area data is tabular and contains a separate record for 
each provider/technology of transmission combination with an associated census block or TIGER road segment, 
depending on the whether the size of the census block area (=/< or > 2 sq. mi.). This data is exported into an 
ArcGIS data format. The American Roamer and Prior Mapping service area data is already in and ArcGIS data 
format.  The validation data is then joined to the Provider service area data by census block or TIGER road 
segment ID. Any database records in the Provider or Validation tables that cannot be joined are output to a 
separate layer that indicates the areas of discrepancy between the two datasets. The joined tables are then 
queried to detect any speed discrepancies which are also output to a separate discrepancy layer. 

Online Surveys and Field Validation Data: The Public and Targeted Business/Household survey and field  
validation data are also collected in tabular database format, and represent a specific lat/long spatial location 
for each record.  This data is exported into ArcGIS data format, joined to the provider data, queried to validate 
pertinent attribution. Again, records not joined and or with detected attribution discrepancies are output to 
separate GIS layers. 

Topology: The ArcGIS Validate Topology Tool is used to flag any topology issues in the broadband data. Flagged 
issues are reviewed to identify false positives and update true errors as required.  
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SBI Check Submission: The NTIA-provided SBI Check Submission tool is utilized to validate that the deliverable 
broadband data is consistent with the business logic rules set forth by the NTIA and a passing receipt is provided 
with the data submittal to NTIA. 

Stakeholder Feedback:  The state broadband mapping website includes a feedback function. Comments received 
from stakeholders are reviewed and used to validate provider data submissions. 

 Validation and Confidence Level Reporting 
To facilitate validation and confidence level reporting, Baker deployed a validation application called Statistical 
Evaluation and Assessment System (SEAS) which automatically compares the multiple independent validation 
datasets against the broadband service provider supplied information.  The SEAS uses statistical methodologies 
to report the confidence level in the spatial and attribute accuracy of the information.  Appendix B shows the 
validation workflow. 

The SEAS comparison is a three-part validation process: 
1. Comparison of the collected validation source against the aggregated broadband provider data. 
2. Match percentage calculation for each provider reported in the DataPackage.xls, “Provider Table” tab, 

“Comments” column. 
3.  Confidence score calculation displayed on the state broadband website.  

 

Figure 4  Statistical Evaluation and Assessment System (SEAS) 
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After completing all validation data source collections, SEAS is used to automatically compare the multiple 
validation datasets against the aggregated broadband data which came from the providers. Through the SEAS 
accumulation table, it produces a match percentage per broadband service record based upon the number of 
matches that record has against each validation source. The matched percentage for each record is the result of 
the total count of the matched validations for the record divided by the total validation source being compared 
against the record.  A validation confidence rating/score is then assigned on a scale of 1 to 5 based upon the 
percentage of validation source matches as per the following score results: 

• 1 Star   = 0% - 19% Match 

• 2 Stars = 20% - 39% Match 

• 3 Stars = 40% - 59% Match 

• 4 Stars = 60% = 79% Match 

• 5 Stars = 80% - 100% Match 

• “No Analytics” = No validation source available for that provider 

The State’s public broadband mapping website (http://broadband.louisiana.gov/providers.asp) is updated with 
the confidence level results at the record level based upon the queried geographic location and the following is 
an example of this representation. 

 
Provider Name Transmission 

Technology 
Max Download 
Speed 

Max Upload Speed  Confidence Score 

AT&T Mobility Mobile Wireless Greater than or e… Greater than or e… 
 

Verizon Asymmetric xDSL Greater than or e… Greater than or e… NO ANALYTICS 
Comcast Cable Modem – 

Other 
Greater than or e… Greater than or e… 

 

  
The matched percentage for the records for each provider are summarized and then divided by the total count 
of the records to create the final matched percentage for the specific provider. These percentages are included 
in DataPackage.xls on the Provider Table tab in the Comments column. 

Low Confidence Provider Feedback  
Provider data which is assigned a low confidence (1 or 2 stars) through the SEAS process is communicated back 
to the provider through a feedback loop. Generally, the low confidence feedback and reconciliation is a 
continuous refinement process and will occur between update cycles. The goal is to provide this feedback 
through the Provider Update Portal via a web connection that will be available and rolled out to provider in early 
2012. 

Changes and Corrections Documentation 
With each NTIA semiannual data submittal, changes and corrections documentation is provided. Significant 
changes in a provider’s status or data, corrections to previously supplied data, providers supplying data for the 
first time, etc. are specified by Provider name in the Changes and Corrections document. 
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Future Validation 
Audit of Wireless Broadband Availability Reporting:  Wireless coverage will be evaluated using a contour 
calculation tool, with key inputs being transmitter location and, where available, data on spectrum power levels 
and other relevant transmission factors provided by carriers and/or supplemented by data available from public 
web sites and other sources.  Data will then be input to a contour calculation tool to provide estimates of fixed 
wireless broadband coverage areas. This dataset is used as a source to determine gaps in provider wireless 
service area coverage.  The Prior Mapping data is also used as a validation source for gap analysis. 
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Appendix A: State of Louisiana SBI Process Workflow 
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Methodologies Used to Create and Validate Broadband Datasets  
For the October 1, 2011 SBDD Submission 

 
 
EXECUTIVE SUMMARY 
 
Broadband data for Massachusetts was collected, integrated and verified by the Massachusetts 
Broadband Institute (MBI), a division of the Massachusetts Technology Collaborative (MTC). 
This data was prepared for the National Telecommunications and Information Administration 
(NTIA) as part of the State Broadband Data and Development (SBDD) grant program and will 
be displayed on the National Broadband Map. This data is current as of June 30, 2011 and will 
continue to be verified and updated to improve the quality and accuracy of the information to 
support MBI activities including adoption studies and last mile deployment planning. 
 
About the MBI 
The MBI is the central broadband entity for the Commonwealth of Massachusetts, created on 
August 4, 2008 when Governor Deval Patrick signed Chapter 231 of the Acts of 2008, An Act 
Establishing and Funding the Massachusetts Broadband Institute (the “Broadband Act”). The 
mission of the MBI is to extend affordable, robust high-speed Internet access to all homes, 
businesses, schools, libraries, medical facilities, government offices and other public places 
across our state.   
 
The Broadband Act gives the MBI the authority to invest up to $40 million of state bond funds 
into broadband infrastructure. This bonding authority is structured as an “incentive fund” 
intended to stimulate private industry investments that will complement the MBI’s public 
investments. The MBI is investing its funds in long-lived infrastructure assets, such as conduit, 
fiber-optic cable, and wireless towers, which will lower the cost of entry for broadband providers 
and make it economically feasible for such firms to provide broadband access service to 
currently unserved residential, business and institutional customers. For more information about 
the MBI and its programs and activities, visit the web site at www.massbroadband.org. 
 
Data Summary 
Data was acquired from 31 providers and created from the web sites of 2 additional providers of 
residential and business broadband access in Massachusetts. Data transmission technologies in 
the datasets include asymmetric and symmetric DSL, other copper wireline, DOCSIS 3.0 and 
other cable, fiber optic, unlicensed fixed wireless, 3G and 4G mobile wireless and satellite 
technologies. This information was integrated and submitted to the NTIA in the following four 
datasets.   
 
Dataset # Providers # Records 
BB_Service_CensusBlock 18 424,663 
BB_Service_RoadSegment 11 8,721 
BB_Service_Wireless 14 24 
BB_ConnectionPoint_MiddleMile 17 599 

 

http://www.massbroadband.org/�
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Information on broadband services at community anchor institutions (CAIs) were collected by 
phone, email and web surveys. Approximately 21% of the CAIs participated in the survey, of 
which 84% subscribe to broadband services. 
 
Dataset # Institutions # Records 
BB_Service_CAInstitution 4282 4,558 

 
 
DATA DEVELOPMENT – GENERAL 
 
Data development was performed using ESRI ArcGIS 10.0 software.     
 
Data Integration 
Data were received from broadband service providers in varying formats and levels of detail.  No 
two datasets were alike, which required a significant amount of manual review and editing to 
integrate the information into a common format.  Although Excel and Shapefile templates were 
made available, very few datasets were received in the template formats and attributes were not 
always provided using the standardized coded values requested.  In addition, attribute field 
names were inconsistent between datasets, contained spaces and special characters or were 
missing altogether.  These differences prevented the use of automated data integration models to 
format and import data into standardized feature class templates.   
 
All attributes were standardized so that the provider name, doing-business-as name and FCC 
registration numbers were consistent throughout the datasets and that attributes complied with 
valid value list (e.g., for technology of transmission, spectrums used, maximum advertised and 
typical speeds, end user category, etc.). 
 
Geocoding 
Unless otherwise specified, address data was geocoded using street addresses and zip codes from 
NAVTEQ 2008 Q4 streets data, which was developed though a partnership between NAVTEQ 
and the Massachusetts Office of Geographic Information (MassGIS) for increased geocoding 
accuracy and success rates for State 911 data. 
 
Data transfer model loading 
The final datasets for each provider were appended and loaded into the SBDD transfer schema.  
Geometry and topology checks were performed a final time and the data were checked for 
conformance with SBDD database and business rules.   
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DATA DEVELOPMENT – WIRELINE AVAILABILITY 
 
This section describes the methods used to create the following datasets representing wireline 
broadband availability (e.g., cable, xDSL, other copper wireline, fiber optic and other 
unclassified wireline services) by census block and/or road segment: 
 
 BB_Service_CensusBlock and  
 BB_Service_RoadSegment 
 
The various wireline broadband availability data formats received include: 
 
1. Non-geographically referenced CAD files containing cable or fiber strands;  
2. Geographically referenced Shapefiles containing census block polygons or road segments;  
3. Excel spreadsheets or delimited text files containing census block IDs 
4. Excel spreadsheets or delimited text files containing individual street addresses;  
5. Excel spreadsheets or delimited text files containing street address ranges 
6. Written or verbal narratives of service areas; and 
7. Excel spreadsheets containing maximum advertised speeds by US Census Bureau core based 

statistical area (CBSA) and rural statistical area (RSA). 
 
For areas where census blocks are less than or equal to 2 square miles in area, a template 
containing 2010 census block polygon geography was used.  Otherwise, a template containing 
line geography from 2010 TIGER/Line roads that intersect 2010 census blocks greater than 2 
square miles in area.  Associated attribute information included provider identification, 
technology of transmission and upload and download speeds.   
 
Data Integration 
The integration methods used, and described below, varied according to the source data format.   
 
1. Integrating CAD strands:  Cable strands submitted in CAD format were georeferenced to 

street centerlines and a 200 foot buffer was created from the strands.  2009 census blocks and 
2009 TIGER/Line road segments (in census blocks greater than 2 square miles in area) that 
intersected the 200 foot buffer were classified as served and associated attribute information 
from tabular datasets or narratives were populated accordingly.  These were later converted 
to 2010 census blocks and roads, as defined in method 4. 

 

2. Integrating census block and road segment polygons:  Data provided in Shapefile format 
required minor formatting of attribute field names and values to match the common schema. 

(a) The census block vintage (2000 or 2010) was determined by reviewing ID values and 
attributes were imported into the census block template.  

(b) If vector data was provided from a source other than TIGER/Line roads, a spatial 
intersection with a 200 foot buffer was performed to transfer attributes to the corresponding 
TIGER/Line road segments. 
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3. Integrating tabular data containing census block IDs:  Tabular information relating to census 
blocks referenced either 2009 or 2010 census block data and were joined to the 
corresponding polygon geometry using the 15 or 16 character FIPS IDs.  2009 census block 
data were summarized and joined to the 2000 census block polygons using the first 15 
characters of the FIPS ID while retaining the maximum advertised and typical speeds and 
other associated validation and data processing attributes.  These were then converted to 
2010 census blocks, as defined in method 4. 

 
4. Converting to 2010 census blocks:  Census blocks and associated attribute information were 

converted from 2000 to 2010 census blocks by performing a spatial overlay of the adjusted 
2000 census blocks and the new 2010 census blocks. Attribute information was summarized 
by the 15 character GEO ID (i.e., FIPS ID) and statistics were calculated to carry over the 
appropriate attribute information (e.g. maximum advertised speeds), which were loaded back 
into a template containing the 2010 census block geometry. 

 
5. Integrating tabular data containing individual street addresses:  Tabular data containing 

individual street addresses, generally representing subscriber addresses, were geocoded using 
NAVTEQ 2008 Q4 streets data to generate point locations. 2010 census blocks and 2010 
TIGER/Line road segments (in census blocks greater than 2 square miles in area) that 
intersect a 200 foot buffer of the points were classified as served.  Associated attributes were 
also imported. 

 
6. Integrating tabular data containing street address ranges:  (a) If tabular data was based on 

2010 TIGER/Line roads and included a TIGER line ID (TLID), the attributes were loaded 
into a template containing the TIGER/Line geometry by joining the TLIDs. 

 (b) If tabular data was not based on TIGER/Line roads or did not have a means for creating a 
unique ID to link to the TIGER/Line data, the minimum, mean and maximum left and right 
street addresses were geocoded using NAVTEQ 2008 Q4 streets data to generate point 
locations.  As with the individual street address methodology above, 2010 census blocks and 
2010 TIGER/Line road segments (in census blocks greater than 2 square miles in area) that 
intersect a 200 foot buffer of the points were classified as served.  Associated attributes were 
also imported. 

 
7. Integrating narrative data:  (a) Location information provided in narrative form, such as the 

names of streets served or unserved, were incorporated by classifying the qualifying road 
segments as served.  A spatial intersection was then performed to classify any census blocks 
with area less than 2 square miles as served. 

(b) Attribute information provided in narrative form generally applied to all records or an 
easily identifiable subset of records in a dataset and the standardized values were assigned to 
the appropriate field in batch. 
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8. Integrating spreadsheets containing speed by CBSA/RSA:  The tabular data was joined to 
corresponding CBSA/RSA polygon geometry using the CBSA/RSA ID. Maximum 
advertised download and upload speed values were transferred to census block and road 
segment availability records from the CBSA/RSA polygon they are located within. 

 
Data standardization 
All information was imported into to 2010 census blocks and road segments.  Records with 
download speeds below 768 kbps (i.e., that don’t qualify as broadband service) were removed 
from the final dataset. 
 
 
DATA DEVELOPMENT – WIRELESS AVAILABILITY 
 
This section describes the methods used to create the following dataset representing wireless 
broadband availability (e.g., fixed and mobile wireless and satellite services) by service area: 
 
 BB_Service_Wireless  
 
The various wireless broadband availability data formats received include: 
 
1. Geographically referenced Shapefiles or MapInfo files containing service area polygons;  
2. Geographically referenced KML raster files depicting service areas;  
3. Non-geographically referenced PDF and JPG files depicting service area polygons;  
4. Hard copy maps with hand-drawn service areas; 
5. Excel spreadsheets containing street addresses; and 
6. Emails and technical documents containing tower and signal specifications. 
 
Associated attribute information included provider identification, technology of transmission, 
wireless spectrums used and upload and download speeds.  In some cases, attributes were 
provided in a separate tabular or narrative form or had to be acquired from the provider’s web 
site.  If providers offered more than one spectrum, a separate feature was created for each unique 
provider and spectrum combination.  
 
Data Integration 
Data integration methods used, and described below, varied according to the source data format.   
 
1. Integrating service area polygons:  Data provided in vector format required minor processing 

to fix geometry errors and create separate polygons for unique provider and spectrum 
combinations.  Polygons less than 0.125 square miles were removed and the remaining 
polygons were dissolved to create a single feature for each unique provider and spectrum 
combination. Attribute field names and values were created, formatted and/or populated from 
tabular or narrative form to match the standardized template format. 
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2. Integrating service area raster images:  Propagation model outputs provided as KML raster 
images were imported into the GIS system; however, the geographic reference information 
was not able to be preserved.  The imported raster images were georeferenced in the GIS by 
matching the intersections of propagation area boundaries and roads in Google Earth.  Once 
georeferenced, the raster images were converted to polygons, then tagged with and 
aggregated by the associated tower ID and spectrum information to create service areas 
polygons for each propagation model.  Additional associated attribute values were populated 
from information provided in narrative form. 

 
3. Integrating static maps:  The PDF and JPG maps containing wireless access points and 

service area buffers were georeferenced using known locations, such as road intersections.  
Service areas were digitized or recreated from buffered points on the georeferenced maps.  
Individual service areas were tagged with spectrum information and aggregated into a single 
service area for the provider and spectrum combination.  Additional associated attribute 
values were populated from information provided in narrative form or from providers’ web 
sites and the resulting service area boundaries received confidence score of 1. 

 
4. Integrating hard copy maps:  Hard copy maps containing shaded service areas were 

reproduced by digitizing boundaries based on known map locations, such as road 
intersections.  Associated attribute values were populated from information provided in 
narrative form and the resulting service area boundaries received confidence score of 1. 

 
5. Using tabular data containing street addresses:  Tabular data containing individual street 

addresses, representing subscriber addresses or addresses where service was determine not to 
be available, were geocoded using NAVTEQ 2008 Q4 streets data to generate point 
locations. These locations were compared to service areas and propagation models to verify 
boundaries. 

 
6. Modeling with tower and signal specifications:  Wireless tower and signal specifications 

(e.g., latitude, longitude, cell site height, cell site frequency and effective radiated power) 
were used as input parameters in SPLAT! radio frequency signal propagation, loss, and 
terrain analysis software. Service area boundaries were derived from the received power 
contours in the resulting propagation models. Additional associated attribute values were 
populated from information provided in narrative form. 

 
Data standardization 
Service area datasets for each provider were clipped to the state boundary and self-intersecting 
lines were fixed prior to loading into the SBDD transfer schema.     
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DATA VERIFICATION – WIRELINE AND WIRELESS AVAILABILITY 
 
This section describes the methods used to verify the following datasets representing wireline 
broadband availability (e.g., cable, xDSL, other copper wireline, fiber optic and other 
unclassified wireline services) by census block and/or road segment and wireless broadband 
availability (e.g., fixed and mobile wireless and satellite services) by service area: 
 
 BB_Service_CensusBlock,  
 BB_Service_RoadSegment and 
 BB_Service_Wireless 
 
Verification of availability data received from providers is essential to determining the accuracy 
and completeness of the resulting broadband availability maps and is an ongoing process.  
Methodologies continue to be developed and implemented for data verification and are 
incorporated into a confidence ranking process.  The data verification and confidence ranking 
methods are described below. 
 
The data verification process employs the following methods, which supply input for the 
confidence ranking methodology.  
 
1. Cable service area modeling:  Cable strand data for incumbent cable providers were acquired 

as georeferenced MapInfo files from the MA Department of Telecommunications and Cable 
(DTC) in 93% of the 305 cable-served towns.  The strands were imported and a 200 foot 
buffer was created to approximate the distance from the cable that a structure can receive 
service without excessive cost or delay.  The 200 foot distance was selected based on 
observed distances between poles and the acceptable distances of structures from cable as 
defined in cable license agreements.  Census blocks and road segments acquired from 
providers that intersected the resulting service area buffers for that provider were given an 
increased confidence score.   

 
2. DSL service area modeling:  DSL service areas were modeled from known DSL-equipped 

central office locations, which were geocoded using NAVTEQ 2008 Q4 streets data and 
refined using aerial photography, street views and bird’s-eye views from Google Maps and 
Bing Maps.  A linear network was developed, using a comprehensive roads dataset 
maintained by the MA Department of Transportation (MassDOT), that encompassed all 
roadways within 17,800 linear feet of the central office location.  A 200 foot buffer of the 
network was created to define a maximum service distance of 18,000 feet from the central 
office to the service location, based on input from industry experts, with the same 200 foot 
distance from pole to structure that was used in the cable model.  The resulting service area 
buffers were cropped at town boundaries except where central offices were known to serve 
neighboring towns.  Census blocks and road segments acquired from providers that 
intersected the estimated service areas for that provider were given an increased confidence 
score.   
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3. Infrastructure field surveys:  Targeted field work has been performed to located broadband 
infrastructure, such as DSL-equipped remote terminals (RTs).  As with the central offices, 
locations were mapped using address and landmark information acquired in the field by 
geocoding with NAVTEQ 2008 Q4 streets data and refining with aerial photography, street 
views and bird’s-eye views from Google Maps and Bing Maps.  Although many DSL-
equipped RTs have been located in the field, they have not yet been incorporated into the 
DSL service area model yet due to the difficulty of predicting the directional nature of 
services provided from those locations.  However, the locations are valuable for visual 
review areas of DSL coverage claimed by providers that fall outside of modeled service areas 
to evaluate the likelihood of service from a given RT location.  These visual reviews are 
performed by team consisting of a GIS expert and a DSL technology expert and confidence 
scores modified accordingly. 

 
4. Public surveys:  Broadband subscription information is collected through web-based 

broadband surveys from the public and from community anchor institutions (see 
www.massbroadband.org/mapping/survey.html).  The surveys are publicized through 
targeted events and publications and MBI email notifications.  Information collected includes 
location, provider name, transmission technology, price, and speed for homes, businesses, 
and institutions throughout the state.  At this time, the survey data is only used to verify 
availability by provider name and transmission technology.  Census blocks and road 
segments acquired from providers that are within 200 feet of survey locations are given an 
increased confidence score.  As with the service area models, the 200 foot distance represents 
the distance at which service can be provided without excessive cost or delay.  In the future, 
speed test results will be summarized by census block to verify typical speed information 
received from providers as well.   
 
Responses to the public survey are geocoded through Google Maps and visually refined by 
the user if desired.  Responses to the community anchor institution surveys are linked to 
existing point locations maintained by the Massachusetts Office of Geographic Information 
(MassGIS) or affiliated agency.  Community anchor institutions that have changed addresses 
or are not already in the MassGIS datasets are geocoded using NAVTEQ 2008 Q4 streets 
data and refined using a combination of institution web sites and aerial photography, street 
views and bird’s-eye views from Google Maps and Bing Maps. 
 
At this time, responses from the FCC’s consumer broadband test are not used for data 
verification, but will be evaluated for inclusion in future data verification phases. 

 
5. Provider web site information:  If information acquired by providers – including availability 

and speed – appeared to be questionable, a search was performed on the provider’s web site 
to confirm it.  This was type of verification was only performed when uncertainties arose 
during visual review of the data.  In the future, this type of review may be incorporated into a 
more structured approach to validate locations that are geographically dispersed throughout a 
provider’s service area.  

 

http://www.massbroadband.org/mapping/survey.html�
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6. Community cable and DSL feedback:  In collaboration with some Regional Planning 
Agencies (RPAs), availability maps were generated and distributed to carefully selected 
community representatives, such as local broadband committee members or town officials, 
with local knowledge of cable and/or DSL services in their town.  The community 
representatives reviewed and mark-up hard copy maps to identify services areas that extend 
too far or not far enough and to provide the location or address of the last known service 
location along a road.  This was initially implemented through a pilot project for the member 
communities of two RPAs and will be rolled out to 3 additional RPAs in other low 
confidence areas, which include the remainder of western Massachusetts and part of central 
Massachusetts.  Confidence scores were be modified based on feedback from the community 
representatives and DSL service area boundaries were modified in areas with the most 
knowledgeable representatives. 

 
7. Wireless drive studies:  In coordination with local colleges, teams of student volunteers were 

trained to perform wireless drive studies.  The students drove pre-defined routes with 
intermittent stops to collect wireless signal location and quality information using Android 
phones operating QoS Solutions’ QMapper and QPerf software (see www.qos-
solutions.com).  The drive studies were performed in the same 5 RPA regions in central and 
western Massachusetts as the community cable and DSL feedback projects.  The drive study 
results will be overlaid on the wireless providers’ service areas and submitted for review by 
the providers.  Further verification or service area boundary modifications may be discussed 
with providers in areas with anomalous results. 

 
Confidence Ranking 
As availability data is verified, the verification status is documented in each individual census 
block or road segment record or subdivision of a wireless service area.  The records are also 
assigned numeric values from 1 to 5 that represent the level of confidence in the likelihood that 
service is available at that location.  When service availability for a given provider and 
technology is verified by an alternate source, the confidence value for that location is increased 
by one, up to a maximum score of 5.  A value of 1 represents the lowest confidence in provider 
data and no corroborating information from alternate sources.  A value of 5 represents 3 or more 
corroborating sources or confirmation through field work.  Data of all confidence levels are 
included in the availability datasets; however, locations that are deemed to be inaccurate as a 
result of the data verification process may have their confidence value reduced and may be 
tagged as not part of the service area. 
 
General guidelines of the confidence ranking process are as follows: 
 
 Initial rankings:  Data records submitted by providers are given an initial confidence ranking 

of “1” or “2” depending on the level of ambiguity in the submission method.  For example, 
availability information provided by census block ID, street address or spatial object is given 
a confidence ranking of 2.  Whereas, availability information provided as hand-drawn or 
narrative estimates may be given a confidence ranking of 1. 

 

http://www.qos-solutions.com/�
http://www.qos-solutions.com/�
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 Verification from alternate sources:  If availability at a given location is corroborated by an 
alternate dataset (such as the cable or DSL models, broadband survey responses, cable or 
DSL service area feedback from community representatives, or wireless drive study data 
interpolation), the verified location receives a 1 point increase in the confidence score for 
each corroborating dataset, with a minimum score of 3 and a maximum score of 5.   

 
 Field confirmation:  If availability at a given location is confirmed by known service 

locations identified through field work, it is given a confidence score of 5.  Confirmed field 
locations include known infrastructure, such as DSL-equipped remote terminals, or known 
service availability acquired in wireless drive studies. 

 
Provider Feedback Loop 
All providers that submitted data received a written data submission report that described the 
format and completeness of the datasets they provided.  This report included requests for 
additional information or alternate formats in the next submission and other data clarifications or 
corrections needed.  Additional feedback was provided by phone or email conversations as 
needed.  In addition, PDF maps of estimated services, based on the census blocks and roads or 
wireless area boundaries, were provided for verification and/or modification.  Information on 
conflicting alternate data sources may also be provided for comment or challenge.  In the future, 
this process will be standardized and formalized through the development of a web-based 
provider data portal.  
 
 
DATA DEVELOPMENT – MIDDLE MILE INTERCONNECTION FACILITIES 
 
This section describes the methods used to create the following dataset representing the location, 
technology and capacity of facilities that connect a service provider’s network to another 
provider’s network or the Internet: 
 
 BB_ConnectionPoint_MiddleMile 
 
Tabular data – including provider identification and facility ownership, capacity and type – were 
received from providers by street address or latitude and longitude.  Latitude and longitude 
values were used to create point geometry when possible.  Otherwise, street address data was 
geocoded using NAVTEQ 2008 Q4 streets data.   
 
The MBI did not have alternate data sources for the verification of these datasets. 
 
Data standardization 
Facility ownership, capacity and type values were standardized to comply with valid value lists.  
Due to the field type of double used to store latitude and longitude, values with trailing 0’s did 
not meet the 6 digit business rule.  However, to preserve the accuracy of the data, these values 
were not modified to contain 6 digits.  Latitude and longitude values received from providers 
with less than 6 digits were also not modified to prevent misrepresenting the data as more 
accurate than it really was. 
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DATA DEVELOPMENT – COMMUNITY ANCHOR INSTITUTION SERVICE SUBSCRIPTIONS 
 
This section describes the methods used to create the following dataset representing the location 
and broadband service subscription of community anchor institutions throughout the state: 
 
 BB_Service_CAInstitutions 
 
The community anchor institution datasets deemed most relevant to broadband issues in 
Massachusetts were:  
 
 K-12 schools 
 Colleges and universities 
 Public libraries 
 Hospitals 

 Community health centers 
 Police and sheriffs 
 Career centers 
 Town halls

 
Existing spatial datasets containing community anchor institution names and locations were 
acquired from state and regional agencies.  The attributes were standardized and imported into a 
template dataset.  Missing attributes (e.g., zip codes) were acquired through web searches (e.g., 
on institution web sites or from the US Postal Service).  
 
Initial data requests were made to state and regional agencies and/or associations to acquire any 
existing compilations of information on broadband service information at affiliated anchor 
institutions. Complete or almost complete datasets for career centers, state police and county 
sheriffs were acquired from the MA Executive Office of Labor and Workforce Development 
(EOLWD) and MA Executive Office of Public Safety and Security (EOPSS).   
 
For the remainder of the anchor institutions, a campaign was implemented to acquire information 
through phone, email and web-based surveys from individuals associated with individual anchor 
institutions that were knowledgeable about its broadband services. Requests were also made 
through targeted outreach at events and in publications targeted at anchor institutions to increase 
awareness of broadband issues and participation the broadband survey. Agencies and 
organizations that assisted in this effort included the MA Department of Secondary and 
Elementary Education (ESE), MA Board of Library Commissioners (MBLC), MA Chiefs of 
Police Association (MCOPA), Massachusetts Municipal Association (MMA) and MA 
Department of Revenue (DOR), Mass League of Community Health Centers (MLCHC) and a 
CIO group for public and community colleges. 
 
Data standardization 
Survey questions were developed to request information that were easily understood and 
acquired by anchor institution staff.  As a result, survey results required additional formatting to 
standardize the information in accordance with SBDD valid values.  This information included 
broadband subscription status, transmission technology and maximum advertised speeds were 
collected and standardized to comply with valid value lists.  In addition, street addresses for new 
anchor institutions that were not in the original GIS datasets were geocoded using NAVTEQ 
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2008 Q4 streets data and refined using visual references such as Google satellite photography 
and street view imagery.     
 
In some cases, standardized transmission technology attribute values were used by the MBI to 
track uncertain technology categories.  These were converted in the final datasets, as shown 
below, to comply with SBDD valid values.   
 

MBI Technology Values SBDD Technology Values 
1: Unknown 0: Other 
42: Cable - DOCSIS Unknown 41: Cable - DOCSIS Other 
72: Fixed Wireless - Unknown 70: Fixed Wireless - Unlicensed 

 
In some cases, transmission technology was corrected to reflect the service known to be offered 
by the specified provider. For anchor institutions that have more than one broadband connection, 
only records with the maximum speeds for each transmission technology type were included.  
For anchor institutions that did not provide broadband information, the broadband service field 
was set to unknown (BBSERVICE = U).  
 
 
BROADBAND CHALLENGES IN MASSACHUSETTS 
 
Broadband access differs significantly between the eastern, central and western parts of the state 
as well as the cape and islands. The majority of “unserved” and “underserved” communities are 
in western Massachusetts, which represents approximately 1/3 of the land mass in the state. 
Barriers to broadband access and deployment in this region are primarily due to topography, 
vegetation and population density. Western Massachusetts, as well as Cape Cod, currently lacks 
the middle mile infrastructure needed to encourage private sector development of last mile 
service. 
 
Wireline broadband availability in Massachusetts, particularly in western Massachusetts, is 
overstated in the current broadband datasets. This is due, in part, to generalizations resulting 
from census block size and population distribution in rural areas. The MBI is also working with 
communities to incorporate local knowledge of service availability in our feedback to broadband 
service providers and flagging census blocks and road segments requiring additional verification. 
 
Wireless broadband availability in Massachusetts is also overstated. The reliability of 
propagation modeling has been identified as a concern in establishing wireless broadband 
availability. Although topography is factored into propagation models, vegetation is also a 
significant barrier to wireless in Massachusetts and makes it difficult to determine if service is 
really available at a location. In addition, at least one fixed wireless provider is not able to accept 
new customers within its service area due to limited capacity. Responses to the MBI survey also 
indicate that typical mobile wireless speeds do not always qualify as broadband.  
 
Information provided by the community anchor institutions also requires additional review and 
modification. Respondents had difficulty selecting the correct transmission technology (e.g., the 



  SBDD Methodology 
  October 2011 Data Submission 

Version 3 – October 1, 2011  Page 13 of 13 

provider name frequently did not correspond to the technology) and often did not know the 
advertised speed of their service.  
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Submission Summary 
 
The staff of the Eastern Shore Regional GIS Cooperative (ESRGC) at Salisbury University in 
Salisbury, Maryland, in its role as primary technical lead for the Maryland Broadband Mapping 
Initiative, contacted 96 facilities‐based broadband service providers (BSPs), received data from 
47 providers which represent 49 different companies.  An overall summary of the data 
submission can be described as: 
 
                96 potential facilities‐based broadband service providers were contacted 
                30 BSPs did not respond 
                9 BSPs responded but did not provide data 
                47 BSPs responded and provided data 
                2 BSPs responded and agreed to provide data but have not as of September 30, 2011 
 
Of those that provided data, 
 
  24 provided addresses 

12 provided census block information 
  9 provided census blocks and road segments 
  13 provided wireless coverage areas 
 
  In addition, 10 of the 49 responsive BSPs provided middle mile infrastructure points 
 
Since our last submission, we gained two participants as Cavalier Telephone LLC (via their new 
owner, PAETEC Communications, Inc.) rejoined the effort and Mediacom Communications 
submitted data for the first time.   
 
Data Processing 
 
For a specific discussion of the data processing steps for any particular BSP, please see the 
individual dataset report for each BSP below.  In general, the data processing used to create the 
Fall 2011 data submission depended on the type of data provided by the BSP. 
 
Census Blocks 
 
To process the served census blocks, one first geocodes the provider‐submitted address table 
(if applicable) to the ArcGIS 10 US Streets Geocode Service.  Second, the address points are 
spatially joined to the Year 2010 census blocks.  Next, divide the address points into the 
different technologies of transmission.  Fourth, select those address points that are within the 
census blocks that are greater than 2 mi2, exporting them as a separate feature class.  Fifth, 
switch the selected set (thus creating all the address points in blocks that are less than 2 mi2), 
and select those blocks. Sixth, import the provider‐submitted table of served census blocks and 
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merge with the address‐created blocks (if applicable). Finally, export the results.  For those 
providers that delivered data in Year 2000 census blocks, the crosswalk table provided by the 
US Bureau of the Census was used to transfer the data from the old blocks to the current 
blocks.  The new, 2010 block‐based map was then sent to the provider so that they could 
confirm the spatial representation.  Finally, changes were made to any served blocks following 
the provider review.  
 
Road Segments 
 
To process the served road segments that are within census blocks that are greater than 2 mi2, 
we import the table of road segment address ranges provided by the BSP.  We then take the TO 
address values and the FROM address values on both the left and the right side of the segment 
and concatenate those address numbers with the street name, type, and direction, thus 
creating a maximum of 4 point addresses per road segment.  Those point addresses are then 
address matched against both the TIGER line file and the Maryland iMap geocoding service.  
We can then find the street segments in TIGER that are adjacent to the located points.  Finally, 
we select those TIGER lines that intersect the census blocks that are greater than 2 mi2.  The 
result can be loaded into the SBDD Transfer data model.   
 
Service Addresses  
 
The process for creating the service addresses is the same as the census blocks (above), except 
that the addresses that fall within the census blocks that are greater than 2 mi2 are kept as the 
key feature class.  
 
Middle Mile Infrastructure  
 
Processing the middle mile infrastructure is relatively trivial, in that the providers submit 
geographic coordinates with the middle mile attributes.  Most of the providers, however, do 
not submit new middle mile data every six months.  Therefore, any middle mile infrastructure 
collected during previous submission periods have been include in the current submission. 
 
Community Anchor Institutions 
 
The creation and verification of the Community Anchor Institution (CAI) Database is the 
responsibility of the Center for GIS at Towson University (CGIS).  For the October 2011 
submission, CGIS focused on improving the quality of Maryland’s CAI broadband dataset by 
reaching out to county executives, by supplementing data collected for medical CAIs with data 
from the Maryland Department of Health and Mental Hygiene, and by removing duplicate data. 
The following narrative describes the work performed in each area. 
 
In order to improve county‐level data, the County Executives of each Maryland county, and 
Baltimore City, were contacted by letter in June 2011 requesting their cooperation with the 
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Maryland Broadband Mapping Initiative’s effort to build the CAI database. Of the 24 county 
executives who received the letter, 22 responded by providing a contact to assist in the data 
collection effort. The CAI information collected to‐date was formatted in an Excel spreadsheet 
for each county. The spreadsheets are organized by tabs representing each of the 7 CAI 
categories. Hospitals, medical CAIs, and private schools were excluded because they are not 
county‐run entities. The county CAI contacts were asked to review the database entries, and to 
add, correct, and delete CAIs and their attributes based on their knowledge and available 
information.  
 
Updated CAI information was returned by 15 counties. Two of the counties (Harford and 
Howard) misinterpreted the request and provided information related to the Broadband 
Technology and Opportunities Program (BTOP). All of the data updates received from the 
counties were reviewed and then integrated into Maryland’s master CAI database. The table 
below summarizes by county the CAI database improvements resulting from this effort (not 
including hospitals, medical CAIs, and private schools). 
 
 
  Submitted to county for review  Returned by county   
 

# 
Records 

# Records 
with 

Broadband 
Info 

% Records 
with 

Broadband 
Info 

# Records 

# Records 
with 

Broadband 
Info 

# Records 
Broadband 

Info 
Updated by 
County 

% Records 
Broadband 

Info 
Updated by 
County 

Allegany  411  62  15% 419 60 7  2%
Anne Arundel  305  164  54% 306 238 221  72%
Baltimore City  1096  227  21% No information received  0%
Baltimore  386  372  96% 385 301 112  29%
Calvert  84  69  82% 79 75 23  29%
Caroline  38  21  55% 46 46 46  100%
Carroll  150  56  37% 151 143 143  95%
Cecil  119  36  30% 121 45 12  10%

Charles  115  38  33% 116 113 15  13%
Dorchester  79  22  28% No information received  0%
Frederick  147  81  55% No information received  0%
Garrett  151  129  85% 126 114 20  16%
Harford  156  71  46% No information received  0%
Howard  153  79  52% No information received  0%
Kent  26  15  58% 28 27 29  104%

Montgomery  464  397  86% 443 392 249  56%
Prince George's  436  398  91% 507 434 282  56%
Queen Anne's  77  26  34% 164 57 33  20%
Somerset  35  20  57% No information received  0%
St. Mary's  73  57  78% 68 61 24  35%
Talbot  33  10  30% 34 24 17  50%

Washington  Did not receive a contact Did not receive a contact  0%
Wicomico  54  42  78% No information received  0%
Worcester  Did not receive a contact Did not receive a contact  0%
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Prior to the April 2011 submission, data was purchased from DirectMail.com in order to obtain 
information about medical CAIs. The purchase totaled 21,996 records. As part of a continuing 
effort, the data were reviewed for erroneous records and for possible consolidation of records 
relating to hospitals, labs, and private practice groups. Due to time constraints and file size, the 
review for the more populous counties was restricted to addresses with five or more healthcare 
providers/facilities. Review of the largest counties (Montgomery, Prince George’s, and 
Baltimore Counties) was restricted to addresses with ten or more facilities. This effort led to an 
approximate reduction of over 3,100 records and will continue through the next update cycle. 
 
To further supplement medical CAIs, GIS data was obtained from the Maryland Department of 
Health and Mental Hygiene’s (DHMH) Office of Health Care Quality licensee database for 
medical facility classes such as assisted living programs, ambulatory surgical facilities, hospices, 
adult medical day care, physical therapy centers, facilities for developmentally disabled 
persons, mental health facilities, rehabilitation centers, and other similar entities. The data 
were reviewed for errors and duplicate records; approximately 500 of the records required 
geocoding and/or address correction. Additionally, the DHMH data were compared against the 
purchased and county medical facilities to remove possible duplications from these sources. 
Overall, more than 6,800 records from DHMH were added to the Maryland’s medical CAI 
database. 
 
In summary, the Maryland broadband CAI database now contains 30,579 records, an increase 
of 3,620 (13.4%) from the spring 2011 submission.  Information regarding the broadband 
service for 2,843 (9.3%) of those CAIs has been obtained.  There were significant percentage 
increases in the number of CAIs with broadband service information in the library, public safety, 
post‐secondary school, and government CAI categories.  Collecting broadband service 
information for the medical/healthcare CAIs continues to be a significant challenge, as does 
collecting a complete census of all county‐based CAIs 
 

    April 2011 Submission  October 2011 Submission 

CAI Category 
# CAIs with 
BBSERVICE 

Total 
CAIs 

% of CAIs 
with 

BBSERVICE

# CAIs with 
BBSERVICE 

Total 
CAIs 

% of CAIs 
with 

BBSERVICE
1  School (K‐12)  1,482 1,876 79.00% 1,465 1,791  81.80%
2  Library  135 202 66.83% 139 193  72.02%
3  Medical / Healthcare  25 22,118 0.11% 22 25,829  0.09%
4  Public Safety  227 684 33.19% 406 722  56.23%
5  University / College/      

Other Post‐Secondary 
39  82  47.56%  50  91  54.95% 

6  Other Community Support 
‐ Government 

633  1,470  43.06%  692  1,255  55.14% 

7  Other Community Support 
‐ Non‐Government 

18  527  3.42%  69  698  9.89% 

Total  2,559  26,959  9.49%  2,843  30,579  9.30% 
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Data Verification 
 
The ESRGC, in partnership with the Center for GIS at Towson University and as a subcontract to 
the SBDD grantee in Maryland, the Maryland Broadband Cooperative, conducted a number of 
verification and validation tests on the provider‐submitted broadband availability data.  In the 
event that inconsistencies or errors were found, certain changes are made to the provider‐
submitted data.  These changes are either retention but modification to provider‐submitted 
data or the removal of the provider‐submitted data, depending on the type and severity of the 
error.  Given our extensive review and testing of broadband availability information in 
Maryland, we feel confident that the changes we make are improving the accuracy of the 
provider’s submission.  We continue to search for new ways to refine the submitted data and 
present an ever‐increasing accurate portrayal of broadband availability in our state.   
 
In the first phase of data validation, the provider‐submitted data is processed for inclusion 
within the NTIA transfer model.  During this processing, several data inconsistencies can be 
found.  They include: 

1) Submitted download and upload speeds do not match the values expected for a 
given technology of transmission 

2) Service addresses are located hundreds of miles away from the provider’s known 
service areas 

3) Served blocks with technologies and speeds that do not meet the working definition 
of broadband 

4) Addresses/road segments/blocks that have no technology of transmission 
For each of these, the initial remedy is to contact the provider for clarification/modification.  If 
that communication is not successful for whatever reason, the data team makes a decision to 
either modify the data to match expected values or removes the errant data. 
 
In the second phase of data validation, a maximum of fourteen data checks are conducted on 
each of the provider‐submitted broadband availability data, listed below.  Different versions of 
data verification tests were conducted on submissions from wireline broadband providers 
versus wireless providers, because of the differing submission geometry.  Each check will be 
explained in detail below.  The result of each of these tests is an error statistic, cataloged in a 
data verification report.  No changes to the data are made based on these tests. 
 

1) Maximum down/upload speeds reported by provider 
2) Typical down/upload speeds reported by provider 
3) Typical down/upload speed from 2010 speed test 
4) Speed tests match reported typical speeds or are within 1 speed tier 
5) Speed tests present within blocks not reported as served by provider 
6) Census blocks/coverage area reported to project, but no tract reported directly to 

FCC 
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7) Tracts reported directly to FCC, but no census blocks/coverage area reported to 
project 

8) Census blocks/coverage areas versus unserved area locations reported 
9) Total number of unserved area locations reported per provider 
10) Web search verification 
11) Census blocks that are outside providers Cable Franchise Boundary 
12) Census blocks that are within another providers Cable Franchise Boundary  
13) Census blocks that are outside DSL boundary 
14) Wireless broadband presence and speed systematic field sampling 

 
Finally, the third and final phase of data validation is an in‐depth discussion of a provider’s data 
submission and the subsequent data tests with the provider via web conference.  During this 
discussion, a detailed review of the submission takes place including an examination of their 
resulting availability maps.  For the Fall 2011 submission, only one of these web conferences 
has taken place.  The length of time between the provider submission and the delivery deadline 
to the NTIA is not enough to complete all three data validation phases.  Our intention is to 
complete the third phase for most if not all providers during the three months following a data 
submission, and incorporating what we learn into the following biannual delivery. 
 
Maximum down/upload speeds reported by provider 
 
Facilities‐based BSPs are required to provide the maximum downstream and upstream speeds 
by the NTIA and the NoFA of August 2009.  These speeds are dependent upon the technology of 
transmission the BSP uses to deliver broadband service.  Speeds are reported in ordinal 
categories, or tiers, as defined by the NoFA.   They are: 
 

Downstream 
Speed Tier 

Upstream 
Speed Tier 

Corresponding Speed 

‐‐  1  Less than or equal to 200 kbps 
‐‐  2  Greater than 200 kbps and less than 768 kbps 
3  3  Greater than or equal to 768 kbps and less than 1.5 mbps 
4  4  Greater than or equal to 1.5 mbps and less than 3 mbps 
5  5  Greater than or equal to 3 mbps and less than 6 mbps 
6  6  Greater than or equal to 6 mbps and less than 10 mbps 
7  7  Greater than or equal to 10 mbps and less than 25 mbps 
8  8  Greater than or equal to 25 mbps and less than 50 mbps 
9  9  Greater than or equal to 50 mbps and less than 100 mbps 
10  10  Greater than or equal to 100 mbps and less than 1 gbps 
11  11  Greater than or equal to 1 gbps 

 
 
For this data check, the maximum downstream/upstream speeds reported from each provider 
are summarized in a table.  These speeds are summarized for census blocks, wireless coverage 
areas, road segments, and service address points. 
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For the data submission, 49 providers (100%) reported maximum downstream/upstream 
speeds for census blocks. The lowest maximum downstream speed Greater than or equal to 
768 kbps and less than 1.5 mbps, reported by 12 providers. The highest maximum downstream 
speed was greater than or equal to 1 gbps, reported by 6 providers The most frequent 
maximum downstream speed was greater than or equal to 3 mbps and less than 6 mbps, 
reported by 2 providers. 
 
 
Typical down/upload speeds reported by provider 
 
BSPs are required to provide the typical downstream and upstream speeds by the NTIA and the 
NoFA of August 2009.  Typical speeds are, per the NoFA, intended to be “the data transfer 
throughput rate that most subscribers to service at the maximum advertised downstream 
speed can achieve consistently during expected periods of heavy network usage.”  These 
speeds are dependent upon the technology of transmission the BSP uses to deliver broadband 
service.  Speeds are reported in ordinal categories, or tiers, as defined by the NoFA (see table 
above). 
 
For this data check, the typical downstream/upstream speeds reported from each provider are 
summarized in a table.  These speeds are summarized for census blocks, wireless coverage 
areas, road segments, and service address points 
 
For the data submission, 20 providers (41%) reported typical downstream/upstream speeds.  
The lowest typical downstream speed was greater than 768 kbps and less than 1.5 mbps, 
reported by 3 provider.  The highest typical downstream speed was greater than or equal to 1 
gbps, reported by 2 providers.  The most frequent typical downstream speed of the census 
blocks was greater than or equal to 3 mbps and less than 6 mbps, reported by 3 providers. 
 
 
Typical down/upload speed from 2010 mobile speed test 
Typical down/upload speed from 2010 computer‐based speed test 
 
Beginning in April 2010, the MBBMI team and the FCC (nearly simultaneously) began collecting 
speed test information from broadband consumers in the state of Maryland.  This speed test 
information included the downstream and upstream speed in kbps, the signal latency, the 
street address of the tester, the type of connection location (home, work, etc), the connection 
technology (cable/DSL, fiber optic, satellite/dial‐up, or unknown – MBBMI test only), the IP 
address of the test machine, and the corresponding BSP.  The MBBMI contracted with a 
company named Ookla to create their test; the FCC used both Ookla and an alternative method 
developed by a company named MLab. 
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From mid‐April 2010 until June 30, 2011, 12,141 speed tests were collected by MBBMI and 
26,537 PC‐based speed tests were collected by the FCC (the FCC also collected mobile speed 
tests, see below).  Of these, 5,527 MLab‐based FCC speed tests were eliminated (to insure 
consistent speed test results and 11,354 were removed because they did not include a valid 
address.  The FCC and the MBBMI speed tests were then combined and geocoded using their 
street address.  Just over 12% of the addresses could not be resolved, thus a total of 19,162 of 
speed tests were used in verification processing. 
 
The speed tests associated with each reporting BSP were extracted from the geocoded set.  The 
downstream and upstream speeds were classified according to the NTIA’s speed tiers (see table 
above) and the number of tests in each tier were counted.  A table of those results in included 
in each data validation/verification report. For mobile broadband providers, a distinction was 
made between the results from mobile speed tests (generated by an iOS or Android app) and 
the results from computer‐based speed tests (generated by a web‐based speed test) as those 
results are likely to be different (due to significant hardware/software differences) even though 
the network being accessed is the same 
 
For the state of Maryland as a whole, the PC‐based speed test results are: 
 

Speed Tier 
Number of 
Downstream 

Tests 

% of 
Downstream 

Tests 

Number of 
Upstream 
Tests 

% of 
Upstream 
Tests 

1  483  2.5%  1,461  7.6% 
2  1,541  8.0%  4,720  24.6% 
3  1,674  8.7%  1,154  6.0% 
4  2,077  10.8%  2,580  13.5% 
5  1,713  8.9%  5,895  30.8% 
6  2,387  12.5%  1,440  7.5% 
7  6,803  35.5%  1,754  9.2% 
8  1,959  10.2%  144  0.8% 
9  469  2.4%  12  0.1% 
10  56  0.3%  2  0.0% 

 
 
Speed tests match reported typical speeds or are within 1 speed tier 
 
For the 20 providers that submitted typical speeds for their data, a comparison was conducted 
between the mode (the most frequent value) of the typical download speed tier from the 
provider area and the FCC/Ookla speed tests. In instances where the most frequent download 
speed tier from the speed tests matched, or was within one tier of, the typical download speed 
tier from the provider, the response to this statement is affirmative (6 providers). When the 
response to this statement is negative (8 providers), there is question about the typical 
download speeds that have been submitted by the provider. 
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Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted) 
Number and percentage of mobile speed tests verifying coverage area 
Number and percentage of computer‐based speed tests verifying coverage area 
 
Using the location of speed tests submitted through the FCC or the MBBMI speed test tools, the 
team sought to compare the location of broadband availability submitted by BSPs and the 
location of actual broadband service reported by speed test takers.  
 
For this verification test on wireline provider census block submissions, the number of census 
blocks served (as determined by the location of a speed test) but were not reported by provider 
were calculated.  That number is then divided by the total number of blocks submitted by the 
provider, reported as an error percentage. 
 
For the state of Maryland, the maximum number of census blocks shown to be served by speed 
test data but not reported by a BSP is 492 ( for Comcast Cable Communications, LLC , 1% of 
their total reported blocks).  The minimum percentage of served census blocks confirmed by 
speed test was 0% (8 providers).  The maximum percentage was 100% (Cogent and Tata 
Communications (America) Inc.).   
 
For this verification test on wireless provider coverage area submissions, the following statistics 
are reported: 

1) Confirmation of coverage area served 
• The number/percentage of computer‐based speed tests that fall within the BSP’s 

reported coverage area(s). 
• The number/percentage of mobile speed tests that fall within the BSP’s reported 

coverage area(s). 
2) Area served, not reported by provider 

• The number/percentage of computer‐based speed tests that fall outside the BSP’s 
reported coverage area(s). 

• The number/percentage of mobile speed tests that fall outside the BSP’s reported 
coverage area(s). 

 
For the wireless providers in the state of Maryland, one‐half (6 of 14) had computer‐based 
speed tests submitted by users.  The maximum number of computer‐based speed tests shown 
to fall within the reported coverage area of a BSP is 67 (for Hughes Communications, Inc., 100% 
of their computer‐based speed tests).  Other BSPs that has 100% of their computer‐based 
speed tests fall within their reported coverage were ATTWireless and Wildblue 
Communications, Inc..  The minimum percentage of computer‐based speed tests shown to fall 
within the reported coverage area of a BSP was 95.2% (Clearwire, 80 tests fell inside).   On 
average, 98.5% of computer‐based speed tests fell within the BSP’s reported coverage area.   
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Regarding the number of mobile speed tests that fall within the reported coverage area of a 
BSP, 50% (7 of 14) of the wireless BSPs had tests and the maximum number came from Verizon 
Wireless customers, with 9,327 tests within their reported coverage area.  Two wireless BSPs 
had 100% of their mobile speed tests fall within their reported coverage area:  Hughes, and 
Wildblue Communications, Inc..  Cleaerwire was the BSP with the smallest percentage of tests 
falling within their reported coverage area – 81.5%.  On average, 96.4% of mobile speed tests 
fell within the BSPs reported coverage areas. 
 
 
Census blocks/coverage area reported to project, but no census tract reported to FCC 
Census tracts reported to FCC, but no census blocks/coverage areas reported to project 
 
Another source of data validation was the FCC’s Form 477 data as of December 2009.  This 
dataset is collected semi‐annually by the FCC from BSPs, both facility‐based and not facility‐
based.  The BSPs report the number of residential and business subscribers to their broadband 
service per census tract.  For comparison, the average census tract in Maryland contains 67 
census blocks.  While the Form 477 data is much coarser than the SBDD‐reported data, it still 
should align spatially. 
 
Therefore, as another verification check, we test the number of census blocks that are reported 
by wireline BSPs that have no corresponding reported census tract in the BSP’s Form 477 data.  
Similarly, we test the number of tracts from the wireline BSP’s Form 477 data that do not have 
corresponded census blocks reported in this initiative. 
 
For the state of Maryland, the maximum number of census blocks that were reported as served 
but had no corresponding Form 477 census tract was 5,785 from Covad Communications 
Company.  On average, 451 census blocks (from 25 providers) had no corresponding census 
tract.  The maximum number of census tracts that had no corresponded reported census blocks 
was 192 from DSLnet Communications, LLC.  On average, 24 census tracts (from 25 providers) 
had no corresponding census blocks. 
 
 
For wireless BSPs, we tested the number of census tracts that either intersect or do not 
intersect each reported coverage area.  Because it is not possible to tell what portion of the 
Form 477 reported census tract may receive the wireless service, a simple intersect between 
served tracts and coverage areas is the only test available from these data sources.  For those 
wireless BSPs reporting to the FCC on Form 477 (8 of 14), 100% of the served census tracts 
intersected the reported coverage areas. 
 
 
Census blocks/coverage areas versus unserved area locations reported 
Total number of unserved area locations reported per provider  
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At the MBBMI website (www.mdbroadbandmap.org) and at the FCC website 
(www.broadband.gov), residents and business owners have the opportunity to report unserved 
areas.  These are locations, specifically addresses, at which the potential broadband customer 
cannot access broadband service.  Those unserved area reports are taken in by the MBBMI 
team, geocoded according to their address, and are examined for their spatial coincidence with 
BSP availability coverages. For each wireline provider, the number of census blocks reported as 
served that contain a unserved area report are calculated, as well as the total number of 
unserved area reports within a BSPs availability area. For each wireless BSP, the 
number/percentage of unserved area reports from both the FCC and the MBBMI that fall within 
and outside the reported coverage area are calculated. 
 
It is important to note that, at the present time, these unserved area reports are unverified.  It 
is possible that broadband service may be available either at the address (but the person 
reporting the unserved area location was unaware of service availability), or not available at the 
address because of some unique configuration problem at that address specifically.  It is also 
entirely possible that portions of a census block may be served but other portions may not. 
 
For the state of Maryland, the maximum number of a wireline BSP’s available census blocks 
that contain an unserved area location report is 63 (Verizon Communications, Inc.).  The 
minimum number is 0 (17 providers).  The maximum number of unserved area location reports 
in a wireline BSP’s available area is 76 (Verizon Communications, Inc.) There were 5 wireline 
providers to have only 1 unserved area location report in their areas. 
 
For the state of Maryland, the maximum percentage of unserved area locations reported from 
the FCC within a wireless BSP’s reported coverage area is 98.7% (both are satellite providers). 
The maximum percentage of unserved area locations reported from the FCC within a non‐
satellite wireless BSP’s reported coverage area is AT&T Wireless at 98.5% (230 of 240).  The 
average percentage of unserved area locations (reported from the FCC) that fall within a 
wireless BSP’s reported coverage area is 48% (116 of 202).  For those unserved area locations 
reported by the MBBMI, the maximum percentage of unserved area locations within a wireless 
BSP’s reported coverage area is 100% (147 of 147), true for each of the satellite wireless 
providers (HughesNet, StarBand, and Wildblue).  The maximum percentage of unserved area 
locations reported from the MBBMI within a non‐satellite wireless BSP’s reported coverage 
area is AT&T Wireless  at 96.6% (142 of 147).  The average percentage of unserved area 
locations (reported from the MBBMI) that fall within a wireless BSP’s reported coverage area is 
44.6% (66 of 147).   
 
 
 
 
 
Web search verification 
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Some broadband service providers publish service availability query tools on their corporate 
websites.  The MBBMI team took the opportunity to test the broadband availability areas 
submitted by the BSPs against the BSP’s web‐based service availability tools.  A systematic 
sampling grid was created for the entire state of Maryland.  A sample point was placed every 
4000 meters, then the nearest property address (within at most 1000 m) was chosen.  This 
yielded a grid of 1,472 sample points. In Baltimore City, an additional 24 sample points were 
added (approximately every 2000 meters) in order to have reasonable sampling density within 
the small area of the City.  This brought the total sample points to 1,496. 
 
For each BSP that had a web‐based service availability query tool (11 providers), the sample 
point grid addresses were used to verify the availability of service (or lack thereof) compared to 
both the reported service area, the area just outside the stated service area, and a random 
selection of grid points across the state.  The following combinations of reported service vs. 
queried service were tallied: 
 

1) A census block/coverage area was reported as served and the sample was returned 
as served 

2) A census block/coverage area was reported as served but the sample was returned 
as unserved 

3) A census block was not reported as served (or the location was outside the wireless 
coverage area) and the sample was returned as not served 

4) A census block was not reported as served (or the location was outside the wireless 
coverage area) but the sample was returned as served 

 
The total number of sample points in categories 2 and 4 are reported as error (of commission 
and of omission, respectively). 
 
For Comcast and Verizon, all 1,496 sample points were used as those two BSPs offer broadband 
service in all areas of the state. 
 
For the eleven wireline BSPs in the state of Maryland that have a Internet‐based availability 
tool, the maximum omission error rate was 24.1% reported by Armstrong Cable  The minimum 
omission error rate was 0% and was reported by Charter Communications and Starpower.  The 
average omission error rate was 11.3%.  The maximum commission error rate was 35.7% 
reported by Verizon Maryland.  The minimum commission error rate was 0% and was reported 
by 4 providers.  The average commission error rate was 7%.  The maximum total error rate was 
36% reported by Verizon Maryland  The minimum total error rate was 0% reported by 4 
providers.  The average total error rate was 15.1%. 
 
 
Census blocks that are outside provider’s own Cable Franchise Boundary 
Census blocks that are within a different provider’s Cable Franchise Boundary 
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For those BSPs that provide broadband service via cable modem technology, they are 
(supposedly) constrained to a service area defined by a local (or several local) cable franchise 
boundar(ies).  The MBBMI team obtained the spatial extent of the cable franchise boundaries 
within the state of Maryland from the Maryland Broadband Cooperative.  With these cable 
franchise boundary areas, a test can be performed to count both the number of served census 
blocks that fall outside of a provider’s designated cable franchise boundary area and the 
number of served census blocks the fall within a different provider’s cable franchise boundary.  
The first statistic may or may not be an error.  If a cable provider is surrounded by an area that 
has no competing franchises, some expansion beyond the existing franchise boundary is 
expected.  The second test may also not be an error in that franchise boundaries usually refer 
to cable television service specifically.  A provider may be allowed to expand non‐television 
services like broadband into competing areas.  It is also possible that the cable franchise 
boundaries are not up‐to‐date. 
 
In Maryland, we can test if any of seven providers report blocks outside of their own boundary.  
The maximum number of blocks that fall outside the cable franchise boundaries is 5,730 
reported by Comcast Cable Communications, LLC.  This represents 11.9% of their total number 
of served blocks.  The minimum number of “outside” blocks is 8 reported by Easton Utilities, or 
1.5% .  The average number of blocks that fall outside the cable franchise boundary is 1,471. 
 
Thirteen broadband providers that deliver service via cable modem have the potential of 
serving blocks contained within someone else’s boundary.  The maximum number of blocks 
that fall into someone else’s cable franchise boundaries is 2,773 reported by Broadstripe, LLC.  
This represents 94% of their total number of served blocks.  The minimum number of blocks to 
fall in someone else’s boundary is 1 reported by Hotwire Communications, but that represents 
100% of their coverage area.  The average number of blocks that fall outside the cable franchise 
boundary is 643 
 
 
 
Census blocks that are outside DSL boundary 
 
For those BSPs that provide broadband service via digital subscriber line (DSL) technology, the 
general area of DSL availability is tracked by several industry groups.  The MBBMI team 
obtained the spatial extent of the DSL availability areas within the state of Maryland from the 
Maryland Broadband Cooperative.  With these DSL availability areas, a test can be performed to 
count the number of census blocks that fall outside of the DSL availability area.  This may 
indicate an error, although it is possible that the DSL availability boundaries are not up‐to‐date 
or correct.  There was no metadata concerning currentness or quality included in the DSL 
availability areas.   
 
In Maryland, 12 providers are eligible for this test.  The maximum number of blocks that fall 
outside the DSL availability areas is 20,257 reported by Verizon Maryland Inc.  This represents 



Maryland Broadband Mapping Initiative:  Verification/Validation Report 

September 30, 2011 
 

Salisbury University    www.mdbroadbandmap.org  
17 

 
   

26% of their total number of served blocks.  The minimum number of “outside” blocks is 0 
reported by Tata.  The average number of blocks that fall outside the DSL availability area is 
3,226. 
 
 
Wireless broadband presence and speed systematic field sampling 
 
For the wireless coverage areas, many of the other data checks and tests are not appropriate to 
use.  In the summer of 2011, the MBBMI embarked on the second phase of a wireless coverage 
area verification project.  For each of the 1,496 systematic sampling grid points (increased 
slightly from 2010 to sample more intensively in Baltimore City), a research team visited the 
sample address with nine phones, two each for Sprint, Verizon Wireless, AT&T, and T‐Mobile, 
measuring both 3G and 4G network presence and speed, as well as one phone to test the 
Cricket network.  Using the FCC/Ookla speed test app, the broadband availability, downstream 
and upstream speeds, and the GPS location of the test were collected.   
 
After the field sampling was completed, 1,486 grid points with valid samples were used to 
conduct this test; 10 of the original sample locations were not collected due to a 
communication error with the field team.  Of those, the following combinations of reported 
service vs. sampled service were tallied: 
 

1) A sample point was in an area reported by the provider as served and the sample 
was collected as served 

2) A sample point was in an area reported by the provider as served but the sample 
was collected as unserved 

3) A sample point was in an area reported by the provider as not served and the 
sample was collected as not served 

4) A sample point was in an area reported by the provider as not served but the sample 
was collected as served 

 
The total number of sample points in categories 2 and 4 are reported as error (of commission 
and of omission, respectively).  Verifying the 4G network presence proved more challenging.  
Because the 4G phones will conduct a mobile broadband test on a 3G network if it all that is 
available, simply noting the presence of a speed test from a 4G phone is not enough to verify 
that the phone was actually accessing the 4G network.  Therefore, in order to isolate those 
speed tests that were truly taken on the 4G network, we selected those tests that had an 
average download speed of 2000 kbps or greater.  This number was chosen by examining the 
typical speed results in the known 4G areas of the state, plus consulting published speed 
comparison studies on numerous popular technology websites. 
 
For the 3G coverage areas in the state of Maryland, T‐Mobile had the maximum number of 
samples that were reported as omitted (sampled as served but not within the coverage area) 
was 849 and the error rate was 63.6% (849 of 1,334 samples that had registered service).  AT&T 
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Wireless had the minimum number of samples that were reported as omitted (13 or 1.0%).  The 
average omission error rate was 26.3%.  Sprint‐Nextel had the maximum number of samples 
that were reported as committed (sampled as not served but within the coverage area) at 263.  
The commission error rate was 26.9% (977 were tested).  Verizon Wireless had the minimum 
number of samples that were reported as committed (64 or 5.2%).  The average commission 
error rate was 15.5%.     
 
For the 4G coverage areas in the state of Maryland, Verizon Wireless had the maximum number 
of samples that were reported as omitted (sampled as served but not within the coverage area) 
was 60 and the error rate was 21.9% (60 of 274 samples that had registered service).  AT&T 
Wireless had the minimum number of samples that were reported as omitted (0).  The average 
omission error rate was 14.0%.  AT&T Wireless had the maximum number of samples that were 
reported as committed (sampled as not served but within the coverage area) at 1,367.  The 
commission error rate was 92% (1,453 were tested).  Verizon Wireless had the minimum 
number of samples that were reported as committed (69 or 24.4%).  The average commission 
error rate was 70.2%. This average rate is so high because most of the tests we took within 4G 
areas did not return 4G speeds. 
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Individual Provider Data Summaries 
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Allied Telecom Group, LLC 
DBA: Allied Telecom Group, LLC 
 
Data Characteristics 
 
Date of Original Submission:              3/7/2011 
Date of Update Submission:              8/26/2011 
Currency of Data:                6/30/2011 
FRN:                     0002154367 
Type of data submitted:               Address Table 
Census Block Count:                             82     
Total Matched Address Points Count:          164 
Unmatched Address Points:              1 
Number of Technology of Transmission Types:        4 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           Complete 
Provided Max Typical Upload Speed:           Complete 
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
Address Table Process: 

• Geocode address table to ESRI US Streets address locator 
o Number matched: 164 
o Number unmatched: 1 

• Spatially join matched address points to 2010 census blocks 
• Separate addresses by technology of transmission 

Census Block Process: 
• Join the spatial join result to the 2010 census blocks based on the GEOID10 field for 

each technology 
o Export results for each technology 
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
Speed Domains: 

• Maximum Advertized and Typical Speeds changed 
o Technology of Transmission 30 – 44 records changed to speed tier 8 to fit 

domain 
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Data Verification 
 
Maximum down/upload speeds reported by provider: 
Census Blocks 
Max Download Category  Count  % of Blocks Max Upload Category Count  % of Blocks

10  44  42% 10  44  42%
11  28  27% 11  28  27%
4  5  5% 4  5  5%
7  28  27% 5  28  27%

 
Typical down/upload speeds reported by provider:  
Census Blocks 
Typical Download Category  Count  % of Blocks Typical Upload Category  Count  % of Blocks

10  44  42% 10  44  42%
11  28  27% 11  28  27%
4  5  5% 4  5  5%
7  28  27% 5  28  27%

 
Typical down/upload speed from 2010 computer based speed test:  
 
Speed Test Download Tier  Count  % of Tests Speed Test Upload Tier Count  % of Tests

4  1  100% 6  1  100%
 
Speed tests match reported typical speeds or are within 1 speed tier:   No 
 
 Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted):  0/82 (0%) 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: N/A 
Number of tracts reported to FCC, but no census blocks reported to project: N/A 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 1 
Total number of dead zones reported per provider via broadband.maryland.gov: 1 
 
Number of census blocks with dead zones reported via mdbroadbandmap.org: 0 
Total number of dead zones reported per provider via mdbroadbandmap.org: 0 
 
Web Search Verification: N/A 
 
Census blocks that are outside DSL boundary:  14/82 (17%) 
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Antietam Cable Television, Inc. 
DBA Name: Antietam Cable Television, Inc 
 
Data Characteristics 
 
Date of Original Submission:              7/29/2010 
Date of Update Submission:              2/21/2011   
Currency of Data:                12/31/2010 
FRN:                     0002154367 
Type of data submitted:               Addresses 
Census Block Count:                             2424     
Total Matched Address Points Count:          21847 
Unmatched Address Points:              37 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           No  
Provided Max Typical Upload Speed:           No  
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Address Table Process: 

• Geocode address table to ESRI US Streets address locator 
o Number matched: 21021 
o Number unmatched: 863 

• Unmatched address are geocoded to Maryland Property View address locator 
o Number matched: 548 
o Number unmatched: 315 

• Unmatched addresses are geocoded to Maryland centerline address locator 
o Number matched:  278 
o Number unmatched:  37 

• Merge matched addresses 
• Spatially join address points to 2010 census blocks 
• Select by location the address points that are completely within a greater than two 

square mile census block 
o Export as address points to be loaded into the NTIA data model 

 Result: BB_Service_Address 
o Switch the selection and export as points to create census blocks 
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Census Block Process: 

• Join the switched selection (BB_Service_Address) address points to the 2010 census 
blocks based on the GEOID10 field  

o Export results  
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census Blocks 
Max Download Category  Count  % of Blocks Max Upload Category Count  % of Blocks

7  2424  100% 4  2424  100%
 
Typical down/upload speeds reported by provider:  N/A 
 
Typical down/upload speed from 2010 computer based speed test:  
Speed Test Download Tier  Count  % of Tests Speed Test Upload Tier Count  % of Tests

0  1  1% 1  1  1%
3  3  2% 2  34  20%
4  33  20% 3  122  73%
5  119  71% 4  8  5%
6  4  2% 6  2  1%
7  7  4%

 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted): 2/2424 (<1%) 
 
Form 477Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 0 
Number of tracts reported to FCC, but no census blocks reported to project: 0 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 1 
Total number of dead zones reported per provider via broadband.maryland.gov: 1 
 
Number of census blocks with dead zones reported via mdbroadbandmap.org: 1 
Total number of dead zones reported per provider via mdbroadbandmap.org: 1 
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Web Search Verification: 41/2424 (2%) of census blocks were confirmed using online search 
feature of given provider. 
Antietam WebSearch Verification Table Count Percentage 
Total # of sample points 1496  
Number of sample points with results  123 8% 
Result is yes and census block is in served area  41 33% 
Result is yes but not in a census block reported as served    21 17% 
Result is no and census block is in served area 5 4% 
Result is no and census block not served area 56 46% 
  
Census blocks that are outside providers own Cable Franchise Boundary:  743/2424 (31%) 
 
Census blocks that fall within another provider’s Cable Franchise Boundary:  58/2424 (2%) 
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Armstrong Holdings, Inc. 
DBA Name: Armstrong Utilities, Inc. 
 
Data Characteristics 
Date of Original Submission:              3/31/2010 
Date of Update Submission:              8/15/2011 
Currency of Data:                6/30/2011 
FRN:                     0003765617 
Type of data submitted:    Census Block Table &       

     Road Segments 
Census Block Count:                             2592     
Total Matched Address Points Count:          N/A 
Unmatched Address Points:              N/A 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           No  
Provided Max Typical Upload Speed:           No  
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  Yes 
 
Data Processing 
Census Block Process: 

• Join the provided census block table to the 2010 census blocks based on the GEOID10 
field  

o Export results  
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
 
Data Verification 
Maximum down/upload speeds reported by provider:  
Census Blocks 
Max Download Category  Count  % of Blocks Max Upload Category  Count  % of Blocks

7  2592 100% 5  2592  100%

Road Segments 

Max Download Category  Count 
% of Road 
Segments Max Upload Category  Count 

% of Road 
Segments

7  198  100% 5 198  100%
 
Typical down/upload speeds reported by provider: N/A 
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Typical down/upload speed from 2010 computer based speed test:  
Speed Test Download Tier  Count  % of Tests Speed Test Upload Tier Count  % of Tests

0  8  10% 1  2  3%
3  1  1% 2  8  10%
4  1  1% 3  10  13%
5  15  19% 4  57  73%
6  42  54% 6  1  1%
7  11  14%

 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted): 0/2592 (0%) 
 
Form 477Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 92 
Number of tracts reported to FCC, but no census blocks reported to project: 1 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 6 
Total number of dead zones reported per provider via broadband.maryland.gov: 6 
 
Number or census blocks with dead zones reported via mdbroadbandmap.org: 5 
Total number of dead zones reported per provider via mdbroadbandmap.org: 6 
 
Web Search Verification: 46/2592 (2%) of census blocks were confirmed using online search 
feature of given provider 
Armstrong WebSearch Verification Table Count Percentage 
Total # of sample points 1496  
Number of sample points with results  166 11% 
Result is yes and census block is in served area  46 28% 
Result is yes but not in a census block reported as served    40 24% 
Result is no and census block is in served area 0 0% 
Result is no and census block not served area 80 48% 
 
Census blocks that are outside providers own Cable Franchise Boundary:  2132/2592 (82%) 
  
Census blocks that fall within another provider’s Cable Franchise Boundary:  742/2592 (29%) 
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AT&T Mobility LLC  
DBA Name: AT&T Mobility LLC  
 
Data Characteristics 
 
Date of Original Submission:              3/9/2010 
Date of Update Submission:              7/29/2011 
Currency of Data:                6/30/2011 
FRN:                     0004979233 
Type of data submitted:               Coverage Area 
Census Block Count:                             N/A     
Total Matched Address Points Count:          N/A 
Unmatched Address Points:              N/A 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           No  
Provided Max Typical Upload Speed:           No  
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
Coverage Area Process: 

• Repair Geometry on delivered coverage area 
• Remove coverage areas less than 0.125 square miles 
• Remove coverage area “holes” less than 0.125 square miles 
• Load coverage area into the NTIA data model 

o Result: BB_Service_Wireless 
 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Coverage Area 
Max Download Category  Count  % of Area Max Upload Category Count  % of Area

4  1  100% 3 1  100%
 
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 mobile speed test:  
Speed Test Download Tier  Count  % of Tests Speed Test Upload Tier  Count  % of Tests

0  425  37% 1  667  58%
3  331  29% 2  307  27%
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4  331  29% 3  135  12%
5  59  5% 4  31  3%
6  3  0% 5  7  1%
7  6  1% 6  1  0%

7  4  0%
8  3  0%

 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
#/% of mobile speed tests verifying coverage area:  
Number of mobile speed tests reported inside coverage area: 1150/1155 (99.5%) 
Number of mobile speed tests reported outside coverage area: 5/1155 (0.5%) 
 
Typical down/upload speed from 2010 computer based speed test: 
Speed Test Download Tier  Count  % of Tests Speed Test Upload Tier Count  % of Tests

0  7  70% 1  5  50%
3  2  20% 2  2  20%
4  1  10% 3  3  30%

 
Speed tests match reported typical download speeds or are within 1 speed tier:   N/A 
 
#/% of computer based speed tests verifying coverage area:  
Number of mobile speed tests reported inside coverage area: 10/10 (100%) 
Number of mobile speed tests reported outside coverage area: 0/10 (0%) 
 
Form 477Verification: 
#/% of tracts reported as served to FCC that overlaps with coverage area: 342/342 (100.0%) 
#/% of tracts reported as served to FCC but do not intersect coverage area: 0/342 (0%) 
 
Dead zones: 
Number of dead zones reported within coverage area via broadband.maryland.gov:  
230/240 (95.8%) 
Number of dead zones reported within coverage area via mdbroadbandmap.org:  
142/147 (96.6%) 
 
Web Search Verification: N/A  
 
Wireless Verification:  
ATT Wireless Verification Table ‐ 3G  Count  Percentage
Total # of sample points 1486    
Number of sample points within coverage area 1453    
Total number of sample points with results 1293    
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Verified served AND within reported coverage area   (yes,yes) 1280    
Verified served AND found outside reported coverage area  (yes,no) 13  1.0%
Verified unserved AND found within reported coverage area   (no,yes) 173  11.6%
Verified unserved AND found outside reported coverage area  (no,no) 20    
Total error  186  12.5%

ATT Wireless Verification Table ‐ 4G  Count  Percentage
Total # of sample points 1486    
Number of sample points with expected 4G results 1453    
Total number of sample points with 4G results 86    
Verified 4G AND within reported coverage area   (yes,yes) 86    
Verified 4G AND found outside reported coverage area  (yes,no) 0  0.0%
Verified not 4G AND found within reported coverage area   (no,yes) 1367  92.0%
Verified not 4G AND found outside reported coverage area  (no,no) 33    
Total error  1367  94.1%
*4G service defined as average down speed of > 2000 bps
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Atlantech Online, Inc. 
DBA: Atlantech Online, Inc. 
 
Data Characteristics 
 
Date of Original Submission:              3/7/2011 
Date of Update Submission:              3/7/2011 
Currency of Data:                12/31/2010 
FRN:                     0018854935 
Type of data submitted:               Address Table 
Census Block Count:                             22     
Total Matched Address Points Count:          39 
Unmatched Address Points:              0 
Number of Technology of Transmission Types:        2 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           No 
Provided Max Typical Upload Speed:           No 
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Census Block Process: 

• Geocode address table to ESRI US Streets address locator 
o Number matched:  39 
o Number unmatched:  39 

• Spatially join matched address points to 2010 census blocks 
• Separate addresses by technology of transmission 

Census Block Process: 
• Join the spatial join result to the 2010 census blocks based on the GEOID10 field for 

each technology 
o Export results for each technology 
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
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Data Verification 
 
Maximum down/upload speeds reported by provider: 
Census Blocks 
Max Download Category  Count  % of Blocks Max Upload Category Count  % of Blocks

11  2  9% 11 2  9%
7  20  91% 7 20  91%

  
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 computer based speed test:  
Speed Test Download Tier  Count  % of Tests Speed Test Upload Tier Count  % of Tests

3  6  14% 2  1  2%
4  1  2% 3  10  23%
5  20  47% 4  12  28%
6  7  16% 5  10  23%
7  3  7% 6  2  5%
8  3  7% 7  4  9%
9  3  7% 8  2  5%

9  2  5%
 
Speed tests match reported typical speeds or are within 1 speed tier:   N/A 
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted): 9/22 (41%) 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 0 
Number of tracts reported to FCC, but no census blocks reported to project: 84 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 1 
Total number of dead zones reported per provider via broadband.maryland.gov: 2 
 
Number of census blocks with dead zones reported via mdbroadbandmap.org: 0 
Total number of dead zones reported per provider via mdbroadbandmap.org: 0 
 
Web Search Verification: N/A 
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Atlantic Broadband (Penn), LLC 
DBA Name: Atlantic BroadBand 
 
Data Characteristics 
Date of Original Submission:              3/26/2011 
Date of Update Submission:              9/16/2011 
Currency of Data:                6/30/2011 
FRN:                     0009596883 
Type of data submitted:               Address Table 
Census Block Count:                             3870     
Total Matched Address Points Count:          63765 
Unmatched Address Points:              4183 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           Complete  
Provided Max Typical Upload Speed:           Complete  
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
Address Table Process: 

• Geocode address table to ESRI US Streets address locator 
o Number matched: 59443 
o Number unmatched: 8505 

• Unmatched address are geocoded to Maryland Property View address locator 
o Number matched: 3282 
o Number unmatched: 5223 

• Unmatched addresses are geocoded to Maryland center line address locator 
o Number matched:  1040 
o Number unmatched:  4183 

• Merge matched addresses 
• Spatially join address points to 2010 census blocks 
• Select by location the address points that are completely within a greater than two 

square mile census block 
o Export as address points to be loaded into the NTIA data model 

 Result: BB_Service_Address 
o Switch the selection and export as points to create census blocks 

Census Block Process: 
• Join the switched selection (BB_Service_Address) address points to the 2010 census 

blocks based on the GEOID10 field  
o Export results Load exported results into the NTIA data model  
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 Result: BB_Service_CensusBlock 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census Blocks 
Max Download Category  Count  % of Blocks Max Upload Category Count  % of Blocks

7  3870  100% 3  3611  93%
4  259  7%

 
Typical down/upload speeds reported by provider:  
Census Blocks 
Typical Download Category  Count  % of Blocks Typical Upload Category  Count  % of Blocks

7  3870  100% 3  3870  100%
 
 
Typical down/upload speed from 2010 computer based speed test:  
Speed Test Download Tier  Count  % of Tests Speed Test Upload Tier Count  % of Tests

0  31  15% 1  1  0%
3  8  4% 2  192  90%
4  17  8% 3  17  8%
5  104  49% 4  3  1%
6  39  18%
7  13  6%
9  1  0%

 
Speed tests match reported typical download speeds or are within 1 speed tier:  No 
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted): 10/3870  (< 1%) 
 
Form 477Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 128 
Number of tracts reported to FCC, but no census blocks reported to project: 5 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 2 
Total number of dead zones reported per provider via broadband.maryland.gov: 2 
 
Number or census blocks with dead zones reported via mdbroadbandmap.org: 6 
Total number of dead zones reported per provider via mdbroadbandmap.org: 6 
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Web Search Verification: 87/3070 (3%) of census blocks were confirmed using online search 
feature of given provider 
 
Atlantic  Broadband WebSearch Verification Table Count Percentage 
Total # of sample points 1496  
Number of sample points with results  1496 100% 
Result is yes and census block is in served area  87 6% 
Result is yes but not in a census block reported as served    116 8% 
Result is no and census block is in served area 2 0% 
Result is no and census block not served area 1289 86% 
 
Census blocks that are outside providers own Cable Franchise Boundary: 1255/3070 (41%) 
  
Census blocks that fall within another provider’s Cable Franchise Boundary: 266/3070 (9%) 
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Bay Country Communications, Inc. 
DBA Name: Bay Country Communications, Inc. 
 
Data Characteristics 
 
Date of Original Submission:              8/9/2010 
Date of Update Submission:              9/12/2011 
Currency of Data:                6/30/2011 
FRN:                     0020136552 
Type of data submitted:               Census Block Table 
Census Block Count:                                 1841 
Total Matched Address Points Count:          N/A 
Unmatched Address Points:              N/A 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           Complete 
Provided Max Typical Upload Speed:           Complete 
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Census Block Process: 

• Join the provided census block table to the 2010 census blocks based on the 2000 block 
name field  

o Export results  
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census Blocks 
Max Download Category  Count  % of Blocks Max Upload Category  Count  % of Blocks

7  1841 100% 7  1841  100%

 
 
Typical down/upload speeds reported by provider: 
Census Blocks 
Typical Download Category  Count  % of Blocks Typical Upload Category  Count  % of Blocks
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4  1841  100% 2  1841  100%
Typical down/upload speed from 2010 computer based speed test:  
Speed Test Download Tier  Count  % of Tests Speed Test Upload Tier  Count  % of Tests

3  1  50% 2  1  50%
4  1  50% 3  1  50%

 
Speed tests match reported typical download speeds or are within 1 speed tier: Yes 
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted): 0/1841 (0%) 
 
Form 477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: N/A 
Number of tracts reported to FCC, but no census blocks reported to project: N/A 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 1 
Total number of dead zones reported per provider via broadband.maryland.gov: 2 
 
Number of census blocks with dead zones reported via mdbroadbandmap.org: 1 
Total number of dead zones reported per provider via mdbroadbandmap.org: 1 
 
Web Search Verification: N/A 
 
Census blocks that are outside providers own Cable Franchise Boundary:  N/A 

 
Census blocks that fall within another provider’s Cable Franchise Boundary:  1439/1841 (78%) 
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Believe Wireless, LLC. 
DBA: Believe Wireless Broadband  
 
Data Characteristics 
 
Date of Original Submission:              3/1/2011 
Date of Update Submission:              9/8/2011 
Currency of Data:                6/30/2011 
FRN:                     9999 
Type of data submitted:               Coverage Area 
Census Block Count:                             N/A   
Total Matched Address Points Count:          N/A 
Unmatched Address Points:              N/A 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           Complete 
Provided Max Typical Upload Speed:           Complete 
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Coverage Area Process: 

• Spectrum not provided 
o Spectrum selected by comparing similar providers and choosing the most likely 

option 
• Use raster analysis to extract coverage area from map 
• Repair Geometry on coverage area 
• Remove coverage areas less than 0.125 square miles 
• Remove coverage area “holes” less than 0.125 square miles 
• Simplify Polygon of coverage area 
• Load coverage area into the NTIA data model 

o Result: BB_Service_Wireless 
 
Speed Domains: 

• Maximum Advertized Speeds changed 
o Reported speeds exceed domain – changed from tier 11 to 6 
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Data Verification 
 
Maximum down/upload speeds reported by provider:  
Coverage Area 
Max Download Category  Count  % of Area Max Upload Category Count  % of Area

6  1  100% 6  1  100%
 
Typical down/upload speeds reported by provider: 
Coverage Area 
Typical Download Category  Count  % of Area Typical Upload Category  Count  % of Area

6  1  100% 6  1  100%
  
Typical down/upload speed from 2010 mobile speed test: N/A 
 
Speed tests match reported typical download speeds or are within 1 speed tier: N/A 
 
#/% of mobile speed tests verifying coverage area:  
Number of mobile speed tests reported inside coverage area: N/A 
Number of mobile speed tests reported outside coverage area: N/A 
 
Form 477Verification: 
#/% of tracts reported as served to FCC that overlaps with coverage area: N/A 
#/% of tracts reported as served to FCC but do not intersect coverage area: N/A 
 
Dead zones: 
Number of dead zones reported within coverage area via broadband.maryland.gov:  
15/240 (6.2%) 
Number of dead zones reported within coverage area via mdbroadbandmap.org:  
6/147 (4%) 
 
Web Search Verification: N/A 
 
Wireless Verification: N/A 
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Bloosurf 
DBA: Bloosurf  
 
Data Characteristics 
 
Date of Original Submission:              2/28/2011 
Date of Update Submission:              9/8/2011 
Currency of Data:                6/30/2011 
FRN:                     0019496462 
Type of data submitted:               Coverage Area 
Census Block Count:                             N/A   
Total Matched Address Points Count:          N/A 
Unmatched Address Points:              N/A 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           No 
Provided Max Typical Upload Speed:           No 
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Coverage Area Process: 

• Digitize coverage area from map 
• Repair Geometry on coverage area 
• Remove coverage areas less than 0.125 square miles 
• Remove coverage area “holes” less than 0.125 square miles 
• Load coverage area into the NTIA data model 

o Result: BB_Service_Wireless 
 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Coverage Area 
Max Download Category  Count  % of Area Max Upload Category Count  % of Area

5  1  100% 3  1  100%
 
Typical down/upload speeds reported by provider: N/A 
  
Typical down/upload speed from 2010 mobile speed test: N/A 
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Speed tests match reported typical speeds or are within 1 speed tier:   N/A 
 
#/% of mobile speed tests verifying coverage area:  
Number of mobile speed tests reported inside coverage area: N/A 
Number of mobile speed tests reported outside coverage area: N/A 
 
Form 477Verification: 
#/% of tracts reported as served to FCC that overlaps with coverage area: N/A 
#/% of tracts reported as served to FCC but do not intersect coverage area: N/A 
 
Dead zones: 
Number of dead zones reported within coverage area via broadband.maryland.gov:  
5/240 (2%) 
Number of dead zones reported within coverage area via mdbroadbandmap.org: 
1/147 (0.7) 
 
Web Search Verification: N/A 
 
Wireless Verification: N/A 
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Broadstripe, LLC 
DBA Name: Broadstripe, LLC 
 
Data Characteristics 
 
Date of Original Submission:              4/14/2010 
Date of Update Submission:              9/9/2011 
Currency of Data:                6/30/2011 
FRN:                     0003773843 
Type of data submitted:               Address Table 
Census Block Count:                             2949     
Total Matched Address Points Count:          107378 
Unmatched Address Points:              100 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           No  
Provided Max Typical Upload Speed:           No  
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Address Table Process: 

• Geocode address table to ESRI US Streets address locator 
o Number matched: 103647 
o Number unmatched: 840 

• Unmatched address are geocoded to Maryland Property View address locator 
o Number matched: 636 
o Number unmatched: 204 

• Unmatched address are geocoded to Maryland street centerline address locator 
o Number matched: 636 
o Number unmatched: 204 

• Merge matched addresses 
• Spatially join address points to 2010 census blocks 
• Select by location the address points that are completely within a greater than two 

square mile census block 
o Export as address points to be loaded into the NTIA data model 

 Result: BB_Service_Address 
o Switch the selection and export as points to create census blocks 
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Census Block Process: 
• Join the switched selection (BB_Service_Address) address points to the 2010 census 

blocks based on the GEOID10 field  
o Export results Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
Data Modification: 

• Removed 2 addresses from data set – address out of provider area 
o Milford, MI 
o Cecil County, MD 

 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census Blocks 
Max Download Category  Count  % of Blocks Max Upload Category Count  % of Blocks

7  2949  100% 4 2949  100%
 
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 computer based speed test:  
Speed Test Download Tier  Count  % of Tests Speed Test Upload Tier Count  % of Tests

3  3  5% 1  3  5%
4  1  2% 2  4  7%
5  10  18% 3  5  9%
6  17  31% 4  43  78%
7  20  36%
8  1  2%
9  2  4%

10  1  2%
 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted): 0/2949 (0%) 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 8 
Number of tracts reported to FCC, but no census blocks reported to project: 0 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 1 
Total number of dead zones reported per provider via broadband.maryland.gov: 1 
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Number of census blocks with dead zones reported via mdbroadbandmap.org: 0 
Total number of dead zones reported per provider via mdbroadbandmap.org: 0 
 
Web Search Verification:  17/2949 (1%) of census blocks were confirmed using online search 
feature of given provider 
Broadstripe WebSearch Verification Table Count Percentage 
Total # of sample points 1496  
Number of sample points with results  85 6% 
Result is yes and census block is in served area  17 20% 
Result is yes but not in a census block reported as served    15 18% 
Result is no and census block is in served area 0 0% 
Result is no and census block not served area 53 62% 
 
Census blocks that are outside providers own Cable Franchise Boundary: 1255/2949 (43%) 
  
Census blocks that fall within another provider’s Cable Franchise Boundary: 266/2949 (9%) 
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Broadview Networks Holdings, Inc. 
DBA Name: Broadview Networks Holdings, Inc. 
 
Data Characteristics 
 
Date of Original Submission:              2/24/2010 
Date of Update Submission:              9/9/2011 
Currency of Data:                6/30/2011 
FRN:                     0010296853 
Type of data submitted:               Address Table 
Census Block Count:                            600     
Total Matched Address Points Count:          797 
Unmatched Address Points:              10 
Number of Technology of Transmission Types:        3 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           No  
Provided Max Typical Upload Speed:           No  
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Address Table Process: 

• Geocode address table to ESRI US Streets address locator 
o Number matched: 786 
o Number unmatched: 23 

• Unmatched address are geocoded to Maryland Property View address locator 
o Number matched: 12 
o Number unmatched: 11 

• Unmatched address are geocoded to Maryland street centerline address locator 
o Number matched: 1 
o Number unmatched: 10 

• Merge matched addresses 
• Spatially join address points to 2010 census blocks 
• Separate and export the address points according to technology of transmission  

Census Block Process: 
• Join the address points to the 2010 census blocks based on the GEOID10 field  

o Export results for each technology of transmission 
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
Data Modification: 
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• Dropped 32 blocks reported by provider that do not meet broadband speeds 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census Blocks 
Max Download Category  Count  % of Blocks Max Upload Category Count  % of Blocks

3  20  3% 2 37  6%
4  496  81% 3 33  5%
5  84  14% 4 459  75%
6  11  2% 5 72  12%

6 10  2%
 
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 computer based speed test:  
Speed Test Download Tier  Count % of Tests Speed Test Upload Tier  Count % of Tests

3  1 100% 3  1 100%
 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted): 2/600 (<1%) 
 
Form 477Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 45 
Number of tracts reported to FCC, but no census blocks reported to project: 54 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 0 
Total number of dead zones reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with dead zones reported via mdbroadbandmap.org: 1 
Total number of dead zones reported per provider via mdbroadbandmap.org: 1 
 
Web Search Verification: N/A 
 
Census blocks that are outside DSL boundary:  111/600 (19%) 
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Brookwood Ventures LLC 
DBA Name: Brookwood Ventures LLC 
 
Data Characteristics 
 
Date of Original Submission:              3/12/2010 
Date of Update Submission:              9/9/2011 
Currency of Data:                6/30/2011 
FRN:                     0010296853 
Type of data submitted:               Coverage Area 
Census Block Count:                             N/A     
Total Matched Address Points Count:          N/A 
Unmatched Address Points:              N/A 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           No  
Provided Max Typical Upload Speed:           No  
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Coverage Area Process: 

• Repair Geometry on delivered coverage area 
• Perform Topology on coverage area 

o Rule: Coverage area should not overlap 
o Load coverage area into the NTIA data model 

 Result: BB_Service_Wireless 
 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Coverage Area 
Max Download Category  Count  % of Area Max Upload Category Count  % of Area

5  1  100% 3 1  100%
 
Typical down/upload speeds reported by provider:  N/A 
 
Typical down/upload speed from 2010 mobile speed test:  N/A 
 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
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#/% of mobile speed tests verifying coverage area: 
Number of mobile speed tests reported inside coverage area:  N/A 
Number of mobile speed tests reported outside coverage area:  N/A 
   
Form 477Verification: 
#/% of tracts reported as served to FCC that overlaps with coverage area:  2/2 
#/% of tracts reported as served to FCC but do not intersect coverage area:  0/2 
 
Dead zones: 
Number of dead zones reported within coverage area via broadband.maryland.gov:  
1/240 (0.4%) 
Number of dead zones reported within coverage area via mdbroadbandmap.org: 
0/147 (0%) 
 
Web Search Verification: N/A 
 
Wireless Verification: N/A 
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Cavalier Telephone Mid‐Atlantic, LLC 
DBA Name: Cavalier Telephone Mid‐Atlantic, LLC 
 
Data Characteristics 
 
Date of Original Submission:              3/10/2010 
Date of Update Submission:              9/2/2011 
Currency of Data:                6/30/2011 
FRN:                     0015799133 
Type of data submitted:               Census Block Table, 
                    Middle Mile 
Census Block Count:                             6858 Unique     
Total Matched Address Points Count:          10263 
Unmatched Address Points:              34 
Number of Technology of Transmission Types:        2 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           No 
Provided Max Typical Upload Speed:           No 
Provided Middle Mile:               Yes 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
Address Table Process: 

• Geocode address table to ESRI US Streets address locator 
o Number matched: 10212 
o Number unmatched: 85 

• Unmatched address are geocoded to Maryland Property View address locator 
o Number matched: 42 
o Number unmatched: 43 

• Unmatched addresses are geocoded to Maryland center line address locator 
o Number matched:  9 
o Number unmatched:  34 

• Merge matched addresses 
• Spatially join address points to 2010 census blocks 
• Separate and export the address points according to technology of transmission 

Census Block Process: 
• Join the address points to the 2010 census blocks based on the GEOID10 field 

o Export results for each technology of transmission 
o Load exported results into the NTIA data model 

 Result: BB_Service_CensusBlock 
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Data Modification: 

• 6342 blocks with technology of transmission 10 exceed domain speed 
o changed to MAXADUP speed tier 7 

 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Coverage Area 

Max Download Category  Count 
% of 
Area Max Upload Category Count 

% of 
Area 

8  7015  100% 8 7015  100%
 

 
Typical down/upload speeds reported by provider:  N/A  
 
Typical down/upload speed from 2010 computer based speed test:  

Speed Test Download Tier  Count 
% of 
Tests

Speed Test Upload 
Tier Count 

% of 
Tests 

0  36  23% 1 14  9%
3  23  14% 2 98  62%
4  31  19% 3 38  24%
5  37  23% 4 1  1%
6  22  14% 5 3  2%
7  7  4% 6 2  1%
8  2  1% 7 3  2%

10  1  1%
 
Speed tests match reported typical download speeds or are within 1 speed tier: N/A   
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted): 16/6856 (< 1%) 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 60 
Number of tracts reported to FCC, but no census blocks reported to project: 79 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 9 
Total number of dead zones reported per provider via broadband.maryland.gov: 13 
 
Number of census blocks with dead zones reported via mdbroadbandmap.org: 4 
Total number of dead zones reported per provider via mdbroadbandmap.org: 4 
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Web Search Verification: 20/6856 (1%) of census blocks were confirmed using online search 
feature of given provider 
 
Cavalier WebSearch Verification Table Count Percentage 
Total # of sample points 1496  
Number of sample points with results  432 29% 
Result is yes and census block is in served area  20 5% 
Result is yes but not in a census block reported as served    47 11% 
Result is no and census block is in served area 26 6% 
Result is no and census block not served area 339 78% 
 
Census blocks that are outside DSL boundary:  263/6856 (4%) 
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Cellco Partnership and its Affiliated Entities 
DBA Name: Verizon Wireless  
 
Data Characteristics 
 
Date of Original Submission:              3/8/2010 
Date of Update Submission:              7/29/2011 
Currency of Data:                6/30/2011 
FRN:                     0003290673 
Type of data submitted:               Coverage Area 
Census Block Count:                            N/A     
Total Matched Address Points Count:          N/A 
Unmatched Address Points:              N/A 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           Incomplete 
Provided Max Typical Upload Speed:           Incomplete 
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Coverage Area Process: 

• Repair Geometry on delivered coverage area 
• Remove coverage areas less than 0.125 square miles 
• Remove coverage area “holes” less than 0.125 square miles 
• Load coverage area into the NTIA data model 

o Result: BB_Service_Wireless 
 
Data Verification 
Maximum down/upload speeds reported by provider:  
Coverage Area 
Max Download Category  Count  % of Area Max Upload Category Count  % of Area

5  3  100% 4  3  100%
6  1  100% 5  1  100%

 
Typical down/upload speeds reported by provider: 
Coverage Area 
Typical Download Category  Count  % of Area Typical Upload Category Count  % of Area

NULL  1  100% NULL  1  100%
3  3  100% 2  3  100%
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Typical down/upload speed from 2010 mobile speed test:  
Speed Test Download Tier  Count  % of Tests Speed Test Upload Tier  Count  % of Tests

0  597  6% 1  353  4%
3  553  6% 2  1395  15%
4  1108  12% 3  460  5%
5  1180  13% 4  1321  14%
6  1599  17% 5  2768  30%
7  4127  44% 6  1218  13%
8  162  2% 7  1803  19%

10  1  0% 8  9  0%
 
Speed tests match reported typical download speeds or are within 1 speed tier:  No 
 
#/% of mobile speed tests verifying coverage area:  
Number of mobile speed tests reported inside coverage area: 9198/9327 (98.6%) 
Number of mobile speed tests reported outside coverage area: 129/9327 (1.4%) 
 
Typical down/upload speed from 2010 computer based speed test: 
Speed Test Download Tier  Count  % of Tests Speed Test Upload Tier Count  % of Tests

0  225  57% 1  120  31%
3  122  31% 2  270  69%
4  45  11% 3  2  1%
5  1  0% 4  1  0%

 
Speed tests match reported typical download speeds or are within 1 speed tier: No 
 
#/% of computer based speed tests verifying coverage area: 
Number of computer based speed tests reported inside coverage area: 385/393 (98%) 
Number of computer based speed tests reported outside coverage area: 8/393 (2%) 
 
Form 477 Verification: 
#/% of tracts reported as served to FCC that overlaps with coverage area: N/A 
#/% of tracts reported as served to FCC but do not intersect coverage area: N/A 
 
Dead zones: 
Number of dead zones reported within coverage area via broadband.maryland.gov:  
203/240 (84.6%) 
Number of dead zones reported within coverage area via mdbroadbandmap.org: 
134/147 (91%) 
 
Web Search Verification:  N/A 
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Wireless Verification: 
Verizon Wireless Verification Table ‐ 3G Count  Percentage
Total # of sample points 1486    
Number of sample points within coverage area 1225    
Total number of sample points with results 1334    
Verified served AND within reported coverage area   (yes,yes) 1161    
Verified served AND found outside reported coverage area  (yes,no) 173  13.0%
Verified unserved AND found within reported coverage area   (no,yes) 64  5.2%
Verified unserved AND found outside reported coverage area  (no,no) 88    
Total error  237  15.9%

*for three different spectrums the results were identical

Verizon Wireless Verification Table ‐ 4G Count  Percentage
Total # of sample points 1486    
Number of sample points with expected 4G results 283    
Total number of sample points with 4G results 274    
Verified 4G AND within reported coverage area   (yes,yes) 214    
Verified 4G AND found outside reported coverage area  (yes,no) 60  21.9%
Verified not 4G AND found within reported coverage area   (no,yes) 69  24.4%
Verified not 4G AND found outside reported coverage area  (no,no) 1143    
Total error  129  8.7%
*4G service defined as average down speed of > 2000 bps
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Charter Communications Inc 
DBA Name: Charter Communications Inc 
 
Data Characteristics 
 
Date of Original Submission:              3/31/2010 
Date of Update Submission:              7/21/2011 
Currency of Data:                7/31/2011 
FRN:                     0017179383 
Type of data submitted:               Census Block Table, 
                    Road Segments 
Census Block Count:                             421     
Total Matched Address Points Count:          N/A 
Unmatched Address Points:              N/A 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           Complete 
Provided Max Typical Upload Speed:           Complete 
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  Yes 
 
Data Processing 
 
Census Block Process: 

• Join the provided census block table to the 2010 census blocks based on the 2000 block 
name field  

o Export results  
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
Road Segment Process: 

• Road segments are 2009 geometry 
• Join road segments to TigerLine by TLID 

o Export results 
o Load exported results into the NTIA data model 

 Result: BB_Service_RoadSegment 
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Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census Blocks 
Max Download Category  Count  % of Blocks Max Upload Category  Count  % of Blocks

6  421  100% 3  421 100%
 
Road Segments 
Max Download Category  Count  % of Road Segments Max Upload Category  Count  % of Road Segments

6  49  100% 3  49  100%
 
 
Typical down/upload speeds reported by provider: 
Census Blocks 
Typical Download Category  Count  % of Blocks Typical Upload Category  Count  % of Blocks

6  421  100% 3  421  100%
 
Road Segments   

Typical Download Category  Count 
% of Road 
Segments Typical Upload Category  Count 

% of Road 
Segments

6  49  100% 3  49 100%
 
Typical down/upload speed from 2010 computer based speed test:  
Speed Test Download Tier  Count  % of Tests Speed Test Upload Tier Count  % of Tests

4  3  50% 2  3  50%
5  2  33% 3  3  50%
7  1  17%

 
Speed tests match reported typical download speeds or are within 1 speed tier:   No 
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted): 0/421 (0%) 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 0 
Number of tracts reported to FCC, but no census blocks reported to project: 0 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 0 
Total number of dead zones reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with dead zones reported via mdbroadbandmap.org: 0 
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Total number of dead zones reported per provider via mdbroadbandmap.org: 0 
 
Web Search Verification: 2/421 (1%) of census blocks were confirmed using online search 
feature of given provider 
Charter WebSearch Verification Table Count Percentage 
Total # of sample points 1496  
Number of sample points with results  55 4% 
Result is yes and census block is in served area  2 4% 
Result is yes but not in a census block reported as served    0 0% 
Result is no and census block is in served area 3 5% 
Result is no and census block not served area 50 91% 
 
Census blocks that are outside providers own Cable Franchise Boundary: 208/421 (49%) 
  
Census blocks that fall within another provider’s Cable Franchise Boundary: 0/421 (0%) 
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Clearwire Corporation 
DBA Name: Clearwire Corporation 
 
Data Characteristics 
 
Date of Original Submission:              3/5/2010 
Date of Update Submission:              9/9/2011 
Currency of Data:                9/2/2011 
FRN:                     0017775628 
Type of data submitted:               Coverage Area 
Census Block Count:                             N/A     
Total Matched Address Points Count:          N/A 
Unmatched Address Points:              N/A 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           Complete 
Provided Max Typical Upload Speed:           Complete 
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Coverage Area Process: 

• Repair Geometry on delivered coverage area 
• Remove coverage areas less than 0.125 square miles 
• Remove coverage area “holes” less than 0.125 square miles 
• Load coverage area into the NTIA data model 

o Result: BB_Service_Wireless 
 
Data Verification 
Maximum down/upload speeds reported by provider:  
Coverage Area 
Max Download Category  Count  % of Area Max Upload Category Count  % of Area

5  1  100% 4  1  100%
 
Typical down/upload speeds reported by provider: 
Coverage Area 
Typical Download Category  Count  % of Area Typical Upload Category  Count  % of Area

5  1  100% 4  1  100%
  
Typical down/upload speed from 2010 mobile speed test:  
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Speed Test Download Tier  Count  % of Tests Speed Test Upload Tier  Count  % of Tests
0  36  14% 1  15  6%
3  83  31% 2  106  40%
4  91  34% 3  142  54%
5  48  18% 7  2  1%
6  5  2%
7  2  1%

 
Speed tests match reported typical download speeds or are within 1 speed tier:   Yes 
 
#/% of mobile speed tests verifying coverage area:  
Number of mobile speed tests reported inside coverage area: 216/265 (81.5%) 
Number of mobile speed tests reported outside coverage area: 49/265 (18.5%) 
 
Typical down/upload speed from 2010 computer based speed test: 
Speed Test Download Tier  Count  % of Tests Speed Test Upload Tier Count  % of Tests

0  7  8% 1  2  2%
3  11  13% 2  22  26%
4  19  23% 3  60  71%
5  35  42%
6  10  12%
7  2  2%

  
Speed tests match reported typical download speeds or are within 1 speed tier: Yes 
 
#/% of computer based speed tests verifying coverage area: 
Number of computer based speed tests reported inside coverage area: 80/84 (95.2%) 
Number of computer based speed tests reported outside coverage area: 4/84 (4.8%) 
 
Form 477Verification: 
#/% of tracts reported as served to FCC that overlaps with coverage area: N/A 
#/% of tracts reported as served to FCC but do not intersect coverage area: N/A 
 
Dead zones: 
Number of dead zones reported within coverage area via broadband.maryland.gov:  
39/240 (16.2%) 
Number of dead zones reported within coverage area via mdbroadbandmap.org:  
6/147 (4%) 
 
Web Search Verification: N/A 
 
Wireless Verification: N/A 
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Cogent Communications Group 
DBA Name: Cogent Communications Group 
 
Data Characteristics 
 
Date of Original Submission:              2/1/2010 
Date of Update Submission:              7/7/2011 
Currency of Data:                Janu6/30/2011 
FRN:                     0019066034 
Type of data submitted:               Address Table, 
                    Middle Mile 
Census Block Count:                            3     
Total Matched Address Points Count:          3 
Unmatched Address Points:              3 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           No  
Provided Max Typical Upload Speed:           No  
Provided Middle Mile:               Yes 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Address Table Process: 

• Geocode address table to ESRI US streets address locator 
o Number matched: 3 
o Number unmatched: 0 

• Spatially join address points to 2010 census blocks 
Census Block Process: 

• Join the address points to the 2010 census blocks based on the GEOID10 field  
o Export results  
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Max Download Category  Count  % of Blocks Max Upload Category Count  % of Blocks

11  3  100% 11  3  100%
 
Typical down/upload speeds reported by provider: N/A 
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Typical down/upload speed from 2010 computer based speed test:  
Speed Test Download Tier  Count  % of Tests   Speed Test Upload Tier Count  % of Tests

0  1  8%   2  1  8%
3  2  15%   3  2  15%
4  1  8%   6  7  54%
6  8  62%   7  3  23%
8  1  8%  

Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted):  8/3 (> 100%) 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 3 
Number of tracts reported to FCC, but no census blocks reported to project: 3 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 0 
Total number of dead zones reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with dead zones reported via mdbroadbandmap.org: 0 
Total number of dead zones reported per provider via mdbroadbandmap.org: 0 
 
Web Search Verification: N/A 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Maryland Broadband Mapping Initiative:  Verification/Validation Report 

September 30, 2011 
 

Salisbury University    www.mdbroadbandmap.org  
61 

 
   

Comcast Corporation 
DBA Name: Comcast Cable Communications, LLC 
 
Data Characteristics 
 
Date of Original Submission:              1/19/2010 
Date of Update Submission:              9/7/2011 
Currency of Data:                6/30/2011 
FRN:                     0004441663 
Type of data submitted:               Census Block Table, 
                    Road Segments 
Census Block Count:                            48720     
Total Matched Address Points Count:          N/A 
Unmatched Address Points:              N/A 
Number of Technology of Transmission Types:        2 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           No  
Provided Max Typical Upload Speed:           No  
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  Yes 
 
Data Processing 
 
Census Block Process: 

• Join the census block table to the 2010 census blocks based on the GEOID10 field  
o Export results for each technology of transmission 
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census Blocks 
Max Download Category  Count  % of Blocks Max Upload Category Count  % of Blocks

9  48720  100% 7  48720  100%

Road Segments 
Max Download Category  Count  % of Blocks Max Upload Category Count  % of Blocks

9  736  100% 7  736  100%
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Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 computer based speed test:  
Speed Test Download Tier  Count  % of Tests   Speed Test Upload Tier Count  % of Tests

0  63  1%   1  36  1%
3  144  3%   2  183  3%
4  117  2%   3  292  5%
5  450  8%   4  1101  19%
6  734  13%   5  3841  68%
7  3737  66%   6  192  3%
8  372  7%   7  26  0%
9  41  1%

10  13  0%
 
Speed tests match reported typical download speeds or are within 1 speed tier:  Yes 
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted): 492/48720 (1%) 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 146 
Number of tracts reported to FCC, but no census blocks reported to project: 0 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 71 
Total number of dead zones reported per provider via broadband.maryland.gov: 102 
 
Number of census blocks with dead zones reported via mdbroadbandmap.org: 32 
Total number of dead zones reported per provider via mdbroadbandmap.org: 41 
 
Web Search Verification: 440/48720 (1%) of census blocks were confirmed using online search 
feature of given provider 
Comcast WebSearch Verification Table Count Percentage 
Total # of sample points 1496  
Number of sample points with results  835 56% 
Result is yes and census block is in served area  440 53% 
Result is yes but not in a census block reported as served    63 8% 
Result is no and census block is in served area 137 16% 
Result is no and census block not served area 194 23% 
 
Census blocks that are outside providers own Cable Franchise Boundary:  5730/48720 (12%) 
 Census blocks that fall within another provider’s Cable Franchise Boundary:  263/48720 (1%) 
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DIECA Communications, Inc. 
DBA: Covad Communication Company 
 
Data Characteristics 
 
Date of Original Submission:              2/1/2010 
Date of Update Submission:              8/6/2011 
Currency of Data:                12/31/2011 
FRN:                     0003753753 
Type of data submitted:               Census Block Table, 
                    Road Segments 
Census Block Count:                             71956     
Total Matched Address Points Count:          N/A 
Unmatched Address Points:              N/A 
Number of Technology of Transmission Types:        3 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           Complete 
Provided Max Typical Upload Speed:           Complete 
Provided Middle Mile:               Yes 
Provided Road Segments for census blocks greater than 2 sq miles:  Yes 
 
Data Processing 

 
Census Block Process: 

• Join the census block table to the 2010 census blocks based on the GEOID10 field  
o Export results for each technology of transmission 
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
Data Modification: 

• 9141 features Typical Downstream Speed changed to speed tier 3 
 
Data Verification 
 
Maximum down/upload speeds reported by provider: 
Census Blocks 
Max Download Category  Count  % of Blocks Max Upload Category Count  % of Blocks

3  10192  6% 2  15085  9%
4  28162  17% 3  41992  26%
5  73822  46% 4  19796  12%
6  30213  19% 5  69943  43%
7  19030  12% 7  14603  9%
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Road Segments 
Max Download 
Category  Count  % of Road Segments

Max Upload 
Category Count  % of Road Segments

3  51  3% 2  88  4%
4  241  12% 3  147  7%
5  1543  78% 4  169  9%
6  112  6% 5  1543  78%
7  22  1% 7  22  1%

 
Typical down/upload speeds reported by provider: 
Census Blocks 
Typical Download Category  Count  % of Blocks Typical Upload Category  Count  % of Blocks

2  9141  6% 2  51662  9%
3  10520  7% 3  6518  26%
4  38120  24% 4  34241  12%
5  83373  52% 5  54395  43%
6  4116  3% 7  14603  9%
7  16149  10%

 
Road Segments 
Typical Download 
Category  Count  % of Road Segments

Typical Upload 
Category Count  % of Road Segments

2  7  0% 2  191  4%
3  116  6% 3  44  7%
4  193  10% 4  193  9%
5  1631  83% 5  1519  78%
7  22  1% 7  22  1%

  
Typical down/upload speed from 2010 computer based speed test:  
Speed Test Download Tier  Count  % of Tests   Speed Test Upload Tier Count  % of Tests

0  9  11%   1  22  27%
3  42  51%   2  33  40%
4  23  28%   3  17  20%
5  4  5%   4  8  10%
6  2  2%   5  3  4%
7  3  4%

 
Speed tests match reported typical speeds or are within 1 speed tier:   No 
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted): 0/71956 (0%) 
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Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 5785 
Number of tracts reported to FCC, but no census blocks reported to project: 0 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 57 
Total number of dead zones reported per provider via broadband.maryland.gov: 72 
 
Number of census blocks with dead zones reported via mdbroadbandmap.org: 20 
Total number of dead zones reported per provider via mdbroadbandmap.org: 28 
 
Web Search Verification: N/A 
 
Census blocks that are outside DSL boundary:  17913/71956 (25%) 
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DSLnet Communications, LLC 
DBA Name: DSLnet Communications, LLC 
 
Data Characteristics 
 
Date of Original Submission:              3/11/2010 
Date of Update Submission:              8/30/2011 
Currency of Data:                6/30/2011 
FRN:                     0004324857 
Type of data submitted:               Address Table 
Census Block Count:                             171     
Total Matched Address Points Count:          595 
Unmatched Address Points:              6 
Number of Technology of Transmission Types:        2 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           No 
Provided Max Typical Upload Speed:           No 
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Address Table Process: 

• Geocode address table to ESRI US Streets address locator 
o Number matched: 592 
o Number unmatched: 9 

• Unmatched address are geocoded to Maryland Property View address locator 
o Number matched: 1 
o Number unmatched: 8 

• Unmatched address are geocoded to Maryland centerline address locator 
o Number matched: 2 
o Number unmatched: 6 

• Merge matched addresses 
• Spatially join address points to 2010 census blocks 
• Separate and export the address points according to technology of transmission  
• Select by location the address points that are completely within a greater than two 

square mile census block 
o Export as address points to be loaded into the NTIA data model 

 Result: BB_Service_Address 
o Switch the selection and export as points to create census blocks 
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Census Block Process: 

• Join the switched selection (BB_Service_Address) address points to the 2010 census 
blocks based on the GEOID10 field  

o Export results for each technology of transmission 
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
Data Modification: 

• Removed 301 addresses from provider submission that do not meet broadband speeds 
• Removed 1 address from provider submission reported with no technology of 

transmission 
 
Data Verification 
Maximum down/upload speeds reported by provider:  
Census Blocks 
Max Download Category  Count  % of Blocks Max Upload Category Count  % of Blocks

3  104  61% 3 104  61%
4  67  39% 4 67  39%

 
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 computer based speed test: N/A 
 
Speed tests match reported typical speeds or are within 1 speed tier:  N/A 
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted):  N/A 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: N/A 
Number of tracts reported to FCC, but no census blocks reported to project: N/A 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 0 
Total number of dead zones reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with dead zones reported via mdbroadbandmap.org: 0 
Total number of dead zones reported per provider via mdbroadbandmap.org: 0 
 
Web Search Verification: N/A 
 
Census blocks that are outside DSL boundary:  6/171 (4%) 
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DSLnet, Inc  
DBA: DSLnet, Inc 
 
Data Characteristics 
 
Date of Original Submission:              3/11/2010 
Date of Update Submission:              8/30/2011 
Currency of Data:                6/30/2011 
FRN:                     0015321136 
Type of data submitted:               Addresses 
Census Block Count:                            30     
Total Matched Address Points Count:          63 
Unmatched Address Points:              0 
Number of Technology of Transmission Types:        2 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           No  
Provided Max Typical Upload Speed:           No  
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Address Table Process: 

• Geocode address table to ESRI US Streets address locator 
o Number matched: 63 
o Number unmatched: 0 

• Spatially join address points to 2010 census blocks 
• Separate and export the address points according to technology of transmission  

Census Block Process: 
• Join the address points to the 2010 census blocks based on the GEOID10 field  

o Export results for each technology of transmission 
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
Data Modification: 

• Removed 31 addresses from provider submission that do not meet broadband speeds 
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Data Verification 
 
Maximum down/upload speeds reported by provider: 
Census Blocks 
Max Download Category  Count  % of Blocks Max Upload Category Count  % of Blocks

3  13  42% 3 13  42%
4  17  55% 4 17  55%
8  1  3% 8 1  3%

  
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 computer based speed test: N/A 
 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted):  N/A 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 0 
Number of tracts reported to FCC, but no census blocks reported to project: 192 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 0 
Total number of dead zones reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with dead zones reported via mdbroadbandmap.org: 0 
Total number of dead zones reported per provider via mdbroadbandmap.org: 0 
 
Web Search Verification: N/A 
 
Census blocks that are outside DSL boundary:  11/30 (37%) 
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Easton Utilities Commission 
DBA Name: Easton Utilities Commission 
 
Data Characteristics 
 
Date of Original Submission:              2/5/2010 
Date of Update Submission:              2/23/2011 
Currency of Data:                12/31/2011 
FRN:                     0003793726 
Type of data submitted:               Address Table 
Census Block Count:                             530     
Total Matched Address Points Count:          4687 
Unmatched Address Points:              3 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           No  
Provided Max Typical Upload Speed:           No  
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Address Table Process: 

• Geocode address table to ESRI address locator 
o Number matched: 4316 
o Number unmatched: 374 

• Unmatched address are geocoded to MDPV address locator 
o Number matched: 367 
o Number unmatched: 7 

• Unmatched address are geocoded to Maryland street centerline address locator 
o Number matched: 4 
o Number unmatched: 3 

• Merge matched addresses 
• Spatially join address points to 2000 census blocks 
• Select by location the address points that are completely within a greater than two 

square mile census block 
o Export as address points to be loaded into the NTIA data model 

 Result: BB_Service_Address 
o Switch the selection and export as points to create census blocks 
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Census Block Process: 

• Join the switched selection (BB_Service_Address) address points to the 2000 census 
blocks based on the BLK2000 field  

o Load exported results into the NTIA data model  
 Result: BB_Service_CensusBlock 

Data Modification: 
• 258 blocks with Technology of Transmission 41 Maximum Advertised Up speed does not 

fit domain ‐ changed to speed tier 2 
 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census Blocks 
Max Download Category  Count  % of Blocks Max Upload Category Count  % of Blocks

3  275  52% 1 258  49%
5  255  48% 2 243  46%

3 24  5%
4 5  1%

 
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 computer based speed test:  
Speed Test Download Tier  Count  % of Tests   Speed Test Upload Tier Count  % of Tests

0  4  4% 1  12  12%
3  11  11% 2  57  56%
4  9  9% 3  29  29%
5  57  56% 4  2  2%
6  19  19% 6  1  1%
7  1  1%

 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted): 0/530 (0%) 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 7 
Number of tracts reported to FCC, but no census blocks reported to project: 0 
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Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 0 
Total number of dead zones reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with dead zones reported via mdbroadbandmap.org: 0 
Total number of dead zones reported per provider via mdbroadbandmap.org: 0 
 
Web Search Verification: N/A 
 
Census blocks that are outside providers own Cable Franchise Boundary:  8/530 (2%) 
  
Census blocks that fall within another provider’s Cable Franchise Boundary:  3/530 (1%) 
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FiberLight LLC 
DBA Name:  FiberLight LLC 
 
Data Characteristics 
 
Date of Original Submission:              3/31/2010 
Date of Update Submission:              3/31/2010 
Currency of Data:                3/31/2010 
FRN:                     0014117139 
Type of data submitted:               Census Block Table 
Census Block Count:                             1128     
Total Matched Address Points Count:          N/A 
Unmatched Address Points:              N/A 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           No  
Provided Max Typical Upload Speed:           No  
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Census Block Process: 

• Join census block table to the 2010 census blocks based on the GEOID10 field  
o Export results  
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census Blocks 
Max Download Category  Count  % of Blocks Max Upload Category Count  % of Blocks

10  1128  100% 10 1128  100%
 
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 computer based speed test: N/A 
 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
%/# of census blocks verified by 2010 computer based speed tests: N/A 
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Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: N/A 
Number of tracts reported to FCC, but no census blocks reported to project: N/A 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 0 
Total number of dead zones reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with dead zones reported via mdbroadbandmap.org: 0 
Total number of dead zones reported per provider via mdbroadbandmap.org: 0 
 
Web Search Verification: N/A 
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Freedom Wireless Broadband, LLC 
DBA Name: Freedom Wireless Broadband, LLC 
 
Data Characteristics 
 
Date of Original Submission:              1/28/2010 
Date of Update Submission:              8/25/2011 
Currency of Data:                Dece6/30/2011 
FRN:                     0018643155 
Type of data submitted:               Coverage Area 
Census Block Count:                 N/A     
Total Matched Address Points Count:          N/A 
Unmatched Address Points:              N/A 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           Complete  
Provided Max Typical Upload Speed:           Complete 
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Coverage Area Process: 

• Repair Geometry on delivered coverage area 
• Load coverage area into the NTIA data model 

o Result: BB_Service_Wireless 
 
Data Verification 
Maximum down/upload speeds reported by provider:  
Coverage Area 
Max Download Category  Count  % of Area Max Upload Category Count  % of Area

4  1  100% 4 1  100%
 
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 mobile speed test: N/A 
 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
#/% of mobile speed tests verifying coverage area:  
Number of mobile speed tests reported inside coverage area: N/A 
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Number of mobile speed tests reported outside coverage area: N/A 
 
Form 477 Verification: 
#/% of tracts reported as served to FCC that overlaps with coverage area: 13/13 
#/% of tracts reported as served to FCC but do not intersect coverage area: 0/13 
 
Dead zones: 
Number of dead zones reported within coverage area via broadband.maryland.gov:  
15/240 (6.2%) 
Number of dead zones reported within coverage area via mdbroadbandmap.org: 
4/147 (2.7%) 
 
Web Search Verification: N/A 
 
Wireless Verification: N/A 
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Gans Communications, LP 
DBA: MetroCast Communications 
 
Data Characteristics 
 
Date of Original Submission:              3/5/2010 
Date of Update Submission:              9/9/2011 
Currency of Data:                6/30/2011 
FRN:                     0016642761 
Type of data submitted:               Census Block Table, 
                    Road Segments 
Census Block Count:                             2467   
Total Matched Address Points Count:          N/A 
Unmatched Address Points:              N/A 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           Complete 
Provided Max Typical Upload Speed:           Complete 
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  Yes 
 
Data Processing 
 
Census Block Process: 

• Join the census block table to the 2010 census blocks based on the GEOID10 field  
o Export results  
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
Road Segment Process: 

• Road segments are 2009 geometry 
• Join road segments to TigerLine by TLID 

o Export results 
o Load exported results into the NTIA data model 

 Result: BB_Service_RoadSegment 
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Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census Blocks 
Max Download Category  Count % of Blocks Max Upload Category  Count  % of Blocks

7  2467 100% 4  2467  100%
 
Road Segments 

Max Download Category  Count 
% of 
Segments Max Upload Category  Count 

% of 
Segments

7  800  100% 4  800  100%
 
 
Typical down/upload speeds reported by provider: 
Census Blocks 
Typical Download Category  Count % of Blocks Typical Upload Category  Count % of Blocks

6  2467 100% 2  2467 100%
  
Road Segments 
Typical Download Category  Count  % of Segments Typical Upload Category  Count % of Segments

7  800  100% 2  800 100%
 
Typical down/upload speed from 2010 computer based speed test:  
Speed Test Download Tier  Count  % of Tests   Speed Test Upload Tier Count  % of Tests

3  3  7% 1  18  40%
4  9  20% 2  24  53%
5  10  22% 3  2  4%
6  21  47% 4  1  2%
7  2  4%

 
Speed tests match reported typical download speeds or are within 1 speed tier:  Yes 
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted):  1/2467 (< 1%) 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: N/A 
Number of tracts reported to FCC, but no census blocks reported to project: N/A 
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Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 6 
Total number of dead zones reported per provider via broadband.maryland.gov: 7 
Number of census blocks with dead zones reported via mdbroadbandmap.org: 6 
Total number of dead zones reported per provider via mdbroadbandmap.org: 7 
 
Web Search Verification: 36/2467 (2%) of census blocks were confirmed using online search 
feature of given provider 
MetroCast Web Search Verification Table Count Percentage 
Total # of sample points 1496  
Number of sample points with results  107 7% 
Result is yes and census block is in served area  36 34% 
Result is yes but not in a census block reported as served    20 19% 
Result is no and census block is in served area 1 1% 
Result is no and census block not served area 50 47% 
 
 
Census blocks that are outside providers own Cable Franchise Boundary:  N/A 
  
Census blocks that fall within another provider’s Cable Franchise Boundary:  1094/2467 (44%) 
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HNS License Sub, LLC 
DBA: Hughes Communications, Inc.  
 
Data Characteristics 
 
Date of Original Submission:              2/2/2010 
Date of Update Submission:              2/2/2010 
Currency of Data:                7/31/2010 
FRN:                     0018483073 
Type of data submitted:               Coverage Area 
Census Block Count:                             N/A     
Total Matched Address Points Count:          N/A  
Unmatched Address Points:              N/A 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           Complete 
Provided Max Typical Upload Speed:           Complete 
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Coverage Area Process: 

• Repair Geometry on delivered coverage area 
• Perform Topology on coverage area 

o Rule: Coverage area should not overlap 
o Load coverage area into the NTIA data model 

 Result: BB_Service_Wireless 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Coverage Area 
Max Download Category  Count  % of Area Max Upload Category Count  % of Area

5  1  100% 2 1  100%
 
Typical down/upload speeds reported by provider:  
Typical Download Category  Count  % of Area Typical  Upload Category  Count  % of Area

3  1  100% 2  1  100%
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Typical down/upload speed from 2010 mobile speed test: 
Speed Test Download Tier  Count  % of Tests Speed Test Upload Tier  Count  % of Tests

0  23  70% 1  10  30%
3  8  24% 2  10  30%
4  1  3% 4  5  15%
5  1  3% 5  6  18%

7  2  6%
  
Speed tests match reported typical download speeds or are within 1 speed tier:  No 
 
#/% of computer based speed tests verifying coverage area: 
Number of computer based speed tests reported inside coverage area: 33/33 (100%) 
Number of computer based speed tests reported outside coverage area: 0/33 (0%) 
 
Typical down/upload speed from 2010 computer based speed test: 
Speed Test Download Tier  Count  % of Tests   Speed Test Upload Tier Count  % of Tests

0  9  13% 1  18  27%
3  34  51% 2  27  40%
6  8  12% 3  2  3%
7  10  15% 4  3  4%
8  5  7% 5  4  6%
9  1  1% 6  8  12%

7  4  6%
8  1  1%

 Speed tests match reported typical download speeds or are within 1 speed tier:   No 
 
#/% of computer based speed tests verifying coverage area:  
Number of mobile speed tests reported inside coverage area: 67/67 (100%) 
Number of mobile speed tests reported outside coverage area: 0/67 (0%) 
 
Form477 Verification: 
#/% of tracts reported as served to FCC that overlaps with coverage area: 295/295 
#/% of tracts reported as served to FCC but do not intersect coverage area: 0/295 
 
Dead zones: 
Number of dead zones reported within coverage area via broadband.maryland.gov:  
237/240 (98.7%) 
Number of dead zones reported within coverage area via mdbroadbandmap.org: 
147/147 (100%) 
 
Web Search Verification: N/A 
Wireless Verification: N/A 
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Hotwire Communications, Ltd 
DBA Name: Hotwire Communications, Ltd 
 
Data Characteristics 
 
Date of Original Submission:              2/19/2010 
Date of Update Submission:              8/30/2011 
Currency of Data:                6/30/2011 
FRN:                     0009846494 
Type of data submitted:               Addresses 
Census Block Count:                             1   
Total Matched Address Points Count:          1 
Unmatched Address Points:              0 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           No  
Provided Max Typical Upload Speed:           No  
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Address Table Process: 

• Geocode address table to ESRI US Streets address locator 
o Number matched: 1 
o Number unmatched: 0 

• Spatially join address points to 2010 census blocks 
Census Block Process: 

• Join the address points to the 2000 census blocks based on the GEOID10 field  
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
 
 
Data Verification 
Maximum down/upload speeds reported by provider:  
Census Blocks 
Max Download Category  Count  % of Blocks Max Upload Category Count  % of Blocks

5  1  100% 3 1  100%
 
Typical down/upload speeds reported by provider: N/A 
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Typical down/upload speed from 2010 computer based speed test: N/A 
 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted): N/A 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 1 
Number of tracts reported to FCC, but no census blocks reported to project: 1 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 0 
Total number of dead zones reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with dead zones reported via mdbroadbandmap.org: 0 
Total number of dead zones reported per provider via mdbroadbandmap.org: 0 
 
Web Search Verification: N/A 
 
Census blocks that are outside providers own Cable Franchise Boundary:  N/A 
  
Census blocks that fall within another provider’s Cable Franchise Boundary:  1 
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Leap Wireless International, Inc 
DBA: Cricket Communications  
 
Data Characteristics 
 
Date of Original Submission:              3/17/2010 
Date of Update Submission:              8/12/2010 
Currency of Data:                8/3/2010 
FRN:                     0002963528 
Type of data submitted:               Coverage Area 
Census Block Count:                             N/A   
Total Matched Address Points Count:          N/A 
Unmatched Address Points:              N/A 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           No 
Provided Max Typical Upload Speed:           No 
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Coverage Area Process: 

• Repair Geometry on delivered coverage area 
• Remove coverage areas less than 0.125 square miles 
• Remove coverage area “holes” less than 0.125 square miles 
• Load coverage area into the NTIA data model 

o Result: BB_Service_Wireless 
 

Data Verification 
 
Maximum down/upload speeds reported by provider:  
Coverage Area 
Max Download Category  Count  % of Area Max Upload Category Count  % of Area

3  1  100% 2 1  100%
 
Typical down/upload speeds reported by provider: N/A 
  
Typical down/upload speed from 2010 mobile speed test: N/A 
 
Speed tests match reported typical speeds or are within 1 speed tier:   N/A 
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#/% of mobile speed tests verifying coverage area:  
Number of mobile speed tests reported inside coverage area: N/A  
Number of mobile speed tests reported outside coverage area: N/A 
 
Form 477 Verification: 
#/% of tracts reported as served to FCC that overlaps with coverage area: N/A 
#/% of tracts reported as served to FCC but do not intersect coverage area: N/A 
 
Dead zones: 
Number of dead zones reported within coverage area via broadband.maryland.gov:  
83/240 (34.5%) 
Number of dead zones reported within coverage area via mdbroadbandmap.org:  
34/147 (23%) 
 
Web Search Verification: N/A 
 
Wireless Verification:  
Cricket Wireless Verification Table ‐ 3G Count  Percentage
Total # of sample points 1486    
Number of sample points within coverage area 446    
Total number of sample points with results 489    
Verified served AND within reported coverage area   (yes,yes) 356    
Verified served AND found outside reported coverage area  (yes,no) 133  27.2%
Verified unserved AND found within reported coverage area   (no,yes) 90  20.2%
Verified unserved AND found outside reported coverage area  (no,no) 907    
Total error  223  15.0%
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Level 3 Communications, LLC 
DBA Name: Level 3 Communications, LLC 
   
Data Characteristics 
 
Date of Original Submission:              1/18/2010 
Date of Update Submission:              8/22/2011 
Currency of Data:                6/30/2011 
FRN:                     0003723822 
Type of data submitted:               Address Table 
Census Block Count:                             170   
Total Matched Address Points Count:          210 
Unmatched Address Points:              5 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           Complete 
Provided Max Typical Upload Speed:           Complete 
Provided Middle Mile:               Yes 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Address Table Process: 

• Geocode address table to ESRI US Steets address locator 
o Number matched: 196 
o Number unmatched: 19 

• Unmatched address are geocoded to Maryland Property View address locator 
o Number matched: 9 
o Number unmatched: 10 

• Unmatched address are geocoded to Maryland centerline address locator 
o Number matched: 5 
o Number unmatched: 5 

• Merge matched addresses 
• Spatially join address points to 2010 census blocks 
• Select by location the address points that are completely within a greater than two 

square mile census block 
o Export as address points to be loaded into the NTIA data model 

 Result: BB_Service_Address 
o Switch the selection and export as points to create census blocks 
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Census Block Process: 
• Join the switched selection (BB_Service_Address) address points to the 2010 census 

blocks based on the GEOID10 field  
o Export results Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census Blocks 
Max Download Category  Count  % of Blocks Max Upload Category Count  % of Blocks

11  170  100% 11  170  100%
 
Typical down/upload speeds reported by provider: 
Census Blocks 
Typical Download Category  Count % of Blocks Typical Upload Category  Count  % of Blocks

11  129 100% 11  129  100%
  
Typical down/upload speed from 2010 computer based speed test:  
Speed Test Download Tier  Count  % of Tests   Speed Test Upload Tier Count  % of Tests

0  39  37%   1  20  19%
3  21  20%   2  28  27%
4  7  7%   3  20  19%
5  7  7%   4  11  10%
6  5  5%   5  3  3%
7  10  10%   6  13  12%
8  12  11%   7  7  7%
9  3  3%   8  3  3%

10  1  1%
 
Speed tests match reported typical download speeds or are within 1 speed tier:  No 
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted): 56/170 (33%) 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 79 
Number of tracts reported to FCC, but no census blocks reported to project: 48 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 1 
Total number of dead zones reported per provider via broadband.maryland.gov: 2 
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Number of census blocks with dead zones reported via mdbroadbandmap.org: 0 
Total number of dead zones reported per provider via mdbroadbandmap.org: 0 
 
Web Search Verification: N/A 
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Mediacom Communications 
DBA: Mediacom Maryland LLC 
 
Data Characteristics 
 
Date of Original Submission:              8/4/2011 
Date of Update Submission:              N/A 
Currency of Data:                7/30/2011 
FRN:                     0003572633 
Type of data submitted:               Census Block Table 
Census Block Count:                 537   
Total Matched Address Points Count:          11420 
Unmatched Address Points:              253 
Number of Technology of Transmission Types:        2 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           No 
Provided Max Typical Upload Speed:           No 
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
Address Table Process: 

• Geocode address table to ESRI US Streets address locator 
o Number matched: 10941 
o Number unmatched: 732 

• Unmatched address are geocoded to Maryland Property View address locator 
o Number matched: 442 
o Number unmatched:  290 

• Unmatched addresses are geocoded to Maryland center line address locator 
o Number matched:  37 
o Number unmatched:  253 

• Merge matched addresses 
• Spatially join address points to 2010 census blocks 

Census Block Process: 
• Join the address points to the 2010 census blocks based on the GEOID10 field  

o Export results Load exported results into the NTIA data model  
 Result: BB_Service_CensusBlock 

Data Modification: 
• Removed 1 address from provider submission – out of service area bounds 
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Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census Blocks 

Max Download Category  Count  % of Blocks Max Upload Category Count 
% of 
Blocks

8  1074  100% 4  1074  100%
 
Typical down/upload speeds reported by provider: N/A 
  
Typical down/upload speed from 2010 computer based speed test:  
Speed Test Download Tier  Count  % of Tests   Speed Test Upload Tier Count  % of Tests

4  8  20% 2  4  10%
5  4  10% 3  28  70%
6  10  25% 4  6  15%
7  18  45% 5  2  5%

 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted):  0/537 (0%) 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 2 
Number of tracts reported to FCC, but no census blocks reported to project: 0 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 3 
Total number of dead zones reported per provider via broadband.maryland.gov: 5 
Number of census blocks with dead zones reported via mdbroadbandmap.org: 1 
Total number of dead zones reported per provider via mdbroadbandmap.org: 1 
 
Web Search Verification: 20/537 (4%) of census blocks were confirmed using online search 
feature of given provider 
Mediacom WebSearch Verification Table Count Percentage 
Total # of sample points 1496  
Number of sample points with results  85 6% 
Result is yes and coverage area is in served area  13 15% 
Result is yes but not in a coverage area reported as served    15 18% 
Result is no and coverage area is in served area 3 4% 
Result is no and coverage area is not in served area 54 64% 
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Census blocks that are outside providers own Cable Franchise Boundary:  231 
Census blocks that fall within another provider’s Cable Franchise Boundary: 69 
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MegaPath, Inc. 
DBA Name: MegaPath 
 
Data Characteristics 
 
Date of Original Submission:              3/11/2010 
Date of Update Submission:              8/30/2011 
Currency of Data:                6/30/2011 
FRN:                     0018105601 
Type of data submitted:               Address Table 
Census Block Count:                             68     
Total Matched Address Points Count:          85 
Unmatched Address Points:              1 
Number of Technology of Transmission Types:        2 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           No 
Provided Max Typical Upload Speed:           No 
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Address Table Process: 

• Geocode address table to ESRI US Streets address locator 
o Number matched: 82 
o Number unmatched: 2 

• Unmatched address are geocoded to Maryland Property View address locator 
o Number matched: 2 
o Number unmatched: 2 

• Unmatched addresses are geocoded to Maryland center line address locator 
o Number matched:  1 
o Number unmatched:  1 

• Merge matched addresses 
• Spatially join address points to 2000 census blocks 
• Separate and export the address points according to technology of transmission  
• Select by location the address points that are completely within a greater than two 

square mile census block 
o Export as address points to be loaded into the NTIA data model 

 Result: BB_Service_Address 
o Switch the selection and export as points to create census blocks 
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Census Block Process: 
• Join the switched selection (BB_Service_Address) address points to the 2010 census 

blocks based on the GEOID10 field  
o Export results for each technology of transmission 
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
Data Modification: 

• Removed 12 addresses from provider submission for not having a Maximum Advertised 
Upload Speed 

• 30 census blocks with Technology of Transmission 20 speed changed to tier 3 to fit 
domain 

 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census Blocks 
Max Download Category  Count  % of Blocks Max Upload Category Count  % of Blocks

3  65  94% 2 28  41%
4  3  4% 3 41  59%
5  1  1%

Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 computer based speed test: 
Speed Test Download Tier  Count  % of Tests   Speed Test Upload Tier Count  % of Tests

0  5  63% 1  2  25%
3  2  25% 2  4  50%

10  1  13% 3  1  13%
 
Speed tests match reported typical speeds or are within 1 speed tier:  N/A 
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted): 6/68 (9%) 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: N/A 
Number of tracts reported to FCC, but no census blocks reported to project: N/A 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 0 
Total number of dead zones reported per provider via broadband.maryland.gov: 0 
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Number of census blocks with dead zones reported via mdbroadbandmap.org: 0 
Total number of dead zones reported per provider via mdbroadbandmap.org: 0 
 
Web Search Verification: N/A 
 
Census blocks that are outside DSL boundary:  1/68 (1%) 
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Mountain Communications, LLC 
DBA:  ProCom 
 
Data Characteristics 
Date of Original Submission:              5/31/2010 
Date of Update Submission:              5/31/2010 
Currency of Data:                5/31/2010 
FRN:                     0008039323 
Type of data submitted:         Census Block Table, 

Road Segments 
Census Block Count:                             161     
Total Matched Address Points Count:          N/A 
Unmatched Address Points:              N/A 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           No  
Provided Max Typical Upload Speed:           No  
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  Yes 
 
Data Processing 
Census Block Process: 

• Join the census block table to the 2010 census blocks based on the GEOID10 field  
o Export results  
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
Road Segment Process: 

• Road segments are 2009 geometry 
• Join road segments to TigerLine by TLID 

o Export results 
o Load exported results into the NTIA data model 

 Result: BB_Service_RoadSegment 
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Data Verification 
Maximum down/upload speeds reported by provider:  
Census Blocks 
Max Download Category  Count  % of Blocks Max Upload Category Count  % of Blocks

10  161  100% 10 161  100%

Road Segments 
Max Download Category  Count  % of Blocks Max Upload Category Count  % of Blocks

10  95  100% 10 161  100%
 
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 computer based speed test: N/A 
 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted): N/A 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: N/A 
Number of tracts reported to FCC, but no census blocks reported to project: N/A 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 0 
Total number of dead zones reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with dead zones reported via mdbroadbandmap.org: 0 
Total number of dead zones reported per provider via mdbroadbandmap.org: 0 
 
Web Search Verification: N/A 
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Neon Connect, Inc 
DBA: Sidera Networks 
 
Data Characteristics 
 
Date of Original Submission:              3/5/2010 
Date of Update Submission:              3/1/2011 
Currency of Data:                December 2010 
FRN:                     0005052741 
Type of data submitted:               Address Table 
Census Block Count:                            1     
Total Matched Address Points Count:          2 
Unmatched Address Points:              0 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           Complete 
Provided Max Typical Upload Speed:           Complete 
Provided Middle Mile:               Yes 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Address Table Process: 

• Geocode address table to ESRI US Streeds address locator 
o Number matched: 2 
o Number unmatched: 0 

• Spatially join address points to 2010 census blocks 
Census Block Process: 

• Join the address points to the 2000 census blocks based on the GEOID10 field  
o Export results  
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
 
 

Data Verification 
Maximum down/upload speeds reported by provider:  
Max Download Category  Count  % of Blocks Max Upload Category  Count % of Blocks

7  1  100% 7  1 100%
 
Typical down/upload speeds reported by provider: 
Typical Download Category  Count  % of Blocks Typical Upload Category  Count % of Blocks
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7  1  100% 7  1 100%
 
Typical down/upload speed from 2010 computer based speed test: N/A 
 
Speed tests match reported typical download speeds or are within 1 speed tier: N/A 
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted):  N/A 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: N/A 
Number of tracts reported to FCC, but no census blocks reported to project: N/A 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 0 
Total number of dead zones reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with dead zones reported via mdbroadbandmap.org: 0 
Total number of dead zones reported per provider via mdbroadbandmap.org: 0 
 
Web Search Verification: N/A 
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New Edge Holding Company 
DBA Name: New Edge Network, Inc 
 
Data Characteristics 
Date of Original Submission:              1/22/2010 
Date of Update Submission:              8/31/2011 
Currency of Data:                7/1/2011 
FRN:                     0003720471 
Type of data submitted:               Address Table 
Census Block Count:                             275   
Total Matched Address Points Count:          371 
Unmatched Address Points:              0 
Number of Technology of Transmission Types:        3 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           Complete 
Provided Max Typical Upload Speed:           Complete 
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Address Table Process: 

• Geocode address table to ESRI address locator 
o Number matched: 335 
o Number unmatched: 2 

• Unmatched address are geocoded to MDPV address locator 
o Number matched: 1 
o Number unmatched: 1 

• Unmatched address are geocoded to Maryland street centerline address locator 
o Number matched: 1 
o Number unmatched: 1 

• Merge matched addresses 
• Spatially join address points to 2000 census blocks 
• Separate and export the address points according to technology of transmission Select 

by location the address points that are completely within a greater than two square mile 
census block 

o Export as address points to be loaded into the NTIA data model 
 Result: BB_Service_Address 

o Switch the selection and export as points to create census blocks 
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Census Block Process: 
• Join the switched selection (BB_Service_Address) address points to the 2000 census 

blocks based on the BLK2000 field  
o Export results (for each technology of transmission) 
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census Blocks 
Max Download Category  Count  % of Blocks   Max Upload Category  Count  % of Blocks

3  58  19% 2  167  56%
4  216  72% 3  83  28%
5  20  7% 4  47  16%
6  3  1% 7  1  0%
7  1  0%

 
Typical down/upload speeds reported by provider: 
Census Blocks 
Typical Download Category  Count  % of Blocks Typical Upload Category  Count  % of Blocks

3  58  19% 2  167  56%
4  216  72% 3  83  28%
5  20  7% 4  47  16%
6  3  1% 7  1  0%
7  1  0%

  
Typical down/upload speed from 2010 computer based speed test: N/A 
 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted):  N/A 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 74 
Number of tracts reported to FCC, but no census blocks reported to project: 39 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 0 
Total number of dead zones reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with dead zones reported via mdbroadbandmap.org: 0 
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Total number of dead zones reported per provider via mdbroadbandmap.org: 0 
 
Web Search Verification: N/A 
 
Census blocks that are outside DSL boundary:  45/275 (16%) 
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One Communications 
DBA: One Communications 
 
Data Characteristics 
 
Date of Original Submission:              3/8/2011 
Date of Update Submission:              9/1/2011 
Currency of Data:                6/30/2011 
FRN:                     0015337702 
Type of data submitted:               Address Table 
Census Block Count:                            148     
Total Matched Address Points Count:          161 
Unmatched Address Points:              8 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           No 
Provided Max Typical Upload Speed:           No 
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Address Table Process: 

• Geocode address table to ESRI US Streets address locator 
o Number matched: 156 
o Number unmatched: 13 

• Unmatched addresses are geocoded to Maryland Property View address locator 
o Number matched: 4 
o Number unmatched: 9 

• Unmatched addresses are geocoded to Maryland centerline address locator 
o Number matched: 1 
o Number unmatched: 8 

• Spatially join address points to 2010 census blocks 
Census Block Process: 

• Join the switched address points to the 2000 census blocks based on the GEOID10 field  
o Export results  
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
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Data Verification 
Maximum down/upload speeds reported by provider:  
Census Blocks 
Max Download Category  Count  % of Blocks Max Upload Category Count  % of Blocks

4  94  64% 4  94  64%
5  45  30% 5  45  30%
6  7  5% 6  7  5%
7  2  1% 7  2  1%

 
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 computer based speed test:  

Speed Test Download Tier  Count 
% of 
Tests  

Speed Test Upload 
Tier Count 

% of 
Tests 

0  1  17% 3 3  50%
3  2  33% 4 1  17%
4  1  17% 5 1  17%
7  1  17% 6 1  17%
8  1  17%

 
Speed tests match reported typical download speeds or are within 1 speed tier: N/A 
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted): 6/148 (4%) 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: N/A 
Number of tracts reported to FCC, but no census blocks reported to project: N/A 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 0 
Total number of dead zones reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with dead zones reported via mdbroadbandmap.org: 0 
Total number of dead zones reported per provider via mdbroadbandmap.org: 0 
 
Web Search Verification: N/A 
  
Census blocks that are outside DSL boundary:  33/148 (22%) 
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PAETEC Communications, Inc. 
DBA Name: PAETEC Communications, Inc. 
 
Data Characteristics 
 
Date of Original Submission:              2/28/2011 
Date of Update Submission:              2/28/2011 
Currency of Data:                12/31/2011 
FRN:                     0011017795 
Type of data submitted:               Address Table 
Census Block Count:                            301     
Total Matched Address Points Count:          373 
Unmatched Address Points:              4 
Number of Technology of Transmission Types:        2 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           Complete 
Provided Max Typical Upload Speed:           Complete 
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Address Table Process: 

• Geocode address table to ESRI US Streets address locator 
o Number matched: 359 
o Number unmatched: 18 

• Unmatched address are geocoded to Maryland Property View address locator 
o Number matched: 9 
o Number unmatched: 9 

• Unmatched address are geocoded to Maryland centerline address locator 
o Number matched: 5 
o Number unmatched: 4  

• Merge matched addresses 
• Spatially join address points to 2010 census blocks 
• Separate and export the address points according to technology of tranmission 

Census Block Process: 
• Join the address points to the 2010 census blocks based on the GEOID10 field  

o Export results  
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
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Data Modification: 
• 52 blocks with Technology of Transmission 30 exceed Maximum Advertised Down and 

Maximum Advertised Up speed domain (delivered as tier 11) 
o Changed to speed tier 8 to fit domain 

 
Data Verification 
Maximum down/upload speeds reported by provider:  
Census Blocks 
Max Download Category  Count  % of Blocks Max Upload Category Count  % of Blocks

11  315  100% 11  315  100%
 
Typical down/upload speeds reported by provider:  
Census Blocks 
Typical Download Category  Count  % of Blocks Typical Upload Category  Count  % of Blocks

3  92  29% 3  92  29%
4  223  71% 4  223  71%

 
Typical down/upload speed from 2010 computer based speed test:  
Speed Test Download Tier  Count  % of Tests   Speed Test Upload Tier Count  % of Tests

0  3  7% 2  6  14%
3  21  49% 3  20  47%
4  11  26% 4  9  21%
5  5  12% 5  6  14%
8  3  7% 6  1  2%

7  1  2%
 
Speed tests match reported typical download speeds or are within 1 speed tier:  Yes 
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted): 20/301 (7%) 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 17 
Number of tracts reported to FCC, but no census blocks reported to project: 74 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 0 
Total number of dead zones reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with dead zones reported via mdbroadbandmap.org: 0 
Total number of dead zones reported per provider via mdbroadbandmap.org: 0 
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Web Search Verification: N/A 
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QCOL, Inc. 
DBA Name: QCOL 
 
Data Characteristics 
 
Date of Original Submission:              5/31/2010 
Date of Update Submission:              2/28/2011 
Currency of Data:                12/31/2010 
FRN:                     0019663095 
Type of data submitted:               Census Block Table, 
                    Road Segments 
Census Block Count:                             308     
Total Matched Address Points Count:          N/A 
Unmatched Address Points:              N/A 
Number of Technology of Transmission Types:        2 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           No  
Provided Max Typical Upload Speed:           No  
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  Yes 
 
Data Processing 
 
Census Block Process: 

• Join the census block table to the 2010 census blocks based on the BLK2000 field  
o Export results for each technology of transmission 
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
Road Segment Process: 

• Road segments are 2009 geometry 
• Join road segments to TigerLine by TLID 

o Export results 
o Load exported results into the NTIA data model 

 Result: BB_Service_RoadSegment 
 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census Blocks 
Max Download Category  Count  % of Blocks Max Upload Category  Count  % of Blocks

10  205  55% 10  205  55%
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6  167  45% 6  167  45%

Road Segments 
Max Download Category  Count  % of Segments Max Upload Category  Count  % of Segments

10  27  56% 10  27  56%
6  21  44% 6  21  44%

Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 computer based speed test:  
Speed Test Download Tier  Count  % of Tests   Speed Test Upload Tier Count  % of Tests

4  1  25% 2  1  25%
5  2  50% 3  2  50%
6  1  25% 5  1  25%

 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted):  1/308 (< 1%) 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: N/A 
Number of tracts reported to FCC, but no census blocks reported to project: N/A 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 2 
Total number of dead zones reported per provider via broadband.maryland.gov: 2 
 
Number of census blocks with dead zones reported via mdbroadbandmap.org: 0 
Total number of dead zones reported per provider via mdbroadbandmap.org: 0 
 
Web Search Verification: N/A 
 
Census blocks that are outside providers own Cable Franchise Boundary:  N/A 
  
Census blocks that fall within another provider’s Cable Franchise Boundary:  272/308 (88%) 
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Shenandoah Telecommunications 
DBA: Shentel Converged Services, Inc 
 
Data Characteristics 
 
Date of Original Submission:              5/31/2010 
Date of Update Submission:              8/19/2011 
Currency of Data:                7/31/2011 
FRN:                     0013962170 
Type of data submitted:               Census Blocks, 
                    Road Segments 
Census Block Count:                             582     
Total Matched Address Points Count:          N/A 
Unmatched Address Points:              N/A 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           No  
Provided Max Typical Upload Speed:           No  
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Census Block Process: 

• Join the census block table to the 2010 census blocks based on the GEOID10 field  
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census Blocks 
Max Download Category  Count  % of Blocks Max Upload Category Count  % of Blocks

6  582  100% 2 582  100%
 
Typical down/upload speeds reported by provider: N/A 
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Typical down/upload speed from 2010 computer based speed test:  
Speed Test Download Tier  Count  % of Tests Speed Test Upload Tier Count  % of Tests

0  1  2% 1  2  4%
3  1  2% 2  9  18%
4  7  14% 3  18  35%
5  13  25% 4  22  43%
7  3  6%
8  6  12%
9  9  18%

10  11  22%
 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted):  6/582 (1%) 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 582 
Number of tracts reported to FCC, but no census blocks reported to project: 1 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 0 
Total number of dead zones reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with dead zones reported via mdbroadbandmap.org: 0 
Total number of dead zones reported per provider via mdbroadbandmap.org: 0 
 
Web Search Verification: N/A 
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Sprint Nextel Corporation 
DBA Name: Sprint Nextel Corporation 
 
Data Characteristics 
 
Date of Original Submission:              2/18/2010 
Date of Update Submission:              8/30/2011 
Currency of Data:                6/30/2011 
FRN:                     0003774593 
Type of data submitted:               Coverage Area 
Census Block Count:                            N/A     
Total Matched Address Points Count:          N/A 
Unmatched Address Points:              N/A 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           Complete 
Provided Max Typical Upload Speed:           Complete 
Provided Middle Mile:               Yes 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Coverage Area Process: 

• Repair Geometry on delivered coverage area 
• Remove coverage areas less than 0.125 square miles 
• Remove coverage area “holes” less than 0.125 square miles 
• Load coverage area into the NTIA data model 

o Result: BB_Service_Wireless 
 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Coverage Area 
Max Download Category  Count  % of Area Max Upload Category Count  % of Area

3  1  100% 2  1  100%
5  1  100% 3  1  100%

 
Typical down/upload speeds reported by provider:  
Coverage Area 
Typical Download Category  Count  % of Area Typical Upload Category  Count  % of Area

3  1  100% 2  1  100%



Maryland Broadband Mapping Initiative:  Verification/Validation Report 

September 30, 2011 
 

Salisbury University    www.mdbroadbandmap.org  
112 

 
   

5  1  100% 3  1  100%
Typical down/upload speed from 2010 mobile speed test: 
Speed Test Download Tier  Count  % of Tests Speed Test Upload Tier  Count  % of Tests

0  3252  44% 1  1863  25%
3  1339  18% 2  3323  45%
4  1332  18% 3  2025  27%
5  1311  18% 4  95  1%
6  145  2% 5  48  1%
7  28  0% 6  8  0%

7  21  0%
8  24  0%

  
Speed tests match reported typical download speeds or are within 1 speed tier:  No 
 
#/% of mobile speed tests verifying coverage area:  
Number of mobile speed tests reported inside coverage area: 7217/7407 (97.4%) 
Number of mobile speed tests reported outside coverage area: 190/7407 (2.6%) 
 
Typical down/upload speed from 2010 computer based speed test: 
Speed Test Download Tier  Count  % of Tests Speed Test Upload Tier Count  % of Tests

0  342  57% 1  206  35%
3  229  38% 2  376  63%
4  18  3% 3  9  2%
5  4  1% 4  1  0%
6  2  0% 5  2  0%

6  1  0%
  
Speed tests match reported typical download speeds or are within 1 speed tier: No 
 
#/% of computer based speed tests verifying coverage area: 
Number of computer based speed tests reported inside coverage area: 581/595 (97.6%) 
Number of computer based speed tests reported outside coverage area: 14/595 (2.4%) 
 
Form 477Verification: 
#/% of tracts reported as served to FCC that overlaps with coverage area: 71/71 
#/% of tracts reported as served to FCC but do not intersect coverage area: 0/71 
 
Dead zones: 
Number of dead zones reported within coverage area via broadband.maryland.gov:  
187/240 (78%) 
Number of dead zones reported within coverage area via mdbroadbandmap.org: 
108/147 (73.5%) 
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Web Search Verification: N/A 
 
Wireless Verification:  
Sprint Wireless Verification Table ‐ 3G Count  Percentage
Total # of sample points 1486    
Number of sample points within coverage area 977    
Total number of sample points with results 975    
Verified served AND within reported coverage area   (yes,yes) 714    
Verified served AND found outside reported coverage area  (yes,no) 261  26.8%
Verified unserved AND found within reported coverage area   (no,yes) 263  26.9%
Verified unserved AND found outside reported coverage area  (no,no) 248    
Total error  524  35.3%

Sprint Wireless Verification Table ‐ 4G Count  Percentage
Total # of sample points 1486    
Number of sample points with expected 4G results 136    
Total number of sample points with 4G results 16    
Verified 4G AND within reported coverage area   (yes,yes) 10    
Verified 4G AND found outside reported coverage area  (yes,no) 6  37.5%
Verified not 4G AND found within reported coverage area   (no,yes) 126  92.6%
Verified not 4G AND found outside reported coverage area  (no,no) 1344    
Total error  132  8.9%
*4G service defined as average down speed of > 2000 bps
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StarBand Communications Inc. 
DBA Name: StarBand Communications Inc. 
 
Data Characteristics 
Date of Original Submission:              1/26/2010 
Date of Update Submission:              7/12/2011 
Currency of Data:                6/30/2011 
FRN:                     0005087457 
Type of data submitted:               Coverage 
Census Block Count:                             N/A     
Total Matched Address Points Count:          N/A 
Unmatched Address Points:              N/A 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           Complete 
Provided Max Typical Upload Speed:           Complete 
Provided Middle Mile:               Yes 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
Coverage Area Process: 

• Repair Geometry on delivered coverage area 
• Perform Topology on coverage area 

o Rule: Coverage area should not overlap 
o Load coverage area into the NTIA data model 

 Result: BB_Service_Wireless 
Speed Domains: 

• Typical Upstream speed < 2 
o Calculated Typical Upstream speed to 2 

 
Data Verification 
Maximum down/upload speeds reported by provider:  
Coverage Area 
Max Download Category  Count  % of Area Max Upload Category Count  % of Area

3  1  100% 2  1  100%
 
Typical down/upload speeds reported by provider: 
Coverage Area 
Typical Download Category  Count % of Area Typical Upload Category  Count  % of Area

3  1 100% 2  1  100%
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Typical down/upload speed from 2010 mobile speed test: N/A 
 
Speed tests match reported typical speeds or are within 1 speed tier:  N/A 
 
# of mobile speed tests verifying coverage area:  
Number of mobile speed tests reported inside coverage area: N/A 
Number of mobile speed tests reported outside coverage area: N/A 
 
Form 477Verification: 
#/% of tracts reported as served to FCC that overlaps with coverage area: 34/34 (100.0%) 
#/% of tracts reported as served to FCC but do not intersect coverage area: 0/34 (0%) 
 
Dead zones: 
Number of dead zones reported within coverage area via broadband.maryland.gov:  
237/240 (98.75) 
Number of dead zones reported within coverage area via broadband.maryland.gov:  
147/147 (100.0%) 
 
Web Search Verification: N/A 
 
Wireless Verification: N/A 
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Starpower Communications, LLC 
DBA Name: RCN & RCN Business Solutions 
 
Data Characteristics 
 
Date of Original Submission:              3/5/2010 
Date of Update Submission:              9/8/2011 
Currency of Data:                6/30/2011 
FRN:                     0003735016 
Type of data submitted:               Address Table 
Census Block Count:                            1381     
Total Matched Address Points Count:          6986 
Unmatched Address Points:              76 
Number of Technology of Transmission Types:        2 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           Complete 
Provided Max Typical Upload Speed:           Complete 
Provided Middle Mile:               Yes 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Address Table Process: 

• Geocode address table to ESRI US Streets address locator 
o Number matched: 6958 
o Number unmatched: 77 

• Unmatched address are geocoded to Maryland street centerline address locator 
o Number matched: 1 
o Number unmatched: 76 

• Merge matched addresses 
• Spatially join address points to 2010 census blocks 

Census Block Process: 
• Join the address points to the 2010 census blocks based on the GEOID10 field  

o Export results  
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
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Data Verification 
Maximum down/upload speeds reported by provider:  
Census Blocks 
Max Download Category  Count  % of Blocks Max Upload Category  Count  % of Blocks

4  3  0% 2  161  12%
5  158  11% 3  15  1%
6  1  0% 4  1196  86%
7  804  58% 5  8  1%
8  414  30% 6  2  0%
9  3  0% 7  1  0%

 
Typical down/upload speeds reported by provider:  
Census Blocks 
Typical Download Category  Count  % of Blocks Typical Upload Category  Count  % of Blocks

4  3  0% 2  161  12%
5  158  11% 3  15  1%
6  1  0% 4  1196  86%
7  804  58% 5  8  1%
8  414  30% 6  2  0%
9  3  0% 7  1  0%

 
Typical down/upload speed from 2010 computer based speed test:  
Speed Test Download Tier  Count  % of Tests   Speed Test Upload Tier Count  % of Tests

0  13  8%   1  3  2%
4  12  7%   2  104  63%
5  36  22%   3  7  4%
6  43  26%   4  44  27%
7  59  36%   5  7  4%
8  1  1%  

10  1  1%  
 
Speed tests match reported typical download speeds or are within 1 speed tier:  Yes 
 
Error reported as proportion of total blocks submitted:  6/1381 (< 1%) 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 2 
Number of tracts reported to FCC, but no census blocks reported to project: 4 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 1 
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Total number of dead zones reported per provider via broadband.maryland.gov: 2 
 
Number of census blocks with dead zones reported via mdbroadbandmap.org: 0 
Total number of dead zones reported per provider via mdbroadbandmap.org: 0 
 
Web Search Verification: 4/1381 (0.3%) of census blocks were confirmed using online search 
feature of given provider 
Starpower WebSearch Verification Table Count Percentage 
Total # of sample points 1496  
Number of sample points with results  55 4% 
Result is yes and census block is in served area  4 7% 
Result is yes but not in a census block reported as served    0 0% 
Result is no and census block is in served area 0 0% 
Result is no and census block not served area 51 93% 
 
Census blocks that are outside providers own Cable Franchise Boundary:  N/A 
  
Census blocks that fall within another provider’s Cable Franchise Boundary:  1379/1381 (99%) 
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Tata Communications (America) Inc. 
DBA Name:  Tata Communications (America) Inc. 
 
Data Characteristics 
 
Date of Original Submission:              2/1/2010 
Date of Update Submission:              9/9/2011 
Currency of Data:                6/30/2011 
FRN:                     0009480302 
Type of data submitted:               Address Table 
Census Block Count:                             1     
Total Matched Address Points Count:          1 
Unmatched Address Points:              0 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           No  
Provided Max Typical Upload Speed:           No  
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Address Table Process: 

• Geocode address table to ESRI US Streets address locator 
o Number matched: 1 
o Number unmatched: 0 

• Spatially join address points to 2010 census blocks 
Census Block Process: 

• Join the address points to the 2000 census blocks based on the GEOID10 field  
o Export results  
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census Blocks 
Max Download Category  Count  % of Blocks Max Upload Category Count  % of Blocks

4  1  100% 4 1  100%
 
Typical down/upload speeds reported by provider: N/A 
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Typical down/upload speed from 2010 computer based speed test:  
Speed Test Download Tier  Count  % of Tests Speed Test Upload Tier Count  % of Tests

0  1  100% 2  1  100%
 
Speed tests match reported typical downloaded speeds or are within 1 speed tier:  N/A 
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted): 1/1 (100%) 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 0 
Number of tracts reported to FCC, but no census blocks reported to project: 0 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 0 
Total number of dead zones reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with dead zones reported via mdbroadbandmap.org: 0 
Total number of dead zones reported per provider via mdbroadbandmap.org: 0 
 
Web Search Verification: N/A 
 
Census blocks that are outside DSL boundary:  0/1 (0%) 
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T‐Mobile USA, Inc. 
DBA Name: T‐Mobile USA, Inc. 
 
Data Characteristics 
 
Date of Original Submission:              2/25/2010 
Date of Update Submission:              8/24/2011 
Currency of Data:                6/30/2011 
FRN:                     0006945950 
Type of data submitted:               Coverage Area 
Census Block Count:                             N/A     
Total Matched Address Points Count:          N/A 
Unmatched Address Points:              N/A 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           No 
Provided Max Typical Upload Speed:           No 
Provided Middle Mile:               Yes 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Coverage Area Process: 

• Repair Geometry on delivered coverage area 
• Remove coverage areas less than 0.125 square miles 
• Remove coverage area “holes” less than 0.125 square miles 
• Load coverage area into the NTIA data model 

o Result: BB_Service_Wireless 
 
Data Verification 
Maximum down/upload speeds reported by provider:  
Coverage Area 
Max Download Category  Count  % of Area Max Upload Category Count  % of Area

4  1  100% 2  1  100%
6  1  100% 4  2  100%
7  1  100%

 
Typical down/upload speeds reported by provider: N/A 
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Typical down/upload speed from 2010 mobile speed test:  
Speed Test Download Tier  Count  % of Tests Speed Test Upload Tier  Count  % of Tests

0  3019  36% 1  1229  15%
3  1599  19% 2  3597  43%
4  2034  24% 3  2538  31%
5  1466  18% 4  848  10%
6  156  2% 5  51  1%
7  31  0% 6  15  0%

7  20  0%
8  7  0%

 
Speed tests match reported typical speeds or are within 1 speed tier:  No 
 
#/% of computer based speed tests verifying coverage area:  
Number of mobile speed tests reported inside coverage area: 8138/8305 (98%) 
Number of mobile speed tests reported outside coverage area: 167/8305 (2%) 
 
Form477 Verification: 
#/% of tracts reported as served to FCC that overlaps with coverage area: N/A 
#/% of tracts reported as served to FCC but do not intersect coverage area: N/A 
 
Dead zones: 
Number of dead zones reported within coverage area via broadband.maryland.gov:  
121/240 (50.4%) 
Number of dead zones reported within coverage area via mdbroadbandmap.org:  
42/147 (28.6%) 
 
Web Search Verification: N/A 
 
Wireless Verification:  
 
TMobile Wireless Verification Table ‐ 3G Count  Percentage
Total # of sample points 1486    
Number of sample points within coverage area 560    
Total number of sample points with results 1334    
Verified served AND within reported coverage area   (yes,yes) 485    
Verified served AND found outside reported coverage area  (yes,no) 849  63.6%
Verified unserved AND found within reported coverage area   (no,yes) 75  13.4%
Verified unserved AND found outside reported coverage area  (no,no) 77    
Total error  924  62.2%
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TMobile Wireless Verification Table ‐ 4G (Speed 6‐10) Count  Percentage
Total # of sample points 1486    
Number of sample points with expected 4G results 402    
Total number of sample points with 4G results 120    
Verified 4G AND within reported coverage area   (yes,yes) 116    
Verified 4G AND found outside reported coverage area  (yes,no) 4  3.3%
Verified not 4G AND found within reported coverage area   (no,yes) 286  71.1%
Verified not 4G AND found outside reported coverage area  (no,no) 1080    
Total error  290  19.5%
*4G service defined as average down speed of > 2000 bps

TMobile Wireless Verification Table ‐ 4G (Speed 10‐25) Count  Percentage
Total # of sample points 1486    
Number of sample points with expected 4G results 382    
Total number of sample points with 4G results 120    
Verified 4G AND within reported coverage area   (yes,yes) 111    
Verified 4G AND found outside reported coverage area  (yes,no) 9  7.5%
Verified not 4G AND found within reported coverage area   (no,yes) 271  70.9%
Verified not 4G AND found outside reported coverage area  (no,no) 1095    
Total error  280  18.8%
*4G service defined as average down speed of > 2000 bps
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TWTelecom of Maryland, LLC 
DBA Name:  TWTelecom of Maryland, LLC 
 
Data Characteristics 
 
Date of Original Submission:              1/30/2010 
Date of Update Submission:              9/2/2011 
Currency of Data:                6/30/2011 
FRN:                     0017348202 
Type of data submitted:               Address table 
Census Block Count:                             55     
Total Matched Address Points Count:          69 
Unmatched Address Points:              0 
Number of Technology of Transmission Types:        2 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           No  
Provided Max Typical Upload Speed:           No  
Provided Middle Mile:               Yes 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Address Table Process: 

• Geocode address table to ESRI US Streets address locator 
o Number matched: 67 
o Number unmatched: 2 

• Unmatched address are geocoded to Maryland Property View address locator 
o Number matched: 2 
o Number unmatched: 0 

• Merge matched addresses 
• Spatially join address points to 2010 census blocks 
• Separate and export the address points according to technology of transmission  

Census Block Process: 
• Join the address points to the 2010 census blocks based on the GEOID10 field  

o Export results for each technology of transmission 
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
Data Modification: 

• Removed 26 records from provider data – do not meet broadband speeds 
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Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census Blocks 
Max Download Category  Count  % of Blocks Max Upload Category Count  % of Blocks

3  13  22% 3 13  22%
4  16  28% 4 16  28%
5  5  9% 5 5  9%
6  3  5% 6 3  5%
7  9  16% 7 9  16%
8  4  7% 8 4  7%
9  2  3% 9 2  3%

10  3  5% 10 3  5%
11  3  5% 11 3  5%

 
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 computer based speed test:  
Speed Test Download Tier  Count  % of Tests Speed Test Upload Tier Count  % of Tests

0  6  40% 1  5  33%
3  1  7% 2  1  7%
4  3  20% 3  1  7%
5  3  20% 4  3  20%
7  2  13% 5  5  33%

 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted): 6/55 (11%) 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 13 
Number of tracts reported to FCC, but no census blocks reported to project: 11 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 0 
Total number of dead zones reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with dead zones reported via mdbroadbandmap.org: 0 
Total number of dead zones reported per provider via mdbroadbandmap.org: 0 
 
Web Search Verification: N/A 
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Vector Data Systems LLC 
DBA Name: Vector Data Systems LLC 
 
Data Characteristics 
Date of Original Submission:              February 2010 
Date of Update Submission:              8/30/2011 
Currency of Data:                6/30/2011 
FRN:                     0017306663 
Type of data submitted:               Coverage Area 
Census Block Count:                             N/A     
Total Matched Address Points Count:          N/A 
Unmatched Address Points:              N/A 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           Complete 
Provided Max Typical Upload Speed:           Complete 
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
Coverage Area Process: 

• Repair Geometry on delivered coverage area 
• Remove coverage areas less than 0.125 square miles 
• Remove coverage area “holes” less than 0.125 square miles 
• Load coverage area into the NTIA data model 

o Result: BB_Service_Wireless 
 
Data Verification 
Maximum down/upload speeds reported by provider:  
Coverage Area 
Max Download Category  Count  % of Area Max Upload Category Count  % of Area

5  1  100% 5  1  100%
 
Typical down/upload speeds reported by provider: 
Coverage Area 
Typical Download Category  Count  % of Area Typical Upload Category  Count  % of Area

5  1  100% 4  1  100%
  
Typical down/upload speed from 2010 mobile speed test: N/A 
 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
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#/% of mobile speed tests verifying coverage area:  
Number of mobile speed tests reported inside coverage area: N/A 
Number of mobile speed tests reported outside coverage area: N/A 
 
Form 477Verification: 
#/% of tracts reported as served to FCC that overlaps with coverage area: 5/5 (100.0%) 
#/% of tracts reported as served to FCC but do not intersect coverage area: 0/5 (0%) 
 
Dead zones: 
Number of dead zones reported within coverage area via broadband.maryland.gov:  
4/240 (1.7%) 
Number of dead zones reported within coverage area via mdbroadbandmap.org:  
0/147 (0%) 
 
Web Search Verification: N/A 
 
Wireless Verification: N/A 
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Verizon Communications Inc 
DBA:  Verizon Maryland Inc 
 
Data Characteristics 
Date of Original Submission:              2/15/2010 
Date of Update Submission:              9/2/2011 
Currency of Data:                6/30/2011 
FRN:                     0002166825 
Type of data submitted:               Census Block Table, 
                    Road Segments 
Census Block Count:                             76768     
Total Matched Address Points Count:          N/A 
Unmatched Address Points:              N/A 
Number of Technology of Transmission Types:        2 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           No  
Provided Max Typical Upload Speed:           No  
Provided Middle Mile:               Yes 
Provided Road Segments for census blocks greater than 2 sq miles:  Yes 
 
Data Processing 
 
Census Block Process: 

• Join the census block table to 2010 census blocks based on the GEOID10 field  
o Export results for each technology of transmission 
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
Road Segment Process: 

• Join road segments to TigerLine by TLID 
o Export results 
o Load exported results into the NTIA data model 

 Result: BB_Service_RoadSegment 
Data Modification: 

• 5 blocks with Technology of Transmission 10 exceed Maximum Advertised Download 
speed 

o Changed to speed tier 8 
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Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census Blocks 
Max Download Category  Count  % of Blocks Max Upload Category  Count  % of Blocks

4  12188  13% 2  12188  13%
5  37049  39% 3  49557  53%
6  12508  13% 7  32281  34%
9  32281  34%

Road Segments 
Max Download Category  Count  % of Segments Max Upload Category  Count  % of Segments

4  1275  32% 2  1275  32%
5  1544  39% 3  1655  41%
6  111  3% 7  1069  27%
9  1069  27%

 
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 computer based speed test:  
Speed Test Download Tier  Count  % of Tests Speed Test Upload Tier Count  % of Tests

0  571  8% 1  589  8%
3  526  8% 2  2060  30%
4  1364  20% 3  56  1%
5  391  6% 4  882  13%
6  692  10% 5  1437  21%
7  2199  32% 6  624  9%
8  1130  16% 7  1186  17%
9  37  1% 8  96  1%

10  21  0% 9  1  0%
 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted): 30/76768 (< 1%) 
 
Form 477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 4229 
Number of tracts reported to FCC, but no census blocks reported to project: 0 
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Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 104 
Total number of dead zones reported per provider via broadband.maryland.gov: 129 
 
Number of census blocks with dead zones reported via mdbroadbandmap.org: 63 
Total number of dead zones reported per provider via mdbroadbandmap.org: 76 
 
Web Search Verification: 479/76768 (1%) of census blocks were confirmed using online search 
feature of given provider 
VerizonMD WebSearch Verification Table Count Percentage 
Total # of sample points 1496  
Number of sample points with results  1435 96% 
Result is yes and census block is in served area  479 33% 
Result is yes but not in a census block reported as served    39 3% 
Result is no and census block is in served area 513 36% 
Result is no and census block not served area 402 28% 
 
Census blocks that are outside DSL boundary:  20257/76768 (26 %) 
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Wildblue Communications, Inc 
DBA Name: Wildblue Communications, Inc 
 
Data Characteristics 
 
Date of Original Submission:              4/21/2010 
Date of Update Submission:              7/20/2011 
Currency of Data:                6/30/2011 
FRN:                     0007843766 
Type of data submitted:               Coverage Area 
Census Block Count:                             N/A     
Total Matched Address Points Count:          N/A 
Unmatched Address Points:              N/A 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           Complete 
Provided Max Typical Upload Speed:           Complete 
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
Coverage Area Process: 

• Repair Geometry on delivered coverage area 
• Perform Topology on coverage area 

o Rule: Coverage area should not overlap 
o Load coverage area into the NTIA data model 

 Result: BB_Service_Wireless 
Data Modification: 

• Typical Downstream Speed < 3   
o Calculated Typical Downstream Speed to 3 

• Typical Upstream Speed < 2 
o Calculated Typical Upstream Speed to 2 

 
Data Verification 
Maximum down/upload speeds reported by provider:  
Coverage Area 
Max Download Category  Count  % of Area Max Upload Category Count  % of Area

4  1  100% 2  1  100%
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Typical down/upload speeds reported by provider: 
Coverage Area 
Typical Download Category  Count % of Area Typical Upload Category  Count  % of Area

3  1 100% 2  1  100%
 
Typical down/upload speed from 2010 mobile speed test:  
Speed Test Download Tier  Count  % of Tests Speed Test Upload Tier  Count  % of Tests

0  4  50% 1  8  100%
3  4  50%

 
Speed tests match reported typical download speeds or are within 1 speed tier:  Yes 
 
#/% of mobile speed tests verifying coverage area:  
Number of mobile speed tests reported inside coverage area: 8/8 (100%) 
Number of mobile speed tests reported outside coverage area: 0/0 (0%) 
 
Typical down/upload speed from 2010 computer based speed test: 
Speed Test Download Tier  Count  % of Tests Speed Test Upload Tier Count  % of Tests

0  31  60% 1  52  100%
3  14  27%
4  7  13%

  
Speed tests match reported typical download speeds or are within 1 speed tier:   No 
 
#/% of computer based speed tests verifying coverage area:  
Number of mobile speed tests reported inside coverage area: 52/52 (100%) 
Number of mobile speed tests reported outside coverage area: 0/52 (0%) 
 
Form 477Verification: 
#/% of tracts reported as served to FCC that overlaps with coverage area: 214/214 (100%) 
#/% of tracts reported as served to FCC but do not intersect coverage area: 0/214 (0%) 
 
Dead zones: 
Number of dead zones reported within coverage area via broadband.maryland.gov:  
237/240 (98.5%) 
Number of dead zones reported within coverage area via mdbroadbandmap.org:  
147/147 (100%) 
 
Web Search Verification: N/A 
 
Wireless Verification: N/A 
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XO Holdings, Inc 
DBA Name: XO Communications, LLC       
 
Data Characteristics 
 
Date of Original Submission:              2/1/2010 
Date of Update Submission:              9/9/2011 
Currency of Data:                6/30/2011 
FRN:                     0006275945 
Type of data submitted:               Address Table 
Census Block Count:                             322     
Total Matched Address Points Count:          354 
Unmatched Address Points:              0 
Number of Technology of Transmission Types:        3 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           No  
Provided Max Typical Upload Speed:           No  
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Address Table Process: 

• Geocode address table to ESRI US Streets address locator 
o Number matched: 354 
o Number unmatched: 0 

• Spatially join address points to 2010 census blocks 
• Separate and export the address points according to technology of transmission  

Census Block Process: 
• Join the address points to the 2010 census blocks based on the GEOID10 field  

o Export results for each technology of transmission 
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
Data Modification: 

• 27 addresses do not meet broadband speeds – dropped from submission 
• 3 blocks with Technology of Transmission 10 exceed domain speeds for Maximum 

Advertised Download and Maximum Advertised Upload 
o Changed to speed tier 8 
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Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census Blocks 
Max Download Category  Count  % of Blocks Max Upload Category Count  % of Blocks

3  30  9% 2 7  2%
4  193  60% 3 28  9%
5  48  15% 4 188  58%
6  13  4% 5 48  15%
7  29  9% 6 13  4%
8  7  2% 7 29  9%

10  3  1% 8 7  2%
10 3  1%

 
Typical down/upload speeds reported by provider:  N/A 
 
Typical down/upload speed from 2010 computer based speed test:  
Speed Test Download Tier  Count  % of Tests Speed Test Upload Tier Count  % of Tests

0  22  31% 1  2  3%
3  17  24% 2  26  37%
4  16  23% 3  20  29%
5  5  7% 4  6  9%
6  5  7% 5  7  10%
7  1  1% 6  3  4%
8  4  6% 7  6  9%

 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted): 36/322 (11%) 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 18 
Number of tracts reported to FCC, but no census blocks reported to project: 8 
 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 3 
Total number of dead zones reported per provider via broadband.maryland.gov: 3 
Number of census blocks with dead zones reported via mdbroadbandmap.org: 1 
Total number of dead zones reported per provider via mdbroadbandmap.org: 1 
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Web Search Verification: N/A 
 
Census blocks that are outside DSL boundary:  59/322 (18%) 
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Zayo Bandwidth LLC 
DBA Name: Zayo Bandwidth LLC 
 
Data Characteristics 
 
Date of Original Submission:              1/13/2011 
Date of Update Submission:              9/7/2011 
Currency of Data:                6/30/2011 
FRN:                     0019133826 
Type of data submitted:               Address Table 
Census Block Count:                             2     
Total Matched Address Points Count:          2 
Unmatched Address Points:              0 
Number of Technology of Transmission Types:        1 
Provided Max Advertised Download Speed:          Complete 
Provided Max Advertised Upload Speed:           Complete 
Provided Max Typical Download Speed:           Complete  
Provided Max Typical Upload Speed:           Complete  
Provided Middle Mile:               No 
Provided Road Segments for census blocks greater than 2 sq miles:  No 
 
Data Processing 
 
Address Table Process: 

• Geocode address table to ESRI US Streets address locator 
o Number matched: 2 
o Number unmatched: 0 

• Spatially join address points to 2010 census blocks 
Census Block Process: 

• Join the address points to the 2010 census blocks based on the GEOID10 field  
o Export results Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census Blocks 
Max Download Category  Count  % of Blocks Max Upload Category  Count  % of Blocks

7  1  50% 7  1  50%
8  1  50% 8  1  50%
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Typical down/upload speeds reported by provider:  
Census Blocks 
Typical Download Category  Count  % of Blocks Typical Upload Category  Count  % of Blocks

7  1  50% 7  1  50%
8  1  50% 8  1  50%

 
Typical down/upload speed from 2010 computer based speed test: N/A 
 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
Speed tests present within blocks not reported as served by provider (error reported as 
proportion of total blocks submitted):  N/A 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 2 
Number of tracts reported to FCC, but no census blocks reported to project: 1 
 
Dead zones: 
Number of census blocks with dead zones reported via broadband.maryland.gov: 0 
Total number of dead zones reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with dead zones reported via mdbroadbandmap.org: 0 
Total number of dead zones reported per provider via mdbroadbandmap.org: 0 
 
Web Search Verification: N/A  
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1 Introduction 
As an NTIA State Broadband Data and Development (SBDD) grant recipient, the State of 
Maine is undertaking a statewide project to inventory and map broadband services for 
inclusion in both national and state broadband maps.  The SBDD grantee project team for 
Maine consists of the ConnectME Authority (ConnectME), the Maine Office of GIS 
(MEGIS), and the James W. Sewall Company (Sewall).  The team is collecting broadband 
service availability data, including speeds and types of technology, as well as information on 
Community Anchor Institution (CAI) locations across the entire state.  The collected service 
data undergoes geospatial processing and verification steps before it is loaded into Maine’s 
broadband geodatabase.   This geodatabase is used to satisfy NTIA’s bi-annual submission 
requirements as well as support the ConnectME Authority’s statewide initiatives and 
programs. 
 
This whitepaper describes the deliverable datasets, the data collection process and the 
verification process. 
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2 Data Description 
The Maine team is providing spatial data representing provider coverage in the state as well 
as information on validation and verification processes.  Files provided are as follows: 
 
Filename Description 
ME_SBDD_2011_10_01.gdb Folder containing SBDD transfer file geodatabase 

ME_DataPackage_2011_10_01.xlsx DataPackage file 

ME_2011_10_01.txt Data Submission Receipt file 

ME_Methodology_2011_10_01.pdf Methodology Paper file 

ReadMe_ME_2011_10_01.txt ReadMe file 

ME_2011_10_01_Changes_and_Corrections.doc Document listing changes and corrections since April 2011 
submission to NTIA 

 

3 Provider Participation 
There were fifty-four potential providers identified in Maine, of which four were found not to 
serve any addresses in Maine and were therefore not included in this analysis. 
 
The Maine team has utilized data from 70% of the companies operating in the state and 
expects to receive data from another 6% in the future for a combined total of 76% 
cooperation.  Two firms (4%) would not provide data, and another 20% were simply not 
responsive to our attempts to communicate. 
 

Company Response Number 
% of Total 
Companies 

Provided data 35 70% 
Will provide data 3 6% 
Will not provide data 2 4% 
   
Non-responsive    10   20% 
 TOTAL 50 100% 

 
Of the thirty-five companies who have submitted data, thirty (86%) own the infrastructure 
used to provide internet services to residential and business customers, two (6%) resell 
internet service, one (3%) does both, and two (6%) provide middle mile and internet 
backhaul services only. 
 
Information on the providers is included on the ‘ProviderTable’ spreadsheet in the file 
datapackage.xls included as part of the submission to NTIA. 
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4 Data Collection and Integration 

4.1 Provider Outreach and Data Gathering 
Mapping broadband coverages across the State begins by identifying potential providers and 
contacting them to determine service capabilities and level of participation.  If a provider 
offers broadband level Internet service in Maine, the provider will be invited to participate in 
the project.  After executing a non-disclosure agreement (NDA), the provider submits data 
showing where services are offered, technology of transmission used, and maximum 
advertised downstream and upstream speeds.  The project team has developed a step by step 
process that has been captured by the high-level workflow shown in Figure 1.  Starting with 
contacting a service provider, the workflow allows a user to determine whether a provider 
should be included and if so what types of service are offered. 

 
Figure 1 - Provider Outreach and Data Gathering Workflow 
 
The task of reaching out to the provider community and gathering service data has five main 
tasks: Research Service Providers, Execute NDA, Gather Provider Data, Assess Provider 
Data, and Categorize Data for Production. 
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4.1.1 Research Service Providers 
The Maine project team has established a service provider contact database, which contains 
contact information for all of the potential broadband service providers in the state.  The 
initial set of providers was obtained from state and industry lists as well as Internet research.  
Ongoing management of the list is required because new providers begin offering services 
that qualify as broadband and changes occur to existing provider companies through mergers 
or acquisitions.   
 
Sewall initially contacts each provider by phone and introduces the project.  One purpose for 
the initial contact is to identify the individual at the provider company with whom the team 
should be working.  In some instances, especially for larger companies it may take multiple 
attempts before the appropriate person is reached. 
 
Another purpose is to determine if the company’s services meet the requirements for 
inclusion in the project.  If a company offers broadband level service in Maine then the next 
step is to determine the type(s) of service being offered, whether the service offerings are as 
an end-user provider or as a middle mile/back haul provider, and whether the company owns 
facilities or re-sells services using another carrier’s network.  Data from back haul carriers 
and resellers are included in the project. 
 
A third purpose behind the initial contact is to confirm that the provider wants to participate 
in project and is willing to submit data that represents its service offerings and coverages.  
Provider companies who elect to participate are invited to execute an NDA to protect those 
data items considered to be confidential or proprietary.  If a provider company does not want 
to participate, Sewall may look for assistance from the ConnectME Authority and the NTIA 
SBDD project team to encourage participation. 

4.1.2 Execute Non-Disclosure Agreement (NDA) 
The process of executing an NDA starts with sending a letter of introduction along with an 
NDA template and a copy of a ConnectME Protective Order.  Appendix A contains a sample 
letter.  The NDA template was drafted by the Maine law firm, Rudman & Winchell, based on 
confidentiality guidelines presented by NTIA and can be found in Appendix B.  A copy of 
the ConnectME Protective Order signed on 21 December 2009 at the request of many of the 
service providers is in Appendix C. 
 
Changes to the NDA template are negotiated with individual companies as needed.  Once 
finalized, the NDA is signed by the provider company, Sewall, and the ConnectME 
Authority before the data gathering process begins. 
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4.1.3 Gather Provider Data 
More often than not after an NDA has been executed, a different individual at a provider 
company is identified as the primary contact for data submittals.  Once the contact is 
confirmed, a data submittal information sheet prepared by the project team is sent to the 
contact.  The data submittal sheet identifies the data items desired and has definitions from 
the SBDD NOFA.  The items requested include: 

� FRN or provider FCC Registration Number 

� Location and extents of service coverage 

� Technology of service 

� Speeds of service including maximum advertised downstream & upstream speeds and 
typical downstream & upstream speeds 

� Tower and transmitter locations and transmission attributes (for fixed wireless 
service) 

� Middle mile and back haul connection points 

� Customer service locations (for wired and fixed wireless service) 

� Failed service locations (for wired and fixed wireless service) 

� Service to Community Anchor Institutions 
 
After sending the data submittal information Sewall follows up with the provider contact to 
review the requested data items and discuss potential formats for submitting data.  The team 
is cognizant of the wide range of environments operated by the provider companies and 
recognizes the need to accommodate submissions in many different formats including tabular 
(CSV, Excel, DBF), GIS (ESRI shapefile, ESRI geodatabase, MapInfo, Google KML/KMZ, 
CAD (AutoCAD, Microstation), and hardcopy.  The team also understands that many of the 
smaller providers in Maine are handicapped by a lack of resources in trying to comply with 
the project’s data submission requirements.  Some of the issues facing these providers 
include small staff sizes, lack of mapping technical expertise, and proprietary digital systems.  
Sewall lends technical assistance and expertise as needed. 
 
Sewall has deployed a web-based GeoPortal site to accommodate all digital data transfers 
related to the broadband mapping project.  Additional details pertaining to this site can be 
found in Section 5.6.1. 

4.1.4 Assess Provider Data 
After data has been submitted by a provider, Sewall catalogues it and assesses the data files 
to see if all of the requested items were provided and what data types were received.  Sewall 
also verifies the locations and spatial definitions for the data items and checks for missing 
attribute information. Any questions generated are sent to the provider for clarification.  It is 
common for the initial submission to need multiple iterations of data exchanges and feedback 
before the submission is completed. 
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Once an initial set of broadband service data is in place, follow-up rounds of data gathering 
will incorporate modifications to existing service coverages, service types, or service speeds.  
Later submittals by a provider could consist of an entire set of data records or may only 
contain updates since the previous submission.  Sewall’s integration processes are equipped 
with GIS and database tools to fold newer versions of provider records into the existing 
baseline.  The team anticipates that further development and refinement of these processes 
and tools will be made as more update submissions are received. 

4.1.5 Categorize Data for Production 
When data from a provider has been received and assessed, production processes are needed 
to integrate the data into the project database.  Section 4 of this paper describes the various 
workflows to turn the submitted data into the SBDD data transfer model features and 
attributes. 

4.2 Community Anchor Outreach and Data Gathering 
Community Anchor Institutions (CAI), as defined by NTIA NOFA category codes, consist of 
the following:  
 
Category 1: School – K through 12 
Category 2: Library 
Category 3: Medical/Healthcare 
Category 4: Public Safety 
Category 5: University, College, Other post secondary 
Category 6: Other community support – government 
Category 7: Other community support – non-governmental 
 
The three primary steps with the CAI are data gathering, data processing and attribution.   

4.2.1 Data Gathering 
Several data sources were utilized to represent all CAI categories across the state.  

State of Maine, Office of Geographic Information Sy stems (MEGIS)  
ARMORIES 
CEMA (County Emergency Management Agency) 
COLLEGES 
FIRE 
HOSPITAL 
HAS (Hospital Service Areas) 
MEAIR (Airports) 
POLICE 
REDCROSS 
RESCUE 
SCHLIB (Schools & Libraries) 

NAVTEQ-NAVSTREETS (Points of Interest) 
NAVTEQ-COMMSVC  
NAVTEQ-EDUINSTS 
NAVTEQ-HOSPITAL 
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NAVTEQ-TRANSHUBS 

State of Maine, Office of Information Technology – State Facilities 
State Facilities File  

Maine Department of Health & Human Services (DHHS) – Maine Care Services 
Hospitals 
Clinics/Rehab/Nursing 
Schools 
Pharmacies 
Home Care 
Counseling/Psychologists 
Shared Living 
Mental Health 
School Departments 
Health related businesses 

Maine School and Library Network (MSLN) 
K-12 schools 
Public libraries 

Maine’s Research & Education Network (MaineREN) 
Universities and colleges 

Service Provider Data 
CAI data submitted by provider companies 

4.2.2 Data Processing 
The data processing task involved an in-depth cleaning and sorting of all CAI source records.  
Data is initially sorted as spatial (e.g., GIS layer) and non-spatial (e.g., table) data. The 
spatial data consisted of points and generally needed minimal formatting before loading into 
a personal geodatabase.  The non-spatial data required some initial format revisions to 
prepare the data for geocoding to generate spatial geometry.  The following descriptions 
associated with Figure 2 below outline the overall workflow and processes involved.  
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Figure 2 - Community Anchor Internal Workflow 
 
(1) Data Gathering 
Data gathering involves acquiring source data involving the seven categories defined by 
NTIA NOFA.  Data may originate from several sources including state, county, town, 
outreach programs, service providers and more.  Records are documented for metadata and 
given a level of confidence reflecting the data source, spatial accuracy and processing 
enhancements. 
 
(2) Data Processing 
The data processing phase separates the data sources into two types: flat file (non-spatial) and 
spatial.  A flat file refers to data or a table that contains 1 record per line, generally in the 
format of an .xls spreadsheet or .dbf table.  Without spatial coordinate values to translate to 
points, this type of data must be geocoded in ArcGIS.  Spatial data contains pre-defined 
coordinate values or is already in a format containing spatial geometry with a defined 
projection and can be imported directly. 
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(3) Non-Spatial Data Source Formatting 
Non-spatial data files are scrubbed to ensure that all necessary fields are present and are 
formatted to run through the geocoding process.   
 
(3.1) Geocode Addresses/Load to Geodatabase 
Using the geocoding tool in ArcGIS, an address locator file must first be setup. The address 
locator file maps out the ConnectME street centerline fields and is used as a reference for the 
non-spatial data during the geocoding process.  The non-spatial data is saved as a .csv file.  
Shown below is a typical record formatted to geocode. 
 

Name Address1 City State Zip 
Healthworks 10 Bangor  Bangor ME 04401 

 
In this example, the geocoding process will reference or match this address record to the 
ConnectME street address locator and place a point at this location in the map layer. All 
records in the source file are processed at once.  Points are generated, based on how matching 
parameters or set.  Points are then loaded into personal geodatabase for final scrubbing and 
quality acceptance. 

Name Address1 City State Latitude Longitude 
Healthworks 10 Bangor St Bangor ME 46.1252 -67.8422 

 
(4) Spatial Data Source Formatting 
Spatial data sources are received as flat files with spatial coordinate values or reside in a GIS 
layer as points.  Each source type is processed differently. 
 
Flat files with coordinate values: 

� Prepare field name formats 

� Prepare coordinate values in decimal degrees 

� Add X,Y data into ArcGIS, generating the point locations on the fly 

� Output to personal geodatabase for final scrubbing and quality acceptance 
 
Point files: 

� Export file to shapefile format if necessary 

� Project file to state coordinate system (UTM NAD83 Zone19 Meters) for 
compatibility with other data layers 

� Output to personal geodatabase for final scrubbing and quality acceptance 
 
(4.1) Load Spatial Data to Geodatabase 
All spatial data types (point files) are loaded into a personal geodatabase for final scrubbing 
and quality acceptance. 
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(5) Data Analysis and Quality Control 
A final analysis is completed on all points loaded in the personal geodatabase to identify any 
issues.  The table below indicates the primary types of issues, the means to detect them, and 
the resulting solution. 
 

Issue   ⇒⇒⇒⇒ Identification   ⇒⇒⇒⇒ Result 
Duplicate Points Selection by location/imagery review Delete incorrect record 
Unmatched geocoded records Google Maps review Matched  record 
Inaccurate CAI locations Imagery review Modify point location 
Unsuitable CAI - Delete record 

 
(6) Data Categorizing 
Once the CAI records have gone through the data analysis and quality control, the records are 
given a category value of 1 to 7, as discussed in the introduction.  
 
(7) Data Attribution 
CAI attributes are the most difficult to acquire at the data gathering stage and are typically 
acquired through additional steps, including contacting each CAI. The required attributes are: 

� Broadband Service  

� Technology of Transmission  

� Advertised Downstream and Upstream Speeds  
 
The project team has completed the initial round of contacting each CAI to collect the above 
information. The task was completed by assembling a call center group assigned to 
contacting each CAI to establish a primary contact and address verification followed by 
exercising an on-line survey aimed to provide feedback to the items listed above.  Completed 
surveys were compiled through the use of SurveyMonkey.com and final survey output (.csv) 
was prepped and values were loaded into the CAI database to populate attributes.  
 
Additional sources and surveys have been utilized to populate the database including MSLN 
(Maine School and Library Network), NCES (National Center for Education Statistics), the 
Maine Fiber Company as part of its Three-Ring Binder project, and state agency listings 
provided by the chief technical officer.  The project team will continue to compile CAI data 
utilizing all the above resources and research additional data sources and methodologies to 
populate these attributes. 
 
(8) Load Data to SDE for Final SBDD Export 
CAI data is loaded from the personal geodatabase to the SDE environment for final export to 
SBDD format. 

4.3 Data Analysis and Conversion 
Data is analyzed and converted with different processes, depending on its type and 
characteristics. 
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4.3.1 Fixed Wired Transmission 
Fixed wired service provider companies in the state of Maine range from small to large 
businesses and utilize several distinct types of technology to deploy broadband service.  In 
order to accommodate the varied inputs, Sewall has developed a flexible and comprehensive 
workflow to incorporate provider information into a state broadband map developed by 
Sewall in conjunction with the ConnectME Authority. 
 
The ConnectME model depicts broadband service provider coverage at the street segment 
level.  The model uses a street centerline as the spatial component of the coverage, and a 
related table stores provider specific information for street segments.  Sewall developed 
production tools to accommodate the incorporation of service provider data into this 
ConnectME model and instill quality control into the process. 
 
The steps in the process for analyzing and converting Fixed Wired Transmission data are 
outlined in Figure 3 and described below.  
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Figure 3 - Data Flow for Fixed Wired Transmission Providers 
 
(1) Wired Service Provider Data 
The data bin is the storage location for wired broadband service provider data gathered by 
Sewall. 
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(2) Data Sort 
The data sort phase immediately follows the data collection process.  Analysts sort the wired 
data by provider and by data characteristics.  The wired data can consist of address data, 
predefined coverage data, flat file coverage data and unreferenced maps.  Individual 
workflows have been developed by Sewall for the various data formats. 
 
(3) Address Data 
The address data bin is reserved for service provider data that is at the address level.  
Examples of address data formats received are spreadsheet and text file format. 
 
(3.1) Load Address Data to Geodatabase 
Address data is formatted to meet the ArcGIS geocoder standards and loaded into the 
geodatabase for processing.  The formatting of the address data will include ensuring fields 
with the full street address and town name are populated in the dataset. 
 
(3.2) Geocode Process 
Formatted address data is geocoded using the ConnectME street centerline dataset.  The 
address locator style used in this process is the ArcGIS US Streets with Zone. For this 
process, the city fields of the ConnectME street dataset are utilized in the zone component of 
the locator. 
 
(3.3) QC Geocode Result 
Analysts review the address data geocode result for the following: 

� Overall geocode hit rate 

� Town geocode hit rates 

� Data anomalies 
If address data fails any of these checks the data will not pass QC acceptance. 
 
(3.4) Manual Correction of Data 
Address data that has not passed the QC acceptance is evaluated for corrections necessary for 
the data to pass QC acceptance.  Corrections to town names and updates to street names are 
commonly required to match the naming conventions in the ConnectME roads dataset. 
 
(3.5) Geocode Process Tool 
Sewall has developed an ArcGIS tool named Geocode Process Tool that translates the 
accepted geocoded address data into tabular address range records related to the 
accompanying ConnectME street centerlines.  This tool is shown in Figure 4 below. 
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Figure 4 - Geocode Process Tool 
Data Layers:(1) Geocoding Results - geocoded layer of address data (2) Roads Layer - ConnectME roads data 
layer (3) Provider Table - table of provider specific information (4) Service Table - broadband service output 
table where the service provider street address ranges are stored. 
Service Attributes:  The first six values are necessary to populate fields in the deliverable.  Source is used to 
designate that the records created are from the Geocode Process Tool. 
 
In ArcMap the user specifies which layers in the map correspond with the data layer inputs 
for the tool as well as the service provider service attributes that correspond with the geocode 
address point layer.  Once the information is set the user clicks ‘Start’ and the process begins. 
 
Each geocoded address point within the geocode layer has as an attribute the street segment 
that the address was geocoded to.  Using this street link, the tool can locate all of the 
geocoded address points assigned to a given street segment and build a modified street range 
of broadband service for the street segment.  The tool then creates a record in the Broadband 
Service table that contains a link to the street segment in the ConnectME street feature class 
and populates the record with the derived broadband service street segment range and 
specified service provider information.  This process is repeated for each unique street 
segment listed in the geocoded address point layer. 
 
(4) GIS Polygon Data 
The GIS polygon data bin is for service provider data that represents a coverage area of 
broadband availability and is delivered in a GIS format. 
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(4.1) QC Polygon Data 
Datasets from the GIS polygon data bin are reviewed by an analyst.  The QC routine ensures 
that the data has spatial integrity and includes the necessary attribution for inclusion to the 
state broadband project. 
 
(4.2) Polygon Cover Tool 
Sewall has developed an ArcGIS tool named Polygon Cover that converts service provider 
coverage area polygons into street segment related tabular records.  Each tabular record 
created by the tool incorporates the service provider broadband specification information as 
well as modified street ranges representing provider street coverage. 
 
This tool was initially created by Sewall for use on the fixed wireless viewshed datasets but 
was incorporated into the wired workflow for service providers that provided polygon 
regions of service coverage. 

 
Figure 5 - Polygon Cover Tool 
Data Layers:  (1) Roads Layer - ConnectME street centerline data layer with address ranges (2) Viewshed 
Layer - viewshed layer used in delineating visible polygons for clipping road segments.  For wired providers 
this would be the polygon layer that depicts a provider’s coverage area. (3) Provider Table - internal 
processing flag (4) Visible Roads (out) - output feature class that stores the clipped road segment geometry 
(5) Service Table (out) - output table that the extracted address ranges populate. 
Service Attributes:  The first seven values are necessary to populate fields in the deliverable.   
Require GRIDCODE = 1:  Toggle is unchecked when running a wired broadband provider dataset that is 
represented as a coverage area. 
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In ArcMap the user specifies which layers in the map correspond with the data layer inputs 
for the tool as well as setting the service attributes for the service provider polygon layer.  
While running the Polygon Cover tool for fixed wired service regions analysts ensure the 
Require GRIDCODE = 1 toggle is unchecked.  Since this tool was initially created for use 
with a viewshed polygon output, the tool will not run on a non-viewshed layer unless this 
toggle is unchecked.  Once the information is set the user clicks ‘Start’ and the process 
begins. 
 
The tool selects street segments from the input Roads layer that intersect the input polygon 
coverage and exports the street segments to a separate working file.  These streets are then 
clipped to the polygon coverage.  Next the tool runs a length ratio process that assigns each 
street segment a fractional value based on the clipped and original lengths.  The tool then 
populates modified street range attributes based on the length ratio of a segment and the 
original street range of a segment.  These modified street range values represent the 
broadband service street range of the provider.  For each street segment the tool also creates a 
record in the Broadband Service table that contains a link to the original street segment in the 
ConnectME street feature class and populates the record with the modified broadband service 
street segment range and specified service provider information. 
 
(5) GIS Street Data 
The GIS street data bin is for wired broadband provider data at the street segment level that is 
delivered in a GIS format. 
 
(6) GIS Block Data 
The GIS block data bin is for provider data that is delivered at the census block level in a GIS 
format. 
 
(7) Flat File Block Data 
Census block service data delivered in a flat file format is stored in the flat file block data 
bin.  Examples of flat file data are spreadsheets, text files and database files. 
 
(7.1) Join Census Block Spatial Data 
Flat file block provider coverage information is joined to a spatial census block layer using 
the full census block id value.  Blocks with provider information joined are exported creating 
a spatial representation of the provider’s census block broadband coverage. 
 
(8) Flat File Street Data 
The flat file street data bin is where provider data is stored when Sewall receives street level 
information in a format that cannot be associated spatially.  Examples of files types delivered 
in a flat file format are spreadsheet, database and text file. 
 
(9) Unreferenced Map Data 
Provider data that cannot be referenced in ArcGIS are stored in the unreferenced map data 
bin.  Examples of this type include paper maps and PDF documents. 
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(10) Census Block GIS Data 
This data is Census 2010 block data in GIS format for the state of Maine that has been 
downloaded from the US Census website.  
 
(11) Load Layers to GDB 
Provider GIS data is loaded into the Sewall SDE geodatabase.  A feature class is created for 
each provider’s dataset.  Sewall workflow tracking attributes are added to the feature classes. 
 
(12) QC Data 
Datasets are sent to a Sewall analyst for QC.  The QC routine is to ensure that the data 
includes the necessary information for inclusion to the state broadband project.  Provider data 
is cross-referenced with information on broadband availability that has been gathered from 
other sources.  The QC of datasets with spatial data includes additional QC routines to ensure 
spatial integrity.   
 
(13) Request more information on data source 
Broadband provider data that does not meet the QC acceptance criteria Sewall initiates a 
request order to the provider for additional information.  This request includes a detailed 
listing of the deficiencies found in the data as well as inquiries regarding spatial inaccuracies 
and anomalies discovered in the analysis. 
 
(14) Infill Process 
Sewall developed a tool named Infill to interact with the ConnectME street segments and 
populate related tabular records for fixed wired service provider availability.  The Infill Tool 
allows a user to configure a specific set of service provider parameters, select ConnectME 
street segments, and then view and edit the related broadband availability information in the 
Broadband Services table that corresponds with the configured attributes.  This tool is used to 
input fixed wired broadband availability data that Sewall received as census block, street or 
unreferenced map data.  The majority of fixed wired service provider datasets utilize the 
Infill Tool for processing.  A screenshot of the configuration dialog box is shown as Figure 6 
below. 
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Figure 6 - Infill Tool Configuration 
Data Layers: (1) Roads Layer: ConnectME roads data layer (2) Provider Table: Internal processing flag (3) 
Service Table: Broadband Service output table where the service provider street address ranges are stored. 
Service Attributes: These fields are necessary to populate fields in the deliverable. 
 
The first time a user uses the Infill tool in an ArcMap session, the ‘Infill Config’ screen 
appears.  The user enters the input data layers and the attributes for the service provider 
dataset that the tool will utilize during processing. 
 
Once the Infill Config screen has been set a user selects one or more ConnectME road 
segments.  Using the unique primary key values of the selected streets and the specified 
provider name and technology of transmission the tool searches the Broadband Services table 
for existing matching tabular records.  If matches are found from this search, the tool reports 
the information in the Infill window.  For selected street segments where no match was found 
in the Broadband Services table, the tool populates the Infill window with street segment 
road name and street range attributes representing potential broadband service ranges for the 
provider on the selected streets.  These street range attributes can be updated in the Infill 
window based on provider sources.  This Infill tool window is shown as Figure 7.  



  SBDD Process Documentation 
  October 2011 Delivery 

 Page 22 of 78 last revised 2011.09.30 

 
Figure 7 - Infill Tool 
Data Layers: (1) Roads Layer: ConnectME roads data layer (2) Service Table: Broadband Service output table 
where the service provider street address ranges are stored  
Config: Opens the Infill Config window (Figure 6)  
Service Attributes: These fields are necessary to populate fields in the deliverable. 
Source: Internal flag for source of service availability 
Update: Updates selected tabular records SOURCE field to the value entered in the Source field 
Tabular Record Attributes: (1) RDNAME: Name of ConnectME road segment (2) Op: Operation being 
performed {INSERT-new tabular record, UPDATE-update existing tabular record, DELETE-delete tabular 
record} (3) L_FROM: “Left from” broadband address range of ConnectME road segment (4) L_TO: “Left to” 
broadband address value of ConnectME road segment (5) R_FROM: “Right from” broadband address value of 
ConnectME road segment (6) R_TO: “Right to” broadband address value of ConnectME road segment 
(7) Range: Reports either “full” or “partial” and is a comparison for each tabular record of the broadband 
provider street range to the accompanying ConnectME street range (8) SOURCE: Internal process flag. 
 
Once the user has reviewed the values, pressing ‘OK’ will perform the operations listed in 
the Op field. 
 
(15) ConnectME Street Data 
The ConnectME street data bin contains the street centerline dataset used in the geocode and 
street relate processes.  The Maine Office of GIS E-911 street centerline file was used to 
create the base street segments and gives the project the most accurate street centerline file 
for the State of Maine.  The NAVTEQ street centerline dataset NAVSTREETS was utilized 
to infill street segments in areas where gaps were assessed in the MEGIS E-911 file. 
 
(16) Relate Process 
Through the use of Sewall developed tools the data gathered for fixed wired broadband 
service providers gets stored in the Broadband Services table as availability street ranges 
associated with street centerline segments.  Each record in the Broadband Services table is 
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associated by a foreign key/primary key relationship with a street segment in the ConnectME 
street centerline dataset.  This relationship allows for clean and easy access to street level 
availability of service providers.   
 
(17) Broadband Services Table 
The Broadband Services geodatabase table was developed by Sewall to store broadband 
service provider information and street range coverage.  NTIA requirements and formats 
were utilized when creating the fields to ensure the records stored in the Broadband Service 
table are compatible with the SBDD data model. 
 
(18) Intelligent Street Centerlines 
The output from the fixed wired workflow is a comprehensive intelligent street centerline 
network comprised of street centerlines and related service availability tabular records. 

4.3.2 Fixed Wireless Transmission 
The initial stage of mapping terrestrial fixed wireless service territories depends on the 
quality of the data received.  To process any service footprint of a particular transmitter, the 
initial resources acquired during the data collection phase of the project are critical.   
 
Terrestrial Fixed Wireless technology is clouded by many variables that determine the 
overall performance of each transmitter signal.  Inaccurate data pertaining to location, height 
of a transmitter, horizontal and vertical limitations, signal range and many more factors 
present potential obstacles to producing an accurate representation of any transmitter’s 
service footprint.  Some of these factors have not been considered during the mapping 
process due to lack of data needed for modeling them.  For example, while a 10-meter DEM 
is used to represent the surface terrain, we have not incorporated obstructions on the surface 
such as trees and other man-made obstacles that could influence a transmitter’s propagation 
model. 
 
The data collection process and subsequent conversion workflow is designed to 
accommodate a variety of data sources received from the service providers and production 
tools have been developed to build efficiencies and quality control into the workflow.  When 
received by the service providers, supplemental data is used throughout the conversion 
workflow to help verify the mapping results.  However, a larger scale verification process is 
described in Section 5. 
 
The data conversion process for fixed wireless transmission is represented by Figure 8 and 
described below. 
 



  SBDD Process Documentation 
  October 2011 Delivery 

 Page 24 of 78 last revised 2011.09.30 

 
Figure 8 - Fixed Wireless Internal Conversion Workflow 
 
(1) Fixed Wireless Service Provider Data 
Service provider data gathered during the data collection phase. Data is cataloged in separate 
folders by provider and managed according to task and technology of transmission. 
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(2) Data Sort 
The data sort phase of production immediately follows the data collection process. During 
this task, a thorough review of the service provider data determines the type of data received.  
Fixed wireless data generally consists of three types: transmitter coordinates and attributes, 
pre-defined polygons and attributes, and supplemental data. Each type of data follows unique 
internal processing steps. 
 
(3) Transmitter Coordinates and Processing 
Transmitter coordinate data is essentially the raw data necessary to generate a viewshed for 
each transmitter.  In order to be processed, the transmitter source data must have certain 
required fields such as latitude and longitude, spot (ground elevation), equipment height at 
the transmitting and receiving ends, horizontal and vertical limitations, and range of 
transmission.  The content of the transmitter data is carefully reviewed for completeness and 
overall consistency prior to the next step.  Once completed, the data is imported into ArcGIS 
for continued processing and quality control. 
 
(3B) Load Transmitter Data into Personal Geodatabase 
Using the newly scrubbed .csv file, transmitter points are created in ArcGIS and the 
transmitter location points are displayed.  A final comparison against supplemental data is 
performed to ensure the transmitter locations are in the correct locations.  Supplemental data 
includes such layers as imagery, political boundaries, and road centerlines. 
 
(3C) Run Tower Cover Tool 
This tool was designed and developed by Sewall to batch process 1 or more transmitter point 
viewsheds.  A screenshot of the tool is shown below as Figure 9. 

 
Figure 9 - Tower Cover Tool (Viewshed Production) 
Tower Points: The data layer containing records of all transmitters that need a viewshed generated.  Originally 
received from ISP and pre-processed by Sewall for format compatibility.  
DEM:  10-meter digital elevation model obtained from MEGIS as the primary surface model for generating the 
viewshed 
Visible Polygons (out): Visible polygons (only) output to an SDE layer 
Output location:  Location of output to personal geodatabase workspace to be used for additional processing. 
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(3D) Fixed Wireless Coverage Polygons 
The Tower Cover Tool generates raster data sets depicting the visible and non-visible 
surfaces representing each transmitter.  As a final output, the tool extracts the visible 
components of the raster data and outputs to polygon vector layers stored in the SDE 
environment as supplemental reference data.  
 
(3E) Run Sewall Polygon Cover Tool 
This tool was designed and developed by Sewall to facilitate several production steps.  
 

 
Figure 10 - Polygon Cover Tool 
Data Layers: (1) Roads Layer - ConnectME Street data layer with address ranges ( 2)Viewshed Layer - 
viewshed layer used toe delineate visible polygons for clipping road segments (3)Provider Table - internal 
processing flag (4) Visible Roads (out) - output feature class that stores the clipped road segment geometry 
(5) Service Table (out) - output table that the extracted address ranges populate.  
Service Attributes: These fields are populated, if data is available, to meet NTIA NOFA requirements. 
 
(3F) Fixed Wireless Visible Road Segments 
The Polygon Cover Tool clips road segments that are within visible polygon viewsheds and 
writes them out to a polyline vector layer stored in the SDE environment as supplemental 
reference data. 
 
(3G) Fixed Wireless Geo-Processing Clean-up 
The fixed wireless polygons or propagation models generated for each provider step through 
several geo-processing routines to check for and eliminate the following conditions: 

� Single pixels less than 0.125 square miles  

� Holes inside the polygons less than 0.125 square miles  
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In each case, all identified polygons are removed and dissolved to create multipart polygons 
by provider, technology, speed and spectrum.  Each provider’s propagation model differs in 
size and complexity due to the number of transmitters and their individual parameters that 
determine each view shed.  Because the geometries are manipulated through many geo-
processing procedures, multiple cycles of validation are run to ensure the geometries are in 
tact and repair routines are run if necessary.  Once all propagation models meet internal 
quality control standards, the geometry is loaded to SDE and stored for final export to the 
SBDD deliverable format. 
 
(4) Viewshed Polygons and Processing 
Although not as common, another source of data received from the service providers is a 
polygon dataset that has already been generated to represent visible service territory of 
transmitters. Service providers or third party vendors will frequently run their own 
propagation models to be used for broadband mapping.  Polygon formats include ESRI 
shapefiles, MapInfo files, Google .kml files, and raster files.  Each format requires a 
thorough review to determine the subsequent processing steps. 
 
(4A) Review Polygon Data 
Although each format listed is unique, the data eventually runs through the Polygon Cover 
tool so that the address ranges within the polygons can be clipped out.  Each format is 
carefully inspected for content, spatial characteristics and accuracy.  The general workflow 
for each format is as follows: 

� Shapefile:  Review content > Edits > Project > QC >  Load for processing > Run 
Sewall Polygon Cover Tool 

� MapInfo:  Review content > Translate to ESRI shapefile > Edits > Project > QC >  
Load for processing > Run Sewall Polygon Cover Tool 

� Google .kml:  Review content > Translate to ESRI shapefile > Edits > Project > QC > 
Load for processing > Run Sewall Polygon Cover Tool 

� Raster:  Review content > Translate raster to polygon > Edits > Project > QC > Load 
for processing > Run Sewall Polygon Cover Tool 

 
(5) Supplemental Data 
Supplemental data received by service providers is generally used for verification to support 
internal processing results. It is not used as a data source to generate transmitter locations or 
viewsheds.  Supplementary data includes, but is not limited to, failed service locations, 
customer service locations, hard copy plots, PDF files, and other digital reference files.  In 
most circumstances, the data can be used for cross-referencing. 
 
(5A) Review Supplemental Data 
Each format is unique and so are the processing steps that are necessary to prepare the data 
for use.  
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� Failed Service Locations:  Provides an excellent source for cross-referencing to 
viewshed polygons (visible and non-visible) but must have complete address in order 
to geocode location of address. 

� Customer Service Locations:  Provides an excellent source for cross-referencing to 
the viewshed polygons (visible and non-visible) but must have a complete address in 
order to geocode location of address. 

� Hard copy plots:  May be used for verification purposes if the content of the material 
is applicable.   

� PDF files: May be used for verification purposes if the data content is applicable.  

� Other data sources:  All sources are reviewed for potential use. 
 
(5B)  Support Verification Tasks 
Supplemental data sources are reviewed to determine if they hold any value to the project 
workflow. Value added data will be stored and utilized as needed to support internal 
processing. 
 
(5C) Store Data 
Data received from service providers that does not have any given value to the project is 
organized and stored under the service provider folder. 
 
(5D) Process Data for Verification Tasks 
Supplemental data sources are scrubbed for compatibility and processed. 
 
(6) Quality Control Acceptance 
Quality control procedures are implemented at each of the three production stages depending 
on the data (transmitter coordinates, viewshed polygons, or supplemental data). Because the 
service provider data is received in numerous formats, styles, and content, much of the initial 
QC is completed during the data collection stage. When data is received from a service 
provider, an initial review is done to determine what is received and what is outstanding.  
This cycle of communication with the providers continues until all the necessary data is 
either received or clearly understood that it will not be received.  Throughout the data 
collection process, Sewall keeps an inventory of receivables. 
 
(6A)  Contact Data Source for Additional Information 
During the data collection phase of the project, questions or clarifications may have been 
overlooked, or items may present road blocks at some point later during the processing.  If an 
internal quality review does not resolve an issue, the service provider is contacted for 
additional information or clarification. 
 
(7) Fixed Wireless Broadband Services Table (Relate Process) 
The Polygon Cover Tool has two outputs; both generated using the visible polygons created 
by the Tower Cover Tool:  (1) road segments, and (2) calculated address ranges.  While the 
visible road segments are not part of the NTIA deliverable, they are stored as a reference file 
named CONNECTME.FW_VISIBLE_ROAD_SEGMENTS. 
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(8) Intelligent Street Centerlines 
The output from the fixed wireless workflow is a comprehensive intelligent street centerline 
network comprised of street centerlines and related service availability tabular records. 

4.3.3 Mobile/Satellite Transmission 
Wireless broadband technology consists of all facilities-based providers of wireless 
broadband service that is not address specific.  For the State of Maine, this includes terrestrial 
mobile wireless and satellite broadband service.  Mapping mobile wireless and satellite 
coverage requires less processing than other technologies that are address-based, such as 
wired and fixed wireless service. Data consists of polygons generated by the providers or 
third party vendors, representing areas where broadband service is offered. As shown in the 
workflow below, the data received from providers is sorted, processed and loaded into a 
geodatabase.  Minimal steps are required to process this data, but established internal 
workflows are taken to ensure that proper protocols and quality assurance are met. The 
primary steps of the internal workflow are shown in Figure 11 and described below. 
 

Figure 11 - Wireless Internal Conversion Data Workflow 
 
(1) Data Sort 
Upon receiving data from a mobile or satellite service provider, Sewall initially sorts and 
stores the data by technology - terrestrial or satellite. 
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(2) Terrestrial Mobile Wireless Data Sources (Review) 
After the data is sorted, an initial data analysis is performed to determine if the data received 
appears to be intact spatially and is accompanied by the proper attribution required for 
adherence to the SBDD data model. Follow-up with the service provider continues until all 
necessary information is acquired.  
 
(2.1) Process Mobile Wireless Polygons in ArcGIS 
After determining that the data has value, the polygons are projected into the proper 
coordinate system to complement the internal workflow.  Depending on the source data, 
additional data processing routines may be necessary before loading the data into the 
geodatabase. 
 
(2.2) Load Mobile Wireless data into Personal Geodatabase 
Although the primary quality control procedures are completed during the verification 
process, initial acceptance testing to ensure the data is spatially valid is performed by cross-
referencing to additional data sources such as aerial imagery or information taken from the 
service provider website. Discrepancies are documented for use in subsequent verification 
processes.  Once quality checks are complete, the data is loaded into a personal geodatabase  
 
(3) Satellite Data Sources (Review) 
When all the spatial and attribute information is received, the satellite data follows the same 
internal workflow as mobile wireless data (Steps 2, 2.1 and 2.2).  
 
(4) Load Data to SDE for final SBDD Export 
Mobile wireless and satellite data is loaded to SDE environment for final export to SBDD 
format. 

4.3.4 Middle Mile Locations 
Middle Mile and Internet Backhaul Connection Points are defined by NTIA as 
“interconnection points that typically enable relatively fast data rates, are built to handle 
substantial capacities, and may be service-quality assured.”  At this stage of the mapping, 
middle mile data has been the most difficult to obtain from service providers during the data 
collection process. Service provider networks can include as little as one middle mile 
location such as a backhaul connection point or as many as dozens, operating as 
interconnection points within a fixed wireless network reaching out to end users.  
Furthermore, some service providers may offer middle mile connection points only as a 
service, such as a splice into a fiber line to support a lateral to a central office or business. 
 
Regardless of the technical framework, all middle mile locations that meet the NTIA 
definition are captured in a point feature class with additional attribution including the 
ownership of the facility, serving facility capacity and serving facility type.   
 
The outline of workflow is shown as Figure 12.  The description of each step follows. 
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Figure 12 - Middle Mile Internal Data Conversion Workflow 
 
(1) Data Sort 
The initial data sort separates the data and distinguishes formats more compatible to the 
database model, such as middle-mile coordinate values listed in a spreadsheet or ESRI 
shapefiles.  Data received in compatible formats require minimal processing steps. 
Supplemental data sources generally require additional processing steps.  Examples may 
include the conversion of .kml files to ESRI shapefiles or polyline files that require points to 
be added at splice or lateral connections. 
 
(2) Middle Mile Coordinate Data Sources Review 
Sewall reviews the data to ensure that the information is a valid input.  If so, the data is 
reformatted and loaded into in ArcGIS.  Sources deemed as invalid are stored, or the service 
provider is contacted for additional information if necessary. 
 
(2.1) Generate Middle Mile Points in ArcGIS 
Points are loaded into ArcGIS.  Sewall analysts run acceptance procedures to verify data 
translation to ArcGIS and spatial accuracy and completeness using supplemental data sources 
provided such as addresses, imagery or descriptive information about the point locations. In 
addition to the point geometry, all attribution carried over in the translation is confirmed.  
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Conflicts or questions are referred back to the service provider for further clarification if 
necessary. 
 
(2.2) Load Middle Mile Data into Personal Geodatabase 
Middle-Mile data is loaded to a personal geodatabase.  Additional data received by the 
service providers or revisions will cycle through the same process and be stored in the 
personal geodatabase prior to loading to the SDE environment for final export. 
 
(3) Middle-Mile Supplemental Data Sources (Review) 
Supplemental data sources may involve additional processing during this step in order to 
proceed. Some of the more common supplemental data sources include, but are not limited 
to, the following: 

� Google .kml files 

� .jpg images showing middle-mile locations 

� AutoCAD point or polyline files 

� e-mails with descriptions of locations 

� Other miscellaneous information 
 
Once the data has been fully reviewed and normalized, the remaining steps follow the same 
internal workflow as coordinate data sources (Steps 2.1 and 2.2). 
 
(4) Load Data to SDE for final SBDD Export 
Middle mile data is loaded from the personal geodatabase to the SDE environment for final 
export to SBDD format. 

4.3.5 Service Overview 
Broadband service providers that participate in the state broadband mapping project have 
been asked to provide broadband service territory footprints at the address, street, census 
block or county level. The service overview dataset contains the information that has been 
delivered at the county level. 
 
The workflow developed by Sewall integrates the gathered data from broadband service 
providers into a consistent spatial format that is stored in a geodatabase designed to be 
compatible with the SBDD deliverable. 
 
The service overview workflow is described below and depicted in Figure 13. 
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Figure 13 - Service Overview Workflow 
 
(1) Service Overview Data 
The Service overview data bin is the storage location for service overview specific 
broadband service provider data gathered by Sewall.  Sewall specifies what information is 
necessary for this deliverable and what formats are acceptable when contacting each provider 
during the data gathering phase of the project. 
 
(2) Data Sort 
The service overview data is sorted into categories by data type. 
 
(3) GIS Service Overview Data 
The GIS data bin is used to store provider data that has been delivered to Sewall with service 
overview attribution and is in the requested GIS format. 
 
(3.1) Attribute Transfer 
Attributes contained in the GIS data are sent through an attribute transfer process that 
populates county data from the MEGIS County data.  This step ensures that there is one 
consistent spatial dataset utilized as a basemap in the service overview. 
 
(4) Flat File Service Overview Data 
The flat file data bin is used to store provider data that has been delivered to Sewall with 
service overview information in a flat file format.   
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(4.1) Join 
Using county name information provided in the flat files the MEGIS county data is joined to 
the flat files.  The joined dataset is exported and stored in the GIS service Overview data bin. 
 
(5) MEGIS County Data 
The shapefile cnty24p.shp was downloaded from the MEGIS website (megis.maine.gov) and 
utilized for county spatial representation of the service overview dataset during the 
workflow. 
 
(6) Load to Geodatabase 
Once the service overview data has been processed, the data is reviewed for content and 
accuracy and then loaded to the ConnectME production database. 
 
(7) Service Overview 
The output of the service overview workflow is a polygon dataset that is compatible with the 
SBDD data model. 
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5 Validation 
The verification process is used to ensure that the data delivered is in fact valid and current.  
Methods used by the Maine teams to validate coverage areas include field tests of mobile 
devices, responses to surveys sent to residents and businesses, comparison with third-party 
datasets both private and governmental, and results compiled from a speed test website 
established specifically for this purpose. 
 
Once the data has been collected, processed and verified, the results are statistically analyzed 
and plotted atop the original provider data coverages in GIS.  Any ‘holes’ or inconsistencies 
in the data from the service provider are reported to the provider in a feedback loop to ensure 
all parties involved are aware of the potential issues with the broadband service in an area. 

5.1 Field Tests for Mobile Coverage 
Mobile coverage consists of data from providers who offer mobile broadband services to 
consumers through devices such as smartphones or mobile laptop aircards.  Common 
providers of this type of broadband service in Maine are AT&T, Verizon Wireless, and 
Sprint. 
 
In order to verify the existence of wired and fixed wireless coverage in an area, direct access 
to the provider’s service is needed.  Logistically this would be difficult because transmission 
receivers, accounts and other equipment would have been required for each of the providers.  
Instead, the project team opted to gather information through other means, so field tests were 
only conducted to validate mobile coverage. 
 
Mobile coverage data is received by Sewall from the service providers in the form of GIS 
polygon files.  After these files have been reviewed and properly projected (see Section 4.3 
for details), they can be analyzed in the verification process.  The mobile coverage file is 
compared against the State of Maine boundary file in a GIS application in order to assess the 
size and location of the coverage area with respect to the State. 

5.1.1 Methodology 
The methodology developed by the ConnectME Authority to verify mobile coverage in 
Maine is to select a series of points throughout a provider’s coverage and have field crews 
run tests at these predetermined locations.  A minimum of 37 points per coverage area are 
needed in order for the statistical analysis on the field data to be valid. 
 
To select the points for field verification, a 28-square-mile grid was created in GIS and 
layered with the provider’s coverage area, the E911 road layer and the state boundaries.  One 
point was placed per grid block within the provider’s coverage network.  Each point was 
placed on a road, usually at road intersections for ease of access by the field crew.  Once all 
the points were placed, the points were divided into groups for distribution to field crew 
personnel.  
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The points were assigned attributes of point ID, latitude and longitude.  The attribute table 
was then exported to an Excel file for further editing.  The columns: field connect, upload 
speed, download speed and notes were added to the spreadsheet.  The field connect column 
holds values to describe whether the field crew was able to log on to the provider’s network., 
speeds collected from the state website at that location are stored in the upload speed and 
download speed columns.  The spreadsheet was loaded onto the field laptops for data entry.   
 
Crews utilized Microsoft Streets & Trips to assist in navigating to each of the field points 
across the state.  The software, which was loaded on each of the field laptops, has a GPS 
component that could track and direct field crews.  The spreadsheet used for data entry was 
also loaded into the software so the points could be plotted based on given coordinates. The 
field crews could properly identify each of the points based on the Point Name attribute. 
 
The program turned each of the points into a “stop.”  The start and ending points of the trip 
were also added, allowing the software to calculate an optimized route to reduce driving time 
and mileage.  After optimization, the software also provided driving directions, which were 
saved and loaded onto the field laptops. 
 
Mobile broadband aircards from each of the mobile service providers were purchased 
outright directly from the providers.  This eliminated the need for a service contract so that 
the aircards can be deactivated after the verification process without a contract cancellation 
fee.  Service providers activated the mobile aircards with a month-to-month data package of 
5GB. 
 
Aircards from each of the providers were then loaded onto the field crew laptops.  The 
software from the aircards was installed, aircard functionality was checked, and any updates 
were installed prior to crews leaving the office. 
 
Each time verification tasks are performed, the points are visited by a field crews who are 
equipped with a field laptop enabled with the mobile broadband aircard of the corresponding 
service provider and proper navigation information.  The field crews drive to each of the 
points, log onto the service provider’s network and navigate via Internet Explorer to an 
internet speed test website created by the James W. Sewall Company specifically for the 
ConnectME Broadband Mapping Project.   
 
For each test point, the point number, service provider and date are entered into the internet 
speed test website (e.g., Test_745_verizon_20100521) and a test is executed.  Results are 
recorded both in the speed test database (automatically) and in the spreadsheet.  Once all of 
the points are completed, crews return to the office and spreadsheets are combined.  Data 
columns are filled in with corresponding broadband upload and download speeds for sites 
with connectivity.   
 
Data points are then plotted on maps to view where broadband coverage is full strength or 
where it is lacking.  If there are large ‘holes’ in the coverage areas, the points are revisited to 
ensure that readings were accurate and not subject to user or equipment error. 
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The merged field spreadsheets are then handed off to a statistician for the statistical analysis 
of the data. 

5.1.2 Statistical Analysis 
Large data sets are often expressed best in terms of summary statistics.  It is often easier to 
look at commonly defined statistics (stats) to get a quick overview of what the data describes, 
than to look at all the raw data. 
 
In analyzing this data, we chose statistics using the following criteria: 

� Commonly used and understood 

� Fit the data (data type) in question 

� Had practical application to the reader in understanding what the data was describing 
 
We believe that the statistics presented can be beneficial in several ways: 

� Description/Summary:  they consolidate many data observations into a few summary 
stats that can be quickly compared 

� Quantification:  they describe which portion of the data falls within or outside of the 
limits of acceptable criteria 

� Reliability/Prediction:  in some cases, they attest to the reliability of the data 
collection 

 
The following statistics were used: 

� Number of samples (n):  number of data points in the sample 

� Average (xbar):  arithmetic mean or the mean value of a set of integers, terms, or 
quantities, expressed as their sum divided by their number.  

� Standard Deviation (sd):  used as a measure of the dispersion or variation in a 
distribution, equal to the square root of the arithmetic mean of the squares of the 
deviations from the arithmetic mean. 

� Percentages (%):  a proportion or share in relation to a whole; a part; a fraction or 
ratio with 100 understood as the denominator (e.g., 0.98 equals a percentage of 98). 

� Hypothesis testing:  statistical process used when trying to determine if it is 
reasonable to conclude that the entire population possesses a certain characteristic by 
the analysis of a sample. 

 
Explanation of choices made: 

� Quantitative statistics were only applied on sample data that fell within the published 
service area of the provider in question.  This was possible because the area was 
“bounded” by the geographic area described in the “service area.”  Outside the 
service area there is no bound (limit), so these same statistics would not be reliable as 
used with our methodology. 



  SBDD Process Documentation 
  October 2011 Delivery 

 Page 38 of 78 last revised 2011.09.30 

� Assumed a normal distribution because this is the most common and typical 
distribution type for this type of data, and we had no evidence to counter this 
assumption.  

� Chose sample statistics because we were not dealing with the whole population 
(almost unlimited sample points possible). 

� Chose hypothesis testing because we wanted to have the most valid predictor of the 
population parameters given the variability of our sample data. 

� Chose student’s T-distribution when sample size was equal to or less than 30 (n=<30) 
and Z-test when populations were above 30 (n>30). 

� Used one-tailed tests because we were interested in the area above the curve from a 
single lower parameter (criteria of minimum speed). 

 
Data was sorted to yield only those sample points that fell within the published service area 
of the provider in question. 
 
Then the following information was calculated: 

� n = number of total sample points 

� Degrees of Freedom (df) = n-1 

� Selection of  t-distribution (df < 30) or standard normal curve (df >= 30)  

� Percent of points where connection was established 

� Percent of points where both tested upload and download speeds were equal to or 
greater than (=>) broadband speeds (200 and 768 kb/sec respectively).  

� Percent of points where either the upload or download speed was equal to or greater 
than (=>) broadband speed, but not both. 

� Percent of points where neither the tested upload or download speeds was equal to or 
greater than (=>) broadband speeds.  

 
Using all data points within the designated service provider coverage that registered an 
upload speed during the test, the following were calculated: 

� Average # of points where a connection was made that had an upload speed equal or 
greater than broadband minimums. 

� Average upload speed (xbar/upload) 

� Standard deviation of the sample (SD/upload) 

� Statistical prediction of percent of points that would meet minimum 3G upload speed 
in subsequent samplings (using one-tailed t-test or z-score, depending on df) – see 
schematic below 
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Using all data points within the designated service provider coverage that registered a 
download speed during the test, the following were calculated: 

� Average # of points where a connection was made that had a download speed equal 
or greater than broadband minimums. 

� Average download speed (xbar/download) 

� Standard deviation of the sample (SD/download) 

� Statistical prediction of percent of points that would meet minimum 3G upload speed 
in subsequent samplings (using one-tailed t-test or z-score, depending on df) – see 
schematic above. 

5.2 Surveys  
The project team is surveying residents and businesses in Maine utilizing a questionnaire 
about their current internet connections.  The ConnectME Authority has opted begin the 
verification of residential broadband service with a pilot survey. 

5.2.1 Pilot Residential Survey 
According to the 2000 Census, there are approximately 518,000 households in Maine, of 
which 10,000 were included with the pilot survey.  Residential addresses were purchased 
from InfoUSA for the mailing as 2,500 addresses in each of four geographic areas:  Maine 
North, Maine South, Maine East, and Maine West.  Addresses were selected at random by 
InfoUSA from the provided GIS polygons constituting adjacent census blocks in each area 
containing approximately 5000 households. 
 
The survey questionnaire is comprised of 10 questions and takes about two minutes to 
complete.  A copy is included in Appendix E.   
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The survey identifies the consumer by the physical address, which is geocoded against a 
street centerline file in GIS to create a point file.  The data associated with each address (e.g., 
transmission type and provider) is analyzed by layering the consumer information with the 
coverage data provided by the service provider.  Sewall can analyze the layers to verify if 
each service provider does cover the areas represented by the data it submitted. In addition, if 
an area shown to have no service by a provider appears in the consumer survey, the provider 
in question can be contacted to confirm and provide updated coverage information. 
 
There is also an online version of the survey that people can access by navigating to a link 
indicated on the delivered hardcopy of the questionnaire.  The electronic version, once 
completed, directs the person to the ConnectME internet speed test website, which reports 
the upload and download speeds of the user’s internet connection.  The speeds are recorded 
in a database that tracks entered physical address and speed test results for future analysis 
(see Section 5.4.1 for further details). 
 
The logistics for a statewide survey are being addressed. Sewall expects to begin 
implementation by December 2011. 

5.3 Third Party Data 
The Maine team has acquired data from American Roamer and from the FCC.  These 
datasets will be used to validate the mapped coverage for each provider through spatial 
analysis. 

5.3.1 American Roamer data 
Maine acquired the American Roamer data, which includes coverages for Sprint, Verizon 
Wireless, AT&T and T-Mobile.  The data consists of polygon shapefiles, which Sewall could 
overlay with the coverages received from the providers.  For each provider, the area in 
common and the area covered only by one dataset were determined from geospatial analysis.  
Differences are used for analysis and refinement of the service territory. 

5.3.2 FCC Form 477 aggregate data 
The FCC has provided SBDD grantees and their teams access to the FCC Form 477 
aggregate data.  This data contains information on service providers in Maine at an aggregate 
or granularity higher than the SBDD data, but is useful for checking the list of providers and 
their locations at Census Track level. 
 
The project team has recently developed a tool that compares the records in the Form 477 
aggregate data to the provider data in the SBDD project database.  The tool lists out by 
Census Track each provider that includes the tract in the Form 477 filing. Each provider that 
has service data that falls within the tract is considered a match.  Using this data, the team has 
been able to find potential providers that were not previously included in the study, as well 
using the tract locations as a cross-reference to where each provider has service.  The team 
has plans to further enhance the tool to provide a set of results centric to each provider. 
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5.4 Crowd Sourced Data 

5.4.1 Speed test results 
For the SBDD project, the ConnectME Authority has implemented an online speed test tool.  
The website was developed by Ookla Net Metrics and was brought online on January 13, 
2010.  To date, over 12,200 tests have been recorded.  The speed test stores downstream and 
upstream speeds as well as the user’s address and ISP.  The results from the speed test tool 
are scrubbed and geocoded.  The information will be used to help verify service coverages 
and service speeds for wired, fixed wireless, and satellite providers. 

5.4.2 FCC Consumer Broadband Test (CBT) data 
The Consumer Broadband Test data provided by the FCC consists of three datasets: Speed 
Test records, Mobile Broadband Speed Test records, and Broadband Dead Zone Report 
records.  The project team plans to incorporate the FCC speed test records along with those 
records captured by the ConnectME speed test tool.  However, the name of the service 
provider is not included with data, so a method for mapping the IP address in these records to 
the appropriate provider must be developed. 
 
The dead zone reports are used to identify locations reported to be without coverage.  The 
addresses from these records are geocoded and then are cross-referenced with service 
provider coverages in the areas. 

5.5 Service Locations / Failed Service Locations 
Service providers are encouraged to submit service locations and/or failed service locations 
to help validate extents of service coverage.  The service addresses and failed service 
addresses are geocoded and the data is analyzed with the coverage data submitted by the 
service provider.  This validation step will continue throughout the project as the team 
continues to receive these locations as part of the providers’ data submittals. 
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5.6 Feedback Loop 
Once broadband service territories are mapped, Sewall generates maps for each provider 
company representing the status of data at the time of the mapping.  This gives each service 
provider the opportunity to validate its broadband service footprint and provide feedback to 
the Sewall project team.  Figure 14 below represents a fixed wired validation map where a 
provider company’s broadband service (DSL) foot print is symbolized in red.  Depending on 
the size of a service footprint and map density, additional information, such as road names, 
may be represented.  

Figure 14 - Fixed Wired Validation Map 
 
Sewall forwards the maps of the service territory, along with any anomalies noted from the 
third-party and crowd-sourced data analysis to each service provider.  Sewall communicates 
regularly with each provider to ensure that the mapping is as comprehensive and correct as 
possible. 
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Sewall also generates maps for mobile service providers showing the coverage and service 
levels according to FCC and NTIA standards.  Figure 15 below represents a sample 
validation map show FCC-defined levels of service.  Town lines and town names are shown. 
 

Figure 15 - Mobile Validation Map 

5.6.1 GeoPortal Transfer Site 
In August 2011 Sewall deployed a web-based GeoPortal site to manage all data transfers 
related to the ConnectME Authority Broadband Mapping Project, see Figure 16.  Each 
broadband service provider has a secure password-authenticated account set up which allows 
designated users to upload and download digital data. All users receive an e-mail notification 
when their account is set up. 
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Figure 16 – Screenshot of GeoPortal web site 
 
Data exchanges between Sewall and the service providers will include, but not be limited to, 
data round submissions, validation maps and other miscellaneous correspondence. In 
addition to data transfers, the GeoPortal will also be used by the general public for viewing 
the static maps posted in the map gallery.  Currently the map gallery contains statewide maps 
representing FCC speed tier coverages, broadband service availability for Maine house and 
senate legislative districts and grant overview maps depicting awarded ConnectME Authority 
grant applications throughout the state. 
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6 Data Delivery 
Service provider data that has been processed to the Sewall production model needs to be 
transferred to the SBDD data model for delivery.  In order to accomplish this Sewall has 
developed a process by which the Sewall production datasets are exported to the current 
SBDD data model structure. 
 
The Sewall production model was designed with the NTIA delivery model in mind and, in as 
many cases as possible, the production model utilizes the NTIA delivery defined attribute 
definitions and domain values.  Through the use of this design philosophy, Sewall has 
mitigated the pitfalls for exporting to the SBDD data model.   
 
To facilitate the transfer of data stored in the Sewall production model to the SBDD model 
for delivery Sewall has developed an ArcCatalog tool named State Broadband Data Export.  
This tool reads a source geodatabase set of features and writes to a destination geodatabase 
set of features.  A screenshot of the tool dialog box is shown in Figure 17. 

 
Figure 17 - State Broadband Data Export Tool 
Source database: Sewall production geodatabase location. 
Source Data Tables:  (1) Providers - Geodatabase table with list of provider specific information  (2) Roads - 
ConnectME street centerline feature class  (3) Census Block - Census 2010 block geodatabase feature class 
(4) Broadband Services - Geodatabase table containing broadband provider characteristics and street ranges 
linked to ConnectME street centerline segments  (5) Middle Mile - Geodatabase point feature class containing 
broadband service provider middle mile locations ( 6) Community Anchors - Geodatabase point feature class 
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containing community anchor institution locations  (7) Area Availability - Geodatabase polygon feature class 
containing mobile wireless and satellite broadband provider coverage  (8)Weighted Speed - Geodatabase 
polygon feature class service overview data  (9) State Boundary - Geodatabase polygon feature class 
portraying the Maine state boundary. 
Destination State Broadband database: SBDD geodatabase location. 
State Broadband Data Tables:  These are the required SBDD deliverables. 
 
On launching the ArcCatalog tool, the user selects the source and destination geodatabases 
for the transfer process.  The source geodatabase is the Sewall internal production model, and 
the destination geodatabase is the empty SBDD model.  Next the user matches the items 
listed in the Source Data Tables section to the production model features.  Once complete, 
the user checks which deliverables the tool will export in the State Broadband Data Tables 
section.  Clicking ‘Start’ will begin the export process. 
 
The road segment and census block exports are performed simultaneously in the State 
Broadband Data Export Tool with road segments being reported in census blocks greater 
than 2 square miles and census blocks being reported in areas up to 2 square miles.  The tool 
reads the service provider data stored in the Sewall production geodatabase and performs an 
analysis through which the deliverables are extracted.  The analysis process by which the tool 
extracts the road segments and census block data is outlined in the whitepaper entitled 
“Misalignment between Census Blocks & Maine E911 Streets:  Technical Whitepaper,” 
dated 30 September 2011.  This paper is included in Appendix D.  The switch from 2000 
Census Blocks to 2010 Census Blocks for the October 1st 2011 delivery caused the team to 
re-evaluate the export process as the 2010 Census Blocks were reported to be a closer match 
to the Maine E911 street dataset.  The finding of that study revealed that the 2010 Census 
Blocks still had spatial misalignments with the Maine street dataset and the conclusions of 
the study in Appendix D are still valid. 
 
Once the census block data has been exported it is run through a QC routine.  As the census 
blocks are created from broadband data at the street level and there is a spatial misalignment 
between the two datasets erroneous data can be created through the export process.  The 
exported census block data is checked against the baseline broadband street dataset for 
inconsistencies.   
 
Middle mile and community anchor institution data are stored as point features in the Sewall 
production model and are extracted utilizing a standard export routine.  The datasets are 
reprojected from the production UTM projection to the SBDD WGS84 projection and 
LAT/LON attributes are populated.  Once complete, the points are loaded into the destination 
feature classes of the SBDD geodatabase. 
 
Wireless, service overview and state boundary data are stored as polygon features in the 
Sewall production model and a standard export routine extracts these to the SBDD features.  
The datasets are reprojected from the production UTM projection to the SBDD WGS84 
projection as features are loaded. 
 
Address data that has been collected is stored as point features in the Sewall production 
model and exported to the SBDD geodatabase using standard export routines within ArcGIS. 
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During the export process features with front-end business rule violations get reported.  The 
report is than reviewed by a Sewall analyst, and necessary corrections are made to the base 
datasets.  This reporting mechanism ensures the data delivered in the SBDD geodatabase is 
as complete and accurate as the provided data sources allow. 
 
Once the SBDD transfer file geodatabase has been created and its content validated, the 
geodatabase files are included in the data submittal zip file along with the other submittal 
files including ‘datapackage.xls,’ schema modifications report, data verification summaries, 
and this technical whitepaper. 
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Appendix A - Sample Letter to Service Providers 
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[date] 

Sewall 
P.O. Box 433 

136 Center St. 
Old Town, ME 04468 

207-827-4456 
[address] 
[address] 
[address] 
[address] 
 
Dear Mr. [name]: 
 
The National Telecommunications and Information Administration (NTIA) of the U. S. Department of 
Commerce has been charged by Congress under the American Recovery and Reinvestment Act of 2009 and the 
Broadband Data Improvement Act (BDIA) to develop and maintain a comprehensive, interactive, and 
searchable nationwide inventory map of existing broadband service capability and availability in the United 
States that depicts the geographic extent to which broadband service is deployed and available from a 
commercial or public provider throughout each state (the Program). 
 
The ConnectME Authority (the Authority) is responsible for developing and maintaining these data for the State 
of Maine and for serving as the conduit for this information to the NTIA. The Authority has contracted with 
James W. Sewall Company of Old Town, Maine, to undertake the initial mapping and to consult with the 
Authority on how best to update and maintain these data going forward.  
 
We are writing to insure that you are familiar with this Program and to invite your collaboration in teaming with 
us in this important, statewide initiative. (See the URL’s provided at the end of this letter for further 
information.) Indeed, your organization’s collaboration is essential to the Program’s success, and we thank you 
in advance for your participation. 
 
To comply with the Program, the NTIA requires each state to provide structured data that includes: 

• the availability of broadband service at the address level; 

• advertised and “expected actual” speeds of broadband service; 

• the technology used to deliver broadband service; 

• location and capability of critical broadband related infrastructure (this data will not be publicly 
displayed on the national broadband map); 

• the spectrum used by wireless broadband service providers. 
 
We expect that the publicly searchable national broadband map and database will contain: 

• geographic areas in which broadband service is available; 

• the technologies used to provide broadband service in such areas; 

• the speed at which broadband service is available in such areas; 

• broadband service availability at public schools, libraries, hospitals, colleges, and all public buildings 
used by the state or municipalities. 

• other economic or demographic data that may enable Federal efforts to provide usable and searchable 
data on a variety of issues pertinent to the public interest. 
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We recognize that some of the data we will ask you to provide is proprietary. Consequently, we include a 
Protective Order authorized by the ConnectME Authority and an accompanying non-disclosure agreement 
(NDA) for your review and execution. Please note, however, that the NTIA requires that this NDA may not 
restrict the Authority from providing all data collected to the NTIA or restrict the NTIA’s use of such data as 
contemplated under this Program, including sharing such data with the FCC or other federal agencies. 
Furthermore, the NTIA prohibits the Authority or Sewall from agreeing to a more restrictive definition of 
Confidential Information than that adopted by the NTIA. Currently, as required under the BDIA, the NTIA 
identifies Confidential Information as any information, including trade secrets, or commercial or financial 
information, submitted under the Program that: 

• identifies the location, type and technical specification of infrastructure owned, leased or used by a 
specific broadband service provider; or 

• explicitly identifies a broadband service provider in relation to its specific service area or at a specific 
service location. 

 
Confidential Information will not be made publicly available pursuant to the limits set forth in the BDIA except 
as required by applicable law or judicial or administrative action or proceeding, including Freedom of 
Information Act requirements. From the BDIA (§ 106(h)): “Notwithstanding any provision of Federal or State 
law to the contrary, an eligible entity shall treat any matter that is a trade secret, commercial or financial 
information, or privileged or confidential, as a record not subject to public disclosure except as otherwise 
mutually agreed to by the broadband service provider and the eligible entity.”  Sewall was chosen to lead this 
task in part because of its long history of handling confidential information for a variety of industries. Finally, 
should your organization apply for a Broadband Technology Opportunities Program (BTOP) grant to support 
the deployment of broadband infrastructure in unserved and underserved areas, enhance broadband capacity at 
public computer centers or to encourage sustainable adoption of broadband service, the NTIA requires that you 
participate in this mapping Program.  
 
The NTIA has set a very aggressive Program schedule, with many deliverables due by November 2009 and all 
initial deliverables due in March 2010. Consequently, a representative from the Sewall team will be contacting 
you soon to discuss any questions you may have and to facilitate completion of the NDA and your participation. 
If we should be in communication with others in your organization concerning either the NDA or the data 
transfers, please inform the Sewall representative as soon as possible. Thank you again and we look forward to 
working with you. 
 
Sincerely, 

 

 
 
 
 
 
 

Phillip W. Lindley, Executive Director 
ConnectME Authority 

James H. Page, CEO 
James W. Sewall Company 

 
URLs for: 
www.maine.gov/connectme  www.ntia.doc.gov/press/2009/BTOP_mappingtotals_090909.html 
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Appendix B - ConnectME Authority Protective Order 
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STATE OF MAINE December 21, 2009 
 
CONNECTME AUTHORITY PROTECTIVE ORDER 
 (Proprietary Business Information)  
_____________________________________________________________________________ 
 
Pursuant to 35-A M.R.S.A. § 9207(1) and Rule Chapter 101, § 4, the ConnectME Authority (Authority) may 
designate information as confidential to protect the legitimate competitive or proprietary interests of 
communications service providers and mobile communications service providers.  The Authority may designate 
information as confidential only to the minimum extent necessary to protect such legitimate competitive or 
proprietary interests.  Information designated as confidential is not a public record under 1 M.R.S.A. § 402(3). 
 
The Authority is currently conducting a Broadband Mapping and Inventory Project with the services of a 
private contractor, James Sewall Company (Sewall).  Sewall is required to obtain data from service providers 
(Provider) by the Authority and the National Telecommunications and Information Administration (NTIA) 
pursuant to the Broadband Data Improvement Act (BDIA) and the NTIA Notice of Funds Availability (NOFA).  
The NTIA requires that the Authority agree to comply with confidentiality requirements in section 106(h)(2) of 
the BDIA. 
 
It is anticipated that providers submitting data to Sewall or the Authority may have a need to provide 
information considered to be confidential, in that the information provided may involve commercially sensitive 
and/or proprietary information regarding information that identifies (i) the location, type, and technical 
specifications of infrastructure owned, leased, or used by providers or (ii) explicitly identifies providers in 
relation to their specific service area or at a specific service location (collectively, the “Confidential 
Information”).  The Authority has determined that such Confidential Information is generally not disclosed 
publicly, and that the public disclosure of such Confidential Information without restriction would cause 
competitive harm to the applicant or provider.  
 
Accordingly, the following terms shall apply unless and until modified by the Authority or a court of competent 
jurisdiction:   
 
 1.   Data submitted to Sewall or the Authority falling within the above definition of Confidential 
Information, as well as any data submitted to Sewall or the Authority pursuant to the Non-Disclosure 
Agreement set forth in Attachment A , (collectively, “Designated Confidential Information”) shall be deemed to 
be competitively sensitive and/or proprietary in nature and such Designated Confidential Information shall be 
and remain exempt from public disclosure pursuant to the terms of this Protective Order and the articles 
referenced therein.   
  
 2.   All Designated Confidential Information shall be and remain exempt from public disclosure 
pursuant to the terms of this Protective Order, unless removed from the coverage of this Protective Order as 
provided below or otherwise by a court of competent jurisdiction.  No persons provided access to any 
Designated Confidential Information by reason of this Protective Order shall use such information for any 
purpose other than the purposes designated by the Authority.  Every person provided access to Designated 
Confidential Information shall use his or her best efforts to keep the Designated Confidential Information secure 
and shall not publicly disclose it or accord public access to it to any person not authorized by the terms of this 
Protective Order. 
 
 3.   Any person or the Authority may challenge the designation of any document or other 
information as Designated Confidential Information.  The Authority will provide reasonable prior notice to the 
applicant or provider and an opportunity for hearing prior to ruling on any such challenge.  In considering any 
such challenge, the usual burdens of proof and production shall apply and no additional presumption shall be 
given as a result of the prior acceptance by the Authority of material as Designated Confidential Information.  
In the event the Authority should rule over the objections of the person providing the Designated Confidential 
Information that any information should no longer be subject to the terms of this Protective Order, such 
information shall not be publicly disclosed until the later of five (5) business days after the Authority so orders 
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or, if the person files within such five day period an appeal or request for stay of such order, the date upon 
which such appeal or request for stay is decided; provided, however, that said periods may be extended in 
accordance with any stay ordered by the Authority or a reviewing court.  Upon the entry of a final unappealed 
decision by the Authority or a reviewing court granting public disclosure, the terms of this Protective Order 
shall cease to bind any person with respect to the information that the order granting disclosure shall have 
expressly and clearly removed from the coverage of this Protective Order. 
 
 4.   Any person provided access to Designated Confidential Information shall review and be 
bound by the terms of this Protective Order.  Prior to obtaining access to any Designated Confidential 
Information, such person shall sign an acknowledgment of his or her obligation to abide by the terms of this 
Protective Order in the Non-Disclosure Agreement (NDA) attached hereto as Attachment A.   
 
 5.   Unless modified by the Authority or a court of competent jurisdiction, access to Designated 
Confidential Information shall be limited to Authority Staff, Sewall, any independent consultants or experts 
retained by the Authority, the National Telecommunications and Information Administration, and those 
designated persons, who have signed the NDA. 
 
 6.   No copies of Designated Confidential Information shall be circulated to persons other than 
those authorized under paragraph 5 of this Protective Order.  Persons authorized under paragraph 5 hereof also 
may take such notes as may be necessary.  Such notes shall be treated as Designated Confidential Information. 
 
 7.   The restrictions upon, and obligations accruing to, persons who become subject to the terms 
of this Protective Order shall not apply to any Designated Confidential Information submitted in accordance 
with this Protective Order if the Authority rules, after reasonable notice to the applicant or provider and an 
opportunity for hearing, that such Designated Confidential Information was publicly known at the time it was 
furnished or has since become publicly known.  
 
 8.   Where reference to Designated Confidential Information is required in any Authority 
document, such reference shall be by citation of title or attachment number only or by some other non-
confidential description to the extent possible. 
 
 9.   Designated Confidential Information furnished to the Authority pursuant to this Protective 
Order shall remain in the possession of the Authority, under seal, and subject to the terms of this Protective 
Order, until the Authority or a court of competent jurisdiction shall otherwise order. 
 
 10.   The terms of this Protective Order may be modified on motion of any person or on the 
Authority’s own motion upon reasonable prior notice to the applicant or provider and an opportunity for 
hearing. 
 
 
BY ORDER OF THE CONNECTME AUTHORITY 
 

 
____________________________ 
Phillip Lindley, Executive Director 
 
 
ATTACHMENT A  [Non-Disclosure Agreement] 
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Appendix C - Template for Non-Disclosure 
Agreement 
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NON-DISCLOSURE AGREEMENT 
 
THIS AGREEMENT is made this ________ day of _________________, 20___, by and 
between __________________________________________________, a 
________________________________ having a principal place of business at 
______________________________________________________ (“PROVIDER”) and 
ConnectME Authority, a body corporate and politic and a public instrumentality of the State 
of Maine established pursuant to 35-A M.R.S.A. § 9203 (the “AUTHORITY”) and James W. 
Sewall Company, a corporation organized under the laws of the State of Maine and having a 
principal place of business at 136 Center Street, Old Town, Maine  04419 (“SEWALL”) 
(AUTHORITY and SEWALL individually or collectively referred to as “RECIPIENTS”) 
(PROVIDER AND RECIPIENTS collectively referred to as the “Parties”). 
 
Recitals 
 
 WHEREAS, the National Telecommunications and Information Administration (the 
“NTIA”) of the United States Department of Commerce has been charged by Congress under 
the America Recovery and Reinvestment Act of 2009 (the “ARRA”) and the Broadband Data 
Improvement Act (the “BDIA”) to develop and maintain a comprehensive, interactive, and 
searchable nationwide inventory map of existing broadband service capability and 
availability in the United States that depicts the geographic extent to which broadband 
service is deployed and available from a commercial or public provider throughout each state 
(the “Data”); and 
 
WHEREAS, the AUTHORITY is responsible for developing and maintaining the Data for 
the State of Maine and for serving as a conduit for the Data to the NTIA; and 
 
WHEREAS, SEWALL is contracted by the AUTHORITY to undertake the initial mapping 
and to consult with the AUTHORITY on how best to update and maintain the Data going 
forward; and 
 
WHEREAS, the PROVIDER has trade secrets and commercial or financial information 
relating to the location, type, and technical specifications of infrastructure owned, leased, or 
used by PROVIDER, which is included in the Data (the “PROVIDER Information”); and 
 
WHEREAS, the PROVIDER has agreed to provide PROVIDER Information to SEWALL 
and/or the AUTHORITY pursuant to the requirements of the ARRA and the BDIA for use by 
the NTIA. 
 
NOW THEREFORE, for and in consideration of the mutual promises and covenants 
contained herein, and for other good and valuable consideration, the receipt and sufficiency 
of which is hereby acknowledged, the Parties agree as follows: 
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 1. As requested in writing by PROVIDER, RECIPIENTS agree to hold in 
absolute and strict confidence and shall not disclose or reveal in any manner or form to any 
entity other than the NTIA any PROVIDER Information identified as confidential that 
identifies (i) the location, type, and technical specifications of infrastructure owned, leased, 
or used by PROVIDER or (ii) explicitly identifies PROVIDER in relation to its specific 
service area or at a specific service location (collectively, the “Confidential Information”), 
whether such disclosure was made orally, in writing, or in any other form, without prior 
written permission from PROVIDER.   
 
Notwithstanding the foregoing, Confidential Information shall not include the following: 
 
(a)  information that now is or hereinafter becomes publicly known or available otherwise 
than through unauthorized disclosure by RECIPIENTS; 
(b)  information that was in RECIPIENTS’ possession at the time of disclosure and was not 
acquired, directly or indirectly, from PROVIDER; 
(c)  information that RECIPIENTS received in good faith from a third party who is not under 
a similar restriction of confidentiality and having a right to disclose the Confidential 
Information; or 
(d)  information that is required to be disclosed pursuant to applicable law or judicial or 
administrative action or proceeding, including the Freedom of Information Act requirements. 
 
 2. RECIPIENTS agree not to use for any purpose the Confidential Information 
except as provided for under the ARRA and the BDIA, without prior written permission from 
PROVIDER.  
 
 3. This Agreement shall be governed by the laws of the State of Maine and 
applicable federal law, except for the State of Maine’s conflict-of-laws provisions, as 
applicable.  The Parties to this Agreement each specifically consent to jurisdiction in Maine 
in connection with any dispute between the Parties arising out of this Agreement or 
pertaining to the subject matter hereof, with venue being in a court of competent jurisdiction 
located in Penobscot or Kennebec County, Maine, United States of America. 
 
 4. This Agreement shall inure to the benefit of and be binding on the Parties and 
their respective successors and assigns. 
  
 5. This Agreement constitutes the complete and exclusive agreement of the 
Parties hereto with respect to the matters set forth herein.  The terms of this Agreement may 
not be modified or amended except by an instrument in writing signed by each of the Parties 
hereto.  
 
 6. This Agreement shall be construed without regard to any presumption or other 
rule requiring construction against the drafting Party. 
 
 7. This Agreement may be executed in counterparts and each Party hereto may 
execute each such counterpart, each of which when executed and delivered shall be deemed 
to be an original and both of which counterparts taken together shall constitute but one and 
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the same instrument.  This Agreement shall become binding when all counterparts taken 
together shall have been executed and delivered by all Parties.  Execution and delivery of this 
Agreement may be made by facsimile transmission, and each Party agrees that the delivery 
of the Agreement by facsimile shall have the same force and effect as delivery of original 
signatures and that each Party may use such facsimile signatures as evidence of the execution 
and delivery of the Agreement by all Parties to the same extent that an original signature 
could be used. 
 
IN WITNESS WHEREOF, the Parties have executed this Agreement the day and year first 
above written.   
 
 
WITNESSED BY: PROVIDER 
 
 
___________________________________ By:
 ___________________________________ 
 Title:
 ___________________________________ 
 
 
 ConnectME Authority 
 
 
___________________________________ By:
 ___________________________________ 
 Title:
 ___________________________________ 
 
 
 James W. Sewall Company 
 
 
___________________________________ By:
 ___________________________________ 
 Title:
 ___________________________________ 
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Appendix D - White Paper:  Maine-SBDD Census 
Block-Street Segment Misalignment 
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Misalignment between Census Blocks & Maine E911 Str eets 

 
Technical Whitepaper 

 
30 September 2011 

Introduction 

Importing broadband service provider data into the State Broadband Data Development 
(SBDD) Map Data Transfer Model at the census block versus street segment level has 
created challenges for the grantees.  For the State of Maine one of the challenges involves the 
spatial misalignment between the Census Block polygon geometries and Maine’s street 
centerline dataset. 
 
In order to better understand the challenge that Maine is encountering it is necessary to 
review how the State is collecting and maintaining broadband service provider data.   
 
As a result of Maine’s geographic population distribution, mapping broadband service at a 
census block level does not satisfy the State’s requirements for statewide broadband tracking 
and development.  Instead of utilizing the hybrid census block-street centerline model 
outlined in the SBDD NOFA, the State is collecting service provider coverages at a street 
level for wired and fixed wired technologies.  The State has developed a relational model to 
best represent the one-to-many relationship between a street segment and its broadband 
service provider coverages. 
 
The street segment data that the State is utilizing is based primarily on the State’s E911 street 
centerline GIS layer with additional street coverage added from a 3rd party dataset for those 
towns not yet participating in the E911 project.  For information on the broadband service 
providers, a database table was developed based on the required attribution descriptions 
outlined in the NOFA. 
 
With the data structure in place the challenge of importing this data into the transfer model 
can be discussed along with the State’s proposed solution to minimize its impact of the 
misalignment on the broadband data processing. 
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The Challenge 

Census Block geometry is spatially misaligned with the Maine’s street centerlines. 
 
Examples described herein reference 2000 Census Block data and reflect examples found in 
both 2000 and 2010 Census Block datasets. 
 

 
 
As shown in the above screen capture the typical misalignment between these two datasets is 
between 50 and 100 feet. 
 
Since Maine is storing all broadband service providers’ information as records associated 
with street centerlines this misalignment causes considerable challenges when trying to 
accurately export this information into the new SBDD data transfer model.  The 
misalignment is great enough that utilizing basic intersect methodology is not enough to 
provide NTIA with a highly accurate representation of broadband coverage in Maine. 
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Example: Basic Intersect 
 

 
 
The above screen capture shows an example of a 2000 Census Block that is greater than 2 
square miles and Provider ‘A’ street coverage data that is to be reported. 
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Performing an intersect between the greater than 2 square mile census block and the street 
network for Provider ‘A’ results in the highlighted streets being reported.   
 

 
 
It is clear from the screen capture that several extra streets where selected and a few streets 
were missed by using the intersection method. 
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Proposed Technical Solution 

The solution to this challenge is a multi-step process that needs to be run on each street 
segment with intelligent analysis employed to minimize errant representation of broadband 
service in census blocks greater that 2 square miles. 
 
The first step is to create mid points of the street centerlines for Provider ‘A’. 
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The next step is to create a buffer around the mid points using a distance to compensate for 
the misalignment in the census blocks.  The distance found to have the best return for this 
process was determined to be 100 feet. 
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Selecting the buffered mid points that intersect the greater than 2 square miles census block 
returns the following results: 
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The selected buffered mid points relate back to the following street selection: 
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Compare this selection to the original intersection process selection: 
 

 
 
The result of the mid point buffering process is a much better representation of streets 
contained within the greater than 2 square miles census block.  A large number of the 
erroneous streets initially marked as included in the census block have been dropped 
providing a much improved report. 
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Taking a look at the left hand side of the map there is a street that intersects the census block 
but is not reported in the mid point buffering process.  A closer look reveals why. 
 

 
 
The street in question is relatively long in length and has a midpoint that is located outside of 
the greater than 2 square miles census block resulting in it not being reported. 
 
Building onto what has been performed already an additional automation check can locate 
and incorporate these long streets into the dataset. 
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The Proposed Solution: Additional Intelligence 

The first step in this additional iteration is to select streets that have not been flagged as being 
contained within a census block greater than 2 square miles and are longer than 500 feet.  
Then create points that are offset 200 feet from each end of the selected streets. 
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Next these 200 feet offset points are buffered 100 feet: 
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Then by selecting the buffers that intersect the greater than 2 square miles census block and 
selecting the associated streets, the process results in the following: 
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The Results 

The screen capture below shows the streets reported using the two step process in 
comparison to the basic intersect method of reporting street segments. 
 

 
 
The following table shows the results of the processes for Provider ‘A’ for this particular 
census block: 
 

Method 
Missed 
Streets 

Extra 
Streets %Error 

Basic Intersect Process 2 11 35.14 
MID Point Process 1 2 8.11 
MID and END Point 
Process 0 2 5.41 

 
The proposed solution gives a much better representation of the data set and minimizes the 
errors induced by using a basic intersection process. 
 



  SBDD Process Documentation 
  October 2011 Delivery 

 Page 73 of 78 last revised 2011.09.30 

Summary 

The SBDD data submission requirements involving census blocks and street segments have 
created a challenge for the grantees to accurately represent broadband service provider 
information.  In particular the State of Maine has a significant offset between the 2010 
Census Block geometries and the corresponding street centerlines that the State is utilizing to 
map broadband availability data.  A basic spatial intersect method has proven to be highly 
inaccurate in identifying street centerline data in census blocks greater than 2 square miles. 
 
Through analysis the State has found that using a two step process using mid-point and offset 
end point buffering provides improved results for street centerlines in the greater than 2 
square mile census blocks.  The State expects this methodology to improve the accuracy of 
street segment determination by approximately 50% for these regions.  Unless instructed 
otherwise by the NTIA project team, the State intends to utilize this two step process to 
develop the SBDD deliverables for street centerlines in census blocks greater than 2 square 
miles. 
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Appendix E – Residential Survey Letter 
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Appendix F – Mobile Provider Feedback Letter 
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Complete 163
Non-Responsive/Refused 22
In Progress 2

Count of Datasets by Status 187
Total Unique Providers Represented 136

Provider Name Platform Status
NDA Execution 

Date Notes

Air Advantage, LLC Fixed Wireless Data Added to Statewide Inventory 3/15/2010

[AUG-24-11 Sarah Finne] Change and Correction: New 
fixed wireless towers in operation and corrected speeds 
(all 3650-3700 MHz towers should be speed tier 6 
download and all Unlicensed towers should be speed 
tier 4 download).

AIRGRANT.COM, INC. Fixed Wireless Data Added to Statewide Inventory
[AUG-18-11 Sarah Finne] Change: New fixed wireless 
provider in the market.

AT&T Inc. DSL Data Added to Statewide Inventory 12/16/2009

[AUG-23-11 Sarah Finne] Change and/or Correction: 
Possible service expansion or corrections to previous 
dataset; entirely new dataset provided for October 2011 
submission.

AT&T Inc. Mobile Wireless Data Added to Statewide Inventory 12/16/2009

[AUG-15-11 Sarah Finne] Change: Network expansion 
to include more of central/western Michigan, with 
additional coverage in Marquette (upper peninsula).

Baraga Telephone Company DSL Data Added to Statewide Inventory 1/14/2010

[SEP-16-11 Sarah Finne] Correction: Fixed some 
alignment issues within their coverage area and 
changed speeds to match DSL-only, per the advertised 
speeds listed on their website.

Baraga Telephone Company Fiber Data Added to Statewide Inventory 1/14/2010

[SEP-16-11 Sarah Finne] Change: Network expansion to 
include additional FTTH areas and provider upgrade 
infrastructure to provide speed tier 9 in most FTTH 
areas.

Block Communications, Inc. Cable Data Added to Statewide Inventory 4/12/2010

[SEP-16-11 Sarah Finne] Correction: Provider corrected 
speed offerings to what is available to the general public 
(tier 7 download speeds) and updated DBA name to 
"Buckeye CableSystem."

Bloomingdale Telephone Company, Inc. DSL Data Added to Statewide Inventory 1/25/2010

[SEP-16-11 Sarah Finne] Change: Provider upgraded 
infrastructure and can now offer speed tier 6 download 
speeds.

CenturyLink DSL Data Added to Statewide Inventory 12/4/2009

[AUG-17-11 Sarah Finne] Change and/or Correction: 
possible service expansion or corrections to previous 
dataset; entirely new dataset provided for October 2011 
submission.

Charter Communications, Inc. Cable Data Added to Statewide Inventory 12/15/2009

[AUG-16-11 Sarah Finne] Change and/or Correction: 
Possible service expansion or corrections to previous 
dataset; entirely new dataset provided for October 2011 
submission.

Clearwire Corporation Mobile Wireless Data Added to Statewide Inventory 3/17/2011

[AUG-16-11 Sarah Finne] Change and/or Correction: 
Possible service expansion or corrections to previous 
dataset; entirely new dataset provided for October 2011 
submission.

Comcast Cable Communications, LLC Cable Data Added to Statewide Inventory 12/7/2009

[AUG-26-11 Sarah Finne] Change and/or Correction: 
Possible service expansion or corrections to previous 
dataset; entirely new dataset provided for October 2011 
submission.

Crystal Automation Systems, Inc. Fixed Wireless Data Added to Statewide Inventory 6/25/2010
[AUG-24-11 Sarah Finne] Change: New fixed wireless 
towers in operation.

D&P Communications, Inc. Fixed Wireless Data Added to Statewide Inventory 3/8/2011
[AUG-24-11 Sarah Finne] Change: Provider launched 
new fixed wireless platform with 3 towers.

Farmers Mutual Telephone Company of Chapin, Inc. DSL Data Added to Statewide Inventory 10/26/2010

[SEP-16-11 Sarah Finne] Change: Provider changed 
name from "Farmers Mutual Telephone Company" to 
"Farmers Mutual Telephone Company of Chapin, Inc."

Fast-Air Internet, Inc. Fixed Wireless Data Added to Statewide Inventory
[AUG-18-11 Sarah Finne] Change: New fixed wireless 
provider in the market.

FNW, LLC Fixed Wireless Data Added to Statewide Inventory 2/12/2010

[AUG-24-11 Sarah Finne] Change and Correction: New 
fixed wireless towers in operation and corrected speeds 
(all towers should be speed tier 4 download).

Frontier Communications Corporation DSL Data Added to Statewide Inventory 1/22/2010

[AUG-18-11 Sarah Finne] Change: Network expansion 
to include several new Central Offices and Remote 
Terminals.

Great Lakes Satellite Group Fixed Wireless Data Added to Statewide Inventory

[SEP-16-11 Sarah Finne] Correction: Great Lakes 
Satellite Group was previously non-responsive, but they 
provided data this round.

Hiawatha Communications, Inc. DSL Data Added to Statewide Inventory 2/2/2010
[AUG-08-11 Sarah Finne] Change: Network expansion 
(new Remote Terminals).

I-2000, Inc. DSL Data Added to Statewide Inventory 3/7/2011
[AUG-22-11 Sarah Finne] Change: Network expansion 
(added additional DSLAM locations).

I-2000, Inc. Fixed Wireless Data Added to Statewide Inventory 3/7/2011
[AUG-24-11 Sarah Finne] Change: Provider deactivated 
7 fixed wireless tower sites.

Iron Bay Computer & Design Fixed Wireless Data Added to Statewide Inventory 1/14/2010
[SEP-16-11 Sarah Finne] Change: Provider 
decommissioned 3 tower sites.

Leap Wireless International, Inc. Mobile Wireless Data Added to Statewide Inventory 4/5/2010

[AUG-22-11 Sarah Finne] Change and/or Correction: 
Possible service expansion or corrections to previous 
dataset; entirely new dataset provided for October 2011 
submission.

Parish Communications Cable Data Added to Statewide Inventory 7/1/2010

[SEP-16-11 Sarah Finne] Change: Provider upgraded 
infrastructure and can now offer speed tier 6 download 
speeds in select areas, and speed tier 4 in other areas.

SonicNet, Inc. Fixed Wireless Data Added to Statewide Inventory 8/4/2011
[AUG-24-11 Sarah Finne] Change: New fixed wireless 
provider in the market.

Broadband Provider Log



Springcom, Inc. Cable Data Added to Statewide Inventory 2/25/2010

[SEP-16-11 Sarah Finne] Change and Correction: 
Corrected some coverage that was mis-aligned, per field 
audit, and provider upgraded infrastructure and can now 
offer tier 6 download speeds.

Sprint Nextel Corporation Mobile Wireless Data Added to Statewide Inventory 1/14/2010

[AUG-16-11 Sarah Finne] Change and/or Correction: 
Possible service expansion or corrections to previous 
dataset; entirely new dataset provided for October 2011 
submission.

T-Mobile USA, Inc. Mobile Wireless Data Added to Statewide Inventory 1/8/2010

[AUG-16-11 Sarah Finne] Change and/or Correction: 
Possible service expansion or corrections to previous 
dataset; entirely new dataset provided for October 2011 
submission.

TDS Telecommunications Corporation DSL Data Added to Statewide Inventory 1/27/2010

[AUG-16-11 Sarah Finne] Change and/or Correction: 
Possible service expansion or corrections to previous 
dataset; entirely new dataset provided for October 2011 
submission.

The Computer Care Company, Inc. DSL Data Added to Statewide Inventory 3/8/2011
[AUG-08-11 Sarah Finne] Change: Network expansion 
(new Central Office).

The Computer Care Company, Inc. Fixed Wireless Data Added to Statewide Inventory 3/8/2011
[AUG-08-11 Sarah Finne] Change: New fixed wireless 
towers in operation.

Time Warner Cable LLC Cable Data Added to Statewide Inventory 12/21/2009

[AUG-16-11 Sarah Finne] Change and/or Correction: 
Possible service expansion or corrections to previous 
dataset; entirely new dataset provided for October 2011 
submission.

Tucker Communications, Inc. Fixed Wireless Data Added to Statewide Inventory 2/17/2011

[AUG-08-11 Sarah Finne] Correction: Recreated 900 
MHz signal propagation to decrease/refine coverage 
area.

United States Cellular Corporation Mobile Wireless Data Added to Statewide Inventory 2/15/2011

[AUG-16-11 Sarah Finne] Change and/or Correction: 
Possible service expansion or corrections to previous 
dataset; entirely new dataset provided for October 2011 
submission.

Verizon North Inc. Mobile Wireless Data Added to Statewide Inventory 12/14/2009

[AUG-16-11 Sarah Finne] Change and/or Correction: 
Possible service expansion or corrections to previous 
dataset; entirely new dataset provided for October 2011 
submission.

Waldron Communication Company Fixed Wireless Data Added to Statewide Inventory 1/12/2010

[SEP-16-11 Sarah Finne] Change: Provider upgraded 
tower infrastructure (raised transmit antenna heights), 
therefore propagations were recreated.

Waldron Communication Company DSL Data Added to Statewide Inventory 1/12/2010

[SEP-16-11 Sarah Finne] Change: Provider upgraded 
infrastructure and can now offer speed tier 3 upload 
speeds.

West Michigan Broadband, LLC Fixed Wireless Data Added to Statewide Inventory

[AUG-29-11 Sarah Finne] Correction: West Michigan 
Broadband was previously non-responsive, but they 
provided data this round.

WideOpenWest Michigan, LLC Cable Data Added to Statewide Inventory

[SEP-16-11 Sarah Finne] Correction: WideOpenWest 
Michigan, LLC previously refused to participate, but they 
provided data this round.

Xyotek, LLC Fixed Wireless Data Added to Statewide Inventory
[AUG-24-11 Sarah Finne] Change: New fixed wireless 
provider in the market.

AT&T Inc. Backhaul Backhaul Provider Only Processing Complete 12/16/2009
Charter Communications, Inc. Backhaul Backhaul Provider Only Processing Complete 12/15/2009
Level 3 Communications, LLC Backhaul Backhaul Provider Only Processing Complete 12/14/2009
MegaPath Inc. Backhaul Backhaul Provider Only Processing Complete 2/15/2010
Sprint Nextel Corporation Backhaul Backhaul Provider Only Processing Complete 1/14/2010
T-Mobile USA, Inc. Backhaul Backhaul Provider Only Processing Complete 1/8/2010
TDS Telecommunications Corporation Backhaul Backhaul Provider Only Processing Complete 1/27/2010
Windstream Communications Backhaul Backhaul Provider Only Processing Complete
Zayo Bandwidth, LLC Backhaul Backhaul Provider Only Processing Complete
2125 Cable Company, LLC Cable No Update to Provide 3/22/2010
Ace Telephone Company of Michigan Inc. DSL No Update to Provide 1/12/2010
Agri-Valley Communications, Inc. Backhaul No Update to Provide 1/22/2010
Agri-Valley Communications, Inc. Fixed Wireless No Update to Provide 1/22/2010
Agri-Valley Communications, Inc. DSL No Update to Provide 1/22/2010
Agri-Valley Communications, Inc. Mobile Wireless No Update to Provide 1/22/2010
Allband Communications Cooperative Fiber No Update to Provide 2/2/2010
Allendale Telephone Company DSL No Update to Provide 2/4/2010
Allendale Telephone Company Fiber No Update to Provide 2/4/2010
Azulstar, Inc. Fixed Wireless No Update to Provide 1/27/2010
Barry County Telephone Company DSL No Update to Provide
Barry County Telephone Company Fiber No Update to Provide
Barry County Telephone Company Fixed Wireless No Update to Provide
Blanchard Telephone Association, Inc. DSL No Update to Provide 6/17/2010
Blanchard Telephone Association, Inc. Backhaul No Update to Provide 6/17/2010
Bloomingdale Telephone Company, Inc. Fixed Wireless No Update to Provide 1/25/2010
Bloomingdale Telephone Company, Inc. Fiber No Update to Provide 1/25/2010
Bright House Networks, LLC Cable No Update to Provide 4/26/2010

Broadstripe LLC Cable No Update to Provide 3/5/2010

[SEP-12-11 Sarah Finne] Correction: Incorrectly reported 
DOCSIS 3.0 as technology type; changed to "Cable 
Modem - Other."

Cable America Michigan, LLC Cable No Update to Provide 3/9/2011
Camp Communication Services, Inc. Fixed Wireless No Update to Provide
Carr Communications, Inc. DSL No Update to Provide 1/15/2010
CCI Systems, Inc. Cable No Update to Provide 6/29/2010
CenturyLink Backhaul No Update to Provide 12/4/2009
City of Norway Cable No Update to Provide 3/14/2011
Climax Telephone Company Backhaul No Update to Provide 1/14/2010
Climax Telephone Company DSL No Update to Provide 1/14/2010
Coldwater Board of Public Utilities Cable No Update to Provide 3/1/2010
Crystal Automation Systems, Inc Backhaul No Update to Provide 6/25/2010
Custom Software Inc. DSL No Update to Provide 2/3/2010
D&P Communications, Inc. Cable No Update to Provide 3/8/2011
D&P Communications, Inc. Fiber No Update to Provide 3/8/2011
Daystarr Communications, LLC Backhaul No Update to Provide
Daystarr Communications, LLC DSL No Update to Provide
Daystarr Communications, LLC Fiber No Update to Provide



DISH Network Corporation Satellite No Update to Provide 1/27/2010

[SEP-16-11 Sarah Finne] Correction: Satellite data is 
being submitted and was not included in the April 2011 
submission. While coverage is currently the entire state 
boundary, work continues on having more granular data 
available.

DMCI Broadband, LLC Fixed Wireless No Update to Provide 2/3/2010

[SEP-16-11 Sarah Finne] Correction: Changed speed 
tier 7 to speed tier 6 on some towers to reflect the 
residential speed packages offered (provider 
accidentally reported business speeds).

Endless Journey, Inc. Fixed Wireless No Update to Provide
Frontier Communications Corporation Backhaul No Update to Provide 1/22/2010
Great Lakes Comnet, Inc. Backhaul No Update to Provide
Great Lakes Internet, Inc. Fixed Wireless No Update to Provide 3/11/2010
Hiawatha Communications, Inc. DSL No Update to Provide 2/2/2010
Hiawatha Communications, Inc. DSL No Update to Provide 2/2/2010
Hiawatha Communications, Inc. Fiber No Update to Provide 2/2/2010
Hiawatha Communications, Inc. DSL No Update to Provide 2/2/2010
Hidden Lake Wireless, Inc. Fixed Wireless No Update to Provide 3/12/2010

Hughes Network Systems, LLC Satellite No Update to Provide 2/5/2010

[SEP-16-11 Sarah Finne] Correction: Satellite data is 
being submitted and was not included in the April 2011 
submission. While coverage is currently the entire state 
boundary, work continues on having more granular data 
available.

Interlink Computers Technology, Inc. Fixed Wireless No Update to Provide 3/12/2010
Iron River Cooperative TV Antenna Corp Cable No Update to Provide 7/27/2010
ISP Management, Inc. Fixed Wireless No Update to Provide 3/22/2010
Kaltelco, LLC DSL No Update to Provide 3/5/2010
Lennon Telephone Company DSL No Update to Provide 1/25/2010
Lennon Telephone Company Cable No Update to Provide 1/25/2010
Ligonier Telephone Company, Inc. Fixed Wireless No Update to Provide 3/31/2010
Mercury Network Corporation Backhaul No Update to Provide 3/9/2011
Mercury Network Corporation Fixed Wireless No Update to Provide 3/9/2011
Merit Network, Inc. Backhaul No Update to Provide 6/21/2010
MetaLINK Technologies, Inc. Fixed Wireless No Update to Provide 3/22/2010
Michigan Cable Partners Inc. Cable No Update to Provide 6/18/2010
Michwave Technologies, Inc. Fixed Wireless No Update to Provide 3/12/2010
Newaygo County Advanced Technology Services Fixed Wireless No Update to Provide
Niagara Telephone Company Backhaul No Update to Provide 1/22/2010
Niagara Telephone Company DSL No Update to Provide 1/22/2010
Northside TV Corporation Cable No Update to Provide
Ogden Communications, Inc. DSL No Update to Provide 1/19/2010
Ogden Communications, Inc. Fixed Wireless No Update to Provide 1/19/2010
One Communications Corporation Backhaul No Update to Provide 3/18/2010
Peninsula Fiber Network, LLC Backhaul No Update to Provide 1/14/2010
Sand Creek Communications Company DSL No Update to Provide 3/2/2010
Sand Creek Communications Company Backhaul No Update to Provide 3/2/2010
Sister Lakes Cable TV Cable No Update to Provide
Small Business Solutions Group L.L.C. Fixed Wireless No Update to Provide 7/20/2010
SpeedNet, LLC Fixed Wireless No Update to Provide 1/7/2010
SpeedNet, LLC Backhaul No Update to Provide 1/7/2010
Springcom, Inc. DSL No Update to Provide 2/25/2010
Summit Digital Holdings, Inc. Cable No Update to Provide
Summit Digital Holdings, Inc. Fixed Wireless No Update to Provide
T2 Communications, LLC Backhaul No Update to Provide 3/10/2010
T2 Communications, LLC Fiber No Update to Provide 3/10/2010
The Computer Care Company, Inc. Backhaul No Update to Provide 3/8/2011
The Iserv Company, LLC Backhaul No Update to Provide 6/21/2010
The Iserv Company, LLC DSL No Update to Provide 6/21/2010
The Iserv Company, LLC DSL No Update to Provide 6/21/2010
The Iserv Company, LLC Fiber No Update to Provide 6/21/2010
Town & Country Cable and Telecommunications, LLC Cable No Update to Provide 6/18/2010
Upper Peninsula Telephone Company DSL No Update to Provide 1/11/2010
US Signal Company, LLC Backhaul No Update to Provide 2/25/2010
Verizon North Inc. Backhaul No Update to Provide 12/14/2009
Westphalia Telephone Company DSL No Update to Provide 1/20/2010

WildBlue Communications, Inc. Satellite No Update to Provide 1/8/2010

[SEP-16-11 Sarah Finne] Correction: Satellite data is 
being submitted and was not included in the April 2011 
submission. While coverage is currently the entire state 
boundary, work continues on having more granular data 
available.

Winn Telephone Company DSL No Update to Provide 6/28/2010
Winn Telephone Company Fiber No Update to Provide 6/28/2010
Winn Telephone Company Fixed Wireless No Update to Provide 6/28/2010
Wyandotte Municipal Services Cable No Update to Provide 3/23/2010
XO Communications, LLC Backhaul No Update to Provide 2/12/2010

BigTube Wireless, LLC Fixed Wireless
No Update Provided - Use Last Submission 
Data 6/17/2010

Boardman River Communications, LLC Cable
No Update Provided - Use Last Submission 
Data 2/10/2010

Cherry Capital Connection, LLC Fixed Wireless
No Update Provided - Use Last Submission 
Data 12/28/2009

CMS Internet LLC   Fixed Wireless
No Update Provided - Use Last Submission 
Data 3/11/2010

Cogent Communications, Inc. Backhaul
No Update Provided - Use Last Submission 
Data

COLI, Inc. Fixed Wireless
No Update Provided - Use Last Submission 
Data

CSInet Internet Access Corp. Fixed Wireless
No Update Provided - Use Last Submission 
Data 3/31/2010

Drenthe Telephone Company DSL
No Update Provided - Use Last Submission 
Data 2/4/2010

Fourway Computer Products, Inc. Fixed Wireless
No Update Provided - Use Last Submission 
Data

Ideal Wireless, Inc. Fixed Wireless
No Update Provided - Use Last Submission 
Data

Invisalink Wireless Enterprises LLC Fixed Wireless
No Update Provided - Use Last Submission 
Data 4/13/2010



KEPS Technologies, Inc. Fixed Wireless
No Update Provided - Use Last Submission 
Data

KEPS Technologies, Inc. DSL
No Update Provided - Use Last Submission 
Data

Lighthouse Computers, Inc. Fixed Wireless
No Update Provided - Use Last Submission 
Data 2/17/2011

Nodin Communications, LLC Fixed Wireless
No Update Provided - Use Last Submission 
Data 4/22/2010

PAETEC Communications, Inc. DSL
No Update Provided - Use Last Submission 
Data

[SEP-16-11 Sarah Finne] Change: PAETEC purchased 
Talk America/Cavalier Telephone.  Submitted Cavalier 
Tel. coverage based on April 2011 data.

PAETEC Communications, Inc. Backhaul
No Update Provided - Use Last Submission 
Data

Pasty.Net, Inc. Fixed Wireless
No Update Provided - Use Last Submission 
Data 1/6/2010

Endless Journey, Inc. DSL Solicited Initial Data
[SEP-16-11 Sarah Finne] Provider hasn't had time to 
gather DSL data.

PAETEC Communications, Inc. DSL Other

[SEP-08-11 Wes Kerr] Multiple outreach attempts were 
conducted but no response was received. PAETEC was 
bought out during the collection phase of this round by 
Windstream and we intend to be able to include the 
PAETEC coverage as a part of the Windstream footprint 
during the next round.

Dreamscape Communications Fixed Wireless Refused to Participate

[MAY-26-11 Terry Holmes] Found this company through 
a WISPA listserv e-mail and located an active website.  
Called listed phone number and spoke with company 
representative who confirmed they are an active WISP, 
but would not provide his name and stated he was not 
interested then hung up the phone.  E-mailed NDA and 
data collection spreadsheet to support@dreamscp.com.

M3 Wireless Fixed Wireless Refused to Participate

[JUN-28-11 Terry Holmes] Spoke with company 
representative.  They have no interest in the program 
and refuse to participate.

Banyan OnLine Services, LLC. Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made between 
June 4, 2010 and February 15, 2011, 7 additional 
attempts were made this period.

Bitwise Wireless, LLC Fixed Wireless Non-Responsive to Multiple Attempts
7 contact attempts were made between May 24, 2011 
and August 8, 2011.

Boardman River Communications, LLC Fixed Wireless Non-Responsive to Multiple Attempts 2/10/2010

In addition to multiple contact attempts made between 
July 23, 2010 and February 15, 2011, 6 additional 
attempts were made this period.

DSTech Fixed Wireless Non-Responsive to Multiple Attempts
4 contact attempts were made between May 24, 2011 
and July 29, 2011.

Global Crossing Telecommunications, Inc. Backhaul Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made between 
July 1, 2010 and February 17, 2011, 3 additional 
attempts were made this period.

Hi-Tech SMR Communications Fixed Wireless Non-Responsive to Multiple Attempts
5 contact attempts were made between May 24, 2011 
and August 8, 2011.

Internet 123, Inc. Fixed Wireless Non-Responsive to Multiple Attempts
6 contact attempts were made between May 24, 2011 
and August 9, 2011.

Lewiston Communications Cable Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made between 
July 1, 2010 and February 15, 2011, 6 additional 
attempts were made this period.

M55 WiFi Wireless Internet Service Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made between 
July 1, 2010 and February 15, 2011, 5 additional 
attempts were made this period.

Microtech Services, Inc. Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made between 
July 1, 2010 and February 14, 2011, 5 additional 
attempts were made this period.

Mutual Data Services, Inc. Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made between 
July 1, 2010 and February 14, 2011, 5 additional 
attempts were made this period.

Network Computers, LLC Fixed Wireless Non-Responsive to Multiple Attempts

Initial contact was made on July 28, 2010, but they did 
not have any active wireless broadband at that time. 
During this perioed, 5 contact attempts were made 
between June 6, 2011 and August 9, 2011. 
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Complete 171
Non-Responsive/Refused 10
In Progress 6

Count of Datasets by Status 187
Total Unique Providers Represented 120

Provider Name Platform Status
NDA Execution 

Date Notes

AirLink Broadband, LLC Fixed Wireless Data Added to Statewide Inventory

[SEP-12-11 Brian Dudek] Change: 
New provider in service for October 
2011 submission.

Arrowhead Communications Corporation DSL Data Added to Statewide Inventory 4/14/2010

[SEP-12-11 Brian Dudek] 
Change/Correction: Provider 
upgraded upload speed capabilities 
and corrected coverage from a 
received broadband inquiry.

AT&T Corp, Inc. Mobile Wireless Data Added to Statewide Inventory 12/16/2009

[SEP-12-11 Brian Dudek] Change: 
Provider expanded mobile territory 
throughout the state.

Benton Cooperative Telephone Company Cable Data Added to Statewide Inventory 6/16/2010

[SEP-12-11 Brian Dudek] Change: 
Provider indicated they also have a 
CLEC operation in Milaca.

Broadband Corp Fixed Wireless Data Added to Statewide Inventory 5/11/2010

[SEP-12-11 Brian Dudek] Change: 
Recreated propagations due to 
additions and deletions for 
unlicensed and licensed area.  

Cable ONE Inc. Cable Data Added to Statewide Inventory 12/7/2009

[SEP-12-11 Brian Dudek] 
Change/Correction: possible 
service expansion or corrections to 
previous dataset; entirely new 
dataset for October 2011 
submission.  Coverage change 
likely a result of the 2000-2010 
census change.

CenturyLink DSL Data Added to Statewide Inventory 12/4/2009

[SEP-12-11 Brian Dudek] 
Change/Correction: possible 
service expansion or corrections to 
previous dataset; entirely new 
dataset for October 2011 
submission.  Provider expanded 
DSL territory by acquiring Qwest 
Corporation.

Charter Communications, Inc. Cable Data Added to Statewide Inventory 12/15/2009

[SEP-12-11 Brian Dudek] 
Change/Correction: possible 
service expansion or corrections to 
previous dataset; entirely new 
dataset for October 2011 
submission.  Coverage change 
likely primarily a result of the 2000-
2010 census change.

CitEscape, LLC Fixed Wireless Data Added to Statewide Inventory 1/25/2010

[AUG-30-11 Brian Dudek] 
Correction: Corrected 3650 MHz 
maximum advertised download 
speeds to speed tier 7 from 
previously submitted 8.

Clearwire Corporation Mobile Wireless Data Added to Statewide Inventory 3/3/2010

[SEP-12-11 Brian Dudek] Change: 
Provider pulled back on prior 
coverage north of Anoka.

Comcast Cable Communications, LLC Cable Data Added to Statewide Inventory 12/7/2009

[SEP-12-11 Brian Dudek] 
Change/Correction: possible 
service expansion or corrections to 
previous dataset; entirely new 
dataset for October 2011 
submission.  Coverage change 
likely primarily a result of the 2000-
2010 census change.

Consolidated Telephone Company Fiber Data Added to Statewide Inventory

[SEP-12-11 Brian Dudek] 
Correction: Nisswa and Baxter 
coverage was added back.  
Coverage was inadvertently 
removed in the April submission 
and was not caught by the 
provider.  

Crosslake Telephone Company DSL Data Added to Statewide Inventory 6/16/2010

[SEP-12-11 Brian Dudek] Change: 
Provider converted some DSL 
infrastructure to fiber.

Broadband Provider Log



Crosslake Telephone Company Fiber Data Added to Statewide Inventory 6/16/2010
[SEP-12-11 Brian Dudek] Change: 
Provider expanded fiber territory.

Eagle Valley Telephone Company DSL Data Added to Statewide Inventory 4/14/2010

[SEP-12-11 Brian Dudek] Change: 
Provider upgraded speed 
capabilities.

Farmers Mutual Telephone Company Fiber Data Added to Statewide Inventory 4/1/2010

[SEP-12-11 Brian Dudek] Change: 
Provider upgraded speed 
capabilities.

Federated Telephone Cooperative Fiber Data Added to Statewide Inventory 4/1/2010

[SEP-12-11 Brian Dudek] Change: 
Provider upgraded speed 
capabilities.

Felton Telephone Company DSL Data Added to Statewide Inventory 4/14/2010

[SEP-12-11 Brian Dudek] Change: 
Provider upgraded speed 
capabilities.

Fibernet Monticello Fiber Data Added to Statewide Inventory

[SEP-12-11 Brian Dudek] 
Correction: New provider for 
October 2011 submission that was 
previously unresponsive.

Frontier Communications of Minnesota, Inc. DSL Data Added to Statewide Inventory 1/22/2010

[AUG-17-11 Brian Dudek] 
Change/Correction: Provider 
expanded DSL territory by adding 
additional CO/RT's.  Modified 
coverage throughout where 
incorrect CO/RT coordinates were 
given in the past that went 
unnoticed.

Garden Valley Telephone Company DSL Data Added to Statewide Inventory 2/17/2010

[SEP-12-11 Brian Dudek] Change: 
Provider converted some DSL 
infrastructure in two exchanges to 
fiber.

Garden Valley Telephone Company Fiber Data Added to Statewide Inventory 2/17/2010

[SEP-12-11 Brian Dudek] Change: 
Provider expanded fiber territory 
into two exchanges.

Granada Telephone Company DSL Data Added to Statewide Inventory 4/14/2010

[SEP-12-11 Brian Dudek] Change: 
Provider upgraded speed 
capabilities.

Hickory Tech Corporation DSL Data Added to Statewide Inventory

[AUG-15-11 Brian Dudek] Change: 
Provider upgraded some 
infrastructure to higher speeds.

Hutchinson Telecommunications, Inc. Fixed Wireless Data Added to Statewide Inventory 4/14/2010

[SEP-12-11 Brian Dudek] Change: 
Provider upgraded speed 
capabilities.

KeyOn Communications, Inc. Fixed Wireless Data Added to Statewide Inventory

[SEP-12-11 Brian Dudek] Change: 
New provider in service for October 
2011 submission.

Knology of the Plains, Inc. Cable Data Added to Statewide Inventory 7/13/2011

[AUG-22-11 Brian Dudek] 
Correction: New provider for 
October 2011 submission that 
previously refused to participate.

Loretel Systems, Inc. DSL Data Added to Statewide Inventory 4/14/2010

[SEP-12-11 Brian Dudek] Change: 
Provider upgraded speed 
capabilities.

Manchester-Hartland Telephone Company Fiber Data Added to Statewide Inventory 4/14/2010

[SEP-12-11 Brian Dudek] Change: 
Provider upgraded speed 
capabilities.

Midcontinent Communications Cable Data Added to Statewide Inventory 12/9/2009

[SEP-12-11 Brian Dudek] 
Change/Correction: possible 
service expansion or corrections to 
previous dataset; entirely new 
dataset for October 2011 
submission.  Coverage change 
likely primarily a result of the 2000-
2010 census change.  Provider 
upgraded speed capabilities in their 
DOCSIS 3.0 cable regions.

Minnesota Valley TV Improvement Corporation Cable Data Added to Statewide Inventory 4/13/2010

[AUG-30-11 Brian Dudek] 
Correction: New provider platform 
for October 2011 submission, that 
was previously unknown.

Minnesota Valley TV Improvement Corporation Fixed Wireless Data Added to Statewide Inventory 4/13/2010

[SEP-12-11 Brian Dudek] Change: 
Provider added additional 
transmission points.

NorthfieldWiFi LLC Fixed Wireless Data Added to Statewide Inventory 2/4/2011

[SEP-12-11 Brian Dudek] Change: 
Provider added additional 
transmission points.

Park Region Mutual Telephone Company DSL Data Added to Statewide Inventory 3/18/2010

[SEP-12-11 Brian Dudek] 
Correction: Provider reported DSL 
speeds incorrectly in Ottertail 
Telcom region.  Reduced speed 
tiers.

Park Region Mutual Telephone Company Fiber Data Added to Statewide Inventory 3/18/2010

[SEP-12-11 Brian Dudek] Change: 
Provider upgraded infrastructure in 
Ottertail Telcom region to speed 
tier 9. 



Paul Bunyan Rural Telephone Cooperative DSL Data Added to Statewide Inventory 6/24/2010

[SEP-12-11 Brian Dudek] 
Correction: Provider coverage 
added in the Red Lake exchange.  
Although available, this coverage 
was not provided in the past 
submission.  

Paul Bunyan Rural Telephone Cooperative Fiber Data Added to Statewide Inventory 6/24/2010

[SEP-12-11 Brian Dudek] 
Correction: Provider coverage 
added in the Red Lake exchange.  
Although available, this coverage 
was not provided in the past 
submission.  

Pine Island Telephone Company DSL Data Added to Statewide Inventory 4/14/2010

[SEP-12-11 Brian Dudek] Change: 
Provider upgraded speed 
capabilities.

Red River Rural Telephone Association DSL Data Added to Statewide Inventory 3/17/2010

[SEP-12-11 Brian Dudek] Change: 
Provider expanded DSL territory 
into Traverse and Wilkin Counties.

Savage Communications Inc. Cable Data Added to Statewide Inventory 2/19/2010

[SEP-12-11 Brian Dudek] Change: 
Provider expanded cable territory 
by acquiring properties in Bovey 
and Coleraine from Jaguar 
Communications.

Scott Rice Telephone Co. DSL Data Added to Statewide Inventory 2/15/2010

[SEP-12-11 Brian Dudek] Change: 
Provider upgraded speed 
capabilities.

Sheehan Gas Fixed Wireless Data Added to Statewide Inventory

[SEP-12-11 Brian Dudek] Change: 
Provider upgraded speed 
capabilities.

Sjoberg's Inc. Cable Data Added to Statewide Inventory 12/21/2009

[SEP-12-11 Brian Dudek] 
Correction: Provider indicated that 
maximum upload speed tier 
needed to be lowered to 3.  

Sleepy Eye Telephone Company DSL Data Added to Statewide Inventory 4/14/2010

[SEP-12-11 Brian Dudek] Change: 
Provider upgraded speed 
capabilities.

Sprint Nextel Corporation Mobile Wireless Data Added to Statewide Inventory 1/14/2010

[SEP-12-11 Brian Dudek] Change: 
Provider expanded mobile territory 
into a few areas.

T-Mobile USA, Inc. Mobile Wireless Data Added to Statewide Inventory 1/8/2010

[SEP-12-11 Brian Dudek] Change: 
Provider expanded mobile territory 
further in east and southeast MN.  
Upgraded speed capabilities with 
HSPA+ 42.

TDS Telecommunications Corporation DSL Data Added to Statewide Inventory 1/27/2010

[SEP-12-11 Brian Dudek] 
Change/Correction: possible 
service expansion or corrections to 
previous dataset; entirely new 
dataset for October 2011 
submission.  Coverage change 
likely primarily a result of the 2000-
2010 census change.

TDS Telecommunications Corporation Fiber Data Added to Statewide Inventory 1/27/2010

[SEP-12-11 Brian Dudek] 
Change/Correction: possible 
service expansion or corrections to 
previous dataset; entirely new 
dataset for October 2011 
submission.  Coverage change 
likely primarily a result of the 2000-
2010 census change.

Verizon Communications, Inc. Mobile Wireless Data Added to Statewide Inventory 12/14/2009

[SEP-12-11 Brian Dudek] Change: 
Provider expanded mobile territory 
further in south MN.  Upgraded 
speeds in 700 MHz spectrum.

Windstream Communications Fixed Wireless Data Added to Statewide Inventory

[SEP-12-11 Brian Dudek] Change: 
Windstream indicated that the 
acquired fixed wireless operations 
from Lakedale should be changed 
to the Windstream provider name, 
dba, and FRN.

Windstream Communications DSL Data Added to Statewide Inventory

[SEP-09-11 Brian Dudek] Change: 
Provider submitted entirely new 
data in the form of 2010 census 
blocks for their Lakedale 
Telephone acquisition only.  Entel 
Communications and Lakedale 
Link not included.  Windstream 
indicated that these two operations 
should be changed to the 
Windstream provider name, dba, 
and FRN.

CenturyLink Backhaul Backhaul Provider Only Processing Complete 12/4/2009
Level 3 Communications, LLC Backhaul Backhaul Provider Only Processing Complete 12/14/2009
Savage Communications Inc. Backhaul Backhaul Provider Only Processing Complete 2/19/2010
T-Mobile USA, Inc. Backhaul Backhaul Provider Only Processing Complete 1/8/2010



Windstream Communications Backhaul Backhaul Provider Only Processing Complete
Zayo Group, LLC Backhaul Backhaul Provider Only Processing Complete

City of Chaska Fixed Wireless
Estimated Coverage Submitted for Non-
Participating Provider

[SEP-1-11 Brian Dudek] 
Correction: New provider for 
October 2011 submission that is 
still unresponsive.  Connected 
Nation estimated coverage for this 
provider.

360networks Backhaul No Update to Provide 1/19/2010
Ace Telephone Association Backhaul No Update to Provide 8/3/2010
Ace Telephone Association DSL No Update to Provide 8/3/2010
Alliance Communications Cooperative, Inc. Backhaul No Update to Provide
Alliance Communications Cooperative, Inc. DSL No Update to Provide
Alliance Communications Cooperative, Inc. Fiber No Update to Provide
Arvig Communication Systems DSL No Update to Provide 2/2/2011
Arvig Communication Systems Fiber No Update to Provide 2/2/2011
Arvig Communication Systems Fixed Wireless No Update to Provide 2/2/2011
AT&T Corp, Inc. Backhaul No Update to Provide 12/16/2009
Barnesville Municipal Telephone DSL No Update to Provide 3/4/2010
Benton Cooperative Telephone Company DSL No Update to Provide 6/16/2010
Benton Cooperative Telephone Company Fiber No Update to Provide 6/16/2010
Benton Cooperative Telephone Company Cable No Update to Provide 6/16/2010

Benton Cooperative Telephone Company Mobile Wireless No Update to Provide 6/16/2010

[JUL-7-11 Brian Dudek]  According 
to provider representative, service 
area is derived from a real-world 
wireless propagation and the 
south/southwest coverage border is 
the licensed border for the 
associated spectrum band.  Will 
not serve outside it.

Blue Earth Valley Telephone Company Cable No Update to Provide 6/16/2010
Blue Earth Valley Telephone Company DSL No Update to Provide 6/16/2010
Blue Earth Valley Telephone Company Fiber No Update to Provide 6/16/2010
Bradco-Wisp, Inc. Fixed Wireless No Update to Provide
Christensen Communications Company Backhaul No Update to Provide 2/2/2010
Christensen Communications Company DSL No Update to Provide 2/2/2010
City of Windom Fiber No Update to Provide
Clara City Telephone Company DSL No Update to Provide 2/5/2010

Clear Choice Communications Fixed Wireless No Update to Provide

[SEP-7-11 Brian Dudek] 
Correction: Provider service area is 
now a real-world propagation unlike 
prior submission. Cut to licensed 
border.

Clearwire Corporation Fixed Wireless No Update to Provide 3/3/2010

[SEP-7-11 Brian Dudek] 
Correction: Provider service area is 
now a real-world propagation unlike 
prior submissions.

Consolidated Telephone Company DSL No Update to Provide
Consolidated Telephone Company Fixed Wireless No Update to Provide
Crosslake Telephone Company Cable No Update to Provide 6/16/2010

DISH Network Corporation Satellite No Update to Provide 1/27/2010

[SEP-16-11 Brian Dudek] 
Correction: Satellite data is being 
submitted and was not included in 
the April 2011 submission. While 
coverage is currently the entire 
state boundary, work continues on 
having more granular data 
available.

diversiCOM DSL No Update to Provide 4/20/2010
diversiCOM Cable No Update to Provide 4/20/2010
diversiCOM Fixed Wireless No Update to Provide 4/20/2010
diversiCOM Fiber No Update to Provide 4/20/2010
Emily Cooperative Telephone Company DSL No Update to Provide 6/24/2010
Emily Cooperative Telephone Company Fiber No Update to Provide 6/24/2010
Enterpoint Wireless Fixed Wireless No Update to Provide
Evertek Enterprises, Inc. Fixed Wireless No Update to Provide 6/17/2010
Farmers Mutual Telephone Company Fixed Wireless No Update to Provide 4/1/2010
Federated Telephone Cooperative Fixed Wireless No Update to Provide 4/1/2010
Frontier Communications of Minnesota, Inc. Backhaul No Update to Provide 1/22/2010
FTTH Communications Fiber No Update to Provide
Gardonville Cooperative Telephone Association DSL No Update to Provide 2/23/2010
Gardonville Cooperative Telephone Association Fiber No Update to Provide 2/23/2010

Gardonville Cooperative Telephone Association Fixed Wireless No Update to Provide 2/23/2010

[SEP-7-11 Brian Dudek] 
Correction: Provider service area is 
now a real-world propagation unlike 
prior submissions.

Genesis Wireless Fixed Wireless No Update to Provide
Halstad Telephone Company DSL No Update to Provide 6/16/2010
Halstad Telephone Company Fixed Wireless No Update to Provide 6/16/2010
Harmony Telephone Company Fiber No Update to Provide 1/12/2010
Hiawatha Broadband Comunications, Inc. Fiber No Update to Provide 3/8/2010
Hiawatha Broadband Comunications, Inc. Cable No Update to Provide 3/8/2010
HomeTown Solutions LLC Fiber No Update to Provide 4/1/2010



Hughes Network Systems, LLC Satellite No Update to Provide 2/5/2010

[SEP-16-11 Brian Dudek] 
Correction: Satellite data is being 
submitted and was not included in 
the April 2011 submission. While 
coverage is currently the entire 
state boundary, work continues on 
having more granular data 
available.

Hutchinson Telecommunications, Inc. DSL No Update to Provide 4/14/2010
Info Link Wireless, Inc. Fixed Wireless No Update to Provide 4/19/2010
Interstate Telecommunications Cooperative, Inc. DSL No Update to Provide 2/10/2010
Interstate Telecommunications Cooperative, Inc. Fiber No Update to Provide 2/10/2010
InvisiMax, Inc. Fixed Wireless No Update to Provide
Jaguar Communications DSL No Update to Provide 4/12/2010
Jaguar Communications Fiber No Update to Provide 4/12/2010

Jaguar Communications Fixed Wireless No Update to Provide 4/12/2010

[SEP-7-11 Brian Dudek] 
Correction: Provider service area is 
now a real-world propagation unlike 
prior submissions.

Johnson Telephone Company DSL No Update to Provide
Kasson & Mantorville Telephone Company DSL No Update to Provide 6/30/2010
Lonsdale Telephone Company, Inc. DSL No Update to Provide
Lonsdale Telephone Company, Inc. Fiber No Update to Provide
Mabel Cooperative Telephone Company DSL No Update to Provide 4/7/2010
Mediacom Communications Corporation Backhaul No Update to Provide 1/12/2010
Mediacom Communications Corporation Cable No Update to Provide 1/12/2010
MegaPath Inc. Backhaul No Update to Provide 2/15/2010
Midcontinent Communications Backhaul No Update to Provide 12/9/2009
Minnesota Valley Telephone Company DSL No Update to Provide 4/29/2010
New Ulm Telecom Inc. DSL No Update to Provide 2/25/2010
Polar Telcom, Inc. DSL No Update to Provide 2/11/2010
Red River Rural Telephone Association Fixed Wireless No Update to Provide 3/17/2010
Red River Rural Telephone Association Fiber No Update to Provide 3/17/2010
River Valley Telephone Coop. Fixed Wireless No Update to Provide 4/28/2010
Rothsay Telephone Company Inc. DSL No Update to Provide 2/18/2010
Runestone Telecom Association DSL No Update to Provide 4/14/2010
Runestone Telecom Association Fiber No Update to Provide 4/14/2010
Sacred Heart Telephone Company DSL No Update to Provide 2/5/2010
Scott Rice Telephone Co. Fiber No Update to Provide 2/15/2010
Sioux Valley Wireless Fixed Wireless No Update to Provide 4/21/2010
Southern Cablevision, Inc. Cable No Update to Provide 3/30/2010
Spring Grove Cooperative Telephone Co. Fiber No Update to Provide 1/12/2010
Sprint Nextel Corporation Backhaul No Update to Provide 1/14/2010
Starbuck Telephone Company DSL No Update to Provide 2/5/2010
Starpoint Communications, Inc. Fixed Wireless No Update to Provide 2/18/2011
TDS Telecommunications Corporation Backhaul No Update to Provide 1/27/2010
tw telecom of minnesota llc Backhaul No Update to Provide 4/20/2010
Upsala Cooperative Telephone Association DSL No Update to Provide
Upsala Cooperative Telephone Association Fiber No Update to Provide
US Cable Corporation Cable No Update to Provide 5/20/2010

US Internet of Minnetoka Fixed Wireless No Update to Provide

[JUL-5-11 Brian Dudek]  According 
to provider representative, service 
area is derived from a real-world 
wireless propagation and is cut to 
the allowed service boundary.  It is 
a city funded project and the 
provider is required to only provide 
within this service boundary.

VAL-ED Joint Venture, LLP DSL No Update to Provide 4/21/2010
VAL-ED Joint Venture, LLP Fixed Wireless No Update to Provide 4/21/2010
Verizon Communications, Inc. Backhaul No Update to Provide 12/14/2009
West Central Telephone Association DSL No Update to Provide 2/18/2010
West Central Telephone Association Fiber No Update to Provide 2/18/2010
Western Telephone Company DSL No Update to Provide 4/14/2010
Wikstrom Telephone Company DSL No Update to Provide 4/12/2010
Wikstrom Telephone Company Fixed Wireless No Update to Provide 4/12/2010

WildBlue Communications, Inc. Satellite No Update to Provide 1/8/2010

[SEP-16-11 Brian Dudek] 
Correction: Satellite data is being 
submitted and was not included in 
the April 2011 submission. While 
coverage is currently the entire 
state boundary, work continues on 
having more granular data 
available.

Winnebago Cooperative Telecom Association Backhaul No Update to Provide 6/17/2010
Winnebago Cooperative Telecom Association DSL No Update to Provide 6/17/2010
Winnebago Cooperative Telecom Association Fiber No Update to Provide 6/17/2010
Winnebago Cooperative Telecom Association Fixed Wireless No Update to Provide 6/17/2010
Wolverton Telephone Company DSL No Update to Provide 6/22/2010
Woodstock Telephone Company DSL No Update to Provide 2/18/2010
Woodstock Telephone Company Fiber No Update to Provide 2/18/2010
XO Communications, LLC Backhaul No Update to Provide 2/12/2010
Zumbrota Telephone Company DSL No Update to Provide 2/5/2010

Albany Mutual Telephone Association DSL No Update Provided - Use Last Submission Data 3/4/2010



Albany Mutual Telephone Association Fiber No Update Provided - Use Last Submission Data 3/4/2010

Cogent Communications, Inc. Backhaul No Update Provided - Use Last Submission Data
Knology of the Plains, Inc. Backhaul Provider Gathering Data 7/13/2011
Superior Broadband Backhaul Provider Gathering Data

Arvig Communication Systems Cable Other 2/2/2011

[SEP-14-11 Brian Dudek]  Cable 
properties are reported under Arvig 
Communications subsidiary 
company Home Telephone, dba 
Southern Cablevision.

Jaguar Communications Cable Other 4/12/2010

[SEP-15-11 Brian Dudek] Data is 
now submitted under Savage 
Communications as they have 
acquired Jaguar Communications' 
original cable properties.

Manchester-Hartland Telephone Company DSL Other 4/14/2010
[SEP-15-11 Brian Dudek] Provider 
indicated DSL is now inactive.

PAETEC Communications, Inc. DSL Other

[SEP-08-11 Wes Kerr] Multiple 
outreach attempts were conducted 
but no response was received. 
PAETEC was bought out during the 
collection phase of this round by 
Windstream and we intend to be 
able to include the PAETEC 
coverage as a part of the 
Windstream footprint during the 
next round.

A Better Wireless, NISP, LLC Fixed Wireless Refused to Participate

[AUG-15-11 James Tull] While 
attempting to solicit data in 
accordance with the NOFA and the 
Clarification, a representative of A 
Better Wireless stated that they 
refused to participate because they 
disputed data already reflected on 
the map. This person further 
agreed to provide e-mail details of 
these stated discrepancies but 
never did. Subsequent attempts at 
contact have all been 
unsuccessful. We will continue to 
attempt to gain A Better Wireless' 
participation in Minnesota's 
broadband mapping project.

Ideaone Telecom Group, LLC DSL Refused to Participate

[JUL-19-11 James Tull] After 
speaking with a receptionist and 
leaving several messages to no 
avail, received an e-mail stating, 
"We are not interested in 
completing the survey you are 
requesting.  We have limited 
customers in Minnesota."

Ideaone Telecom Group, LLC Fixed Wireless Refused to Participate

[JUL-19-11 James Tull] After 
speaking with a receptionist and 
leaving several messages to no 
avail, received an e-mail stating, 
"We are not interested in 
completing the survey you are 
requesting.  We have limited 
customers in Minnesota."

Nextera Communications DSL Refused to Participate

[JUL-29-11 John Determan] In 
addition to multiple contact 
attempts made between May 5, 
2009 and April 28, 2011, multiple 
attempts were made during this 
submission period; however after 
discussions with executive 
management,  Nextera is not 
prepared to commit the resources 
needed for a project of this 
magnitude and therefore fefused to 
participate.

Access Broadband Fixed Wireless Non-Responsive to Multiple Attempts

8 contact attempts were made 
between May 24, 2011 and August 
24, 2011.

City of Detroit Lakes Fixed Wireless Non-Responsive to Multiple Attempts 5/10/2010

In addition to multiple contact 
attempts made between June 22, 
2010 and February 24, 2011, 9 
additional attempts were made this 
period.

Global Crossing Telecommunications, Inc. Backhaul Non-Responsive to Multiple Attempts

In addition to multiple contact 
attempts made between July 1, 
2010 and February 17, 2011, 3 
additional attempts were made this 
period.



Reliance Globalcom Services, Inc. Backhaul Non-Responsive to Multiple Attempts

In addition to contact attempts 
made between November 18, 2010 
and February 3, 2011, 3 additional 
attempts were made this period.

Ridge Runner Internet Services Inc. Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact 
attempts made between April 6, 
2010 and February 15, 2011, 5 
additional attempts were made this 
period.

Utopian Wireless Corporation Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact 
attempts made between August 9, 
2010 and January 4, 2011, 4 
additional attempts were made this 
period.
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11  Introduction 

This document provides background for the data collection and processing phases of the Missouri 
Broadband Data and Development Project. It covers the initial processing of data to meet specific 
requirements defined by the National Telecommunications and Information Administration (NTIA), 
governed by the Notice of Funds Availability (NOFA) first published in volume 74, number 129, at 
page 32545 of the Federal Register and subsequently clarified in volume 74, number 154, at page 
40569 of the Federal Register. It also covers the quality control aspects of the project, including back 
lab, field, and independent verification. 
 

22  Non-Disclosure Agreement Development Process 

The State Parties to the Non-Disclosure Agreement (NDA) process include the State of Missouri, the 
University of Missouri, GeoDecisions, and CBG Communications.  Each party, along with the individual 
broadband service provider, is a signatory of each NDA. 
 
A standard NDA was developed using an initial template provided by CBG, existing templates from 
providers, and was subsequently edited with inputs from all state parties.  This NDA was then vetted 
with representatives from the Missouri broadband provider community in order to develop a data 
sharing document that reflected the concerns of both the state and industry. 
 
The state drafted, signed, and distributed an initial letter to providers; including data collection 
guidelines and a draft of the standard NDA (see Attachment A).  This letter was initially sent to 129 
providers initially in late March 2010.  Most partners to the NDA signed this initial NDA as provided.  
Some providers have asked for some changes to this NDA which then require legal review by all 5 
parties to the agreement.  These negotiations have taken some time to complete for individual 
providers.   
 
We have also found that having a signed NDA does not ensure the State that data will be forthcoming 
as we have at least five providers with signed NDAs that we have not received data for.  These are 
still being pursued. 
 
 

33  IIddeennttiiffyyiinngg  PPrroovviiddeerrss 

The state parties used multiple methodologies to: a) identify broadband providers potentially offering 
service in the State of Missouri, and b) to acquire contact information for each of the providers. 
 
Identification of providers began by accessing the FCC’s Form 477 publically available data. 
This data provides the Holding Company Name, the FCC Registration number (FRN), and the filing 
company name of all broadband providers in the state that completed the Form 477. We began with 
this information and performed research tasks, including internet research of each of the companies 
to obtain a high-level contact within the company, as well as their phone and e-mail contact 
information. If some of this information was not obtainable via Internet research, CBG made initial 
contact with the company, primarily through phone, to further explore the most pertinent contact. 
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In addition, we performed research of various websites to determine if there are providers that had 
not filed a Form 477 with the FCC that should be included in the data collection process. We 
researched these companies again for the best contact information through various public records 
including, but not limited to, Missouri Public Service Commission databases, State 
Telecommunications Industry Association memberships, FCC Cable TV Community Unit and Physical 
System ID databases, FCC telephone company databases, business licenses, state and local tax 
records, etc., as well as various state, local and other departments and agencies, including Division of 
Corporations, Division of Revenue, Local Franchise Authorities, Chambers of Commerce, etc. 
 
We also continue to identify additional potential providers during our field verification processes.  This 
list of potential providers is comprised of business names advertised (signage/trucks etc.), labeled 
infrastructure observed, or are mentioned by Missouri citizens through an interview. 
 
As new providers are identified, the contact information is given to MU for delivery of initial contact 
letters to identified providers. These documents are mailed out by MU via e-mail, in order to expedite 
the process, and through the USPS as a formal notification.  Based on input from providers in other 
states, these documents were sent by the State in order to show the importance that the State places 
on the project. All correspondence with the providers, including clarification of the NDA or Data 
Request, data formatting issues, and data submission by the providers, was then handled by 
GeoDecisions and CBG personnel unless the provider required interaction with state personnel (ie. 
negotiation of NDA). 
 
Due to the initial timeframe for completion (May 31, 2010) for Missouri’s first version of the statewide 
map of broadband provision, the providers were requested to return the signed NDAs within five (5) 
business days of receipt and submit their data, in as usable a format as possible, by April 15, 2010. 
 
The state parties performed follow-up with the providers on an as-needed basis. This included making 
contact with a provider if we did not hear from them after sending out the NDA and Data Request, 
following up to receive initial data sets, clarification regarding data sets, etc. Contact with the 
providers included phone calls, voicemail, and e-mail. In the case where a provider did not respond 
after numerous attempts, we also followed up with USPS mail as well as through their affiliated 
associations. 
 
A spreadsheet was utilized to keep track of all contact information that was developed and contacts 
that were made to ensure the accuracy of each provider’s pertinent contacts for the statewide 
project. These have been maintained as contacts and personnel change within the provider’s industry. 
 

44  Requested Data Format 

The overarching goal of the data collection was to satisfy the requirements of the State 
Broadband Data and Development (SBDD) grant program, which is governed by the Notice of 
Funds Availability (NOFA) first published in volume 74, number 129, at page 32545 of the 
Federal Register and subsequently clarified in volume 74, number 154, at page 40569 of the Federal 
Register. Both the NOFA and subsequent discussions with the NTIA have indicated that time is of the 
essence, and strict deadlines are in place for the delivery of data to the NTIA. As such, timely, 
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accurate data collection was of primary concern. GeoDecisions requested that broadband providers 
submit data in a timely manner in whatever format the information was currently available to 
eliminate the lag that can be expected with the providers attempting to meet NOFA formatting 
compliance themselves; however, it was determined that many national providers, having gone 
through this process in other states, could deliver NOFA compliant data as part of their data 
submittal. 
 
To assist in the NDA execution process and to further facilitate the timely delivery of data from the 
providers, GeoDecisions and CBG reviewed the State’s NOFA cover letter.  The cover letter provided 
background on the project and the contacts to project team members from the State, GeoDecisions, 
and CBG. The cover letter stressed the incredibly short initial project timeline and specified the 
requirement to collect this data on an ongoing basis – every 6 months. 
 
In addition to the cover letter, GeoDecisions and CBG developed a separate attachment to the NDAs. 
This Data Collection Guidelines was reviewed by the State and provided further background and 
project goals associated with Missouri’s State Broadband Data and Development project. The 
document also specified the guidelines to which the project would abide. The Data Collection 
Guidelines informed providers of the intended use of the data that they would be submitting. The 
intended uses included delivery of NOFA-compliant data to the NTIA, data dictionary, the intention of 
generating static maps, as well as the creation of a Missouri-specific interactive broadband mapping 
website. Finally, the Data Collection Guidelines specified the NOFA data and format standards that 
were required of the State for delivery to the NTIA. 
 
GeoDecisions also developed a provider data request spreadsheet template document that was 
distributed upon request and allowed the providers to enter NOFA compliant data as they chose to do 
so. It included mock-up sample data as reference for their own data entry.  GeoDecisions, under the 
guidance of the State, also developed a preliminary Missouri-centric web site that displayed census 
blocks, census tracts, counties, and major roads in order to assist providers in correlating their service 
areas to census blocks.  Providers could access this site and zoom, pan and print census block maps 
as needed. 
 
Spatial data was requested from the providers in the following hierarchy of data format preferences.  
 

1) Shapefiles or Geodatabase (personal or file) 
2) CAD files with embedded attributes included 
3) Text-based data (MS Access, spreadsheets, comma-delimited files, etc.) 
4) Paper maps 
5) Any method in which the provider could readily submit the required data 

 
55  Data Processing 

Because of the variety of ways providers could submit their data, one of the major challenges of this 
project was to consolidate and then integrate this data into a common model.  For each provider, the 
work was divided into three main steps: 
 

1. Capture the supplied data into a provider-specific staging geodatabase 
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2. Process and QA features in the provider's staging geodatabase 
3. Move the data from the provider's staging geodatabase into the final deliverable 

geodatabase model. 
4.  Final QA of all features and associated attribute data. 

 
The first step was the most involved and time consuming.  Regardless of the type of data provided, 
the base-level data (the 2010 census blocks, the 2010 TIGER street segments, and the county 
boundaries), all came from a single source, so are therefore consistent across all providers.  A 
number of different processes were developed for loading the staging geodatabase, depending on the 
type and form of data supplied. Each process was extensively documented through a process 
checklist to ensure accuracy and consistency.  A description of these different processes used to load 
data into the provider specific staging geodatabase follows: 
 

Availability Area 
If a provider supplied their availability area as a single boundary or multiple boundaries drawn 
on a paper map or image file, those area(s) were geo-referenced and digitized into a shape 
file.  If the boundary was provided as a CAD drawing or arose from another GIS system, it 
was also converted to a shape file format.  Some wireless providers defined their area of 
availability as their wireless coverage area.  This may be a supplied boundary, but it may also 
have been defined using the location of the wireless tower, the angle of coverage, and the 
coverage distance.  This would result in a sector of a circle, which was then used as the 
availability area. 
 
Once a shape file of the boundary was created, interpreted, and available, all census blocks 
intersecting that boundary were collected.  Those census blocks less than two square miles 
were assembled into one feature class.  For census blocks greater than two square miles, all 
street segments that overlapped both the census blocks and the availability area were 
collected into another feature class.  Along with the availability area, the providers were also 
to supply the technology of transmission and speed information.  These attributes were 
assigned to either the census blocks or street segments. Additional provider information 
including Name, DBA, and FRN, were also added as attributes. 
 
Census Blocks 
Some providers submitted a list of census blocks for their area of availability, along with 
technology of transmission and speed information specified for each census block.  In these 
cases, the census block polygon was selected for each listed census block.  If the census 
block’s area was less than two square miles, it was added to the census block feature class 
and the technology of transmission and speed information were assigned from the provided 
list.  If the census block’s area was greater than two square miles, all street segments that 
overlapped it were added to the street segment feature class and the technology of 
transmission and speed information were assigned from the associated census block on the 
list. 
 
The 2010 census block dataset was used for our data processing however a few providers 
submitted data using 2000 or 2009 vintage census blocks.  When a provider submitted in a 
vintage other than 2010, the 2010 census blocks for the corresponding availability area were 
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coded for that provider.  Thus the true coverage of the census blocks were maintained and 
consistent with the provider's list but represented in the 2010 block structure. 
 
Address Information 
If a list of addresses was provided as the availability area, the first step was to obtain the 
coordinates of these addresses.  When geocoded successfully, this resulted in a point for each 
address located.  The census blocks intersecting all the points were collected. If the block’s 
area was greater than two square miles it was treated separately.  If a census block contained 
address locations with different technologies of transmission, the census block was duplicated, 
and a distinct technology of transmission assigned to each duplicated census block.  For 
different locations in a census block with the same technology of transmission, the maximum 
value for each speed was obtained and that maximum assigned to the census block. 
 
If the geocoded point lay within a census block with an area greater than two square miles, 
the nearest street segment was located and the technology of transmission and speed 
assigned to that segment.  As with census blocks, if there were several locations with different 
technologies of transmission along the same street segment, the street segment was 
duplicated and each segment assigned a different technology of transmission.  The speed 
assigned to that segment was the maximum speed for all locations along the segment sharing 
that segment's technology of transmission. 
 
Wireless Boundary 
In most cases, wireless providers supplied a boundary, either in electronic format or as a 
paper map.  These were converted to a shape file either by digitizing or by performing a data 
conversion as appropriate.  Some providers supplied tower locations, the angle of coverage, 
and the distance.  In these cases the wireless boundary was constructed from this.  Finally, 
some providers defined their wireless boundary using an exchange boundary or as an 
aggregate of their customers.  Although these boundaries may not accurately represent the 
wireless availability area, they were initially included in the dataset in order for the providers 
to submit feedback and more accurately specify boundaries of availability in future iterations. 
 
Middle Mile Points 
If middle mile points were supplied on a hardcopy or image file map, the point was digitized.  
Usually these points were provided with latitude and longitude, so it was a simple matter to 
add them to the feature class.  The elevation data was not always supplied due to the 
provider not having this information available, but when it was, it was often given as feet 
above sea level.  The model requires elevation to be feet above (or below) grade.  In these 
cases, a digital terrain model was used to obtain the ground elevation at the middle mile 
structure location, which was subtracted from the height above sea level to obtain the height 
above grade. 

 
The above processes were used to capture the provider-supplied data into provider-specific individual 
staging geodatabases using the common National States Geographic information Council (NSGIC) 
data model suggested for use by the NTIA.  Once this was completed, the data could be updated or 
modified and Quality Checked (QC) using the same processes regardless of how it was originally 
submitted.   
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One such process was the creation of overview areas.  The census blocks and street segments for a 
provider were collected and grouped by technology of transmission.  County boundaries that 
overlapped each of these groups were then collected.  The technology of transmission of all census 
blocks and street segments for the group was then assigned to the county. The assignment of 
maximum speed within the group to the county has been discontinued per NTIA’s request. 
 
At this point the dataset for a particular provider was complete.  An extensive QC checklist was used 
to examine the dataset, verify consistency, and ensure that it matched the data submitted by the 
provider.  Once the dataset was passed the quality check, the features were appended into final 
database model along with all data from other completed providers.  Both the Validate Topology and 
Validate Features ESRI tools were run, any corrections necessary were made, and the Tools were re-
run until they processed without error.  As individual provider data sets were appended into the 
master database and again when all data sets were appended, the NTIA supplied ‘SBDD Check 
Submission’ tool was also run against the data.  Any errors detected were corrected and the tool re-
run.  A final manual QC review was performed to ensure that all the provider data is present and 
consistent.  This was then followed by a final run of the SBDD Check Submission tool against the 
master data model to determine if any further corrections / changes were necessary. 
 
Public Data Sources 
The University of Missouri (UM) was in charge of the process to obtain and compile cable strand 
maps, as well as maps of service / coverage areas obtained from the service provider’s public offices 
directly or from their Web sites and advertising materials.  This was particularly true in cases where 
no other authoritative source was available for the given provider.  Websites were collected and 
inventoried through the use of a ‘surveymonkey’ instrument to standardize and assemble the 
database from the webcrawling activities.  All files and maps found through the webcrawling were 
then either imported, scanned, or screen-captured to create a digital representation or image of the 
associated service area.  These files were then georeferenced to a common Missouri base map. The 
spatial transformation methodology used was determined by the image type, confidence in a real 
representation, and scale of source materials.  In addition, maps of telephone company exchange 
areas and cable franchise areas from their respective associations were digitized and attributed to 
provide additional points of reference as well. These files were then held as elements of independent 
validation for the GeoDecision/CBG files created from Provider sources. 
 
Community Anchor Institutions 
The University of Missouri (UM) was lead on the development of the Community Anchor Institution 
database. Many elements of the Community Anchor Points were initially compiled by the UM in 
coordination with the Department of Public Safety (SEMA and OHS) providing a starting point for this 
data collection. The list of Anchor Institutions inventoried and monitored in this project include: 
Police, Fire, Hospitals, EOC, PSAPs, Municipal Courthouses, Libraries, K-12, Higher Education, 
Extension Offices, Correctional Facilities, Government Buildings, Community Centers, County 
Courthouses, and Armories. 
 
The community anchor attribute information was gathered by the University through phone calling 
and site visits by UM students and staff.  These efforts were coordinated with respective state 
agencies / associations with jurisdiction over these sites. For example, the State Fire Marshall’s Office 
sent out a memo under their letterhead informing their constituency of the inventory and assessment 
so that the student callers and those conducting site visits would be received positively. UM also used 
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their ongoing local data review, validation, and verification processes in partnership with Regional 
Planning Councils, Regional Homeland Security Oversight Committees, and associated local 
governments to assemble and verify data for some counties within Missouri.  This process of data 
development had already been deployed in some areas of Missouri in association with the 
development and review of public safety structure-based information and has proven to work well.   
 

66  Data Accuracy – Back Lab Verification Methods 

Throughout the project, GeoDecisions and CBG performed numerous verification tasks to determine 
the level of accuracy of the information gathered from the broadband providers in the State.  The 
initial verification methods were called back lab verification tasks by the NTIA. Unlike the field 
verification processes (described below), these tasks were performed in a lab or office setting.  Each 
of the following GeoDecisions/CBG back lab processes was utilized to validate the data collected from 
some or all of the providers: 
 
After the data from a given provider was captured into the geodatabase, the mapped data was then 
compared against information gleaned from various sources. The FCC had documentation that was 
used such as the Form 320 (Basic Signal Leakage Performance Report), which is filled out by cable 
television providers on an annual basis, and Cable TV Community Unit and Physical System 
databases. These information databases provided high-level information of geographic areas served 
by cable TV and other broadband providers. This information alerted our team to areas not included 
in gathered data from a broadband provider. 
 
Additional sources of information utilized during the back lab verification process included franchise 
and exchange boundaries, cable strand maps, media prints, as well as business and taxation licenses. 
These sources varied in value to the project, depending on the level of information gathered and 
maintained by local franchising authorities and state agencies such as the PSC. Telecommunications 
associations were also queried for information regarding providers and system boundaries or areas of 
the state where specific providers offer service. 
 
The above processes primarily relate to wireline broadband providers.  For wireless broadband 
providers, we compared information gathered from the providers against FCC and FAA tower 
databases and private tower databases, as needed.   
 
Independent Validation and Assessment: The UM also performed similar verification tasks as 
listed above to determine the level of accuracy and confidence in the information delivered by 
GeoDecisions/CBG as assembled from the broadband providers in the State.  Again, these verification 
methods were called back lab verification tasks by the NTIA as these tasks were performed in a lab or 
office setting.   
 
In addition to the above, the UM back lab processes took the assembled public sourced data for all 
providers (where this type of information could be found) and intersected it with the supplied 
GeoDecisions / CBG provider service areas. As well, Ookla site data, survey data, and 
presence/absence data assembled were also used to assess these data.  From these data, additional 
analyses were performed to create measures of agreement, confidence indexes, spatial confidence 
indexes, and to visualize patterns of service and gaps in service.   
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These gaps and patterns of service are currently being examined to determine common threads for 
the State of Missouri across socio-economic, demographic, density of CAI, and other measurable 
elements of this mapping. We hope to use these data to inform the Regional Technology Planning 
Teams of opportunities and impediments. 
 
The results of the independent assessment and validation were then combined with findings from 
GeoDecisions/CBG to form a report that then was delivered back to the provider to initiate the 
‘provider feedback’ element (see Section 19 of this report) of the assessment and to validate/verify 
the assessments of these data and their extents by both UM and GeoDecisions/CBG with the 
respective provider. 
  

77  Development/Implementation of a field verification guide and 
checklist 

Prior to beginning field verification activities, CBG Communications, Inc. (CBG) developed a field 
verification guide for use by each member of the field verification team.  The guide included 
systematic instructions and a checklist related to verification of each broadband system and service 
type.  The guide and checklist were drafted, reviewed and finalized prior to the beginning of field 
verification activities. 
 
As we continue to move forward with each submission, our field verification efforts continue to 
advance.  Provider data is used to determine higher success areas having overlapping or common 
areas as well as including providers not able to be thoroughly verified from prior rounds.  Those areas 
are the initial focus, medium priority areas are determined using similar stepped-down criteria.  Lower 
priority areas are for providers thoroughly verified in past rounds but current data is needed.  This 
also includes locations in between the higher and medium priority areas.  Provider data is loaded on 
laptops or Garmin units for use by field verification personnel. 
 

88  Field verification team training  

To ensure uniformity of the team’s approach to field verification, field team training was held 
immediately prior to the beginning of field verification activities.  Training was conducted for 
GeoDecisions, CBG, and University students and staff. The training covered all field verification 
activities, including: 
 

 Use of the guide, instructions and checklist 
 Understanding of each system and service types 
 Understanding of coverage characteristics 
 Understanding of service attributes, including system technology type, upstream and 

downstream connection speeds, and other attributes required (by the NTIA) to be 
documented and verified 

 Use of the equipment needed for field verification activities  
 Proper documentation of field verification activities 
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The office tutorial lasted ½ day.  An additional field-based ½ day session was utilized for actual 
demonstration of field verification activities. 
 

99  Team Assignments  

Two person teams were utilized the next 2 days after office and field training in order to work 
together and become more comfortable with the process.  Eventually, field verification team members 
were expected to perform field verification activities on their own, with the exception of University 
student teams, who continued to participate in pairs of two for safety and security reasons.  The 
State was divided into five (5) large areas encompassing Northwest, Northeast, Southwest, Southeast 
and Central Missouri.  The contractor assembled ten (10) team members, and assigned two for each 
area. Initially the UM team assembled eight (8) team members to form four (4) teams, and assigned 
them to certain counties and particular census blocks within those counties. In subsequent iterations 
the UM team assembled 6 team members to form two (2) 2-3 person teams that reviewed targeted 
areas within counties and larger census blocks. As well, these teams conducted the surveys and 
interaction at the Missouri State Fair and other regional fairs as discussed in Section 13 of this report. 
 
Each team member was provided an official-looking ID card and a letter of certification on Missouri 
State letterhead in order to mitigate findings early-on that residents were suspicious of individuals 
asking unsolicited questions.  These two items proved very effective in minimizing these concerns. 
 

1100  Verifying Coverage 

Broadband system coverage was verified by sampling whether services were available at various 
locations shown on the providers’ system coverage maps randomly chosen from all of the census 
blocks that are at the ends of the providers’ systems.  The random sample was developed separately 
by the UM and contractor teams. 
 
The contractor team initially verified availability by looking for a mixture of large and small providers 
across the state, being sure to hit each of the 19 Regions which would form the basis for the Regional 
Technology Planning Teams involved in the state broadband planning process.  Efforts were made to 
locate and verify all providers that had submitted data.  Verifying the large providers, especially, in 
each of these regions was a priority.  Each contractor team member collected field gathered data in 
an MS Access database.  The data included:  Lat/Lon of verification point, provider name, technology 
type, speed test results if available, customer comments and notes from team member.  All data was 
compiled and used to not only validate provider submitted data as mapped, but for providing 
feedback to the providers.    
 
As a cross check, the UM team sampled a selection of counties, looking for more detailed coverage in 
a subset of the state’s counties.  
 
As we continue to move forward with each submission, our field verification efforts, as with all other 
aspects of the project, continue to advance.  Providers are now categorized from prior verification 
rounds as unverified, high, medium or low priority.  Unverified are new providers or one not able to 
be verified in previous attempts.  High are providers with minimal verification in previous attempts.  
Medium are providers fairly thoroughly verified in previous verification and low are providers heavily 
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verified in prior verification.  Provider data is also used to determine highest provider concentration 
areas having overlapping or common areas.  Those areas are the initial focus for unverified and high 
priority providers.  Medium and lower priority providers and areas are secondary and my include 
locations between the unverified and high priority areas.  Provider data is loaded on laptops or 
Garmin units for use by field verification personnel. 
 

1111  Ookla Speed Test Web Site 

As part of the field verification process, State residents and businesses interviewed or visited were 
given a card briefly explaining the project and directed them to the State’s designed speed test 
website.  These cards were broadly distributed at the State Fair and other regional fairs as well.  This 
has led to more responses on the Speed Test. This project specific Ookla speed test web site was set 
up to collect information on providers, users, as well as the upstream and downstream speeds 
associated with their broadband connection.    
 
 

 
Figure 1: Depiction of Ookla Speed Test Site 

 
 

1122  Equipment Utilized for Field Verification Activities 

Each team member carried the following equipment in order to perform field verification activities for 
the various types of services: 

a. Laptop with Wi-Fi capability and provider GIS data installed 

b. Cellular 3G/4G and WiMAX aircards (independent card for each provider) for use with 
laptop 

c. Binoculars 
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d. GPS for verifying and documenting exact locations 

e. Hardcopy forms and electronic database for documenting verification data 

f. Cell phone with 3G or 4G used in lieu of laptop for certain types of wireless broadband 
services 

g. Digital recorder for aural field notes, as needed 

h. Identification documents (business cards, State or other ID badges, letter from the 
State acknowledging that the team member is part of the verification team, for those 
with questions) 

i. Car chargers and/or DC to AC Inverters for equipment chargers  

j. Census block maps (boundary details shown) and other maps as needed 

k. Garmin GPS unit. 

l. Postcards advertising the Ookla web site for distribution, as shown below 

 

 
Figure 2: Postcards Distributed to Residents 

 
1133  Other Verification Methods 

In addition to utilizing the above mentioned equipment and the methodologies listed below for 
verifying coverage and characteristics, team members entered into discussions with residents in the 
various areas.  Residents were asked questions such as: Do they currently have broadband service?, 
Who their provider is?, If they know what speeds they could achieve, and if they knew of other 
provider’s services being available in the area.  This information needed to be confirmed by multiple 
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residents before being considered accurate.  Residents often did not know what their service level 
was nor what their speed of service was.   Questions such as how much were they paying for the 
service led to a better understanding of their service level.  Residents were encouraged to visit the 
Ookla speed test site to assist in gathering actual speed data.  To date, nearly 6500 results have been 
received.   
 
Missouri State Fair: In order to collect a large amount of information from Missouri residents for 
verification, the Broadband Mapping Team (BB Team) visited the Missouri State Fair in Sedalia, 
Missouri. The 2010 Missouri State Fair had an estimated attendance of over 330,000 people.  With 
such a high attendance, it was determined that this event would be useful for data collection. For the 
2011 Missouri State Fair, attendance exceeded that of the previous year, estimated at 330,000 to 
350,000 attendees. The BB Team had two locations at the fair.  The first was in the Mizzou Central 
Building in the MO-AG Theater organized by the College of Agriculture, Food and Natural Resources. 
This was the main location for the BB Team, where an informational slide show continuously played 
and signage was displayed throughout the booth area. At this location, Missouri residents were asked 
to fill out a survey regarding their internet service. A total of 699 surveys were completed at the 2011 
Missouri State Fair, an increase of 117 surveys from the previous year, and were later geocoded to be 
used as verification and validation for UMs independent assessments.  
 
The second BB Team location was on the lawn outside of the MO-AG Theater, where a Mizzou Tent 
was assembled daily and tables were set displaying a large Missouri map divided into four quadrants. 
Each of the four quadrants represented different regions of Missouri, northwest, northeast, southwest 
and southeast. At this station, Missouri residents were able to physically place a colored pin on their 
home location.  The color of the pins was used to differentiate whether or not broadband was 
available.  A total of 320 pins were placed by Missouri residents, denoting presence or absence of 
broadband. The 2010 Missouri State Fair pin total was 880, a difference of 560 pins down from the 
previous year due to severe weather that occurred two out of the four days the team was present at 
the fair.  
 
In addition to the 2011 Missouri State Fair, the BB Team also visited three regional fairs and an extra 
state fair, the Boone County Regional Fair, Phelps County Regional Fair, the Shelby County Regional 
Fair and the Southeast Missouri District Fair in the city of Cape Girardeau. The three regional fairs, all 
located near the University, were chosen specifically to increase the amount of broadband data for 
the Mid-Missouri region. The Southeast Missouri District Fair was selected because the 2010 Missouri 
State Fair results displayed little or no data in the southeast Missouri region. In total, 1053 surveys 
were completed and approximately 390 pins were placed during this verification phase.  
 
At all of the fairs, the broadband speed test cards for the Missouri Ookla site were handed out to 
residents after filling out a survey or placing a pin on one of the four maps. The BB Team also 
distributed drinking cups, refrigerator magnets, and pens with the State Broadband speedtest site on 
them.  
 
In terms of verifying provider coverage, the state and regional fairs have provided valuable data that 
could not have been otherwise obtained.  The color-coded push pin maps have been converted to 
point-based shape files.  Combined with additional information collected from the fair attendees while 
interacting with the push pin maps, the resulting shape file has provided a statewide, grassroots 
survey of internet service provider, type of internet service (broadband, dial-up, etc.), technology of 
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transmission, subscribed speed, and customer satisfaction.  This data has been used in the 
verification process as a visual comparison to census block provider footprints.  The results, so far, 
have been very positive and the fair points have displayed a high spatial correlation with the census 
blocks.  More data collection will be required before this verification method can be formalized, but 
the results are very promising.  
 

1144  Verifying Wireline Broadband Coverage Characteristics 

Using the specified random sampling technique, field team members searched for the physical 
endpoints of cable systems, telephone/DSL and fiber optic infrastructure and noted when additional 
infrastructure was not seen moving outward from the core either in an aerial (overhead) or 
underground manner.  These areas were targeted for discussions with residents and to perform 
speed tests.  Observations and findings were documented accordingly. 
 

1155  Wireless Broadband Coverage 

Verification team members reviewed the provider’s information and looked for network availability 
near the antenna site or in the middle of the provider’s service area to confirm network and test 
equipment compatibility.  Using the specified random sampling technique, the team member tested 
with pertinent gear to determine when service could and couldn’t be achieved by the laptop, cell 
phone, or other wireless broadband-enabled device.  These locations were documented accordingly.  
 

1166  Upstream and Downstream Connection Speeds for Wireline 
Providers 

The field verification team member: 
 

a. For cable modem – Upstream and downstream connection speeds were verified using the 
Ookla speed test at locations within the providers’ coverage area using the specified 
random sampling technique.  An already installed cable modem connection was utilized, as 
available.  These included both preselected points with arrangements made for testing 
(such as at local libraries or at public facilities utilizing cable modem service) and at 
randomly chosen business and homeowner locations where the business or homeowner 
consented to test the service.  Findings were documented accordingly on electronic or 
paper forms.  In addition, the speed test was documented via the Ookla site. 

b. For DSL connection speed testing –The same procedures were used as for cable modem 
testing. Findings were documented accordingly on paper or electronic forms. 

c. For fiber optic connection speeds – For services to homes and small businesses the same 
procedures were used as above for cable modem and DSL.  For higher speed services to 
larger businesses, institutional network connections, enterprise/wide area network 
connections, etc., the team member worked with the business or institutions’ IT group to 
perform connection speed testing.  If actual testing could not be performed, team 
members attempted to gain existing end user documentation tests and performance 
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documentation related to speeds of the network.  Findings were documented accordingly 
on paper or electronic reports. 

 

1177  Wireless Broadband Service Connection Speed Testing 

For cellular broadband 3G and 4G testing – A provider specific air card was needed in order to enable 
the laptop to access the Ookla speed test to determine the speed of connection.  Some service 
providers provided air cards to conduct this testing.  All teams also used both personal and corporate 
cards to assist in the testing.  The speed of connection was tested at randomly selected points 
beginning close to the providers’ tower/antenna infrastructure, at a mid-point and then at the ends of 
the verified coverage area.  Findings were documented accordingly on paper or electronic reports. 
Documentation was uploaded daily by the team members to ensure timely and uniform oversight and 
modifications of the processes.  
 
The MU BB team also conducted a more detailed test of fixed mobile wireless coverage areas 
throughout Boone County using high-speed wireless broadband air cards. For wireless broadband 
testing purposes, the top five providers, AT&T, US Cellular, T-Mobile, Sprint/Virgin Mobile and Verizon 
were tested to understand how mobile broadband varies in different locations by collecting 
information such as: signal strength, speed, as well as the latitude and longitude coordinates of 
where the test was performed.   
 
To gather upload and download speed information for each air card, the team members used the 
MOBroadbandNow Speed Test website on Ookla. During the speed testing it was not uncommon that 
the speeds varied at a specific point for each air card, therefore the air card was tested a total of 
three times for analysis and comparison.  The signal strength was determined by how many “bars” 
were displayed for each provider. The bars would vary depending on if the team was in a mobile 
coverage area or not. The latitude and longitude coordinates were recorded using a GPS unit. The 
speed, signal strength, and coordinates were tested and recorded in ½ mile increments along 
selected urban and/or rural routes throughout Boone County.  
 
Additional air card testing and verification was completed over this past May-July in various counties 
such as:  Howard, Callaway, Cooper, Moniteau, Cole, Morgan, Miller and Camden using specific 
provider footprints. For this testing method, random locations were chosen within the provider 
footprint and air cards were tested to see how each provider varied in strength and signal. 
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1188  Coordination of Contractor and State Parties’ Field Verification 

The state and contractor utilized the process in the diagrams below to coordinate field verification 
activities: 
 
 
 

 
 

Figure 3: Field Verification Coordination Process 

 
1199  PPrroovviiddeerr  FFeeeeddbbaacckk  RReeppoorrttiinngg 

Upon completion of the provider submitted data, feedback information was supplied to each of the 91 
providers that had submitted data.  This feedback was presented in the following forms: 
 

1. A detailed Data Review Report in MS Word format,  
2. All provider attribute data exported into MS Excel format, and  
3. Multiple Overview, Wired and Wireless GIS exported image files in pdf format.   

 
This information would allow each provider to review our validation findings, as well as check their 
submitted data as depicted in the GIS data model, both in a graphical and tabular form. 
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The Data Review Report detailed the usability and completeness of their submitted data as well as an 
estimate of our confidence in their submitted data based on field verification efforts and back lab 
verification steps as detailed above. The report also requested feedback on the accuracy of how we 
characterized their availability areas, technologies, speeds etc.  Based on the provider’s feedback, the 
data was adjusted and refined accordingly. 
 
Field verification and back lab verification processes and procedures were utilized, as available and as 
needed, to ensure the highest level of confidence that the information gleaned from the providers 
was as accurate as possible. During this process, GeoDecisions contacted providers when we found 
instances that appeared to conflict with the information they initially provided and worked with the 
providers to adjust the maps accordingly. 
 
 

2200  SSttaattiissttiiccss 

File Type  Number of Records 
Total Records in all Files  717,930 
Census Block < 2 sq. miles  518,849 
Address‐Level  Not Required 
Street Segment  190,678 
Wireless Shape File  63 
BB Service Overview  587 
Community Anchor Institution  6,917 
Middle Mile  835 
State Boundary  1 
Metadata Provided for Geospatial Data  YES 
Number of ISP's Provided in Submission  101 
 
 

Providers Completed  101 
Pending Additional Data  15 
Non‐Responsive/Refused  22 
Researching  56 
Non‐Facilities Based  84 
Out of Business  8 

TOTAL 286 
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Provider Name  Status  FRN 
NDA Execution 

Date  Notes/Comments 
Adams Networks  Data Included in Missouri State Submission  0011616356  5/18/2010  No updates submitted in third data call response. 
Alma Communications Company  Data Included in Missouri State Submission  0007196207  5/18/2010  No updates submitted in third data call response. 
Alsat Wireless  Data Included in Missouri State Submission  0021067509  8/3/11  New provider from Data Call 4 
Holway Telephone Company   Data Included in Missouri State Submission  0004746863  4/5/2010  Forth data call updates included. 
KLM Telephone Company  Data Included in Missouri State Submission  0003772274  4/5/2010  Forth data call updates included. 
N. W. Communications  Data Included in Missouri State Submission  0003772290  4/5/2010  Forth data call updates included. 
American Fiber Systems, Inc. – Zayo Group  Data Included in Missouri State Submission  0006651202  4/27/2010  Forth data call updates included. 
AT&T Corp.  Data Included in Missouri State Submission  0004496774  4/7/2010  Forth data call updates included. 
AT&T Mobility, LLC.  Data Included in Missouri State Submission  0004979233  4/7/2010  Forth data call updates included. 
AT&T Southwest  Data Included in Missouri State Submission  0016657918  4/7/2010  Forth data call updates included. 
Bay’s Internet  Data Included in Missouri State Submission  0018912576  Not Req’d by Provider  No updates submitted in forth data call response. 
Big River Telephone, LLC  Data Included in Missouri State Submission  0018520320  Not Req’d by Provider  Forth data call updates included. 
BlueBird Network, LLC.  Data Included in Missouri State Submission  0018995944  Not Req’d by Provider  New provider from Data Call 4 
Boycom Cablevision, Inc.  Data Included in Missouri State Submission  0007630791  Not Req’d by Provider  New provider from Data Call 4 
Boycom Cablevision, Inc.  – Partel Broadband Telecom Inc.  Data Included in Missouri State Submission  0020795449  Not Req’d by Provider  New provider from Data Call 4 
Cable One, Inc.  Data Included in Missouri State Submission  0003474327  4/5/2010  Forth data call updates included. 
Cable America Missouri, LLC  Data Included in Missouri State Submission  0015466766  6/10/2010  No updates submitted in forth data call response. 
Carthage Water & Electric  Data Included in Missouri State Submission  0007147143  Not Req’d by Provider  No updates submitted in forth data call response. 
Suddenlink Communications – Cebridge  Data Included in Missouri State Submission  0014367650  6/12/2010  Forth data call updates included. 
Suddenlink Communications – Friendship Cable  Data Included in Missouri State Submission  0004999025  6/12/2010  Forth data call updates included. 
Suddenlink Communications – Cequel III Communications II  Data Included in Missouri State Submission  0009725870  6/12/2010  Forth data call updates included. 
CenturyLink  Data Included in Missouri State Submission  0018626853  4/20/2010  Forth data call updates included. 
Chariton Valley Telephone Corporation  Data Included in Missouri State Submission  0002549392  5/26/2010  Forth data call updates included. 
Chariton Valley Telecom Corporation  Data Included in Missouri State Submission  0008437147  5/26/2010  Forth data call updates included. 
Charter Communications  Data Included in Missouri State Submission  0017179383  6/10/2010  Forth data call updates included. 
Citizens Telephone Company of Higginsville Missouri  Data Included in Missouri State Submission  0002504298  4/5/2010  No updates submitted in forth data call response. 
LiNKCity  Data Included in Missouri State Submission  0016051450  Not Req’d by Provider  No updates submitted in forth data call response. 
City Utilities Springfield (SpringNet)  Data Included in Missouri State Submission  0004759411  3/23/2011  No updates submitted in forth data call response. 
Cogent Communications, Inc.   Data Included in Missouri State Submission  0019898303  Not Req’d by Provider  No updates submitted in forth data call response. 
Comcast  Data Included in Missouri State Submission  0004441663  5/27/2010  Forth data call updates included. 
Covad Communications Company  Data Included in Missouri State Submission  0003753753  5/18/2010  Forth data call updates included. 
Craw‐Kan Telephone  Data Included in Missouri State Submission  0002334225  4/5/2010  No updates submitted in forth data call response. 
T‐Mobile  Data Included in Missouri State Submission  0006945950  5/4/2010  Forth data call updates included. 
Ellington Telephone Company  Data Included in Missouri State Submission  0003741956  4/5/2010  No updates submitted in forth data call response. 
FairPoint Communications Missouri, Inc.  Data Included in Missouri State Submission  0014710388  9/1/2010  Forth data call updates included. 
ExOp of Missouri Inc.  Data Included in Missouri State Submission  0004969697  9/1/2010  New provider from Data Call 4 
Farber Telephone Company  Data Included in Missouri State Submission  0003748043  4/5/2010  No updates submitted in forth data call response. 
BPS Telephone Company  Data Included in Missouri State Submission  0003730835  4/5/2010  Forth data call updates included. 
BPS Networks  Data Included in Missouri State Submission  0016026965  4/5/2010  Forth data call updates included. 
Brown Dog Networks  Data Included in Missouri State Submission  0009254095  Not Req’d by Provider  New provider from Data Call 4 
Fidelity Cablevision, Inc  Data Included in Missouri State Submission  0000013326  4/5/2010  Forth data call updates included. 
Fidelity Communications Services I, Inc.  Data Included in Missouri State Submission  0004351722  4/5/2010  Forth data call updates included. 
Fidelity Telephone Company  Data Included in Missouri State Submission  0002550309  4/5/2010  Forth data call updates included. 
Granby Telephone Company  Data Included in Missouri State Submission  0005061189  4/5/2010  Forth data call updates included. 
Grand River Mutual Telephone Corp.  Data Included in Missouri State Submission  0002505519  4/7/2010  Forth data call updates included. 
Green Hills Technologies  Data Included in Missouri State Submission  0003736246  4/5/2010  Forth data call updates included. 
Green Hills Telephone ILEC  Data Included in Missouri State Submission  0003736238  4/5/2010  No updates submitted in forth data call response. 
Green Hills Telecommunications Services  Data Included in Missouri State Submission  0003736253  4/5/2010  No updates submitted in forth data call response. 
Hughes Network Systems, LLC  Data Included in Missouri State Submission  0017434911  Not Req’d by Provider  No updates submitted in forth data call response. 
KC Coyote – Isotech  Data Included in Missouri State Submission  0014669097  Not Req’d by Provider  New provider from Data Call 4 
KTIS (Kingdom Telephone Company)  Data Included in Missouri State Submission  0002212314  4/5/2010  Forth data call updates included. 
Cricket Communications, Inc. (Leap Wireless International)  Data Included in Missouri State Submission  0002963528  4/20/2010  Forth data call updates included. 
Le‐Ru Telephone Co.  Data Included in Missouri State Submission  0002490472  4/7/2010  No updates submitted in forth data call response. 
Level 3 Communications, LLC  Data Included in Missouri State Submission  0003723822  4/27/2010  Forth data call updates included. 
LTO Communications, LLC  Data Included in Missouri State Submission  0019008036  Not Req’d by Provider  No updates submitted in forth data call response. 
Mark Twain Communications Company  Data Included in Missouri State Submission  0002531879  4/5/2010  No updates submitted in forth data call response. 
Mark Twain Rural Telephone Co  Data Included in Missouri State Submission  0002549228  4/5/2010  No updates submitted in forth data call response. 
McDonald County Telephone Co  Data Included in Missouri State Submission  0002504058  4/5/2010  Forth data call updates included. 
MCC Missouri LLC (Mediacom)  Data Included in Missouri State Submission  0005184247  9/1/2010  No updates submitted in forth data call response. 
Mid States Services, LLC.  Data Included in Missouri State Submission  0018511303  5/26/2010  Forth data call updates included. 
MyChoice Network LLC   Data Included in Missouri State Submission  0000000000  Not Req’d by Provider  New provider from Data Call 4 / FRN not provided. 
New Florence Telephone Company, Inc.  Data Included in Missouri State Submission  0004374047  4/5/2010  Forth data call updates included. 
Northeast Missouri Rural Telephone Company  Data Included in Missouri State Submission  0004337044  4/20/2010  No updates submitted in forth data call response. 
Northwest Missouri Cellular  Data Included in Missouri State Submission  0002534618  Not Req’d by Provider  No updates submitted in forth data call response. 
Oregon Farmers Mutual Telephone Company  Data Included in Missouri State Submission  0003733847  4/5/2010  Forth data call updates included. 
New Wave Communications  Data Included in Missouri State Submission  0001202938  Not Req’d by Provider  No updates submitted in forth data call response. 
Iland Internet Services  Data Included in Missouri State Submission  0017606898  Not Req’d by Provider  Forth data call updates included. 
Mid Missouri Telephone Co.  Data Included in Missouri State Submission  0002509040  4/5/2010  No updates submitted in forth data call response. 
Ozark Computers  Data Included in Missouri State Submission  0018658179  Not Req’d by Provider  Forth data call updates included. 
Peace Valley Telephone Co., Inc.  Data Included in Missouri State Submission  0018539742  4/5/2010  No updates submitted in forth data call response. 
Poplar Bluff, City of  Data Included in Missouri State Submission  0002514529  Not Req’d by Provider  No updates submitted in forth data call response. 
ProTronics Technologies, Inc.  Data Included in Missouri State Submission  0010790061  Not Req’d by Provider  New provider from Data Call 4 
Radio Wire, Inc.  Data Included in Missouri State Submission  0018912626  Not Req’d by Provider  No updates submitted in forth data call response. 
Ralls Technologies (Ralls County Electric Cooperative)  Data Included in Missouri State Submission  0018539916  Not Req’d by Provider  New provider from Data Call 4 
Midwest Data Center – Subsidiary of Rock Port Telephone  Data Included in Missouri State Submission  0004362505  4/7/2010  No updates submitted in forth data call response. 
Rock Port Cablevision  Data Included in Missouri State Submission  0004362505  4/7/2010  New provider from Data Call 4 



Missouri Broadband Data and Development 

Data Collection and Processing 
 
 

Page 18 

Goodman Telephone Company, Inc.  Data Included in Missouri State Submission  0004269775  4/12/2010  No updates submitted in forth data call response. 
Ozark Telephone Company  Data Included in Missouri State Submission  0004269817  4/12/2010  No updates submitted in forth data call response. 
Seneca Telephone Company  Data Included in Missouri State Submission  0004269809  4/12/2010  No updates submitted in forth data call response. 
Sho‐Me Technologies, LLC  Data Included in Missouri State Submission  0008875890  Not Req’d by Provider  No updates submitted in forth data call response. 
Sprint Nextel Corporation  Data Included in Missouri State Submission  0003774593  6/11/2010  Forth data call updates included. 
StarBand Communications Inc.  Data Included in Missouri State Submission  0005087457  4/5/2010  No updates submitted in forth data call response. 
Steelville Telephone Exchange Inc  Data Included in Missouri State Submission  0002549665  4/5/2010  Forth data call updates included. 
Miller Telephone Company  Data Included in Missouri State Submission  0004269528  4/5/2010  Forth data call updates included. 
TDS Telecommunications Corporation – Stoutland  Data Included in Missouri State Submission  0002502243  4/26/2010  Forth data call updates included. 
TDS Telecommunications Corporation – New London  Data Included in Missouri State Submission  0002529733  4/26/2010  Forth data call updates included. 
TDS Telecommunications Corporation – Orchard Farm  Data Included in Missouri State Submission  0003767340  4/26/2010  Forth data call updates included. 
Time Warner Cable  Data Included in Missouri State Submission  0013430244  6/21/2010  Forth data call updates included. 
Total Highspeed Internet Service  Data Included in Missouri State Submission  0017633405  Not Req’d by Provider  New provider from Data Call 4 
Townes Tele‐Comm, Inc. – Choctaw Telephone Company  Data Included in Missouri State Submission  0004928792  Not Req’d by Provider  Forth data call updates included. 
Townes Tele‐Comm, Inc. – MoKan Dial, Inc.  Data Included in Missouri State Submission  0004928750  Not Req’d by Provider  Forth data call updates included. 
Tw telecom  Data Included in Missouri State Submission  0017348061  4/27/2010  No updates submitted in forth data call response. 
United Services, Inc. (United Sky Wireless)  Data Included in Missouri State Submission  0016087876  4/5/2010  No updates submitted in forth data call response. 
Verizon Wireless – Cellco Partnership  Data Included in Missouri State Submission  0003290673  5/26/2010  Forth data call updates included. 
WildBlue Communications, Inc.  Data Included in Missouri State Submission  0007843766  5/4/2010  No updates submitted in forth data call response. 
Windjammer Communications LLC  Data Included in Missouri State Submission  0017915182  Not Req’d by Provider  No updates submitted in forth data call response. 
Windstream Corporation  Data Included in Missouri State Submission  0014400220  6/10/2010  No updates submitted in forth data call response. 
YHTI  Data Included in Missouri State Submission  0014205504  4/5/2010  Forth data call updates included. 
Lathrop Telephone Company  Data Included in Missouri State Submission  0003737376  4/7/2010  Forth data call updates included. 
NPG Cable, Inc. (St. Joseph Cablevision)  Data Included in Missouri State Submission  0002508687  Not Req’d by Provider  Forth data call updates included. 
United States Cellular Corporation  Data Included in Missouri State Submission  0004372322  8/21/2010  Forth data call updates included. 
KC Web Internet Services, LLC  Compiling Data – No Data Submitted  0011513751  Not Req’d by Provider  No source data received to date. 
KEI Internet Service  Compiling Data – No Data Submitted  0000000000  Not Req’d by Provider  No source data received to date. 
Wisper ISP, INC  Compiling Data – No Data Submitted  0016278970  Not Req’d by Provider  No source data received to date. 
AccuBak Data Systems, Inc.  Data Compiled But Not Submitted By Provider  0018543744  Not Req’d by Provider  Owner still having trouble seeing the benefit to submitting data. 
Ritter Cable Corporation  NDA Fully Executed – No Data Submitted  0014054449  4/20/2010  No source data received to date. 
IAMO Telephone Company  NDA Fully Executed – No Data Submitted  0014067565  4/7/2010  No source data received to date. 
SureWest Kansas, LLC – Everest Midwest LLC  NDA Fully Executed – No Data Submitted  0004069035  4/12/2010  No source data received to date. 
Blue Mule Wireless  Data Not Submitted By Provider  0000000000  Not Req’d by Provider  No source data received to date. 
TA Highspeed  Data Not Submitted By Provider  0000000000  Not Req’d by Provider   No source data received to date. 
Tower Internet  Data Not Submitted By Provider  0000000000  Not Req’d by Provider  No source data received to date. 
US Cable of Coastal‐Texas, L.P.  Data Not Submitted By Provider  0000000000  Not Req’d by Provider  No source data received to date. 
Crystal Broadband  Data Not Submitted By Provider  0000000000  Not Req’d by Provider  No source data received to date. 
Socket Telecom, LLC  Working Toward Signed NDA  0008515595  NA  Reseller currently. Becoming facilities based provider  
Haug Communications, Inc.  Working Toward Signed NDA  0004711735  NDA Sent – Speeds currently below Broadband. 
Finally Broadband, LLC.  Working Toward Signed NDA  Not  fully operational as of 8/31/11 
Iowa Telecommunications Services, Inc.  Non‐Responsive  0003911385    
Mo‐Ark Communications – (Wasp Wireless)  Non‐Responsive  0004376919  NDA Sent 
CorpraNet  Non‐Responsive  NDA Sent 
Cox Communications  Non‐Responsive  NDA Sent 
True Broadband Networks  Non‐Responsive  No answer at phone numbers and e‐mails kick‐back 
Enventis Telecom Inc.  Non‐Responsive  0008394322  NDA Sent 
Dexter Broadband  Non‐Responsive  NA  Phones disconnected and e‐mails are unanswered 
St Joe Wireless  Non‐Responsive  0002545929  Attempting to make initial contact. 
First Cable of MO (Mississippi Valley)  Non‐Responsive    
Galactic Broadband  Non‐Responsive  No contact information found 
SES Americom  Non‐Responsive  Attempting to make initial contact. 
Verizon Business Global LLC dba Verizon Business  Non‐Responsive  0010856284  Submitted data with wireless company only. 
Momentum  Non‐Responsive    
Mid Missouri Broadband & Cable LLC  Non‐Responsive    
St Louis Broadband  Refused to participate at this time   Does not see benefit 
Birch Telecom of Missouri, Inc.  Refused to Participate  0003732294  NA  Refuse to sign NDA or participate 
Ionex Communications, Inc.  Refused to Participate  0005027453  NA  Refuse to sign NDA or participate ‐ Birch Communications 
Pixius Communications  Refused to Participate  0010480176  NA  Refuse to sign NDA or participate at this time 
Poplar Bluff Internet, Inc (SEMO)  Refused to Participate  0013662408  NA  Refuse to sign NDA or participate at this time 
Semo Communications Inc.  Refused to Participate  0003788775  NA  Poplar Bluff Internet ‐ refuse to sign NDA or participate at this time 
NuVox, Inc.  Researching ‐ Acquired By Windstream  0004319414  6/10/2010  No source data received to date. 
Stouffer Communications  Researching ‐ Included as Granby Telephone  0005061189    
CenturyTel Fiber Co. II, LLC dba LightCore, a CenturyTel Co  Researching Included in CenturyLink submission  0008612293  4/20/2010 
Falcon Cablevision  Researching Acquired By Charter Comm  NA  Data included in Charter submission. 
New Cingular Wireless Services, Inc.  Researching – Purchased by AT&T  0003766532  4/7/2010  Included in AT&T submissions 
City Light Gas & Water Office – City of Kennett  Researching To Determine If Broadband Provider 
City of Marshall  Researching To Determine If Broadband Provider 
Fidelity Communication Services II, Inc.  Researching To Determine If Broadband Provider  0005918503  4/5/2010  Researching inclusion with other Fidelity Provider submissions. 
Fidelity Networks, Inc.  Researching To Determine If Broadband Provider  0004312963  4/5/2010  Researching inclusion with other Fidelity Provider submissions. 
Excel Telecommunications – SureWest  Researching To Determine If Broadband Provider  4/12/2010    
TDS Metrocom  Researching To Determine If Broadband Provider  4/26/2010  Researching inclusion with other TDS Provider submissions. 
TDS Missouri  Researching To Determine If Broadband Provider  4/26/2010  Researching inclusion with other TDS Provider submissions. 
Telephone and Data Systems  Researching To Determine If Broadband Provider  4/26/2010  Researching inclusion with other TDS Provider submissions. 
Aurora Communications, Inc.  Researching To Determine If Broadband Provider  0015696180  4/5/2010  Researching inclusion with other YHTI Provider submissions. 
Full Stream Wireless  Researching To Determine If Broadband Provider 
Broadview Networks Holdings, Inc.  Researching To Determine If Broadband Provider  0010296853 
Broadwing Communications, LLC  Researching To Determine If Broadband Provider  0008599706  4/27/2010  Researching inclusion with other Level 3 Provider submission 
WilTel Communications, LLC.  Researching To Determine If Broadband Provider  0003716511  4/27/2010  Researching inclusion with other Level 3 Provider submission 
AT&T Services, Inc.  Researching To Determine If Broadband Provider  0008644056  4/7/2010  Researching inclusion with other AT&T Provider submission. 
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Advanced Digital LLC  Researching To Determine If Broadband Provider 
BMU Internet  Researching To Determine If Broadband Provider 
Co‐Mo Electric  Researching To Determine If Broadband Provider 
Computer Magic Internet LLC  Researching To Determine If Broadband Provider 
DNG Electronics  Researching To Determine If Broadband Provider 
Extreme  Researching To Determine If Broadband Provider 
Green City Electric Utility  Researching To Determine If Broadband Provider 
Human Span  Researching To Determine If Broadband Provider 
Insight Cable  Researching To Determine If Broadband Provider 
Jaguar Technologies Inc (JagTec)  Researching To Determine If Broadband Provider 
Jobe Internet Services  Researching To Determine If Broadband Provider 
Keno Telephone  Researching To Determine If Broadband Provider 
LocalNet  Researching To Determine If Broadband Provider 
MCM System Wireless  Researching To Determine If Broadband Provider 
MHE Net  Researching To Determine If Broadband Provider 
Midwest Internet Technologies (MITI)  Researching To Determine If Broadband Provider 
Midwest Telecommunications  Researching To Determine If Broadband Provider 
Mist Valley  Researching To Determine If Broadband Provider 
Momentum  Researching To Determine If Broadband Provider 
MoreNet  Researching To Determine If Broadband Provider 
NetZero  Researching To Determine If Broadband Provider 
North Missouri Internet Services  Researching To Determine If Broadband Provider 
Optimum Cablevision  Researching To Determine If Broadband Provider  0003301363 
Pacific Wireless Internet  Researching To Determine If Broadband Provider  0018044297 
PIP Internet  Researching To Determine If Broadband Provider 
Primary Networks  Researching To Determine If Broadband Provider 
Regis  Researching To Determine If Broadband Provider 
Sikeston Internet  Researching To Determine If Broadband Provider  0018375808 
Suddenlink Communications ‐ Cequel Communications  Researching To Determine If Broadband Provider  0015784663  6/12/2010    
Superior Cable  Researching To Determine If Broadband Provider 
Tri‐Lakes Internet  Researching To Determine If Broadband Provider 
Turbo Net  Researching To Determine If Broadband Provider 
Utopian Wireless Corporation  Researching To Determine If Broadband Provider 
United Electric  Researching To Determine If Broadband Provider 
Vaughn's Computer Central  Researching To Determine If Broadband Provider  0019846674 
Wave Internet Technologies LLC  Researching To Determine If Broadband Provider  0020090023 
Access US  Not Facilities Based    
Board of Municipal Utilities  Not Facilities Based  0016073389  Discontinued offering service 
McLeodUSA Telecommunications Services, Inc. (PaeTec)  Not Facilities Based  0003716073  NA    
XO Communications, LLC  Not Facilities Based  0006275945  NA    
Telnet Worldwide  Not Facilities Based  NA    
Terre Star  Not Facilities Based  NA    
TMC Communications  Not Facilities Based  NA    
TracFone  Not Facilities Based  NA    
Sofnet  Not Facilities Based  NA    
Clear Communications, Inc.  Not Facilities Based  Equipment seller 
Superfone Inc.  Not Facilities Based  0008402202    
Tritel  Not Facilities Based  NA    
Missouri Broadband  Not Facilities Based  NA    
Mobilcom Pittsburg, Inc.  Not Facilities Based  0002324465  NA    
PneumaTek  Not Facilities Based  NA  Not responding to email 
City of Newburg  Not Facilities Based  NA    
Qwest Communications Company, LLC  Not Facilities Based  0003605953  NA    
South Holt Cablevision  Not Facilities Based  NA  Offer Internet through Oregon Farmers Mutual Telephone Co 
ADC  Not Facilities Based  NA    
Adva Optical Networking North America, Inc.  Not Facilities Based  NA    
AFL Communications  Not Facilities Based  NA    
Aircell  Not Facilities Based  NA    
Airdis Telecom  Not Facilities Based  NA    
Airespring, Inc.  Not Facilities Based  0006875322  NA    
ANPI  Not Facilities Based  NA    
Arch Communications  Not Facilities Based  NA    
Atlantis Holdings LLC  Not Facilities Based  0018587402  NA    
Bluegrass Cellular  Not Facilities Based  NA    
Boost Mobile  Not Facilities Based  NA    
Broadband National  Not Facilities Based  NA    
BullsEye Telecom, Inc.  Not Facilities Based  0004350930  NA    
Cellular one  Not Facilities Based  NA    
CHR Solutions  Not Facilities Based  NA    
Charles Industries  Not Facilities Based  NA    
Chillicothe Municipal Utilities  Not Facilities Based  0004192225  NA    
City of Newburg  Not Facilities Based  NA    
Cooperative Communications, Inc.  Not Facilities Based  NA    
Curt's Custom Cable  Not Facilities Based  NA    
DeSoto ISP  Not Facilities Based  NA    
Digital Landing  Not Facilities Based  NA    
DirecTV  Not Facilities Based  NA    
DSL,net, Inc. (Megapath)  Not Facilities Based  0004324851  NA    
Earthlink  Not Facilities Based  NA    
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Extel  Not Facilities Based  NA    
Freedom Communications  Not Facilities Based  NA    
GlobalNet  Not Facilities Based  NA    
Golden State Cellular  Not Facilities Based  NA    
Granite Telecommunications  Not Facilities Based  NA    
Illinois Valley Cellular  Not Facilities Based  NA    
Innovative Systems  Not Facilities Based  NA    
Interglobe Communications, Inc.  Not Facilities Based  0005156229  NA    
Inter‐Linc  Not Facilities Based  NA    
Jitterbug   Not Facilities Based  NA    
LightEdge Solutions, Inc.  Not Facilities Based  0015546443  NA    
Logix Communications  Not Facilities Based  NA    
Metropolitan Telecommunications Holding Company  Not Facilities Based  0009806019  NA    
Mid America Computer Corporation  Not Facilities Based  NA    
Mohave Wireless  Not Facilities Based  NA    
Netlogic, Inc.  Not Facilities Based  0006825954  NA    
New Edge Holding Company  Not Facilities Based  0003720471  NA    
Nex‐Tech Wireless   Not Facilities Based  NA    
Nortel Solutions  Not Facilities Based  NA    
Open Range  Not Facilities Based  NA    
OFS  Not Facilities Based  NA    
Pacific Wireless  Not Facilities Based  NA    
Preferred Long Distance  Not Facilities Based  NA    
Protel  Not Facilities Based  NA    
Pulse Broadband  Not Facilities Based  NA  Reseller for Ralls Tech. 
Ralls Technologies, LLC  Not Facilities Based  0018539916  NA   Becoming facilities based in the near future 
SkyTerra Communications  Not Facilities Based  NA    
SkyWay USA  Not Facilities Based  NA    
Spirit Telecom  Not Facilities Based  NA    
Stutler Technologies Corp  Not Facilities Based  NA    
Tablerock Net  Not Facilities Based  NA    
TCO Network, Inc.  Not Facilities Based  NA    
TCS Telecom, Inc.  Not Facilities Based  NA    
Telefonica Data Corp SA  Not Facilities Based  0018547828  NA    
Tellabs  Not Facilities Based  NA    
Toast.Net  Not Facilities Based  NA    
Tranquility Internet  Not Facilities Based  NA    
Video Direct  Not Facilities Based  NA    
Vonage  Not Facilities Based  NA    
Zone Telecom, Inc.  Not Facilities Based  NA    
WestLink  Not Facilities Based  NA    
Aero‐Surf Wireless Internet  Out of Business   Appear to be out of business 
Almega Cable  Out of Business  Not Req'd by Provider   Phone number no longer in service.  Out of business? 
Longview Cable and Data, LLC.  Out of Business  0013948609  NA  Sold off Assets  
Total  Wireless Communications  Out of Business  0018726729  Not Req'd by Provider  Acquired by Total Highspeed Internet Services 
Missouri Network Alliance  Out of Business  0015540669  Not Req'd by Provider  Acquired by BlueBird Network 
Worldcom Broadband Solutions  Out of Business  NA    
Global Crossing Telecommunications, Inc.  Out of Business  0002850519  NA    
Sikeston Board of Municipal Utilities   Out of Business  0016073389  NA    
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Figure 5: Standard NDA pg 2 
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Figure 6: Standard NDA pg 3 
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OVERVIEW 

This white paper highlights the Submission Summary for this deliverable, as well as describes the Data Gathering, 
Data Integration, Data Validation and Verification and Quality Control processes used to create the Broadband 
Mapping Project’s October 1, 2011 data submission. To support varying levels of technical and program 
knowledge, both a high-level summary and a detailed process review are supplied. 
 

SUBMISSION SUMMARY 

PROVIDER DETAILS 

PROVIDER PARTICIPATION 

 Providers Included 

 Docomo Pacific 

 IT& E 

 MCV 
 

 New Providers Since Last Data Submission 

 MCV 
 

 Non-Responsive/Non-Cooperative Providers  

 None 
 

 Other Provider Comments 

 iConnect 

 Currently not a broadband service provider; however they are researching further on 

entering the Terrestrial Fixed Wireless market 

 GTA 

 Working towards becoming a reseller provider in this area 
 

 

COVERAGE AREA CHANGES 

 Coverage Footprint Reductions/Map Refinement –  

 No refinement was required for this data submission 

 

 Coverage Footprint Expansion –  

 IT&E expanded for TT-10 and in Middle Mile  
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DATA CORRECTIONS 

 There were no data corrections required for this data submission 
 

 

 

 

 

 

SUBMISSION RECEIPT RESULTS 

 Attached are the results from the NTIA data submission receipt quality script. 

  
 

 Error Report 

 All items flagged by the submission receipt output listed below were verified as correct 
entries within the data submission.   

 

 Field Check:     FAILED      MiddleMile_LONGITUDE has 23 UNEXPECTED VALUES for 
query: LONGITUDE Is Null OR (LONGITUDE < -170 OR LONGITUDE > -60) 
 

 Field Check:     FAILED      CensusBlock_STATEFIPS has 1084 UNEXPECTED VALUES for 
query: STATEFIPS IS NULL OR STATEFIPS = '' OR STATEFIPS = ' ' OR STATEFIPS <> '0' 

 

 Field Check:     FAILED      Overview_STATECOUNTYFIPS has 3 UNEXPECTED VALUES for 
query: STATECOUNTYFIPS IS NULL OR (STATECOUNTYFIPS NOT LIKE '0%') OR 
(CHAR_LENGTH(STATECOUNTYFIPS) <> 5) 

 

 The following error highlights a broadband provider, Docomo Pacific, which contains speeds 
that are below the specified broadband requirement.  The team decided to keep the 
coverage area in as it’s the only footprint for Docomo Pacific. 

 

 Field Check:     FAILED      Wireless_SpeedNotBB has 1 UNEXPECTED VALUES for query: 
MAXADDOWN = '1' OR MAXADDOWN = '2' OR MAXADUP = '1' 
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COMMUNITY ANCHOR INSTITUION (CAI) DETIALS 

OVERALL STATISTICS 

Community Anchor Institution - Categories 
Overall 
Count 

Broadband 
Subscriber 

Trans 
Tech 

Advertised 
Speed Down 

Advertised 
Speed Up 

Category 1 - School K through 12 19 0 0 0 0 

Category 2 - Library  3 0 0 0 0 

Category 3 - Medical/Healthcare 3 0 0 0 0 

Category 4 - Public Safety 0 0 0 0 0 

Category 5 - Universities/Colleges 1 0 0 0 0 

Category 6 - Other:  Government 7 0 0 0 0 

Category 7 - Other:  Non-Government  11 0 0 0 0 

Total 44 0 0 0 0 

 

 
 

CAI CHANGES 

 

 The only change for this data submission was the inclusion of the CAIID extracted from the three 
databases communicated by NTIA.  They are as follows: 
 

 For K-12 institutions (CAI type 1) please add the NCES ID CCD ID value found here: 

http://nces.ed.gov/ccd/bat/  

 

 For Higher Education (CAI type 5) please add the NCES IPEDS ID value found here: 

http://nces.ed.gov/ipeds/datacenter/  

 

 For Libraries (CAI type 2) please. Combine (do not add) “FSCSKey” and “FSCs_SEQ” from the 

“puout08av2000” file and place them here: 

http://harvester.census.gov/imls/data/pls/index.asp (FYI the LIBID is your state’s unique ID 

for libraries) 

 

  

http://nces.ed.gov/ccd/bat/
http://nces.ed.gov/ipeds/datacenter/
http://harvester.census.gov/imls/data/pls/index.asp
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HIGH-LEVEL SUMMARY 

DATA GATHERING 

BROADBAND SERVICE AREAS, MIDDLE MILE AGGREGATION POINTS AND 
BROADBAND SERVICE OVERVIEW 

The collection of Broadband Service Areas, Middle Mile Aggregation Points and Broadband Service 
Overview information is handled through the following Provider Outreach Process: 

 Build and maintain an inventory of Broadband providers through research and State inputs. 

 Update provider material that describes the data requirements and logistics for data transfer. 

 Update Non-Disclosure Agreement (NDA) for use in project, where applicable. 

 Maintain multiple protocols for the provider to submit data, including Secure File Transfer Protocol 
(SFTP) technology when desired. 

 Conduct one-on-one informational discussions with each provider to communicate the following: 
o Requirements of this project; 

o Broadband data required to support the product data model; 

o Submission protocols available; 

o Capability to validate how the supplied data is aggregated. 

 Download/receive provider data. 

 Establish a repeatable process with provider. Maintain provider communication, transaction and data 
handling records throughout the project (dates contacted, data received, etc.).  

 

COMMUNITY ANCHOR INSTITUTION (CAI) 

The collection of CAI information is handled through the following CAI Collection Process: 

 Collect and maintain inventory of CAIs through data mining, research and State inputs. 

 Maintain web-based CAI portal for institutions to add or confirm attribution, location and enter 
broadband-specific information. 

 Upload web-based data to Core Database for standardization. 

 Perform internal cleansing, such as removing duplicate records, identifying gaps in broadband 
attribution and verifying category. 

 Geocode CAI locations. 

 Translate Core Database data to deliverable-ready format. 

 Continue engagement with non-responsive institutions. 
  



                                                                                   

       Version 2.0         September 2011 Author: Kristin Rousseau 
       Page 9 

DATA INTEGRATION PROCESS 

The data integration and processing mechanisms currently used allow for multiple types of inputs and result in 
a standardized output that meets the NTIA deliverable requirements. This flexible process supports data 
model changes and project-requested enhancements. 

 Receive inputs from providers via submission protocols; upload into Sourcing Database and catalog 
with provider information. 

 Review provider-supplied data for completeness and for potential discrepancies that require 
resolution prior to processing and flag as necessary. 

 Categorize input into data-type category (addresses, block lists, paper maps, etc.). 

 Standardize input based on data type within Staging Database. 

 Create Compact Polygons (CP)—(internal methodology for generating area-based feature for 
coverage in Staging Database). 

 Apply broadband attribution to CP; apply metadata to CP. 

 Perform quality analysis of the CP against the source supplied to identify any completeness or 
accuracy issues. 

 Request additional information from the provider if elements of coverage are missing or contain 
discrepancies. This is a second manual quality check to ensure data is complete. 
o Process coverage area to build the required NTIA data model layers.  

 Process CAI data input into internal standardized format, as discussed above in the Community 
Anchor Institution (CAI) subsection, based on NTIA and State-level requirements. 

 

DATA VALIDATION AND VERIFICATION 

Following the creation of the product, process steps within Data Validation and Verification occur. To ensure 
the data collected and processed is as accurate and comprehensive as possible, provider validation and 
internal verification activities are employed. After the initial mapping of providers’ coverage areas and 
serviceability claims, additional reviews are performed using the methods described in the subsections below 
(Third-Party Data Verification, Broadband Provider Validation, Confidence Values). 
 

THIRD-PARTY DATA VERIFICATION 

The coverage is visually and programmatically compared against third-party data. Pitney Bowes and 
American Roamer data are used in cases where a coverage area is questionable. All anomalies identified 
during this analysis are reviewed with the providers. 

 

BROADBAND PROVIDER VALIDATION—PROVIDER PORTAL APPLICATION 

Providers are trained on and requested to use a secure interactive web application to review their current 
coverage area(s) and supporting broadband attribution and validate their data or submit change requests 
to update their data. All provider change requests go through the Data Integration Process and are 
reviewed with the provider to complete validation. 
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CONFIDENCE VALUES 

All verification, validation and manual quality review results are tracked by provider/technology type and 
stored and maintained within a Validation table. A confidence value is assigned, based on internal 
assessments of the collected information, to highlight the provider coverage areas and/or attributions 
that would benefit from further investigation and/or enhancements. 

 

QUALITY CONTROL 

Following collection, processing and analysis of the provider and CAI data, the product is checked manually 
and algorithmically against the NTIA data model. Some of the items included within these checks are: 

 Format correctness; 

 Table and field structure; 

 Valid values, including default values, where applicable; 

 Geographic extent and topology errors. 
 
Prior to data submission, another quality control script supplied by NTIA is run. This script, 
SBDD_CheckSubmission.py, creates an output in text form that is required to be submitted along with the final 
deliverable. All errors must come up clean, unless otherwise specified by NTIA. Exceptions to the script as 
noted by NTIA on the SBDD Workspace on 03/25/11 can be found at the following link: https://sbdd-
granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions  

 Longitude values for States outside the lower 48 (any table); 

 CAI results for Transtech, MaxAdUp, MaxAdDown if BBService is “No” or “Unknown”; 

 Overview MaxAdDown, MaxAdUp if 100% of record-level data has MaxAdDown or MaxAdUp 
populated. 
  

https://sbdd-granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions
https://sbdd-granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions
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DETAILED PROCESS REVIEW 

A detailed review of the data collection, integration and quality control points within the broadband data gathering 
and mapping process are discussed in the subsections that follow. In addition, a diagram showing the overall 
process can be seen below. 

 
 

PROVIDER OUTREACH 

For the October 2011 data submission, an e-mail notification was sent to all providers with supporting 
deliverable dates. The providers mainly used the Provider Portal web application to submit changes to and/or 
validate their current coverage area(s). 

 
In support of the data collection effort, providers that did not timely respond to the outreach were contacted 
by phone. 
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OUTREACH MATERIALS 

The original provider packet sent via e-mail to the providers included the following documents and files: 

 Letter from the State inviting them to participate in the program; 

 Copy of the Non-Disclosure Agreement (NDA); 

 Copy of the Mapping NOFA from the NTIA; 

 Copy of the NOFA Clarification from the NTIA; 

 Broadband service address example file in CSV format; 

 Word document describing service address example file; 

 Broadband service block example file in CSV format; 

 Word document describing service block example file; 

 Broadband service street example file in CSV format; 

 Word document describing service street example file; 

 Broadband subscriber example file in CSV format; 

 Word document describing subscriber example file; 

 Broadband wireless coverage area sample shapefile; 

 Word document describing wireless coverage area sample shapefile; 

 Instructions for downloading, installing and using the WinSCP SFTP application. 
 

OUTREACH PROCESS 

The provider outreach process is comprised of the following general steps: 

 Send the provider package and introduction letter to the main point of contact for the provider. 

 Follow up with e-mail and telephone to verify that the main point of contact is correct. 

 If necessary, discuss the NDA further and resolve any redlines. 

 Once the correct primary contact is established, set up a telephone call, if necessary, to learn more 
about the provider’s offerings and direct them to the appropriate outreach materials. 

 If providers are unable to be contacted (non-responsive) or indicate that they are not interested in 
participating (non-cooperative), mark them as such on the provider tracking sheet. These providers 
will be escalated to the State for further action. 

 As the providers are collecting the required data, provide instructions on downloading, installing and 
using the WinSCP SFTP application, if required. 

 Arrange with the providers to transfer the data in whatever way they are comfortable: some 
providers will find regular email acceptable; others will want to use the SFTP application. 

 After data is received and reviewed, it may be necessary to contact a provider for clarification or to 
address incomplete datasets. In the interest of building and maintaining relationships, care is given 
not to push the provider but to work with it to obtain accurate data in the best possible format. 
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DATA COLLECTION 

DATA TRANSFER PROCEDURES 

There are three primary ways data is collected from providers. These are: 

 Secure FTP (SFTP) using the WinSCP application; 

 Regular e-mail; 

 Mail. 
 

INITIAL DATA REVIEW AND QUALITY ASSURANCE 

The initial data review and quality assurance process consists of the following general steps: 
1) Access the data from the SFTP site or e-mail. 

a. If e-mailed, place copy of original dataset in the appropriate provider folder on the SFTP site. 
2) Place copy of raw data on local computer in a working directory. 
3) Review data and determine course of action based on type of data received. 
4) Ensure data is complete and contact provider to address any gaps. 

 

NOTE: 
The goal is to get as many providers as possible to provide subscriber address data in the correct format. 
Obviously, this will not be possible with all providers so we will continue to have to process various types of 
provider-supplied data. 

 

DATA INGESTION 

DATA INGESTION OVERVIEW 

The following subsections outline the process steps taken based on the type of input supplied by the data 

provider: 

 Point Data: 
o Subscriber location; 
o DSLAM location; 
o Central Office location; 
o Broadcast Tower location. 

 Linear Data: 
o TIGER® street segments. 

 Polygonal Data: 
o Census Blocks; 
o Coverage Area. 

Overall, the process is geared toward taking the provider data supplied and creating polygon shapes to 
append to the bb_cov feature class. The bb_cov feature class is the interim dataset that is then processed 
using the makeDeliverable.py Python script to create the MapConnect

TM
 data layers that will be delivered 

to the State and, ultimately, to the NTIA. Detailed instructions used in this process can be found in the 
subsections below. 
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POINT DATA 

SUBSCRIBER LOCATION—ADDRESS DATA 

In the event that the data provider supplies subscriber address data, the steps are as follows: 
1) First, convert the address data to a clean Excel spreadsheet in an appropriate address data 

format. 
a. Usually, this has the following columns: street address (number, pre-directional, pre-

modifier, street name, street type, post-directional and post-modifier concatenated), city, 
state, ZIP. 

2) Configure the ArcGIS® geocoding tool to use the TIGER® 2009 streets dataset. 
a. In ArcCatalog®, create a new Address Locater by right-clicking in the white space of the 

appropriate directory and selecting New>Address Locater from the dropdown menu. 
b. Select US Streets with Zone and click OK. 

 

NOTE: 
It is likely that multiple Address Locators will have to be set up to handle the variety of provider address data 
received. 
 

c. Navigate to the TIGER Streets 2009 file and click OK. 
d. Fill in the dialog box, as shown below: 
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e. Click OK. 
3) Open ArcMap® and add the Excel spreadsheet with the address information. 
4) Right-click on the Excel spreadsheet and select Geocode Addresses from the dropdown menu. 
5) Select the appropriate address locator by clicking Add…, then OK. 

 

6) Fill out the Geocode Addresses dialog box, as shown below: 

 

7) Geocode the list in batch mode using the geocode service set up in Step 2 above, accepting all 
the default parameters. 

8) Review results. See example below. 
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9) Adjust geocoding parameters accordingly and repeat batch to resolve issues. 
10) Manually geocode unmatched addresses until target hit rate achieved, generally 90%. 
11) Visually inspect the data, as shown below: 

 

12) Follow the steps detailed in Subscriber Location—GIS Data below. 
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SUBSCRIBER LOCATION—XY DATA 

If the provider supplies a list of subscriber data with accompanying XY data such as latitude and 
longitude, the steps are as follows: 

1) Refine the format in Excel so that the data can be opened easily using ArcMap®. 

a. Remove all font color, highlighting, cell colors and borders, clean up column headers and 
make certain there are no merged cells. 

b. Make certain that XY locations are in decimal degrees. 
(i.) To convert from degrees, minutes, seconds (39º 26’ 45.67”) to decimal degrees, use the 

following formula: DD + (MM/60) + (SS.SSS/3600). 
 

NOTE: 
If XY locations from some other coordinate system are provided, you can use those in the process below but you 
must know what the coordinate system is. 
 

2) Open the Excel worksheet in ArcMap®. 

3) From the menu bar, select Tools>Add XY Data… 

 

4) Supply the appropriate fields for the X and Y coordinates, choose the appropriate coordinate 
system and click OK. 

5) Results are an event layer, not a true spatial layer. Export the data by right-clicking the event 
layer and selecting Data>Export Data… from the dropdown menu. 

6) Follow the steps detailed in Subscriber Location—GIS Data below. 
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SUBSCRIBER LOCATION—GIS DATA 

If the provider supplies subscriber location in GIS format, the only process step is to load that data 
into the appropriate data schema and it will be ready for processing. 
1) First, load the data into the Point Address database schema (please see Appendix D for an 

example of the Point Address database schema.) using an empty feature class in that schema. 

2) In ArcCatalog®, right-click on the empty feature class and select Load from the dropdown menu. 

3) Navigate to the provider address GIS dataset and then map the attribute fields accordingly, as 
shown below: 

 

4) Once you have successfully loaded the provider address data into the temporary database with 
the correct schema, you now will append that data to the overall Point Address database. 

5) In ArcToolbox®, use the Append command (Data Management Tools>General> Append) to add 
the features into the overall Point Address database, as shown below: 
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6) Since the data is already in the Point Address database schema, there is no need to alter the Field 
Map in the Append tool. 

7) After appending, calculate metadata reflecting geometry source and representation values. 
8) Break provider-specific points into separate county feature classes and perform the following 

steps per county feature class: 
a. Within ArcGIS®: 

(i.) Summarize download and upload speeds [first,last] to determine all speeds available for 
county. 
(1) This will save as a DBF table. Keep track of location for future reference. 

(ii.) Buffer county address point featureclass to 150’. 
(1) During buffer command, dissolve on ad_down; ad_up; provider; dba; frn; tt; all 

metadata fields; stctyfips. Save as…. county_fastestdown_fastestup.  
(2) Example using Qwest data: boulder_40128_20128, where boulder=county; 

40128=ad_down; 20128=ad_up. 
 

NOTE: 
These attribute fields are specific to the Point Address database. 
 

(iii.) Select the features that represent the lowest speeds. 
b. Using XtoolsPro (http://www.xtoolspro.com/): 

(i.) In the XTools Pro toolbar, select XTools Pro>Layer Operations>Erase Features. 
(ii.) Use the same feature class for Input and Overlay. 
(iii.) Check Use selected features on the Input feature, as shown below. 
(iv.) Repeat and erase slowest speeds one speed at a time. Save each new feature class as 

the next slowest speed, using the same naming convention as shown in a.(ii.)(1) above. 
A general example is shown below: 
  

http://www.xtoolspro.com/
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c. Return to ArcGIS®: 
(i.) Edit/delete speeds from the attribution table of each feature class, so each remaining 

feature class has only one speed value. 
(ii.) Merge individual speed feature classes using the Merge command in ArcToolbox® (Data 

Management Tools>General>Merge). The dialog box is shown below:  

 

(iii.) Merge individual county feature classes using the Merge command in ArcToolbox (Data 
Management Tools>General>Merge). 

(iv.) Since the county files are all in the same schema, DO NOT alter the Field Map portion of 
the command interface. 
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(v.) When all the county files are merged into one dataset, use the Append command in 
ArcToolbox® (Data Management Tools>General>Append) to add the features to the 
bb_cov interim dataset. Use the Field Map portion of the Append tool to map the 
appropriate field values to their corresponding fields in the bb_cov feature class. 

DSLAM OR CENTRAL OFFICE LOCATION—ADDRESS DATA 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central 
Office address data, the steps are as follows: 
1) Follow the process for geocoding points in Subscriber Location—Address Data above. 
2) Follow the steps detailed in DSLAM or Central Office Location—GIS Data below. 

DSLAM OR CENTRAL OFFICE LOCATION—XY DATA 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central 
Office XY data, the steps are as follows: 
1) Follow the process for creating points from XY data in Subscriber Location—XY Data above. 
2) Follow the steps detailed in DSLAM or Central Office Location—GIS Data below. 

DSLAM OR CENTRAL OFFICE LOCATION—GIS DATA 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central 
Office GIS data, the steps are as follows: 
1) Buffer the DSLAM/Central Office points feature class. 

a. Add the point feature class to ArcMap®. 

b. Open the ArcToolbox® and go to Analysis Tools>Proximity>Buffer. 

c. Set the buffer distance to 5 miles. 
d. Set the dissolve type to ALL. 
e. Name the output feature class. 
f. Typical Buffer tool is shown below: 

 

g. Click OK. 
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2) Use the resulting buffer feature class to clip the TIGER® street layer: 

a. Add TIGER® street layer to ArcMap®. 

b. Open the ArcToolbox® and go to Analysis Tools>Extract>Clip. 

c. Complete the dialog box as shown below: 

 

d. Click OK. 

3) Using ArcCatalog® and within the file geodatabase: 

a. Right-click and create a new Feature Dataset.  
(i.) For the Feature Dataset settings: 

(1) Name the feature dataset accordingly. 
(2) Select horizontal coordinate system by importing the coordinate system associated 

with the clipped TIGER® street layer by selecting Import and navigating to the 

location of that feature class. 
(3) No vertical coordinate system needed. 
(4) Leave all x,y,z,m values at default. 
(5) Click Finish. 

4) Import previously created street feature class into new Feature Dataset. 
5) Right-click Feature Dataset and create new Network Dataset—accept all default setting for the 

Network Dataset. 
 

NOTE: 
The Network Analyst extension must be turned on. 
 

6) In ArcMap® turn on the Network Analyst Toolbar by going to View>Toolbars>Network Analyst. 

7) Add the Network Dataset created in Step 5 to ArcMap. 
8) Using the Network Analyst Toolbar dropdown, create New Service Area. 

9) Open the Network Analyst Window by selecting the  button. See below. 
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10) Right-click Facilities layer, select Load Locations and navigate to the DSLAM/Central Office 
facilities feature class. 

 

11) Click OK. 

12) Click the Service Area Properties button . 
13)  For the following tabs, change the following properties: 

a. Polygon Generation tab:  
(i.) Select Merge by break value.  
(ii.) Also disable the Trim Polygons option. 

b. Analysis Settings tab—using and converting the specified DSLAM buffer distance from feet 
to meters—input buffer distance value in meters into the Default Breaks location. 
(i.) Generally, 18,000 feet (5486 meters) from DSLAM or Central Office location is used as 

the buffer distance. See below. 
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c. Click OK. 

14) On the Network Analyst Toolbar, click the Solve button  to create service area polygons. 
15) Right-click on the created service area polygon in the layer list, and select Data>Export Data from 

the dropdown list. 
16) Export to a feature class in the file geodatabase you created earlier. 

17) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the feature class created in Step 16 into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click the Add button, then click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 
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e. Click Next, then Next again, then Finish. 

18) In ArcToolbox®, go to Data Management Tools>General>Append. 

19) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 

 

20) Leave the Schema Type as TEST. 
21) Click OK. 

22) In ArcMap®, open bb_cov for editing and manually input associated attribution. 
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BROADCAST TOWER LOCATION—ADDRESS DATA 

In the event that the provider supplies wireless broadcast tower location address data, the steps are 
as follows: 
1) Follow the process for geocoding points in Subscriber Location—Address Data above. 
2) Follow the steps detailed in Broadcast Tower Location—GIS Data below. 

BROADCAST TOWER LOCATION—XY DATA 

In the event that the provider supplies wireless broadcast tower location XY data, the steps are as 
follows: 
1) Follow the process for creating points from XY data in Subscriber Location—XY Data above. 
2) Follow the steps detailed in Broadcast Tower Location—GIS Data below. 

BROADCAST TOWER LOCATION—GIS DATA 

In the event that the provider supplies wireless broadcast tower location GIS data, the steps are as 
follows: 
1) Download the required software (Radio Mobile) from the website: 

http://www.cplus.org/rmw/english1.html  
2) Install the software according to the standard directions, found here: 

http://www.cplus.org/rmw/download/download.php?S=1  
3) Open the application. 
4) Load the broadcast tower location and elevation information by selecting File>Unit properties. 

The following dialog box appears: 

 

5) Add the information for all the towers supplied by the WISP data provider, including the 
elevation. If provider does not supply elevation, this information can be obtained from Google 
Earth. 
a. If available, use the Import button to import a Google Earth KML of the tower locations. 

6) Go to the National Map Seamless Server (http://seamless.usgs.gov/) and download elevation 
data sufficient to contain the tower locations. 

http://www.cplus.org/rmw/english1.html
http://www.cplus.org/rmw/download/download.php?S=1
http://seamless.usgs.gov/
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a. At least the 1/3” NED data is needed. Select this by clicking the Download button in the 
upper right of the website and checking the box next to 1/3“ NED. 

b. Zoom to the area of interest and use the Download tools to define the area to download: 

 

c. Click the Modify Data Request button to request the data in BIL_16INT format, not ESRI 
GRID, as shown below: 

 

d. Download the data and unzip it. 
7) Select File>Map Properties to define the map. 
8) Enter a latitude and longitude in the center of the tower locations. 
9) Set the size (in pixels) and the size (in kilometers) of the map. 
10) Set the directory path leading to the BIL elevation data just downloaded. 
11) The dialog box is shown below: 
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12) Click Extract. 
13) The elevation data is rendered as a hill shade, as shown below: 

 
14) Select File>Network properties from the main menu. 
15) Create a new network and enter in the frequency range under the Parameters tab, as shown 

below: 
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16) Leave all the other values as they appear, and select the Systems tab. 
17) Create enough systems to cover all the varieties of equipment in the provider network. This will 

include the antenna type, height and line loss, as shown below: 

 
 

18) Now click on the Membership tab, and assign the individual towers to their respective systems, 
providing the azimuth for non-omnidirectional antennas, as shown below: 
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19) Click OK. 
20) Select Tools>Radio Coverage>Combined Cartesian from the main menu. 
21) Complete the dialog box as shown below, providing the Maximum Range from the highest tower 

beam radius supplied by the provider. 
22) Set the Pixel Size at 5 (experiment depending on the area covered to get the right level of 

granularity), as shown below: 

 
23) Set the Signal range to draw to S-Unit and type 5 in the From (>=) box. 
24) Click on Draw. See below. 
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25) Save the resulting image as a TIF by selecting File>Save Picture as. 
26) Open ArcMap® and load the BIL elevation data you used in Radio Mobile. 
27) Load the TIF image you created and georeference it using the corners of the BIL data. 

a. The corners of the data can be seen in the TIF image. 
28) Follow the georeferencing directions from the Coverage Area—PDF/JPG/Other Image Format 

section below. 
29) Use the Georeferencing Toolbar to Update the Georeferencing for the TIF dataset. 
30) In ArcToolbox®, select Data Transformations>From Raster>Raster to Polygon and input the 

georeferenced TIF you just created, as shown below: 
31) Open the resulting polygon feature class for editing using the Editing toolbar in ArcMap® and 

clean up as necessary. 
32) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the feature class created above into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click the Add button, then click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 
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e. Click Next, then Next again, then Finish. 

33) In ArcToolbox®, go to Data Management Tools>General>Append. 
34) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 

 
35) Leave the Schema Type as TEST. 
36) Click OK. 

37) In ArcMap®, open bb_cov for editing and manually input associated attribution. 
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LINEAR DATA 

TIGER® STREET SEGMENTS—LIST, SPREADSHEET OR GIS DATA 

In the event that the provider supplies TIGER® street segments in list or spreadsheet format, the 
steps are as follows: 
1) Join TIGER® road segments to 2000 census blocks feature class using one of two methods based 

on how the data is provided: 
a. If the TIGER® data is provided with a Census Block ID, then join the segments to the Census 

Block geometry based on that ID: 
(i.) Load both datasets into ArcMap®; 
(ii.) In the layer list, right-click on the 2000 census block feature class and select Joins and 

Relates>Join; 
(iii.) In the dialog box, select the TIGER® road segments data and the proper attribute fields 

for joining, as shown below: 

 
(iv.) Click OK. 

b. If the data provided is a list containing TLIDs, then join to the TIGER®/Line data using the 
TLID, and use a spatial join to associate the TIGER® segment with the coterminous block 
based on the block ID: 
(i.) Load both datasets into ArcMap®; 
(ii.) In the layer list, right-click on the 2000 census block feature class and select Joins and 

Relates>Join; 
(iii.) Select Join data from another layer based on spatial location from the dropdown 

menu; 
(iv.) Complete the dialog box, as shown below and click OK. 
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2) Export joined records into a temporary feature class. 
3) If joined Census Block geometry is confined to one specific area, then dissolve blocks into one 

record. If joined Census Block geometry is distributed throughout a particular State, then dissolve 
sub-selections of census blocks for each county. 
a. Use the County FIPS code to dissolve by county. 

b. In ArcToolbox®, select Data Management Tools>Generalization>Dissolve. 

c. Complete the Dissolve dialog box, as shown below: 
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d. Click OK. 

4) For each dissolved region, open the feature class for editing using the Editing tool in ArcMap® 

and remove unnecessary slivers and other small holes. For general guidance on editing features 

in ArcMap®, see http://webhelp.esri.com/arcgisdesktop/9.3/pdf/Editing_Tutorial.pdf  

5) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the feature class created above into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click on the Add button, then click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 
 

http://webhelp.esri.com/arcgisdesktop/9.3/pdf/Editing_Tutorial.pdf
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e. Click Next, then Next again, then Finish. 

6) In ArcToolbox®, go to Data Management Tools>General>Append. 
7) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 

 
8) Leave the Schema Type as TEST. 
9) Click OK. 
10) In ArcMap®, open bb_cov for editing and manually input associated attribution if necessary. 
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POLYGONAL DATA 

COVERAGE AREA—PDF/JPG/OTHER IMAGE FORMAT 

In the event that the provider supplies coverage area data in some image format such as PDF or JPG 
format, the steps are as follows: 
1) If in PDF format, open in Adobe Acrobat and Save As… JPG format. 

2) Open the JPG image in ArcMap®. 

3) Add the required base map vector data for georeferencing. 

a. This generally will be either the CDOT data or TIGER® data. 

4) Change the coordinate system of the data frame to the desired end coordinate system. 
5) Zoom to the general location of the JPG map image. 

a. This is the location based on the vector data, not the JPG image itself. For example, if you 
know that the JPG image represents an area around the town of Limon, zoom to the town of 
Limon in your vector data. 

6) Open the Georeferencing toolbar by selecting View>Toolbars>Georeferencing from the main 
menu bar. 

7) Using the Georeferencing toolbar, select Fit to Display; results are shown below: 

 

8) Use the Control Point button  to add control points to the map. 
9) Use common points in the base dataset and the JPG image. 

a. For example, find major street intersections, county/city boundaries, etc. 
b. Try to distribute the points more or less in the four corners on the image for the best 

transformation. 
10) Click on the location on the image first, then click on the corresponding location on the vector 

database map, as shown in the image below: 
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11) After placing each control point, the image transformation will update automatically.  
12) Repeat until satisfied with the transformation. 

 

NOTE: 
The transformation may take up to four points, although sometimes only two are necessary. 
 

13) When satisfied with the transformation, select Update Georeferencing from the Georeferencing 
toolbar dropdown. 
a. This will create a “world” file (.jgw in the case of JPGs) in the same directory as the image 

file. 

14) In ArcCatalog®, create a new polygon shapefile with the appropriate data schema for a provider 

coverage area, which can be found in Appendix D. 

15) Add the shapefile to ArcMap®. 

16) Using the Editor toolbar, select Start Editing. Set the Task to Create New Feature. 

17) Use the Sketch Tool  to digitize a new coverage polygon using the coverage area outline 
from the georeferenced JPG and add the required attributes manually. 

18) Repeat the above steps for all subscriber speed coverage areas provided. 
19) Follow the steps detailed in Coverage Area—GIS Data below. 

COVERAGE AREA—KML/KMZ 

In the event that the provider supplies coverage area data in Google Earth KML or KMZ format, the 
steps are as follows: 

1) Use a KML to SHP converter to translate file into an Esri® format. 

2) http://arcscripts.esri.com/details.asp?dbid=15603  

3) Download the script and follow the provided instructions for installing it in ArcToolbox®. 

4) Double-click on the script in ArcToolbox® and navigate to the location of the KML file, as shown 

below: 
 

http://arcscripts.esri.com/details.asp?dbid=15603
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5) Add the new shapefile to ArcMap®. Repeat for all KML files provided. 

6) Follow the steps detailed in Coverage Area—GIS Data below. 

COVERAGE AREA—CAD DATA 

In the event that the provider supplies coverage area data in GIS format, the steps are as follows: 

1) Transform the CAD dataset into an Esri® format. 

2) http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datase
ts 

3) It may be necessary to contact the provider first to determine the coordinate system of the CAD 
data. 

4) If the CAD data is not in a standard coordinate system, it may be necessary first to use ArcMap® 

to georeference the CAD data to a known coordinate system. 
a) To do so, follow the instructions provided above in Coverage Area—PDF/JPG/Other Image 

Format. 

5) In ArcCatalog®, create a new polygon shapefile with the appropriate data schema for a provider 

coverage area, which can be found in Appendix D. 

6) Add the shapefile to ArcMap®. 

7) Using the Editor Toolbar, select Start Editing. Set the Task to Create New Feature. 

8) Use the Sketch Tool  to digitize a new coverage polygon using the coverage area outline 
from the georeferenced CAD file and add the required attributes manually. 

9) Follow the steps detailed in Coverage Area—GIS Data below. 

COVERAGE AREA—GIS DATA 

In the event that the provider supplies coverage area data in GIS format, the steps are as follows: 

1) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the GIS feature class either created above or supplied by the provider into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click on the Add button, then click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 

 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datasets
http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datasets
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e. Click Next, then Next again, then Finish. 

2) In ArcToolbox®, go to Data Management Tools>General>Append. 

3) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 

 
4) Leave the Schema Type as TEST. 
5) Click OK. 

6) In ArcMap®, open bb_cov for editing and manually input associated attribution, if necessary. 

COMPACT POLYGON FROM SUBSCRIBER POINTS  

1) Geocode address list using latest State Composite Locator.  
2) Verify that your geocoded file has only one TT (Technology Type). If not, export individual 

geocoded layers for each Technology Type. 
3) For each TT, check for differences in speed values or speed tiers and create separate layers for 

each speed value/tier. 
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4) Clean your geocoding results: remove any points that geocode to accuracy levels below ZIP+4 
(ZIP centroids, carrier route centroids, etc). Also, verify that outliers with acceptable accuracy 
levels are legitimate, i.e., fall in correct city and Zip. 

5) Perform spatial join between county polygons (using stcnyfips field) and the cleaned geocoded 
subscriber points in order to carry the county name and stcnty fips. 

6) Summarize the number of subscribers by county and use the subscriber counts by county to 
populate the Rate Tier table. 

7) Un-join the county data from the geocode subscribers list. 
8) Create Compact Polygon using cleaned geocoded layer or sub-selection of XtoolsPro—

ConvexHull-DetailedHull option. A sub-selection of geocoded points will be used in areas where 
more than one polygon will need to be created for one provider’s service area. 

9) Evaluate output Hull carefully, looking for areas that should not be covered by hull polygon. 
a. If it is determined that an area or areas should not be represented in coverage area, 

manually reshape hull polygon until coverage area is adequate. 
b. When not obvious and as a general rule, manually resolve compact polygon when the 

distance between the subscriber points used to define the outer boundary of the compact 
polygon exceeds 5 miles . When reshaping the hull polygon, snap to the outermost 
geocoded points. See the three figures below for examples. 

      Compact Hull: Manual Resolution Required            
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Compact Hull: Manual Resolution Required                                        Compact Hull: After Manual Resolution        

                      
10) To attribute the compact polygon, perform a spatial join where your Target Feature Class is the 

compact polygon and the Join Feature Class is your geocoded point layer. Export compact hull 
with joined attributes and name file appropriately. 

11) Append attributed compact polygon to Broadband TT template Feature Class and, if required, 
manually input any provider attribution that may not have carried over in the append process. 

12) Intersect compact polygon with county boundaries to create unique records by county and use 
the state-county-fips field to populate stcty_fips field. Also use the county name field to populate 
the BBCov_Name field. 
a. Exception: where a provider’s coverage is distributed throughout more than one area of any 

given county where the BBcov_Name should be populated using an appropriate city or other 
logical name based on geographical location. 

13) Export/load into appropriate BB TT model dataset. 

CENSUS BLOCKS—LIST OR SPREADSHEET 

In the event that the provider supplies census block data in a list or spreadsheet, the steps are as 
follows: 
1) Ensure block polygons supplied by the provider are 2000 currency. 
2) If other currency, convert to 2000 currency before proceeding. 

a. To do this, remove the trailing letter (a, b, etc.) from the block ID. 
b. You will now have two blocks that equate to one block in the 2000 block geometry. 
c. Delete duplicate block IDs, retaining the higher service tier in each case. 

3) Prepare the block list in clean Excel format, removing all Excel-only formatting, merged cells, 
colors, borders, etc. 

4) Import the spreadsheet into ArcMap®. 

5) Right-click on the 2000 census block feature class in the layer list in ArcMap® and select Joins 

and Relates>Join from the dropdown menu. Join the census block list to the 2000 census blocks 
feature class using the block ID and export joined records in a new feature class. The Join dialog 
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box and process can be seen above in the TIGER® Street Segments—List, Spreadsheet or GIS 

Data subsection. 
6) Follow the steps in Census Blocks—GIS Data below. 

CENSUS BLOCKS—GIS DATA 

In the event that the provider supplies census block GIS data, the steps are as follows: 
1) Ensure that the blocks supplied by the provider are in the required data schema and are 

complete as far as required attribution. 
a. If not, manually enter the required attribution or contact the provider to fill gaps. 

2) If census block geometry is distributed throughout more than one county, then select Data 
Management Tools>Generalization>Dissolve in ArcToolbox® and dissolve based on 
County/Provider/TT/Speed Tier so that unique records are created for each unique combination. 
a. The Dissolve dialog box is shown above in the TIGER® Street Segments—List, Spreadsheet 

or GIS Data section. 
b. Two examples of undissolved census block polygons are shown below: 

 
Undissolved census block polygons 

 
Census block polygons dissolved by county 

3) For each dissolved region use the Editing toolbar in ArcMap® to remove unnecessary slivers and 

other small holes. 
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4) In ArcToolbox®, select Data Management Tools>General>Merge and merge the processed 

polygons into a single layer. 
5) The merged census blocks will need to have the subscriber’s frn field added and populated. 

6) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the GIS feature class either created above or supplied by the provider into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click the Add button, the click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 

 
e. Click Next, then Next again, then Finish. 

7) In ArcToolbox®, go to Data Management Tools>General>Append. 

8) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 
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9) Leave the Schema Type as TEST. 
10) Click OK. 

11) In ArcMap®, open bb_cov for editing and manually input associated attribution, if necessary. 

 

METADATA TRANSACTIONS 

Following any updates or changes completed within the file geodatabase (fGDB) stored on the GIS-Analysts 
staging environment, the GIS-Analyst runs transactions to compare that fGDB with the one stored on the Core 
server to ensure metadata on all changes is recorded. 

 
The steps taken to run transactions on the updated Core database are outlined below: 

1) Open a command line window and run generateTransactions.py:  
a. Usage: generateTransactions.py  [Core fGDB] [Staging Environment fGDB]  
b. Example of command line:  

<path>generateTransactions.py <path>ST_BB_POLY_SRV_AREAS.gdb <path>ST_BB_POLY_SRV_AREAS.gdb  
2) Shown below is an example of the output screen that will be displayed: 
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3) After the process has completed, results can be found in the ST_BB_POLY_SRV_AREAS_HIST.gdb:  

a. The transactions scripts records changes at a feature level. 
b. Shown below is a screenshot supporting the directory structure of the historical fGDB. 

 
c. Attribution associated with each added/removed/changed feature is tracked, including the 

following additional columns appended to the end of each: 
(i.) Commit_by 
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(1) Records the GIS-Analyst who committed the changes to the historical fGDB. 
(ii.) Commit_date 

(1) Records the date and time stamp on which the changes were committed. 
(iii.) Trans_type 

(1) This field reflects the type of change recorded; 
(2) Categorized by: Adds/Change/Deletes. 

(iv.) New_values 
(1) Records the new values when a change was completed on a feature. Example: 

Name or speed change. 
d. MD_Process also is transferred from the edited fGDB to the historical fGDB, which states the 

actions completed by the GIS-Analyst. 

 

 

DATA PROCESSING 

DATA PROCESSING OVERVIEW 

The following subsections detail the steps and layout required to process the service provider data further 
to meet NTIA requirements: 

 Weighted Nominal Speed; 

 Middle Mile; 

 Broadband Coverage Template. 
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WEIGHTED NOMINAL SPEED 

The weighted nominal speed is populated in one of the following two ways: subscriber data supplied by 
provider or value supplied by provider. 

SUBSCRIBER DATA SUPPLIED BY PROVIDER 

Where the data provider supplies subscriber speed information, the following formula from the NOFA 
is used: 

(speed tier-1 in kbps × no. of tier-1 subscribers) + (speed tier-2 in kbps × no. of tier-2 subscribers) + (etc.) 
Total average monthly subscribers 

 
Data is initially broken up in the following order: 
1) Stcty_fips; 
2) Transmission technology type; 
3) Subscriber tiers. 

VALUE SUPPLIED BY PROVIDER 

Some providers will supply their weighted nominal speed. In these cases, the data supplied will be 
populated instead of using the NOFA formula. These obtained or calculated values are used to update 
the service overview layer. 
 
This can be done manually or by creating a table with the provider’s FRN and average weighted speed 

and joining it to the service overview table in ArcMap®. 

1) To join, right-click on the layer to join to and select Joins and Relates>Join from the dropdown 
menu. 

2) Then navigate to the table to join to and select the join fields from the dropdown list. 

3) Then open the source table (the table in ArcMap®) and right-click on the header of the Average 

Weighted Speed field and select Calculate Field from the dropdown menu. 
4) Use the value of the average weighted speed from the joined table. 

 

MIDDLE MILE 

Middle mile information generally is provided in spreadsheet or text file format. The process is to take 
what is supplied by the provider and translate it into the required data schema. 

1) If the data is supplied with address information, follow the process outlined above in Subscriber 
Location—Address Data. 

2) If the data is supplied with associated XY coordinates, follow the process outlined above in 
Subscriber Location—XY Data. 

3) Once the data is in GIS format, use the Append (Data Management Tools>General>Append) 

command in ArcToolbox® to append the data to the overall middle mile dataset. 

4) Set the schema type to NO_TEST and use the Field Map to map the attribute fields from the 
source to the target dataset. 
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BROADBAND COVERAGE TEMPLATE 

The table below lists descriptions of the fields within the bb_cov layer, which is the interim dataset used 
to create the final product deliverable. 
 

NAME ALIAS DESCRIPTION 

objectid OBJECTID Internal Object ID 

shape SHAPE Internal Shape storage 

prov_id PROVIDER_ID Unique numeric identifier for each provider 

prov_name PROVIDER_NAME Unique name for each provider 

dba_name DOING_BUSINESS_AS An alternative "Doing-Business-As" name for the provider 

frn FCC_REGISTRATION_NUMBER Provider FCC Registration Number 

bbcov_name BBCOV_NAME BroadMap Broadband Coverage name 

trans_code TRANSMISSION_CODE Unique code for the transmission technology type described by 

this layer 

trans_name TRANSMISSION_NAME Name for the transmissions technology type 

trans_desc TRANSMISSION_DESC Description for the transmissions technology type 

spect_code SPECTRUM_CODE Unique code for the spectrum [WIRELESS ONLY] 

spect_name SPECTRUM_NAME Name for the spectrum [WIRELESS ONLY] 

spect_desc SPECTRUM_DESC Description for the spectrum [WIRELESS ONLY] 

mad_dwn_t MAX_AD_DOWN_TIER Maximum advertised downstream speed available within given 

area (speed tier) 

mad_up_t MAX_AD_UP_TIER Maximum advertised upstream speed available within given area 

(speed tier) 

typ_dwn_t TYPICAL_DOWN_TIER Typical downstream speed available within given area (speed tier) 

typ_up_t TYPICAL_UP_TIER Typical upstream speed available within given area (speed tier) 

mad_dwn_k MAX_AD_DOWN_KBPS Maximum advertised downstream speed available within given 

area (kbps) 

mad_up_k MAX_AD_UP_KBPS Maximum advertised upstream speed available within given area 

(kbps) 

typ_dwn_k TYPICAL_DOWN_KBPS Typical downstream speed available within given area (kbps) 

typ_up_k TYPICAL_UP_KBPS Typical upstream speed available within given area (kbps) 

subs SUBSCRIBERS Total average monthly subscribers for this provider for this 

technology for this coverage polygon 

md_geom MD_GEOMETRY Metadata: Comma separated list of source ids from which the 

polygon extent was produced 

md_exists MD_EXISTS Metadata: Comma-separated list of source ids used in 

understanding and editing the provider data for this polygon 
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NAME ALIAS DESCRIPTION 

md_who MD_WHO Metadata: Name of the editor who last edited this feature at the 

time in md_when 

md_when MD_WHEN Metadata: Date/time that this feature was last edited 

md_process MD_PROCESS Metadata: Comma-separated list of processes used to create 

and/or modify this layer 

stcty_fips STATE_COUNTY_FIPS State/County FIPS code 

rec_id RECORD_ID Compound Key formed from 

STCTY_FIPS+"|"+Provider_ID+"|"+Trans_Code+"|"+BBCov_Name 

st_area ST_AREA(SHAPE) Area in square decimal degrees  

st_length ST_LENGTH(SHAPE) Length in decimal degrees  

Provider_Type Type of Provider Has Subtype (1:Broadband provider as described in the 

NOFA,2:Reseller,3:Unknown), default value=1 (New 04/11 Model) 

 

VERIFICATION AND VALIDATION 

PROVIDER VALIDATION—PROVIDER PORTAL/PDF MAP REVIEW 

Following the collection and aggregation of provider data, the aggregated data is validated by the 
provider to ensure it is an accurate representation of their coverage area and supporting broadband 
information. 

 This validation is completed through the Provider Portal web application, which is a secure 
interactive map that displays the provider’s coverage areas and allows the provider to 
validate, submit feedback or request changes. 
o If changes are requested, then the features on the portal are updated and an automatic 

request is sent to the provider to complete the validation process. 

 Providers that did not use the Provider Portal are asked to validate a PDF map displaying 
their coverage area(s). This is accomplished via e-mail notification. 

PROVIDER VERIFICATION—THIRD PARTY SOURCE REVIEW 

After the provider has validated its coverage areas, a third-party source comparison and analysis is 
performed. 

 Where anomalies or discrepancies are identified, a “SCAN” point is dropped and descriptive 
comments are applied to be reviewed later with the provider. 

 During the provider review, the map is displayed along with the “SCAN” points and potential 
refinement is completed based on input from the provider. 

The table below shows third-party sources used: 

THIRD-PARTY SOURCE NAME SOURCE TYPE VERIFICATION TYPE 

InfoUSA Consumer and 
Business Listings 

Community Anchor Institutions; 
Can also be used for demographic information 
supporting the State websites. 

Pitney Bowes (PBBI) Exchange Info Plus 
(Central Office 
Locations) 

Exchange datasets are used to verify the following 
Transmission Technologies (TT): 
Asymmetric xDSL (10), Symmetric xDSL (20), Other 
Copper Wireline (30), and Optical Carrier/Fiber to the 
End User (50). 

Media Prints Cable Boundaries Used to verify the following TT: 
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THIRD-PARTY SOURCE NAME SOURCE TYPE VERIFICATION TYPE 

Cable Modem—DOCSIS 3.0 (40) and Cable Modem—
Other (41). 

American Roamer  Wireless Coverage 
Patterns (EVDO, 
GPRS, WISP, HSPA) 

Used to verify the following TT: 
Terrestrial Fixed Wireless—Unlicensed (70), Terrestrial 
Fixed Wireless—Licensed (71) and Terrestrial Mobile 
Wireless (80). 

ComSearch Wireless Spectrum 
Holdings and Tower 
Data 

Used to verify the following TT: 
Terrestrial Fixed Wireless—Unlicensed (70), Terrestrial 
Fixed Wireless—Licensed (71) and Terrestrial Mobile 
Wireless (80). 

ASSIGNING CONFIDENCE VALUES 
All findings and results from the abovementioned validation and verification activities, plus internal 
peer quality reviews, are captured and tracked in a Validation table (see example on the following 
page) and form the basis of the confidence value assigned for each provider and then each 
technology. 

CONFIDENCE VALUE DESCRIPTION 

    0 Coverage area has not been reviewed. 

  10 Extremely Low: 
Single Source QC.   

  20 Very Low: 
Needs additional validation\verification. 

  30 Low: 
Even with validation\verification, coverage still is suspect. 

  40 Acceptable: 
Confirm with State prior to shipment. 

  50 Meets requirements to be included in shipment. 

  60 Moderate: 
Meets NTIA/State’s standards, representative of Technology Type (TT). 

  70 High: 
Accurate representation of coverage based upon TT. 

  80 Very High: 
Multiple validation\verification with most third-party sources. 

  90 Extremely High: 
Multiple validation\verification sources. 

100 Perfect: 
Multiple validation\verification sources, with complete alignment with 
sources and ground truth verification activities. 

 

The Validation table is maintained as updates or changes occur for each provider, down to 
technology type, with the overall goal to improve the confidence values and overall map 
representation. An example of the Validation table is shown below: 
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COMMUNITY ANCHOR INSTITUTION (CAI) DATA 

DATA COLLECTION 

The CAI data was initially collected from the State to create the baseline inventory. All location 
information and broadband coverage data supplied also was ingested into the data deliverable. 
Additional collection of CAI information was done via data mining and/or webscraping to build out 
the inventory further. For example: Collection of additional CAIs and location information. 
 
The State-agency-provided CAI inventory was comprehensive but the challenge is collecting 
broadband related data: service provider(s), technology and speed data for each CAI. Availability of 
the CAI portal has not significantly increased submission of this data. Additional promotion to CAIs to 
use the CAI portal will be needed to increase this data for subsequent deliverables. 

INSTITUTION DATA 

Institution data is obtained from a variety of sources and almost always provided in Excel spreadsheet 
format. The general process for incorporating this data is as follows: 
1) If the data is provided in Excel or some similar format: 

a. Clean and standardize the Excel spreadsheet, removing any cell formats, merged cells, etc. 
b. Standardize the address format as defined in the staging CAI database. 
c. If the spreadsheet includes X and Y values, such as latitude and longitude, use the Add XY 

Data tool in ArcMap® to create a spatial data layer. 

d. If there are only addresses, then follow the geocoding steps outlined above to create spatial 
data points for each of the institutions. 

(i.) Institutions that do not geocode based on the TIGER® 2009 dataset will have to be 

located manually using Google Maps, Google Earth or some other information source. 
2) If the CAI source data is in GIS format, add the Latitude and Longitude fields and use the 

Calculate Geometry tool to populate them, using the WGS 84 coordinate system. 

3) Using ArcCatalog®, load the new data into the staging CAI database. 

4) This database is ready for the makeDeliverable.py script to process the information into the final 
State and NTIA deliverables. 
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COMMUNITY ANCHOR INSTITUTION (CAI) PORTAL UPDATES 

A web application has been released to allow for further data collection and validation of anchor 
institution location information, broadband coverage and speed test data. Information collected from 
the CAI Portal is then ingested into the overall inventory and will be compared later against the 
provider coverage areas mapped to locate any potential discrepancies. 

 

PRODUCT EXTRACT 

PYTHON SCRIPTS 

The following subsections make use of Python scripts. In general, to use a Python script you must have 
Python installed on your computer. To download the latest version of Python, go to 
http://www.python.org/download/ and download the latest stable version. As of August 2010, this was 
version 2.7. Once this is installed, the general way to run a script is to type the following at a command 
prompt: C:\Python27\python.exe C:\<location of script>. Many of the scripts provided have environment 
variables that must be set before they can be run. 
 
The Python code for BroadMap’s product extract has been incorporated into a Hudson CI System, which is 
detailed in the Process Operation and Monitoring section of this document. This was a process 
improvement activity so that all processes can be monitored, controlled and will contain historical 
tracking on each process. 

 

PRODUCT EXTRACT PROCESS 

NOTE: 
Specific Python scripts are called out in red font in the subsections below. 
 

The MapConnect
TM

 product extract process, makeDeliverable.py, uses the BB_Cov and 
BROADMAP_POINTS interim datasets to create the following layers according to the current 
specifications: 

 BB_Service_Road_Segment 
o This layer contains all broadband services associated with specific street segments for census 

2000 blocks larger in area than two square miles. 

 BB_ServiceCensusBlock 
o Contains all broadband services associated with census blocks of no greater than two square 

miles. 

 BB_Service_Wireless 
o This layer contains all wireless services not associated with specific addresses. 

 BB_ServiceOverview 
o This layer contains subscriber-weighted nominal speed for each provider's service area at a 

county level and is meant to act as a summarized view. 

 BB_ConnectionPoint_MiddleMile 
o This layer contains middle-mile and backbone interconnection points. 

 BB_Service_CAInstitutions 
o Broadband Service at Community Anchor Institutions (CAI). 
o Community Anchor Institutions consist of schools, libraries, medical and healthcare 

providers, public safety entities, community colleges and other institutions of higher 
education as well as other community support organizations and entities. 

http://www.python.org/download/
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Because of a NTIA model change for the October 2010 data deliverable, an addition to this code was 
created to support both models in case a comparison is later desired or a request is made to revert to the 
original model. This script name is bdia2ntia.py and creates the following layers in addition to the layers 
mentioned above, rolled up to NATL_Broadband_Map. 

 BB_ConnectionPoint_LastMile 
o This layer contains last mile infrastructure points, which is populated only if data cannot be 

provided at a more granular level. 

 BB_Service_Address 
o Represents broadband availability for service address points. Address Point availability refers 

to those individual addresses at which each facilities-based provider of broadband service 
can provide broadband services of minimal characteristics within 7-10 business days. 

 State_Boundary 
o State boundary supporting topological validation of point feature classes. 

 NATL_Broadband_Topology 
o Supports basic topology quality checking. Example: No CAIs or Middle Mile points outside of 

the State boundary. 
 
The following process flow provides a view of how the Core fGDB is extrapolated to the NTIA final 
deliverable via the makeDeliverable.py script. Following that, the bdia2ntia.py script is run, which limits 
what is placed in the final layers based on the NTIA modeling standards. 
 
The product scripts and supporting extract were originally created separately per request, in case data 
model comparisons were to be completed. 

 

PRODUCT STATISTICS 

Following the completion of a product extract, the product statistics script (BDIA_ReleaseNotesStats.py) 
extracts the following information supporting that product deliverable. 

 Provider Statistics: 
o Collects all provider information, listing by Provider Name. 
o Provides output of FRN. 
o Counts the number of features supported within the following layers: 

 Census Block; 
 Street Segment; 
 Max Upstream; 
 Wireless Services; 
 Infrastructure Points. 

o These updates were made to support the Data Package required to accompany every NTIA 
product deliverable. 

 Community Anchor Institution (CAI) Statistics: 
o Breaks down CAI to the eight categories: 

 1: School: K through 12; 
 2: Library; 
 3: Medical/Healthcare; 
 4: Public Safety; 
 5: University/College; 
 6: Other Government; 
 7: Other Community non-government; 
 None: Unknown Category. In cases where this occurs, further investigation is completed 

prior to product shipment to ensure all CAIs are categorized accurately. 
o Reports out the following counts: 
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 Total CAIs within that category; 
 Total CAIs that contain partial BB coverage. Contains any of the following information for a 

given CAI: BB Subscriber, Transmission Technology, Speed Down Speed Up; 
 Total CAIs that contain full BB coverage. Contains all of the abovementioned BB information 

for a given CAI. 
The output of this script is two CSV files: AnchorInstitutions.csv and Providers.csv. These files then can be 
inspected to ensure that there are the expected number of CAIs and providers for every release. 

 

QUALITY ASSURANCE 

Quality assurance is supported manually and algorithmically on the interim data, BB_Cov file geodatabase and 
on the final product. For scheduled product releases, a test product extract and subsequent manual and 
algorithmic QC run is completed along with a release review. The product specifications, project status reports 
and previous product release notes are used as references throughout this review. 
 
The following parameters are tested using the methodology listed below each: 

 Product Deliverable Format:  
o Correct names and format of data deliverables. 

 BDIA_QC_SUITES (please see below for details). 
o Correct Projections/Datum. 

 Manual interaction with product. 
o Metadata Present and Correct. 

 Manual interaction with product. 

 Table Structure: 
o All required tables included. 

 BDIA_QC_SUITES. 
o Extraneous tables identified. 

 BDIA_QC_SUITES. 

 Field Structure: 
o All fields included. 

 BDIA_QC_SUITES. 
o Extraneous fields identified. 

 BDIA_QC_SUITES. 
o Correct field names, types and widths. 

 BDIA_QC_SUITES. 

 Field Domains: 
o Values in all tables are constrained to the specified values specified: 

 This action is accomplished via BDIA_QC_SUITES and manual review of the product; 
 This tends to identify project completeness issues as fields with a null value are identified. 

 Geometric Representation: 
o Identify if all layers have the correct geometric representation: 

 Manual review of the BB_ServiceOverview layer; 
 Dependent on NTIA and client requirements. 

 Geographic Extent: 
o Product includes the necessary Geography associated with Product? 

 Manual Review—ArcGIS®. 
o Is there extraneous geography included in Product? 

 Manual Review—ArcGIS®. 

 Completeness: 
o Products contain the expected amount of data? 
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 Manual review of product statistics relative to weekly State reports and defined expectations. 

 Accuracy: 
o Product meets the stated accuracy requirements for the deliverable? 

 Sampling procedure to manually review source material to resulting product; 
 Provider Validation; 
 Verification using Third-Party Data; 
 Verification against reality, where applicable. 

 Data Regression: 
o Any unexplainable data loss or change? 

 This action is accomplished by comparing results within product statistics script 
(BDIA_ReleaseNotesStats.py) from previous releases, as well as manual review of the product. 

 Confidentiality: 
o Any unauthorized confidential information included in the delivery? 

 Review of NDAs and delivery expectations. 

 Prior Issues Resolved:  
o Have expected internal issues been resolved? 

 Manual review of data against previous product release notes. 
o Have agreed-upon customer issues been resolved? 

 Manual review of data against previous product release notes, status report and client feedback. 

 Delivery Medium: 
o Has the product medium been verified? 

 Manual review. 
o All files present. 

 Manual review of SFTP site to ensure all files are copied correctly, including file/directory size. 
o Correct location. 

 Manual review—confirmation of SFTP link, username and password. 
 

QC SUITE 

The BDIA_QC_SUITES consists of four main types of scripts supporting the overall QC process. These 
scripts are all run in concert and are called from the test_runner script and the test_BDIAProductGDB 
script. 

CONFIGURATION  

These scripts establish the configuration for the test_BDIAProductGDB script, which is the core of the 
QC Suite. 
update_test_config 
active_config 
config_PROCESS01_automated 
config_PROCESS01_manual 
set_active_config 

LIBRARIES 

These scripts provide additional functionality that is called from with the test_BDIAProductGDB 
script. 
bb_unittest_fixture 
bbcov_structure 
BC_XmlWriter 
file_folder 
search_and_replace 
unittst_fixture 
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validate_BB_DB 
validate_BB_GDB 
xmlrunner_gui 

QC SUITE 

This is the core script for performing automated QA/QC on the interim and final data deliverables. 
test_BDIAProductGDB 

OTHER  

These scripts perform other functions detailed below: 
test_runner—this is the main script that runs all the other QC scripts and imports all the necessary 
scripts and libraries. 
which_build—this determines the current build and passes information to the configuration scripts. 

 

PROCESS OPERATION AND MONITORING 

Product Extract, makeDeliverable.py and bdia2ntia.py, is run within BroadMap using a platform called Hudson 
that has been enhanced to support BDIA product extraction, process monitoring, as well as product validation. 
The same platform can be planned for implementation for the State, if desired. 
 
Below are examples of the product create, product validation, product statistics and monitoring processes 
that are managed within the BroadMap Hudson CI-System. All of the abovementioned Python scripts, with 
the exception of metadata transactions script, are run via this system. 

 

BDIA PRODUCT CREATE 

Below is an example of the main page where the type of product build can be selected. 
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Selecting based on the type of process that will be initiated is shown below: 

 

  
The Console Output can be reviewed to see the progress of product create. Following the completion of 
each product creation process, an e-mail notification is automatically sent to the team. 

 
All processes run via the BroadMap Hudson CI-System are stored for historical reporting. Each process can 
be reviewed, including the Console Output and Build Artifacts from that run. 



                                                                                   

       Version 2.0         September 2011 Author: Kristin Rousseau 
       Page 59 
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PRODUCT VALIDATION AND STATISTICS 

Once the product creation process is complete, Product Validation and Statistics are then initiated. These 
support the BDIA_ReleaseNotesStats.py script and the BDIA_QC_SUITES scripts detailed above. 

 
All statistics and reports are stored for historical review with the capability to place violation criticality on 
each quality control check, allowing the identification of errors because of project status/completeness 
verses project correctness. Example: Typical Speeds populated. 

 

Below is an example of the report provided based on various control points running over a specified 
period: 

 
Similar to the Product Create process, all results from the process are maintained: 
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Results are then reviewed manually to ensure no errors reported are critical or in violation of the NTIA 
data model or project completion statements. Any errors of concern are communicated ahead of product 
delivery and included within the product release notes. Further detail on the Hudson-CI System 
environment can be found by navigating to the following link: 
http://wiki.hudson-ci.org/display/HUDSON/Meet+Hudson 

 
 

PRODUCT EXTRACT DATA DELIVERY 

Product delivery for MapConnect
TM

 Broadband is handled two ways, depending on client requirements: 
1) State Submittal: 

a. Data is submitted via SFTP site; 
b. Product Release Notes and QC Test Report accompany the delivery. 

2) NTIA Submittal: 
a. Directions for using the NTIA State Broadband Data file submission tool: 

(i.) Go to the following website: https://esupport.fcc.gov/statedata; 
(ii.) Enter your username and password as provided to you from the NTIA program 
administrator; 

 
(iii.) Click in Upload a file field; 
(iv.) Browse to local file for submission using the Browse button. Select file, then select 

ATTACH FILE. See example below. 

http://wiki.hudson-ci.org/display/HUDSON/Meet+Hudson
https://esupport.fcc.gov/statedata
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(v.) Logout/Receipt using the Logout button in the top right of the screen; 
(vi.) A receipt of submission is e-mailed to username e-mail address. 
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OVERVIEW 

This white paper highlights the Submission Summary for this deliverable, as well as describes the Data Gathering, 
Data Integration, Data Validation and Verification and Quality Control processes used to create the Broadband 
Mapping Project’s October 1, 2011 data submission. To support varying levels of technical and program 
knowledge, both a high-level summary and a detailed process review are supplied. 
 

SUBMISSION SUMMARY 

PROVIDER DETAILS 

PROVIDER PARTICIPATION 

 Providers Included 

Bay Springs Telephone Co. Inc. 

 
GulfPines Communications, LLC 

BellSouth Telecommunications, Inc. d/b/a AT&T Mississippi 

 
Lakeside Telephone Company Inc. 

BPM Inc. (Noxapater Telephone Company) 

 
Level 3 Communications, LLC 

Bruce Telephone Co. Inc. 

 
Megagate Broadband, Inc. 

Cable One, Inc. 

 
MetroCast of MS, LLC 

Cellular South Licenses, Inc. 

 
Mound Bayou Telephone & Communications, Inc. 

CenturyTel Of North MS. Inc. 

 
NetWireless Solutions, LLC  

Charter Fiberlink MS - CCVI, LLC 

 
Rural Cellular Corporation (Verizon) 

Comcast Phone of Mississippi, LLC 

 
Sledge Telephone Co. Inc. 

Contact Network, Inc. (Inline) 

 
Smithville Telephone Co. Inc. 

Covad Communication 

 
Southern Light, L.L.C. 

Cricket Communications of MS 

 
Sprint PCS 

Decatur Telephone Co. Inc. 

 
StarBand Communications Inc. 

Delta Link LLC. 

 
TDS Telecommunications Corporation 

Delta Telephone Co. Inc. 

 
TEC of Jackson, Inc. 

DeltaCom, Inc. 

 
Telepak Networks, Inc. 

Dixie Net Communications, Inc. 

 
T-Mobile USA, Inc. 

Franklin Telephone Co. Inc. 

 
Trust Communications 

Frontier Communications of Miss. LLC 

 
tw telecom of mississippi llc 

Fulton Telephone Co. Inc. 

 
Windstream Mississippi LLC 

Georgetown Telephone Company Inc. 

 
XFone USA, Inc. 

 

 New Providers Since Last Data Submission 

 Delta Link LLC. 

 EarthLink Business 

 Firenet1.com 

 New Edge Networks 

 StarBand Communications Inc. 

 T-Mobile USA, Inc. 
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 Non-Responsive/Non-Cooperative Providers  

 None 
 

 Other Provider Comments 

 Provider coverage areas were removed from the final product in cases where their speeds 
reported as below broadband, according to the NOFA requirements. 

 
 

 

COVERAGE AREA CHANGES 

 Coverage Footprint Reductions/Map Refinement –  

 Comcast  (TT-41) 

 Mound Bayou Telephone and Communications, Inc   (TT-10) 
 

 Coverage Footprint Expansion –  

 AT&T Mississippi  (TT-10) 

 Bruce Telephone Company, Inc.  (TT-10) 

 CenturyLink  (TT-10) 

 Comcast  (TT-40) 

 Covad Communications Company  (TT-30) 

 DIXIE-NET  (TT-10) 

 Decatur Telephone Co. Inc.  (TT-10) 

 Delta Telephone Co. Inc.  (TT-10 and TT-50) 

 Franklin Telephone Co. Inc.  (TT-10) 

 Frontier Communications of Mississippi, LLC  (TT-10) 

 Fulton Telephone Company, Inc  (TT-10) 

 Georgetown Telephone Company Inc.  (TT-10) 

 GulfPines Communications  (TT-10) 

 InLine  (TT-50) 

 Lakeside Telephone Company Inc.  (TT-50) 

 Level 3 Communications, LLC  (TT-50) 

 Megagate Broadband  (TT-10 and TT-30) 

 MetroCast Communications of Mississippi, LLC  (TT-40 and TT-41) 

 Network Telephone Corp. (TT-30) 

 Noxapater Telephone Company  (TT-10) 

 Sledge Telephone Co. Inc.  (TT-10 and TT-50) 

 Smithville Telephone Company, Incorporated  (TT-10) 

 Southern Light LLC  (TT-50) 

 TDS Telecom  (TT-10) 

 TEC of Jackson, Inc  (TT-10) 

 Telepak Networks, Inc.  (TT-41 and TT-50) 

 Trust Communications  (TT-41) 

 Windstream Mississippi LLC  (TT-10) 

 Xfone USA, Inc.  (TT-10) 
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DATA CORRECTIONS 

 No data corrections were required for this round. 
 

 

COMMUNITY ANCHOR INSTITUTION (CAI) DETIALS 

OVERALL STATISTICS 

Community Anchor Institution - Categories 
Overall 
Count 

Broadband 
Subscriber 

(1 or 2) 

Trans 
Tech 

Advertised 
Speed Down 

Advertised 
Speed Up 

Category 1 - School K through 12 697 502 502 502 56 

Category 2 - Library  278 197 197 197 37 

Category 3 - Medical/Healthcare 437 243 243 243 136 

Category 4 - Public Safety 869 136 136 136 93 

Category 5 - Universities/Colleges 40 0 0 0 0 

Category 6 - Other:  Government 409 335 335 335 142 

Category 7 - Other:  Non-Government  0 0 0 0 0 

Total 2730 1413 1413 1413 464 

 

 

CAI CHANGES 

 

 The core change completed was the inclusion of CAIIDs to the CAI Inventory for Category 1: K-12 
Schools, Category 2: Libraries and Category 5: Colleges, which were extracted from the three 
databases communicated by NTIA.  These databases are as follows: 

 

 For K-12 institutions (CAI type 1) please add the NCES ID CCD ID value found here: 

http://nces.ed.gov/ccd/bat/  

 

 For Higher Education (CAI type 5) please add the NCES IPEDS ID value found here: 

http://nces.ed.gov/ipeds/datacenter/  

 

 For Libraries (CAI  type 2) please. Combine (do not add) “FSCSKey” and “FSCs_SEQ” from the 

“puout08av2000” file and place them here: 

http://harvester.census.gov/imls/data/pls/index.asp (FYI the LIBID is your state’s unique ID 

for libraries) 

 

  

http://nces.ed.gov/ccd/bat/
http://nces.ed.gov/ipeds/datacenter/
http://harvester.census.gov/imls/data/pls/index.asp
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SUBMISSION RECEIPT 

SUBMISSION RECEIPT RESULTS 

 Attached are the results from the NTIA data submission receipt quality script. 
  

 
 

 Error Report 

 The only item flagged in the submission receipt output is the following error, which has been 
verified as correct entries within the data submission.   
 

 Field Check:     FAILED      CAInstitutions_TRANSTECH has 2679 UNEXPECTED VALUES for 
query: TRANSTECH <> 0 AND TRANSTECH <> 10 AND TRANSTECH <> 20 AND TRANSTECH <> 
30 AND TRANSTECH <> 40 AND TRANSTECH <> 41 AND TRANSTECH <> 50 AND TRANSTECH 
<> 60 AND TRANSTECH <> 70 AND TRANSTECH <> 71 AND TRANSTECH <> 80 AND 
TRANSTECH <> 90 AND TRANSTECH <> 0 

 

 This was flagged due to an inconsistency between the data model and the submission 
receipt script, which has also been communicated by other Grantees on PBWorks.  

 
Hyperlink to Grantee Workspace in which the same issues were identified by other Grantees: 
https://sbdd-granteeworkspace.pbworks.com/w/page/42442088/Data%20Model%20Issues-June2011  

  

https://sbdd-granteeworkspace.pbworks.com/w/page/42442088/Data%20Model%20Issues-June2011
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HIGH-LEVEL SUMMARY 

DATA GATHERING 

BROADBAND SERVICE AREAS, MIDDLE MILE AGGREGATION POINTS AND 
BROADBAND SERVICE OVERVIEW 

The collection of Broadband Service Areas, Middle Mile Aggregation Points and Broadband Service 
Overview information is handled through the following Provider Outreach Process: 

 Build and maintain an inventory of Broadband providers through research and State inputs. 

 Update provider material that describes the data requirements and logistics for data transfer. 

 Update Non-Disclosure Agreement (NDA) for use in project, where applicable. 

 Maintain multiple protocols for the provider to submit data, including Secure File Transfer Protocol (SFTP) 
technology when desired. 

 Conduct one-on-one informational discussions with each provider to communicate the following: 
o Requirements of this project; 

o Broadband data required to support the product data model; 

o Submission protocols available; 

o Capability to validate how the supplied data is aggregated. 

 Download/receive provider data. 

 Establish a repeatable process with provider. Maintain provider communication, transaction and data handling 
records throughout the project (dates contacted, data received, etc.).  

 

COMMUNITY ANCHOR INSTITUTION (CAI) 

The collection of CAI information is handled through the following CAI Collection Process: 

 Collect and maintain inventory of CAIs through data mining, research and State inputs. 

 Maintain web-based CAI portal for institutions to add or confirm attribution, location and enter broadband-
specific information. 

 Upload web-based data to Core Database for standardization. 

 Perform internal cleansing, such as removing duplicate records, identifying gaps in broadband attribution and 
verifying category. 

 Geocode CAI locations. 

 Translate Core Database data to deliverable-ready format. 

 Continue engagement with non-responsive institutions. 
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DATA INTEGRATION PROCESS 

The data integration and processing mechanisms currently used allow for multiple types of inputs and result in 
a standardized output that meets the NTIA deliverable requirements. This flexible process supports data 
model changes and project-requested enhancements. 

 Receive inputs from providers via submission protocols; upload into Sourcing Database and catalog 
with provider information. 

 Review provider-supplied data for completeness and for potential discrepancies that require 
resolution prior to processing and flag as necessary. 

 Categorize input into data-type category (addresses, block lists, paper maps, etc.). 

 Standardize input based on data type within Staging Database. 

 Create Compact Polygons (CP)—(internal methodology for generating area-based feature for 
coverage in Staging Database). 

 Apply broadband attribution to CP; apply metadata to CP. 

 Perform quality analysis of the CP against the source supplied to identify any completeness or 
accuracy issues. 

 Request additional information from the provider if elements of coverage are missing or contain 
discrepancies. This is a second manual quality check to ensure data is complete. 
o Process coverage area to build the required NTIA data model layers.  

 Process CAI data input into internal standardized format, as discussed above in the Community 
Anchor Institution (CAI) subsection, based on NTIA and State-level requirements. 

 

DATA VALIDATION AND VERIFICATION 

Following the creation of the product, process steps within Data Validation and Verification occur. To ensure 
the data collected and processed is as accurate and comprehensive as possible, provider validation and 
internal verification activities are employed. After the initial mapping of providers’ coverage areas and 
serviceability claims, additional reviews are performed using the methods described in the subsections below 
(Third-Party Data Verification, Broadband Provider Validation, Confidence Values). 
 

THIRD-PARTY DATA VERIFICATION 

The coverage is visually and programmatically compared against third-party data. Pitney Bowes and 
American Roamer data are used in cases where a coverage area is questionable. All anomalies identified 
during this analysis are reviewed with the providers. 

 

BROADBAND PROVIDER VALIDATION—PROVIDER PORTAL APPLICATION 

Providers are trained on and requested to use a secure interactive web application to review their current 
coverage area(s) and supporting broadband attribution and validate their data or submit change requests 
to update their data. All provider change requests go through the Data Integration Process and are 
reviewed with the provider to complete validation. 
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CONFIDENCE VALUES 

All verification, validation and manual quality review results are tracked by provider/technology type and 
stored and maintained within a Validation table. A confidence value is assigned, based on internal 
assessments of the collected information, to highlight the provider coverage areas and/or attributions 
that would benefit from further investigation and/or enhancements. 

 

QUALITY CONTROL 

Following collection, processing and analysis of the provider and CAI data, the product is checked manually 
and algorithmically against the NTIA data model. Some of the items included within these checks are: 

 Format correctness; 

 Table and field structure; 

 Valid values, including default values, where applicable; 

 Geographic extent and topology errors. 
 
Prior to data submission, another quality control script supplied by NTIA is run. This script, 
SBDD_CheckSubmission.py, creates an output in text form that is required to be submitted along with the final 
deliverable. All errors must come up clean, unless otherwise specified by NTIA. Exceptions to the script as 
noted by NTIA on the SBDD Workspace on 03/25/11 can be found at the following link: https://sbdd-
granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions  

 Longitude values for States outside the lower 48 (any table); 

 CAI results for Transtech, MaxAdUp, MaxAdDown if BBService is “No” or “Unknown”; 

 Overview MaxAdDown, MaxAdUp if 100% of record-level data has MaxAdDown or MaxAdUp 
populated. 
  

https://sbdd-granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions
https://sbdd-granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions
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DETAILED PROCESS REVIEW 

A detailed review of the data collection, integration and quality control points within the broadband data gathering 
and mapping process are discussed in the subsections that follow. In addition, a diagram showing the overall 
process can be seen below. 

 
 

PROVIDER OUTREACH 

For the October 2011 data submission, an e-mail notification was sent to all providers with supporting 
deliverable dates. The providers mainly used the Provider Portal web application to submit changes to and/or 
validate their current coverage area(s). 

 
In support of the data collection effort, providers that did not timely respond to the outreach were contacted 
by phone. 
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OUTREACH MATERIALS 

The original provider packet sent via e-mail to the providers included the following documents and files: 

 Letter from the State inviting them to participate in the program; 

 Copy of the Non-Disclosure Agreement (NDA); 

 Copy of the Mapping NOFA from the NTIA; 

 Copy of the NOFA Clarification from the NTIA; 

 Broadband service address example file in CSV format; 

 Word document describing service address example file; 

 Broadband service block example file in CSV format; 

 Word document describing service block example file; 

 Broadband service street example file in CSV format; 

 Word document describing service street example file; 

 Broadband subscriber example file in CSV format; 

 Word document describing subscriber example file; 

 Broadband wireless coverage area sample shapefile; 

 Word document describing wireless coverage area sample shapefile; 

 Instructions for downloading, installing and using the WinSCP SFTP application. 
 

OUTREACH PROCESS 

The provider outreach process is comprised of the following general steps: 

 Send the provider package and introduction letter to the main point of contact for the provider. 

 Follow up with e-mail and telephone to verify that the main point of contact is correct. 

 If necessary, discuss the NDA further and resolve any redlines. 

 Once the correct primary contact is established, set up a telephone call, if necessary, to learn more 
about the provider’s offerings and direct them to the appropriate outreach materials. 

 If providers are unable to be contacted (non-responsive) or indicate that they are not interested in 
participating (non-cooperative), mark them as such on the provider tracking sheet. These providers 
will be escalated to the State for further action. 

 As the providers are collecting the required data, provide instructions on downloading, installing and 
using the WinSCP SFTP application, if required. 

 Arrange with the providers to transfer the data in whatever way they are comfortable: some 
providers will find regular email acceptable; others will want to use the SFTP application. 

 After data is received and reviewed, it may be necessary to contact a provider for clarification or to 
address incomplete datasets. In the interest of building and maintaining relationships, care is given 
not to push the provider but to work with it to obtain accurate data in the best possible format. 
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DATA COLLECTION 

DATA TRANSFER PROCEDURES 

There are three primary ways data is collected from providers. These are: 

 Secure FTP (SFTP) using the WinSCP application; 

 Regular e-mail; 

 Mail. 
 

INITIAL DATA REVIEW AND QUALITY ASSURANCE 

The initial data review and quality assurance process consists of the following general steps: 
1) Access the data from the SFTP site or e-mail. 

a. If e-mailed, place copy of original dataset in the appropriate provider folder on the SFTP site. 
2) Place copy of raw data on local computer in a working directory. 
3) Review data and determine course of action based on type of data received. 
4) Ensure data is complete and contact provider to address any gaps. 

 

NOTE: 
The goal is to get as many providers as possible to provide subscriber address data in the correct format. 
Obviously, this will not be possible with all providers so we will continue to have to process various types of 
provider-supplied data. 

 

DATA INGESTION 

DATA INGESTION OVERVIEW 

The following subsections outline the process steps taken based on the type of input supplied by the data 

provider: 

 Point Data: 
o Subscriber location; 
o DSLAM location; 
o Central Office location; 
o Broadcast Tower location. 

 Linear Data: 
o TIGER® street segments. 

 Polygonal Data: 
o Census Blocks; 
o Coverage Area. 

Overall, the process is geared toward taking the provider data supplied and creating polygon shapes to 
append to the bb_cov feature class. The bb_cov feature class is the interim dataset that is then processed 
using the makeDeliverable.py Python script to create the MapConnect

TM
 data layers that will be delivered 

to the State and, ultimately, to the NTIA. Detailed instructions used in this process can be found in the 
subsections below. 
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POINT DATA 

SUBSCRIBER LOCATION—ADDRESS DATA 

In the event that the data provider supplies subscriber address data, the steps are as follows: 
1) First, convert the address data to a clean Excel spreadsheet in an appropriate address data 

format. 
a. Usually, this has the following columns: street address (number, pre-directional, pre-

modifier, street name, street type, post-directional and post-modifier concatenated), city, 
state, ZIP. 

2) Configure the ArcGIS® geocoding tool to use the TIGER® 2009 streets dataset. 
a. In ArcCatalog®, create a new Address Locater by right-clicking in the white space of the 

appropriate directory and selecting New>Address Locater from the dropdown menu. 
b. Select US Streets with Zone and click OK. 

 

NOTE: 
It is likely that multiple Address Locators will have to be set up to handle the variety of provider address data 
received. 
 

c. Navigate to the TIGER Streets 2009 file and click OK. 
d. Fill in the dialog box, as shown below: 
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e. Click OK. 
3) Open ArcMap® and add the Excel spreadsheet with the address information. 
4) Right-click on the Excel spreadsheet and select Geocode Addresses from the dropdown menu. 
5) Select the appropriate address locator by clicking Add…, then OK. 

 

6) Fill out the Geocode Addresses dialog box, as shown below: 

 

7) Geocode the list in batch mode using the geocode service set up in Step 2 above, accepting all 
the default parameters. 

8) Review results. See example below. 
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9) Adjust geocoding parameters accordingly and repeat batch to resolve issues. 
10) Manually geocode unmatched addresses until target hit rate achieved, generally 90%. 
11) Visually inspect the data, as shown below: 

 

12) Follow the steps detailed in Subscriber Location—GIS Data below. 
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SUBSCRIBER LOCATION—XY DATA 

If the provider supplies a list of subscriber data with accompanying XY data such as latitude and 
longitude, the steps are as follows: 

1) Refine the format in Excel so that the data can be opened easily using ArcMap®. 

a. Remove all font color, highlighting, cell colors and borders, clean up column headers and 
make certain there are no merged cells. 

b. Make certain that XY locations are in decimal degrees. 
(i.) To convert from degrees, minutes, seconds (39º 26’ 45.67”) to decimal degrees, use the 

following formula: DD + (MM/60) + (SS.SSS/3600). 
 

NOTE: 
If XY locations from some other coordinate system are provided, you can use those in the process below but you 
must know what the coordinate system is. 
 

2) Open the Excel worksheet in ArcMap®. 

3) From the menu bar, select Tools>Add XY Data… 

 

4) Supply the appropriate fields for the X and Y coordinates, choose the appropriate coordinate 
system and click OK. 

5) Results are an event layer, not a true spatial layer. Export the data by right-clicking the event 
layer and selecting Data>Export Data… from the dropdown menu. 

6) Follow the steps detailed in Subscriber Location—GIS Data below. 
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SUBSCRIBER LOCATION—GIS DATA 

If the provider supplies subscriber location in GIS format, the only process step is to load that data 
into the appropriate data schema and it will be ready for processing. 
1) First, load the data into the Point Address database schema (please see Appendix D for an 

example of the Point Address database schema.) using an empty feature class in that schema. 

2) In ArcCatalog®, right-click on the empty feature class and select Load from the dropdown menu. 

3) Navigate to the provider address GIS dataset and then map the attribute fields accordingly, as 
shown below: 

 

4) Once you have successfully loaded the provider address data into the temporary database with 
the correct schema, you now will append that data to the overall Point Address database. 

5) In ArcToolbox®, use the Append command (Data Management Tools>General> Append) to add 
the features into the overall Point Address database, as shown below: 

  



                                                                                

       Version 2.0         September 2011 Author: Kristin Rousseau 
       Page 20 

 

6) Since the data is already in the Point Address database schema, there is no need to alter the Field 
Map in the Append tool. 

7) After appending, calculate metadata reflecting geometry source and representation values. 
8) Break provider-specific points into separate county feature classes and perform the following 

steps per county feature class: 
a. Within ArcGIS®: 

(i.) Summarize download and upload speeds [first,last] to determine all speeds available for 
county. 
(1) This will save as a DBF table. Keep track of location for future reference. 

(ii.) Buffer county address point featureclass to 150’. 
(1) During buffer command, dissolve on ad_down; ad_up; provider; dba; frn; tt; all 

metadata fields; stctyfips. Save as…. county_fastestdown_fastestup.  
(2) Example using Qwest data: boulder_40128_20128, where boulder=county; 

40128=ad_down; 20128=ad_up. 
 

NOTE: 
These attribute fields are specific to the Point Address database. 
 

(iii.) Select the features that represent the lowest speeds. 
b. Using XtoolsPro (http://www.xtoolspro.com/): 

(i.) In the XTools Pro toolbar, select XTools Pro>Layer Operations>Erase Features. 
(ii.) Use the same feature class for Input and Overlay. 
(iii.) Check Use selected features on the Input feature, as shown below. 
(iv.) Repeat and erase slowest speeds one speed at a time. Save each new feature class as 

the next slowest speed, using the same naming convention as shown in a.(ii.)(1) above. 
A general example is shown below: 
  

http://www.xtoolspro.com/
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c. Return to ArcGIS®: 
(i.) Edit/delete speeds from the attribution table of each feature class, so each remaining 

feature class has only one speed value. 
(ii.) Merge individual speed feature classes using the Merge command in ArcToolbox® (Data 

Management Tools>General>Merge). The dialog box is shown below:  

 

(iii.) Merge individual county feature classes using the Merge command in ArcToolbox (Data 
Management Tools>General>Merge). 

(iv.) Since the county files are all in the same schema, DO NOT alter the Field Map portion of 
the command interface. 
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(v.) When all the county files are merged into one dataset, use the Append command in 
ArcToolbox® (Data Management Tools>General>Append) to add the features to the 
bb_cov interim dataset. Use the Field Map portion of the Append tool to map the 
appropriate field values to their corresponding fields in the bb_cov feature class. 

DSLAM OR CENTRAL OFFICE LOCATION—ADDRESS DATA 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central 
Office address data, the steps are as follows: 
1) Follow the process for geocoding points in Subscriber Location—Address Data above. 
2) Follow the steps detailed in DSLAM or Central Office Location—GIS Data below. 

DSLAM OR CENTRAL OFFICE LOCATION—XY DATA 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central 
Office XY data, the steps are as follows: 
1) Follow the process for creating points from XY data in Subscriber Location—XY Data above. 
2) Follow the steps detailed in DSLAM or Central Office Location—GIS Data below. 

DSLAM OR CENTRAL OFFICE LOCATION—GIS DATA 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central 
Office GIS data, the steps are as follows: 
1) Buffer the DSLAM/Central Office points feature class. 

a. Add the point feature class to ArcMap®. 

b. Open the ArcToolbox® and go to Analysis Tools>Proximity>Buffer. 

c. Set the buffer distance to 5 miles. 
d. Set the dissolve type to ALL. 
e. Name the output feature class. 
f. Typical Buffer tool is shown below: 

 

g. Click OK. 
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2) Use the resulting buffer feature class to clip the TIGER® street layer: 

a. Add TIGER® street layer to ArcMap®. 

b. Open the ArcToolbox® and go to Analysis Tools>Extract>Clip. 

c. Complete the dialog box as shown below: 

 

d. Click OK. 

3) Using ArcCatalog® and within the file geodatabase: 

a. Right-click and create a new Feature Dataset.  
(i.) For the Feature Dataset settings: 

(1) Name the feature dataset accordingly. 
(2) Select horizontal coordinate system by importing the coordinate system associated 

with the clipped TIGER® street layer by selecting Import and navigating to the 

location of that feature class. 
(3) No vertical coordinate system needed. 
(4) Leave all x,y,z,m values at default. 
(5) Click Finish. 

4) Import previously created street feature class into new Feature Dataset. 
5) Right-click Feature Dataset and create new Network Dataset—accept all default setting for the 

Network Dataset. 
 

NOTE: 
The Network Analyst extension must be turned on. 
 

6) In ArcMap® turn on the Network Analyst Toolbar by going to View>Toolbars>Network Analyst. 

7) Add the Network Dataset created in Step 5 to ArcMap. 
8) Using the Network Analyst Toolbar dropdown, create New Service Area. 

9) Open the Network Analyst Window by selecting the  button. See below. 
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10) Right-click Facilities layer, select Load Locations and navigate to the DSLAM/Central Office 
facilities feature class. 

 

11) Click OK. 

12) Click the Service Area Properties button . 
13)  For the following tabs, change the following properties: 

a. Polygon Generation tab:  
(i.) Select Merge by break value.  
(ii.) Also disable the Trim Polygons option. 

b. Analysis Settings tab—using and converting the specified DSLAM buffer distance from feet 
to meters—input buffer distance value in meters into the Default Breaks location. 
(i.) Generally, 18,000 feet (5486 meters) from DSLAM or Central Office location is used as 

the buffer distance. See below. 
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c. Click OK. 

14) On the Network Analyst Toolbar, click the Solve button  to create service area polygons. 
15) Right-click on the created service area polygon in the layer list, and select Data>Export Data from 

the dropdown list. 
16) Export to a feature class in the file geodatabase you created earlier. 

17) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the feature class created in Step 16 into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click the Add button, then click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 
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e. Click Next, then Next again, then Finish. 

18) In ArcToolbox®, go to Data Management Tools>General>Append. 

19) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 

 

20) Leave the Schema Type as TEST. 
21) Click OK. 

22) In ArcMap®, open bb_cov for editing and manually input associated attribution. 
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BROADCAST TOWER LOCATION—ADDRESS DATA 

In the event that the provider supplies wireless broadcast tower location address data, the steps are 
as follows: 
1) Follow the process for geocoding points in Subscriber Location—Address Data above. 
2) Follow the steps detailed in Broadcast Tower Location—GIS Data below. 

BROADCAST TOWER LOCATION—XY DATA 

In the event that the provider supplies wireless broadcast tower location XY data, the steps are as 
follows: 
1) Follow the process for creating points from XY data in Subscriber Location—XY Data above. 
2) Follow the steps detailed in Broadcast Tower Location—GIS Data below. 

BROADCAST TOWER LOCATION—GIS DATA 

In the event that the provider supplies wireless broadcast tower location GIS data, the steps are as 
follows: 
1) Download the required software (Radio Mobile) from the website: 

http://www.cplus.org/rmw/english1.html  
2) Install the software according to the standard directions, found here: 

http://www.cplus.org/rmw/download/download.php?S=1  
3) Open the application. 
4) Load the broadcast tower location and elevation information by selecting File>Unit properties. 

The following dialog box appears: 

 

5) Add the information for all the towers supplied by the WISP data provider, including the 
elevation. If provider does not supply elevation, this information can be obtained from Google 
Earth. 
a. If available, use the Import button to import a Google Earth KML of the tower locations. 

6) Go to the National Map Seamless Server (http://seamless.usgs.gov/) and download elevation 
data sufficient to contain the tower locations. 
a. At least the 1/3” NED data is needed. Select this by clicking the Download button in the 

upper right of the website and checking the box next to 1/3“ NED. 

http://www.cplus.org/rmw/english1.html
http://www.cplus.org/rmw/download/download.php?S=1
http://seamless.usgs.gov/
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b. Zoom to the area of interest and use the Download tools to define the area to download: 

 

c. Click the Modify Data Request button to request the data in BIL_16INT format, not ESRI 
GRID, as shown below: 

 

d. Download the data and unzip it. 
7) Select File>Map Properties to define the map. 
8) Enter a latitude and longitude in the center of the tower locations. 
9) Set the size (in pixels) and the size (in kilometers) of the map. 
10) Set the directory path leading to the BIL elevation data just downloaded. 
11) The dialog box is shown below: 



                                                                                

       Version 2.0         September 2011 Author: Kristin Rousseau 
       Page 29 

 
12) Click Extract. 
13) The elevation data is rendered as a hill shade, as shown below: 

 
14) Select File>Network properties from the main menu. 
15) Create a new network and enter in the frequency range under the Parameters tab, as shown 

below: 
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16) Leave all the other values as they appear, and select the Systems tab. 
17) Create enough systems to cover all the varieties of equipment in the provider network. This will 

include the antenna type, height and line loss, as shown below: 

 
 

18) Now click on the Membership tab, and assign the individual towers to their respective systems, 
providing the azimuth for non-omnidirectional antennas, as shown below: 
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19) Click OK. 
20) Select Tools>Radio Coverage>Combined Cartesian from the main menu. 
21) Complete the dialog box as shown below, providing the Maximum Range from the highest tower 

beam radius supplied by the provider. 
22) Set the Pixel Size at 5 (experiment depending on the area covered to get the right level of 

granularity), as shown below: 

 
23) Set the Signal range to draw to S-Unit and type 5 in the From (>=) box. 
24) Click on Draw. See below. 
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25) Save the resulting image as a TIF by selecting File>Save Picture as. 
26) Open ArcMap® and load the BIL elevation data you used in Radio Mobile. 
27) Load the TIF image you created and georeference it using the corners of the BIL data. 

a. The corners of the data can be seen in the TIF image. 
28) Follow the georeferencing directions from the Coverage Area—PDF/JPG/Other Image Format 

section below. 
29) Use the Georeferencing Toolbar to Update the Georeferencing for the TIF dataset. 
30) In ArcToolbox®, select Data Transformations>From Raster>Raster to Polygon and input the 

georeferenced TIF you just created, as shown below: 
31) Open the resulting polygon feature class for editing using the Editing toolbar in ArcMap® and 

clean up as necessary. 
32) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the feature class created above into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click the Add button, then click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 
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e. Click Next, then Next again, then Finish. 

33) In ArcToolbox®, go to Data Management Tools>General>Append. 
34) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 

 
35) Leave the Schema Type as TEST. 
36) Click OK. 

37) In ArcMap®, open bb_cov for editing and manually input associated attribution. 
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LINEAR DATA 

TIGER® STREET SEGMENTS—LIST, SPREADSHEET OR GIS DATA 

In the event that the provider supplies TIGER® street segments in list or spreadsheet format, the 
steps are as follows: 
1) Join TIGER® road segments to 2000 census blocks feature class using one of two methods based 

on how the data is provided: 
a. If the TIGER® data is provided with a Census Block ID, then join the segments to the Census 

Block geometry based on that ID: 
(i.) Load both datasets into ArcMap®; 
(ii.) In the layer list, right-click on the 2000 census block feature class and select Joins and 

Relates>Join; 
(iii.) In the dialog box, select the TIGER® road segments data and the proper attribute fields 

for joining, as shown below: 

 
(iv.) Click OK. 

b. If the data provided is a list containing TLIDs, then join to the TIGER®/Line data using the 
TLID, and use a spatial join to associate the TIGER® segment with the coterminous block 
based on the block ID: 
(i.) Load both datasets into ArcMap®; 
(ii.) In the layer list, right-click on the 2000 census block feature class and select Joins and 

Relates>Join; 
(iii.) Select Join data from another layer based on spatial location from the dropdown 

menu; 
(iv.) Complete the dialog box, as shown below and click OK. 
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2) Export joined records into a temporary feature class. 
3) If joined Census Block geometry is confined to one specific area, then dissolve blocks into one 

record. If joined Census Block geometry is distributed throughout a particular State, then dissolve 
sub-selections of census blocks for each county. 
a. Use the County FIPS code to dissolve by county. 

b. In ArcToolbox®, select Data Management Tools>Generalization>Dissolve. 

c. Complete the Dissolve dialog box, as shown below: 
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d. Click OK. 

4) For each dissolved region, open the feature class for editing using the Editing tool in ArcMap® 

and remove unnecessary slivers and other small holes. For general guidance on editing features 

in ArcMap®, see http://webhelp.esri.com/arcgisdesktop/9.3/pdf/Editing_Tutorial.pdf  

5) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the feature class created above into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click on the Add button, then click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 
 

http://webhelp.esri.com/arcgisdesktop/9.3/pdf/Editing_Tutorial.pdf
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e. Click Next, then Next again, then Finish. 

6) In ArcToolbox®, go to Data Management Tools>General>Append. 
7) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 

 
8) Leave the Schema Type as TEST. 
9) Click OK. 
10) In ArcMap®, open bb_cov for editing and manually input associated attribution if necessary. 
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POLYGONAL DATA 

COVERAGE AREA—PDF/JPG/OTHER IMAGE FORMAT 

In the event that the provider supplies coverage area data in some image format such as PDF or JPG 
format, the steps are as follows: 
1) If in PDF format, open in Adobe Acrobat and Save As… JPG format. 

2) Open the JPG image in ArcMap®. 

3) Add the required base map vector data for georeferencing. 

a. This generally will be either the CDOT data or TIGER® data. 

4) Change the coordinate system of the data frame to the desired end coordinate system. 
5) Zoom to the general location of the JPG map image. 

a. This is the location based on the vector data, not the JPG image itself. For example, if you 
know that the JPG image represents an area around the town of Limon, zoom to the town of 
Limon in your vector data. 

6) Open the Georeferencing toolbar by selecting View>Toolbars>Georeferencing from the main 
menu bar. 

7) Using the Georeferencing toolbar, select Fit to Display; results are shown below: 

 

8) Use the Control Point button  to add control points to the map. 
9) Use common points in the base dataset and the JPG image. 

a. For example, find major street intersections, county/city boundaries, etc. 
b. Try to distribute the points more or less in the four corners on the image for the best 

transformation. 
10) Click on the location on the image first, then click on the corresponding location on the vector 

database map, as shown in the image below: 
 



                                                                                

       Version 2.0         September 2011 Author: Kristin Rousseau 
       Page 39 

 
11) After placing each control point, the image transformation will update automatically.  
12) Repeat until satisfied with the transformation. 

 

NOTE: 
The transformation may take up to four points, although sometimes only two are necessary. 
 

13) When satisfied with the transformation, select Update Georeferencing from the Georeferencing 
toolbar dropdown. 
a. This will create a “world” file (.jgw in the case of JPGs) in the same directory as the image 

file. 

14) In ArcCatalog®, create a new polygon shapefile with the appropriate data schema for a provider 

coverage area, which can be found in Appendix D. 

15) Add the shapefile to ArcMap®. 

16) Using the Editor toolbar, select Start Editing. Set the Task to Create New Feature. 

17) Use the Sketch Tool  to digitize a new coverage polygon using the coverage area outline 
from the georeferenced JPG and add the required attributes manually. 

18) Repeat the above steps for all subscriber speed coverage areas provided. 
19) Follow the steps detailed in Coverage Area—GIS Data below. 

COVERAGE AREA—KML/KMZ 

In the event that the provider supplies coverage area data in Google Earth KML or KMZ format, the 
steps are as follows: 

1) Use a KML to SHP converter to translate file into an Esri® format. 

2) http://arcscripts.esri.com/details.asp?dbid=15603  

3) Download the script and follow the provided instructions for installing it in ArcToolbox®. 

4) Double-click on the script in ArcToolbox® and navigate to the location of the KML file, as shown 

below: 
 

http://arcscripts.esri.com/details.asp?dbid=15603
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5) Add the new shapefile to ArcMap®. Repeat for all KML files provided. 

6) Follow the steps detailed in Coverage Area—GIS Data below. 

COVERAGE AREA—CAD DATA 

In the event that the provider supplies coverage area data in GIS format, the steps are as follows: 

1) Transform the CAD dataset into an Esri® format. 

2) http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datase
ts 

3) It may be necessary to contact the provider first to determine the coordinate system of the CAD 
data. 

4) If the CAD data is not in a standard coordinate system, it may be necessary first to use ArcMap® 

to georeference the CAD data to a known coordinate system. 
a) To do so, follow the instructions provided above in Coverage Area—PDF/JPG/Other Image 

Format. 

5) In ArcCatalog®, create a new polygon shapefile with the appropriate data schema for a provider 

coverage area, which can be found in Appendix D. 

6) Add the shapefile to ArcMap®. 

7) Using the Editor Toolbar, select Start Editing. Set the Task to Create New Feature. 

8) Use the Sketch Tool  to digitize a new coverage polygon using the coverage area outline 
from the georeferenced CAD file and add the required attributes manually. 

9) Follow the steps detailed in Coverage Area—GIS Data below. 

COVERAGE AREA—GIS DATA 

In the event that the provider supplies coverage area data in GIS format, the steps are as follows: 

1) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the GIS feature class either created above or supplied by the provider into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click on the Add button, then click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 

 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datasets
http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datasets
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e. Click Next, then Next again, then Finish. 

2) In ArcToolbox®, go to Data Management Tools>General>Append. 

3) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 

 
4) Leave the Schema Type as TEST. 
5) Click OK. 

6) In ArcMap®, open bb_cov for editing and manually input associated attribution, if necessary. 

COMPACT POLYGON FROM SUBSCRIBER POINTS  

1) Geocode address list using latest State Composite Locator.  
2) Verify that your geocoded file has only one TT (Technology Type). If not, export individual 

geocoded layers for each Technology Type. 
3) For each TT, check for differences in speed values or speed tiers and create separate layers for 

each speed value/tier. 



                                                                                

       Version 2.0         September 2011 Author: Kristin Rousseau 
       Page 42 

4) Clean your geocoding results: remove any points that geocode to accuracy levels below ZIP+4 
(ZIP centroids, carrier route centroids, etc). Also, verify that outliers with acceptable accuracy 
levels are legitimate, i.e., fall in correct city and Zip. 

5) Perform spatial join between county polygons (using stcnyfips field) and the cleaned geocoded 
subscriber points in order to carry the county name and stcnty fips. 

6) Summarize the number of subscribers by county and use the subscriber counts by county to 
populate the Rate Tier table. 

7) Un-join the county data from the geocode subscribers list. 
8) Create Compact Polygon using cleaned geocoded layer or sub-selection of XtoolsPro—

ConvexHull-DetailedHull option. A sub-selection of geocoded points will be used in areas where 
more than one polygon will need to be created for one provider’s service area. 

9) Evaluate output Hull carefully, looking for areas that should not be covered by hull polygon. 
a. If it is determined that an area or areas should not be represented in coverage area, 

manually reshape hull polygon until coverage area is adequate. 
b. When not obvious and as a general rule, manually resolve compact polygon when the 

distance between the subscriber points used to define the outer boundary of the compact 
polygon exceeds 5 miles . When reshaping the hull polygon, snap to the outermost 
geocoded points. See the three figures below for examples. 

      Compact Hull: Manual Resolution Required            
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Compact Hull: Manual Resolution Required                                        Compact Hull: After Manual Resolution        

                      

 
10) To attribute the compact polygon, perform a spatial join where your Target Feature Class is the 

compact polygon and the Join Feature Class is your geocoded point layer. Export compact hull 
with joined attributes and name file appropriately. 

11) Append attributed compact polygon to Broadband TT template Feature Class and, if required, 
manually input any provider attribution that may not have carried over in the append process. 
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12) Intersect compact polygon with county boundaries to create unique records by county and use 
the state-county-fips field to populate stcty_fips field. Also use the county name field to populate 
the BBCov_Name field. 
a. Exception: where a provider’s coverage is distributed throughout more than one area of any 

given county where the BBcov_Name should be populated using an appropriate city or other 
logical name based on geographical location. 

13) Export/load into appropriate BB TT model dataset. 

CENSUS BLOCKS—LIST OR SPREADSHEET 

In the event that the provider supplies census block data in a list or spreadsheet, the steps are as 
follows: 
1) Ensure block polygons supplied by the provider are 2000 currency. 
2) If other currency, convert to 2000 currency before proceeding. 

a. To do this, remove the trailing letter (a, b, etc.) from the block ID. 
b. You will now have two blocks that equate to one block in the 2000 block geometry. 
c. Delete duplicate block IDs, retaining the higher service tier in each case. 

3) Prepare the block list in clean Excel format, removing all Excel-only formatting, merged cells, 
colors, borders, etc. 

4) Import the spreadsheet into ArcMap®. 

5) Right-click on the 2000 census block feature class in the layer list in ArcMap® and select Joins 

and Relates>Join from the dropdown menu. Join the census block list to the 2000 census blocks 
feature class using the block ID and export joined records in a new feature class. The Join dialog 

box and process can be seen above in the TIGER® Street Segments—List, Spreadsheet or GIS 

Data subsection. 
6) Follow the steps in Census Blocks—GIS Data below. 

CENSUS BLOCKS—GIS DATA 

In the event that the provider supplies census block GIS data, the steps are as follows: 
1) Ensure that the blocks supplied by the provider are in the required data schema and are 

complete as far as required attribution. 
a. If not, manually enter the required attribution or contact the provider to fill gaps. 

2) If census block geometry is distributed throughout more than one county, then select Data 
Management Tools>Generalization>Dissolve in ArcToolbox® and dissolve based on 
County/Provider/TT/Speed Tier so that unique records are created for each unique combination. 
a. The Dissolve dialog box is shown above in the TIGER® Street Segments—List, Spreadsheet 

or GIS Data section. 
b. Two examples of undissolved census block polygons are shown below: 
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Undissolved census block polygons 

 
Census block polygons dissolved by county 

3) For each dissolved region use the Editing toolbar in ArcMap® to remove unnecessary slivers and 

other small holes. 

4) In ArcToolbox®, select Data Management Tools>General>Merge and merge the processed 

polygons into a single layer. 
5) The merged census blocks will need to have the subscriber’s frn field added and populated. 

6) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the GIS feature class either created above or supplied by the provider into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click the Add button, the click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 

 
e. Click Next, then Next again, then Finish. 
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7) In ArcToolbox®, go to Data Management Tools>General>Append. 

8) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 

 
9) Leave the Schema Type as TEST. 
10) Click OK. 

11) In ArcMap®, open bb_cov for editing and manually input associated attribution, if necessary. 

 

METADATA TRANSACTIONS 

Following any updates or changes completed within the file geodatabase (fGDB) stored on the GIS-Analysts 
staging environment, the GIS-Analyst runs transactions to compare that fGDB with the one stored on the Core 
server to ensure metadata on all changes is recorded. 

 
The steps taken to run transactions on the updated Core database are outlined below: 

1) Open a command line window and run generateTransactions.py:  
a. Usage: generateTransactions.py  [Core fGDB] [Staging Environment fGDB]  
b. Example of command line:  

<path>generateTransactions.py <path>ST_BB_POLY_SRV_AREAS.gdb <path>ST_BB_POLY_SRV_AREAS.gdb  
2) Shown below is an example of the output screen that will be displayed: 
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3) After the process has completed, results can be found in the ST_BB_POLY_SRV_AREAS_HIST.gdb:  

a. The transactions scripts records changes at a feature level. 
b. Shown below is a screenshot supporting the directory structure of the historical fGDB. 

 
c. Attribution associated with each added/removed/changed feature is tracked, including the 

following additional columns appended to the end of each: 
(i.) Commit_by 
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(1) Records the GIS-Analyst who committed the changes to the historical fGDB. 
(ii.) Commit_date 

(1) Records the date and time stamp on which the changes were committed. 
(iii.) Trans_type 

(1) This field reflects the type of change recorded; 
(2) Categorized by: Adds/Change/Deletes. 

(iv.) New_values 
(1) Records the new values when a change was completed on a feature. Example: 

Name or speed change. 
d. MD_Process also is transferred from the edited fGDB to the historical fGDB, which states the 

actions completed by the GIS-Analyst. 

 

 

DATA PROCESSING 

DATA PROCESSING OVERVIEW 

The following subsections detail the steps and layout required to process the service provider data further 
to meet NTIA requirements: 

 Weighted Nominal Speed; 

 Middle Mile; 

 Broadband Coverage Template. 
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WEIGHTED NOMINAL SPEED 

The weighted nominal speed is populated in one of the following two ways: subscriber data supplied by 
provider or value supplied by provider. 

SUBSCRIBER DATA SUPPLIED BY PROVIDER 

Where the data provider supplies subscriber speed information, the following formula from the NOFA 
is used: 

(speed tier-1 in kbps × no. of tier-1 subscribers) + (speed tier-2 in kbps × no. of tier-2 subscribers) + (etc.) 
Total average monthly subscribers 

 
Data is initially broken up in the following order: 
1) Stcty_fips; 
2) Transmission technology type; 
3) Subscriber tiers. 

VALUE SUPPLIED BY PROVIDER 

Some providers will supply their weighted nominal speed. In these cases, the data supplied will be 
populated instead of using the NOFA formula. These obtained or calculated values are used to update 
the service overview layer. 
 
This can be done manually or by creating a table with the provider’s FRN and average weighted speed 

and joining it to the service overview table in ArcMap®. 

1) To join, right-click on the layer to join to and select Joins and Relates>Join from the dropdown 
menu. 

2) Then navigate to the table to join to and select the join fields from the dropdown list. 

3) Then open the source table (the table in ArcMap®) and right-click on the header of the Average 

Weighted Speed field and select Calculate Field from the dropdown menu. 
4) Use the value of the average weighted speed from the joined table. 

 

MIDDLE MILE 

Middle mile information generally is provided in spreadsheet or text file format. The process is to take 
what is supplied by the provider and translate it into the required data schema. 

1) If the data is supplied with address information, follow the process outlined above in Subscriber 
Location—Address Data. 

2) If the data is supplied with associated XY coordinates, follow the process outlined above in 
Subscriber Location—XY Data. 

3) Once the data is in GIS format, use the Append (Data Management Tools>General>Append) 

command in ArcToolbox® to append the data to the overall middle mile dataset. 

4) Set the schema type to NO_TEST and use the Field Map to map the attribute fields from the 
source to the target dataset. 
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BROADBAND COVERAGE TEMPLATE 

The table below lists descriptions of the fields within the bb_cov layer, which is the interim dataset used 
to create the final product deliverable. 
 

NAME ALIAS DESCRIPTION 

objectid OBJECTID Internal Object ID 

shape SHAPE Internal Shape storage 

prov_id PROVIDER_ID Unique numeric identifier for each provider 

prov_name PROVIDER_NAME Unique name for each provider 

dba_name DOING_BUSINESS_AS An alternative "Doing-Business-As" name for the provider 

frn FCC_REGISTRATION_NUMBER Provider FCC Registration Number 

bbcov_name BBCOV_NAME BroadMap Broadband Coverage name 

trans_code TRANSMISSION_CODE Unique code for the transmission technology type described by 

this layer 

trans_name TRANSMISSION_NAME Name for the transmissions technology type 

trans_desc TRANSMISSION_DESC Description for the transmissions technology type 

spect_code SPECTRUM_CODE Unique code for the spectrum [WIRELESS ONLY] 

spect_name SPECTRUM_NAME Name for the spectrum [WIRELESS ONLY] 

spect_desc SPECTRUM_DESC Description for the spectrum [WIRELESS ONLY] 

mad_dwn_t MAX_AD_DOWN_TIER Maximum advertised downstream speed available within given 

area (speed tier) 

mad_up_t MAX_AD_UP_TIER Maximum advertised upstream speed available within given area 

(speed tier) 

typ_dwn_t TYPICAL_DOWN_TIER Typical downstream speed available within given area (speed tier) 

typ_up_t TYPICAL_UP_TIER Typical upstream speed available within given area (speed tier) 

mad_dwn_k MAX_AD_DOWN_KBPS Maximum advertised downstream speed available within given 

area (kbps) 

mad_up_k MAX_AD_UP_KBPS Maximum advertised upstream speed available within given area 

(kbps) 

typ_dwn_k TYPICAL_DOWN_KBPS Typical downstream speed available within given area (kbps) 

typ_up_k TYPICAL_UP_KBPS Typical upstream speed available within given area (kbps) 

subs SUBSCRIBERS Total average monthly subscribers for this provider for this 

technology for this coverage polygon 

md_geom MD_GEOMETRY Metadata: Comma separated list of source ids from which the 

polygon extent was produced 

md_exists MD_EXISTS Metadata: Comma-separated list of source ids used in 

understanding and editing the provider data for this polygon 
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NAME ALIAS DESCRIPTION 

md_who MD_WHO Metadata: Name of the editor who last edited this feature at the 

time in md_when 

md_when MD_WHEN Metadata: Date/time that this feature was last edited 

md_process MD_PROCESS Metadata: Comma-separated list of processes used to create 

and/or modify this layer 

stcty_fips STATE_COUNTY_FIPS State/County FIPS code 

rec_id RECORD_ID Compound Key formed from 

STCTY_FIPS+"|"+Provider_ID+"|"+Trans_Code+"|"+BBCov_Name 

st_area ST_AREA(SHAPE) Area in square decimal degrees  

st_length ST_LENGTH(SHAPE) Length in decimal degrees  

Provider_Type Type of Provider Has Subtype (1:Broadband provider as described in the 

NOFA,2:Reseller,3:Unknown), default value=1 (New 04/11 Model) 

 

VERIFICATION AND VALIDATION 

PROVIDER VALIDATION—PROVIDER PORTAL/PDF MAP REVIEW 

Following the collection and aggregation of provider data, the aggregated data is validated by the 
provider to ensure it is an accurate representation of their coverage area and supporting broadband 
information. 

 This validation is completed through the Provider Portal web application, which is a secure 
interactive map that displays the provider’s coverage areas and allows the provider to 
validate, submit feedback or request changes. 
o If changes are requested, then the features on the portal are updated and an automatic 

request is sent to the provider to complete the validation process. 

 Providers that did not use the Provider Portal are asked to validate a PDF map displaying 
their coverage area(s). This is accomplished via e-mail notification. 

PROVIDER VERIFICATION—THIRD PARTY SOURCE REVIEW 

After the provider has validated its coverage areas, a third-party source comparison and analysis is 
performed. 

 Where anomalies or discrepancies are identified, a “SCAN” point is dropped and descriptive 
comments are applied to be reviewed later with the provider. 

 During the provider review, the map is displayed along with the “SCAN” points and potential 
refinement is completed based on input from the provider. 

The table below shows third-party sources used: 

THIRD-PARTY SOURCE NAME SOURCE TYPE VERIFICATION TYPE 

InfoUSA Consumer and 
Business Listings 

Community Anchor Institutions; 
Can also be used for demographic information 
supporting the State websites. 

Pitney Bowes (PBBI) Exchange Info Plus 
(Central Office 
Locations) 

Exchange datasets are used to verify the following 
Transmission Technologies (TT): 
Asymmetric xDSL (10), Symmetric xDSL (20), Other 
Copper Wireline (30), and Optical Carrier/Fiber to the 
End User (50). 

Media Prints Cable Boundaries Used to verify the following TT: 
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THIRD-PARTY SOURCE NAME SOURCE TYPE VERIFICATION TYPE 

Cable Modem—DOCSIS 3.0 (40) and Cable Modem—
Other (41). 

American Roamer  Wireless Coverage 
Patterns (EVDO, 
GPRS, WISP, HSPA) 

Used to verify the following TT: 
Terrestrial Fixed Wireless—Unlicensed (70), Terrestrial 
Fixed Wireless—Licensed (71) and Terrestrial Mobile 
Wireless (80). 

ComSearch Wireless Spectrum 
Holdings and Tower 
Data 

Used to verify the following TT: 
Terrestrial Fixed Wireless—Unlicensed (70), Terrestrial 
Fixed Wireless—Licensed (71) and Terrestrial Mobile 
Wireless (80). 

ASSIGNING CONFIDENCE VALUES 
All findings and results from the abovementioned validation and verification activities, plus internal 
peer quality reviews, are captured and tracked in a Validation table (see example on the following 
page) and form the basis of the confidence value assigned for each provider and then each 
technology. 

CONFIDENCE VALUE DESCRIPTION 

    0 Coverage area has not been reviewed. 

  10 Extremely Low: 
Single Source QC.   

  20 Very Low: 
Needs additional validation\verification. 

  30 Low: 
Even with validation\verification, coverage still is suspect. 

  40 Acceptable: 
Confirm with State prior to shipment. 

  50 Meets requirements to be included in shipment. 

  60 Moderate: 
Meets NTIA/State’s standards, representative of Technology Type (TT). 

  70 High: 
Accurate representation of coverage based upon TT. 

  80 Very High: 
Multiple validation\verification with most third-party sources. 

  90 Extremely High: 
Multiple validation\verification sources. 

100 Perfect: 
Multiple validation\verification sources, with complete alignment with 
sources and ground truth verification activities. 

 

The Validation table is maintained as updates or changes occur for each provider, down to 
technology type, with the overall goal to improve the confidence values and overall map 
representation. An example of the Validation table is shown below: 
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COMMUNITY ANCHOR INSTITUTION (CAI) DATA 

DATA COLLECTION 

The CAI data was initially collected from the State to create the baseline inventory. All location 
information and broadband coverage data supplied also was ingested into the data deliverable. 
Additional collection of CAI information was done via data mining and/or webscraping to build out 
the inventory further. For example: Collection of additional CAIs and location information. 
 
The State-agency-provided CAI inventory was comprehensive but the challenge is collecting 
broadband related data: service provider(s), technology and speed data for each CAI. Availability of 
the CAI portal has not significantly increased submission of this data. Additional promotion to CAIs to 
use the CAI portal will be needed to increase this data for subsequent deliverables. 

INSTITUTION DATA 

Institution data is obtained from a variety of sources and almost always provided in Excel spreadsheet 
format. The general process for incorporating this data is as follows: 
1) If the data is provided in Excel or some similar format: 

a. Clean and standardize the Excel spreadsheet, removing any cell formats, merged cells, etc. 
b. Standardize the address format as defined in the staging CAI database. 
c. If the spreadsheet includes X and Y values, such as latitude and longitude, use the Add XY 

Data tool in ArcMap® to create a spatial data layer. 

d. If there are only addresses, then follow the geocoding steps outlined above to create spatial 
data points for each of the institutions. 

(i.) Institutions that do not geocode based on the TIGER® 2009 dataset will have to be 

located manually using Google Maps, Google Earth or some other information source. 
2) If the CAI source data is in GIS format, add the Latitude and Longitude fields and use the 

Calculate Geometry tool to populate them, using the WGS 84 coordinate system. 

3) Using ArcCatalog®, load the new data into the staging CAI database. 

4) This database is ready for the makeDeliverable.py script to process the information into the final 
State and NTIA deliverables. 
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COMMUNITY ANCHOR INSTITUTION (CAI) PORTAL UPDATES 

A web application has been released to allow for further data collection and validation of anchor 
institution location information, broadband coverage and speed test data. Information collected from 
the CAI Portal is then ingested into the overall inventory and will be compared later against the 
provider coverage areas mapped to locate any potential discrepancies. 

 

PRODUCT EXTRACT 

PYTHON SCRIPTS 

The following subsections make use of Python scripts. In general, to use a Python script you must have 
Python installed on your computer. To download the latest version of Python, go to 
http://www.python.org/download/ and download the latest stable version. As of August 2010, this was 
version 2.7. Once this is installed, the general way to run a script is to type the following at a command 
prompt: C:\Python27\python.exe C:\<location of script>. Many of the scripts provided have environment 
variables that must be set before they can be run. 
 
The Python code for BroadMap’s product extract has been incorporated into a Hudson CI System, which is 
detailed in the Process Operation and Monitoring section of this document. This was a process 
improvement activity so that all processes can be monitored, controlled and will contain historical 
tracking on each process. 

 

PRODUCT EXTRACT PROCESS 

NOTE: 
Specific Python scripts are called out in red font in the subsections below. 
 

The MapConnect
TM

 product extract process, makeDeliverable.py, uses the BB_Cov and 
BROADMAP_POINTS interim datasets to create the following layers according to the current 
specifications: 

 BB_Service_Road_Segment 
o This layer contains all broadband services associated with specific street segments for census 

2000 blocks larger in area than two square miles. 

 BB_ServiceCensusBlock 
o Contains all broadband services associated with census blocks of no greater than two square 

miles. 

 BB_Service_Wireless 
o This layer contains all wireless services not associated with specific addresses. 

 BB_ServiceOverview 
o This layer contains subscriber-weighted nominal speed for each provider's service area at a 

county level and is meant to act as a summarized view. 

 BB_ConnectionPoint_MiddleMile 
o This layer contains middle-mile and backbone interconnection points. 

 BB_Service_CAInstitutions 
o Broadband Service at Community Anchor Institutions (CAI). 
o Community Anchor Institutions consist of schools, libraries, medical and healthcare 

providers, public safety entities, community colleges and other institutions of higher 
education as well as other community support organizations and entities. 

http://www.python.org/download/


                                                                                

       Version 2.0         September 2011 Author: Kristin Rousseau 
       Page 55 

Because of a NTIA model change for the October 2010 data deliverable, an addition to this code was 
created to support both models in case a comparison is later desired or a request is made to revert to the 
original model. This script name is bdia2ntia.py and creates the following layers in addition to the layers 
mentioned above, rolled up to NATL_Broadband_Map. 

 BB_ConnectionPoint_LastMile 
o This layer contains last mile infrastructure points, which is populated only if data cannot be 

provided at a more granular level. 

 BB_Service_Address 
o Represents broadband availability for service address points. Address Point availability refers 

to those individual addresses at which each facilities-based provider of broadband service 
can provide broadband services of minimal characteristics within 7-10 business days. 

 State_Boundary 
o State boundary supporting topological validation of point feature classes. 

 NATL_Broadband_Topology 
o Supports basic topology quality checking. Example: No CAIs or Middle Mile points outside of 

the State boundary. 
 
The following process flow provides a view of how the Core fGDB is extrapolated to the NTIA final 
deliverable via the makeDeliverable.py script. Following that, the bdia2ntia.py script is run, which limits 
what is placed in the final layers based on the NTIA modeling standards. 
 
The product scripts and supporting extract were originally created separately per request, in case data 
model comparisons were to be completed. 

 

PRODUCT STATISTICS 

Following the completion of a product extract, the product statistics script (BDIA_ReleaseNotesStats.py) 
extracts the following information supporting that product deliverable. 

 Provider Statistics: 
o Collects all provider information, listing by Provider Name. 
o Provides output of FRN. 
o Counts the number of features supported within the following layers: 

 Census Block; 
 Street Segment; 
 Max Upstream; 
 Wireless Services; 
 Infrastructure Points. 

o These updates were made to support the Data Package required to accompany every NTIA 
product deliverable. 

 Community Anchor Institution (CAI) Statistics: 
o Breaks down CAI to the eight categories: 

 1: School: K through 12; 
 2: Library; 
 3: Medical/Healthcare; 
 4: Public Safety; 
 5: University/College; 
 6: Other Government; 
 7: Other Community non-government; 
 None: Unknown Category. In cases where this occurs, further investigation is completed 

prior to product shipment to ensure all CAIs are categorized accurately. 
o Reports out the following counts: 
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 Total CAIs within that category; 
 Total CAIs that contain partial BB coverage. Contains any of the following information for a 

given CAI: BB Subscriber, Transmission Technology, Speed Down Speed Up; 
 Total CAIs that contain full BB coverage. Contains all of the abovementioned BB information 

for a given CAI. 
The output of this script is two CSV files: AnchorInstitutions.csv and Providers.csv. These files then can be 
inspected to ensure that there are the expected number of CAIs and providers for every release. 

 

QUALITY ASSURANCE 

Quality assurance is supported manually and algorithmically on the interim data, BB_Cov file geodatabase and 
on the final product. For scheduled product releases, a test product extract and subsequent manual and 
algorithmic QC run is completed along with a release review. The product specifications, project status reports 
and previous product release notes are used as references throughout this review. 
 
The following parameters are tested using the methodology listed below each: 

 Product Deliverable Format:  
o Correct names and format of data deliverables. 

 BDIA_QC_SUITES (please see below for details). 
o Correct Projections/Datum. 

 Manual interaction with product. 
o Metadata Present and Correct. 

 Manual interaction with product. 

 Table Structure: 
o All required tables included. 

 BDIA_QC_SUITES. 
o Extraneous tables identified. 

 BDIA_QC_SUITES. 

 Field Structure: 
o All fields included. 

 BDIA_QC_SUITES. 
o Extraneous fields identified. 

 BDIA_QC_SUITES. 
o Correct field names, types and widths. 

 BDIA_QC_SUITES. 

 Field Domains: 
o Values in all tables are constrained to the specified values specified: 

 This action is accomplished via BDIA_QC_SUITES and manual review of the product; 
 This tends to identify project completeness issues as fields with a null value are identified. 

 Geometric Representation: 
o Identify if all layers have the correct geometric representation: 

 Manual review of the BB_ServiceOverview layer; 
 Dependent on NTIA and client requirements. 

 Geographic Extent: 
o Product includes the necessary Geography associated with Product? 

 Manual Review—ArcGIS®. 
o Is there extraneous geography included in Product? 

 Manual Review—ArcGIS®. 

 Completeness: 
o Products contain the expected amount of data? 
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 Manual review of product statistics relative to weekly State reports and defined expectations. 

 Accuracy: 
o Product meets the stated accuracy requirements for the deliverable? 

 Sampling procedure to manually review source material to resulting product; 
 Provider Validation; 
 Verification using Third-Party Data; 
 Verification against reality, where applicable. 

 Data Regression: 
o Any unexplainable data loss or change? 

 This action is accomplished by comparing results within product statistics script 
(BDIA_ReleaseNotesStats.py) from previous releases, as well as manual review of the product. 

 Confidentiality: 
o Any unauthorized confidential information included in the delivery? 

 Review of NDAs and delivery expectations. 

 Prior Issues Resolved:  
o Have expected internal issues been resolved? 

 Manual review of data against previous product release notes. 
o Have agreed-upon customer issues been resolved? 

 Manual review of data against previous product release notes, status report and client feedback. 

 Delivery Medium: 
o Has the product medium been verified? 

 Manual review. 
o All files present. 

 Manual review of SFTP site to ensure all files are copied correctly, including file/directory size. 
o Correct location. 

 Manual review—confirmation of SFTP link, username and password. 
 

QC SUITE 

The BDIA_QC_SUITES consists of four main types of scripts supporting the overall QC process. These 
scripts are all run in concert and are called from the test_runner script and the test_BDIAProductGDB 
script. 

CONFIGURATION  

These scripts establish the configuration for the test_BDIAProductGDB script, which is the core of the 
QC Suite. 
update_test_config 
active_config 
config_PROCESS01_automated 
config_PROCESS01_manual 
set_active_config 

LIBRARIES 

These scripts provide additional functionality that is called from with the test_BDIAProductGDB 
script. 
bb_unittest_fixture 
bbcov_structure 
BC_XmlWriter 
file_folder 
search_and_replace 
unittst_fixture 
validate_BB_DB 
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validate_BB_GDB 
xmlrunner_gui 

QC SUITE 

This is the core script for performing automated QA/QC on the interim and final data deliverables. 
test_BDIAProductGDB 

OTHER  

These scripts perform other functions detailed below: 
test_runner—this is the main script that runs all the other QC scripts and imports all the necessary 
scripts and libraries. 
which_build—this determines the current build and passes information to the configuration scripts. 

 

PROCESS OPERATION AND MONITORING 

Product Extract, makeDeliverable.py and bdia2ntia.py, is run within BroadMap using a platform called Hudson 
that has been enhanced to support BDIA product extraction, process monitoring, as well as product validation. 
The same platform can be planned for implementation for the State, if desired. 
 
Below are examples of the product create, product validation, product statistics and monitoring processes 
that are managed within the BroadMap Hudson CI-System. All of the abovementioned Python scripts, with 
the exception of metadata transactions script, are run via this system. 

 

BDIA PRODUCT CREATE 

Below is an example of the main page where the type of product build can be selected. 
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Selecting based on the type of process that will be initiated is shown below: 

 

  
The Console Output can be reviewed to see the progress of product create. Following the completion of 
each product creation process, an e-mail notification is automatically sent to the team. 

 
All processes run via the BroadMap Hudson CI-System are stored for historical reporting. Each process can 
be reviewed, including the Console Output and Build Artifacts from that run. 
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PRODUCT VALIDATION AND STATISTICS 

Once the product creation process is complete, Product Validation and Statistics are then initiated. These 
support the BDIA_ReleaseNotesStats.py script and the BDIA_QC_SUITES scripts detailed above. 

 
All statistics and reports are stored for historical review with the capability to place violation criticality on 
each quality control check, allowing the identification of errors because of project status/completeness 
verses project correctness. Example: Typical Speeds populated. 

 

Below is an example of the report provided based on various control points running over a specified 
period: 

 
Similar to the Product Create process, all results from the process are maintained: 
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Results are then reviewed manually to ensure no errors reported are critical or in violation of the NTIA 
data model or project completion statements. Any errors of concern are communicated ahead of product 
delivery and included within the product release notes. Further detail on the Hudson-CI System 
environment can be found by navigating to the following link: 
http://wiki.hudson-ci.org/display/HUDSON/Meet+Hudson 

 
 

PRODUCT EXTRACT DATA DELIVERY 

Product delivery for MapConnect
TM

 Broadband is handled two ways, depending on client requirements: 
1) State Submittal: 

a. Data is submitted via SFTP site; 
b. Product Release Notes and QC Test Report accompany the delivery. 

2) NTIA Submittal: 
a. Directions for using the NTIA State Broadband Data file submission tool: 

(i.) Go to the following website: https://esupport.fcc.gov/statedata; 
(ii.) Enter your username and password as provided to you from the NTIA program 
administrator; 

 
(iii.) Click in Upload a file field; 
(iv.) Browse to local file for submission using the Browse button. Select file, then select 

ATTACH FILE. See example below. 

http://wiki.hudson-ci.org/display/HUDSON/Meet+Hudson
https://esupport.fcc.gov/statedata
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(v.) Logout/Receipt using the Logout button in the top right of the screen; 
(vi.) A receipt of submission is e-mailed to username e-mail address. 
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Executive Summary 
 

The e-NC Authority 
The e-NC Authority, created by the N.C. General Assembly under Session Law 2003-425, is dedicated to 
growing local-level wealth and creating jobs and educational opportunity through increased broadband 
deployment. Mandated as the primary Internet policy and planning body for the state, e-NC works with 
citizens, broadband service providers, local and state government and partners across the state. Its 
responsibilities include: 

• Serving as the Broadband Authority for the state, with a focus on rural and urban-distressed 
areas; 

• Conducting research to help guide the state in economic development decision-making; 
• Mapping of broadband infrastructure in North Carolina per the requirements of the National 

Telecommunications & Information Administration (NTIA); 
• Providing Technical Assistance to communities and organizations; 
• Responding to citizen inquiries; 
• Facilitating local-level programs on technology-based economic development (i.e. the e-NC 

Business & Technology Telecenters); and  
• Serving as a grant-making and monitoring organization. 

 

e-NC finds and advocates for solutions to ensure that all North Carolina citizens and businesses increase 
broadband adoption and usage and have equal access to affordable, high-speed broadband. e-NC also 
promotes the benefits of broadband investments around commerce, education, healthcare, agriculture 
and government services to demonstrate greater economic opportunities. e-NC serves as a resource and 
manager for various statewide broadband initiatives and accomplishes its work through public-private 
partnerships, targeted research and direct outreach and education. Currently, the e-NC Authority is 
implementing a five-year project under the NTIA of the U.S. Department of Commerce.  

North Carolina's SBDD Grant 
The e-NC Authority (through its fiscal agent, the Rural Economic Development Center), is the recipient of 
the NTIA’s State Broadband Data and Development Grant for North Carolina. The SBDD grant program 
enables North Carolina to collect comprehensive and accurate state-level broadband availability data 
and to display a state-level broadband map (http://e-ncbroadband.org/), with these efforts aimed at 
aiding in the development and maintenance of the national broadband map. The e-NC Authority is 
currently using provider data for its map, but is also evaluating other data collection methodologies 
including Web crawling techniques and collecting broadband consumer data at the local level.    In 
addition, e-NC uses radio wave propagation prediction modeling (using GIS) to reflect wireless coverage 
in North Carolina. We recently turned in a report on the evaluation of various data collection techniques 
to the NTIA SBDD offices . Initial broadband planning funds for the project were used to conduct the 
2010 Citizen Survey on broadband usage in North Carolina and the 2010 e-Strategy Survey of businesses, 
organizations, and households looking at broadband usage and benefits among industry sectors. In 
addition to the data collection, validation and display work; and the initial broadband planning surveys, 

http://e-ncbroadband.org/
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the SBDD funding allows e-NC to undertake the following additional programs: state broadband capacity 
building, a technical assistance program, a Lifeline Online pilot to improve computer ownership and 
Internet usage (LITE-UP), and funding to partner with the NC Center for Geographic Information and 
Analysis on address file improvements for the state, with all these efforts continuing through October 
2014.  

Spring 2011 Broadband Data Collection and Mapping Process 
 

Data Collection 
The official data request letter was sent to all 104 identified providers of broadband service on June 28, 
2011, via e-mail and hardcopy mailed letter.  Attachments were included explaining the SBDD mapping 
project effort, the e-NC Authority’s role in the endeavor, and all requested parameters for information.  
Providers were asked to reply to the request on or before July 29, 2011. 
 
Excel and geodatabase templates were shared with providers, along with PDF format instructions 
summarizing all NTIA requirements and information relevant to each type of provider (fixed wireless, 
mobile wireless,  and wireline).  Technical assistance was provided to any organization who requested it. 
 
A secure server hosted by MCNC is configured with an open source, browser-based direct file upload 
system called eGroupware.  Providers were sent a log-in name and password for this upload system 
once they contacted either Samantha Jackson or Stephanie Jane Edwards to communicate that their 
data was ready for submission. A confirmation e-mail went to Stephanie Jane once data had been 
uploaded. 
 
Reminder e-mails were sent to unresponsive providers with usernames and passwords for data upload.  
An official reminder e-mail was sent out the first week of August to providers of broadband service that 
were unresponsive to the data request.  Phone calls were placed at various times in September to 
organizations that had not yet responded to the data request or reminders.  These phone calls and some 
background research allowed for e-NC to determine the companies that have gone out of business and 
those that refused to submit data. One provider which was thought to be out of business was found to 
still be operational in one McDowell County (AND Wireless and Security, Inc.), and another provider 
(Cherokee Broadband Enterprises) was identified for the first time. The number of known broadband 
service providers operating in North Carolina is now at 104. 
 

Integration of Provider Data into NTIA Statewide Geodatabase 
For ease of data integration, a front-end Excel format template was offered to all providers, containing 
notes defining required fields, explanations of which data is required in which formats by which types of 
providers, and hyperlinks connecting fields to additional tables listing the corresponding NTIA-specified 
values and codes (for speed tiers, technology types, connection point facility types and capacities, 
county codes, end user types).  A brief description of how census block FIPS codes work was also taken 
from an internet source and distributed as needed to providers who had questions about how to report 
this information. 

BB Service by Census Block  
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As requested by the NTIA mapping and planning team, all census block data is included with 2010 
census block geometry.  Technical assistance was often needed by providers to correctly report served 
areas by either the 15-digit FIPS codes or in some way by which e-NC staff could derive the appropriate 
FIPS codes. 
 
BB Service Road Segment  
The reporting and mapping of data by street segment presented significant challenges to accurate 
interpretation of where broadband availability is and is not.  This is mainly attributed to the difficulty of 
standardization among the many data structures by which providers report street segments.  Quality of 
data has improved since some providers have switched to submitting data in shapefile format, and 
others have been able to start including a Tigerline ID (TLID) field for reference in mapping tabular 
information. Use of this unique identifier has reduced ambiguity in some tabular datasets and improved 
data quality upon mapping.   
 
BB Service Address  
A few address-level datasets were submitted to e-NC with the latitude/longitude coordinates already 
included, but most needed to be geocoded.  This was done using the NC Master Address file as the 
primary reference file, significantly increasing the accuracy of matching records.   Secondary sources for 
address records that did not find a match this way included street segment interpolation, ESRI data 
utilizing the 4-digit ZIP extension, and manual placement/digitizing based on a combination of reference 
data and online browser maps.  Upon completion of geocoding for each provider submitting address 
data, the address point features were overlain with a 2010 census block layer to add the census block 
FIPS code attribute, then all address feature points were loaded into the geodatabase feature class.  The 
geocoded shapefiles for each provider are kept with geocode match score and match reference type for 
every matched address, so the thoroughness of this data type could be tracked and/or improved with 
more time. 

BB Service Wireless  
Approximately seven small, fixed wireless providers have been able to share technical information about 
their transmitting towers, antennae, and frequencies, so that e-NC can produce for them a service 
coverage shapefile using the contracted services of the University of NC at Greensboro Center for 
Geographical Information Science (http://cgis.uncg.edu) .  An Excel template was developed with all the 
relevant information that can be filled in by providers with technical assistance in some cases, and the 
propagation model is field-calibrated to reflect actual ground conditions. 

BB Service Overview  
Records for overview containing subscriber-weighted nominal speeds of a given provider were generally 
joined to a template layer of county features, using the option to keep matching records only.  Then 
these matching features and their new attributes were exported as a new shapefile before being loaded 
into the collective overview feature class.  For providers with multiple technology types serving a given 
county in at least one instance, this information was single-field geocoded using the 5-digit county FIPS 
code, and then geocoded point features were spatially joined to the county polygon using “within” 
criteria. 

Some detail formatting performed as needed: 

• Add state FIPS code and any needed leading zeros onto county code for the new State+County 
FIPS code. Most providers list just the county code because this was the original NOFA request. 

• Change state abbreviation values from “37” to “NC”. 

http://cgis.uncg.edu/
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• Change weighted speeds to appropriate units (kbps) and remove unit text. 
• Translate to county from weighted speeds reported by RSA/MSA. 

 

BB Service - Critical Anchor Institutions  
Only anchor Institutions that could be geolocated were included. Only 17 CAIs were identified that could 
not be geocoded to a point feature.  CAIs were collected by contacting administrative offices of some 
CAI category types and receiving databases of information, as well as collecting from individual CAI 
locations for other types using survey emails and follow up phone calls as necessary.  There are 5,857 
CAI’s identified, located, and included in the geodatabase to date.  

Census Block data (tabular) 

• Fields standardized and transferred into Excel template 
• Geocoded to centroids of census blocks using 2010 Census Block layer in WGS1984 projection as 

reference file for “Address Locator”. 
• Spatial join of geocoded census block data points to polygon features 

 

Census Block Geometry Conversion (2000 to 2010) 
 
The following providers either are represented based on data submitted in previous data pulls, or 
submitted new data in census block geometry from 2000, therefore requiring geometry conversion: 

• Carolina Mountain Cable 
• Cherokee Cablevision 
• CoMPAS Cable 
• Country Cablevision 
• Inteliport 
• Lexcom 
• North State 
• Piedmont TMC 
• Skyenet 
• Star TMC 
• Suddenlink 
• Surry TMC 
• Tele-Media Corporation 
• Windstream Concord Telephone 
• Windstream North Carolina 

 
The following steps were carried out in ArcGIS for each provider: 

• Select all records in Spring 2011 provider dataset 
• Relate FIPS 2000 field in provider data to FIPS 2000 field in statewide crosswalk table 
• Relate FIPS 2010 field in statewide crosswalk table to GEOID field in 2010 census block layer. 
• Export related/selected 2010 CB records as new layer, and related/selected crosswalk records as 

a provider-specific dBase table. 
• Attribute join on exported Crosswalk subset with Spring 2011 provider data layer based on year 

2000 CB number, keeping matching records only.  Number of records should stay the same. 
Export all features as new joined crosswalk DBF. 
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• Attribute join on new 2010 CB layer with the joined crosswalk DBF (which should now have the 
relevant provider data) based on 2010 FIPS field, keeping matching records only. Number of 
records should stay the same. 

• Export 2ns join results into new finalized 2010 CB layer with broadband data. 
• After adding the new EndUserCat field, this 2010 CB service area layer is loaded into the 

geodatabase. 

Street Data 
Some datasets were submitted to e-NC by providers already in shapefile format, and others were 
reported in various tabular formats (text, Excel, CSV, etc.).  Of the tabular datasets, some included a 
Tigerline ID (“TLID”) field along with some or all other fields such as city, state, zip, and census block 
FIPS. 

• For datasets submitted tabular with TLID:   
o Max and Min address ranges were calculated from the FromRight, ToRight, FromLeft, 

ToLeft format used by most standard street segment reference files and incoming 
datasets 

o All data formatted into back-end Excel format, including converted speeds if reported at 
some other granularity. 

o Table geocoded to Tigerline 2010 street segment file using single-field and “TLID” 
values, with zero offset. 

o Geocoded point features converted to street segment geometry via spatial join using 
“contains” criteria, keeping matched records only. 

• For datasets submitted tabular without TLID: 
o Max and Min address ranges were calculated from the FromRight, ToRight, FromLeft, 

ToLeft format used by most standard street segment reference files and incoming 
datasets 

o All data formatted into back-end Excel format, including converted speeds if reported at 
some other granularity. 

o Table geocoded to Tigerline 2010 street segment file using false midpoint address and 
either ZIP5 or census block FIPS (whichever available) as address locator zone. 

o Geocoded point features converted to street segment geometry via spatial join using 
“contains” criteria, keeping matched records only. 

• For datasets submitted as shapefiles:  VB If/Then statements used to calculate “Max” and “Min” 
address range attributes required by the NTIA/FCC, converted from the FromRight, ToRight, 
FromLeft, ToLeft format used by most standard street segment reference files and incoming 
datasets: 

o To calculate “Min”: 
Dim fromRight 
Dim toRight 
Dim fromLeft 
Dim toLeft 
 
fromRight = [FROMRIGHT]  
toRight = [TORIGHT]  
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fromLeft = [FROMLEFT] 
toLeft = [TOLEFT]  
 
 
Dim minright 
If fromRight = 0 And toRight = 0 Then 
    minright = 0 
ElseIf fromRight = 0 Then 
   minright = toRight 
ElseIf toRight = 0 Then 
   minright = fromRight 
Else 
   If fromRight < toRight Then 
      minright = fromRight 
   Else 
      minright = toRight 
   End If 
End If 
 
Dim minleft 
If fromLeft = 0 And toLeft = 0 Then 
    minleft = 0 
ElseIf fromLeft = 0 Then 
   minleft = toLeft 
ElseIf toLeft = 0 Then 
   minleft = fromLeft 
Else 
   If fromLeft < toLeft Then 
      minleft = fromLeft 
   Else 
      minleft = toLeft 
   End If 
End If 

o To calculate “Max”: 
Dim fromRight 
Dim toRight 
Dim fromLeft 
Dim toLeft 
 
 
fromRight = [FROMRIGHT]  
toRight = [TORIGHT]  
fromLeft = [FROMLEFT] 
toLeft = [TOLEFT]  
 
 
Dim maxright 
If fromRight > toRight Then 
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   maxright = fromRight 
Else 
   maxright = toRight 
End If 
 
Dim maxleft 
If fromLeft > toLeft Then 
   maxleft = fromLeft 
Else 
   maxleft = toLeft 
End If 
 
Dim max 
If maxleft > maxright Then 
   max = CStr(maxleft) 
Else 
   max = CStr(maxright) 
End If 

 

Creating last mile and middle mile features 

• Formatted numeric fields in Excel as text since the short integer format in the data model for 
these fields will not accept values from the Excel import’s default general format. 

• ArcToolbox > Data Management Tools > Layers and Table Views > Create XY Event Layer 
• Zoom to Layer, verifying that all points are located inside NC boundaries 

 

Provider-specific notes, functions and corrections performed by e-NC as needed 
 
Access/On Multimedia Inc. 

• This is a middle mile only provider 
• Provider confirmed no changes since last round so fall data was used 

AT&T F11 
• Converted subscriber weighted nom speed data from CBSA to county 
• Converted max advertised speed data from CBSA to county 
• Translated max advertised speeds from KBPS to NTIA codes 
• Applied converted speeds to appropriate availability records by county based on FIPS codes, by 

pasting the CBlock FIPS codes into speed columns and using Find/Replace functions in Excel (ex 
Find fields with 37001* and Replace with 7).  For data by street and CB. 

• Copied max advertised speeds into typical speed columns (for which data was not supplied by 
AT&T) 

• Calculated conversion of Left and Right To/From addresses for street segment data to NTIA’s 
required Max/Min values (using “min” and “max” formulas in Excel) 

• Checked data by CB for duplicates, 14,399 found and removed. 
• Used 2010 TLID field in attribute join to map street segment data. 

 
AT&T Mobility F11 

• Merged shapefile features into a single multipart polygon to remove arbitrary grid boundaries. 
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• Validation: Ran “Eliminate Polygon Part” tool to remove any parts or donut holes less than 0.125 
square miles in area. 

• Added attributes supplied in Excel spreadsheet. 
 

ATMC 
• Added Address field populated with a concatenation formula of component address 

information. 
• Added EndUserCat field and populated with code 5 
• Overlay of address points w/CB layer to get FIPS code field 
• Created new fields and used Calculate Geometry function in ArcMap to generate Lat and Long 

attributes 
 
ATMC Wireless 

• Clipped shapefile to state boundary 
• Eliminated polygon parts less than 0.125 square miles 
• Added spectrum attribute 

 
CenturyLink F11 

• Reprojected CB and street shapefiles and changed format of some fields for loading 
• Ran Delete Identical tool on streets shapefile to remove duplicates based on Tigerline Ref 

numbers. 
• Used If/Then scripts to calculate min and max address fields from left and right max/min ranges 

in ArcMap field calculator 
• Created new fields of compatible type for TransTech and Provider_Type fields 

 
Charter F11 

• Projected and formatted attribute fields. 
• Streets submitted and mapped in 2010 Tigerline, which has no address range information. 

 
Comporium F11 

• Removed duplicate records in Excel during formatting 
• Ran address sorter, transferred previously geocoded features into new GDB (with the newer 

tech and speed attributes) and geocoded new data. 
 
Comcast F11 

• Mapped previous CB’s and streets, then new CB’s and Streets submitted this round 
• Calculated min/max address ranges for street segment data in Excel 
• Geocoded hypothetical midpoint of tabular street segments by address range and spatially 

joined to street segment features. 
• Used Overview data from Fall 2010 
• Low quality on streets from previous data pulls (only a 61% match to tiger streets w/CB zone) 

 
Country Cablevision and Carolina Mountain Cable F11 

• Converted CB shapefile from Spring 2011 into 2010 geometry 
• Duplicated max advertised speeds into typical speed fields via Field Calculator 
• Added Provider Type field and populated with code 1 
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Electronics Service Co of Hamlet 
• Customized propagation model for unique antenna setup high up in trees 
• Clipped output to state boundary 

 
Electronic Solutions 

• Converted coordinates, added negative sign to longitude 
• Produced shapefile from data supplied in Tab D. Converted raw speeds to NTIA codes.  
• Put weighted speeds into correct units. 

 
Epproach 

• Copied Census blocks from Fall 2010 geodatabase 
• Merged census block polygons 
• Loaded into geodatabase and populated Unlicensed for spectrum field. 

 
Frontier F11 

• Started with Spring 2010 Verizon data with legal agreement from both Verizon and Frontier. 
• Applied Max Advertised speeds from MSA to CB and Street Segment level based on FIPS codes 

and relevant counties. 
• Missing speed data: duplicated Max speeds for Typical which were not submitted.  Speeds were 

not reported for all CB’s and streets reported, and for these the lowest (except for 1 CB) values 
from Max speed data, NTIA code 5 for down and 3 for up, were applied.  

• Middle Mile: assumed “Owned” for Ownership field to substitute for missing information, as 
instructed by federal program office. 

• Created XY Event layer for new last mile points submitted. Learned from follow up with provider 
that data from previous round still applies, and that 15,000 foot service circle applies to new last 
mile points for availability. 

• Selected 2010 road segments that intersect eitherthe new 15,000 ft radius buffers, the 
previously reported census blocks, or the previously reported streets.  Exported as single streets 
shapefile for fall. 

• Manually deleted stray street segments which mapped far outside of counties reported as 
served. 

• Selected and exported census blocks <2mi2 which contained a served street segment. 
• Erased street segments from new layer which overlap 2010 census blocks <2mi2. 
• Manually attributed provider/tech/speed data (uniform across service area) 
• Loaded last mile points from current and previous data pulls. Middle mile points from previous 

data pull. 
 
 
Greenlight (City of Wilson) F11 

• Re-projected shapefiles into WGS84. 
• Added FRN2 field with leading zeroes, Lat, Long, EndUserCat (populated with code 5), and 

Provider type field (populated with code 1) to address attributes, and re-concatenated 
“Address” field. 

• Removed duplicate addresses using Delete Identical tool in ArcToolbox, checking in Address, 
TransTech, MaxAdDown and MaxAdUp fields. 

• Populated missing Typical speed fields with Maximum Advertised fields. 
• Added/populated FRN w/leading zeroes, lat and long fields for middle and last mile 
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• Attribute join to county template feature class for Overview 
 
Hughes Network Systems F11 

• Added leading zeros and concatenated tabular census state, county, tract, and block FIPS 
component fields. 

• Geocode and spatial join on year 2000 census block list.  Merge on all census block features into 
a single polygon.  Manual attribution from email and website contents. 

 
Interstar 

• Mapped subscriber addresses supplied by the provider, then used the point locations to derive a 
Minimum Bounding Polygon (Convex Hull) representing available wireless coverage. 

• One-to-one spatial join associating provider attributes and speeds (max for served area) with 
minimum bounding polygon. 

• Added spectrum field and populated with code 6. 
 
Level 3 

• 11 duplicate address records removed, 209 unique records remaining. 
 
Mediacast F11 

• Max Advertised speed values duplicated to populate typical speed fields. 
 
Mediacom F11 

• Corrected fields in MidMile (provider name typo, ownership, positive longitude value) 
• Removed duplicate address records from data in Excel 
• Concatenated street address and other full address components 
• Used end user field in supplied data translating “RES” as EndUserCat code 1, and “COM” as 

EndUserCat code 3 (though size of the business cannot be determined). 
• Manual cleanup of some address field values 
• Duplicated max advertised speed values for typical speed fields 
• Run script to sort out/update previously geocoded addresses and prepare new addresses for 

processing. 
 

MI-Connection F11 
• Deleted 8,071 duplicate records (using address, transtech, and all speed fields) 
• Populated unmatched/ungeocoded addresses with placeholder values (-9999) 
• Re-concatenated Address field for cleaner, consistent contents 

 
Morris F11 

• Use of same address list as Spring 2011, confirmed that these include both current and potential 
broadband customer locations. 

• Learned that speeds for fiber records had been reported by Mbps and converted these to NTIA 
codes to match other records. 

• Spatial join with 2010 census blocks for FIPS field. 
 
North State 

• Emailed about missing FIPS digit and inserted (leading zero for tracts) upon their response. 
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• Speeds were reported as Typical Up/Down only. Substituted these values into Max Ad Up/Down 
as well. 

• Duplicate CB records were given to us for each service tier.  Merged into CB shapefile after 
geocoding by: 

o Splitting into separate shapefiles by tech type (10, 30, and 50) 
o  One-to-one spatial join field merge rule taking the maximum value from duplicates’ 

speed fields. 
• Middle Mile, Last Mile: Added negative sign to longitude values 
• Last Mile point with longitude -70.97528 fell out of state boundaries and was changed to  

-79.97528 based on locations of all the other last mile locations. 
 
Sprint Nextel F11 

• Validation: Ran “Eliminate Polygon Part” tool to remove any parts or donut holes less than 0.125 
square miles in area. 

 
Starvision F11 

• Parsed tabular address-level data in Excel. 
• XY event layer created with address-level data that included coordinates. 
• Corrected typo on one point that appeared outside of service area, moved point and applied 

new census block FIPS code. 
 
Surry TMC and Piedmont TMC 

• Contacted for clarification and formatted mislabeled “street” information into address tab 
• Removed 7 duplicates from address data in Excel 

 
Skybest and Skyline F11 

• Downloaded and created missing .prj file for shapefile exports from provider, based on follow 
up determining an NAD 83 North Carolina FIPS 3200 ft projection. 

• Converted polylines to polygon for each DSL and fiber-to-the-home technology layers. 
• Reprojected into WGS 1984 
• Selected Tigerline 2010 streets by location inside newly created polygons 
• Attributed for TransTech then merged into street layers by provider 
• Created fields and attributed manually from contents of provider-supplied Word documents. 
• Used VB script in Field Calculator to derive max/min address range information 

 
Sky Catcher 

• Wireless Propagation study. 
• Created XY Event Layer to map Middle Mile information, deleted duplicate records. Remaining 

records loaded into geodatabase. 
 
Suddenlink F11 

• Deleted 203 census block records and 332 address records that had blank technology/speed 
info, after confirming with the provider these records are not relevant to broadband. 

• Removed 410 duplicates in the address field after concatenating without apartment numbers. 
• Mapped census blocks then converted to 2010 census block geometry/attributes.   
• Manually deleted 2 census blocks that mapped well outside the reported service area. 
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TDS Telecom 
• 713 out of 741 matches for addresses submitted found in old data. Remaining records 

geocoded. 
 
Tele-media 

• Provider type of 1 assumed and populated. 
• Checked for duplicates CB’s in Excel, none found  

 
Time Warner Cable 

• CB and Streets: 
o Padded FRN w/two zeroes 
o Reprojected into WGS 1984 
o Added Provider Type field and coded as a “1” 
o Input Max Advertised speeds as Typical Speeds as well, since they were not provided. 

• Streets: created “AddyMax” and “AddyMin” fields and used If/Then statement to calculate 
values from LFrom, LTo, RFrom, and RTo fields 

 
T-Mobile F11 

• Reprojected shapefiles into WGS 1984. 
• Added field to categorize by technology type/T-mobile service tier (3G, 4G).  
• Attributed manually from information sent in a text file from T-Mobile. 
• Executed spatial Union between coverage of higher speed and the broader 3G coverage, then 

extracted (Data Export selected features) resulting 3G only features to distinguish max speeds 
here versus where higher speeds are also available. Merged into single shapefile 

• Eliminate Polygon part tool to remove features <0.125 square mile. 
 
Tri-County 

• Concatenated address information into single Address field in BackEnd template spreadsheet. 
• Duplicates removed by technology type (17 dsl, 3 wireless) 
• Lat/longs from provider with address data, so mapped using Create XY Event Layer in 

ArcToolbox 
• Sorted, selected, and exported by TransTech types 70 and 10, then one-to-one overlay of each 

shapefile with CB layer. Maximum merge rule used for speed information. 
• For Tech Type 10: Selected and exported resulting aggregated CB data for CB’s <2 mi.  These 

were loaded into the geodatabase with associated broadband data. 
• For Tech Type 70: created copy of resulting CB’s <2 shapefile and merged all features into one 

multi-part polygon.  This was loaded into the wireless feature class and manually assigned 
“Unlicensed” spectrum value. 

• Address feature layer was clipped using polygons created from merged CB’s OVER 2 miles, and 
those in the clip result were loaded into the geodatabase with associated broadband data. 
 

Verizon Wireless 
• Compared submitted shapefile with previously submitted shapefile, differences confirmed. 

 
Windstream (Windstream North Carolina, Windstream Concord Telephone, and Lexcom) 

• Sorted 2 Access tables by “DSL” field and deleted all records without a “Y” 
• Sorted 2 Access tables by census block size field, dividing up data by CB and streets 
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• Copy pasted all relevant fields into Excel Template column by column, including number listed 
indicating company name and MSA/RSA name pasted into Max Advertised Download Speed 
field. 

• Used Find/Replace to populate appropriate Provider, DBA Names and FRN’s (sent in emails upon 
request) and Up/Down Max Advertised Speed info based on contents of cells w/direct 
relationship to this information. 

• Recalculated left/right, to/from street segment address ranges to max and min 
• Created false address using the integer midpoint of max and min concatenated with street name 

provided, then geocoded these “addresses” using Tigerline 2009 overlain with CB 2000 to use as 
Zone 

• Split Windstream NC and Windstream CT geocode results up into two tables, then one-to-one 
keep common spatial join w/Tigerline 2009 features using “contains” criteria. 

 
Yadtel F11 

• Corrected middle mile capacity code after checking with the provider. 
 

Post-processing Functions for Final Integration 

Census Block 
After Census Block data was loaded into the transfer geodatabase feature class, FIPS code fields were 
calculated using commands in the Field Calculator and contents of the FullFIPSID field.  The following 
calculation formulas were used: 
 
STATE FIPS = Left ([FULLFIPSID],2 ) 
COUNTYFIPS = Mid([FULLFIPSID],3,3) 
TRACT = Mid([FULLFIPSID],6,6) 
BLOCKID = Right ([FULLFIPSID],4) 
 

• 1019 duplicate records (with same value for Provider Name, DBA Name, FRN, TransTech, and 
FullFIPS ID) were removed using the ArcToolbox Delete Duplicates tool. Identified by provider 
using the ArcToolbox frequency tool, the following number of duplicates were removed: 
 

o CenturyLink (1010) 
o Covad Communications (1) 
o Ellerbe TMC (3) 
o Time Warner Cable (1) 
o PTC Communications (1) 
o TriCounty Telecom (3) 

 

Address Data 

• Exported features into a shapefile, conducted one-to-one, keep all spatial join with CB 2010 
using “Is_Within” criteria to produce the associated 15-digit FIPS Code.  These features were 
then reloaded into a clean version of the Address feature class. 

• Parsing of 317 records that had null value for building number or street name or city. 
• Reverse selection within state boundary used to then export (for record-keeping) and deletion 

of addresses outside North Carolina. 
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• Excluded 23 records (from @Communications) that did not meet broadband speed threshold 
values. 

• Sorted out, selected, and field calculated missing End User Category values from “ZZ” default 
value to “5” for Other/Cannot Determine. 

• Calculated geometry for missing Lat/long, for unmatched addresses changed to -9999. 
 

Wireless 

• Duplication of multipart coverage polygons to reflect multiple spectrum ranges used, per 
NTIA/FCC instruction. 

Overview 

• Field Calculated “Geographic Unit Type” field to CO, and “StateAbbr” field to NC. 
• Field Calculated missing Maximum Advertised Up and Down speed fields to “ZZ” “default” 

values. 
• Deleted records of information for wireless technology types. 
• Verified that all FRN’s were either 9999 or 10 digits with leading zeroes. 

 

Last Mile 

• Field Calculated “Ownership” field to -9999, as we do not collect this field.  Calculated 
“StateAbbr” field to NC.  Then went back and calculated all “Ownership” field values to “0” for 
owned since the data model script does not accept the default values we were instructed to use. 

 

Middle Mile 

• Spatial join with census block layer to derive the 15-digit FIPS code, then reload features into 
middle mile feature class including the new values for populating the “FullFIPSID” field. 

• Replaced Null Elevation values with -9999 “default” value using Field Calculator. 
• Populated State Abbreviation column with “NC”. 

 

CAI 

• Parsed address information for address fields 
• Deleted “DMV Tag Office” in “Charlotte, NC” due to absence of street address information. Was 

geocoded incorrectly. 
• Deleted 526 records for which survey respondents report that they do subscribe to broadband 

but did not give speed information accepted by the NTIA’s script. 

Verification Implemented Prior to Fall Data Submission 
Data verification methods implemented by e-NC in time for submission at the federal level followed 
generally along the lines of quality control.  Methods most often used are outlined below.  Time 
constraints on existing staff did not allow for the execution of some less basic verification approaches 
that are in the planning/setup stages, but more substantial verification involving multiple data sources 
are in development.   
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Standardizing  
The files from datasets received from each provider, except for those few submitted in shapefile format, 
were manually transferred to a back end Excel-format template with field headers, to create a single-
file, standardized field structure for each provider’s data that could be used for quick reference and map 
feature creation.  This step also helped staff to ensure that all required components were either present 
or requested in follow up to the provider, and that the components were reported in the correct format. 

Lat/long coordinates 
Some information was submitted to e-NC with lat/long coordinates included for the location of point 
features.  This location information was checked during the mapping process, and values were corrected 
if the provider had made mistakes such as reversing the latitude with the longitude, or forgetting to 
include the negative sign for the longitude value.  In addition, e-NC followed up with providers on point 
features that showed up in the map outside the state and/or outside the provider’s reasonably expected 
service area.  Point features that mapped outside the state after follow up with providers, including 
those that mapped to zero degrees latitude and longitude due to an unknown location, were deleted 
from the geodatabase for submission at the federal level.  For fixed wireless data generated by 
propagation model from antenna specs, the latitude/longitude coordinates of the antenna locations 
reported by the provider to e-NC were verified by e-NC’s university GIS research contractor using high-
resolution orthoimagery.   

Multiple FRNs 
In several instances, providers reported multiple FRN’s that increased in numerical increments of one for 
each record of data, and this was found to be a simple error when the providers were trying to paste 
their organization information down the rows applying to a list of broadband data records.  This was 
checked for and corrected after confirming that the lowest/first reported FRN was the correct one. 

Correct technology type codes 
Knowledge from our technical staff and online research was sometimes used to supplement data that e-
NC had relevant to a provider that was unresponsive or otherwise did not supply this specific piece of 
the information.  For example, a provider may have gaps in their transmission technology field and these 
were filled in when technical staff could confirm that the provider operates with only a single technology 
type.  Or the staff may know which technology type is used by a provider who simply left this field blank 
on all records. 

Subscriber-weighted nominal speeds  
Weighted nominal speed values were checked, and staff followed up with the provider if all values were 
the same for multiple counties, as this could result from either a single speed tier for a given 
transmission technology across counties, or in some cases providers were not following the formula 
provided and had manually entered the same value regardless of differences in subscriber numbers.  
When these cases were discovered, technical assistance was offered and a new subscriber-weighted 
nominal speed dataset created to reflect variation between counties. 

Wireless model fieldwork  
For fixed wireless provider data that was generated as coverage area output from models based on 
technology and environmental factors, the data was verified by “ground-truthing” with measurements 
of signal strengths at sample locations within a provider’s service area, observation of the influential 
ground conditions in each location, and comparison to the expected signal strengths at the same 
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locations in the model.  Some calibration of the model was then performed so that the resulting 
polygons could more accurately reflect what would be found in real life. 

Check Geometry  
After compiling all datasets into the geodatabase feature classes, the check geometry process in Arc 
Toolbox’s Data Management section was used on each feature class to identify and repair any geometry 
errors in the features. 

Comparisons with Citizen-Sourced Data 
 
The e-NC Authority has recently constructed a mapped layer of input from citizens who report having no 
access to broadband at their location, from any broadband provider.  The compiled layer is collected 
from local citizen advocates, citizen input on e-NC’s website feedback form, and locally conducted 
surveys.  Comparison of provider-sourced data with this source of information has allowed for targeted 
follow up with providers in order to promote access to broadband for these citizens, as well as to begin 
refinement of our statewide broadband data.   Further data collection from citizen input and 
comparative analysis approaches will be described in spring 2012. 
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1.0 Provider Outreach 

1.1 Mapping Participants 

Apex and the Nebraska Public Service Commission (NPSC) began the mapping project 

by collecting contact information for providers listed on the FCC’s 477 data base and 

from Nebraska certificated and rural local exchange carriers, communications providers 

(internet service providers, cellular, fixed, and mobile wireless) that had registered with 

the NPSC and other potential providers thought to be in the State of Nebraska.  The total 

number of potential internet service providers (ISPs) on the original combined list was 

283.  Using various research methods (telephone calls, web searches, crowd source) 159 

names were identified as either a subsidiary of an ISP already on the list or did not 

provide internet access service at that time.   

Non-disclosure agreements (NDAs) were sent to 124 potential ISPs. In reviewing the 

NDA information some ISPs determined that they did not meet the broadband speed 

qualification standard by the National Telecommunication and Information 

Administration (NTIA) or did not return the NDA.  Two ISPs refused to participate in the 

mapping program. The NE_DataPackage_2011_10_01.xls file in the 

NE_SBDD_2011_10_01 data submittal provides a current list of ISPs and their status. 

The NPSC staff and Apex continue to be engaged in ongoing outreach activities to 

encouraging ISPs to participate and identify new ISPs.   

 

1.2 Non-disclosure Agreement (NDA) Process 

The NDA process was completed for most providers during the first quarter of 2010.   

Prior to that time, Apex developed a standard NDA to be used in this project.  Broadband 

providers were made aware of the NDA through a series of emails and reminder emails, 

workshops and individual calls to contact persons.   Most providers used the standard 

NDA.  However, a few of the providers requested minor changes in the standard NDA.  

Those changes were accepted whenever possible.  In a limited number of instances, 

several iterations of changes were negotiated. Providers and Apex were able to agree on 

the final NDA. 

NDAs will be executed with new ISPs as they are identified.  
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2.0 Data Collection 

2.1 Data Input  

2.1.1 First and Second Round  

In the first round a data input template in an Excel spreadsheet format was developed by 

Apex and given to ISPs for use in the data submission. The template was based on the 

appendix to the NTIA Notice of Funds Available (NOFA) as amended by the NOFA 

clarification. The template included the following worksheets associated with the State 

Broadband Data and Development (SBDD) Grant Program Data transfer deliverable:  

a. BB_Service_Address 

b. BB_ConnectionPoint_MiddleMile 

c. BB_Service_CensusBlock 

d. BB_Service_RoadSegment 

e. BB_Service_Wireless 

f. BB_Service_Wireless_Antenna 

g. BB_ConnectionPoint_LastMile 

h. BB_Service_Overview 

i. BB_Service_CAInstitutions 

The wireless worksheet included information requested by the NOFA and information 

required to generate the propagation patterns for wireless service areas. 

In the first round data collection, Apex experienced numerous occasions where 

Information Service Provider (ISPs) submitted data that was incorrect or insufficient.  

In the second round the NPSC, selected ISPs based on geographic coverage and 

willingness to work with the NPSC to improve the data collection process.  

These efforts included on-site meetings with the staff of the ISPs to explain in detail the 

overall mapping process, sharing of the specific data requirements of the NOFA, 

examining the results of the first round of data collection, and identifying issues that 

contributed to difficulties in data collection, submission, and presentation.  

 

2.1.2 Third Round  

After the one-on-one meetings with the selected ISPs in Round 2, the NPSC perceived a 

need for a more simplified, user-friendly, and standardized method for ISPs to provide 

the required data in the allowed Microsoft Excel format.  Consequently, the NPSC began 

development of a sophisticated, user friendly, method to allow ISPs the ability to provide 

broadband data in a standardized, validated format.  The DIM was implemented for the 

third round of data collection.   
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The DIM provides a uniform method of data entry; minimize the repetitive entry of 

company specific data, while performing real-time validation of submitted data. The DIM 

is a robust mechanism, developed in Microsoft Excel, on a Windows platform, with all 

supporting modules residing in a Visual Basic environment. 

 

The DIM provides for three operations; manual record input, with field verification, 

import of an entire dataset, with field verification and error logging, and export of a 

verified dataset to be submitted to the NPSC. 

 

To facilitate these operations, DIM users are guided through an interactive menu 

environment.  Initial menus allow for entry of Provider Name and DBA Name unique 

pairs based on a dropdown list of predefined entities.  The Federal Registration Number 

(FRN) associated with that unique pair is then populated as a function of the user’s 

entries.
1
  Finally, in order to enter the record input stage, an ISP must select the modality 

and ownership status of service for which broadband data is being provided.   

 

 
 

Specific data requirements, also as a function of the user’s selections, are then 

dynamically displayed and made available for entry.  The data entry structure is 

demonstrated below. 

 

Wireline / Cable Carriers 

Alternative I 

Required Tabs 

                                                 
1
  The NPSC requires all ISPs have an FCC Federal Registration Number (FRN) to submit data, 

ensuring all data and DBAs are appropriately assigned.  The DIM allows the NPSC to manage this 

requirement as, absent the existence of a valid FRN, an ISP is unable to enter the data entry portion of the 

DIM.  The NPSC enacted this requirement to ensure knowledge of any new ISP entering the Nebraska 

market, prior to its providing broadband data. 
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BB_SERVICE_ADDRESS 

BB_SERVICE_OVERVIEW 

BB_CONNECTIONPOINT _MIDDLEMILE 

Optional Tabs 

BB_CONNECTIONPOINT_LASTMILE 

BB_SERVICE_CAINSTITUTION 

Alternative II 

Required Tabs 

BB_SERVICE_CENSUSBLOCK 

BB_SERVICE_ROADSEGMENT 

BB_SERVICE_OVERVIEW 

BB_CONNECTIONPOINT _MIDDLEMILE 

Optional Tabs 

BB_CONNECTIONPOINT_LASTMILE 

BB_SERVICE_CAINSTITUTION 

 

Wireless Carriers 

Required  

BB_SERVICE_WIRELESS 

BB_SERVICE_OVERVIEW 

BB_CONNECTIONPOINT _MIDDLEMILE 

Verification Required 

BB_WIRELESS_ANTENNA 

Optional 

BB_CONNECTIONPOINT_LASTMILE 

BB_SERVICE_CAINSTITUTION 

 

For each record in a worksheet, key fields are required to initiate and continue the data 

entry process.  Each field is validated upon entry to ensure consistency and compliance 

with NTIA data model requirements.
2
  Finally, once entry is complete, the ISP utilizes 

the DIM’s export function and provides said results for submittal to the NPSC. 

 

The data entry requirements inherent to the DIM’s underlying validation result in a more 

uniform dataset for mapping purposes, ensuring a more accurate mapping process and 

effective mapping product.  The project mapping vendor, California State University – 

Chico, found the use of the DIM in the third round of data collection created efficiencies 

not experienced in earlier rounds. 

 

                                                 
2
  To further facilitate the process, each data tab is color coded to indicate those datasets which are 

mandatory versus voluntary, as well as available help for each field. 
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The DMI’s dynamic, forward-thinking, design gives the NPSC a priceless tool to utilize 

in its endeavors as it strives to provide an accurate picture of the landscape today, while 

maintaining focus in an ever-changing environment, on the visions of tomorrow. 

2.1.3 Fourth Round 

Based upon feedback from the ISPs and the fact that the project mapping vendor, 

California State University – Chico, found the use of the DIM in the third round of data 

collection had created efficiencies not experienced in earlier rounds, the DIM was 

upgraded for Round Four to implement the changes in data fields required by the NTIA.  

When compared with previous rounds the Round 4 DIM reduced the amount of data that 

was being returned to ISPs and allowed the NPSC to provide a longer data submission 

window to the ISPs. Additional improvements to the DIM are being considered for future 

rounds of data collection.  

2.2 Engage ISP Participants  

2.2.1 Workshop 

NPSC and Apex conducted a workshop prior to Round 3 data collection to 

explain how to use the DIM. This workshop was conducted in Lincoln, Nebraska, 

on October 7, 2010. ISPs that could not attend were able to participate via web 

based Live Meeting
©

 

At the workshop NPSC discussed the data collection and mapping issues faced 

during the first two data submissions to the NTIA, the lessons learned, plans for 

the Third Round Data submission and how to use the data submission and review 

tools. Participants were provided a CD containing the DIM for use in collecting 

and submitting the next round of data to the Commission and the ESRI ArcReader 

tool for reviewing their data after processing and before submittal to the NTIA. 

No additional workshops were conducted during Round 4 since there had not 

been any major changes in the method of data collection and the use of 

SharePoint for ISPs to submit data.  

2.2.2 Teleconferences 

The NPSC staff and Apex continued to provide “help-desk” service to the 

broadband providers through teleconferences. During the calls, the NSPC staff 

and Apex gave in depth guidance to provider questions regarding the DIM, 

alternative data submission templates and other inquiries from the providers 

regarding the Nebraska and NTIA projects. In each of these sessions the ISP was 

walked through the process of loading data into the DIM and submitting the data 

to Apex using the SharePoint Portal. 
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2.3 SharePoint Portal for Data and Map 

Apex uses a SharePoint portal to collect data and distribute information to broadband 

providers.  General information and announcements are available to all participating 

providers.  In addition, each provider is assigned a unique password protected folder.  

The provider submits confidential data into the folder.  Apex gathers the submitted data 

from the folders to begin the data processing procedures.  

2.4 Data Scrub using DataSlave 

During Round 3 data submission the NTIA SBDD data model requirements and python 

script (SBDD_CheckSubmission.py Version 1.0) checks were implemented in DataSlave. 

The Python source code was examined and reverse engineered into the DataSlave. ISP 

data submission in the DIM format was processed in DataSlave and fall outs were 

addressed with the individual providers.  

With the improvements in the Round 4 DIM the DataSlave used in Round 3 was not 

needed but remains a tool available for future use if needed. 
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3.0 Community Anchor Institutions 

3.1 Community Anchor Institutions (CAI) 

The method used to collect data consisted of the NPSC sending emails and making 

telephone calls to specific groups that represent Community Anchor Institutions (CAI’s) 

in Nebraska such as: 

 

 Chief Information Officer for Nebraska 

 Nebraska Hospital Association 

 Nebraska Office of Rural Health 

 Nebraska Library Commission 

 Nebraska Information Technology Commission 

 Catholic Health Initiatives and Network Nebraska 

 

These entities provided information on the locations and contact information for 

hospitals, county health departments, libraries and schools including post-secondary 

institutions. Network Nebraska is tasked with implementing legislation designed to 

migrate the past distance learning environment to an IP based system which includes 

scheduling software. The NPSC is represented on the Network Nebraska steering 

committee known as the Collaborative Aggregation Partnership (CAP) and significant 

information on broadband service provided to schools was obtained from Network 

Nebraska data. ISP’s have also provided CAI broadband information.  

 

The primary focus of the NPSC on CAI data during Round 4 was the identification and 

collection of school and Library ID’s. Programmatic efforts resulted in locating the ID 

numbers for 1,259 K-12 and secondary education schools and Library’s. Manual methods 

will be used to locate the ID numbers for the remaining 481 K-12 and secondary 

education schools and Library’s.  

 

The collection of CAI broadband information requires extensive time and effort to send 

initial emails, follow-up emails and place telephone calls. The following analysis is a 

summary of the classification of CAI’s contained in our data set: 

 

Nebraska Round 3 CAI Data Analysis  

1 - School - K through 12 1,487 

2 - Library 91 

3 - Medical/healthcare 147 

4 - Public safety 129 

5 - University, college, other post-secondary 162 

6 - Other community support - government 348 

7 - Other community support - nongovernmental 134 

TOTAL 2,498 
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4.0 Data Validation 

Four validation techniques were developed and implemented for Round 3 data. First, a 

direct in-person survey was conducted by Edison Research (Appendix B). Second, Apex 

developed ProField Drive application to test the wireless signal coverage of major 

wireless broadband providers. Third, Apex conducted phone and mail survey of Nebraska 

residential customers. Finally Apex developed an online speed test, however as discussed 

below, this test was discontinued.  

4.1 Edison’s Sample Methodology Scope 

The sample methodology for the Nebraska broadband study conforms to principles of 

probability sampling. That is, each census block has a known, and measurable, 

probability of being selected. Likewise, each household within a census block has a 

known selection probability. The population consists of all households in Nebraska. The 

sample frame is a list of all census blocks with households (as reported by the 2000 

census) in Nebraska. For additional information on the sample methodology and survey 

refer to Appendix B. 

 

Stratum Sample Census 

Block 

Allocation 

Percent of 

Households 

1 – Douglas County 75 27.3% 

2 – Cass, Lancaster, Sarpy counties   37 22.8% 

3 – Medium Rural/Urban Area  (17 counties) 97 24.7% 

4 – Rural West  (53 counties) 77 13.7% 

5 – Rural East  (18 counties)  57 11.1% 

6 – Thurston County (Indian Reservation)  7 0.3% 

 

 

The in-person survey was conducted in 597 Nebraska census blocks. The survey 

validated ISPs’ supplied information that Broadband service was available in 583 (98%) 

of the survey census blocks. In the remaining 14 (2%) of the census blocks Edison was 

unable to determine if the offered service qualified as a Broadband service per NTIA’s 

definition. 

Validation Methods Wireline Wireless 

ProField - Field Survey  x x 

Drive Test   x 

Phone and Mail Survey  x x 

Online Speed Test  x x 
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4.2 ProField Drive Test 

Apex used two Nebraska residents to perform the Spectrum Drive Test. The hardware 

used included a laptop with 3 nationwide ISP data cards. (AT&T, Verizon and Sprint) 

and customized ProField software.  The route was divided into two regions, Eastern and 

Western Nebraska. A total of over 3,000 road miles were covered during the drive test.  

The ProField application cycles through each ISP card and captured the RSSI value and 

recorded to the database. The data was continuously uploaded to the Database Server. A 

chart of East and West routes along with the validation charts are contained in Appendix 

C.  

The Spectrum drive test was conducted in 5,637 Nebraska census blocks. The drive test 

validated ISPs’ (AT&T, Verizon and Sprint) supplied information that Broadband service 

was available in 5,287 (94%) of the census blocks. In the remaining 350 census blocks 

Apex was unable to determine if the offered service qualified as a Broadband service per 

NTIA’s definition. 

4.3 Mail and Phone Survey 

Apex procured Nebraska resident data from US Data Corporation. Apex selected a 

random sample of residents. The sample was divided into two groups. The first group 

was called over a period of two weeks. The second group received the survey in the mail 

and was asked to complete the survey and return it in a pre-paid envelope. 

 

The sample was selected to complement the in-person Edison survey and the planning 

survey. Census blocks already sampled by the Edison survey and the planning survey 

were excluded from the mail and phone survey. 

 

Mail and phone survey questionnaire collected information that was similar to Edison’s 

in-person survey.  

 

The mail survey was sent to 3,003 Nebraska residents. A total of 506 residents responded 

to the survey, a response rate of 17%. Of the 506 residents, 445 had broadband service. 

The broadband customers resided in 433 unique census blocks. The responses indicated 

that 88% of the residential customers subscribed to a broadband service. The results 

validated ISPs’ submitted data for census blocks with broadband service.
3
  

 

The phone survey contacted 2,500 Nebraska residents in 293 unique census blocks. 

Broadband service was available in 63% of the census blocks. The results matched the 

ISPs’ submitted data for the respective census blocks.  

 

                                                 
3
 A mail survey conducted by the Nebraska Planning group (consisting of the University of Nebraska – 

Lincoln, Nebraska Information and Technology Commission, and the Nebraska Department of Economic 

Development) in February/March 2010 had a response rate of 47% and identified similar broadband 

availability. The complete results of this survey were filed with the NTIA program office in the NPSC 

quarterly report on July 30, 2010.  
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4.4 Online Speed Test 

As a component of verification, the NPSC’s vendor, Apex, initially established an Online 

Speed Test, requesting consumers perform a test to record the speed of their broadband 

connection.  Data collected was to include geographical identifiers, upload and download 

speeds, and latency.  Preliminary review of the testing methodology was conducted by 

Apex. 

In addition to the online availability of the Apex speed test, the NPSC provided a 

disclaimer to participants noting, in part, the irregular variability inherent to measuring 

broadband speed availability at a given time, using a given hardware configuration.  

Further, the NPSC stated, while a speed test may give consumers information on relative 

speed, the test was not endorsed as a definitive testing method. 

Irrespective, subsequent to implementation, the NPSC began fielding numerous 

complaints regarding the testing results from consumers and industry representatives 

alike.  In an independent effort, the NPSC conducted a review of the testing methodology 

and determined the testing results to be inconsistent and unreliable.  Results deviated 

significantly when compared to those obtained utilizing Speedtest.net, owned and 

operated by Ookla, and displayed significant variation across platforms.  Further, the 

results obtained via the Apex Online Speed Test were not consistent with those reported 

by ISPs themselves. 

As such, the NPSC determined it necessary to remove access to the Online Speed Test, 

rather than risk losing the trust and confidence of consumers and the support of the 

industry.   
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5.0 Map Processing 

5.1 CSU – Chico (Appendix A) Map Processing 

As a result of the improvements in the DIM for Round 4 data collection, new data 

process methodologies were used as described in the follow sections.  

5.1.1 Address Submissions 

Internet service providers submit address data in tabular format.  Address records 

are geocoded to the street segment level using E911 reference data.  Matched records are 

preserved as a geographic point layer.  Records not meeting the minimum match 

requirements are selected and exported in tabular format.  Non-matching records are run 

through a second geocoding process using a composite locator built on underlying 

TeleAtlas reference data.  This secondary geocoding process produces match results at 

the street segment level where possible.  Non-matching records are run through a third 

geocoding process using a composite locator built on underlying 2010 Tigerline reference 

data.  This additional geocoding process produces match results at the street segment 

level where possible.  If no qualifying street segment is found the locator will move to a 

secondary level of matching based on city/state.  City/state matches are represented as a 

generalized center point of the geographic area considered to be included or related to 

any city, town, or community within the state.  Street segment and city/sate matches are 

preserved as a geographic point layer.  The two geocoding match result layers are then 

merged to create a single geographic point layer representing all records within the 

submission that were able to be matched with confidence at any particular level.  The 

attribute table of this layer is analyzed to produce a report of how many records were 

matched to each specific locator through both geocoding processes.  The address point 

layer is then run through a spatial relation process against census block polygons in order 

to obtain the appropriate FIPS number for each address point location.  All non-matching 

records are preserved in table format and returned to the provider for review. 

Optionally, Internet service providers submit address data as longitude and 

latitude coordinate pairs in tabular format.  Longitude and latitude coordinate pairs are 

plotted on the map and preserved as geographic point locations.  This layer is then run 

through the same spatial relation process as the geocoded points to obtain the appropriate 

FIPS number for each address point location. 

If a combination of address listings and longitude and latitude coordinate 

information is submitted, the data will be processed accordingly in respect to each data 

type and then combined upon output to create final address output layer. 

5.1.2 Census Blocks from Address Submissions 

Final address result layers are run through a spatial relation process against census 

block polygons.  The resulting output is a polygon format representing all census blocks 

in which each geographic address point resides.  All broadband specific attribution is 

propagated over to the census block polygons from the provider’s final address point 

layer.  Census block polygons are then reviewed in regards to their geographic area.  

Only those census block polygons that are less than two square miles in size are 
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preserved.  All polygons that are greater than two square miles in size are removed.  This 

process can result in duplicate stacked polygon in cases where multiple address points 

fell within the same census block polygon and have the same underlying characteristics 

in regards to broadband data attribution.  Census block polygons are reviewed for 

duplicate records and filtered to preserve unique records only. 

5.1.3 Street Segments from Address Submissions 

Final address result layer is divided into multiple layers specific to technology of 

transmission and speed characteristics.  Each unique class of address is run through 

spatial relation processes along with a street segment line layer to obtain a unique 

identifier for the nearest segment to each individual address point.  Resulting output is 

address point features containing the unique identifier of the closest street segment 

attributed in the address layer’s data table.  A table join is executed appending the 

broadband characteristics of the address data to the street segments.  The appropriate 

street segments are called out and preserved.  An erase operation is then run using the 

provider’s resulting census block polygon layer to remove any street segments that fall 

within service census blocks that are less than two square miles in area.  All remaining 

street segments are preserved to represent service in areas where census blocks are 

greater than two square miles in area. 

5.1.4 Census Block Submissions 

Internet service providers submit census block data in tabular format.  A table join 

is done using census block centroid points to append longitude and latitude coordinates to 

each record in the submitted census block table.  Output is a standalone representing each 

census block submitted by the provider and now contains the longitude and latitude 

coordinates of a point within the relative census block.  This information is used to plot 

coordinate pair events.  The output is a point dataset representing each record submitted 

by the provider.  This point layer is then run through a spatial relation process along with 

the census block polygons.  Output is a polygon layer representing all submitted census 

block records for said provider.  Census block polygons are reviewed for duplicate 

records and filtered to preserve unique records only. 

5.1.5 Census Block Migration – 2000 to 2010 Vintage 

Consistent with Round 3 many internet service providers submit census block 

data using vintage 2000 geography. The U.S. census delivered and supplied a crosswalk 

database to assist in migration of 2000 geography to the equivalent 2010 geography.  

Using this crosswalk a query table is created to properly cross reference FULLFIPSIDS 

between 2000 and 2010 census years.  The output is a polygon layer representing all 2010 

census blocks that are geographically equivalent to the submitted 2000 census block 

records for said provider.  Census block polygons are reviewed for duplicate records and 

filtered to preserve unique records only.  

5.1.6 Street Segment Submissions 

Internet service providers submit street segment data by census block in tabular 

format.  A spatial relation process is run using the submitted census block records to call 

out the specific census blocks in which a provider claims to have service.  The 

appropriate street segments are called out via the census blocks reported, and preserved.  
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An erase operation is then run using the provider’s resulting census block polygon layer 

to remove any street segments that fall within service census blocks that are less than two 

square miles in area.  All remaining street segments are preserved to represent service in 

areas where census blocks are greater than two square miles in geographic area. 

5.1.7 Street Segment Migration – 2000 to 2010 

Consistent with Round 3, many internet service providers submit street segment 

data using vintage 2000 geography.  A spatial relationship process is run using the 

submitted street segment geography to transfer provider data to all street segments within 

50 feet.  This is done to insure that all final output data is Tigerline 2010 street data.  An 

erase operation is then run using the provider’s resulting census block polygon layer to 

remove any street segments that fall within service census blocks that are less than two 

square miles in area.  All remaining street segments are preserved to represent service in 

areas where census blocks are greater than two square miles in geographic area. 

5.1.8 County Overview Submissions 

Internet service providers submit county overview data in tabular format.  A table 

join is done using county centroid points to append longitude and latitude coordinates to 

each record in the submitted census block table.  Output is a standalone representing each 

county submitted by the provider and now contains the longitude and latitude coordinates 

of a point within the relative county.  This information is used to plot coordinate pair 

events.  The output is a point dataset representing each record submitted by the provider.  

This point layer is then run through a spatial relation process along with the county 

polygons.  Output is a polygon layer representing all submitted county records for said 

provider.  County polygons are reviewed for duplicate records and filtered to preserve 

unique records only. 

5.1.9 Middle Mile Submissions 

Internet service providers submit middle mile data as longitude and latitude 

coordinate pairs in tabular format.  Longitude and latitude coordinate pairs are plotted on 

the map and preserved as geographic point locations.  The middle mile point layer is then 

run through a spatial relation process against census block polygons in order to obtain the 

appropriate FIPS number for each middle mile point location. 

5.1.10 Wireless Submissions 

Providers who offer wireless service but could not submit a shapefile or 

geographic representation of their service area give tabular antenna information.  

Wireless antenna parameters are used to model a service area and shapefiles are created 

for each provider. The wireless propagation model is based on the Longley-Rice, 

Irregular Terrain propagation model.  Individual unit specifications are used to measure 

performance based on frequency, transmit power, receiver sensitivity, antenna gain, and 

height.  Signal coverage patterns are produced for each individual unit taking into 

account terrain and vegetation features that may hinder signal dispersion. 
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5.2 Provider Verification 

During Rounds 2 and 3, broadband providers received static PDF maps which proved to 

be a less than adequate tool for the broadband providers to review the submitted data. .  

During Round 3, the project mapping partner produced a preliminary ESRI map file for 

each broadband provider. This changeover allowed the broadband providers to obtain a 

more focused and flexible mapping review product and therefore enhanced the 

confidence of the broadband providers in the mapping process.  Apex and the NPSC staff 

helped the provider community obtain ESRI ArcReader and gave assistance to the 

providers in using the ESRI ArcReaders.  The provider reviewed the map and either 

accepted the map or returned comments regarding any perceived inaccuracies.  Apex, the 

NPSC staff and the provider discussed the comments and, when necessary, made 

corrections to the preliminary maps.   

The use of the ArcReader maps revealed a problem with geocoding results. Too many 

locations were stacked at the centroid of a town or zip code rather than at the correct 

customer site. Apex and the NPSC staff engaged in a detailed analysis of this issue.  

At the same time, the NPSC staff worked with selected providers in a one-on-one labor-

intensive process comparing the submitted data tables to the preliminary maps.  For 

locations that appeared problematic, the providers were able to collect additional 

information to improve the data table.  In some instances, the additional information was 

acquired by driving past a customer location with GPS equipment to obtain the exact 

latitude and longitude of the customer. This improved data was entered into the data 

tables allowing CSU-Chico to revise the providers’ maps.   

ArcReader maps continued to be used in Round 4 as a provider verification tool.  
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6.0 Nebraska Matching Fund 

6.1 E911 Data 

The NPSC’s implementation of enhanced wireless 911 throughout Nebraska required the 

arduous task of designing the framework to initiate, develop, and maintain the robust, and 

invaluable, GIS databases vital and necessary for the provision of enhanced wireless 911.  

These GIS databases are in a standard projection and include; street centerline, depicting 

all public roadways; railways; political boundaries, including city, township, and county; 

areas of interest, including parks, cemeteries, hazardous facilities, power plants and 

substations; water features; fire districts; ambulance districts; law enforcement districts; 

and emergency service boundaries.  

 

Nebraska GIS data for all 93 counties, 77,358 square miles, has been developed and is 

continually maintained; all through funding support provided by the Nebraska Wireless 

E911 Fund.  Nebraska data is housed within the NPSC’s secure on-line statewide GIS 

Data Repository. 

 

The NPSC utilized the data, developed through the Nebraska Wireless E911 Fund, to 

fulfill the matching requirements of the SBDD Grant Program. 

  

Further, during the validation phase of the second round of data collection, the NPSC 

identified broadband unique field enhancements, when applied in addition to the existing 

E911 data, resulted in significant geocoding improvements in many rural areas of 

Nebraska served by smaller ISPs.  The NPSC and the project mapping subcontractor 

worked extensively for several weeks to develop and implement these improvements 

prior to the third round of data collection.  Sample geocoding results analyzed subsequent 

to completion of all enhancements, indicated an average record resolution increase of just 

over 51% in those rural areas.  

 

The project mapping vendor, California State University – Chico, utilized the enhanced 

dataset to develop an Address Locator, unique to Nebraska, which is then used to 

geocode address data provided by ISPs and ultimately submit to the NTIA for the third 

round broadband data submission.   

 

The NPSC will continue to utilize the E911 data resources for address processing and 

geospatial verification throughout the term of the SBDD Grant Program. 
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Appendix - A Mapping Project Partners 

Apex CoVantage LLC  

Apex CoVantage is a private, employee-owned company that has helped businesses to 

develop and execute information and knowledge strategies for more than two decades. 

Apex was a pioneer in offshore knowledge-based solutions and now has more than 2,500 

employees in the US and abroad. Apex is known for developing and improving man-

machine processes that optimally combine human creativity with machine processing 

efficiency, introducing transformative solutions that lead to quantum gains in efficiency.  

Apex is recognized as one of the premier firms in its field, working for clients such as 

AT&T, Exelon, Baltimore Gas and Electric, Qwest, Silver Spring Networks, SMUD, 

Veridian Connections and more.  

California State University (CSU)-Chico 

The Geographical Information Center (GIC) at California State University, 

Chico was established in 1988 to introduce digital mapping and geographical 

information systems (GIS) technology to the Northern California region and to 

provide valuable on-the-job training and employment opportunities for our 

students.  The Center's mission is both academic and service oriented.  With 

numerous research opportunities available throughout California, the growth of 

the GIC has resulted in a renewed University commitment to strengthen ties to the 

Northern California region.   

The GIC employs between 10 and 20 individuals.  The staff includes professionals with 

extensive GIS training mentoring qualified graduates, student assistants and interns.  The 

center runs its own intranet and is connected to the multi-campus CSU-Net, giving it 

state-of-the-art networking capability. 

 

While the center’s primary area of expertise is GIS technology, the GIC also has 

experience in digital orthophoto development, global positioning system (GPS) 

applications, computer cartography, image processing and air photo interpretation.  

 

The GIC has the technical expertise to plan, develop, install, serve and maintain an 

agency’s GIS. It uses ESRI GIS software
 
and can develop a customized ArcGIS training 

workshop to meet an agency’s needs.  Because it is affiliated with California State 

University, Chico, it can draw specialized expertise from the academic community.  The 

center’s contracts are primarily with federal, state and local agencies, but it also serves a 

variety of private sector clients.  Projects are equally split between urban and natural 

resource applications.  Contracts are administered through the California State 

University, Chico Research Foundation.   
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Edison Research 

Edison Research conducts market research and exit polling, providing strategic 

information for businesses and media organizations worldwide. 

With an expertise in both quantitative and qualitative research, Edison works with many 

established corporations looking to keep their edge or expand, as well as young 

companies just starting to develop their businesses. Edison offers expertise in telephone, 

Internet and in-person research as well as focus groups and dial testing. 

Edison Research has been the sole provider of exit poll information to the six major news 

organizations - ABC, CBS, CNN, FOX, NBC and the Associated Press - since 2003. 

Edison has conducted exit polls and collected precinct vote returns to project and analyze 

results for every major primary and the general election in 2004, 2006 and 2008. 

Edison is also the leading provider of consumer exit polling and has conducted face-to-

face research in almost every imaginable venue. Edison Research has conducted research 

at leisure locations (movie theaters, golf courses, health clubs, museums, cruise ships), 

transit locations (airports, subway stations, bus stations, truck stops, school buses, 

parking garages, gas stations), retail establishments (shopping malls, restaurants, stores), 

stadiums/arenas (concerts, sporting events), and many other locations including office 

buildings, conventions/conferences, and medical centers. Our network of more than 

10,000 experienced interviewers allows us to conduct research in almost any location. 

Another specialty for Edison is its work for radio stations throughout the world, 

conducting both strategic and music research for successful stations in North America, 

South America, Europe and Asia. Additionally, Edison conducts research for the U.S. 

Government's broadcasting ventures in the Middle East including "Radio Sawa" and 

"Radio Farda." This research is currently conducted weekly in Abu Dhabi, Egypt, Iraq, 

Jordan, Lebanon and Morocco. 
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Appendix - B  

Strata Sample Methodology 

An in person survey was conducted using personal digital assistants with customized 

software.  The sample included four households or community anchor institutions in each 

selected census block.  The initial phase included 1,400 in person’s interviews.   

Sample Design Overview 

The sample design was a stratified cluster sample. The first layer consisted of six 

strata that encompassed the entirety of Nebraska. The second layer of the design 

consisted of a sample of 350 census blocks. These census blocks were referred to 

as the primary sampling unit (PSU). The third layer of the design was the 

household/community anchor. These locations are known as the secondary 

sampling unit (SSU), or observation unit. 

Stratification 

Six strata encompassing all of Nebraska were created for this sample design. 

These strata were created based on the relative rural/urban nature of the area, the 

cultural makeup of the area and the geographic region of the state. All strata 

boundaries follow county boundary lines. 

 

These strata for Nebraska consist of: 

1. Stratum 1 – Douglas County 

2. Stratum 2 – Cass, Lancaster, Sarpy counties 

3. Stratum 3 – Medium Rural/Urban Area – (17 counties) 

4. Stratum 4 – Rural West – (53 counties) 

5. Stratum 5 – Rural East – (18 counties) 

6. Stratum 6 – Thurston County (Indian Reservation) 

 

Of the sample of 350 census blocks, each strata were allocated a portion of the 

sample. The allocation was an optimal allocation procedure based on the racial 

makeup of each stratum. This means that the strata with greater racial variability 

will be allocated more census blocks than strata with less variability. 

Consequently, heterogeneous strata had more census blocks and homogeneous 

strata had fewer census blocks. This resulted in a more efficient use of the sample 

placing the census blocks where they were most needed. Stratification sample 

allocation and household distribution: 
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Stratum Sample Census 

Block 

Allocation 

Percent of 

Households 

1 – Douglas County 75 27.3% 

2 – Cass, Lancaster, Sarpy counties   37 22.8% 

3 – Medium Rural/Urban Area  (17 counties) 97 24.7% 

4 – Rural West  (53 counties) 77 13.7% 

5 – Rural East  (18 counties)  57 11.1% 

6 – Thurston County (Indian Reservation)  7 0.3% 

 

Primary Sampling Units – Census Blocks 

The primary sampling units was the census block. These census blocks were 

nested within a given stratum. Each census block had a known probability of 

selection based on the number of households that exist within that census block. 

Every census block was contained within a county. Nebraska has many small 

census blocks where the number of completed interviews from 

households/community anchors was less than four (4). In this situation the 

interviewer was instructed to begin sampling at the nearest neighboring census 

block contained within the census block group of the sampled census block. They 

continued interviewing until four interviews are obtained. By keeping the 

interviewer within the census block group this ensured that interviews obtained 

outside the original sampled block were still within the same county and 

consequently the same stratum. 

Secondary Sampling Units – Households/CAI 

Secondary sampling units, households/community anchors, were selected 

systematically within a census block. Community anchor locations were not 

specifically targeted. However, they were included if they fell within the 

systematic selection. The interviewer was given a random starting point within the 

census block. The interviewer proceeded to follow their assigned path and 

interviewing rate until four (4) completed interviews were obtained. 

Conclusion 

This sampling plan resulted in a statistically valid sample. This sampling plan 

consisted of an initial sample of size 350 (up to 425 in the final sample). This 

resulted in a final anticipated statewide margin of error of (+/- 5%). A total of 

1,400 households/community anchors were sampled. The results of this sample 

could be used for further estimation and extrapolation to other census blocks that 

were not part of the final sample. 



6-23 

 

 

 

Edison In-person Survey Questionnaire 

1. Enter census block number (DO  NOT READ): __ __ __ __ 

 

2. Code type of location (DO NOT READ) 

  

Household (Use "household")      1  SKIP TO Q.4  

  Commercial Business (Use "business")    2  

  Other location: ________________ (Use "location")  3  SKIP TO Q.4 

 

3.  What type of business is this? (RECORD EXACT RESPONSE) 

______________________ 

 

 Don’t Know/No Answer 9 

  

4. Does this (ANSWER FROM Q.2) have Internet access? (PROBE: IF UNSURE, ASK IF 

SOMEONE ELSE IS AVAILABLE) 
  

  Yes 1 CONTINUE 

  No 2 SKIP TO Q.10 

  Don’t Know/No one available 9 TERMINATE 

   

5. Which type of Internet access does this (ANSWER FROM Q.2) have? If you are not sure, 

let me know and I can describe the difference between the two. (READ LIST) 
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  Dial-up   1 CODE Q.6 AS “DIAL-UP” & SKIP  

      TO Q.10 
  Broadband   2  CODE Q.6 AS “BROADBAND” &  

      SKIP TO Q.8 
  Both (DO NOT READ)   3 CODE Q.6 AS “BOTH” & SKIP TO  

      Q.8 

  Don’t Know/No Answer (DO NOT READ) 9 CONTINUE 

 

6. Most people who access the Internet do so through dial-up or broadband. A dial-up 

connection is where your computer connects to the Internet using your telephone line.  

  

A broadband connection usually uses a cable modem provided by your cable company or a 

service called DSL.  Broadband connections access the Internet at much faster speeds than a 

dial-up connection, and allow you to always remain connected to the Internet. 

 

Which of these two types of Internet connections does this (ANSWER FROM Q.2) have-- a 

dial-up connection or a broadband connection?  

 

  Dial-up   1 SKIP TO Q.8 

  Broadband   2  SKIP TO Q.8 

  Both (VOLUNTEERED)   3 SKIP TO Q.8 

  Don’t Know/No Answer (DO NOT READ) 9 CONTINUE 

 

7. Is there anyone else who might know whether or not this (ANSWER FROM Q.2) accesses 

the Internet through dial-up or broadband? 

 

  Yes, available  1 ASK FOR THAT PERSON, GO BACK TO Q.5 

  Yes, not available 2 THANK AND TERMINATE 

  No 3 THANK AND TERMINATE 

  Don’t Know/No Answer 4 THANK AND TERMINATE 

 

8. Who is the broadband Internet provider for this (ANSWER FROM Q.2)? (READ LIST) 

(PROBE: IF UNSURE, ASK IF SOMEONE ELSE IS AVAILABLE) 
  

  Insert list of known service providers in the census block entered in Q.1  

  Other: __________________   98     

   

  Don’t Know/No Answer (DO NOT READ) 99     

 

9. Which type of broadband service does your Internet provider supply to this (ANSWER 

FROM Q.2)? (READ LIST) (PROBE: IF UNSURE, ASK IF SOMEONE ELSE IS 

AVAILABLE) 
 

  Cable   1  

  DSL   2   

  Other: ______________   3  

  Don’t Know/No Answer (DO NOT READ) 9  

  

10. Code gender (DO NOT READ)   

 

  Male 1 
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  Female 2 

 

11. Can you please tell me your age? (RECORD EXACT RESPONSE) ________ 

 

12. The last few questions are for classification purposes only. Which of the following best 

describes you? Are you…? 

 

  White 1 

  African-American 2 

  Asian 3 

  Or of some other background? 4  

  Refused/No Answer 9 

 

13. Are you of Hispanic or Latino descent? 

 

  Yes 1 

  No 2  

  Refused/No Answer 9  

 

IF Q.2 CODED "1", CONTINUE, OTHERWISE, SKIP TO NOTE ABOVE Q.17 
  

14. What is the highest level of education achieved by ANYONE in this household? (READ 

LIST) 
  

  High school or less                    1                       

  One to three years of college   2                           

  Four year college degree   3                               

  Some graduate credits   4                                            

  Advanced degree such as MA, MBA or PhD 5                

  Don’t Know/No Answer (DO NOT READ) 9            

 

15. Including yourself, how many adults age 18 or older live in this household?  

 (RECORD EXACT RESPONSE) _______ 

  

16. Is there anyone under the age of 18 living in this household? 

 

  Yes 1 

  No 2  

  Don’t Know/No Answer 9 

 

IF Q.6 CODED "1"/DIAL-UP, SKIP TO Q.18, OTHERWISE, CONTINUE 
 

17. The state of Nebraska would also like to know how fast the broadband connection is in this 

(ANSWER FROM Q.2). Login to the Nebraska speed test web site, enter the ID number 

located on this postcard (SHOW POSTCARD) and it will automatically log your speed. No 

identifying information is captured on the speed test web site. This would be a great help and 

we would appreciate the additional effort.  

 

 UNIQUE ID NUMBER IS GENERATED 

 

 Enter the ID number on to the postcard. Hand it to the respondent. (DO NOT READ) 
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18. In case my supervisor needs to verify that I completed this interview, may I please have your 

first name?  (RECORD EXACT RESPONSE) ______________________ 

 

 Don’t Know/No Answer 9 

 

19. And may I have your phone number or email address? It will ONLY be used if my supervisor 

wants to verify any of the information in this interview. (RECORD EXACT RESPONSE)  

 

  Phone number  (__ __ __) __ __ __ - __ __ __ __  

  E-mail address _____________@________.______ 

 

  Don’t Know/No Answer 9 

 

20. Thank you for your time and cooperation!  

 

21. Enter respondent’s address. (RECORD AFTER YOU HAVE COMPLETED THE 

INTERVIEW) 
 

  Address 1: _________________________________ 

  Address 2: _________________________________ 

  City, State, Zip: Insert city, state and zip code as determined by the census block entered in 

Q.1 
 

Mail Survey Questionnaire  

Your response is important!   Please fill out and promptly mail the Nebraska Broadband 

Mapping Survey. Results from these surveys will be used to map the availability of 

Broadband service for the ENTIRE STATE OF NEBRASKA. Without enough 

completed surveys, your community may not receive its fair share of government funding 

to support the build out of the Broadband network in Nebraska! 

 

 Please mark the appropriate answers to the survey questions below.  

1. Do you have Internet access at your home?  

   Yes (Continue)     No (Skip to Question 5)   

2. Which type of Internet access does your household have? (Mark all that apply) 

   Dial-up  (A dial-up connection is when you will not be able to receive a  

 telephone call using the same telephone line that connects your computer to the 

 Internet.)  

               Broadband  (A broadband connection usually uses a cable modem provided 

 by your cable company or a service called DSL.  Broadband connections access 

 the Internet at much faster speeds than a dial-up connection, and allow you to 

 always remain connected to the Internet.)                

    Don’t Know (Skip to Question 5) 
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3. Who is your broadband Internet provider?      

      _______________________________________ 

4.  Which type of broadband service does your Internet provider supply to your home? 

(Mark all that apply) 

      Cable       DSL 

    Satellite       Other: ________________________ (specify)  

 

5. Gender:           Male      Female   

6. Please provide your exact age:  ___________ 

7. Are you…? (Mark all that apply) 

   White     African-American     Asian        

   Other background   

 

8. Are you of Hispanic or Latino descent? 

    Yes       No 

 

9. What is the highest level of education achieved by anyone in this household? 

  High School or less 

   One to three years of college 

   Four year college degree 

   Some graduate credits 

   Advanced degree such as MA, MBA, or PhD 

 

10. Including you, how many adults age 18 or older live in this household?    

_________________   

 

11. Is there anyone under the age of 18 living in this household? 

      Yes      No    

 

The State of Nebraska would also like to know how fast your broadband connection is. 

Please go to the Nebraska Public Service Commission Web site at 

www.psc.nebraska.gov. Click on “Speed Test”, enter your address and it will 
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automatically log your speed. No identifying information is captured. This would be a 

great help and we would appreciate the additional effort. 

Thank you for your time and cooperation! 

 

Phone Survey Questionnaire 

Please use the script below for Nebraska Broadband Availability Mapping Survey. 

 1. Does your household have Internet access? 

1 _____    Yes    CONTINUE 

2 _____     No    SKIP TO Q.5 

9 _____     Don’t Know (DO NOT READ) SKIP TO Q.5 

 

2A. Which type of Internet access does your household have? If you are not sure, let 

 me know and I can describe the difference between the two. (READ LIST) 

 (PROBE: IF UNSURE, ASK IF SOMEONE ELSE MIGHT KNOW AND IS 

 AVAILABLE) 

 1 _____   Dial-up     SKIP TO Q.5 

2 _____   OR Broadband   SKIP TO Q.3 

3 _____   Both (DO NOT READ)  SKIP TO Q.3 

9 _____   Don’t Know (DO NOT READ) CONTINUE TO Q.2B 

 

2B. Most people who access the Internet do so through dial-up or broadband. A dial-

 up connection is when you will not be able to receive a telephone call using the 

 same telephone line that connects your computer to the Internet.  

 A broadband connection usually uses a cable modem provided by your cable 

 company or a service called DSL.  Broadband connections access the Internet at 

 much faster speeds than a dial-up connection, and allow you to always remain 

 connected to the Internet. 

 Which of these two types of Internet connections do you have -- a dial-up 

 connection or a broadband connection?  

1 _____   Dial-up     SKIP TO Q.5 

2 _____   OR Broadband 

3 _____   Both (DO NOT READ) 

 

3. Who is your broadband Internet provider? (PROBE: IF UNSURE, ASK IF 

 SOMEONE ELSE MIGHT  KNOW AND IS AVAILABLE) 
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  __________________ If it was left blank, leave the cell blank. 

   

 9______  Don’t Know/No Answer (DO NOT READ) 

 

 

4. Which type of broadband service does your Internet provider supply to your 

 home? (PROBE: IF  UNSURE, ASK IF SOMEONE ELSE MIGHT KNOW 

 AND IS AVAILABLE) (ACCEPT MULTIPLE RESPONSES) 

1 _____   Cable  

2 _____   DSL 

3 _____   Satellite  

4 _____   Other: _____________________________ (RECORD EXACT 

RESPONSE) 

 

5. Gender of the Resident answering the Survey (DO NOT READ, BUT USE 

 VOICE AND NAME TO RECORD GENDER) 

 

1 _____   Male  

2 _____   Female 

 

6. Can you please tell me your age? (RECORD EXACT RESPONSE) ________ 

   

 NA ______  No Answer (DO NOT READ)  

 

7. The last few questions are for classification purposes only.  Which of the 

 following bests describes you?  Are  you…? 

1 _____   White 

2 _____   African-American 

3 _____   Asian 

4 _____   Other background 

9 _____   No Answer (DO NOT READ) 
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8. Are you of Hispanic or Latino descent? 

1 _____   Yes 

2 _____    No 

9 _____    No Answer (DO NOT READ) 

 

9. What is the highest level of education achieved by anyone in this household? 

 (ACCEPT MULTIPLE RESPONSES) 

1 _____   High School or less 

2 _____   One to three years of college 

3 _____   Four year college degree 

4 _____   Some graduate credits 

5 _____   Advanced degree such as MA, MBA, or PhD 

 9 _____    No Answer (DO NOT READ) 

 

10. Including yourself, how many adults age 18 or older live in this household? 

 (RECORD EXACT RESPONSE) ________ 

 NA _____    No Answer (DO NOT READ)  

  

11. Is there anyone under the age of 18 living in this household? 

1 _____   Yes 

2 _____   No 

9 _____    No Answer (DO NOT READ) 

 

12. The State of Nebraska would also like to know how fast your broadband 

 connection is. Go to the Nebraska Public Service Commission Web site at 

 www.psc.nebraska.gov. Click on “Speed Test”, enter your address and it will 

 automatically log your speed. No identifying information is captured. This would 

 be a great help and NPSC would appreciate the additional effort.  

 

 Thank you for your time and cooperation! 
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Appendix - C Spectrum Drive Test 

ProField Drive Test  
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Results from Drive Test 

 

http://coverage.sprint.com/IMPACT.jsp?ECID=vanity:coverage 

 

http://coverage.sprint.com/IMPACT.jsp?ECID=vanity:coverage
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http://www.verizonwireless.com/wireless-coverage-area-map.shtml 

http://www.verizonwireless.com/wireless-coverage-area-map.shtml
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http://www.wireless.att.com/coverageviewer/#?type=data 

 

http://www.wireless.att.com/coverageviewer/#?type=data
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Appendix - D Access Database 

All information regarding Nebraska Broadband Project is available in an Access 

database. The database tracks the details such as ISP submission filings and 

contacts,  

 

 

The ISP details table contains information regarding FRN, Business Name & 

DBA.  It is possible to search the table by field  
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Add New ISP: 

            Click on add  button to generate the add 

formpopulate the form with ISP data and press the 

save  button. 

 

 

 

 

View ISP details: 

            Double click ISP details in list view or select 

the ISP from the list view and press view  button. 
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Edit ISP details: 

              To edit the ISP details, select the ISP from 

the list view and press view  button Edit the ISP 

form and press save  button.  

 

 

 

 

 

 

 

 

Delete ISP: 

To delete an ISP details, select ISP from the list view and press delete  button. 

  

 

NDA: 

To view the NDA details for an ISP select the ISP from the list view and press NDA 

button. Click on open  NDA button to view the NDA scanned document. 
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ISP Data:  

To get the ISP Broadband Data we need to select ISP from the list view and press ISP 

Data ,then Broadband Data form opened. Using this module we can Add, Edit & View 

ISP Broadband Data & Data Tracking details of each round of data.  

 

 

Add Broadband Data: 

Click on “Add ISP Data”  button. Broadband Data form will be opened. You 

need to fill the required fields and press save  button. 
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View Broadband Data: 

Double click ISP round data in list view or select the round data from the list view and 

press view  button. You can view all details as shown below.  

 

Edit Broadband Data: 

Select the round data which you want to edit from the list view and press  

button. Update the data and press save button. 
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Export Broadband Data: 

Click on the export  button to export ISP Broadband Data to excel. 

Add & Edit Data Tracking:  

The number of records in “Geo Database” submitted by the ISP will be updated in 

Data Tracking module for each round of data. Select the round from the list view 

and click on Data Tracking  button. The Data Tracking form will be opened. 

Update the values and press save button. 
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Notes: 

Add or view notes by selecting the ISP from the list view and press the Notes  button. 

Click the notes button you will get a message “Press Yes to add notes, No to view notes” 

as show below. 

 

If you press “Yes”, the Notes form will be displayed. Key in values and press the save 

button. 

 

If you press “No”, Notes form will be displayed. You can view all the notes by pressing 

navigation  buttons. 

 

Calling Module 

 ISSUES IN SUBMITTED DATA: - If we have any issues with the data we need 

to select this option and add the missing data details in the comments. So that 

when we generate the daily status thes comments will be displayed. 

 ISP COMMENTS: - If ISP’s give any comments we need to select this. 

 ACQUIRED BY: - If ISP acquired by any other ISP’s we need to add a note by 

select this. So that when we generate the daily status this comments will be 

displayed. 

For Exp: - Galaxy (FRN:0005921713) has been acquired by Zito Media (FRN 

0020111225) 
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 NOTES:-if you want to add any notes select this as a calling module 

 

Export to Excel 

To export the ISP details to Excel by press export  button. 

Click on the Contact details, to see the below contact details form.  It is also possible to 

search contact details by FRN, Business Name & DBA and press the search  button. 
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Add Contacts: 

Click on add contact button. The Contacts form will be opened.   

 

Click FRN button and the Find form will be opened. Select the FRN from the list and 

press Ok button as shown below. Key in First, Last name, etc and click save button. 

  

Edit Contacts: 

Select contact person from the list view and press edit  button. Update the data 

and press save button. 
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View Contacts: 

Double click contact person in list view or select the contact person and press view  

button. 

  

Delete Contacts: 

Select contact person whom you want to delete from the list view and press delete  

button. 

Export to Excel: 

You can even export the Contact details to excel by pressing export  button. 
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Notes: 

To add or view notes, select the contact person from the list view and press the 

Notes  button.  Clicking the notes button and the following message is shown 

 

If you press “Yes”, the Notes form will be displayed. Key in values and press the 

save button. 

 

If you press “No”, the Notes form will be displayed. You can view all the notes 

by pressing navigation  buttons. 

In access database main form there is a report option. Seven reports are available 

as shown below. Select ISP data round and click on the report name.  
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Appendix - E DataSlave 

DataSlave™ (used in Round 3) is an award winning Windows product designed to help you 

validate, de-duplicate and transform your data. Quickly move data from in and out of your 

business applications.   

        Migrate data from one system to another 

   Import leads into your marketing system 

   
Validate and correct key data. Includes comprehensive data 

transformation tools.  

DataSlave provides a graphical tool to import, validate, transform and export data.  

At all times the data can be reviewed in the data panel showing rows that pass validation and 

those that fail. 

Any column can be validated to check, for example, 

- The customer ID is in range  

- The Contact Name is valid 

- The Region is not missing 

- The ZIP code is of correct format 

- The Phone and Fax numbers are correctly formatted 

Data can be mapped onto the fields of your database, and where required, transformed. 

In this case the Contact Name is split into separate FirstName and LastName fields 

Validation of Feature Class in DataSlave 

a) BB_Service_Address. 

b) BB_ConnectionPoint_MiddleMile. 

c) BB_ConnectionPoint_LastMile. 

d) BB_Service_CAInstitutions. 

e) BB_Service_CensusBlock. 

f) BB_Service_RoadSegment. 

g) BB_Service_Overview. 

h) BB_Service_Wireless. 

i) BB_Wireless_Antenna 

Steps in DataSlave 

a) Go to “File” menu, click on “Open Map” and the “Open” dialog 

will be shown, open the file named “BB_Service_Address.dbm”, for 

validate “BB_Service_Address” tab data. The BB_Service_Address Map 

file was open as shown below. 
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b) Click on the “Address” button for select the file data file 

 

c) Then “File Location” dialog box will apprise as shown below. 

There  select the path of the address file  to be validated. Then press Next 

button.   

 

 

d) “Record Source” dialog box will apprise as shown below. Select 

the worksheet. Then press the Next button. 
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e) Preview dialog box will apprise as shown below. Then press the 

Finish button.  Once you click on the Finish button you will get the 

message box asking “Execute Valid Data?” as shown below, press the 

“No” button. 
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f) Click the double arrow button  on the toolbar to start validating 

all the Address Data files. 

g) A summary of the results of the validation will appear in the 

“Output” area at the bottom. Invalid records are written to a log file called 

“Address Data Invalid.log” in the ISP Data directory. Valid records are 

written to “Address Data Valid.csv”.  

h) If you want to see the validation rules for the 

“BB_Service_Address. dbm”, click on the “Validate Rules” button as 

shown below. 

 

i) See the validation rule for the “BB_Service_Address.dbm” as 

shown below. It is possible to “Add or Delete or Edit” any rules from here. 

 

j) To preview the validation status for each record, click on the 

“Preview” button. 
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k) To check if any record failed the validation checks, the application 

will mark error ( sign.) to the value as shown in the below snapshot.  

  



New Hampshire Broadband Mapping and Planning Program 
University of New Hampshire 

September 2011 Data Submission 
 
I.   Data Description 
 
In accordance with the effective NTIA guidance for Round 4 data submissions, the New 
Hampshire Broadband Mapping and Planning Program (NHBMPP) submitted the data set 
described below and associated documents to NTIA in September of 2011. 
 
NH_SBDD_2011_09_30.gdb – file geodatabase containing feature classes for: 
 

Feature Class Number of 
Records 

BB_ConnectionPoint_LastMile 0  
BB_ConnectionPoint_MiddleMile 109  
BB_Service_Address 17 
BB_Service_CAInstitutions 3,778 
BB_Service_CensusBlock 95,452 
BB_Service_Overview 0  
BB_Service_RoadSegment 33,770 
BB_Service_Wireless 37  
State_Boundary 1 

 
In total, almost 133,200 individual data records on broadband availability were submitted by 
New Hampshire.  Collectively, these records describe availability as reported by 39 broadband 
providers in the state, representing an increase of 8 participating providers from the Spring 2011 
submission.   In addition, the NHBMPP submitted data on 3,778 community anchor institutions, 
an increase of 402 records from the prior submission.   
 
II.   Provider Participation 
 
The NHBMPP has identified 63 broadband providers in the state.   As noted above, 39 of these 
providers actively participated in the program for the Fall 2011 cycle.  The participating 
providers include: 
 

Provider Name Technology 
1. Argent Communications* Cable, Fixed Wireless 
2. AT&T Mobility LLC Mobile Wireless 
3. Charter Ring Communications Cable 
4. Comcast Cable Communications, LLC. Cable 
5. Covad Communications Company DSL, Middle Mile 
6. Cyberpine Cooperative, Inc.* Fixed Wireless 
7. Dunbarton Telephone Company, Inc.* DSL 
8. Earthlink Business (aka One 

Communications) 
DSL, Middle Mile 

9. FairPoint Communications, Inc. DSL 



10. Freedom Ring Communications, LLC. (dba 
BayRing Communications)* 

Middle Mile 

11. G4 DSL, Middle Mile 
12. Granite State Communications (aka Granite 

State Telephone)* 
DSL, Fiber 

13. Great Auk Wireless** Fixed Wireless 
14. GWI (aka  Biddeford Internet Corporation) DSL 
15. HughesNet Satellite 
16. IAMNOW.net Fixed Wireless 
17. Lakes Region Wireless Fixed Wireless 
18. Level 3 Communications Fiber, Middle Mile 
19. Lightower Fiber Networks* Middle Mile 
20. MetroCast* Cable 
21. OTT Communications DSL, Middle Mile 
22. Oxford Networks* Middle Mile 
23. Sidera Networks, LLC Middle Mile 
24. SkiSat* Cable 
25. Sovernet Communications* DSL 
26. Spectra Access Middle Mile 
27. Sprint Mobile Wireless 
28. StarBand Communications, Inc. Satellite 
29. Tamworth Wireless Cooperative* Fixed Wireless 
30. TDS Telecom DSL, Fiber, Middle Mile 
31. Time Warner Cable Cable 
32. T-Mobile Mobile Wireless 

33. Topsham Communications* Fiber 

34. U.S. Cellular Mobile Wireless 
35. Verizon Wireless Mobile Wireless 
36. Wave Comm, LLC Fixed Wireless 
37. WildBlue Satellite 
38. Wireless LINC of NH and VT (f/k/a NCIC) Fixed Wireless 
39. WiValley Fixed Wireless 

 
* Provider did not submit revised data for this round.  Data collected for the March, 2011 submission was 
reported as still being effective.  All previously submitted data was reprocessed using Census 2010 geography. 
 
** Provider’s data submission was incomplete or contained errors.  Consequently, data included in NHBMPP 
submission represents only part of their coverage footprint. 
 

The following 14 providers were identified during prior data submission rounds, but have 
remained unresponsive to multiple requests to participate in the NHBMPP. 
 

Provider Name 
1. Boston Telephone 2. Broadview Networks  
3. CityVoice 4. DSCI 
5. ITLLC (f/k/a Russet Communications) 6. NCIA  
7. NHvt 8. Qwest Communications 



9. RadiusNorth 10. segTel, Inc. 
11. SkyWireWifi (f/k/a Akers Pond) 12. telJet 
13. The Granite Connection 14. Turnpike Technologies 

 
Finally, the 7 providers listed below were identified during the current submission round from 
analysis of the FCC Form 477 data (filings through February, 2011). The NHBMPP has contacted 
these providers, but to this date the providers have either been unresponsive or data has not 
been received.   
 

Provider Name 
1. Airespring, Inc. 2. BergNet 
3. Global Crossing North America, Inc. 4. New Edge Network, Inc. 
5. NextWave Wireless, Inc. 6. PaeTec Communications 
7. Telovations, Inc.  

 
The NHBMPP is continuing its efforts to identify active service providers in the state beyond 
those listed above.  Preliminary review of speed tests submitted through the project web site 
has identified additional providers that may be offering broadband service but are not yet 
represented in our current listings. Additional analysis will be conducted to identify which of the 
recorded entities represents new providers, and not providers doing-business-as a currently 
identified provider, providers operating private networks, out-of-state cellular service providers, 
and/or providers that are a remnant of mergers. 
 
III.   Data Collection and Integration 
 
A. Primary Data Collection 
 
Data Acquisition 
Primary data was collected directly from the service providers.  The NHBMPP first developed a 
set of guidance documents based on NTIA specifications, and distributed those to the individual 
providers.  Once the guidance was disseminated, NHBMPP staff followed up with providers via 
phone/email to encourage participation and address questions, as required.  Typically, multiple 
communications were required to ensure a complete data submission was received. 
 
Data Pre-Processing 
To support the data mapping and integration efforts, the following base data sets were acquired 
and/or retrieved from the NH GRANIT state GIS clearinghouse archives: 

• State and town boundaries (based on 1:24,000 USGS DLG files); 

• 2001 Land Cover data set (derived from Landsat TM imagery); 

• 2010 TIGER Census Blocks;  

• 2010 Census MAF/TIGER Road Segments;  and 

• 2009 USGS National Elevation Data set (NED). 



All required NTIA fields were added to the census block and road segment data sets.  In 
addition, the road segments were processed against the census blocks to populate two fields 
used internally – the left block ID and the right block ID associated with each road segment. 
 
Data Processing and Integration 
The broadband availability data was processed and integrated using a suite of GIS tools and 
procedures, depending upon the format and content of the data submitted by the individual 
providers.  Generally, the processing involved executing one or more of the following steps: 
 

• Scanning and georeferencing paper maps and using the results as a visual reference 
to select out corresponding features from the project base data sets. 

• Geocoding addresses using both an internal locator based on the TIGER road 
segments, and where required, the ESRI TA_BatchAddress_US subscription service; 
where NDAs were in place, geocoded points were then used to identify the host 
census block (if <=  2 sq. mi.), or the TIGER road segment in closest proximity but 
within 500’  (if the host census block was > 2 sq. mi.).   Related note(s): 
o In some cases, the selection of the TIGER road segment in closest proximity to 

the geocoded point yielded a pattern of disconnected road segments with 
broadband service. 

• Using ArcGIS Network Analyst to select road segments within a cumulative distance 
of 18,000 lineal feet from central office locations. The selected segments were 
subsequently used to identify adjacent census blocks <= 2 sq. mi. or used as features 
to quantify coverage along census blocks > 2 sq. mi. 

• Processing KMZ image files, using the bounding rectangle to establish interior 
georeferencing, and then converting the georeferenced image to polygons. 

• Utilizing Cellular Expert ArcGIS extension to generate a signal prediction surface for 
wireless providers submitting antenna locations (and associated data).  Related 
note(s): 
o Working with UNC-Raleigh and a NH-based fixed-wireless provider, the data 

processing models previously utilized were refined to take into consideration 
visibility parameters (in addition to vegetation and topography). 

o A -86 DB threshhold was used to define service areas of fixed-wireless 
providers. 

o In processing the fixed-wireless polygon data, exterior polygons,  e.g. those 
outside of the main coverage footprint, that were  < .125 sq. mi. were 
eliminated.   Interior non-coverage polygons were not eliminated. 

• Processing satellite coverage footprints to incorporate the Utah shadow analysis (as 
posted on PBWorks). 

 
Data Processing Issues 
The NHBMPP encountered a number of issues in processing the broadband data for the state.  
These include: 
 

• Most providers submitted data only on areas that are currently served, and not on 
areas that could be served following the NTIA guidance.  This contributed to the 
pattern of occasional disconnected rural road segments with broadband service. 



• Reliance on the TIGER road segments likely yielded overstated broadband coverage 
in rural areas.  A single rural customer address, when geocoded, could result in a long 
street segment being selected as part of a provider’s coverage area.   

• Most providers did not submit typical speed data.  As the volume of our speed test 
data set grows, we will explore using this information to estimate typical speeds. 

• Fixed wireless providers frequently did not deliver the full set of antenna parameters 
required for the signal propagation software, and required multiple requests for data 
followed by requests for clarification of those data submitted.  In some cases, data 
was missing on exact antenna patterns (which in some instances was also 
unavailable from the antenna manufacturer), and/or on detailed power information 
specific to an antenna (e.g. power information provided on the host tower only).  In 
these situations, default values were used to run the software.  As reported in the 
previous section, our refinement of the data processing models has yielded improved 
results despite missing detailed power information. 

• Elevation data submitted by middle mile providers was typically reported relative to 
sea level, not relative to grade. 

• Providers who are knowledgeable and experienced with the original 2009 NTIA NOFA 
and corresponding clarification documentation provided information appropriate to 
that data schema / model, and modifications to these in June 2011 resulted in 
additional follow-up required to achieve a complete data submission. 

• Migration to the 2010 census data provided some processing challenges.  
Crosswalking strictly via attributes tables between the 2000 and 2010 vintage data 
sets was difficult, as we encountered cases where sections of 2000 census blocks 
were appended/split into 2010 blocks.   As a result, the NHBMPP opted to use spatial 
overlays rather than a crosswalking approach to convert provider data reported 
based on 2000 geometry to the 2010 standard.   All data submitted to NTIA in the 
Fall 2011 data round was processed against 2010 geometry (census blocks and road 
segments), regardless of whether the provider submitted data previously or 
delivered updated information for this submission. 

• As a result of reprocessing the data against 2010 geometry, coverage footprints 
occasionally changed even when providers did not report new data.  Some blocks 
that were formerly greater than 2 square miles were split into smaller census blocks, 
resulting in coverage that was previously reported in the road segment feature class 
now being reported in the census block feature class.  The opposite situation also 
occurred, in that some formerly smaller census blocks expanded to cover an area 
larger than 2 square miles, resulting in the data being reported at the census block 
level rather than the road segment level. 

• For providers who submitted address records, the first process was to geocode those 
addresses to the 2010 TIGER road segments.  For any ungeocoded addresses, the 
program next utilized ESRI’s online geocoding services.  Any remaining, ungeocoded 
records were geocoded manually using Bing.  In some instances, records continued 
to remain uncoded after this three-phase approach.  We have identified a number of 
issues with some of the resulting geocoded data:  
o In reviewing addresses geocoded against ESRI services, we discovered a small 

number of records that did not appear to be correctly positioned.  The incorrect 
positioning was confirmed by viewing the geocoded points relative to both 
TIGER road data and by referencing Bing.  In some instances, the geocoded 



points were positioned a significant distance away from any mapped road 
segment.   A proximity analysis with a 500’ distance constraint was used to 
identify the closest road in these instances. 

o Finally, some geocoded results were mapped in a town other than the town 
identified by the provider in their address records.  In most instances the 
geocoded result was to a neighboring town and was within .1 miles of the 
recorded town.  The NHBMPP retained the geocoded locations and notified the 
provider of these discrepancies. 

• For speeds reported by providers in ranges, e.g. 4G LTE, the speed tier reported was 
selected to include the upper end of the range. 

• Some fixed wireless providers continue to report minimum download speeds < 768 
kbps, e.g. outside of the NTIA domain, but maximum download speeds within NTIA 
speed tier domain values.  In these instances, the NHBMPP reported the data based 
on the maximum speed reported. 

 
B. Community Anchor Institutions 
 
Data was submitted for 3,778 Community Anchor Institutions (CAIs) in the state covering the full 
range of categories established by NTIA, as follows: 

 
Category Number of 

CAIs 
Percent of 

Total 
1.  School – K through 12 770 20.4% 
2.  Library 774 20.5% 
3.  Medical/health care 808 21.4% 
4.  Public safety 566 15.0% 
5.  University, college, other post-secondary 65 1.7% 
6.  Other community support – government 745 19.7% 
7.  Other community support – non governmental 50 1.3% 
TOTAL 3,778 100.0% 

 
In this data collection and maintenance round, the collection was largely accomplished by the 
nine regional planning commissions in New Hampshire, with the Upper Valley Lake Sunapee 
Regional Planning Commission (UVLSRPC) & NHBMPP staff at the University responsible for 
developing guidance, for overseeing collection, and for compiling the resulting regional data sets 
into a standardized statewide layer.  The primary steps in the process included: 
 

• Develop a master list of CAIs by category that were not inventoried in previous 
rounds through review of updated statewide lists (schools, libraries, health care 
facilities), existing GIS data sets (largely from local hazard mitigation plans), and local 
knowledge; 

• Develop a list of previously identified CAIs with incomplete broadband information; 
• Contact those entities to collect their broadband details using an email outreach 

methodology, as well as phone surveys; 
• Map the location of each unmapped CAI, using existing GIS data sets, reference to 

aerial imagery, property boundaries, web research, and field data collection where 
necessary; 



• Verify data (see verification section below). 
 

IV.   Validation 
 
A.  Primary Data Collection 
 
The NHBMPP utilized multiple processes to verify the broadband provider data collected during 
the current round.   First, the NHBMPP continued to use local knowledge to conduct an internal 
analysis of the reasonableness and consistency of our mapping results.   Significant 
overstatements or understatements of service areas resulting from internal processing issues 
were readily identified and addressed. 
 
Secondly, the Fall 2011 feedback loop with providers was more robust than prior rounds, largely 
due to increased effort on the part of program staff to solicit comment and the strong 
relationship now established between the providers and program staff.   Unlike in the previous 
round where feedback/verification was primarily implemented in cases where the provider 
delivered non-geographic data, this round’s efforts engaged  all providers, including those who 
did not submit new data. The NHBMPP returned maps (.pdf files) to each provider for review 
and correction.  Where providers delivered addresses or road segments, the product returned 
was a geographically referenced version of the data that was submitted.  For wireless providers 
who delivered antenna locations and specifications, the program provided maps that displayed 
the modeled coverage area generated from the Cellular Expert signal propagation modeling 
software.  Some providers requested the data verification information be provided in shapefile 
and/or Google Earth (.kmz) format.  The process was successful in identifying several significant 
errors/omissions, e.g. in one instance, a provider identified that their data vendor incorrectly 
processed the coverage information and required them to resubmit their data for inclusion in 
the NHBMPP.   
 
Thirdly, the NHBMPP utilized FCC Form 477 filings (through February, 2011) to support the 
verification of provider coverage areas.  Analysis of tracts reported as being served by each 
provider against those developed from the provider’s submission allowed for verification and 
validation of service areas.  There were some instances where a provider’s FCC report indicated 
a greater footprint than indicated by their data submission, and this information was relayed 
back to the provider during the data review period.  In two cases to date, providers identified 
that their FCC Form 477 was incorrect and would require updating due to the NHBMPP mapping 
and verification efforts. 
 
The NHBMPP also verified the “reasonableness” of data by comparing current coverage 
footprints to those reported during the prior round.  This allowed us to identify areas where 
significantly greater (or reduced) service areas were mapped, and to communicate these 
findings to the provider for verification. 
 
Other verification measures included: 
 

• Speed test – The NHBMPP program has posted a customized speed test on the 
project web site (iwantbroadbandnh.org).  To date, approximately 4,000 records 
have been submitted.  We have processed those data to generate speed result 
summaries and the locations from which the tests were conducted.  Through further 



analysis of the speed tests  focusing on reported providers, the program will 
compare the service identified to the provider’s reported coverage area to ensure 
there are not areas unreported, and/or areas where speed test results represent a 
significant deviation from  the reported speed tier.   
 

• Broadband survey – The NHBMPP website also hosts an online broadband survey, 
encouraging users to report their broadband access (or lack thereof) at the address 
level.  The address submitted is then geocoded, which delivers a means of verifying 
provider coverage data at specific locations.  (The survey is also linked to the speed 
test, so that users completing the form are asked to take the speed test as well.)  To 
date, 324 surveys have been completed.   

• Satellite dish survey – The NHBMPP has completed a drive-by inventory of satellite 
dishes in selected rural areas of the state, under the premise that a cluster of 
buildings with satellite broadband dishes signifies an area with no other broadband 
options available.   This information has been utilized as part of the internal data 
review cycle. 

 
B.  Community Anchor Institutions 

The CAI data has been subjected to several rounds of verification during this and previous data 
submission cycles.  An initial round of verification was completed in May, 2010 by re-
interviewing a randomly selected subset of CAI contacts (20% of the entities within each of the 7 
data categories).  Subsequent verification rounds, including one conducted during July/August 
of 2011, were accomplished by generating a broadband profile sheet for each CAI, emailing that 
to each CAI contact for review, and modifying the CAI record based on any updates returned.  
Over 275 responses were received, and those updates were incorporated in the data set prior to 
the Fall 2011 submission. 
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Data Processing: Collection, Reception, Loading, Validation 
This document presents a description of the process used by the New Jersey Office of Information Technology (OIT) and 
Telcordia Technologies to collect, receive, load, validate and verify broadband availability and usage data submitted to us by 
wireless and wireline service providers, CAIs, and other sources and organizations for the State of New Jersey.  Individual 
provider data reports attached hereto provide details on each provider’s submission and explain how the policies presented in 
this document were applied to the data. The CAI summary report, also attached, provides details on the CAI data processing.  
This report also describes some of the complexities and challenges we have encountered to date in this project. 

 

1 Structure of this Report 
This methodology report consists of the following 

o Section 2 summarizes our outreach efforts to collect data 
• This section also describes some of the challenges in determining what service providers are in and out of 

scope for this work and our approach to service provider categorization, in addition to summarizing our 
efforts to engage CAI constituencies 

o Section 3 provides an overview of our process for Service Provider Data Reception 
o Section 4 provides an overview of our process for Service Provider Data Loading 
o Section 5 provides an overview of our process for Data Validation 

• This section includes a table of business rules and how they were implemented. 
o Section 6 provides additional details on two issues related to Geometry 
o Appendix A: NJ Provider Data Reports    

• This appendix concatenates 36 files in Microsoft Word format, one file for each provider whose data was 
included in the submission.  Each report provides a narrative describing the steps involved in collecting, 
verifying, loading, and validating the provider data, including a log of the interactions with the provider. 

o Appendix B:  CAI Processing Report 
• This is a summary of the details of the CAI processing for this submission. 

 

2 Data Outreach 

2.1 Provider Data Outreach  
Telcordia and OIT have conducted further outreach this summer to identify additional potential resellers as well as providers 
not previously participating.  We have used web searches and email and telephone contact to investigate the status of these 
organizations with respect to the NOFA definitions and the goals of this project.    OIT will negotiate NDAs with those 
providers who request them.  Providers are given instructions on data requirements, including how to submit via our custom-
designed Web site found at http://connectingnj.state.nj.us/.  

Most providers were willing to participate, although several have expressed concerns about the burdens of the data collection 
process.  One provider – Hotwire Communications – previously declined to devote any effort to submitting data.  The large 
national providers clearly have processes in place to collect and submit data, while the small local providers require greater 
assistance.  Telcordia offers assistance where possible, allowing providers to submit whatever data they have available in any 
convenient format. This increases the complexity of the data collection and processing operations, but enables greater 
coverage of providers. As examples, some smaller wireline providers simply submitted a list of addresses where they offer 
service and some small cable operators submitted the names of the municipalities they cover.   
 

o In this round we have submitted availability data from 35 facilities-based providers plus one reseller, including five 
organizations that are new to our program this round (Clearwire, Level 2, NetCarrier Telecom, and Network Billing 
Systems are new providers and New Edge Networks dba Earthlink Business is a new reseller).  We also continued to 
include the three satellite providers whose data we first submitted in April (i.e., Hughes, Starband and Wildblue).  
Our initial company list at the onset of this project came from FCC aggregate Form-477 data that we receive under 
the Form-477 sharing arrangement.  We have been subsequently working to expand this list by screening other 
potential providers and resellers. In addition we have been tracking the evolution of the provider community over 



NJ September 2011 Submission / Page 3 

time – this includes mergers and acquisitions among organizations as well as organizations that expand their region 
of operation and go in or out of business. 

o There are numerous web-based sources and aggregators that provide information on potential broadband service 
providers and resellers. As just one example, the Broadband Internet Directory (http://broadband.theispguide.com/ ) 
is a consumer website that lists broadband offerings and plans.  Other examples are www.dslone.net/nj, 
www.globalspec.com, www.broadbandinfo.com, etc.  We periodically review these sources to identify organizations 
that may be relevant for this program.  

o The broadband industry is dynamic with mergers and acquisitions taking place regularly.  We track the 
consolidation of entities, among other reasons, because the availability data may not reflect the larger organization 
for some time after the closure of the transaction.  Some of the transactions we are currently tracking include:  
PaeTec acquisition of Cavalier; CenturyLink acquisitions of Qwest and Savvis; MegaPath acquisitions of Covad and 
Speakeasy; Earthlink acquisition of One Communications; Appia Services acquisition of Voxitas; etc. 

o On the reseller front, there is a wide range of entities that fit rather differently into this program, ranging from 
resellers like New Edge Networks whose data is included in this submission to MetTel who does not maintain 
engineering data about customer service technologies.  We would also like to note that Global Crossing was very 
responsive to our outreach.  As a facilities-based provider who does not meet the 7-10 service provision window, 
however, they do not meet the NOFA definition. 
 

2.2 Service Provider Classification 
We have classified Service Providers into the four categories as follows: 

Type 1 = Broadband 
These are broadband providers that meet the NOFA definition of a facilities-based provider with a 7-10 service provision 
time frame. 

Type 2 = Reseller 
These are broadband providers who do not meet the NOFA definition of a facilities-based provider because they resell 
facilities that belong to another service provider.    

Type 3= Other 
These are broadband providers who are known not to be of Type 1 or Type 2.  Typically this is either because they cannot 
meet the 7-10 day service provision time frame or because their service architecture is complex and is neither facilities-based 
nor a reseller.   

Type 4 = N/A 
We are not currently using Type 4. 

Since it is only Type 1 providers who are squarely in scope for this program, these are the only ones for whom we have 
ensured that the NDA, provider_ind and submit_ind columns in the service_provider_info spreadsheet are completed.   Our 
rationale for this is the following -- we would not want to categorize a non-Type-1 organization as “will not provide data” or 
“non-responsive” under provider_ind, as this may appear pejorative. 

In our ongoing efforts to reach out to the full set of broadband service providers in New Jersey, we work to identify potential 
providers and screen them to determine if they are providing or reselling broadband services in the state.  We maintain a 
commented list of those organizations that we have determined not to be New Jersey broadband providers or resellers and of 
those organizations that remain under investigation.  Some of these organizations are no longer active business concerns; 
some are no longer independent organizations, but have been acquired by other entities; some offer or resell broadband 
service in other locations but not in New Jersey; some are companies that provide engineering or consulting support around 
broadband, but do not provide or resell service; and some are firms for which further interaction is needed to definitely 
determine their situation.   Service Providers 

During the summer we initiated additional outreach to try and identify potential broadband service providers or resellers and 
then determine their categorization.  The impetus for this effort was the program’s expansion of focus to include resellers and 
the additional service provider types.  Our efforts resulted in the categorization of twenty-nine additional organizations: 

• Four additional Type 1 service providers whose data is included in this submission:  Clearwire, Level 3, NetCarrier 
Telecom, Network Billing Systems. 
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• One additional Type 2 service provider whose data is included in this submission:  New Edge Networks dba 
Earthink Business. 

• Two additional Type 3 service providers:  airBand Communications (fixed wireless provider with service in 
Philadelphia; they have one location in New Jersey from which they cannot serve additional customers) and Global 
Crossing (cannot typically meet the 7-10 day service provisioning time frame). 

• Sixteen organizations for which we are still in the process of determining their status and role in the industry.  

• Six organizations that are neither broadband service providers nor resellers; these firms are summarized in the table 
below. 

Name of Company URL Explanation 

American Telephone 
Company LLC 

americantelephoneinc.com Equipment provider 

DatNet Communications 
Group, Inc. 

See under lightower.com Acquired in 2007 by Lightower. 

Hickory Tech 
Corporation 

hickorytech.com Not currently offering service in New Jersey 

Towerstream, Inc. towerstream.com Not currently offering service in New Jersey. 

World Discount 
Communications Co. 

mywdt.com Provides discount calling cards. 

Yipes Holdings, Inc. Redirects to Reliance 
Globecom 

Yipes was acquired in 2007 by Reliance. 

 

2.3 CAI Data Outreach 
Telcordia and OIT used a variety of means to collect Community Anchor institution data.  We collected reference data with 
lists of CAIs of various types in the state and we collected broadband data from individual institutions via our website and 
from aggregated sources.   For healthcare institutions we had previously obtained a reference list of hospitals from the New 
Jersey Hospital Association and we augmented this with information parsed from the New Jersey Department of Health and 
Senior Services (NJ HSS) which maintains on-line records of all licensed health care facilities.  For K-12 education we 
augmented our broadband records with information extracted from NJ applications to the federal e-Rate program.  For the e-
Rate program, we obtained public information on all New Jersey applications from the USAC website.  There are five 
funding categories established in the e-Rate program, plus a Miscellaneous category.  We selected applications that requested 
funding for the Internet Access category.  The available information allowed us to identify these schools as having broadband 
access 

For each CAI category, the following table provides the number of records we obtained from the reference source, the 
number of broadband access records we obtained, the total number of records we submitted to the NTIA and the number of 
complete records, with verified address information and broadband access information.    

 

CAI Category Reference 
Records 

Broadband 
Records 

Total 
Records 

Complete 
Records 

Submitted 
Records 

School K-12 (Public) 2603 
796 (Web) 

478 (eRate) 

2598 175 

3518 School K-12 (Private) 1260  

(NCES) 
1267 169 

Libraries 465 

(IMLS) 
89 472 50 443 
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CAI Category Reference 
Records 

Broadband 
Records 

Total 
Records 

Complete 
Records 

Submitted 
Records 

Medical/Healthcare 1107 

(NJ-DHHS) 
5 1107 5 1106 

Public Safety 343 

(NJ 911 Comm.) 
120 349 104 328 

University 158 

(NCES IPEDS) 

39 

(NJEdge) 
158 39 147 

Other – State 
Government 0 2007 1947 1947 

1671 
Other – Local 
Government 

0 54 54 54 

Other – Non 
Government 

0 8 8 8 8 

      

Total     5814 

 
Abbreviations and Acronyms 
911 Comm  New Jersey 9-1-1 Commission 
IMLS  Institute of Museum and Library Services 
IPEDS  Integrated Postsecondary Education Data System 
NCES   National Center for Education Statistics 
NJHA   New Jersey Hospital Association 
NJ-DHHS New Jersey Department of Health and Human Services 
 
New Jersey has a strong tradition of home rule and, like many eastern states, a plethora of small governance entities – towns, 
townships, boroughs, cities, and other local municipalities.  Among the major challenges we face in collecting broadband 
CAI data in the state are the dearth of strong, state-level organizations that might compel members to provide data (as 
opposed to comparatively weaker coordinating bodies) and the lack of existing broadband data sources.  NJEdge’s data on 
the higher education institutions to which they provide service is one of the very few such resources in the state.   
 
NJ OIT executives worked through state-level contacts in public safety, education and libraries, etc., to encourage their 
constituencies to participate and submit data through the website.  While some groups were more responsive than others, 
many expressed concerns about placing additional burdens in a time of shrinking budgets and cutbacks. Telcordia also 
conducted individual outreach county-by-county in the state which resulted in some additional broadband submissions from 
county government through the website. 
 
We encountered a few issues with collection, interpretation and processing of CAI data: 

o Some institutions provide information on multiple connections to the internet, each with its own technology of 
transmission and maximum speeds.   These may represent separate redundant connections for a large institution that 
provides critical services or separate facilities for different classes of users (e.g., staff and clients).  Our policy has 
been to submit a single entry for each institution, using the highest available download speed, but this policy may be 
a candidate for refinement. 

o Satellite institutions such as branch libraries or campus outreach centers can complicate the CAI picture.  Our policy 
is to attempt to collect data for each separate geographic location as a separate CAI.   

o Sometimes multiple government offices are co-located in one geographic location; e.g., a large building or complex 
that may include county government offices, court, jail, and/or other government offices.  Here the challenge is not 
to incorrectly overstate broadband capability or understate the need for broadband services. 
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o It remains challenging to convince busy employees at CAIs to take the time to provide this data. 
o The CAI transfer model requires a street number and for some CAIs this is not readily available as institutions may 

use a cross street for directions, a PO box for paper mail, etc.  We suggest that the NTIA consider making street 
number optional in the transfer model on a going forward basis. 

 
 

3 Service Provider Data Reception 
Telcordia defined a process for handling provider data upon receipt.  The following steps describe that process: 

These steps must be performed upon receipt of provider data.  These steps set up the file system and database for later 
processing, including both the initial assessment and load, and protect the confidentiality of the information. 

1. Update the provider interaction log spreadsheet with the date of receipt and other metadata. 
2. Copy the email or decrypt the uploaded files to individual directory on dedicated and secure server. 
3. Test that the files can be opened, read, etc.  This may require using ESRI ArcCatalog to check a shapefile or file 

geodatabase. 
4. Send an acknowledgement to the provider of receipt of readable submission, or request re-send as needed. 
5. Create empty provider data report into the new folder, using the appropriate wireless or wireline template.  
6. Connect to the PostgreSQL database and instantiate a schema for the provider  
7. Import the NTIA transfer model tables to the new schema using ArcCatalog.  These are available in the 

“ntiamodel” schema. 
8. Add triggers to the newly imported tables.  These triggers update columns with the user name and date/time for 

each insert and update.   
9. Perform an initial evaluation on the submitted data, evaluating the completeness of the submission and the 

validity and reasonableness of the included values.  Interact with provider to address any questions or issues. 
 
 

4 Service Provider Data Loading  
All providers are responding to the mandate to provide the different types of data that go into the various tables in the NTIA 
data transfer model.  The provider data submissions vary in form, format and content and in the ease versus complexity of the 
processing and loading tasks.   

In general, the most straightforward data to process are shape files submitted by wireless providers.  Wireline providers who 
submit census block data are a step up in terms of complexity.  Some cable providers simply list the municipalities which 
they serve.  A number of smaller providers provide address lists corresponding to locations where they provide service.  
These are much more challenging to process as we must first manipulate the address information and then geo-code the 
locations; these operations can be time consuming and subject to inaccuracies.  

The service provider reports attached in Appendix A give the full details per provider on all steps taken to extract, transform, 
and load the contents of the provider tables into the NTIA tables.  Note that every NTIA table has a “shape” column where a 
geographic feature such as a point, line (e.g., road segment) or area (e.g., census block) must be submitted. 

Here is a summary of some of our key policies and challenges:  

o All non-disclosure agreements executed with providers prohibit us from disclosing customer addresses.  Although 
some providers have not executed NDAs, we have chosen to treat all providers similarly.  We have chosen to 
obfuscate the address data by transforming it to census blocks or street segments.  This carries a slight risk of 
overstating coverage, but that seems more appropriate than simply dropping the data because it is sensitive. 

o Speeds associated with address data from some providers represent the price plan chosen by the customer; they are 
definitely neither the max advertised speed nor the typical speed.  Our decision was to keep the maximum speeds 
encountered in the census block and report them in the maximum advertised fields and to report typical as null.  If 
customers’ selections in neighboring census blocks were vastly different, we would use the highest speed in a 
(subjectively defined) area as the maximum advertised speed. 

o Maximum advertised speed, combined with the 7-10 availability requirement, results in vagaries in interpretation.  
In particular, the concept of advertised speed is well suited for providers who offer services to extended areas, such 
as large telephone and cable television companies.  Its application is less clear for smaller providers who offer 
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service to defined set of specific addresses.  They deliver services to those specific addresses, and could offer the 
same service to a new tenant within the time limit.  In some cases, they could increase the speed within that time 
period as well.  They could not easily deliver service to any neighboring location with a two-week period.  We have 
operationalized the notion of maximum advertised speed by determining the maximum speed a provider could offer 
on the facilities they have in place at customer locations, then reporting that speed for census blocks or street 
segments.   

o After initial poor results in geo-coding the customer address lists provided by some cable providers who had no geo-
spatial capabilities, we identified an alternate approach that leveraged the franchise-nature of cable television service 
in the state.  We asked those cable TV providers to send us the list of municipalities that they are licensed to serve.  
We build the submission by locating the municipality shapes and using those shapes to find all census blocks 
contained within them.   For large census blocks, we report all the TigerLine street segments that are contained 
within those blocks. 

o For middle mile data, the exact definition of a connection point remains open to interpretation and requires further 
development.  We are not completely sure that all providers interpret middle mile in the same fashion and do not 
have a clear enough picture ourselves to provide appropriate guidance or validation.  Despite this, we have 
submitted the middle mile information that we received. 

o All but one provider submitted 2010 Census Blocks (CBs).  Xchange was the one provider who submitted 2000 
CBs, requiring us to map the coverage to 2010.  This results in a modest overstatement as we show availability for 
all 2010 CBs for which there is overlap with a 2000 CB in their serving territory. 
 
 

5 Data Validation 
Incoming data was subjected to a number of validation checks.  When incoming data failed a validation check, we first 
investigated our process to ensure that we were not inadvertently creating an issue.  If the problem was determined to be with 
the submitted data, we notified the provider concerned and recorded the interaction in the provider data report as provided in 
Appendix A.  Where possible, we impute missing data.  As reported with our April submission, we have attempted to 
perform some data validation using the FCC speed-test data, but had limited success due to the sparseness of the coverage of 
the speed-test data.  Recent FCC speed test data is showing a reduction in the number of measurements, which only increases 
the sparsity. 

We have observed a few issues that arose when processing the current submission: 

o The alignment of Tiger Lines and 2010 CBs has sometimes been problematic, particularly for large CBs.  When a 
2010 CB has a Tiger Line road segment as part of its boundary, we have found a number of examples where there is 
misalignment which makes the road segment appear to be within a specific CB rather than as a boundary.  Please see 
Section 6.1 for an example.  

o New Jersey placenames can be difficult.  We validate against data from the following sources: State of New Jersey 
geographic information (https://njgin.state.nj.us/NJ_NJGINExplorer/DataDownloads.jsp), the Federal Government 
placename information (http://geonames.usgs.gov/domestic/download_data.htm), and the US Postal Service data 
(available for a fee). 

o A survey of 3100 New Jersey households was conducted in November and December by Rutgers University as 
Telcordia’s subcontractor under this program.  Householders who responded that they were broadband users were 
asked who their service provider was and this was compared against service provider serving areas.  95% of the 
responses aligned with service provider information.  In the remaining 63 cases, the survey respondents reported 
being served by a provider whose coverage area did not appear to cover that location. Through these cases we have 
identified an area for additional investigation which may lead to improvements in service provider coverage.  The 
technique, based on geo-spatial analysis of neighboring CBs is briefly described in Section 6.2.   

o T-Mobile submitted wireless coverage data that provided one of the more interesting validation issues.  T-Mobile 
provided separate information about three different varieties of 3GPP-based wireless technology, each of which 
supports broadband data services through mobile terrestrial wireless service capability; namely:  UMTS, HSPA21 
(i.e., HSPA) and HSPA42 (i.e., HSPA+)1.  In order to avoid duplicates – that is, rows of T-Mobile data with 

                                                           
1 Here are a few more technical details.  UMTS is based upon 3GPP release 99 and is the oldest and slowest of the three varieties.  
HSPA (HSPA21) is 3GPP R6 which supports HSDPA and HSDPU for downlink and uplink high-speed packet access and offers 
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identical shapes and the same technology and spectrum codes, differing only in maximum speed, we performed 
spatial joins separately for each of UMTS, HSPA21 and HSPA42.  We then submitted one shape for each 3GPP 
technology. 

o The End_User_Category for Census Blocks or Road Segments is an optional field for designating the geography as 
being primarily Residential, Non-Residential, or Other (primarily neither Residential nor Non-Residential).  Based 
on discussions with NJ OIT we have elected not to complete this field as OIT does not have a trusted data source for 
this information. 
 

We applied the business rules in the script supplied by the NTIA and other data-specific validations after the data were 
loaded into the tables.  These were applied as a check on both the data supplied by the providers and on the process we used 
for data collections, reception and loading.   

The following business rules were applied above and beyond those in the NTIA script: 
 

We checked uniqueness of the entries in each table, using the following definitions of uniqueness: 

Layer Unique key Notes 

Middle Mile frn, latitude, longitude  

CAI anchorname, address, transtech  

Census Block frn, fullfipsid, transtech  

Street Segment frn, tlid, transtech Tlid is an internal column.  

Wireless frn,transtech, spectrum, shape  

 

 

We also performed the following additional validations: 

Layer Validation Rules 

Middle Mile • Check (dbaname, provname, frn) against our FRN reference table 
• Valid census block id within the state of New Jersey 
• Check latitude not between 38.7 and 41.4 
• Check longitude not between -75.6 and -73.8 
• Shape should not be empty 
• All check_submission rules 

CAI • Valid zip code 
• Check latitude not between 38.7 and 41.4 
• Check longitude not between -75.6 and -73.8 
• Shape should not be empty 
• All check_submission rules 

Census Block • Check (dbaname, provname, frn) against our FRN reference table  
• Valid census block id within the state of New Jersey  
• The area of a census block should be less than < 2 square Mile 
• Shape should not be empty 
• All check_submission rule 

Street Segment • Check (dbaname, provname, frn) against our FRN reference table  
• Street segment is present in a census block >= 2 square miles 
• Shape should not be empty 
• All check_submission rule 

                                                                                                                                                                                                         
intermediate speeds.   HSPA+ (HSPA42) is 3GPP R7. It is the most advanced of the three and supports high-speed packet access evolution 
with peak data rate increases from MIMO and higher-order modulation, among other technical advances.  
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Wireless • Check (dbaname, provname, frn) against our FRN reference table  
• Shape should not be empty 
• All check_submission_rule 

 

6 Two Issues in Geometry 

6.1 Tiger Lines and 2010 Census Block Misalignment 
 

Here is an example of two 2000 Census Blocks and the Tiger Line which forms part of the boundary illustrating proper 
alignment. 

 

 

 

 
The next page shows an example of the same geometry with 2010 Census Blocks and illustrates the misalignment between 
the line and the CB boundary. 
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Misaligned line and 2010 CB boundary: 

 

 

 

 

 

6.2 Gap Analysis of Neighboring Census Blocks 
 

The analysis of the survey data identified some instances where a survey respondent identified their service provider and then 
the service provider’s data did not show coverage in that respondent’s Census Block.  Further analysis indicated that a 
number of these instances occurred in ‘gaps’ or ‘holes’ in submitted provider coverage data.  One way to define a simple hole 
is that it is a single CB that is not in the stated provider coverage area when all neighboring CBs are in the stated coverage 
area.  Our investigations of these simple holes showed that some are associated with zero-population CBs – e.g., a CB that 
comprises a strip of land neighboring a major roadway.   Other simple holes, however, appear to be anomalies in service 
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provider data as we find examples of a residential CB, surrounded by other residential CBs, and no clear rationale to explain 
why the initial (middle) CB would not have coverage when all neighboring CBs do have coverage.   

 

 

The next figure shows a few simple holes in Comcast data from Cranbury Township at a fine resolution. 

 

 

 

 

 

Our analysis of the simple holes shows that some are anomalies that may provide a way to improve the accuracy of provider 
data.  To pursue such possible improvements, we developed software that automates the identification of simple holes.  
Somewhat to our surprise, when we ran this software on the data for this submission, we found rather sizeable numbers of 
holes for some of the providers.  For example, we identified almost 250 simple holes for Cablevision (including Lightpath) 
and over 1400 for Comcast.  The following graphic illustrates the simple holes for Comcast. 
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Graphic of Simple Holes in Comcast Data: 

 

 

 

 

Given the number of holes, it is apparent that conveying them one-by-one to providers for review is not feasible.  However, 
the identification of these simple holes opens an avenue for implementation of additional automated verification of service 
provider coverage.  Essentially what we are considering is entering the geospatial locations of the holes in major providers’ 
on-line service availability systems in a mechanized fashion.  This would allow us to conduct an efficient and automatic 
internal consistency check between provider data and the web-based service availability systems offered by major providers.   
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Overview 

 
This document is a concatenation of the individual data reports for each provider whose 
data was processed and included in the October 2011 submission to the NTIA. 
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Provider: Advanza 

Received: August 2011 
Submission date: October 2011 
 
This report presents details on processing of broadband data for delivery to the National 
Telecommunications and Information Administration. 
 
Section 1: NDA Status 
 
Advanza states that NONE is required.   
 
Section 2: Submission Overview 
 

AVAILABILITY DATA – RECEIVED AUGUST, 2010 

ID 

Provider name 

“Doing business as” name 

FRN 

Holding Company Name 

Holding Company Number 

Advanza Telecom Inc 

Advanza 

0017029141 

Advanza Telecom, Inc. 

180002 

FOR WIRELINE 

Filetypes 1 xlsx spreadsheet 

File size NJBB_0017029141_AddressLevelAvailability-20110630.xls file has 47 records  

Speeds 

Type 

 Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream X address 

Typical-downstream X address 

Advertised-upstream X address 

Advertised-
downstream 

X 
address 

Subscriber-weighted-
up 

� Not provided 

Subscriber-weighted-
down 

� Not provided 

 

All provided speeds have code 
4 (1.5 mbps ≤ BW < 3.0 mbps) 
for all records, which would 
make sense if all service is T1 

Technology 
Type 

Code 30 ( = Other Copper Wireline) given for all records  

End-user 
specification 

Data not available 

Comments:  
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INTERCONNECTION DATA  

ID  

File size No data provided 

Ownership  

Transport Type  

Data 
Rates/Capacity 

 

Location  

Comments: 

 
 
 
Section 3: Submission File Details 
 
Received one file by secure upload to the connectingnj web site. 
 
Size  Name 
71,168 NJBB_0017029141_AddressLevelAvailability-20110630.xls 
 
The addresses in this file appear to be for individual customers (as opposed to 
addresses of multi-tenant buildings in a central business district).   
 
Section 4: Validations and Results 
 
All addresses were successfully geocoded using Arroyo with Yahoo geocoder. All 
records successfully spatially joined on 2010 NJ Census Block shapes. 
 
Passed all validations described in summary report. 
 
Section 5: Data Transformation and Loading 
 
The standard NDA prohibits us from submitting address-level data to the NTIA.  Instead, 
we discover the census block for each customer address, and then report the census 
block shape drawn from Census Bureau TigerLine reference data. 
 
NTIA Table BB_Service_CensusBlock 
 
Loaded from the file mentioned above.  The following table explains the transformations 
that were applied to load the target table. 
 
Table Column  Data Source / Transformation  
PROVNAME Set to " Advanza Telecom Inc" (no trailing period) 
DBANAME Not supplied; set same as PROVNAME 
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PROVIDER_TYPE Set to 1 
FRN Set to "0017029141" 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census Block FIPS Code (first 3 digits) 
TRACT Populated from Census Block FIPS Code (next 6 digits) 
BLOCKID Populated from Census Block FIPS Code 
FULLFIPSID Populated from Census Block FIPS Code 
TRANSTECH As supplied in column Tehcnology of Transmission (sic) 
MAXADDOWN As supplied in column Maximum Advertised Downstream Speed 
MAXADUP As supplied in column Maximum Advertised Upstream Speed 
TYPICDOWN Set to null (see below) 
TYPICUP Set to null (see below) 
ENDUSERCAT Set to null (see below) 
SHAPE Copied from Census Bureau TigerLine 2010,  

as matched by spatial join on geocoded address 
 
Internal processing notes: 

1. Geocoded the addresses using an Arroyo flow and the Yahoo geocoder, leaving 
the result with address and lat, long data in an Excel spreadsheet. 

2. Imported the spreadsheet to a simple ESRI geodatabase table 
3. Added point shapes corresponding to each Latitude,Longitude pair by creating a 

feature class from the table using ArcCatalog’s “Create Feature Class from XY 
Table” option 

4. Added a column containing the ID of the containing year 2010 census block 
using ArcCatalog's spatial join feature.  The newly created point shapes are 
joined against census block shapes from reference data. 

5. Discarded typical speeds since they were in all cases identical to maximum 
advertised speeds, not measured values. 

6. The end user category value as originally supplied applied to an address. The 
NTIA directs us to report the “predominant” end-user category, which is not 
supplied here. 

7. Copied contents to the target data model table with the transformations specified 
above.  Discarded 15 rows with duplicate census blocks. 

 
 
Section 6: Clarification Questions and Responses 
 
None required as part of initial review. 
 
 
Section 7: Notes and Open Issues 
 



5 
 

Section 8: Overview Map of Submitted Data 
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Provider: AT&T Mobility LLC 

Received: August 4 2011 
Submission date: October 2011 
 
This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 
 
 
Section 1: NDA Status 
 
NDA was executed with NJ OIT. 
 
 
Section 2: Submission Overview 
 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

AT&T Mobility LLC 

AT&T Mobility LLC 

0004979233 for mobility 

NB:  “AT&T Corporation, Inc.” with FRN  
0004979244 for middle mile 

FOR WIRELESS 

Filetypes shapefile collection: shp/dbf/prj/shx, 
mdb, gdb, imagefile etc. 

Spreadsheet (XLSX) and shapefile that uses 
projection GCS_WGS_1984 

Speeds 

Type 
Spatial Resolution (address, 
street seg, census block, 
RSA/MSA, zipcode) 

Upstream max 
adv 

State 

Downstream 
max adv 

State 

Upstream 
typical 

Not provided 

Downstream 
typical 

Not provided 

Subscriber-
weighted 

Not provided 

 

 

Technology 
Type 

Spectrum (Mhz, FCC code) Cellular (code 1) and PCS (code 3) 

Comments:  

INTERCONNECTION DATA 
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ID  

File size Single row 

Ownership Code 0 

Transport Type Code 1 

Data 
Rates/Capacity 

Code 6 

Location Newark, NJ 

Comments: Single location provided 

 
 
Data overview: 
 

 
Figure. Quick load of data into ArcMap 
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Section 3: Submission File Details 
 
Received six (6) files by SECURE UPLOAD: 
 
Size kb  Name 
9  Mobility Response NJ June 2011.xlsx 
3  ATT_June2011_UMTSNJ.DBF 
1  ATT _ June2011_UMTSNJ.PRJ 
488  ATT _ June2011_UMTSNJ.shp 
1   ATT _ June2011_UMTSNJ.SHX 
8  ATT Router Locations NJ June 2011.xlsx 
 
Subscriber-Weighted Nominal Speed by county was NOT provided. 
 
Middle-mile (connection point) data is available in a previous submission. 
 
 
Section 4: Validations and Results 
 
File “Mobility Response NJ June 2011.xlsx” 
 
Contains a single row with provider name, DBA name, FRN, technology of transmission, 
a specification of the spectrum bands used, and the maximum advertised up/down 
speeds.  The FRN is missing the leading zeros.  The TechTrans code is valid.  The max 
speed values are plausible. 
 
Shapefile “NJ_June2011_UMTSNJ” (DBF, PRJ, SHP, and SHX file extensions) 
 
Contains a 63 rows representing a multiple polygons.  No text attributes are associated 
with the row.  The coverage area is most of the State of New Jersey, broken into 
separate shapes by various horizontal and vertical lines.  The map strongly resembles 
the map shown at www.wireless.att.com. 
 
 
Section 5: Data Transformation and Loading 
 
NTIA Table BB_ConnectionPoint_MiddleMile 
 
Loaded from supplied Excel Spreadsheet “ATT Router Locations NJ June 2011.xlsx” (1 
row).  The following table explains the transformations that were applied.  
 
Table 
Column 

Data Source / Transform ation  

PROVNAME As supplied  
DBANAME As supplied 
FRN Added leading zeroes to read 0004496774 (see below) 
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OWNERSHIP As provided in column “Ownership” 
BHCAPACITY As provided in column “Serving Facility Capacity” 
BHTYPE As provided in column “Serving Facility Type” 
LATITUDE As provided in column “Latitude_geo” 
LONGITUDE As provided in column “Longitude_geo” 
ELEVFEET Set to “0” (zero) 
STATEABBR Set to “NJ” 
FULLFIPSID ID of containing census block from Year 2010 Census Bureau 

TigerLine reference data  
SHAPE Created using ESRI ArcDesktop 
 
Internal notes on processing: 

1. Used the provider name, DBA name, and FRN as supplied, after adding back 
leading zeros to the FRN.  Note that the middle-mile entity is different than the 
mobility entity and per clarification from AT&T during the October 2010 
submission round, should indeed be reported differently. 

2. Imported the excel sheet to a geodatabase table. 
3. Added point for the Latitude,Longitude pair by creating a feature class from the 

table using ArcCatalog’s “Create Feature Class from XY Table” option. 
4. Mapped to separate shape file to correct tolerance. 
5. Added a column containing the ID of the containing year 2010 census block via a 

spatial join of the points and the census block shapes from reference data. 
 
 
NTIA Table BB_Service_Wireless 
 
Loaded from the supplied shapefile “EVDO_NJ”.  The following table explains the 
transformations that were applied. 
 
Table Column  Data Source / Transformation  
PROVNAME Set to “AT&T Mobility LLC” 
DBANAME As supplied in file Mobility Response NJ June 2011.xlsx 
FRN Set to 0004979233 
TRANSTECH As supplied in file Mobility Response NJ June 2010.xlsx 
SPECTRUM Set to “3” per translation shown below 
MAXADDOWN Set to “4”, see below. 
MAXADUP Set to “3”, see below. 
TYPICDOWN Not provided, set to null 
TYPICUP Not provided, set to null 
STATEABBR Set to “NJ” 
SHAPE As supplied. 
 
Internal notes on processing: 

1. The supplied shape uses geographic coordinate system name GCS_WGS_1984  
The NTIA data model requires the same coordinate system.  No geographic 
transformation was required, but the XY Tolerance values differ if the shapefile is 
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imported trivially into the geodatabase.  Imported shape then mapped to 
separate shape with proper tolerance. 

2. Spectrum: AT&T Mobility provided multiple columns of data about their spectrum 
use.  Searching on the web suggests that AT&T 3G uses frequencies 850MHz 
and 1900Mhz.  The NTIA data model has a single column for spectrum.  No 
mapping is provided for frequency 850MHz.  Frequency 1900MHz corresponds 
to NTIA “SPECTRUM USED” code value 3. 

3. Speeds: The maximum advertised speeds provided in the spreadsheet are 1.7 
Mbps down and 1.2 Mbps up.  For max adv speeds we encoded the submitted 
down speed as value 4 (range 1.5-3 Mbps) and encoded the submitted up speed 
as value 3 (range 768 Kbps – 1.5 Mbps). 

4. The only data imputed was the state abbreviation. 
 
 
Section 6: Clarification Questions and Responses 
 
None 
 
Section 7: Notes and Open Issues 
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Section 8: Overview Map of Submitted Data 
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Provider: Broadview Networks, Inc. 

Submission date: October 2011 
 
This report presents details on processing broadband data for delivery to the National 
Telecommunications and Information Administration (NTIA).   
 
This is a stub report, since data from the previous submission was reused unchanged.  
The complete report from the previous submission begins on the next page.  Notable 
differences from the processing done on the previous submission are listed next. 
 
NTIA Table BB_ConnectionPoint_MiddleMile 
 
No changes to columns since the last submission. 
 
Total rows loaded: 30 
 
NTIA Table BB_Service_CensusBlock 
 

1. Column " blocksubgroup" was dropped. 
2. Column "endusercat" was added; set to null because data was not supplied. 
3. Discarded 22 records for addresses that could not be geocoded in New Jersey 

(mostly in New York State). 
4. Discarded 150 records with speeds that do not meet the NOFA definition of 

broadband 
5. Discarded 354 records with duplicate census blocks (i.e., multiple addresses in 

the same census block) 
 
Total rows loaded: 1404 
 
NTIA Table BB_Service_RoadSegment 
 

1. Column " blocksubgroup" was dropped. 
2. Column "endusercat" was added; set to null because data was not supplied. 
3. See discards above. 
4. Found 6 large census blocks while loading the BB_Service_CensusBlock table. 
5. Found 247 road segments in these large census blocks. 

 
Total rows loaded: 247 
 
Notes  
 
To create the “providerInput” tables for this submission, we removed the 2000 census 
block column from the old providerInput tables and performed a spatial join against the 
2010 census block reference data table.   
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Provider Interactions 
 
 
Received email from Jarrod Harper  on 8/22/2011 instructing us to use previously 
submitted data. 
 
From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  

Sent: Tuesday, September 13, 2011 1:10 PM 
To: 'Harper, Jarrod' 

Cc: ConnectingNJ@research.telcordia.com 
Subject: NJ BB Clarification 

 

Jarrod, 
   We have reviewed the data you submitted to the NJ Broadband Mapping program and have a few 
clarification questions.  We had asked these questions when you submitted the data last March, but we 
did not receive a reply from you. 

1. The values you provided for the max. advertised up/down speeds appear to be the price plan 

choices.  Can we use the highest values as the Maximum Advertised speeds across all your 

locations?? 

2. Do you own or lease the facilities at the interconnection points you have listed? 

3. You provided  the service facility type for the middle-mile points but not the facility capacity. 

Would it be possible for you to provide this data. 
 
Thanks for your participation in the program! 
 
 
John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
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Provider: Broadview Networks, Inc. 

Received: September 2010 
Submission date: April 2011 
 
This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 
 
Section 1: NDA Status 
 
No NDA executed. 
 
Section 2: Submission Overview 
 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Broadview Networks Inc. 

Broadview Networks 

0003775285 

FOR WIRELINE 

Filetypes Excel spreadsheet 

File size 1,936 data rows 

Speeds 

Type  Address level data 

Typical-upstream  Not provided 

Typical-downstream  Not provided 

Advertised-upstream 
 

Customer speed 
choice listed 

Advertised-
downstream 

 
Customer speed 
choice listed 

Subscriber-weighted-
nominal speed 

 
Not provided 

 

Instead of max advertised, each 
service address price plan is 
shown. 

Technology 
Type 

10 (ADSL), 20 (SDSL), 30 (Other Wireline) 

End-user 
specification 

Yes 

Comments:  

INTERCONNECTION DATA 

ID  

File size Excel spreadsheet with 31 rows 

Ownership Not provided 

Transport Type Code 2, copper 
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Data 
Rates/Capacity 

Not provided 

Location Address provided 

Comments: 

 
 
 
Section 3: Submission File Details 
 
Received 2 files by secure upload: 
 
Size  Name 
514560 NJ Table 1 063010.xls 
24576  NJ Table 8 - Middle Mile & Backbone Interconnection Point 063010.xls 
 
 
Section 4: Validations and Results 
 
Table 1 has 1,936 service addresses (with abbreviated town names and many missing 
zip codes), the technology speed tiers in service at each address, and the count of 
connections.  Most records contain max advertised up/down speed codes, but over 100 
do not. Records have no typical up/down speed and no specification of subscriber-
weighted nominal speed.  Table 1 shows no provider name, no DBA name, and no 
FRN.  Geocoding succeeded for N of the addresses and failed for 628 addresses.  Most 
of the addresses that failed geocoding have no street component, just a city name. 
 
Table 8 has 33 middle-mile points, with addresses, CLLI codes, and the service facility 
type (all copper).  There is no specification of ownership or facility capacity.  Table 8 
lists provider name, DBA name, and FRN.  Geocoding succeeded for 32 of the 
addresses and failed for 1 ("Delsea Dr N & Focer St, Glassboro, NJ 08028, USA"). 
 
 
Section 5: Data Transformation and Loading 
 
NTIA Table BB_ConnectionPoint_MiddleMile 
 
Loaded from data supplied in the XLS sheet. The following table explains the necessary 
transformations that were applied.  
 
Table 
Column 

Data Source / Transformation  

PROVNAME Set to "Broadview Networks Inc." 
DBANAME Set to "Broadview Networks" 
FRN As supplied in column "FRN" 
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OWNERSHIP Set to null, not supplied 
BHCAPACITY Set to null, not supplied 
BHTYPE As supplied in column "Serving Facility Type" 
LATITUDE Obtained by geocoding the address 
LONGITUDE Obtained by geocoding the address 
ELEVFEET Set to “0” (zero), not supplied 
STATEABBR Set to “NJ” 
FULLFIPSID ID of containing census block from Year 2000 Census Bureau 

TigerLine reference data  
SHAPE Point shape created using ESRI ArcDesktop 
 
Internal notes on processing: 

6. Geocoded the addresses to obtain Latitude, Longitude value pairs. 
7. Created an excel sheet and imported to a geodatabase table. 
8. Added a point shape corresponding to the Latitude, Longitude pair by creating a 

feature class from the table using ArcCatalog’s “Create Feature Class from XY 
Table” option. 

9. Added a column containing the ID of the containing Year 2010 Census Block via 
a spatial join of the points and the census block shapes from reference data. 

 
 
NTIA Table BB_Service_CensusBlock 
 
The standard NDA prohibits us from submitting address-level data to the NTIA.  So we 
do not populate the table BB_Service_Address with the availability data.  Instead, we 
discover the census block for each customer address, then report the census block 
shape drawn from Census Bureau TigerLine reference data. 
 
Loaded from supplied file of addresses after applying the corrections discussed below.  
The following table explains the transformations that were applied to load the target 
table. 
 
Table Column  Data Source / Transformation  
PROVNAME Set to "Broadview Networks Inc." 
DBANAME Set to "Broadview Networks" 
PROVIDER_TYPE Set to 1 
FRN Set to " 0003775285" 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census Block FIPS Code (first 3 digits) 
TRACT Populated from Census Block FIPS Code (next 6 digits) 
BLOCKID Populated from Census Block FIPS Code 
BLOCKSUBGROUP Set to null 
FULLFIPSID Populated from Census Block FIPS Code 
TRANSTECH As supplied in column Technology 
MAXADDOWN As supplied in column Max Advertised Upstream 
MAXADUP As supplied in column Max Advertised Downstream 
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TYPICDOWN Set to null 
TYPICUP As supplied in column Typical Upstreatm Speed (sic) 
SHAPE Copied from Census Bureau TigerLine 2010,  

as matched by spatial join on geocoded address 
 
Internal processing notes: 

8. Geocoded the addresses using the Google geocoder to obtain a Latitude, 
Longitude pair for each.. Addresses that yielded results with accuracy of 6 or 
below were excluded; only intersection (7) or rooftop (8) accuracy is acceptable.  
The list of addresses that failed geocoding is available. 

9. Created an Excel sheet and imported it to a geodatabase table. 
10. Added point shapes corresponding to each Latitude, Longitude pair by creating a 

feature class from the table using ArcCatalog’s “Create Feature Class from XY 
Table” option. 

11. Added a column containing the ID of the containing year 2000 census block via a 
spatial join of the point shapes and the census block shapes from reference data. 

12. Discarded 150 rows with no value for the maximum advertised download speed. 
13. Discarded 383 rows with duplicate census blocks. 
14. Loaded 1,377 census blocks. 

 
 
NTIA Table BB_Service_RoadSegment 
 
Loaded with street segments in census blocks larger than 2 square miles as gathered 
from Census Bureau TigerLine reference data.  The following table explains the 
transformations that were applied to load the target table. 
 
Table Column  Data Sourc e / Transformation  
PROVNAME Set to "Broadview Networks Inc." 
DBANAME Set to "Broadview Networks" 
PROVIDER_TYPE Set to 1 
FRN Set to " 0003775285" 
ADDMIN From reference data 
ADDMAX From reference data 
PREDIR  Set to null, not available in reference data 
STREETNAME From reference data 
STREETTYPE Set to null, not available in reference data 
SUFFDIR Set to null, not available in reference data 
CITY From reference data 
STATECODE Set to "NJ" 
ZIP5 From reference data 
ZIP4 Set to null, not available in reference data 
TRANSTECH As supplied in column Technology 
MAXADDOWN As supplied in column Max Advertised Upstream 
MAXADUP As supplied in column Max Advertised Downstream 
TYPICDOWN Set to null, not provided 
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TYPICUP  Set to null, not provided 
SHAPE From reference data 
Internal processing notes: 

1. Discovered all street segments that touch census blocks larger than 2 square 
miles using the census block list discovered as discussed for table 
BB_Service_Censusblock above. 

2. Joined against reference data to discover street segment, for a total of 208 
entries. 

 
 
Section 6: Clarification Questions and Responses 
 
From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  

Sent: Tuesday, September 13, 2011 1:10 PM 
To: Harper, Jarrod 

Cc: ConnectingNJ@research.telcordia.com 
Subject: NJ BB Clarification 
 

Jarrod, 
   We have reviewed the data you submitted to the NJ Broadband Mapping program and have a few 
clarification questions.  We had asked these questions when you submitted the data last March, but we 
did not receive a reply from you. 

1. The values you provided for the max. advertised up/down speeds appear to be the price plan 

choices.  Can we use the highest values as the Maximum Advertised speeds across all your 

locations?? 

2. Do you own or lease the facilities at the interconnection points you have listed? 

3. You provided  the service facility type for the middle-mile points but not the facility capacity. 

Would it be possible for you to provide this data. 
 
Thanks for your participation in the program! 
 
 
John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
 
 
From: Harper, Jarrod [mailto:jharper@broadviewnet.com]  

Sent: Tuesday, September 13, 2011 3:45 PM 
To: ConnectingNJ@research.telcordia.com 

Subject: RE: NJ BB Clarification 

 
John, 
 

1. Yes, use those across the locations 
2. The facilities are leased 
3. I will have to inquire about this and get back to you on it. 

Thanks, 
 
Jarrod 
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From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  

Sent: Tuesday, September 13, 2011 3:48 PM 

To: 'Harper, Jarrod' 
Cc: ConnectingNJ@research.telcordia.com 

Subject: RE: NJ BB Clarification 

 

Jarrod, 
   Thanks for the quick response.  We’ll begin processing with the first two answers and will hold up the 
middle mile awaiting your answer to item 3. 
 
John 
 
 
 
Section 7: Notes and Open Issues 
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Section 8: Overview Map of Submitted Data 
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Provider: Cavalier Telephone Mid-Atlantic LLC 

Submission date: October 2011 
 
This report presents details on processing broadband data for delivery to the National 
Telecommunications and Information Administration (NTIA).   
 
This is a stub report, since data from the previous submission was reused unchanged.  
The complete report from the previous submission begins on the next page.  Notable 
differences from the processing done on the previous submission are listed next. 
 
NTIA Table BB_Service_CensusBlock 
 

6. Column " blocksubgroup" was dropped. 
7. Column "endusercat" was added; set to null because data was not supplied. 

 
 
Notes  
 
To create the “providerInput” table for this submission, we removed the 2000 census 
block column from the old providerInput table and performed a spatial join against the 
2010 census block reference data table.   
 
 
NTIA Table BB_ConnectionPoint_MiddleMile 
 

1. No changes. 
 
 
Notes  
 
To create the “providerInputMiddleMileTol” table for this submission, we removed the 
2000 census block column from the old providerInput table and performed a spatial join 
against the 2010 census block reference data table.   
 
 
Provider Interactions 
 

Margaret Ring reported on 9/8/2011 that there were no substantive changes to 
coverage, speed or middle mile since last submission. 
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Connecting New Jersey - Broadband Provider Data Report 
Provider: Cavalier Telephone Mid-Atlantic LLC 
Submission date: April 2011 
 
This report presents details on processing broadband data for delivery to the National 
Telecommunications and Information Administration (NTIA). 
 
This is a stub report, since data from the previous submission was reused unchanged.  
The complete report from the previous submission begins on the next page.  Notable 
differences from the processing done on the previous submission are listed next. 
 
NTIA Table BB_Service_CensusBlock 
 

1. Column "reseller" was dropped. 
2. Set the new column "provider_type" to value 1 ("Broadband provider as 

described in the NOFA") 
3. Dropped non-measured typical up/down speed code values. 

 
 
NTIA Table BB_ConnectionPoint_MiddleMile 
 

1. No changes. 
 
Provider Interactions 
 
From: Ring, Margaret H. [mailto:mhring@cavtel.com]  

Sent: Friday, March 04, 2011 1:03 PM 

To: 'ConnectingNJ@research.telcordia.com' 
Subject: RE: NJ BB Data Collection - Spring 2011 

 

Cavalier Telephone has had no substantial changes to its broadband footprint since its last 

data submission.  Please feel free to use the same data for this round of reporting.  Let me 

know if you have any questions or concerns. 
  
Regards, 
  
Margaret Ring, Director 
Regulatory 
Cavalier Telephone 
850.465.1748 
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Provider: Cavalier Telephone Mid-Atlantic LLC 
Received: August 2010 
Submission date: August 2010 
 
This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 
 
Section 1: NDA Status 
 
NDA in place 
 
Section 2: Submission Overview 
 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Cavalier Telephone Mid-Atlantic LLC 

No DBA name (confirmed with 
company) 

0015-7991-33 

FOR WIRELINE 

Filetypes Excel (Cavalier NJ Broadband Response.xls) 

File size 52736 bytes; 122 records 

Speeds 

Type 

 Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Address 

Typical-downstream  Address 

Advertised-upstream  Address 

Advertised-
downstream 

 
Address 

Subscriber-weighted-
up 

 
Not provided 

Subscriber-weighted-
down 

 Not provided 

 

Typical up speeds 3,4; down 
5,6,7,7.  Adv up speed 4, down 
6.  Note typical speed code that 
is greater  than the max 
advertised speed code 

 

Company clarified during 
October submission that the 7 
typical speed should be a 6. 

Technology 
Type 

Initial submission included Codes 1 and 3.  Provider clarified during October 2010 
submission that these should be ADSL (1=10) and Other Copper Wireline (3-30). 

End-user 
specification 

Codes 1 (residential) and 3 (small business). 

Comments:  

INTERCONNECTION DATA 

ID  
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File size  

Ownership  

Transport Type  

Data 
Rates/Capacity 

 

Location  

Comments:  

 
 
 
Section 3: Submission File Details 
 
Received 1 file by email. 
 
Size  Name 
52736  Cavalier NJ Broadband Response.xls 
 
The file contains 124 rows and 122 data records for broadband availability by address, 
and 18 rows of middle-mile connection points. 
 
 
Section 4: Validations and Results 
 
Some of the address records (13) are post office boxes, which are invalid for this 
purpose.   
 
All validations described in summary were applied 
 
Section 5: Data Transformation and Loading 
 
NTIA Table BB_ConnectionPoint_MiddleMile 
 
Loaded from supplied file “Cavalier NJ Broadband Response.xls”, tab “Middle Mile 
Interconnection”.  The following table explains the transformations that were applied.  
 
Table 
Column 

Data Source / Transformation  

PROVNAME As supplied in column “Provider Name” 
DBANAME Not supplied; set same as PROVNAME 
FRN As supplied in column “FRN”, after removing hyphens 
OWNERSHIP As supplied in column “Ownership” 
BHCAPACITY As supplied in column “Serving Facility Capacity” 
BHTYPE As supplied in column “Serving Facility Type” 
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LATITUDE Created by geocoding the supplied address 
LONGITUDE Created by geocoding the supplied address 
ELEVFEET Set to “0” (zero) 
STATEABBR Set to “NJ” 
FULLFIPSID ID of containing census block from Year 2010 Census Bureau 

TigerLine reference data  
SHAPE Point shape created using ESRI ArcDesktop 
 
Internal notes on processing: 

10. Geocoded the addresses using the Google geocoder. 
11. Created an excel sheet and imported to a geodatabase table. 
12. Added point shapes corresponding to each Latitude,Longitude pair by creating a 

feature class from the table using ArcCatalog’s “Create Feature Class from XY 
Table” option. 

13. Added a column containing the ID of the containing year 2000 census block via a 
spatial join of the point shapes and the census block shapes from reference data. 

 
 
NTIA Table BB_Service_CensusBlock 
 
The standard NDA prohibits us from submitting address-level data to the NTIA.  So we 
do not populate the table BB_Service_Address with the availability data.  Instead, we 
discover the census block for each customer address, then report the census block 
shape drawn from Census Bureau TigerLine reference data. 
 
Loaded from supplied file “Cavalier NJ Broadband Response.xls”, tab “Wireline 
Address-Level” after applying the corrections discussed below.  The following table 
explains the transformations that were applied to load the target table. 
 
Table Column  Data Source / Transformation  
PROVNAME As supplied in column “Provider Name” 
DBANAME Not supplied; set same as PROVNAME 
PROVIDER_TYPE Set to 1 
FRN As supplied in column “FRN”, after removing hyphens 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census Block FIPS Code (first 3 digits) 
TRACT Populated from Census Block FIPS Code (next 6 digits) 
BLOCKID Populated from Census Block FIPS Code 
BLOCKSUBGROUP Set to null 
FULLFIPSID Populated from Census Block FIPS Code 
TRANSTECH As supplied in column Technology 
MAXADDOWN As supplied in column Max Advertised Upstream 
MAXADUP As supplied in column Max Advertised Downstream 
TYPICDOWN Set to null 
TYPICUP Set to null 
SHAPE Copied from Census Bureau TigerLine 2010,  
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as matched by spatial join on geocoded address 
 
Internal processing notes: 

1. Created a corrected spreadsheet based on response to questions, see next 
section. 

2. Geocoded the addresses using the Google geocoder to obtain a Latitude, 
Longitude pair for each.. Addresses that yielded results with accuracy of 6 or 
below were excluded; only intersection (7) or rooftop (8) accuracy is acceptable.  
The list of addresses that failed geocoding is available. 

3. Created an Excel sheet and imported it to a geodatabase table. 
4. Added point shapes corresponding to each Latitude, Longitude pair by creating a 

feature class from the table using ArcCatalog’s “Create Feature Class from XY 
Table” option. 

5. Added a column containing the ID of the containing year 2000 census block via a 
spatial join of the point shapes and the census block shapes from reference data. 

6. Discarded 173 rows with duplicate census blocks while preserving the greatest 
speed. 

 
The mechanized procedure for the three steps is described in file GeoExcel_proc.txt. 
 
Section 6: Clarification Questions and Responses 
None this round 

 
Section 7: Notes and Open Issues 
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Section 8: Overview Map of Submitted Data 
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Provider: CenturyTel DBA Century Link 

Received: August 2011 
Submission date: October 2011 
 
This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 
 
Section 1: NDA Status 
 
Century Link executed an NDA with NJ OIT; the data files refer to the NDA. 
 
Section 2: Submission Overview 
 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

CenturyLink, Inc. (per email) 

Century Link 

0018626853 

FOR WIRELINE 

Filetypes Shapefiles “ResultantBroadBandInfo-NJ_6_30_11_polyline” and “...region” 

File size  

Speeds 

Type 
 Spatial Resolution: 

county 

Typical-upstream 
 

Census block and 
street segment (w. 
TigerLine REF) 

Typical-downstream 
 

Census block and 
street segment (w. 
TigerLine REF) 

Advertised-upstream  Census block 

Advertised-
downstream 

 
Census block 

Subscriber-weighted-
up 

 
Not provided 

Subscriber-weighted-
down 

 
 

 

 

Technology 
Type 

10 (ADSL) 

End-user 
specification 

Not provided 

Comments:  

INTERCONNECTION DATA 
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ID  

File size  

Ownership  

Transport Type  

Data 
Rates/Capacity 

 

Location  

Comments: Middle-mile data was not provided this submission. 

 

 
 
 
Figure1. Quick load test results 
 
Section 3: Submission File Details 
 
Size (kb) Name 
1202    ResultantBroadBandInfo-NJ_polyline.dbf 
1    ResultantBroadBandInfo-NJ_polyline.prj 
723   ResultantBroadBandInfo-NJ_polyline.shp 
29   ResultantBroadBandInfo-NJ_polyline.shx 
2474   ResultantBroadBandInfo-NJ_region.dbf 
1    ResultantBroadBandInfo-NJ_region.prj 
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11745   ResultantBroadBandInfo-NJ_region.shp 
58    ResultantBroadBandInfo-NJ_region.shx 
 
 
Section 4: Validations and Results 
 
Two shapefiles were submitted: 
 
Shapefile (feature class) ResultantBroadBandInfo-NJ_6_30_11_region provides 
coverage data for census blocks with an area less than or equal to 2 square miles.  It 
contains 7,405 records.  All of the IDs shown in the shapefile correspond to valid Year 
2010 Census Block IDs and all are smaller than 2 square miles. 
 
Shapefile (feature class) ResultantBroadBandInfo-NJ_6_30_11_polyline shows street 
segments, for census blocks larger than 2 square miles.  It contains 3,597 records. The 
polyline data includes a field called TIGER_REF.  We attempted to validate this as a 
Tiger Line ID against Year 2010 line-segment reference data records, but none were 
matched, so we do not know what the column contains.  (In the previous submission, 
we received an answer in response to email that the values are not TigerLine IDs) 
 
The address left-from, left-to, right-from, and right-to fields are problematic because 
they are defined as numeric (not text) which precludes address such as those found in 
parts of NYC such as “12-26”. The fields of this polyline data include: 
AREA_SQMI 
PROVIDER, DBA, FRN, ID, LOCATION 
CENSUS_BLOCK 
MAX_DOWNLOAD, MAX_UPLOAD, TYPICAL_DOWN, TYPICAL_UP 
TECHNOLOGY 
TIGER_REF 
 
The speed data gives cause for concern.  We see significantly different maximum 
advertised speeds in adjacent census blocks.  How is this possible?  Further, the typical 
and maximum advertised columns are *always* identical.  Maybe these data 
correspond to actual customer speed and price-plan choices rather than advertised 
speeds.   
 
Section 5: Data Transformation and Loading 
 
NTIA Table BB_ConnectionPoint_MiddleMile 
 
Loaded 1 row of data from Excel Spreadsheet “middlemile_NJ.txt” (1 row) that was 
supplied for the October 2010 submission.  The following table explains the 
transformations that were applied.  
 
Table 
Column 

Data Source / Transformation  
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PROVNAME Set to “CenturyLink, Inc.” per email 
DBANAME As supplied in DbaName 
FRN As supplied in FRN 
OWNERSHIP As supplied in Own 
BHCAPACITY As supplied in BHCap 
BHTYPE As supplied in BHType 
LATITUDE As supplied in Lat 
LONGITUDE As supplied in Long 
ELEVFEET Set to “0” (zero) 
STATEABBR Set to “NJ” 
FULLFIPSID ID of containing census block from Year 2010 Census Bureau 

TigerLine reference data  
SHAPE Point shape created using ESRI ArcDesktop 
 
Internal notes on October 2011 processing: 

1. Source table was reused from the October 2010 submission. 
2. Added a column containing the ID of the containing year 2010 census block via a 

spatial join of the point and the census block shapes from reference data. 
 
 
NTIA Table BB_Service_CensusBlock 
 
Loaded from supplied shapefile feature “ResultantBroadBandInfo-NJ_region”.  The 
following table explains the transformations that were applied to load the target table. 
 
Table Column  Data Source  / Transformation  
PROVNAME Set to “CenturyLink, Inc.” per email 
DBANAME As supplied in column “dba_name” 
PROVIDER_TYPE Set to 1 
FRN Set to "0018626853" 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from census_blo (digits 3-5) 
TRACT Populated from census_blo (digits 6-11) 
BLOCKID Populated from census_blo (digits 12-15) 
BLOCKSUBGROUP Set to null 
FULLFIPSID As supplied in column census_blo 

See discussion of Census blocks below. 
TRANSTECH As supplied in column technology 
MAXADDOWN As supplied in column max_downlo 
MAXADUP As supplied in column max_upload 
TYPICDOWN Set to null 
TYPICUP Set to null 
SHAPE As supplied 
 
Internal notes on processing 
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1. The supplied feature class uses XY coordinate system name 
GCS_North_American_1983.  The NTIA data model requires XY coordinate 
system GCS_WGS_1984.  To change the projection we applied the geographic 
transformation NAD_1983_To_WGS_1984_5 (per NAD), resulting in a feature 
class with a suffix of “_wgs”. 

2. We had to create a new feature class and reload the data so that the tolerance 
value matches the NTIA transfer model’s tolerance value exactly, resulting in a 
feature class with a suffix of “_wgs_tol”. 

3. The feature class "region" has 287 rows with duplicate census block IDs and 
identical technology codes (confusingly the speeds are different for the some of 
these duplicates).  We discarded these to avoid creating duplicate shapes in the 
table. 

 
 
NTIA Table BB_Service_RoadSegment 
 
Loaded from supplied shapefile feature “ResultantBroadBandInfo-
NJ_6_30_11_polyline”.  The following table explains the transformations that were 
applied to load the target table. 
 
Table Column  Data Source  / Transformation  
PROVNAME Set to “CenturyLink, Inc.” per email 
DBANAME As supplied in column “dba_name” 
PROVIDER_TYPE Set to 1 
FRN Set to "0018626853" 
ADDMIN Set to the least of the non-empty address numbers 
ADDMAX Set to the greatest of the non-empty address numbers 
PREDIR  Set to null (no value supplied) 
STREETNAME As supplied (has all street components, not just name) 
STREETTYPE Set to null (no value supplied) 
SUFFDIR Set to null (no value supplied) 
CITY Set to null (no value supplied) 
STATECODE Set to “NJ” 
ZIP5 Set to null (no value supplied) 
ZIP4 Set to null (no value supplied) 
TRANSTECH As supplied 
MAXADDOWN As supplied 
MAXADUP As supplied 
TYPICDOWN Set to null 
TYPICUP  Set to null 
TLID Set to null since the supplied values in column “tiger_ref” are not 

valid TLID values 
SHAPE As supplied 
 
Internal notes on processing: 

1. The supplied feature class uses XY coordinate system name 
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GCS_North_American_1983.  The NTIA data model requires XY coordinate 
system GCS_WGS_1984.  To change the projection we applied the geographic 
transformation NAD_1983_To_WGS_1984_5 (per ESRI KB article 24159), 
resulting in a feature class with a suffix of “_wgs”. 

2. We had to create a new feature class and reload the data so that the tolerance 
value matches the NTIA transfer model’s tolerance value exactly, resulting in a 
feature class with a suffix of “_wgs_tol”. 

3. We discarded 529 records with no street name (field empty). 
4. The county number and a column "tiger_ref" are supplied for each segment.  We 

checked for uniqueness using the county number and tiger_ref.  After discarding 
records with an empty street name, 2002 unique records were accepted and 
1066 duplicates were dropped.  However this is questionable.  As mentioned in 
validations, the tiger_ref column is not a TLID, so using it for validation might not 
be reasonable. 
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Section 6: Questions 
1. The midlemile data is missing. In the last submission, there is 1 middlemile data? Should 

we assume it is the same as the last submission? 

 
 
From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  
Sent: Monday, August 22, 2011 10:41 AM 

To: 'David.Bonsick@CenturyLink.com' 
Subject: NJBB Clarification 

 

David, 
   We have performed our initial analysis on the data you submitted and had two clarification questions: 

1. Did you use the 2010 geometry for the census blocks that you submitted? 

2. You did not submit any middle mile data.  Does that data you submitted for the October 2010 

delivery still represent your facilities? 

 
Thanks for your cooperation, 
 
 
John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
 

 
Section 7: Notes and Open Issues 
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Section 8: Overview Map of Submitted Data 
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Provider: Clearwire 

Received: September 2011 
Submission date: October 2011 
 
This report presents details on processing of broadband data for delivery to the National 
Telecommunications and Information Administration. 
 
 
Section 1: NDA Status 
 
None 
 
Section 2: Submission Overview 
 

AVAILABILITY DATA 

ID 

PROVIDER NAME 

DBA NAME 

FRN  

Holding company name: 

Holding company number:  

Clearwire Corporation 

Clearwire Corporation 

0017775628 

FOR WIRELESS 

Filetypes 

1 Mapinfo file corresponding to NJ terrestrial 
mobile wireless coverage  

The MapInfo file contains 522 
polygon shapes, as well as attributes 
for each that include: ID_UNIQUE (6 
digit number), CODE (RDG, WMT, 
PHL), and MARKET_ID (3 digit 
number) 

Speeds 

Type 
Spatial Resolution (address, 
street seg, census block, 
RSA/MSA, zipcode) 

Upstream max 
adv 

no. 

Downstream 
max adv 

no. 

Upstream 
typical 

no. 

Downstream 
typical 

no. 

Subscriber-
weighted 

no. 

 

 

Technology 
Type 

Spectrum : no  

Comments:  
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INTERCONNECTION DATA 

ID  

File size  

Ownership  

Transport Type  

Data 
Rates/Capacity 

 

Location  

Comments: no IC data provided. 

 
 

Preview of submitted Mapinfo data: 

 

 
Figure 1. View of submitted data 
 
 
Section 3: Submission File Details 
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1 zip file containing 4 files: 
 
Size kb Name 
19 kb  NJ_WiMAX_090211_region.dbf  
1  NJ_WiMAX_090211_region.prj 
6145  NJ_WiMAX_090211_region.shp 
5  NJ_WiMAX_090211_region.shx 
 
 
Section 4: Validations and Results 
 
The MapInfo file contains 522 polygon shapes, as well as attributes for each that 
include: ID_UNIQUE (a 6 digit number), CODE (RDG, WMT, PHL (are these location 
codes??), and MARKET_ID (a 3 digit (internal?) code). 
 
The shape goes beyond the NJ state boundary.  
 
Provider does not provide: 

1. Name,  DBA Name , FRN, Holding company information 
2. Typical speeds, spectrums 
3. Weighted averages 
4. Interconnection data 

 
 
Section 5: Data Transformation and Loading 
 
NTIA Table BB_Service_Wireless 
 
Loaded from the supplied shapefiles as augmented by email and phone conversations.  
The following table explains the transformations that were applied. 
 
Table Column  Data Source / Transformation  
PROVNAME Set to “Clearwire Corporation” per email and phone interactions 
DBANAME Set to “Clearwire Corporation” per email and phone interactions 
FRN Set to “0017775628” per email and phone interactions 
TRANSTECH Set to “80” (terrestrial mobile wireless) based on statement of WiMAX 
SPECTRUM Set to “5” per email and phone interactions 
MAXADDOWN Set to “5” (code for range of 3-6Mbps) per email and phone 

interactions 
MAXADUP Set to “3” (code for range that includes 1Mbps) per email and phone 

interactions 
TYPICDOWN Set to null 
TYPICUP Set to null 
STATEABBR Set to “NJ” 
SHAPE As supplied. 
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Internal notes on processing: 
5. The supplied shapefile uses geographic coordinate system name 

GCS_WGS_1984.  The NTIA data model requires the same coordinate system.  
No geographic transformation was required.  Loaded into our geodatabase to 
feature class name NJ_WiMAX_090211_region. 

6. The XY Tolerance value differs on the supplied data from the required NTIA 
model.  Imported the table schema and the table data in two separate operations, 
thereby ensuring perfect compatibility with the NTIA data model.  The table has 
the suffix “_tol”. 

7. The shape extends beyond the NJ State boundary.  Clipped the shape using 
ESRI: Analysis Tools-> Extract -> Clip with, select feature class 
Ntia_oct2011.State_Boundary. The table has the suffix "_clip". 272 rows are left 
after clip operation. 

8. Loaded 272 rows. 
 
 
Section 6: Clarification Questions and Responses 
 
(N.B. note “Oregon” and other non-New Jersey locations referenced below.) 
 
Subject: RE: Summary Sheet: New Jersey Broadband Da ta Collection 
Date: Mon, 12 Sep 2011 15:58:09 +0000 
From: Tajit Mehta <tajit.mehta@clearwire.com> 
To: Diane E. Duffy <diane@research.telcordia.com> 
 
Clearwire appreciates the opportunity to participat e.  Attached are map files 
for Clearwire's  WiMAX and Expedience Coverage in O regon State. Clearwire 
operates WiMAX service with respective speeds below  in Portland and Salem.  
All other markets in the attached file operate usin g expedience technology.  
Below are some particulars regarding our service th at you might need per NTIA 
form. 
 
Provider Name: Clearwire Corporation 
DBA: Clear (WiMAX markets), Clearwire (Expedience M arkets) 
FRN: 0017775628 
 
Spectrum:  Clearwire operates its WiMAX and Expedie nce network's using  
2.5MHz spectrum (Spectrum 5 on the NTIA's list). 
 
WIMAX Speed:  Clearwire's WiMAX network delivers av erage mobile download  
speeds of 3 to 6 mbps with bursts over 10 mbps.*  W imax up is 1 Mbps 
 
* Speed claims based on download speeds only. Actua l performance may vary and 
is not guaranteed. CLEAR performance claim is based  on average download user 
speeds achieved during tests performed on the CLEAR  commercial network by 
CLEAR. Other carrier performance based on their adv ertised claims. 
 
Expedience Speed:   Service is offered at Premium ( 1.5 Mbps down) and  
Premium Plus (2 Mbps down). 256 kbps up for both pr emium and premium plus. 
 
Average Speeds: Clearwire does not disclose speeds as stand-alone  
average only a range. 
 
FCC Classification:  Clearwire is classified as ter restrial mobile  
wireless-licensed spectrum. 
 
Middle Mile Request:  Non-response 
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Regards, 
Taj 
 
Taj Mehta - clearw.re - Spectrum Development 
593 Herndon Parkway, Herndon, VA 20170 - Office 571 -490-8577 - Mobile  
571-220-4657 - Fax 571-490-8491 
 
 
-----Original Message----- 
From: Diane E. Duffy [mailto:diane@research.telcord ia.com] 
Sent: Monday, September 12, 2011 11:50 AM 
To: Tajit Mehta 
Cc: Diane Duffy 
Subject: Summary Sheet: New Jersey Broadband Data C ollection 
 
 
Hi Taj, 
Might you be able to forward the summary sheet?  Bi ll is working on  
this, but he needs to get certain approvals from fo lks in the state of  
Pennsylvania and I'm not sure how long that will ta ke. 
Thnx again, 
Diane 
 
 
Section 7: Notes and Open Issues 
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Section 8: Overview Map of Submitted Data 
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Provider: Cogent 

Submission date: October 2011 
 
This report presents details on processing broadband data for delivery to the National 
Telecommunications and Information Administration (NTIA).   
 
This is a stub report, since data from the previous submission was reused unchanged.  
The complete report from the previous submission begins on the next page.  Notable 
differences from the processing done on the previous submission are listed next. 
 
 
NTIA Table BB_Service_CensusBlock 
 

1. Column " blocksubgroup" was dropped. 
2. Column "endusercat" was added; set to null because data was not supplied. 

 
Total rows loaded: 14 
 
Notes  
 
To create the “providerInput” table for this submission, we removed the 2000 census 
block column from the old providerInput table and performed a spatial join against the 
2010 census block reference data table.   
 
 
Provider Interactions 
 
 

From: Zulager, Ried [mailto:RZulager@Cogentco.com]  
Sent: Thursday, July 07, 2011 11:11 AM 

To: Wullert, John R II 
Subject: For your information: NJ Broadband Data Collection 

 

Fine.   The website may have changed slightly, but you can still get a list of address locations fairly easily 
from Cogent’s public facing data.  Just limit your searches to NJ as the jurisdiction of interest. 
 
http://www.cogentco.com/en/network/service-locations  
 
Ried Zulager 
Corporate Secretary 
Cogent Communications Group, Inc. 
1015 31st St. NW 
Washington, DC  20007 
tel: +1-202-295-4274 
rzulager@cogentco.com 
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Broadband Provider Data Report 
 
Provider: Cogent Communications  
Received: August 2010 
Submission date: April 2011 
 
This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 
 
Section 1: NDA Status 
 
No NDA was executed.  All data were taken from the provider’s public web site, FCC 
filings and/or information supplied by the provider via email 
 
Section 2: Submission Overview 
 

MAPPING DATA - RECEIVED MARCH 1, 2011 

ID 

Provider name 

“Doing business as” name 

FRN 

Cogent Communications, Inc. 

Not provided 

0019898303 

FOR WIRELINE 

Filetypes Txt, xls, pdf, etc. Email and pointers to Web site 
and SEC filings 

File size Number of records, data elements List of 20 addresses where 
they offer service  

Speeds 

Type 
Spatial Resolution (address, 
street seg, census block, 
RSA/MSA, zipcode) 

Adver down Address 

Adver up Address 

Typical down Not provided 

Typica up Not provided 

Subscriber-
weighted 

Not provided 

 

 Provided building addresses.  
Adver down and up are 10/11, 
very fast. 

Technology 
Type 

DOCSIS, xDSL, fiber, etc. Fiber 

End-user 
specification 

Business, consumer, gov’t etc  

Comments: They offer service directly to businesses at the addresses they provided.  They are a reseller 
of broadband access to businesses at other locations. 

They had previously refused to provide data on Typical and Subscriber Weighted speeds. Inquired whether 
there was any change in their position on this  via email. 

INTERCONNECTION DATA 

ID Provider name  
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“Doing business as” name 

FRN 

File size Number of records, data elements  

Ownership Leased/owned  

Transport Type Fiber, wireless, copper  

Data 
Rates/Capacity 

  

Location Street address, lat/lon, elevation  

Comments: 

We had previously extracted data for Middle Mile sites, based on the assumption that Cogent’s Data 
Centers were interconnection points.  We were instructed by the provider that these sites did not meet the 
definition of Middle Mile sites and thus should be removed. 

DATA COMPLETENESS 

Data Validation/ 
Verification 

 
 
 

 
 
Section 3: Submission File Details 
 
Received one file by email on 13 Aug 2010: NJ State locations 100813 B.docx.  
Updated the address information via a query of "Service Locations" from provider's Web 
site 
(http://www.cogentco.com/?lang=en&option=com_content&view=article&id=40&action=
search).  Searched using: North America, United States, New Jersey. 
 
Section 4: Validations and Results 
 
Noted that 3 addresses have no street address, and one address did not have a valid 
zip code.  Used Internet search to determine zip code for that location and verified with 
Cogent. 
 
Confirmed provider reported data rates with their published information and SEC filings. 
 
The only other validation to be done is whether each address can be successfully 
geocoded.  See next section.  One address is not  
 
Section 5: Data Transformation and Loading 
 
The standard NDA prohibits us from submitting address-level data to the NTIA.  Instead, 
we discover the census block for each customer address, then report the census block 
shape drawn from Census Bureau TigerLine reference data. 
 
NTIA Table BB_Service_CensusBlock 
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We copied the information to a spreadsheet.  The following table explains the 
transformations that were applied to load the target table. 
 
Table Column  Data Source / Transformation  
PROVNAME Set to “Cogent Communications, Inc.” 
DBANAME Same as PROVNAME 
PROVIDER_TYPE Set to 1 
FRN Set to “0019898303” 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census Block FIPS Code (first 3 digits) 
TRACT Populated from Census Block FIPS Code (next 6 digits) 
BLOCKID Populated from Census Block FIPS Code 
BLOCKSUBGROUP Set to null 
FULLFIPSID Populated from Census Block FIPS Code 
TRANSTECH Set to “50” 
MAXADDOWN Populated from column “Maximum Advertised Speed Down” 
MAXADUP Populated from column “Maximum Advertised Speed Up 
TYPICDOWN Set to null 
TYPICUP Set to null 
SHAPE Copied from Census Bureau TigerLine 2000,  

as matched by spatial join on geocoded address 
 
Internal processing notes: 

14. Geocoded the addresses using the Google geocoder to obtain a Latitude, 
Longitude pair for each.. 

15. Created an excel sheet and imported it to a geodatabase table. 
16. Added point shapes corresponding to each Latitude, Longitude pair by creating a 

feature class from the table using ArcCatalog’s “Create Feature Class from XY 
Table” option. 

17. Added a column containing the ID of the containing year 2000 census block via a 
spatial join of the point shapes and the census block shapes from reference data. 

18. Discarded 8 rows with duplicate census blocks. 
 
The mechanized procedure for the geocoding step is described in file 
GeoExcel_proc.txt. 
 
 
Section 6: Clarification Questions and Responses 
 
 
From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  
Sent: Tuesday, March 01, 2011 4:45 PM 

To: 'Zulager, Ried' 
Cc: ConnectingNJ@research.telcordia.com 

Subject: RE: NJ BB Data Collection - Spring 2011 

Sensitivity: Private 
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Ried, 
    The attached spreadsheet integrates the data you submitted to us last year with and the data we could 
obtain from your Web site and SEC filings.   We will use this data as the basis for the submission to the 
NTIA.   If you have any comments or corrections on the data, please let me know. 
   We did notice that the “Service Location” form on your Web site did not return a valid zip code for the 
5851 Westside Ave in North Bergen.  We assigned an zip code of 07047 based on a Google search. 
   Of the data requested by NTIA, we were not able to obtain data on Typical speeds and the Subscriber 
Weighted Nominal Speed.  You indicated last time that you were not prepared to offer this information.  If 
your position on this matter has changed, we would be happy to receive the data. 
 
Thanks for your cooperation 
 
John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
 
 
From: Zulager, Ried [mailto:RZulager@Cogentco.com]  
Sent: Tuesday, March 01, 2011 6:03 PM 

To: ConnectingNJ@research.telcordia.com 
Subject: RE: NJ BB Data Collection - Spring 2011 

Sensitivity: Private 

 
“We did notice that the “Service Location” form on your Web site did not return a valid zip code for the 
5851 Westside Ave in North Bergen.  We assigned an zip code of 07047 based on a Google search.”  
Seems reasonable; since zip codes are fairly irrelevant to Cogent’s business the zip code is not 
something that hits out A list of priorities in any database – nor is geocode. 
 
 
Section 7: Notes and Open Issues 
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Section 8: Overview Map of Submitted Data 
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Provider: Comcast 

Received: August 2011 
Submission date: October 2011 
 
This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 
 
Section 1: NDA Status 
 
NDA in place 
 
Section 2: Submission Overview 
 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

COMCAST CABLE COMMUNICATIONS LLC 

COMCAST 

0004-4416-63 

FOR WIRELINE 

Filetypes 
Excel files w. Census Block Year 2010 data.  Street segment level and CB level availability 
tables for CB’s less than and greater than 2 sq. mi. 

File size see files 

Speeds 

Type 

 Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Not provided 

Typical-downstream  Not provided 

Advertised-upstream  yes (CBSA/RSA level) 

Advertised-
downstream 

 
yes (CBSA/RSA level) 

Subscriber-weighted-
up 

 
no 

Subscriber-weighted-
down 

 
no. 

 

 

Technology 
Type 

40 (Cable Modem DOCSIS3.0) 

End-user 
specification 

Comcast provides availability at the Census Block and Street Segment level.  

  

INTERCONNECTION DATA: PROVIDED AFTER REQUEST 
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ID  

File size  

Ownership  

Transport Type  

Data 
Rates/Capacity 

 

Location  

Comments:  

 
 
 
Section 3: Submission File Details 
 
Received three (3) files by SECURE UPLOAD. 
 
Size  Name 
55KB  34-streets-NJ.xlsx 
2743KB  34-blocks-NJ.xlsx 
9KB  New Jersey Maximum Advertised Speeds 6 30 11.xlsx 
 
Section 4: Validations and Results 
 
File 34-streets-NJ.xlsx contains 516 records.  No shape is provided, and no reference 
ID such as Tiger Line ID is provided either.  We cannot validate these segments against 
reference data, nor can we generate shapes for these segments. 
 
File 34-blocks-NJ.xlsx contains 62,834 records.  No shape is provided, but a Census 
Block ID is provided.  Every ID is 15 digits long. Provider asserts that these are 2010 
census blocks.   
 
File "..Max Ad.." contains 7 records specifying the max advertised speed by CBSA/RSA.  
The max down speeds are 9 or 10; the max up speeds are all 7. 
 
 
 
Section 5: Data Transformation and Loading 
 
NTIA Table BB_Service_CensusBlock 
 
Loaded 62,834 records from supplied Excel file “34-streets-NJ.xlsx”.  The following table 
explains the transformations that were applied to load the target table. 
 
Table Column  Data Source / Transformation  
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PROVNAME As supplied in column “Provider_Name” but without trailing period 
DBANAME As supplied in column “DBA_NAme” 
PROVIDER_TYPE Set to 1 
FRN As supplied in column “FRN” 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census_Block_FIPS_Code (first 3 digits) 
TRACT Populated from Census_Block_FIPS_Code (next 6 digits) 
BLOCKID Populated from Census_Block_FIPS_Code (last 4 digits) 
FULLFIPSID As supplied in column Census_Block_FIPS_Code 
TRANSTECH As supplied in column Technology_of_Transmission 
MAXADDOWN Set to “10” or “9” (see below) 
MAXADUP Set to “7” (see below) 
TYPICDOWN Set to null, not supplied 
TYPICUP Set to null, not supplied 
SHAPE Copied from Census Bureau TigerLine 2010,  

As matched by Census block 2010 ID 
 
Processing notes: 

1. Census Blocks: Comcast supplied Census 2010 block IDs.  We referenced the 
Census Bureau reference database for Year 2010 to extract and submit 
geographic features (i.e., shapes) for each census block based on the supplied 
Census_Block_FIPS_Code. 

2. Speeds:  Data for maximum advertised down and up speeds were taken from file 
“New Jersey Maximum Advertised Speeds 6 30 11.xlsx”.  Comcast listed the 
same upload speed (7) for all seven MSAs they serve.  Six of the MSAs had the 
same download speed (10).  The remaining MSA (Allentown-Bethlehem-Easton, 
PA-NJ Metropolitan Statistical Area) has a download speed category of 9.  This 
MSA encompasses Warren County in New Jersey.  We identified the census 
blocks in Warren County (CountyFIPS = 041) and set the download speed to 9; 
the speed for all other census blocks was set to 10. 

 
 
NTIA Table BB_Service_RoadSegment 
 
Loaded as discussed below.  The following table explains the transformations that were 
applied to load the target table. 
 
Table Column  Data Source / Transformation  
PROVNAME Set to “Comcast Cable Communications, LLC” 
DBANAME Set to “Comcast” 
PROVIDER_TYPE Set to 1 
FRN Set to “0004441663” 
ADDMIN Set to the least of the non-empty address numbers for the line 

segment 
ADDMAX Set to the greatest of the non-empty address numbers for the line 

segment 
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PREDIR  Set to null (no value supplied) 
STREETNAME As supplied (has all street components, not just name) 
STREETTYPE Set to null (no value supplied) 
SUFFDIR Set to null (no value supplied) 
CITY Set to null (no value supplied) 
STATECODE Set to “NJ” 
ZIP5 Set to value of zipl column for the line segment 
ZIP4 (no value supplied) 
TRANSTECH As supplied (40) 
MAXADDOWN See below 
MAXADUP Set to 7 
TYPICDOWN Set to null 
TYPICUP  Set to null 
SHAPE Copied from Census Bureau TigerLine 2010,  

As matched by County + Tiger Line ID 
 
As mentioned above, the Comcast submission of street segments could not be matched 
with the Census Bureau TigerLine database.  Instead we gathered a list of segments in 
large census blocks based on the municipalities served by Comcast.  We processed 
3142 street segments. 
 
For municipalities served in their entirety by Comcast, the following approach was used. 
(Note: steps 1-4 were performed previously and not repeated for this round.) 

1. Adjusted the Municipality names provided by Comcast with the following rules to 
enable matching with official New Jersey Municipality reference data 

a. Changed to upper case 
b. Performed the following string replacements on the Municipality field 

i. TOWNSHIP -> TWP 
ii. BOROUGH -> BORO (only when preceded by a space) 
iii. MT. -> MOUNT 
iv. PT. -> POINT 
v. ORANGE CITY -> CITY OF ORANGE TWP (ORANGE at start of 

line) 
c. Removed any additional information in parentheses  (I.e., appended 

county name) 
2. Performed join between two data sources, using Municipality and County as keys 
3. Dropped four military bases that did not match any municipality 
4. Generated a file with Municipality, Type, County and Municipal Code 
5. Joined this information with the large census blocks for each municipality, and 

then joined that result with the street segments for each large census block.   
6. Loaded the resulting set of street segments and shapes after removing 

duplicates.  
 
Download Speed 

1. Speeds:  Data for maximum advertised down and up speeds were taken from file 
“New Jersey Maximum Advertised Speeds 6 30 11.xlsx”.  Comcast listed the 
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same upload speed (7) for all seven MSAs they serve.  Six of the MSAs had the 
same download speed (10).  The remaining MSA (Allentown-Bethlehem-Easton, 
PA-NJ Metropolitan Statistical Area) has a download speed category of 9.  This 
MSA encompasses Warren County in New Jersey.  For large census blocks that 
were listed as being in Warren County, we set the download speed to 9; the 
speed for all other census blocks was set to 10. 

 
 
Section 6: Clarification Questions and Responses 
 
From: Ruger, Michael [mailto:Michael_Ruger@comcast.com]  
Sent: Monday, August 15, 2011 5:12 PM 

To: ConnectingNJ@research.telcordia.com 

Cc: Shelley Bates 
Subject: RE: Reminder - NJ Broadband Data Collection 

 

Good afternoon— 
 
 
Attached please find Comcast’s response to the state’s broadband mapping request for information.  The 
data reflects Comcast’s broadband service as of June 30, 2011.  This submission is being provided to the 
state consistent with the terms provided for in the State Broadband Data and Development Grant 
Program established by the Department of Commerce’s National Telecommunications and Information 
Administration.  In particular, this submission is intended to comply with the commitments made by 
Comcast as described in the Department of Commerce’s clarification of the information requirements for 
State Broadband Data and Development Grant Program published on August 7, 2009. 
 
The attached spreadsheets provide the following data, as of June 30, 2011: 
 

• Data for 2010 Census blocks less than two square miles  
• Data for address availability  
• Maximum advertised speeds  

 
Please give me a call if you have any questions. 
 
Thanks-- 
Michael 
 
Michael Ruger 
Senior Director, Government Affairs 
Comcast Cable Communications, LLC 
One Comcast Center 
Philadelphia, Pennsylvania 19103 
(215) 286-7586 
 
 

Section 7: Notes and Open Issues 
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Section 8: Overview Map of Submitted Data 
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Provider: Cablevision 

Received: August 2011 
Submission date: October 2011 
 
This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 
 
Section 1: NDA Status 
 
Executed with NJ OIT. 
 
Section 2: Submission Overview 
 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Holding company name 

Holding company number 

CSC HOLDINGS INC 

CABLEVISION / LIGHTPATH 

0003735909, 0003510195 

CSC Holdings, Inc. 

130370 

FOR WIRELINE 

Filetypes Shapefile with Census Block Year 2010 data 

File size Multiple tables and shapes, for cable modem and optical (Lightpath) technologies. 

Speeds 

Type 

 Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Not provided 

Typical-downstream  Not provided 

Advertised-upstream 
 

Census block and 
street segment 

Advertised-
downstream 

 
Census block and 
street segment 

Subscriber-weighted-
up 

 
Not provided 

Subscriber-weighted-
down 

 Not provided 

 

 

Technology 
Type 

40 (Cable Modem DOCSIS3.0), 41 (Cable Modem - Other), 50 (Optical carrier) 

End-user 
specification 

Yes. Address data provided in 2 shape files (for both cable and optical) with street 
segment ID. (a field is called TLID, which is assumed means Tiger Line ID). 
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Comments: Street data is comprised solely of polylines in the shapefile  while the other files are polygons 
representing coverage. No subscriber weighted data found. 

INTERCONNECTION DATA: PROVIDED AFTER REQUEST 

ID  

File size  

Ownership  

Transport Type  

Data 
Rates/Capacity 

 

Location  

Comments: None. 

 
Figure 1. submitted data (quick preview) 
 



56 
 

Overview of submitted data 
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Section 3: Submission File Details 
 
Received one (1) file by SECURE UPLOAD.  The zip archive contains six shapefiles: 
large census blocks (Cablevision and Lightpath), small census blocks (Cablevision and 
Lightpath), and one with roadsegments (Cablevision and Lightpath).  The data and 
shapes appear to use Year 2010 Census Bureau geometry.  The shapefiles use the XY 
Coordinate System GCS_North_American_1983. 
 
 
Size  Name 

 
 
 
 
Section 4: Validations and Results 
 
Cablevision Census blocks:            60,122 
Cablevision Large Census blocks:         29 
Cablevision Streets:                             516 
 
Lightpath Census blocks:                     811 
Lightpath Large Census blocks:              6 
Lightpath Streets:                                 140     
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Feature class "CV_NJ_AR_AV_2009_TI_ST" 
This road segment table has 39 duplicate shapes according to ESRI. 

 
Feature class "LP_NJ_AR_AV_2009_TI_ST" 

This road segment table has 9 duplicate shapes according to ESRI.   
 

 
 
Section 5: Data Transformation and Loading 
 
NTIA Table BB_ConnectionPoint_MiddleMile 
 
Loaded from data supplied in the XLS sheet.  Only one row describes a connection 
point in New Jersey.  The following table explains the transformations that were applied.  
 
Table 
Column 

Data Source / Transformation  

PROVNAME Set to “CSC HOLDINGS INC” 
DBANAME Set to “CABLEVISION” 
FRN As supplied in column frn_name 
OWNERSHIP Set to code 1, leased 
BHCAPACITY Set to code 4; 1gbps falls in range 600mbps – 2.4gbps 
BHTYPE Set to code 1, fiber 
LATITUDE Obtained by geocoding the address 
LONGITUDE Obtained by geocoding the address 
ELEVFEET Set to “0” (zero) 
STATEABBR Set to “NJ” 
FULLFIPSID ID of containing census block from Year 2010 Census Bureau 

TigerLine reference data  
SHAPE Point shape created using ESRI ArcDesktop 
 
Internal notes on processing: 

1. Reused the table created for the October 2010 submission, but mapped Lat/Long 
to 2010 census block. 

 
 
NTIA Table BB_Service_CensusBlock 
 
Loaded from the two supplied feature classes (shapefiles) with census blocks, one for 
Cablevision and one for LightPath.  The following table explains the transformations that 
were applied to load the target table. 
 
Table Column  Data Source / Transformation  
PROVNAME As supplied in column proname 
DBANAME As supplied in column dbaname 
PROVIDER_TYPE Set to 1 
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FRN As supplied in column frn 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from cenblock (digits 3-5) 
TRACT Populated from cenblock (digits 6-11) 
BLOCKID Populated from cenblock (digits 12-15)  
FULLFIPSID As supplied in column cenblock 
TRANSTECH As supplied  

- For Cablevision: column trechtrans2  
- For Lightpath: column techtrans 

MAXADDOWN As supplied in column maxaddnsp 
MAXADUP As supplied in column maxadupsp 
TYPICDOWN Set to null, not supplied 
TYPICUP Set to null, not supplied 
ENDUSERCAT Set to null, not supplied 
SHAPE As supplied in column shape 
 
Internal processing notes: 

1. Import the features with XY Coordinate System " GCS_North_American_1983" 
via the following three-step process.  (A simple Import using ArcCatalog yields an 
incompatible tolerance value.) 

a. First, copy the data from the shapefiles to the geodatabase using a 
geographic transformation “NAD_1983_to_WGS_1984_5”.  This yields 
feature classes with the required coordinate system but an incorrect 
tolerance value.  Names are "cv_nj_ar_av_cb_lt_2mi" and 
"lp_nj_ar_av_db_lt_2mi".   

b. Second, create new feature classes with the same schema as the 
provided shapefile feature classes and the required coordinate reference 
system (GCS_WGS_1984) and tolerance (0.000000002 degrees).  
Names are " cv_nj_ar_av_cb_lt_2mi _tol" and "lp_nj_ar_av_db_lt_2mi 
_tol".   

c. Third, load the data into the newly created feature classes to ensure 
perfect compatibility with the required coordinate reference system and 
tolerance.   

2. Ignored the column "techtrans1" in the Cablevision feature class 
3. All of the cenblock values correspond to valid Year 2010 Census Block IDs. 
4. The Cablevision data includes 29 census blocks that are larger than 2.0 square 

miles, including blocks 340258017005001 (approx 9 sq mi) and 
340258106003000 (approx 3 sq mi). We discarded this data.  No large blocks 
were found in Lightpath data. 

 
 
NTIA Table BB_Service_RoadSegment 
 
Loaded from the two supplied features with line segments.  The following table explains 
the transformations that were applied to load the target table. 
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Table Column  Data Source  / Transformation  
PROVNAME As supplied in column prvd_name 
DBANAME As supplied in column dba_name 
PROVIDER_TYPE Set to 1 
FRN As supplied in column frn_name 
ADDMIN Set to the least of the non-empty address numbers 
ADDMAX Set to the greatest of the non-empty address numbers 
PREDIR  Set to null (no value supplied) 
STREETNAME As supplied (has all street components, not just name) 
STREETTYPE Set to null (no value supplied) 
SUFFDIR Set to null (no value supplied) 
CITY Set to null (no value supplied) 
STATECODE Set to “NJ” 
ZIP5 Set to null (no value supplied) 
ZIP4 Set to null (no value supplied) 
TRANSTECH As supplied in column tech_trans 
MAXADDOWN As supplied in column max_ad_dwn 
MAXADUP As supplied in column max_ad_up 
TYPICDOWN Set to null (no value supplied) 
TYPICUP  Set to null (no value supplied) 
SHAPE As supplied 
 
Internal processing notes: 

1. Feature classes were imported exactly as discussed above for table 
BB_Service_CensusBlock. 

2. Ignored the column "tech_trans2" in the Cablevision feature class. 
3. Dropped 145 rows with empty street name values. 
4. One data column in the Cablevision and Lightpath feature classes is named 

"linearid".  We validated the data in the “linearid” column against Year 2010 
TigerLine Census Bureau reference data, but none are valid values. We used the 
supplied shapes.  
 
 

  



61 
 

Section 6: Clarification Questions and Responses 
 

1. no interconnection data. (same as the last time) 
 

 
From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  
Sent: Monday, August 22, 2011 11:00 AM 

To: 'tbaecher@cablevision.com' 
Subject: NJBB Clarification 

 

Ted, 
       We have performed our initial review of the data you submitted and we have a clarification question.  
Your recent submission did not include any middle mile information.  Is the middle mile information you 
submitted in March still valid?  If not, could you please supply us with updated information? 
 
Thanks for your cooperation. 
 
John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
 

 
From: Theodore Baecher [mailto:TBAECHER@cablevision.com]  

Sent: Monday, August 22, 2011 11:29 AM 

To: ConnectingNJ@research.telcordia.com 
Subject: Re: NJBB Clarification 

 

John- 
  

The middle mile information we submitted in March is still valid. 
 

Thanks- 

  
Ted 

 

 

 
From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  

Sent: Friday, August 26, 2011 11:34 AM 
To: 'Theodore Baecher' 

Cc: 'ConnectingNJ@research.telcordia.com' 
Subject: NJBB - Data Clarification Request 

 

Ted, 
   We have attempted to load the data you submitted to the NJBB Mapping program and have run into a 
problem with the data for census blocks larger than 2 square miles.  The data we received does not 
include TigerLine IDs and does not include minimum/maximum addresses for the street segments.  This 
information was included in your previous submissions.  We do see a “linearID” field in the submitted 
data, but we do not know how to interpret that data.  This is true for both the cable and LightPath 
services. 

   Can you please provide updated information that includes the street-segment information? 
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Thanks, 
 
 
John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
 

 

Section 7: Notes and Open Issues 
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Section 8: Overview Map of Submitted Data 
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Provider: Dieca DBA Covad 

Received: July 2011 
Submission date: October 2011 
 
This report presents details on processing broadband data for delivery to the National 
Telecommunications and Information Administration. 
 
Section 1: NDA Status 
 
NDA was executed with NJ OIT. 
 
Section 2: Submission Overview 
 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

DIECA Communications, Inc. 

Covad Communications Company 

0003753753 

FOR WIRELINE 

Filetypes  

File size  

Speeds 

Type 

 Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Address & block 

Typical-downstream  Address & block 

Advertised-upstream  Address & block 

Advertised-
downstream 

 
Address & block 

Subscriber-weighted-
up 

 
county level 

Subscriber-weighted-
down 

 
county level 

 

Speeds are provided at address 
(line segment) and census 
block granularity. 

Technology 
Type 

10 (ADS), 20 (SDSL), 30 (other copper) 

End-user 
specification 

Not provided 

Comments:  

INTERCONNECTION DATA 

ID File **MiddleMileConnection*.txt 
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File size 1kb 

Ownership 1 

Transport Type  

Data 
Rates/Capacity 

4, 5 

Location 5 locations 

Comments:Five (5) data rows provided 

 
 
 
Section 3: Submission File Details 
 
Received a zip file by SECURE UPLOAD in July 2011: 
 
Size  Name 
712799 DIECACommunicationsInc._NJ_CONFIDENTIAL.zip 
 
The original archive contains the following five (5) files: 
 
Size  Name 
111959  NJBB_0003753753_AddressSegmentAvailability_DIECACommunicationsInc._CONFIDENTIAL.txt 
21006114 NJBB_0003753753_CensusBlockAvailability_DIECACommunicationsInc._CONFIDENTIAL.txt 
2509  NJBB_0003753753_CMAAdvertisedAvailability_DIECACommunicationsInc._CONFIDENTIAL.txt 
644  NJBB_0003753753_MiddleMileConnection_DIECACommunicationsInc._CONFIDENTIAL.txt 
2254     
 NJBB_0003753753_SubscriberWeightedNominalSpeed_DIECACommunicationsInc._CONFIDENTIAL.txt 
 
 
Received a revised zip file by secure upload in September 2011: 
 
Size  Name 
715421 DIECACommunicationsInc._NJ_CONFIDENTIAL.zip 
 
The revised archive contains the following five (5) files: 
 
Size  Name 
84891  NJBB_0003753753_AddressSegmentAvailability_DIECACommunicationsInc._CONFIDENTIAL.txt 
20820959 NJBB_0003753753_CensusBlockAvailability_DIECACommunicationsInc._CONFIDENTIAL.txt 
2509  NJBB_0003753753_CMAAdvertisedAvailability_DIECACommunicationsInc._CONFIDENTIAL.txt 
644  NJBB_0003753753_MiddleMileConnection_DIECACommunicationsInc._CONFIDENTIAL.txt 
2254     
 NJBB_0003753753_SubscriberWeightedNominalSpeed_DIECACommunicationsInc._CONFIDENTIAL.txt 
 
 
 
Section 4: Validations and Results 
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File “..AddressSegmentAvailability..” 
Technologies: 30,20,10 (xDSL and other copper) 
 
Fields: 
Provider Name  
DBA Name  
FRN  
Census Block ID  
Street Name Street Segment ID (TLID)  
Technology of Transmission  
Maximum Advertised Downstream Speed  
Maximum Advertised Upstream Speed  
Typical Downstream Speed  
Typical Upstream Speed 
 
 
All TLID were validated against year 2010 Census Bureau reference data successfully, 
and all are in large census blocks. 
 
 
File “..CensusBlockAvailability..” 
Fields: 
Provider Name  
DBA Name  
FRN  
Census Block ID  
Technology of Transmission  
Maximum Advertised Downstream Speed  
Maximum Advertised Upstream Speed  
Typical Downstream Speed  
Typical Upstream Speed 
 
The input contains Year 2010 census block data, judging from the consistent length of 
15 digit block IDs.  Due to use of multiple technologies there are more rows here than 
the number of NJ census blocks (169,588).  No duplicates were received, all submitted 
IDs are valid according to Year 2010 reference data, and all are less than 2 square 
miles. 
 
 
File “..CMAAdvertisedAvailability..” 
Provides three technology codes (10, 20, 30), MSA codes, and max advertised up and 
down speed codes.  The max speed for a given technology is different for different 
MSAs.  We are unlikely to use this data since max speed codes are provided on a row-
by-row basis. 
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File “..MiddleMileConnection..” 
 
There are 5 rows, the same as the last submission.  Viewing the data in ArcMap 
indicates that all points are in New Jersey. 
 
File “..SubscriberWeightedNominalSpeed..” 
 
We do not submit overview data in this submission round so will not use this input file. 

 
 
Section 5: Data Transformation and Loading 
 
NTIA Table BB_ConnectionPoint_MiddleMile 
 
Loaded from supplied file “..MiddleMileConnection..”.  The following table explains the 
transformations that were applied.  
 
Table 
Column 

Data Source / Transformation  

PROVNAME As supplied in column Provider Name 
DBANAME As supplied in column DBA Name 
FRN As supplied in column FRN 
OWNERSHIP As supplied in column Ownership 
BHCAPACITY As supplied in column Serving Facility Capacity 
BHTYPE As supplied in column Service Facility Type 
LATITUDE As supplied in column Latitude 
LONGITUDE As supplied in column Longitude 
ELEVFEET As supplied in column Elevation 
STATEABBR Set to “NJ” 
FULLFIPSID ID of containing census block from Year 2010 Census Bureau 

reference data  
SHAPE Point shape created using ESRI 
 
Internal notes on processing: 

1. Created an Excel sheet and imported to a geodatabase table. 
2. Added a point shape to each row corresponding to the Latitude, Longitude pair 

by creating a feature class from the table using ArcCatalog’s “Create Feature 
Class from XY Table” option.  Specify WGS84 for the coordinate system of the 
points.  Result is feature class middlemile_point_tol. 

3. Added a column “geoid10” with the ID of the containing year 2010 census block 
via a spatial join of the points and the census block shapes from reference data.  
Result is feature class middlemile_point_tol_cb. 

 
 
NTIA Table BB_Service_CensusBlock 
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Loaded from supplied file “..CensusBlockAvailability..”.  The following table explains the 
transformations that were applied to load the target table. 
 
Table Column  Data Source / Transformation  
PROVNAME As supplied in column Provider_Name 
DBANAME As supplied in column DBA_Name 
PROVIDER_TYPE Set to 1 
FRN As supplied in column FRN 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census_Block_ID (first 3 digits) 
TRACT Populated from Census_Block_ID (next 6 digits) 
BLOCKID Populated from Census_Block_ID (remaining 4 digits) 
FULLFIPSID As supplied in column Census_Block_ID 
TRANSTECH As supplied in column Technology_of_Transmission 
MAXADDOWN As supplied in column Maximum_Advertised_Downstream_Speed 
MAXADUP As supplied in column Maximum_Advertised_Upstream_Speed 
TYPICDOWN Set to null (see below) 
TYPICUP Set to null (see below) 
ENDUSERCAT Set to null because not supplied 
SHAPE As found in Census Bureau year 2010 reference data 
 
Internal processing notes: 

1. The supplied text file has 219,166 rows. 
2. Discarded typical speeds since they were in all cases identical to maximum 

advertised speeds, not measured values. 
3. We used Census Bureau reference data for Year 2010 to locate and submit 

geographic features (i.e., shapes) for each census block.  All submitted blocks 
were matched. 

4. Total rows (shapes) loaded is 219,166. 
 

 
 
NTIA Table BB_Service_RoadSegment 
 
 
Loaded from supplied File “..AddressSegmentAvailability..".  The following table 
explains the transformations that were applied to load the target table. 
 
Table Column  Data Source / Transformation  
PROVNAME As supplied in column Provider_Name 
DBANAME As supplied in column DBA_Name 
PROVIDER_TYPE Set to 1 
FRN As supplied in column FRN 
ADDMIN Set to the least of the non-empty address numbers from TigerLine 
ADDMAX Set to the greatest of the non-empty address numbers from 

TigerLine 
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PREDIR  Set to null (no value supplied) 
STREETNAME As supplied (has all street components, not just name) 
STREETTYPE Set to null (no value supplied) 
SUFFDIR Set to null (no value supplied) 
CITY Set to null (no value supplied) 
STATECODE Set to “NJ” 
ZIP5 Set to zipl from TigerLine 
ZIP4 Set to null (no value available in reference data) 
TRANSTECH As supplied in column Technology_of_Transmission 
MAXADDOWN As supplied in column Maximum_Advertised_Downstream_Speed 
MAXADUP As supplied in column Maximum_Advertised_Upstream_Speed 
TYPICDOWN Set to null (see below) 
TYPICUP  Set to null (see below) 
SHAPE Road segment shape from Year 2010 TigerLine reference data, as 

matched by TLID 
 
Internal processing notes: 

1. Of 722 input rows, discarded 1 row as duplicates based on compound key of 
county, TLID, and tech_transmission fields (TLID 134418087).  This probably 
occurs because a road segment touches different counties, but we cannot submit 
duplicate shapes. 

2. After a join against Census Bureau 2010 reference data, no rows were discarded 
based on compound key of county, TLID, and tech_transmission fields.  

3. Total rows (shapes) loaded is 721. 
 
 
Section 6: Clarification Questions and Responses 
 

1. It looks like that they use the 2010 Census blocks. But we need to confirm. 

 
From: Wullert, John R II  
Sent: Monday, August 22, 2011 11:04 AM 

To: 'SSanta@covad.com' 

Subject: NJBB Clarification 

 

Stefanie, 
       We have performed our initial review of the data you submitted and we have a clarification question.  
Your recent submission did not include any middle mile information.  Is the middle mile information you 
submitted in February still valid?  If not, could you please supply us with updated information? 
 
Thanks for your cooperation. 
 
John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
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From: Stefanie Santa-Esparza [mailto:Stefanie.Santa-Esparza@megapath.com]  

Sent: Monday, August 22, 2011 1:54 PM 
To: Wullert, John R II 

Subject: RE: NJBB Clarification 

 

John, 
There were 5 txt docs in the zip file I uploaded to your FTP site.  
NJBB_0003753753_MiddleMileConnection_DIECACommunicationsInc._CONFIDENTIAL.txt is the one 
with our middle mile information.  However, it is true that it is unchanged from last submission. 
 
Thanks, 
Stefanie 
 
 
From: Wullert, John R II [mailto:jwullert@telcordia.com]  
Sent: Monday, August 22, 2011 11:01 AM 

To: Stefanie Santa-Esparza 
Subject: RE: NJBB Clarification 

 

Stefanie, 
   I apologize.  I am sending questions to many providers and I inadvertently sent the wrong question to 
you.  What I did want to do is confirm that you submission did use the 2010 Census Block geometry. 
 
John 
 
 
From: Stefanie Santa-Esparza [mailto:Stefanie.Santa-Esparza@megapath.com]  

Sent: Monday, August 22, 2011 2:03 PM 
To: Wullert, John R II 

Subject: RE: NJBB Clarification 
 
John, 
No worries.  Yes, we used 2010 census data.  
 
Thanks, 
Stefanie 
 
 
From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  
Sent: Thursday, September 15, 2011 5:04 PM 

To: 'SSanta@covad.com' 
Cc: ConnectingNJ@research.telcordia.com 

Subject: NJBB Clarification 

 

Stefanie, 
   In the course of our validation of the data you submitted to the New Jersey Broadband project, we have 
come across a problem.  It seems that a large number of the street segments that you submitted (192 of 
them) are not located in large census blocks.  The attached file gives several examples.  We would like to 
represent your service area as accurately as possible, and hope that you can analyze the data and 
resubmit within the next week.  If you are not able to do so, we will have to drop those street segments 
from the submission. 
   If you have any questions, please call or email. 
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John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
 
 
Section 7: Notes and Open Issues 
 
There are 192 street segments that do not belong to large census blocks. 
Below are a few examples: 
 
Example 1. 
Block ID  Street Name  Street Segment ID (TLID) 
340030021002008 Allison Rd  64376023 
 

 
 
 
Example 2: 
Block ID  Street Name  Street Segment ID (TLID) 
340030021002008 Closter Dock Rd 64427166 
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Example 3: 
Block ID  Street Name  Street Segment ID (TLID) 
340258005003001 Broadway  90535998 
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Section 8: Overview Map of Submitted Data 
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Provider: Earthlink Business (previously New Edge) 

Received: October 2011 
Submission date: October 2011 
 
This report presents details on processing of broadband data for delivery to the National 
Telecommunications and Information Administration. 
 
Section 1: NDA Status 
 
None 
 
Section 2: Submission Overview 
 
 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

EarthLink Business 

EarthLink Business 

0003720471 

FOR WIRELINE 

Filetypes Txt, xls, pdf, etc. Xls 

File size Number of records, data elements 605 rows 

Speeds 

Type Spatial Resolution (address, street seg, census 
block, RSA/MSA, zipcode) 

Upstream 1 = < 200, 2 = 200-768, 3 = 768-1.5, 4 = 1.5-3 

Downstream 3 = 768-1.5, 4 = 1.5-3, 5 = 3-6 

Typical Not given 

Advertised See above 
 

Existing customer addresses as 
unfielded data 

No census blocks. 

Technology Type DOCSIS, xDSL, fiber, etc. 10 = ADSL, 20 = SDSL, 30 = other DSL

End-user 
specification 

Business, consumer, gov’t etc Not specified; looks like businesses

   

FOR WIRELESS 
Filetypes shapefile collection: shp/dbf/prj/shx, mdb, gdb, imagefile etc. N/A 

Speeds 

Type Spatial Resolution (address, street seg, census 
block, RSA/MSA, zipcode) 

Upstream  

Downstream  

Typical  

Advertised  

Subscriber-
weighted 

 

 

 

Technology Type Spectrum (Mhz, FCC code)  
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INTERCONNECTION DATA 

ID 

Provider name 

“Doing business as” name 

FRN 
None 

File size Number of records, data elements  

Ownership Leased/owned  

Transport Type Fiber, wireless, copper  

Data 
Rates/Capacity 

  

Location Street address, lat/lon, elevation  

DATA VALIDATION AND VERIFICATION 

Data Validation/ 
Verification 

-  

 
 
 
Section 3: Submission File Details 
 
Received 1 file by a CD in June 2010.  Instructed by provider to use prior data. 
 
Size  Name 
184320 NJ_Service_Address.xls 
 
Section 4: Validations and Results 
 
Address data has 605 records. 
 
Data Completeness 

- New Edge reported a list of addresses that appears to be locations where they 
currently offer service 

o We are interpreting this to mean they offer service in that census block 
- New Edge reported maximum advertised speeds 
- New Edge did not report typical speeds or subscriber weighted average speeds. 
- New Edge said that they do not have the ability to report Middle Mile data 

Speed/technology data 
- The New Edge data included certain addresses with multiple services 

o In some cases the same location had more than one record with different 
maximum advertised speeds 

- New Edge reported technologies of ADSL (code 10), SDSL (code 20) and other 
DSL (code 30) 

- The Maximum Advertised Speeds reported by New Edge indicated downloads at 
rates of 768 kbps to 6 Mbs (codes, 3, 4, 5) and uploads at less than 200 kbs to 3 
Mbs (codes 1, 2, 3, 4) 
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Middle Mile Data 
None reported 
 
Section 5: Data Transformation and Loading 
 
We determine the census block for each customer address, and then report the census 
block shape drawn from Census Bureau TigerLine reference data. 
 
NTIA Table BB_Service_CensusBlock 
 
Loaded from the file mentioned above.  The following table explains the transformations 
that were applied to load the target table. 
 
Table Column  Data Source / Transformation  
PROVNAME Set to “EarthLink Business” 
DBANAME Set to “EarthLink Business” 
PROVIDER_TYPE Set to “2” 
FRN As supplied in column 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census Block FIPS Code (first 3 digits) 
TRACT Populated from Census Block FIPS Code (next 6 digits) 
BLOCKID Populated from Census Block FIPS Code 
FULLFIPSID Populated from Census Block FIPS Code 
TRANSTECH As supplied in column  
MAXADDOWN As supplied in column  
MAXADUP As supplied in column  
TYPICDOWN Set to null (see below) 
TYPICUP Set to null (see below) 
ENDUSERCAT Set to null (see below) 
SHAPE Copied from Census Bureau TigerLine 2010,  

as matched by spatial join on geocoded address 
 
Internal processing notes: 

1. Geocoded the addresses using an Arroyo flow and the Yahoo geocoder, leaving 
the result with address and lat, long data in an Excel spreadsheet.   

2. Imported the spreadsheet to a simple ESRI geodatabase table 
3. Added point shapes corresponding to each Latitude/Longitude pair by creating a 

feature class from the table using ArcCatalog’s “Create Feature Class from XY 
Table” option 

4. Added a column containing the ID of the containing year 2010 census block 
using ArcCatalog's spatial join feature.  The newly created point shapes are 
joined against census block shapes from reference data.  All records successfully 
spatially joined on 2010 NJ Census Block shapes. 

5. Discarded 198 records with upload speeds that are not considered broadband 
(speed code 1). 

6. Discarded 83 duplicate census block records, which result from multiple 
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addresses in the same census block. 
7. Discarded 1 large census block record (340330216005000). 
8. Loaded 323 records. 

 
Section 6: Clarification Questions and Responses 
  
Questions for clarification 

• The data submitted by New Edge Networks appears to be based on a listing of 
existing customers.  What does the offering of service at these locations imply 
about the ability to offer service to other locations within the census block or 
along a street segment.   

• Response (via phone conversation): New Edge is a pure reseller serving 
business customers only. They do not do residential at all (not home-based 
business, according to Pia). They are co-located in LEC central offices and, 
when they get a service request, they go to LECs for pre-qualification.  Pia's view 
is that they can provide service anywhere that a LEC can. But she also said that 
'technically they are not facilities-based.'  We elected to limit their coverage area 
based on current delivery.  We will need to determine in the future if we should 
adjust the coverage area to match LEC. 

 
 
Section 7: Notes and Open Issues 



78 
 

Section 8: Overview Map of Submitted Data 
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Provider: GOES Telecom 

Received: July 2011 
Submission date: October 2011 
 
This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 
 
Section 1: NDA Status 
 
None 
 
Section 2: Submission Overview 
 

AVAILABILITY DATA 

ID 

Provider name 
“Doing business as” name 
FRN 
Holding company name 
Holding company number 

GOES Telecom 
Not provided 
0011437746 
GOES 
130548 

FOR WIRELINE 

Filetypes 1 Excel  

File size worksheet 17,408 bytes, approx 28 rows 

Speeds 

Type 

 Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Not provided 

Typical-downstream  Not provided 

Advertised-upstream  Not provided 

Advertised-
downstream 

 
Not provided 

Subscriber-weighted-
up 

 
Not provided 

Subscriber-weighted-
down  

Not provided 

 

Submitted 28 addresses with 
upload and download speeds 
(generally in kbps) for each 
address.   These are delivered 
speeds to customers.  We 
located advertised speeds on 
their Web site, and provider 
confirmed that those speeds 
were available at each location 
they served.  We will use the 
data from Web site as 
advertised speeds.   

Note that for three addresses, 
submitted speeds as “10mpbh”.  
Need to ask them what that 
means.  We asked these 
questions last time, but did not 
receive a response in time to 
submit.  This time we received 
corrected data. 

Note also that some speeds are 
listed as having faster upload 
speeds than download speeds.  
Need to verify.  We asked these 
questions last time, but did not 
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receive a response in time to 
submit.  This time we received 
corrected data. 

No typical or subscriber 
weighted speeds were 
provided. 

Technology 
Type 

10 (ADSL) and 70 (Terrestrial fixed wireless) 

End-user 
specification 

None 

Comments: Provided a list of 28 customers and the speeds they are subscribed to.  Most are 128K up, 512K 
down. 

INTERCONNECTION DATA 

ID None provided 

File size  

Ownership  

Transport Type  

Data 
Rates/Capacity 

 

Location  

Comments: 

 
 
Section 3: Submission File Details 
 
Received 1 file by email: 
 
Size  Name 
17,408 20110711 Telcordia.xls 
 
The file contains a list of addresses and max speeds; e.g., the “up-to” limit of their rate 
plan.  The addresses in this file appear to be for individual customers (as opposed to 
addresses of multi-tenant buildings in a central business district).   
 
Section 4: Validations and Results 
 
For many ADSL subscribers, a download/upload rating of 512K/128K looks reasonable, 
but this is not a "broadband" service according to the NOFA definition.  We will discard 
records for slow services. 
 
Some ADSL subscribers have upload speeds that exceed download.  The last two 
entries have unknown speed ratings: 10mpbh up and 10mpbh down.   
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What spectrum is used by the fixed wireless service? 
 
 
Section 5: Data Transformation and Loading 
 
All addresses were successfully geocoded using Arroyo with Yahoo geocoder. All 
records successfully spatially joined on 2010 NJ Census Block shapes. 
 
The standard NDA prohibits us from submitting address-level data to the NTIA.  Instead, 
we will discover the census block for each customer address, then report the census 
block shape drawn from Census Bureau TigerLine reference data. 
 
NTIA Table BB_Service_CensusBlock 
 
 
Loaded from supplied file “20110711 Telcordia_update.xls” (28 data rows).  The 
following table explains the transformations that were applied to load the target table. 
 
Table Column  Data Source / Transformation  
PROVNAME Set to “Global Online Electronic Services, Inc.” 
DBANAME Not supplied; set same as PROVNAME 
PROVIDER_TYPE Set to 1 
FRN Set to “0011437746” 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census Block FIPS Code (first 3 digits) 
TRACT Populated from Census Block FIPS Code (next 6 digits) 
BLOCKID Populated from Census Block FIPS Code 
BLOCKSUBGROUP Set to null 
FULLFIPSID Populated from Census Block FIPS Code 
TRANSTECH As supplied in column Technology Code 
MAXADDOWN Set to code 4 per March 2011 email response to questions 
MAXADUP Set to code 3 per March 2011 email response to questions 
TYPICDOWN Set to null, not provided 
TYPICUP Set to null, not provided 
SHAPE Copied from Census Bureau 2010, 

as matched by spatial join on geocoded address point 
 
Internal processing notes: 

1. Geocoded the addresses using the Google geocoder to obtain latitude, longitude 
value pairs. 

2. Created point shapes using ESRI from lat, long value pairs. 
3. Spatially joined the points with Census Bureau Year 2010 reference data to find 

the containing census block.  This yielded census block attributes including the 
block ID (“geoid10”). 

4. Dropped duplicate census blocks (caused by two customers in the same census 
block). 
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5. Loaded the resulting data into an SDE feature class.  Of 28 original records, all 
were successfully geocoded; 10 have broadband speeds (rest are 512Kbps 
down); and 2 are duplicates, leaving 8 records; 7 use wireline technology. 

 
The mechanized procedure for the three steps is described in file GeoExcel_proc.txt. 
 
 
NTIA Table BB_Service_Wireless 
 
Loaded using shapes from reference data for the 1 record that indicates wireless 
technology.  The following table explains the transformations that were applied. 
 
Table Column  Data Source / Transformation  
PROVNAME Set to “Global Online Electronic Services, Inc.” 
DBANAME Not supplied; set same as PROVNAME 
FRN Set to "0011437746" 
TRANSTECH Set to 70 as supplied in XLS sheet 
SPECTRUM Set to 6 
MAXADDOWN Set to 7 
MAXADUP Set to 7 
TYPICDOWN Set to null 
TYPICUP Set to null 
STATEABBR Set to “NJ” 
SHAPE Year 2010 Census Block shape obtained from reference data. 
 
Internal processing notes: 

9. See above for discussion of geocoding addresses and finding the containing 
census block. 

10. Spectrum: Set to 6, Unlicensed 
11. Speeds: The fixed-wireless link is reported with 10Mbps in each direction 

(symmetric).  That corresponds to NOFA speed code 7. 
 
 
Section 6: Clarification Questions and Responses 
 
See March 2011 provider data report. 
 

 

Section 7: Notes and Open Issues 
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Section 8: Overview Map of Submitted Data 

 
  



84 
 

Provider: Hometown Online 

Received: July 2011 
Submission date: October 2011 
 
This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 
 
Section 1: NDA Status 
 
No NDA in place. 
 
Section 2: Submission Overview 
 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Hometown Online Inc. 

Warwick Online  

0006-6512-44 

FOR WIRELINE 

Filetypes Text 

File size 1,764,352 bytes; 6,778 rows 

Speeds 

Type 

 Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Not provided 

Typical-downstream  Not provided 

Advertised-upstream  Not provided 

Advertised-
downstream 

 
Not provided 

Subscriber-weighted-
up 

 
Not provided 

Subscriber-weighted-
down 

 
Not provided 

 

Provided list of customer 
locations with column “DSL 
speed avail”.  This is probably 
downstream speed, but need to 
verify with provider. 

 

Communications with provider 
and validation via their Web site 
resulted in clarification: Max 
advertised speeds are: 

Downstream: 15 Mbps 

Upstream: 800 Mbps. 

‘ 

Rows where the speed and 
DSL Qual columns are blank 
indicate no-service.  These 
should be dropped. 

 

Provider has column that 
indicates geo-spatial 
capabilities, but only one 
address in list appears to be 
geo-located on their map 

Technology 
Type 

DSL – not clear in each case whether it is Asymmetric or Symmetric 
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End-user 
specification 

Not provided 

Comments: Address data with some indications of qualification for different data services. 

INTERCONNECTION DATA 

ID  

File size  

Ownership  

Transport Type  

Data 
Rates/Capacity 

 

Location  

Comments:No connection-point data provided 

 
 
 
Section 3: Submission File Details 
 
Received one (1) file by EMAIL: 
 
Size  Name 
1,761,280 M4 STRUCTURES - NJ 7-18-11.xls 
 
 
Section 4: Validations and Results 
 
The file contains 6778 rows of data.  Each row has a street address.  All rows have an 
indication of maximum possible DSL speed.  Some indicate 5Mbps, some 15Mpbs and 
some 25Mbps.  Also has information about TV qualification, which we will ignore. 
 
All normal validations performed. 
 
 
Section 5: Data Transformation and Loading 
 
The standard NDA prohibits us from submitting address-level data to the NTIA.  Instead, 
we discover the census block for each customer address, and then report the census 
block shape drawn from Census Bureau TigerLine reference data. 
 
NTIA Table BB_Service_CensusBlock 
 
Loaded from the supplied file after geocoding.  The following table explains the 
transformations that were applied to load the target table. 
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Table Column  Data Source / Transformation  
PROVNAME Set to “Hometown Online Inc.” 
DBANAME Set to “Warwick Online” 
PROVIDER_TYPE Set to 1 
FRN Set to “0006651244” 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census Block 2010 (first 3 digits) 
TRACT Populated from Census Block 2010 (next 6 digits) 
BLOCKID Populated from Census Block 2010 Code 
BLOCKSUBGROUP Set to null 
FULLFIPSID Populated from Census Block 2010 Code 
TRANSTECH Set to code “10” (ADSL) 
MAXADDOWN Set to code “7” (range includes 15Mbps, per email) 
MAXADUP Set to code “3” (range includes 1Mbps, per email) 
TYPICDOWN Set to null, not supplied 
TYPICUP Set to null, not supplied 
SHAPE Copied from Census Bureau TigerLine 2000,  

as matched by spatial join on geocoded address point 
 
Internal processing notes: 

1. All addresses were successfully geocoded using Arroyo with the Yahoo 
geocoder. Four records failed to spatially join on 2010 NJ Census Block shapes. 

2. Created an excel sheet and imported to a geodatabase table. 
3. Added point shapes corresponding to each Latitude,Longitude pair by creating a 

feature class from the table using ArcCatalog’s “Create Feature Class from XY 
Table” option. 

4. Added a column containing the ID of the containing year 2010 census block via a 
spatial join of the point shapes and the census block shapes from reference data. 

5. Kept only blocks in the cities of Hardyston, Highland, Vernon, and West Milford 
(several variations like Twp and Township).  Discarded 14 blocks that were 
geolocated in cities Hewitt, Hillsdale, Wantage Twp, etc. 

6. Discarded 6310 rows with duplicate census blocks, leaving 449 unique census 
blocks. 

7. Discarded 1 census block larger than 2 square miles (340312568021002).   
8. Loaded 448 blocks. 

 
 
Section 6: Clarification Questions and Responses 
 
See April 2011 report for clarifications. 
 
 
Section 7: Notes and Open Issues 
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Section 8: Overview Map of Submitted Data 
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Provider: HughesNet Communications Inc. 

Submission date: October 2011 
 
This report presents details on processing broadband data for delivery to the National 
Telecommunications and Information Administration (NTIA).   
 
This is a stub report, since data from the previous submission was reused unchanged.  
The complete report from the previous submission begins on the next page.  Notable 
differences from the processing done on the previous submission are listed next. 
 
NTIA Table BB_Service_Wireless 
 
Total rows loaded: 21 (each county in New Jersey) 
 
Notes 
 
Provider Interactions 
 
None, the provider did not respond to our requests for updates.  This data was used 
without explicit instructions from the provider.  It seemed highly unlikely that the satellite 
coverage has changed in six months, so we elected to reuse prior data. 
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Connecting New Jersey - Broadband Provider Data Report 
 
Provider: HughesNet Communications Inc. 
Received: March 2011 
Submission date: April 2011 
 
This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 
 
Sections: 

1. NDA Status 
2. Submission Overview 
3. Submission File Details 
4. Data Validations and Results 
5. Data Transformation and Loading 
6. Clarification Questions and Provider Responses 
7. Notes and Open Issues 

 
 
Section 1: NDA Status 
 
NONE 
 
Section 2: Submission Overview 
 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Hughes Network Systems, LLC 

HughesNet 

0017434911 

FOR WIRELINE 

Filetypes  

File size  

Speeds 

Type 

 Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Not provided 

Typical-downstream  Not provided 

Advertised-upstream  Provided 

Advertised-
downstream 

 
Provided 

Subscriber-weighted-
up 

 
Not provided 

Submitted Excel file containing 
a list of counties per state that 
are covered by their service.  
This included all 21 counties in 
New Jersey.  

 

Email message contained an 
image that listed their three 
consumer service plans and the 
associated upstream and 
downstream data rate. 

Max plan "Power 200" is 2Mbps 
down, 300Kbps up.  The 
corresponding speed range 
codes are 4 down, 2 up. 
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Subscriber-weighted-
down 

 
Not provided 

 

 

Spectrum is 7, satellite. 

Technology 
Type 

Code 60 (Satellite) 

End-user 
specification 

Voice message indicated that the referenced plans are consumer-focused. 

Comments:  

INTERCONNECTION DATA: NONE 

ID  

File size  

Ownership  

Transport Type  

Data 
Rates/Capacity 

 

Location  

Comments: Not provided 

 
 
 
Section 3: Submission File Details 
 
Received an extraordinarily short email explaining their service offering, with a JPG 
image of the northeastern United States showing where they have subscribers.   
 
 
Section 4: Validations and Results 
 
No rows of data need to be validated. 
 
 
Section 5: Data Transformation and Loading 
 
NTIA Table BB_Service_Wireless 
 
Loaded county shapes from reference data for the State of New Jersey based on 
emailed statements that all counties are covered.  The following table explains the 
transformations that were applied. 
 
Table Column  Data Source / Transformation  
PROVNAME Set to "Hughes Network Systems, LLC" 
DBANAME Set to "HughesNet" 
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FRN Set to 0017434911 
TRANSTECH Set to 60 
SPECTRUM Set to 7 per translation shown below 
MAXADDOWN Set to 4, see below. 
MAXADUP Set to 2”, see below. 
TYPICDOWN Not provided, set to null 
TYPICUP Not provided, set to null 
STATEABBR Set to “NJ” 
SHAPE County shape read from reference data. 
 
Internal notes on processing: 

12. Spectrum: No statement was provided.  The NTIA data model has a single 
column for spectrum.  Satellite corresponds to NTIA “SPECTRUM USED” code 
value 7. 

13. Speeds: The maximum advertised speeds provided in the emailed brochure are 
as discussed above  For max adv speeds we encoded the submitted down 
speed as value 4 (range 1.5-3 Mbps) and encoded the submitted up speed as 
value 2 (range 200 Kbps -- 768 Kbps). 

 
 
Section 6: Clarification Questions and Responses 
 
From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  

Sent: Wednesday, March 09, 2011 1:46 PM 

To: 'Mark Wymer' 
Cc: ConnectingNJ@research.telcordia.com 

Subject: RE: NJ Broadband Data Collection 

 

Mark, 
   Thanks for the information.   Sorry I did not return your call – I just got back from a meeting. 
 
   One question – do you have information on typical speeds that are experienced by your customers on 
each of these plans? 
 
A side note – the NTIA is interested in finer-grained information than this, looking at specific factors that 
affect satellite coverage, such as terrain and building shadowing.  As I understand it, they will be 
contacting satellite providers at some point in the future to discuss appropriate techniques to model such 
effects. 
 
Thanks for you participation in the program. 
 
 
John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
 
 
From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  
Sent: Friday, March 18, 2011 10:43 AM 
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To: 'Mark.Wymer@hughes.com' 

Cc: 'NJ Broadband Data Collection' 
Subject: Hughes NJ Broadband Clarification 

 

Mark, 
   We need to report data to the NTIA using Provider Name, Doing-Business-As Name and FCC 
Registration number.  The information we retrieved from the FCC is: 
 
Provider Name:                Hughes Network Systems, LLC  
FRN:                                      00 17434911 
 
Are these correct?  Also, do you have another “doing-business-as” name? 
 
Thanks, 
 
 
John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
 
 
Section 7: Notes and Open Issues 
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Section 8: Overview Map of Submitted Data 
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Provider: Leap Cricket 

Received: Aug, 2011 
Submission date: Oct, 2011 
 
This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 
 
Section 1: NDA Status 
 
None 
 
Section 2: Submission Overview 
 

AVAILABILITY DATA 

ID 

PROVIDER NAME 

DBA NAME 

FRN  

Holding company name: 

Holding company number:  

Leap Wireless International, Inc. 

Cricket Communications, Inc. 

0002963528 

Leap Wireless International, Inc." 

130730 

FOR WIRELESS 

Filetypes 1 Mapinfo file corresponding to NJ terrestrial 
mobile wireless coverage (type 80) 

 

Speeds 

Type 
Spatial Resolution (address, 
street seg, census block, 
RSA/MSA, zipcode) 

Upstream max 
adv 

yes (for entire shapefile) given 
in tier 

Downstream 
max adv 

yes (for entire shape) given in 
tier 

Upstream 
typical 

no. 

Downstream 
typical 

no. 

Subscriber-
weighted 

no. 

 

 

Technology 
Type 

Spectrum : yes 3 (PCS) and 4(AWS) 

Comments:  

INTERCONNECTION DATA 

ID  

File size  
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Ownership  

Transport Type  

Data 
Rates/Capacity 

 

Location  

Comments: no IC data provided. 

 
  



 

Quick loading results: 
 

Figure 1. Loading results 
 
 
Section 3 : Submission File Details

 
1 zip file containing 5 files by (EMAIL, SECURE UPLOAD)
 
Size  Name 
1KB  NJ_Broadband_region.dbf
1KB  NJ_Broadband_regio
1KB  NJ_Broadband_region.shx
820KB NJ_Broadband_region.shp
2KB  NJ_Broadband_region.TAB
 
Section 4 : Validations and Results
 
The Mapinfo file contains a single row with a multipolygon shape (see above for preview 
picture).  The columns identify that 
two different spectrum ranges are in use.   Speed values were reasonable for the 
technology. 
 
 
Section 5 : Data Transformation and Loading
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: Submission File Details  

(EMAIL, SECURE UPLOAD): 

NJ_Broadband_region.dbf 
NJ_Broadband_region.prj 
NJ_Broadband_region.shx 
NJ_Broadband_region.shp 
NJ_Broadband_region.TAB 

: Validations and Results  

The Mapinfo file contains a single row with a multipolygon shape (see above for preview 
picture).  The columns identify that the technology of transmission is wireless and that 
two different spectrum ranges are in use.   Speed values were reasonable for the 

: Data Transformation and Loading  

The Mapinfo file contains a single row with a multipolygon shape (see above for preview 
the technology of transmission is wireless and that 

two different spectrum ranges are in use.   Speed values were reasonable for the 
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Loaded from the supplied Mapinfo file, with transformations as s 
 
Table Column  Data Source / Transformation  
PROVNAME As supplied in column prov_name 
DBANAME As supplied in column dba_name 
FRN Set to "130730" 
TRANSTECH As supplied in column tech_trans 
SPECTRUM Set to “4” per translation shown below 
MAXADDOWN As supplied in column down_speed. 
MAXADUP As supplied in column up_speed.. 
TYPICDOWN Not supplied, set to null 
TYPICUP Not supplied, set to null. 
STATEABBR Set to “NJ” 
SHAPE As supplied. 
 
Internal notes on processing: 

1. The supplied shape uses geographic coordinate system GCS_WGS_1984, same 
as that required by the NTIA data model.   

2. Spectrum: Leap provided “Y” value in the columns spectrum_pcs and 
spectrum_aws.  In the NTIA model the AWS spectrum is coded as value 4.  In a 
response to our query, Leap indicated that the different spectra are in use in 
different places of their footprint.  They have not provided separate shape files for 
these different spectrum bands. 

 
 
Section 6: Clarification Questions and Responses 
 
Provider provides 2 spectrum values for the coverage shape (PCS and AWS). We have 
previously requested separation of the shapes for these different technologies to no 
avail. 
 
 
From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  

Sent: Friday, March 04, 2011 1:33 PM 

To: 'dougwhite@cricketcommunications.com' 
Cc: 'ConnectingNJ@research.telcordia.com' 

Subject: NJBB Clarification Questions 

 

Doug, 
   We have reviewed the data you submitted to the NJ Broadband mapping program and have a few 
clarification questions: 

1. You include two spectrum values in the data you submitted.  Are those two spectrum bands 

used uniformly throughout the area specified by the shape? 

2. The NTIA is encouraging us to request and submit to them subscriber weighted nominal speed 

(down only) for each county served and middle mile locations.  Are you willing to provide this 

data? 
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Thanks for your participation in the program. 
 
 
John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
 
 
From: Douglas White [mailto:dougwhite@cricketcommunications.com]  

Sent: Monday, March 14, 2011 6:54 PM 
To: ConnectingNJ@research.telcordia.com 

Subject: RE: NJBB Clarification Questions 

Importance: High 

 

John – please see Cricket’s response below.  Thanks, 
-Doug 
 
Doug White 
Manager, Government Affairs 

Cricket Communications, Inc. 
5887 Copley Drive 

San Diego, CA 92111 
Phone: 858-882-9394 

Fax: 858-882-6080 

dougwhite@cricketcommunications.com 

 
 
 
From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  

Sent: Friday, March 04, 2011 10:33 AM 
To: Douglas White 

Cc: ConnectingNJ@research.telcordia.com 

Subject: NJBB Clarification Questions 

 

Doug, 
   We have reviewed the data you submitted to the NJ Broadband mapping program and have a few 
clarification questions: 

3. You include two spectrum values in the data you submitted.  Are those two spectrum bands 

used uniformly throughout the area specified by the shape? 

• No, they are not used uniformly in all the shape area.  PCS spectrum band is used only in 

Mercer and Cumberland counties and AWS in all the rest of the counties with coverage. 

4. The NTIA is encouraging us to request and submit to them subscriber weighted nominal speed 

(down only) for each county served and middle mile locations.  Are you willing to provide this 

data? 

• We will not be providing middle mile data. 

 
Thanks for your participation in the program. 
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From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  

Sent: Monday, March 14, 2011 8:44 PM 
To: 'Douglas White' 

Cc: 'ConnectingNJ@research.telcordia.com' 

Subject: RE: NJBB Clarification Questions 

 

Doug, 
   Can you provide us with separate shape files for the PCS and AWS?  I would offer to extract a shape 
for the counties, but I am sure your coverage areas do not line up exactly with the county boundaries. 
 
Thanks, 
John 
 
 
 
 
Section 7: Notes and Open Issues 
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Section 8: Overview Map of Submitted Data 
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Provider: Level3 Networks, Inc. 

Received: August 2011 
Submission date: October 2011 
 
This report presents details on processing of broadband data for delivery to the National 
Telecommunications and Information Administration. 
 
Section 1: NDA Status 
 
No NDA executed. 
 
Section 2: Submission Overview 
 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Level 3 Communications, LLC 

Level 3 

0003723822 

FOR WIRELINE 

Filetypes Text file spreadsheets 

File size 350 data rows 

Speeds 

Type  Address level data 

Typical-upstream  Yes 

Typical-downstream  Yes 

Advertised-upstream  Yes 

Advertised-
downstream 

 
Yes  

Subscriber-weighted-
nominal speed 

 
Not provided 

 

All set to same value: 11 ( >= 
1gpbs) 

Technology 
Type 

50 (optical carrier/fibre) 

End-user 
specification 

Yes (addresses) 

Comments: typical and Advertised UP and DOWN are ALL THE SAME VALUE:  11 ( >= 1gpbs) 

INTERCONNECTION DATA 

ID  

File size text spreadsheet with 338 rows. (See comment) 

Ownership Not provided 

Transport Type provided 

Data provided 
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Rates/Capacity  

Location Address provided as well as lat/long 

Comments: A large number of duplicate rows were confusing. This is worth asking the provider. 

 

Provider indicates that they are separate instances and should NOT be removed as duplicates. 

 
 
 
Section 3: Submission File Details 
 
Received 2 files by secure upload: 
 
Size kb Name 
45  AddressAvailability_NewJersey_8-18-2011.txt 
41  MiddleMile_New Jersey_8-18-2011.txt  
 
 
Section 4: Validations and Results 
 
The “address” file has 350 rows.  All speed codes set the same, code 11 (1+ Gbps), 
suggesting these are all commercial customers.   
 
The “middlemile” file has 338 rows, including many rows that are exact duplicates which 
we will have to discard despite the provider’s assurances that they are “different”. 
 
 
Section 5: Data Transformation and Loading 
 
The standard NDA prohibits us from submitting address-level data to the NTIA.  Instead, 
we discover the census block for each customer address, and then report the census 
block shape drawn from Census Bureau TigerLine reference data. 
 
NTIA Table BB_ConnectionPoint_MiddleMile 
 
Loaded from the supplied tab-separated file.  The following table explains the 
transformations that were applied.  
 
Table 
Column 

Data Source / Transformation  

PROVNAME As supplied in column “DBA”  (no provider name supplied separately) 
DBANAME As supplied in column “DBA” 
FRN As supplied in column “FRN” after removing dashes 
OWNERSHIP Set to null (not supplied) 
BHCAPACITY As provided in column “Serving Facility Capacity” 
BHTYPE As provided in column “Serving Facility Type” 
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LATITUDE As supplied 
LONGITUDE As supplied  
ELEVFEET As supplied (all zero values) 
STATEABBR Set to “NJ” 
FULLFIPSID ID of containing census block from Year 2010 Census Bureau 

TigerLine reference data  
SHAPE Point shape created using ESRI ArcDesktop 
 
Internal notes on processing: 

1. Imported the data to a geodatabase table 
2. Added a point for each Latitude, Longitude pair by creating a feature class from 

the table using ArcCatalog’s “Create Feature Class from XY Table” option. 
3. Added a column containing the ID of the containing year 2010 census block via a 

spatial join of the points and the census block shapes from reference data. All 
records successfully spatially joined on 2010 NJ Census Block shapes. 

4. Discarded 149 records with identical lat, long values and addresses. 
5. Loaded 188 records. 

 
 
NTIA Table BB_Service_CensusBlock 
 
Loaded from the supplied tab-separated file.  The following table explains the 
transformations that were applied to load the target table. 
 
Table Column  Data Source / Transformation  
PROVNAME As supplied in column “DBA”  (no provider name supplied 

separately) 
DBANAME As supplied in column “DBA” 
PROVIDER_TYPE Set to “1” 
FRN As supplied in column “FRN” 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census Block FIPS Code (first 3 digits) 
TRACT Populated from Census Block FIPS Code (next 6 digits) 
BLOCKID Populated from Census Block FIPS Code 
FULLFIPSID Populated from Census Block FIPS Code 
TRANSTECH As supplied in column “Technology of Transmission” 
MAXADDOWN As supplied in column “Maximum Advertised Download Speed”  
MAXADUP As supplied in column “Maximum Advertised Upload Speed” 
TYPICDOWN Set to null (see below) 
TYPICUP Set to null (see below) 
ENDUSERCAT Set to null (see below) 
SHAPE Copied from Census Bureau TigerLine 2010,  

as matched by spatial join on the geocoded address 
 
Internal processing notes: 

1. Geocoded the addresses using an Arroyo flow and the Yahoo geocoder, leaving 



104 
 

the result with address and lat, long data in an Excel spreadsheet.  All addresses 
were successfully geocoded, although 1 was not placed in New Jersey. 

2. Imported the spreadsheet to an ESRI geodatabase table 
3. Added point shapes corresponding to each Latitude,Longitude pair by creating a 

feature class from the table using ArcCatalog’s “Create Feature Class from XY 
Table” option 

4. Added a column containing the ID of the containing year 2010 census block 
using ArcCatalog's spatial join feature.  The newly created point shapes are 
joined against census block shapes from reference data.  All but three records 
successfully spatially joined on 2010 NJ Census Block shapes. 

5. Discarded typical speeds since they were in all cases identical to maximum 
advertised speeds, not measured values. 

6. The end user category value as originally supplied applied to an address, but we 
must anonymize the addresses and report census blocks.  The NTIA directs us 
to report the “predominant” end-user category, which is not supplied here. 

7. Discarded 79 duplicate census block records, which result from multiple 
addresses in the same census block. 

8. Loaded 270 records. 
 
 
Section 6: Clarification Questions and Responses 
 
 
From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  
Sent: Wednesday, August 24, 2011 9:14 AM 

To: Diamond, Greg 

Cc: ConnectingNJ@research.telcordia.com 
Subject: NJBB Data Clarification 

 

Greg, 
   We have reviewed the data you submitted to the New Jersey Broadband Mapping 
program.   We have one question. The middle-mile data you submitted in 
MiddleMile_New Jersey_8-18-2011.txt includes many rows that are duplicates.  Can we 
safely discard these duplicate entries? 
 
Thanks for you participation, 
 
 
John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
 

 
From: Diamond, Greg [mailto:Greg.Diamond@Level3.com]  
Sent: Wednesday, August 24, 2011 1:17 PM 

To: ConnectingNJ@research.telcordia.com 
Subject: RE: NJBB Data Clarification 
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John, this issue came up with our CA submission as well.  We investigated and determined that there 
were in fact some differences, albeit small, with some of the sites such that each site is in fact unique.  
Give that, I would not treat them as duplicates. 
 
Greg 
 
 
 
 
PLEASE NOTE MY NEW ADDRESS AND TELEPHONE NUMBER 
Gregory T. Diamond 
Regulatory Counsel 
Level 3 Communications 
1505 5th Avenue 
Suite 501 
Seattle, WA 98110 
Desk:  206-652-5608 
Mobile:  303-562-7378 
 
 
Section 7: Notes and Open Issues 
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Section 8: Overview Map of Submitted Data 
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Provider: Monmouth Telephone and Telegraph 

Received: July 2011 
Submission date: October  2011 
 
This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 
 
Section 1: NDA Status 
 
Signed NDA is in place with NJ OIT. 
 
Section 2: Submission Overview 
 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Monmouth Telephone & Telegraph 

same 

0004325205 

FOR WIRELINE 

Filetypes Csv (NJBB_0004325205_AddressLevelAvailability.csv)  

File size 105958 bytes, 1054 records 

Speeds 

Type 

 Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Address 

Typical-downstream  Address 

Advertised-upstream  Address 

Advertised-
downstream 

 
Address 

Subscriber-weighted-
up 

 
None provided 

Subscriber-weighted-
down 

 
Not provided 

 

 

Technology 
Type 

Code 30 – other copper line  

Code 50 - Optical Carrier/Fiber to the End User 

End-user 
specification 

Code 4 – Medium or Large Enterprise 

Comments:  
 

INTERCONNECTION DATA 

ID  
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File size  

Ownership  

Transport Type  

Data 
Rates/Capacity 

 

Location  

Comments: No middle mile was provided at this time.  Monmouth gave the following explanation: 

 

Please note that Table 8, “Middle-mile and Backbone Interconnection Points Data”, is not included per 
instructions on page 11 of the  Data Submission Specifications” “Middle-mile and Backbone Interconnection 
Point information should focus on the connectivity at a point. That is, if a point at which network elements or 
segments are joined would not reasonably offer the possibility of technical connectivity with the network[s], it 
should not be reported”. 
 

 
 
Section 3: Submission File Details 
 
The data are very similar to the last submission. 
 
Received 1 zip file: 
 
Size  Name 
20Kb  Broadband Mapping.zip 
 
The zip archive contains the following files: 
 
Size  Name 
104Kb  NJBB_0004325205_AddressLevelAvailability.csv 
1Kb  NJBB_0004325205_CMAAdvertisedAvailability.csv 
1Kb  NJBB_0004325205_SubscriberWeightedNominalSpeed.csv 
21Kb  Read Me.doc 
 
File details: 
 
File NJBB_0004325205_AddressLevelAvailability.csv:  
 
The file contains 1054 records.  Note that data file does not have a header row, but 
follows (largely) the ADDRESS DATA table from the NTIA “State Broadband Data and 
Development Grant Program” document. The columns and the corresponding headers 
are: 

A  - Provider Name 
C  - FRN 
D-L - Address 
M  - EndUserCat 
N  - TransTech 
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O  - MaxAdvDown 
P  - MaxAdvUp 
Q  - TypicDown 
R  - TypicUp 

 
The FRN is missing leading zeros. Very few entries are provided in the 4-digit zip 
column (L), some do not have the required leading zeros.  It was established (prior 
interactions) that the DBA is Monmouth Telephone & Telegraph. Certain addresses will 
need to be fixed for geocoding (also per prior interactions). 
Some records have speed tiers of 2 or less. 
 
  
NJBB_0004325205_CMAAdvertisedAvailability.csv 
 
The file contains 14 records. Note that data file does not have a header row, but follows 
the CMA data submission template that we posted on the connectingnj web site. The 
columns and the corresponding headers are: 

A  - Provider Name 
C  - FRN 
D - CMA 
E  - TransTech 
F  - MaxAdvDown 
G  - MaxAdvUp 

 
 
NJBB_0004325205_SubscriberWeightedNominalSpeed.csv 
 
The file contains 14 records. Note that data file does not have a header row, but follows 
the Subscriber-Weighted Nominal Speed data submission template that we posted on 
the connectingnj web site. The columns and the corresponding headers are: 

A  - Provider Name 
C  - FRN 
D - CMA 
E  - TransTech 
F  - SubsWeightedSpeed 

 
 
Read Me.doc 
 
The file contains explanations of the submission. 
 
 
Section 4: Validations and Results 
 
See notes in file description section 
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Some of the addresses will be difficult or impossible to geo-locate due to format; e.g., 
“179 Ave at the Common & 11, Shrewsbury, NJ” 
 
 
Section 5: Data Transformation and Loading  
 
The standard NDA prohibits us from submitting address-level data to the NTIA.  Instead, 
we will discover the census block for each customer address, then report the census 
block shape drawn from Census Bureau TigerLine reference data. 
 
NTIA Table BB_Service_CensusBlock 
 
Loaded from supplied Excel spreadsheet after suitable geospatial operations.  The 
following table explains the transformations that were applied to load the target table. 
 
Table Column  Data Source / Transformation  
PROVNAME Set to “Monmouth Telephone & Telegraph” 
DBANAME Set same as PROVNAME 
PROVIDER_TYPE Set to 1 
FRN Set to “0004325205” 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census Block FIPS Code (first 3 digits) 
TRACT Populated from Census Block FIPS Code (next 6 digits) 
BLOCKID Populated from Census Block FIPS Code 
BLOCKSUBGROUP Set to null 
FULLFIPSID Populated from Census Block FIPS Code 
TRANSTECH As supplied in column TransTech 
MAXADDOWN As supplied in column MaxAdvDown 
MAXADUP As supplied in column MaxAdvUp 
TYPICDOWN Set to null 
TYPICUP Set to null 
SHAPE Copied from Census Bureau TigerLine 2000,  

as matched by spatial join on geocoded address 
 
Internal processing notes: 

1. All NJBB_0004325205_AddressLevelAvailability.csv records were successfully 
geocoded. Geocoded the addresses using the Google and Yahoo geocoders to 
obtain a Latitude, Longitude pair for each.. Addresses that yielded results with 
accuracy of 6 or below were excluded; only intersection (7) or rooftop (8) 
accuracy is acceptable.  

2. Created an Excel sheet and imported it to a geodatabase table. 
3. Added point shapes corresponding to each Latitude, Longitude pair by creating a 

feature class from the table using ArcCatalog’s “Create Feature Class from XY 
Table” option. 

4. Added a column containing the ID of the containing year 2010 census block via a 
spatial join of the point shapes and the census block shapes from reference data. 
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One record failed to spatially join on the 2010 NJ Census Block shapes.   
5. Discarded 100 rows because the max adv down speed code was 1 or 2, which is 

not broadband according to the requirements of the NOFA 
6. Discarded 185 rows with duplicate census blocks while preserving the greatest 

speed.  These result from multiple customers in the same census block. 
7. Discarded 4 large census blocks (greater than 2 square miles). 
8. Final record count loaded is 764. 

 
 
 
Section 6: Clarification Questions and Responses 
 
 

 
Section 7: Notes and Open Issues 
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Section 8: Overview Map of Submitted Data 
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Provider: Netcarrier 

Received: June 2011 
Submission date: October 2011 
 
This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 
 
Section 1: NDA Status 
 
None 
 
Section 2: Submission Overview 
 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Netcarrier 

Netcarrier Telecom, Inc. 

0005043195 

FOR WIRELINE 

Filetypes Excel 

File size 119 KB (595 rows) 

Speeds 

Type 
 Spatial Resolution: 

address  

Typical-upstream  Address-level 

Typical-downstream  Address-level 

Advertised-upstream  Address-level 

Advertised-
downstream 

 
Address-level 

Subscriber-weighted-
up 

 
Not provided 

Subscriber-weighted-
down 

 
Not provided 

 

Provides a .xls file with 895 
rows of information (end user 
addresses). 

Technology 
Type 

Types: 10, 30, 50 

End-user 
specification 

Address level. 

Comments: No weighted values provided. 

INTERCONNECTION DATA 

ID NJ_Broadband_Mapping-Backbone-090711 

File size 12 kb 

Ownership Not provided 
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Transport Type Facility type provided (code 1 and 2 used) 

Data 
Rates/Capacity 

Not provided 

Location Provided by street address (elevation provided as well) 

Comments: 2 other fields called V-COORD and H-COORD (5 digit #’s) are provided. 

 
 
 
Section 3: Submission File Details 
 
Received 1 file by secure upload: 
 
Size  Name 
74 kb  NJ477_Workbook-090411-NJ-BroadbandMapping-A.xls 
12  NJ_Broadband_Mapping-Backbone-090711.xls 
 
 
Section 4: Validations and Results 
 
Address data has 895 records that appear to be valid locations with reasonable 
technology and speed information 
 
Backbone has 11 records. 
 
 
Section 5: Data Transformation and Loading 
 
The standard NDA prohibits us from submitting address-level data to the NTIA.  Instead, 
we discover the census block for each customer address, and then report the census 
block shape drawn from Census Bureau TigerLine reference data. 
 
NTIA Table BB_ConnectionPoint_MiddleMile 
 
Loaded from the supplied Excel Spreadsheet.  The following table explains the 
transformations that were applied.  
 
Table 
Column 

Data Source / Transformation  

PROVNAME As supplied in column “Provider Name” but changed “c” to “C” 
DBANAME As supplied in column “DBA” but changed “c” to “C” 
FRN As supplied in column “FRN” 
OWNERSHIP As provided in column “Ownership” 
BHCAPACITY As provided in column “Serving Facility Capacity” 
BHTYPE As provided in column “Serving Facility Type” 
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LATITUDE As computed from address 
LONGITUDE As computed from address 
ELEVFEET Set to “0” (zero); values such as “Fl 1” were not parsed 
STATEABBR Set to “NJ” 
FULLFIPSID ID of containing census block from Year 2010 Census Bureau 

TigerLine reference data  
SHAPE Created using ESRI ArcDesktop 
 
Internal notes on processing: 

1. Used the provider name, DBA name, and FRN as supplied. 
2. Geocoded the address to obtain a Latitude, Longitude value pair. All middle-point 

addresses were successfully geocoded using Arroyo with Yahoo geocoder. 
3. Imported the resulting data to a geodatabase table. 
4. Added a point for the Latitude, Longitude pair by creating a feature class from the 

table using ArcCatalog’s “Create Feature Class from XY Table” option. 
5. Added a column containing the ID of the containing year 2010 census block via a 

spatial join of the points and the census block shapes from reference data. All 
records successfully spatially joined on 2010 NJ Census Block shapes. 

6. Loaded 11 records. 
 
 
NTIA Table BB_Service_CensusBlock 
 
Loaded from the file mentioned above.  The following table explains the transformations 
that were applied to load the target table. 
 
Table Column  Data Source / Transformation  
PROVNAME As supplied in column “Provider Name” but changed “c” to “C” 
DBANAME As supplied in column “DBA” but changed “c” to “C” 
PROVIDER_TYPE Set to “1” 
FRN As supplied in column “FRN” 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census Block FIPS Code (first 3 digits) 
TRACT Populated from Census Block FIPS Code (next 6 digits) 
BLOCKID Populated from Census Block FIPS Code 
FULLFIPSID Populated from Census Block FIPS Code 
TRANSTECH As supplied in column “Technology Code” 
MAXADDOWN As supplied in column “Max Ad Download Speed”  
MAXADUP As supplied in column “Max Ad Upload Speed” 
TYPICDOWN Set to null (see below) 
TYPICUP Set to null (see below) 
ENDUSERCAT Set to null (see below) 
SHAPE Copied from Census Bureau TigerLine 2010,  

as matched by spatial join on geocoded address 
 
Internal processing notes: 
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1. Geocoded the addresses using an Arroyo flow and the Yahoo geocoder, leaving 
the result with address and lat, long data in an Excel spreadsheet.  All addresses 
were successfully geocoded (note: Excel file has an empty record at the end). 

2. Imported the spreadsheet to a simple ESRI geodatabase table 
3. Added point shapes corresponding to each Latitude,Longitude pair by creating a 

feature class from the table using ArcCatalog’s “Create Feature Class from XY 
Table” option 

4. Added a column containing the ID of the containing year 2010 census block 
using ArcCatalog's spatial join feature.  The newly created point shapes are 
joined against census block shapes from reference data.  All but three records 
successfully spatially joined on 2010 NJ Census Block shapes. 

5. Discarded typical speeds since they were in all cases identical to maximum 
advertised speeds, not measured values. 

6. The end user category value as originally supplied applied to an address, but we 
must anonymize the addresses and report census blocks.  The NTIA directs us 
to report the “predominant” end-user category, which is not supplied here. 

7. Discarded 324 duplicate census block records, which result from multiple 
addresses in the same census block. 

8. Discarded 1 large census block record (340297351041013). 
9. Loaded 567 records. 

 
 
 
Section 6: Clarification Questions and Responses 
 
Provider did not provide: 

1. Subscriber weighted values  
 
Section 7: Notes and Open Issues 
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Section 8: Overview Map of Submitted Data\ 
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Provider: Network Billing Systems 

Received: August 2011 
Submission date: October 2011 
 
This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 
 
Section 1: NDA Status 
 
None 
 
Section 2: Submission Overview 
 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Network Billing Systems LLC 

 
0004965141 

FOR WIRELINE 

Filetypes NO Data Provided 

File size  

Speeds 

Type  Spatial Resolution: 

Typical-upstream   

Typical-downstream   

Advertised-upstream   

Advertised-
downstream 

 
 

Subscriber-weighted-
up 

 
 

Subscriber-weighted-
down 

 
 

 

None 

Technology 
Type 

Types:  

End-user 
specification 

 

Comments:  

INTERCONNECTION DATA 

ID  

File size  

Ownership Not provided 
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Transport Type Fiber 

Data 
Rates/Capacity 

Not provided 

Location Provided by street address 

One email with three addresses of their fiber ring interconnections, two in New Jersey. 

 
 
 
Section 3: Submission File Details 
 
Received 1 file by email: 
 
Size  Name 
1Kb  NBS_MiddleMile txt.txt 
 
Section 4: Validations and Results 
 
Addresses were geocoded.  Limited validation is possible as only middle mile data was 
provided. 
 
 
Section 5: Data Transformation and Loading 
 
 
NTIA Table BB_ConnectionPoint_MiddleMile 
 
The following table explains the transformations that were applied.  
 
Table 
Column 

Data Source / Transformation  

PROVNAME Set to “Network Billing Systems LLC” 
DBANAME Set to “Network Billing Systems LLC” 
FRN Set to “0004965141” 
OWNERSHIP Set to null, not provided 
BHCAPACITY Set to 5, OC-48 is 2.5Gbps 
BHTYPE Set to 1, transport facility is fiber 
LATITUDE As computed from address 
LONGITUDE As computed from address 
ELEVFEET Set to “0” (zero) 
STATEABBR Set to “NJ” 
FULLFIPSID ID of containing census block from Year 2010 Census Bureau 

TigerLine reference data  
SHAPE Created using ESRI ArcDesktop 
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Internal notes on processing: 
1. Used the provider name, DBA name, and FRN from FCC Form 477 reference 

data. 
2. Geocoded the address to obtain a Latitude, Longitude value pair. All middle-point 

addresses were successfully geocoded using Arroyo with Yahoo geocoder. 
3. Imported the resulting data to a geodatabase table. 
4. Added a point for the Latitude, Longitude pair by creating a feature class from the 

table using ArcCatalog’s “Create Feature Class from XY Table” option. 
5. Added a column containing the ID of the containing year 2010 census block via a 

spatial join of the points and the census block shapes from reference data. All 
records successfully spatially joined on 2010 NJ Census Block shapes. 

6. Loaded 2 records. 
 
 
Section 6: Clarification Questions and Responses 
 
 
Section 7: Notes and Open Issues 
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Section 8: Overview Map of Submitted Data 
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Provider: One Communications 

Received: June 2011 
Submission date: October 2011 
 
This report presents details on processing of broadband data for delivery to the National 
Telecommunications and Information Administration. 
 
Section 1: NDA Status 
 
Executed an NDA with NJ OIT. 
 
Section 2: Submission Overview 
 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

One Communications 

Not provided 

015-33-7702 

FOR WIRELINE 

Filetypes Excel (“One NJ Broadband Connections Data as of 06.30.11.xls”) 

File size 119 KB (595 rows) 

Speeds 

Type 
 Spatial Resolution: 

address  

Typical-upstream  Not provided 

Typical-downstream  Not provided 

Advertised-upstream  Not provided 

Advertised-
downstream 

 
Not provided 

Subscriber-weighted-
up 

 
Not provided 

Subscriber-weighted-
down 

 
Not provided 

 

Provided table with 
addresses and speeds at 
each address.   Speed columns 
are labeled “Downstream 
speed” and “Maximum 
upstream speed” with values 
2..8. 

Code 8 is  “25 mbps and less 
than 50 mbps”;( Verified that is 
possible on copper?) 

Technology 
Type 

10 (ADSL), 20 (SDSL), 30 (Other copper) 

End-user 
specification 

All 3 (small business) – 88 rows at the end of the set have no EndUserCat specified.? 

Comments:  

INTERCONNECTION DATA 

ID Not provided 

File size  

Ownership  
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Transport Type  

Data 
Rates/Capacity 

 

Location  

Comments: 

 
 
 
Section 3: Submission File Details 
 
Received 1 file by secure upload: 
 
Size  Name 
119 kb One NJ Broadband Connections Data as of 6.30.11.xls 
 
 
Section 4: Validations and Results 
 
Speed data has values between 2 and 8. 
Code 8 is  “25 mbps and less than 50 mbps”. 
 Verified that is possible on copper. 
 
Section 5: Data Transformation and Loading 
 
NTIA Table BB_Service_CensusBlock 
 
Loaded from supplied Excel file.  The following table explains the transformations that 
were applied to load the target table. 
 
Table Column  Data Source / Transformation  
PROVNAME As supplied in column “Provider Name” 
DBANAME Not supplied; set same as PROVNAME 
PROVIDER_TYPE Set to 1 
FRN As supplied in column FRN, without dashes 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census_Block_ID (first 3 digits) 
TRACT Populated from Census_Block_ID (next 6 digits) 
BLOCKID Populated from Census_Block_ID (remaining 4 digits) 
FULLFIPSID As discovered from reference data (see below) 
TRANSTECH As supplied in column Technology of Transmission 
MAXADDOWN As supplied in column Maximum Downstream Speed 
MAXADUP As supplied in column Maximum Upstream Speed 
TYPICDOWN Set to null (see below) 
TYPICUP Set to null (see below) 
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ENDUSERCAT Set to null because not supplied 
SHAPE As found in Census Bureau year 2010 reference data 
 
Internal processing notes: 

1. All addresses were successfully geocoded using Arroyo with Yahoo geocoder. 
2. Created an excel sheet and imported it to a geodatabase table. 
3. Added point shapes corresponding to each Latitude, Longitude pair by creating a 

feature class from the table using ArcCatalog’s “Create Feature Class from XY 
Table” option. 

4. All records successfully spatially joined on 2010 NJ Census Block shapes to find 
the containing census block (ID and shape) for each address. 

5. Discarded 84 rows with duplicate census blocks (multiple addresses in the same 
census block). 

6. Discarded 1 row with a census block larger than 2 square miles 
(340230085021027). 

7. Loaded 509 records. 
 
 
Section 6: Clarification Questions and Responses 
 

1. 88 rows at the end of the set have no EndUserCat specified 
2. Clarify semantics of table rows named “Donwstream Speed” (e.g., typical, 

chosen?), and “Maximum Upstream Speed” (see question from last round). From 
last round the response was: 

a. “The data in the max up/down columns correspond to the maximum speeds 

available to each respective customer for his/her service.  I realize that the 

request asks for typical up/download speeds.  However, I was informed by our 

engineering department that this information is not typical kept and available in 

our systems.” 
3. Looks like the rest is similar to past input so similar questions remain (though 

they may have been answered acceptably already). E.g., see Speed’s table 
above and the comments left there. 

 
 
Section 7: Notes and Open Issues 
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Section 8: Overview Map of Submitted Data\ 
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Provider: Service Electric Cable TV of Hunterdon 

Submission date: October 2011 
 
This report presents details on processing broadband data for delivery to the National 
Telecommunications and Information Administration (NTIA).   
 
This is a stub report, since data from the previous submission was reused unchanged.  
The complete report from the previous submission begins on the next page.  Notable 
differences from the processing done on the previous submission are listed next. 
 
NTIA Table BB_Service_CensusBlock 
 

1. Column " blocksubgroup" was dropped. 
2. Column "endusercat" was added; set to null because data was not supplied. 

 
Total rows loaded: 1,745 
 
 
NTIA Table BB_Service_RoadSegment 
 

1. Column " blocksubgroup" was dropped. 
2. Column "endusercat" was added; set to null because data was not supplied. 

 
Total rows loaded: 76 
 
 
Notes 
 
 
Provider Interactions 
 
August 10, 2011: Tim Himmelright informed us via voice mail that there have been no 
changes in their speeds or coverage.   
 
August 11, 2011: John sent email asking for written confirmation. 
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Connecting New Jersey - Broadband Provider Data Report 
 
Provider: Service Electric Cable TV of Hunterdon 
Submission date: April 2011 
 
This report presents details on processing broadband data for delivery to the National 
Telecommunications and Information Administration (NTIA).  This is a stub report, since 
data from the previous submission was reused unchanged.  The complete report from 
the previous submission begins on the next page.  Notable differences from the 
processing done on the previous submission are listed next. 
 
NTIA Table BB_Service_CensusBlock 
 

1. Dropped the column "reseller". 
2. Added the column "provider_type" and populated with value 1 ("Broadband 

provider as described in the NOFA") 
 
NTIA Table BB_Service_RoadSegment 
 

1. Dropped the column "reseller". 
2. Added the column "provider_type" and populated with value 1 ("Broadband 

provider as described in the NOFA") 
 
Provider Interactions 
 
Tim Himmelright of Service Electric called and spoke to John Wullert on 4 March 2011 
and confirmed that their data had not changed since the October data collection cycle 
and instructed us to use the previous data. 
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Connecting New Jersey - Broadband Provider Data Report 
 
Provider: Service Electric Cable TV of Hunterdon 
Received: August 2010 
Submission date: October 2010 
 
This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 
 
Section 1: NDA Status 
 
None. 
 
Section 2: Submission Overview 
 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Service Electric Cable TV of 
Hunterdon, Inc. 

DBA not provided 

0003760014 

FOR WIRELINE 

Filetypes Text (a letter, not structured data) 

File size  

Speeds 

Type 

 Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Not provided 

Typical-downstream  Not provided 

Advertised-upstream  Municipality 

Advertised-
downstream 

 
Municipality 

Subscriber-weighted-
up 

 
Not provided 

Subscriber-weighted-
down 

 Not provided 

 

Advertised downstream speeds 
1.5, 3, 5, 7 and 10 mbps; up 
speed 800 kbps. 

 

Typical Speeds were confirmed 
prior to October submission to 
be 10-15% below advertised. 

Technology 
Type 

Docsis 2.0 (use code 41) 

End-user 
specification 

Not provided 

Comments:  
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INTERCONNECTION DATA 

ID None 

File size  

Ownership  

Transport Type  

Data 
Rates/Capacity 

 

Location  

Comments: 

 
Section 3: Submission File Details 
 
Received email for October submission with information on the municipalities served in 
entirety, the technology of transmission, and the speed tiers offered to customers.  
Confirmed that information via phone on March 4, 2011 
 
Section 4: Validations and Results 
 
The sole data to validate is their provided list of municipality names: 
 
Municipality  County  
Alexandria Township Hunterdon 
Alpha Borough Warren 
Bloomsbury Borough Hunterdon 
Frenchtown Borough Hunterdon 
Greenwich Township Warren 
Harmony Township Warren 
Holland Township Hunterdon 
Kingwood Township Hunterdon 
Lopatcong Township Warren 
Milford Borough Hunterdon 
Phillipsburg Warren 
Pohatcong Township Warren 
 
 
Section 5: Data Transformation and Loading 
 
NTIA Table BB_Service_CensusBlock 
 
Loaded based on email received on August 23, 2010.  We submitted all census blocks 
in the named municipalities.  The following table explains the transformations that were 
applied to load the target table. 



130 
 

 
Table Column  Data Source / Transform ation  
PROVNAME Set to “Service Electric Cable TV of Hunterdon, Inc.” 
DBANAME Not supplied; set same as PROVNAME 
RESELLER Set to “N” 
FRN Set to “0003760014” 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census Block FIPS Code (first 3 digits) 
TRACT Populated from Census Block FIPS Code (next 6 digits) 
BLOCKID Populated from Census Block FIPS Code 
BLOCKSUBGROUP Set to null 
FULLFIPSID Populated from Census Block FIPS Code 
TRANSTECH Set to 41 (Cable Modem – Other) per email Docsis-2.0 
MAXADDOWN Set to 7 (10Mbps) per email 
MAXADUP Set to 3 (800Kbps) per email 
TYPICDOWN Set to null, not provided 
TYPICUP Set to null, not provided 
SHAPE Copied from Census Bureau TigerLine 2000,  

as matched by spatial join on geocoded address 
 
Internal processing notes: 

1. Created a file with municipality names that match exactly names in the “name” 
column in the Year 2000 Census Bureau TigerLine database.  Primarily this 
meant changing “Boro” to “Borough”. 

2. Joined against reference data to discover census blocks. 
 
 
NTIA Table BB_Service_RoadSegment 
 
Loaded with street segments in census blocks larger than 2 square miles as listed in 
Census Bureau TigerLine reference data.  The following table explains the 
transformations that were applied to load the target table. 
 
Table Column  Data Source  / Transformation  
PROVNAME Set to “Service Electric Cable TV of Hunterdon, Inc.” 
DBANAME Not supplied; set same as PROVNAME 
RESELLER Set to “N” 
FRN Set to “0003760014” 
ADDMIN From reference data 
ADDMAX From reference data 
PREDIR  From reference data 
STREETNAME From reference data 
STREETTYPE From reference data 
SUFFDIR From reference data 
CITY From reference data 
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STATECODE From reference data 
ZIP5 From reference data 
ZIP4 From reference data 
TRANSTECH Set to 41 (Cable Modem – Other) per email Docsis-2.0 
MAXADDOWN Set to 7 (10Mbps) per email 
MAXADUP Set to 3 (800Kbps) per email 
TYPICDOWN Set to null, not provided 
TYPICUP  Set to null, not provided 
SHAPE From reference data 
 
 
Section 6: Clarification Questions and Responses 
 
 

1. What is the FRN? 
2. Should we expect any middle-mile data? 

 
Interaction from August 2010: 

Tim, 
    We have been reviewing the data you submitted t o 
the New Jersey Broadband mapping program.  Based on  our 
initial review, we have some questions for you that  
will help us better understand the data and process  it 
accurately. 
 
1. Could you please provide the FRN for your compan y? 
2. Is there any information you can provide about t he 
typical speeds experienced by your customers, based  on 
your network configurations, monitoring results or 
general experience?   
3. Do you have any middle mile locations to report?  
 
We would appreciate your prompt attention to these 
questions.  If you need further clarification, plea se 
feel free to contact me. 
 
Thank you for your participation! 
 
John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
 
Tim Himmel called John Wullert on 8/27/2010.  He 
answered the questions as followed: 

• He will have to check on the FRN.  He wasn’t quite 
sure what that meant. 

• He said that their typical speeds are generally 
10-15% below advertised (5.9 to 6.3 Mbps on a 7 
Mbps line).  (They are going to build out DOCSIS 3 
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over the next six months to a year to address 
this.  With that, they may over-provision the 
lines (provide 12 Mbps for 10 Mbps line). 

• They do not have any middle mile sites.  They 
connect direct to PenTeleData, who provides 
Internet access for multiple cable operators. 

 
Tim Himmel called John Wullert on 8/31/2010 to repo rt 
the FRN number.  The number he provided is:  FRN 00 03-
7600-14 

 
 
From: Tim Himmelwright [mailto:himmelt@sectv.com]  
Sent: Friday, March 04, 2011 3:58 PM 

To: ConnectingNJ@research.telcordia.com 
Subject: Re: NJ BB Data Collection - Spring 2011 

 

John, 
  
Computing data rates are the same as our last report.  We have deployed high-speed 2-
way internet services in 100-percent of all 12 communities that we serve in New Jersey. 
  
Our platform is still operating on DOCSIS 2.0.  However, we are testing DOCSIS 3.0 in 
two of our Pennsylvania franchises.  Once we work out the few small bugs we have 
encountered, we do plan to migrate our New Jersey properties to DOCSIS 3.0 as well.  I 
will keep you up to date on our progress. 
  
Best Regards, 
  
Timothy S. Himmelwright 
Communications & Public Affairs 
Service Electric Cable TV & Communications 
 
Section 7: Notes and Open Issues 
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Section 8: Overview Map of Submitted Data 
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Provider: Service Electric Cable TV of Sparta 

Submission date: October 2011 
 
This report presents details on processing broadband data for delivery to the National 
Telecommunications and Information Administration (NTIA).   
 
This is a stub report, since data from the previous submission was reused unchanged.  
The complete report from the previous submission begins on the next page.  Notable 
differences from the processing done on the previous submission are listed next. 
 
 
NTIA Table BB_ConnectionPoint_MiddleMile 
 

1. No changes to columns, loaded as before, but using Year 2010 Census Bureau 
data. 

 
Total rows loaded: 8 
 
Notes  
 
To create the “providerMMInput” table for this submission from the previous version, we 
removed the 2000 census block ID column and performed a spatial join against the 
2010 census block reference data table to add a new column “geoid10” with the Year 
2010 census block ID. 
 
NTIA Table BB_Service_CensusBlock 
 

1. Column " blocksubgroup" was dropped. 
2. Column "endusercat" was added; set to null because data was not supplied. 

 
Total rows loaded: 5,265 
 
NTIA Table BB_Service_Roadsegment 
 

1. Column " blocksubgroup" was dropped. 
2. Column "endusercat" was added; set to null because data was not supplied. 

 
Total rows loaded: 986 
 
 
Provider Interactions 
 
Received email from James Galliford on 8/22/2011 instructing us to use previously 
submitted data. 
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Provider: Service Electric Cable TV of Sparta 
Received: March 2011 
Submission date: April 2011 
 
This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 
 
Section 1: NDA Status 
 
No NDA executed. 
 
Section 2: Submission Overview 
 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Service Electric Cable TV of NJ Inc. 
Service Electric Broadband Cable 

0005007125 

FOR WIRELINE 

Filetypes Text 

File size 9728 bytes 

Speeds 

Type 

 Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Not provided 

Typical-downstream  Not provided 

Advertised-upstream  Municipality 

Advertised-
downstream 

 
Municipality 

Subscriber-weighted-
up 

 
Municipality 

Subscriber-weighted-
down 

 
Municipality 

 

 

Technology 
Type 

Docsis 3.1 (will use code 40) 

End-user 
specification 

Not provided 

Comments:  

INTERCONNECTION DATA 

ID  

File size Several addresses provided 
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Ownership Not provided 

Transport Type Fiber 

Data 
Rates/Capacity 

One says “Fiber 10 gbps”; others have no statement  

- Clarified this via email.  See answers below. 

Location Address 

Comments: 

 
 
Section 3: Submission File Details 
 
Received one (1) file by EMAIL: 
 
Size  Name 
9728   Broadband data Information.xls 
 
Received a spreadsheet with information on the municipalities served in entirety, the 
technology of transmission, the modem speeds offered to customers, and some 
connection points.   
 
We will gather all the census blocks in the municipality based on the TigerLine 
reference data and report those shapes in the BB_service_censusblock table. 
 
 
Section 4: Validations and Results 
 
Municipality names were normalized to agree with Census Bureau reference data. 
 
In this submission the speeds appear to be provided in a straightforward fashion as 
Max.Down/MaxUp values, the ‘Combined’ value can probably be ignored. 
 
 
Section 5: Data Transformation and Loading 
 
NTIA Table BB_ConnectionPoint_MiddleMile 
 
Loaded from 8 rows in the supplied Excel spreadsheet.  The following table explains the 
transformations that were applied.  
 
Table 
Column 

Data Source / Transformation  

PROVNAME Set to “Service Electric Cable TV of NJ Inc.” per email response 
DBANAME Set to “Service Electric Broadband Cable” per email response 
FRN Set to “0005007125” per email response 
OWNERSHIP Set to 0 to indicate owned per email 
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BHCAPACITY Set to null, not provided 
BHTYPE Set to null, not provided 
LATITUDE Created by geocoding the supplied address 
LONGITUDE Created by geocoding the supplied address 
ELEVFEET Set to “0” (zero) 
STATEABBR Set to “NJ” 
FULLFIPSID ID of containing census block from Year 2000 Census Bureau 

TigerLine reference data  
SHAPE Created using ESRI ArcDesktop 
 
Internal notes on processing: 

1. Created an excel sheet and imported to a geodatabase table. 
2. Added points corresponding to each Latitude,Longitude pair by creating a feature 

class from the table using ArcCatalog’s “Create Feature Class from XY Table” 
option. 

3. Added a column containing the ID of the containing year 2000 census block via a 
spatial join of the points and the census block shapes from reference data. 

 
 
NTIA Table BB_Service_CensusBlock 
 
Loaded based on the supplied file “Broadband data Information.xls”.  We submitted all 
census blocks less than 2 square miles in the named municipalities.  The following table 
explains the transformations that were applied to load the target table. 
 
Table Column  Data Source / Transformation  
PROVNAME Set to “Service Electric Cable TV of NJ Inc.” per email response 
DBANAME Set to “Service Electric Broadband Cable” per email response 
PROVIDER_TYPE Set to 1 
FRN Set to “0005007125” per email response 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census Block FIPS Code (first 3 digits) 
TRACT Populated from Census Block FIPS Code (next 6 digits) 
BLOCKID Populated from Census Block FIPS Code 
BLOCKSUBGROUP Set to null 
FULLFIPSID Populated from Census Block FIPS Code 
TRANSTECH Set to 41 (Cable Modem – Other) per file 
MAXADDOWN Set to code 7 per max speed 30Mbps on web site 
MAXADUP Set to code 4 per max speed 2Mbps on web site 
TYPICDOWN Set to null, not provided 
TYPICUP Set to null, not provided 
SHAPE Copied from Census Bureau TigerLine 2010,  

as matched by spatial join on geocoded address 
 
Internal processing notes: 



138 
 

1. Created a file with municipality names that match exactly names in the “name” 
column in the Year 2010 Census Bureau TigerLine database.  Primarily this 
meant changing “Boro” to “Borough”. 

2. Joined against reference data to discover census blocks, for a total of 4,135 
blocks. 

 
NTIA Table BB_Service_RoadSegment 
 
Loaded with street segments in census blocks larger than 2 square miles as gathered 
from Census Bureau TigerLine reference data.  The following table explains the 
transformations that were applied to load the target table. 
 
Table Column  Data Source  / Transformation  
PROVNAME Set to “Service Electric Cable TV of NJ Inc.” per email response 
DBANAME Set to “Service Electric Broadband Cable” per email response 
PROVIDER_TYPE Set to 1 
FRN Set to “0005007125” per email response 
ADDMIN From reference data 
ADDMAX From reference data 
PREDIR  Set to null, not available in reference data 
STREETNAME From reference data 
STREETTYPE Set to null, not available in reference data 
SUFFDIR Set to null, not available in reference data 
CITY From reference data 
STATECODE Set to "NJ" 
ZIP5 From reference data 
ZIP4 Set to null, not available in reference data 
TRANSTECH Set to 41 (Cable Modem – Other) per email Docsis-2.0 
MAXADDOWN Set to code 7 per max speed 30Mbps on web site 
MAXADUP Set to code 4 per max speed 2Mbps on web site 
TYPICDOWN Set to null, not provided 
TYPICUP  Set to null, not provided 
SHAPE From reference data 
Internal processing notes: 

3. Discovered all street segments that touch census blocks larger than 2 square 
miles using the census block list discovered as discussed for table 
BB_Service_Censusblock. 

4. Joined against reference data to discover street segment, for a total of 2,223 
entries. 

 
 
Section 6: Clarification Questions and Responses 
 
 
From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  
Sent: Thursday, March 10, 2011 8:54 AM 
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To: 'cherie@secable.com' 

Cc: ConnectingNJ@research.telcordia.com 
Subject: Service Electric of Sparta - NJ BB Data Clarifications 

 

Cherie, 
   We have reviewed the data you submitted to the NJ Broadband Data Mapping program and have a few 
clarification questions about the middle mile data you submitted: 

1. You list Fiber at 10Gbps with one address in your middle mile list.  Do you have this same type of 

connection at all the locations listed?  If not, can you please provide the technology and speed 

for each location? 

2. Do you own or lease the facilities at the interconnection points you have listed? 

 
We appreciate your participation in the program! 
 
 
John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
 
 
From: James Galliford [mailto:james.galliford@secable.com]  

Sent: Thursday, March 10, 2011 1:13 PM 
To: ConnectingNJ@research.telcordia.com 

Cc: cherie@secable.com 
Subject: Re: FW: Service Electric of Sparta - NJ BB Data Clarifications 

 

Hello John, 
 
I hope my answers clear up your questions: 

1. Further detail into interconnection links: 
1. 320 Sparta Ave, Sparta, NJ & 50 Esto Lane, Hamburg, NJ are interconnected via dual 

10Gbps circuits 
2. All other hubsites are connected via dual 1Gbps circuits 

2. We own all of the facilities used for data propagation. 

 
Thanks. 
 

Section 7: Notes and Open Issues 
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Section 8: Overview Map of Submitted Data 
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Provider: Sidera Networks (formerly RCN) 

Received: August 2011 
Submission date: October 2011 
 
This report presents details on processing of broadband data for delivery to the National 
Telecommunications and Information Administration. 
 
Section 1: NDA Status 
 
Executed with NJ OIT. 
 
Section 2: Submission Overview 
 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

RCN New York Communications, LLC 
Sidera Networks 

0006-2544-03 

FOR WIRELINE 

Filetypes Text 

File size 32 rows 

Speeds 

Type 

 Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream 
 

Not provided (despite 
the provider’s claim) 

Typical-downstream 
 

Not provided (despite 
the provider’s claim) 

Advertised-upstream  Address 

Advertised-
downstream 

 
Address 

Subscriber-weighted-
up 

 
Not provided 

Subscriber-weighted-
down 

 
Not provided 

 

 

Technology 
Type 

50 (fiber) 

End-user 
specification 

Category 4 (med or lg enterprise) 

Comments:  
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INTERCONNECTION DATA 

ID Provided – see above 

File size 73 rows 

Ownership Leased 

Transport Type Fiber 

Data 
Rates/Capacity 

Will use the max. of 3 provided values (Ethernet, SONET, and/or Waves) 

Location  

 

 
Section 3: Submission File Details 
 
Received two (2) files by SECURE UPLOAD: 
 
Size  Name 
 
1952  NJ_Sidera_Networks_LLC_Proprietary_and_Confidential_20110701.txt 
 
Given the prior interactions, each row is established to contain an address, end-user 
category, technology code (50), max advertised down/up speeds and two additional 
columns:  ADVER_DOWNLOAD_SPEED and ADVER_UPLOAD_SPEED, which the 
provider claims (in their response) to be the typical down/up-load speed. We will NOT 
use data in these columns as the typical down/up-load speed data. 
 
 
41984  NJ (Sidera) Middle Mile Proprietary and Confidential 20110701.xls 
 
Each row has an address, building type, statement of Ethernet, SONET, and/or Waves 
backhaul network speed, building ownership (all leased), and entrance (all fiber). 
We will use the max. of the three provided network speed values (Ethernet, SONET, 
and Waves) as the serving facility backhaul capacity value. 
 
 
Section 4: Validations and Results 
 
All addresses were successfully geocoded using Arroyo with Yahoo geocoder. All 
records successfully spatially joined on 2010 NJ Census Block shapes. 
 
 
Section 5: Data Transformation and Loading 
 
 
NTIA Table BB_Connectionpoint_Middlemile 
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Loaded from supplied file NJ (Sidera) Middle Mile Proprietary and Confidential 
20110701.xls” (73 rows).  The following table explains the transformations that were 
applied.  
 
Table 
Column 

Data Source / Transformation  

PROVNAME Set to “Sidera Networks, LLC" 
DBANAME Set to “Sidera Networks” 
FRN Set to “0006254403” 
OWNERSHIP Set to 1 (leased) 
BHCAPACITY Set to 6 (10 Gbps or greater) 
BHTYPE Set to 1 (fiber) 
LATITUDE Created by geocoding the supplied address 
LONGITUDE Created by geocoding the supplied address 
ELEVFEET Set to “0” (zero) 
STATEABBR Set to “NJ” 
FULLFIPSID ID of containing census block from Year 2010 Census Bureau 

reference data  
SHAPE Point shape created using ESRI ArcDesktop 
 
Internal notes on processing: 

1. Geocoded the addresses using the Google geocoder. 
2. Created an excel sheet and imported to a geodatabase table. 
3. Added point shapes corresponding to each Latitude,Longitude pair by creating a 

feature class from the table using ArcCatalog’s “Create Feature Class from XY 
Table” option. 

4. Added a column containing the ID of the containing year 2010 census block via a 
spatial join of the point shapes and the census block shapes from reference data. 

5. Loaded 73 rows. 
 
 
NTIA Table BB_Service_CensusBlock 
 
Loaded from supplied file 
“NJ_Sidera_Networks_LLC_Proprietary_and_Confidential_20110701.txt” (20 rows).  
The following table explains the transformations that were applied to load the target 
table. 
 
Table Column  Data Source / Transformation  
PROVNAME Set to “Sidera Networks, LLC" 
DBANAME Set to “Sidera Networks” 
PROVIDER_TYPE Set to 1 
FRN Set to “0006254403” 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census Block FIPS Code (first 3 digits) 
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TRACT Populated from Census Block FIPS Code (next 6 digits) 
BLOCKID Populated from Census Block FIPS Code 
FULLFIPSID Populated from Census Block FIPS Code 
TRANSTECH As supplied in column Technology_Code 
MAXADDOWN As supplied in column Max_Download_Speed 
MAXADUP As supplied in column Max_Download_Speed_1 
TYPICDOWN Set to null, not supplied 
TYPICUP Set to null, not supplied 
ENDUSERCAT Set to null, not supplied 
SHAPE Copied from Census Bureau 2010 reference data,  

as matched by spatial join on geocoded address 
 
Internal processing notes: 

1. Geocoded the addresses using the Google geocoder to obtain a Latitude, 
Longitude pair for each. 

2. Created an Excel sheet and imported it to a geodatabase table. 
3. Added point shapes corresponding to each Latitude, Longitude pair by creating a 

feature class from the table using ArcCatalog’s “Create Feature Class from XY 
Table” option. 

4. Created a new feature class and loaded data to correct tolerance value. 
5. Added a column containing the ID of the containing year 2010 census block via a 

spatial join of the point shapes and the census block shapes from reference data. 
6. Discarded 20 rows with duplicate census blocks while preserving the greatest 

speed. 
7. Loaded 12 rows. 

 
 
Section 6: Clarification Questions and Responses  
 

1. NTIA specifies four serving facility types (1=Fiber; 2=Copper;3=Hybrid Fiber 
Coax (HFC); 4=Wireless) for the middle-mile connection points data. You have 
provided 3 columns referring (we assume) to the serving facilities in you network. 
One of them is titled 'Waves'. Does that indicate the wireless facility ? 
(This question seems to have been already posted in the previous round.)  

a. This was answered – all middle-mile points are Fiber. 
 
 
Section 7: Notes and Open Issues 
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Section 8: Overview Map of Submitted Data 

 
  



146 
 

Provider: Sprint  

Received: July 2011 
Submission date: October 2011 
 
This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 
 
Section 1: NDA Status 
 
NDA was executed. 
 
Section 2: Submission Overview 
 

AVAILABILITY DATA - RECEIVED JULY  15, 2010 

ID 

Provider name 

“Doing business as” name 

FRN 

Sprint Nextel 
Communications 

Sprint 

0003-77-45-93 

FOR WIRELINE 

Filetypes Txt, xls, pdf, etc.  

File size Number of records, data elements  

Speeds 

Type 
Spatial Resolution (address, 
street seg, census block, 
RSA/MSA, zipcode) 

Upstream  

Downstream  

Typical  

Advertised  

Subscriber-
weighted 

 

 

  

Technology 
Type 

DOCSIS, xDSL, fiber, etc.  

End-user 
specification 

Business, consumer, gov’t etc  

Comments:  

FOR WIRELESS 

Filetypes 

shapefile collection: shp/dbf/prj/shx, mdb, gdb, 
imagefile etc. 

Supplied a shapefile (zip 
archive) with a two rows 
that uses projection 
GCS_WGS_1984. The 
actual shape in the 
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archive is a multi -
polygon. The 2 rows 
correspond to spectrums 
3 and 5. 

Speeds 

Type 
Spatial Resolution (address, 
street seg, census block, 
RSA/MSA, zipcode) 

Upstream max 
adv 

Single shape, single speed 

Downstream 
max adv 

Single shape, single speed 

Upstream 
typical 

Single shape, single speed 

Downstream 
typical 

Single shape, single speed 

Subscriber-
weighted 

County; but all values are 
identical 

 

Max advertised up 3, down 
2; typical upstream 3, down 
2. 

Technology 
Type 

Spectrum (Mhz, FCC code) 3 and 5 (PCS 1850-1915 
MHz, 1930-1995) 

Comments:  

INTERCONNECTION DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Sprint Nextel Corporation 

Sprint 

0003-77-45-93  

File size Number of records, data elements 4 

Ownership Leased/owned Leased = 2, owned  = 2 

Transport Type Fiber, wireless, copper Fiber 

Data 
Rates/Capacity 

 2.4 GBPS <        < 10GBPS 

Location Street address, lat/lon, elevation Lat/Long 

Comments: 

 

  

 
 
Section 3: Submission File Details 
 
Received these files by upload to the secure web site: 
 
Size  Name 
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1   Confidential_Middlemile_NJ.zip 
3547KB  Sprint_AreaAvailability_NJ.zip 
 
The zip archives contained these files: 
 
Size  Name 
427  Confidential_Middlemile_NJ.txt 
1754  Confidential_Sprint_Pricing_NJ.txt 
209  readme.txt 
2  Sprint_AreaAvailability_NJ_region.dbf 
1  Sprint_AreaAvailability_NJ_region.prj 
5470  Sprint_AreaAvailability_NJ_region.shp 
1  Sprint_AreaAvailability_NJ_region.shx 
 
Section 4: Validations and Results 
 

• Sprint provided a map showing coverage areas covering the majority of the state of New 

Jersey 

• Sprint provided a single set of attribute data, to be applied to the entire coverage area 

on 2 polygons 

o They included typical and maximum advertised upload and download speeds 

• Sprint provided spectrum data 

 
Section 5: Data Transformation and Loading 
 
Loaded 4 rows from the text file “Confidential_Middlemile_NJ.txt” supplied in October 
2010.  The following table explains the transformations that were applied.  
 
Table Column  Data Source / Transformation  
PROVNAME As supplied in column “provider_name” 
DBANAME As supplied  
FRN As supplied in column “frn”, after removing hyphens 
OWNERSHIP As supplied 
BHCAPACITY As supplied in column “servingfacilitycapacity” 
BHTYPE As supplied in column “servicefacilitytype” 
LATITUDE As supplied 
LONGITUDE As supplied 
ELEVFEET As supplied in column “elevation” (all zero) 
STATEABBR Set to “NJ” 
FULLFIPSID Year 2010 Census Bureau TigerLine reference data  
SHAPE Created via ArcMap “Add XY Data” feature for lat/long value pairs 
 
Internal notes on processing: 

1. Created an excel sheet with the data and imported to a geodatabase table. 
2. Created a feature class from the table by creating a Point shape using ArcMap’s 
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“Add XY Data” feature corresponding to each Latitude, Longitude pair. 
3. Added a column containing the ID of the containing year 2000 census block via a 

spatial join of the points and the census block shapes from reference data. 
4. The only data imputed was the state abbreviation. 
5. Reused the ESRI feature class created in the last round. 

 
 
NTIA Table BB_Service_Wireless 
 
Loaded two rows from from the supplied shapefile “Sprint_AreaAvailability_NJ_region.  
The following table explains the transformations that were applied. 
 
Table Column  Data Source / Transformation  
PROVNAME As supplied in column “provider_name” 
DBANAME As supplied in column “dbaname” 
FRN As supplied in column “frn” after removing hyphens 
TRANSTECH As supplied in column “techtrans” 
SPECTRUM Set to 3 or 5 per translation shown below 
MAXADDOWN As supplied in column “maxaddnsp” 
MAXADUP As supplied in column “maxadupsp” 
TYPICDOWN Set to null 
TYPICUP Set to null 
STATEABBR Set to “NJ” 
SHAPE As supplied. 
 
Internal notes on processing: 

1. The supplied shape uses geographic coordinate system name GCS_WGS_1984  
The NTIA data model requires the same coordinate system.  No geographic 
transformation was required, but the XY Tolerance values differ when the 
shapefile is imported into the geodatabase.  Imported the table schema and the 
table data in two separate operations, thereby ensuring perfect compatibility with 
the NTIA data model. 

2. Details on spectrum transformation: Sprint provided input columns: spectrum1, 
spectrum2, spectrum3, spectrum4, spectrum5, spectrum6, spectrum7.  Sprint put 
a "Y" in columns spectrum3 (representing range 1850-1915 MHz) and spectrum5 
(representing range 2496–2690 MHz).  The NTIA data model has a single 
column for spectrum.  The corresponding NTIA “SPECTRUM USED” coded 
values are 3 and 5. 

3. The only data imputed was the state abbreviation. 
 
 
Section 6: Clarification Questions and Responses 
 
None. 
 
NB: In June 2010 we questioned why the max advertised speed codes and the typical 
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speed codes are always the same.  Sprint confirmed that data. 
 
 
Section 7: Notes and Open Issues 



151 
 

Section 8: Overview Map of Submitted Data 
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Provider: Starband 

Submission date: October 2011 
 
This report presents details on processing broadband data for delivery to the National 
Telecommunications and Information Administration (NTIA).   
 
This is a stub report, since data from the previous submission was reused unchanged.  
The complete report from the previous submission begins on the next page.  Notable 
differences from the processing done on the previous submission are listed next. 
 
 
NTIA Table BB_Service_Wireless 
 
Total rows loaded: 21 (each county in New Jersey) 
 
 
Provider Interactions 
 

Received note from Lesley Cooper on 7/12/2011 indicating that they had no new data to 
report. 
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Connecting New Jersey - Broadband Provider Data Report 
 
Provider: StarBand Communications Inc. 
Received: March 2011 
Submission date: April 2011 
 
This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 
 
Section 1: NDA Status 
 
NONE 
 
Section 2: Submission Overview 
 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

StarBand Communications Inc. 

Not provided 

0005087457 

FOR WIRELINE 

Filetypes  

File size  

Speeds 

Type 

 Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Not provided 

Typical-downstream  Not provided 

Advertised-upstream   

Advertised-
downstream 

 
 

Subscriber-weighted-
up 

 
256Kbps 

Subscriber-weighted-
down 

 
1.5Mbps 

 

Max advertised up is Code 2 
(256 Kbps), down is Code 3 
(1.5 Mbps) 

Technology 
Type 

Code 60 (Satellite) 

End-user 
specification 

Not provided 

Comments:  

INTERCONNECTION DATA 



154 
 

ID  

File size  

Ownership  

Transport Type  

Data 
Rates/Capacity 

 

Location  

Comments: Not provided 

 
 
 
Section 3: Submission File Details 
 
Received email explaining their service offering.  Satellite service is provided in all of 
New Jersey.  
 
On subscriber weighted values, they say: 
“Since we have only 1 service that meets the definition of broadband service, the 
weighted average is the same as the average for that service.  Upload speed is 256 
Kbps and download speed is 1.5Mbps.” 
 
 
Section 4: Validations and Results 
 
No rows of data need to be validated. 
 
 
Section 5: Data Transformation and Loading 
 
NTIA Table BB_Service_Wireless 
 
Loaded county shapes from reference data for counties in the State of New Jersey 
based on emailed statements that all counties are covered.  The following table explains 
the transformations that were applied. 
 
Table Co lumn  Data Source / Transformation  
PROVNAME Set to "StarBand Communications Inc." 
DBANAME Set to "StarBand" 
FRN Set to 0005087457 
TRANSTECH Set to 60 
SPECTRUM Set to 7 per translation shown below 
MAXADDOWN Set to 4, see below. 
MAXADUP Set to 2, see below. 
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TYPICDOWN Not provided, set to null 
TYPICUP Not provided, set to null 
STATEABBR Set to “NJ” 
SHAPE County shape read from reference data. 
 
Internal notes on processing: 

1. Spectrum: No statement was provided.  The NTIA data model has a single 
column for spectrum.  Satellite corresponds to NTIA “SPECTRUM USED” code 
value 7. 

2. Speeds: The maximum advertised speeds provided in the emailed brochure are 
as discussed above  For max adv speeds we encoded the submitted down 
speed as value 4 (range 1.5-3 Mbps) and encoded the submitted up speed as 
value 2 (range 200 Kbps -- 768 Kbps). 

 
 
Section 6: Clarification Questions and Responses 
 

1. What is DBA name if different than provider name? 
 
 
From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  

Sent: Friday, March 18, 2011 10:51 AM 
To: 'Lesley Cooper - McLean' 

Cc: 'NJ Broadband Data Collection' 

Subject: Starband NJBB CLarification 

 

Lesley, 
   One quick clarification: we have your provider name as Starband Communications Inc.  Do you have 
any other “doing-business-as” name that we should include in the submission to the NTIA? 
 
 
John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
 
 
From: Lesley Cooper - McLean [mailto:Lesley.Cooper@Spacenet.com]  

Sent: Tuesday, March 22, 2011 5:48 PM 
To: ConnectingNJ@research.telcordia.com 

Subject: RE: Starband NJBB CLarification 

 

John, 
 
No, we do not.  StarBand is the provider of consumer broadband.  StarBand is a part of another 
company, Spacenet Inc., but Spacenet is not a provider of consumer broadband services. 
 
Please let me know if you have any further questions. 
 
Lesley 
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From: Lesley Cooper - McLean [mailto:Lesley.Cooper@Spacenet.com]  

Sent: Tuesday, July 12, 2011 11:54 AM 
To: ConnectingNJ@research.telcordia.com 

Subject: RE: NJ Broadband Data Collection 

 
This is to advise you that StarBand Communications does not have any changes to report. 
 
Regards, 
 
Lesley Cooper 
Senior Counsel 
StarBand Communications 
 
 
 
 
Section 7: Notes and Open Issues 
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Section 8: Overview Map of Submitted Data 
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Provider: Time Warner 

Received: August 2011 
Submission date:  October 2011 
 
This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 
 
Section 1: NDA Status 
 
NDA established with NJ OIT. 
 
Section 2: Submission Overview 
 

AVAILABILITY DATA 

ID 

PROVIDER NAME 

DBA NAME 

FRN  

Holding company name 

Holding company number 

Time Warner Cable, LLC  

Time Warner Cable 

0013430244 

Time Warner Cable Inc. 

131352 

FOR WIRELINE 

File types 
Time Warner supplied 2 pdf files and a 
shapefile showing coverage on FIPS census 
block level. 

 

Speeds 

Type 
Spatial Resolution (address, 
street seg, census block, 
RSA/MSA, zipcode) 

Upstream max 
adv 

yes (code 5). census block. 

Downstream 
max adv 

yes (code 9). census block 

Upstream 
typical 

not provided. 

Downstream 
typical 

not provided 

Subscriber-
weighted 

not provided 

 

 

Technology 
Type 

40  

Comments:  

INTERCONNECTION DATA:     INSTRUCTED TO USE PREVIOU S DATA 

ID  
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File size  

Ownership  

Transport Type  

Data 
Rates/Capacity 

 

Location  

Comments: not provided . 

 
 

Section 3: Submission File Details 
 
 
Received 1 archive file by EMAIL: 
 
Size   Name 
489338 Bytes TWC_0013430244_NJ_063011.zip 
 
This archive contains a shapefile made up of the following 7 files: 
 
Size   Name 
149,696  NJ Broadband Cltr.pdf 
5    TWC_0013430244_CensusBlock_NJ_063011.cpg 
658,366  TWC_0013430244_CensusBlock_NJ_063011.dbf 
167    TWC_0013430244_CensusBlock_NJ_063011.prj 
538,984   TWC_0013430244_CensusBlock_NJ_063011.shp 
15,860   TWC_0013430244_CensusBlock_NJ_063011.shx 
 
 
Quick loading results:   1970 polygons in shapefile, spanning 2 counties in NJ. 
 
Figure 1. Loaded results 
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Section 4: 

Validations and Results 
 
The PDF file does not contain any submission data. 
 
The shapefile TWC_0013430244_CensusBlock_NJ_063011 contains 1970 rows 
(polygons). See above for a preview picture. 
 
The shapes use XY coordinate system GCS_North_American_1983.  Provides census-
block shapes and associated speed data.  All census block IDs are length 15. All 
submitted block IDs are unique and were found in Census Bureau Year 2010 reference 
data.  Only technology code 40 is present.  Maximum advertised speed codes are 
present. 
 
NOT PRESENT - SEE PREVOUS DATA REPORTS 

• Middle-mile data – as per the cover letter, we will reuse data from the 
June 2010 submission. 

• Typical upstream/downstream values not provided and will not be 
submitted. 

 
 
Section 5: Data Transformation and Loading 
 
 
NTIA Table BB_ConnectionPoint_MiddleMile 
 



161 
 

Loaded from supplied file “0013430244_middlemile_NJ_06302009.txt” (19 rows, only 1 
in New Jersey) received in June  2010 (and apparently unchanged since)  The following 
table explains the transformations that were applied.  
 
Table 
Column 

Data Source / Transformation  

PROVNAME Set to “Time Warner Cable LLC” (“LLC” was missing) 
DBANAME As supplied in column ”DBAName” 
FRN Set to “0013430244” 
OWNERSHIP As supplied in column ”Ownership” 
BHCAPACITY As supplied in column ”Serving Facility Capacity” 
BHTYPE As supplied in column ”Serving Facility Type” 
LATITUDE As supplied in column “Latitude” 
LONGITUDE As supplied in column “Longitude” 
ELEVFEET As supplied in column “Elevation” 
STATEABBR Set to “NJ” 
FULLFIPSID ID of containing census block from Year 2010 Census Bureau 

reference data  
SHAPE Point corresponding to Lat, Long created using ESRI 
 
Internal processing notes from prior report: 

1. Created an excel sheet and imported to a geodatabase table. 
2. Added points corresponding to each Latitude,Longitude pair by creating a feature 

class from the table using ArcCatalog’s “Create Feature Class from XY Table” 
option. 

3. We dropped all locations outside the New Jersey state boundary, leaving just 
one.  In this row, the elevation value is 30, and we were told in June 2010 that 
the connection point is on the 7th floor of a building, so we did not change the 
value. 

4. Added a column with the ID of the containing Year 2000 Census block via a 
spatial join of the points and the census block shapes from reference data. 

 
 
NTIA Table BB_Service_CensusBlock 

 
Loaded from the supplied shape file.  The following table explains the transformations 
that were applied to load the target table. 
 
Table Column  Data Source / Transformation  
PROVNAME Set to “Time Warner Cable LLC” (“LLC” was missing) 
DBANAME As supplied in column ”DBAName” 
PROVIDER_TYPE Set to 1 
FRN Set to “0013430244” 
STATEFIPS Set to “34” 
COUNTYFIPS Populated from cb_fips (digits 3-5) 
TRACT Populated from cb_fips (next 6 digits) 
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BLOCKID Populated from cb_fips (next 4 digits) 
FULLFIPSID As supplied in column cb_fips 
TRANSTECH As supplied in column tech_trans 
MAXADDOWN As supplied in column max_ad_dwn 
MAXADUP As supplied in column max_ad_up 
TYPICDOWN Not provided, set to null 
TYPICUP Not provided, set to null 
ENDUSERCAT Not provided, set to null 
SHAPE As supplied 
 
Internal notes on processing 

1. Geographic coordinate system:  The supplied shape uses geographic coordinate 
system name GCS_North_American_1983.  The NTIA transmittal data model 
requires coordinate system GCS_WGS_1984.  To change the projection we 
applied the geographic transformation NAD_1983_To_WGS_1984_5 (per ESRI 
KB article 24159).  We also had to load the data into a second feature class such 
that the tolerance value matches the NTIA transmittal model’s value of 
0.000000002. 

 
 
Section 6: Clarification Questions and Responses 
 
 
Section 7: Notes and Open Issues 
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Section 8: Overview Map of Submitted Data 
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Provider: T-Mobile 

Received: 07 August 2011 
Submission date: October 2011 
 
This report presents details on processing broadband data for delivery to the National 
Telecommunications and Information Administration. 
 
Section 1: NDA Status 
 
Executed with NJ OIT. 
 
Section 2: Submission Overview 
 

AVAILABILITY DATA 

ID 

PROVIDER NAME 

DBA NAME 

FRN 

Holding company name 

Holding company number 

T-Mobile USA, Inc. 

T-Mobile 

0006945950 

T-Mobile USA 

130403 

FOR WIRELESS 

Filetypes 

T-mobile supplies .xls, .txt. and shapefiles 
(availability). They supply 3 sets of shape files: 
2 for HSPA+ coverage and another for 3G 
coverage. 

 

Speeds 

Type 
Spatial Resolution (address, 
street seg, census block, 
RSA/MSA, zipcode) 

Upstream max 
adv 

yes (shapefiles for both 3G and 
4G) 

Downstream 
max adv 

yes (shapefiles for both 3G and 
4G) 

Upstream 
typical 

not found. 

Downstream 
typical 

not found. 

Subscriber-
weighted 

Provided as a table of vals 

in mbps (not kbps) correlated to 
21 FIPS codes (code 80)  

 

Notes: “ T-Mobile submitted three 
sets of map files for this state.  The 
file names correspond with 
maximum advertised speed data 
above. HSPA42 represents increased 
4G download speed (it does not 
affect upload speed).” 

Technology 
Type 

Spectrum (Mhz, FCC code) Advanced Wireless Services spectrum 
(1710-1755 MHz; 2100-2155) 

Comments:  

INTERCONNECTION DATA 
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ID  

File size 5 rows 

Ownership Code 1 

Transport Type Type 1 

Data 
Rates/Capacity 

codes 4 and 6 

Location lat/lons given for all (either A or Z end is in NJ) 

Comments: seems there were 10 rows at the last iteration? 5 rows this time. 
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Figure 1. Preview of submitted data in ESRI 
 
 
 
  



167 
 

Section 3: Submission File Details 
 
The original submission of July 2011 included these 16 data files: 
 
Size  Name 
7078KB Area_availability.zip (contains below shape files) 
3KB  Area_availability.txt 
10KB  Middle_mile_NJ.xls 
10KB  avg_speed_nj.xls 
131KB NJ_HSPA21.dbf 
1KB  NJ_HSPA21.prj 
12,863KB NJ_HSPA21.shp 
31KB  NJ_HSPA21.shx 
36KB  NJ_HSPA42.dbf 
1KB  NJ_HSPA42.prj 
2675KB NJ_HSPA42.shp 
9KB  NJ_HSPA42.shx 
126KB NJ_UMTS.dbf 
1KB  NJ_ UMTS.prj 
6710KB NJ_ UMTS.shp 
16KB  NJ_ UMTS.shx 
 
The additional submission of September 2011 provided the following corrected files: 
1KB  NJ_HSPA21.dbf 
1KB  NJ_HSPA21.prj 
2,505KB NJ_HSPA21.shp 
1KB  NJ_HSPA21.shx 
 
 
Section 4: Validations and Results 
 
We validated the following data items in the original submission. 
 
Geospatial Data 
- Received three shape files in July 2011; see above for preview of shapefiles in 

ESRI. 
o NJ_HSPA21 

• 1958 duplicates found out of 3916 candidates 
o NJ_HSPA42 

• 0 duplicates found out of 1068 candidates 
o NJ_UMTS 

• 0 duplicates found out of 1977 candidates 
- All shapes are contained within the state of New Jersey 

- The data rows carry no technology, speed, or other broadband data.   
- Received one shape file in September 2011 

o NJ_HSPA21 
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• Has exactly 1 polygon  
 

Middle Mile Data 
- File middle_mile_nj.xls lists 5 connections with 2 unique endpoints in New Jersey.  

Ownership, facility capacity, facility type codes are all valid 
 
Speed/Technology Data 
- File area_availability.txt provides technology and spectrum codes that are within the 

valid set.  It also provides maximum-advertised speeds for each wireless technology. 
- File avg_speed_nj.xls provides subscriber-weighted nominal speeds, which we will 

not be using for this round (no overview table required). 
 
 
Section 5: Data Transformation and Loading 
 
NTIA Table BB_ConnectionPoint_MiddleMile 
 
Loaded from supplied file “middle_mile_NJ.xlsx” (5 rows, 3 unique points).  The 
following table explains the transformations that were applied.  
 
Table 
Column 

Data Source / Transformation  

PROVNAME Set to “T-Mobile USA, Inc." 
DBANAME Set to "T-Mobile" 
FRN Set to “0006945950” 
OWNERSHIP As provided in column Ownership (value 1)l 
BHCAPACITY As provided in column Serving Facility Capacity 
BHTYPE As provided in column Serving Facility Type 
LATITUDE Created by geocoding the supplied address 
LONGITUDE Created by geocoding the supplied address 
ELEVFEET Set to “0” (zero) 
STATEABBR As provided in column State 
FULLFIPSID ID of containing census block from Year 2010 Census Bureau 

reference data  
SHAPE Point created using ESRI tools 
 
Internal notes on processing: 

1. Created an excel sheet with the original data and imported to a geodatabase 
table. 

2. Added points corresponding to each Latitude,Longitude pair by creating a feature 
class from the table using ArcCatalog’s “Create Feature Class from XY Table” 
option. 

3. Added a column containing the ID of the containing year 2010 census block via a 
spatial join of the points and the Year 2010 census block shapes from Tiger Line 
reference data. 
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NTIA Table BB_Service_Wireless 
 
Loaded from the supplied shapefiles NJ_HSPA21 (as revised; 1 row), NJ_HSPA42 (1 
row), and NJ_UMTS  (1 row).  The following table explains the transformations that 
were applied. 
 
Table Column  Data Source / Transformation  
PROVNAME Set to "T-Mobile USA, Inc." per area_availability_NJ.txt 
DBANAME Set to “T-Mobile" per area_availability_NJ.txt 
FRN Set to “0006945950” 
TRANSTECH Set to 80 per area_availability_NJ.txt 
SPECTRUM Set to “4” per translation shown below 
MAXADDOWN Set as follows: HSPA 21 is 6; HSPA 42 is 7; UMTS is 4;  

as specified in file area_availability_NJ.txt 
MAXADUP Set as follows: HSPA 21 is 4; HSPA 42 is 4; UMTS is 2;  

as specified in file area_availability_NJ.txt 
TYPICDOWN Set to null (not supplied) 
TYPICUP Set to null (not supplied) 
STATEABBR As supplied in column “state” with “NJ” 
SHAPE As supplied. 
 
Internal notes on processing: 

1. Spectrum: NOFA defines 7 spectrum columns.  T-Mobile provided a “Y” value in 
column 4 (Advanced Wireless Services, ranges 1710-1755 MHz; 2100-2155) in 
file area-availability_NJ.txt, so we coded the value as '4'. 

2. The supplied shapes use geographic coordinate system 
GCS_North_American_1983.  The NTIA data model requires coordinate system 
GCS_WGS_1984.  To change the projection we applied the ESRI geographic 
transformation NAD_1983_To_WGS_1984_5 (per ESRI KB article 24159).  The 
resulting table is named with suffix “_wgs”. 

3. The supplied shapes use tolerance values different from the NTIA transmittal 
model.  The transformed feature classes with suitable tolerances are named with 
suffix “_wgs_tol”.  

4. The NJ_HSPA42 and NJ_UMTS shapefiles contained some identical rows as 
determined by spectrum, technology, and shape; the rows only differed in the 
maximum advertised speed.  To prevent the problem of duplicate shapes in the 
merged  data, we took the following actions: 

a. Merged  shapes in NJ_HSPA42_wgs_tol into a single shape, using 
ArcGIS Dissolve tool. The transformed table is named with suffix 
"_wgs_tol_dissolve". 

b. Merged the shapes in NJ_UMTS_wgs_tol into a single shape, using 
ArcGIS Dissolve tool. The transformed table is named with suffix 
"_wgs_tol_dissolve". 

 
 
Section 6: Clarification Questions and Responses 
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From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  

Sent: Friday, September 16, 2011 2:08 PM 
To: 'jeni.wilcox@t-mobile.com' 

Cc: ConnectingNJ@research.telcordia.com 
Subject: NJBB Clarification 

 

Jeni, 
   We have reviewed the data that you submitted to the New Jersey Broadband program and have 
uncovered a few questions/issues that we’d like your help in addressing. 
   First, you submitted three shape files, describing HSPA21, HSPA42 and UMTS services.  With this, you 
only provided a single frequency assignment.  Do all these service areas make use of the same 
frequency? 
   Second, in looking at the HSPA21 shape file, we have found a large number of duplicate shapes (1958 
of the total 3916 are duplicates).  We were concerned that this might indicate some issue with your 
process in generating the HSPA21 shape file.  (We found no duplicates in the other shape files.)  We 
have been instructed by NTIA not to submit duplicates, so are asking you to examine the data and make 
the appropriate corrections within the next week.  If you cannot meet that deadline, we will drop the 
duplicates and submit the rest of the shape file. 
 
Thanks for your prompt attention, 
 
 
John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
 
 
 
Hi John,  
 
Thanks for the email.  Please see my responses below in red and let me know if you have additional 
questions. 
 
Thank you, 
 
Jeni Wilcox   
Regulatory Specialist  
▪T▪▪▪Mobile▪ stick together  
| Desk: 425.383.6377 | Fax: 425.383.3640 |  
 
From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  
Sent: Friday, September 16, 2011 11:08 AM 

To: Wilcox, Jeni 
Cc: ConnectingNJ@research.telcordia.com 

Subject: NJBB Clarification 

 
Jeni, 
   We have reviewed the data that you submitted to the New Jersey Broadband program and have 
uncovered a few questions/issues that we’d like your help in addressing. 
   First, you submitted three shape files, describing HSPA21, HSPA42 and UMTS services.  With this, you 
only provided a single frequency assignment.  Do all these service areas make use of the same 
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frequency?  [JW] Yes, same frequency.  
   Second, in looking at the HSPA21 shape file, we have found a large number of duplicate shapes (1958 
of the total 3916 are duplicates).  We were concerned that this might indicate some issue with your 
process in generating the HSPA21 shape file.  (We found no duplicates in the other shape files.)  We 
have been instructed by NTIA not to submit duplicates, so are asking you to examine the data and make 
the appropriate corrections within the next week.  If you cannot meet that deadline, we will drop the 
duplicates and submit the rest of the shape file.  [JW] Attached is the HSPA+21 file without the 
duplicates.  
 
Thanks for your prompt attention, 
 
 
John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
 
 
Section 7: Notes and Open Issues 
 
This provider has given us three sets of shapes, one for "HSPA21", one for "HSPA42" 
and one for "UMTS".  All are submitted to us as technology code 80 and all in spectrum 
code 4.  But they have different speeds.  The validations complain about duplicate rows, 
which I assume is based on the shape column and the technology code. Here it seems 
the technology and spectrum codes do not adequately capture what we have received 
from the provider. 

We addressed the problem by using the ArcGIS “Dissolve” tool to merge all the 
polygons in each submitted feature class  into a single polygon.  The submission has 
exactly three rows, one shape for each speed tier, and presumably will not be flagged 
as duplicates.  Note however that these shapes will have some geo-spatial overlap. 
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Section 8: Overview Map of Submitted Data 
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Provider: tw telecom of new jersey l.p. 

Submission date: October 2011 
 
This report presents details on processing broadband data for delivery to the National 
Telecommunications and Information Administration (NTIA).   
 
This is a stub report, since data from the previous submission was reused unchanged.  
The complete report from the previous submission begins on the next page.  Notable 
differences from the processing done on the previous submission are listed next. 
 
 
NTIA Table BB_Service_CensusBlock 
 

1. Column "blocksubgroup" was dropped. 
2. Column "endusercat" was added; set to null because data was not supplied. 

 
Received 35 input records, discarded 11 due to duplicate census blocks, loaded 24 
records. 
 
Notes  
 
To create the “providerInput” table for this submission from the previous version, we 
removed the 2000 census block ID column and performed a spatial join against the 
2010 census block reference data table to add a new column “geoid10” with the Year 
2010 census block ID. 
 
 
Provider Interactions 
 
August 8, 2011: Tammy Chatfield instructed us to use previous data. 
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Received: March, 2011 
Submission date: March 2011 
 
This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 
 
Section 1: NDA Status 
 
NONE 
 
Section 2: Submission Overview 
 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Holding company name 

Holding company number 

tw telecom of new jersey l.p. 
Not provided 

0004351417 

tw telecom inc. 

160153 

FOR WIRELINE 

Filetypes Text 

File size 3419 bytes, 35 records 

Speeds 

Type 

 Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Not provided 

Typical-downstream  Not provided 

Advertised-upstream  Address; values 2..11 

Advertised-
downstream 

 
Address; values 2..11 

Subscriber-weighted-
up 

 
Not provided 

Subscriber-weighted-
down 

 
Not provided 

 

 

Technology 
Type 

30 (Other copper) and 50 (fiber) 

End-user 
specification 

4  (medium – large enterprise) 

Comments:  

INTERCONNECTION DATA 

ID  
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File size  

Ownership  

Transport Type  

Data 
Rates/Capacity 

 

Location  

Comments: None provided 

 
 
 
Section 3: Submission File Details 
 
Received 1 file by secure upload: 
 
Size  Name 
3419  NJBB_0004351417_AddressLevelAvailability.txt 
 
The file has 35 records.  All are addresses; no apartment/suite/unit numbers are 
provided.  Some addresses are repeated, sometimes with different speed numbers, 
suggesting that these entries are customer service addresses.  Several are the 
addresses of multi-tenant buildings.   
 
Section 4: Validations and Results 
 
All addresses could be geocoded.  All coded values in the tech trans and speed 
columns are valid. 
 
Section 5: Data Transformation and Loading 
 
The standard NDA prohibits us from submitting address-level data to the NTIA.  Instead, 
we discover the census block for each customer address, then report the census block 
shape drawn from Census Bureau TigerLine reference data. 
 
NTIA Table BB_Service_CensusBlock 
 
Loaded from supplied file “NJBB_0004351417_AddressLevelAvailability.txt”.  The 
following table explains the transformations that were applied to load the target table. 
 
Table Column  Data Source / Transformation  
PROVNAME As supplied in column “Provider Name” 
DBANAME Not supplied; set same as PROVNAME 
PROVIDER_TYPE Set to 1 
FRN As supplied in column “FRN”, with leading zeroes 
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STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census Block FIPS Code (first 3 digits) 
TRACT Populated from Census Block FIPS Code (next 6 digits) 
BLOCKID Populated from Census Block FIPS Code 
BLOCKSUBGROUP Set to null 
FULLFIPSID Populated from Census Block FIPS Code 
TRANSTECH As supplied in column Technology of Transmission 
MAXADDOWN For technology 30: Set to 7, the max val in MaxAdDown 

For technology 50: Set to 11, the max val in MaxAdDown 
MAXADUP For technology 30: Set to 7, the max val in MaxAdDown 

For technology 50: Set to 11, the max val in MaxAdDown 
TYPICDOWN Set to null, not provided 
TYPICUP Set to null, not provided 
SHAPE Copied from Census Bureau TigerLine 2000,  

as matched by spatial join on geocoded address 
 
Internal processing notes: 

1. Geocoded the addresses using the Google geocoder to obtain a Latitude, 
Longitude pair for each.. 

2. Created an excel sheet and imported it to a geodatabase table. 
3. Added point shapes corresponding to each Latitude, Longitude pair by creating a 

feature class from the table using ArcCatalog’s “Create Feature Class from XY 
Table” option. 

4. Added a column containing the ID of the containing year 2000 census block via a 
spatial join of the point shapes and the census block shapes from reference data. 

5. Discarded 11 rows with duplicate census blocks, which means multiple 
customers are present in the same census block. 

 
The mechanized procedure for the three steps is described in file GeoExcel_proc.txt. 
 
 
 
Section 6: Clarification Questions and Responses 
 

1. Based on the prior interactions with the provider, the following was assumed: 
  DBNAME   - not supplied; set same as PROVNAME 
  address level data - need to obfuscate 
 middle mile  - none 
  typical speeds - not provided 

 
From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  

Sent: Tuesday, March 08, 2011 8:27 AM 

To: 'tammy.chatfield@twtelecom.com' 
Cc: ConnectingNJ@research.telcordia.com 

Subject: TW Telecom Clarification Questions 

 

Tammy, 



177 
 

   We have reviewed the data you submitted to the NJ Broadband data Mapping program and have two 
clarification questions: 

1. During your last submission, you indicated that you did not have any middle mile connection 

points in NJ.  Is that still the case? 

2. You provided us with maximum advertised speeds.  Would it be possible for you to provide 

typical speeds experienced by your customers? 

 
Thanks for your participation in the program. 
 
 
John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
 
 
From: Chatfield, Tammy [mailto:Tammy.Chatfield@twtelecom.com]  

Sent: Tuesday, March 08, 2011 8:45 AM 

To: ConnectingNJ@research.telcordia.com 
Subject: RE: TW Telecom Clarification Questions 

 

1.       Correct, we do not have any middle mile facilities in NJ. 

2.       Unfortunately, we do not have any information on typical speeds. 
  
 
Section 7: Notes and Open Issues 
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Section 8: Overview Map of Submitted Data 
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Provider: Verizon 

Received: August 2011 
Submission date: October 2011 
 
This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 
 
Section 1: NDA Status 
 
Verizon executed an NDA with NJ OIT. 
 
Section 2: Submission Overview 
 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Holding company name 

Holding company number 

Verizon Online LLC 

Verizon 

0012254363 

Verizon Communications Inc. 

131425 

FOR WIRELINE 

Filetypes Text and excel 

File size See below 

Speeds 

Type 

 Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Not provided 

Typical-downstream  Not provided 

Advertised-upstream  County (code 7) 

Advertised-
downstream 

 
County (code 9) 

Subscriber-weighted-
up 

 
Not provided 

Subscriber-weighted-
down 

 
County 

 

 

Technology 
Type 

DSL (10) and FTTP (50) 

End-user 
specification 

Not provided  

Comments:   
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INTERCONNECTION DATA 

ID  

File size Excel file, 11 POP rows provided, see below 

Ownership Not provided 

Transport Type Not provided 

Data 
Rates/Capacity 

Not provided 

Location Address 

Comments: 

 
 
Section 3: Submission File Details 
 
Received these files initially via CD-ROM, with updated files submitted via email 
 
VZ-NJ-BB(Revised).zip  
 
Size  Name 
7062862 NJ - Wireline Service By Census Block - Jun 2011 with Speeds v2.txt 
143167 NJ - Wireline Service By Street Segment - Jun 2011 with Speeds v2.txt 
 
Verizon.zip 
 
Size  Name 
603   NJ - Advertised Speed by County (Jun 2011).txt 
2805  NJ - Pricing (Jun 2011).txt 
29184  NJ - POP List (Jun 2011).xls 
 
 
Section 4: Validations and Results 
 
We validated the following data items in the original submission. 
 
File “NJ - Advertised Speed by County (Jun 2011).tx t” (21 data rows) 
 
Lists these columns (* indicates no data):  Provider Name*, DBA Name*, FRN*, ID, 
County FIPS Code, County Name, Maximum Advertised Downstream Speed, Maximum 
Advertised Upstream Speed.  
 
County codes are valid.  Speed codes are valid; every county is listed at 9 (down) and 7 
(up).  This must be for technology 50 (FTTP); it's not reasonable for technology codes 
10 and 20 (ADSL, SDSL). 
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File “NJ - Wireline Service By Census Block with Sp eeds (Jun 2011).txt” (159,878 
data rows)  
Updated File: NJ - Wireline Service By Census Block  - Jun 2011 with Speeds 
v2.txt (159,876 rows) (Update removes records that were associated with large 
census blocks) 
 
Lists these columns (* indicates no data): ProviderName*, DBAName*, FRN*, ID, 
Census Block FIPS Code, Census Block Square Miles, Technology of Transmission. 
 
Two technology codes are present, 10 and 50, both are valid.  All FIPS codes reflect 
Year 2010 Census Bureau geometry.  According to census block reference data, three 
census blocks larger than 2 square miles are in the list:   

• 340258119001027 

• 340297310011001 

• 340297381007002 

For the latter two, Verizon data indicates an area of zero.  For the first, Verizon has an 
area of 1.959261973 and we have an area of 2.01155747.  Sent note to Verizon to 
clarify on 8/30/2011. 
 
File “NJ - Wireline Service By Street Segment with Speeds (Jun 2011).txt”  (1,841 
data rows) 
Updated File: NJ - Wireline Service By Street Segme nt - Jun 2011 with Speeds 
v2.txt (1864 rows) (Update adds streets for blocks that previously were submitted 
as census blocks)  
 
Lists these columns (* indicates no data): Provider Name*, DBA Name*, FRN*, ID, 
Census Block FIPS Code, Census Block Square Miles, TLID, Street Name, FRADDL, 
TOADDL, FRADDR, TOADDR, Technology of Transmission. 
 
TigerLine IDs were matched against Year 2010 Census Bureau TigerLine reference 
data, all are valid IDs.  All TigerLine IDs correspond to roads.  All the census blocks 
included are valid NJ 2010 census blocks. 
 
The input set contains 22 records that are duplicates when checked by county 
(characters 3-5 of Census Block FIPS Code), TLID and TechTrans.  The census blocks 
are different for the records.  The Tiger lines must touch multiple census blocks.  We will 
discard these records to avoid creating duplicate shapes in the submission. 
 
There were 478 TLIDs that do not belong to our table of street segments in large 
census blocks (tl_2010_34_large_streets_10_wgs).  The primary reason is that the 
table does not contain the full list of streets in large blocks due to poor alignment 
between the 2010 TIGER lines and Census blocks. To address this, we created a table 
of valid tigerline IDs by joining tiger shapes with census blocks using a 2 meter buffer.  
After we did this, there were only 11 TLIDs that do not belong to the resulting table,  
tl_2010_34_large_streets_10_2m_wgs.  These TLIDs were removed from the data.. 
See section 7 for details. 
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File “NJ - Pricing (Jun 2011).txt” (53 data rows) 
 
This file provides subscriber-weighted nominal speeds.  The columns are not labeled 
but appear to be as follows: Provider_Name,  FRN, County ID (based on odd numbers 
1..41), State, Technology of Transmission, Subscriber Weighted Nominal Speed.  
 
The county IDs are valid, the state ID (“34”) is valid, and the technology of transmission 
codes 10, 20, and 50 are all valid.  The Subscriber Weighted Nominal Speed values are 
plausible for the specified technology of transmission codes; e.g., DSL speeds are 
about 4,000.  However, every FIOS speed is shown at 25,000 or higher.  Given the 
availability of FIOS/FTTP plans at download speeds of less than 25Mbps, it seems 
extraordinarily unlikely that not a single customer uses one of those plans and/or that so 
many customers use a 50Mbps plan that the average is brought up so high. 
 
Per NTIA directions we are not submitting the "BB_Service_Overview" table in this 
submission so will not use this data. 
 
File “NJ - POP List (Jun 2011).xls” (11 rows) 
 
Column names: Address, City, State, Zip. 
 
The data is the same as the last submission. 
 
We geocoded the addresses to obtain latitude, longitude value pairs.  All addresses 
were found.  However, Verizon did not supply needed information on the elevation, 
ownership, serving facility capacity, and service facility type of these addresses.  In 
June 2010 Verizon indicated they had no intention of supplying this information. 
 
 
File “NJ - Pricing (Jun 2011).txt” (53 rows) 
 
Per NTIA instructions, we will not be submitting pricing dat. 
 
Section 5: Data Transformation and Loading 
 
NTIA Table BB_ConnectionPoint_MiddleMile 
 
Loaded from supplied Excel Spreadsheet “NJ - POP List (Jun 2011).xls”.  The following 
table explains the transformations that were applied.  
 
Table 
Column 

Data Source / Transformation  

PROVNAME Set to “Verizon Online LLC”” 
DBANAME Set to “Verizon” 
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FRN Set to “0012254363” 
OWNERSHIP Set to null 
BHCAPACITY Set to null 
BHTYPE Set to null 
LATITUDE Created by geocoding the supplied address 
LONGITUDE Created by geocoding the supplied address 
ELEVFEET Set to “0” (zero) 
STATEABBR Set to “NJ” 
FULLFIPSID ID of containing census block from Year 2010 Census Bureau 

TigerLine reference data  
SHAPE Created using ESRI ArcDesktop 
 
Internal notes on processing: 

1. To date Verizon has declined to provide information about ownership, backhaul 
capacity, or backhaul type, so we submit null values. 

2. Created an excel sheet and imported to a geodatabase table. 
3. Added points corresponding to each Latitude,Longitude pair by creating a feature 

class from the table using ArcCatalog’s “Create Feature Class from XY Table” 
option. 

4. Added a column containing the ID of the containing year 2010 census block via a 
spatial join of the points and the census block shapes from reference data. 

5. Note that October 2011 was identical to that submitted in October 2009, so we 
used previously loaded data (steps 2-4). 

 
 
NTIA  Table BB_Service_CensusBlock 
 
Loaded from supplied text file “NJ - Wireline Service By Census Block - Jun 2011 with 
Speeds v2.txt”.  The following table explains the transformations that were applied to 
load the target table. 
 
Table Column  Data Source / Transformation  
PROVNAME Set to “Verizon Online LLC” 
DBANAME Set to “Verizon” 
PROVIDER_TYPE Set to 1 
FRN Set to “0012254363” 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from 2010_Census_Block_FIPS_Code (1st 3 digits) 
TRACT Populated from 2010_Census_Block_FIPS_Code (next 6 digits) 
BLOCKID Populated from 2010_Census_Block_FIPS_Code  

(next 4 digits) 
BLOCKSUBGROUP Set to null 
FULLFIPSID First 15 digits of 2010_Census_Block_FIPS_Code 

See discussion of Census blocks below. 
TRANSTECH As supplied in column Technology_of_Transmission 
MAXADDOWN Set to 6 or 9, see below. 
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MAXADUP Set to 3 or 7; see below 
TYPICDOWN Set to null 
TYPICUP Set to null 
SHAPE Copied from Year 2000 Census Bureau reference data,  

As matched by Census block 2000 ID 
 
Internal processing notes: 

1. Verizon submitted initially 3 census blocks that were significantly larger than 2 
square miles in this table.  Verizon corrected the 3 very large census blocks with 
re-submitted data.   

2. Verizon submitted two other census blocks that our calculations put just above 2 
square miles:. 

a. 340190118002005 (2.00887743 mi2) 
b. 340270461061026 (2.00118133 mi2) 

We believe this is a result of variations in the projections used to calculate the 
areas.  In processing, we gathered the entire set of street segments associated 
with these census blocks and included them in the street segment table.   

3. Speeds: We imputed max advertised up and down speeds based on the 
technology of transmission, the contents of the File “NJ - Advertised Speed by 
County.txt”, and information on the Verizon web site.  Mad adv down for tech 
code 10 (DSL) is speed code 6, and max adv down for tech code 50 (FIOS) is 
speed code 9.  Max adv up for tech code 10 (DSL) is speed code 3, and max adv 
up for tech code 50 (FIOS) is speed code 7.   

 
 
NTIA Table BB_Service_RoadSegment 
 
Loaded from supplied text file “NJ - Wireline Service By Street Segment - Jun 2011 with 
Speeds v2.txt” and from road segments discovered in large census blocks our 
calculations put at slightly larger than two square miles (See item 2 above).  The 
following table explains the transformations that were applied to load the target table. 
 
Table Column  Data Source / Transformation  
PROVNAME Set to “Verizon Online LLC” 
DBANAME Set to “Verizon” 
PROVIDER_TYPE Set to 1 
FRN Set to “0012254363” 
ADDMIN Set to the least of the address numbers, if any 
ADDMAX Set to the greatest of the address numbers, if any 
PREDIR  Set to null (no value supplied) 
STREETNAME As supplied (has all street components, not just name) 
STREETTYPE Set to null (no value supplied) 
SUFFDIR Set to null (no value supplied) 
CITY Set to null (no value supplied) 
STATECODE Set to “NJ” 
ZIP5 Set to null (no value supplied) 
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ZIP4 Set to null (no value supplied) 
TRANSTECH As supplied 
MAXADDOWN Set to 6 or 9, see below. 
MAXADUP Set to 3 or 7; see below 
TYPICDOWN Set to null (no value supplied) 
TYPICUP  Set to null (no value supplied) 
TLID As supplied 
SHAPE Copied from Census Bureau TigerLine 2000,  

As matched by County + Tiger Line ID 
 
Internal notes on processing: 
 

1. All rows were supplemented with a line-segment shape from the Census 
Bureau’s TigerLine data set. 

2. We removed 100 records from the Verizon submitted data that were duplicates, 
based on county and tlid. 

3. We removed 11 records from the Verizon submitted data that had entries in the 
tlid field that did not match our list of street segments in large census blocks. 

4. Speeds: : We imputed max advertised up and down speeds based on the 
technology of transmission, the contents of the File “NJ - Advertised Speed by 
County.txt”, and information on the Verizon web site.  Max adv up for tech code 
10 (DSL) is speed code 3, and max adv up for tech code 50 (FIOS) is speed 
code 7.  Mad adv down for tech code 10 (DSL) is speed code 7, and max adv 
down for tech code 50 (FIOS) is speed code 9. 

 
Section 6: Clarification Questions and Responses 
 
We confirmed that 2010 census blocks were used. 
 
 
From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  
Sent: Friday, August 26, 2011 2:25 PM 

To: 'douglas.w.schoenberger@verizon.com' 

Cc: 'Clemons, Keefe B' 
Subject: NJBB Data Clarification 

 

Douglas, 
   We have reviewed the data that Verizon submitted to the New Jersey Broadband mapping program and 
have one clarification question: Did you use the 2010 census block geometry as the basis for your 
submission? 
 
Thanks for your participation, 
 
 
John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
 



186 
 

 
From: Wullert, John R II [mailto:jwullert@telcordia.com]  
Sent: Monday, August 29, 2011 5:53 PM 

To: Schoenberger, Douglas W. 
Cc: Clemons, Keefe B; connectingnj@research.telcordia.com 

Subject: Re: NJBB Clarification 
 

 
Douglas, 

   An additional clarification issue: We proceeded assuming these were 2010 
census blocks.  We came across three census blocks that you have as being smaller 

than 2 square miles that we have as over two square miles.  For two of these, you 
have a area of zero, which is clearly incorrect.  For the third one, 
340258119001027, you have an area of 1.959261973 and we have an area of 

2.01155747.  Could you please check your data on these census blocks? 
 

Thanks, 
 

John 

 
 
-----Original Message----- 
From: Schoenberger, Douglas W. [mailto:douglas.w.schoenberger@verizon.com]  

Sent: Tuesday, August 30, 2011 9:54 AM 
To: Wullert, John R II 

Cc: Clemons, Keefe B; connectingnj@research.telcordia.com 
Subject: RE: NJBB Clarification 
 

John, 
 

In response to your questions: 
 

1) We did use the 2010 census block geometry to prepare the Verizon NJ broadband 
data.  

 
2) Could you identify the two specific 2010 census blocks that we have as zero 

area that you have as over two square miles?   
 
Thanks, 

Doug   

 
 
From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  
Sent: Tuesday, August 30, 2011 3:20 PM 

To: 'Schoenberger, Douglas W.' 
Cc: Clemons, Keefe B; connectingnj@research.telcordia.com 

Subject: FW: NJBB Clarification 
 

Doug, 
   The census blocks that your data indicates zero area are 340297310011001 and 

340297381007002.  We have areas of 2.47 and 2.54 square miles, respectively. 
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John 

 

 
From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  

Sent: Tuesday, August 30, 2011 4:47 PM 
To: 'NJ Broadband Data Collection'; 'Schoenberger, Douglas W.' 

Cc: 'Clemons, Keefe B' 
Subject: RE: NJBB Clarification 

 
Doug, 

   A couple more census blocks that we have as larger than 2 square miles.  
(These are so close that the difference may be attributable to rounding error): 
a. 340190118002005 (2.00887743 mi2) 

b. 340270461061026 (2.00118133 mi2) 
 

John 

 

 

 
From: Schoenberger, Douglas W. [mailto:douglas.w.schoenberger@verizon.com]  
Sent: Friday, September 23, 2011 3:28 PM 

To: Wullert, John R II 

Cc: Clemons, Keefe B; connectingnj@research.telcordia.com 
Subject: Revised NJ Broadband Dataset 

Importance: High 

 

Confidential 
  
Hi John, 
  
Attached is  a  revised broadband data for NJ that should replace the data set we 
provided earlier.  This data set corrects for the 0 square mile issue that  you identified.  
This data is confidential and being made available pursuant to the terms of the non-
disclosure agreement. 
  
Please let me know if you have any questions.    
   
Thanks,  
  
Doug Schoenberger  
973-649-0552 
 
 
Section 7: Notes and Open Issues 
 
This section provides detail on the line segments that we believe are mistakenly 
associated with large census blocks. 
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There are 11 line segments that do not belong to large census blocks. 
Here are three examples, for the following tlids: 
 
 624803467 
203769459 
203790565 
 
Row 1:  
 
Census   Block Square Miles TLID  Street Name 
340090219002007 2.059921127  624803467 Pond Creek la 
 
 

 
 

 
 
 

 
Row 2:  
 
Census   Block Square Miles TLID  Street Name 
340297360021058 5.580632034  203769459 Main St 601 
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Row 3:  
Census   Block Square Miles TLID  Street Name 
340297201011066 7.354582338  203790565 Manchester Blvd 
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Section 8: Overview Map of Submitted Data 
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Provider: Netlogic DBA Voxitas 

Submission date: October 2011 
 
This report presents details on processing broadband data for delivery to the National 
Telecommunications and Information Administration (NTIA).   
 
This is a stub report, since data from the previous submission was reused unchanged.  
The complete report from the previous submission begins on the next page.  Notable 
differences from the processing done on the previous submission are listed next. 
 
 
NTIA Table BB_Service_CensusBlock 
 

1. Column " blocksubgroup" was dropped. 
2. Column "endusercat" was added; set to null because data was not supplied. 

 
Total rows loaded: 2 
 
Notes  
 
To create the “providerInput” table for this submission, we removed the 2000 census 
block column from the old providerInput table and performed a spatial join against the 
2010 census block reference data table.   
 
 
Provider Interactions 
 
None.
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Connecting New Jersey - Broadband Provider Data Report 
 
Provider: Voxitas 
Received: August 2010 
Submission date: October 2010 
 
This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 
 
Section 1: NDA Status 
 
Executed. 
 
Section 2: Submission Overview 
 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Netlogic, Inc. 

Voxitas 

0006825954 

FOR WIRELINE 

Filetypes Excel spreadsheet 

File size 9767 bytes, 4 data rows 

Speeds 

Type 

 Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Not provided 

Typical-downstream  Not provided 

Advertised-upstream  Not provided 

Advertised-
downstream 

 
Not provided 

Subscriber-weighted-
up  

Not provided 

Subscriber-weighted-
down 

 
Not provided 

 

Address rows with speed 
entries were provided, probably 
the speed promised to the 
customer.  Not averaged over 
an area so not typical; no 
advertised speeds provided. 

Technology 
Type 

Not provided; guess at copper – other (“DS1”) 

End-user 
specification 

Not provided 

Comments:  

INTERCONNECTION DATA 
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ID  

File size  

Ownership  

Transport Type  

Data 
Rates/Capacity 

 

Location  

Comments: Not provided 

 
 
 
Section 3: Submission File Details 
 
Received 1 file by secure upload. 
 
Size  Name 
9767  NJBroadband.xlsx 
 
The file has 4 (four) rows of data.  All have customer names and addresses.  Three 
records describe DS1 service, one describes something else.  Speeds listed are 
probably the provisioned speeds, not typical or advertised.  No cover letter with DBA 
name, FRN, or other company data is present.  No coded representations of data such 
as end user type, technology of transmission, etc. are provided. 
 
Section 4: Validations and Results 
 
No codes etc. were provided; the only possible validations are to check the addresses, 
and all four appear valid. 
 
 
Section 5: Data Transformation and Loading 
 
The standard NDA prohibits us from submitting address-level data to the NTIA.  Instead, 
we discover the census block for each customer address, then report the census block 
shape drawn from Census Bureau TigerLine reference data. 
 
NTIA Table BB_Service_CensusBlock 
 
Loaded from supplied file “NJBroadband.xlsx” (4 rows).  The following table explains the 
transformations that were applied to load the target table. 
 
Table Column  Data Source / Transformation  
PROVNAME Set to “Netlogic, Inc.” 
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DBANAME Set to “Voxitas” 
RESELLER Set to “N” 
FRN Set to “0006825954” 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census Block FIPS Code (first 3 digits) 
TRACT Populated from Census Block FIPS Code (next 6 digits) 
BLOCKID Populated from Census Block FIPS Code 
BLOCKSUBGROUP Set to null 
FULLFIPSID Populated from Census Block FIPS Code 
TRANSTECH Set to “30” 
MAXADDOWN As supplied in column Downstream 
MAXADUP As supplied in column Upstream 
TYPICDOWN Set to null, not provided 
TYPICUP Set to null, not provided 
SHAPE Copied from Census Bureau TigerLine 2000,  

as matched by spatial join on geocoded address 
 
Internal processing notes: 

1. Geocoded the addresses using the Google geocoder. 
2. Created an excel sheet and imported to a geodatabase table. 
3. Added point shapes corresponding to each Latitude,Longitude pair by creating a 

feature class from the table using ArcCatalog’s “Create Feature Class from XY 
Table” option. 

4. Added a column containing the ID of the containing year 2000 census block via a 
spatial join of the point shapes and the census block shapes from reference data. 

5. Discarded NN rows with duplicate census blocks. 
 
The mechanized procedure for the geocoding steps is described in file 
GeoExcel_proc.txt. 
 
 
Section 6: Clarification Questions and Responses 
 

1. Do you strictly resell access to line owned by other companies? 
2. What is your DBA name? 
3. What is your FRN? 
4. Are all services provided on copper?  We must submit details about “Technology 

of Transmission” per the NOFA. 
5. You have submitted address data, but the NDA prohibits us from submitting 

address-level details to the NTIA.  We will report in terms of census blocks, 
unless you choose to direct us to report address data. 

6. The data look like provisioned speeds.  Is this correct?  We are expected to 
report maximum advertised up and down speeds in your service area, as well as 
typical up and down speeds.  Please tell us how you wish the speeds that you 
submitted to be reported. 
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From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com] 

Sent: Wednesday, August 25, 2010 1:47 PM 

To: Kirk Deyer 

Cc: 'NJ Broadband Data Collection' 

Subject: NJBB Clarification Questions 

 

Kirk, 

     We have been reviewing the data you submitted to the New Jersey Broadband mapping 

program.  Based on our initial review, we have some questions for you that will help us 

better understand the data and process it accurately. 

 

 

1.                   You provided data for a small set of addresses, raising two questions: 

 

a.       Do you own the access facilities that connect to those addresses? (If not, you would 

be classified as a "reseller" and would not have to report data at this time.) 

 

b.      If we are to report this data, is it acceptable to report it at address level? 

 

 

From: Kirk Deyer [mailto:kdeyer@appiaservices.com] 

Sent: Wednesday, August 25, 2010 1:57 PM 

To: ConnectingNJ@research.telcordia.com 

Subject: RE: NJBB Clarification Questions 

 

We lease the lines that connect to those addresses.  Reporting it at the address level is 

acceptable. 

 

Kirk Deyer 

Finance Manager 

Appia Communications, Inc. 

231-929-0970 x140 

Fax:  231-946-8954 

U.S. Eastern Time 

 

 

From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com] 

Sent: Wednesday, August 25, 2010 5:08 PM 

To: Kirk Deyer 

Cc: 'NJ Broadband Data Collection' 

Subject: RE: NJBB Clarification Questions 

 

Kirk, 
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   Thanks for your quick response.  One other clarification - what should we use for the 

"Provider Name" and "Doing Business As" names? 

 

John 

 

 

From: Kirk Deyer [mailto:kdeyer@appiaservices.com] 

Sent: Wednesday, August 25, 2010 5:40 PM 

To: ConnectingNJ@research.telcordia.com 

Subject: RE: NJBB Clarification Questions 

 

Netlogic, Inc. DBA Voxitas 

 

Kirk Deyer 

Finance Manager 

Appia Communications, Inc. 

231-929-0970 x140 

Fax:  231-946-8954 

U.S. Eastern Time 

www.appiaservices.com<http://www.appiaservices.com> 

 
 

From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  

Sent: Friday, August 27, 2010 4:25 PM 

To: Kirk Deyer 

Subject: Additional NJBB Clarifications 

 

Kirk, 

   Upon further review, we identified a few other questions that will help us 

understand and accurately report your data: 

 

1.    What is your FRN? 

2.    Are all services provided on copper?  We must submit details about “Technology 

of Transmission” per the NOFA. 

3.    The data look like provisioned speeds.  Is this correct?  We are expected to 

report maximum advertised up and down speeds in your service area, as well as 

typical up and down speeds.  Please tell us how you wish the speeds that you 

submitted to be reported. 

 

We appreciate your continued support of this program! 

 

 

John Wullert 

Manager – NJ BB Data Collection 
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Telcordia Technologies 

732-699-2687 

 
 

From: Kirk Deyer [mailto:kdeyer@appiaservices.com] 

Sent: Wednesday, August 25, 2010 5:40 PM 

To: ConnectingNJ@research.telcordia.com 

Subject: RE: NJBB Clarification Questions 

 

Our FRN is 0006825954.  The services are provided on copper and they are 

provisioned speeds. 

 

Kirk Deyer 

Finance Manager 

Appia Communications, Inc. 

231-929-0970 x140 

Fax:  231-946-8954 

U.S. Eastern Time 

www.appiaservices.com 

 

 
Section 7: Notes and Open Issues 
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Section 8: Overview Map of Submitted Data 
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Provider: Wave2Wave 

Submission date: October 2011 
 
This report presents details on processing broadband data for delivery to the National 
Telecommunications and Information Administration (NTIA).   
 
This is a stub report, since data from the previous submission was reused unchanged.  
The complete report from the previous submission begins on the next page.  Notable 
differences from the processing done on the previous submission are listed next. 
 
NTIA Table BB_Service_CensusBlock 
 

1. Column " blocksubgroup" was dropped. 
2. Column "endusercat" was added; set to null because data was not supplied. 
3. Discarded 1 record for address that could not be geocoded in New Jersey (in 

Pennsylvania) 
4. Discarded 55 records with duplicate census blocks (i.e., multiple addresses in the 

same census block) 
 
Total rows loaded: 63 
 
NTIA Table BB_Service_Wireless 
 

1. No column changes 
2. See discards above. 

 
Total rows loaded: 105 
 
Notes  
 
To create the “providerInput” table for this submission, we removed the 2000 census 
block column from the old providerInput table and performed a spatial join against the 
2010 census block reference data table.   
 
 
Provider Interactions 
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Connecting New Jersey - Broadband Provider Data Report 
 
Provider: Wave2Wave Communications, Inc. 
Received: March 2011 
Submission date: April 2011 
 
This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 
 
Section 1: NDA Status 
 
NDA executed with NJ OIT. 
 
Section 2: Submission Overview 
 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Wave2Wave Communications, Inc. 

Wave2Wave Communications 

0015329394 

FOR WIRELINE 

Filetypes XLS 

File size 229 rows 

Speeds 

Type 

 Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Address 

Typical-downstream  Address 

Advertised-upstream  Address 

Advertised-
downstream 

 
Address 

Subscriber-weighted-
up 

 
Not provided 

Subscriber-weighted-
down 

 
Not provided 

 

 

Technology 
Type 

30 (other copper - probably Ethernet) and 70 (Terrestrial Fixed Wireless) 

End-user 
specification 

Codes 3 and 4 

Comments:  

INTERCONNECTION DATA 
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ID None provided 

File size  

Ownership  

Transport Type  

Data 
Rates/Capacity 

 

Location  

Comments: 

 
 
 
Section 3: Submission File Details 
 
Received 1 file by SECURE UPLOAD: 
 
Size  Name 
 
76800  NJBB_0015329394_AddressLevelAvailability_03.08.2011.xls 
 
 
Section 4: Validations and Results 
 
The submitted file has 229 rows with street addresses, tech transmission, max adv 
speeds, and typical speeds.  The codes are reasonable, but the high variety in 
maximum advertised speeds is most likely an artifact, rather than a representation of 
the actual capabilities.  Of the original rows, 223 could be geocoded successfully and 6 
could not.  The input address set yielded 163 unique census blocks. 
 
Section 5: Data Transformation and Loading 
 
NTIA Table BB_Service_CensusBlock 
 
Loaded from supplied XLS file.  The following table explains the transformations that 
were applied to load the target table. 
 
Table Column  Data Source / Transformation  
PROVNAME As supplied in column “ProvName” 
DBANAME As supplied in column “DBAName” 
PROVIDER_TYPE Set to 1 
FRN As supplied in column “FRN” 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census Block FIPS Code (first 3 digits) 
TRACT Populated from Census Block FIPS Code (next 6 digits) 
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BLOCKID Populated from Census Block FIPS Code 
BLOCKSUBGROUP Set to null 
FULLFIPSID Populated from Census Block FIPS Code 
TRANSTECH As supplied in column TransTech 
MAXADDOWN As supplied in column MaxAdvDown 
MAXADUP As supplied in column MaxAdvUp 
TYPICDOWN Set to null 
TYPICUP Set to null 
SHAPE Copied from Census Bureau 2000 reference data,  

as matched by spatial join on geocoded address 
 
Internal processing notes: 

1. Geocoded the addresses using the Google geocoder. 
2. Created an excel sheet and imported to a geodatabase table. 
3. Added point shapes corresponding to each Latitude,Longitude pair by creating a 

feature class from the table using ArcCatalog’s “Create Feature Class from XY 
Table” option. 

4. Added a column containing the ID of the containing year 2000 census via a 
spatial join of the point shapes and the census block shapes from reference data. 

5. Copied the Census Block shape from reference data. 
6. Discarded 60 rows with duplicate census blocks, leaving 63 for technology 30. 

 
 
NTIA Table BB_Service_Wireless 
 
Loaded using census block shapes from reference data for the records with 
transmission technology 70.  The following table explains the transformations that were 
applied. 
 
Table Column  Data Source / Transformation  
PROVNAME As supplied in column “ProvName” 
DBANAME As supplied in column “DBAName” 
FRN As supplied in column “FRN” 
TRANSTECH As supplied 
SPECTRUM Set to 6, Unlicensed  
MAXADDOWN Set to 10, the largest value submitted for this tech 
MAXADUP Set to 10, the largest value submitted for this tech 
TYPICDOWN Set to null 
TYPICUP Set to null 
STATEABBR Set to “NJ” 
SHAPE Year 2000 Census Block shape obtained from reference data. 
 
Internal processing notes: 

1. See above for discussion of geocoding addresses and finding the containing 
census block. 

2. Spectrum: Imputed the code for unlicensed spectrum. 
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Section 6: Clarification Questions and Responses 
 
. 
 
Section 7: Notes and Open Issues 
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Section 8: Overview Map of Submitted Data 
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Provider: Wildblue 

Submission date: October 2011 
 
This report presents details on processing broadband data for delivery to the National 
Telecommunications and Information Administration (NTIA).   
 
This is a stub report, since data from the previous submission was reused unchanged.  
The complete report from the previous submission begins on the next page.  Notable 
differences from the processing done on the previous submission are listed next. 
 
 
NTIA Table BB_Service_Wireless 
 
Total rows loaded: 21 (each county in New Jersey) 
 
 
Provider Interactions 
 
From: Stauthamer, Roz [mailto:Roz.Stauthamer@viasat.com]  

Sent: Wednesday, July 20, 2011 12:45 PM 
To: connectingNJ@research.telcordia.com 

Subject: RE: NJ Broadband Data Collection 

 

Dear Shelley Bates and Map Team: 
 

In response to the request for an updated submission, WildBlue Communications, Inc. notifies 
you as follows: 
 
There are no changes to the submission WildBlue previously provided to your office.   WildBlue 
has not had any changes in service coverage area or service offerings, nor have there been any 
administrative changes.   

 

Best wishes, 
 
Roz 
 
 
From: connectingNJ@research.telcordia.com  

Sent: Monday, July 25, 2011 1:22 PM 
To: Stauthamer, Roz [mailto:Roz.Stauthamer@viasat.com] 

Subject: RE: NJ Broadband Data Collection 
 
Roz, 

   Thanks for the response.  We will use the data you submitted previously for the upcoming delivery to NTIA.  Note 

that we will be applying some additional validation tests to the data this round.  We will get back to you if we run 

into any issues with the data. 

 

Thanks, 
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Connecting New Jersey - Broadband Provider Data Report 
 
Provider: WildBlue Communications Inc. 
Received: March 2011 
Submission date: April  2011 
 
This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 
 
Section 1: NDA Status 
 
NONE 
 
Section 2: Submission Overview 
 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

WildBlue Communications, Inc. 

WildBlue 

0007843766  

FOR WIRELESS 

Filetypes text file, shape file 

File size  

Speeds 

Type 

 Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Not provided (‘0’) 

Typical-downstream  Not provided (‘0’) 

Advertised-upstream  yes. Entire state. 

Advertised-
downstream 

 
yes. Entire state 

Subscriber-weighted-
up 

 
Not provided? 

Subscriber-weighted-
down 

 
By county 

 

Submitted shape file describing 
the entire state of NJ with 
attributes for  

Technology 
Type 

Code 60 (Satellite) 

End-user 
specification 

Voice message indicated that the referenced plans are consumer-focused. 

Comments:  From the provider’s input package: 

“The subscriber-weighted nominal speed information has been calculated using only the service tiers 
that meet the NTIA definition of broadband speed, and is based on subscriber data for active 
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subscribers as of March 17, 2011 
 

INTERCONNECTION DATA: NONE 

ID  

File size  

Ownership  

Transport Type  

Data 
Rates/Capacity 

 

Location  

Comments: Not provided 

 
 

 
Figure 1. The shape submitted by the provider (the entire state of NJ) 
 
Section 3: Submission File Details 
 
Size (kb) Name 
2  WildBlue_Subscriber_Weighted_Nominal_speed_By_County_NJ.txt 
1  WildBlue_Availability_0007843766_NJ_region.shx 
1  WildBlue_Availability_0007843766_NJ_region.dbf 
1  WildBlue_Availability_0007843766_NJ_region.prj 
19  WildBlue_Availability_0007843766_NJ_region.shp 
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Section 4: Validations and Results 
 
WildBlue notes that of the possible ‘Spectrum Used’ options provided, none listed Ka-
Band as an option for Satellite Providers.  WildBlue uses Ka-Band spectrum (uplink in 
the 29.5 – 30 gigahertz band and downlink in the 19.7 – 20.2 gigahertz band). WildBlue 
has not provided Typical Upstream Speed and Typical Downstream Speed values. 
WildBlue does not track speeds on a state-by-state basis, but instead primarily monitors 
overall network speeds. WildBlue has begun the process of recording more granular 
data relating to the speeds normally experienced by subscribers on a spot-beam basis. 
WildBlue believes that it will be able to provide this data in the coming months. 
 
The map and supporting data are for one singular service area polygon that equals the 
entire State of New Jersey. The WildBlue service data values provided do not vary 
across any county or region within the state; therefore, there is only one service area 
polygon, namely the entire State of New Jersey 
 
Section 5: Data Transformation and Loading 
 
NTIA Table BB_Service_Wireless 
 
We did not load the shapefile as submitted.  Instead we loaded county shapes from 
reference data for counties in the State of New Jersey based on emailed statements 
that all counties are covered.  The following table explains the transformations that were 
applied. 
 
Table Column  Data Source / Transformation  
PROVNAME Set to "WildBlue Communications, Inc." 
DBANAME Set to "WildBlue" 
FRN Set to 0007843766 
TRANSTECH Set to 60 
SPECTRUM Set to 7 per translation shown below 
MAXADDOWN Set to 4, see below. 
MAXADUP Set to 2, see below. 
TYPICDOWN Not provided, set to null 
TYPICUP Not provided, set to null 
STATEABBR Set to “NJ” 
SHAPE County shape read from reference data. 
 
Internal notes on processing: 

1. Spectrum: No statement was provided.  The NTIA data model has a single 
column for spectrum.  Satellite corresponds to NTIA “SPECTRUM USED” code 
value 7. 

2. Speeds: The maximum advertised speeds provided in the emailed brochure are 
as discussed above  For max adv speeds we encoded the submitted down 
speed as value 4 (range 1.5-3 Mbps) and encoded the submitted up speed as 
value 2 (range 200 Kbps -- 768 Kbps). 
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3. Did not use the supplied shapefile because it was faster to copy over reference 
data that's already in the right XY coordinate system and tolerance value. 

 
 
Section 6: Clarification Questions and Responses 
 
 

 
Section 7: Notes and Open Issues 
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Section 8: Overview Map of Submitted Data 
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Provider: Xchange Telecom 

Submission date: October 2011 
 
This report presents details on processing broadband data for delivery to the National 
Telecommunications and Information Administration (NTIA).   
 
This is a stub report, since data from the previous submission was reused unchanged.  
The complete report from the previous submission begins on the next page.  Notable 
differences from the processing done on the previous submission are listed next. 
 
NTIA Table BB_Service_CensusBlock 
 

1. Column " blocksubgroup" was dropped. 
2. Column "endusercat" was added; set to null because data was not supplied. 

 
Total rows loaded: 1,012 
 
 
Notes 
 
No large census blocks were found in Lakewood, so no street-segment records were 
loaded. 
 
 
Provider Interactions 
 
 
The Service providers told us to use the April 2011 data. 
 
Last time, they told us they cover the entire city of lakewood.  We sent email back to 
him to confirm that is still the case. 
 
 
From: Duvid Rottenberg [drottenberg@xchangetele.com] 
Sent: Wednesday, August 10, 2011 2:54 PM 
To: ConnectingNJ@research.telcordia.com; shelley.bates@oit.state.nj.us 
Cc: 'Mordy Gross'; DBECK@xchangetele.com 
Subject: RE: Reminder - NJ Broadband Data Collection 
 
Hi, 
 
I don't have this data available on the census tract level, however we provide broadband service for all 
customers served by the LKWDNJLKDS5 switch. Our advertised broadband speed for this area is 2 Mbps 
Up and 10 Mbps down. We service both business & residential. 
 
Back in March, you were able to use this info to get the census tracts, please let me know if this OK for 
now too. 
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Thank You, 
Duvid Rottenberg 
Xchange Telecom, Corp. 
drottenberg@xchangetele.com 
(646) 722-7258 
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Connecting New Jersey - Broadband Provider Data Report 
 
Provider: Xchange Telecom 
Received: March 2011 
Submission date: April 2011 
 
This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 
 
Section 1: NDA Status 
 
None 
 
Section 2: Submission Overview 
 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Xchange Telecom Corp 

Xchange Telecom 

0006831713 

FOR WIRELINE 

Filetypes  

File size  

Speeds 

Type 

 Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream   

Typical-downstream   

Advertised-upstream  2 Mbps (code 4) 

Advertised-
downstream 

 
10 Mbps (code 7) 

Subscriber-weighted-
nominal speed 

 
 

 

Information provided via email 
exchange (see below).   

 

Provider originally indicated that 
their coverage was limited to 
the area supported by a single 
central office.  In further 
exchanges, the provider 
indicated that their coverage is 
limited to city of Lakewood and 
that they cover the entire city 
limits. 

 

Technology 
Type 

ADSL (code 10) 

End-user 
specification 

In response to inquiry, provider reported residential and small business. 

Comments:  

INTERCONNECTION DATA 

ID  

File size  
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Ownership  

Transport Type  

Data 
Rates/Capacity 

 

Location  

Comments: 

 
 
Section 3: Submission File Details 
 
Received no file submission, only statements by email. 
 
Section 4: Validations and Results 
 
No data was submitted, so no additional validation was required. 
 
Section 5: Data Transformation and Loading 
 
NTIA Table BB_Service_CensusBlock 
 
Loaded based on the emailed statement of service to all of Lakewood Township, Ocean 
county, New Jersey.  We submitted all census blocks less than 2 square miles in this 
municipality.  The following table explains the transformations that were applied to load 
the target table. 
 
Table Colum n Data Source / Transformation  
PROVNAME Set to “Xchange Telecom Corp” per email response 
DBANAME Set to “Xchange Telecom” 
PROVIDER_TYPE Set to 1 
FRN Set to “0006831713” per email response 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census Block FIPS Code (first 3 digits) 
TRACT Populated from Census Block FIPS Code (next 6 digits) 
BLOCKID Populated from Census Block FIPS Code 
BLOCKSUBGROUP Set to null 
FULLFIPSID Populated from Census Block FIPS Code 
TRANSTECH Set to 10 (ADSL) per email 
MAXADDOWN Set to code 7 per email 
MAXADUP Set to code 4 per email 
TYPICDOWN Set to null, not provided 
TYPICUP Set to null, not provided 
SHAPE Copied from Census Bureau TigerLine 2010 
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Internal processing notes: 
1. Created a file with a municipality name that matches exactly the “name” column 

in the Year 2010 Census Bureau TigerLine database. 
2. Joined against reference data to discover census blocks, for a total of 681 

blocks. 
3. All of the census blocks discovered for Lakewood Township are smaller than 2 

square miles, so no road segments were loaded. 
 
 
Section 6: Clarification Questions and Responses 
 
 
From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  

Sent: Wednesday, March 09, 2011 8:34 AM 
To: 'Duvid Rottenberg'; 'ConnectingNJ@research.telcordia.com' 

Cc: 'Shelley Bates' 
Subject: RE:  

 

Duvid, 
   We can work with that information as far as geography and mapping into Census blocks.  What we 
would need then is information on your speeds and middle-mile interconnection points.  In terms of 
speeds, we are requesting the maximum upstream and downstream speeds you advertise in Lakewood, 
and the typical upstream and speeds experienced by your customers.  For middle-mile interconnection 
points, we are requesting the address, and the technology and bandwidth you have available and 
whether you own or lease the trunks. 
 
   There is also a small amount of general information we need.  Specifically, we need you official 
company name, and other names you do business as and your FCC FRN number. 
 
Thanks for your participation in the program! 
 
 
John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
 
 

From: Duvid Rottenberg [mailto:drottenberg@xchangetele.com]  
Sent: Tuesday, March 08, 2011 3:36 PM 

To: ConnectingNJ@research.telcordia.com 

Cc: 'Shelley Bates' 
Subject: RE:  

 

John, 
We are a UNE-L company, we lease the loop from Verizon and provide broadband for the end user on 
the leased circuits. I believe we do cover the whole city of Lakewood. 
 
Duvid Rottenberg 
Xchange Telecom, Corp. 
drottenberg@xchangetele.com 
(646) 722-7258 



217 
 

 
 
From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  
Sent: Tuesday, March 08, 2011 3:21 PM 

To: drottenberg@xchangetele.com 
Cc: ConnectingNJ@research.telcordia.com; 'Shelley Bates' 

Subject:  

 

Duvid, 
   I received the note that you sent to Shelley Bates regarding the questions you have about submitting 
your broadband availability data.  Rather than attempting to answer your question, let me first ask another 
question that will help determine if you are required to report data at this time.  We are currently only 
collecting data from “facilities-based” providers.  NTIA definition is: 
 
An entity is a ‘‘facilities-based’’ provider of broadband service connections to end user locations if any of 
the following conditions are met: (1) It owns the portion of the physical facility that terminates at the end 
user location; (2) it obtains unbundled network elements (UNEs), special access lines, or other leased 
facilities that terminate at the end user location and provisions/equips them as broadband; or (3) it 
provisions/equips a broadband wireless channel to the end user location over licensed or unlicensed. 
 
If you fit the definition, then we would be looking to collect data from you.  In that case, we need to come 
up with a method of determining your coverage area.  We do not have a clean way of mapping from COs 
to census blocks.  We do have a couple options: 

1. If you could estimate your coverage area in terms of governmental boundaries, we could map 

that into census blocks.  For example, if you know that you cover the entire town/city of 

Lakewood, we could handle the rest. 

2. If you were to send us a list of addresses, we could geo-code those locations.  This is less 

desirable, as where you have customers does not fully represent the locations where you could 

offer service, but we have done it in some cases. 

 
Let me know how I can help you in determining an approach. 
 
 
John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
 
 
From: Duvid Rottenberg [mailto:drottenberg@xchangetele.com]  

Sent: Tuesday, March 08, 2011 11:41 AM 
To: Bates, Shelley 

Cc: Michael Robinson 

Subject: Xchange Telecom Broadband Service 

 

Hi Shelley, 
 
I am working on providing the data you requested from Michael. Our broadband service is currently 
available for all customers served by the LKWDNJLKDS5 CO, I'm not sure how to map that into  census 
tracts. I have tried setting up an account at http://connectingnj.state.nj.us but I got an error stating that 
Xchange Telecom is not a recognized provider. 
 
Thank You, 
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Duvid Rottenberg 
Xchange Telecom, Corp. 
drottenberg@xchangetele.com 
(646) 722-7258 
 
From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  
Sent: Tuesday, March 08, 2011 3:21 PM 

To: drottenberg@xchangetele.com 

Cc: ConnectingNJ@research.telcordia.com; 'Shelley Bates' 
Subject:  

 

Duvid, 
   I received the note that you sent to Shelley Bates regarding the questions you have about submitting 
your broadband availability data.  Rather than attempting to answer your question, let me first ask another 
question that will help determine if you are required to report data at this time.  We are currently only 
collecting data from “facilities-based” providers.  NTIA definition is: 
 
An entity is a ‘‘facilities-based’’ provider of broadband service connections to end user locations if any of 
the following conditions are met: (1) It owns the portion of the physical facility that terminates at the end 
user location; (2) it obtains unbundled network elements (UNEs), special access lines, or other leased 
facilities that terminate at the end user location and provisions/equips them as broadband; or (3) it 
provisions/equips a broadband wireless channel to the end user location over licensed or unlicensed. 
 
If you fit the definition, then we would be looking to collect data from you.  In that case, we need to come 
up with a method of determining your coverage area.  We do not have a clean way of mapping from COs 
to census blocks.  We do have a couple options: 

1. If you could estimate your coverage area in terms of governmental boundaries, we could map 

that into census blocks.  For example, if you know that you cover the entire town/city of 

Lakewood, we could handle the rest. 

2. If you were to send us a list of addresses, we could geo-code those locations.  This is less 

desirable, as where you have customers does not fully represent the locations where you could 

offer service, but we have done it in some cases. 
 
Let me know how I can help you in determining an approach. 
 
 
John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
 
 
From: Duvid Rottenberg [mailto:drottenberg@xchangetele.com]  
Sent: Tuesday, March 08, 2011 3:36 PM 

To: ConnectingNJ@research.telcordia.com 
Cc: 'Shelley Bates' 

Subject: RE:  

 
John, 
We are a UNE-L company, we lease the loop from Verizon and provide broadband for the end user on 
the leased circuits. I believe we do cover the whole city of Lakewood. 
 
Duvid Rottenberg 
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Xchange Telecom, Corp. 
drottenberg@xchangetele.com 
(646) 722-7258 
 
 
From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  
Sent: Wednesday, March 09, 2011 8:34 AM 

To: 'Duvid Rottenberg'; 'ConnectingNJ@research.telcordia.com' 
Cc: 'Shelley Bates' 

Subject: RE:  

 

Duvid, 
   We can work with that information as far as geography and mapping into Census blocks.  What we 
would need then is information on your speeds and middle-mile interconnection points.  In terms of 
speeds, we are requesting the maximum upstream and downstream speeds you advertise in Lakewood, 
and the typical upstream and speeds experienced by your customers.  For middle-mile interconnection 
points, we are requesting the address, and the technology and bandwidth you have available and 
whether you own or lease the trunks. 
 
   There is also a small amount of general information we need.  Specifically, we need you official 
company name, and other names you do business as and your FCC FRN number. 
 
Thanks for your participation in the program! 
 
John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
 
 
From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  
Sent: Monday, March 14, 2011 4:16 PM 

To: 'NJ Broadband Data Collection'; 'Duvid Rottenberg' 

Cc: 'Shelley Bates' 
Subject: RE:  

 

Duvid, 
   I am sending this again to request data from you on the types of service you advertise.  I attempted to 
gain this information from your Web site, but was unable to get any information on the plans you offer.  
Could please send me information on the maximum upstream and downstream speeds you advertise in 
Lakewood?  If you have information on the typical upstream and speeds experienced by your customers, 
that would be useful as well. 
   Please feel free to call me if you have any questions. 
 
 
John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
 
 
From: Duvid Rottenberg [mailto:drottenberg@xchangetele.com]  
Sent: Monday, March 14, 2011 4:31 PM 

To: ConnectingNJ@research.telcordia.com 
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Cc: 'Shelley Bates' 

Subject: RE:  

 

2 Mbps Upstream and 10 Mbps downstream.  
 
Duvid Rottenberg 
 
 
From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  
Sent: Monday, March 14, 2011 4:46 PM 

To: 'Duvid Rottenberg'; 'ConnectingNJ@research.telcordia.com' 

Cc: 'Shelley Bates' 
Subject: RE:  

 

Thanks for this. 
 
One other question – do you serve both residential and business customers? 
 
John 
 
 
From: Duvid Rottenberg [mailto:drottenberg@xchangetele.com]  

Sent: Monday, March 14, 2011 4:57 PM 
To: ConnectingNJ@research.telcordia.com 

Cc: 'Shelley Bates' 
Subject: RE:  

 

Yes we do. 
 
Duvid Rottenberg 
 
 
From: NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  

Sent: Friday, March 18, 2011 10:41 AM 

To: 'Duvid Rottenberg' 
Cc: 'NJ Broadband Data Collection' 

Subject: Xchange NJ BB Clarification 

 

Duvid, 
   We need to report data using Provider Name, Doing-Business-As Name and FCC Registration number.  
The information we retrieved from the FCC is: 
 
Provider Name:                XCHANGE TELECOM CORP.    
FRN:                                      0006831713 
 
Are these correct?  Also, do you have another “doing-business-as” name? 
 
Thanks, 
 
 
John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
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Section 7: Notes and Open Issues 
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Section 8: Overview Map of Submitted Data 

 
  



223 
 

Provider: XO Communications 

Submission date: October 2011 
 
This report presents details on processing broadband data for delivery to the National 
Telecommunications and Information Administration (NTIA).   
 
This is a stub report, since data from the previous submission was reused unchanged.  
The complete report from the previous submission begins on the next page.  Notable 
differences from the processing done on the previous submission are listed next. 
 
A specific challenge in this case is mapping from the Year 2000 census block geometry 
used in the April 2011 submission to the Year 2010 census block IDs required for 
October 2011. 
 
NTIA Table BB_Service_CensusBlock 
 

1. Column " blocksubgroup" was dropped. 
2. Column "endusercat" was added; set to null because data was not supplied. 

 
 
Notes 

1. Discarded 28 records with missing or slow maximum download speed codes. 
2. Used Census Bureau reference data to build a list of Year 2010 census blocks 

for each submitted Year 2000 census block.  The 419 valid Year 2000 blocks 
resulted in 879 unique Year 2010 blocks. 

3. Total rows loaded: 879 
 
 
Provider Interactions 
 
July 7, 2011: Sharon Adams instructed us to use previous data. 
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Connecting New Jersey - Broadband Provider Data Report 
 
Provider: XO Communications 
Submission date: April 2011 
 
This report presents details on processing broadband data for delivery to the National 
Telecommunications and Information Administration (NTIA).   
 
This is a stub report, since data from the previous submission was reused unchanged.  
The complete report from the previous submission begins on the next page.  Notable 
differences from the processing done on the previous submission are listed next. 
 
NTIA Table BB_Service_CensusBlock 
 

1. Column "reseller" was dropped. 
2. Set the new column "provider_type" to value 1 ("Broadband provider as 

described in the NOFA") 
3. Set the max advertised speed code values (down and up) to 9, which is the 

maximum value among all records provided to us. 
4. Dropped non-measured typical up/down speed code values. 

 
 
Provider Interactions 
 
From:  Adams, Sharon E [mailto:Sharon.E.Adams@xo.com]  
Sent:  Tuesday, March 01, 2011 4:11 PM 
To:  ConnectingNJ@research.telcordia.com 
Subject:  RE: NJ BB Data Collection - Spring 2011 
 
Hi John, 
 
I don’t have any new data to report.  
 
Thanks, 
Sharon Adams 
 
 
From:  NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  
Sent:  Tuesday, March 01, 2011 4:23 PM 
To:  Adams, Sharon E 
Cc:  ConnectingNJ@research.telcordia.com 
Subject:  RE: NJ BB Data Collection - Spring 2011 
 
Sharon, 
   Are you saying that we can use the data you submitted last time (that it reflects your network 
capabilities as of 12/31/2011)? 
 
 
John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 



225 
 

732-699-2687 
 
From:  Adams, Sharon E [mailto:Sharon.E.Adams@xo.com]  
Sent:  Tuesday, March 01, 2011 4:41 PM 
To:  ConnectingNJ@research.telcordia.com 
Subject:  RE: NJ BB Data Collection - Spring 2011 
 
Yes, the previous data can be used again. 
 
Thanks, 
Sharon Adams 
 
 
From:  NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  
Sent:  Friday, March 18, 2011 9:34 AM 
To:  'Adams, Sharon E' 
Cc:  'NJ Broadband Data Collection' 
Subject:  XO NJBB Data Clarification 
 
Sharon, 
   We have performed our initial review of your data and have a clarification question:  

We see several locations where your download speeds are a tier 2, which the NTIA does 
not consider broadband.  This appears that it might be the provisioned speed sold to the 
customer.  Is there a higher, advertised speed that you could provision to these locations 
if the customer asked?  One option would be for us to use the highest speed you deliver 
in a larger area as the maximum advertised speed.  Would that accurately represent 
your ability to deliver service? 

 
 
John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
 
 
From:  Adams, Sharon E [mailto:Sharon.E.Adams@xo.com]  
Sent:  Thursday, July 07, 2011 9:56 AM 
To:  ConnectingNJ@research.telcordia.com 
Subject:  NJ Broadband Data Collection 
 
Good morning, 
 
Neither XO Communications Services, Inc. nor Nextlink Wireless, Inc. have any updates to previously 
submitted data.  Please advise what steps need to be taken in order to ensure these companies 
compliance. 
 
Kind regards, 
Sharon Adams 
 
 
From:  NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  
Sent:  Thursday, July 07, 2011 11:13 AM 
To:  'Adams, Sharon E' 
Cc:  'connectingNJ@research.telcordia.com' 
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Subject:  RE: NJ Broadband Data Collection 
 
Sharon, 
   Thanks for the quick response.  Your email message is sufficient notification for us to proceed using the 
data you have already submitted. 
 
  Note that we will be applying additional validation and verification procedures during this round and will 
get back to you if any issues arise with the data you supplied. 
 
 
John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
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Connecting New Jersey - Broadband Provider Data Report 
 
Provider: XO Communications 
Received: August, 2010 
Submission date: October 2010 
 
This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 
 
Section 1: NDA Status 
 
Executed. 
 
Section 2: Submission Overview 
 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

XO Communications, LLC 
Provided, but looks weird 
0006275945 

FOR WIRELINE 

Filetypes  

File size  

Speeds 

Type 

 Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  census block 

Typical-downstream  census block 

Advertised-upstream  census block 

Advertised-
downstream 

 
census block 

Subscriber-weighted-
up 

 
Not provided 

Subscriber-weighted-
down 

 
Not provided 

 

 

Technology 
Type 

Entered codes 1, 2, and 3, which are not valid NOFA TechTrans codes. 

End-user 
specification 

Business (444 entries), Residence (5 entries) 

Comments:  

INTERCONNECTION DATA 
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ID  

File size  

Ownership  

Transport Type  

Data 
Rates/Capacity 

 

Location  

Comments: Not provided 

 
 
 
Section 3: Submission File Details 
 
Received 1 file by SECURE UPLOAD. 
 
Size  Name 
41358  NJBroadbandData63009.xlsx 
 
 
Section 4: Validations and Results 
 
The spreadsheet provides census block IDs and associated max adv and typical 
speeds. The last two rows of the sheet are different from the 447 data rows proceeding 
them, and one of those last two is in New York.  The DBA name looks unusual and the 
technology of transmission codes are not valid.  After receiving clarification by email we 
created a corrected spreadsheet based on the original submission as follows: 

1. Dropped the last two rows that have addresses instead of provider name, DBA 
name, etc. 

2. Changed DBA Name entries to “XOCSI” 
3. Changed technology of transmission codes: 1 to 10, 2 to 20, and 3 to 30. 

 
Section 5: Data Transformation and Loading 
 
NTIA  Table BB_Service_CensusBlock 
 
Loaded from the supplied spreadsheet.  The following table explains the 
transformations that were applied to load the target table. 
 
Table Column  Data Source / Transformation  
PROVNAME As supplied in column “Provider Name” 
DBANAME As supplied in column “DBA Name” 
RESELLER Set to “N” 
FRN As supplied in column “FRN”, after adding leading zeros 
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STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from column census_block (1st 3 digits) 
TRACT Populated from column census_block (next 6 digits) 
BLOCKID Populated from column census_block 

(last 4 digits) 
BLOCKSUBGROUP Set to null 
FULLFIPSID As supplied in column census_block 
TRANSTECH As supplied in column Tech Code 
MAXADDOWN As supplied in column MaxDownload 
MAXADUP As supplied in column MaxUpload 
TYPICDOWN As supplied in column TypDownload 
TYPICUP As supplied in column TypUpload 
SHAPE Copied from Census Bureau TigerLine 2010,  

As matched by Census block ID 
 
 
Internal processing notes: 

1. No duplicate census blocks were found. 
 
Section 6: Clarification Questions and Responses 
 
From:  NJ Broadband Data Collection [mailto:ConnectingNJ@research.telcordia.com]  
Sent:  Tuesday, September 13, 2011 4:07 PM 
To:  'Adams, Sharon E' 
Cc:  ConnectingNJ@research.telcordia.com 
Subject:  RE: NJ Broadband Data Collection 
 
Sharon, 
   We realized that we have a potential issue with processing the data you submitted previously.  The 
NTIA has transitioned from using the 2000 census block geometry to the 2010 census block geometry.  
While it is possible for us to translate your prior data, there is a high risk of overstating or understating 
your actual coverage area due to the many-to-many mappings between the two sets of census blocks. 
   Is it possible for you to provide your data using the 2010 geometry? 
 
 
John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
 
 
From:  Adams, Sharon E [mailto:Sharon.E.Adams@xo.com]  
Sent:  Tuesday, September 13, 2011 4:10 PM 
To:  ConnectingNJ@research.telcordia.com 
Subject:  RE: NJ Broadband Data Collection 
 
Hi John, 
 
It’s fine to restate our data with the new census block geometry.  I do not have the new 2010 geometry to 
restate the data. 
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Thanks, 
Sharon Adams 
 
 
 
Section 7: Notes and Open Issues 
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Section 8: Overview Map of Submitted Data 
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Summary 
For each category of community anchor institution, we generally obtained data from two sources.  One 

source was a reference source that provided a list of institutions with name, address and ID number 

where applicable.  This reference source was expected to be nearly complete, representing all the 

institutions of the specified type in the state.  The other source provided the broadband information.  In 

most cases, the broadband information was supplied by the institutions via our Web site.   

There were exceptions, however, to these guidelines.  In the case of Higher Education, we obtained the 

broadband access information from NJEdge, an organization that collects data via its own survey.  In the 

case of State Government, we obtained a list of broadband circuits provided to the state by Verizon; 

there was no reference list for comparison.   We similarly had no reference list for local government and 

non-governmental organizations; we used only data from collected via our Web site for these classes of 

institution. 

For each CAI category, t he following table provides the number of records we obtained from the 

reference source, the number of broadband access records we obtained, the total number of records we 

submitted to the NTIA and the number of complete records, with verified address information and 

broadband access information.  

CAI Category Reference 

Records 

Broadband 

Records 

Total Records 

Submitted 

Complete Records 

Submitted 

School K-12 (Public) 2603 
796 (Web) 

478 (eRate) 

2598 175 

School K-12 

(Private) 

1260 

(NCES) 
1267 169 

Libraries 465 

(IMLS) 
89 472 50 

Medical/Healthcare 1107 

(NJ-HHS) 
5 1108 5 

Public Safety 343 

(NJ 911 Comm.) 
120 349 104 

University 158 

(NCES IPEDS) 

39 

(NJEdge) 
158 39 

Other – State 

Government 
 2007 1947 1947 

Other – Local 

Government 
0 54 54 54 

Other – Non 

Government 
0 8 8 8 

Total   6964 2551 
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Local Government and Non-Government Organizations 
1. Accepted data submitted by 54 local government and 8 non-governmental organizations via 

specially designed Web site.  We merged data submitted to Web site for April 2011 delivery with 

that submitted between April and September.  (Files lib_20110323.xml and lib_20110907.xml) 

Data collected included: 

i. Community Anchor Institution Category  

ii. Community Anchor Institution Name  (System, Branch) 

iii. Address: Street, City, State, Zip, County   

iv. Contact info: Name, Phone, Email, Web address   

v. Wi-Fi access 

vi. Broadband info: Provider, Technology, Upstream and Downstream speeds 

vii. Comment 

2. Generated Latitude and Longitude via geo-coding using Yahoo geocoder API. 

a. Ensured no errors were present, that at least on entry was returned and that quality 

metric was over 75.  Also ensured that result was in New Jersey and that city and zip 

were not both blank. 

Output is in file Submitted_GovNGO_CAIs.xls. 

3. Manually edited results to add street numbers in those places where it was missing via Google 

search for the institution name.   

 

State Government 
1. Obtained a listing of 2007 connections provided by the primary broadband service provider to 

the state.  List of connections included the following data: 

a. Service address   

i. This field included an indication of the office or department being served and an 

extremely abbreviated version of the address 

ii. e.g.: “(SPNL)STATE OF NJ-TLS 19 LANDIS AV, UP DRFLD T” 

b. Speed (single value, 1.5 to 1000 Mbps) 

c. Technology (ATM, Ethernet, Frame Relay, PRI, Point-to-Point 

2. Used an automated process to expand the town names in the Service Address field  (flow for 

steps 2-6 is in file VerizonList_Geocode.arroyo; input file is Broadband Mapping Prod Sum 2500 

Feb 11_Addressed_Ida_Murray3.xlsx) 

a. For example, replaced “PRSPY” with “Parsippany” and “FR LN” with “Fair Lawn” 

3. Extracted address information from Service Address field  by removing the following: 

a.  Digits following and including a pound sign (e.g., NJ STATE PAROLE DIST #6 210 S 

BROAD) 

b.  “P.O Box NNNN”,  

c. Anything in parentheses (e.g., (SPNL)STATE OF NJ:OIT 90 STATE HWY NO 183) 
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d. Any string consisting solely of letters, backslashes, colons, dashes, ampersands and 

spaces prior to the first number string in the address (e.g., SONJ:DOE 7 GLENWOOD AV, 

E O BLDG FLR 4;DES SUITE 401-402) 

e. Any string after the first comma (e.g., 7 GLENWOOD AV, E O BLDG FLR 4;DES SUITE 401-

402 

f. Text prior to and including an ampersand (e.g., NJ STATE DOT @ ROUTE 23) 

g. Replacing “AV,” with “AVE,” 

h. Any text between commas  (e.g., 3810 NEW JERSEY AV, WILD DES DEPT LABOR,) 

4. Extracted CAI Name information using the following rules: 

a. Extract text between four characters in parentheses and the last number to appear 

b. Remove any number and text following it 

c. Remove any ampersand and the text following it 

d. Replace empty strings with SONJ 

5. Merged city information and state information with extracted addresses. 

6. Generated Latitude and Longitude via geo-coding using Yahoo geocoder API. 

a. Ensured no errors were present, that at least on entry was returned 

b. Ensured that state was New Jersey and that city and state values were populated. 

7. For those that failed test with Yahoo geocoder API, attempted to match with Google geocoder 

API 

a. Ensured no errors were present, that at least on entry was returned 

b. Ensured that state was New Jersey and that city and state values were populated. 

8. Results in successful geocoding of 1917 of the 2007 entries 

a. Results are in file NJ_State_Verizon_Geocoded.xls  

Hospitals 
1. Obtained a listing of 1107 hospitals from NJ Department of Health and Human Services  .  List of 

connections included the following data: 

a. Facility Name 

b. Address: Street, City, State, Zip  

2. Generated Latitude and Longitude via geo-coding using Google geocoder API. 

a. Ensured that at least on entry was returned, that state was New Jersey and that city or 

zip were present in recognized address.  (Used Arroyo flow 

HHS_Hospital_Process.arroyo) 

Output of this stage is in file Hospitals_Geocoded2.csv. 

3. Merged NJ-HHS data with data collected from 5 hospitals via our hosted Web site to merge 

address and ID information with speed and Wi-Fi availability information.  We merged data 

submitted to Web site for April 2011 delivery with that submitted between April and 

September.  (Files lib_20110323.xml and lib_20110907.xml) 

a. Performed exact match between NJ-HHS and submitted data on institution name 
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i. Facilitated matching by Converting names to upper case, removing certain 

common words (THE, HOSPITAL, MEDICAL, CENTER, SYSTEM, HEALTHCARE), 

removing double spaces and trimming leading and trailing spaces. 

This portion of the process occurs in SubmittedCAI_Hospital_Process.arroyo. 

Output is in file Hosp_Submitted_Matched.xls. 

4. Manually matched inserted last hospital into list. 

Higher Education 
1. Obtained the following data from the named sources 

a. List of higher education institutions from National Center for Education Statistics IPEDS 

Data Center (http://nces.ed.gov/collegenavigator/?s=NJ).  Table included information 

on 158 institutions with the following fields: 

i. Institution Name 

ii. Address: Street, City, County, State, ZIP 

iii. IPEDS ID 

Final input data, including a few manual edits (see below) is in file 

CollegeNavigator_NJ_20110909_fixed2.xlsx 

b. Generated Latitude and Longitude via geo-coding using Yahoo geocoder API (flow 

IPEDS_HigherEd_Geocode.arroyo). 

i. Ensured no errors were present, that at least on entry was returned 

ii. Ensured that state was New Jersey and that city and state values were 

populated. 

c. For those that failed test with Yahoo geocoder API, attempted to match with Google 

geocoder API (Flow IPEDS_HigherEd_Geocode.arroyo) 

i. Ensured no errors were present, that at least on entry was returned 

ii. Ensured that state was New Jersey and that city and state values were 

populated. 

d. Manually updated a few addresses that failed to produce maps.  Result was that 156 of 

158 institutions were properly geocoded. 

2. List of members of NJEdge (Format-edited version is in file Mapping 

Bandwidth_Mb_07112011_edit.xlsx).  Table included information on 50 institutions, most of 

which (39) were unique state, community or private institutions of higher learning.  Information 

from NJEdge included: 

i. Institution Name 

ii. Address 

iii. Technology Type 

iv. Upstream and downstream speeds 

3. Merged IPEDS and NJEdge data to match institution data with broadband access information 

a. Performed exact match on institution name 
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i. Facilitated matching by Converting names to upper case and trimming excess 

spaces 

b. Of those NJEdge data entries that did not match, used approximate matching based on 

institution name 

i. Preprocess prior to approximate match involved 

1. Removing strings COLLEGE, UNIVERSITY, NEW JERSEY 

2. Removing any punctuation 

ii. Matched using Levenshtein Distance metric with threshold of 4. 

c. Reviewed unmatched NJEdge data manually and identified three additional matches. 

4. Successfully merged data from all 39 NJEdge institutions into IPEDS data for total of 158 

institutions 

a. Note that remaining NJEDGE institution (Fairleigh Dickenson) has different address than 

either of the campuses in the IPEDS data. 

Final output is in file HigherEd_Geocoded_RateMatched.xls 

5. Manually edited results to add street numbers in those places where it was missing via Google 

search for the institution name.   

Libraries 
1. Obtained the following data from the named sources  

a. Obtained the file “Public Libraries Survey Fiscal Year 2009” from 

http://harvester.census.gov/imls/data/pls/index.asp.  Used file puout09.txt 

i. Manually extracted 465 records for the state of New Jersey 

ii. Used the following data items: 

1. FSCSKEY 

2. FSCS_SEQ 

3. LIBNAME 

4. ADDRESS 

5. CITY 

6.  ZIP 

7. LATITUDE 

8. LONGITUDE 

b. Data submitted by 89 library organizations via specially designed Web site.  Data 

collected included same fields listed above for Local Governmental organizations 

2. Merged library survey data with data collected from libraries via our hosted Web site to merge 

address and ID information with speed and Wi-Fi availability information. 

a. Performed exact match between survey and submitted data on library name 

i. Facilitated matching by Converting library names to upper case, cutting 

submitted names to fixed-field length of survey data (60 characters) and 

trimming excess spaces 

b. For those submitted data entries that did not match, performed an approximate match 

based on library name 
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i. Preprocess prior to approximate match involved 

1. Removing strings “P.L.”, “FREE”, “PUBLIC”, “LIBRARY”, TOWNSHIP, 

TSWP, PUB, LIB, THE, SYSTEM 

2. Removing any punctuation 

3. Converting “NO”/”SO” at start of line to NORTH and SOUTH respectively 

ii. Matched using Levenshtein Distance metric with threshold of 3. 

c. Successfully matched all but twelve submitted entries to Library Survey Data 

i. Manual comparison showed that two of those libraries were not present in the 

survey data. 

ii. Remaining ten were branches of Newark Public Library, but all were submitted 

with the same address, so they could not be successfully geocoded. 

Results (LibraryPlusSubmitted.xls) include 472 Library entries.  This is larger than the 465 

from the survey because some libraries submitted more than one broadband provider. 

3. Manually edited results to add street numbers in those places where it was missing via Google 

search for the institution name.   

a. During manual edit, also removed entries that were labeled “bookmobile” as not 

indicating a valid anchor institution able to receive broadband. 

Private K-12 Schools 
1. Obtained the following data from the named sources:  

a. List of private K-12 education institutions from National Center for Education Statistics 

Private School Universe Survey (http://nces.ed.gov/surveys/pss/pssdata.asp).  Table 

included information on 1260 institutions with the following fields: 

i. Name 

ii. Address: Street, City, State, ZIP 

iii. NCES_ID 

iv. Latitude/Longitude 

b. Data submitted by schools via specially designed Web site.  Data collected included 

same fields listed above for Local Governmental organizations.  Total number of Public 

and Private schools submitting information was 796. 

c. Data from the USAC eRate program, listing schools that have obtained subsidized 

Internet access, including following relevant fields 

i. Name 

ii. Address: Street, City, State, ZIP 

iii. Provider 

There were 478 records that corresponded to schools and Internet access. 

2. Merged NCES private school with data collected from private schools via our hosted Web site to 

merge address and ID information with speed information. 

a. Performed exact match between NCES and submitted data on institution name and zip 

code 

i. Facilitated matching by: 
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1. Converting school names to upper case 

2. Removing string “, NJ” 

3. Converting string SAINT to ST 

b. For those submitted data entries that did not match NCES data, performed an 

approximate match based on institution name 

i. Preprocess prior to approximate match involved 

1. Replacing string SCHOO or SCHO with SCHOOL 

2. Replacing string “HIGH SCHOOL” with HS and string “ELEMENTARY” with 

ELEM 

3. Removing strings SCHOOL, THE, REGIONAL, HIGH and ACADEMY 

4. Trimming excess spaces 

ii. Matched using Levenshtein Distance metric with threshold of 3. 

c. Successfully merged data from 71 submitted private school into 1260 NCES institutions 

i. Manual comparison resulted in matching of two additional institutions 

ii. Remaining institutions were ambiguous or not present in the NCES data. 

3. Combined results of step 2 with eRate data to merge address and ID information with access 

and provider data. (Flow in file K-12_eRateProcess.arroyo, handles both public and private 

schools) 

a. Performed exact match between step-2 results and eRate data on institution name and 

zip code 

b. Verified uniqueness of results based on institution name, zip code and provider 

c. When a match was detected, set the Availability flag to “y” and filled in provider name 

from eRate data.  (Unless provider name was already present from Web-submitted 

data) 

d. Filled in an 128 additional records 

4. Generated 1267 records to submit.  Note that some schools had more than one service provider 

and thus include multiple records. 

a. Output file is PrivateSchool_GeoMatched.xls 

5. Manually edited results to add street numbers in those places where it was missing via Google 

search for the institution name.  Note that not all schools have a street number – some list an 

intersection and others simply list the street as their address. 

Public K-12 Schools 
1. Obtained the following data from the named sources:  

a. List of public K-12 education institutions from National Center for Education Statistics 

Public School Universe Survey.  (Went to http://nces.ed.gov/ccd/schoolsearch/ , 

searched for schools in New Jersey, then selected option at bottom of results page to 

download an Excel file: ncesdata_DE2476A3.xls.) Table included information on 2603 

institutions with the following fields: 

i. Name 

ii. Address: Street, City, State, ZIP 



8 

 

iii. NCES_ID 

b. Data submitted by schools via specially designed Web site.  This was entries in the 

school category that did not match any of the NCES private schools.  Total number of 

Public and Private schools submitting information was 796.  Of those,  673 did not 

match private schools. 

c. Data from the USAC eRate program, listing schools that have obtained subsidized 

Internet access, including following relevant fields 

i. Name 

ii. Address: Street, City, State, ZIP 

iii. Provider 

There were 478 records that corresponded to schools and Internet access. 

2. Merged NCES private school with data collected from private schools via our hosted Web site to 

merge address and ID information with speed information. (Flow in file PublicK-

12Process.arroyo) 

a. Performed exact match between NCES and submitted data on institution name and zip 

code 

i. Facilitated matching by: 

1. Removing SCHOOL and all truncated versions of the word from the ends 

of any string 

2. Performing the following conversions 

a.  “SENIOR HIGH” and HIGH to HS  

b.  “MIDDLE”, “M S”, “MID” and “MIDD” to MS 

c. “ELEMENTARY” to ELEM 

d. CHARTER to CS 

e. BOROUGH to BORO 

f. AVENUE to AVE 

g. TOWNSHIP to TWP 

h. STREET to ST 

3. Removing the strings REGIONAL, “ REG” and ACADEMY 

4. Removing punctuation and double spaces 

5. Trimming any leading or trailing spaces 

b. For those submitted data entries that did not match NCES data, performed an 

approximate match based on concatenation of institution name and zip code 

i. Preprocess prior to approximate match involved 

1. Removing the following phrases 

a. “BOARD OF EDUCATION” and all truncated versions 

b. BOE 

c. DISTRICT and all truncated versions 

d. PRIMARY, INTERMEDIATE, ELEM, MS, HS, SR, JR 

e. # or any digits 

f. PUBLIC 

2. Trimming excess spaces 
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3. Submitted entries that were blank after these operations were 

removed.  

ii. Matched using Levenshtein Distance metric with threshold of 2. 

c. Successfully merged data from 169 submitted entries into 2595 NCES institutions 

i. Dropped 8 NCES institutions as incomplete 

ii. Recurring issue was information submitted for districts that did not correspond 

to a specific school 

3. Combined results of step 2 with eRate data to merge address and ID information with access 

and provider data. (Flow in file K-12_eRateProcess.arroyo, handles both public and private 

schools) 

a. Performed exact match between step-2 results and eRate data on institution name and 

zip code 

b. Verified uniqueness of results based on institution name, zip code and provider 

c. When a match was detected, set the Availability flag to “y” and filled in provider name 

from eRate data.  (Unless provider name was already present from Web-submitted 

data) 

d. Filled in nine additional records 

4. Generated Latitude and Longitude via geo-coding using Yahoo geocoder API. 

a. Ensured no errors were present, that at least on entry was returned and that quality 

metric was over 75. 

b. Ensured that state was New Jersey and that city and/or zip value was populated. 

5. Generated 2598 records to submit.  Note that some schools had more than one service provider 

and thus include multiple records. 

a. Output file is PublicSchool_GeoMatched.xls 

6. Manually edited results to add street numbers in those places where it was missing via Google 

search for the institution name.  This was only attempted for a portion of those with missing 

street numbers.  Of those attempted, only 25% were producing a valid street number, so the 

manual step was not deemed worthwhile. 

Public Safety Organizations 
1. Obtained the following data from the named sources:  

a. List of local and state public safety organizations obtained from NJ State 911 

Commission.  (Reused data from April 2011 - PSAP's & PSDP's_Geocoded.xls) Table 

included information on 343 institutions with the following fields: 

i. Name 

ii. Address: Street, City, State, ZIP, County 

iii. NCES_ID 

b. Data submitted by 120 public safety organizations via specially designed Web site.  Data 

collected included same fields listed above for Local Governmental organizations 

2. Generated on 911 Commission Data Latitude and Longitude via geo-coding using Yahoo 

geocoder API. 
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a. Ensured no errors were present, that at least on entry was returned and that quality 

metric was over 75. 

3. Merged 911 Commission data with PSAP data collected from via our hosted Web site (99 

entries) to merge address and ID information with speed information. 

a. Performed exact match between 911 and submitted data on institution name 

i. Facilitated matching by: 

1. Converting names to upper case 

2. Removing the Strings DEPARTMENT, DEPT, TOWNSHIP, TWP 

3. Removing punctuation and double-spaces 

4. Replacing string PD with POLICE and string BOROUGH with BORO 

b. Performed manual merging to integrate additional submitted records that were not 

matched. 

i. Successfully merged 104 submitted PSAP entries with 911 Commission data. 

Output in file PSAP_911_Matched.xls 

4. Manually edited results to add street numbers in those places where it was missing via Google 

search for the institution name.   

 

CAI Load Processing  

Submission date: October 2011 

This report presents details on processing data about Community Anchor Institutions for 

delivery to the National Telecommunications and Information Administration.   

For each location submitted to us we report a street address, details about the data service at 

the Institution (if known), a point shape corresponding to the street address, and the ID of the 

enclosing Year 2010 Census Block. 

Overview of Transfer Model Table 

The following table lists the columns in the NTIA data-transfer table. 

Table Column Null? Data Source / Transformation 

ANCHORNAME NO  

ADDRESS NO  

BLDGNBR NO  

PREDIR YES Usually set to null 
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STREETNAME NO  

STREETTYPE YES Usually set to null 

SUFFDIR YES Usually set to null 

CITY NO  

STATECODE NO Set to "NJ" 

ZIP5 NO  

ZIP4 YES Set to null 

LATITUDE NO Submitted or geocoded from street address 

LONGITUDE NO Submitted or geocoded from street address 

CAICAT NO Set to appropriate category 

BBSERVICE NO  

PUBLICWIFI NO  

URL YES  

TRANSTECH YES Note: set to “0” if unknown. 

FULLFIPSID NO ID of enclosing Year 2010 Census Block 

CAIID YES  

SUBSCRBDOWN YES  

SUBSRBUP YES Note missing “C” in name 

SHAPE NO Created for the latitude, longitude value pair 

 

Overview of Data Load Process 

In general all data went thru the following processing steps: 

1. Geocoded the addresses using an Arroyo flow and either the Google or the Yahoo 

geocoder, leaving the result with address and (lat, long) pairs in an Excel spreadsheet. 

2. Imported the spreadsheet to the geodatabase.  During this step it was essential to 
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import latitude and longitude columns as type Double (ESRI will convert if they are 

stored as Text and the target type is specified).  The result is a simple table (not a 

feature class) with a name “catN_name”; e.g., “cat3_hosp”. 

3. Created a feature class with point shapes corresponding to each (lat, long) pair from the 

table using ArcCatalog’s “Create Feature Class from XY Table” option.  Remember, X is 

Longitude, Y is Latitude, and use WGS 1984 as the coordinate system.  The result is a 

feature class with a name like “catN_name_point”. 

4. Created a feature class with the same content as the previous step but with the 

geographic coordinate tolerance value the same as the transfer model.  The result is a 

feature class with a name like “catN_name_point_tol”. 

5. Created a new feature class with a column containing the ID of the containing year 2010 

Census Block ID using ArcCatalog's spatial join feature.  The result is a feature class with 

a name like “catN_name_point_tol_cb”. 

6. Copied the data to the bb_service_cainstitutions table 

 

Category  1: Schools 

Private school source file is “PrivateSchool_GeoMatched.xls”, tab “Matched” with 1,267 rows. 

Public school source file is “PublicSchool_GeoMatched.xls”, tab “Matched” with 2,598 rows. 

Internal processing notes:  

1. The private-school spreadsheet has a column “OBJECTID” that should be imported, or if 

it is, it must be renamed first. 

2. The school names often are sharply abbreviated; e.g., “Woodside”, with no indication of 

whether it is an elementary, secondary, high school, etc. 

 
Category  2: Public Libraries  

Source file is “LibraryPlusSubmitted.xls”, tab “SurveyPlusSubmitted”, with 472 rows. 

Internal processing notes: None. 

Category  3: Hospitals  

Source file is “Hosp_Submitted_Matched.xls”, tab “NJHA plus Survey Matched”, with 1108 

rows. 

Internal processing notes: None. 

Category  4: Public Safety  

Source file is “PSAP_911_Matched.xls”, tab “911 with Matched”, with 351 rows. 
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Internal processing notes: File had some rows shifted off by one position, which resulted in 

discarding “public wifi” field. 

Category  5: Higher Education  

Source file is “HigherEd_Geocoded_RateMatched.xls”, tab NCES+NJEDGE”, with 157 rows. 

Internal processing notes: None. 

Category  6: Local Government  

Source file is “NJ_State_Verizon_Geocoded.xls”, tab “GoodGeocoding”, with 1,947 rows. 

Internal processing notes: Excel sheet yielded several empty rows when loaded to a simple 

table.  Ignored these, they will fail in the spatial join and will be excluded during the final load 

operation. 

Categories 6 and 7: Other Community Support  

Source file is “Submitted_GovNGO_CAIs.xls”, tab “Sheet0”, with 62 rows. 

Internal processing notes: None. 

 

Validation 

Discarded records that did not meet transfer model requirements: 

No zip code: 4 

No building number: 328 

No street name: 1 

No city: 19 

State outside NJ: 3 

Successfully Loaded: 7221 

 

Our investigation revealed that many institutions, particularly public schools, do not post or use 

street/building numbers.  Therefore, the requirement for a street number is causing us to 

discard many otherwise valid records. 
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New Mexico State Broadband Initiative 

Methodology: October 1, 2011 

 

Introduction 

The State of New Mexico (hereafter, NM or State), through its agents Earth Data Analysis Center (EDAC) 
at The University of New Mexico and NM Department of Information Technology (DoIT), submitted the 
October 1, 2011 New Mexico Broadband (NMBB) Program data package, in compliance with the 
National Telecommunications and Information Administration (NTIA) State Broadband Initiative 
Program (SBI). 
 

Data Submittal Description 

The NMBB October 1, 2011 data submission included: 
 Data Transmittal Memo (PDF). This document described NMBB data submittal components, 

state-restricted data fields, and contact information. 
 Provider Data Request Template (XLS). The data-request spreadsheet contained an overview 

and upload instructions in addition to eight worksheets for different types of service, subscriber 
speed, and community anchor institutions. 

 FCC-prepared Data Package Spreadsheet (XLS). The data-package spreadsheet consisted of three 
worksheets for overview and checklist, record count, and provider table. 

 NTIA-compliant Geodatabase with FGDC-compliant Metadata (GDB). The NMBB geodatabase 
was created to NTIA standards and included metadata for the database layers. 

 Check Submission Receipt (TXT). This document listed pass/fail for received data-submission 
layer and field entries. 

 NM Methodology 20111001 (PDF). This Methodology document is included in the submitted 
package. 

 Changes and Corrections 20111001 (PDF). The document corresponds to a readme document, 
especially for Internet Service Provider (ISP) information. 

All files were zipped together and submitted as NM_SBDD_20111001 (ZIP). 
 

SBDD Geodatabase Layer Number of Records: October 1, 2011 
BB_Service_Address 0* 
BB_Service_Road_Segment 4158 
BB_Service_CensusBlock 157454 
BB_Service_CAInstitutions 2606 
BB_Service_Wireless 77 
BB_Service_Overview 115 
BB_ConnectionPoint_LastMile 0* 
BB_ConnectionPoint_MiddleMile 424 

 
* Due to restrictions in the Non-disclosure Agreement (NDA) with New Mexico Internet Service 
Providers (ISPs), New Mexico cannot populate the Service Address and Last-Mile feature classes in the 
NMBB Geodatabase. 
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Provider Participation 

The NMBB Program requested broadband data from seventy NM Internet Service Providers (ISPs) in July 
2011. A total of forty-two different ISPs provided data to the NMBB Program, representing thirty-seven 
companies. Seven providers did not submit new data for the October 2011 submittal, and two 
companies (Cyber Mesa Computer Systems Incorporated and Higher-Speed Internet, LLC) were reluctant 
to further participate in the program. Six ISPs confirmed that they currently do not provide broadband 
services in New Mexico. 
 
CenturyLink replaced Qwest Corporation as a Provider in New Mexico, and the NMBB Program 
negotiated and executed an NDA with CenturyLink before this October 2011 data submittal. 
 

Internet Service Providers Number: October 1, 2011 
Contacted 70 
Responded: Provided Data 42* 
Responded: Will Provide Data 3 
Responded: Will not Participate 2 
Responded: Not Broadband Provider 6** 
Did Not Respond 22 

 
* 5 ISPs of 42 provided data as 2 distinct companies/subsidiaries; 1 ISP would not provide data but 
directed NMBB to data on their Web site. 
** These ISPs are not broadband providers for New Mexico. 
 

Participating New Mexico Internet Service Providers: NTIA Data Submittal, October 1, 2011 
360networks (USA) Inc. PTCI (Panhandle Telephone Cooperative, Inc.) 
Agavue Broadband LLC PVT Networks 
AT&T Mobility LLC Sacred Wind Communications, Inc. 
Baca Valley Telephone Company, Inc. Sierra Communications 

  (a subsidiary of Baca Valley Telephone) 
Baja Broadband Southwestern Wireless 
Cable ONE Sprint 
CenturyLink (replaced Qwest Corporation) Suddenlink Communications 
Comcast T-Mobile 
Cricket Communications, Inc. Time Warner Cable 
Cyber Mesa Telecom Tularosa Communications, Inc. 
Dell Telephone Cooperative, Inc. TW Telecom of New Mexico, LLC 
DIECA Communications, Inc. 
  (Covad Communications Company) 

US Cable 

ENMR Plateau Telecommunications Valley TeleCom Group  
  (Copper Valley Telephone, Inc.) 

Frontier Navajo Communications 
  (Navajo Communications Company, Inc.) 

Valley TeleCom Group  
  (Valley Telephone Cooperative, Inc.) 

Higher-Speed Internet, LLC Verizon Wireless 
La Jicarita Rural Telephone Cooperative Windstream Communications SouthWest 
Leaco Rural Telephone Cooperative WNM Communications 
Level 3 Communications, LLC Yucca Telecom (Roosevelt County Rural Telephone 

  Cooperative, Inc.) 
MATI Networks (Mescalero Apache Telecom, Inc.) Yucca Telecom 
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  (Yucca Telecommunication Systems, Inc.) 
Penasco Valley Telecommunications Spacenet, Inc. (StarBand Communications, Inc.) 
Plateau Telecommunications, Inc. WildBlue Communications,  Inc. 

 

Workflow Processing Scheme 

New Mexico acknowledges the importance of understanding data reliability and integrity as the Provider 
data are processed for NTIA submittal. The NMBB Data Workflow and Processing Scheme include four 
broad stages: 

1. Obtain – Acquire raw Provider data. 
2. Validate – Check for internal data consistency and for consistency with external data sources. 
3. Process – Develop Geographic Information System (GIS) data and update NTIA Geodatabase. 
4. Report – Submit the final Geodatabase to NTIA. 

 
These stages and their relationships are depicted in the diagram below, and are discussed in the 
following sections. The October 1, 2011 Data Workflow and Processing Scheme did not change from the 
April 2011 scheme and so retained the V3.0 designation. 
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Figure 1 New Mexico Broadband Workflow and Processing Scheme 
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Data Collection 

Provider Engagement 

The NM Department of Information Technology established contact with each New Mexico Broadband 
Provider and negotiated a signed NDA with the State and with EDAC, if required. NM DoIT negotiated 
and executed a new NDA with CenturyLink, which replaced Qwest Corporation. 
 

Data Request 

EDAC sent an e-mail requesting broadband data to seventy NM Internet Service Providers in July 2011, 
and a reminder e-mail in August to those who had not responded. In addition to an NMBB Program 
overview and formal request for data, the message included a Web link for the NM Broadband Data 
Request Form (MS Excel Worksheet); this form included instructions for completing the eight data 
worksheets and for securely uploading Provider data to the EDAC Secure FTP site. 
 

Data Receipt 

EDAC created a Secure File Transfer Protocol (SFTP) site for broadband data upload, and created an 
account on the site for each NM Provider. Each Provider was assigned a unique username and 
password; this account information is stored in the NMBB SFTP Account Management form. 
 
Provider data arrive in numerous formats, including NMBB or Provider spreadsheets, shapefiles, CAD 
files, and text files. These data are downloaded from the SFTP site to the EDAC network. 
 

Provider and Data Tracking 

EDAC creates or updates the specific Provider record in a Provider Data Processing Tracking Form. 
Throughout the data process, each Tracking Form step is recorded with analyst initials and date of task 
completion. Steps include: 

 Record Provider name information and the assigned 2-digit Primary Key (PKey). 
 Record the Holding Company Name, DBA Name, FRN (if available), and whether Community 

Anchor Institutions data are provided. 
 Record type of files submitted; date of data submission and the initials of the receiving GIS 

analyst; and how data were submitted (e.g., FTP or physical medium). 
 

Provider Database 

EDAC evaluates the uploaded Provider data for consistency with the NTIA data model and creates 
database-format tables. 
 

Data Validation 

Data Assessment 

EDAC assesses the submitted data for completeness according to the National Broadband Map Data 
Transfer Model V1.0.2: 

 Identify fields (names, types); 
 Fill in missing data, if possible; and 
 Check field codes, and standardize the values where appropriate. 
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Data Export 

If the data are incomplete, based upon the above assessment steps, EDAC performs the If required 
steps, below; otherwise, EDAC proceeds with data validation. Changes and assumptions are 
documented. 
If required: 

 Return data in standardized format to the Provider for completion. 
 Receive modified data back from Provider. 
 Re-import data. 

 

Data Validation 

EDAC performs the final data validation for each Provider’s data set: all missing data filled in; all field 
codes checked and standardized where appropriate. 
 

Data Processing 

GIS Data 

EDAC creates and verifies Provider-specific GIS data, using ArcGIS 10 software and third-party data sets: 
 New Mexico Road Centerline (NM RCL) data files. 
 NM Telephone Exchange Boundaries 911. 
 U.S. Census TIGER/Line shapefiles. 
 TomTom MultiNet Road shapefiles. 
 NAVTEQ Road data files. 
 ESRI Road shapefiles. 
 ESRI Cable Boundaries data file. 

 
Ancillary consistency checks include comparison with other data sources that are available through the 
New Mexico geospatial clearinghouse – Resource Geographic Information System (RGIS; 
http://rgis.unm.edu). 
 
EDAC processes the GIS data according to the National Broadband Map Data Transfer Model V1.0.2. 
 
Middle Mile Points 

 ISPs provide the geographic coordinates for Middle Mile points. Those points are exported as 
shapefiles and a spatial join is performed against Census 2010 Blocks to obtain FULLFIPSID. 

 Data sets are further processed by adding required fields based on the NTIA Data Model. 
 
Census Blocks 

 ISP data were requested for the Census 2010 Blocks, rather than the Census 2000 Blocks. 
 If an ISP provides the Census Block IDs, then those tables are spatially joined with the Census 

2010 Data and the blocks are extracted. Then, the Census Blocks (Area < 2 sq mi) are extracted. 
 If the ISP provides address-specific data, those addresses are geocoded against the New Mexico 

Road Centerline (NM RCL) address locator. Unmatched addresses are processed against third-
party data sets, such as the TomTom MultiNet and NAVTEQ Road data, which were purchased 
by the State as a part of the NMBB project, and ESRI Road data. All of those matched records are 
appended together to obtain a single address data set. The address points are aggregated 
spatially to the Census Blocks, and the Census Blocks (Area < 2 sq mi) are extracted. 
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 If an ISP provides shapefiles of Census Blocks, EDAC verifies those to make sure they are less 
than 2 sq. mi. in area. 

 If an ISP provides their telephone exchange boundaries instead of addresses, then those 
boundaries are verified with the NM Telephone Exchange Boundaries 911 data set, and Census 
Blocks (Area < 2 sq mi) that lie within those boundaries are extracted. If an ISP provides the 
CO/RT locations, then a buffer of 1800 ft is drawn, and the Census Blocks (Area < 2 sq mi) that 
intersect with the buffer area are extracted. 

 If an ISP provides service areas instead of addresses for Cable, then the service areas are verified 
with the ESRI Cable Boundaries data file. Census Blocks (Area < 2 sq mi) that lie within the 
boundaries are extracted. 

 If an ISP does not provide data for this data-submittal round, Crosswalk tables from the U.S. 
Census Bureau are used to convert the previously-submitted Census 2000 Blocks to Census 2010 
Blocks. Extracted Census 2010 data are overlaid on the original Census 2000 data to confirm that 
the ISP-provided area from the previous round is covered. In cases of differences, where the 
areas are not covered, Census 2010 Blocks are manually selected and added to the other 
extracted Blocks to complete the data set. 
Crosswalk tables are downloaded from 
http://www.census.gov/geo/www/2010census/rel_blk_download.html. 

 Data sets are further processed by adding required fields based on the NTIA Data Model. 
 
Road Segments 

 If an ISP provides address-specific data, EDAC geocodes those points (using a process similar to 
that explained above in Census Blocks). The address points are aggregated spatially to Census 
Blocks, and the blocks with area greater than 2 sq mi (Area > 2 sq mi) are extracted. NM RCL 
roads within those Census Blocks are exported, and the geocoded address points are spatially 
joined with adjacent road segments within a distance of 25 ft (or 30 ft for rural areas). The road 
segments with joined address points are selected and exported. 

 If an ISP provides road segment data with address ranges, any one of the address range values 
(TO/FROM) for the road is taken and the data are geocoded. Or, if no address ranges are 
provided, the address file is joined with the NM RCL roads, based on Street Name, City, and 
Postal Code and the matched records are extracted. 

 If an ISP provides Tiger/Line roads data, those roads are extracted from the U.S. Census 
Tiger/Line shapefile by joining them based on the TLID (Tiger/Line ID). NM RCL road data that 
match the Tiger/Line roads are exported.  

 If an ISP provides Telephone Exchange Boundaries or CO/RT locations or Cable service area 
boundaries, road segments for these data sets are not processed due to uncertainty about the 
NMBB procedures for these cases. EDAC checks for ISP-provided address-specific data and, if 
those data are present, processes the data using the first-listed Road Segments step. Otherwise, 
those roads are not further processed. NM DoIT and EDAC will request clarification from NTIA. 

 Data sets are further processed by adding required fields based on the NTIA Data Model. 
 

Community Anchor Institutions 

 EDAC created an Anchor Geodatabase that has data on all the Community Anchor Institutions, 
such as Schools, Libraries, Health Care, Higher Education, Public Safety Facilities, Government 
Agencies, and Non-governmental Institutions throughout the State of New Mexico. These data 
were obtained from different sources, including the Public Schools Facilities Authority (PSFA), 
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New Mexico State Library, Homeland Security Information Program (HSIP), and NM Resource 
Geographic Information System Program (RGIS). 

 The Anchor Geodatabase is further processed to meet the NTIA requirements. NCES IDs for 
schools, IPEDS IDs for higher education, and IMLS IDs for libraries are obtained from the 
respective Web sites and are joined with records in the geodatabase.  

 Broadband data provided by the ISPs are also included in the geodatabase. EDAC uses the third-
party USAC (Universal Service Administrative Company) data set for broadband information for 
Schools and the NM State Library data set for broadband information for Libraries. 

 Data sets are further processed by adding required fields based on the NTIA Data Model. 
 
Wireless 

 If an ISP has multiple spectra, the provided polygon is duplicated for each spectrum and then 
appended together to obtain a single shapefile with stacked geometry.  

 If an ISP provides tower location (address or coordinates) and transmit radius instead of 
shapefiles, those locations are mapped and a buffer is drawn with the transmit radius.  

 Data sets are further processed by adding required fields based on the NTIA Data Model. 
 
Overview 

 This set of notes applies to wire-line data, only. 
 If an ISP provides the Subscriber Weighted Nominal (SWNOM) Speed of respective technology 

types for the counties it serves, those values are joined with the County boundary file from the 
U.S. Census Tiger/Line shapefiles.  

 If an ISP provides the technology of transmission, number of subscribers, and the maximum 
advertised speed for the Counties it serves, the SWNOM Speed is calculated and the values are 
joined with the County boundaries shapefile. 

 These county files from each ISP are appended together to obtain a statewide stacked 
geometry. Data are further processed by adding required fields based on the NTIA Data Model. 

 

GIS Data Verification, Updates, and Edits 

Processed data are developed as Provider-specific spreadsheet and GeoPDF products. As the first step in 
New Mexico’s Provider feedback loop, EDAC places each Provider’s products on the SFTP site and 
requests that Providers verify accuracy and identify needed edits and corrections. Seven (7) ISPs 
responded to the verification request in the October 1, 2011 data submission cycle. 
 
GIS data are updated and edited, based on Provider feedback, and modified data products (spreadsheet 
and GeoPDF) are delivered to the Provider through the SFTP site for final verification and to complete 
the feedback loop. 
 

NTIA Geodatabase Preparation 

EDAC produces a final “clean” GIS data set from the processed and Provider-specific, versioned feature 
data sets, and then prepares the NTIA Geodatabase from these finalized GIS data. Crowd sourced data 
were not used for preparation or validation. 
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NTIA Geodatabase Validation 

EDAC validates the geodatabase by performing the validation checks provided below and by running the 
geodatabase through the SBDD_CheckSubmission tool. EDAC then assigns Quality Assurance/Quality 
Control (QA/QC) values. 

 Repair Geometry. 
 Validate Topology. 
 Check Provider identification fields by Frequency tool and Summarize tool.  
 Check for Null values in Transmission Technology codes, PROVIDER_TYPE, FULLFIPSID, 

STATEFIPS, COUNTYFIPS, TRACT, BLOCKID fields. 
 Check for Null values in TRANSTECH, ANCHORNAME, ADDRESS (BLDGNBR, STREETNAME), CITY, 

ZIP5, STATE, GEOUNITTYPE, STATECOUNTYFIPS fields.  
 Check Maximum advertised and typical down/upload speed fields for null values and for valid 

domain values. MAXADDOWN/TYPDOWN < MAXADUP/TYPUP; MAXADDOWN < ‘0’ OR 
MAXADDOWN > ‘9’. 

 Check for SPECTRUM values <1 and >10. 
  

NMBB Report and Submittal 

Finalized NTIA Geodatabase and Metadata 

EDAC finalizes the Geodatabase per NTIA standards (National Broadband Map Data Transfer Model 
V1.0.2) and creates the associated metadata. 
 

NMBB Program Manager 

The NMBB Program Manager receives the finalized Geodatabase through the SFTP site and approves the 
files for submittal to NTIA. The finalized Geodatabase was uploaded for review and approved on 
September 26. 
 
EDAC completes and delivers all files to the NMBB Program Manager, as required by the Program. Files 
include correspondence logs with NM Providers, documentation for Web mapping activities, and the 
Provider-specific Data Processing Tracking Form. 
 

NTIA Submittal 

The Geodatabase and required files (data transmittal memorandum, Provider data request template 
[not a required file], data package spreadsheet, check-submission receipt, methodology, and changes 
and corrections) are uploaded, using the FCC/NTIA SFTP site. 
 

NMBB Map Layers 

EDAC creates GIS map layers from the Geodatabase and publishes them to the New Mexico Broadband 
Program Mapping site, www.nmbbmapping.org/mapping/. 
 

Response: NTIA Submission Summary 

NM DoIT and EDAC developed a document template to respond to the NTIA Submission Summary, both 
to address NTIA-identified issues or gaps and to request clarification and additional information. New 
Mexico responds within one week of receiving NTIA’s Submission Summary. 
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NMBB System Security 

System Security 

The NM Broadband Server is a fully patched Windows Server 2008. The server is protected by Symantec 
Endpoint Protection and a double firewall. 
 
The first layer of firewall protection is a Cisco hardware firewall that protects the Server from any 
intrusion from outside the EDAC network. This firewall only allows connections on Ports 80 and 22. 

 Port 80 allows Web browsing. 
 Port 22 allows Secure FTP. SFTP service is fully encrypted with SHA1 stored passwords. 

 
The Windows software firewall is configured to allow access on Ports 80, 22, 443, and 3389. 

 Port 443 gives EDAC developers the ability to configure ArcGIS Server from within the EDAC 
network. 

 Port 3389 gives EDAC system administrators the ability to configure the base Windows server 
from within the EDAC network. 

 

Server Connections 

Connect to the Server from the outside: 
 HTTP: No authentication (simple Web browsing). 
 SFTP: Authentication required and fully encrypted. 

 
Connect to the Server from within the EDAC network: 

 HTTPS: Authentication required and fully encrypted. 
 RDP: Authentication required and fully encrypted. 
 SMB: Port 445, Windows file-share port. 

 

Virtual Machine and Networked Drive Back-ups 

The NMBB Virtual Machine (VM) is a dedicated server. 
 
Back-up: Development Networked Drive (not published) 

 Daily: A differential back-up to a tape server is performed; the tape server is connected to a 
secure tape library. 

 Friday/Weekend: A full back-up of the networked drive is performed to the secure tape server. 
 
Back-up: Virtual Machine (published) 

 Daily: The entire VM is backed up by VDR (VMware Data Recovery [application]) to a secure, 
self-contained data store. 

 

Physical Security 

NM Broadband Server physical security is accomplished through: 
 Controlled-environment floor space in a locked, code-protected room for system servers, and 
 An uninterrupted power supply (UPS). 
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Lessons Learned 

Provider Feedback Loop 

During the April-2011 submittal process, EDAC identified and implemented several measures for more 
effective data collection. These included: 

 Developing and formalizing an interaction process between data providers and EDAC. 

 Modifying the data request template, based on the updated NTIA data model. 

 Setting deadlines for receiving data from ISPs. This allowed EDAC sufficient time for processing 
and submitting feedback maps to ISPs for their verification. 

These measures were successful with respect to efficient data processing and validation and for ISP 
engagement. 
 

Data Validation and Processing 

EDAC continued to address issues regarding data validation and processing. These included: 

 Updating data validation procedures to meet the requirements of the data model. 

 Researching and learning the propagation models for processing Satellite and Wireless data.  
 

NMBB Web Map 

The New Mexico Broadband Map (www.nmbbmapping.org/mapping/) is developed as part of the NMBB 
Program for the State of New Mexico. This Web map displays all of the processed ISP broadband data 
that are submitted to NTIA for the National Broadband Map, and the processed statewide satellite-
service data. 
 
Figure 2, below, is a screen-capture image of the New Mexico Broadband Map V 2.0 showing DSL, Cable, 
and Copper Wire broadband-coverage layers on the Streets base map. Satellite and Mobile Wireless 
layers are not displayed. Tools include: layer selection; base map selection; dynamic legend; slider-bar 
and custom zoom; drag-and-drop and directional pan; full, previous, and next extent; identify; find 
address; scale bar; and print map. Additionally, a feedback tool, help (online user guide), program 
information, and New Mexico’s disclaimer are provided. 
 
Version 2.0 includes enhancements to the Identify tool, which allow the user to identify ISPs by 
technology type, and addition of the Data Update: <data submittal date> in the application title. 
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Figure 2 NMBB Program: New Mexico Broadband Map, www.nmbbmapping.org/mapping/; accessed 27 September 2011 
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Table of Abbreviations and Acronyms 

API Application Programming Interface 

BB broadband 

CAD Computer-aided Design 

CO/RT Central Office/Rural Terminal 

DBA Doing Business As 

DoIT [NM] Department of Information Technology 

DSL Digital Subscriber Line 

EDAC [UNM] Earth Data Analysis Center 

FCC Federal Communications Commission 

FGDC Federal Geographic Data Committee 

FRN FCC Registration Number 

ft foot 

FTP File Transfer Protocol 

GDB, gdb Geodatabase; Geodatabase file extension 

GIS Geographic Information Systems 

HSIP Homeland Security Information Program 

HTTP Hypertext Transfer Protocol 

HTTPS Hypertext Transfer Protocol Secure 

ID [unique] identifier 

IE [Microsoft] Internet Explorer 

ISP Internet Service Provider 

NDA Non-Disclosure Agreement 

NM New Mexico, State of New Mexico 

NMBB New Mexico Broadband Program 

NM DoIT New Mexico Department of Information Technology 

NOFA Notice of Funding Availability 

NTIA National Telecommunications and Information Administration 

PDF, pdf [Adobe] Portable Document Format and file extension 

QA/QC Quality Assurance/Quality Control 

RCL [NM] Road Centerlines 

RDP Remote Desktop Protocol 

SBI State Broadband Initiative 

SFTP Secure File Transfer Protocol 

SHA1, sha1 Secure Hash Algorithm 1 

SMB Server Message Block 

sq mi square mile(s) 

SWNOM Subscriber Weighted Nominal [Speed] 

TIGER [U.S. Census] Topologically Integrated Geographic Encoding and Referencing (system) 

TXT, txt Text file extension 

UNM EDAC The University of New Mexico Earth Data Analysis Center 

UPS uninterrupted power supply 

USAC Universal Service Administrative Company 

VDR VMware Data Recovery (application) 

VM Virtual Machine 

Web World Wide Web 

XLS, xls Microsoft Excel file extension 

ZIP, zip Zipped file extension 
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Complete 70
Non-Responsive/Refused 4
In Progress 2

Count of Datasets by Status 76
Total Unique Providers Represented 58

Provider Name Platform Status

NDA 
Execution 

Date Notes

Above All Communications, LLC DSL Data Added to Statewide Inventory
[SEP-12-11 Jess Cary] Change: New DSL 
Provider.

Above All Communications, LLC Fixed Wireless Data Added to Statewide Inventory
[SEP-13-11 Jess Cary] Change: New WISP 
provider.

Arizona Nevada Tower Corporation Fixed Wireless Data Added to Statewide Inventory 3/8/2010
[SEP-13-11 Jess Cary] Change: Provider added 
a new tower, expanded coverage.

AT&T Inc. DSL Data Added to Statewide Inventory 12/16/2009

[SEP-12-11 Jess Cary] Changes and/or 
Corrections: possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

AT&T Inc. Mobile Wireless Data Added to Statewide Inventory 12/16/2009
[SEP-12-11 Jess Cary] Change: Provider 
expanded coverage area.

Baja Broadband Holding Company, LLC Cable Data Added to Statewide Inventory 2/22/2010
[SEP-12-11 Jess Cary] Change: Provider 
upgraded their speeds to tier 7.

CC Communications Fiber Data Added to Statewide Inventory 6/11/2010

[SEP-12-11 Jess Cary] Change: Provider 
expanded coverage area and increased 
download speeds to tier 8.

CC Communications DSL Data Added to Statewide Inventory 6/11/2010
[SEP-12-11 Jess Cary] Correction: Provider 
revised service area extent.

Cellco Partnership Mobile Wireless Data Added to Statewide Inventory 12/14/2009

[SEP-12-11 Jess Cary] Changes and/or 
Corrections: possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

CenturyTel, Inc. DSL Data Added to Statewide Inventory 12/4/2009

[SEP-12-11 Jess Cary] Changes and/or 
Corrections: possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Charter Communications, Inc. Cable Data Added to Statewide Inventory 12/15/2009

[SEP-12-11 Jess Cary] Changes and/or 
Corrections: possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Citizens Telecommunications Company of 
Nevada DSL Data Added to Statewide Inventory 1/22/2010

[SEP-16-11 Jess Cary] Changes and/or 
Corrections: possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Clearwire Corporation Mobile Wireless Data Added to Statewide Inventory 3/3/2010

[SEP-12-11 Jess Cary] Changes and/or 
Corrections: possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Clearwire Corporation Fixed Wireless Data Added to Statewide Inventory 3/3/2010

[SEP-12-11 Jess Cary] Changes and/or 
Corrections: possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

CoxCom Inc. Cable Data Added to Statewide Inventory 2/3/2010

[SEP-12-11 Jess Cary] Changes and/or 
Corrections: possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Filer Mutual Telephone Company DSL Data Added to Statewide Inventory 2/9/2010

[SEP-13-11 Jess Cary] Change: Provider 
upgraded infrastructure and can now offer 
download speeds in some areas of tier 7.

Fort Mojave Telecommunications, Inc. DSL Data Added to Statewide Inventory
[SEP-12-11 Jess Cary] Change: New provider in 
the market.

Great Basin Internet Services, Inc. Fixed Wireless Data Added to Statewide Inventory 4/6/2010
[SEP-12-11 Jess Cary] Change: Provider added 
two new towers.

LasVegas.Net LLC Fixed Wireless Data Added to Statewide Inventory
[SEP-13-11 Jess Cary] Correction: Propagations 
were created to replace generalized polygons.

Leap Wireless International, Inc. Mobile Wireless Data Added to Statewide Inventory 4/6/2010

[SEP-12-11 Jess Cary] Changes and/or 
Corrections: possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Moapa Valley Telephone Fiber Data Added to Statewide Inventory 2/22/2010
[SEP-12-11 Jess Cary] Change: Provider 
upgraded max download speed to tier 9.

Moapa Valley Telephone DSL Data Added to Statewide Inventory 2/22/2010

[SEP-13-11 Jess Cary] Change: Provider 
upgraded infrastructure and can now offer 
download speeds of tier 7 in additional areas.

Broadband Provider Log



Rio Virgin Telephone Company Fiber Data Added to Statewide Inventory

[SEP-13-11 Jess Cary] Change: Provider 
upgraded infrastructure and can now provide tier 
10 download speeds.

Rio Virgin Telephone Company DSL Data Added to Statewide Inventory

[SEP-12-11 Jess Cary] Change: Provider 
upgraded infrastructure and can now offer tier 7 
download speeds.

Robinson Communications Corporation DSL Data Added to Statewide Inventory 2/25/2010

[SEP-12-11 Jess Cary] Change: Provider 
upgraded infrastructure and can now offer tier 6 
download speeds.

Satview Broadband LTD Cable Data Added to Statewide Inventory 1/11/2010
[SEP-12-11 Jess Cary] Change: Expanded 
coverage area.

Sprint Nextel Corporation Mobile Wireless Data Added to Statewide Inventory 1/14/2010

[SEP-12-11 Jess Cary] Changes and/or 
Corrections: possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

T-Mobile USA, Inc. Mobile Wireless Data Added to Statewide Inventory 1/8/2010

[SEP-12-11 Jess Cary] Changes and/or 
Corrections: possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Vegas Wifi Communications LLC Fixed Wireless Data Added to Statewide Inventory 4/7/2010
[SEP-13-11 Jess Cary] Change: New tower 
added, coverage area expanded.

360networks Backhaul Backhaul Provider Only Processing Complete 1/19/2010
CenturyTel, Inc. Backhaul Backhaul Provider Only Processing Complete 12/4/2009
CoxCom Inc. Backhaul Backhaul Provider Only Processing Complete 2/3/2010
Level 3 Communications, Inc. Backhaul Backhaul Provider Only Processing Complete 12/14/2009
MegaPath Inc. Backhaul Backhaul Provider Only Processing Complete 2/15/2010
Sprint Nextel Corporation Backhaul Backhaul Provider Only Processing Complete 1/14/2010
T-Mobile USA, Inc. Backhaul Backhaul Provider Only Processing Complete 1/8/2010
U.S. TELEPACIFIC CORP  Backhaul Backhaul Provider Only Processing Complete 2/25/2010
Zayo Bandwidth, LLC Backhaul Backhaul Provider Only Processing Complete

Avant Wireless LLC Fixed Wireless
Estimated Coverage Submitted for Non-
Participating Provider

[APR-17-11 Charlie Roodenburg] Received reply 
from company representative stating they are 
not interested in participating due to bad 
experiences with previous big business 
methodology.  Indicated they have a public map.
[SEP-13-11 Jess Cary] Correction: Provider 
refused to participate.  Coverage area and 
attributes extracted from their website.

Arizona Nevada Tower Corporation Fixed Wireless No Update to Provide 3/8/2010
Beehive Telephone Co., Inc. NV Fixed Wireless No Update to Provide 4/5/2010
Beehive Telephone Co., Inc. NV DSL No Update to Provide 4/5/2010
CalNeva Broadband, LLC Cable No Update to Provide 4/8/2010
Cellco Partnership Backhaul No Update to Provide 12/14/2009
CenturyTel, Inc. Backhaul No Update to Provide 12/4/2009
Citizens Telecommunications Company of 
Nevada Backhaul No Update to Provide 1/22/2010

DISH Network Corporation Satellite No Update to Provide 1/27/2010

[SEP-16-11 Jess Cary] Correction: Satellite data 
is being submitted and was not included in the 
April 2011 submission.  While coverage is 
currently the entire state boundary, work 
continues on having more granular data.

ETAN Industries Cable No Update to Provide
High Desert Internet Services Fixed Wireless No Update to Provide
Highlands Wireless Inc. Fixed Wireless No Update to Provide
Hot Spot Broadband, Inc. Fixed Wireless No Update to Provide

Hughes Network Systems, LLC Satellite No Update to Provide 2/5/2010

[SEP-16-11 Jess Cary] Correction: Satellite data 
is being submitted and was not included in the 
April 2011 submission.  While coverage is 
currently the entire state boundary, work 
continues on having more granular data.

InfoWest, Inc. Fixed Wireless No Update to Provide
Lincoln County Telephone System DSL No Update to Provide 3/5/2010
Lincoln County Telephone System Fiber No Update to Provide 3/5/2010
Martell Telecommunications DSL No Update to Provide 3/23/2010
Mt. Wheeler Power DSL No Update to Provide 4/5/2010
Mt. Wheeler Power Fixed Wireless No Update to Provide 4/5/2010
NextWeb, Inc. Backhaul No Update to Provide 1/19/2010
Oasis Online, Inc. Fixed Wireless No Update to Provide
Schatnet Internet LLC Fixed Wireless No Update to Provide
SMS Computing, Inc. Fixed Wireless No Update to Provide 3/19/2010
Tele-NET.net LLC Fixed Wireless No Update to Provide
tw telecom of nevada, llc Backhaul No Update to Provide 4/27/2010

ViaSat, Inc. Satellite No Update to Provide 1/8/2010

[SEP-16-11 Jess Cary] Correction: Satellite data 
is being submitted and was not included in the 
April 2011 submission.  While coverage is 
currently the entire state boundary, work 
continues on having more granular data.

XO Communications, Inc. Backhaul No Update to Provide 6/2/2010
Yonder Media Fixed Wireless No Update to Provide

Cogent Communications, Inc. Backhaul No Update Provided - Use Last Submission Data

KeyOn Communications, Inc. Fixed Wireless No Update Provided - Use Last Submission Data 10/15/2009
[SEP-12-11 Jess Cary] Change: KeyOn took 
over WREC's towers.  Coverage expanded.



Nevada System of Higher Education Backhaul No Update Provided - Use Last Submission Data
American Wireless Networks, Inc. Fixed Wireless Solicited Initial Data

U.S. TELEPACIFIC CORP  Fixed Wireless Other 2/25/2010

[AUG-30-11 Ashley Littell] Covad Wireless (dba 
under NextWeb) was acquired by TelePacific 
and operation is now as a business provider and 
no longer residential.

Pyramid Net DSL Refused to Participate

[AUG-5-2011 Charlie Roodenburg] A 
representative of the company replied to a 
request for participation by asking that they be 
removed from our list.

ACI, Inc. Fixed Wireless Non-Responsive to Multiple Attempts

In addition to contact attempts made on July 1, 
2010 and January 5, 2011, 2 additional attempts 
were made this period.

Air-Internet, Inc. Fixed Wireless Non-Responsive to Multiple Attempts

In addition to contact attempts made on July 1, 
2010 and January 5, 2011, 2 additional attempts 
were made this period.

Ezznet, Inc. Fixed Wireless Non-Responsive to Multiple Attempts
5 contact attempts were made between April 17, 
2011 and August 8, 2011.



“White Paper” from New York describing Round 4 (Fall, 2011) Data 
Submission to the NTIA under the SBDD 

October 1, 2011 

Executive Summary  
 
The Broadband Mapping Team at the New York State Office of Cyber Security (OCS) is pleased to submit our 
Round 4 (Fall 2011) data for the State Broadband Initiative (SBI).   
 
Our goals for Round 4 were to:  1) maintain the very high level of participation from New York providers, 2) Add 
to and enhance our data verification methods and, 3) improve the completeness and quality of the data 
delivered. We believe we have met those goals.  
 
We had 82 providers participate in the spring 2011, Round 3 submission. That number has risen to 87. We 
anticipate an increase in that number in the future as we continue to reach out to small fixed wireless 
companies. We believe mapping these provider’s serviceable areas is a very important component required to 
fine tune NYS’s served and un-served boundaries. 
 
We are very pleased with the enhancements to our verification methods implemented this round and are 
energized to continue to find innovative ways to use disparate data available from commercial, government 
and public sources to validate and identify inconsistencies in provider reported availability data. 
 
Lastly, we made small but significant steps in improving the Community Anchor Institution data (attributes and 
location), middle mile points and,  by working even closer with our providers, we were able to improve the 
quality of the availability data using the new 2010 Census geography.  
 
The remainder of this paper provides a summary of our data collection results; describes our methodology for 
performing data verification; summarizes the progress made on all our Round 4 goals and identifies our focus 
for Round 5. 
 

Provider Participation Summary Tables: 
 

87 Total Participating Providers 

72 Wireline Providers 

17 Wireless Providers (2 are both Wireless & Wireline) 

1 Provider is middle-mile only 

44 Providers submitted Middle Mile Data 
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Technology Type 

Wireline 
Census 
Block 

Provider 
Count 

Wireline 
Service 

Availability 
by Census 

Block 

Wireline 
Street 

Segment 
Provider 

Count 

Service 
Availability 
by Street 
Segment 

Wireless 
Provider 

Count 

Wireless 
Services 

by 
Shapefile 

Middle 
Mile 

Provider 
Count 

Middle 
Mile 

Points 

Asymetric xDSL 43 307,636 35 26,945 0 0 28 1,704 

Symetric xDSL 6 66,616 2 81 0 0 0 0 

Other Copper Wireline 7 93,947 4 235 0 0 1 4 

Cable Modem - DOCSIS 3.0 8 197,110 6 15,069 0 0 3 10 

Cable Modem Other 13 173,283 11 21,022 0 0 1 1 

Optical Carrier/Fiber to the End User 23 120,961 14 2,129 0 0 7 652 

Satellite 0 0 0 0 3 3 0 0 

Terrestrial Fixed Wireless - Unlicensed 0 0 0 0 7 12 1 10 

Terrestrial Fixed Wireless - Licensed 0 0 0 0 1 1 0 0 

Terrestrial Mobile Wireless 0 0 0 0 6 13 2 14 

Other (middle-mile only) 0 0 0 0 0 0 1 2 

 

A note regarding New York’s Provider Table in Data Package XLS:  
 
In the July 13, 2011 “NY December 2010 Data Feedback’ conference call, the program office requested that 
New York include in its submission any company that we had researched in order to determine if  they met the 
“provider” definition of the program and provide services in NYS. For this submission, we have included an 
exhaustive list of providers that we have captured information on from Rounds 1 through 4. 
 
In our Provider Table, companies  are listed by order of participation status with those that “Provided Data” 
listed first, followed by companies that said they “Will Provide Data”, those that were “Non-Responsive”, and 
finally those that “Will Not Provide Data.” Providers that were contacted in Round 4 are contained within the 
top 3 statuses and include all known facilities based providers. 
 
Companies that received a “Will Not Provide Data” status include the following: 
 
  
  
  
  
  
  
 
Because of the sheer number of resellers in New York and their questionable ability to provide service within 7 
to 10 days, resellers were a low priority for Round 4 outreach. 
 
The companies that populate the Provider Table were gleaned from the FCC list provided in the “NY SBDD 
Submission Summary.xls” as well as from our own research in Rounds 1 through 4. We hope that this list is 
useful for the program office and provides some clarity on the volume of providers New York has researched. 
 

 Company Type Code 

Providers that do not serve New York 3 

Companies who are not broadband providers 4 

Broadband equipment companies 3 

Resellers 2 
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Verification: 
 

Automated verification was accomplished via the following methods: 

1. Business rules built into the SBI data transfer model (catching problems on the way in) 

2. Repeatedly running the NTIA supplied Python script 

3. ESRI ‘Check Geometry’ and ‘Fix Geometry’ tools 

Non-automated verification methods ranged from the very simple to complex, multi-step procedures. They 

were: 

1. Provider Website Research:  For Round 4, a careful study was made of the websites of New York 

State’s 80+ broadband providers. The goal was verify the technology and data transfer speeds that 

were voluntarily self-reported to the OCS broadband mapping team. 

 

Upon this review, a few generalizations can be posited and some interesting facts can be gleaned.  

First, it has to be noted that although there are at least 83 separate companies offering DSL, cable, 

fiber, or wireless technologies, there were actually only 67 differing websites to examine.  This is due to 

the fact that some of the smaller companies have the same parent company.  Thus, there is one 

uniform website for all of the parent company’s subsidiaries.  For example, when searching for the 

main website of Berkshire Cable Corporation, Berkshire Telephone Corporation, Chautauqua and Erie 

Telephone Company, or Taconic Telephone Company, the same exact FairPoint Communications 

website will pop up.  If there is some disparity in the products and speeds per individual company, it 

cannot be discerned from the catch-all corporate website.  

This study exposed some noteworthy details.  12 of the companies provide no specific information on 
the actual data transfer speeds of their broadband products.  Two of them, Castle Communications of 
Willsboro, and Fishers Island Telephone Corporation, did not even have a working website!  Of the 
remaining 71 companies that did provide speeds, only 29 of them provided both downstream and 
upstream speeds. 
 
Once all the website speed data was collected from the websites, the maximum download and upload 
speeds offered were reclassified and coded into speed tiers between 1 and 11.  The vast majority 
corresponded to self-reported speeds; however, there were some notable discrepancies. 
 
Most discrepancies were within one or two code numbers.  For example, Verizon reported to us that 
they offered “6” speed broadband at Tech Code 10 (ADSL), and their website indicated  it was “7” level 
speed.  There were a handful of companies though that reported much higher speeds than what was 
found on the internet. Often, they were companies that offered broadband at a Tech Code of 50, which 
indicated optical carriers/fiber to the end user.  Thus, they offered high-end technology or specialized 
technology producing higher speeds that was not detailed on their site.  For example, DFT Local Service 
Corp reported to us they have “11” speed technology, but it is not detailed on their website, as we 
have uncovered only  code“7” level speed, which is what their fastest DSL service registers.  
 
There were approximately 26 cases where speed code differences ranging from minor to significant 
occurred. In half the cases, the max speed advertised on the company’s internet site was less than 
what they reported to us.   Therefore, the other half of the cases involved the internet sites boasting 
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higher speeds than what we were aware of, so it is difficult to ascertain a pattern.  In 8 of the 26 
instances, there were speed code disparities of 3 or more.  For example, Hometown Online, Inc. 
reported to us maximum speeds in the 8 speed tier range, but their website indicates speeds up to 2 
mbps, which is only within the 4 speed tier.  It should be noted that this data is just comparing 
maximum download speeds, because so few maximum upload speeds were advertised on the 
websites.   
 
While the results on this study were not conclusive enough to permit significant revisions to the 
providers’ self-report speed data, this study will serve to generate constructive discussion with our 
providers and assist with future refinements to our speed data to more accurately portray the diverse 
palette of broadband coverage offerings. 
 

2. Use of crowd-sourced data:  

a. NYS Speed Test data points and attributes were used to verify provider reported availability. 

The NYS speed test website includes a data collection form which requests: 

i. Street address at which the test was taken 

ii. Service provider 

iii. Service technology 

After satellite provider records and sub-broadband speed records were removed, 5624 records 

were successfully geocoded and used for verification. Four levels of verification were 

established for points that fell within areas of reported service availability. They are: 

 

Code 1 = Provider and technology matched 

Code 2 = Provider matched and technology unknown 

Code 3 = Provider matched but technology is mismatched 

Code 5 = Provider and technology unknown but Broadband is available in the location 

 

Each census block and street segment availability record involved with this verification activity 

was assigned one of the above codes.  

 

b. FCC speed test records were used to verify provider reported availability. FCC speed test 

records lack provider information but we were able to successfully establish the provider via a 

publically available IP Address search engine (the APNIC Whois Database). Those records were 

then used to verify provider reported availability in the same manner as was used with the NYS 

speed test points. Because the technology was not known, the highest verification code 

assigned was 2 (Provider Matched and Technology = 'Unknown').  Here is a statistical summary: 

 

   Number Percentage 

Total Number  of FCC Wireline Speed Test Points  62,642 N/A 

Total Number / Percentage Successfully Geo-coded 32,621 / 62,642 52% 

Total Number / Percentage Successfully IP Searched 21,766 / 32,621 67% 
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c. NYS Broadband Map feedback:  After receiving an email through the “Is This Correct” link on 

the NYS broadband map, the details were logged in a tracking spreadsheet and investigated on 

our map. The address, census block, or street segment was then further investigated in ArcMap 

using provider submitted data to confirm reported availability. If we confirmed that the 

provider submitted availability data for that location, the next step was to use the provider’s 

own website to attempt to verify that availability.  

 

If available, the public responder’s address was used along with address point datasets from 

New York State and Navteq. In a census block or street segment, addresses were identified at 

both ends of the bounding features. These addresses were entered into an availability search 

on the provider’s website and the results were logged. In Frontier’s case, the address points 

were used to perform a reverse lookup and identify phone numbers at those addresses. The 

phone number was then entered on Frontier’s site.  

 

If an address within the block or segment was identified by the provider’s site as potentially 

served, that block or segment retained that provider’s coverage on our map. If no addresses 

within the block or segment were identified as potentially served, we removed coverage of that 

block or street segment for that provider from our map. 

This round, for the first time, we investigated surrounding “suspect” blocks and segments. 
These are areas that were submitted as served by providers, but contradicted some of the “on 
the ground” knowledge we received from the public. These were also areas that stood out 
spatially (i.e. non-contiguous or “island” coverage) against the type of technology in question 
(i.e.  wireline technologies that run along roadway). 
 

Here are summary statistics for this feedback activity: 

 

 
 

 
 

 

 

 

3. Use of newly identified government data sources: The NYS Department of Motor Vehicles supplied 

three new datasets for our verification activities. Satellite Offices, Dealer Locations and Inspection 

Station Locations were used to verify provider reported availability.  All of these facilities have 

broadband connections.  The Dealer and Inspection Location datasets did not have provider or 

technology information associated with the locations.  Therefore, the highest verification code assigned 

was a 5 because we were only able to confirm that there was broadband at those locations.  However, 

the DMV Satellite Offices dataset came with provider information, so those locations were assigned a 

verification code of 2.  

   Number 

Public emails received during Round 4   102 

 Block Records Street Records 

Number of locations investigated and verified   87 4 

Number of locations investigated and removed 130 212 
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4. Use of newly identified commercial data source:  TomTom data was used to verify provider reported 

availability.  The TomTom data included boundaries for many of the broadband providers we have 

received data from.  The TomTom boundary for each provider included in the dataset was overlaid 

onto the provider footprint from our SBI data transfer model.  This was done to ensure that the 

availability data sent to us by the providers was within the respective boundary in the commercially 

available TomTom data.  All of the provider footprints that had matching boundaries in the TomTom 

data fell within their respective boundary.  

 

5. Select CAI locations were used to verify provider reported availability for the first time this round. We 

selected Colleges, Hospitals, Federal Correctional Facilities, State Prisons and State Police Stations from 

our total collection of previously identified CAIs as an additional verification data source because we 

strongly believe all have broadband connections. Since the provider and technology are still unknown 

at this time, the highest verification code assigned was 5 (Provider and technology unknown but 

Broadband is available in the location). All but 12 of the 887 points used confirmed provider reported 

availability. The 12 conflicts are currently being researched. Results will be reflected in Round 5 data. 

 
6. Provider verification: For providers with significant changes from the previous round, we created 

review maps showing Round 4 availability aggregated to census blocks and street segments. There 

providers were given at least five days to respond and initiate any changes or corrections. Changes 

were made based on provider feedback. Changes were documented for future reference.  These OCS 

generated maps were later compared to the provider footprints in the geodatabase to ensure that the 

data loaded in correctly.  Many of the providers have multiple review maps, so each of these maps had 

to be examined and compared to the corresponding area in the data.  During the comparison process, 

four provider’s footprints were discovered to have some missing data and were corrected.  The rest of 

the provider’s footprints matched their respective review maps. 

 

7. Verizon NY (wire-line) specific scrubbing:  Verizon New York submitted data in 2010 TIGER/Line Census 

Blocks and Edge Files as text delimited files.  

a. Street segments in the original data were highly fragmented and discontinuous in census blocks 

greater than 2 square miles. An infill process was used to select segments 100 meters or less 

where availability was not reported by Verizon but that segment fell in between two street 

segments with Verizon reported availability.  Addresses from a sampling of the new street 

segments were checked through Verizon’s website and broadband availability was verified. A 

total of 920 segments were added to Verizon’s availability and assigned the max advertised 

speed attributes of the nearest street segment. 312 Street segments that were discontinuous 

with any other reported availability or fell more than one mile outside Verizon’s service 

footprint were checked for availability through Verizon’s website and subsequently deleted.  

b. Census blocks in the original data contained outliers. 122 Census blocks reported by Verizon fell 

more than one mile outside their exchange boundary and were discontinuous with any other 

Verizon reported availability. Addresses sampled in these blocks were checked for availability 
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through Verizon’s website. Through this process, it was verified that there is no Verizon service 

in these blocks, and the census blocks were deleted. 

 
8. Clipping all data to the NYS boundary file  

 

Round 4 Anticipated Focus and Current Status: 

The six items below describe work we believed, at the time of our last submission, warranted special emphasis 

during the next round of data collection, processing and verification.   The current status is provided after each 

description. 

 

1. From April 1, 2011 methodology paper:  Further attribution and enhanced spatial accuracy of our 

Community Anchor Institution (CAI) data: To date, collection of the broadband service attributes for 

our CAIs remains one of our activities in need of the most improvement. To that end, we are nearing a 

final version of a proposed scope of work for our partner, the Center for Technology in Government 

(CTG), to expand their data collection activities beyond speed test data to include CAI broadband 

service attributes. The speed test data collection website and CTG’s outreach network will be further 

leveraged. 

 

Current Status: We amended our Memorandum of Understanding with CTG to expand their outreach 

and data collection activities to include broadband service attributes for schools, libraries, colleges/ 

universities, medical /healthcare facilities and municipal halls (Other community support – government 

category).  CTG successfully used their outreach network to bring the State Education Department 

(which governs schools, colleges/universities and libraries) to the table and agree to begin a joint 

broadband data collection effort once per year. This will consolidate three separate survey efforts that 

collected basically the same information and should result in a very high rate of participation within 

these sectors of CAIs. This first joint collection is scheduled for October 2011. OCS was provided earlier 

survey results from these sectors and we were able to extract partial SBI required attributes for use in 

this submission.  CTG will also focus on municipal halls and medical/healthcare institutions for the next 

submission, OCS will focus on the public safety sector. While it took a great deal of time to get this far, 

this is a significant step in the right direction for this area of focus with collateral benefits for the State 

Education Department as well as the individual institutions that must complete state surveys. 

 

2. From April 1, 2011 methodology paper:  Identifying and working with fixed wireless providers: We 

believe we have yet to identify some existing providers and new companies will be starting up to fill 

small pockets of underserved or un-served. 

 

Current Status: In Round 4 we reached out to 8 companies we identified as fixed wireless providers in 

New York. In most cases these companies were non-responsive. Two companies, Logical Net Corp. and 

NY Air, expressed willingness to participate. However, after our initial exchanges, both companies 
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became non-responsive. We had a similar occurrence in Round 3 with the fixed wireless company 

Plexicomm. We believe that the small sizes of these companies, as well as the perceived amount of 

effort to provide data, are the greatest hurdles. New York plans to keep reaching out to these providers 

as they are seen as a viable alternative to wired broadband in underserved areas and areas previously 

thought to be unserved. 

 

3. From April 1, 2011 methodology paper:  Adding verification methods: We intend to pursue the use of 

additional crowd sourced, commercial, and public data source and the aggregated FCC supplied 477 

data. 

 

Current Status: As noted above, the use of the crowd sourced data received via our state broadband 

map was extended to verify “surrounding suspect areas”. This resulted in additional corrections that 

would have otherwise not been realized.  No new crowd sourced data sets were identified or created 

this round. We also utilized a newly discovered commercially available TomTom data product to further 

verify provider footprints DMV (see details in verification section above).  

 

We researched InfoGroup (formerly InfoUSA) data. One cut of data they offered contained “marketing” 

records with a single broadband related attribute (email addresses that in some cases could be 

associated with technology). They also offered to query their data store using NAICs codes in attempt 

to identify CAIs and provide contact info, location address and email address. After reviewing sample 

data, we decided neither offering was going to be very helpful.  

 

We obtained and utilized three new datasets obtained from the NYS DMV (see details in verification 

section above). Most of this information is publically available but the DMV provided it to us in a “ready 

to use” format. Lastly, we are nearing the end to the process of agreeing to and satisfying the 

conditions for obtaining the aggregated FCC 477 data. We will be able to utilize this data for verification 

of Round 5 data. We will develop methods using Round 4 data. 

 

Overall, use of additional data sets and extending our verification methods have allowed us to get 

closer to our goal of eventually having record level verification of all data within the SBI data transfer 

model deliverable.  To ever reach that level though, we will need to automate at least some of our 

currently manual methods but we continue to get new, innovative ideas each round. 

 

4. From April 1, 2011 methodology paper:  Migration to 2010 Census data layers: This will involve the 

realignment of new Census geography to NYS basemap layers and migrating the previous round’s data 

to Census blocks that have entirely new id numbers. 

 

Current Status: A migration to US Census Dept. provided 2010 geography was completed.  All block 

level data delivered in the SBI data transfer model is attached to 2010 census blocks. Street level data is 

attached to the most current version of the NYS streets geography. OCS will likely contract out the 

work to have the Census supplied geography aligned to NYS streets and other NYS base map layers. We 

receive an estimate from Navteq to perform this realignment and conflation work in time to use these 
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results for this Round 4 deliverable. Navteq is currently under contract with OCS and there was the 

potential to leverage that existing procurement vehicle.  We felt the cost was too high, in large part 

because of the “rush” nature of our request. We declined and will likely have to do a competitive 

procurement to obtain an “affordable” price.  

 

5. From April 1, 2011 methodology paper:  Improvements to the NYS Broadband Map and increasing the 

number of ‘visits’: We see our state map as an area where we can provide value to our provider 

partners. We have already met with some providers to discuss displaying multiple ‘speed package’ 

offerings. Time Warner Cable has agreed to work with us to pilot that enhancement. We are also in 

discussions with CTG in order to have them perform outreach work to increase the visits to the site and 

specifically encourage visitors to provide feedback regarding the accuracy of the availability data. We 

already have a detailed verification workflow in place to effectively utilize this data. 

 

Current Status: We made changes that we believe enhance the user-friendliness of our State 

Broadband Map, including a homepage redesign (www.broadbandmap.ny.gov). We also added 

provider footprints to the map. With our October 2011 release of the Round 4 data, we will be adding 

functionality to view multiple speed offerings data voluntarily given to us by 11 providers (including 

Time Warner, a major NYS provider). We will also be adding a composite max advertised speed layer 

and discrete single speed tier layers. Functionality allowing the public to identify unserved addresses is 

planned for release before the end of this year. CTG has agreed to expand their scope of work to 

include marketing our mapping site and feedback tools. A second amendment to our MOU with CTG is 

nearing completion. 

 

6. From April 1, 2011 methodology paper:  Further development of a project plan for our address point 

development work: We are already using address points for geocoding service delivery addresses and 

for verification work. For Round 4, we envision our use of address points for verification to increase and 

for their use in enhancing our ability to estimate household availability, underserved areas and 

uninhabited lands. Needs assessment discussions are already underway with E911 and key government 

agency stakeholders. 

 
Current Status: The Address File portion of our project plan was expanded and approved along with 

our entire project plan, budget and timeline package required under our supplement grant award.  We 

have recruited two county 9-1-1 organizations to work with us on a pilot to develop address point 

mapping standards and define data workflows. Work on that pilot is expected to begin before year’s 

end. We also completed work with a professional demographer reviewing our methods for calculating 

household units with broadband availability. A final report was produced and posted to PBWORKS. 

 

Round 5 Focus 
 

1. One of our primary focuses will be to develop methods to reduce the upward bias in our calculation of 

household units with broadband availability. We will continue to work with the demographer we have 

under contract as well as further explore our own ideas. When NY availability percentages are 

http://www.broadbandmap.ny.gov/
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presented at public forums, we consistently get feedback that our numbers are inaccurate. At the most 

recent event attended, Congressmen Gibson’s Rural Broadband Symposium (9/29/11, NY’s 20th 

District), US Department of Agriculture staff were also presenters. When discussing their Rural 

Development Community Connect grant program, they stated that in 100% of over 40 instances where 

an applicant’s claim of being unserved was in conflicted with the data on the NBM, the applicant’s 

claim was substantiated by Dept. of Ag. local field staff investigations. Clearly the granularity of data 

collection is insufficient to produce accurate mapping in rural areas of the country.  We see 

improvement here as paramount to the continued success of our state’s program. We anticipate 

increased use of public feedback and other crowd sourced data playing a significant role in improving 

the accuracy of the availability data. 

 

2. CAI attribution: Collaboration agreements with multiple units within the NYS State Education 

Department and a refinement of our CAI definition have laid the ground work for significant 

advancement is this area. 

 

3. Advancement of our Address Point Mapping Standards pilot and additional use of address point data 

for data verification: Our work to date with the NY 9-1-1 Coordinators Association and a related pilot 

project currently being planned with US Census Bureau has set the stage for significant advancement of 

our Address File project. 

 

4. Additional enhancement of our verification activities: This will include the addition of “unserved 

address” functionality to our state broadband map; the use of the aggregated 477 data and the use of 

yet to be identified new data sources. 
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Complete 160
Non-Responsive/Refused 16
In Progress 4

Count of Datasets by Status 180
Total Unique Providers Represented 133

Provider Name Platform Status

NDA 
Execution 

Date Notes

AT&T Inc. DSL Data Added to Statewide Inventory 12/16/2009

[AUG-26-11 Amanda Bentley]  Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

AT&T Inc. Mobile Wireless Data Added to Statewide Inventory 12/16/2009

[AUG-16-11 Amanda Bentley]  Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Bascom Mutual Telephone Company Fixed Wireless Data Added to Statewide Inventory 3/22/2010
[SEP-02-11 Amanda Bentley]  Change: New 
fixed wireless tower in operation.

Block Communications, Inc. Cable Data Added to Statewide Inventory 2/8/2010

[AUG-11-11 Amanda Bentley]  Correction: 
Speeds changed from speed tier 9 max down 
and speed tier 5 max up to speed tier 7 max 
down and speed tier 3 max up.  The higher 
speed tiers are currently being tested, but not yet 
advertised.

BluSky Wireless Fixed Wireless Data Added to Statewide Inventory 2/24/2010
[SEP-02-11 Amanda Bentley]  Correction:  Fixed 
wireless coverage was revised.

CenturyLink DSL Data Added to Statewide Inventory 12/4/2009

[AUG-17-11 Amanda Bentley]  Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Cequel Communications Cable Data Added to Statewide Inventory 12/15/2009

[AUG-17-11 Amanda Bentley]  Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Clearwire Corporation Mobile Wireless Data Added to Statewide Inventory 3/3/2010

[AUG-10-11 Amanda Bentley]  Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Clearwire Corporation Fixed Wireless Data Added to Statewide Inventory 3/3/2010

[AUG-11-11 Amanda Bentley]  Correction: 
Propagations were created to represent the fixed 
wireless system to replace the less accurate 
coverage used previously.

Comcast Cable Communications, LLC Cable Data Added to Statewide Inventory 12/7/2009

[AUG-24-11 Amanda Bentley]  Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

CoxCom Inc. Cable Data Added to Statewide Inventory 1/29/2010

[AUG-29-11 Amanda Bentley]  Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

DuplexCom of Ohio, LLC Fixed Wireless Data Added to Statewide Inventory
[SEP-02-11 Amanda Bentley]  Change: New 
fixed wireless provider in the market.

Eagle Communications, LLC Fixed Wireless Data Added to Statewide Inventory

[AUG-29-11 Amanda Bentley] Correction: 
Provider was included for the first time in the 
October 2011 submission because we did not 
have their participation previously.

Erie County Cablevision, Inc. Cable Data Added to Statewide Inventory 2/8/2010

[AUG-10-11 Amanda Bentley]  Correction: 
Speeds changed from speed tier 9 max down 
and speed tier 5 max up to speed tier 7 max 
down and speed tier 3 max up.  The higher 
speed tiers are currently being tested, but not yet 
advertised.

FairPoint Communications DSL Data Added to Statewide Inventory 12/22/2009

[AUG-19-11 Amanda Bentley]  Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided (Germantown exchange only) 
for October 2011 submission.

Frontier Communications Corporation DSL Data Added to Statewide Inventory 1/22/2010

[AUG-22-11 Amanda Bentley]  Change: Upgrade 
to network, additional DSLAMs added expanding 
service area.

Imagine Networks, LLC Fixed Wireless Data Added to Statewide Inventory 7/13/2011
[AUG-11-11 Amanda Bentley]  Change: New 
fixed wireless provider in the market.

JB-Nets, LLC Fixed Wireless Data Added to Statewide Inventory 4/5/2010
[AUG-31-11 Amanda Bentley]  Change: New 
fixed wireless towers in operation.

KeyOn Communications, Inc. Fixed Wireless Data Added to Statewide Inventory 10/15/2009

[AUG-15-11 Amanda Bentley]  Correction: 
Previously unreported coverage was added to 
the service area from the April 2011 submission.

Broadband Provider Log



Leap Wireless International, Inc. Mobile Wireless Data Added to Statewide Inventory 4/6/2010

[AUG-16-11 Amanda Bentley]  Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Massillon Cable TV, Inc. Cable Data Added to Statewide Inventory 2/9/2010
[AUG-11-11 Amanda Bentley]  Change: Upgrade 
to network, expansion of service area.

MetaLINK Technologies, Inc. Fixed Wireless Data Added to Statewide Inventory 3/22/2010
[AUG-11-11 Amanda Bentley]  Change: New 
fixed wireless towers in operation.

New Knoxville Telephone Company Fixed Wireless Data Added to Statewide Inventory 3/12/2010
[AUG-23-11 Amanda Bentley]  Change: New 
fixed wireless towers in operation.

Omnicity, Inc. Fixed Wireless Data Added to Statewide Inventory

[AUG-11-11 Amanda Bentley]  Correction: 
Provider was included for the first time in the 
October 2011 submission because we did not 
receive a full dataset previously.

OneCommunity Fixed Wireless Data Added to Statewide Inventory 4/14/2010

[AUG-29-11 Amanda Bentley]  Correction: 
Provider is being included for the first time in the 
October 2011 submission because we didn’t 
have their participation previously.

Ottoville Mutual Telephone Company DSL Data Added to Statewide Inventory 12/22/2009

[AUG-15-11 Amanda Bentley] Correction: 
Provider corrected their speed information from 
the April 2011 submission.

Ottoville Mutual Telephone Company Fiber Data Added to Statewide Inventory 12/22/2009
[AUG-15-11 Amanda Bentley]  Change: Upgrade 
to network, provider now offers FTTH.

Sprint Nextel Corporation Mobile Wireless Data Added to Statewide Inventory 1/14/2010

[AUG-10-11 Amanda Bentley]  Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

T-Mobile USA, Inc. Mobile Wireless Data Added to Statewide Inventory 1/8/2010

[AUG-10-11 Amanda Bentley]  Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

TDS Telecommunications Corporation DSL Data Added to Statewide Inventory 1/27/2010

[AUG-15-11 Amanda Bentley]  Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Time Warner Cable LLC Cable Data Added to Statewide Inventory 12/21/2009

[AUG-22-11 Amanda Bentley]  Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

UDATAnet Fixed Wireless Data Added to Statewide Inventory

[AUG-29-11 Amanda Bentley] Correction: 
Provider was included for the first time in the 
October 2011 submission because we did not 
have their participation previously.

Verizon Communications, Inc. Mobile Wireless Data Added to Statewide Inventory 12/14/2009

[AUG-10-11 Amanda Bentley]  Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Wavelinc Communications Fixed Wireless Data Added to Statewide Inventory

[AUG-26-11 Ashley Littell] Changes and 
Correction: Provider activated five new towers 
and upgraded network to offer higher speeds; 
also removed one tower from previous 
submission because it is not active.

WideOpenWest Finance, LLC Cable Data Added to Statewide Inventory

[AUG-11-11 Amanda Bentley] Correction: 
Provider was included for the first time in the 
October 2011 submission because we did not 
have their participation previously.

Windstream Communications DSL Data Added to Statewide Inventory 1/28/2010

[AUG-23-11 Amanda Bentley]  Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.  
Coverage was completely removed from 
Ashtabula, Hardin, and Lucas Counties where 
coverage was reported previously.

CenturyLink Backhaul Backhaul Provider Only Processing Complete 12/4/2009
ConnectLink, Inc. Backhaul Backhaul Provider Only Processing Complete 3/15/2010
Level 3 Communications, LLC Backhaul Backhaul Provider Only Processing Complete 12/14/2009
T-Mobile USA, Inc. Backhaul Backhaul Provider Only Processing Complete 1/8/2010
Windstream Communications Backhaul Backhaul Provider Only Processing Complete 1/28/2010
Zayo Group, LLC Backhaul Backhaul Provider Only Processing Complete

Insight Communications of Central Ohio, LLC Cable
Estimated Coverage Submitted for Non-
Participating Provider

[SEP-08-11 Ashley Littell] Correction: Finalized 
coverage dataset for Insight based on website 
listings and broadband inquiries received from 
consumers regarding available service in the 
area. Advertised speed data acquired from 
Insight website. Since company is being 
acquired by Time Warner, data will likely be 
submitted under that name in the next 
submission.

Amplex Internet Fixed Wireless
Approval for Update Not Received – Data Still 
Submitted 3/26/2010

[AUG-30-11 Amanda Bentley]  Change: New 
fixed wireless tower in operation.

Country Connections LLC Fixed Wireless
Approval for Update Not Received – Data Still 
Submitted 2/15/2010

[SEP-02-11 Amanda Bentley]  Correction:  Fixed 
wireless coverage was revised.

Freund Enterprises Inc. Fixed Wireless
Approval for Update Not Received – Data Still 
Submitted 3/2/2010

[SEP-16-11 Amanda Bentley]  Change: New 
fixed wireless towers in operation.

Armstrong Utilities, Inc. Cable No Update to Provide 3/11/2010
Arthur Mutual Telephone Company DSL No Update to Provide 12/22/2009



AT&T Inc. Backhaul No Update to Provide 12/16/2009
Ayersville Telephone Company DSL No Update to Provide 3/22/2010
Bascom Mutual Telephone Company Cable No Update to Provide 3/22/2010
Bascom Mutual Telephone Company Fiber No Update to Provide 3/22/2010
Bascom Mutual Telephone Company Backhaul No Update to Provide 3/22/2010
Bryan Municipal Utilities Cable No Update to Provide
Bryan Municipal Utilities Fiber No Update to Provide
Buckland Telephone Co. Fiber No Update to Provide 4/10/2010
Cable Co-op, Inc. Cable No Update to Provide 4/9/2010
CenturyLink Backhaul No Update to Provide 12/4/2009
Champaign Telephone Company DSL No Update to Provide
Champaign Telephone Company Fiber No Update to Provide

Champaign Telephone Company Fixed Wireless No Update to Provide

[SEP-02-11 Amanda Bentley]  Correction:  Fixed 
wireless coverage changed to actual 
propagations to replace the concentric circle 
polygon used previously.

Cincinnati Communications, LLC Backhaul No Update to Provide 1/6/2011
Cincinnati Communications, LLC BPL No Update to Provide 1/6/2011
City of Wadsworth Cable No Update to Provide 7/19/2010
Citynet, LLC Backhaul No Update to Provide 4/5/2010
Com Net, Inc. Backhaul No Update to Provide
Computers4U Fixed Wireless No Update to Provide
Conneaut Telephone Company Cable No Update to Provide 12/22/2009
Conneaut Telephone Company DSL No Update to Provide 12/22/2009
CoxCom Inc. Backhaul No Update to Provide 1/29/2010
Coyote Wireless Broadband LLC Fixed Wireless No Update to Provide 4/19/2010
Dark Horse Networks, LLC Fixed Wireless No Update to Provide 3/15/2010
DataBit Solutions Corp Fixed Wireless No Update to Provide

DISH Network Corporation Satellite No Update to Provide 1/27/2010

[SEP-16-11 Amanda Bentley]  Correction: 
Satellite data is being submitted and was not 
included in the April 2011 submission. While 
coverage is currently the entire state boundary, 
work continues on having more granular data 
available.

East Cleveland Cable TV and Communications, 
LLC Cable No Update to Provide 4/13/2010
FairPoint Communications Cable No Update to Provide 12/22/2009
Farmers Mutual Telephone Company DSL No Update to Provide 12/22/2009
Farmers Mutual Telephone Company Fixed Wireless No Update to Provide 12/22/2009
Freund Enterprises Inc. Backhaul No Update to Provide 3/2/2010
Frontier Communications Corporation Backhaul No Update to Provide 1/22/2010
Gateway Telecom LLC Fixed Wireless No Update to Provide 3/22/2010
Glandorf Telephone Company, Inc. DSL No Update to Provide 3/9/2010
Glandorf Telephone Company, Inc. Cable No Update to Provide 3/9/2010
Horizon Telcom, Inc. DSL No Update to Provide 3/27/2010
Horizon Telcom, Inc. Fiber No Update to Provide 3/27/2010

Hughes Network Systems, LLC Satellite No Update to Provide 2/5/2010

[SEP-16-11 Amanda Bentley]  Correction: 
Satellite data is being submitted and was not 
included in the April 2011 submission. While 
coverage is currently the entire state boundary, 
work continues on having more granular data 
available.

Intelliwave, LLC Fixed Wireless No Update to Provide
Jefferson County Cable TV, Inc. Cable No Update to Provide 2/1/2010
Jenco Speed Web Fixed Wireless No Update to Provide 4/28/2010
Kalida Telephone Company, Inc. DSL No Update to Provide 3/8/2010
McClure Telephone Company DSL No Update to Provide 4/5/2010
McClure Telephone Company Fiber No Update to Provide 4/5/2010
Mediacom Indiana LLC Cable No Update to Provide 1/12/2010
MegaPath Inc. Backhaul No Update to Provide 2/15/2010
Mikulski Communications LLC Fixed Wireless No Update to Provide 4/13/2010
Minford Telephone Company DSL No Update to Provide 3/3/2010
New Era Broadband, LLC Fixed Wireless No Update to Provide 7/12/2010
New Knoxville Telephone Company DSL No Update to Provide 3/12/2010
New Knoxville Telephone Company Cable No Update to Provide 3/12/2010
New Knoxville Telephone Company Fiber No Update to Provide 3/12/2010
New Knoxville Telephone Company Backhaul No Update to Provide 3/12/2010
NexGenAccess Inc. Fixed Wireless No Update to Provide 4/16/2010
North West Net, Inc. Fixed Wireless No Update to Provide 4/6/2010
One Communications Corporation Backhaul No Update to Provide 3/18/2010
OneCommunity Backhaul No Update to Provide 4/14/2010
Ottoville Mutual Telephone Company Backhaul No Update to Provide 12/22/2009
SAA bright.net, Inc. Fixed Wireless No Update to Provide 3/23/2010
Slane Telecom Fixed Wireless No Update to Provide 4/9/2010
Sprint Nextel Corporation Backhaul No Update to Provide 1/14/2010
Sycamore Telephone Company DSL No Update to Provide 12/22/2009
Sycamore Telephone Company Backhaul No Update to Provide 12/22/2009
TDS Telecommunications Corporation Backhaul No Update to Provide 1/27/2010
The City of Dover Backhaul No Update to Provide 4/9/2010
tw telecom of ohio, llc Backhaul No Update to Provide 4/21/2010
Vaughnsville Telephone Company, Inc DSL No Update to Provide 12/22/2009
Verizon Communications, Inc. Backhaul No Update to Provide 12/14/2009
Wabash Mutual Telephone Company DSL No Update to Provide 3/30/2010
Wabash Mutual Telephone Company Fiber No Update to Provide 3/30/2010
Wabash Mutual Telephone Company Fixed Wireless No Update to Provide 3/30/2010



WildBlue Communications, Inc. Satellite No Update to Provide 1/8/2010

[SEP-16-11 Amanda Bentley]  Correction: 
Satellite data is being submitted and was not 
included in the April 2011 submission. While 
coverage is currently the entire state boundary, 
work continues on having more granular data 
available.

XO Communications, LLC Backhaul No Update to Provide 2/12/2010
YES Learning and Computer Center Inc. Backhaul No Update to Provide 4/24/2010

Avolve, Inc. Fixed Wireless No Update Provided - Use Last Submission Data 2/17/2011

Benton Ridge Telephone Company DSL No Update Provided - Use Last Submission Data 4/13/2010

Benton Ridge Telephone Company Fixed Wireless No Update Provided - Use Last Submission Data 4/13/2010

Cincinnati Bell Telephone Company LLC DSL No Update Provided - Use Last Submission Data 3/16/2010

Cincinnati Bell Telephone Company LLC Cable No Update Provided - Use Last Submission Data 3/16/2010

Cincinnati Bell Telephone Company LLC Fiber No Update Provided - Use Last Submission Data 3/16/2010

Cincinnati Bell Telephone Company LLC Mobile Wireless No Update Provided - Use Last Submission Data 3/16/2010

Cogent Communications, Inc. Backhaul No Update Provided - Use Last Submission Data

Doylestown Telephone Company DSL No Update Provided - Use Last Submission Data 4/14/2010

Doylestown Telephone Company Cable No Update Provided - Use Last Submission Data 4/14/2010

Doylestown Telephone Company Fiber No Update Provided - Use Last Submission Data 4/14/2010

Fort Jennings Telephone Company DSL No Update Provided - Use Last Submission Data 4/2/2010

Fort Jennings Telephone Company Fiber No Update Provided - Use Last Submission Data 4/2/2010

g wireless, Inc. Fixed Wireless No Update Provided - Use Last Submission Data 3/15/2010

GMN Wireless Broadband Fixed Wireless No Update Provided - Use Last Submission Data 3/15/2010

Hometown Cable Company Fiber No Update Provided - Use Last Submission Data 4/15/2010

King Office Service, Inc. Fixed Wireless No Update Provided - Use Last Submission Data 4/9/2010

LightSpeed Technologies Fixed Wireless No Update Provided - Use Last Submission Data 2/9/2010

Mango Bay Internet Fixed Wireless No Update Provided - Use Last Submission Data 2/23/2010

Mechcom Dot Net Fixed Wireless No Update Provided - Use Last Submission Data 4/22/2010

Middle Point Home Telephone Company DSL No Update Provided - Use Last Submission Data 1/19/2010

Nelsonville TV Cable, Inc. Cable No Update Provided - Use Last Submission Data 4/7/2010

North Coast Wireless Communications Fixed Wireless No Update Provided - Use Last Submission Data 4/14/2010

Nova Telephone Company DSL No Update Provided - Use Last Submission Data 4/5/2010

nTelos, Inc. DSL No Update Provided - Use Last Submission Data

RAA Services Fixed Wireless No Update Provided - Use Last Submission Data 3/12/2010

Redbird Internet Services Fixed Wireless No Update Provided - Use Last Submission Data 3/22/2010

Ridgeville Telephone Company DSL No Update Provided - Use Last Submission Data 3/12/2010

RTEC Communications, Inc. Cable No Update Provided - Use Last Submission Data 4/13/2010

RTEC Communications, Inc. Fiber No Update Provided - Use Last Submission Data 4/13/2010

S. Bryer Cable TV Corp. Cable No Update Provided - Use Last Submission Data 8/16/2010

Sherwood Mutual Telephone Association DSL No Update Provided - Use Last Submission Data 3/25/2010

Skymax Broadband, Inc. Fixed Wireless No Update Provided - Use Last Submission Data 2/11/2010

Southern Ohio Communication Services, Inc. Fixed Wireless No Update Provided - Use Last Submission Data 4/20/2010

Telephone Service Company DSL No Update Provided - Use Last Submission Data 4/6/2010

Telephone Service Company Cable No Update Provided - Use Last Submission Data 4/6/2010

Telephone Service Company Fiber No Update Provided - Use Last Submission Data 4/6/2010

US Signal Company, LLC Backhaul No Update Provided - Use Last Submission Data 6/17/2010

Waldron Communication Company Fixed Wireless No Update Provided - Use Last Submission Data 3/19/2010

Waldron Communication Company Backhaul No Update Provided - Use Last Submission Data 3/19/2010



Wilkshire Communications, Inc. Fixed Wireless No Update Provided - Use Last Submission Data 3/16/2010
Open Range Communications, Inc. Fixed Wireless Solicited Initial Data 5/5/2011

PAETEC Communications, Inc. DSL Other

[SEP-08-11 Wes Kerr] Multiple outreach 
attempts were conducted but no response was 
received. Paetec was bought out during the 
collection phase of this round by Windstream 
and we intend to be able to include the Paetec 
coverage as a part of the Windstream footprint 
during the next round.

PAETEC Communications, Inc. DSL Other

[SEP-08-11 Wes Kerr] Multiple outreach 
attempts were conducted but no response was 
received. Paetec was bought out during the 
collection phase of this round by Windstream 
and we intend to be able to include the Paetec 
coverage as a part of the Windstream footprint 
during the next round.

Southern Ohio Communication Services, Inc. Fixed Wireless Other 4/20/2010

[SEP-16-11 Amanda Bentley]  Scioto Wireless 
LTD has been acquired by Southern Ohio 
Communication Services, Inc.  Coverage is still 
operational as Scioto Wireless and is submitted 
as such.

Just Micro Digital Services, Inc. Fixed Wireless Refused to Participate 4/13/2010

[JAN-26-11 Chip Spann]  Received 1 e-mail from 
the provider stating his refusal to participate, 
followed by 1 email requesting to have his 
coverage area removed from the map.

Advanced Computer Connections Fixed Wireless Non-Responsive to Multiple Attempts

In addition to contact attempts made on July 1, 
2010 and January 25, 2011, 2 additional 
attempts were made this period.

Bellaire Television Cable Co. Inc. Cable Non-Responsive to Multiple Attempts

In addition to contact attempts made on July 1, 
2010 and February 10, 2011, 3 additional 
attempts were made this period.

Firewire Internet DSL Non-Responsive to Multiple Attempts
3 contact attempts were made between June 2, 
2011 and August 9, 2011.

Firewire Internet Fixed Wireless Non-Responsive to Multiple Attempts
3 contact attempts were made between June 2, 
2011 and August 9, 2011.

First Communications, LLC Fiber Non-Responsive to Multiple Attempts

In addition to contact attempts made in July 2010 
and January 2011, 2 additional attempts were 
made this period.

Global Crossing Telecommunications, Inc. Backhaul Non-Responsive to Multiple Attempts

In addition to contact attempts made between 
July 1, 2010 and February 17, 2011, 3 additional 
attempts were made this period.

GLW Broadband Cable Non-Responsive to Multiple Attempts

In addition to contact attempts made between 
July 1, 2010 and February 18, 2011, 3 additional 
attempts were made this period.

Hocking Internet Technologies, Ltd Fixed Wireless Non-Responsive to Multiple Attempts 8/12/2010

In addition to contact attempts made between 
July 1, 2010 and February 14, 2011, 3 additional 
attempts were made this period.

Linked Communications, LLC Fixed Wireless Non-Responsive to Multiple Attempts

In addition to contact attempts made between 
July 1, 2010 and February 11, 2011, 3 additional 
attempts were made this period.

New Albany Net Fiber Non-Responsive to Multiple Attempts
3 contact attempts were made between May 6, 
2011 and July 26, 2011.

Practical Support, Ltd. Fixed Wireless Non-Responsive to Multiple Attempts

In addition to contact attempts made between 
July 1, 2010 and January 19, 2011, 3 additional 
attempts were made this period.
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1  Introduction

This report is submitted along with the fourth data submission for the 
Oklahoma Broadband Mapping Project.  This submission includes all data 
collected sofar per the requirements of the National Telecommunications 
and Information Administration (NTIA) State Broadband Data and 
Development Grant Program (Docket No. 0660-ZA29) Notice of Funds 
Availability (NOFA) and formal and informal clarifications to it. 
Specifically, it includes broadband data collected from broadband 
providers and Community Anchor Institutions data compiled from various 
sources for the State of OK.  The State of Oklahoma has retained a 
mapping contractor, The Sanborn Map Company to performthe work 
related to the Mapping Grant for this project.Data from the previous 
submission is now publicly accessible via the Oklahoma Broadband 
Program (http://www.ok.gov/broadband/).

This document is a supplement to the three previous reports 
submitted with previous data submissions on May 1, 2010, October 
1, 2010, and April 1, 2011 respectively.  Therefore, it builds on the 
document provided with those submissions.  Rather than repeat the 
contents of the previous report, this document makes incremental 
updates on various topics where changes have been made in the 
methodology or reiterates the methodology used.  Please refer to the 
previous documents for further details.
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1 Overall Project Status

DATA COLLECTION

This section details data collection related to NTIA deliverables which 
include broadband data and community anchor institution data.  

1.1.1 Broadband Data

For this submission, Sanborn began data collection efforts on July 
12th2011by sending out data update requests and technical data 
specifications to all providers. This incorporated all the NTIA changes 
released on June 30th, 2011.  These were sent to a large list of companies 
which were compiled from past collection efforts, the revised FCC 477 
(dated June 30th, 2010),alist of providers from the NTIA’s Wireless 
Internet Service Providers Association (WISPA) and from any providers 
that were identified through other sources such as web research, 
planning meetings, etc. We then actively followed up with the providers 
and as we had discovered in the past, many of the providers listed on the 
FCC 477 list are either resellers, or not involved in the actual delivery of 
broadband. (Many are VOIP or teleconference service providers that 
utilize existing broadband connections.) 

In our technical document, we highlighted the transformation of data from 
Census 2000 to Census 2010 and given that change, we requested all 
providers to submit data in the Census 2010 format. Due to the change in 
census geography new data was requested whenever possible. Sanborn 
also uploaded the final data for each provider in NTIA format to the 
Sanborn Provider Portal.  The providers were encouraged to use the 
provider portal and update their information on it.  More and more 
providers are participating through the use of the provider portal and 
appreciate the ease of being able to see and validate their data through 
this process.

During our solicitation for data updates, we told providers that if we didn’t 
hear from them by a certain date, we would default to using their data 
from Submission 3.  However, we still contacted them a few times after 
the due date but eventually used Submission 3 data (converting it to 
census 2010) if they did not respond.

We followed the same contact and follow-up protocols as the previous 
submissions.  The following are some of the important changes or no 
changes:

1. All census blocks and road segments are mapped based on 2010 
census data set.  Any data submitted in 2000 or 2009 format was 
converted to 2010 for this submission.  

Oklahoma Broadband Mapping 10/01/11
4th Data Submission Report Page 4



2. We continued to not collect data from resellers 

3. We are submitting data for satellites in this submission based on 
NTIA clarifications.  All satellite providers who have provided 
speed, FRN number and other technology information have been 
mapped to serve the full state.  At present, Oklahomareceived 
acceptable files from two companies (Hughes and Wildblue). 
Weanticipate receivingcoveragefrom the other satellite providers 
(Starband and Stratos) in our next delivery to NTIA (Submission 5, 
due to NTIA on April 1, 2012) both of which did not provide 
adequate attribute information in order to be included in this 
submission.

1) Four satellite providers have been identified in Oklahoma – 
Hughes, Starband, Wildblue, and Stratos.  

4. Due to NDA restrictions and our inability to accurately flag service 
by “category of end user”, address points are not included in this 
submission to NTIA for any commercial provider.

5. Some providers did not submit middle mile elevation or backhaul 
capacity, particularly when they asked us to reuse previous 
submission data.  Wherever possible, we went back to providers 
to obtain that information, but it is not available for every record.

6. Terrestrial Mobile Wireless and Terrestrial Fixed Wireless 
(licensed and unlicensed) were treated as wireless coverage and 
were delivered as a shape file.  In cases where a provider served 
using the same technology and spectrum but with different 
speeds, overlapping areas were removed and the higher speed 
was assigned.

7. If a cable based wireline provider provides both DOCIS 2.0 and 
DOCIS 3.0 service to the same area, the block or road was listed 
only once with a technology code of 40.

8. Providers were only willing to indicate on a general level if they 
served business, residential or both, so we did not get any 
providers that broke down the type of service by block. Only if the 
provider stated they only serve business to business customers 
did we fill in the “category of end user” with a code of 2, otherwise 
this field was left blank.

9. The submission 4 provider data model is currently based on the 
NTIA data model as of 6/30/11.

We added 6 new providers in this submission – SkyBeam/Jab 
Broadband (terrestrial fixed wireless unlicensed), AirLink Internet 
Services (terrestrial fixed wireless unlicensed), Cellular Network 
Partnership / CNP (terrestrial fixed wireless licensed), Ozark 
Telephone Company (aDSL), Seneca Telephone Company (aDSL), 
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and Dobson Telephone, McLoud Division / Dobson Telephone 
Company (aDSL). 
In this submission, 41% of the providers submitted new or updated 
data whereas for 59% of the providers we reused data from their 
previous submissions.  Jab bought Partnership Broadband and also 
bought out Rhino as of July 1, 2011.

1.1.2 Community Anchor Institutions Data

The community anchor institutions data continues to be crowd-sourced 
through the online data gathering application created by the Sanborn 
Team. The State of Oklahoma is undertaking the PR around this data 
collection and contacting the relevant agencies to request their 
participationin filling out the data survey. This has been a slow process 
and we are getting to a point of diminishing returns with this effort.  The 
State of Oklahoma is also preparingto implement additional planning 
tasks to try to increase these numbers for future submissions. The current 
totals for community anchor institutions that have responded so 
farthrough this submission areprovided below:

Category Name Total

Total with 
Broadband 
Information in 
Submission 4

1 School - K through 12 1956 112
2 Library 210 71
3 Medical/healthcare 444 29
4 Public Safety 1793 8
5 University, college, other post-secondary 79 16
6 Other community support - government 490 20

7
Other community support - 
nongovernmental 16 1
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Community Anchor Institution: Crowdsourcing Portal
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DATA PROCESSING

1.1.3 General Overview
In general, submission 4processes followed the same basic approach 
asprevious submissions except for the conversion of Census 2000 to 
Census 2010. The following sections outline the modifications made to 
the initial processing in order to meet the submission 4requirements as 
defined by NTIA.

In summary they can be divided into the following categories:

• Processing of Provider Data

• Conversion from Census 2000 to Census 2010 format

• Reference Data Creation

• NTIA Submission Data Model Schema Changes

1.1.4 Processing of Provider Data
All data received went through the following processing steps:

1. Triage:  All new data was quickly reviewed to understand what 
was received, and in what format. We also made sure we had all 
the required components for NTIA’s data model, such as their 
FRN and advertised speed information. We also screened for any 
known issues that we might have seen before (such as Excel 
2003 spreadsheets that cut off at 32k row).

2. Ingest: At this time the data is actually brought into our systems. 
Each provider is set up with a unique file geodatabase to store 
their information. Record counts of what was received is logged so 
that we can validate we did not drop anything in processing.

3. Data Processing:  This is where the data goes through a number 
of ETL routines to convert the raw proprietary information into a 
format similar to the NTIA format. The exact routine utilized 
depends on how the data is received

1) When a provider submits a service boundary, we select all 
the blocks and roads inside that shape.

2) If a provider submits a customer address list, the points 
are geocoded, and then the appropriate block or road 
segment is selected.

3) If a provider submits block and road information using 
Census data, we just make sure everything is formatted to 
the appropriate specifications.

4) If the provider submits any type of road or line data that 
does not direct correlate to the TIGER data set, we convert 
the lines to TIGER by selecting the road centroid and 
spatially selecting the closed segment in our data set. If 
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the road is in a block less than 2sqmi, than the block is 
selected. Some manual cleanup is also applied to make 
sure we do not accidentally drop any road segments that 
should have been processed.

5) After each round of processing, we make sure that we only 
keep unique records. A unique record is defined as having 
a unique combination of FRN, Block/Road ID, and 
technology type. If there are multiple records with different 
speeds, but all else is equal, than we select the maximum 
of the advertised speeds.

4. QC Review: All data is then sent to a different analyst to perform 
a through quality control review on the processed data set. Record 
counts are compared to what was submitted. The QC staff also 
made sure the ETL scripts and routines populated all of the right 
fields.

5. QA Review: Data is then sent to another team for Quality 
Assurance Review. In this step the data is not only double 
checked against what was originally submitted, but it is also 
brought up inside standardized MXD templates that allow us to 
make sure our results make sense. This often involves comparing 
the new data set with prior submissions, as well as looking for any 
possible technology or speed anomalies.

6. Provider Review:  Processed data is all posted to a customized 
web-mapping tool we commonly refer to as the Provider Portal. All 
providers were notified once their data was available on the site, 
and they were always given 3-5 business days to review the data 
and respond. In this site, providers can log on and visually see 
their processed data in a map format. It also allows them to 
overlay their raw data to help them validate that we did indeed 
process things correctly. The provider portal also has a suite of 
markup tools that will allow the providers to edit their data, 
including adding or removing service areas, and making changes 
to the data attributes.

7. Comment Processing:  All comments and feedback received 
from the provider portal, is then reviewed, and applied to the 
processed data set. This updated data set goes back through our 
QA and QC processes, and if time allows, back out to the Provider 
Portal, for the provider to review and sign off on.

8. Data Append: After all of the individual data sets are processed 
and approved, we run an append process which merges all of the 
individual provider data sets into one geodatabase. This is also 
the point where our team will do any final transformations to get 
our working data model into the latest NTIA publishing format.

9. Final QA/QC:  A series of quality checks are run on the final 
appended data sets to ensure it is ready for submission to NTIA. 
We also run the NTIA receipt tool at this time. Any last issues are 
corrected, and the data is sent to the state for their review.

10. Submission to NTIA.
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1.1.5 Conversion Process of Data from Census 2000 to 
2010

Due to the changes in census geography, all providers were asked to 
submit new data. In those instances when a provider A) submitted new 
data in Census 2000 format, or B) instructed us to reuse their last data 
submission, we had to convert the blocks and roads into 2010 format.

Basic 2000 to 2010 Conversion Process:  
1. For the blocks, take the 2000 block ID, and select all the 

corresponding 2010 block id’s
1) using census crosswalk table – not an actual spatial 

process, since this was faster
2. Look at the new 2010 block ids, and filter on greater than or less 

than 2 sq. miles.
1) If less than or equal to 2 --> bring in the 2010 geometry 

and add that record to the blocks table
2) If greater than 2 --> select any roads in that area – spatial 

select (using roads gt2 table)
3. For the roads, take the 2000 or 2009 TLID and try to match it to 

the 2010 TLID’s
1) If there is a match,  add that record to the roads table
2) If there is not a match, select centroid of existing 

2000/2009 segment, and select closest 2010 road
3) If the road is now in a block LT2, select the block(s) 

instead and drop the road
4. Remove any duplicate records in both tables
5. Run some automated checks to catch missed features (i.e. add 

le2smi blocks surrounded by roads that have not already been 
added)

6. Manual review (QC) and corrections.
1) There will be some blocks that are selected inappropriately 

(especially at town edges for CT providers, where we know 
their franchise ends at a town line.)

2) There are some holes in the census crosswalk table
3) The road conversion process may only select one portion 

of the road if it has now been broken into multiple 
segments

Assumptions

1. If a road was in an area greater than 2smi in s3, and due to 
census re-drawing, is now in an area less than 2smi, we will grab 
blocks (le2smi) on both sides of that road and add them to the 
provider data:

2. If a new 2010 block, that is less than 2smi, is completely 
surrounded by roads and/or blocks served by that provider, than 
we will add the block to the provider service area.
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1.1.6 Submission 4: ReferenceData Creation
This section describes the reference data used in submission 4.  

BLOCK REFERENCE
For s4, Census 2010 data was utilized.  The data was set up as follows:

1. Block size (AREA) is calculated combining the 2000 land area 
(ALAND) and water area (AWATER)

2. AREA is converted from square meters to square miles to 
calculate square mileage (SMI).

3. If the SMI of a block is less than or equal to 2, then the less than 
or equal to 2 square mile indicator (LE2SMI) is set to true.

ROAD REFERENCE
2010 Tiger Line IDs (TLID) were used for data processing in s4.   The 

data was set up as follows:

1. The GT2SMI (Greater Than 2 Square Mile) indicator is set to True 
when:

1) The 2010 road segment is completely within a block that is 
NOT less than 2 square miles

2. Only minimum and maximum address ranges and a single zip 
code for each road segment is maintained.  

1.1.7 Submission4: NTIA Submission Data Model Schema 
Changes

The data model released on June 30, 2011 contained the following 
changes from the s4 data model:

• The Category of End user field was added back in to the block and 
road tables. In addition the domain values were changed. 1 still 
represents residential, but a 2 now represents all non-residential uses. 

o This field is not required, and for many providers, was left 

blank since the data was not provided.

DATA VALIDATION

Sanborn has continued to perform the same validation on the data as the 
previous threesubmissions(details in previous reports).  Some minor 
updates to the validation process are discussed below.

1) QC of the data at various steps

2) Spatial checks against public and commercial datasets
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a. For OK, we continued to use the following datasets for 
validation:

i. Exchange Boundaries:  for DSL boundaries

ii. MediaPrints:  for Cable boundaries

iii. Speedtest.net data

3) Verification by providers

4) In this Submission, along with the standard verification by providers 
using the Provider Portal, we also identified for providers issues that 
they needed to focus on regarding the findings of our validation team. 
This also included validation and feedback we received through our 
website – this submission we have incorporated and integrated 
several feedback tools in the Interactive Map and information sourced 
from users is evaluated with respect to provider data and any noted 
discrepancies are passed back to the provider for correction.  In 
addition, in this round, we incorporated any feedback provided by 
NTIA for Submission 3.  All of these were done by sending providers a 
letter that identified issues using screenshots and explaining to them 
what the error was and then asking them to go fix those errors using 
the secure provider portal.  If providers disagreed with the feedback, 
we have documented their response.

5) Speedtest data collection and other data collection for verification 

a. We continue to use speedtest data and community anchor 
data crowd sourced for validation purposes.

6) Planning workshops and local validation

a. During this submission, local validation was undertaken by an 
independent group, the Center for Spatial Analysis at the 
University of Oklahoma (OU).  OU performed an independent 
survey gathering data points from CAI’s and the GIS 
community for the State of Oklahoma.WithinSanborn’s 
validation process, OU’s points werecompared against 
provider’s data. Those data points found in question were 
taken back to the providers for correction. OU is increasing 
their efforts to gather more data points and this process will be 
performed throughout Submission 5. 

Oklahoma Broadband Mapping 10/01/11
4th Data Submission Report Page 12



                                                                               

       Version 2.0         September 2011 Author: Kristin Rousseau 
       Page 1 

 

Oregon Broadband Mapping Project: 
Product Release White Paper 

 

 

 

 

 

Contact Name Manager: Bryan Conway 

Contact Phone Number:   503-378-6200 

Contact E-mail:   bryan.conway@state.or.us 

 

 

Submitted By:   Kristin Rousseau 

Contact E-mail:   kristin.rousseau@broadmap.com 

 

 

Product Specification: Fall 2011 NTIA Data Model  

Product/Process: NTIA—October 1, 2011 Data Deliverable 

Dataset Submission QC:   NTIA—SBDD_CheckSubmission.py 

 

 

 

 

 

 

 

mailto:bryan.conway@state.or.us
mailto:kristin.rousseau@broadmap.com


                                                                               

       Version 2.0         September 2011 Author: Kristin Rousseau 
       Page 2 

Table of Contents 

OVERVIEW .........................................................................................5 

SUBMISSION SUMMARY ....................................................................5 

PROVIDER DETAILS ........................................................................................ 5 

PROVIDER PARTICIPATION ......................................................................................... 5 

COVERAGE AREA CHANGES ........................................................................................ 7 

DATA CORRECTIONS ................................................................................................... 7 

COMMUNITY ANCHOR INSTITUTION (CAI) DETIALS ....................................... 8 

OVERALL STATISTICS .................................................................................................. 8 

CAI CHANGES ............................................................................................................. 8 

SUBMISSION RECEIPT .................................................................................... 9 

SUBMISSION RECEIPT RESULTS ................................................................................... 9 

HIGH-LEVEL SUMMARY .................................................................... 10 

DATA GATHERING ....................................................................................... 10 

BROADBAND SERVICE AREAS, MIDDLE MILE AGGREGATION POINTS AND BROADBAND 
SERVICE OVERVIEW .................................................................................................. 10 

COMMUNITY ANCHOR INSTITUTION (CAI) ................................................................ 10 

DATA INTEGRATION PROCESS ..................................................................... 11 

DATA VALIDATION AND VERIFICATION ........................................................ 11 

THIRD-PARTY DATA VERIFICATION ........................................................................... 11 

BROADBAND PROVIDER VALIDATION—PROVIDER PORTAL APPLICATION ................. 11 

CONFIDENCE VALUES ............................................................................................... 12 

QUALITY CONTROL ...................................................................................... 12 

DETAILED PROCESS REVIEW ............................................................. 13 

PROVIDER OUTREACH ................................................................................. 13 

OUTREACH MATERIALS ............................................................................... 14 

OUTREACH PROCESS ................................................................................... 14 



                                                                               

       Version 2.0         September 2011 Author: Kristin Rousseau 
       Page 3 

DATA COLLECTION ....................................................................................... 15 

DATA TRANSFER PROCEDURES ................................................................................. 15 

INITIAL DATA REVIEW AND QUALITY ASSURANCE ..................................................... 15 

DATA INGESTION ......................................................................................... 15 

DATA INGESTION OVERVIEW .................................................................................... 15 

POINT DATA ............................................................................................................. 16 

SUBSCRIBER LOCATION—ADDRESS DATA.................................................................................................... 16 
SUBSCRIBER LOCATION—XY DATA ............................................................................................................ 19 
SUBSCRIBER LOCATION—GIS DATA ........................................................................................................... 20 
DSLAM OR CENTRAL OFFICE LOCATION—ADDRESS DATA ................................................................................ 23 
DSLAM OR CENTRAL OFFICE LOCATION—XY DATA ........................................................................................ 23 
DSLAM OR CENTRAL OFFICE LOCATION—GIS DATA ........................................................................................ 23 
BROADCAST TOWER LOCATION—ADDRESS DATA ......................................................................................... 28 
BROADCAST TOWER LOCATION—XY DATA .................................................................................................. 28 
BROADCAST TOWER LOCATION—GIS DATA ................................................................................................. 28 

LINEAR DATA ............................................................................................................ 35 

TIGER® STREET SEGMENTS—LIST, SPREADSHEET OR GIS DATA ......................................................................... 35 

POLYGONAL DATA .................................................................................................... 39 

COVERAGE AREA—PDF/JPG/OTHER IMAGE FORMAT .................................................................................... 39 
COVERAGE AREA—KML/KMZ .................................................................................................................. 40 
COVERAGE AREA—CAD DATA .................................................................................................................. 41 
COVERAGE AREA—GIS DATA ................................................................................................................... 41 
COMPACT POLYGON FROM SUBSCRIBER POINTS ........................................................................................... 42 
CENSUS BLOCKS—LIST OR SPREADSHEET .................................................................................................... 44 
CENSUS BLOCKS—GIS DATA .................................................................................................................... 45 

METADATA TRANSACTIONS ........................................................................ 47 

DATA PROCESSING ...................................................................................... 49 

DATA PROCESSING OVERVIEW ................................................................................. 49 

WEIGHTED NOMINAL SPEED ..................................................................................... 50 

SUBSCRIBER DATA SUPPLIED BY PROVIDER .................................................................................................. 50 
VALUE SUPPLIED BY PROVIDER ................................................................................................................. 50 

MIDDLE MILE ........................................................................................................... 50 

BROADBAND COVERAGE TEMPLATE ......................................................................... 51 

VERIFICATION AND VALIDATION .............................................................................. 52 

PROVIDER VALIDATION—PROVIDER PORTAL/PDF MAP REVIEW ....................................................................... 52 
PROVIDER VERIFICATION—THIRD PARTY SOURCE REVIEW .............................................................................. 52 
ASSIGNING CONFIDENCE VALUES .............................................................................................................. 53 



                                                                               

       Version 2.0         September 2011 Author: Kristin Rousseau 
       Page 4 

COMMUNITY ANCHOR INSTITUTION (CAI) DATA ....................................................... 54 

DATA COLLECTION ................................................................................................................................ 54 
INSTITUTION DATA ................................................................................................................................ 54 
COMMUNITY ANCHOR INSTITUTION (CAI) PORTAL UPDATES ............................................................................ 55 

PRODUCT EXTRACT...................................................................................... 55 

PYTHON SCRIPTS ...................................................................................................... 55 

PRODUCT EXTRACT PROCESS .................................................................................... 55 

PRODUCT STATISTICS ............................................................................................... 56 

QUALITY ASSURANCE .................................................................................. 57 

QC SUITE .................................................................................................................. 58 

CONFIGURATION .................................................................................................................................. 58 
LIBRARIES ........................................................................................................................................... 58 
QC SUITE ............................................................................................................................................ 59 
OTHER ............................................................................................................................................... 59 

PROCESS OPERATION AND MONITORING .................................................... 59 

BDIA PRODUCT CREATE ............................................................................................ 59 

PRODUCT VALIDATION AND STATISTICS ................................................................... 62 

PRODUCT EXTRACT DATA DELIVERY ............................................................ 63 

 



                                                                               

       Version 2.0         September 2011 Author: Kristin Rousseau 
       Page 5 

 

OVERVIEW 

This white paper highlights the Submission Summary for this deliverable, as well as describes the Data Gathering, 
Data Integration, Data Validation and Verification and Quality Control processes used to create the Broadband 
Mapping Project’s October 1, 2011 data submission. To support varying levels of technical and program 
knowledge, both a high-level summary and a detailed process review are supplied. 
 

SUBMISSION SUMMARY 

PROVIDER DETAILS 

PROVIDER PARTICIPATION 

 Providers Included (listed by Provider and Holding Company name) 
 

360networks 
 

Frontier Communications of America 
 

SCIO Mutual Telephone Assn. 

AboveNet Communications Inc. 
 

Gervais Telephone Company 
 

SCS Communications and Security Inc 

Alyrica 
 

Gorge Networks 
 

Sprint Nextel Corp 

AT&T Communications of the Pacific 
Northwest Inc  

Helix Telephone Company 
 

St Paul Telephone 

Axxis Communications 
 

Hughes Network Systems 
 

Starband Communications Inc / Spacenet 

Bend Cable Communications, LLC 
 

Integra Telecom of Oregon Inc 
 

Stayton Cooperative Telephone Co (SCTC) 

Broadband Cable Telecommunications LLC 
Beaver Creek Telephone Company  

J & N Cable Systems, Inc. 
 

Stephouse Holdings Company llc 

Cal-Ore Communications Inc. 
 

Level 3 Communications LLC 
 

T-Mobile 

Canby Telephone Association 
 

Lightspeed Networks Inc. 
 

Tanager Telecommunucations (Sawnet) 

Cascade Networks, Inc. 
 

McMinnville Access Company (OnlineNW) 
 

TDS Telecom 

Cascade Utilities 
 

Molalla Communications 
 

Tillamook - CoastCom, Inc 

Casco Communications 
 

Monitor Cooperative Telephone Company 
 

Trans-Cascades Telephone 

CenturyLink 
 

Monmouth Independence Networks (MINet) 
 

TW Telecom of Oregon LLC 

Chambers Cable 
 

Monroe Telephone Company 
 

Umpqua Indian Development (Rio Net) 

Charter Fiberlink OR - CCVII LLC 
 

Mount Angel Telephone 
 

Upward Access Support 

City of Sandy 
 

Nehalem Telecommunications Inc (RTI) 
 

Verizon Wireless 

Clear Creek Telephone & TeleVision 
 

North-State Telephone Co. 
 

Warm Springs Telecommunications  

Clearwire 
 

Oregon-Idaho Utilities Inc 
 

Wave Division Holdings LLC  

Colton Telephone 
 

Oregon Telephone Company 
 

Webformix 

Comcast Cable Communications, LLC 
 

Oregonfast.net 
 

Whiz to Coho Inc 

Comspan Communications, Inc. 
 

Peoples Telephone Co 
 

WildBlue Communications Inc. 

Country Vision Cable 
 

Pine Telephone Systems, Inc. 
 

Wtechlink Wireless Broadband 

Covad Communications Company 
 

Pioneer Consolidated, Inc. 
 

XO Communications Services Inc. 

CP NW 1 LLC (Broadstripe) 
 

PocketiNet Communications, Inc. 
  

Crestview Cable 
 

Qlife 
  

Cricket Communications 
 

Quantum Communications 
  

Douglas Services, Inc/Douglas Cooperative 
 

Qwest Communications Corp 
  

Eastern Oregon Telecom 
 

Roome Telecommunications, Inc. 
  

Freewire Broadband 
 

Rural Network 
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 New Providers Since Last Data Submission 

 Hughes Network Systems – Satellite  

 Oregon-Idaho Utilities, Inc. 

 Silver Star Telecom LLC 

 Windwave Technologies, Inc. 
 
 

 Non-Responsive Providers 

 Air Speed LLC 

 Bendtel Inc. 

 Eagle Telephone System, Inc. 

 Eaglecap.Net LLC 

 Hunter Communications Inc. 

 Nextnet Telecom Inc 

 Preferred Connections Inc NW 

 Tillamook Lightwave 

 Vertex Group Inc. 

 X5 PDX LLC 

 Yellow Knife Wireless 
 
 

 Non-Cooperative Providers  

 Blue Mt TV Cable Co 

 Cogent Communications Group 

 Comspan Communications, Inc. 

 Gorge Ventures Inc 

 Meritel Group Inc 

 NextGen Internet Systems, Inc. 
 
 

 Other Provider Changes 

 CenturyLink and Qwest have merged and submitted separate data for this round with the same 
FRN.  Data was aggregated into one footprint and the Qwest provider name was removed. 
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COVERAGE AREA CHANGES 

 Coverage Footprint Reductions/Map Refinement –  

 Douglas Services, Inc. (TT-50) 

 Integra – TT-10, 20 and 30 

 J & N Cable Systems, Inc. (TT-30) 

 Tanager – TT-70 
 

 Coverage Footprint Expansion – 

 360 Networks (USA) Inc. – Increase in Middle Mile 

  Ashland Fiber Network  (TT-41 and TT-50) 

 Beaver Creek Telephone Company (TT-41 and TT-50) 

 Cableone (TT-41) 

 Cal-Ore Communications Inc. (TT-50) 

 Canby Telcom (TT-10, TT-20, TT-30, TT-50) 

 CenturyLink (TT-10) 

 Chambers Cable (TT-41) 

 Comcast (TT-40) 

 Covad Communications Company (TT-10, TT-20, TT-30) 

 Crestview Cable (TT-41) 

 Datavision Communications (TT-50) 

 Eastern Oregon Telecom (TT-10) 

 Frontier Communications Northwest Inc. (TT-10) 

 Integra Telecom  (TT-10, TT-20, TT-30) 

 LS Networks (TT-30 and TT-50) 

 Mount Angel Telephone Company (TT-10) 

 New Edge Network (TT-30) 

 North-State Telephone Co.  (TT-50) 

 Pine Telephone Systems, Inc.  (TT-10 and TT-50) 

 QualityLife Intergovernmental Agency (TT-50) 

 Quantum Communications   (TT-20, TT-30, TT-50) 

 SCIO Mutual Telephone (TT-10 and TT-50) 

 SawNet (TT-50) 

 Stayton Cooperative Telephone Company (TT10 and TT-50) 

 TW Telecom of Oregon LLC (TT-30 and TT-50) 

 Verizon Wireless (TT-80) 

 Wave Broadband (TT-41) 

 XO Communications Services, Inc. (Affiliated Entity) (TT-30) 
 

 

DATA CORRECTIONS 

 Comcast coverage data included in the spring data submission did not represent its 
complete coverage area, which was corrected with receipt of census block data from 
Comcast.  Coverage has been validated by provider for dataset 4 submission. 
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COMMUNITY ANCHOR INSTITUTION (CAI) DETIALS 

OVERALL STATISTICS 

Community Anchor Institution - Categories 
Overall 
Count 

Broadband 
Subscriber 

(1 or 2) 

Trans 
Tech 

Advertised 
Speed Down 

Advertised 
Speed Up 

Category 1 - School K through 12 1616 359 349 318 318 

Category 2 - Library  189 185 185 177 177 

Category 3 - Medical/Healthcare 342 12 9 5 5 

Category 4 - Public Safety 1135 238 114 65 65 

Category 5 - Universities/Colleges 69 38 37 34 34 

Category 6 - Other:  Government 227 43 38 34 34 

Category 7 - Other:  Non-Government  19 3 1 1 1 

Total 3597 878 733 634 634 

 

 

CAI CHANGES 

 

 The overall inventory was reviewed and updated to include institutions that were previously 
missed or that are new and to remove or add institutions to correctly represent categories 6 or 7 
as defined by Oregon.  

 Additional broadband attribution was collected and mapped mainly for Schools and Libraries; 
although broadband attribution improved within all categories. 

 Another change was the inclusion of CAIIDs to the CAI Inventory for Category 1: K-12 Schools, 
Category 2: Libraries and Category 5: Colleges, which were extracted from the three databases 
communicated by NTIA.  These databases are as follows: 
 

 For K-12 institutions (CAI type 1) please add the NCES ID CCD ID value found here: 

http://nces.ed.gov/ccd/bat/  

 

 For Higher Education (CAI type 5) please add the NCES IPEDS ID value found here: 

http://nces.ed.gov/ipeds/datacenter/  

 

 For Libraries (CAI  type 2) please. Combine (do not add) “FSCSKey” and “FSCs_SEQ” from the 

“puout08av2000” file and place them here: 

http://harvester.census.gov/imls/data/pls/index.asp (FYI the LIBID is your state’s unique ID 

for libraries) 

 

  

http://nces.ed.gov/ccd/bat/
http://nces.ed.gov/ipeds/datacenter/
http://harvester.census.gov/imls/data/pls/index.asp
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SUBMISSION RECEIPT 

SUBMISSION RECEIPT RESULTS 

 Attached are the results from the NTIA data submission receipt quality script. 
  

 
 Error Report 

 The only item flagged in the submission receipt output is the following error, which has been 
verified as containing correct entries within the data submission.   
 

 Field Check:     FAILED      CAInstitutions_TRANSTECH has 2679 UNEXPECTED VALUES for 
query: TRANSTECH <> 0 AND TRANSTECH <> 10 AND TRANSTECH <> 20 AND TRANSTECH <> 
30 AND TRANSTECH <> 40 AND TRANSTECH <> 41 AND TRANSTECH <> 50 AND TRANSTECH 
<> 60 AND TRANSTECH <> 70 AND TRANSTECH <> 71 AND TRANSTECH <> 80 AND 
TRANSTECH <> 90 AND TRANSTECH <> 0 

 

 This was flagged due to an inconsistency between the data model and the submission 
receipt script, which has also been communicated by other Grantees on PBWorks.  

 
Hyperlink to Grantee Workspace in which the same issues were identified by other Grantees: 
https://sbdd-granteeworkspace.pbworks.com/w/page/42442088/Data%20Model%20Issues-June2011  

  

https://sbdd-granteeworkspace.pbworks.com/w/page/42442088/Data%20Model%20Issues-June2011
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HIGH-LEVEL SUMMARY 

DATA GATHERING 

BROADBAND SERVICE AREAS, MIDDLE MILE AGGREGATION POINTS AND 
BROADBAND SERVICE OVERVIEW 

The collection of Broadband Service Areas, Middle Mile Aggregation Points and Broadband Service 
Overview information is handled through the following Provider Outreach Process: 

 Build and maintain an inventory of Broadband providers through research and State inputs. 

 Update provider material that describes the data requirements and logistics for data transfer. 

 Update Non-Disclosure Agreement (NDA) for use in project, where applicable. 

 Maintain multiple protocols for the provider to submit data, including Secure File Transfer Protocol 
(SFTP) technology when desired. 

 Conduct one-on-one informational discussions with each provider to communicate the following: 
o Requirements of this project; 

o Broadband data required to support the product data model; 

o Submission protocols available; 

o Capability to validate how the supplied data is aggregated. 

 Download/receive provider data. 

 Establish a repeatable process with provider. Maintain provider communication, transaction and data 
handling records throughout the project (dates contacted, data received, etc.).  

 

COMMUNITY ANCHOR INSTITUTION (CAI) 

The collection of CAI information is handled through the following CAI Collection Process: 

 Collect and maintain an inventory of current CAIs through Grantee input and data mining, 

 Collect and maintain CAI inventory attribution through anchor institution input using a web-based CAI 
portal, CAIID databases and state agencies. Upload data from the CAI portal to Core Database for 
standardization to NTIA data model, where needed. 

 Perform internal data cleansing, such as removing duplicate records, identifying gaps or errors in 
broadband attribution and verifying category. 

 Geocode CAI locations. 

 Translate Core Database data to deliverable-ready format. 

 Continued dialog with Grantee on accuracy of inventory and the collection of broadband attribution 
from non-responsive institutions. 
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DATA INTEGRATION PROCESS 

The data integration and processing mechanisms currently used allow for multiple types of inputs and result in 
a standardized output that meets the NTIA deliverable requirements. This flexible process supports data 
model changes and project-requested enhancements. 

 Receive inputs from providers via submission protocols; upload into Sourcing Database and catalog 
with provider information. 

 Review provider-supplied data for completeness and for potential discrepancies that require 
resolution prior to processing and flag as necessary. 

 Categorize input into data-type category (addresses, block lists, paper maps, etc.). 

 Standardize input based on data type within Staging Database. 

 Create Compact Polygons (CP)—(internal methodology for generating area-based feature for 
coverage in Staging Database). 

 Apply broadband attribution to CP; apply metadata to CP. 

 Perform quality analysis of the CP against the source supplied to identify any completeness or 
accuracy issues. 

 Request additional information from the provider if elements of coverage are missing or contain 
discrepancies. This is a second manual quality check to ensure data is complete. 
o Process coverage area to build the required NTIA data model layers.  

 Process CAI data input into internal standardized format, as discussed above in the Community 
Anchor Institution (CAI) subsection, based on NTIA and State-level requirements. 

 

DATA VALIDATION AND VERIFICATION 

Following the creation of the product, process steps within Data Validation and Verification occur. To ensure 
the data collected and processed is as accurate and comprehensive as possible, provider validation and 
internal verification activities are employed. After the initial mapping of providers’ coverage areas and 
serviceability claims, additional reviews are performed using the methods described in the subsections below 
(Third-Party Data Verification, Broadband Provider Validation, Confidence Values). 
 

THIRD-PARTY DATA VERIFICATION 

The coverage is visually and programmatically compared against third-party data. Pitney Bowes and 
American Roamer data are used in cases where a coverage area is questionable. All anomalies identified 
during this analysis are reviewed with the providers. 

 

BROADBAND PROVIDER VALIDATION—PROVIDER PORTAL APPLICATION 

Providers are trained on and requested to use a secure interactive web application to review their current 
coverage area(s) and supporting broadband attribution and validate their data or submit change requests 
to update their data. All provider change requests go through the Data Integration Process and are 
reviewed with the provider to complete validation. 
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CONFIDENCE VALUES 

All verification, validation and manual quality review results are tracked by provider/technology type and 
stored and maintained within a Validation table. A confidence value is assigned, based on internal 
assessments of the collected information, to highlight the provider coverage areas and/or attributions 
that would benefit from further investigation and/or enhancements. 

 

QUALITY CONTROL 

Following collection, processing and analysis of the provider and CAI data, the product is checked manually 
and algorithmically against the NTIA data model. Some of the items included within these checks are: 

 Format correctness; 

 Table and field structure; 

 Valid values, including default values, where applicable; 

 Geographic extent and topology errors. 
 
Prior to data submission, another quality control script supplied by NTIA is run. This script, 
SBDD_CheckSubmission.py, creates an output in text form that is required to be submitted along with the final 
deliverable. All errors must come up clean, unless otherwise specified by NTIA. Exceptions to the script as 
noted by NTIA on the SBDD Workspace on 03/25/11 can be found at the following link: https://sbdd-
granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions  

 Longitude values for States outside the lower 48 (any table); 

 CAI results for Transtech, MaxAdUp, MaxAdDown if BBService is “No” or “Unknown”; 

 Overview MaxAdDown, MaxAdUp if 100% of record-level data has MaxAdDown or MaxAdUp 
populated. 
  

https://sbdd-granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions
https://sbdd-granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions


                                                                               

       Version 2.0         September 2011 Author: Kristin Rousseau 
       Page 13 

DETAILED PROCESS REVIEW 

A detailed review of the data collection, integration and quality control points within the broadband data gathering 
and mapping process are discussed in the subsections that follow. In addition, a diagram showing the overall 
process can be seen below. 

 
 

PROVIDER OUTREACH 

For the October 2011 data submission, an e-mail notification was sent to all providers with supporting 
deliverable dates. The providers mainly used the Provider Portal web application to submit changes to and/or 
validate their current coverage area(s). 

 
In support of the data collection effort, providers that did not timely respond to the outreach were contacted 
by phone. 
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OUTREACH MATERIALS 

The original provider packet sent via e-mail to the providers included the following documents and files: 

 Letter from the State inviting them to participate in the program; 

 Copy of the Non-Disclosure Agreement (NDA); 

 Copy of the Mapping NOFA from the NTIA; 

 Copy of the NOFA Clarification from the NTIA; 

 Broadband service address example file in CSV format; 

 Word document describing service address example file; 

 Broadband service block example file in CSV format; 

 Word document describing service block example file; 

 Broadband service street example file in CSV format; 

 Word document describing service street example file; 

 Broadband subscriber example file in CSV format; 

 Word document describing subscriber example file; 

 Broadband wireless coverage area sample shapefile; 

 Word document describing wireless coverage area sample shapefile; 

 Instructions for downloading, installing and using the WinSCP SFTP application. 
 

OUTREACH PROCESS 

The provider outreach process is comprised of the following general steps: 

 Send the provider package and introduction letter to the main point of contact for the provider. 

 Follow up with e-mail and telephone to verify that the main point of contact is correct. 

 If necessary, discuss the NDA further and resolve any redlines. 

 Once the correct primary contact is established, set up a telephone call, if necessary, to learn more 
about the provider’s offerings and direct them to the appropriate outreach materials. 

 If providers are unable to be contacted (non-responsive) or indicate that they are not interested in 
participating (non-cooperative), mark them as such on the provider tracking sheet. These providers 
will be escalated to the State for further action. 

 As the providers are collecting the required data, provide instructions on downloading, installing and 
using the WinSCP SFTP application, if required. 

 Arrange with the providers to transfer the data in whatever way they are comfortable: some 
providers will find regular email acceptable; others will want to use the SFTP application. 

 After data is received and reviewed, it may be necessary to contact a provider for clarification or to 
address incomplete datasets. In the interest of building and maintaining relationships, care is given 
not to push the provider but to work with it to obtain accurate data in the best possible format. 
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DATA COLLECTION 

DATA TRANSFER PROCEDURES 

There are three primary ways data is collected from providers. These are: 

 Secure FTP (SFTP) using the WinSCP application; 

 Regular e-mail; 

 Mail. 
 

INITIAL DATA REVIEW AND QUALITY ASSURANCE 

The initial data review and quality assurance process consists of the following general steps: 
1) Access the data from the SFTP site or e-mail. 

a. If e-mailed, place copy of original dataset in the appropriate provider folder on the SFTP site. 
2) Place copy of raw data on local computer in a working directory. 
3) Review data and determine course of action based on type of data received. 
4) Ensure data is complete and contact provider to address any gaps. 

 

NOTE: 
The goal is to get as many providers as possible to provide subscriber address data in the correct format. 
Obviously, this will not be possible with all providers so we will continue to have to process various types of 
provider-supplied data. 

 

DATA INGESTION 

DATA INGESTION OVERVIEW 

The following subsections outline the process steps taken based on the type of input supplied by the data 

provider: 

 Point Data: 
o Subscriber location; 
o DSLAM location; 
o Central Office location; 
o Broadcast Tower location. 

 Linear Data: 
o TIGER® street segments. 

 Polygonal Data: 
o Census Blocks; 
o Coverage Area. 

Overall, the process is geared toward taking the provider data supplied and creating polygon shapes to 
append to the bb_cov feature class. The bb_cov feature class is the interim dataset that is then processed 
using the makeDeliverable.py Python script to create the MapConnect

TM
 data layers that will be delivered 

to the State and, ultimately, to the NTIA. Detailed instructions used in this process can be found in the 
subsections below. 
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POINT DATA 

SUBSCRIBER LOCATION—ADDRESS DATA 

In the event that the data provider supplies subscriber address data, the steps are as follows: 
1) First, convert the address data to a clean Excel spreadsheet in an appropriate address data 

format. 
a. Usually, this has the following columns: street address (number, pre-directional, pre-

modifier, street name, street type, post-directional and post-modifier concatenated), city, 
state, ZIP. 

2) Configure the ArcGIS® geocoding tool to use the TIGER® 2009 streets dataset. 
a. In ArcCatalog®, create a new Address Locater by right-clicking in the white space of the 

appropriate directory and selecting New>Address Locater from the dropdown menu. 
b. Select US Streets with Zone and click OK. 

 

NOTE: 
It is likely that multiple Address Locators will have to be set up to handle the variety of provider address data 
received. 
 

c. Navigate to the TIGER Streets 2009 file and click OK. 
d. Fill in the dialog box, as shown below: 
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e. Click OK. 
3) Open ArcMap® and add the Excel spreadsheet with the address information. 
4) Right-click on the Excel spreadsheet and select Geocode Addresses from the dropdown menu. 
5) Select the appropriate address locator by clicking Add…, then OK. 

 

6) Fill out the Geocode Addresses dialog box, as shown below: 

 

7) Geocode the list in batch mode using the geocode service set up in Step 2 above, accepting all 
the default parameters. 

8) Review results. See example below. 
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9) Adjust geocoding parameters accordingly and repeat batch to resolve issues. 
10) Manually geocode unmatched addresses until target hit rate achieved, generally 90%. 
11) Visually inspect the data, as shown below: 

 

12) Follow the steps detailed in Subscriber Location—GIS Data below. 
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SUBSCRIBER LOCATION—XY DATA 

If the provider supplies a list of subscriber data with accompanying XY data such as latitude and 
longitude, the steps are as follows: 

1) Refine the format in Excel so that the data can be opened easily using ArcMap®. 

a. Remove all font color, highlighting, cell colors and borders, clean up column headers and 
make certain there are no merged cells. 

b. Make certain that XY locations are in decimal degrees. 
(i.) To convert from degrees, minutes, seconds (39º 26’ 45.67”) to decimal degrees, use the 

following formula: DD + (MM/60) + (SS.SSS/3600). 
 

NOTE: 
If XY locations from some other coordinate system are provided, you can use those in the process below but you 
must know what the coordinate system is. 
 

2) Open the Excel worksheet in ArcMap®. 

3) From the menu bar, select Tools>Add XY Data… 

 

4) Supply the appropriate fields for the X and Y coordinates, choose the appropriate coordinate 
system and click OK. 

5) Results are an event layer, not a true spatial layer. Export the data by right-clicking the event 
layer and selecting Data>Export Data… from the dropdown menu. 

6) Follow the steps detailed in Subscriber Location—GIS Data below. 
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SUBSCRIBER LOCATION—GIS DATA 

If the provider supplies subscriber location in GIS format, the only process step is to load that data 
into the appropriate data schema and it will be ready for processing. 
1) First, load the data into the Point Address database schema (please see Appendix D for an 

example of the Point Address database schema.) using an empty feature class in that schema. 

2) In ArcCatalog®, right-click on the empty feature class and select Load from the dropdown menu. 

3) Navigate to the provider address GIS dataset and then map the attribute fields accordingly, as 
shown below: 

 

4) Once you have successfully loaded the provider address data into the temporary database with 
the correct schema, you now will append that data to the overall Point Address database. 

5) In ArcToolbox®, use the Append command (Data Management Tools>General> Append) to add 
the features into the overall Point Address database, as shown below: 
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6) Since the data is already in the Point Address database schema, there is no need to alter the Field 
Map in the Append tool. 

7) After appending, calculate metadata reflecting geometry source and representation values. 
8) Break provider-specific points into separate county feature classes and perform the following 

steps per county feature class: 
a. Within ArcGIS®: 

(i.) Summarize download and upload speeds [first,last] to determine all speeds available for 
county. 
(1) This will save as a DBF table. Keep track of location for future reference. 

(ii.) Buffer county address point featureclass to 150’. 
(1) During buffer command, dissolve on ad_down; ad_up; provider; dba; frn; tt; all 

metadata fields; stctyfips. Save as…. county_fastestdown_fastestup.  
(2) Example using Qwest data: boulder_40128_20128, where boulder=county; 

40128=ad_down; 20128=ad_up. 
 

NOTE: 
These attribute fields are specific to the Point Address database. 
 

(iii.) Select the features that represent the lowest speeds. 
b. Using XtoolsPro (http://www.xtoolspro.com/): 

(i.) In the XTools Pro toolbar, select XTools Pro>Layer Operations>Erase Features. 
(ii.) Use the same feature class for Input and Overlay. 
(iii.) Check Use selected features on the Input feature, as shown below. 
(iv.) Repeat and erase slowest speeds one speed at a time. Save each new feature class as 

the next slowest speed, using the same naming convention as shown in a.(ii.)(1) above. 
A general example is shown below: 
  

http://www.xtoolspro.com/
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c. Return to ArcGIS®: 
(i.) Edit/delete speeds from the attribution table of each feature class, so each remaining 

feature class has only one speed value. 
(ii.) Merge individual speed feature classes using the Merge command in ArcToolbox® (Data 

Management Tools>General>Merge). The dialog box is shown below:  

 

(iii.) Merge individual county feature classes using the Merge command in ArcToolbox (Data 
Management Tools>General>Merge). 

(iv.) Since the county files are all in the same schema, DO NOT alter the Field Map portion of 
the command interface. 
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(v.) When all the county files are merged into one dataset, use the Append command in 
ArcToolbox® (Data Management Tools>General>Append) to add the features to the 
bb_cov interim dataset. Use the Field Map portion of the Append tool to map the 
appropriate field values to their corresponding fields in the bb_cov feature class. 

DSLAM OR CENTRAL OFFICE LOCATION—ADDRESS DATA 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central 
Office address data, the steps are as follows: 
1) Follow the process for geocoding points in Subscriber Location—Address Data above. 
2) Follow the steps detailed in DSLAM or Central Office Location—GIS Data below. 

DSLAM OR CENTRAL OFFICE LOCATION—XY DATA 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central 
Office XY data, the steps are as follows: 
1) Follow the process for creating points from XY data in Subscriber Location—XY Data above. 
2) Follow the steps detailed in DSLAM or Central Office Location—GIS Data below. 

DSLAM OR CENTRAL OFFICE LOCATION—GIS DATA 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central 
Office GIS data, the steps are as follows: 
1) Buffer the DSLAM/Central Office points feature class. 

a. Add the point feature class to ArcMap®. 

b. Open the ArcToolbox® and go to Analysis Tools>Proximity>Buffer. 

c. Set the buffer distance to 5 miles. 
d. Set the dissolve type to ALL. 
e. Name the output feature class. 
f. Typical Buffer tool is shown below: 
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g. Click OK. 

2) Use the resulting buffer feature class to clip the TIGER® street layer: 

a. Add TIGER® street layer to ArcMap®. 

b. Open the ArcToolbox® and go to Analysis Tools>Extract>Clip. 

c. Complete the dialog box as shown below: 

 

d. Click OK. 

3) Using ArcCatalog® and within the file geodatabase: 

a. Right-click and create a new Feature Dataset.  
(i.) For the Feature Dataset settings: 

(1) Name the feature dataset accordingly. 
(2) Select horizontal coordinate system by importing the coordinate system associated 

with the clipped TIGER® street layer by selecting Import and navigating to the 

location of that feature class. 
(3) No vertical coordinate system needed. 
(4) Leave all x,y,z,m values at default. 
(5) Click Finish. 

4) Import previously created street feature class into new Feature Dataset. 
5) Right-click Feature Dataset and create new Network Dataset—accept all default setting for the 

Network Dataset. 
 

NOTE: 
The Network Analyst extension must be turned on. 
 

6) In ArcMap® turn on the Network Analyst Toolbar by going to View>Toolbars>Network Analyst. 

7) Add the Network Dataset created in Step 5 to ArcMap. 
8) Using the Network Analyst Toolbar dropdown, create New Service Area. 

9) Open the Network Analyst Window by selecting the  button. See below. 
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10) Right-click Facilities layer, select Load Locations and navigate to the DSLAM/Central Office 
facilities feature class. 

 

11) Click OK. 

12) Click the Service Area Properties button . 
13)  For the following tabs, change the following properties: 

a. Polygon Generation tab:  
(i.) Select Merge by break value.  
(ii.) Also disable the Trim Polygons option. 

b. Analysis Settings tab—using and converting the specified DSLAM buffer distance from feet 
to meters—input buffer distance value in meters into the Default Breaks location. 
(i.) Generally, 18,000 feet (5486 meters) from DSLAM or Central Office location is used as 

the buffer distance. See below. 
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c. Click OK. 

14) On the Network Analyst Toolbar, click the Solve button  to create service area polygons. 
15) Right-click on the created service area polygon in the layer list, and select Data>Export Data from 

the dropdown list. 
16) Export to a feature class in the file geodatabase you created earlier. 

17) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the feature class created in Step 16 into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click the Add button, then click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 
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e. Click Next, then Next again, then Finish. 

18) In ArcToolbox®, go to Data Management Tools>General>Append. 

19) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 

 

20) Leave the Schema Type as TEST. 
21) Click OK. 

22) In ArcMap®, open bb_cov for editing and manually input associated attribution. 
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BROADCAST TOWER LOCATION—ADDRESS DATA 

In the event that the provider supplies wireless broadcast tower location address data, the steps are 
as follows: 
1) Follow the process for geocoding points in Subscriber Location—Address Data above. 
2) Follow the steps detailed in Broadcast Tower Location—GIS Data below. 

BROADCAST TOWER LOCATION—XY DATA 

In the event that the provider supplies wireless broadcast tower location XY data, the steps are as 
follows: 
1) Follow the process for creating points from XY data in Subscriber Location—XY Data above. 
2) Follow the steps detailed in Broadcast Tower Location—GIS Data below. 

BROADCAST TOWER LOCATION—GIS DATA 

In the event that the provider supplies wireless broadcast tower location GIS data, the steps are as 
follows: 
1) Download the required software (Radio Mobile) from the website: 

http://www.cplus.org/rmw/english1.html  
2) Install the software according to the standard directions, found here: 

http://www.cplus.org/rmw/download/download.php?S=1  
3) Open the application. 
4) Load the broadcast tower location and elevation information by selecting File>Unit properties. 

The following dialog box appears: 

 

5) Add the information for all the towers supplied by the WISP data provider, including the 
elevation. If provider does not supply elevation, this information can be obtained from Google 
Earth. 
a. If available, use the Import button to import a Google Earth KML of the tower locations. 

6) Go to the National Map Seamless Server (http://seamless.usgs.gov/) and download elevation 
data sufficient to contain the tower locations. 

http://www.cplus.org/rmw/english1.html
http://www.cplus.org/rmw/download/download.php?S=1
http://seamless.usgs.gov/
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a. At least the 1/3” NED data is needed. Select this by clicking the Download button in the 
upper right of the website and checking the box next to 1/3“ NED. 

b. Zoom to the area of interest and use the Download tools to define the area to download: 

 

c. Click the Modify Data Request button to request the data in BIL_16INT format, not ESRI 
GRID, as shown below: 

 

d. Download the data and unzip it. 
7) Select File>Map Properties to define the map. 
8) Enter a latitude and longitude in the center of the tower locations. 
9) Set the size (in pixels) and the size (in kilometers) of the map. 
10) Set the directory path leading to the BIL elevation data just downloaded. 
11) The dialog box is shown below: 
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12) Click Extract. 
13) The elevation data is rendered as a hill shade, as shown below: 

 
14) Select File>Network properties from the main menu. 
15) Create a new network and enter in the frequency range under the Parameters tab, as shown 

below: 
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16) Leave all the other values as they appear, and select the Systems tab. 
17) Create enough systems to cover all the varieties of equipment in the provider network. This will 

include the antenna type, height and line loss, as shown below: 
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18) Now click on the Membership tab, and assign the individual towers to their respective systems, 
providing the azimuth for non-omnidirectional antennas, as shown below: 

 
19) Click OK. 
20) Select Tools>Radio Coverage>Combined Cartesian from the main menu. 
21) Complete the dialog box as shown below, providing the Maximum Range from the highest tower 

beam radius supplied by the provider. 
22) Set the Pixel Size at 5 (experiment depending on the area covered to get the right level of 

granularity), as shown below: 

 
23) Set the Signal range to draw to S-Unit and type 5 in the From (>=) box. 
24) Click on Draw. See below. 
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25) Save the resulting image as a TIF by selecting File>Save Picture as. 
26) Open ArcMap® and load the BIL elevation data you used in Radio Mobile. 
27) Load the TIF image you created and georeference it using the corners of the BIL data. 

a. The corners of the data can be seen in the TIF image. 
28) Follow the georeferencing directions from the Coverage Area—PDF/JPG/Other Image Format 

section below. 
29) Use the Georeferencing Toolbar to Update the Georeferencing for the TIF dataset. 
30) In ArcToolbox®, select Data Transformations>From Raster>Raster to Polygon and input the 

georeferenced TIF you just created, as shown below: 
31) Open the resulting polygon feature class for editing using the Editing toolbar in ArcMap® and 

clean up as necessary. 
32) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the feature class created above into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click the Add button, then click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 
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e. Click Next, then Next again, then Finish. 

33) In ArcToolbox®, go to Data Management Tools>General>Append. 
34) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 

 
35) Leave the Schema Type as TEST. 
36) Click OK. 

37) In ArcMap®, open bb_cov for editing and manually input associated attribution. 
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LINEAR DATA 

TIGER® STREET SEGMENTS—LIST, SPREADSHEET OR GIS DATA 

In the event that the provider supplies TIGER® street segments in list or spreadsheet format, the 
steps are as follows: 
1) Join TIGER® road segments to 2000 census blocks feature class using one of two methods based 

on how the data is provided: 
a. If the TIGER® data is provided with a Census Block ID, then join the segments to the Census 

Block geometry based on that ID: 
(i.) Load both datasets into ArcMap®; 
(ii.) In the layer list, right-click on the 2000 census block feature class and select Joins and 

Relates>Join; 
(iii.) In the dialog box, select the TIGER® road segments data and the proper attribute fields 

for joining, as shown below: 

 
(iv.) Click OK. 

b. If the data provided is a list containing TLIDs, then join to the TIGER®/Line data using the 
TLID, and use a spatial join to associate the TIGER® segment with the coterminous block 
based on the block ID: 
(i.) Load both datasets into ArcMap®; 
(ii.) In the layer list, right-click on the 2000 census block feature class and select Joins and 

Relates>Join; 
(iii.) Select Join data from another layer based on spatial location from the dropdown 

menu; 
(iv.) Complete the dialog box, as shown below and click OK. 
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2) Export joined records into a temporary feature class. 
3) If joined Census Block geometry is confined to one specific area, then dissolve blocks into one 

record. If joined Census Block geometry is distributed throughout a particular State, then dissolve 
sub-selections of census blocks for each county. 
a. Use the County FIPS code to dissolve by county. 

b. In ArcToolbox®, select Data Management Tools>Generalization>Dissolve. 

c. Complete the Dissolve dialog box, as shown below: 
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d. Click OK. 

4) For each dissolved region, open the feature class for editing using the Editing tool in ArcMap® 

and remove unnecessary slivers and other small holes. For general guidance on editing features 

in ArcMap®, see http://webhelp.esri.com/arcgisdesktop/9.3/pdf/Editing_Tutorial.pdf  

5) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the feature class created above into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click on the Add button, then click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 
 

http://webhelp.esri.com/arcgisdesktop/9.3/pdf/Editing_Tutorial.pdf
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e. Click Next, then Next again, then Finish. 

6) In ArcToolbox®, go to Data Management Tools>General>Append. 
7) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 

 
8) Leave the Schema Type as TEST. 
9) Click OK. 
10) In ArcMap®, open bb_cov for editing and manually input associated attribution if necessary. 

  



                                                                               

       Version 2.0         September 2011 Author: Kristin Rousseau 
       Page 39 

POLYGONAL DATA 

COVERAGE AREA—PDF/JPG/OTHER IMAGE FORMAT 

In the event that the provider supplies coverage area data in some image format such as PDF or JPG 
format, the steps are as follows: 
1) If in PDF format, open in Adobe Acrobat and Save As… JPG format. 

2) Open the JPG image in ArcMap®. 

3) Add the required base map vector data for georeferencing. 

a. This generally will be either the CDOT data or TIGER® data. 

4) Change the coordinate system of the data frame to the desired end coordinate system. 
5) Zoom to the general location of the JPG map image. 

a. This is the location based on the vector data, not the JPG image itself. For example, if you 
know that the JPG image represents an area around the town of Limon, zoom to the town of 
Limon in your vector data. 

6) Open the Georeferencing toolbar by selecting View>Toolbars>Georeferencing from the main 
menu bar. 

7) Using the Georeferencing toolbar, select Fit to Display; results are shown below: 

 

8) Use the Control Point button  to add control points to the map. 
9) Use common points in the base dataset and the JPG image. 

a. For example, find major street intersections, county/city boundaries, etc. 
b. Try to distribute the points more or less in the four corners on the image for the best 

transformation. 
10) Click on the location on the image first, then click on the corresponding location on the vector 

database map, as shown in the image below: 
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11) After placing each control point, the image transformation will update automatically.  
12) Repeat until satisfied with the transformation. 

 

NOTE: 
The transformation may take up to four points, although sometimes only two are necessary. 
 

13) When satisfied with the transformation, select Update Georeferencing from the Georeferencing 
toolbar dropdown. 
a. This will create a “world” file (.jgw in the case of JPGs) in the same directory as the image 

file. 

14) In ArcCatalog®, create a new polygon shapefile with the appropriate data schema for a provider 

coverage area, which can be found in Appendix D. 

15) Add the shapefile to ArcMap®. 

16) Using the Editor toolbar, select Start Editing. Set the Task to Create New Feature. 

17) Use the Sketch Tool  to digitize a new coverage polygon using the coverage area outline 
from the georeferenced JPG and add the required attributes manually. 

18) Repeat the above steps for all subscriber speed coverage areas provided. 
19) Follow the steps detailed in Coverage Area—GIS Data below. 

COVERAGE AREA—KML/KMZ 

In the event that the provider supplies coverage area data in Google Earth KML or KMZ format, the 
steps are as follows: 

1) Use a KML to SHP converter to translate file into an Esri® format. 

2) http://arcscripts.esri.com/details.asp?dbid=15603  

3) Download the script and follow the provided instructions for installing it in ArcToolbox®. 

4) Double-click on the script in ArcToolbox® and navigate to the location of the KML file, as shown 

below: 
 

http://arcscripts.esri.com/details.asp?dbid=15603
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5) Add the new shapefile to ArcMap®. Repeat for all KML files provided. 

6) Follow the steps detailed in Coverage Area—GIS Data below. 

COVERAGE AREA—CAD DATA 

In the event that the provider supplies coverage area data in GIS format, the steps are as follows: 

1) Transform the CAD dataset into an Esri® format. 

2) http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datase
ts 

3) It may be necessary to contact the provider first to determine the coordinate system of the CAD 
data. 

4) If the CAD data is not in a standard coordinate system, it may be necessary first to use ArcMap® 

to georeference the CAD data to a known coordinate system. 
a) To do so, follow the instructions provided above in Coverage Area—PDF/JPG/Other Image 

Format. 

5) In ArcCatalog®, create a new polygon shapefile with the appropriate data schema for a provider 

coverage area, which can be found in Appendix D. 

6) Add the shapefile to ArcMap®. 

7) Using the Editor Toolbar, select Start Editing. Set the Task to Create New Feature. 

8) Use the Sketch Tool  to digitize a new coverage polygon using the coverage area outline 
from the georeferenced CAD file and add the required attributes manually. 

9) Follow the steps detailed in Coverage Area—GIS Data below. 

COVERAGE AREA—GIS DATA 

In the event that the provider supplies coverage area data in GIS format, the steps are as follows: 

1) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the GIS feature class either created above or supplied by the provider into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click on the Add button, then click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 

 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datasets
http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datasets
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e. Click Next, then Next again, then Finish. 

2) In ArcToolbox®, go to Data Management Tools>General>Append. 

3) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 

 
4) Leave the Schema Type as TEST. 
5) Click OK. 

6) In ArcMap®, open bb_cov for editing and manually input associated attribution, if necessary. 

COMPACT POLYGON FROM SUBSCRIBER POINTS  

1) Geocode address list using latest State Composite Locator.  
2) Verify that your geocoded file has only one TT (Technology Type). If not, export individual 

geocoded layers for each Technology Type. 
3) For each TT, check for differences in speed values or speed tiers and create separate layers for 

each speed value/tier. 
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4) Clean your geocoding results: remove any points that geocode to accuracy levels below ZIP+4 
(ZIP centroids, carrier route centroids, etc). Also, verify that outliers with acceptable accuracy 
levels are legitimate, i.e., fall in correct city and Zip. 

5) Perform spatial join between county polygons (using stcnyfips field) and the cleaned geocoded 
subscriber points in order to carry the county name and stcnty fips. 

6) Summarize the number of subscribers by county and use the subscriber counts by county to 
populate the Rate Tier table. 

7) Un-join the county data from the geocode subscribers list. 
8) Create Compact Polygon using cleaned geocoded layer or sub-selection of XtoolsPro—

ConvexHull-DetailedHull option. A sub-selection of geocoded points will be used in areas where 
more than one polygon will need to be created for one provider’s service area. 

9) Evaluate output Hull carefully, looking for areas that should not be covered by hull polygon. 
a. If it is determined that an area or areas should not be represented in coverage area, 

manually reshape hull polygon until coverage area is adequate. 
b. When not obvious and as a general rule, manually resolve compact polygon when the 

distance between the subscriber points used to define the outer boundary of the compact 
polygon exceeds 5 miles . When reshaping the hull polygon, snap to the outermost 
geocoded points. See the three figures below for examples. 

      Compact Hull: Manual Resolution Required            
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Compact Hull: Manual Resolution Required                                        Compact Hull: After Manual Resolution        

                      
10) To attribute the compact polygon, perform a spatial join where your Target Feature Class is the 

compact polygon and the Join Feature Class is your geocoded point layer. Export compact hull 
with joined attributes and name file appropriately. 

11) Append attributed compact polygon to Broadband TT template Feature Class and, if required, 
manually input any provider attribution that may not have carried over in the append process. 

12) Intersect compact polygon with county boundaries to create unique records by county and use 
the state-county-fips field to populate stcty_fips field. Also use the county name field to populate 
the BBCov_Name field. 
a. Exception: where a provider’s coverage is distributed throughout more than one area of any 

given county where the BBcov_Name should be populated using an appropriate city or other 
logical name based on geographical location. 

13) Export/load into appropriate BB TT model dataset. 

CENSUS BLOCKS—LIST OR SPREADSHEET 

In the event that the provider supplies census block data in a list or spreadsheet, the steps are as 
follows: 
1) Ensure block polygons supplied by the provider are 2000 currency. 
2) If other currency, convert to 2000 currency before proceeding. 

a. To do this, remove the trailing letter (a, b, etc.) from the block ID. 
b. You will now have two blocks that equate to one block in the 2000 block geometry. 
c. Delete duplicate block IDs, retaining the higher service tier in each case. 

3) Prepare the block list in clean Excel format, removing all Excel-only formatting, merged cells, 
colors, borders, etc. 

4) Import the spreadsheet into ArcMap®. 

5) Right-click on the 2000 census block feature class in the layer list in ArcMap® and select Joins 

and Relates>Join from the dropdown menu. Join the census block list to the 2000 census blocks 
feature class using the block ID and export joined records in a new feature class. The Join dialog 
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box and process can be seen above in the TIGER® Street Segments—List, Spreadsheet or GIS 

Data subsection. 
6) Follow the steps in Census Blocks—GIS Data below. 

CENSUS BLOCKS—GIS DATA 

In the event that the provider supplies census block GIS data, the steps are as follows: 
1) Ensure that the blocks supplied by the provider are in the required data schema and are 

complete as far as required attribution. 
a. If not, manually enter the required attribution or contact the provider to fill gaps. 

2) If census block geometry is distributed throughout more than one county, then select Data 
Management Tools>Generalization>Dissolve in ArcToolbox® and dissolve based on 
County/Provider/TT/Speed Tier so that unique records are created for each unique combination. 
a. The Dissolve dialog box is shown above in the TIGER® Street Segments—List, Spreadsheet 

or GIS Data section. 
b. Two examples of undissolved census block polygons are shown below: 

 
Undissolved census block polygons 

 
Census block polygons dissolved by county 

3) For each dissolved region use the Editing toolbar in ArcMap® to remove unnecessary slivers and 

other small holes. 
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4) In ArcToolbox®, select Data Management Tools>General>Merge and merge the processed 

polygons into a single layer. 
5) The merged census blocks will need to have the subscriber’s frn field added and populated. 

6) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the GIS feature class either created above or supplied by the provider into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click the Add button, the click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 

 
e. Click Next, then Next again, then Finish. 

7) In ArcToolbox®, go to Data Management Tools>General>Append. 

8) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 
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9) Leave the Schema Type as TEST. 
10) Click OK. 

11) In ArcMap®, open bb_cov for editing and manually input associated attribution, if necessary. 

 

METADATA TRANSACTIONS 

Following any updates or changes completed within the file geodatabase (fGDB) stored on the GIS-Analysts 
staging environment, the GIS-Analyst runs transactions to compare that fGDB with the one stored on the Core 
server to ensure metadata on all changes is recorded. 

 
The steps taken to run transactions on the updated Core database are outlined below: 

1) Open a command line window and run generateTransactions.py:  
a. Usage: generateTransactions.py  [Core fGDB] [Staging Environment fGDB]  
b. Example of command line:  

<path>generateTransactions.py <path>ST_BB_POLY_SRV_AREAS.gdb <path>ST_BB_POLY_SRV_AREAS.gdb  
2) Shown below is an example of the output screen that will be displayed: 
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3) After the process has completed, results can be found in the ST_BB_POLY_SRV_AREAS_HIST.gdb:  

a. The transactions scripts records changes at a feature level. 
b. Shown below is a screenshot supporting the directory structure of the historical fGDB. 

 
c. Attribution associated with each added/removed/changed feature is tracked, including the 

following additional columns appended to the end of each: 
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(i.) Commit_by 
(1) Records the GIS-Analyst who committed the changes to the historical fGDB. 

(ii.) Commit_date 
(1) Records the date and time stamp on which the changes were committed. 

(iii.) Trans_type 
(1) This field reflects the type of change recorded; 
(2) Categorized by: Adds/Change/Deletes. 

(iv.) New_values 
(1) Records the new values when a change was completed on a feature. Example: 

Name or speed change. 
d. MD_Process also is transferred from the edited fGDB to the historical fGDB, which states the 

actions completed by the GIS-Analyst. 

 

 

DATA PROCESSING 

DATA PROCESSING OVERVIEW 

The following subsections detail the steps and layout required to process the service provider data further 
to meet NTIA requirements: 

 Weighted Nominal Speed; 

 Middle Mile; 

 Broadband Coverage Template. 
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WEIGHTED NOMINAL SPEED 

The weighted nominal speed is populated in one of the following two ways: subscriber data supplied by 
provider or value supplied by provider. 

SUBSCRIBER DATA SUPPLIED BY PROVIDER 

Where the data provider supplies subscriber speed information, the following formula from the NOFA 
is used: 

(speed tier-1 in kbps × no. of tier-1 subscribers) + (speed tier-2 in kbps × no. of tier-2 subscribers) + (etc.) 
Total average monthly subscribers 

 
Data is initially broken up in the following order: 
1) Stcty_fips; 
2) Transmission technology type; 
3) Subscriber tiers. 

VALUE SUPPLIED BY PROVIDER 

Some providers will supply their weighted nominal speed. In these cases, the data supplied will be 
populated instead of using the NOFA formula. These obtained or calculated values are used to update 
the service overview layer. 
 
This can be done manually or by creating a table with the provider’s FRN and average weighted speed 

and joining it to the service overview table in ArcMap®. 

1) To join, right-click on the layer to join to and select Joins and Relates>Join from the dropdown 
menu. 

2) Then navigate to the table to join to and select the join fields from the dropdown list. 

3) Then open the source table (the table in ArcMap®) and right-click on the header of the Average 

Weighted Speed field and select Calculate Field from the dropdown menu. 
4) Use the value of the average weighted speed from the joined table. 

 

MIDDLE MILE 

Middle mile information generally is provided in spreadsheet or text file format. The process is to take 
what is supplied by the provider and translate it into the required data schema. 

1) If the data is supplied with address information, follow the process outlined above in Subscriber 
Location—Address Data. 

2) If the data is supplied with associated XY coordinates, follow the process outlined above in 
Subscriber Location—XY Data. 

3) Once the data is in GIS format, use the Append (Data Management Tools>General>Append) 

command in ArcToolbox® to append the data to the overall middle mile dataset. 

4) Set the schema type to NO_TEST and use the Field Map to map the attribute fields from the 
source to the target dataset. 
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BROADBAND COVERAGE TEMPLATE 

The table below lists descriptions of the fields within the bb_cov layer, which is the interim dataset used 
to create the final product deliverable. 
 

NAME ALIAS DESCRIPTION 

objectid OBJECTID Internal Object ID 

shape SHAPE Internal Shape storage 

prov_id PROVIDER_ID Unique numeric identifier for each provider 

prov_name PROVIDER_NAME Unique name for each provider 

dba_name DOING_BUSINESS_AS An alternative "Doing-Business-As" name for the provider 

frn FCC_REGISTRATION_NUMBER Provider FCC Registration Number 

bbcov_name BBCOV_NAME BroadMap Broadband Coverage name 

trans_code TRANSMISSION_CODE Unique code for the transmission technology type described by 

this layer 

trans_name TRANSMISSION_NAME Name for the transmissions technology type 

trans_desc TRANSMISSION_DESC Description for the transmissions technology type 

spect_code SPECTRUM_CODE Unique code for the spectrum [WIRELESS ONLY] 

spect_name SPECTRUM_NAME Name for the spectrum [WIRELESS ONLY] 

spect_desc SPECTRUM_DESC Description for the spectrum [WIRELESS ONLY] 

mad_dwn_t MAX_AD_DOWN_TIER Maximum advertised downstream speed available within given 

area (speed tier) 

mad_up_t MAX_AD_UP_TIER Maximum advertised upstream speed available within given area 

(speed tier) 

typ_dwn_t TYPICAL_DOWN_TIER Typical downstream speed available within given area (speed tier) 

typ_up_t TYPICAL_UP_TIER Typical upstream speed available within given area (speed tier) 

mad_dwn_k MAX_AD_DOWN_KBPS Maximum advertised downstream speed available within given 

area (kbps) 

mad_up_k MAX_AD_UP_KBPS Maximum advertised upstream speed available within given area 

(kbps) 

typ_dwn_k TYPICAL_DOWN_KBPS Typical downstream speed available within given area (kbps) 

typ_up_k TYPICAL_UP_KBPS Typical upstream speed available within given area (kbps) 

subs SUBSCRIBERS Total average monthly subscribers for this provider for this 

technology for this coverage polygon 

md_geom MD_GEOMETRY Metadata: Comma separated list of source ids from which the 

polygon extent was produced 

md_exists MD_EXISTS Metadata: Comma-separated list of source ids used in 

understanding and editing the provider data for this polygon 
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NAME ALIAS DESCRIPTION 

md_who MD_WHO Metadata: Name of the editor who last edited this feature at the 

time in md_when 

md_when MD_WHEN Metadata: Date/time that this feature was last edited 

md_process MD_PROCESS Metadata: Comma-separated list of processes used to create 

and/or modify this layer 

stcty_fips STATE_COUNTY_FIPS State/County FIPS code 

rec_id RECORD_ID Compound Key formed from 

STCTY_FIPS+"|"+Provider_ID+"|"+Trans_Code+"|"+BBCov_Name 

st_area ST_AREA(SHAPE) Area in square decimal degrees  

st_length ST_LENGTH(SHAPE) Length in decimal degrees  

Provider_Type Type of Provider Has Subtype (1:Broadband provider as described in the 

NOFA,2:Reseller,3:Unknown), default value=1 (New 04/11 Model) 

 

VERIFICATION AND VALIDATION 

PROVIDER VALIDATION—PROVIDER PORTAL/PDF MAP REVIEW 

Following the collection and aggregation of provider data, the aggregated data is validated by the 
provider to ensure it is an accurate representation of their coverage area and supporting broadband 
information. 

 This validation is completed through the Provider Portal web application, which is a secure 
interactive map that displays the provider’s coverage areas and allows the provider to 
validate, submit feedback or request changes. 
o If changes are requested, then the features on the portal are updated and an automatic 

request is sent to the provider to complete the validation process. 

 Providers that did not use the Provider Portal are asked to validate a PDF map displaying 
their coverage area(s). This is accomplished via e-mail notification. 

PROVIDER VERIFICATION—THIRD PARTY SOURCE REVIEW 

After the provider has validated its coverage areas, a third-party source comparison and analysis is 
performed. 

 Where anomalies or discrepancies are identified, a “SCAN” point is dropped and descriptive 
comments are applied to be reviewed later with the provider. 

 During the provider review, the map is displayed along with the “SCAN” points and potential 
refinement is completed based on input from the provider. 

The table below shows third-party sources used: 

THIRD-PARTY SOURCE NAME SOURCE TYPE VERIFICATION TYPE 

InfoUSA Consumer and 
Business Listings 

Community Anchor Institutions; 
Can also be used for demographic information 
supporting the State websites. 

Pitney Bowes (PBBI) Exchange Info Plus 
(Central Office 
Locations) 

Exchange datasets are used to verify the following 
Transmission Technologies (TT): 
Asymmetric xDSL (10), Symmetric xDSL (20), Other 
Copper Wireline (30), and Optical Carrier/Fiber to the 
End User (50). 
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THIRD-PARTY SOURCE NAME SOURCE TYPE VERIFICATION TYPE 

Media Prints Cable Boundaries Used to verify the following TT: 
Cable Modem—DOCSIS 3.0 (40) and Cable Modem—
Other (41). 

American Roamer  Wireless Coverage 
Patterns (EVDO, 
GPRS, WISP, HSPA) 

Used to verify the following TT: 
Terrestrial Fixed Wireless—Unlicensed (70), Terrestrial 
Fixed Wireless—Licensed (71) and Terrestrial Mobile 
Wireless (80). 

ComSearch Wireless Spectrum 
Holdings and Tower 
Data 

Used to verify the following TT: 
Terrestrial Fixed Wireless—Unlicensed (70), Terrestrial 
Fixed Wireless—Licensed (71) and Terrestrial Mobile 
Wireless (80). 

ASSIGNING CONFIDENCE VALUES 
All findings and results from the abovementioned validation and verification activities, plus internal 
peer quality reviews, are captured and tracked in a Validation table (see example on the following 
page) and form the basis of the confidence value assigned for each provider and then each 
technology. 

CONFIDENCE VALUE DESCRIPTION 

    0 Coverage area has not been reviewed. 

  10 Extremely Low: 
Single Source QC.   

  20 Very Low: 
Needs additional validation\verification.  Coverage has not been 
validated by provider and is not found in third-party sources. 

  30 Low: 
Even with validation\verification, coverage still is suspect. 

  40 Presentable: 
Meets NTIA/State’s standards, broadband attribution (technology vs. 
speeds) is questionable and needs to be validated by provider. 

  50 Acceptable: 
Meets NTIA/State’s standards, display is generalized or doesn’t align 
completely with technology capability.  Okay for shipment, but requires 
further review. 

  60 Moderate: 
Meets NTIA/State’s standards and is representative of the Technology 
Type (TT). 

  70 High: 
Accurate representation of coverage based upon TT and aligns with a 
third-party source. 

  80 Very High: 
Multiple validation\verification with most third-party sources. 

  90 Extremely High: 
Multiple validation\verification sources. 

100 Perfect: 
Multiple validation\verification sources, with complete alignment with 
sources and ground truth verification activities. 
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The Validation table is maintained as updates or changes occur for each provider, down to 
technology type, with the overall goal to improve the confidence values and overall map 
representation. An example of the Validation table is shown below: 

 
 

COMMUNITY ANCHOR INSTITUTION (CAI) DATA 

DATA COLLECTION 

The CAI data was initially collected from the State to create the baseline inventory. All location 
information and broadband coverage data supplied also was ingested into the data deliverable. 
Additional collection of CAI information was done via data mining and/or webscraping to build out 
the inventory further. For example: Collection of additional CAIs and location information. 
 
The State-agency-provided CAI inventory was comprehensive but the challenge is collecting 
broadband related data: service provider(s), technology and speed data for each CAI. Availability of 
the CAI portal has not significantly increased submission of this data. Additional promotion to CAIs to 
use the CAI portal will be needed to increase this data for subsequent deliverables. 

INSTITUTION DATA 

Institution data is obtained from a variety of sources and almost always provided in Excel spreadsheet 
format. The general process for incorporating this data is as follows: 
1) If the data is provided in Excel or some similar format: 

a. Clean and standardize the Excel spreadsheet, removing any cell formats, merged cells, etc. 
b. Standardize the address format as defined in the staging CAI database. 
c. If the spreadsheet includes X and Y values, such as latitude and longitude, use the Add XY 

Data tool in ArcMap® to create a spatial data layer. 

d. If there are only addresses, then follow the geocoding steps outlined above to create spatial 
data points for each of the institutions. 

(i.) Institutions that do not geocode based on the TIGER® 2009 dataset will have to be 

located manually using Google Maps, Google Earth or some other information source. 
2) If the CAI source data is in GIS format, add the Latitude and Longitude fields and use the 

Calculate Geometry tool to populate them, using the WGS 84 coordinate system. 

3) Using ArcCatalog®, load the new data into the staging CAI database. 
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4) This database is ready for the makeDeliverable.py script to process the information into the final 
State and NTIA deliverables. 

COMMUNITY ANCHOR INSTITUTION (CAI) PORTAL UPDATES 

A web application has been released to allow for further data collection and validation of anchor 
institution location information, broadband coverage and speed test data. Information collected from 
the CAI Portal is then ingested into the overall inventory and will be compared later against the 
provider coverage areas mapped to locate any potential discrepancies. 

 

PRODUCT EXTRACT 

PYTHON SCRIPTS 

The following subsections make use of Python scripts. In general, to use a Python script you must have 
Python installed on your computer. To download the latest version of Python, go to 
http://www.python.org/download/ and download the latest stable version. As of August 2010, this was 
version 2.7. Once this is installed, the general way to run a script is to type the following at a command 
prompt: C:\Python27\python.exe C:\<location of script>. Many of the scripts provided have environment 
variables that must be set before they can be run. 
 
The Python code for BroadMap’s product extract has been incorporated into a Hudson CI System, which is 
detailed in the Process Operation and Monitoring section of this document. This was a process 
improvement activity so that all processes can be monitored, controlled and will contain historical 
tracking on each process. 

 

PRODUCT EXTRACT PROCESS 

NOTE: 
Specific Python scripts are called out in red font in the subsections below. 
 

The MapConnect
TM

 product extract process, makeDeliverable.py, uses the BB_Cov and 
BROADMAP_POINTS interim datasets to create the following layers according to the current 
specifications: 

 BB_Service_Road_Segment 
o This layer contains all broadband services associated with specific street segments for census 

2000 blocks larger in area than two square miles. 

 BB_ServiceCensusBlock 
o Contains all broadband services associated with census blocks of no greater than two square 

miles. 

 BB_Service_Wireless 
o This layer contains all wireless services not associated with specific addresses. 

 BB_ServiceOverview 
o This layer contains subscriber-weighted nominal speed for each provider's service area at a 

county level and is meant to act as a summarized view. 

 BB_ConnectionPoint_MiddleMile 
o This layer contains middle-mile and backbone interconnection points. 

 BB_Service_CAInstitutions 
o Broadband Service at Community Anchor Institutions (CAI). 

http://www.python.org/download/
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o Community Anchor Institutions consist of schools, libraries, medical and healthcare 
providers, public safety entities, community colleges and other institutions of higher 
education as well as other community support organizations and entities. 

Because of a NTIA model change for the October 2010 data deliverable, an addition to this code was 
created to support both models in case a comparison is later desired or a request is made to revert to the 
original model. This script name is bdia2ntia.py and creates the following layers in addition to the layers 
mentioned above, rolled up to NATL_Broadband_Map. 

 BB_ConnectionPoint_LastMile 
o This layer contains last mile infrastructure points, which is populated only if data cannot be 

provided at a more granular level. 

 BB_Service_Address 
o Represents broadband availability for service address points. Address Point availability refers 

to those individual addresses at which each facilities-based provider of broadband service 
can provide broadband services of minimal characteristics within 7-10 business days. 

 State_Boundary 
o State boundary supporting topological validation of point feature classes. 

 NATL_Broadband_Topology 
o Supports basic topology quality checking. Example: No CAIs or Middle Mile points outside of 

the State boundary. 
 
The following process flow provides a view of how the Core fGDB is extrapolated to the NTIA final 
deliverable via the makeDeliverable.py script. Following that, the bdia2ntia.py script is run, which limits 
what is placed in the final layers based on the NTIA modeling standards. 
 
The product scripts and supporting extract were originally created separately per request, in case data 
model comparisons were to be completed. 

 

PRODUCT STATISTICS 

Following the completion of a product extract, the product statistics script (BDIA_ReleaseNotesStats.py) 
extracts the following information supporting that product deliverable. 

 Provider Statistics: 
o Collects all provider information, listing by Provider Name. 
o Provides output of FRN. 
o Counts the number of features supported within the following layers: 

 Census Block; 
 Street Segment; 
 Max Upstream; 
 Wireless Services; 
 Infrastructure Points. 

o These updates were made to support the Data Package required to accompany every NTIA 
product deliverable. 

 Community Anchor Institution (CAI) Statistics: 
o Breaks down CAI to the eight categories: 

 1: School: K through 12; 
 2: Library; 
 3: Medical/Healthcare; 
 4: Public Safety; 
 5: University/College; 
 6: Other Government; 
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 7: Other Community non-government; 
 None: Unknown Category. In cases where this occurs, further investigation is completed 

prior to product shipment to ensure all CAIs are categorized accurately. 
o Reports out the following counts: 

 Total CAIs within that category; 
 Total CAIs that contain partial BB coverage. Contains any of the following information for a 

given CAI: BB Subscriber, Transmission Technology, Speed Down Speed Up; 
 Total CAIs that contain full BB coverage. Contains all of the abovementioned BB information 

for a given CAI. 
The output of this script is two CSV files: AnchorInstitutions.csv and Providers.csv. These files then can be 
inspected to ensure that there are the expected number of CAIs and providers for every release. 

 

QUALITY ASSURANCE 

Quality assurance is supported manually and algorithmically on the interim data, BB_Cov file geodatabase and 
on the final product. For scheduled product releases, a test product extract and subsequent manual and 
algorithmic QC run is completed along with a release review. The product specifications, project status reports 
and previous product release notes are used as references throughout this review. 
 
The following parameters are tested using the methodology listed below each: 

 Product Deliverable Format:  
o Correct names and format of data deliverables. 

 BDIA_QC_SUITES (please see below for details). 
o Correct Projections/Datum. 

 Manual interaction with product. 
o Metadata Present and Correct. 

 Manual interaction with product. 

 Table Structure: 
o All required tables included. 

 BDIA_QC_SUITES. 
o Extraneous tables identified. 

 BDIA_QC_SUITES. 

 Field Structure: 
o All fields included. 

 BDIA_QC_SUITES. 
o Extraneous fields identified. 

 BDIA_QC_SUITES. 
o Correct field names, types and widths. 

 BDIA_QC_SUITES. 

 Field Domains: 
o Values in all tables are constrained to the specified values specified: 

 This action is accomplished via BDIA_QC_SUITES and manual review of the product; 
 This tends to identify project completeness issues as fields with a null value are identified. 

 Geometric Representation: 
o Identify if all layers have the correct geometric representation: 

 Manual review of the BB_ServiceOverview layer; 
 Dependent on NTIA and client requirements. 

 Geographic Extent: 
o Product includes the necessary Geography associated with Product? 

 Manual Review—ArcGIS®. 
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o Is there extraneous geography included in Product? 
 Manual Review—ArcGIS®. 

 Completeness: 
o Products contain the expected amount of data? 

 Manual review of product statistics relative to weekly State reports and defined expectations. 

 Accuracy: 
o Product meets the stated accuracy requirements for the deliverable? 

 Sampling procedure to manually review source material to resulting product; 
 Provider Validation; 
 Verification using Third-Party Data; 
 Verification against reality, where applicable. 

 Data Regression: 
o Any unexplainable data loss or change? 

 This action is accomplished by comparing results within product statistics script 
(BDIA_ReleaseNotesStats.py) from previous releases, as well as manual review of the product. 

 Confidentiality: 
o Any unauthorized confidential information included in the delivery? 

 Review of NDAs and delivery expectations. 

 Prior Issues Resolved:  
o Have expected internal issues been resolved? 

 Manual review of data against previous product release notes. 
o Have agreed-upon customer issues been resolved? 

 Manual review of data against previous product release notes, status report and client feedback. 

 Delivery Medium: 
o Has the product medium been verified? 

 Manual review. 
o All files present. 

 Manual review of SFTP site to ensure all files are copied correctly, including file/directory size. 
o Correct location. 

 Manual review—confirmation of SFTP link, username and password. 
 

QC SUITE 

The BDIA_QC_SUITES consists of four main types of scripts supporting the overall QC process. These 
scripts are all run in concert and are called from the test_runner script and the test_BDIAProductGDB 
script. 

CONFIGURATION  

These scripts establish the configuration for the test_BDIAProductGDB script, which is the core of the 
QC Suite. 
update_test_config 
active_config 
config_PROCESS01_automated 
config_PROCESS01_manual 
set_active_config 

LIBRARIES 

These scripts provide additional functionality that is called from with the test_BDIAProductGDB 
script. 
bb_unittest_fixture 
bbcov_structure 
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BC_XmlWriter 
file_folder 
search_and_replace 
unittst_fixture 
validate_BB_DB 
validate_BB_GDB 
xmlrunner_gui 

QC SUITE 

This is the core script for performing automated QA/QC on the interim and final data deliverables. 
test_BDIAProductGDB 

OTHER  

These scripts perform other functions detailed below: 
test_runner—this is the main script that runs all the other QC scripts and imports all the necessary 
scripts and libraries. 
which_build—this determines the current build and passes information to the configuration scripts. 

 

PROCESS OPERATION AND MONITORING 

Product Extract, makeDeliverable.py and bdia2ntia.py, is run within BroadMap using a platform called Hudson 
that has been enhanced to support BDIA product extraction, process monitoring, as well as product validation. 
The same platform can be planned for implementation for the State, if desired. 
 
Below are examples of the product create, product validation, product statistics and monitoring processes 
that are managed within the BroadMap Hudson CI-System. All of the abovementioned Python scripts, with 
the exception of metadata transactions script, are run via this system. 

 

BDIA PRODUCT CREATE 

Below is an example of the main page where the type of product build can be selected. 
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Selecting based on the type of process that will be initiated is shown below: 

 

  
The Console Output can be reviewed to see the progress of product create. Following the completion of 
each product creation process, an e-mail notification is automatically sent to the team. 

 
All processes run via the BroadMap Hudson CI-System are stored for historical reporting. Each process can 
be reviewed, including the Console Output and Build Artifacts from that run. 
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PRODUCT VALIDATION AND STATISTICS 

Once the product creation process is complete, Product Validation and Statistics are then initiated. These 
support the BDIA_ReleaseNotesStats.py script and the BDIA_QC_SUITES scripts detailed above. 

 
All statistics and reports are stored for historical review with the capability to place violation criticality on 
each quality control check, allowing the identification of errors because of project status/completeness 
verses project correctness. Example: Typical Speeds populated. 

 

Below is an example of the report provided based on various control points running over a specified 
period: 

 
Similar to the Product Create process, all results from the process are maintained: 
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Results are then reviewed manually to ensure no errors reported are critical or in violation of the NTIA 
data model or project completion statements. Any errors of concern are communicated ahead of product 
delivery and included within the product release notes. Further detail on the Hudson-CI System 
environment can be found by navigating to the following link: 
http://wiki.hudson-ci.org/display/HUDSON/Meet+Hudson 

 
 

PRODUCT EXTRACT DATA DELIVERY 

Product delivery for MapConnect
TM

 Broadband is handled two ways, depending on client requirements: 
1) State Submittal: 

a. Data is submitted via SFTP site; 
b. Product Release Notes and QC Test Report accompany the delivery. 

2) NTIA Submittal: 
a. Directions for using the NTIA State Broadband Data file submission tool: 

(i.) Go to the following website: https://esupport.fcc.gov/statedata; 
(ii.) Enter your username and password as provided to you from the NTIA program 
administrator; 

 
(iii.) Click in Upload a file field; 
(iv.) Browse to local file for submission using the Browse button. Select file, then select 

ATTACH FILE. See example below. 

http://wiki.hudson-ci.org/display/HUDSON/Meet+Hudson
https://esupport.fcc.gov/statedata
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(v.) Logout/Receipt using the Logout button in the top right of the screen; 
(vi.) A receipt of submission is e-mailed to username e-mail address. 
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Introduction 
The following sections of this document provide an overview of the process used for the SBI Broadband 

Mapping data development for the Commonwealth of Pennsylvania. The following narrative is depicted in 

Appendix A, Commonwealth of Pennsylvania SBI Process Workflow, and Appendix B, State Broadband Data 

Validation Workflow, included at the end of this document. 

Broadband Provider Outreach 
The following outreach procedure provides the framework for communicating with Broadband Service Providers 

(providers). The primary goals of the outreach approach documented herein are to:  

 Promote provider understanding and acceptance of the Broadband Mapping process, results, and benefits 

 Clarify NTIA Broadband Mapping requirements 

 Facilitate data confidentiality agreements as required 

 Minimize the submittal of invalid data 

 Enhance provider understanding of the semi-annual update process   

 Work with providers to evaluate submittal options to facilitate data submittals  

Data Submission Guidelines 
Guidelines for the providers’ submission of Broadband Mapping Data are documented in the “Data Submission 

Guidelines”. These Guidelines define technical requirements, submission specifications, and coordination and 

documentation activities. 

Pennsylvania Broadband Providers Website 
A URL was deployed (http://www.bakergis.com/PABroadbandProvider/) to communicate and distribute NTIA 

NOFA requirements to providers along with outreach and data submittal materials including: 

 NTIA NOFA and subsequent clarification 

 Outreach letters to providers 

 Draft Non-Disclosure/Data Sharing Agreement 

 Quick Start Guides 

 Data Submission Guidelines 

 Data Transmittal Letter 

 Broadband Data Submittal Templates 

 Census TIGER Data 

 Data Submittal Assistance Contact Information 

Outreach Delivery Vehicles 
 A State Broadband Mapping Initiative Call for Data letter from the Commonwealth of Pennsylvania 

Department of Community and Economic Development (DCED) was emailed to all providers in the 

Commonwealth. This initial provider contact letter described the program and the role of Michael Baker Jr., 

Inc. (Baker) acting on behalf of the DCED for Broadband Data Collection and Mapping. 

http://www.bakergis.com/PABroadbandProvider/
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 Baker distributed a follow-up letter to all providers describing the data submittal requirements and material 

and help available to aid with the data submittals. 

 Submittal assistance was provided to providers that needed help with data submittals. 

 Presentations were conducted with various broadband provider associations to present the data submittal 

requirements and answer questions. 

 Email communication and electronic transfer of data was encouraged to facilitate a faster delivery of data 

and information. 

 A URL was deployed and promoted to distribute outreach material and information concerning the 

Broadband Mapping Project. 

 A secure FTP URL was provided for submittal of broadband data by providers. 

Broadband Outreach Tracker Application 

The Tracker application (Figure 1) was utilized to collect all correspondence with providers and feedback on the 

effectiveness of the outreach activities by tracking items such as:  

 The number and content of incoming e-mails and letters submitted from the providers 

 The number and source of comments, questions, and suggestions made by providers 

 The number and source of comments, questions, and suggestions made by attendees at provider meetings 

and conference calls 

 Provider contact information and data submittal status. 
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Figure 1 Broadband Outreach Tracker 

Provider Submittal Validation 
When a data submittal is received from a broadband service provider, it is updated in the Broadband Outreach 

Tracker and run through an initial validation process to assure that it meets the submittal guidelines.  

Validation Checklist 
The following items are part of this initial data validation process: 

 Verify provider’s transmittal letter requested in Data Submission Guideline with is complete and 

matches submitted data 

 Verify the file naming conventions 

 Verify each file is machine readable 

 Verify data is in the correct GIS or Tabular format/file type 

 Verify each field is populated and no empty or NULL values are present for mandatory fields 

 Verify all ID (record number points) are unique within the submittal 

 Verify all attribute data is formatted according to the submittal guidelines 

 Verify topology for all geospatial submissions 

 Verify Metadata for all submissions 

 Verify the required contact information is included 

 Verify adherence to Data Submittal Guidelines (see http://www.bakergis.com/PABroadbandProvider/ to 
access Data Submittal Guidelines) 
Broadband Service Availability (at least one) 

 Individual Street Addresses (Sec 3.1 & 4.1) 

http://www.bakergis.com/PABroadbandProvider/
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 Census Blocks < 2 sq mi (Sec 3.3 & 4.3) 

 Street Segments for Census Blocks > 2 sq mi (Sec 3.2 & 4.2) 

 Service Overview (Sec 3.4 & 4.4) 

 Polygonal Boundary Area(s) (Sec 3.8 & 4.8) 

Middle-mile Points (Sec 3.5 & 4.5) 

Community Anchor Institutions (Sec 3.7 & 4.7) 

Last Mile Connection Points (Sec 3.6 & 4.6) 

WISP Antennas (Sec 4.9) 

Data Usability Determination 
The validation results are evaluated by the outreach and aggregation persons to determine the usability of the 

data. If the data meets the submission specifications, it is forwarded on for data aggregation. If it is determined 

to be unusable, it is returned to the provider for resolution. If the data can be manipulated to get it into a usable 

format, it is manipulated as required, and then forwarded on for data aggregation. 

SBI Data Development 
Data from the providers may be submitted in various formats as defined in the Data Submittal Guidelines, or in 

some cases unspecified formats may be accepted to help facilitate provider participation. Depending on the 

format of the submitted data, it is processed through one of the following processes to upgrade it to the NTIA 

SBI data standards. 

2000 to 2010 Census Data Translation 
Many providers indicated there were no changes to their previous data submission that was compiled to 2000 

census information and they did not have the capacity to upgrade their data to 2010 census information.  

Therefore, the Broadband Mapping team has translated the April 2011 data for these providers using the 

workflow shown in Appendix C. 

Spatial Data  
After validation and any required manipulation of any spatial data submitted by the providers, it is 

georeferenced and simply loaded into the appropriate NTIA geodatabase feature class.  

Address Data Geocoding 
If not already in the standard address point template, the provider tabular address data is first loaded into that 

template. The data is then exported to a geodatabase table using the ArcGIS Conversion Tools. ArcGIS geocoding 

tools are then utilized geospatially locate the address points for the tabular records. Interactive address 

rematching is performed against two additional street centerline datasets as needed to increase geocoding 

matching results. The NTIA deliverable is the geocoded address point geodatabase table. The geocoded address 

points are also subsequently aggregated to the census block or road segment feature class for public web map 

display. 
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Census Block Aggregation 
If not already in the standard census block template, the provider tabular census block data is first loaded into 

that template. The data is then exported to a geodatabase table using the ArcGIS Conversion Tools. The provider 

tabular census block records are then joined to the geodatabase 2010 U.S. Census Block. This join is performed 

as many times as necessary for multiple Trans Tech values for each Provider/Census Block combination. The 

NTIA deliverable is the census block geodatabase table.  

If the list of census blocks contains blocks > 2 sq. miles then these blocks are used to select all the 2010 U.S. 

Census TIGER centerlines that intersect those blocks.  The Census Block record data is aggregated to each Road 

Segment within the Census Block.  This process is performed as many times as necessary for multiple Trans Tech 

values for each Provider/Census Block combination. 

Road Segment Aggregation 
If not already in the standard road segment template, the provider road segment data is first loaded into that 

template. The data is then exported to a geodatabase table using the ArcGIS Conversion Tools. If the provider 

submittal included graphic centerline segments, these are migrated into the delivery geodatabase along with 

the linked attribute records. If the provider submittal was tabular road segment records only, they are then 

joined to the geodatabase 2010 U.S. Census TIGER centerline feature class. This join is performed as many times 

as necessary for multiple Trans Tech values for each Provider/Road Segment combination. The NTIA deliverable 

is the road segment geodatabase table.  

If the provider road segment data lie within census blocks <= 2 sq. miles then the road segment data is 

aggregated to the census block.  This process is performed as many times as necessary for multiple Trans Tech 

values for each Provider/Road Segment combination. The NTIA deliverable is the road segment geodatabase 

table. 

Overview Data Aggregation 
Provider Service Availability Areas submitted for entire county areas are loaded into the NTIA geodatabase 

Overview table. If not already in the standard template, the provider data is first loaded into that template. The 

data is then exported to a geodatabase table using the ArcGIS Conversion Tools. The provider overview records 

are then joined to the geodatabase 2010 U.S. Census County feature class. This join is performed as many times 

as necessary for multiple Trans Tech values for each Provider/County Area combination. 

Polygonal Boundary Aggregation/Integration 
Providers submitting polygonal service area data are handled in two ways. Wireline Provider data is aggregated 

to the census block feature class for areas where census blocks <= 2 sq. mi., or road segment feature class for 

areas where census blocks > 2 sq. mi. Wireless Provider Service Availability Areas submitted by polygonal area 

are simply loaded into the NTIA geodatabase Poly_Bndry feature class.  

Wireline Provider 

The polygonal data is georeferenced and loaded into the Poly_Bndry feature class. The polygon is then 

attributed, manually if necessary. Depending on the area, census blocks < or => 2 sq. mi., a selection set of either 
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census blocks or road segments that intersect the polygon boundary is created. The attributed polygon 

boundary is then joined with census blocks or road segments table to attribute accordingly. This join is 

performed as many times as necessary for multiple Trans Tech values for each Provider/County Area 

combination.  The NTIA deliverable is the census block or road segment geodatabase table. 

Wireless Provider 

The polygonal data is georeferenced and loaded into the Poly_Bndry feature class. The polygon is then 

attributed, manually if necessary. Multiple Poly_Bndry records are created for multiple Trans Tech values for 

each provider. The NTIA deliverable is the polygon boundary geodatabase table. 

Middle/Last Mile Data Integration 
If not already in the standard template, the data is first loaded into that template. The data is then exported to a 

geodatabase table using the ArcGIS Conversion Tools. The point features are geo-located utilizing the lat/long 

information provided.  The NTIA deliverable is the middle or last mile geodatabase table. 

Community Anchor Institution Integration 
Providers supplied some Community Anchor Institution (CAI) data with the data submittals. But the majority of 

the data was collected from existing GIS Layers maintained by the Commonwealth of Pennsylvania, outreaching 

to CAIs through state agencies and their contacts, and having CAIs complete an online survey at 

http://www.bakerbb.com/pa_institution_survey/.  

Provider CAIs 

If not already in the standard template, the data is first loaded into that template. The data is then exported to a 

geodatabase table using the ArcGIS Conversion Tools. The point features are geo-located utilizing the lat/long 

information provided. Address data is used to geocode locations only when lat/long data is not provided. 

Commonwealth CAIs 

CAI shapefiles were provided through the Commonwealth’s other geospatial efforts. The shapefiles were then 

exported to the NTIA geodatabase CAI feature class. Various sources for obtaining broadband information for 

the CAIs were utilized. Various state agencies provided some of the information, i.e. Pennsylvania Department 

of Education (PDE) provided tabular broadband information for schools, PDE provided tabular broadband 

information for libraries, and Pennsylvania State Police provided tabular broadband information for their 

facilities. A CAI data survey website was also deployed and the URL distributed by various state agencies to the 

CAI contacts. Data from all of these sources were then aggregated into the CAI geodatabase table for the NTIA 

deliverable. 

Provider Validation 
After data development, service availability maps are generated and submitted to the providers to validate their 

mapping results.  This provides a “sign off” on the interpretation of the submitted data and extends the 

outreach efforts by providing a visual representation of the data to be delivered to the State and the NTIA. 

Types of Provider Maps 
Provider maps generally consist of the following types. 

http://www.bakerbb.com/pa_institution_survey/
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Outreach Maps 

Often, providers will send data which does not contain all the information needed for a NTIA compliant dataset.  

In such cases, as an aid to the outreach communication, it may be necessary to produce a map to help the 

provider locate their service area or verify data they have provided.  These maps may take many forms, but 

generally are of two types: 

 General Location Maps – these maps are often produced when the provider does not have a list of address 

or other standard submittal data and needs help defining their service area.  A typical map will show 

counties, major roads, and towns of the general area the provider has stated as their service area.  The 

intent of the map is to give the provider a way to markup or delineate their service area.  If a provider has 

not provided required attribute information such as Technology of Transmission, Speed Data, etc. then it 

may be necessary to add a visual clue to this data like an information stamp on the map that they can easily 

fill out.  If the provider sends the map back with a service area boundary, this can then be digitized and sent 

back to the provider for verification. 

 Verification of Provider Supplied Boundaries – these maps are produced when the provider has sent service 

area boundary information which is confusing or otherwise unclear.  Often these are produced when 

providers send CAD maps, hand drawn maps that need digitization, or lists of zip codes or counties served.  

A typical map will place the interpreted boundary over a location map so the provider can verify the service 

area.  As with the General Location Map, information stamps or other visual clues may be placed on the 

map. 

Initial Verification Maps 

Once the provider data has been processed and the census block and road segment feature classes created, an 

Initial Verification Map (Figure 2) is produced to give the provider a visual representation of their service area by 

census block.  These maps enable the provider to verify their service area and make changes if necessary.  Initial 

Verification Maps are produced using a set of standards and produced at the highest resolution necessary to 

convey the map information to the provider.  Initial Verification Maps are also produced for Wireless Polygon 

areas. 

Detailed Verification Maps 

Providers who have questions about their service areas may request additional information to help clarify issues.  

In these cases, it may be necessary to create a Detailed Verification Map to highlight the areas in question.  

Detailed Verification Maps provide the same information as Initial Verification Maps only at a higher resolution.  

Several maps may be needed to accurately portray an area in question. 

Revised Maps 

Revised maps take two forms: 

 Initial or Detailed Verification Maps which have been annotated or marked-up by the provider 

 Outreach produced Initial or Detailed Verification Maps incorporating provider changes 
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Figure 2  Provider Map 

Data Validation 
A critical component of the project is the validation of the data submitted by the broadband service providers. 

Data from various sources, as described in more detail in the following sections, is utilized to develop a level of 

confidence in the data received from the broadband providers.  

Validation Data Set Collection and Development 
This validation process employs data sets developed or acquired from different sources as described in the 

following sections.  

Provider Feedback Loop:  Maps of completed provider service areas and data are furnished back to the 

providers for confirmation of the processed/aggregated information. Feedback is integrated into the each 

provider’s dataset.  
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Telogical Systems Wireline Market Intelligence Data:  This commercially available dataset was developed using a 

methodology that incorporates deep web crawling and additional means, including direct mail harvesting and 

advertising collaterals (including door to door) to gather cable and telecommunication provider information. 

This dataset is used as a validation source for wireline provider service area coverage, Technology of 

Transmission, and Speed. 

American Roamer Wireless Market Intelligence Data:  This commercially available dataset is used as an 

independent source to verify information submitted by providers of wireless broadband service. This dataset is 

used as a validation source for wireless provider service area coverage. 

Prior Commonwealth Broadband Mapping Dataset:  Under the requirements of the Commonwealth’s Act 183 of 

2004 legislation, broadband coverage data was previously collected by the Commonwealth. These datasets are 

used as a validation source for provider service area coverage and Technology of Transmission. 

FCC Speed Test: The FCC speed test data includes the IP addresses for each specific speed test conducted. This IP 

address is queried against a web search engine to determine the provider assigned to that address and is used 

as a validation source for the provider service coverage and typical speeds. 

Fixed Wireless Line of Sight Analysis: Utilizing the existing PAMAP LiDAR for topography generation and 

determining tower/antennae heights, line of sight analysis is performed to determine areas of reported fixed 

wireless broadband coverage that is questionable.  

Field Data Acquisition: Broadband technicians visited a sampling of census block locations to gather broadband 

data to be used for validation. The following criteria were taken into account when developing the census block 

sampling dataset: 

 urban vs. rural census block characteristic 

 censes block grouping 

 land vs. water census block characteristic 

The overarching mission of the Federal broadband stimulus program is to expand Broadband service to areas 

that are currently unserved and underserved. Also, the market intelligence validation sources typically represent 

some rural, but more urban areas. Thus, our field data collection efforts were targeted more towards the rural 

areas; split 90% rural, 10% urban.   

Additionally, a study by Penn State University (Glasmeier 2002) notes that a large number of census block 

groups typically fit within any given cable or telephone company service areas. Therefore, our field sample was 

also based on selection of one census block per block group and a land mass greater than 50% to avoid field 

visiting areas covered mostly by water.  There are a total of 10,387 block groups in PA. Using a statistical sample 

size calculator based upon the number of block groups in the state and +/- 4% margin of error at a 95% 

confidence level, the sample size is 568 census block locations statewide.  The procedure for selecting the 

calculated field verification census blocks is provided below.  

1. Select one census block per census block group 
a. Convert the census block groups polygon to label points. 
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b. Select the census block polygon by doing a spatial selection using census block groups label 
points. 

2. Select from the current selection where the census block land mass is 50% or greater and the block is 
rural. 

3. Export the selected blocks to a new shapefile. This reset the FID for the next step. 
4. Select every 2nd, 3rd, 4th, or so on to get the desired number of blocks. Query used to select: 

MOD(“FID”,2) = 0. This will select every other record. 

The planned census block field locations are shown in Figure 3. 

 

Figure 3  Planned Field Verification Census Block Locations 

For each census block in the sample set, broadband technicians collected data using Panasonic Toughbook 

computers, loaded with MapPoint mapping software, and a customized Microsoft Access data collection form 

with the ability to automatically import GPS coordinates. The sample census blocks were pre-loaded and directly 

accessible from MapPoint.  Two types of data collection were conducted (infrastructure observation and 

wireless speed testing) and the results were recorded and linked to the corresponding field location coordinates 

within the designated sample census block.  The information collected by the field broadband technicians 

includes: 

Wireline: 

 GPS coordinates 

 circuit infrastructure feeding the area (copper, fiber, cable) 
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 local distribution hut equipment inspection, where allowed/possible 

 witness access circuit speed tests, where allowed/possible 

 facility elevation (measurement relative to grade), where allowed/possible 

 distance from DSLAM measurement where applicable and determine access speed capability with an 

accuracy within 500ft using mapping software 

 collect site pictures 

Wireless: 

 GPS coordinates 

 internet speed test 

The map in Figure 4 shows the locations (blue points) of the census block field surveys that were performed.  

 

Figure 4  Completed Field Verification Locations 

For the 568 census blocks that were visited, 2821 individual wired/wireless data elements were recorded and 

3666 pictures were taken at those locations. This field collected dataset is used as a validation source primarily 

for wireline and wireless technology of transmission, middle mile, and wireless speed. 
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Provider Data Validation Process 

Provider Feedback Loop: Feedback received from the providers is visually inspected and integrated directly in 

the mapping GIS database. 

Service Area Validation Data: The Telogical wireline service area data is tabular and contains a separate record 

for each provider/technology of transmission combination with an associated census block or TIGER road 

segment, depending on the whether the size of the census block area (=/< or > 2 sq. mi.). This data is exported 

into an ArcGIS data format. The American Roamer wireless service area data is already in and ArcGIS data 

format.  The validation data is then joined to the provider service area data by census block or TIGER road 

segment ID. Any database records in the provider or validation tables that cannot be joined are output to a 

separate layer that indicates the areas of discrepancy between the two datasets. The joined tables are then 

queried to detect any speed discrepancies which are also output to a separate discrepancy layer. 

Field Validation Data: The field data are also collected in tabular database format, and represent a specific 

lat/long spatial location for each record.  This data is also exported into an ArcGIS data format, joined to the 

provider data, queried to validate pertinent attribution. Again, records not joined and/or with detected 

attribution discrepancies are output to separate GIS layers. 

Topology: The ArcGIS Validate Topology Tool is used to flag any topology issues in the broadband data. Flagged 

issues are reviewed to identify false positives and update true errors as required.  

SBI Check Submission: The NTIA-provided SBI Check Submission tool is utilized to validate that the deliverable 

broadband data is consistent with the business logic rules set forth by the NTIA and a passing receipt is provided 

with the data submittal to NTIA. 

Stakeholder Feedback:  The state broadband mapping website includes a feedback function. Comments received 

from stakeholders such as the regional Economic Development Districts and the public are reviewed and used to 

validate the provider data submissions. 

Validation and Confidence Level Reporting 

To facilitate validation and confidence level reporting, 

Baker deployed a validation application called Statistical 

Evaluation and Assessment System (SEAS), shown in 

Figure 5, which automatically compares the multiple 

independent validation datasets against the broadband 

service provider supplied information.  The SEAS 

application uses statistical methodologies to report the 

confidence level in the spatial and attribute accuracy of 

the information.  Appendix B shows the validation 

workflow. 

 

 Figure 5  SEAS 
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The SEAS comparison is a three-part validation process: 

1. Comparison of the collected validation source against the aggregated broadband provider data. 

2. Match percentage calculation for each provider reported in the DataPackage.xls, “Provider Table” tab, 

“Comments” column. 

3. Confidence score calculation displayed on the state broadband website. 

After completing all validation data source collections, SEAS is used to automatically compare the multiple 

validation datasets against the aggregated broadband data which came from the providers. Through the SEAS 

accumulation table, it produces a match percentage per broadband service record based upon the number of 

matches that record has against each validation source. The matched percentage for each record is the result of 

the total count of the matched validations for the record divided by the total validation source being compared 

against the record.  Validation confidence rating/score is assigned on a scale of 1 to 5 based upon the 

percentage of validation source matches as per the following score results: 

o 1 Star   = 0% - 19% Match 

o 2 Stars = 20% - 39% Match 

o 3 Stars = 40% - 59% Match 

o 4 Stars = 60% = 79% Match 

o 5 Stars = 80% - 100% Match 

o “No Analytics” = No validation source available for that provider 

The Commonwealth’s public broadband mapping website (www.broadbandinpa.com) is updated with the 

confidence level results at the record level based upon the queried geographic location and the following shows 

an example of this representation. 

 
Provider Name Transmission 

Technology 

Max Download 

Speed 

Max Upload Speed  Confidence Score 

AT&T Mobility Mobile Wireless Greater than or e… Greater than or e… 
 

Verizon Asymmetric xDSL Greater than or e… Greater than or e… NO ANALYTICS 

Comcast Cable Modem – 

Other 

Greater than or e… Greater than or e… 
 

  

The matched percentage for the records for each provider are summarized and then divided by the total count 

of the records to create the final matched percentage for the specific provider. These percentages are included 

in DataPackage.xls on the Provider Table tab in the Comments column. 

Low Confidence Provider Feedback  
Provider data which is assigned a low confidence (1 or 2 stars) through the SEAS process is communicated back 

to the provider through a feedback loop.  Generally, the low confidence feedback and reconciliation is a 

continuous refinement process and usually occurs between update cycles. The goal is to provide this feedback 

http://www.broadbandinpa.com/
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through the Provider Update Portal via a web connection that will be available and rolled out to provider in early 

2012. 

Changes and Corrections Documentation 
With each semi-annual NTIA data submittal, changes and corrections documentation is provided. Significant 

changes in a provider’s status or data, corrections to previously supplied data, providers supplying data for the 

first time, etc. are specified by Provider name in the Changes and Corrections document. 
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Appendix A: Appendix A: Commonwealth of Pennsylvania SBI Process Workflow 
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                                                                            Appendix B:  
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Appendix C: 2000 to 2010 Census Data Translation Workflow 

 
  

 



 Commonwealth of Pennsylvania 
SBI Broadband Mapping Project 

DATA DEVELOPMENT & VALIDATION METHODOLOGIES 
 

 
 
 21 

 



 Commonwealth of Pennsylvania 
SBI Broadband Mapping Project 

DATA DEVELOPMENT & VALIDATION METHODOLOGIES 
 

 
 
 22 

 



THE

STA

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

OFFIC
E NATION

ATE BRO

 

 

 

 

 

 

CIAL OCT
NAL TEL

ADMI
OADBAND

COMMO

TOBER 20
LECOMM
INISTRA

D INITIAT
ONWEAL

Octo

011 UPDA
MUNICAT
ATION UN
ATIVE GR
LTH OF P

 

ober 1, 201

ATE SUBM
TIONS AN
NDER TH

RANT PRO
PUERTO R

11 

MISSION 
ND INFOR
HE 
OGRAM F
RICO 

TO 
RMATION

FOR THE

N 

E 

 

 



  
 
 
                

 

Octo
 

 

Puerto Ri

Data Acq

SBI Data

Provider 

Puerto Ri

Data Sub

Accuracy

Wireless M

Broadban

Broadban

Speed Te
 
Broadban

 
 

 

                     

ber 1, 2011    

ico Cover Le

quisition:  Pu

a Submission 

Changes and

ico Field Val

bmission and 

y and Verifica

Methodology

nd Inquiries M

ndStat Metho

est Methodol

nd Provider L

                     

                     

etter ...............

uerto Rico Co

Methodolog

d Corrections

lidation Meth

Coverage E

ation:  Provid

y ....................

Methodology

odology ........

logy ...............

Log ...............

                   

                     

TABLE O

.......................

ommunity An

gy ...................

s for Octobe

hodology ......

stimation of 

der Validatio

.......................

y ....................

.......................

.......................

.......................

 

                     

                     

OF CONT

......................

nchor Institu

......................

er 2011 .........

......................

Non-Particip

n Methodolo

......................

......................

......................

......................

......................

                  C

                    

TENTS	

......................

utions Metho

......................

......................

......................

pating Provid

ogy ................

......................

......................

......................

......................

......................

Connect Puerto 

                     

......................

odology ........

......................

......................

......................

der ...............

......................

......................

......................

......................

......................

......................

Rico Methodol

                     

............... 3 

............... 7 

............... 8 

............. 10 

............. 11 

............. 12 

............. 21 

............. 22 

............. 24 

............. 25 

............. 25 

............. 27 

logies 
 

       2 



  
 
 
                

 

Octo
 

PUERTO

 
October 
 
Ms. Anne
SBI Gran
National 
U.S. Dep
1401 Con
Washingt
 
Dear Ms.
 
Connecte
Puerto Ri
Broadban

These art
annual da
Availabili
Mapping 
 
 
Inventory
 
NOFA R
Appendix

Appendix

Appendix

Appendix

Appendix

Appendix

 

                     

ber 1, 2011    

O RICO CO

1, 2011 

e W. Neville 
nt Program D
Telecommun

partment of C
nstitution Av
ton, DC 2023

. Neville: 

ed Nation is p
ico Office of
nd Initiative (

tifacts should
ata update an
ity (NOFA) a
of Broadban

ry of Deliver

Requirement 
x A:  1(a)(i) 

x A:   1(a)(ii) 

x A:   1(b) 

x A:   3(b) 

x A:   4 

x A:   4 

                     

                     

OVER LETT

Director 
nications and

Commerce 
venue, NW R
30 

pleased to pr
f the Chief In
(SBI) Grant 

d be found to
nd in accorda
and all subse
nd Service Av

rables, Conn

Data
BB_S

BB_S

BB_S

BB_C

BB_S

n/a 

                   

                     

TER 

d Informatio

Room 4716 

resent this su
nformation O
Program, kn

o be complian
ance with the
equent clarific
vailability.  T

nect Puerto 

a Transfer Mo
Service_Cen

Service_Road

Service_Wire

ConnectionP

Service_CAI

                     

                     

n Administra

ubmission on
Officer, and t
nown as Conn

 
nt with the O

e terms of the
cations perta

This packet in

o Rico: Octob

odel
susBlock

dSegment

eless

Point_Middle

Institutions

                  C

                    

ation 

n behalf of th
the Common
nect Puerto R

October 1, 20
e July 1, 2009
aining to deliv
ncludes: 

ober 1, 2011

Data
Broa
Facili
Cens
Than
Broa
Facili
Segm
in Ar
Broa
Wire
a Spe

eMile Broa
Midd
Inter

 Com
Listin
Com
Narr

Connect Puerto 

                     

he Designate
nwealth of P
Rico. 

011, deadline
9, Notice of 
very of Terri

a Description
adband Servic
lities-Based P
sus Blocks of
n Two Square
adband Servic
lities-Based P

ment in Censu
rea Than Tw
adband Servic
eless Services
ecific Addres
adband Servic
dle-Mile and 
rconnection P

mmunity Anch
ng 

mmunity Anch
ratives 

Rico Methodol

                     

d Entity, the
uerto Rico’s 

e for the sem
Funds 
itory-Level 

n 
ce Availabilit
Providers in 
f No Greater
e Miles in Ar
ce Availabilit
Providers by 
us Blocks La

wo Square Mil
ce Availabilit
 Not Provide

ss 
ce Infrastruc
Backbone 
Points 
hor Institutio

hor Institutio

logies 
 

       3 

e 
State 

mi-

ty of 

r 
rea 
ty of 
Road 

arger 
les 
ty of 
ed to 

cture 

ons-

ons-



  
 
 
                

 

Octo
 

VII.A.1(a
n/a 

n/a 

n/a 

n/a 

 
In additio
program 
Administ
program.

 
S
T
D
h
as
 
A
T
th
w
C
cu
ac
re
a 
 

This Octo
continues
and the B
level broa
and main
broadban
 
Broadba
 
This data
percent o
participat

 

                     

ber 1, 2011    

a) 

on, this data u
requirement

tration since 
  Specifically

BI Data Tra
The submissio
Data Transfer

ave been ma
s much infor

Additional Su
This submissi
he April 2011

why data disp
Changes can i
ustomers, an
ctivated DSL
evisions to sp
previously e

ober 2011 se
s to demonst
Broadband D
adband mapp

ntenance of th
nd planning. 

and Service A

a update subm
of the Puerto
ting provider

                     

                     

n/a 
Data

n/a 

n/a 

n/a 

update subm
s instituted b
the time of t

y, these new r

ansfer Mode
on of the bro
r Model as re
ade to comply
rmation on ea

ubmission G
on also inclu
1 submission
lays and/or s
include upgra

n expansion o
LAMs, etc.), o
peed tier info
xisting provi

emi-annual da
trate our ded

Data Improve
ping data, dev
he National B

Availability 

mission unde
Rico provid

rs and 1 addit

                   

                     

aPackage.xlsx

mission shoul
by the Nation
the April 201
requirements

el 
oadband data
eleased on th
y with forma
ach provider

Guidance 
udes a list of 
n and the Oct
supplied spee
ades to infras
of the service
or a new pro
ormation that
ider that has 

ata update un
dication to im
ement Act (B
veloping stat
Broadband M

y — Provider

er the SBI pro
der communi
tional non-pa

                     

                     

x

d be found t
nal Telecomm
1 SBI data su

s are: 

aset for Octo
e Grantee W

atting, domai
r as possible. 

changes and 
tober 2011 su
eds, etc. are d
structure to a
e area (e.g. ad
ovider in the m
t was previou
not yet been

nder the Stat
mplementing t
BDIA) by gat
te-level broad
Map, and und

r Outreach a

ogram includ
ty, or 16 of 1
articipating p

                  C

                    

Accu
Work
Infor
Prov
List o
to th
Non-
Narr
Broa
Parti

to be complia
munications 
ubmission fo

ober 1, 2011, 
Workspace on
in, and metad
 

corrections 
ubmission. T
different from
allow for hig
dditional fixe
marketplace.
usly reported

n submitted in

te Broadband
the joint pur

thering comp
dband maps,
dertaking stat

and Verifica

des datasets f
18 total prov
provider who

Connect Puerto 

                     

uracy and Ve
ksheets of Co
rmation, Rec

vider Summar
of Changes a

he Dataset 
-Participating

ratives 
adband Provi
cipation Stat

ant with the 
and Informa
or the Conne

is contained
n June 30, 20
data requirem

made to the 
This represen
m the previo

gher throughp
ed wireless to
. Corrections
d incorrectly 
n a semi-ann

d Initiative G
rposes of the
prehensive an
, aiding in th
tewide initiat

ation 

for approxim
viders.  There
ose estimated

Rico Methodol

                     

rification Re
ontact 

cord Count, a
ry Table 
and Correctio

g Provider 

ider Roster a
tus 

additional 
ation 
ect Puerto Ri

d within the S
11. All effort

ments to inclu

dataset betw
nts a summar
ous submissio
put speeds fo

owers, recentl
s can include 
or the additi

nual dataset.  

Grant Program
e Recovery A
nd accurate s
e developme
tives for 

mately 88.89 
e are 15 
d coverage ar

logies 
 

       4 

port 

and 

ons 

nd 

ico 

SBI 
ts 
ude 

ween 
ry of 
on. 
or 
ly 
 
ion of 
 

m 
Act 
state-
ent 

reas 



  
 
 
                

 

Octo
 

have been
coverage 
participat
in the atta
 
As the af
collective
were mad
pursuant 
 
Connect 
means. In
conducts 
field verif
Validation
 
The Conn
outreach 
participat
submit br
 
As an ind
unique vi
4,130 visi
20, 2009, 
Additiona
period (6
allows the
map. The
the Conn
vehicles t
affirmatio
artifacts. 
broadban
field valid
 
Commun
 
Connect 
broadban
requireme
 
In conjun
conducte

 

                     

ber 1, 2011    

n submitted. 
area(s), whil

tion status an
ached datase

forementione
e opinion of t
de to account
to this semi-

Puerto Rico 
n addition to 
field validati

fication activ
n Methodolo

nect Puerto R
and data col

te in the proc
roadband inq

dicator of sta
isits during th
its to the Spa
which includ

ally, this pron
2 grant incep
e consumer t
ese consumer
nect Puerto R
to provide in
on or contest
 Since the ini

nd inquiries h
dation, which

unity Anchor

Puerto Rico 
nd connectivi
ents of the S

nction with th
d during this

                     

                     

Of the 15 pa
e 6 have repo

nd contact re
ts were non-

ed roster and
the Connect 
t for 100 per
-annual data 

has also con
confirmatio

ion efforts.  T
vities. Additio
ogy. 

Rico website
lection effor
cess by offeri
quiries, or co

keholder pen
his reporting 
anish website
des 3,984 to 
nounced We
ption to date)
to confirm o
r-initiated act

Rico interactiv
formation re
t of the repor
itial data coll

has allowed C
h is scheduled

r Institution

has establish
ity of Comm
BI NOFA T

he Puerto Ri
s data update

                   

                     

articipating p
orted no cha
cord is conta
-responsive t

attached me
Puerto Rico

rcent of the k
update subm

ntinued to per
n of service a
To date, 12 (
onal details o

e, www.conne
t.  This prog
ing interactiv

ontact a progr

netration, the
g period, whic
e (9,078 total 
the English w
b activity net
).  The websi
r dispute the
tions are faci
ve mapping t
egarding avail
rted data rep
lection and re
Connected N
d as soon as 

ns  

hed an ongoin
munity Ancho
Technical App

ico Office of
e reporting pe

                     

                     

providers, 9 s
ange.  A comp
ained herein.
o multiple co

ethodology d
 principals th

known Puerto
mission. 

rform broad
area(s) by eac
(66.67 percen

on verification

ectpr.org, co
gram asset pro
ve tools for u
ram represen

e Connect Pu
ch includes 1
to date for t

website and 
tted 38 broad
ite also provi
e coverage re
ilitated throu
tool (Broadb
lability in the

presented in t
elease of cor

Nation to iden
possible.  

ng mechanis
or Institution
pendix.   

f the Chief In
eriod by Con

                  C

                    

supplied an u
plete roster b
  The 2 prov
ontact attemp

documentatio
hat all comm
o Rico broad

dband verifica
ch provider, 
nt) providers
n activities ar

 
ontinues to se
ovides a way

users to test t
ntative.   

uerto Rico w
1,289 visits to
the life of the
5,094 to the 
dband inquir
ides the Broa

epresented on
ugh the Conn
bandStat) tha
eir respective
the Connect 
rresponding m
ntify addition

sm for gather
ns (CAI), in a

nformation O
nnect Puerto 

Connect Puerto 

                     

update to the
by provider d
viders that are
pts.   

on will attest,
mercially reaso
dband provid

ation activitie
Connect Pu

s have been v
re contained 

erve a promin
y for the gene
their connect

website encou
o the English
e grant award
Spanish web

ries over this 
adbandStat a
n the broadb
nect Puerto R
at offer the ci
e service area
Puerto Rico
maps, feedba
nal areas that 

ring data on t
accordance w

Officer, outre
Rico to con

Rico Methodol

                     

eir network o
depicting 
e not represe

, it is the 
onable effort
der communi

es through se
uerto Rico 
validated thro

within the F

nent role in t
eral public to
tion speed, 

untered 5,419
h website and
ded on Dece
bsite).  

same report
application, w
band inventor
Rico website 
itizens the 
a, either in 
 mapping 
ack in the for
t are in need 

the location 
with the data 

each was 
tinue 

logies 
 

       5 

or 

ented 

ts 
ity, 

everal 

ough 
Field 

the 
o 

9 
d 
ember 

ting 
which 
ry 
and 

rm of 
of 

and 



  
 
 
                

 

Octo
 

identifica
continues
reporting
associatio
participat
relationsh
and raise 
 
Connect 
Rico Bro
newspape
this data 
Broadban
along wit
increasing
 
 
The Conn
broadban
Common
Broadban
 
Respectfu
 
 
 
Thomas W
Chief Op
Connecte
 
cc:  Juan 
      Gove
 
 

 

                     

ber 1, 2011    

ation of existi
s to be made
g period Conn
ons to promo
tion in this da
hips over the
awareness o

Puerto Rico 
adband Task
ers.  From ou
to future col
nd Map.  We
th an investm
g the data tha

nect Puerto R
nd services an
nwealth of Pu
nd Map.  We

ully submitte

W. Ferree 
perating Offic
ed Nation, In

Eugenio Rod
ernment of P

                     

                     

ing, centraliz
 available for
nect Puerto R
ote the impor
ata collection

e coming mon
f this project

is beginning
k Force and t
ur work in Pu
laboration ef
 plan to cont

ment of both 
at is secured 

Rico program
nd to assist in
uerto Rico, a
 look forwar

ed, 

cer 
nc. 

driguez de H
Puerto Rico 

 

                   

                     

ed sources fo
r all institutio
Rico has con
rtance of bro
n process.  C
nths and util
t. 

g to coordinat
through the d
uerto Rico, a
fforts within 
tinue to bring
human and t
and reported

m exists to im
n the extensi
s well as the 

rd to the cont

Hostos, CIO

                     

                     

or CAI conn
ons on the C
ntinued devel
oadband conn

Connect Puer
lize its contac

te our outrea
distribution o
as well as oth
the common
g best practic
technical reso
d as part of t

mprove data o
on of broadb
United State
tinuing work

                  C

                    

nectivity data
onnect Puert
loping relatio
nectivity at a

rto Rico will c
cts througho

ach through t
of press relea
her states, we
nwealth as w
ces to the Co
ources requir
this process.�

on the deplo
band technol
es through co
k ahead. 

Connect Puerto 

                     

.  Additional
to Rico webs
onships with 
anchor institu
continue to b

out the territo

the newly fo
ases to local i
e recognize th
well as its valu
onnect Puert
red to reach 
�

oyment and a
logy across a
ontribution t

Rico Methodol

                     

lly, a CAI sur
site.  During 
territory-wid

utions and 
build upon th
ory to collect 

rmed Puerto
island 
he great value
ue to the Nat
to Rico effort
our goal of 

adoption of 
all regions of 
to the Nation

logies 
 

       6 

rvey 
this 

de 

hese 
data 

o 

e of 
tional 
ts, 

f the 
nal 

dclark
Cueball



  
 
 
                

 

Octo
 

DATA A
METHO

In this fo
the Puert
mechanis
Institutio
During th
outreach 
 
Connect 
territory-w
manual so
 
Connect 
in both S
developed
gathering
Puerto Ri
througho
customiz
 
The surve
http://co
 
During th
education
Rico mad
to locate 
 
In tandem
CAI cont
importan
key CAI a
continue 
As part o
the island
be release
  
Connect 
importan
about the
inclusion 
relationsh

 

                     

ber 1, 2011    

ACQUISITIO

ODOLOGY  

ourth reportin
to Rico Offic
sm for gather
ns (CAI), in 
his reporting 
and raising a

Puerto Rico 
wide outreac
ourcing and g

Puerto Rico 
panish and E
d during the 

g spreadsheet
ico will conti

out the comin
ed to fit the 

ey can be acc
onnectpr.org

his reporting 
n sector, to id
de contact wi
any addition

m with these 
tacts in an ef

nce of CAI br
associations 
to utilize the

of this outrea
d to distribute
ed within the

Puerto Rico 
nce of particip
e importance
on the Natio

hips that are 

                     

                     

ON:  PUERT

ng period of 
ce of the Chie
ring data on t
accordance w
period Conn

awareness of 

has continue
ch campaign.
geocoded by

continues to
English, with
first reportin

t, was distribu
inue to use th
ng months le
CAI categori

cessed at this
/mapa/recop

period Conn
dentify existin
ith numerous

nal centralized

efforts to id
ffort to distrib
roadband con
that are parti

e contacts of 
ch Connect P
e a customiz

e coming mo

has an ongo
pating in the 
 of broadban
onal Broadba
already being

                   

                     

TO RICO C

the SBI, Con
ef Informatio
the location 
with the data
nect Puerto R
f this importa

ed to identify
  Physical ad

y Connect Pu

o utilize a cus
h a landing pa
ng period.  T
uted to a targ
hese data-gat
ading up to t
ies as defined

s link in both
pilacion_de_

nect Puerto R
ng, centralize
s contacts ac
d sources for

entify existin
bute and pro
nnectivity.  C
icipating in th
these associa

Puerto Rico 
ed joint surv
nths, and dat

ing mission t
project.  Par

nd connectiv
and Map.  Co
g developed 

                     

                     

COMMUNIT

nnect Puerto
on Officer (O
and broadba

a requiremen
Rico has con
ant project. 

y and process
ddress inform
uerto Rico.  

stomized onli
age on the Co

This survey, in
geted list of C
thering tools 
the next repo
d in the SBD

h English and
_datos__de_i

Rico conduct
ed sources fo
ross the islan
r CAI data. 

ng data, Conn
omote the on
Connect Puer
he Puerto Ri
ations leadin
is specifically

vey that will t
ta will be rep

to educate C
rticipation by

vity and the n
onnect Puert
through the 

                  C

                    

TY ANCHO

o Rico, worki
OCIO), has e
and connectiv
nts of the SBI
ntinued to foc

s CAI data o
mation contin

line survey ho
onnect Puert
n combinatio
CAI through
 for future ta
orting period

DD NOFA.  

d Spanish: 
instituciones_

ted research,
or CAI conne
nd across all 

nect Puerto R
nline survey a
rto Rico is es
ico Broadban

ng up to the A
y working wi
target healthc
ported for the

CAI througho
y these institu
need to repor
to Rico will c
work of the 

Connect Puerto 

                     

OR INSTITU

ing in close c
established a
vity of Comm
I NOFA Tec
cus efforts on

obtained thro
nues to be aug

osted throug
to Rico webs
on with a cus
hout the islan
argeted outre
d.  These mat

_comunitaria

, specifically w
ectivity data.
CAI sectors 

Rico continu
and raise awa
stablishing re
nd Task Forc
April 2012 su
ith key health
care facilities
e April 2012 

out the territo
utions will ra
rt the request
continue to b
Puerto Rico 

Rico Methodol

                     

UTIONS 

coordination 
an ongoing 
munity Anch
chnical Appe
n conducting

ough an ongo
gmented thr

gh SurveyMo
site that was 
stomized dat
nd.  Connect 
each efforts 
terials are 

as_ancla.php

within the 
  Connect Pu
but was una

ues to identify
areness of the
elationships w
ce and will 
ubmission pe
hcare contact
.  This surve
submission.

ory on the 
aise awarenes
ted data for 
build off the 

Broadband 

logies 
 

       7 

with 

hor 
endix.  
g 

oing 
ough 

onkey 

a-

p 

uerto 
able 

y key 
e 
with 

eriod.  
ts on 

ey will 
 

ss 

Task 



  
 
 
                

 

Octo
 

Force and
the Q420
to small i
data for t
 
The great
broadban
relationsh
Task For
up to the 
 
A CAI su
 

C

K-12 
Libraries
Healthca
Public Sa
Higher E
Other Go
Other No
Total 

 
 
 
SBI DA

The subm
Transfer 
Connecte
model an
for the te
and territ
Technical
followed 
checklists
Transfer 
 
As part o
submissio
coverage 
on other 
Providers
eliminate

 

                     

ber 1, 2011    

d work with 
011.  Addition
sland newspa

this project. 

test challenge
nd connectivi
hips that are 
ce.  Connect
April 2012 s

ummary of al

CAI Type 

s 
are 
afety 
Ed Institutions
overnment 
on-Governmen

ATA SUBMIS

mission of th
Model and a

ed Nation ha
nd recognizes
erritory, as it 
tories and po
l Mapping G
to ensure th

s, completing
Model, and c

of the ongoin
on of the Da
and accomp
providers th
s deemed non
d for reasons

                     

                     

the OCIO to
nally Connec
apers with a 

e with collect
ity data.  Con
being formed

t Puerto Rico
submission. 

ll processed a

Total 

1,992 
154 
621 
279 

s 549 
6 

nt 1,508 
5,109 

SSION MET

e broadband
additional com
as reviewed al
s that it does 
is meant prim

opulate the N
Guide, as relea

e completene
g the DataPa
checking the 

ng review and
ataPackage sp
panying attrib
at are consid
n-viable that
s such as (i) t

                   

                     

o release a ta
ct Puerto Ric
CAI press re

ting this data
nnect Puerto
d and our wo

o expects not

and submitte

Physical 
Address

1,992
154 
620 
278 
549 
6 

1,448
5,047

THODOLO

d dataset for O
mponents as
ll literature th
not replace o

marily as a m
National Broa

ased on the G
ess and valid
ckage spread
dataset using

d analysis pro
preadsheet. In
butes are subm
dered to be n
t have been e
the company

                     

                     

rgeted CAI n
co and the O
elease that wo

a continues to
 Rico is over
ork with the 
ted progress 

ed data is pro

Lat/Long

1,687
153 
139 
277 
88 
1 

979 
3,324

GY 

October 1, 2
 released on 
hat relates to
or dictate ho

means to trans
adband Map i
Grantee Wor

dity of the sub
dsheet, uploa
g the SBDD

ocess, NTIA 
n addition to
mitted in the
on-viable is a

excluded from
y offers Inter

                  C

                    

newsletter to
CIO have m
ould promot

o be the diffi
rcoming this 
OCIO and t
to occur ove

ovided below

g 
Technol
Transm

1,50
3
0
21
21
0
8

1,55

2011, is conta
the Grantee 

o the release a
ow data is sto
sfer the broa
in a seamless
rkspace on M
bmission thr

ading broadb
D_CheckSubm

has requeste
o the informa
e SBI Data T
also included
m continued 
rnet service b

Connect Puerto 

                     

o assist with o
made plans to
te the value o

ficulty in secu
challenge th

the Puerto Ri
er the coming

w: 

logy of 
mission 

Dow
S

01 

 
 

54 

ained within 
Workspace 

and use of th
ored, process
adband data f
s fashion. Gu

March 24, 201
rough comple
and datasets 

mission recei

ed further inf
ation on prov

Transfer Mod
d in the Data
outreach ma

but at speeds 

Rico Methodol

                     

outreach duri
 target outre

of providing 

uring CAI 
hrough new 
Rico Broadban

g months lea

wnload 
Speed 

Up
S

1 
2 
0 
11 
16 
0 
5 
35 

the SBI Data
on June 30, 2

his data trans
ed, or display
from all state
uidance from
11, was also 
etion steps an
into the Dat

ipt process. 

formation in 
viders whose

del, informati
aPackage. 
ay have been
below the 

logies 
 

       8 

ing 
ach 
CAI 

nd 
ading 

pload 
peed 
1 
2 
0 
11 
16 
0 
5 
35 

a 
2011. 
sfer 
yed 
es 

m the 

nd 
ta 

the 
e 
ion 

 



  
 
 
                

 

Octo
 

current d
provider,
install net
and (iv) th
informati
outreach,
of an exe
 
In additio
informati
submitted
 
Inventory
 
NOFA R
Appendix

Appendix

Appendix

Appendix

Appendix

 
The prov
have been
of the SB
segments
connectio
contained
been mad
informati
 
Connecte
speed inf
class are t

 

                     

ber 1, 2011    

efinition of b
but is actual

twork infrast
he company 
ion that has b
, such as a Fe
cuted Nondi

on to the met
ion, the data 
d within the 

ry of Deliver

Requirement 
x A:  1(a)(i) 

x A:   1(a)(ii) 

x A:   1(b) 

x A:   3(b) 

x A:   4 

vider data col
n formatted p

BI Data Trans
s, wireless ava
ons and com
d at the censu
de to comply
ion as possib

ed Nation ha
formation, bu
the satellite c

                     

                     

broadband; (
lly a network
tructure, but 
has gone ou

been obtaine
ederal Registr
isclosure Agr

thodologies c
dictionary, a
SBI Data Tra

rables, Conn

Data
BB_S

BB_S

BB_S

BB_C

BB_S

llected by Co
per the given
sfer Model. W
ailability is co
munity anch
us block, roa
y with format
ble.  

as continued 
ut granular co
companies pr

                   

                     

(ii) the compa
k solution or 

does not act
ut of business
ed through th
ration Numb
reement, and

contained he
and a provide
ansfer Mode

nect Puerto 

a Transfer Mo
Service_Cen

Service_Road

Service_Wire

ConnectionP

Service_CAI

onnected Nat
n specificatio
Wireline avai
ontained as p

hor institution
ad segment, o
tting, domain

outreach to s
overage is no
roviding serv

                     

                     

any was listed
consulting fi

tually provide
s. The submi
he course of d
ber (if applica
d brief notatio

erein, as well 
er summary t
el for the Com

o Rico: Octob

odel
susBlock

dSegment

eless

Point_Middle

Institutions

tion on behal
ons and uploa
ilability is con
polygons of c
ns are contain
or wireless po
n, and metada

satellite prov
ot yet availabl
vice to Puerto

                  C

                    

d in advertise
irm, etc.; (iii) 
e the broadb
itted DataPac
due diligence
able), the com
ons regarding

as the DataP
table, the foll
mmonwealth

ober 1, 2011

Data
Broa
Facili
Cens
Than
Broa
Facili
Segm
in Ar
Broa
Wire
a Spe

eMile Broa
Midd
Inter

 Com
Listin

lf of the Com
aded into the
ntained withi
coverage area
ned as point 
olygon level 
ata requirem

viders on thei
le. Submitted
o Rico as a p

Connect Puerto 

                     

ements as a b
 the compan

band service t
ckage include
e and/or dire
mpany’s URL
g the status o

Package.xls c
lowing featur

h of Puerto R

a Description
adband Servic
lities-Based P
sus Blocks of
n Two Square
adband Servic
lities-Based P

ment in Censu
rea Than Tw
adband Servic
eless Services
ecific Addres
adband Servic
dle-Mile and 
rconnection P

mmunity Anch
ng. 

mmonwealth
e appropriate
in census blo
as, and middl
data. All spe
of availability

ments to inclu

ir availability
d within the w

polygon of th

Rico Methodol

                     

broadband 
ny may build 
to consumer
es any releva
ect provider 
L, the existen
of the compa

containing co
re classes are

Rico. 

n 
ce Availabilit
Providers in 
f No Greater
e Miles in Ar
ce Availabilit
Providers by 
us Blocks La

wo Square Mil
ce Availabilit
 Not Provide

ss. 
ce Infrastruc
Backbone 
Points. 
hor Institutio

h of Puerto R
e feature clas
ocks and road
le-mile 
eed data is 
y. All efforts

ude as much 

y, technology
wireless featu

he territory 

logies 
 

       9 

or 
s; 

ant 

nce 
any. 

ontact 
e 

ty of 

r 
rea. 
ty of 
Road 

arger 
les. 
ty of 
ed to 

cture 

ons-

Rico 
ses 
d 

 have 

y, and 
ure 



  
 
 
                

 

Octob
 

boundary
based on 
 
 
 
PROVID

As reques
between t
informati
data inclu
network t
addition o
coverage 
the April 
 

Corre
• 

• 

• 

• 
• 

• 

 
Chan

• 
• 
• 
• 

 
 
 
 

 

                     

ber 1, 2011      

y. Efforts wil
availability a

DER CHANG

sted by the S
the April 201
ion is presen
ude expansio
to provide hi
of previously
or speed inf
2011 dataset

ections 
Ayustar C
October 2
Critical H
for Octob
Hughes N
included in
boundary,
Liberty Gl
Puerto Ric
April 2011
2011 subm
Puerto Ric
past subm

nges and/or
AT&T Mo
Puerto Ric
Sprint Ne
T-Mobile 

                     

                     

ll continue to
analyses and g

GES AND C

SBI Program 
11 and Octob
ted in this se
n of service 
igher downlo
y existing pro
formation tha
t. 

Corporation (
2011 submiss
ub Networks

ber 2011 subm
Network Syste

n the April 2
, work contin
lobal, Inc. (c
co Cable Acq
1 submission
mission. 
co Telephon

missions but m

r Correction
obility LLC (
co Telephon
xtel Corpora
USA, Inc. (m

 

                   

                     

o collect, pro
guidance rec

CORRECTIO

Office, a list
ber 2011 sub
ection as well
area(s), activ
oad speeds to
oviders whos
at was incorr

fixed wireles
sion. 
s (fixed wirel
mission. 
ems, LLC (sa

2011 submiss
nues on havin
able): Provid
quisition Com
n or October

ne Company I
made data av

ns – Entirely
(mobile wirel

ne Company I
ation (mobile
mobile wirele

                     

                    

cess, or othe
ceived from N

ONS FOR O

ting of the ch
bmissions is i
l as in the Br
ation of new
o consumers.
se coverage h
rect, and any 

s): No prior 

less): No prio

atellite): Satel
sion. While c
ng more gran
der supplied c
mpany, Inc. (
2011 submis

Inc. (mobile 
vailable for th

y New Data
less) 
Inc. (DSL) 

e wireless) 
ess) 

                  C

                     

erwise create 
NTIA.  

OCTOBER 2

hanges and/o
included in th
roadband Pro
w wireless tow

. Corrections
has never bee
other items 

participation

or participati

llite data is b
overage is cu
nular data av
corrections t
(cable): Did n
ssion but wil

wireless): Pr
he October 2

set Submitt

Connect Puerto 

                     

more granul

2011 

or correction
his narrative.
ovider Log. C
wers, and upg
s to the datas
en submitted
that were mi

n. Provider su

ion. Provider

being submitt
urrently the e
vailable. 
to previous d
not provide 
ll be included

rovider has n
2011 submiss

ted 

Rico Methodol

                     

lar satellite da

ns to the data
. This 
Changes to th
grades to the
set include th

d, revision of 
isrepresented

upplied data 

r supplied da

ted and was n
entire territor

dataset. 
approval for
d in the Octo

not participat
sion. 

logies 
 

     10 

ata 

asets 

he 
e 
he 

d in 

for 

ata 

not 
ry 

r 
ober 

ed in 



  
 
 
                

 

Octob
 

 PUERT

Connecte
 

• co
37

• co
sm

• id
re
d

• cr
w

• va
G
T

• lo
co

• co
h
sp

 
Additiona
that all kn
members
Book, Pu
Commerc
 
To date, C
providers
Data@cc
Telephon
 
From pro
field valid
percent w
 
Connecte
platform 
paramete
question 
below. 
 

 

                     

ber 1, 2011      

TO RICO FI

ed Nation foc

onducting ra
7-XP spectru
onducting m
mart phone) 
dentifying pre
eferencing da
atabases such
ross-referenc

well as the FC
alidating pro

Garmin eTrex
Trips; 
ocating physi
omparing the
onducting on
ttp://www.b
peed test util

ally, Connect
nown broadb
ship logs from
ublic Utility C
ce, etc. 

Connected N
s:  Areonet W
cess; Liberty 
ne Company;

ogram initiati
dation testing
within the Co

ed Nation ha
listings, and 
rs. Any prov
have been fu

                     

                    

IELD VALID

cused a porti

ndom spectr
um analyzer; 

mobile speed t
as well as pr
e-selected, pr
ata about tha
h as Antenna
cing Federal R
CC COmmiss
vider submit

x Summit GP

ical wire-line 
em against pr
n-net and off
broadband.go
lity located on

ted Nation cr
band provide
m the trade a
Commission r

Nation’s staff
Wireless; AT&
Cablevision o
; Sprint Next

ion through t
g against 12 c
ommonwealth

as also contin
other intrica

viders whose 
urther review

 

                   

                     

DATION M

ion of its tim

rum analysis 

tests through
rovider-speci
rovider-subm
at tower again
a Structure R
Registration 
sion REgistr
tted data (for
PS unit or GP

attributes (su
rovider subm
f-net speed te
ov/qualitytes
n each of Co

ross-referenc
ers were locat
associations (
records, Pub

f conducted o
&T, Inc.; Cho
of Puerto Ri
tel Corporati

this reporting
companies (o
h of Puerto R

nued to review
acies that may
submitted co

wed and confi

                     

                     

METHODOL

me on specific

studies throu

hout the terri
fic aircards (S

mitted wireles
nst the Feder

Registration a
Number dat

ration System
r example: lat
PS enabled s

uch as Remo
mitted data; a
ests using the
st/about/ or 
onnected Nat

ced numerou
ted and cont
(WISPA, WC
blic Service C

on-site valida
oice Commu
co Ltd.; Nep
on; T-Mobile

g period, Co
out of a unive
Rico.   

w provider d
y fall outside
overage and 

firmed; detail

                  C

                     

LOGY 

c validation p

ughout the te

itory using an
Sprint 3G/4
ss transmit to
ral Communi
and/or the U
ta against ava

m (CORES);
titude/longit
software such

ote terminals,
and  
e FCC portal

r using the O
tion’s state-sp

us public doc
tacted.  This 
CAI, PCIA, e
Commission r

ation tests in
unications; Cr
ptuno Media;
e; and World

nnected Nat
erse of 18 via

datasets for a
e of the stand
attributes are
s on a case-b

Connect Puerto 

                     

processes suc

erritory using

n iPhone, An
4G, Clearwire
ower sites an
ications Com

Universal Lice
ailable FCC F

tude) using a 
h as Microso

, CATV plan

l at 
Ookla Net Me

pecific websi

cuments in or
included sea

etc.), the Cab
records, Cha

n Puerto Rico
ritical Hub N
; OneLink; P
dnet. 

tion has com
able provider

accurate spee
dard SBI Dat
e anticipated
by-case basis 

Rico Methodol

                     

ch as: 

g an Avcom P

ndroid (or oth
e et al); 
nd cross-
mmission (FC
ensing System
Form 477 da

 handheld 
ft Streets and

nt, etc.) and 

etrics enabled
ites. 

rder to ensur
rching 

ble Television
amber of 

o on the follo
Networks; 
Puerto Rico 

mpleted in-the
rs) totaling 6

d informatio
ta Transfer M

d to come int
are presente

logies 
 

      11 

PSA-

her 

CC) 
m; 
ta as 

d 

d 

re 

n Fact 

owing 

e-
66.67 

on, 
Model 
o 

ed 



  
 
 
                

 

Octob
 

Choice C
Issue: Te
than expe
Resolutio
area, inclu
 
 
 
DATA S
PROVID

 
As part o
processes
broadban
SBDD m
 
The follo
LLC (d.b
area, expl
validation
 
Backgro
CN staff 
one-on-o
OCIO, to
Septembe
of their in
failed to m
 
The Issu
OneLink
initiative. 
provider 
of the OC
 
Identific
CN began
with info
the Junta 
once ope
Registrati
did not yi

 

                     

ber 1, 2011      

Cable 
chnology of 
ected value ra
on: Provider r
uding at the 

UBMISSION

DER 

of its ongoing
s with the go
nd provider, r

mapping initia

owing narrativ
.a. OneLink)
laining how a
n techniques 

und 
members att

one provider 
o discuss the 
er 24 at 10:00
ntent to canc
motivate On

ue 
, by its lack o
This surface
will continue
CIO. 

cation of Pro
n building a 
rmation obta
Reglamenta
rated by Ade
ion Number 
ield results.  

                     

                     

transmission
ange for the 
representativ
12 Mbps dow

N AND COV

San J

g broadband 
al of submitt
regardless of
ative. 

ve will discus
), a cable tele
and where CN
that support

tended meeti
meetings, wh
SBDD gran

0 a.m.; howev
cel). Outreach
neLink into ei

of actions, in
ed as a proble
e to threaten 

ovider’s Leg
file based on
ained through
dora de Tele
elphia was th
(“FRN”) on
It was later d

                   

                     

n 40 with a m
technology.

ve confirmed
wnload speed

VERAGE E

Juan Cable,

mapping eff
ting mapping
f whether the

ss the recent 
evision and ca
N obtained p
t the underlyi

ings in Puert
hich had bee

nt program.  O
ver, no one f
h efforts con
ither respond

dicated its un
em during th
to skew futu

gal Name, d
n anecdotal in
h the public 

ecomunicacio
he same territ
n the FCC CO
discovered th

                     

                    

maximum adv

d that DOCSI
d offering. 

STIMATION

e, LLC (d.b.a

forts, Connec
g data to NT
e provider ha

data collecti
able modem 
publicly avail
ing data.   

o Rico from 
n scheduled 
OneLink was
from the com

nducted from
ding or partic

nwillingness 
he first two st
ure research a

d.b.a., and F
nformation a
domain.  Fo

ones de Puert
tory now ope
Ommission R
hat the entity 

                  C

                     

vertised down

IS 3.0 is in u

N OF NON

a. OneLink)

cted Nation h
TIA for every
as chosen to 

ion activities 
provider in 

lable data and

September 2
by Maria Po
s scheduled t
mpany arrive

m September 
cipating in th

to participat
tages of map
and planning

FRN 
and, as time p
r example, C
to Rico (“JRT
erated by On
REgistration

y of record wi

Connect Puerto 

                     

nload speed 

use throughou

N-PARTICIP

k) 

has develope
y known and 
support and 

related to Sa
the San Juan
d the “on-th

21-25, 2009, 
ou, Special As
to attend a m
d (nor did th
2009 throug

he mapping i

e in the islan
pping; the lac
g activities un

progressed, e
CN received i
T”) indicatin

neLink.  A se
n System (“C

with the JRT w

Rico Methodol

                     

in tier 7, low

ut their servi

PATING 

ed a series of
qualifying 
participate in

an Juan Cable
n, Puerto Rico
he-ground” 

for a series o
ssistant to th

meeting on 
hey notify Ma
gh July 2011 h
nitiative. 

nd-wide mapp
ck of data for
nder the dire

enriched the f
information 

ng that territo
arch for a Fe
ORES”) syst
was, in fact, S

logies 
 

     12 

wer 

ice 

f 

n the 

e, 
o 

of 
he 

aria 
has 

ping 
r this 
ction 

file 
from 

ory 
ederal 
tem 
San 



  
 
 
                

 

Octob
 

Juan Cab
A) and ad
submissio
 

 

                     

ber 1, 2011      

le, LLC.  A n
dditional con
on summary 

                     

                     

new search o
ntact data.  Th
comparison 

Exh

                   

                     

on the FCC C
his was later 
against FCC

Exhi

hibit B: SBB

                     

                    

CORES site y
confirmed w

C Form 477 f

ibit A:  FRN

 
 
 

BD Form 477

                  C

                     

yielded an FR
when NTIA p
filers (Exhib

N 

7 Reference

Connect Puerto 

                     

RN of 00137
provided CN

bit B). 

e

Rico Methodol

                     

778857(Exhi
N with a 

logies 
 

     13 

ibit 

 



  
 
 
                

 

Octob
 

 
Identific
Connecte
(Exhibit
the greate
 

 

 

 

                     

ber 1, 2011      

cation of Pro
ed Nation ex
 C) and used
est advertised

                     

                     

ovider’s Cov
tracted the m

d the compan
d extent of O

E

 

                   

                     

verage Area
municipio bo
ny’s publishe

OneLink’s ser

Exhibit C: M

Exhibit D

                     

                    

undaries from
d boundaries
rvice area. 

Municipal Bo

 

D: GIS Shap

                  C

                     

m OneLink’s
s to create a 

oundaries 

pefile 

Connect Puerto 

                     

s publicly ava
GIS shapefil

Rico Methodol

                     

ailable websi
le (Exhibit D

  

 

logies 
 

     14 

ite 
D) of 



  
 
 
                

 

Octob
 

These po
attempted
extracted
submitted
 

 
Using thi
out on an
modems 
Connecte
operators
 
Testing T
Specific q
goal was 
plant – w
 

 

                     

ber 1, 2011      

olygons were 
d communica
from OneLi

d by OneLin

E

is combined 
n exploratory
likely existed

ed Nation de
s) to conduct

Techniques
quadrants (E
to drive thro

whether fiber 

                     

                     

then compar
ation (Exhib
ink’s website
k. 

Exhibit E:  

coverage pol
y “drive test”
d in the great
eployed five s
t a thorough 

s 
Exhibit F) we
ough each of 
or coaxial. 

                   

                     

red against th
bit E).  The p
e, and the red

OneLink Fr

lygon as the b
 to determin

ter San Juan a
staff member
analysis of O

ere assigned 
the areas and

                     

                    

he only data su
purple-shade

d outlines illu

 
ranchise Bo

basis for furt
ne where cabl
area.  During
rs (all highly 

OneLink’s all

to each of th
d determine 

                  C

                     

upplied by O
ed area was t
ustrate the fra

oundary Sub

ther investiga
le plant exist
g the period o
trained, form

leged coverag

he validation 
the existence

Connect Puerto 

                     

OneLink durin
the CN cover
anchisee bou

bmission 

ation, Conne
ed and estim
of February 

mer telecomm
ge area.  

teams on a d
e (or lack the

Rico Methodol

                     

ng the course
rage polygon
undaries 

 

ected Nation 
mate where ca

7-11, 2011, 
munications 

daily basis.  T
ereof) of CAT

logies 
 

     15 

e of 
n 

 set 
able 

The 
TV 



  
 
 
                

 

Octob
 

Test poin
which als
was ident
likely to e
conducte
modem s

 

                     

ber 1, 2011      

nts were pre-
so created a G
tified, marker
exist. Connec
d random in

service. 

                     

                     

selected and 
GPS-enabled
rs were place
cted Nation s

nterviews with

E

                   

                     

Exhibit F: 

entered into
d “trace route
ed within Stre
staff member
h residents w

Exhibit G: T

                     

                    

Sample Qu

 
o Microsoft’s 
e” of each da
eets & Trips, p
rs then proce

within the are

Test Point L

                  C

                     

uadrant 

Streets & Tri
ay’s drive test
pinpointing t
eeded to stop
ea querying th

Locations 

Connect Puerto 

                     

rips software (
ting activities
the areas wh
p at points al
he actual ava

 

Rico Methodol

                     

(Exhibit G)
s. As cable pl
ere service w
long the way
ailability of ca

logies 
 

     16 

, 
lant 

was 
y and 
able 

 



  
 
 
                

 

Octob
 

Based on
specify th
illustratio
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
Visual ide
The Conn
little diffi
below the
 
 

 

                     

ber 1, 2011      

n the lack of v
he population
on below (Ex

entification o
nected Natio
iculty in iden
e earth’s surf

                     

                     

visible or trac
n areas where
xhibit H) rep

Ex

of physical CA
on team mem
tifying aerial 
face (undergr

E

                   

                     

ceable cable 
e the Connec
presents one

xhibit H: Co

ATV plant (E
mbers, many o

(above grou
round plant) 

xhibit I: On

                     

                    

plant, polygo
cted Nation s
 such gap are

overage Gap

Exhibit I) w
of whom we

und) CATV p
based simply

neLink Servi

                  C

                     

ons were crea
staff believed
ea identified 

p Polygon 

was relatively
ere former CA
plant or in loc
y on looking 

ice Truck

Connect Puerto 

                     

ated in ArcG
d coverage ga
during the d

y easy and str
ATV operato
cating plant t

g for specific 

Rico Methodol

                     

GIS Explorer 
aps existed. T

drive test. 

raightforward
ors, found ve
that traveled
cable routes.

logies 
 

     17 

to 
The 

d. 
ery 

d 
. 

 



  
 
 
                

 

Octob
 

The imag
(Exhibit
above-gro
 

 

 

 

                     

ber 1, 2011      

ges below dem
 J) and ident
ound pedesta

                     

                     

monstrates th
tify CATV pl
als (Exhibit 

Ex

 

                   

                     

hat the Conn
lant moving 
K) were easi

Exhibit 

xhibit K: Ab

                     

                    

nected Nation
from a pole 
ily traced and

J: Aerial P

bove Groun

                  C

                     

n team could
to an area wh
d identified.

Plant 

nd Pedestal

Connect Puerto 

                     

d, in fact, loc
here undergr

Rico Methodol

                     

cate aerial pla
round vaults 

 

 

logies 
 

     18 

ant 
or 



  
 
 
                

 

Octob
 

At the co
miles of t
surveyed 
determine
identified
 
Results a
As a resu
efforts, C
modem b
SBDD m
for collec
The imag
revisions 
demonstr
remaining
data subm
 

 
 
 

 

                     

ber 1, 2011      

onclusion of t
the OneLink
numerous lo
e maximum 

d and likely co

and Submis
ult of the coll
Connected Na
broadband se

mapping initia
cting and vali
ge below (Ex
made to the 

rate areas wh
g purple-shad
mission for th

                     

                     

this week-lon
k franchise ar
ocal residents
advertised co
overage area 

ssion for Oc
ection of pub
ation is subm
ervice area of
ative, CN has
idating the se
xhibit L) sho

advertised c
here the CN s
ded areas are
he October 1

 

                   

                     

ng exercise, C
ea, located ab
s, obtained co
onnection sp
of OneLink

tober 2011
blicly availab

mitting on be
f OneLink. W
s proceeded w
ervice area of
ows the exact
cable broadba
staff reasona
e included, al
1, 2011, deliv

Exhibit L: 

                     

                    

Connected N
bove-ground
ollateral mate

peeds), and cr
k.  

ble informatio
ehalf of the C
Without prov
with develop
f a currently 
t results of th
and availabili

ably believes “
ong with full

verable to NT

Validation R

                  C

                     

Nation had dr
d and underg
erial from O
reated a poly

on and the on
Commonwea
vider particip
ping a relevan
non-particip

he validation 
ity in the San
“gaps” exist 
l attributes, i
TIA for the S

Results 

Connect Puerto 

                     

riven through
ground plant,
neLink’s loc

ygon that illus

n-the-ground
alth of Puerto
ation and sup
nt and feasibl

pating broadb
efforts in ter

n Juan area. P
in the franch

in the Puerto
SBI grant pro

Rico Methodol

                     

h several hun
, visited with 
al offices (to
strates the 

d validation 
o Rico, the ca
pport of the 
le methodolo

band provide
rms of the 

Polygons in r
hise area. Th
o Rico broadb
ogram. 

logies 
 

     19 

ndred 
and 
 

able 

ogy 
er. 

red 
e 
band 

 



  
 
 
                

 

Octob
 

Sample O
 

 

                     

ber 1, 2011      

OneLink Ca

                     

                     

able Modem

                   

                     

m Collateral 

                     

                     

l Material 

                  C

                    

Connect Puerto 

                     

Rico Methodol

                     

logies 
 

     20 



  
 
 
                

 

Octob
 

ACCURA

Broadban
of compl
across all 
the data t
review.  T
geograph
broadban
issues tha
format or
sources a
work in t
represent
map(s) ar
other rev
approval;
provider 
the review
ready for 
 
Once the
and muni
can visit t
areas and
various p
and provi
as consum
identifyin
allows for
for Conn
validation
localized 
resolve in
provided 
 
Estimates
Rico1 hou
percent o

               
   1 In accor
includes bo
and upload

2 Due to 
geographic

 

                     

ber 1, 2011      

ACY AND V

nd providers 
exity and gra
providers an

that provider
The resulting
hic format – f
nd service are
at appear in t
r from the or

and through t
he field are a
ts the real-wo
re remedied b
visions. Revis
; Connected 
is in agreeme
w process ha
NTIA subm

e data collecti
icipality-level
the interactiv

d analyze corr
latforms allo
ide feedback
mers submit 
ng areas wher
r a follow-up

nected Nation
n of available
validation m

naccuracies a
to stakehold

s derived fro
useholds do 
of Puerto Ric

                   
rdance with NT

oth terrestrial fix
d speeds greater

the nature of t
units and stree

                     

                     

VERIFICATI

maintain the
anularity. In o
nd that it is a
rs are able to 
g map(s) and 
for some pro
ea. Having th
the data repre
riginal data c
the review an
able to ensure
orld network 
by Connected
ed maps of s
Nation will r
ent that the m

as been comp
mission. 

ion has been
l availability a
ve online too
responding d

ows for publi
k on the repre
inquiries to C
re broadband
p to provider
n to identify l
e services. Pu

method for pr
s they are ide

ders. 

m provider-v
not have terr

co household

               
TIA’s definition
xed and mobile
r than 200 Kbp
the SBI data col
et segment data

                   

                     

ION:  PROV

eir service are
order to ensu
as accurate as

supply into 
review proce

oviders, this i
he mapped se
esentation, w
ollection and
nd revision p
e that the tab
extent. Any 

d Nation, wh
service area r
revise data an
map represen
pleted and fin

 aggregated a
are produced
l, Broadband

demographic 
ic users, prov
esented data.
Connected N
d service is sh
rs regarding r
locations wh

ublic feedbac
rovider-suppl
entified to en

validated dat
restrial fixed 

ds have neithe

n of available br
 broadband ser
s. 
llection method

a, the estimates 

                     

                    

VIDER VAL

ea data in ma
ure that the d
s possible, Co
a GIS shapef
ess allow for 
is the first tim
ervice area all
whether the is
d submission
process, local 
bular data tha
issues in how

hether they a
representatio
nd return ma
nts their serv
nal approval 

at a territory-
d and made p
dStat, to crea
information

viders, and ot
. This feedba

Nation either 
hown on the 
revisions to t
here on-site v
k on all form
lied informat

nsure that on

ta indicate tha
broadband s
er mobile no

roadband servi
rvice, if the serv

dology as define
of broadband a

                  C

                     

LIDATION M

any different 
data required
onnected Na
file and prod
providers to

me they have
llows provide
ssue is in the

n. Often data 
engineers w

at has been s
w the service

are additions,
ns are sent to

aps as many t
vice area as ac
of the data is

-wide level, s
publicly avail
ate customize
n. Leveraging
ther stakehol
ack becomes 

affirming wh
 map, but in 

the data as it 
visits may be 
ms of mappin
tion and allow

nly the highes

at approxima
service availa
or fixed broad

ce as specified 
vice offers dow

ed by the NTIA
availability deriv

Connect Puerto 

                     

METHODO

t formats, all 
d by the NTIA
ation translate
duces maps f
o see their ser
e seen maps o
ers to quickly
e data translat

is provided 
who operate th
submitted is a
e area is repre
, removal of 
o the provide
times as nece
ccurately as p
s provided, t

static maps o
lable. In addi
ed views of b
g broadband 
lders to revie
a validation 
here service 
actuality is n
is represente
necessary to

ng products s
ws Connecte
st quality info

ately 14.01 p
able, and app
dband servic

in the SBI NO
wnload speeds o

A and based on
ved from provi

Rico Methodol

                     

OLOGY  

in varying le
A is standard
es and forma

for the provid
rvice area in 
of their 
y identify any
tion into a G
from various
he networks 
accurate and
esented on th
service, or an
er for review
essary until th
possible. Onc
the data is de

of territory-wi
ition, consum
broadband se
service data 
ew, scrutinize
method in it
is not availab

not available.
ed; it also allo
o complete fie
serves as a 
ed Nation to 
ormation is 

ercent of Pu
proximately 0
ce available.2  

OFA, this estima
of at least 768 K

n both census b
ider-validated d

logies 
 

     21 

evels 
dized 
ats 
der to 
a 

y 
GIS 
s 
and 
 
he 
ny 

w and 
he 
ce 

eemed 

ide 
mers 
ervice 
on 
e, 
tself 
ble or 
 This 
ows 
eld 

uerto 
0.35 
  

ate 
Kbps 

block 
data 



  
 
 
                

 

Octob
 

 
Withi
appro
broad
have 
estim
updat

 
 
 
WIRELE

 
Data solic
limited to

1. 
2. 
3. 
4. 
5. 
6. 
7. 

8. 

9. 

10. 
11. 
12. 
13. 
14. 
15. 

               
may includ
based data 
its network
block level 

3 See foo
4 See foo

 

                     

ber 1, 2011      

in rural areas
oximately 21.
dband service
neither mob

mates presente
ted in the nea

ESS METHO

Br

cited from a 
o: 

The name o
Whether the
The maximu
The typical 
The frequen
The primary
The physica
from the pro
Latitude in e
received as N
Longitude in
received as N
Antenna pat
Azimuth of 
Approximat
Polarity of t
Transmit an
Line loss (ap
cabling – ex
                   

e an overstatem
collection meth

k is present acro
can be amplifie

otnote 1. 
otnote 2. 

                     

                     

s of the territ
.82 percent o
e available, an
ile nor fixed 
ed are based 
ar future with

ODOLOGY 

roadband Se
Wireless Se

fixed wireles

of the structu
e transmitting
um advertise
downstream 

ncy range of 
y population 
al address of 
ovider this al
either Degree
NAD 27 or N
n either Degr
NAD 27 or N
ttern (e.g. om
antenna (e.g

te transmit ra
transmit ante
ntenna gain (i
pplicable onl
xcludes powe

                   
ment of the actu
hod, a provider
oss the whole o
ed as the data is

                   

                     

ory, results d
of rural Puert
nd approxim
broadband s
on Census 2
h Census 201

ervice Avail
ervices Not P

ss provider to

ure 
g device is op

ed downstrea
speed, the ty

spectrum bei
center(s) bei
the transmit 
llows a quick
es, Minutes a
NAD 83)  
rees, Minute
NAD 83)  

mni-direction
g. 360° with m
adius (in feet
enna (Vertica
in dBi) 
ly to provider
er-over-Ether

                   
ual number of h
r will typically re
or only a subset 
s aggregated ac

                     

                     

derived from 
to Rico hous

mately 0.48 pe
service availa
2000 househo
10 household

ability in Pr
Provided to

o create prop

perational or
am speed, the
ypical upstre
ing used (as p
ing served (fo
site (in the e

k reference p
and Seconds 

s and Second

nal, 180°, 120
magnetic dec
t, miles, or kil
al or Horizon

rs using coax
rnet devices)
                  

households with
eport broadban
of that census 
ross the entire 

                  C

                    

 provider-val
eholds do no
ercent3 of rur
able.4  Please 
old informati
d informatio

rovider’s Ser
o a Specific A

pagation mod

r proposed 
e maximum a
eam speed (pe
prescribed b

for geopolitic
event latitude
oint for geoc
and/or in D

ds and/or in 

0°, 90°, etc.)
clination if kn
ilometers) 
ntal) 

x, heliax, wav
 
                   

h broadband av
nd availability fo
block.  This po
state or territor

Connect Puerto 

                     

lidated data i
ot have terre
ral Puerto Ri
note that the
ion; these fig
n. 

rvice Area 
Address 

dels include, 

advertised up
eak periods f

by NTIA) 
cal boundary 
e/longitude i
coding) 

Decimal Degr

Decimal De

nown) 

veguide or ot

                   
vailability.  Und
or an entire cen
otential overesti
ry. 

Rico Methodol

                     

indicate that 
strial fixed 
ico househol
e availability 
gures will be 

but are not 

pstream spee
for both) 

reference) 
is unavailable

rees (typically

egrees (typica

ther forms of

                   
der the census b
nsus block whe
imation at the c

logies 
 

     22 

lds 

ed 

e 

y 

ally 

f 

         
block-
ther 
census 



  
 
 
                

 

Octob
 

16. 
17. 

18. 

19. 
20. 

21. 
22. 

23. 
24. 
25. 

 
Propagati
wave pro
software(
propagati
theory an
predicting
signal in t
Okumura
where bu
graphical 
based on 
elevation 
 
After con
remove th
created b
the under
to display
appear as
Typically,
highly ele
As a resu
submitted
than 0.12
wireless p

 

                     

ber 1, 2011      

Mechanical 
Equipment 
sheet) 
Power outp
specification
AMSL at ba
Antenna cen
of the actua
Foliage facto
Ground Clu
areas to acco
Average gain
Receive ante
Federal Reg
reference an
Universal Li

ion modeling
pagation as a

(s) typically u
ion for frequ

nd statistical a
g the median
time and in s
a-Hata mode
uildings are th

illustration o
defined vari
terrain input

nverting prop
he small pixe
ased on the p
rlying data pa
y a broadban
s a result of s
, while this p
evated points
ult, and congr
d to NTIA o
25 square mil
provider. 

                     

                     

and/or Elec
Manufacture

ut of the tran
ns are applied
ase of tower s
nterline AGL
l antenna) 
ors (Evergre

utter (primari
ount for type
n of receive 
enna is estim

gistration Num
nd/or obtain 
icensing Syst

g is an empir
a function of
use the Irregu
uencies betwe
analyses of th
n attenuation 
space.  For m
el which acco
he primary ob
of the theore
ables (receiv
t). 

pagation mod
els representi
parameters e
arameters of 
d service are
ignal levels r

pixilation ano
s may have ex
ruent to the W
n January 20
es in area hav

                   

                     

trical beam t
er (allows eas

nsmitting dev
d) 
site 
L (height of a

ens/Deciduo
ily used in ru
es and height
antenna 

mated at heigh
mbers (if app
additional d

tem and the C

rical mathema
f frequency, d
ular Terrain M
een 20 MHz 
he combinati
of a radio si

metropolitan a
ounts for pred
bstructions. T

etical propaga
er sensitivity

dels into a ge
ing service pr
entered in the

elevation, hi
ea as accurate
reaching the h
omaly shows 
xceedingly sp
Wireless Techn
0, 2011, all in
ve been remo

                     

                     

tilt (if applica
sy cross-refer

vice (if unkno

antenna abov

ous and perc
ural areas to a
ts of building

ht above aver
plicable) whi

data from the
COmmission

atical formul
distance, and
Model (also k
and 20 GHz
ion of terrain
ignal as a fun
areas, the sof
dicting the b
The resulting
ation charact
y of the home

eospatial form
resent in the
e software fro
illshade, etc.,
ely as possibl
highest eleva
legitimate ar

parse populat
nology Methodo
dependent p
oved from th

                  C

                    

able) 
rence against

own, FCC st

ve ground lev

cent of groun
account for f
gs if known) 

rage terrain (
ch may allow

e Federal Com
n REgistratio

lation for the
d other condi
known as Lo
z. This mode
n features and
nction of dist
ftware can ty
ehavior of ce
g product fro
teristics of a s
e/mobile dev

mat, addition
resulting dat

om the prov
, and the limi
le. Generally,
ated points w
reas where sig
tions or are e
ologies and Bus
pixels represe
he geospatial

Connect Puerto 

                     

t manufactur

tandards or m

vel measured

nd cover) 
foliage and in
  

(HAAT) of 6
w opportuniti
mmunication
on System 

e characteriza
itions. Propa

ongley-Rice) o
el is based on
d radio meas
tance and the
ypically be ad
ellular transm
om either mo
selected freq
vice, foliage f

nal processing
taset. These 

vider equipme
itations of th
, these rando

within the pre
gnals can be 
entirely void 
siness Logic wh
enting service
l representati

Rico Methodol

                     

rer’s specifica

manufacturer

d at the cente

n metropolita

6.2 meters/20
ies to cross-

ns Commissio

ation of radio
agation 
of radio 

n electromagn
surements, th
e variability o
djusted to use
missions in ar
odel depicts a
quency range 
factor, and d

g is complete
areas are init
ent informati

he software it
om pixel stria
escribed radiu
received, the
of populatio

hite paper 
e that are less
ion of each 

logies 
 

     23 

ation 

r 

erline 

an 

0 feet 

on 

o 

netic 
hen 
of the 
e the 
reas 
a 

digital 

ed to 
tially 
ion, 
tself 
ations 
us. 
ese 
on. 

s 



  
 
 
                

 

Octob
 

BROADB

Connecte
inquiries 
service. O
broadban
real-world
inquiries. 
informati
residents 
broadban
 
BBIs are 
seek help
able to pr
help mod
Nation re
consumer
through c
3) to map
alternativ
 
New BBI
team dep
GIS or E
consumer
research i
validation
ETS team
communi
 
The broa
programs
inquiries 
data verif
updated e
and can n
allowed th
providers
broadban
have resp
worthwhi
able to sh
to provid

 

                     

ber 1, 2011      

BAND INQ

ed Nation co
represent an

Once BBIs ar
nd availability
d comparison
 Consumers

ion regarding
who have br

nd, but the br

submitted fr
p to identify l
rovide servic
dify maps wit
egarding thes
r information
cooperation w
p and analyze
ves to current

Is are assigne
ending on th

ETS team mem
r.  Many BBI
in the field, t
ns in the area
m members r
ication.   

adband inquir
s with succes
since 2007, a
fication.  The
every six mon
now receive b
he Connecte
s the exact lo
nd if it was m
ponded to thi
ile. Data veri

how those inq
ders, who the

                     

                     

QUIRIES ME

ollects consum
y type of com
re received ac
y information
n of the broa
s submitting t
g three catego
roadband bu
roadband inv

requently by 
ocal broadba
e to that con
th actual serv
se inquiries ar
n and follow
with mapped
e information
tly mapped s

ed to either th
he category e
mbers respo
Is can be reso
the assigned E
a of the inqui
espond to an

ry process ha
sful results. A

allowing the 
ese inquiries 
nths, to dete
broadband at
ed Nation sta
ocations wher
made available

is process an
ification meth
quiries that in

en verify whe

                   

                     

ETHODOLO

mer feedback
mmunication
cross the com
n which was 
adband lands
these inboun
ories:  1) resi

ut want a diffe
ventory maps

consumers v
and provider 
nsumer.  Con
vice area info
re 1) to impr

w-up field rese
d providers a
n from consu
ervices. 

he GIS depa
ntered by the
nd to each in
olved throug
ETS team m
iry, or at othe
nd conclude B

as been imple
Altogether C
state program
are continuo
rmine if prev
t their residen
ate programs 
re the popula
e to them. Pr

nd have expan
hods have al
ndicate the b

ere service ca

                     

                     

OGY  

k in the form
n received fro
mmonwealth
collected thr
scape to the i
nd comments
idents who d
ferent provide
s indicate tha

via the Conne
options, or t

nsumer comm
ormation.  Th
rove the accu
earch; 2) to p
and by facilita
umers about 

rtment or th
e consumer o
nquiry accord
gh desktop re

member condu
er such time 
BBIs via tele

emented in e
Connected Na
ms to evaluat
ously examine
viously unser
nce. This dat
to aggregate

ation has mad
roviders in th
nded to areas
lso proven su
broadband se
nnot reach in

                  C

                    

m of broadban
om the publi
h, this inform
rough the SB
information 
s and/or inq

do not have b
er; and 3) res
at they do. 

ect Puerto Ri
to learn whe

ments also pr
he primary ob
uracy of the t
provide broad
ating new bro
areas of unm

he Engineerin
on the websi
ding to the in
esearch; how
ucts such res
as is practica

ephone conta

each of the C
ation has rec
te each inqui
ed against cu
rved househo
tabase of bro
e demand in c
de it clear th
he states and 
s knowing th
uccessful, as 
ervice areas a
n regard to th

Connect Puerto 

                     

nd inquiries 
c regarding b

mation is over
BI program.  

received from
quiries are abl
broadband bu
sidents who 

Rico website. 
en a specific p
rovide inform
bjectives of C
territory map
dband option
oadband serv

met broadban

ng & Technic
ite submissio
nformation r

wever, if a BB
search when 
al and approp
act and/or e-

Connected Na
ceived over 1
iry for broadb
urrent broadb
olds have bee
oadband inqu
concentrated

hat they woul
the territory

hat their inve
the state pro

are misrepres
hat residence

Rico Methodol

                     

(BBIs). Thes
broadband 
rlaid with the
This allows f
m broadband
le to provide
ut want it; 2)
do not have 

 Inquiries of
provider may
mation which
Connected 
ps with subm
ns to consum
vice options;
nd demand a

cal Services (
on form.  The
equested by 

BI requires 
performing 
priate.  GIS a
-mail 

ation state 
7,000 broadb
band demand
band availabi
en expanded
uiries has also
d areas to sho
d purchase 

y of Puerto R
estment will b
ograms have b
sented on the
e(s). The 

logies 
 

     24 

se 

e 
for a 
d 
e 
 

ften 
y be 
h may 

mitted 
mers 
; and 
and 

(ETS) 
e 
the 

field 
and 

band 
d and 
ility, 

d to 
o 
ow 

Rico 
be 
been 
e map 



  
 
 
                

 

Octob
 

broadban
inquiries 
 
During th
grant ince
validation
areas hav
 
 
 
BROADB

Broadban
broadban
informati
leaders, p
adoption 
 
First and 
that offer
build and
populatio
 
New func
data displ
broadban
to validat
broadban
providers
world ava
 
The Conn
a total of 
849 occur
 
 
 
SPEED T

The 478 s
reporting
Nation an
data bein
testing sit
 

 

                     

ber 1, 2011      

nd coverage i
submitted by

his reporting 
eption to dat
n of the broa
ve a high dem

BANDSTAT

ndStat is an o
nd data. Deve
ion system (G
policymakers,

of broadban

foremost, B
r broadband 
d evaluate bro
on demograp

ctionality in B
layed on the 

nd is presente
te the broadb
nd, but the in
s within that 
ailability on t

nect Puerto R
f 1,336 visits t
rred this repo

TEST MET

speed tests th
g period (876 
nd Ookla Ne
g collected a
te. 

                     

                     

in these state
y the public. 

period, the C
te).  As more
adband landsc
mand for broa

T METHOD

online, intera
eloped throu
GIS) softwar
, consumers,
nd.  

roadbandSta
Internet serv

oadband exp
hics, broadb

BroadbandSt
interactive m

ed.  This visu
band availabil
nteractive ma
area in an ef

the ground.   

Rico project 
to date (846 
orting period

THODOLOG

hat are repre
grant incept

et Metrics. U
nd provides 

                   

                     

es has been al

Connect Pue
e inquiries are
cape can be p
adband adop

DOLOGY 

ctive mappin
ugh a partner
re, Broadband
 and technol

at allows con
vice to that lo
ansion scena
and availabil

tat allows the
map.  Throug
ualization allo
lity for accur

ap shows oth
ffort to trim d

launched Br
to the Englis

d (477 to the 

GY  

sented in the
tion to date) 
tilizing this r
for a far grea

                     

                     

ltered to crea

erto Rico pro
e submitted t
performed, w

ption. 

ng tool for vi
ship with ES
dStat is a mu
logy provider

sumers to loc
ocation. The 
arios using a w
lity, and resea

e consumer t
gh the collect
ows the Conn
racy.  If resid
erwise, this a
down their c

roadbandStat
sh website an
English web

e Connect Pu
are the result

relationship in
ater sample s

                  C

                    

ate a more ac

oject has rece
to Connect P
while also allo

iewing, analy
SRI, the mark
ulti-functiona
rs to devise a

cate their res
interactive p
wealth of da
arch about th

to provide fe
tion of this fe
nected Natio

dents within a
allows Conne
overage to m

t on Septemb
nd 490 to the
bsite and 372

uerto Rico Sp
t of a partner
ncreases the 
size than cou

Connect Puerto 

                     

ccurate map 

eived a total o
Puerto Rico, 
owing provid

yzing, and val
ket leader in 
al, user-friend
a plan for the

sidence and i
platform allow
ata, including 
he barriers to

eedback on th
feedback, a vi
on state prog
a region state
ected Nation

more accurate

ber 17, 2010, 
e Spanish we
2 to the Span

peed Test Re
rship betwee
level of con

uld be collect

Rico Methodol

                     

based on the

of 38 inquirie
a more thoro
ders to see w

lidating 
geographic 
dly way for lo
e expansion a

identify prov
ws for users 

g education an
o adoption. 

he broadband
isual demand

grams the abi
e they are wit
n to approach
ely represent 

 and has rece
ebsite), of wh
nish website).

eport during 
en Connected
fidence in th
ted by a singl

logies 
 

     25 

e 

es (62 
ough 

which 

ocal 
and 

viders 
to 
nd 

d 
d for 
ility 
thout 
h the 
real-

eived 
hich 
 

this 
d 

he 
le 



  
 
 
                

 

Octob
 

Ookla ow
Connect 
developed
variability
utilizing G
aggregatio
of tests th
detail due
each spee
 
In an effo
informati
taken thro
must con
is two-tie
Puerto Ri
theoretica
speed tes
Common
 
 

 

 

                     

ber 1, 2011      

wns and oper
Puerto Rico 
d and run on
y of geograph
Geo-IP techn
on, typically 
hat have been
e to the test r
ed test. 

ort to validat
ion is collecte
ough all netw

nnect to in or
ered.  First, it
ico with the i
al speed info
ts provide re

nwealth of Pu

                     

                     

rates Speedte
speed test w

n its testing te
hic informati
nology. This 
larger nodes 
n conducted,
results being 

te broadband
ed throughou
works (a prov
rder to reach 
t allows for a 
information 
rmation whi

eal-world info
uerto Rico. 

                   

                     

est.net, as wel
website, for pa
echnology pr
ion collected
technology a
across provi

, the level of 
located at th

d data from th
ut the territo
vider’s netwo
the host test
comprehens
on where br
ch was receiv
ormation on 

                     

                     

ll as develop
artners aroun
rovides Ookl
 across the v
allows for tes
ider network

f aggregation 
hese larger no

he Connect P
ory.  Speed te
ork as well as
t.  The benef
sive dataset o
roadband serv
ved through 
the speeds th

 
 

                  C

                    

s and deploy
nd the world
la with a vast

varying speed
sts to be geo

ks.  While the
is only suffic

odes and not

Puerto Rico 
ests provide s
s additional n
fit of this col
of speeds, wh
rvices are ava
the data coll
hat currently

Connect Puerto 

                     

ys speed tests
d. This netwo
t dataset that

d test sites, is 
ocoded to poi
ere are hundr
cient for mun
t at an absolu

project, spee
speed inform
networks) a lo
llection of sp
hile also prov
ailable.  Secon
lection proce
y exist within

Rico Methodol

                     

s, such as the
ork of sites th
t, due to the 
geocoded 

ints of 
reds of thous
nicipality-lev

ute location f

ed test 
mation on the

ocal machine
peed informa
viding Conne
nd, unlike 
ess, the use o
n the 

logies 
 

     26 

e 
hat is 

sands 
vel 
for 

e path 
e 
tion 
ect 

of 



Complete 16
Non-Responsive/Refused 3
In Progress 0

Count of Datasets by Status 19
Total Unique Providers Represented 18

Provider Name Platform Status
NDA Execution 

Date Notes

AT&T Mobility LLC Mobile Wireless Data Added to Statewide Inventory 12/16/2009

[SEP-15-11 Jess Cary] Changes and/or Corrections: 
possible service expansion or corrections to previous 
dataset: entirely new dataset provided for October 2011 
submission.

Liberty Global, Inc. Cable Data Added to Statewide Inventory 10/19/2009
[SEP-15-11 Jess Cary] Corrections: Provider supplied 
corrections to previous dataset.

Puerto Rico Telephone Company Inc. Mobile Wireless Data Added to Statewide Inventory 4/23/2010

[SEP-15-11 Jess Cary] Correction: Provider has not 
participated in past submissions but made data 
available for Oct 2011 submission.

Puerto Rico Telephone Company Inc. DSL Data Added to Statewide Inventory 4/23/2010

[SEP-15-11 Jess Cary] Changes and/or Corrections: 
possible service expansion or corrections to previous 
dataset: entirely new dataset provided for October 2011 
submission.

Sprint Nextel Corporation Mobile Wireless Data Added to Statewide Inventory 1/14/2010

[SEP-15-11 Jess Cary] Changes and/or Corrections: 
possible service expansion or corrections to previous 
dataset: entirely new dataset provided for October 2011 
submission.

T-Mobile USA, Inc. Mobile Wireless Data Added to Statewide Inventory 1/8/2010

[SEP-15-11 Jess Cary] Changes and/or Corrections: 
possible service expansion or corrections to previous 
dataset: entirely new dataset provided for October 2011 
submission.

Aeronet Wireless Broadband Corp. Backhaul Backhaul Provider Only Processing Complete
Sprint Nextel Corporation Backhaul Backhaul Provider Only Processing Complete 1/14/2010

San Juan Cable Holding, LLC, OneLink 
Communications Cable

Estimated Coverage Submitted for Non-
Participating Provider

[SEP-16-11 Jess Cary] Provider is still non-responsive 
to participation outreach and the same coverage as April 
2011 is being submitted again.

Ayustar Corporation Fixed Wireless
Approval for Update Not Received – Data Still 
Submitted 7/12/2010

[SEP-15-11 Jess Cary] Corrections: No prior 
participation. Provider supplied data for Oct 2011 
submission.

Critical Hub Networks Fixed Wireless
Approval for Update Not Received – Data Still 
Submitted 9/30/2010

[SEP-15-11 Jess Cary] Corrections: No prior 
participation. Provider supplied data for Oct 2011 
submission.

Puerto Rico Cable Acquisition Company, Inc. Cable
Approval for Update Not Received – Data Still 
Submitted 9/27/2010

[SEP-15-11 Jess Cary] Correction: Did not provide 
approval for April 2011 submission or Oct 2011 
submission but will be included in the Oct 2011 
submission.

Critical Hub Networks Backhaul No Update to Provide 9/30/2010
Data@ccess Communications Backhaul No Update to Provide 9/29/2009

Hughes Network Systems, LLC Satellite No Update to Provide 2/5/2010

[SEP-16-11 Jess Cary] Correction: Satellite data is 
being submitted and was not included in the April 2011 
submission. While coverage is currently the entire 
territory boundary, work continues on having more 
granular data available.

MCI Communications Services, Inc. Backhaul No Update to Provide 12/14/2009
Neptuno Media, Inc. Backhaul No Update to Provide 4/29/2010
PREPA Networks Corp Backhaul No Update to Provide 4/21/2010
Worldnet Telecommunications Inc. Backhaul No Update to Provide 4/19/2010

Aeronet Wireless Broadband Corp. Fixed Wireless Non-Responsive to Multiple Attempts

In addition to contact attempts made between July 1, 
2010 and February 21, 2011, 5 additional attempts were 
made this period.

Orizon Wireless Corp Backhaul Non-Responsive to Multiple Attempts 1/28/2011

In addition to contact attempts made between July 1, 
2010 and February 17, 2011, 3 additional attempts were 
made this period.

Telefonica International Holding, BV Backhaul Non-Responsive to Multiple Attempts

In addition to contact attempts made between July 1, 
2010 and February 17, 2011, 4 additional attempts were 
made this period.

Broadband Provider Log



Rhode Island 
 Broadband Mapping Project 

September 2011 Data Submission - 
 Summary and Processes 

 

 

 

 

 

 

 

Prepared By: 
Stuart Freiman 

Broadband Program Manager 
Rhode Island Economic Development Corp. 

315 Iron Horse Way. Suite 101 
Providence, RI 02908 

401-278-9100 
sfreiman@riedc.com 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
R I E D C  –  B r o a d b a n d  R h o d e  I s l a n d  M a p p i n g  P r o g r a m  

 

1 

 

Section A: The Broadband Rhode Island Mapping Team Overview 
 

In support of the national broadband initiatives being undertaken by President Obama  

and the Federal Government through the American Recovery & Reinvestment Act of 

2009 (Recovery Act), Public Law No. 111-5, and the Broadband Data Improvement Act 

(BDIA), title I of Public Law No. 110-385, 122 Stat. 4096, the Rhode Island Economic 

Development Corporation (RIEDC), as the entity assigned by Governor Donald Carcieri, 

has filed to the United States Department of Commerce – National Telecommunications 

and Information Administration (NTIA) a request for grant funds from the State 

Broadband Data and Development Grant Program. 
 

Project Description 

EA Engineering, Science, and Technology, Inc. (EA), has been selected by RIEDC for the 

through their Broadband Initiative for Rhode Island (BBRI) to provide a data 

management and retrieval system for RIEDC.  RIEDC and EA entered into a contractual 

agreement on January 15, 2010 for a base period of 2 (two) years with 3 (three) option 

years.  The work assignment consists of negotiating non disclosure agreements (NDA) 

with the State’s broadband providers, collecting provider broadband data, verifying data 

submitted, combining and updating data collected, developing and implementing a 

broadband website with mapping application, and reporting findings to RIEDC and the 

NTIA.   

 

This program will create a statewide broadband map which will be maintained for five 

(5) years, that assesses broadband infrastructure in Rhode Island and distinguishes 

between served, underserved and un-served communities as per the definition specified 

by NTIA.  The data will be made available to the public, with certain restrictions to 

account for confidentiality of supplier information, through a state website and will also 

be linked to a Federal Department of Commerce webpage.  The goal of this project is to 

meet the RIEDC’s broadband mapping needs and in doing so provide maps and 

information that will be used to lend guidance and assistance in the planning of future 

broadband infrastructure development, as well as provide numerous broadband options 

to the end users.  

 

The BBRI is a comprehensive effort aimed at producing a high level of detailed inventory 

of broadband services provided to residential, government and business consumers 

within the State of Rhode Island.  The project is not only a Geographical Information 

Systems (GIS) mission but a project that needs expertise in GIS, contracting and legal 

issues, Quality Assurance/Quality Control (QAQC), and project management.   In order 

to acquire, collect, process, analyze and display the data that represents these services 

it was necessary to combine the resources of several professional firms.  Each team 

member provides unique set of strengths and capabilities needed to create the system 

that is in place.  The team is made up of Rhode Island Economic Development 

Corporation (RIEDC), EA Engineering (EA), University of Rhode Island (URI), Adler Pollock 

& Sheehan P.C. (AP&S), Eastern Shore Regional GIS Cooperative (ESRGC), and Mapping 
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& Planning Services (M&PS).    The following paragraphs provide information on each 

team member and their role the project. 

 

The RIEDC is leading the project efforts for the State of Rhode Island (RI).  Led by Mr. 

Stuart Freiman, they oversee all facets of the project and teams involved. The RIEDC 

coordinates schedules, communicates directly with the National Telecommunications 

Information Agency (NTIA), reviews and approves all project deliverables, and ensure all 

project deadlines are met.  With their high visibility in the RI business community they 

are instrumental in arranging meetings between broadband providers and BBRI Team 

members.  The relationship and communication RIEDC has with the State’s providers 

was and continues to be instrumental in making the process of collecting and verifying 

information from the providers as effortless as possible. 

 

EA is the prime contractor selected to lead the State’s data collection, verification, 

reporting, and mapping efforts.   EA has been providing scientific and engineering 

technical solutions to a wide range of government and industrial clients since 1973. 

Serving IT and GIS solutions via the web has become a standard business solution for 

EA’s clients.  As the prime contractor EA works closely with the RIEDC on all phase of the 

BBRI project.  Included in the work EA has done to date, is the creation of the State’s 

broadband website and mapping application (Digital Atlas).   The website provides 

information on the project, links to related sites, custom mapping capabilities, and user 

speed test and feedback forms.  The site can be viewed at the following address; 

http://broadband.ri.gov/. 

 

M&PS has been providing GIS consulting services in RI for over 20 years.  For the RI 

Broadband Mapping project, M&PS assisted in the development of a verification and 

analysis process which is used to perform the QA/QC of the data prior to submitting to 

the NTIA.  Prior to each bi-annual NTIA submittal M&PS uses this process to review and 

check the data.  During this process MP&S checks for positional and attribute accuracy 

of the data by using a random sampling methodology.  The service MP&S provides 

insures data going to the NTIA is of the highest accuracy and precision.  Additional 

M&PS provides data analysis and static maps displaying the data status at each delivery 

date. 

 

The GIS laboratory in the URI’s Department of Natural Resources is the center of 

technical expertise in the GIS field for the State of RI.  On this project URI manages all 

GIS data report by EA to the RIEDC.   They also serve as an additional tier of QA/QC on 

the data that is collected and submitted to the NTIA.  URI provides technical input to the 

data processes and the types of maps and data to be displayed on the website.  

Additionally, several data layers including Community Anchor Institute locations and 

base map layers being used on the Digital Atlas are provided by URI.  

 

The Eastern Shore Regional GIS Cooperative (ESRGC) is an organization that provides 

technical support, training, and GIS services to local governments on the Eastern Shore 
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of Maryland.  In addition to supporting the BBRI project, ESRGC is leading the 

broadband mapping efforts for the state of Maryland.  For the BBRI project, the ESRGC’s 

provides the project team technical advisor support.  They provide guidance on the 

project’s technical approach and peer review support based on knowledge gained from 

their work in Maryland.  ESRGC provided assistance in defining requirements for the 

QA/QC process, database design, and data verification tasks.  The ESRGC provides the 

Team with a “lessons learned” from the Maryland Broadband project which guided the 

BBRI Team around common mistakes made on broadband mapping projects. 

 

AP&S is a local RI law firm providing legal advice and representation and has been 

servicing RI residents and firms for 50 years.  The role AP&S plays on this project is 

providing the necessary legal advice and contracting that is necessary between the 

RIEDC and the broadband providers.  To date, AP&S has brokered the Non-Disclosure 

Agreements (NDA’s) between the RIEDC and 16 broadband providers.  These 

agreements were imperative and had to be in place before any data was submitted by 

the broadband providers.  All provider broadband information that is made public is 

based on what the NDAs state.  AP&S became the State’s expert as to what information 

was legal for the team to make available to the public and modeled the NDAs off of the 

guidance provided in the NOFA. 

 

Project Contacts 

Contact Project Role Phone Email 

Rhode Island Economic Development Corp (RIEDC) 

Stuart Freiman  RIEDC PM 401-278-9168 sfreiman@riedc.com  

Shane White State GIS 

Coordinator 

401-222-6483 swhite@doa.ri.gov 

University of Rhode 

Island 

URI    

Greg Bonynge URI-EDC 

Director/BBRI 

Project Liaison 

401-874-2180 greg@edc.uri.edu 

EA Engineering, Science and Technology (EA) 

Jon Brownstein, Ph.D. Principal In 

Charge 

410-771-7950 jbrownst@eaest.com 

Lou Garcia, PMP Project Manager 410-771-7950 lgarcia@eaest.com 

Jason Samus Senior Technical 

Review 

410-771-7950 jsamus@eaest.com 

Brian Lesinski Senior Technical 

Advisor 

401-736-3440 blesinsk@eaest.com 
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Joe DeLuca, GISP Technical Lead 410-771-7950 jdeluca@eaest.com  

Chuck Murza Task Manager 410-771-7950 cmurza@eaest.com 

Adler Pollock & Sheehan (APS) 

Alan Shoer, Esq. Legal Team 401-274-7200 ashoer@apslaw.com 

Kristen Sherman, Esq. Legal Team 401-274-7200 KSherman@apslaw.co

m  

Mapping & Planning Services (M&PS) 

Mary Hutchinson., 

GISP 

Verification 

Analyst 

401-423-3841 mhutch@mappingplan

ning.com 

 

Eastern Shore Regional GIS Cooperative (ESRGC) 

Michael Scott, Ph.D., 

GISP 

Senior Technical 

Advisor 

410-543-6083 msscott@salisbury.edu  
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BROADBAND PROVIDER DATA VERIFICATION REPORT 

RHODE ISLAND DATA SUBMITTAL #3 

SEPTEMBER 30, 2011 
 

General Findings: 

 

• Rhode Island has extensive broadband coverage from 19 providers.  Collectively, these 19 

providers offer broadband coverage for the entire state of Rhode Island. 

 

• Broadband availability on a census block basis is summarized in the Figure below:   

 

Broadband Availability  Census Blocks % of Total 

Unserved; census block has no access to broadband 0 0 

Underserved:  One to Two broadband providers 28 <1 

     Competitive:   Three to Four broadband providers 127 <1 

                           Five to Nine broadband providers 9,789 39 

                           Ten to Thirteen broadband providers 15,013 60 

                                Fourteen to Sixteen broadband providers 224 <1 

     Total                          25,181 100 
Note:  Several of the Provider datasets do not show coverage of some census blocks in Rhode Island coastal waters (for example, the 

satellite providers).  This results in some over-reporting of the availability results at the low end, in particular, the underserved 

figures.  Broadband is defined as being wireline, wireless and satellite service for this table.   

 

• A total of 19 broadband Providers submitted data; 11 wireline, 5 wireless, and 3 satellite.  The 

completeness of the attributes in the 19 providers’ datasets is summarized in the Figures below.  

(Statistics for NTIA Delivery 1 and 2 are included for comparison purposes).   

 

 
 

Change in Wireline Attributes Submit 

Delivery 1 (grey), Delivery 2 (green) and Delivery 3 (orange) 

Note: The decrease in the Counts for Typical Speed between Deliveries 2 and 3, is due to a change in the Providers serving Rhode Island  
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Completeness of Wireless Data :: 5 Providers
Del ivery 1 (grey), Del ivery 2 (blue) and Del ivery 3 (orange)

Note: Delivery 1 and 2 had only 4 Providers
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Completeness of Satellite Data :: 3 Providers
Del ivery 1 (grey), Del ivery 2 (mauve) and Del ivery 3 (orange)

Note: Delivery 1 and 2 had only 2 Providers.
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• Middle Mile data was provided by 8 broadband providers.  There were a total of 40 facilities (16 

owned and 24 leased). 
 

• Last Mile data was provided by 2 broadband providers. 
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• A total of 984 Community Anchor Institutions (CAIs) are identified.  These were verified with 

available Rhode Island Geographic Information System (RIGIS) datasets and 529 RIEDC and FCC 

speed tests. 

 

• The RIEDC has collected 4,385 speed tests in 1,403 (5.6%) of the census blocks within the State.  

These tests are for the period 3/23/10 to 9/5/11.  There is a continued growth both in the 

number and distribution of the RIEDC speed tests.   

 

• A total 1,904 wireline speed tests from FCC are used for the verification.  These tests are for the 

period 3/11/10 to 6/30/11 and cover 948 (4%) of the census blocks within the State.  Tests were 

collected by OOKLA and MLAB.   
 

• FCC tests for Mobile Applications (accessing Cellular and Wi-Fi) are also used for the verification.  

These 3,828 speed tests are recorded for the period 3/11/10 to 6/30/11 and cover 1,036 (4%) of 

the census blocks within the State.  These tests were all collected by OOKLA. 
 

• A total of 10,117 speed tests (RIEDC, FCC, and FCC Mobile Applications) were used for 

verification purposes.  These were distributed within 2,910 (12%) of the 2010 US Census 

Bureau’s 25,181 census blocks in the state.  The distribution of each of these sources/types of 

tests is similar and follows population and household patterns across the State.  The distribution 

of the speed tests are shown in the Figures on the following page.   

 

• A total of 56 census blocks are greater than 2 sq. miles, with 28 over land and 28 over open 

water.  Road Segment data was provided by 1 provider.  Service Address data was provided by 1 

provider.  There was one census block (greater than 2 sq miles) with no road segment or service 

address data (440070133003013 in Foster, RI).    
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The Figures below show the distribution of speed tests used for verification purposes.   

 

FCC Collected Speed Test - Mobile                   FCC Collected Speed Test - Wireline                             RIEDC Collected Speed Test 
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The Figures below display the wireline and wireless coverage areas reported in Rhode Island and the number of providers available per census 

block. 

                  

                         Rhode Island Broadband Coverage Map                                                        Number of Providers Available Per Census Block 
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The Figures below display the availability of each technology types offered in Rhode Island. 

 

 

 

 

                Satellite Coverage                                                            Copper Wireline Coverage                                                             Cable Coverage 
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The Figures below display the availability of each technology types offered in Rhode Island. 

             

 

              Fiber Optic Coverage                                                             Wireless Coverage                                                                       DSL Coverage 
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Provider Name:  Above Net Communications Inc. 

DBA:  AboveNet  
 

Data Characteristics 

FRN:           0000820598   

Type of Data Submitted:        Census Blocks 

Census Block Count (unique):        2 

Provided Technology of Transmission:      YES 

Provided Max Advertised Download Speed:      YES   

Provided Max Advertised Upload Speed:      YES   

Provided Typical Download Speed:       NO 

Provided Typical Upload Speed:      NO 

Provided Middle Mile:         YES 

Provided Last Mile:         YES 

Provided End User Category:       YES 
 

 

Maximum advertised down/upload speeds reported by provider:  

Max Download Category Max Upload Category 

11 11 
 

Typical down/upload speeds reported by provider: Not provided 

 

Number of technology transmission types reported by provider:  1 
 

Count of Middle Mile Facilities:  1 

 

Count and Capacity of Last Mile Facilities: 1, 9  

 

End user Category:  2 

 

Data Verification: 
 

Counties served by provider and number of census blocks with service.  A total of 2 census blocks are served.  

 

 

 

 

 

 

 

 

Greatest down/upload speed from Historical 
1
  speed tests:  No speed tests were taken 

Greatest down/upload speed from RIEDC 
2
  speed tests:  No speed tests were taken 

Greatest down/upload speed from FCC 
3
  speed tests:  No speed tests were taken 

Greatest down/upload speed from FCC Mobile Application speed tests:  No speed tests were taken 

 

 

 

County Census Block per County 

Bristol 0 

Kent 0 

Newport 0 

Providence 2 

Washington 0 
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Count of Historical speed tests:  0 

Count of RIEDC 
2
 speed tests:  0 

Count of FCC 
3
 speed tests:  0 

Count of FCC Mobile Application 
4
  speed tests:  0   

 

RIEDC and FCC speed tests outside of reported service area:  0 

 

Middle Mile facilities outside of reported service area:  Facility is located within the reported service area.  

 

Last Mile facilities outside of reported service area:  Facility is located within the reported service area. 

 

%/# of census blocks verified by RIEDC & FCC speed tests: 

Confirmation of census block served 0 

Census blocks served, not reported by provider 0 

Total number of served census blocks reported by provider 2 

% of served census blocks confirmed by speed test 0 

 
 

Footnotes: 

1 Historical Date Range:  3/23/2009 to 3/22/2010 

2 RIEDC Date Range:  3/23/2010 to 9/5/2011 

3 FCC Date Range: 3/11/2010 to 6/30/2011 

4 FCC Mobile Application Date Range:  3/11/2010 to 6/30/2011  
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Provider Name:  AT&T Mobility LLC 

DBA:  AT&T Mobility LLC 

 

Data Characteristics 

FRN:           0004979233 

Type of Data Submitted:        Wireless 

Census Block Count (unique):        N/A 

Provided Technology of Transmission:      YES 

Provided Spectrum Used:       YES 

Provided Max Advertised Download Speed:      YES 

Provided Max Advertised Upload Speed:      YES 

Provided Typical Download Speed:       NO 

Provided Typical Upload Speed:      NO 

Provided Middle Mile:         NO 

Provided Last Mile:         NO 

 

Maximum advertised down/upload speeds reported by provider:  

Max Download Category Max Upload Category 

4 3 

 

Typical down/upload speeds reported by provider: Not provided 

 

Number of technology of transmission types and spectrums reported by provider:  1, with 2 spectrums 

 

Data Verification: 

 

Counties served by provider and number of census blocks with service.  A total of 24,993 census blocks are 

served.  

County Census Blocks per County 

Bristol 1,087 

Kent 4,177 

Newport 2,343 

Providence 13,148 

Washington 4,238 

 

Greatest down/upload speed from Historical 
1
  speed tests:  9, 8 

Greatest down/upload speed from RIEDC 
2
  speed tests:  9,8 

Greatest down/upload speed from FCC 
3
  speed tests:  No FCC speed tests were taken 

Greatest down/upload speed from FCC 
4
  Mobile Application speed tests:  7, 7 

 

Count of Historical speed tests:  1,010 

Count of RIEDC speed tests: 8 

Count of FCC speed tests:  0 

Count of FCC Mobile Application speed tests:  51 

 

Speed tests outside of reported service area:  0 
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%/# of census blocks verified by RIEDC and FCC speed tests:  

Confirmation of census blocks served 23 

Census blocks served, not reported by provider 0 

Total number of served census blocks reported by provider 24,993 

% of served census blocks confirmed by speed test <1% 

 

 

Middle mile facilities outside of reported service area:  No middle mile facilities. 

 

 
Footnotes: 

1 Historical Date Range:  3/23/2009 to 3/22/2010 

2 RIEDC Date Range:  3/23/2010 to 9/5/2011 

3 FCC Date Range: 3/11/2010 to 6/30/2011 

4 FCC Mobile Application Date Range:  3/11/2010 to 6/30/2011 
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Provider Name:  Broadview Networks, Inc. 

DBA:  Broadview Networks, Inc. 
 

Data Characteristics 

FRN:           0003775285   

Type of Data Submitted:        Census Blocks 

Census Block Count (unique):        9,952 

Provided Technology of Transmission:      YES 

Provided Max Advertised Download Speed:      YES   

Provided Max Advertised Upload Speed:      YES   

Provided Typical Download Speed:       YES 

Provided Typical Upload Speed:      YES 

Provided Middle Mile:         YES 

Provided Last Mile:         NO 

Provided Road Segments for census blocks greater than 2 sq miles:   NO 

Provided Address Points for census block greater than 2 sq miles:  NO 

Provided End User Category:       NO 
 

Maximum advertised down/upload speeds reported by provider:    

Technology Max Download Category Max Upload Category Count 

10 5 5 3 

20 5 5 7 

30 10 10 7,149 

50 11 11 4,755 

 

Typical down/upload speeds reported by provider:    

Technology Max Download Category Max Upload Category Count 

10 4 2 3 

20 4 4 1 

30 N/A N/A 7,149 

50 5 5 11 

 

Number of technology transmission types reported by provider:  4 
 

Count of Middle Mile Facilities:  8  

 

End user Category:  Not provided 
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Data Verification: 
 

Counties served by provider and number of census blocks with service.  A total of 9,952 census blocks are 

served.  

 

 

 

 

 

 

 

 

Greatest down/upload speed from Historical 
1
  speed tests:  4, 4 

Greatest down/upload speed from RIEDC 
2
  speed tests:  4, 4 

Greatest down/upload speed from FCC 
3
  speed tests:  4, 4 

Greatest down/upload speed from FCC Mobile Application speed tests:  No FCC Mobile speed tests were taken 

 

Count of Historical speed tests:  64 

Count of RIEDC 
2
 speed tests:  5 

Count of FCC 
3
 speed tests:  2 

Count of FCC Mobile Application 
4
  speed tests:  0   

 

RIEDC and FCC speed tests outside of reported service area:  0 

 

Middle mile facilities outside of reported service area:  All are centrally located within the reported census 

blocks.  

 

%/# of census blocks verified by RIEDC & FCC speed tests: 

Confirmation of census block served 7 

Census blocks served, not reported by provider 0 

Total number of served census blocks reported by provider 9,952 

% of served census blocks confirmed by speed test <1% 

 
 

Footnotes: 

5 Historical Date Range:  3/23/2009 to 3/22/2010 

6 RIEDC Date Range:  3/23/2010 to 9/5/2011 

7 FCC Date Range: 3/11/2010 to 6/30/2011 

8 FCC Mobile Application Date Range:  3/11/2010 to 6/30/2011  

 

County Census Block per County 

Bristol 4 

Kent 1,110 

Newport 959 

Providence 7,872 

Washington 7 
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Provider Name:  Cellco Partnership 

DBA:  Verizon Wireless 

 

Data Characteristics 

FRN:           0003290673 

Type of Data Submitted:        Wireless 

Census Block Count:         N/A 

Provided Technology of Transmission:      YES 

Provided Spectrum Used:       YES 

Provided Max Advertised Download Speed:      YES 

Provided Max Advertised Upload Speed:      YES  

Provided Typical Download Speed:       YES 

Provided Typical Upload Speed:      YES 

Provided Middle Mile:         NO 

Provided Last Mile:         NO 

 

Maximum advertised down/upload speeds reported by provider:  

Max Download Category Max Upload Category 

5 4 

 

Typical down/upload speeds reported by provider: 3, 3 

 

Number of technology of transmission types and spectrums reported by provider:  1, with 3 spectrums  

 

Data Verification: 

 

Counties served by provider and number of census blocks with service.  A total of 24,929 census blocks are 

served.  

 County Census Blocks per County 

Bristol 1,088 

Kent 4,150 

Newport 2,318 

Providence 13,145 

Washington 4,228 

 

Greatest down/upload speed from Historical 
1
  speed tests:  No Historical speed tests were reported 

Greatest down/upload speed from RIEDC 
2
  speed tests:  3, 2 

Greatest down/upload speed from FCC 
3
  speed tests:  4,2 and 3, 3 

Greatest down/upload speed from FCC Mobile Application 
4
  speed tests:  7,4 and 6,5 

 

Count of Historical speed tests:  0 

Count of RIEDC 
2
 speed tests:  10 

Count of FCC 
3
  speed tests:  10 

Count of FCC Mobile Applications 
4
 speed tests:  334 

 

RIEDC and FCC speed tests outside of reported service area: 0 
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%/# of census blocks verified by RIEDC and FCC speed tests:  

Confirmation of census blocks served 76 

Census blocks served, not reported by provider 0 

Total number of served census blocks reported by provider 24,929 

% of served census blocks confirmed by speed test <1% 

 

 
Footnotes: 

1 Historical Date Range:  3/23/2009 to 3/22/2010 

2 RIEDC Date Range:  3/23/2010 to 9/5/2011 

3 FCC Date Range: 3/11/2010 to 6/30/2011 

4 FCC Mobile Application Date Range:  3/11/2010 to 6/30/2011  
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Provider Name:  Clearwire 

DBA:  Clearwire 

 

Data Characteristics 

FRN:           0017775628 

Type of Data Submitted:        Wireless 

Census Block Count:         N/A 

Provided Technology of Transmission:      YES 

Provided Spectrum Used:       YES 

Provided Max Advertised Download Speed:      YES 

Provided Max Advertised Upload Speed:      YES  

Provided Typical Download Speed:       YES 

Provided Typical Upload Speed:      YES 

Provided Middle Mile:         NO 

Provided Last Mile:         NO 

 

Maximum advertised down/upload speeds reported by provider:  

Max Download Category Max Upload Category 

5 3 

 

Typical down/upload speeds reported by provider: Not provided 

 

Number of technology of transmission types and spectrums reported by provider:  1, with 1 spectrum  

 

Data Verification: 

 

Counties served by provider and number of census blocks with service.  A total of 11,670 census blocks are 

served.  

 County Census Blocks per County 

Bristol 136 

Kent 3,018 

Newport 7 

Providence 8,427 

Washington 82 

 

Greatest down/upload speed from Historical 
1
  speed tests:  No Historical speed tests were reported 

Greatest down/upload speed from RIEDC 
2
  speed tests:  5, 3 

Greatest down/upload speed from FCC 
3
  speed tests:  No FCC speed tests were taken 

Greatest down/upload speed from FCC Mobile Application 
4
  speed tests:  6, 3 

 

Count of Historical speed tests:  0 

Count of RIEDC 
2
 speed tests:  2 

Count of FCC 
3
  speed tests:  0 

Count of FCC Mobile Applications 
4
 speed tests:  1 

 

RIEDC and FCC speed tests outside of reported service area: 0 
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%/# of census blocks verified by RIEDC and FCC speed tests:  

Confirmation of census blocks served 3 

Census blocks served, not reported by provider 0 

Total number of served census blocks reported by provider 11,670 

% of served census blocks confirmed by speed test <1% 

 

 
Footnotes: 

1 Historical Date Range:  3/23/2009 to 3/22/2010 

2 RIEDC Date Range:  3/23/2010 to 9/5/2011 

3 FCC Date Range: 3/11/2010 to 6/30/2011 

4 FCC Mobile Application Date Range:  3/11/2010 to 6/30/2011  
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Provider Name:  Cogent Communication, Inc.  

DBA:  Cogent Communication 

 

Data Characteristics 

FRN:           0004654042  

Type of Data Submitted:        Census Blocks 

Census Block Count (unique):        2 

Provided Technology of Transmission:      YES 

Provided Max Advertised Download Speed:      YES 

Provided Max Advertised Upload Speed:      YES   

Provided Typical Download Speed:       NO 

Provided Typical Upload Speed:      NO 

Provided Middle Mile:         YES 

Provided Last Mile:         NO 

Provided Road Segments for census blocks greater than 2 sq miles:   NO 

Provided Address Points for census block greater than 2 sq miles:  NO 

Provided End User Category:       YES 

 

Maximum down/upload speeds reported by provider:  

Max Download Category Count Max Upload Category Count 

11 2 11 2 

 

Typical down/upload speeds reported by provider: Not Provided 

 

Number of technology of transmission types reported by provider:  1 

 

Count of Middle Mile Facilities:  1 

 

End User Category:  2  

 

 

Data Verification: 

 

Counties served by provider and number of census blocks with service.  A total of 2 census blocks are served.  

County Census Blocks per County 

Bristol 0 

Kent 0 

Newport 0 

Providence 2 

Washington 0 

 

Greatest down/upload speed from Historical 
1
  speed tests:  No speed tests were taken 

Greatest down/upload speed from RIEDC 
2
  speed tests: No speed tests were taken 

Greatest down/upload speed from FCC 
3
  speed tests:  No speed tests were taken 

Greatest down/upload speed from FCC Mobile Applications 
4
  speed tests:  No speed tests were taken 
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Count of Historical speed tests:  0 

Count of RIEDC 
2
 Speed tests:  0 

Count of FCC  
3
  speed tests:  0 

Count of FCC Mobile Applications 
4
  speed tests:  0   

 

RIEDC and FCC speed tests outside of reported service area:  No speed tests were taken 

 

Middle mile facilities outside of reported service area:  Facility is within the reported census blocks.  

 

%/# of census blocks verified by RIEDC and FCC speed tests:  

Confirmation of census block served 0 

Census blocks served, not reported by provider 0 

Total number of served census blocks reported by provider 2 

% of served census blocks confirmed by speed test 0% 

 

 
Footnotes: 

1       Historical Date Range:  3/23/2009 to 3/22/2010 

2 RIEDC Date Range:  3/23/2010 to 9/5/2011 

3 FCC Date Range: 3/11/2010 to 6/30/2011 

4 FCC Mobile Application Date Range:  3/11/2010 to 6/30/2011  
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Provider Name:  CoxCom, Inc.  

DBA:  Cox Communications, Inc. 

 

Data Characteristics 

FRN:           0001524461 

Type of Data Submitted:        Census Blocks, Address Points 

Census Block Count (unique):        24,424 

Service Address Point Count (unique):      2,267 

Provided Technology of Transmission:      YES  

Provided Max Advertised Download Speed:      YES   

Provided Max Advertised Upload Speed:      YES   

Provided Typical Download Speed:       NO 

Provided Typical Upload Speed:      NO 

Provided Middle Mile:         YES 

Provided Last Mile:         NO 

Provided Road Segments for census blocks greater than 2 sq miles:  NO 

Provided Address Points for census block greater than 2 sq miles:  YES 

Provided End user Category:        NO 

 

Maximum advertised down/upload speeds reported by provider:  

Data Type Max Download Category Max Upload Category Count 

Census Blocks 9 5 24,424 

Service Address Points 9 5 2,267 

 

Typical down/upload speeds reported by provider:  Not provided 

 

Number of technology of transmission types reported by provider:  1   

 

Count of Middle Mile Facilities:  1  

 

End User Category:  Not provided 

 

 

Data Verification: 

 

Counties served by provider and number of census blocks with service.  A total of 24,447 census blocks are 

served (24,424 by census block data and 23 by service address data).   

County Census Blocks per County 

Bristol 1,086 

Kent 4,113 

Newport 2,285 

Providence 12,885 

Washington 4,055 
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Greatest down/upload speed from Historical 
1 

 speed tests:  9, 9 and 10, 6 

Greatest down/upload speed from RIEDC 
2
  speed tests:  10, 4 and 9, 9 

Greatest down/upload speed from FCC 
3
  speed tests:  9, 8 

Greatest down/upload speed from FCC Mobile Applications 
4
  speed tests:  7, 6 

 

Count of Historical speed tests:  98,305 

Count of RIEDC 
2
 speed tests:  2,597 

Count of FCC 
3
  speed tests:  928 

Count of FCC Mobile Applications 
4
  speed tests:  1,286   

 

RIEDC and FCC speed tests outside of reported service area:  2 of 4,811 speed tests were recorded outside of 

the coverage area reported by provider.   

 

Middle mile facilities outside of reported service area:  All are located within the reported census blocks.  

 

%/# of census blocks verified by RIEDC and FCC speed tests:  

Confirmation of census block served 1,707 

Census blocks served, not reported by provider 2 

Total number of served census blocks reported by provider 24,447 

% of served census blocks confirmed by speed test 7% 

 

 

Footnotes: 
1 Historical Date Range:  3/23/2009 to 3/22/2010 

2 RIEDC Date Range:  3/23/2010 to 9/5/2011 

3 FCC Date Range: 3/11/2010 to 6/30/2011 

4 FCC Mobile Application Date Range:  3/11/2010 to 6/30/2011  
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Provider Name:  DIECA Communications, Inc. 

DBA:  Covad Communications Company 

 

Data Characteristics 

FRN:           0003753753  

Type of Data Submitted:        Census Blocks 

Census Block Count: (unique)       10,610 

Provided Technology of Transmission:      YES 

Provided Max Advertised Download Speed:      YES 

Provided Max Advertised Upload Speed:      YES   

Provided Typical Download Speed:       YES 

Provided Typical Upload Speed:      YES 

Provided Middle Mile:         NO 

Provided Last Mile:         NO 

Provided Road Segments for census blocks greater than 2 sq miles:   NO 

Provided Address Points for census block greater than 2 sq miles:  NO 

Provided End User Category:       NO 

 

Maximum advertised down/upload speeds reported by provider:  

Technology Max Download Category Max Upload Category Count 

10 6 3 2,554 

20 5 5 1,582 

30 5 5 6,028 

 

Typical down/upload speeds reported by provider:  

Technology Max Download Category Max Upload Category Count 

10 5 3 3,628 

20 4 4 2,879 

30 5 5 6,016 

 

Number of technology of transmission types reported by provider:  3 

 

Count of Middle Mile Facilities:  0  

 

End User Category:  Not provided 
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Data Verification: 

 

Counties served by provider and number of census blocks with service.  A total of 10,610 census blocks are 

served.  

 

 

 

Greatest down/upload speed from Historical 
1 

 speed tests:  9, 3 

Greatest down/upload speed from RIEDC 
2
  speed tests:  No speed tests were taken 

Greatest down/upload speed from FCC 
3
  speed tests:  No speed tests were taken 

Greatest down/upload speed from FCC Mobile Applications 
4
  speed tests:  No speed tests were taken 

 

Count of Historical speed tests:  57 

Count of RIEDC  
2
 speed tests:  0 

Count of FCC  
3
  speed tests:  0 

Count of FCC Mobile Applications 
4
  speed tests:  0  

 

RIEDC and FCC speed tests outside of reported service area:   No speed tests were taken 

 

 

%/# of census blocks verified by RIEDC and FCC speed tests:  

Confirmation of census block served 0 

Census blocks served, not reported by provider 0 

Total number of served census blocks reported by provider 10,610 

% of served census blocks confirmed by speed test 0% 

 
 

Footnotes: 

1 Historical Date Range:  3/23/2009 to 3/22/2010 

2 RIEDC Date Range:  3/23/2010 to 9/5/2011 

3 FCC Date Range: 3/11/2010 to 6/30/2011 

4 FCC Mobile Application Date Range:  3/11/2010 to 6/30/2011  

 

 

 

 

 

 

 

 

 

 

County Census Blocks per County 

Bristol 2 

Kent 2,606 

Newport 2 

Providence 8,000 

Washington 0 
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Provider Name:  Fiber Technologies Networks, LLC. 

DBA:  FiberTech  

 

Data Characteristics 

FRN:           0006797849 

Type of Data Submitted:        Census Blocks 

Census Block Count (unique):        11 

Provided Technology of Transmission:      YES 

Provided Max Advertised Download Speed:      YES 

Provided Max Advertised Upload Speed:      YES   

Provided Typical Download Speed:       NO 

Provided Typical Upload Speed:      NO 

Provided Middle Mile:         NO 

Provided Last Mile:         NO 

Provided Road Segments for census blocks greater than 2 sq miles:   NO 

Provided Address Points for census block greater than 2 sq miles:  NO 

Provided End User Category:       YES 

 

Maximum advertised down/upload speeds reported by provider:  

Max Download Category Max Upload Category Count 

10 10 7 

 

Typical down/upload speeds reported by provider: Not provided 

 

Number of technology of transmission types reported by provider:  1 

 

Count of Middle Mile Facilities:  0 

 

End User Category:  4 

 

 

Data Verification: 

 

Counties served by provider and number of census blocks with service.  A total of 11 census blocks are served.  

County Census Block s per County 

Bristol 0 

Kent 2 

Newport 0 

Providence 9 

Washington 0 

 

Greatest down/upload speed from Historical 
1 

 speed tests:  7, 5 

Greatest down/upload speed from RIEDC 
2
  speed tests:  8,6 

Greatest down/upload speed from FCC 
3
  speed tests:  No FCC speed tests were taken 

Greatest down/upload speed from FCC Mobile Applications 
4
  speed tests:  No FCC speed tests were taken 
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Count of Historical speed tests:  3 

Count of RIEDC 
2
 speed tests:  1 

Count of FCC 
3
  speed tests:  0 

Count of FCC Mobile Applications 
4
  speed tests:  0   

 

RIEDC and FCC speed tests outside of reported service area:   0 

 

%/# of census blocks verified by RIEDC and FCC speed tests:  

Confirmation of census block served 1 

Census blocks served, not reported by provider 0 

Total number of served census blocks reported by provider 11 

% of served census blocks confirmed by speed test 9% 

 

 
Footnotes: 

1 Historical Date Range:  3/23/2009 to 3/22/2010 

2 RIEDC Date Range:  3/23/2010 to 9/5/2011 

3 FCC Date Range: 3/11/2010 to 6/30/2011 

4 FCC Mobile Application Date Range:  3/11/2010 to 6/30/2011  
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Provider Name:  Full Channel TV, Inc. 

DBA:  Full Channel 

 

Data Characteristics 

FRN:           0004973731 

Type of Data Submitted:        Census Blocks 

Census Block Count (unique):        1,089 

Provided Technology of Transmission:      YES 

Provided Max Advertised Download Speed:      YES 

Provided Max Advertised Upload Speed:      YES   

Provided Typical Download Speed:       YES 

Provided Typical Upload Speed:      YES 

Provided Middle Mile:         YES 

Provided Last Mile:         NO 

Provided Road Segments for census blocks greater than 2 sq miles:   NO 

Provided Address Points for census block greater than 2 sq miles:  NO 

Provided End User Category:       NO 

 

Maximum advertised down/upload speeds reported by provider:  

Max Download Category Max Upload Category Count 

6 4 1,089 

 

Typical down/upload speeds reported by provider: 6, 4 
 

Number of technology of transmission types reported by provider:  1 
 

Count of Middle Mile Facilities:  1 

 

End User Category:  Not provided 
 

 

Data Verification: 

 

Counties served by provider and number of census blocks with service.  A total of 1,089 census blocks are 

served.  

County Census Blocks per County 

Bristol 1,089 

Kent 0 

Newport 0 

Providence 0 

Washington 0 

 

Greatest down/upload speed from Historical 
1
  speed tests:  10, 3 and 9, 9 

Greatest down/upload speed from RIEDC 2010 
2
  speed tests:  6, 4 

Greatest down/upload speed from FCC 2010 
3
  speed tests:  6, 4 

Greatest down/upload speed from FCC 2010 
4
  Mobile Applications speed tests:  6, 4 
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Count of Historical speed tests:  1,819 

Count of RIEDC 
2
 speed tests:  17 

Count of FCC 
3
  speed tests:  11 

Count of FCC Mobile Applications 
4
  speed tests:  17 

 

RIEDC and FCC speed tests outside of reported service area:  1  

 

%/# of census blocks verified by RIEDC and FCC speed tests: 

Confirmation of census block served 26 

Census blocks served, not reported by provider 1 

Total number of served census blocks reported by provider 1,089 

% of served census blocks confirmed by speed test 2% 

 

 
Footnotes: 

1 Historical Date Range:  3/23/2009 to 3/22/2010 

2 RIEDC Date Range:  3/23/2010 to 9/5/2011 

3 FCC Date Range: 3/11/2010 to 6/30/2011 

4 FCC Mobile Application Date Range:  3/11/2010 to 6/30/2011 
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Provider Name:  Hughes Network Systems, LLC 

DBA:  Hughes 

 

Data Characteristics 

FRN:           0009559881 

Type of Data Submitted:        Satellite 

Census Block Count (unique):        N/A 

Provided Technology of Transmission:      YES 

Provided Spectrum Used:       YES 

Provided Max Advertised Download Speed:      YES 

Provided Max Advertised Upload Speed:      YES   

Provided Typical Download Speed:       YES 

Provided Typical Upload Speed:      YES 

 

Maximum advertised down/upload speeds reported by provider:  

Max Download Category Max Upload Category 

5 2 

 

Typical down/upload speeds reported by provider:  5, 1 
 

Number of technology of transmission types reported by provider:  1, with 1 spectrum 
 

 

Data Verification: 

 

Counties served by provider and number of census blocks with service.  A total of 24,999 census blocks are 

served.  

County Census Blocks per County 

Bristol 1,087 

Kent 4,180 

Newport 2,342 

Providence 13,150 

Washington 4,240 

 

 

Greatest down/upload speed from Historical 
1
  speed tests:  No speed tests were taken  

Greatest down/upload speed from RIEDC 
2
  speed tests:  No speed tests were taken 

Greatest down/upload speed from FCC 
3
  speed tests:  No speed tests were taken 

Greatest down/upload speed from FCC Mobile Application 
4
  speed tests:  3, 2 

 

Count of Historical speed tests:  0 

Count of RIEDC 
2
 speed tests:  0 

Count of FCC 
3
  speed tests:  0 

Count of FCC Mobile Applications 
4
  speed tests:  3 

 

RIEDC and FCC speed tests outside of reported service area:  0 
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%/# of census blocks verified by RIEDC and FCC speed tests: 

Confirmation of census block served 3 

Census blocks served, not reported by provider 0 

Total number of served census blocks reported by provider 24,999 

% of served census blocks confirmed by speed test <1% 

 

 
Footnotes: 

1 Historical Date Range:  3/23/2009 to 3/22/2010 

2 RIEDC  Date Range:  3/23/2010 to 9/5/2011 

3 FCC Date Range: 3/11/2010 to 6/30/2011 

4 FCC Mobile Application Date Range:  3/11/2010 to 6/30/2011 
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Provider Name:  Level 3 Communications, LLC 

DBA:  Broadwing 

 

Data Characteristics 

FRN:           0003723822 

Type of Data Submitted:        Census Blocks 

Census Block Count (unique):        6 

Provided Technology of Transmission:      YES 

Provided Max Advertised Download Speed:      YES 

Provided Max Advertised Upload Speed:      YES   

Provided Typical Download Speed:       YES 

Provided Typical Upload Speed:      YES 

Provided Typical Download Speed:       YES 

Provided Middle Mile:         YES 

Provided Last Mile:         NO 

Provided Road Segments for census blocks greater than 2 sq miles:   NO 

Provided Address Points for census block greater than 2 sq miles:  NO 

Provided End User  Category:       NO 

 

Maximum advertised down/upload speeds reported by provider:  

Max Download Category Max Upload Category Count 

11 11 6 

 

Typical down/upload speeds reported by provider: 11, 11 

 

Number of technology of transmission types reported by provider:  1 

 

Count of Middle Mile Facilities:  8 

 

End User Category:  Not provided 

 

Data Verification: 

 

Counties served by provider and number of census blocks with service.  A total of 6 census blocks are served.  

County Census Block s per County 

Bristol 0 

Kent 0 

Newport 0 

Providence 6 

Washington 0 

 

Greatest down/upload speed from Historical 
1
  speed tests:  4, 4 

Greatest down/upload speed from RIEDC 
2
  speed tests:  4, 4 

Greatest down/upload speed from FCC 
3
  speed tests:  7,5 

Greatest down/upload speed from FCC Mobile Applications 
4
  speed tests: No FCC Mobile speed tests were 

taken 
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Count of Historical speed tests:  30 

Count of RIEDC  
2
 speed tests:  4 

Count of FCC  
3
  speed tests:  1 

Count of FCC Mobile Applications 
4
  speed tests:  0 

 

RIEDC and FCC speed tests outside of reported service area: 5 of 5 speed tests were recorded outside the 

coverage area reported by provider   

 

Middle mile facilities outside of reported service area:  None of the 8 facilities reported are located within the 

reported service areas.  The closest is within 400 ft, the furthest is 30 miles.    

 

%/# of census blocks verified by RIEDC and FCC speed tests:  

 

 

 
Footnotes: 

1 Historical Date Range:  3/23/2009 to 3/22/2010 

2 RIEDC  Date Range:  3/23/2010 to 9/5/2011 

3 FCC Date Range: 3/11/2010 to 6/30/2011 

4 FCC Mobile App Date Range:  3/11/2010 to 6/30/2011 

Confirmation of census blocks served 0 

Census blocks served, not reported by provider 4 

Total number of served census blocks reported by provider 6 

% of served census blocks confirmed by speed test 0% 
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Provider Name:  Lightower Fiber Networks 

DBA:  Lightower Fiber Networks   

 

Data Characteristics 

FRN:           00017625567 

Type of Data Submitted:        Census Blocks 

Census Block Count (unique):        8,186 

Provided Technology of Transmission:      YES 

Provided Max Advertised Download Speed:      YES 

Provided Max Advertised Upload Speed:      YES   

Provided Typical Download Speed:       YES 

Provided Typical Upload Speed:      YES 

Provided Middle Mile:         NO 

Provided Last Mile:         NO 

Provided Road Segments for census blocks greater than 2 sq miles:   NO 

Provided Address Points for census block greater than 2 sq miles:  NO 

Provided End User Category:       NO 

 

Maximum advertised down/upload speeds reported by provider:  

Max Download Category Max Upload Category Count 

11 11 8,186 

 

Typical down/upload speeds reported by provider:  11, 11 

 

Number of technology of transmission types reported by provider:  1 

 

Count of Middle Mile Facilities:  0 

 

End User Category:  Not provided 

 

Data Verification: 

 

Counties served by provider and number of census blocks with service.  A total of 8,186 census blocks are 

served.  

County Census Blocks per County 

Bristol 0 

Kent 406 

Newport 0 

Providence 7,780 

Washington 0 

 

Greatest down/upload speed from Historical 
1
  speed tests:  No speed tests were taken 

Greatest down/upload speed from RIEDC  
2
  speed tests:  No speed tests were taken 

Greatest down/upload speed from FCC 
3
  speed tests:  No speed tests were taken 

Greatest down/upload speed from FCC Mobile Applications 
4
  speed tests:  No speed tests were taken 

Count of Historical speed tests:  0 
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Count of RIEDC 
2
 speed tests:  0 

Count of FCC 
3
 speed tests:  0 

Count of FCC Mobile Application 
4
 speed tests:  0 

 

RIEDC and FCC speed tests outside of reported service area: No speed tests were taken 

 

%/# of census blocks verified by RIEDC and FCC speed tests:  

Confirmation of census block served 0 

Census blocks served, not reported by provider 0 

Total number of served census blocks reported by provider 8,186 

% of served census blocks confirmed by speed test 0% 

 

 
Footnotes: 

1 Historical Date Range:  3/23/2009 to 3/22/2010 

2 RIEDC  Date Range:  3/23/2010 to 9/5/2011 

3 FCC Date Range: 3/11/2010 to 6/30/2011 

4 FCC Mobile App Date Range:  3/11/2010 to 6/30/2011 
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Provider Name:  One Communications Corp. 

DBA:  One Communications 

 

Data Characteristics 

FRN:           0015337702 

Type of Data Submitted:        Census Blocks 

Census Block Count (unique):        452 

Provided Technology of Transmission:      YES 

Provided Max Advertised Download Speed:      YES 

Provided Max Advertised Upload Speed:      YES   

Provided Typical Download Speed:       NO 

Provided Typical Upload Speed:      NO 

Provided Middle Mile:         YES 

Provided Last Mile:         NO 

Provided Road Segments for census blocks greater than 2 sq miles:   NO 

Provided Address Points for census blocks greater than 2 sq miles:  YES 

Provided End User Category:       NO 

 

Maximum advertised down/upload speeds reported by provider:  

Technology Max Download Category Max Upload Category Count 

10 7 7 1 

20 8 8 1 

30 7 7 1 

 

Typical down/upload speeds reported by provider:  Not provided  

 

Number of technology of transmission types reported by provider:  3 

 

Total count of Middle Mile facilities:  17 

 

End User Category:  Not provided 

 

Data Verification: 

 

Counties served by provider and number of census blocks with service.  A total of 452 census blocks are 

served.  

County Census Block per County 

Bristol 13 

Kent 40 

Newport 38 

Providence 338 

Washington 23 
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Greatest down/upload speed from Historical 
1
  speed tests:  5, 5 

Greatest down/upload speed from RIEDC  
2
  speed tests:  8, 8 

Greatest down/upload speed from FCC 
3
  speed tests:  3, 2 

Greatest down/upload speed from FCC Mobile Applications 
4
  speed tests:  3, 2 

 

Count of Historical speed tests:  889 

Count of RIEDC 
2
 speed tests:  42  

Count of FCC 
3
  speed tests:  3 

Count of FCC Mobile Application 
4
  speed tests:  3 

 

Speed tests outside of reported service area:  14 of 48 speed tests were reported outside the coverage area 

reported by the provider.   

 

Middle mile facilities outside of reported service area:  All facilities are in the general area of served areas.    

 

%/# of census blocks verified by RIEDC and FCC speed tests:  

Confirmation of census block served 17 

Census blocks served, not reported by provider 12 

Total number of served census blocks reported by provider 452 

% of served census blocks confirmed by speed test 4% 

 

 
Footnotes: 

1 Historical Date Range:  3/23/2009 to 3/22/2010 

2 RIEDC  Date Range:  3/23/2010 to 9/5/2011 

3 FCC Date Range: 3/11/2010 to 6/30/2011 

4 FCC Mobile Application Date Range:  3/11/2010 to 6/30/2011 
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Provider Name:  Sprint Nextel Corporation 

DBA:  Sprint 

 

Data Characteristics 

FRN:           0003774593 

Type of Data Submitted:        Wireless 

Census Block Count (unique):        N/A 

Provided Technology of Transmission:      YES 

Provided Spectrum Used:       YES 

Provided Max Advertised Download Speed:      YES 

Provided Max Advertised Upload Speed:      YES   

Provided Typical Download Speed:       YES 

Provided Typical Upload Speed:      YES 

Provided Middle Mile:         NO 

Provided Last Mile:         NO 

 

Maximum advertised down/upload speeds reported by provider:  

Max Download Category Max Upload Category 

5 3 

 

Typical down/upload speeds reported by provider:   5, 3 

 

Number of technology of transmission types reported by provider:  1, with 2 spectrums 

 

 

Data Verification: 

 

Counties served by provider and number of census blocks with service.  A total of 24,048 census blocks are 

served.  

 County Census Blocks per County 

Bristol 1,092 

Kent 4,004 

Newport 2,264 

Providence 12,821 

Washington 3,867 

 

Greatest down/upload speed from Historical 
1
  speed tests:  6, 3 

Greatest down/upload speed from RIEDC 
2
  speed tests:  8, 7 

Greatest down/upload speed from FCC 
3
  speed tests:  7, 6 

Greatest down/upload speed from FCC Mobile Applications 
4
  speed tests:  5, 5 

 

Count of Historical speed tests:  10 

Count of RIEDC 
2
 speed tests:  85 

Count of FCC 
3
  speed tests:  5 

Count of FCC Mobile Applications 
4
  speed tests:  291 
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RIEDC and FCC speed tests outside of reported service area:  4  

 

%/# of census blocks verified by RIEDC and FCC speed tests:  

Confirmation of census blocks served 70 

Census blocks served, not reported by provider 1 

Total number of served census blocks reported by provider 24,048 

% of served census blocks confirmed by speed test <1% 

 

 
Footnotes: 

1 Historical Date Range:  3/23/2009 to 3/22/2010 

2 RIEDC  Date Range:  3/23/2010 to 9/5/2011 

3 FCC Date Range: 3/11/2010 to 6/30/2011 

4 FCC Mobile Application Date Range:  3/11/2010 to 6/30/2011 
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Provider Name:  StarBand Communications, Inc. 

DBA:  StarBand Communications, Inc. 

 

Data Characteristics 

FRN:           0005087457  

Type of Data Submitted:        Satellite 

Census Block Count:         N/A 

Provided Technology of Transmission:      YES 

Provided Spectrum Used:         YES 

Provided Max Advertised Download Speed:      YES 

Provided Max Advertised Upload Speed:      YES   

Provided Typical Download Speed:       NO 

Provided Typical Upload Speed:      NO 

 

Maximum advertised down/upload speeds reported by provider:  

Max Download Category Max Upload Category 

3 2 

 

Typical down/upload speeds reported by provider:  Not reported 

 

Number of technology of transmission types reported by provider:  1, with 1 spectrum 

 

 

Data Verification: 

 

Counties served by provider and number of census blocks with service.  A total of 25,181 census blocks are 

served:  

County Census Block per County 

Bristol 1,092 

Kent 4,183 

Newport 2,452 

Providence 13,157 

Washington 4,297 

 

 

Greatest down/upload speed from Historical 
1
 speed test:  No speed tests were taken  

Greatest down/upload speed from RIEDC 
2
 speed test:  No speed tests were taken  

Greatest down/upload speed from FCC  
3
 speed test:  No speed tests were taken  

Greatest down/upload speed from FCC Mobile Applications 
4
 speed test:  No speed tests were taken 

 

Count of Historical speed tests:  0 

Count of RIEDC 
2
 speed tests:  0 

Count of FCC 
3
 speed tests:  0 

Count of FCC Mobile Applications 
4
  speed test:  0 
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RIEDC and FCC speed tests outside of reported service area:  0   

 

%/# of census blocks verified by RIEDC and FCC speed tests:  

Confirmation of census block served 0 

Census blocks served, not reported by provider 0 

Total number of served census blocks reported by provider 25,181 

% of served census blocks confirmed by speed test 0% 

 

 
Footnotes: 

1 Historical Date Range:  3/23/2009 to 3/22/2010 

2 RIEDC  Date Range:  3/23/2010 to 9/5/2011 

3 FCC Date Range: 3/11/2010 to 6/30/2011 

4 FCC Mobile Application Date Range:  3/11/2010 to 6/30/2011 
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Provider Name:  T-Mobile USA, Inc. 

DBA:  T-Mobile 

 

Data Characteristics 

FRN:           0006945950 

Type of Data Submitted:        Wireless 

Census Block Count (unique):        N/A 

Provided Technology of Transmission:      YES 

Provided Spectrum Used:       YES 

Provided Max Advertised Download Speed:      YES 

Provided Max Advertised Upload Speed:      YES   

Provided Typical Download Speed:       NO 

Provided Typical Upload Speed:      NO 

Provided Middle Mile:         YES 

Provided Last Mile:         NO 

 

Maximum advertised down/upload speeds reported by provider:  

Technology Max Download Category Max Upload Category 

80 7 4 

 

Typical down/upload speeds reported by provider: Not provided 

 

Number of technology of transmission types reported by provider:  1, with 1 spectrum 

 

Total count of Middle Mile facilities: 3 

 

Data Verification: 

 

Counties served by provider and number of census blocks with service.  A total of 23,891 census blocks are 

served.  

 County Census Blocks per County 

Bristol 1,088 

Kent 3,939 

Newport 2,303 

Providence 12,572 

Washington 3,989 

 

Greatest down/upload speed from Historical 
1
 speed tests:  No Historical speed tests were taken 

Greatest down/upload speed from RIEDC 
2
  speed tests:  No RIEDC speed tests were taken 

Greatest down/upload speed from FCC  
3
  speed tests:  2, 2 

Greatest down/upload speed from FCC Mobile Applications 
4
  speed tests:  5, 3 

 

Count of Historical speed tests:  0 

Count of RIEDC 2010 
2
 speed tests:  0 

Count of FCC 2010 
3
 speed tests:  1 

Count of FCC 2010  Mobile Applications 
4
  speed tests:  62 
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RIEDC and FCC speed tests outside of reported service area:   0  

 

Middle mile facilities outside of reported service area:  The two facilities are within the reported service area, 

though are located within 280 ft of each other.    

 

%/# of census blocks verified by RIEDC and FCC speed tests:  

Confirmation of census blocks served 69 

Census blocks served, not reported by provider 0 

Total number of served census blocks reported by provider 23,891 

% of served census blocks confirmed by speed test <1% 

 

 
Footnotes: 

1 Historical Date Range:  3/23/2009 to 3/22/2010 

2 RIEDC  Date Range:  3/23/2010 to 9/5/2011 

3 FCC Date Range: 3/11/2010 to 6/30/2011 

4 FCC Mobile Application Date Range:  3/11/2010 to 6/30/2011 
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Provider Name:  Verizon New England Inc. 

DBA:  Verizon 

 

Data Characteristics 

FRN:           0003628971 

Type of Data Submitted:        Census Blocks, Road Segments 

Census Block Count (unique):        18,479 

Road Segment Count (unique):       626  

Provided Technology of Transmission:      YES 

Provided Max Advertised Download Speed:      YES 

Provided Max Advertised Upload Speed:      YES   

Provided Typical Download Speed:       NO 

Provided Typical Upload Speed:      NO 

Provided Middle Mile:         NO 

Provided Last Mile:         NO 

Provided Road Segments for census blocks greater than 2 sq miles:   YES 

Provided Address Points for census blocks greater than 2 sq miles:  NO 

 

Maximum advertised down/upload speeds reported by provider:  

Technology Max Download Category Max Upload Category Count 

10 6 3 2,250 

50 9 7 13,763 

 

Typical down/upload speeds reported by provider: Not provided 

 

Number of technology of transmission types reported by provider:  2 

 

Total count of Middle Mile facilities:  Not provided 

 

Data Verification: 

 

Counties served by provider and number of census blocks with service.  A total of 18,522 census blocks are 

served ( 18,479 by census block data and 43 by road segment service data).   

 

County Census Blocks per County 

Bristol 896 

Kent 3,235 

Newport 1,647 

Providence 10,237 

Washington 2,507 

 

Greatest down/upload speed from Historical 
1
  speed tests:  10, 7 and 9, 8 

Greatest down/upload speed from RIEDC 2010 
2
  speed tests:  10,7 

Greatest down/upload speed from FCC 2010 
3
  speed tests:  9, 4 and 8, 8 

Greatest down/upload speed from FCC 2010 
4
  Mobile Application speed tests:  7, 7 
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Count of Historical speed tests:  44,322 

Count of RIEDC 
2
 speed tests:  1,042 

Count of FCC 
3
  speed tests:  383 

Count of FCC Mobile Application 
4
  speed tests:  775 

 

RIEDC and FCC speed tests outside of reported service area:   82 of the 2,200 speed tests outside of reported 

area  

 

 

%/# of census blocks verified by RIEDC and FCC speed tests:  

Confirmation of census block served 1,215 

Census blocks served, not reported by provider 37 

Total number of served census blocks reported by provider 18,479 

% of served census blocks confirmed by speed test 4% 

 
 

Footnotes: 

1 Historical Date Range:  3/23/2009 to 3/22/2010 

RIEDC  Date Range:  3/23/2010 to 9/5/2011 

2 FCC Date Range: 3/11/2010 to 6/30/2011 

3 FCC Mobile Application Date Range:  3/11/2010 to 6/30/2011 
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Provider Name:  Wild Blue Communications, Inc. 

DBA:  Wild Blue Communications, Inc. 

 

Data Characteristics 

FRN:           0007843766 

Type of Data Submitted:        Satellite 

Census Block Count (unique):        N/A 

Provided Technology of Transmission:      YES 

Provided Spectrum Used:       YES 

Provided Max Advertised Download Speed:      YES 

Provided Max Advertised Upload Speed:      YES  

Provided Typical Download Speed:       NO 

Provided Typical Upload Speed:      NO 

 

Maximum advertised down/upload speeds reported by provider:  

Max Download Category Max Upload Category 

4 2 

 

Typical down/upload speeds reported by provider: Not provided 

 

Number of technology of transmission types reported by provider:  1, and 1 spectrum 

 

Data Verification: 

 

Counties served by provider and number of census blocks with service.  A total of 25,181 census blocks are 

served.   

County Census Blocks per County 

Bristol 1,092 

Kent 4,183 

Newport 2,452 

Providence 13,157 

Washington 4,297 

 

 

Greatest down/upload speed from Historical 
1
  speed tests:  4, 1 

Greatest down/upload speed from RIEDC 
2
  speed tests:  No speed tests were taken 

Greatest down/upload speed from FCC 
3
  speed tests:  No speed tests were taken 

Greatest down/upload speed from FCC Mobile Application 
4
 speed tests:  No speed tests were taken 

 

Count of Historical speed tests:  0 

Count of RIEDC 
2
 speed tests: 0 

Count of FCC 
3
 speed tests:  0 

Count of FCC Mobile Application 
4
  speed tests: 0 

 

RIEDC and FCC speed tests outside of reported service area:   0  
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%/# of census blocks verified by RIEDC and FCC speed tests:  

Confirmation of census block served 0 

Census blocks served, not reported by provider 0 

Total number of served census blocks reported by provider 25,181 

% of served census blocks confirmed by speed test 0% 

 
 

Footnotes: 

4 Historical Date Range:  3/23/2009 to 3/22/2010 

5 RIEDC  Date Range:  3/23/2010 to 9/5/2011 

6 FCC Date Range: 3/11/2010 to 6/30/2011 

7 FCC Mobile Application Date Range:  3/11/2010 to 6/30/2011 
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Community Anchor Institutions:  All categories 

 

Data Characteristics 

Type of Data Submitted:       Point 

Feature Count:         984 

Provided Technology of Transmission:     YES, INCOMPLETE (382 of 984)  

Provided Subscribe Downstream Speed:     YES, INCOMPLETE (411 of 984)  

Provided Subscribe Upstream Speed:      YES, INCOMPLETE (861 of 984)  

Provided Street Address:      YES, COMPLETE  

Provide Public Wifi:       YES, COMPLETE  

Provided URL:        YES, INCOMPLETE (888 of 984)  

Provided CAIID:        YES, INCOMPLETE (652 of 984) 

 

Count of Community Anchor Institutions by category: 

 

 

Maximum Subscribe down/upstream speeds reported by institutions:  

CAI Category Max Downstream Category Max Upstream Category Count 

1 10 10 1 

2 10 10 1 

3 10 10 4 

4 10 10 2 

5 11 11 2 

6 11 11 1 

7 7 6 1 

 

Number of technology of transmission types reported by provider:  9 

 

Data Verification: 

Greatest down/upload speed from Historical   speed test:  10, 10   

Greatest down/upload speed from RIEDC  
1
  speed test:  10, 8 

Greatest down/upload speed from FCC 
2
  speed test:  9, 3 or 8, 8 

Greatest down/upload speed from FCC Mobile Applications 
3 

speed tests:  7, 5 
 

Count of RIEDC speed tests:  398 

Count of FCC speed tests: 52 

Count of FCC Mobile Applications speed tests:  79 
 

CAI Category Count of Features 

1 – School K through Grade 12 518 

2 - Library 91 

3 – Medical/healthcare 56 

4 – Public safety 243 

5 – Univ., college, other post-secondary 24 

6 – Other govt support - govt 48 

7 – Other govt support - nongovt 4 
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Footnotes: 

1 RIEDC Date Range:  3/23/2010 to 9/5/2011 

2 FCC Date Range: 3/11/2010 to 6/30/2011 

3 FCC Mobile Application Date Range:  3/11/2010 to 6/30/2011 
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Appendix A 

Glossary of Key Terms 

 

RIEDC: The Rhode Island Economic Development Corporation is the full service, official economic development 

organization for the state of Rhode Island. A quasi-public agency, the Corporation serves as a government and 

community resource to help streamline the business expansion in, and relocation to, Rhode Island. 

 

BBRI: An initiative of the RIEDC, Broadband Rhode Island funded by the American Recovery and Reinvestment Act and 

focuses on broadband mapping and broadband planning in the State of Rhode Island. 

 

Community Anchor Institute: Community Anchor Institutions (CAI) include Schools, libraries, medical and healthcare 

providers, public safety entities, community colleges and other institutions of higher education, and other community 

support organizations and entities. 

 

NTIA: The National Telecommunications and Information Administration (NTIA) is an agency of the United States 

Department of Commerce that serves as the President's principal adviser on telecommunications policies pertaining to 

the United States' economic and technological advancement and to regulation of the telecommunications industry. 

 

FCC:  The Federal Communications Commission (FCC) is an independent agency of the United States government, 

created, Congressional statute, and with the majority of its commissioners appointed by the current President. The FCC 

works towards six goals in the areas of broadband, competition, the spectrum, the media, public safety and homeland 

security, and modernizing the FCC. 

 

Census Block: A census block is the smallest geographic unit used by the United States Census Bureau for tabulation of 

100-percent data (data collected from all houses, rather than a sample of houses). Several blocks make up block 

groups, which again make up census tracts. 

 

Up Speed, Upstream Speed, Upload Speed: Measurement that describes how fast your connection can send data from 

your device. 

 

Down Speed, Downstream Speed, Download Speed:  Measurement that describes how fast your connection can 

deliver data to your device. 

 

Transmission Type, Transmission Technology:  Method by which users access broadband. 

Types Include 

10-Asymmetric xDSL 

20-Symmetric xDSL 

30-Other Copper Wireline 

40-Cable Modem – DOCSIS 3.0 

41-Cable Modem – Other 

50-Optical Carrier/Fiber to the End User 

60-Satellite 

70-Terrestrial Fixed Wireless - Unlicensed 

71-Terrestrial Fixed Wireless - Licensed 

80-Terrestrial Mobile Wireless 

90-Electric Power Line 

0-All Other 
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Spectrum Used: From which band range on the radio frequency spectrum the broadband signal is transmitted. 

Types Include 

1-Cellular spectrum (824-849 MHz; 862-869) used to provide service 

2-700 MHz spectrum (698-758 MHz; 775-788 MHz; 805-806 MHz) used to provide service 

3-Broadband Personal Communications Services spectrum (1850-1915 MHz; 1930-1995) used to provide 

service 

4-Advanced Wireless Services spectrum (1710-1755 MHz; 2100-2155) used to provide service 

5-Broadband Radio Service/Educational Broadband Service spectrum (2496-2690 MHz) used to provide service 

6-Unlicensed (including broadcast television white spaces) spectrum used to provide service 

7-Specialized Mobile Radio Service (SMR) (817-824 MHz; 862-869 MHz; 896-901 MHz; 935-940 MHz) 

8-Wireless Communications Service (WCS) spectrum (2305-2320 MHz; 2345-2360 MHz), 3650-3700 MHz 

9-Satellite (L-band, Big LEO, Little LEO, 2 GHz, Ka-Band, Ku-Band) 

10-Other 

99-Unknown 

 

Middle Mile: The segment of a telecommunications network linking a network operator's core network to the local 

network plant, typically situated in the central office 

 

Last Mile: The final leg of delivering connectivity from a communications provider to a customer. 
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Section C: Data Processes and Submission Overview 

Submission Summary 

The Broadband Rhode Island Mapping Team (BBRI) Team, led by EA Engineering, Science & 

Technology, Inc. (EA) in its role as primary technical lead for the Rhode Island Broadband 

Mapping project, contacted 140 potential facilities-based broadband service providers (BSPs) 

and received data from 19 providers.  An overall summary of the data submission is described 

below:  

  

140 potential facilities-based broadband service providers were contacted  

34 BSPs did not respond  

3 BSPs responded but did not provide data  

84 BSPs were identified as resellers of data 

19 BSPs responded and provided data  

 

Of those that provided data: 

  

9 provided only census block information  

1 provided census blocks and addresses  

1 provided census blocks and road segments  

8 provided wireless coverage areas  

  

In addition, 8 of the 19 responsive BSPs provided middle mile infrastructure points and 2 of 19 

responsive BSPs provided last mile infrastructure points. 

 

Rhode Island Broadband Mapping Data Processes 

Data Received From Providers – The process begins by receiving data from each provider that 

offers service in the State of Rhode Island (RI).  Broadband data is currently received from 19 

broadband facility based service providers within the State who have signed Non-Disclosure 

Agreements with RIEDC.  Once all of the available data is received from a provider it is reviewed 

and archived in its native format.  While the same data is requested from each provider the 

information often comes in different formats and with missing attribute and or spatial data.   If 

attributes are missing from the dataset the provider is contacted to see if the missing 

information is available.   

 

Data Evaluated & Processed – The EA project team gives the data spatial attributes through 

geocoding to the RI E911 data or by joining the data to the 2010 census block data.  The 

attribute data is then formatted so that the database can easily be entered in the Broadband 

Rhode Island geodatabase.  Speeds reported below broadband levels are removed from the 

dataset and archived.  Data that is located in census blocks great than 2 square miles are loaded 

into either the address or street segment feature classes.   All remaining data is loaded into the 

census block feature class.   The data is loaded using Esri tools and software.  The Broadband 

Rhode Island, or our data analysis geodatabase, stores the most recent broadband information.  
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Data is extracted from this geodatabase and formatted as needed to be used for the State’s 

web map and our biannual NTIA submittals.   Data is pulled from this analysis database, 

formatted to meet the web and NTIA formatting requirements, and loaded into either the NTIA 

transfer database or the web mapping database using custom built data extraction and loading 

tools.   
 

• Community Anchor Institute (CAI) Data:  The initial list of CAIs were received from the 

University of Rhode Island and populated into the BBRI database.  This data was then 

compared to and updated using 3
rd

 party datasets in order to create the most 

comprehensive CAI list available for RI.   In order to collect the broadband data for the 

CAIs, the BBRI Team utilized a top down approach.   The agencies that oversaw a large 

number of CAIs such as RINET and OSHEAN were contacted regarding the data 

collection.  CAIs that still had missing attribute data after contacting these agencies 

were contact directly via phone and email.  Once contacted, the CAIs were directed to 

an online survey.   The online survey walked the user through a short questionnaire that 

collected the required CAI broadband data.   At the end of the survey the user was 

directed to take a speed test in order to help with the data collection and verification 

process.     

 

Data Verification – Once the data is loaded into the geodatabase the verification process can 

begin.  This process is comprised of several steps to ensure that the actual facilities and services 

provided to the public match the provider’s data being reported.  

• Compared to Available Datasets  - 

o Speed test – Using Ookla’s speed test application, EA has been collecting speed 

test data for RI since March 2010.  A breakdown of speed tests collected over the 

past year by EA, displayed by month, can be found in the table below.   EA uses 

both the FCC speed tests collected for RI and the speed tests collected on the RI 

broadband website to get a better view of the actual speeds and coverage area 

providers are offering the public.   The speed tests are geocoded and mapped by 

provider.   (FCC speed test providers are identified by the speed test’s IP address)  

Each provider’s speed test data is compared to their stated coverage area.  

Discrepancies are noted and reported back to the provider.   The provider either 

gives a reason for the discrepancy or instructs us to modify their coverage area 

to match the speed test data.  
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o User feedback - user feedback information is captured by both the FCC and RI’s 

broadband mapping website.   This information is reviewed on a case by case 

basis.  Changes are made as needed to the data and reported to the provider, 

similar to the speed test data update process.   

 

o Best practices for final data quality checks include the review and comparison to 

3rd party datasets (such as the FCC’s 477 data) with the information received 

from the providers.  The FCC’s data is used to check for previously unknown 

providers, perform spatial analysis and comparisons on the data, and to give a 

better understanding of our confidence in the data.   Since FCC data is broken 

out by census tract the provider’s data must be converted to the tract level in 

order to perform a full data comparison.    

 

• Spatial Analysis of Coverage Area– Spatial Analysis is performed on each provider’s data 

set.  The analysis checks for small areas in populated sections of the state that are 

surrounded by coverage areas but do not show coverage.  These “donut holes” in the 

data are reviewed and reported to the provider if we feel they have a high probability of 

actually being covered by the providers’ broadband services.    

 

• Physical Infrastructure Survey - As part of the expanding need to verify broadband 

coverage within RI, a physical infrastructure survey pilot project was performed for the 

Town of Foster.  The physical infrastructure survey verified the physical broadband 

facilities present within the Town.  EA performed the survey utilizing GPS equipment 

and industry knowledge to capture the actual location of strategic infrastructure 

facilities throughout Foster.  The data was then mapped and analyzed to determine 

where wireline broadband service is theoretically available within the town.   Structures 

outside of the identified theoretical service area were mailed surveys to determine if 

broadband was actually available at their location as well as collect additional 

broadband usage information from the residents.    
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• Provider Meetings - The BBRI Team held conference calls with broadband providers that 

had significant changes in their current data submittals or had identified issues that 

required a review.  These conference calls were used as working sessions to review 

reasoning behind changes being made, discuss findings, address questions, and review 

edits being made to the provider’s submitted dataset.  Following the meetings, edits to 

the data were made final based on the information agreed upon.  The reason for making 

each edit to the data was documented in case issues or questions arose in the future. 

 

• 3
rd

 Party Verification – A 3
rd

 party, Mapping & Planning Services (M&PS), is used to do 

provide an independent review and a report on the status of each provider’s data.  

These reports summarize the data collected and provide a second review of the 

verification steps listed above. 

 

Data Analysis – In addition to the data verification steps, a complete summary of each 

provider’s data and static broadband coverage maps are created for RIEDC.  These maps are 

used to analyze existing data availability and plan for future broadband development and 

outreach projects. 

 

Geodatabase Checks– Once the data is processed and verified the database is checked prior to 

submittal to the NTIA.  This process is comprised of several steps to ensure that the information 

in the geodatabase is as accurate and complete and possible. 

    

• Visual Checks - These visual checks inspect the data to ensure completeness, accuracy, 

and engineering logic.  The visual inspection process employs random sampling 

techniques to validate feature placement and attribution.  The random sampling is 

performed in accordance with ANSI standards for attribute inspection.   

 

• Automated Checks – These checks are performed on 100% of the data.  ESRI’s 

Production Line Tool Set (PLTS) and the NTIA’s QC toolbox are utilized for the 

automated check of the data.   PLTS check for both schema and logical errors in the 

data.  The following checks are performed on the data.  

 

o Geodatabase Format - Verify that the geodatabase’s name and feature classes 

are correct per the corresponding RIEDC data model and NOFA requirements.  

o Coordinate System Errors - Check for proper projection definition. 

o Validity Checks - Verify the attribution fields in the tables and field values fall 

within the domain specified in the geodatabase.  

o Duplicate Item Values - Verify the uniqueness of attribute values within a user-

specified item (such as Feature IDs). 

o Invalid Item Values - Checks for invalid codes using discrete values and ranges 

defined in the appropriate domain tables. 

o Spatial Logic Checks - Checks the geodatabase to validate minimum size 

polygons, minimum length lines, and dangles in line feature classes. 
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• If the geodatabase has passed all tests listed above, and has met the acceptance criteria, 

the dataset is considered passed and can be processed for delivery to RIEDC and the 

NTIA.  If the geodatabase fails any test and does not meet acceptance criteria, the data 

is considered failed and will be returned with error reports to the data processing team 

for correction.  Additional follow-up with the providers may be necessary to correct the 

issue(s).  Once edits are completed or exceptions are documented, the geodatabase will 

be returned to the QC team for an additional sequence of all QC procedures.  This 

process will be repeated until all tests have received a passing status or exceptions have 

been documented. 
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Section D: Rhode Island’s Current Broadband Mapping Issues 

 

This section lists the issues the BBRI Team has encountered and is currently developing 

mitigation efforts against.  These issues are being reviewed by the BBRI Team in conjunction 

with other States and the NTIA.  Recommended solutions to each issue have been or will be 

presented to the NTIA when they are available.   

 

1. Currently the NTIA requires data at the address or street segment level for census blocks 

that are greater than 2 square miles in diameter.  This is a model that was developed to 

work for all states.   However, in the northeast region and RI in particular, the BBRI 

Team feels that the size standard for reporting at the address and street segment level 

should be smaller due to the higher density levels of population.  The BBRI Team is 

currently looking into a size standard that would better fit RI.  

 

2. Speed tests are currently being extensively utilized by the BBRI team.  The tests are very 

good at showing that coverage is available in a given area, but the actual speeds 

reported vary widely from one test to the next.  The speeds are inconsistent even if they 

are taken at the same location within minutes of one another.  Therefore, the speed 

results taken from this test cannot be used to verify or populate provider’s typical 

speeds.    

 

3. When using the SBDD submission check tool, the CAI TransTech check failed on the basis 

of “unexpected values.”  Based on the National Broadband Map message board, this 

seems to be an issue with the submission check tool and not the database attributes.  

Therefore, no change was made to correct CAI TransTech value at this time.  Updates to 

the check tool will be required in the future to eliminate this issue. 

 

4. The NTIA’s Data Package   spreadsheet needs to be updated.    

a. For the “Data Package Home” tab, one of the questions still reference 2000 

census blocks instead of 2010.   

b. For the “Providers Table” tab, we are required to list all potential providers that 

were contacted as part of this project.   This means that resellers are listed even 

if we are not requesting data from them.    There is no response in column F –

“This Company provided data, will provide data, will not provide data, or is non-

responsive” to match this category.   The BBRI Team listed these resellers as “will 

provide data” and noted that no data is being collected from them in the 

comments column.    
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Complete 99
Non-Responsive/Refused 6
In Progress 3

Count of Datasets by Status 108
Total Unique Providers Represented 50

Provider Name Platform Status

NDA 
Execution 

Date Notes

AT&T Inc. DSL Data Added to Statewide Inventory 12/16/2009

[AUG-31-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

AT&T Inc. Mobile Wireless Data Added to Statewide Inventory 12/16/2009

[AUG-31-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

CenturyLink DSL Data Added to Statewide Inventory 12/4/2009

[AUG-31-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Charter Communications, Inc. Cable Data Added to Statewide Inventory 12/15/2009

[AUG-31-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Chester Telephone Company DSL Data Added to Statewide Inventory 1/25/2010

[AUG-31-11 Matthew Brunt] Change: Provider 
upgraded infrastructure and can now offer 
speed tier 7 download speeds.

Chester Telephone Company Fiber Data Added to Statewide Inventory 1/25/2010
[AUG-31-11 Matthew Brunt] Change: Provider 
coverage area expanded.

Chester Telephone Company Cable Data Added to Statewide Inventory 1/25/2010
[AUG-31-11 Matthew Brunt] Change: Provider 
coverage area expanded.

Clearwire Corporation Mobile Wireless Data Added to Statewide Inventory 3/17/2011

[AUG-31-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Comcast Cable Communications, LLC Cable Data Added to Statewide Inventory 12/7/2009

[AUG-31-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Family View CableVision Cable Data Added to Statewide Inventory

[AUG-31-11 Matthew Brunt] Correction: 
Provider submitted initial data for October 2011 
submission.

Farmers Telephone Cooperative, Inc. Mobile Wireless Data Added to Statewide Inventory 1/22/2010
[AUG-31-11 Matthew Brunt] Change: Provider 
expanded coverage area.

Frontier Communications Corporation DSL Data Added to Statewide Inventory 1/22/2010
[AUG-31-11 Matthew Brunt] Change: Provider 
expanded coverage area.

Frontier Communications Corporation Fiber Data Added to Statewide Inventory 1/22/2010

[SEPT-13-11 Matthew Brunt] Change:  Provider 
upgraded part of their infrastructure, and can 
now provide fiber service to portions of their 
coverage area.

Home Telephone Company, Inc. Fiber Data Added to Statewide Inventory 1/22/2010
[AUG-31-11 Matthew Brunt] Change: Provider 
expanded coverage area.

Horry Telephone Cooperative, Inc. Cable Data Added to Statewide Inventory 1/22/2010

[AUG-31-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Horry Telephone Cooperative, Inc. DSL Data Added to Statewide Inventory 1/22/2010

[AUG-31-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Horry Telephone Cooperative, Inc. Fiber Data Added to Statewide Inventory 1/22/2010

[AUG-31-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Horry Telephone Cooperative, Inc. Mobile Wireless Data Added to Statewide Inventory 1/22/2010

[AUG-31-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Knology of South Carolina, Inc. Cable Data Added to Statewide Inventory 7/13/2011

[AUG-31-11 Matthew Brunt] Correction: 
Provider submitted initial data for October 2011 
submission.

Leap Wireless International, Inc. Mobile Wireless Data Added to Statewide Inventory 4/6/2010

[AUG-31-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Piedmont Rural Telephone Cooperative, Inc. Mobile Wireless Data Added to Statewide Inventory 1/28/2010
[AUG-31-11 Matthew Brunt] Change: Provider 
expanded coverage area.

Broadband Provider Log



Rock Hill Telephone Company Cable Data Added to Statewide Inventory 1/25/2010

[AUG-31-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Rock Hill Telephone Company Cable Data Added to Statewide Inventory 1/25/2010

[AUG-31-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Rock Hill Telephone Company Cable Data Added to Statewide Inventory 1/25/2010

[AUG-31-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Rock Hill Telephone Company Cable Data Added to Statewide Inventory 1/25/2010

[AUG-31-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Rock Hill Telephone Company Fiber Data Added to Statewide Inventory 1/25/2010

[AUG-31-11 Matthew Brunt] Correction: 
Provider's coverage area reduced slightly for a 
more accurate representation.

Rock Hill Telephone Company Fiber Data Added to Statewide Inventory 1/25/2010

[AUG-31-11 Matthew Brunt] Changes and 
Corrections: Service expansion and corrections 
to previous dataset.

Rock Hill Telephone Company Fiber Data Added to Statewide Inventory 1/25/2010

[AUG-31-11 Matthew Brunt] Changes and 
Corrections: Service expansion and corrections 
to previous dataset.

Rock Hill Telephone Company Mobile Wireless Data Added to Statewide Inventory 1/25/2010
[AUG-31-11 Matthew Brunt] Change: Provider 
expanded coverage area.

Sprint Nextel Corporation Mobile Wireless Data Added to Statewide Inventory 1/14/2010

[AUG-31-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

T-Mobile USA, Inc. Mobile Wireless Data Added to Statewide Inventory 1/8/2010

[AUG-31-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

TDS Telecommunications Corporation DSL Data Added to Statewide Inventory 1/27/2010

[AUG-31-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Time Warner Cable LLC Cable Data Added to Statewide Inventory 12/21/2009

[AUG-31-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

United States Cellular Corporation Mobile Wireless Data Added to Statewide Inventory 2/15/2011

[AUG-31-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Verizon South Inc. Mobile Wireless Data Added to Statewide Inventory 12/14/2009

[AUG-31-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

West Carolina Rural Telephone Cooperative, Inc. Fiber Data Added to Statewide Inventory 1/22/2010
[AUG-31-11 Matthew Brunt] Change: Provider's 
entire service area upgraded to fiber.

Windstream Communications DSL Data Added to Statewide Inventory 1/20/2010

[AUG-31-11 Matthew Brunt] Changes and/or 
Corrections: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

DeltaCom, Inc. Backhaul Backhaul Provider Only Processing Complete 2/16/2010
Horry Telephone Cooperative, Inc. Backhaul Backhaul Provider Only Processing Complete 1/22/2010
Level 3 Communications, LLC Backhaul Backhaul Provider Only Processing Complete 12/14/2009
Sprint Nextel Corporation Backhaul Backhaul Provider Only Processing Complete 1/14/2010
TDS Telecommunications Corporation Backhaul Backhaul Provider Only Processing Complete 1/27/2010
AT&T Inc. Backhaul No Update to Provide 12/16/2009
ATG Communications, LLC Backhaul No Update to Provide 1/14/2010
Atlantic Broadband, LLC Cable No Update to Provide 2/3/2010
CenturyLink Backhaul No Update to Provide 12/4/2009
Chesnee Telephone Company, Inc. DSL No Update to Provide 1/25/2010
Chesnee Telephone Company, Inc. Cable No Update to Provide 1/25/2010
Chester Telephone Company Backhaul No Update to Provide 1/25/2010

DISH Network Corporation Satellite No Update to Provide 1/27/2010

[SEPT-16-11 Matthew Brunt] Correction: 
Satellite data is being submitted and was not 
included in the April 2011 submission. While 
coverage is currently the entire state boundary, 
work continues on having more granular data 
available.

Electronics Service Company of Hamlet, LLC Fixed Wireless No Update to Provide 3/24/2010
Farmers Telephone Cooperative, Inc. DSL No Update to Provide 1/22/2010
Farmers Telephone Cooperative, Inc. Backhaul No Update to Provide 1/22/2010
Farmers Telephone Cooperative, Inc. Backhaul No Update to Provide 1/22/2010
Farmers Telephone Cooperative, Inc. DSL No Update to Provide 1/22/2010
Farmers Telephone Cooperative, Inc. Fiber No Update to Provide 1/22/2010
Hargray Communications Group, Inc. DSL No Update to Provide 1/25/2010
Hargray Communications Group, Inc. DSL No Update to Provide 1/25/2010
Hargray Communications Group, Inc. Cable No Update to Provide 1/25/2010
Hargray Communications Group, Inc. Cable No Update to Provide 1/25/2010
Hargray Communications Group, Inc. Fiber No Update to Provide 1/25/2010
Hargray Communications Group, Inc. Backhaul No Update to Provide 1/25/2010



Hargray Communications Group, Inc. Backhaul No Update to Provide 1/25/2010
Hargray Communications Group, Inc. Backhaul No Update to Provide 1/25/2010
Harron Communications LP Cable No Update to Provide
Home Telephone Company, Inc. Cable No Update to Provide 1/22/2010
Home Telephone Company, Inc. DSL No Update to Provide 1/22/2010
Home Telephone Company, Inc. Backhaul No Update to Provide 1/22/2010
Home Telephone Company, Inc. Backhaul No Update to Provide 1/22/2010
Home Telephone Company, Inc. Cable No Update to Provide 1/22/2010
Home Telephone Company, Inc. Fiber No Update to Provide 1/22/2010

Hughes Network Systems, LLC Satellite No Update to Provide 2/5/2010

[SEPT-16-11 Matthew Brunt] Correction: 
Satellite data is being submitted and was not 
included in the April 2011 submission. While 
coverage is currently the entire state boundary, 
work continues on having more granular data 
available.

Northland Communications Corp. Cable No Update to Provide
Palmetto Rural Telephone Cooperative, Inc. DSL No Update to Provide 1/22/2010
Palmetto Rural Telephone Cooperative, Inc. DSL No Update to Provide 1/22/2010
Pee Dee Net Fixed Wireless No Update to Provide 2/23/2010
Pee Dee Online Consulting Fixed Wireless No Update to Provide 2/24/2010
Piedmont Rural Telephone Cooperative, Inc. DSL No Update to Provide 1/28/2010
Rock Hill Telephone Company DSL No Update to Provide 1/25/2010
Rock Hill Telephone Company Cable No Update to Provide 1/25/2010
Rock Hill Telephone Company Fiber No Update to Provide 1/25/2010
Rock Hill Telephone Company Backhaul No Update to Provide 1/25/2010
Rock Hill Telephone Company Backhaul No Update to Provide 1/25/2010
Rock Hill Telephone Company Backhaul No Update to Provide 1/25/2010
Rock Hill Telephone Company Fixed Wireless No Update to Provide 1/25/2010
Rock Hill Telephone Company DSL No Update to Provide 1/25/2010
Rock Hill Telephone Company DSL No Update to Provide 1/25/2010
Rock Hill Telephone Company DSL No Update to Provide 1/25/2010
Sandhill Telephone Coop., Inc. DSL No Update to Provide 1/25/2010
Sandhill Telephone Coop., Inc. Backhaul No Update to Provide 1/25/2010
Skyrunner, Inc. Fixed Wireless No Update to Provide
Southern Coastal Cable, LLC Cable No Update to Provide 6/30/2010
tw telecom of south carolina, llc Backhaul No Update to Provide 4/26/2010
Verizon South Inc. Backhaul No Update to Provide 12/14/2009

West Carolina Rural Telephone Cooperative, Inc. DSL No Update to Provide 1/22/2010

West Carolina Rural Telephone Cooperative, Inc. Backhaul No Update to Provide 1/22/2010

WildBlue Communications, Inc. Satellite No Update to Provide 1/8/2010

[SEPT-16-11 Matthew Brunt] Correction: 
Satellite data is being submitted and was not 
included in the April 2011 submission. While 
coverage is currently the entire state boundary, 
work continues on having more granular data 
available.

Windstream Communications Backhaul No Update to Provide 1/20/2010

NTInet, Inc Fixed Wireless
No Update Provided - Use Last Submission 
Data 2/9/2010

Knology of South Carolina, Inc. Backhaul Provider Gathering Data 7/13/2011
Open Range Communications, Inc. Fixed Wireless Solicited Initial Data 5/5/2011

PAETEC Communications, Inc. Backhaul Other

[SEP-08-11 Wes Kerr] Multiple outreach 
attempts were conducted but no response was 
received. Paetec was bought out during the 
collection phase of this round by Windstream 
and we intend to be able to include the Paetec 
coverage as a part of the Windstream footprint 
during the next round.

Aero Networks, LLC Satellite Refused to Participate 11/22/2010
[JUL-11-11 Wes Kerr] Received a message that 
they would not provide any data this round.  

Birch Communications, Inc. DSL Refused to Participate

[JUN-22-11 Daryl Coffey] a company 
representative sent an e-mail stating they are 
still not interested in participating.

Birch Communications, Inc. Backhaul Refused to Participate

[JUN-22-11 Daryl Coffey] a company 
representative sent an e-mail stating they are 
still not interested in participating.

Countrywide Wireless Fixed Wireless Non-Responsive to Multiple Attempts

In addition to contact attempts made on August 
5, 2010 and January 4, 2011, 4 additional 
attempts were made this period.

Global Crossing Telecommunications, Inc. Backhaul Non-Responsive to Multiple Attempts

In addition to contact attempts made between 
July 1, 2010 and February 17, 2011, 3 additional 
attempts were made this period.

Main Street Wireless Fixed Wireless Non-Responsive to Multiple Attempts

In addition to contact attempts made between 
July 1, 2010 and February 1, 2011, 4 additional 
attempts were made this period.



                                                                                      

       Version 2.0         September 2011 Author: Kristin Rousseau 
       Page 1 

 

South Dakota Broadband Mapping Project: 
Product Release White Paper 

 

 

 

 

 

Contact Name Manager: Jim Edman 

Contact Phone Number:   603-773-4861 

Contact E-mail:   Jim.Edman@state.sd.us 

 

 

Submitted By:   Kristin Rousseau 

Contact E-mail:   kristin.rousseau@broadmap.com  

 

 

Product Specification: Fall 2011 NTIA Data Model  

Product/Process: NTIA—October 1, 2011 Data Deliverable 

Dataset Submission QC:   NTIA—SBDD_CheckSubmission.py 

 

 

 

 

 

 

 

mailto:Jim.Edman@state.sd.us
mailto:kristin.rousseau@broadmap.com


                                                                                      

       Version 2.0         September 2011 Author: Kristin Rousseau 
       Page 2 

Table of Contents 

OVERVIEW .........................................................................................5 

SUBMISSION SUMMARY ....................................................................5 

PROVIDER DETAILS ........................................................................................ 5 

PROVIDER PARTICIPATION ......................................................................................... 5 

COVERAGE AREA CHANGES ........................................................................................ 6 

DATA CORRECTIONS ................................................................................................... 7 

DATA VALIDATION & VERIFICATION ........................................................................... 7 

COMMUNITY ANCHOR INSTITUTION (CAI) DETIALS ....................................... 9 

OVERALL STATISTICS .................................................................................................. 9 

CAI CHANGES ............................................................................................................. 9 

SUBMISSION RECEIPT .................................................................................. 10 

SUBMISSION RECEIPT RESULTS ................................................................................. 10 

HIGH-LEVEL SUMMARY .................................................................... 11 

DATA GATHERING ....................................................................................... 11 

BROADBAND SERVICE AREAS, MIDDLE MILE AGGREGATION POINTS AND BROADBAND 
SERVICE OVERVIEW .................................................................................................. 11 

COMMUNITY ANCHOR INSTITUTION (CAI) ................................................................ 11 

DATA INTEGRATION PROCESS ..................................................................... 12 

DATA VALIDATION AND VERIFICATION ........................................................ 12 

THIRD-PARTY DATA VERIFICATION ........................................................................... 12 

BROADBAND PROVIDER VALIDATION—PROVIDER PORTAL APPLICATION ................. 12 

CONFIDENCE VALUES ............................................................................................... 13 

QUALITY CONTROL ...................................................................................... 13 

DETAILED PROCESS REVIEW ............................................................. 14 

PROVIDER OUTREACH ................................................................................. 14 

OUTREACH MATERIALS ............................................................................... 15 



                                                                                      

       Version 2.0         September 2011 Author: Kristin Rousseau 
       Page 3 

OUTREACH PROCESS ................................................................................... 15 

DATA COLLECTION ....................................................................................... 16 

DATA TRANSFER PROCEDURES ................................................................................. 16 

INITIAL DATA REVIEW AND QUALITY ASSURANCE ..................................................... 16 

DATA INGESTION ......................................................................................... 16 

DATA INGESTION OVERVIEW .................................................................................... 16 

POINT DATA ............................................................................................................. 17 

SUBSCRIBER LOCATION—ADDRESS DATA.................................................................................................... 17 
SUBSCRIBER LOCATION—XY DATA ............................................................................................................ 20 
SUBSCRIBER LOCATION—GIS DATA ........................................................................................................... 21 
DSLAM OR CENTRAL OFFICE LOCATION—ADDRESS DATA ................................................................................ 24 
DSLAM OR CENTRAL OFFICE LOCATION—XY DATA ........................................................................................ 24 
DSLAM OR CENTRAL OFFICE LOCATION—GIS DATA ........................................................................................ 24 
BROADCAST TOWER LOCATION—ADDRESS DATA ......................................................................................... 29 
BROADCAST TOWER LOCATION—XY DATA .................................................................................................. 29 
BROADCAST TOWER LOCATION—GIS DATA ................................................................................................. 29 

LINEAR DATA ............................................................................................................ 36 

TIGER® STREET SEGMENTS—LIST, SPREADSHEET OR GIS DATA ......................................................................... 36 

POLYGONAL DATA .................................................................................................... 40 

COVERAGE AREA—PDF/JPG/OTHER IMAGE FORMAT .................................................................................... 40 
COVERAGE AREA—KML/KMZ .................................................................................................................. 41 
COVERAGE AREA—CAD DATA .................................................................................................................. 42 
COVERAGE AREA—GIS DATA ................................................................................................................... 42 
COMPACT POLYGON FROM SUBSCRIBER POINTS ........................................................................................... 43 
CENSUS BLOCKS—LIST OR SPREADSHEET .................................................................................................... 45 
CENSUS BLOCKS—GIS DATA .................................................................................................................... 46 

METADATA TRANSACTIONS ........................................................................ 48 

DATA PROCESSING ...................................................................................... 50 

DATA PROCESSING OVERVIEW ................................................................................. 50 

WEIGHTED NOMINAL SPEED ..................................................................................... 51 

SUBSCRIBER DATA SUPPLIED BY PROVIDER .................................................................................................. 51 
VALUE SUPPLIED BY PROVIDER ................................................................................................................. 51 

MIDDLE MILE ........................................................................................................... 51 

BROADBAND COVERAGE TEMPLATE ......................................................................... 52 

VERIFICATION AND VALIDATION .............................................................................. 53 

PROVIDER VALIDATION—PROVIDER PORTAL/PDF MAP REVIEW ....................................................................... 53 
PROVIDER VERIFICATION—THIRD PARTY SOURCE REVIEW .............................................................................. 53 



                                                                                      

       Version 2.0         September 2011 Author: Kristin Rousseau 
       Page 4 

ASSIGNING CONFIDENCE VALUES .............................................................................................................. 54 

COMMUNITY ANCHOR INSTITUTION (CAI) DATA ....................................................... 55 

DATA COLLECTION ................................................................................................................................ 55 
INSTITUTION DATA ................................................................................................................................ 55 
COMMUNITY ANCHOR INSTITUTION (CAI) PORTAL UPDATES ............................................................................ 56 

PRODUCT EXTRACT...................................................................................... 56 

PYTHON SCRIPTS ...................................................................................................... 56 

PRODUCT EXTRACT PROCESS .................................................................................... 56 

PRODUCT STATISTICS ............................................................................................... 57 

QUALITY ASSURANCE .................................................................................. 58 

QC SUITE .................................................................................................................. 59 

CONFIGURATION .................................................................................................................................. 59 
LIBRARIES ........................................................................................................................................... 59 
QC SUITE ............................................................................................................................................ 60 
OTHER ............................................................................................................................................... 60 

PROCESS OPERATION AND MONITORING .................................................... 60 

BDIA PRODUCT CREATE ............................................................................................ 60 

PRODUCT VALIDATION AND STATISTICS ................................................................... 63 

PRODUCT EXTRACT DATA DELIVERY ............................................................ 64 

 



                                                                                      

       Version 2.0         September 2011 Author: Kristin Rousseau 
       Page 5 

 

OVERVIEW 

This white paper highlights the Submission Summary for this deliverable, as well as describes the Data Gathering, 
Data Integration, Data Validation and Verification and Quality Control processes used to create the Broadband 
Mapping Project’s October 1, 2011 data submission. To support varying levels of technical and program 
knowledge, both a high-level summary and a detailed process review are supplied. 
 

SUBMISSION SUMMARY 

PROVIDER DETAILS 

PROVIDER PARTICIPATION 

 Providers Included 

Alliance Communications Cooperative 
 

Northern Valley Communications 

AT&T MOBILITY 
 

Northern Wireless 

Beresford Municipal Telephone 
 

Qwest Communications 

CenturyLink 
 

RC Communications 

Cheyenne River Sioux Tribe 
 

RC Technologies, Inc. 

Consolidated Telecom 
 

Roberts County Telephone Cooperative 

DigitalBridge Communications (BridgeMaxx) 
 

Santel Communications 

Faith 
 

SDN Communications 

Fort Randall 
 

Sioux Valley Wireless 

Frontier Communications 
 

Sprint 

Golden West Communications 
 

StarBand Communications Inc. 

Interstate Telecommunications Cooperative 
 

Swiftel Communications 

Kennebec Telephone Company 
 

T-Mobile 

KeyOn Communications Inc. 
 

Triotel / McCook Cooperative 

Knology, Inc. 
 

Valley Telecommunications Cooperative 

Long Lines 
 

Valley Telephone 

Mediacom Communications Corporation 
 

Venture Communications 

Midcontinent Communications 
 

Verizon Wireless 

Midstate Communications 
 

West River Cooperative 

Mitchell Telecom 
 

West River Telecommunications Cooperative 

MNW Wireless 
 

Western Telephone Company 

 
 

 New Providers Since Last Data Submission 

 MNW Wireless 

 Northern Wireless 

 StarBand Communications 
 

 Non-Responsive/Non-Cooperative Providers  

 None 
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 Other Provider Comments 

 CenturyLink and Qwest have merged and submitted separate data for this round with the 
same FRN.  Data was aggregated into one footprint and the Qwest provider name was 
removed. 

 Expanded provider outreach to include the Form 477 filers and discovered that the majority 
of them that aren’t already included in the map are not broadband providers.  Attached is a 
spreadsheet reflecting the results of this review: 

477ProviderReview.
xlsx

 
 

 

COVERAGE AREA CHANGES 

 Coverage Footprint Reductions/Map Refinement –  

 Alliance Communications (TT-10 and TT-50) 

 Fort Randall Telephone Company (TT-10) 

 Golden West Cablevision Inc (TT-10, TT-41, TT-50) 

 Splitrock (TT-50) 
 

 Coverage Footprint Expansion –  

 Beresford Municipal Telephone  (TT-20) 

 CenturyLink (TT-10) 

 Due to Qwest acquisition 

 Interstate Telecommunications Cooperative, Inc.  (TT-10, TT-20 and TT-50) 

 Kennebec Telephone Company Inc 

 Inclusion of TT-50 

 Midcontinent Communications (TT-40 and TT-50) 

 Midstate Communications (TT-10, TT-40, TT-50, TT-70) 

 Mitchell Telecom (TT-50) 

 NVC (TT-10) 

 RC Communications (TT-10) 

 Roberts County Telephone Coop. Assn (TT-10) 

 Santel Communications Cooperative (TT-10) 

 SDN Communications (TT-50) 

 Splitrock (TT-10) 

 Swiftel Communications (TT-10 and TT-50) 

 TrioTel Communications, Inc.  (TT-10 and TT-50) 

 Valley Telecommunications  (TT-10 and TT-50) 

 Venture Communications Coop. (TT-10 and TT-50) 

 Verizon Wireless (TT-80) 

 West River Cooperative Telephone Company  (TT-10 and TT-50) 

 West River Telecommunications (TT-10) 
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DATA CORRECTIONS 

 Business only provider coverage areas were added back into the data now that the NTIA data 
model supports it with the inclusion of the EndUserCat field. 

 Midcontinent Communications 
 

 

DATA VALIDATION & VERIFICATION 

 Provider coverage areas were individually compared against third-party data to identify if the 
footprint is in alignment. In cases where anomalies were identified, we contacted the provider 
for further validation and refined the map, where needed.  The third-party data sources used for 
this review are as follows: 

o Comsearch 
o Pitney Bowes 
o American Roamer 

 

 For wireline and fixed wireless technologies, a set of reviews were conducted.  Coverage areas 
were first reviewed for accuracy by the providers directly via our online provider portal.   

 
Coverage areas were compared against known telecommunications exchange and territory 
boundaries. 
 
Coverage areas were compared by state telecommunications personnel against previously stated 
service boundaries, known areas of operation, and areas/locations where state-funded agencies 
have broadband services or have attempted to obtain broadband services. 
 
Crowd sourcing efforts were also undertaken to verify and validate broadband coverage areas.  A 
survey of community anchor institutions was sent by postal mail and electronic mail where 
possible, collecting information on broadband service availability, technology in use, advertised 
speeds, and results of a speed test.  This effort engaged government technology personnel along 
with the technology leadership of the healthcare systems of South Dakota, the K-12 education 
technology coordinators, and technology personnel of higher education.  Other industry sectors 
were also included in the survey by direct mailing and articles in trade publications.  This 
information was overlaid onto provider coverage areas and analyzed for alignment with stated 
capabilities. 
 
A public crowd sourcing campaign, including television spots, press releases, and online 
marketing/social media efforts was started requesting citizens to take speed tests from home, 
work, and elsewhere via our broadband website.  Combining address collection and verification 
with the speed test, over 5,000 consumer and business locations across the state have been 
collected.  These results have been combined with the data collected by the FCC Consumer 
Broadband Test and FCC Mobile Application to generate a master list of known broadband 
addresses and speeds.  This master list was analyzed for alignment with provider stated coverage 
areas and attribution. 
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 For verification of TransTech 80, Mobile Wireless, a series of drive tests were conducted across 
the state.  Using specialized software on mobile handsets, information on signal strength and 
broadband speed was GPS-tagged and collected.  To date, nearly 17,000 miles of local roads, 
state and federal highways have been driven, collecting over 5,000 GPS-tagged speed tests and 
over 600,000 signal strength values.  This data was overlaid onto coverage polygons received 
from each mobile wireless provider and analyzed for accuracy.   
 
Locations discovered to not have mobile wireless coverage but stated by the provider are being 
scheduled for additional focus testing and reporting to the provider for review.   
 
Locations found with broadband data coverage but not included with the provider’s original data 
will also be sent to the provider for review upon discovery. To date, none have been fully 
confirmed. 
 
Speed test results were compared against providers advertised speeds for anomalies. 
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COMMUNITY ANCHOR INSTITUTION (CAI) DETIALS 

OVERALL STATISTICS 

Community Anchor Institution - Categories 
Overall 
Count 

Broadband 
Subscriber 

(1 or 2) 

Trans 
Tech 

Advertised 
Speed Down 

Advertised 
Speed Up 

Category 1 - School K through 12 453 451 69 64 64 

Category 2 - Library  120 120 24 17 16 

Category 3 - Medical/Healthcare 204 172 36 27 26 

Category 4 - Public Safety 480 468 58 32 32 

Category 5 - Universities/Colleges 40 40 22 26 26 

Category 6 - Other:  Government 333 333 104 56 54 

Category 7 - Other:  Non-Government  19 18 4 3 3 

Total 1649 1602 317 225 221 

 

 

CAI CHANGES 

 A revised approach to the development of the South Dakota CAI list began for the Oct 2011 
submission.  Prior efforts involved the use of a combination of data sources, including locations 
gathered from the South Dakota Department of Education, the South Dakota Board of Regents, 
the South Dakota Bureau of Administration, trade organizations, healthcare systems, data 
purchased from the InfoUSA group, and resources internal to the South Dakota Bureau of 
Information and Telecommunications.  This approach was found to include institutions that 
would not fit the true spirit and definition of a CAI. As such, SDBIT removed those CAI’s from the 
list, while updating the list to include newly opened facilities. 
 

 The list of changes include, but are not limited to: 

 Inclusion of the most recent K-12 education facility list, removing recently consolidated K-12 
school district locations and included newly opened facilities 

 Updating the library list to the most recent obtained from the South Dakota State Library 

 Reduction of healthcare facilities to hospitals, major clinics, and facilities for an entire 
community/locality; thereby removing specialized and limited practice facilities such as 
dentists, dialysis centers, and chiropractors 

 Reduction of public safety locations to facilities staffed at least part-time 

 Inclusion of the most public higher-education facilities list obtained from the South Dakota 
Board of Regents 

 Inclusion of additional higher-education facilities, including newly-opened facilities, 
expanding campus locations, seminaries, and additional private schools located since 
previous submissions 

 Reduction of government community support locations to those that provide services to a 
community, such as social services offices, city halls, courthouses, public health nurse 
offices, and job service locations; Locations removed include maintenance and fueling 
facilities, government storage facilities, and state park ticketing offices 
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 Reduction of non-government community support locations, including removal of smaller 
airport facilities, churches and other houses of worship, and retail offices 
 
 

 There were 489 CAIIDs added to the CAI Inventory for Category 1: K-12 Schools, Category 2: 
Libraries and Category 5: Colleges, which were extracted from the three databases 
communicated by NTIA.  These databases are as follows: 
 

 For K-12 institutions (CAI type 1) please add the NCES ID CCD ID value found here: 

http://nces.ed.gov/ccd/bat/  

 

 For Higher Education (CAI type 5) please add the NCES IPEDS ID value found here: 

http://nces.ed.gov/ipeds/datacenter/  

 

 For Libraries (CAI  type 2) please. Combine (do not add) “FSCSKey” and “FSCs_SEQ” from the 

“puout08av2000” file and place them here: 

http://harvester.census.gov/imls/data/pls/index.asp (FYI the LIBID is your state’s unique ID 

for libraries) 

 

 

 

SUBMISSION RECEIPT 

SUBMISSION RECEIPT RESULTS 

 Attached are the results from the NTIA data submission receipt quality script. 
 

  
 The only item flagged in the submission receipt output is the following error, which has been 

verified as correct entries within the data submission.   
 

 Field Check:     FAILED      CAInstitutions_TRANSTECH has 2679 UNEXPECTED VALUES for 
query: TRANSTECH <> 0 AND TRANSTECH <> 10 AND TRANSTECH <> 20 AND TRANSTECH <> 
30 AND TRANSTECH <> 40 AND TRANSTECH <> 41 AND TRANSTECH <> 50 AND TRANSTECH 
<> 60 AND TRANSTECH <> 70 AND TRANSTECH <> 71 AND TRANSTECH <> 80 AND 
TRANSTECH <> 90 AND TRANSTECH <> 0 

 

 This was flagged due to an inconsistency between the data model and the submission 
receipt script, which has also been communicated by other Grantees on PBWorks.  

 
Hyperlink to Grantee Workspace in which the same issues were identified by other Grantees: 
https://sbdd-granteeworkspace.pbworks.com/w/page/42442088/Data%20Model%20Issues-June2011  

 
 

http://nces.ed.gov/ccd/bat/
http://nces.ed.gov/ipeds/datacenter/
http://harvester.census.gov/imls/data/pls/index.asp
https://sbdd-granteeworkspace.pbworks.com/w/page/42442088/Data%20Model%20Issues-June2011
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HIGH-LEVEL SUMMARY 

DATA GATHERING 

BROADBAND SERVICE AREAS, MIDDLE MILE AGGREGATION POINTS AND 
BROADBAND SERVICE OVERVIEW 

The collection of Broadband Service Areas, Middle Mile Aggregation Points and Broadband Service 
Overview information is handled through the following Provider Outreach Process: 

 Build and maintain an inventory of Broadband providers through research and State inputs. 

 Update provider material that describes the data requirements and logistics for data transfer. 

 Update Non-Disclosure Agreement (NDA) for use in project, where applicable. 

 Maintain multiple protocols for the provider to submit data, including Secure File Transfer 
Protocol (SFTP) technology when desired. 

 Conduct one-on-one informational discussions with each provider to communicate the following: 
o Requirements of this project; 

o Broadband data required to support the product data model; 

o Submission protocols available; 

o Capability to validate how the supplied data is aggregated. 

 Download/receive provider data. 

 Establish a repeatable process with provider. Maintain provider communication, transaction and 
data handling records throughout the project (dates contacted, data received, etc.).  

 

COMMUNITY ANCHOR INSTITUTION (CAI) 

The collection of CAI information is handled through the following CAI Collection Process: 

 Collect and maintain inventory of CAIs through data mining, research and State inputs. 

 Maintain web-based CAI portal for institutions to add or confirm attribution, location and enter 
broadband-specific information. 

 Upload web-based data to Core Database for standardization. 

 Perform internal cleansing, such as removing duplicate records, identifying gaps in broadband 
attribution and verifying category. 

 Geocode CAI locations. 

 Translate Core Database data to deliverable-ready format. 

 Continue engagement with non-responsive institutions. 
  



                                                                                      

       Version 2.0         September 2011 Author: Kristin Rousseau 
       Page 12 

DATA INTEGRATION PROCESS 

The data integration and processing mechanisms currently used allow for multiple types of inputs and result in 
a standardized output that meets the NTIA deliverable requirements. This flexible process supports data 
model changes and project-requested enhancements. 

 Receive inputs from providers via submission protocols; upload into Sourcing Database and catalog 
with provider information. 

 Review provider-supplied data for completeness and for potential discrepancies that require 
resolution prior to processing and flag as necessary. 

 Categorize input into data-type category (addresses, block lists, paper maps, etc.). 

 Standardize input based on data type within Staging Database. 

 Create Compact Polygons (CP)—(internal methodology for generating area-based feature for 
coverage in Staging Database). 

 Apply broadband attribution to CP; apply metadata to CP. 

 Perform quality analysis of the CP against the source supplied to identify any completeness or 
accuracy issues. 

 Request additional information from the provider if elements of coverage are missing or contain 
discrepancies. This is a second manual quality check to ensure data is complete. 
o Process coverage area to build the required NTIA data model layers.  

 Process CAI data input into internal standardized format, as discussed above in the Community 
Anchor Institution (CAI) subsection, based on NTIA and State-level requirements. 

 

DATA VALIDATION AND VERIFICATION 

Following the creation of the product, process steps within Data Validation and Verification occur. To ensure 
the data collected and processed is as accurate and comprehensive as possible, provider validation and 
internal verification activities are employed. After the initial mapping of providers’ coverage areas and 
serviceability claims, additional reviews are performed using the methods described in the subsections below 
(Third-Party Data Verification, Broadband Provider Validation, Confidence Values). 
 

THIRD-PARTY DATA VERIFICATION 

The coverage is visually and programmatically compared against third-party data. Pitney Bowes and 
American Roamer data are used in cases where a coverage area is questionable. All anomalies identified 
during this analysis are reviewed with the providers. 

 

BROADBAND PROVIDER VALIDATION—PROVIDER PORTAL APPLICATION 

Providers are trained on and requested to use a secure interactive web application to review their current 
coverage area(s) and supporting broadband attribution and validate their data or submit change requests 
to update their data. All provider change requests go through the Data Integration Process and are 
reviewed with the provider to complete validation. 
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CONFIDENCE VALUES 

All verification, validation and manual quality review results are tracked by provider/technology type and 
stored and maintained within a Validation table. A confidence value is assigned, based on internal 
assessments of the collected information, to highlight the provider coverage areas and/or attributions 
that would benefit from further investigation and/or enhancements. 

 

QUALITY CONTROL 

Following collection, processing and analysis of the provider and CAI data, the product is checked manually 
and algorithmically against the NTIA data model. Some of the items included within these checks are: 

 Format correctness; 

 Table and field structure; 

 Valid values, including default values, where applicable; 

 Geographic extent and topology errors. 
 
Prior to data submission, another quality control script supplied by NTIA is run. This script, 
SBDD_CheckSubmission.py, creates an output in text form that is required to be submitted along with the final 
deliverable. All errors must come up clean, unless otherwise specified by NTIA. Exceptions to the script as 
noted by NTIA on the SBDD Workspace on 03/25/11 can be found at the following link: https://sbdd-
granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions  

 Longitude values for States outside the lower 48 (any table); 

 CAI results for Transtech, MaxAdUp, MaxAdDown if BBService is “No” or “Unknown”; 

 Overview MaxAdDown, MaxAdUp if 100% of record-level data has MaxAdDown or MaxAdUp 
populated. 
  

https://sbdd-granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions
https://sbdd-granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions
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DETAILED PROCESS REVIEW 

A detailed review of the data collection, integration and quality control points within the broadband data gathering 
and mapping process are discussed in the subsections that follow. In addition, a diagram showing the overall 
process can be seen below. 

 
 

PROVIDER OUTREACH 

For the October 2011 data submission, an e-mail notification was sent to all providers with supporting 
deliverable dates. The providers mainly used the Provider Portal web application to submit changes to and/or 
validate their current coverage area(s). 

 
In support of the data collection effort, providers that did not timely respond to the outreach were contacted 
by phone. 
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OUTREACH MATERIALS 

The original provider packet sent via e-mail to the providers included the following documents and files: 

 Letter from the State inviting them to participate in the program; 

 Copy of the Non-Disclosure Agreement (NDA); 

 Copy of the Mapping NOFA from the NTIA; 

 Copy of the NOFA Clarification from the NTIA; 

 Broadband service address example file in CSV format; 

 Word document describing service address example file; 

 Broadband service block example file in CSV format; 

 Word document describing service block example file; 

 Broadband service street example file in CSV format; 

 Word document describing service street example file; 

 Broadband subscriber example file in CSV format; 

 Word document describing subscriber example file; 

 Broadband wireless coverage area sample shapefile; 

 Word document describing wireless coverage area sample shapefile; 

 Instructions for downloading, installing and using the WinSCP SFTP application. 
 

OUTREACH PROCESS 

The provider outreach process is comprised of the following general steps: 

 Send the provider package and introduction letter to the main point of contact for the provider. 

 Follow up with e-mail and telephone to verify that the main point of contact is correct. 

 If necessary, discuss the NDA further and resolve any redlines. 

 Once the correct primary contact is established, set up a telephone call, if necessary, to learn more 
about the provider’s offerings and direct them to the appropriate outreach materials. 

 If providers are unable to be contacted (non-responsive) or indicate that they are not interested in 
participating (non-cooperative), mark them as such on the provider tracking sheet. These providers 
will be escalated to the State for further action. 

 As the providers are collecting the required data, provide instructions on downloading, installing and 
using the WinSCP SFTP application, if required. 

 Arrange with the providers to transfer the data in whatever way they are comfortable: some 
providers will find regular email acceptable; others will want to use the SFTP application. 

 After data is received and reviewed, it may be necessary to contact a provider for clarification or to 
address incomplete datasets. In the interest of building and maintaining relationships, care is given 
not to push the provider but to work with it to obtain accurate data in the best possible format. 
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DATA COLLECTION 

DATA TRANSFER PROCEDURES 

There are three primary ways data is collected from providers. These are: 

 Secure FTP (SFTP) using the WinSCP application; 

 Regular e-mail; 

 Mail. 
 

INITIAL DATA REVIEW AND QUALITY ASSURANCE 

The initial data review and quality assurance process consists of the following general steps: 
1) Access the data from the SFTP site or e-mail. 

a. If e-mailed, place copy of original dataset in the appropriate provider folder on the SFTP site. 
2) Place copy of raw data on local computer in a working directory. 
3) Review data and determine course of action based on type of data received. 
4) Ensure data is complete and contact provider to address any gaps. 

 

NOTE: 
The goal is to get as many providers as possible to provide subscriber address data in the correct format. 
Obviously, this will not be possible with all providers so we will continue to have to process various types of 
provider-supplied data. 

 

DATA INGESTION 

DATA INGESTION OVERVIEW 

The following subsections outline the process steps taken based on the type of input supplied by the data 

provider: 

 Point Data: 
o Subscriber location; 
o DSLAM location; 
o Central Office location; 
o Broadcast Tower location. 

 Linear Data: 
o TIGER® street segments. 

 Polygonal Data: 
o Census Blocks; 
o Coverage Area. 

Overall, the process is geared toward taking the provider data supplied and creating polygon shapes to 
append to the bb_cov feature class. The bb_cov feature class is the interim dataset that is then processed 
using the makeDeliverable.py Python script to create the MapConnect

TM
 data layers that will be delivered 

to the State and, ultimately, to the NTIA. Detailed instructions used in this process can be found in the 
subsections below. 
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POINT DATA 

SUBSCRIBER LOCATION—ADDRESS DATA 

In the event that the data provider supplies subscriber address data, the steps are as follows: 
1) First, convert the address data to a clean Excel spreadsheet in an appropriate address data 

format. 
a. Usually, this has the following columns: street address (number, pre-directional, pre-

modifier, street name, street type, post-directional and post-modifier concatenated), city, 
state, ZIP. 

2) Configure the ArcGIS® geocoding tool to use the TIGER® 2009 streets dataset. 
a. In ArcCatalog®, create a new Address Locater by right-clicking in the white space of the 

appropriate directory and selecting New>Address Locater from the dropdown menu. 
b. Select US Streets with Zone and click OK. 

 

NOTE: 
It is likely that multiple Address Locators will have to be set up to handle the variety of provider address data 
received. 
 

c. Navigate to the TIGER Streets 2009 file and click OK. 
d. Fill in the dialog box, as shown below: 
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e. Click OK. 
3) Open ArcMap® and add the Excel spreadsheet with the address information. 
4) Right-click on the Excel spreadsheet and select Geocode Addresses from the dropdown menu. 
5) Select the appropriate address locator by clicking Add…, then OK. 

 

6) Fill out the Geocode Addresses dialog box, as shown below: 

 

7) Geocode the list in batch mode using the geocode service set up in Step 2 above, accepting all 
the default parameters. 

8) Review results. See example below. 
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9) Adjust geocoding parameters accordingly and repeat batch to resolve issues. 
10) Manually geocode unmatched addresses until target hit rate achieved, generally 90%. 
11) Visually inspect the data, as shown below: 

 

12) Follow the steps detailed in Subscriber Location—GIS Data below. 
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SUBSCRIBER LOCATION—XY DATA 

If the provider supplies a list of subscriber data with accompanying XY data such as latitude and 
longitude, the steps are as follows: 

1) Refine the format in Excel so that the data can be opened easily using ArcMap®. 

a. Remove all font color, highlighting, cell colors and borders, clean up column headers and 
make certain there are no merged cells. 

b. Make certain that XY locations are in decimal degrees. 
(i.) To convert from degrees, minutes, seconds (39º 26’ 45.67”) to decimal degrees, use the 

following formula: DD + (MM/60) + (SS.SSS/3600). 
 

NOTE: 
If XY locations from some other coordinate system are provided, you can use those in the process below but you 
must know what the coordinate system is. 
 

2) Open the Excel worksheet in ArcMap®. 

3) From the menu bar, select Tools>Add XY Data… 

 

4) Supply the appropriate fields for the X and Y coordinates, choose the appropriate coordinate 
system and click OK. 

5) Results are an event layer, not a true spatial layer. Export the data by right-clicking the event 
layer and selecting Data>Export Data… from the dropdown menu. 

6) Follow the steps detailed in Subscriber Location—GIS Data below. 
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SUBSCRIBER LOCATION—GIS DATA 

If the provider supplies subscriber location in GIS format, the only process step is to load that data 
into the appropriate data schema and it will be ready for processing. 
1) First, load the data into the Point Address database schema (please see Appendix D for an 

example of the Point Address database schema.) using an empty feature class in that schema. 

2) In ArcCatalog®, right-click on the empty feature class and select Load from the dropdown menu. 

3) Navigate to the provider address GIS dataset and then map the attribute fields accordingly, as 
shown below: 

 

4) Once you have successfully loaded the provider address data into the temporary database with 
the correct schema, you now will append that data to the overall Point Address database. 

5) In ArcToolbox®, use the Append command (Data Management Tools>General> Append) to add 
the features into the overall Point Address database, as shown below: 
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6) Since the data is already in the Point Address database schema, there is no need to alter the Field 
Map in the Append tool. 

7) After appending, calculate metadata reflecting geometry source and representation values. 
8) Break provider-specific points into separate county feature classes and perform the following 

steps per county feature class: 
a. Within ArcGIS®: 

(i.) Summarize download and upload speeds [first,last] to determine all speeds available for 
county. 
(1) This will save as a DBF table. Keep track of location for future reference. 

(ii.) Buffer county address point featureclass to 150’. 
(1) During buffer command, dissolve on ad_down; ad_up; provider; dba; frn; tt; all 

metadata fields; stctyfips. Save as…. county_fastestdown_fastestup.  
(2) Example using Qwest data: boulder_40128_20128, where boulder=county; 

40128=ad_down; 20128=ad_up. 
 

NOTE: 
These attribute fields are specific to the Point Address database. 
 

(iii.) Select the features that represent the lowest speeds. 
b. Using XtoolsPro (http://www.xtoolspro.com/): 

(i.) In the XTools Pro toolbar, select XTools Pro>Layer Operations>Erase Features. 
(ii.) Use the same feature class for Input and Overlay. 
(iii.) Check Use selected features on the Input feature, as shown below. 
(iv.) Repeat and erase slowest speeds one speed at a time. Save each new feature class as 

the next slowest speed, using the same naming convention as shown in a.(ii.)(1) above. 
A general example is shown below: 
  

http://www.xtoolspro.com/
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c. Return to ArcGIS®: 
(i.) Edit/delete speeds from the attribution table of each feature class, so each remaining 

feature class has only one speed value. 
(ii.) Merge individual speed feature classes using the Merge command in ArcToolbox® (Data 

Management Tools>General>Merge). The dialog box is shown below:  

 

(iii.) Merge individual county feature classes using the Merge command in ArcToolbox (Data 
Management Tools>General>Merge). 

(iv.) Since the county files are all in the same schema, DO NOT alter the Field Map portion of 
the command interface. 
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(v.) When all the county files are merged into one dataset, use the Append command in 
ArcToolbox® (Data Management Tools>General>Append) to add the features to the 
bb_cov interim dataset. Use the Field Map portion of the Append tool to map the 
appropriate field values to their corresponding fields in the bb_cov feature class. 

DSLAM OR CENTRAL OFFICE LOCATION—ADDRESS DATA 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central 
Office address data, the steps are as follows: 
1) Follow the process for geocoding points in Subscriber Location—Address Data above. 
2) Follow the steps detailed in DSLAM or Central Office Location—GIS Data below. 

DSLAM OR CENTRAL OFFICE LOCATION—XY DATA 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central 
Office XY data, the steps are as follows: 
1) Follow the process for creating points from XY data in Subscriber Location—XY Data above. 
2) Follow the steps detailed in DSLAM or Central Office Location—GIS Data below. 

DSLAM OR CENTRAL OFFICE LOCATION—GIS DATA 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central 
Office GIS data, the steps are as follows: 
1) Buffer the DSLAM/Central Office points feature class. 

a. Add the point feature class to ArcMap®. 

b. Open the ArcToolbox® and go to Analysis Tools>Proximity>Buffer. 

c. Set the buffer distance to 5 miles. 
d. Set the dissolve type to ALL. 
e. Name the output feature class. 
f. Typical Buffer tool is shown below: 
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g. Click OK. 

2) Use the resulting buffer feature class to clip the TIGER® street layer: 

a. Add TIGER® street layer to ArcMap®. 

b. Open the ArcToolbox® and go to Analysis Tools>Extract>Clip. 

c. Complete the dialog box as shown below: 

 

d. Click OK. 

3) Using ArcCatalog® and within the file geodatabase: 

a. Right-click and create a new Feature Dataset.  
(i.) For the Feature Dataset settings: 

(1) Name the feature dataset accordingly. 
(2) Select horizontal coordinate system by importing the coordinate system associated 

with the clipped TIGER® street layer by selecting Import and navigating to the 

location of that feature class. 
(3) No vertical coordinate system needed. 
(4) Leave all x,y,z,m values at default. 
(5) Click Finish. 

4) Import previously created street feature class into new Feature Dataset. 
5) Right-click Feature Dataset and create new Network Dataset—accept all default setting for the 

Network Dataset. 
 

NOTE: 
The Network Analyst extension must be turned on. 
 

6) In ArcMap® turn on the Network Analyst Toolbar by going to View>Toolbars>Network Analyst. 

7) Add the Network Dataset created in Step 5 to ArcMap. 
8) Using the Network Analyst Toolbar dropdown, create New Service Area. 

9) Open the Network Analyst Window by selecting the  button. See below. 
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10) Right-click Facilities layer, select Load Locations and navigate to the DSLAM/Central Office 
facilities feature class. 

 

11) Click OK. 

12) Click the Service Area Properties button . 
13)  For the following tabs, change the following properties: 

a. Polygon Generation tab:  
(i.) Select Merge by break value.  
(ii.) Also disable the Trim Polygons option. 

b. Analysis Settings tab—using and converting the specified DSLAM buffer distance from feet 
to meters—input buffer distance value in meters into the Default Breaks location. 
(i.) Generally, 18,000 feet (5486 meters) from DSLAM or Central Office location is used as 

the buffer distance. See below. 
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c. Click OK. 

14) On the Network Analyst Toolbar, click the Solve button  to create service area polygons. 
15) Right-click on the created service area polygon in the layer list, and select Data>Export Data from 

the dropdown list. 
16) Export to a feature class in the file geodatabase you created earlier. 

17) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the feature class created in Step 16 into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click the Add button, then click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 
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e. Click Next, then Next again, then Finish. 

18) In ArcToolbox®, go to Data Management Tools>General>Append. 

19) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 

 

20) Leave the Schema Type as TEST. 
21) Click OK. 

22) In ArcMap®, open bb_cov for editing and manually input associated attribution. 

  



                                                                                      

       Version 2.0         September 2011 Author: Kristin Rousseau 
       Page 29 

BROADCAST TOWER LOCATION—ADDRESS DATA 

In the event that the provider supplies wireless broadcast tower location address data, the steps are 
as follows: 
1) Follow the process for geocoding points in Subscriber Location—Address Data above. 
2) Follow the steps detailed in Broadcast Tower Location—GIS Data below. 

BROADCAST TOWER LOCATION—XY DATA 

In the event that the provider supplies wireless broadcast tower location XY data, the steps are as 
follows: 
1) Follow the process for creating points from XY data in Subscriber Location—XY Data above. 
2) Follow the steps detailed in Broadcast Tower Location—GIS Data below. 

BROADCAST TOWER LOCATION—GIS DATA 

In the event that the provider supplies wireless broadcast tower location GIS data, the steps are as 
follows: 
1) Download the required software (Radio Mobile) from the website: 

http://www.cplus.org/rmw/english1.html  
2) Install the software according to the standard directions, found here: 

http://www.cplus.org/rmw/download/download.php?S=1  
3) Open the application. 
4) Load the broadcast tower location and elevation information by selecting File>Unit properties. 

The following dialog box appears: 

 

5) Add the information for all the towers supplied by the WISP data provider, including the 
elevation. If provider does not supply elevation, this information can be obtained from Google 
Earth. 
a. If available, use the Import button to import a Google Earth KML of the tower locations. 

6) Go to the National Map Seamless Server (http://seamless.usgs.gov/) and download elevation 
data sufficient to contain the tower locations. 

http://www.cplus.org/rmw/english1.html
http://www.cplus.org/rmw/download/download.php?S=1
http://seamless.usgs.gov/
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a. At least the 1/3” NED data is needed. Select this by clicking the Download button in the 
upper right of the website and checking the box next to 1/3“ NED. 

b. Zoom to the area of interest and use the Download tools to define the area to download: 

 

c. Click the Modify Data Request button to request the data in BIL_16INT format, not ESRI 
GRID, as shown below: 

 

d. Download the data and unzip it. 
7) Select File>Map Properties to define the map. 
8) Enter a latitude and longitude in the center of the tower locations. 
9) Set the size (in pixels) and the size (in kilometers) of the map. 
10) Set the directory path leading to the BIL elevation data just downloaded. 
11) The dialog box is shown below: 
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12) Click Extract. 
13) The elevation data is rendered as a hill shade, as shown below: 

 
14) Select File>Network properties from the main menu. 
15) Create a new network and enter in the frequency range under the Parameters tab, as shown 

below: 
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16) Leave all the other values as they appear, and select the Systems tab. 
17) Create enough systems to cover all the varieties of equipment in the provider network. This will 

include the antenna type, height and line loss, as shown below: 
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18) Now click on the Membership tab, and assign the individual towers to their respective systems, 
providing the azimuth for non-omnidirectional antennas, as shown below: 

 
19) Click OK. 
20) Select Tools>Radio Coverage>Combined Cartesian from the main menu. 
21) Complete the dialog box as shown below, providing the Maximum Range from the highest tower 

beam radius supplied by the provider. 
22) Set the Pixel Size at 5 (experiment depending on the area covered to get the right level of 

granularity), as shown below: 

 
23) Set the Signal range to draw to S-Unit and type 5 in the From (>=) box. 
24) Click on Draw. See below. 
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25) Save the resulting image as a TIF by selecting File>Save Picture as. 
26) Open ArcMap® and load the BIL elevation data you used in Radio Mobile. 
27) Load the TIF image you created and georeference it using the corners of the BIL data. 

a. The corners of the data can be seen in the TIF image. 
28) Follow the georeferencing directions from the Coverage Area—PDF/JPG/Other Image Format 

section below. 
29) Use the Georeferencing Toolbar to Update the Georeferencing for the TIF dataset. 
30) In ArcToolbox®, select Data Transformations>From Raster>Raster to Polygon and input the 

georeferenced TIF you just created, as shown below: 
31) Open the resulting polygon feature class for editing using the Editing toolbar in ArcMap® and 

clean up as necessary. 
32) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the feature class created above into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click the Add button, then click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 
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e. Click Next, then Next again, then Finish. 

33) In ArcToolbox®, go to Data Management Tools>General>Append. 
34) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 

 
35) Leave the Schema Type as TEST. 
36) Click OK. 

37) In ArcMap®, open bb_cov for editing and manually input associated attribution. 
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LINEAR DATA 

TIGER® STREET SEGMENTS—LIST, SPREADSHEET OR GIS DATA 

In the event that the provider supplies TIGER® street segments in list or spreadsheet format, the 
steps are as follows: 
1) Join TIGER® road segments to 2000 census blocks feature class using one of two methods based 

on how the data is provided: 
a. If the TIGER® data is provided with a Census Block ID, then join the segments to the Census 

Block geometry based on that ID: 
(i.) Load both datasets into ArcMap®; 
(ii.) In the layer list, right-click on the 2000 census block feature class and select Joins and 

Relates>Join; 
(iii.) In the dialog box, select the TIGER® road segments data and the proper attribute fields 

for joining, as shown below: 

 
(iv.) Click OK. 

b. If the data provided is a list containing TLIDs, then join to the TIGER®/Line data using the 
TLID, and use a spatial join to associate the TIGER® segment with the coterminous block 
based on the block ID: 
(i.) Load both datasets into ArcMap®; 
(ii.) In the layer list, right-click on the 2000 census block feature class and select Joins and 

Relates>Join; 
(iii.) Select Join data from another layer based on spatial location from the dropdown 

menu; 
(iv.) Complete the dialog box, as shown below and click OK. 
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2) Export joined records into a temporary feature class. 
3) If joined Census Block geometry is confined to one specific area, then dissolve blocks into one 

record. If joined Census Block geometry is distributed throughout a particular State, then dissolve 
sub-selections of census blocks for each county. 
a. Use the County FIPS code to dissolve by county. 

b. In ArcToolbox®, select Data Management Tools>Generalization>Dissolve. 

c. Complete the Dissolve dialog box, as shown below: 
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d. Click OK. 

4) For each dissolved region, open the feature class for editing using the Editing tool in ArcMap® 

and remove unnecessary slivers and other small holes. For general guidance on editing features 

in ArcMap®, see http://webhelp.esri.com/arcgisdesktop/9.3/pdf/Editing_Tutorial.pdf  

5) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the feature class created above into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click on the Add button, then click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 
 

http://webhelp.esri.com/arcgisdesktop/9.3/pdf/Editing_Tutorial.pdf
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e. Click Next, then Next again, then Finish. 

6) In ArcToolbox®, go to Data Management Tools>General>Append. 
7) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 

 
8) Leave the Schema Type as TEST. 
9) Click OK. 
10) In ArcMap®, open bb_cov for editing and manually input associated attribution if necessary. 
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POLYGONAL DATA 

COVERAGE AREA—PDF/JPG/OTHER IMAGE FORMAT 

In the event that the provider supplies coverage area data in some image format such as PDF or JPG 
format, the steps are as follows: 
1) If in PDF format, open in Adobe Acrobat and Save As… JPG format. 

2) Open the JPG image in ArcMap®. 

3) Add the required base map vector data for georeferencing. 

a. This generally will be either the CDOT data or TIGER® data. 

4) Change the coordinate system of the data frame to the desired end coordinate system. 
5) Zoom to the general location of the JPG map image. 

a. This is the location based on the vector data, not the JPG image itself. For example, if you 
know that the JPG image represents an area around the town of Limon, zoom to the town of 
Limon in your vector data. 

6) Open the Georeferencing toolbar by selecting View>Toolbars>Georeferencing from the main 
menu bar. 

7) Using the Georeferencing toolbar, select Fit to Display; results are shown below: 

 

8) Use the Control Point button  to add control points to the map. 
9) Use common points in the base dataset and the JPG image. 

a. For example, find major street intersections, county/city boundaries, etc. 
b. Try to distribute the points more or less in the four corners on the image for the best 

transformation. 
10) Click on the location on the image first, then click on the corresponding location on the vector 

database map, as shown in the image below: 
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11) After placing each control point, the image transformation will update automatically.  
12) Repeat until satisfied with the transformation. 

 

NOTE: 
The transformation may take up to four points, although sometimes only two are necessary. 
 

13) When satisfied with the transformation, select Update Georeferencing from the Georeferencing 
toolbar dropdown. 
a. This will create a “world” file (.jgw in the case of JPGs) in the same directory as the image 

file. 

14) In ArcCatalog®, create a new polygon shapefile with the appropriate data schema for a provider 

coverage area, which can be found in Appendix D. 

15) Add the shapefile to ArcMap®. 

16) Using the Editor toolbar, select Start Editing. Set the Task to Create New Feature. 

17) Use the Sketch Tool  to digitize a new coverage polygon using the coverage area outline 
from the georeferenced JPG and add the required attributes manually. 

18) Repeat the above steps for all subscriber speed coverage areas provided. 
19) Follow the steps detailed in Coverage Area—GIS Data below. 

COVERAGE AREA—KML/KMZ 

In the event that the provider supplies coverage area data in Google Earth KML or KMZ format, the 
steps are as follows: 

1) Use a KML to SHP converter to translate file into an Esri® format. 

2) http://arcscripts.esri.com/details.asp?dbid=15603  

3) Download the script and follow the provided instructions for installing it in ArcToolbox®. 

4) Double-click on the script in ArcToolbox® and navigate to the location of the KML file, as shown 

below: 
 

http://arcscripts.esri.com/details.asp?dbid=15603
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5) Add the new shapefile to ArcMap®. Repeat for all KML files provided. 

6) Follow the steps detailed in Coverage Area—GIS Data below. 

COVERAGE AREA—CAD DATA 

In the event that the provider supplies coverage area data in GIS format, the steps are as follows: 

1) Transform the CAD dataset into an Esri® format. 

2) http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datase
ts 

3) It may be necessary to contact the provider first to determine the coordinate system of the CAD 
data. 

4) If the CAD data is not in a standard coordinate system, it may be necessary first to use ArcMap® 

to georeference the CAD data to a known coordinate system. 
a) To do so, follow the instructions provided above in Coverage Area—PDF/JPG/Other Image 

Format. 

5) In ArcCatalog®, create a new polygon shapefile with the appropriate data schema for a provider 

coverage area, which can be found in Appendix D. 

6) Add the shapefile to ArcMap®. 

7) Using the Editor Toolbar, select Start Editing. Set the Task to Create New Feature. 

8) Use the Sketch Tool  to digitize a new coverage polygon using the coverage area outline 
from the georeferenced CAD file and add the required attributes manually. 

9) Follow the steps detailed in Coverage Area—GIS Data below. 

COVERAGE AREA—GIS DATA 

In the event that the provider supplies coverage area data in GIS format, the steps are as follows: 

1) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the GIS feature class either created above or supplied by the provider into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click on the Add button, then click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 

 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datasets
http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datasets
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e. Click Next, then Next again, then Finish. 

2) In ArcToolbox®, go to Data Management Tools>General>Append. 

3) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 

 
4) Leave the Schema Type as TEST. 
5) Click OK. 

6) In ArcMap®, open bb_cov for editing and manually input associated attribution, if necessary. 

COMPACT POLYGON FROM SUBSCRIBER POINTS  

1) Geocode address list using latest State Composite Locator.  
2) Verify that your geocoded file has only one TT (Technology Type). If not, export individual 

geocoded layers for each Technology Type. 
3) For each TT, check for differences in speed values or speed tiers and create separate layers for 

each speed value/tier. 
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4) Clean your geocoding results: remove any points that geocode to accuracy levels below ZIP+4 
(ZIP centroids, carrier route centroids, etc). Also, verify that outliers with acceptable accuracy 
levels are legitimate, i.e., fall in correct city and Zip. 

5) Perform spatial join between county polygons (using stcnyfips field) and the cleaned geocoded 
subscriber points in order to carry the county name and stcnty fips. 

6) Summarize the number of subscribers by county and use the subscriber counts by county to 
populate the Rate Tier table. 

7) Un-join the county data from the geocode subscribers list. 
8) Create Compact Polygon using cleaned geocoded layer or sub-selection of XtoolsPro—

ConvexHull-DetailedHull option. A sub-selection of geocoded points will be used in areas where 
more than one polygon will need to be created for one provider’s service area. 

9) Evaluate output Hull carefully, looking for areas that should not be covered by hull polygon. 
a. If it is determined that an area or areas should not be represented in coverage area, 

manually reshape hull polygon until coverage area is adequate. 
b. When not obvious and as a general rule, manually resolve compact polygon when the 

distance between the subscriber points used to define the outer boundary of the compact 
polygon exceeds 5 miles . When reshaping the hull polygon, snap to the outermost 
geocoded points. See the three figures below for examples. 

      Compact Hull: Manual Resolution Required            
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Compact Hull: Manual Resolution Required                                        Compact Hull: After Manual Resolution        

                      
10) To attribute the compact polygon, perform a spatial join where your Target Feature Class is the 

compact polygon and the Join Feature Class is your geocoded point layer. Export compact hull 
with joined attributes and name file appropriately. 

11) Append attributed compact polygon to Broadband TT template Feature Class and, if required, 
manually input any provider attribution that may not have carried over in the append process. 

12) Intersect compact polygon with county boundaries to create unique records by county and use 
the state-county-fips field to populate stcty_fips field. Also use the county name field to populate 
the BBCov_Name field. 
a. Exception: where a provider’s coverage is distributed throughout more than one area of any 

given county where the BBcov_Name should be populated using an appropriate city or other 
logical name based on geographical location. 

13) Export/load into appropriate BB TT model dataset. 

CENSUS BLOCKS—LIST OR SPREADSHEET 

In the event that the provider supplies census block data in a list or spreadsheet, the steps are as 
follows: 
1) Ensure block polygons supplied by the provider are 2000 currency. 
2) If other currency, convert to 2000 currency before proceeding. 

a. To do this, remove the trailing letter (a, b, etc.) from the block ID. 
b. You will now have two blocks that equate to one block in the 2000 block geometry. 
c. Delete duplicate block IDs, retaining the higher service tier in each case. 

3) Prepare the block list in clean Excel format, removing all Excel-only formatting, merged cells, 
colors, borders, etc. 

4) Import the spreadsheet into ArcMap®. 

5) Right-click on the 2000 census block feature class in the layer list in ArcMap® and select Joins 

and Relates>Join from the dropdown menu. Join the census block list to the 2000 census blocks 
feature class using the block ID and export joined records in a new feature class. The Join dialog 
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box and process can be seen above in the TIGER® Street Segments—List, Spreadsheet or GIS 

Data subsection. 
6) Follow the steps in Census Blocks—GIS Data below. 

CENSUS BLOCKS—GIS DATA 

In the event that the provider supplies census block GIS data, the steps are as follows: 
1) Ensure that the blocks supplied by the provider are in the required data schema and are 

complete as far as required attribution. 
a. If not, manually enter the required attribution or contact the provider to fill gaps. 

2) If census block geometry is distributed throughout more than one county, then select Data 
Management Tools>Generalization>Dissolve in ArcToolbox® and dissolve based on 
County/Provider/TT/Speed Tier so that unique records are created for each unique combination. 
a. The Dissolve dialog box is shown above in the TIGER® Street Segments—List, Spreadsheet 

or GIS Data section. 
b. Two examples of undissolved census block polygons are shown below: 

 
Undissolved census block polygons 

 
Census block polygons dissolved by county 

3) For each dissolved region use the Editing toolbar in ArcMap® to remove unnecessary slivers and 

other small holes. 
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4) In ArcToolbox®, select Data Management Tools>General>Merge and merge the processed 

polygons into a single layer. 
5) The merged census blocks will need to have the subscriber’s frn field added and populated. 

6) In ArcCatalog®, create an empty feature class with the schema of the bb_cov feature class and 

load the GIS feature class either created above or supplied by the provider into it. 
a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class. 
b. Click the Add button, the click Next. 
c. Accept the defaults and click Next. 
d. DO NOT attempt to map any fields, as shown below: 

 
e. Click Next, then Next again, then Finish. 

7) In ArcToolbox®, go to Data Management Tools>General>Append. 

8) Append the formerly empty feature class to bb_cov, completing the dialog box, as shown below: 
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9) Leave the Schema Type as TEST. 
10) Click OK. 

11) In ArcMap®, open bb_cov for editing and manually input associated attribution, if necessary. 

 

METADATA TRANSACTIONS 

Following any updates or changes completed within the file geodatabase (fGDB) stored on the GIS-Analysts 
staging environment, the GIS-Analyst runs transactions to compare that fGDB with the one stored on the Core 
server to ensure metadata on all changes is recorded. 

 
The steps taken to run transactions on the updated Core database are outlined below: 

1) Open a command line window and run generateTransactions.py:  
a. Usage: generateTransactions.py  [Core fGDB] [Staging Environment fGDB]  
b. Example of command line:  

<path>generateTransactions.py <path>ST_BB_POLY_SRV_AREAS.gdb <path>ST_BB_POLY_SRV_AREAS.gdb  
2) Shown below is an example of the output screen that will be displayed: 
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3) After the process has completed, results can be found in the ST_BB_POLY_SRV_AREAS_HIST.gdb:  

a. The transactions scripts records changes at a feature level. 
b. Shown below is a screenshot supporting the directory structure of the historical fGDB. 

 
c. Attribution associated with each added/removed/changed feature is tracked, including the 

following additional columns appended to the end of each: 
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(i.) Commit_by 
(1) Records the GIS-Analyst who committed the changes to the historical fGDB. 

(ii.) Commit_date 
(1) Records the date and time stamp on which the changes were committed. 

(iii.) Trans_type 
(1) This field reflects the type of change recorded; 
(2) Categorized by: Adds/Change/Deletes. 

(iv.) New_values 
(1) Records the new values when a change was completed on a feature. Example: 

Name or speed change. 
d. MD_Process also is transferred from the edited fGDB to the historical fGDB, which states the 

actions completed by the GIS-Analyst. 

 

 

DATA PROCESSING 

DATA PROCESSING OVERVIEW 

The following subsections detail the steps and layout required to process the service provider data further 
to meet NTIA requirements: 

 Weighted Nominal Speed; 

 Middle Mile; 

 Broadband Coverage Template. 
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WEIGHTED NOMINAL SPEED 

The weighted nominal speed is populated in one of the following two ways: subscriber data supplied by 
provider or value supplied by provider. 

SUBSCRIBER DATA SUPPLIED BY PROVIDER 

Where the data provider supplies subscriber speed information, the following formula from the NOFA 
is used: 

(speed tier-1 in kbps × no. of tier-1 subscribers) + (speed tier-2 in kbps × no. of tier-2 subscribers) + (etc.) 
Total average monthly subscribers 

 
Data is initially broken up in the following order: 
1) Stcty_fips; 
2) Transmission technology type; 
3) Subscriber tiers. 

VALUE SUPPLIED BY PROVIDER 

Some providers will supply their weighted nominal speed. In these cases, the data supplied will be 
populated instead of using the NOFA formula. These obtained or calculated values are used to update 
the service overview layer. 
 
This can be done manually or by creating a table with the provider’s FRN and average weighted speed 

and joining it to the service overview table in ArcMap®. 

1) To join, right-click on the layer to join to and select Joins and Relates>Join from the dropdown 
menu. 

2) Then navigate to the table to join to and select the join fields from the dropdown list. 

3) Then open the source table (the table in ArcMap®) and right-click on the header of the Average 

Weighted Speed field and select Calculate Field from the dropdown menu. 
4) Use the value of the average weighted speed from the joined table. 

 

MIDDLE MILE 

Middle mile information generally is provided in spreadsheet or text file format. The process is to take 
what is supplied by the provider and translate it into the required data schema. 

1) If the data is supplied with address information, follow the process outlined above in Subscriber 
Location—Address Data. 

2) If the data is supplied with associated XY coordinates, follow the process outlined above in 
Subscriber Location—XY Data. 

3) Once the data is in GIS format, use the Append (Data Management Tools>General>Append) 

command in ArcToolbox® to append the data to the overall middle mile dataset. 

4) Set the schema type to NO_TEST and use the Field Map to map the attribute fields from the 
source to the target dataset. 
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BROADBAND COVERAGE TEMPLATE 

The table below lists descriptions of the fields within the bb_cov layer, which is the interim dataset used 
to create the final product deliverable. 
 

NAME ALIAS DESCRIPTION 

objectid OBJECTID Internal Object ID 

shape SHAPE Internal Shape storage 

prov_id PROVIDER_ID Unique numeric identifier for each provider 

prov_name PROVIDER_NAME Unique name for each provider 

dba_name DOING_BUSINESS_AS An alternative "Doing-Business-As" name for the provider 

frn FCC_REGISTRATION_NUMBER Provider FCC Registration Number 

bbcov_name BBCOV_NAME BroadMap Broadband Coverage name 

trans_code TRANSMISSION_CODE Unique code for the transmission technology type described by 

this layer 

trans_name TRANSMISSION_NAME Name for the transmissions technology type 

trans_desc TRANSMISSION_DESC Description for the transmissions technology type 

spect_code SPECTRUM_CODE Unique code for the spectrum [WIRELESS ONLY] 

spect_name SPECTRUM_NAME Name for the spectrum [WIRELESS ONLY] 

spect_desc SPECTRUM_DESC Description for the spectrum [WIRELESS ONLY] 

mad_dwn_t MAX_AD_DOWN_TIER Maximum advertised downstream speed available within given 

area (speed tier) 

mad_up_t MAX_AD_UP_TIER Maximum advertised upstream speed available within given area 

(speed tier) 

typ_dwn_t TYPICAL_DOWN_TIER Typical downstream speed available within given area (speed tier) 

typ_up_t TYPICAL_UP_TIER Typical upstream speed available within given area (speed tier) 

mad_dwn_k MAX_AD_DOWN_KBPS Maximum advertised downstream speed available within given 

area (kbps) 

mad_up_k MAX_AD_UP_KBPS Maximum advertised upstream speed available within given area 

(kbps) 

typ_dwn_k TYPICAL_DOWN_KBPS Typical downstream speed available within given area (kbps) 

typ_up_k TYPICAL_UP_KBPS Typical upstream speed available within given area (kbps) 

subs SUBSCRIBERS Total average monthly subscribers for this provider for this 

technology for this coverage polygon 

md_geom MD_GEOMETRY Metadata: Comma separated list of source ids from which the 

polygon extent was produced 

md_exists MD_EXISTS Metadata: Comma-separated list of source ids used in 

understanding and editing the provider data for this polygon 
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NAME ALIAS DESCRIPTION 

md_who MD_WHO Metadata: Name of the editor who last edited this feature at the 

time in md_when 

md_when MD_WHEN Metadata: Date/time that this feature was last edited 

md_process MD_PROCESS Metadata: Comma-separated list of processes used to create 

and/or modify this layer 

stcty_fips STATE_COUNTY_FIPS State/County FIPS code 

rec_id RECORD_ID Compound Key formed from 

STCTY_FIPS+"|"+Provider_ID+"|"+Trans_Code+"|"+BBCov_Name 

st_area ST_AREA(SHAPE) Area in square decimal degrees  

st_length ST_LENGTH(SHAPE) Length in decimal degrees  

Provider_Type Type of Provider Has Subtype (1:Broadband provider as described in the 

NOFA,2:Reseller,3:Unknown), default value=1 (New 04/11 Model) 

 

VERIFICATION AND VALIDATION 

PROVIDER VALIDATION—PROVIDER PORTAL/PDF MAP REVIEW 

Following the collection and aggregation of provider data, the aggregated data is validated by the 
provider to ensure it is an accurate representation of their coverage area and supporting broadband 
information. 

 This validation is completed through the Provider Portal web application, which is a secure 
interactive map that displays the provider’s coverage areas and allows the provider to 
validate, submit feedback or request changes. 
o If changes are requested, then the features on the portal are updated and an automatic 

request is sent to the provider to complete the validation process. 

 Providers that did not use the Provider Portal are asked to validate a PDF map displaying 
their coverage area(s). This is accomplished via e-mail notification. 

PROVIDER VERIFICATION—THIRD PARTY SOURCE REVIEW 

After the provider has validated its coverage areas, a third-party source comparison and analysis is 
performed. 

 Where anomalies or discrepancies are identified, a “SCAN” point is dropped and descriptive 
comments are applied to be reviewed later with the provider. 

 During the provider review, the map is displayed along with the “SCAN” points and potential 
refinement is completed based on input from the provider. 

The table below shows third-party sources used: 

THIRD-PARTY SOURCE NAME SOURCE TYPE VERIFICATION TYPE 

InfoUSA Consumer and 
Business Listings 

Community Anchor Institutions; 
Can also be used for demographic information 
supporting the State websites. 

Pitney Bowes (PBBI) Exchange Info Plus 
(Central Office 
Locations) 

Exchange datasets are used to verify the following 
Transmission Technologies (TT): 
Asymmetric xDSL (10), Symmetric xDSL (20), Other 
Copper Wireline (30), and Optical Carrier/Fiber to the 
End User (50). 
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THIRD-PARTY SOURCE NAME SOURCE TYPE VERIFICATION TYPE 

Media Prints Cable Boundaries Used to verify the following TT: 
Cable Modem—DOCSIS 3.0 (40) and Cable Modem—
Other (41). 

American Roamer  Wireless Coverage 
Patterns (EVDO, 
GPRS, WISP, HSPA) 

Used to verify the following TT: 
Terrestrial Fixed Wireless—Unlicensed (70), Terrestrial 
Fixed Wireless—Licensed (71) and Terrestrial Mobile 
Wireless (80). 

ComSearch Wireless Spectrum 
Holdings and Tower 
Data 

Used to verify the following TT: 
Terrestrial Fixed Wireless—Unlicensed (70), Terrestrial 
Fixed Wireless—Licensed (71) and Terrestrial Mobile 
Wireless (80). 

ASSIGNING CONFIDENCE VALUES 
All findings and results from the abovementioned validation and verification activities, plus internal 
peer quality reviews, are captured and tracked in a Validation table (see example on the following 
page) and form the basis of the confidence value assigned for each provider and then each 
technology. 

CONFIDENCE VALUE DESCRIPTION 

    0 Coverage area has not been reviewed. 

  10 Extremely Low: 
Single Source QC.   

  20 Very Low: 
Needs additional validation\verification. 

  30 Low: 
Even with validation\verification, coverage still is suspect. 

  40 Acceptable: 
Confirm with State prior to shipment. 

  50 Meets requirements to be included in shipment. 

  60 Moderate: 
Meets NTIA/State’s standards, representative of Technology Type (TT). 

  70 High: 
Accurate representation of coverage based upon TT. 

  80 Very High: 
Multiple validation\verification with most third-party sources. 

  90 Extremely High: 
Multiple validation\verification sources. 

100 Perfect: 
Multiple validation\verification sources, with complete alignment with 
sources and ground truth verification activities. 

 

The Validation table is maintained as updates or changes occur for each provider, down to 
technology type, with the overall goal to improve the confidence values and overall map 
representation. An example of the Validation table is shown below: 
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COMMUNITY ANCHOR INSTITUTION (CAI) DATA 

DATA COLLECTION 

The CAI data was initially collected from the State to create the baseline inventory. All location 
information and broadband coverage data supplied also was ingested into the data deliverable. 
Additional collection of CAI information was done via data mining and/or webscraping to build out 
the inventory further. For example: Collection of additional CAIs and location information. 
 
The State-agency-provided CAI inventory was comprehensive but the challenge is collecting 
broadband related data: service provider(s), technology and speed data for each CAI. Availability of 
the CAI portal has not significantly increased submission of this data. Additional promotion to CAIs to 
use the CAI portal will be needed to increase this data for subsequent deliverables. 

INSTITUTION DATA 

Institution data is obtained from a variety of sources and almost always provided in Excel spreadsheet 
format. The general process for incorporating this data is as follows: 
1) If the data is provided in Excel or some similar format: 

a. Clean and standardize the Excel spreadsheet, removing any cell formats, merged cells, etc. 
b. Standardize the address format as defined in the staging CAI database. 
c. If the spreadsheet includes X and Y values, such as latitude and longitude, use the Add XY 

Data tool in ArcMap® to create a spatial data layer. 

d. If there are only addresses, then follow the geocoding steps outlined above to create spatial 
data points for each of the institutions. 

(i.) Institutions that do not geocode based on the TIGER® 2009 dataset will have to be 

located manually using Google Maps, Google Earth or some other information source. 
2) If the CAI source data is in GIS format, add the Latitude and Longitude fields and use the 

Calculate Geometry tool to populate them, using the WGS 84 coordinate system. 

3) Using ArcCatalog®, load the new data into the staging CAI database. 

4) This database is ready for the makeDeliverable.py script to process the information into the final 
State and NTIA deliverables. 
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COMMUNITY ANCHOR INSTITUTION (CAI) PORTAL UPDATES 

A web application has been released to allow for further data collection and validation of anchor 
institution location information, broadband coverage and speed test data. Information collected from 
the CAI Portal is then ingested into the overall inventory and will be compared later against the 
provider coverage areas mapped to locate any potential discrepancies. 

 

PRODUCT EXTRACT 

PYTHON SCRIPTS 

The following subsections make use of Python scripts. In general, to use a Python script you must have 
Python installed on your computer. To download the latest version of Python, go to 
http://www.python.org/download/ and download the latest stable version. As of August 2010, this was 
version 2.7. Once this is installed, the general way to run a script is to type the following at a command 
prompt: C:\Python27\python.exe C:\<location of script>. Many of the scripts provided have environment 
variables that must be set before they can be run. 
 
The Python code for BroadMap’s product extract has been incorporated into a Hudson CI System, which is 
detailed in the Process Operation and Monitoring section of this document. This was a process 
improvement activity so that all processes can be monitored, controlled and will contain historical 
tracking on each process. 

 

PRODUCT EXTRACT PROCESS 

NOTE: 
Specific Python scripts are called out in red font in the subsections below. 
 

The MapConnect
TM

 product extract process, makeDeliverable.py, uses the BB_Cov and 
BROADMAP_POINTS interim datasets to create the following layers according to the current 
specifications: 

 BB_Service_Road_Segment 
o This layer contains all broadband services associated with specific street segments for census 

2000 blocks larger in area than two square miles. 

 BB_ServiceCensusBlock 
o Contains all broadband services associated with census blocks of no greater than two square 

miles. 

 BB_Service_Wireless 
o This layer contains all wireless services not associated with specific addresses. 

 BB_ServiceOverview 
o This layer contains subscriber-weighted nominal speed for each provider's service area at a 

county level and is meant to act as a summarized view. 

 BB_ConnectionPoint_MiddleMile 
o This layer contains middle-mile and backbone interconnection points. 

 BB_Service_CAInstitutions 
o Broadband Service at Community Anchor Institutions (CAI). 
o Community Anchor Institutions consist of schools, libraries, medical and healthcare 

providers, public safety entities, community colleges and other institutions of higher 
education as well as other community support organizations and entities. 

http://www.python.org/download/
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Because of a NTIA model change for the October 2010 data deliverable, an addition to this code was 
created to support both models in case a comparison is later desired or a request is made to revert to the 
original model. This script name is bdia2ntia.py and creates the following layers in addition to the layers 
mentioned above, rolled up to NATL_Broadband_Map. 

 BB_ConnectionPoint_LastMile 
o This layer contains last mile infrastructure points, which is populated only if data cannot be 

provided at a more granular level. 

 BB_Service_Address 
o Represents broadband availability for service address points. Address Point availability refers 

to those individual addresses at which each facilities-based provider of broadband service 
can provide broadband services of minimal characteristics within 7-10 business days. 

 State_Boundary 
o State boundary supporting topological validation of point feature classes. 

 NATL_Broadband_Topology 
o Supports basic topology quality checking. Example: No CAIs or Middle Mile points outside of 

the State boundary. 
 
The following process flow provides a view of how the Core fGDB is extrapolated to the NTIA final 
deliverable via the makeDeliverable.py script. Following that, the bdia2ntia.py script is run, which limits 
what is placed in the final layers based on the NTIA modeling standards. 
 
The product scripts and supporting extract were originally created separately per request, in case data 
model comparisons were to be completed. 

 

PRODUCT STATISTICS 

Following the completion of a product extract, the product statistics script (BDIA_ReleaseNotesStats.py) 
extracts the following information supporting that product deliverable. 

 Provider Statistics: 
o Collects all provider information, listing by Provider Name. 
o Provides output of FRN. 
o Counts the number of features supported within the following layers: 

 Census Block; 
 Street Segment; 
 Max Upstream; 
 Wireless Services; 
 Infrastructure Points. 

o These updates were made to support the Data Package required to accompany every NTIA 
product deliverable. 

 Community Anchor Institution (CAI) Statistics: 
o Breaks down CAI to the eight categories: 

 1: School: K through 12; 
 2: Library; 
 3: Medical/Healthcare; 
 4: Public Safety; 
 5: University/College; 
 6: Other Government; 
 7: Other Community non-government; 
 None: Unknown Category. In cases where this occurs, further investigation is completed 

prior to product shipment to ensure all CAIs are categorized accurately. 
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o Reports out the following counts: 
 Total CAIs within that category; 
 Total CAIs that contain partial BB coverage. Contains any of the following information for a 

given CAI: BB Subscriber, Transmission Technology, Speed Down Speed Up; 
 Total CAIs that contain full BB coverage. Contains all of the abovementioned BB information 

for a given CAI. 
The output of this script is two CSV files: AnchorInstitutions.csv and Providers.csv. These files then can be 
inspected to ensure that there are the expected number of CAIs and providers for every release. 

 

QUALITY ASSURANCE 

Quality assurance is supported manually and algorithmically on the interim data, BB_Cov file geodatabase and 
on the final product. For scheduled product releases, a test product extract and subsequent manual and 
algorithmic QC run is completed along with a release review. The product specifications, project status reports 
and previous product release notes are used as references throughout this review. 
 
The following parameters are tested using the methodology listed below each: 

 Product Deliverable Format:  
o Correct names and format of data deliverables. 

 BDIA_QC_SUITES (please see below for details). 
o Correct Projections/Datum. 

 Manual interaction with product. 
o Metadata Present and Correct. 

 Manual interaction with product. 

 Table Structure: 
o All required tables included. 

 BDIA_QC_SUITES. 
o Extraneous tables identified. 

 BDIA_QC_SUITES. 

 Field Structure: 
o All fields included. 

 BDIA_QC_SUITES. 
o Extraneous fields identified. 

 BDIA_QC_SUITES. 
o Correct field names, types and widths. 

 BDIA_QC_SUITES. 

 Field Domains: 
o Values in all tables are constrained to the specified values specified: 

 This action is accomplished via BDIA_QC_SUITES and manual review of the product; 
 This tends to identify project completeness issues as fields with a null value are identified. 

 Geometric Representation: 
o Identify if all layers have the correct geometric representation: 

 Manual review of the BB_ServiceOverview layer; 
 Dependent on NTIA and client requirements. 

 Geographic Extent: 
o Product includes the necessary Geography associated with Product? 

 Manual Review—ArcGIS®. 
o Is there extraneous geography included in Product? 

 Manual Review—ArcGIS®. 

 Completeness: 
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o Products contain the expected amount of data? 
 Manual review of product statistics relative to weekly State reports and defined expectations. 

 Accuracy: 
o Product meets the stated accuracy requirements for the deliverable? 

 Sampling procedure to manually review source material to resulting product; 
 Provider Validation; 
 Verification using Third-Party Data; 
 Verification against reality, where applicable. 

 Data Regression: 
o Any unexplainable data loss or change? 

 This action is accomplished by comparing results within product statistics script 
(BDIA_ReleaseNotesStats.py) from previous releases, as well as manual review of the product. 

 Confidentiality: 
o Any unauthorized confidential information included in the delivery? 

 Review of NDAs and delivery expectations. 

 Prior Issues Resolved:  
o Have expected internal issues been resolved? 

 Manual review of data against previous product release notes. 
o Have agreed-upon customer issues been resolved? 

 Manual review of data against previous product release notes, status report and client feedback. 

 Delivery Medium: 
o Has the product medium been verified? 

 Manual review. 
o All files present. 

 Manual review of SFTP site to ensure all files are copied correctly, including file/directory size. 
o Correct location. 

 Manual review—confirmation of SFTP link, username and password. 
 

QC SUITE 

The BDIA_QC_SUITES consists of four main types of scripts supporting the overall QC process. These 
scripts are all run in concert and are called from the test_runner script and the test_BDIAProductGDB 
script. 

CONFIGURATION  

These scripts establish the configuration for the test_BDIAProductGDB script, which is the core of the 
QC Suite. 
update_test_config 
active_config 
config_PROCESS01_automated 
config_PROCESS01_manual 
set_active_config 

LIBRARIES 

These scripts provide additional functionality that is called from with the test_BDIAProductGDB 
script. 
bb_unittest_fixture 
bbcov_structure 
BC_XmlWriter 
file_folder 
search_and_replace 
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unittst_fixture 
validate_BB_DB 
validate_BB_GDB 
xmlrunner_gui 

QC SUITE 

This is the core script for performing automated QA/QC on the interim and final data deliverables. 
test_BDIAProductGDB 

OTHER  

These scripts perform other functions detailed below: 
test_runner—this is the main script that runs all the other QC scripts and imports all the necessary 
scripts and libraries. 
which_build—this determines the current build and passes information to the configuration scripts. 

 

PROCESS OPERATION AND MONITORING 

Product Extract, makeDeliverable.py and bdia2ntia.py, is run within BroadMap using a platform called Hudson 
that has been enhanced to support BDIA product extraction, process monitoring, as well as product validation. 
The same platform can be planned for implementation for the State, if desired. 
 
Below are examples of the product create, product validation, product statistics and monitoring processes 
that are managed within the BroadMap Hudson CI-System. All of the abovementioned Python scripts, with 
the exception of metadata transactions script, are run via this system. 

 

BDIA PRODUCT CREATE 

Below is an example of the main page where the type of product build can be selected. 
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Selecting based on the type of process that will be initiated is shown below: 

 

  
The Console Output can be reviewed to see the progress of product create. Following the completion of 
each product creation process, an e-mail notification is automatically sent to the team. 

 
All processes run via the BroadMap Hudson CI-System are stored for historical reporting. Each process can 
be reviewed, including the Console Output and Build Artifacts from that run. 
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PRODUCT VALIDATION AND STATISTICS 

Once the product creation process is complete, Product Validation and Statistics are then initiated. These 
support the BDIA_ReleaseNotesStats.py script and the BDIA_QC_SUITES scripts detailed above. 

 
All statistics and reports are stored for historical review with the capability to place violation criticality on 
each quality control check, allowing the identification of errors because of project status/completeness 
verses project correctness. Example: Typical Speeds populated. 

 

Below is an example of the report provided based on various control points running over a specified 
period: 

 
Similar to the Product Create process, all results from the process are maintained: 
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Results are then reviewed manually to ensure no errors reported are critical or in violation of the NTIA 
data model or project completion statements. Any errors of concern are communicated ahead of product 
delivery and included within the product release notes. Further detail on the Hudson-CI System 
environment can be found by navigating to the following link: 
http://wiki.hudson-ci.org/display/HUDSON/Meet+Hudson 

 
 

PRODUCT EXTRACT DATA DELIVERY 

Product delivery for MapConnect
TM

 Broadband is handled two ways, depending on client requirements: 
1) State Submittal: 

a. Data is submitted via SFTP site; 
b. Product Release Notes and QC Test Report accompany the delivery. 

2) NTIA Submittal: 
a. Directions for using the NTIA State Broadband Data file submission tool: 

(i.) Go to the following website: https://esupport.fcc.gov/statedata; 
(ii.) Enter your username and password as provided to you from the NTIA program 
administrator; 

 
(iii.) Click in Upload a file field; 
(iv.) Browse to local file for submission using the Browse button. Select file, then select 

ATTACH FILE. See example below. 

http://wiki.hudson-ci.org/display/HUDSON/Meet+Hudson
https://esupport.fcc.gov/statedata
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(v.) Logout/Receipt using the Logout button in the top right of the screen; 
(vi.) A receipt of submission is e-mailed to username e-mail address. 
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Complete 96
Non-Responsive/Refused 6
In Progress 10

Count of Datasets by Status 112
Total Unique Providers Represented 90

Provider Name Platform Status

NDA 
Execution 

Date Notes

AT&T Inc. DSL Data Added to Statewide Inventory 12/16/2009

[SEP-08-11 Ashley Littell] Changes and/or 
Corrections: possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

AT&T Inc. Mobile Wireless Data Added to Statewide Inventory 12/16/2009

[SEP-08-11 Ashley Littell] Changes and/or 
Corrections: possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Cable ONE Inc. Cable Data Added to Statewide Inventory 12/7/2009

[AUG-25-11 Ashley Littell] Changes and/or 
Corrections: possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission. 
Download speeds upgraded to speed tier 9.

CenturyLink DSL Data Added to Statewide Inventory 12/4/2009

[AUG-25-11 Ashley Littell] Changes and/or 
Corrections: possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Charter Communications, Inc. Cable Data Added to Statewide Inventory 12/15/2009

[SEP-08-11 Ashley Littell] Changes and/or 
Corrections: possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Clearwire Corporation Mobile Wireless Data Added to Statewide Inventory 3/3/2010

[SEP-08-11 Ashley Littell] Changes and/or 
Corrections: possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Comcast Cable Communications, LLC Cable Data Added to Statewide Inventory 12/7/2009

[SEP-14-11 Ashley Littell] Changes and/or 
Corrections: speed and technology of 
transmission information was updated using the 
previous spatial coverage converted to 2010 
Census data. Additional, more current spatial 
information could not be provided, verified, and 
approved in the necessary time frame.

ECSIS.NET Fixed Wireless Data Added to Statewide Inventory 10/29/2009

[SEP-08-11 Ashley Littell] Change: provider 
added three new fixed wireless towers into 
service. 

Electric Power Board for the City of Chattanooga Fiber Data Added to Statewide Inventory

[AUG-25-11 Ashley Littell] Correction: Speed 
fields revised from tier 10 to tier 11 to reflect 1 
Gbps symmetrical service is available.

ETC Communications, LLC Cable Data Added to Statewide Inventory 10/14/2009

[AUG-25-11 Ashley Littell] Change: Speed tier 
upgrades from download 7 to 9 and upload 3 to 
5; technology also upgraded to DOCSIS 3.0.

Frontier Communications Corporation DSL Data Added to Statewide Inventory 1/22/2010
[SEP-08-11 Ashley Littell] Change: Three 
DSLAMs added to previous coverage areas.

Jackson Energy Authority Fiber Data Added to Statewide Inventory 3/17/2010
[SEP-08-11 Ashley Littell] Change: Provider 
upgraded from download speed tier 9 to tier 10.

Ken-Tenn Wireless, L.L.C. Fixed Wireless Data Added to Statewide Inventory 1/25/2010

[SEP-08-11 Ashley Littell] Change: provider 
added four new fixed wireless towers into 
service.

Knology of Tennessee, Inc. Cable Data Added to Statewide Inventory 7/13/2011

[SEP-08-11 Ashley Littell] Correction: First time 
coverage has been submitted for this provider, 
which previously offered broadband service in 
the state.

Leap Wireless International, Inc. Mobile Wireless Data Added to Statewide Inventory 4/6/2010

[SEP-08-11 Ashley Littell] Changes and/or 
Corrections: possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Millington CATV, Inc. Cable Data Added to Statewide Inventory 10/19/2009

[SEP-08-11 Ashley Littell] Changes and/or 
Corrections: possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Millington CATV, Inc. DSL Data Added to Statewide Inventory 10/19/2009
[SEP-08-11 Ashley Littell] Change: provider 
expanded service into additional areas.

Monster Broadband, Inc. Fixed Wireless Data Added to Statewide Inventory 11/6/2009

[SEP-08-11 Ashley Littell] Change: provider 
added four new fixed wireless towers into 
service.

Morristown Utilities Commission Fiber Data Added to Statewide Inventory 3/25/2010
[SEP-08-11 Ashley Littell] Change: provider 
expanded service into additional area.

Broadband Provider Log



OnWav, Inc. Fixed Wireless Data Added to Statewide Inventory 3/15/2010

[SEP-08-11 Ashley Littell] Correction: previously 
submitted coverage was a generalized polygon 
of service; it has been replaced with modeled 
propagation.

Sprint Nextel Corporation Mobile Wireless Data Added to Statewide Inventory 1/14/2010

[SEP-08-11 Ashley Littell] Changes and/or 
Corrections: possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

T-Mobile USA, Inc. Mobile Wireless Data Added to Statewide Inventory 1/8/2010

[SEP-08-11 Ashley Littell] Changes and/or 
Corrections: possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

TDS Telecommunications Corporation DSL Data Added to Statewide Inventory 1/27/2010

[SEP-08-11 Ashley Littell] Changes and/or 
Corrections: possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

TDS Telecommunications Corporation Fiber Data Added to Statewide Inventory 1/27/2010
[SEP-08-11 Ashley Littell] Change: provider 
expanded service into additional areas.

TEC of Jackson, Inc. DSL Data Added to Statewide Inventory 7/29/2010

[SEP-08-11 Ashley Littell] Correction: provider 
corrected coverage based on where their 
franchise boundaries are located.

TEC of Jackson, Inc. DSL Data Added to Statewide Inventory 7/29/2010

[SEP-08-11 Ashley Littell] Correction: provider 
corrected service area based on where 
franchise boundaries are located. 

TEC of Jackson, Inc. DSL Data Added to Statewide Inventory 7/29/2010

[SEP-08-11 Ashley Littell] Changes and/or 
Corrections: possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

United States Cellular Corporation Mobile Wireless Data Added to Statewide Inventory 2/15/2011

[SEP-08-11 Ashley Littell] Changes and/or 
Corrections: possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

United Telephone Company, Inc. Fiber Data Added to Statewide Inventory 2/25/2010

[SEP-08-11 Ashley Littell] Correction: First time 
coverage has been submitted for this provider, 
which previously offered fiber broadband service 
in the state.

Verizon Communications, Inc. Mobile Wireless Data Added to Statewide Inventory 12/14/2009

[SEP-08-11 Ashley Littell] Changes and/or 
Corrections: possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

DeltaCom, Inc. Backhaul Backhaul Provider Only Processing Complete 2/16/2010
Level 3 Communications, LLC Backhaul Backhaul Provider Only Processing Complete 12/14/2009
Sprint Nextel Corporation Backhaul Backhaul Provider Only Processing Complete 1/14/2010
T-Mobile USA, Inc. Backhaul Backhaul Provider Only Processing Complete 1/8/2010
Windstream Communications Backhaul Backhaul Provider Only Processing Complete
Zayo Group, LLC Backhaul Backhaul Provider Only Processing Complete

TELE-PAGE Inc. Fixed Wireless
Approval for Update Not Received – Data Still 
Submitted 1/26/2010

[SEP-12-11 Ashley Littell] Correction: previously 
submitted coverage was a generalized polygon 
of service; it has been replaced with modeled 
propagation.

Access Cable Television, Inc. Cable No Update to Provide
Ardmore Telephone Company Inc. DSL No Update to Provide 2/16/2010
AT&T Inc. Backhaul No Update to Provide 12/16/2009
Beasley Wireless Fixed Wireless No Update to Provide 1/19/2010
Ben Lomand Rural Telephone Coop., Inc. DSL No Update to Provide 10/21/2009
Ben Lomand Rural Telephone Coop., Inc. Fiber No Update to Provide 10/21/2009
Bledsoe Telephone Cooperative Inc. DSL No Update to Provide 1/20/2010
BreezeAir.net Fixed Wireless No Update to Provide 8/17/2010
Bristol Tennessee Essential Services Fiber No Update to Provide 9/1/2010
Celina Cable Communications, Inc. Cable No Update to Provide 1/15/2010
Cellular South, Inc. Mobile Wireless No Update to Provide 4/12/2010
CenturyLink Backhaul No Update to Provide 12/4/2009
Clarksville Department of Electricity Fiber No Update to Provide
Columbia Power & Water Systems Cable No Update to Provide
CRU Enterprises, Inc. Fixed Wireless No Update to Provide 2/4/2010
DeKalb Telephone Cooperative, Inc. DSL No Update to Provide 2/24/2010

DISH Network Corporation Satellite No Update to Provide 1/27/2010

[SEP-16-11 Ashley Littell] Correction: Satellite 
data is being submitted and was not included in 
the April 2011 submission. While coverage is 
currently the entire state boundary, work 
continues on having more granular data 
available.

Fayetteville Public Utilities Cable No Update to Provide
High Country Online LLC Fixed Wireless No Update to Provide 3/4/2010
Highland Telephone Cooperative, Inc. DSL No Update to Provide 3/14/2010

Hughes Network Systems, LLC Satellite No Update to Provide 2/5/2010

[SEP-16-11 Ashley Littell] Correction: Satellite 
data is being submitted and was not included in 
the April 2011 submission. While coverage is 
currently the entire state boundary, work 
continues on having more granular data 
available.

iGiles.net Fixed Wireless No Update to Provide 2/25/2010
Info-Ed Inc Fixed Wireless No Update to Provide 2/9/2010
InfoStructure Inc. Cable No Update to Provide 10/2/2009
James Cable LLC Cable No Update to Provide 1/11/2010
Loretto Telephone Company, Inc. DSL No Update to Provide 3/16/2010
Mediacom Southeast LLC Cable No Update to Provide 1/12/2010
MegaPath Inc. Backhaul No Update to Provide 2/15/2010



MidSouth Satellite, LLC Fixed Wireless No Update to Provide 7/7/2010
MidSouth Satellite, LLC Backhaul No Update to Provide 7/7/2010
NetEase Fixed Wireless No Update to Provide 2/3/2010
NewWave Communications Cable No Update to Provide 10/13/2009
North Central Communications DSL No Update to Provide 2/5/2010
OrbWireless.net Fixed Wireless No Update to Provide
Pickwick Cablevision, Inc. Cable No Update to Provide
Planet Connect Internet Fixed Wireless No Update to Provide
Pulaski Electric System Fiber No Update to Provide 12/30/2009
Rural Tennessee Wireless Broadband (RTWB) Fixed Wireless No Update to Provide 2/15/2011
Skyline Telephone Membership Corporation DSL No Update to Provide 2/2/2010
Skyline Telephone Membership Corporation Backhaul No Update to Provide 2/2/2010
Softek, Inc. Fixed Wireless No Update to Provide 1/14/2010
Spirit Broadband Cable No Update to Provide 3/29/2010
Surfmore.Net, Inc. Fixed Wireless No Update to Provide 1/25/2010
TDS Telecommunications Corporation Backhaul No Update to Provide 1/27/2010
TEC of Jackson, Inc. Backhaul No Update to Provide 7/29/2010
Tullahoma Utilities Board Fiber No Update to Provide
tw telecom of tennessee, llc Backhaul No Update to Provide 3/31/2010
Twin Lakes Telephone Cooperative Corporation DSL No Update to Provide 1/14/2010
Ultranet High-Speed Internet Fixed Wireless No Update to Provide 2/23/2010
United Telephone Company, Inc. DSL No Update to Provide 2/25/2010
Verizon Communications, Inc. Backhaul No Update to Provide 12/14/2009
Wave2Wave Communications Inc. Backhaul No Update to Provide 4/28/2010
West Kentucky Rural Telephone Coop Corp Inc. DSL No Update to Provide 1/7/2010

WildBlue Communications, Inc. Satellite No Update to Provide 1/8/2010

[SEP-16-11 Ashley Littell] Correction: Satellite 
data is being submitted and was not included in 
the April 2011 submission. While coverage is 
currently the entire state boundary, work 
continues on having more granular data 
available.

XO Communications, LLC Backhaul No Update to Provide 2/12/2010
Zito Midwest, LLC Cable No Update to Provide 2/17/2011

Aurora Cable TV Cable No Update Provided - Use Last Submission Data 3/12/2010

Iris Networks Backhaul No Update Provided - Use Last Submission Data 1/5/2010

QuickRelay Wireless Communications Fixed Wireless No Update Provided - Use Last Submission Data

Trenton TV Cable Company Cable No Update Provided - Use Last Submission Data
ABG Wireless, LLC Fixed Wireless Provider Gathering Data
TNets Internet Fixed Wireless Solicited Initial Data
Wisper, LLC Fixed Wireless Solicited Initial Data 2/22/2011

DeKalb Telephone Cooperative, Inc. Fiber Other 2/24/2010

[AUG-16-11 Ashley Littell] While provider is in 
the process of building out fiber, they do not 
have any in service as of June 30, 2011.

Highland Telephone Cooperative, Inc. Fiber Other 3/14/2010

[AUG-16-11 Ashley Littell] While provider is in 
the process of building out fiber, they do not 
have any in service as of June 30, 2011.

North Central Communications Fiber Other 2/5/2010

[AUG-16-11 Ashley Littell] While provider is in 
the process of building out fiber, they do not 
have any in service as of June 30, 2011.

PAETEC Communications, Inc. Backhaul Other

[SEP-08-11 Wes Kerr] Multiple outreach 
attempts were conducted but no response was 
received. PAETEC was bought out during the 
collection phase of this round by Windstream 
and we intend to be able to include the PAETEC 
coverage as a part of the Windstream footprint 
during the next round.

Skyline Telephone Membership Corporation Fiber Other 2/2/2010

[SEP-13-11 Ashley Littell] Provider is in the 
process of constructing fiber network and 
anticipates that the project will be completed in 
early 2012.

Twin Lakes Telephone Cooperative Corporation Fiber Other 1/14/2010

[SEP-01-11 Ashley Littell] Coverage maps were 
sent for review, but approval and additional 
information on the network was not received. 
Since data was created from scanned 
document, the accuracy is in question. Build-out 
of fiber continues and may not be completely 
active yet. Data will be submitted in April 2012.

West Kentucky Rural Telephone Coop Corp Inc. Fiber Other 1/7/2010

[AUG-16-11 Ashley Littell] While provider is in 
the process of building out fiber, they do not 
have any in service as of June 30, 2011.

Birch Communications, Inc. DSL Refused to Participate

[JUN-22-11 Daryl Coffey] a company 
representative sent an e-mail stating they are 
still not interested in participating.

Birch Communications, Inc. Backhaul Refused to Participate

[JUN-22-11 Daryl Coffey] a company 
representative sent an e-mail stating they are 
still not interested in participating.

Global Crossing Telecommunications, Inc. Backhaul Non-Responsive to Multiple Attempts

In addition to contact attempts made between 
July 1, 2010 and February 17, 2011, 3 additional 
attempts were made this period.



Trinity Communications LLC Cable Non-Responsive to Multiple Attempts

In addition to contact attempts made between 
July 1, 2010 and February 16, 2011, 5 additional 
attempts were made this period.

Utopian Wireless Corporation Fixed Wireless Non-Responsive to Multiple Attempts

In addition to contact attempts made between 
August 9, 2010 and January 4, 2011, 4 
additional attempts were made this period.

TNWEB, LLC Fixed Wireless
Slated Field Audit for Estimated Coverage 
Analysis

[AUG-17-11 Ashley Littell] While provider has 
refused to participate, we discovered that the 
fixed wireless service is limited to Lewisburg. 
Chip Spann will schedule a trip to estimate 
service area for the next submission.
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TEXAS COVER LETTER 

 
 
October 1, 2011 
 
Ms. Anne W. Neville 
SBI Grant Program Director 
National Telecommunications and Information Administration 
U.S. Department of Commerce 
1401 Constitution Avenue, NW Room 4716 
Washington, DC 20230 
 
Dear Ms. Neville: 
 
As the State Broadband Designated Entity, in partnership with the state of Texas, please accept this 
submission from Connected Nation on behalf of the state of Texas’ State Broadband Initiative (SBI) 
Grant Program, known as Connected Texas. 

 
These artifacts should be found to be compliant with the October 1, 2011, deadline for the semi-
annual data update and in accordance with the terms of the July 1, 2009, Notice of Funds 
Availability (NOFA) and all subsequent clarifications pertaining to delivery of state-level mapping of 
broadband service availability.  This packet includes: 
 
 
Inventory of Deliverables, Connected Texas: October 1, 2011 
 
NOFA Requirement Data Transfer Model Data Description 
Appendix A:  1(a)(i) BB_Service_CensusBlock Broadband Service Availability of 

Facilities-Based Providers in 
Census Blocks of No Greater 
Than Two Square Miles in Area 

Appendix A:   1(a)(ii) BB_Service_RoadSegment Broadband Service Availability of 
Facilities-Based Providers by Road 
Segment in Census Blocks Larger 
in Area Than Two Square Miles 

Appendix A:   1(b) BB_Service_Wireless Broadband Service Availability of 
Wireless Services Not Provided to 
a Specific Address 

Appendix A:   3(b) BB_ConnectionPoint_MiddleMile Broadband Service Infrastructure 
Middle-Mile and Backbone 
Interconnection Points 

Appendix A:   4 BB_Service_CAInstitutions  Community Anchor Institutions-
Listing 
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Appendix A:   4 n/a Community Anchor Institutions-
Narratives 

VII.A.1(a) n/a Accuracy and Verification Report 
n/a DataPackage.xlsx Worksheets of Contact 

Information, Record Count, and 
Provider Summary Table 

n/a n/a List of Changes and Corrections 
to the Dataset 

n/a n/a Non-Participating Provider 
Narratives 

n/a n/a Broadband Provider Roster and 
Participation Status 

 
In addition, this data update submission should be found to be compliant with the additional 
program requirements instituted by the National Telecommunications and Information 
Administration since the time of the April 2011 SBI data submission for the Connected Texas 
program.  Specifically, these new requirements are: 

 
SBI Data Transfer Model 
The submission of the broadband dataset for October 1, 2011, is contained within the SBI 
Data Transfer Model as released on the Grantee Workspace on June 30, 2011. All efforts 
have been made to comply with formatting, domain, and metadata requirements to include 
as much information on each provider as possible.  
 
Additional Submission Guidance 
This submission also includes a list of changes and corrections made to the dataset between 
the April 2011 submission and the October 2011 submission. This represents a summary of 
why data displays and/or supplied speeds, etc. are different from the previous submission. 
Changes can include upgrades to infrastructure to allow for higher throughput speeds for 
customers, an expansion of the service area (e.g. additional fixed wireless towers, recently 
activated DSLAMs, etc.), or a new provider in the marketplace. Corrections can include 
revisions to speed tier information that was previously reported incorrectly or the addition of 
a previously existing provider that has not yet been submitted in a semi-annual dataset.   
 
Another addition in this submission is narratives describing the data and coverage 
estimations of non-participating providers. While Connected Texas continues outreach to all 
providers prior to each submission period, the need to submit broadband service data for all 
providers regardless of their participation is evident as the SBI program continues into this 
fourth round of data submissions. The submission of these estimated broadband service 
areas for providers that have not supplied data to Connected Texas is essential in being able 
to portray a more accurate depiction of the current broadband landscape. 
 

This October 2011 semi-annual data update under the State Broadband Initiative Grant Program 
continues to demonstrate our dedication to implementing the joint purposes of the Recovery Act 
and the Broadband Data Improvement Act (BDIA) by gathering comprehensive and accurate state-
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level broadband mapping data, developing state-level broadband maps, aiding in the development 
and maintenance of the National Broadband Map, and undertaking statewide initiatives for 
broadband planning. 
 
Broadband Service Availability — Provider Outreach and Verification 
 
This data update submission under the SBI program includes datasets for approximately 80.54 
percent of the Texas provider community, or 149 of 185 total providers.  There are 146 participating 
providers and 3 additional non-participating providers whose estimated coverage areas have been 
submitted. Of the 146 participating providers, 54 supplied an update to their network or coverage 
area(s), while 75 have reported no change. The remaining 17 represent providers who previously 
supplied data but were non-responsive in the October 2011 update effort; therefore their previous 
dataset is being put forward as part of this compilation. A complete roster by provider depicting 
participation status and contact record is contained herein.  The 36 providers that are not 
represented in the attached datasets have refused to participate in the voluntary program or were 
non-responsive to multiple contact attempts. 
 
As the aforementioned roster and attached methodology documentation will attest, it is the 
collective opinion of the Connected Texas principals that all commercially reasonable efforts were 
made to account for 100 percent of the known Texas broadband provider community, pursuant to 
this semi-annual data update submission. 
 
Connected Texas has also continued to perform broadband verification activities through several 
means. In addition to confirmation of service area(s) by each provider, Connected Texas conducts 
field validation efforts.  To date, 114 (61.62 percent) providers have been validated through field 
verification activities. Additional details on verification activities are contained within the Field 
Validation Methodology. 
  
The Connected Texas website, www.connectedtx.org, continues to serve a prominent role in the 
outreach and data collection effort.  This program asset provides a way for the general public to 
participate in the process by offering interactive tools for users to test their connection speed, 
submit broadband inquiries, or contact a program representative.   
 
As an indicator of stakeholder penetration, the Connected Texas website encountered 5,289 unique 
visits during this reporting period, which includes 5,143 visits to the English website and 146 visits 
to the Spanish website (34,898 total to date for the life of the grant awarded on January 1, 2010, 
which includes 34,505 to the English website and 393 to the Spanish website).  Additionally, this 
pronounced Web activity netted 50 broadband inquiries over this same reporting period (474 grant 
inception to date).  The website also provides the BroadbandStat application, which allows the 
consumer to confirm or dispute the coverage represented on the broadband inventory map. These 
consumer-initiated actions are facilitated through the Connected Texas website and the Connected 
Texas interactive mapping tool (BroadbandStat) that offer the citizens the vehicles to provide 
information regarding availability in their respective service area, either in affirmation or contest of 
the reported data represented in the Connected Texas mapping artifacts.  Since the initial data 
collection and release of corresponding maps, feedback in the form of broadband inquiries has 
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allowed Connected Nation to identify additional areas that are in need of field validation, which is 
scheduled as soon as possible.  
 
Community Anchor Institutions  
 
Connected Texas has established an ongoing mechanism for gathering data on the location and 
broadband connectivity of Community Anchor Institutions (CAI), in accordance with the data 
requirements of the SBI NOFA Technical Appendix.   
 
In conjunction with the Texas Department of Agriculture, outreach was conducted during this data 
update reporting period by Connected Texas to continue identification of existing, centralized 
sources for CAI connectivity data.   Additionally, outreach was coordinated to distribute a CAI 
survey to institutions throughout the state through multiple methods including a customized online 
survey available on the Connected Texas website.  During this reporting period Connected Texas 
has developed a number of new relationships with statewide associations to promote the importance 
of broadband connectivity at anchor institutions and participation in this data collection 
process.  Connected Texas will continue to build upon these new relationships over the coming 
months and utilize its contacts throughout the state to collect data and raise awareness of this 
project. 
 
Connected Texas continues to work with the Texas Broadband Task Force and utilize the inaugural 
issue of the Connected Texas CAI newsletter to further outreach opportunities within the state.  
From our work in Texas, as well as other states, we recognize the great value of this data to future 
collaboration efforts within the state as well as its value to the National Broadband Map.  We plan to 
continue to bring best practices to the Connected Texas efforts, along with an investment of both 
human and technical resources required to reach our goal of increasing the data that is secured and 
reported as part of this process. 
 
 
The Connected Texas program exists to improve data on the deployment and adoption of 
broadband services and to assist in the extension of broadband technology across all regions of the 
great state of Texas, as well as the United States through contribution to the National Broadband 
Map.  We look forward to the continuing work ahead. 
 
Respectfully submitted, 
 
 
 
Thomas W. Ferree 
Chief Operating Officer 
Connected Nation, Inc. 

dclark
Cueball
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DATA ACQUISITION:  TEXAS COMMUNITY ANCHOR INSTITUTIONS 

METHODOLOGY 

In this fourth reporting period of the SBI, Connected Texas, working in coordination with the Texas 
Department of Agriculture, has established an ongoing mechanism for gathering data on the 
location and broadband connectivity of Community Anchor Institutions (CAI), in accordance with 
the data requirements of the SBI NOFA Technical Appendix.  During this reporting period 
Connected Texas has continued to focus efforts on conducting outreach and raising awareness of 
this important project. 
 
Connected Texas has continued to identify and process CAI data obtained through an ongoing 
statewide outreach campaign.  Physical address information continues to be augmented through 
manual sourcing and geocoded by Connected Texas through ESRI ArcGIS software. 
 
Connected Texas continues to utilize a customized online survey hosted through SurveyMonkey, 
with a landing page on the Connected Texas website that was developed during the first reporting 
period.  This survey, in combination with a customized data-gathering spreadsheet, was distributed 
to a targeted list of CAI throughout the state.  Connected Texas will continue to use these data-
gathering tools for future targeted outreach efforts throughout the coming months leading up to the 
next reporting period.  These materials are customized to fit the CAI categories as defined in the 
SBI NOFA.   
 
The survey can be accessed at this link using the following password: 
http://connectedtx.org/mapping/Community_Anchor_Institution_Data_Collection.php 

Password: CAI_TX_7933 
 
During this reporting period Connected Texas conducted research, specifically within the education 
sector, to identify existing, centralized sources for CAI connectivity data.  Connected Texas has 
located existing datasets within the state for K-12 schools, libraries, and higher education facilities 
but is still in coordination with these groups to receive this data for processing as part of this 
project.  Any data received as part of this effort will be reported during the April 2012 submission.  
In tandem with these efforts to identify existing data, Connected Texas continues to identify key 
CAI contacts in an effort to distribute and promote the online survey and raise awareness of the 
importance of CAI broadband connectivity.   
  
Connected Texas has an ongoing mission to educate CAI throughout the state on the importance of 
participating in the project.  Participation by these institutions will raise awareness about the 
importance of broadband connectivity and the need to report the requested data for inclusion on the 
National Broadband Map.  Connected Texas continues to utilize a CAI newsletter which was 
distributed in March 2011 and is available on the CAI page of the Connected Texas website.  The 
newsletter is currently being updated with plans to distribute an updated version in Q42011. 
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The greatest challenge with collecting this data continues to be the difficulty in securing CAI 
broadband connectivity data.  Connected Texas is overcoming this challenge through new 
relationships that are being formed, our work with the Texas Department of Agriculture, and the 
upcoming release of an updated CAI newsletter.  Connected Texas expects noted progress to occur 
over the coming months leading up to the April 2012 submission. 
 
A CAI summary of all processed and submitted data is provided below: 
 

CAI Type Total 
Physical 
Address 

Lat/Long
Technology of 
Transmission 

Download 
Speed 

Upload 
Speed 

K-12 10,604 10,604 10,601 78 71 71 
Libraries 1,136 1,136 1,136 103 261 100 
Healthcare 865 865 865 78 163 80 
Public Safety 2,904 2,904 2,870 256 543 254 
Higher Ed Institutions 420 420 420 36 106 35 
Other Government 705 705 705 464 92 43 
Other Non-Government 10,604 10,604 10,601 78 71 71 
Total 16,634 16,634 16,597 1,015 1,236 583 

 
 
 
SBI DATA SUBMISSION METHODOLOGY  

The submission of the broadband dataset for October 1, 2011, is contained within the SBI Data 
Transfer Model and additional components as released on the Grantee Workspace on June 30, 2011. 
Connected Nation has reviewed all literature that relates to the release and use of this data transfer 
model and recognizes that it does not replace or dictate how data is stored, processed, or displayed 
for the state, as it is meant primarily as a means to transfer the broadband data from all states and 
territories and populate the National Broadband Map in a seamless fashion. Guidance from the 
Technical Mapping Guide, as released on the Grantee Workspace on March 24, 2011, was also 
followed to ensure the completeness and validity of the submission through completion steps and 
checklists, completing the DataPackage spreadsheet, uploading broadband datasets into the Data 
Transfer Model, and checking the dataset using the SBDD_CheckSubmission receipt process.  
 
As part of the ongoing review and analysis process, NTIA has requested further information in the 
submission of the DataPackage spreadsheet. In addition to the information on providers whose 
coverage and accompanying attributes are submitted in the SBI Data Transfer Model, information 
on other providers that are considered to be non-viable is also included in the DataPackage. 
Providers deemed non-viable that have been excluded from continued outreach may have been 
eliminated for reasons such as (i) the company offers Internet service but at speeds below the 
current definition of broadband; (ii) the company was listed in advertisements as a broadband 
provider, but is actually a network solution or consulting firm, etc.; (iii) the company may build or 
install network infrastructure, but does not actually provide the broadband service to consumers; 
and (iv) the company has gone out of business. The submitted DataPackage includes any relevant 
information that has been obtained through the course of due diligence and/or direct provider 
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outreach, such as a Federal Registration Number (if applicable), the company’s URL, the existence 
of an executed Nondisclosure Agreement, and brief notations regarding the status of the company. 
 
In addition to the methodologies contained herein, as well as the DataPackage.xls containing contact 
information, the data dictionary, and a provider summary table, the following feature classes are 
submitted within the SBI Data Transfer Model for the state of Texas. 
 
Inventory of Deliverables, Connected Texas: October 1, 2011 
 
NOFA Requirement Data Transfer Model Data Description 
Appendix A:  1(a)(i) BB_Service_CensusBlock Broadband Service Availability of 

Facilities-Based Providers in Census 
Blocks of No Greater Than Two 
Square Miles in Area. 

Appendix A:   1(a)(ii) BB_Service_RoadSegment Broadband Service Availability of 
Facilities-Based Providers by Road 
Segment in Census Blocks Larger in 
Area Than Two Square Miles. 

Appendix A:   1(b) BB_Service_Wireless Broadband Service Availability of 
Wireless Services Not Provided to a 
Specific Address. 

Appendix A:   3(b) BB_ConnectionPoint_MiddleMile Broadband Service Infrastructure 
Middle-Mile and Backbone 
Interconnection Points. 

Appendix A:   4 BB_Service_CAInstitutions  Community Anchor Institutions-
Listing. 

 
The provider data collected by Connected Nation on behalf of the state of Texas have been 
formatted per the given specifications and uploaded into the appropriate feature classes of the SBI 
Data Transfer Model. Wireline availability is contained within census blocks and road segments, 
wireless availability is contained as polygons of coverage areas, and middle-mile connections and 
Community Anchor Institutions are contained as point data. All speed data is contained at the 
census block, road segment, or wireless polygon level of availability. All efforts have been made to 
comply with formatting, domain, and metadata requirements to include as much information as 
possible.  
 
Connected Nation has continued outreach to satellite providers on their availability, technology, and 
speed information, but granular coverage is not yet available. Submitted within the wireless feature 
class are the satellite companies providing service to Texas as a polygon of the state boundary. 
Efforts will continue to collect, process, or otherwise create more granular satellite data based on 
availability analyses and guidance received from NTIA.  
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PROVIDER CHANGES AND CORRECTIONS FOR OCTOBER 2011  

As requested by the SBI Program Office, a listing of the changes and/or corrections to the datasets 
between the April 2011 and October 2011 submissions is included in this narrative. This 
information is presented in this section as well as in the Broadband Provider Log. Changes to the 
data include expansion of service area(s), activation of new wireless towers, and upgrades to the 
network to provide higher download speeds to consumers. Corrections to the dataset include the 
addition of previously existing providers whose coverage has never been submitted, revision of 
coverage or speed information that was incorrect, and any other items that were misrepresented in 
the April 2011 dataset. 
 

Changes 
 Alenco Communications, Inc. (DSL): Provider upgraded infrastructure and can now 

offer speed tier 7 download speeds in select area. 
 AT&T Communications of Texas, Inc. (mobile wireless): Network expansion to include 

more coverage around Midland, Odessa, Fairfield, Palestine, Buffalo, etc. 
 Big Bend Telephone Company, Inc. (fiber): Provider upgraded infrastructure to expand 

FTTH service territory. 
 Cap Rock Telephone Cooperative, Inc. (DSL): Network update to include additional 

Remote Terminals and provider upgraded infrastructure and can now offer speed tier 5 
download speeds in select area. 

 Cap Rock Telephone Cooperative, Inc. (fiber): Provider upgraded infrastructure and can 
now offer speed tier 5 download speeds. 

 Celltex Networks, LLC (fixed wireless): New fixed wireless tower in operation. 
 Central Texas Telephone Investments, LP (fixed wireless): New fixed wireless towers in 

operation. 
 Coleman County Telephone Cooperative, Inc. (DSL): Network expansion to include 

new DSLAMs. 
 Consolidated Communications (fiber): Provider upgraded infrastructure and now offers 

FTTH in select areas. 
 CTX Unwired (fixed wireless): New fixed wireless towers in operation. 
 Cumby Telephone Cooperative, Inc. (fiber): Provider upgraded infrastructure to expand 

FTTH service territory. 
 DigiComm Enterprises, LLC (fixed wireless): New fixed wireless towers in operation. 
 Dot 10 Wireless, LLC (fixed wireless): New fixed wireless tower in operation. 
 East Texas DSL (fixed wireless): New fixed wireless towers in operation. 
 Eastex Telephone Cooperative, Inc. (DSL): Network expansion (new Remote 

Terminals). 
 ENMR Telephone Cooperative, Inc. (fiber): Network expansion (new fiber lines) and 

provider upgraded infrastructure and can now offer tier 7 download and upload speeds. 
 Gower Computer Support, Inc. (fixed wireless): Provider upgraded infrastructure and 

can now offer speed tier 4 download speeds. 
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 Grande Communications Networks LLC (cable): Provider upgraded infrastructure to 
service additional homes and provide maximum download speeds of tier 10 to most 
market areas. 

 Grayson CableRocket, LLC (cable): Provider upgraded infrastructure and can now offer 
speed tier 7 download speeds. 

 Gtek Communications (fixed wireless): New fixed wireless towers in operation. 
 GVEC.net (fixed wireless): New fixed wireless towers in operation. 
 IGN-LPG Enterprises LLC (fixed wireless): New fixed wireless tower in operation. 
 Industry Telephone Company (DSL): Provider upgraded infrastructure and can now 

offer speed tier 6 download speeds. 
 JAB Wireless, Inc. (fixed wireless): JAB Wireless acquired the following fixed wireless 

operators: Rhino Communications, PVCo, Twilight Communications, Cobalt 
Broadband, and Wickson. 

 KeyOn Communications, Inc. (fixed wireless): Provider acquired some of ERF 
Wireless's tower sites in Central Texas and North Texas; new composite propagations 
submitted. 

 Millennium Telcom, LLC (fixed wireless): New fixed wireless towers in operation. 
 Poka Lambro Telephone Cooperative, Inc. (DSL): Network expansion and provider 

upgraded infrastructure and can now offer speed tier 8 download speeds. 
 Poka Lambro Telephone Cooperative, Inc. (fiber): Provider upgraded infrastructure to 

expand FTTH service territory and can now offer speed tier 8 download speeds. 
 Rodzoo Wireless (fixed wireless): Provider's speed tiers previously didn't meet the 

minimum requirements/definition of broadband.  Provider upgraded infrastructure and 
can now offer speed tier 3 download speeds. 

 South Plains Telephone Cooperative, Inc. (fiber): Provider upgraded infrastructure to 
expand FTTH service territory. 

 Texas Wireless Internet (fixed wireless): New fixed wireless towers in operation. 
 TISD, Inc. (fixed wireless): New fixed wireless towers in operation. 
 US Cable Corporation (cable): Network expansion to include new plant in Fort 

Stockton. 
 Valley Telephone Cooperative, Inc. (fixed wireless): New fixed wireless towers in 

operation. 
 Versalink Enterprises, LLC (cable): Provider expanded service area. 
 XIT Telecommunications & Technology, Ltd. (fiber): Provider upgraded infrastructure 

to expand FTTH service territory. 
 
Corrections 

 Big Bend Telephone Company, Inc. (satellite): Provider submitted new platform type, 
satellite, for this submission. 

 Broadwaves (fixed wireless): Estimated coverage submitted (propagation) for non-
participating provider. 
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 Charter Communications, Inc. (cable): Provider submitted a new dataset showing a slight 
decrease in coverage. 

 CKS Wireless, Inc. (fixed wireless): Estimated coverage submitted (propagation) for 
non-participating provider. 

 DISH Network Corporation (satellite): Satellite data is being submitted and was not 
included in the April 2011 submission. While coverage is currently the entire state 
boundary, work continues on having more granular data available. 

 East Texas Broadband (fixed wireless): Estimated coverage submitted (propagation) for 
non-participating provider. 

 East Texas WiFi (fixed wireless): East Texas WiFi was previously non-responsive, but it 
provided data this round. 

 ERF Wireless (fixed wireless): "Circle" polygons of service have been replaced with 
propagations. Also, speeds corrected to what is actually advertised on its website for 
residential services (1M down). 

 Hi Speed Wireless (fixed wireless): Provider clarified it only offers speed tier 5 download 
speeds as its highest package. 

 Hughes Network Systems, LLC (satellite): Satellite data is being submitted and was not 
included in the April 2011 submission. While coverage is currently the entire state 
boundary, work continues on having more granular data available. 

 Millennium Telcom, LLC (cable): Updated download speeds to tier 8, per its website 
information and DOCSIS 3.0 technology type. 

 NetWest Online, Inc. (fixed wireless): Provider only offers 3-5M download speeds to 
residential subscribers; corrected to tier 5. 

 Stelera Wireless, LLC (mobile wireless): "Circle" polygons of service have been replaced 
with propagations. 

 Tier One Converged Networks, Inc. (fixed wireless): "Circle" polygons of service have 
been replaced with propagations. 

 WildBlue Communications, Inc. (satellite): Satellite data is being submitted and was not 
included in the April 2011 submission. While coverage is currently the entire state 
boundary, work continues on having more granular data available. 

 Windjammer Communications LLC (cable): Windjammer Communications LLC was 
previously non-responsive, but it provided data this round. 

 
Changes and/or Corrections – Entirely New Dataset Submitted 

 AT&T Communications of Texas, Inc. (DSL) 
 Cable ONE, Inc. (cable) 
 CenturyLink (DSL) 
 Cequel Communications (cable) 
 Clearwire Corporation (fixed wireless, mobile wireless) 
 Comcast Cable Communications, LLC (cable) 
 Consolidated Communications (DSL) 
 Leap Wireless International, Inc. (mobile wireless) 
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 Sprint Nextel Corporation (mobile wireless) 
 T-Mobile USA, Inc. (mobile wireless) 
 Time Warner Cable LLC (cable) 
 United States Cellular Corporation (mobile wireless) 
 Verizon Southwest, Inc. (DSL, fiber, mobile wireless) 
 Windstream Communications (DSL) 

 
 
 
TEXAS FIELD VALIDATION METHODOLOGY  

Connected Nation focused a portion of its time on specific validation processes such as: 
 

 conducting random spectrum analysis studies throughout the state using an Avcom PSA-37-
XP spectrum analyzer; 

 conducting mobile speed tests throughout the state using an iPhone, Android (or other 
smart phone) as well as provider-specific aircards (Sprint 3G/4G, Clearwire et al); 

 identifying pre-selected, provider-submitted wireless transmit tower sites and cross-
referencing data about that tower against the Federal Communications Commission (FCC) 
databases such as Antenna Structure Registration and/or the Universal Licensing System; 

 cross-referencing Federal Registration Number data against available FCC Form 477 data as 
well as the FCC COmmission REgistration System (CORES); 

 validating provider submitted data (for example: latitude/longitude) using a handheld 
Garmin eTrex Summit GPS unit or GPS enabled software such as Microsoft Streets and 
Trips; 

 locating physical wire-line attributes (such as Remote Terminals, CATV plant, etc.) and 
comparing them against provider submitted data; and  

 conducting on-net and off-net speed tests using the FCC portal at 
http://www.broadband.gov/qualitytest/about/ or using the Ookla Net Metrics enabled 
speed test utility located on each of Connected Nation’s state specific websites. 

 
Additionally, Connected Nation cross-referenced numerous public documents in order to ensure 
that all known broadband providers were located and contacted.  This included searching 
membership logs from the trade associations (WISPA, WCAI, PCIA, etc.), the Cable Television Fact 
Book, Public Utility Commission records, Public Service Commission records, Chamber of 
Commerce, etc. 
 
To date, Connected Nation’s staff conducted on-site validation tests in Texas on the following 
providers:  Alenco Communications, Inc.; Allegiance Communications; Alpheus (d.b.a. Aspen 
Communications); AT&T, Inc.; AwesomeNet, Inc.; Basin 2 Way Radio, Inc.; Basin Broadband, Inc.; 
Big Bend Telephone Company, Inc.; Blossom Telephone; Border to Border Communications, Inc.; 
Broadband Data Services of Texas LLC; Broadcomm.US; Cable One, Inc.; Cameron Telephone 
Company LLC; Cap Rock Telephone Cooperative, Inc.; Cebridge (d.b.a. Suddenlink); Central Texas 
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Cable Partners, Inc.; Central Texas Telephone Cooperative, Inc.; CenturyLink; Cequel 
Communications; Charter Communications; Clearwire Corporation; Coleman County Telephone 
Cooperative LLC; Colorado Valley Telephone Cooperative LLC; Comcast Cable Communications 
LLC; Community Telephone Company, Inc.; Consolidated Communications; Cumby Telephone 
Company, Inc.; DCT Texas.Net; Dell Telephone Cooperative, Inc.; Digitex.com; East Texas DSL; 
Eastex Telephone Cooperative, Inc.; Eccentric Technologies; ECTISP; ELC Internet Services, Inc.; 
Electra Telephone Company; Element Networks LLC; eNet; ENMR Telephone Cooperative, Inc. 
(d.b.a. ENMR Plateau Communications, Inc.); ERF Wireless; ETAN Industries; Etex 
Communications LP; ETS Cablevision Company, Inc.; Farm to Market Broadband LP; Five Area 
Telephone Company, Inc.; Ganado Telephone Company, Inc.; GEUS; Gilmer Cable; Gower 
Computer Support, Inc.; Grande Communications Network LLC; Grayson CableRocket LLC; 
Greasy Bend Ventures, Inc. (d.b.a. Live Air Networks); GTEK Communications; Guadalupe Valley 
Communications Systems; GVEC.net; Hill Country Telephone Cooperative; Iguana Net; Industry 
Telephone Company; JAB Wireless (d.b.a. Dot11 Networks, Partnership Broadband); KeyOn 
Communications, Inc.;  La Ward Telephone Exchange, Inc.; Lake Livingston Telephone Company; 
Leap Wireless International, Inc.; Livingston Telephone Company, Incorporated; Maverick Internet; 
McDonald Group; Mid-Plains Rural Co-op, Inc.; NetWest Online, Inc.; Neu Ventures, Inc.; Nortex 
Communications; North Texas Broadband LLC; Northland Communications; NTS 
Communications; Panhandle Telephone Cooperative, Inc.; Phantom Wave (d.b.a. Argon 
Technologies); Poka Lambro Telephone Cooperative, Inc.; Promptwireless LLP; RB3 LLC; 
Ridgewood Cable; Rioplex Wireless Ltd.; Riviera Telephone Company, Inc.; Rock Solid Internet & 
Telephone; Santa Rosa Telephone Cooperative, Inc.; Smithville System; South Plains Telephone 
Cooperative, Inc.; Southwest Arkansas Telephone Cooperative, Inc.; Southwest Texas Telephone 
Company; Speed of Light Broadband, Inc.; Sprint Nextel Corporation; Stelera Wireless LLC; Tatum 
Telephone; Taylor Telephone Cooperative, Inc.; Texas Broadband, Inc.; Texas CellNet; Texas 
Wireless Internet; Texhoma Wireless; TierOne Converged Networks, Inc.; Time Warner Cable, Inc.; 
TISD; T-Mobile USA, Inc.; Totalcom Communications, Inc.; U.S. Cable; Valley Telephone 
Cooperative, Inc.; Verizon Southwest, Inc.; WEHCo Video (d.b.a. Kilgore Video, Kilgore Cable); 
West Texas Rural Telephone Cooperative; Wes-Tex Telecommunications Ltd.; Wharton County 
Electric Cooperative, Inc.; Windstream Communications; XIT Telecommunications & Technology 
Ltd.; and Zito Midwest LLC (d.b.a. Galaxy Cable). 
 
From program initiation through this reporting period, Connected Nation has completed in-the-
field validation testing against 114 companies (out of a universe of 185 viable providers) totaling 
61.62 percent within the state of Texas.   
 
Connected Nation has also continued to review provider datasets for accurate speed information, 
platform listings, and other intricacies that may fall outside of the standard SBI Data Transfer Model 
parameters. Any providers whose submitted coverage and attributes are anticipated to come into 
question have been further reviewed and confirmed; details on a case-by-case basis are presented 
below. 
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Comcast 
Issue: Cable platform with maximum advertised download speed in tier 10, higher than expected 
value range for the technology. 
Resolution: Provider’s website advertises 105 Mbps; screenshot available below. 
 

 
 

Grande Communications 
Issue: Cable platform with maximum advertised download speed at tier 10, higher than expected 
value range for the technology. 
Resolution: Provider’s website advertises 110 Mbps; screenshot available below. 
 

 
 
 
Millennium Telcom 
Issue: Technology of transmission 40 with maximum advertised download speed at tier 6, lower 
than expected value range for the technology. 
Resolution: Use of DOCSIS 3.0 throughout service area was confirmed, even at lower speeds. 
 
Nortex Communications 
Issue: Technology of transmission 40 with maximum advertised download speed at tier 7, lower 
than expected value range for the technology. 
Resolution: Confirmed use of DOCSIS 3.0 throughout service area; however, speeds are kept lower 
currently to be backwards compatible. 
 
North Texas Broadband 
Issue: Technology of transmission 40 with maximum advertised download speed at tier 6, lower 
than expected value range for the technology. 
Resolution: Use of DOCSIS 3.0 throughout service area was confirmed, even at lower speeds. 
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Suddenlink 
Issue: Technology of transmission 40 with maximum advertised download speeds in tiers 3, 4, 5, 6, 
and 7, lower than expected value range for the technology. 
Resolution: Additional information on the technology in use was not received and the dataset is 
submitted as-is; work will continue on the technology clarification. 
 
US Cable 
Issue: Technology of transmission 40 with maximum advertised download speed in tier 7, lower 
than expected value range for the technology. 
Resolution: Provider representative confirmed that DOCSIS 3.0 is indeed in use across its entire 
service area. 
 
 
 
DATA SUBMISSION AND COVERAGE ESTIMATION OF NON-PARTICIPATING 

PROVIDERS 

 
Broadwaves 

As part of its ongoing broadband mapping efforts, Connected Nation (CN) has developed a series 
of processes with the goal of submitting mapping data to NTIA for every known and qualifying 
broadband provider, regardless of whether the provider has chosen to support and participate in the 
SBDD mapping initiative. 

 
The following narrative provides detail regarding the recent data collection activities related to 
Broadwaves, a wireless Internet service provider (WISP), located in Brenham, Texas, with a service 
area in and around Washington County.  The narrative will include information regarding how and 
where CN obtained publicly available data, and the “on-the-ground” validation techniques that 
support the underlying data. 
 
Background 
CN staff members have attempted to obtain the participation of the provider with at least 18 
recorded instances of communication via telephone and e-mail from September 17, 2009, through 
August 5, 2011. Over that period, the provider representative stated on three occasions that the 
company would not participate in the state mapping program. 
 
A CN staff member visited the provider’s home city of Brenham in May 2011 seeking a storefront 
or office, but was unable to locate the provider.  The staff member, however, was able to identify 
the provider’s tower site in Brenham (a commercial bank building) and spoke with the site landlord 
to confirm the provider’s equipment presence on the building.  Unfortunately, the landlord 
representative did not know the business location of the provider.  In a visit to a local computer 
repair shop adjacent to the bank site, the CN staff member spoke with a computer technician who 
knew about the local Internet providers, but did not know of Broadwaves. 
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During the site visit to Brenham in May, the CN staff member attempted to contact the provider for 
an in-person meeting; however, the provider did not respond.  On June 7, 2011, the CN staff 
member sent via e-mail a representative propagation map of one of the provider’s seven advertised 
tower sites with the objective of securing a meeting with the provider, however, the provider did not 
respond.  On June 28, the same CN staff member again sent an e-mail request for a personal 
meeting with the provider for the following week; however, the provider continued to be 
unresponsive. 
 
The Issue 
Connected Nation has been unable to obtain this provider’s broadband coverage information 
through typical outreach efforts.  Broadwaves has, since April 2010, repeatedly stated its refusal to 
participate in the Connected Texas broadband mapping initiative, and has been unresponsive to 
multiple attempts to meet in person to discuss the program and the provider’s coverage area. 
 
 
Identification of Provider’s Service Plans, Service Area, Legal Name, d.b.a., FRN, and 
Licensing 
CN began building a file based on research information and, as time progressed, enriched the file 
with information obtained through the public domain.  As a first step, CN reviewed the provider’s 
website (www.broadwaves.net) to determine the residential service plans (Exhibit A) and the 
service area (Exhibit B) advertised for the provider’s wireless network.  A search for a Federal 
Registration Number (“FRN”) on the FCC COmmission REgistration System (“CORES”) system 
using both the business name as well as the company owner’s name did not reveal a verifiable FRN.  
A similar search in the Texas business licensing system also did not identify Broadwaves as an entity 
licensed to do business in the state.  Finally, a search of the FCC’s Universal Licensing System (ULS) 
for Washington County, Texas, did not identify any wireless licenses held by the provider. 
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Exhibit A:  Advertised Service Plans 

 
 
 

Exhibit B:  Advertised Service Area 

 
 

 
  

Broadwaves.net website as of June 30, 2011
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Preliminary Identification of Provider’s Coverage Area 
The website service area extracted from the Broadwaves website was utilized to create a Google 
Earth (GE) image overlay (Exhibit C) for the purpose of determining approximate center points 
and possible tower sites.  The image overlay was positioned to match the GE base map’s roadways, 
county boundaries, and water bodies. 
 
The approximate center points of each of the seven advertised coverage circles were examined 
utilizing the zoom option of GE’s aerial imagery as well as GE street-level views.   Target locations 
and structures were identified for on-the-ground research. 
 

Exhibit C:  Google Earth Image Overlay of Provider’s Advertised Service Area 
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Field Testing Techniques 
Connected Nation staff developed a tower site research and validation plan based on information 
identified with the Google Earth image overlay. A CN wireless technician sought out viable tower 
locations beginning with the approximate center points, and extending in road-based search patterns 
radiating from those logical center points.  Utilizing Microsoft’s Streets and Trips software, the search 
results are depicted in Exhibit D.   
 

Exhibit D:  Likely Tower Locations for Seven Advertised Service Areas 

 
 
Where possible, the CN technician confirmed through a third party that the tower location was 
being utilized by Broadwaves.  Examples include the confirmation of Broadwaves gear on the 
Brenham bank building as described above, and a telephone conversation with a water utility 
representative confirming the presence of Broadwaves gear (as well as another provider’s gear) on 
the water tower in Burton.  In other instances, the presence of the same transmission gear on 
multiple tower locations added confidence to the identification of the likely Broadwaves tower sites.  
Photographs were also taken at each tower site of the equipment, the support structure, and the 
general location of the site (e.g., populated vs. rural). 
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Having established the most likely tower location for each circular coverage area represented on the 
Broadwaves website, the CN technician then performed signal tests for the detection of active 
wireless frequencies typically utilized to provide WISP service.  The CN technician was equipped 
with an AVCOM PSA-37XP analyzer with RF detection from 1 MHz to 6 GHz and an array of 
antennas tuned specifically for the 900 MHz, 2.4 GHz, 3.65 GHz, and 5 GHz frequency bands.  At 
each signal test location, the CN technician attempted to be isolated from Wi-Fi networks in the test 
area, facilitated spectrum readings from the AVCOM analyzer, and captured the results of the 
frequency tests as validation data for wireless tower transmissions (Exhibit E), which can be viewed 
on the following page. 
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Exhibit E:  Signal Test Results for the Kenney Service Area 
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Signal Propagation Maps 
Upon making a reasonable confirmation that the tested tower site was, or was likely to be, a 
Broadwaves tower site, the CN technician estimated the antenna height, determined the GPS 
coordinates for the tower, and recorded this and other information into the standard Excel provider 
data collection format.  With the objective of reasonably representing the provider’s practical service 
area, the CN technician obtained information for each tower site (Exhibit F), and prepared 
propagation maps (Exhibit G) based on that information as well as the provider’s own advertised 
service area representations.  
 

Exhibit F:  Tower Research and Propagation Data 
 

 
 

 
 

Exhibit G:  Propagation Map for the Carmine Tower Location 
 

 
  

Wireless Provider Information
Provider Name (Legal entity) Broadwaves
DBA ("Doing Business As") Name N/A
FRN # (10‐digit FCC Registration Number) not found

Name of Location Status Pop Center Structure Latitude Longitude Omni? Radius Frequency Gain Power Elevation
Carmine Active Carmine silo 30.13259 ‐96.66647 Yes 10 2400 10 24 120
Burton Active Burton water twr 30.18331 ‐96.59476 Yes 10 2400 12 24 100

Lake Somerville Proposed Lake Somerville water tank 30.25615 ‐96.56818 Yes 10 2400 12 24 100
Brenham Active Brenham bank bldg 30.14776 ‐96.39574 Yes 10 2400 14 26 100
Kenney Active Kenney tower 30.05281 ‐96.3293 Yes 10 2400 10 23 120

Chappell Hill Proposed Chappell Hill tower 30.17138 ‐96.25596 Yes 10 2400 10 24 80
Washington Active Washington tower 30.30463 ‐96.21346 Yes 10 2400 10 24 220
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Results and Submission for October 2011 
After driving several hundred miles combing the highways, streets, and county roads of the 
provider’s overall service area, seven likely access points were identified.  Two sites – Lake 
Somerville and Chappell Hill – could not be verified as operational sites; the advertised service areas 
near those towns are likely to be proposed areas rather than currently operational. A composite 
propagation study (Exhibit H), excluding these two “proposed” locations, reasonably represents 
the researched service area based on all information identified as of June 30, 2011 (see Follow-Up 
Notes below).  As indicated above, a propagation map was forwarded to the provider several weeks 
ago, with no response received.  Nonetheless, this document was also forwarded to Broadwaves 
with the acknowledgement that this information would be submitted to the Texas Department of 
Agriculture and NTIA broadband mapping projects for immediate inclusion unless a provider 
representative responded to CN within 48 hours with corrections or additional notes. 
 
 
 

Exhibit H:  Broadwaves Composite Coverage 
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Follow-Up Notes 
Subsequent to the accumulation of research results related to the service area for Broadwaves as of 
June 30, 2011, for the October 2011 data update submission, the CN technician most familiar with 
this provider noted changes to the coverage information on the provider’s website.  The new 
advertised coverage area includes nine tower access points instead of the previous seven, some of 
the original coverage circles were moved to suggest a changed center point/tower location, and all 
of the circles are differently-sized, presumably based on preferred operating parameters specific to 
each site (Exhibit I).  In early September, the CN technician plotted the likely center points for each 
circle, and visited the Carmine area to perform new research (Exhibit J), which is visible on the 
following page.   
 
 

Exhibit I:  Broadwaves Coverage Subsequent to June 30, 2011 
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Exhibit J:  Broadwaves Possible Tower Locations Subsequent to June 30, 2011 

 
 
 
In this Exhibit J, the red circle depicts the proscribed service area based on the new website 
information.  The red pushpin is proximate to the center point for the previous service area, and is 
the actual tower location identified for the June 30 submission.  The green pushpin is the 
approximate center point of the new service area.  The recent site visit determined that the tower 
identified as closest to the green pushpin was at the edge of the community of Round Top and is 
represented by a blue pushpin. 
 
The CN technician visited the Round Top Chamber of Commerce (RTCOC), whose representative 
was unaware of any company called Broadwaves operating in the area.  The RTCOC representative, 
however, did point the technician towards the construction location of a new community Wi-Fi 
network being built by the local incumbent telephone provider.  The CN technician visited the Wi-
Fi site less than one mile from the identified tower (blue pushpin) and spoke with a construction 
representative who said that he was unaware of any conflicting wireless signals in the area, 
particularly in the 2.4 GHz band, and also unaware of a competing Internet provider called 
Broadwaves.  A signal test performed by the CN technician from an isolated area in close proximity 
to the tower (blue pushpin) resulted in the detection of a weak signal, and only in the 2.4 GHz band. 
 
Finally, the technician drove by the original tower location in Carmine, and found the wireless 
transmission equipment still in place on top of the grain silo.  Although additional work will need to 
be performed to update the coverage area for the April 2012 submission, the composite map 
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contained herein as Exhibit H represents the best information for the October 2011 submission of 
the broadband coverage area for Broadwaves. 
 
 
 

CKS Wireless, Inc. 
 
As part of its ongoing broadband mapping efforts, Connected Nation (CN) has developed a series 
of processes with the goal of submitting mapping data to NTIA for every known and qualifying 
broadband provider, regardless of whether the provider has chosen to support and participate in the 
SBI mapping initiative. 
 
The following narrative provides detail regarding the recent data collection activities related to CKS 
Wireless, Inc., a wireless Internet service provider (WISP), located in Jacksonville, Texas, with a 
service area around Mount Selman, Ponta, Jacksonville, and Rusk, Texas. The narrative will include 
information regarding how and where CN obtained publicly available data and the “on-the-ground” 
validation techniques that support the underlying data. 
 
Background 
CN staff members have continued trying to obtain the participation of the provider with 23 
instances of communication via telephone and e-mail sessions since February 10, 2010, through July 
19, 2011. Only one communication reply was received from a company representative on May 13, 
2010, with a response of electing not to participate. Additionally, a CN staff member visited the 
CKS Wireless, Inc. office on February 10, 2011, to discuss the broadband mapping project in person 
with CKS Wireless, Inc. owner, but he was unavailable for discussions. 
 
The Issue 
CKS Wireless, Inc. by its lack of responsiveness since May 13, 2010, has predicated its unwillingness 
to participate in the Connected Texas broadband mapping initiative. 
 
Identification of Provider’s Service Plans, Service Area, Legal Name, d.b.a., FRN, and 
Licensing 
CN began building a file based on research information and, as time progressed, enriched the file 
with information obtained through the public domain.  For example, CN reviewed the provider’s 
website (www.ckswireless.com) to determine the residential service plans (Exhibit A) and the 
service area (Exhibit B) of the provider’s wireless network. A search for a Federal Registration 
Number (“FRN”) on the FCC COmmission REgistration System (“CORES”) the system yielded an 
FRN of 0006165625 (Exhibit C) with contact information relative to the owner of the company. 
Also, to support field validation of access points, the FRN was referenced to the FCC Universal 
Licensing System (ULS) to identify any licenses the provider may hold which could possibly enhance 
locating active access points for the service area. This process yielded license WQJW906 (Exhibit 
D), Radio Service: NN-3650-3700MHz with 5 unique locations. 
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Exhibit A:  Service Plans 

 
 

 
 
 

  



                                                                       Connected Texas Methodologies 
 

 

 
October 1, 2011  Page 29 
 
 

Exhibit B:  Service Area 

 
 
 
 

Exhibit C:  Federal Registration Number 
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Exhibit D:  WQJW906 License Reference 
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Preliminary Identification of Provider’s Coverage Area 
Connected Nation extracted the CKS Wireless, Inc. service area map from its website and the 
information through the FCC ULS database in reference to license WQJW906. The website service 
area was utilized to create a Google Earth image overlay (Exhibit E). The image overlay was 
positioned to match the Google Earth base map’s roadways, county boundaries, and water bodies. 
The degree of accuracy of the image overlay was maintained at less than .1 mile (528 ft.) to establish 
a minimum search criteria of a given access point. The provider’s service area depiction is 
represented by tower symbols as shown in Exhibit B. Using the coordinates (5 unique locations) 
available through the FCC ULS license search an accuracy validation of the image overlay was 
conducted to determine the feasibility of utilizing the tower symbols for identifying coordinates of 
the remaining 7 locations. The five licensed locations’ coordinates were inputted into Google Earth 
and examined utilizing the zoom option of the aerial imagery. All five locations structures were 
identified. This provided a means of establishing coordinates for the remaining access point 
locations. All 12 locations were entered into the Streets and Trips software program (Exhibit F) to 
develop a route for the validation process, which is presented on the following page. 
 
 

Exhibit E:  Google Earth – CKS Wireless Inc.’s Service Area Image Overlay 
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Exhibit F:  Validation Points for AP Structures 

 
 
 
Testing Techniques 
Connected Nation staff developed a site validation route based on data established with the Google 
Earth image overlay and publicly available data through the FCC ULS database for CKS Wireless, 
Inc. 3650-3700 MHz radio service. The CN wireless engineer was equipped with an AVCOM PSA-
37XP analyzer with RF detection from 1 MHz to 6 GHz and an array of antennas tuned specifically 
for the 900 MHz, 2.4 GHz, 3.65 GHz, and 5 GHz frequency bands (Exhibit G). Each validation 
point was scrutinized for frequency of operation. A screen image of the operating frequency (or 
frequencies) was captured; general notes were recorded for each location - approximate antenna 
height, frequency of operation, antenna type (omni or sectored), and photographs were taken of the 
access points. 
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Exhibit G:  Field Data for CKS Wireless, Inc. Office/Hub Location     
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Results and Submission for October 2011 
Of the 18 locations visited during the validation point route, 12 access points were identified and 
relative information was logged into the CKS Wireless, Inc. field validation notes file (Exhibit H). 
The field and the publicly available data were transferred to the Connected Nation Provider 
Information file. A composite propagation study was completed based on the field data (Exhibit I). 
Both documents were forwarded to CKS Wireless, Inc. and advised the information will be 
submitted to Connected Texas and the NTIA broadband mapping project for processing if there are 
no discrepancies of the estimated coverage received from the provider within a 48-hour period. 
 

Exhibit H:  Field Validation Notes 

Location Latitude Longitude

Frequency 
Band 

Availability Structure

Approximate 
Antenna 
Height

Mt. Selman 32.065356 ‐95.280947 900MHz Tower 180 ft.

N. Jacksonville(3.65G) 32.011444 ‐95.282236
900MHz 
3.65GHz Tower 300 ft.

WEB‐Cove Spring 32.008128 ‐95.353983 900MHz Rohn‐Residential 90 ft.

CKS‐Office_Jacksonville(3.65G) 31.967694 ‐95.245750

900MHz 
2.4GHz 
3.65GHz Tower 120 ft.

Craft WT(3.65G) 31.905431 ‐95.251653
900MHz 
3.65GHz Water Tank 140 ft.

SE LakeJack 31.910836 ‐95.288650 900MHz Rohn‐Residential 90 ft.
SW LakeJack 31.92005278 ‐95.295992 900MHz Rohn‐Residential 90 ft.
NW LakeJack 31.93175 ‐95.295992 900MHz Rohn‐Residential 90 ft.
N. Rusk WT 31.80921667 ‐95.166878 900MHz Water Tower 150 ft.
Rusk Downtown 31.79418333 ‐95.150214 2.4GHz Rohn 80 ft.

East Rusk‐KOA(3.65GHz) 31.79272222 ‐95.118783
2.4GHz 
3.65GHz Tower 120 ft.

Ponta 31.90592778 ‐95.084975
900MHz 
2.4GHz   Tower 130 ft.
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Exhibit I:  CKS Wireless, Inc. Composite Coverage 

 
 

 
  



                                                                       Connected Texas Methodologies 
 

 

 
October 1, 2011  Page 36 
 
 

East Texas Broadband 

As part of its ongoing broadband mapping efforts, Connected Nation (CN) has developed a series 
of processes with the goal of submitting mapping data to NTIA for every known and qualifying 
broadband provider, regardless of whether the provider has chosen to support and participate in the 
SBI mapping initiative. 
 
The following narrative provides detail regarding the recent data collection activities related to East 
Texas Broadband, a wireless Internet service provider (WISP), located in Palestine, Texas, with a 
service area around Palestine, Elkhart, and Elmwood, Texas. The narrative will include information 
regarding how and where CN obtained publicly available data and the “on-the-ground” validation 
techniques that support the underlying data. 
 
Background 
CN staff members have continued trying to obtain the participation of the provider with 17 
instances of communication via telephone and e-mail sessions since July 7, 2010, through August 24, 
2011. Only one communication was established with a company representative on February 4, 2011. 
An introduction of the state mapping initiative was provided to the representative with a request to 
review and provide the requested data as submitted with previous correspondence. Since this date 
the representative has been non-responsive to telephone messages and e-mails. 
 
The Issue 
East Texas Broadband, by its lack of responsiveness since February 4, 2011, has predicated its 
unwillingness to participate in the Connected Texas broadband mapping initiative. 
 
Identification of Provider’s Service Plans, Service Area, Legal Name, d.b.a., FRN, and 
Licensing 
CN began building a file based on research information and as time progressed, enriched the file 
with information obtained through the public domain or by phone inquiry through the provider’s 
customer support line.  For example, CN reviewed the provider’s website (www.etbroadband.net) to 
determine the residential service plans. However, the website did not identify the residential service 
plans. A telephone call was placed through customer support and the residential plans were quoted 
over the phone (Exhibit A) and the service area (Exhibit B) of the provider’s wireless network was 
identified. A search for a Federal Registration Number (“FRN”) on the FCC COmmission 
REgistration System (“CORES”) system yielded no FRN for East Texas Broadband. Also, to 
support field validation of access points, the FCC Universal Licensing System (ULS) was utilized to 
identify any licenses the provider may hold which could possibly enhance locating active access 
points for the service area. This process yielded no licensed frequencies associated to East Texas 
Broadband, indicating the provider’s broadband delivery is by way of the unlicensed Wi-Fi 
frequencies band (900 MHz, 2.4 GHz, and 5 GHz). 
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Exhibit A:  Service Plans 
 

 
 

 
 

 
 
 
 
 
 

 
 

Exhibit B:  Service Area 
 

 
 
 

 
 
 

Speed Tier Offerings Residential 
Service 
Price 

Download Upload

512 Kbps 256 Kbps $24.95
1 Mbps 512 Kbps $39.95
2 Mbps 1 Mbps $54.95

3 Mbps 1 Mbps $69.95
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Preliminary Identification of Provider’s Coverage Area 
Connected Nation extracted the East Texas Broadband service area map from its website. The 
website service area was utilized to create a Google Earth image overlay (Exhibit C). The image 
overlay was positioned to match the Google Earth base map’s roadways, county boundaries, and 
water bodies. The degree of accuracy of the image overlay was maintained at less than .1 mile (528 
ft.) to establish a minimum search criteria of a given access point. The provider’s service area 
depiction is represented by circular type polygons as shown in Exhibit B. Based on the provider’s 
website coverage depiction there are nineteen (19) locations identified as possible locations for 
access point structures. Utilizing Google Earth with the provider’s coverage overlay (Exhibit C), 
coordinates were established of the circular polygons center points for route development. Further 
enhancement for possible structure identification was completed by a satellite aerial imagery and 
street level session with the Google Earth application.  Possible structure locations were identified 
around the center points. This provided a means of establishing coordinates for the access point 
locations. Twenty-one (21) locations were entered into the Streets and Trips software program 
(Exhibit D) to develop a route for the validation process. 
 

 
Exhibit C:  Google Earth - Provider’s Service Area Image Overlay 
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Exhibit D:  Validation Points for AP Structures 
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Testing Techniques 
Connected Nation staff developed a site validation route based on data established with the Google 
Earth image overlay and publicly available data through East Texas Broadband’s website. The CN 
wireless engineer was equipped with an AVCOM PSA-37XP analyzer with RF detection from 1 
MHz to 6 GHz and an array of antennas tuned specifically for the 900 MHz, 2.4 GHz, 3.65 GHz, 
and 5 GHz frequency bands (Exhibit E). Each validation point was scrutinized for frequency of 
operation. A screen image of the operating frequency (or frequencies) was captured; general notes 
were recorded for each location - approximate antenna height, frequency of operation, and antenna 
type (omni or sectored), and photographs were taken of the access points. 
 

Exhibit E:  Sample Field Data for East Texas Broadband  
CR433-ROHN (CntrPoint#2) Location 

 

           
 
 
 

Provider Location Latitude Longitude Frequency Availability Structure

Approximate 
Antenna 
Height Notes

900MHz 2.4GHz 3.65GHz 5.0GHz

East Texas BB CR433‐ROHN (CntrPoint#2) 31.813611 ‐95.693056   X   Residential Rohn 80
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Location Latitude Longitude

Frequency 
Band 
Availability Structure

Approximate 
Antenna 
Height

Elmwood‐WaterTank#1 31.920556 ‐95.645033 900MHz Water Tank 100 ft.
CR404 WT (CntrPoint#1) 31.831667 ‐95.645833 900MHz Water Tank 100 ft.
CR433‐ROHN (CntrPoint#2) 31.813611 ‐95.693056 2.4GHz Residential Rohn 80 ft.
CR419‐ROHN (CntrPoint#3) 31.780833 ‐95.670000 900MHz Residential Rohn 70 ft.
BroylesChapel‐ROHN (CntrPoint#4) 31.769444 ‐95.718611 900MHz Residential Rohn 80 ft.
Hwy79SW‐Lattice (TwrLocation#1) 31.738125 ‐95.664222 900MHz Lattice 120 ft.
Larkspur Ln‐ROHN (CntrPoint#5) 31.729167 ‐95.685833 900MHz Residential Rohn 60 ft.
CR2012B‐GuyedTwr (TwrLocation#2) 31.717817 ‐95.649658 900MHz Commercial Guyed 100 ft.
Hwy322‐WaterTower 31.587222 ‐95.667778 900MHz Water Tank 120 ft.
Elkhart‐WaterTower 31.624781 ‐95.580536 900MHz Water Tower 150 ft.
FM3266 WtrTwr (WtrTank#2) 31.766944 ‐95.531389 900MHz Water Tank 80 ft.
N. Church‐BldgROHN (TwrConfig) 31.763889 ‐95.626667 2.4GHz 3 story w 40Ft. Rohn 80 ft.
Hwy155 (RohnTowerAP) 31.791303 ‐95.619117 2.4GHz Residential Rohn 100 ft.
Hwy79N_ROHN (TwrLocationOffice) 31.798764 ‐95.593725 900MHz Residential Rohn‐G 120 ft.
WalstonSpringsWT (TwrLocation#4) 31.708767 ‐95.583875 900MHz Water Tower 80 ft.

ETBB Office 31.730833 ‐95.623333
2.4GHz 
5.1GHz Commercial Guyed 150 ft.

Results and Submission for October 2011 
Of the 21 locations visited during the validation point route, 17 access points were identified and 
relative information was logged into the East Texas Broadband field validation notes file (Exhibit 
F). The field and the publicly available data were transferred to the Connected Nation Provider 
Information file. A composite propagation study was completed based on the field data (Exhibit 
G). Both documents were forwarded to East Texas Broadband and advised the information will be 
submitted to Connected Texas and the NTIA broadband mapping project for processing if there are 
no discrepancies of the estimated coverage received from the provider within a 48-hour period. 
 
 

Exhibit F:  Field Validation Notes 
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Exhibit G:  East Texas Broadband Composite Coverage 
 

  
 
 
 
ACCURACY AND VERIFICATION:  PROVIDER VALIDATION METHODOLOGY 

Broadband providers maintain their service area data in many different formats, all in varying levels 
of complexity and granularity. In order to ensure that the data required by the NTIA is standardized 
across all providers and that it is as accurate as possible, Connected Nation translates and formats 
the data that providers are able to supply into a GIS shapefile and produces maps for the provider to 
review.  The resulting map(s) and review process allow for providers to see their service area in a 
geographic format – for some providers, this is the first time they have seen maps of their 
broadband service area. Having the mapped service area allows providers to quickly identify any 
issues that appear in the data representation, whether the issue is in the data translation into a GIS 
format or from the original data collection and submission. Often data is provided from various 
sources and through the review and revision process, local engineers who operate the networks and 
work in the field are able to ensure that the tabular data that has been submitted is accurate and 
represents the real-world network extent. Any issues in how the service area is represented on the 
map(s) are remedied by Connected Nation, whether they are additions, removal of service, or any 
other revisions. Revised maps of service area representations are sent to the provider for review and 
approval; Connected Nation will revise data and return maps as many times as necessary until the 
provider is in agreement that the map represents their service area as accurately as possible. Once 
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the review process has been completed and final approval of the data is provided, the data is deemed 
ready for NTIA submission. 
 
Once the data collection has been aggregated at a statewide level, static maps of statewide and 
county-level availability are produced and made publicly available. In addition, consumers can visit 
the interactive online tool, BroadbandStat, to create customized views of broadband service areas 
and analyze corresponding demographic information. Leveraging broadband service data on various 
platforms allows for public users, providers, and other stakeholders to review, scrutinize, and 
provide feedback on the represented data. This feedback becomes a validation method in itself as 
consumers submit inquiries to Connected Nation either affirming where service is not available or 
identifying areas where broadband service is shown on the map, but in actuality is not available. This 
allows for a follow-up to providers regarding revisions to the data as it is represented; it also allows 
for Connected Nation to identify locations where on-site visits may be necessary to complete field 
validation of available services. Public feedback on all forms of mapping products serves as a 
localized validation method for provider-supplied information and allows Connected Nation to 
resolve inaccuracies as they are identified to ensure that only the highest quality information is 
provided to stakeholders. 
 
Estimates derived from provider-validated data indicate that approximately 3.53 percent of Texas 
households do not have terrestrial fixed broadband service available, and approximately 0.22 
percent1 of Texas households have neither mobile nor fixed broadband service available.2   
Within rural areas of the state, results derived from provider-validated data indicate that 
approximately 8.13 percent of rural Texas households do not have terrestrial fixed broadband 
service available, and approximately 0.70 percent3 of rural Texas households have neither mobile nor 
fixed broadband service available.4  Please note that the availability estimates presented are based on 
Census 2000 household information; these figures will be updated in the near future with Census 
2010 household information. 
 
 
  

                                                            
1 In accordance with NTIA’s definition of available broadband service as specified in the SBI NOFA, this estimate 

includes both terrestrial fixed and mobile broadband service, if the service offers download speeds of at least 768 Kbps 
and upload speeds greater than 200 Kbps. 

2 Due to the nature of the SBI data collection methodology as defined by the NTIA and based on both census block 
geographic units and street segment data, the estimates of broadband availability derived from provider-validated data 
may include an overstatement of the actual number of households with broadband availability.  Under the census block-
based data collection method, a provider will typically report broadband availability for an entire census block whether 
its network is present across the whole or only a subset of that census block.  This potential overestimation at the census 
block level can be amplified as the data is aggregated across the entire state. 

3 See footnote 1. 
4 See footnote 2. 
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WIRELESS METHODOLOGY 

Broadband Service Availability in Provider’s Service Area 
Wireless Services Not Provided to a Specific Address 

 
Data solicited from a fixed wireless provider to create propagation models include, but are not 
limited to: 

1. The name of the structure 
2. Whether the transmitting device is operational or proposed 
3. The maximum advertised downstream speed, the maximum advertised upstream speed 
4. The typical downstream speed, the typical upstream speed (peak periods for both) 
5. The frequency range of spectrum being used (as prescribed by NTIA) 
6. The primary population center(s) being served (for geopolitical boundary reference) 
7. The physical address of the transmit site (in the event latitude/longitude is unavailable 

from the provider this allows a quick reference point for geocoding) 
8. Latitude in either Degrees, Minutes and Seconds and/or in Decimal Degrees (typically 

received as NAD 27 or NAD 83)  
9. Longitude in either Degrees, Minutes and Seconds and/or in Decimal Degrees (typically 

received as NAD 27 or NAD 83)  
10. Antenna pattern (e.g. omni-directional, 180°, 120°, 90°, etc.) 
11. Azimuth of antenna (e.g. 360° with magnetic declination if known) 
12. Approximate transmit radius (in feet, miles, or kilometers) 
13. Polarity of transmit antenna (Vertical or Horizontal) 
14. Transmit antenna gain (in dBi) 
15. Line loss (applicable only to providers using coax, heliax, waveguide or other forms of 

cabling – excludes power-over-Ethernet devices) 
16. Mechanical and/or Electrical beam tilt (if applicable) 
17. Equipment Manufacturer (allows easy cross-reference against manufacturer’s specification 

sheet) 
18. Power output of the transmitting device (if unknown, FCC standards or manufacturer 

specifications are applied) 
19. AMSL at base of tower site 
20. Antenna centerline AGL (height of antenna above ground level measured at the centerline 

of the actual antenna) 
21. Foliage factors (Evergreens/Deciduous and percent of ground cover) 
22. Ground Clutter (primarily used in rural areas to account for foliage and in metropolitan 

areas to account for types and heights of buildings if known)   
23. Average gain of receive antenna 
24. Receive antenna is estimated at height above average terrain (HAAT) of 6.2 meters/20 feet 
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25. Federal Registration Numbers (if applicable) which may allow opportunities to cross-
reference and/or obtain additional data from the Federal Communications Commission 
Universal Licensing System and the COmmission REgistration System. 

 
Propagation modeling is an empirical mathematical formulation for the characterization of radio 
wave propagation as a function of frequency, distance, and other conditions. Propagation 
software(s) typically use the Irregular Terrain Model (also known as Longley-Rice) of radio 
propagation for frequencies between 20 MHz and 20 GHz. This model is based on electromagnetic 
theory and statistical analyses of the combination of terrain features and radio measurements, then 
predicting the median attenuation of a radio signal as a function of distance and the variability of the 
signal in time and in space.  For metropolitan areas, the software can typically be adjusted to use the 
Okumura-Hata model which accounts for predicting the behavior of cellular transmissions in areas 
where buildings are the primary obstructions. The resulting product from either model depicts a 
graphical illustration of the theoretical propagation characteristics of a selected frequency range 
based on defined variables (receiver sensitivity of the home/mobile device, foliage factor, and digital 
elevation terrain input). 
 
After converting propagation models into a geospatial format, additional processing is completed to 
remove the small pixels representing service present in the resulting dataset. These areas are initially 
created based on the parameters entered in the software from the provider equipment information, 
the underlying data parameters of elevation, hillshade, etc., and the limitations of the software itself 
to display a broadband service area as accurately as possible. Generally, these random pixel striations 
appear as a result of signal levels reaching the highest elevated points within the prescribed radius. 
Typically, while this pixilation anomaly shows legitimate areas where signals can be received, these 
highly elevated points may have exceedingly sparse populations or are entirely void of population. 
As a result, and congruent to the Wireless Technology Methodologies and Business Logic white paper 
submitted to NTIA on January 20, 2011, all independent pixels representing service that are less 
than 0.125 square miles in area have been removed from the geospatial representation of each 
wireless provider. 
 
 
 
BROADBAND INQUIRIES METHODOLOGY  

Connected Nation collects consumer feedback in the form of broadband inquiries (BBIs). These 
inquiries represent any type of communication received from the public regarding broadband 
service. Once BBIs are received across the state, this information is overlaid with the broadband 
availability information which was collected through the SBI program.  This allows for a real-world 
comparison of the broadband landscape to the information received from broadband inquiries.  
Consumers submitting these inbound comments and/or inquiries are able to provide information 
regarding three categories:  1) residents who do not have broadband but want it; 2) residents who 
have broadband but want a different provider; and 3) residents who do not have broadband, but the 
broadband inventory maps indicate that they do. 
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BBIs are submitted frequently by consumers via the Connected Texas website.  Inquiries often seek 
help to identify local broadband provider options, or to learn when a specific provider may be able 
to provide service to that consumer.  Consumer comments also provide information which may 
help modify maps with actual service area information.  The primary objectives of Connected 
Nation regarding these inquiries are 1) to improve the accuracy of the state maps with submitted 
consumer information and follow-up field research; 2) to provide broadband options to consumers 
through cooperation with mapped providers and by facilitating new broadband service options; and 
3) to map and analyze information from consumers about areas of unmet broadband demand and 
alternatives to currently mapped services. 
 
New BBIs are assigned to either the GIS department or the Engineering & Technical Services (ETS) 
team depending on the category entered by the consumer on the website submission form.  The 
GIS or ETS team members respond to each inquiry according to the information requested by the 
consumer.  Many BBIs can be resolved through desktop research; however, if a BBI requires 
research in the field, the assigned ETS team member conducts such research when performing field 
validations in the area of the inquiry, or at other such time as is practical and appropriate.  GIS and 
ETS team members respond to and conclude BBIs via telephone contact and/or e-mail 
communication.   
 
The broadband inquiry process has been implemented in each of the Connected Nation state 
programs with successful results. Altogether Connected Nation has received over 17,000 broadband 
inquiries since 2007, allowing the state programs to evaluate each inquiry for broadband demand and 
data verification.  These inquiries are continuously examined against current broadband availability, 
updated every six months, to determine if previously unserved households have been expanded to 
and can now receive broadband at their residence. This database of broadband inquiries has also 
allowed the Connected Nation state programs to aggregate demand in concentrated areas to show 
providers the exact locations where the population has made it clear that they would purchase 
broadband if it was made available to them. Providers in the states have responded to this process 
and have expanded to areas knowing that their investment will be worthwhile. Data verification 
methods have also proven successful, as the state programs have been able to show those inquiries 
that indicate the broadband service areas are misrepresented on the map to providers, who then 
verify where service cannot reach in regard to that residence(s). The broadband coverage in these 
states has been altered to create a more accurate map based on the inquiries submitted by the public. 
During this reporting period, the Connected Texas project has received a total of 50 inquiries (474 
grant inception to date).  As more inquiries are submitted to Connected Texas, a more thorough 
validation of the broadband landscape can be performed, while also allowing providers to see which 
areas have a high demand for broadband adoption. 
 
 
 
BROADBANDSTAT METHODOLOGY 

BroadbandStat is an online, interactive mapping tool for viewing, analyzing, and validating 
broadband data. Developed through a partnership with ESRI, the market leader in geographic 
information system (GIS) software, BroadbandStat is a multi-functional, user-friendly way for local 
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leaders, policymakers, consumers, and technology providers to devise a plan for the expansion and 
adoption of broadband.  
 
First and foremost, BroadbandStat allows consumers to locate their residence and identify providers 
that offer broadband Internet service to that location. The interactive platform allows for users to 
build and evaluate broadband expansion scenarios using a wealth of data, including education and 
population demographics, broadband availability, and research about the barriers to adoption.  
 
New functionality in BroadbandStat allows the consumer to provide feedback on the broadband 
data displayed on the interactive map.  Through the collection of this feedback, a visual demand for 
broadband is presented.  This visualization allows the Connected Nation state programs the ability 
to validate the broadband availability for accuracy.  If residents within a region state they are without 
broadband, but the interactive map shows otherwise, this allows Connected Nation to approach the 
providers within that area in an effort to trim down their coverage to more accurately represent real-
world availability on the ground.   
 
The Connected Texas project launched BroadbandStat on June 16, 2010, and has received a total of 
14,948 visits to date (14,937 to the English website and 11 to the Spanish website), of which 1,407 
occurred this reporting period (1,401 to the English website and 6 to the Spanish website). 
 
 
 
SPEED TEST METHODOLOGY 

The 1,018 speed tests that are represented in the Connected Texas Speed Test Report during this 
reporting period (6,312 grant inception to date) are the result of a partnership between Connected 
Nation and Ookla Net Metrics. Utilizing this relationship increases the level of confidence in the 
data being collected and provides for a far greater sample size than could be collected by a single 
testing site. 
 
Ookla owns and operates Speedtest.net, as well as develops and deploys speed tests, such as the 
Connected Texas speed test website, for partners around the world. This network of sites that is 
developed and run on its testing technology provides Ookla with a vast dataset that, due to the 
variability of geographic information collected across the varying speed test sites, is geocoded 
utilizing Geo-IP technology. This technology allows for tests to be geocoded to points of 
aggregation, typically larger nodes across provider networks.  While there are hundreds of thousands 
of tests that have been conducted, the level of aggregation is only sufficient for county-level detail 
due to the test results being located at these larger nodes and not at an absolute location for each 
speed test. 
 
In an effort to validate broadband data from the Connected Texas project, speed test information is 
collected throughout the state.  Speed tests provide speed information on the path taken through all 
networks (a provider’s network as well as additional networks) a local machine must connect to in 
order to reach the host test.  The benefit of this collection of speed information is two-tiered.  First, 
it allows for a comprehensive dataset of speeds, while also providing Connected Texas with the 
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information on where broadband services are available.  Second, unlike theoretical speed 
information which was received through the data collection process, the use of speed tests provide 
real-world information on the speeds that currently exist within the state of Texas.   
 
 

 
 

	



Complete 243
Non-Responsive/Refused 40
In Progress 1

Count of Datasets by Status 284
Total Unique Providers Represented 185

Provider Name Platform Status

NDA 
Execution 

Date Notes

Alenco Communications, Inc. DSL Data Added to Statewide Inventory 11/17/2009

[SEP-16-11 Sarah Finne] Change: Provider 
upgraded infrastructure and can now offer speed 
tier 7 download speeds in select area.

AT&T Communications of Texas, Inc. DSL Data Added to Statewide Inventory 12/16/2009

[AUG-24-11 Sarah Finne] Change and/or 
Correction: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

AT&T Communications of Texas, Inc. Mobile Wireless Data Added to Statewide Inventory 12/16/2009

[AUG-15-11 Sarah Finne] Change: Network 
expansion to include more coverage around 
Midland, Odessa, Fairfield, Palestine, Buffalo, 
etc.

Big Bend Telephone Company, Inc. Fiber Data Added to Statewide Inventory 3/10/2010

[SEP-16-11 Sarah Finne] Change: Provider 
upgraded infrastructure to expand FTTH service 
territory.

Big Bend Telephone Company, Inc. Satellite Data Added to Statewide Inventory 3/10/2010

[SEP-16-11 Sarah Finne] Correction: Provider 
submitted new platform type, satellite, for this 
submission.

Cable ONE, Inc. Cable Data Added to Statewide Inventory 12/7/2009

[AUG-18-11 Sarah Finne] Change and/or 
Correction: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Cap Rock Telephone Cooperative, Inc. DSL Data Added to Statewide Inventory 3/4/2010

[SEP-16-11 Sarah Finne] Change: Network 
update to include additional Remote Terminals 
and provider upgraded infrastructure and can 
now offer speed tier 5 download speeds in select 
area.

Cap Rock Telephone Cooperative, Inc. Fiber Data Added to Statewide Inventory 3/4/2010

[SEP-16-11 Sarah Finne] Change: Provider 
upgraded infrastructure and can now offer speed 
tier 5 download speeds.

Celltex Networks, LLC Fixed Wireless Data Added to Statewide Inventory
[SEP-16-11 Sarah Finne] Change: New fixed 
wireless tower in operation.

Central Texas Telephone Investments, LP Fixed Wireless Data Added to Statewide Inventory 4/22/2010
[AUG-19-11 Sarah Finne] Change: New fixed 
wireless towers in operation.

CenturyLink DSL Data Added to Statewide Inventory 12/4/2009

[AUG-17-11 Sarah Finne] Change and/or 
Correction: possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Cequel Communications Cable Data Added to Statewide Inventory 12/15/2009

[AUG-29-11 Sarah Finne] Change and/or 
Correction: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Charter Communications, Inc. Cable Data Added to Statewide Inventory 12/15/2009

[AUG-15-11 Sarah Finne] Change: Provider 
submitted a new dataset showing a slight 
decrease in coverage.

Clearwire Corporation Mobile Wireless Data Added to Statewide Inventory 3/3/2010

[AUG-24-11 Sarah Finne] Change and/or 
Correction: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Clearwire Corporation Fixed Wireless Data Added to Statewide Inventory 3/3/2010

[AUG-24-11 Sarah Finne] Change and/or 
Correction: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Coleman County Telephone Cooperative, Inc. DSL Data Added to Statewide Inventory 3/10/2010
[SEP-16-11 Sarah Finne] Change: Network 
expansion to include new DSLAMs.

Comcast Cable Communications, LLC Cable Data Added to Statewide Inventory 12/7/2009

[AUG-29-11 Sarah Finne] Change and/or 
Correction: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Consolidated Communications DSL Data Added to Statewide Inventory 11/30/2009

[AUG-24-11 Sarah Finne] Change and/or 
Correction: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Consolidated Communications Fiber Data Added to Statewide Inventory 11/30/2009

[AUG-24-11 Sarah Finne] Change: Provider 
upgraded infrastructure and now offers FTTH in 
select areas.

CTX Unwired Fixed Wireless Data Added to Statewide Inventory 2/14/2011
[AUG-22-11 Sarah Finne] Change: New fixed 
wireless towers in operation.

Cumby Telephone Cooperative, Inc. Fiber Data Added to Statewide Inventory 3/5/2010

[SEP-16-11 Sarah Finne] Change: Provider 
upgraded infrastructure to expand FTTH service 
territory.

DigiComm Enterprises, LLC Fixed Wireless Data Added to Statewide Inventory 6/15/2010
[SEP-16-11 Sarah Finne] Change: New fixed 
wireless towers in operation.

Dot 10 Wireless, LLC Fixed Wireless Data Added to Statewide Inventory
[SEP-16-11 Sarah Finne] Change: New fixed 
wireless tower in operation.

Broadband Provider Log



East Texas DSL Fixed Wireless Data Added to Statewide Inventory 5/25/2010
[AUG-24-11 Sarah Finne] Change: New fixed 
wireless towers in operation.

East Texas WiFi Fixed Wireless Data Added to Statewide Inventory

[AUG-22-11 Sarah Finne] Correction: East 
Texas WiFi was previously non-responsive, but 
they provided data this round.

Eastex Telephone Cooperative, Inc. DSL Data Added to Statewide Inventory 6/20/2011
[AUG-08-11 Sarah Finne] Change: Network 
expansion (new Remote Terminals).

ENMR Telephone Cooperative, Inc. Fiber Data Added to Statewide Inventory 4/22/2010

[AUG-08-11 Sarah Finne] Change: Network 
expansion (new fiber lines) and provider 
upgraded infrastructure and can now offer tier 7 
download and upload speeds.

Gower Computer Support, Inc. Fixed Wireless Data Added to Statewide Inventory 2/14/2011

[AUG-08-11 Sarah Finne] Change: Provider 
upgraded infrastructure and can now offer speed 
tier 4 download speeds.

Grande Communications Networks LLC Cable Data Added to Statewide Inventory 3/31/2010

[AUG-23-11 Sarah Finne] Change: Provider 
upgraded infrastructure to service additional 
homes and provide maximum download speeds 
of tier 10 to most market areas.

Grayson CableRocket, LLC Cable Data Added to Statewide Inventory 6/15/2010

[AUG-08-11 Sarah Finne] Change: Provider 
upgraded infrastructure and can now offer speed 
tier 7 download speeds.

Gtek Communications Fixed Wireless Data Added to Statewide Inventory 5/24/2010
[AUG-22-11 Sarah Finne] Change: New fixed 
wireless towers in operation.

GVEC.net Fixed Wireless Data Added to Statewide Inventory 2/25/2010
[AUG-22-11 Sarah Finne] Change: New fixed 
wireless towers in operation.

IGN-LPG Enterprises LLC Fixed Wireless Data Added to Statewide Inventory 2/17/2011
[AUG-22-11 Sarah Finne] Change: New fixed 
wireless tower in operation.

Industry Telephone Company DSL Data Added to Statewide Inventory 11/6/2009

[SEP-16-11 Sarah Finne] Change: Provider 
upgraded infrastructure and can now offer speed 
tier 6 download speeds.

JAB Wireless, Inc. Fixed Wireless Data Added to Statewide Inventory 6/14/2010

[AUG-22-11 Sarah Finne] Change: JAB Wireless 
acquired the following fixed wireless operators: 
Rhino Communications, PVCo, Twilight 
Communications, Cobalt Broadband, and 
Wickson.

KeyOn Communications, Inc. Fixed Wireless Data Added to Statewide Inventory 10/15/2009

[SEP-16-11 Sarah Finne] Change: Provider 
acquired some of ERF Wireless' tower sites in 
Central Texas and North Texas.; new composite 
propagations submitted.

Leap Wireless International, Inc. Mobile Wireless Data Added to Statewide Inventory 4/6/2010

[AUG-22-11 Sarah Finne] Change and/or 
Correction: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Millennium Telcom, LLC Fixed Wireless Data Added to Statewide Inventory 8/26/2010
[SEP-16-11 Sarah Finne] Change: New fixed 
wireless towers in operation.

Poka Lambro Telephone Cooperative, Inc. DSL Data Added to Statewide Inventory 2/15/2010

[SEP-01-11 Sarah Finne] Change: Network 
expansion and provider upgraded infrastructure 
and can now offer speed tier 8 download 
speeds.

Poka Lambro Telephone Cooperative, Inc. Fiber Data Added to Statewide Inventory 2/15/2010

[AUG-30-11 Sarah Finne] Change: Provider 
upgraded infrastructure to expand FTTH service 
territory and can now offer speed tier 8 download 
speeds.

RodZoo Wireless Fixed Wireless Data Added to Statewide Inventory

[SEP-16-11 Sarah Finne] Change: Provider's 
speed tiers previously didn't meet the minimum 
requirements/definition of broadband.  Provider 
upgraded infrastructure and can now offer speed 
tier 3 download speeds.

South Plains Telephone Cooperative, Inc. Fiber Data Added to Statewide Inventory 3/15/2010

[SEP-16-11 Sarah Finne] Change: Provider 
upgraded infrastructure to expand FTTH service 
territory.

Sprint Nextel Corporation Mobile Wireless Data Added to Statewide Inventory 1/14/2010

[AUG-24-11 Sarah Finne] Change and/or 
Correction: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

T-Mobile USA, Inc. Mobile Wireless Data Added to Statewide Inventory 1/8/2010

[AUG-24-11 Sarah Finne] Change and/or 
Correction: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Texas Wireless Internet Fixed Wireless Data Added to Statewide Inventory 5/14/2010
[AUG-23-11 Sarah Finne] Change: New fixed 
wireless towers in operation.

Time Warner Cable LLC Cable Data Added to Statewide Inventory 12/21/2009

[AUG-17-11 Sarah Finne] Change and/or 
Correction: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

TISD, Inc. Fixed Wireless Data Added to Statewide Inventory 4/19/2010
[AUG-22-11 Sarah Finne] Change: New fixed 
wireless towers in operation.

United States Cellular Corporation Mobile Wireless Data Added to Statewide Inventory 2/15/2011

[AUG-24-11 Sarah Finne] Change and/or 
Correction: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

US Cable Corporation Cable Data Added to Statewide Inventory 5/20/2010
[AUG-18-11 Sarah Finne] Change: Network 
expansion to include new plant in Fort Stockton.

Valley Telephone Cooperative, Inc. Fixed Wireless Data Added to Statewide Inventory 11/24/2009
[AUG-22-11 Sarah Finne] Change: New fixed 
wireless towers in operation.

Verizon Southwest, Inc. DSL Data Added to Statewide Inventory 12/14/2009

[AUG-18-11 Sarah Finne] Change and/or 
Correction: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.



Verizon Southwest, Inc. Fiber Data Added to Statewide Inventory 12/14/2009

[AUG-18-11 Sarah Finne] Change and/or 
Correction: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Verizon Southwest, Inc. Mobile Wireless Data Added to Statewide Inventory 12/14/2009

[AUG-18-11 Sarah Finne] Change and/or 
Correction: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

Versalink Enterprises, LLC Cable Data Added to Statewide Inventory 5/11/2010
[SEP-16-11 Sarah Finne] Change: Provider 
expanded service area.

Windjammer Communications LLC Cable Data Added to Statewide Inventory 11/16/2009

[AUG-18-11 Sarah Finne] Correction: 
Windjammer Communications LLC was 
previously non-responsive, but they provided 
data this round.

Windstream Communications DSL Data Added to Statewide Inventory 1/19/2010

[AUG-22-11 Sarah Finne] Change and/or 
Correction: Possible service expansion or 
corrections to previous dataset; entirely new 
dataset provided for October 2011 submission.

XIT Telecommunications & Technology, Ltd. Fiber Data Added to Statewide Inventory 3/2/2010

[SEP-16-11 Sarah Finne] Change: Provider 
upgraded infrastructure to expand FTTH service 
territory.

360networks Backhaul Backhaul Provider Only Processing Complete 1/19/2010
Alenco Communications, Inc. Backhaul Backhaul Provider Only Processing Complete 11/17/2009
Alpheus Communications, L.P. Backhaul Backhaul Provider Only Processing Complete
AT&T Communications of Texas, Inc. Backhaul Backhaul Provider Only Processing Complete 12/16/2009
CenturyLink Backhaul Backhaul Provider Only Processing Complete 12/4/2009
Charter Communications, Inc. Backhaul Backhaul Provider Only Processing Complete 12/15/2009
Level 3 Communications, LLC Backhaul Backhaul Provider Only Processing Complete 12/14/2009
MegaPath Inc. Backhaul Backhaul Provider Only Processing Complete 2/15/2010
Poka Lambro Telephone Cooperative, Inc. Backhaul Backhaul Provider Only Processing Complete 2/15/2010
Sprint Nextel Corporation Backhaul Backhaul Provider Only Processing Complete 1/14/2010
T-Mobile USA, Inc. Backhaul Backhaul Provider Only Processing Complete 1/8/2010
Valley Telephone Cooperative, Inc. Backhaul Backhaul Provider Only Processing Complete 11/24/2009
Verizon Southwest, Inc. Backhaul Backhaul Provider Only Processing Complete 12/14/2009
Windstream Communications Backhaul Backhaul Provider Only Processing Complete 1/19/2010
Zayo Bandwidth, LLC Backhaul Backhaul Provider Only Processing Complete

Broadwaves Fixed Wireless
Estimated Coverage Submitted for Non-Participating 
Provider

[SEP-13-11 Sarah Finne] Correction: Estimated 
coverage submitted (propagation) for non-
participating provider.

CKS Wireless, Inc. Fixed Wireless
Estimated Coverage Submitted for Non-Participating 
Provider

[SEP-09-11 Sarah Finne] Correction: Estimated 
coverage submitted (propagation) for non-
participating provider.

East Texas Broadband Fixed Wireless
Estimated Coverage Submitted for Non-Participating 
Provider

[SEP-01-11 Sarah Finne] Correction: Estimated 
coverage submitted (propagation) for non-
participating provider.

AirBand Communications, Inc. Backhaul No Update to Provide 3/29/2010
Aledo Broadband Backhaul No Update to Provide 3/26/2010
Aledo Broadband Fixed Wireless No Update to Provide 3/26/2010
Alenco Communications, Inc. Fixed Wireless No Update to Provide 11/17/2009
Alenco Communications, Inc. Fiber No Update to Provide 11/17/2009
Allegiance Communications Cable No Update to Provide 2/4/2010
Argon Technologies Fixed Wireless No Update to Provide
AwesomeNet, Inc. Fixed Wireless No Update to Provide
Basin 2 Way Radio, Inc. Fixed Wireless No Update to Provide 4/14/2010
Big Bend Telephone Company, Inc. DSL No Update to Provide 3/10/2010
Big Bend Telephone Company, Inc. Backhaul No Update to Provide 3/10/2010
Blossom Telephone Company, Inc. DSL No Update to Provide 3/26/2010
Border to Border Communications, Inc. DSL No Update to Provide
Brazoria Telephone Company Cable No Update to Provide 6/17/2010
Brazoria Telephone Company DSL No Update to Provide 6/17/2010
Broadcomm.US Fixed Wireless No Update to Provide 3/9/2011
Cameron Telephone Company, LLC Backhaul No Update to Provide 3/18/2010
Cameron Telephone Company, LLC DSL No Update to Provide 3/18/2010
Cap Rock Telephone Cooperative, Inc. Backhaul No Update to Provide 3/4/2010
Cap Rock Telephone Cooperative, Inc. Fixed Wireless No Update to Provide 3/4/2010
Central Texas Cable Partners, Inc. Cable No Update to Provide 2/22/2010
Central Texas Telephone Cooperative, Inc. DSL No Update to Provide 3/2/2010
Central Texas Telephone Cooperative, Inc. Fixed Wireless No Update to Provide 3/2/2010
CenturyLink Backhaul No Update to Provide 12/4/2009
Coleman County Telephone Cooperative, Inc. Fixed Wireless No Update to Provide 3/10/2010
Colorado Valley Telephone Cooperative, Inc. DSL No Update to Provide 3/9/2010
Colorado Valley Telephone Cooperative, Inc. Fixed Wireless No Update to Provide 3/9/2010
Community Telephone Company, Inc. Backhaul No Update to Provide 3/10/2010
Community Telephone Company, Inc. DSL No Update to Provide 3/10/2010
Connextions Telcom DSL No Update to Provide 3/2/2011
Connextions Telcom Fiber No Update to Provide 3/2/2011
Cumby Telephone Cooperative, Inc. DSL No Update to Provide 3/5/2010
Dell Telephone Cooperative, Inc. Backhaul No Update to Provide 4/6/2010
Dell Telephone Cooperative, Inc. DSL No Update to Provide 4/6/2010
Dell Telephone Cooperative, Inc. Fiber No Update to Provide 4/6/2010
Dell Telephone Cooperative, Inc. Fixed Wireless No Update to Provide 4/6/2010
Digitex.com Fixed Wireless No Update to Provide 5/25/2010
Digitex.com Backhaul No Update to Provide 5/25/2010

DISH Network Corporation Satellite No Update to Provide 1/27/2010

[SEP-16-11 Sarah Finne] Correction: Satellite 
data is being submitted and was not included in 
the April 2011 submission. While coverage is 
currently the entire state boundary, work 
continues on having more granular data 
available.

Eccentrix Technologies, LLC Fixed Wireless No Update to Provide 3/30/2010
ELC Internet Services, Inc. Fixed Wireless No Update to Provide 3/4/2011
Electra Telephone Company DSL No Update to Provide 11/24/2009
Element Networks, LLC Fixed Wireless No Update to Provide 5/14/2010



ENMR Telephone Cooperative, Inc. Backhaul No Update to Provide 4/22/2010
ENMR Telephone Cooperative, Inc. DSL No Update to Provide 4/22/2010
ETAN Industries Cable No Update to Provide
ETEX Communications, LP Backhaul No Update to Provide 2/25/2010
ETEX Communications, LP DSL No Update to Provide 2/25/2010
ETEX Communications, LP Fiber No Update to Provide 2/25/2010
ETS Cablevision Co., Inc. Cable No Update to Provide 10/30/2009
ETS Cablevision Co., Inc. Fiber No Update to Provide 10/30/2009
Farm to Market Broadband LP Fixed Wireless No Update to Provide 4/16/2010
Ganado Telephone Company, Inc. DSL No Update to Provide 11/16/2009
GEUS Cable No Update to Provide
Gilmer Cable Television Company, Inc. Cable No Update to Provide 6/18/2010
Gtek Communications Backhaul No Update to Provide 5/24/2010
Guadalupe Valley Communications Systems Cable No Update to Provide 11/23/2009
Guadalupe Valley Communications Systems DSL No Update to Provide 11/23/2009
Guadalupe Valley Communications Systems Fiber No Update to Provide 11/23/2009
GVEC.net Backhaul No Update to Provide 2/25/2010
Helmsco, Inc. Fixed Wireless No Update to Provide 2/15/2010

Hi Speed Wireless Fixed Wireless No Update to Provide 2/22/2011

[SEP-16-11 Sarah Finne] Correction: Provider 
clarified they only offer speed tier 5 download 
speeds as their highest package.

Hill Country Telephone Cooperative, Inc. Backhaul No Update to Provide 3/9/2011
Hill Country Telephone Cooperative, Inc. DSL No Update to Provide 3/9/2011
Hill Country Telephone Cooperative, Inc. Fixed Wireless No Update to Provide 3/9/2011

Hughes Network Systems, LLC Satellite No Update to Provide 2/5/2010

[SEP-16-11 Sarah Finne] Correction: Satellite 
data is being submitted and was not included in 
the April 2011 submission. While coverage is 
currently the entire state boundary, work 
continues on having more granular data 
available.

James Cable LLC Cable No Update to Provide 1/11/2010
James Cable LLC Fixed Wireless No Update to Provide 1/11/2010
La Ward Telephone Exchange, Inc. DSL No Update to Provide 11/16/2009
Lake Livingston Telephone Company, Inc. DSL No Update to Provide 11/20/2009
Livingston Telephone Company, Inc. Backhaul No Update to Provide 2/25/2010
Livingston Telephone Company, Inc. DSL No Update to Provide 2/25/2010
Maverick Internet Fixed Wireless No Update to Provide 6/4/2010
Maverick Internet Backhaul No Update to Provide 6/4/2010
McDonald Group Cable No Update to Provide 3/5/2010
Mid-Plains Rural Tel. Co-op. Inc. Backhaul No Update to Provide 3/5/2010
Mid-Plains Rural Tel. Co-op. Inc. DSL No Update to Provide 3/5/2010
Mid-Plains Rural Tel. Co-op. Inc. Fiber No Update to Provide 3/5/2010
Millennium Telcom, LLC DSL No Update to Provide 8/26/2010
Millennium Telcom, LLC Fiber No Update to Provide 8/26/2010

Millennium Telcom, LLC Cable No Update to Provide 8/26/2010

[SEP-12-11 Sarah Finne] Correction: Updated 
download speeds to tier 8, per their website 
information and DOCSIS 3.0 technology type.

NetWest Online, Inc. Fixed Wireless No Update to Provide 2/23/2010

[SEP-12-11 Sarah Finne] Correction: Provider 
only offers 3-5M download speeds to residential 
subscribers; corrected to tier 5.

Neu Ventures, Inc. Backhaul No Update to Provide 6/17/2010
Neu Ventures, Inc. Cable No Update to Provide 6/17/2010
Neu Ventures, Inc. Fixed Wireless No Update to Provide 6/17/2010
Nextlink Wireless, Inc. Backhaul No Update to Provide 2/12/2010
Nortex Communications Backhaul No Update to Provide 2/12/2010
Nortex Communications Cable No Update to Provide 2/12/2010
Nortex Communications DSL No Update to Provide 2/12/2010
Nortex Communications Fiber No Update to Provide 2/12/2010
Nortex Communications Fixed Wireless No Update to Provide 2/12/2010
North Texas Cellular, Inc. DSL No Update to Provide 3/22/2010
North Texas Telephone Company DSL No Update to Provide 11/30/2009
Northland Communications Cable No Update to Provide 8/19/2010
Panhandle Telephone Cooperative, Inc. Cable No Update to Provide 12/7/2009
Panhandle Telephone Cooperative, Inc. DSL No Update to Provide 12/7/2009
Panhandle Telephone Cooperative, Inc. Fixed Wireless No Update to Provide 12/7/2009
Peoples Communication, Inc. Backhaul No Update to Provide 3/4/2010
Peoples Communication, Inc. DSL No Update to Provide 3/4/2010
Poka Lambro Telephone Cooperative, Inc. Fixed Wireless No Update to Provide 2/15/2010
Promptwireless, LLP Fixed Wireless No Update to Provide 4/27/2010
RB3, LLC Cable No Update to Provide 10/23/2009
RB3, LLC Fixed Wireless No Update to Provide 10/23/2009
Ridgewood Cable Fixed Wireless No Update to Provide
Rioplex Wireless LTD Fixed Wireless No Update to Provide 3/3/2010
Santa Rosa Telephone Cooperative, Inc. Backhaul No Update to Provide 3/9/2010
Santa Rosa Telephone Cooperative, Inc. DSL No Update to Provide 3/9/2010
Santa Rosa Telephone Cooperative, Inc. Fiber No Update to Provide 3/9/2010
Santa Rosa Telephone Cooperative, Inc. Fixed Wireless No Update to Provide 3/9/2010
Smithville System Fixed Wireless No Update to Provide 6/17/2010
South Plains Telephone Cooperative, Inc. Backhaul No Update to Provide 3/15/2010
South Plains Telephone Cooperative, Inc. DSL No Update to Provide 3/15/2010
Southwest Arkansas Telephone Cooperative, Inc. Backhaul No Update to Provide 1/19/2010
Southwest Arkansas Telephone Cooperative, Inc. DSL No Update to Provide 1/19/2010
Southwest Texas Telephone Company Backhaul No Update to Provide 3/3/2010
Southwest Texas Telephone Company DSL No Update to Provide 3/3/2010
Southwest Texas Telephone Company Fixed Wireless No Update to Provide 3/3/2010
Speed of Light Broadband, Inc. Fixed Wireless No Update to Provide 11/3/2009

Stelera Wireless, LLC Mobile Wireless No Update to Provide

[SEP-12-11 Sarah Finne] Correction: "Circle" 
polygons of service have been replaced with 
propagations.

Tatum Telephone Company DSL No Update to Provide 11/24/2009
Taylor Telephone Cooperative, Inc. Backhaul No Update to Provide 3/11/2010
Taylor Telephone Cooperative, Inc. DSL No Update to Provide 3/11/2010
Taylor Telephone Cooperative, Inc. Fiber No Update to Provide 3/11/2010



Texas Broadband, Inc. Fixed Wireless No Update to Provide 5/12/2010
Texas CellNet Fixed Wireless No Update to Provide 2/17/2011
Texhoma Wireless, L.L.C. Fixed Wireless No Update to Provide 3/8/2011
TGN Cable Cable No Update to Provide 5/20/2010

Tier One Converged Networks, Inc. Fixed Wireless No Update to Provide 3/24/2010

[SEP-09-11 Sarah Finne] Correction: "Circle" 
polygons of service have been replaced with 
propagations.

Time Warner Cable LLC Backhaul No Update to Provide 12/21/2009
Totelcom Communications, LLC Fixed Wireless No Update to Provide 11/30/2009
Totelcom Communications, LLC DSL No Update to Provide 11/30/2009
tw telecom of texas, llc Backhaul No Update to Provide 3/10/2010
Valley Telephone Cooperative, Inc. DSL No Update to Provide 11/24/2009
Valley Telephone Cooperative, Inc. Fiber No Update to Provide 11/24/2009
Wes-Tex Telecommunications, Ltd. Backhaul No Update to Provide 3/1/2010
Wes-Tex Telecommunications, Ltd. Cable No Update to Provide 3/1/2010
Wes-Tex Telecommunications, Ltd. DSL No Update to Provide 3/1/2010
Wes-Tex Telecommunications, Ltd. Fixed Wireless No Update to Provide 3/1/2010
Wharton County Electric Cooperative, Inc. Backhaul No Update to Provide 4/15/2010
Wharton County Electric Cooperative, Inc. Fixed Wireless No Update to Provide 4/15/2010

WildBlue Communications, Inc. Satellite No Update to Provide 1/8/2010

[SEP-16-11 Sarah Finne] Correction: Satellite 
data is being submitted and was not included in 
the April 2011 submission. While coverage is 
currently the entire state boundary, work 
continues on having more granular data 
available.

XIT Telecommunications & Technology, Ltd. DSL No Update to Provide 3/2/2010
XO Communications, LLC Backhaul No Update to Provide 2/12/2010
Zito Midwest, LLC Cable No Update to Provide 2/17/2011
Basin Broadband, Inc. Fixed Wireless No Update Provided - Use Last Submission Data 3/23/2010
Broadband Data Services of Texas, LLC Fixed Wireless No Update Provided - Use Last Submission Data 4/29/2010
Cequel Communications Backhaul No Update Provided - Use Last Submission Data 12/15/2009
Cogent Communications, Inc. Backhaul No Update Provided - Use Last Submission Data
ECTISP, Inc. Fixed Wireless No Update Provided - Use Last Submission Data
Enet Internet Services, LLC Fixed Wireless No Update Provided - Use Last Submission Data

ERF Wireless Fixed Wireless No Update Provided - Use Last Submission Data

[SEP-09-11 Sarah Finne] Correction: "Circle" 
polygons of service have been replaced with 
propagations. Also, speeds corrected to what is 
actually advertised on their website for 
residential services (1M down).

Five Area Telephone Cooperative, Inc. DSL No Update Provided - Use Last Submission Data 3/8/2010
Five Area Telephone Cooperative, Inc. Fiber No Update Provided - Use Last Submission Data 3/8/2010
Greasy Bend Ventures, Inc. Fixed Wireless No Update Provided - Use Last Submission Data 8/16/2010
North Texas Broadband, LLC Cable No Update Provided - Use Last Submission Data 3/1/2010
NTS Communications DSL No Update Provided - Use Last Submission Data
NTS Communications Fiber No Update Provided - Use Last Submission Data
Our-Town Internet Service Fixed Wireless No Update Provided - Use Last Submission Data 3/31/2010
Pulsestream Internet Services, LLC Backhaul No Update Provided - Use Last Submission Data 6/2/2011
Riviera Telephone Company, Inc. Backhaul No Update Provided - Use Last Submission Data 3/11/2010
Riviera Telephone Company, Inc. DSL No Update Provided - Use Last Submission Data 3/11/2010
Rock Solid Internet & Telephone Fixed Wireless No Update Provided - Use Last Submission Data 2/14/2011
SmartBurst, LLC Fixed Wireless No Update Provided - Use Last Submission Data 8/4/2010
WEHCo Video, Inc. Cable No Update Provided - Use Last Submission Data
West Texas Rural Telephone Cooperative, Inc. Backhaul No Update Provided - Use Last Submission Data 3/31/2010
West Texas Rural Telephone Cooperative, Inc. Cable No Update Provided - Use Last Submission Data 3/31/2010
West Texas Rural Telephone Cooperative, Inc. DSL No Update Provided - Use Last Submission Data 3/31/2010
West Texas Rural Telephone Cooperative, Inc. Fiber No Update Provided - Use Last Submission Data 3/31/2010

Central Texas Telephone Investments, LP DSL Other 4/22/2010
[SEP-12-11 Sarah Finne] Provider does not offer 
any DSL services.  Record added by mistake.

Anvil Communications Fixed Wireless Refused to Participate

[JUN-21-11 Dwayne Goodman] Spoke directly to 
a company representative indicating there is no 
merit to the participation and feels the 
information will be used by competitors; 
expressed unwillingness to participate.

CIT - Campbell Information Technology Fixed Wireless Refused to Participate

[JUL-27-11 Dwayne Goodman] A company 
representative responded to the October 2011 
data submission cycle and requested removal of 
current coverage. As stated by the 
representative, the organization feels there is too 
much information available for competitors and 
sees no benefit for their organization or potential 
new customers.

Fiberlight, LLC Backhaul Refused to Participate 4/20/2010

[JUN-21-11 Dwayne Goodman] A company 
representative forwarded the following message, 
"We appreciate your effort but at this time we 
have decided not to participate."

SOS Communications LLC Fixed Wireless Refused to Participate

[MAY-04-11 Dwayne Goodman] Received the 
following e-mail from a company representative: 
"We decline to participate in NTIA survey.  No 
value or benefit."

Starnet Online Systems Fixed Wireless Refused to Participate

[JUN-13-11 Daryl Coffey] A company officer 
stated that he doesn't "see the benefit at this 
time" in participating.

Telecom Cable, LLC Cable Refused to Participate

[AUG-08-11 Dwayne Goodman] Received an e-
mail reply from a representative of the company 
indicating there will not be any additional 
contribution from the organization other than the 
standard FCC Form 477 reporting to the 
appropriate authorities.

Terral Telephone Company Fixed Wireless Refused to Participate

[MAY-04-11 Dwayne Goodman] A company 
representative declined to participate per the 
data submission outreach. 



Western Broadband Fixed Wireless Refused to Participate

[JUN-13-11 Dwayne Goodman] Received an e-
mail reply from the provider representative 
stating "we will not be participating."

281 Communications, Inc. Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 2, 2010 and February 21, 2011, 
3 additional attempts were made this period.

AMA TechTel Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 11, 2010 and February 1, 2011, 
6 additional attempts were made this period.

Bee Creek Communications Fixed Wireless Non-Responsive to Multiple Attempts 5/21/2010

In addition to multiple contact attempts made 
between July 26, 2010 and January 24, 2011, 10 
additional attempts were made this period.

Buffalo Cable TV Cable Non-Responsive to Multiple Attempts
4 contact attempts were made between March 1, 
2011 and August 5, 2011.

Buford Media Group Cable Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 2, 2010 and February 16, 2011, 
5 additional attempts were made this period.

Centrovision Cable Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 2, 2010 and February 16, 2011, 
5 additional attempts were made this period.

Centrovision Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 2, 2010 and February 16, 2011, 
5 additional attempts were made this period.

Cybercom Corporation Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 2, 2010 and January 5, 2011, 6 
additional attempts were made this period.

Digital Passage Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between January 10, 2011 and February 22, 
2011, 5 additional attempts were made this 
period.

East Texas Cable Co. Cable Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 4, 2010 and February 16, 2011, 
6 additional attempts were made this period.

Gecko Inter.net Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 9, 2010 and January 14, 2011, 
3 additional attempts were made this period.

Hometown Computing Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 4, 2010 and January 14, 2011, 
3 additional attempts were made this period.

Indian Creek Internet Services Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 4, 2010 and February 18, 2011, 
3 additional attempts were made this period.

Internet America Wireless Internet Access Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 9, 2010 and January 14, 2011, 
3 additional attempts were made this period.

Liquid Stone Wireless Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 12, 2010 and February 18, 
2011, 3 additional attempts were made this 
period.

LSCWeb.Com Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 5, 2010 and February 18, 2011, 
3 additional attempts were made this period.

Medicine Park Telephone Company Backhaul Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between January 31, 2011 and February 11, 
2011, 3 additional attempts were made this 
period.

Pathwayz Communications, Inc. DSL Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 3, 2010 and January 13, 2011, 
2 additional attempts were made this period.

Pathwayz Communications, Inc. Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 3, 2010 and January 13, 2011, 
2 additional attempts were made this period.

Phonoscope Enterprises Group, LLC Backhaul Non-Responsive to Multiple Attempts 5/20/2010

In addition to multiple contact attempts made 
between August 11, 2010 and February 18, 
2011, 5 additional attempts were made this 
period.

Presidio Community Wireless Network Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between February 1, 2011 and February 18, 
2011, 1 additional attempt was made this period.

Reliance Globalcom Services, Inc. Backhaul Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 5, 2010 and February 3, 2011, 3 
additional attempts were made this period.

Sterling Cable Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 4, 2010 and February 16, 2011, 
6 additional attempts were made this period.



Sterling Cable Cable Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 4, 2010 and February 16, 2011, 
6 additional attempts were made this period.

Texas Communications DSL Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 4, 2010 and February 18, 2011, 
6 additional attempts were made this period.

Texas Communications Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 4, 2010 and February 18, 2011, 
6 additional attempts were made this period.

Twin Wireless, Inc. Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 4, 2010 and February 17, 2011, 
4 additional attempts were made this period.

Utopian Wireless Corporation Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 9, 2010 and January 6, 2011, 4 
additional attempts were made this period.

VRFuturenet Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 4, 2010 and February 18, 2011, 
4 additional attempts were made this period.

WesTex Connect Internet Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 3, 2010 and February 18, 2011, 
5 additional attempts were made this period.

Zeecon Wireless Internet, LLC Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 4, 2010 and February 18, 2011, 
4 additional attempts were made this period.

Zulu Internet, Inc. Fixed Wireless Non-Responsive to Multiple Attempts
6 contact attempts were made between May 26, 
2011 and August 12, 2011



 
 
About the Utah Broadband Project’s Map & Data 
 
The Utah Broadband Project Interactive Map website is a joint project of the Utah 
Public Service Commission, Governor’s Office of Economic Development, and 
Department of Technology Services. 

The Utah Broadband  Interactive Map was developed and is hosted by the Utah 
Automated Geographic Reference Center (AGRC) utilizing data complied by the 
Project from broadband providers and public sources, including Utah’s State 
Geographic Information Database (SGID) which is utilized extensively for 
locating addresses, locating geographic places, and displaying background 
maps. 

Please report any problems with this web page, the Utah Broadband Interactive 
Map, or relating to broadband availability in Utah to broadband@utah.gov. 
This page contains the following sections: 

 Additional Utah Broadband Maps and Resources 
 Map Goals 
 Map Data Description 
 Map Data Validation 
 Map Data Verification 
 Map Disclaimer 
 Map and Data Update Log 
 
Additional Utah Broadband Maps and Resources 
In addition to the Utah Broadband Map interactive map website, additional 
broadband map products are available that depict availability, speed, and 
technology in Utah. At present these include maps of highest available 
speed, available technology, and community anchor institution maps that depict 
school, health center, government office, and emergency response station 
facilities and the internet access at these locations. 
 

http://utah.gov/broadband/map.html
mailto:broadband@utah.gov?subject=Report%20a%20Problem
http://blog.broadband.utah.gov/about/about-the-interactive-map/#AdditionalMaps
http://blog.broadband.utah.gov/about/about-the-interactive-map/#MapGoals
http://blog.broadband.utah.gov/about/about-the-interactive-map/#MapDataDescription
http://blog.broadband.utah.gov/about/about-the-interactive-map/#MapDataValidation
http://blog.broadband.utah.gov/about/about-the-interactive-map/#MapDataVerification
http://blog.broadband.utah.gov/about/about-the-interactive-map/#MapDisclaimer
http://utahbroadband.wordpress.com/?page_id=981
http://blog.broadband.utah.gov/about/about-the-interactive-map/mapresources/
http://blog.broadband.utah.gov/about/about-the-interactive-map/mapresources/
http://http/utahbroadband.files.wordpress.com/2011/02/maxspeedsummary_small1.
http://http/utahbroadband.files.wordpress.com/2011/02/maxspeedsummary_small1.
http://http/utahbroadband.files.wordpress.com/2011/02/technologysummary_small1.pdf


 
 
Map Goals 
The map attempts to provide consumers, community leaders, and broadband 
providers with a comprehensive map-based view of non-confidential data 
complied by the Utah Broadband Project. This information can be used to 
support: 
 Consumer and Business Decision Support: 

 What provider options and performance are available at a specified 
locations? 

 What locations is broadband service available from a provider of 
interest (a current provider, for example)? 

 Does the broadband map accurately reflect available services? 
 Community Leader Decision Support: 

 How does broadband service compare in an area of interest with 
other parts of the state? 

 Where are un- or under-served areas for which the expansion of 
broadband service or performance should be targeted? 

 Does the broadband map accurately reflect available services? 
 Broadband Providers Decision Support: 

 Where are opportunities to expand service and performance? 
 Does the broadband map accurately reflect available services? 
 

Map Data Description 
The Utah Broadband Project’s Fall 2010 submission to the NTIA/FCC State 
Broadband Data and Development (SBDD) program includes both confidential 
and non-confidential data relating to service availability and infrastructure for over 
40 broadband providers. Non-confidential data depicts broadband availability, 
speed, and technology for wireless service provision as service area polygons 
and, for wireline provision, as service areas and address points aggregated to a 
census block level in urban and rural settled areas and along road segments in 
rural and exurban areas where census blocks are greater than 2 square miles in 
size.  Additionally, provider-submitted middle and last mile infrastructure data and 
pre-aggregation address-level wireline service information were submitted to the 
SBDD program as confidential data. 
 



 

The locations of community anchor institutions, such as schools, libraries, 
government offices, health and human service provision locations, and public 
safety facilities were also collected and submitted. Where possible, speed and 
service technology are indicated, especially for those institutions that receive 
broadband service from the Utah Education Network, the State of Utah 
Department of Technology Services, or the Utah Telehealth Network and those 
organizations that report this information to the State Library. 

The State of Utah and its provider engagement contractor, International 
Research Council (of Mesa, Arizona) developed program communication 
packets, worked to develop NDAs where necessary, and provided engagement 
and technical assistance to providers regarding the submission guidelines and 
process. 

 Participating providers list 
 
Map Data Validation 
The Utah Broadband Project submission was in the data structure outlined in the 
National Broadband Map Data Transfer Model (NBMDTM)  v1.0.1. In order to 
submit data in this format, all provider data submissions were transformed to this 
data structure and loaded into an ESRI File Geodatabase. The project worked 
with provider data in many formats including customer and ‘buildings-passed’ 
addresses and address ranges in spreadsheet, text file, and geographic 
information system formats. Census blocks, pdf maps, computer assisted design 
(CAD) data files, and public-facing websites showing provider service areas were 
also translated into NBMDTM compliant formats. 
Aerial photography, address location services, census block geometry, and road 
segment geometry used for broadband service mapping and quality control of the 
data are from public domain resources in Utah’s State Geographic Information 
Database (SGID) maintained by the Utah Automated Geographic Reference 
Center and funded and supported by the State of Utah general fund, the Utah 
911 Committee, and partnering local, state and federal agencies. 

 

http://utahbroadband.wordpress.com/providers/providers/


 

Additionally, in cases where providers were only able to provide last-mile 
infrastructure locations, terrain modeling was used to generate wireless coverage 
data and network distance modeling was used to form DSL provision areas using 
the street network as a surrogate for the broadband delivery system’s wire 
network. 

Due to time constraints, validation work was somewhat limited to the work to 
translate provider data submissions into the NBMDTM and its list of coded values 
and other attribute specifications. In subsequent submissions, the Project will 
incorporate automated procedures developed by the FCC to ensure that project 
data conforms to the evolving NBMDTM. 

Map Data Verification 
Utah feels strongly the best verification resource is a continued relationship with 
participating providers and the display of availability and speed data through the 
state broadband interactive map.  Along these lines, Utah prepared provider 
feedback packages including a CD containing the providers NBMDTM 
transformed data, pdf overview maps of the providers service area by download 
speed, submission record counts, transformation process notes (including 
problem areas), and suggestions on how to improve the data quality and/or how 
to make subsequent submissions easier. 
Utah also compared data submitted to the American Roamer and Media Print 
Cable Boundaries data and to the Public Service Commission’s 
telecommunications territory boundaries. In preparation for the release of the 
Utah Broadband Map, project staff is holding interactive review sessions with 
providers to review service area data together via online meetings and a preview 
version of the map. These sessions are targeted to providers where further 
clarification is deemed necessary. 

Utah has also experimented with mapping and analysis of FCC speed test data 
and terrain analysis of statewide satellite coverage claims. 

 
 



 
 
Map Disclaimer 
Broadband service availability and characteristics are depicted as derived from 
data assembled by the Utah Broadband Project. Data sources include biannual 
broadband service provider submissions and publicly available sources. Data 
has been modified, where necessary, to meet broadband mapping standards set 
by the National Telecommunications and Information Administration (NTIA). 
Broadband service availability is displayed per NTIA specifications which include 
technology and speed categories and the aggregation of non-wireless service 
availability information to either U.S. Census blocks (where smaller than 2 sq. 
miles) or road segments. 

Speeds shown are the ‘maximum advertised’ for the geographic features 
depicted, and must exceed 0.768 Mbps download and 0.2 Mbps upload (NTIA 
broadband definition) to be included. Actual speeds may vary within and along 
census blocks and roads, due to the granularity and currency of the data, 
technological limitations, and service plan limitations. Users of the site are 
encouraged to inquire directly to providers for current service availability and 
speed. 

All information presented on the Utah’s interactive broadband map is for general 
reference purposes only and may contain errors and omissions. The State of 
Utah makes no warranty with respect to information available, express or implied, 
including but not limited to the fitness for use for a particular purpose. 

The Utah Broadband Project welcomes your comments (broadband@utah.gov). 
 

mailto:broadband@utah.gov
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Summary of Virginia Submission 
 
The Virginia Center for Innovative Technology (CIT) was designated by the Governor of 
Virginia as the primary point of contact for all Commonwealth of Virginia participation in 
the National Broadband Mapping Project.  The CIT worked in conjunction with the 
Virginia Information Technologies Agency’s (VITA) Virginia Geographic Information 
Network (VGIN) to review, process, normalize and submit the information outlined in the  
National Telecommunications and Information Administration’s (NTIA)  Notice of Funding 
Availability (NOFA) establishing a Virginia iteration of the National Broadband Map. 
 
The fall 2011 submission is the fourth submission of data to the NTIA and the update 
includes data from 47 broadband service providers with unique federal identifications 
delivered in various formats ranging from GIS shape files to text files detailing broadband 
availability.   Of the 47 broadband providers included, 28 submitted updated service 
information.  To provide a complete snapshot of broadband availability in Virginia, the 
spring 2011 submission data was carried forward for several remaining broadband 
providers while some carry over providers were reworked for the 2010 census block 
request. 
 
A summary of the fall 2011 submission data includes: 
 

Census Block polygons provided with coverage information 359947 

Address points provided with availability information 63497 

Street Segments provided with availability information 54707 

Wireless polygons with coverage 19 

Middle Mile points with availability information 557 

Community Anchor Institution points with availability information 3591 

 
All broadband providers participating provided advertised speed information for wireless 
polygons, census block, road centerline segment, or addresses.   
 

Base Map Data 

 
VGIN maintains a series of statewide feature classes or partnerships with commercial 
entities which allow the granularity of data necessary to support the National Broadband 
Mapping Project.  The following Virginia and Federal data sets were used in SBDD data 
processing. 
 
Address Points - VGIN maintains a statewide address point feature class that is updated 
quarterly using locality address submissions.  This statewide address point database is 
used to generate a Point Address Geocoding Service which is fed into the Virginia 
statewide composite geocoding web service. 
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Road Centerlines (RCL) – VGIN maintains a statewide road centerline feature class that is 
updated quarterly using locality centerline submissions.  This road centerline database 
contains address range information when it is provided by the locality.  The RCL database 
is used to generate a geocoding service which is an interpolated point along a centerline 
and this is fed into the Virginia statewide composite geocoding web service. 
 
TIGER 2010 Census Blocks – 2010 Census geometry that is available to the broadband 
mapping project for location and presentation of broadband data. 
 

 
Getting Started:  Selection Set Feature Classes 
 
Before any provider information was processed, a geodatabase of selection set feature 
classes was created and individual feature classes were created for use in the 2011 fall 
data submission.  In order to support the processing of broadband data based on select 
by location, feature classes were set up into a selection feature database which allowed 
subsets of provider information to be joined spatially or by attributes and schema to be 
used seamlessly from the processing environment to the transfer data model.  Each 
feature class of interest was an import of the most recent iteration the NTIA SBDD data 
model schema (June 2011). Features from Virginia base map data was ETL’d using 
appropriate field mapping.  The following are layers used in the Selection Set 
geodatabase: 
 

 
 
NTIA_Roads Feature Class - Virginia RCL data has address ranges in the form of four 
fields; from left, to left, from right, & to right.  Two fields were added in the VA State RCL 
output for address high and low and calculated based on several selection queries.  A 
blank schema feature class of the roads was added and the field V_LEID (VA RCL unique 
ID) was added to the feature class.  This customized statewide data set from the Virginia 
RCL Quarter 2 of 2011 was then loaded to a selection set feature class which cloned the 
schema of the NTIA SBDD model feature class called BB_Service_RoadSegment. Unique 
IDs from the VA centerline were loaded to the selection set road centerline feature class.  
All Broadband related fields (DBA, FRN, TransTech, etc.) assumed default values of the 
NITA data model and were <Null> or blank.    
 
NTIA_Addresses Feature Class - Statewide data from the Virginia AP Q2 of 2011 was 
loaded to a selection set feature class which cloned the schema of the NTIA SBDD model 
feature class called BB_Service_Address.  A spatial join was performed to this data set to 
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the 2010 census blocks in order to apply block information to the point and the 2010 
bock information available on the fly.  The FULLFIPSID field inside the address points was 
then overwritten with the new spatially joined data based on the GEOID value from 2010.  
Latitude and Longitude values were also calculated in the selection set feature class.  All 
Broadband related fields assumed default values of the NTIA data model and were <Null> 
or blank.  These values were calculated individually for providers who submitted data 
relevant to address points. 
 
NTIA_Blocks2000 Feature Class - 2000 Tiger blocks were loaded into the NTIA model 
directly using the schema of the NTIA SBDD data model for the feature class named 
BB_Service_CensusBlock.  FIPS values were matched up in the ETL and several other 
related block fields were loaded as well.  Broadband related fields assumed default values 
of the NTIA data model.  Values were calculated individually based on joins.  This data 
was used solely to create a quick reference to confirm suspicions of whether a provider 
submitted data in 2000 census block geography or 2010. 
 
NTIA_Blocks2010 Feature Class - 2010 Tiger blocks were loaded into the NTIA model 
directly using the schema of the NTIA SBDD data model for the feature class name 
BB_Service_CensusBlock. GEOID values in the 2010 data were mapped to the FIPS values 
in the NTIA schema and other related block data was matched with its appropriate field 
name.  Broadband related fields assumed default values of the NTIA data model.  A 
separate field called SQ_MI_VA_LAMBERT was added to the selection set feature class 
and was created in the NAD_1983_Virginia_Lambert (Meters) projection and calculated 
to the WGS_84 data set.  This was used in Square Mile QC. 

 
Broadband Provider Processing Environment 
 
To support the processing of broadband provider information separately, a broadband 
provider specific staging geodatabase was created. Each broadband provider 
participating in the fall 2011 had its own geodatabase and data was processed completely 
independent of all other broadband providers, allowing providers to move through the 
process at different rates.  This also allowed the correction of any data problems specific 
to broadband providers without affecting the entire submission database.   
 
A naming convention for each selection set feature class was used and called “NTIA_” and 
the feature class type.  “NTIA_Roads” were loaded to the transfer data model feature 
class BB_Service_RoadSegment, “NTIA_Census_Blocks” were loaded to the transfer data 
model BB_Service_CensusBlock feature class, “NTIA_Addresses” were loaded to the 
transfer data model BB_Service_Address feature class, and depending on provider 
category “NTIA_Wireless” was loaded to the transfer data model BB_Service_Wireless.  
Once the broadband provider data was processed to a point in its native feature class in 
the staging geodatabase which fully conformed to the NTIA specifications, it was included 
in the Virginia submission for quality control and subsequent delivery. 



6  Virginia Broadband Data Submission, Fall 2011 

 
http://www.wired.virginia.gov/ 

 
 

Virginia Provider Data Submission Categorization 
 
Between submissions from the spring 2011 and fall 2011, Virginia designed a 
nomenclature to use in referring to a provider based on the category of data which they 
provide to the CIT and VGIN.  While it is apparent that the receipt of GIS data is the most 
desirable format when processing data sets, some providers may not be able to send this 
type of information based on the resources they have at hand.  Provider data category 
generally dictates provider processing methodology.   
 
Between submissions it was noted that some providers may actually change the type of 
data they submit to CIT and VGIN.  Some providers may have the capability of storing or 
already storing their information in the most desirable format although not submitting 
data in this format.   
 
Tracking what is sent and placing a category for the type of data received can be a good 
factor in analyzing deltas for feedback looping and can ultimately build provider 
communication and allow new standardization of data submitted.  Virginia would like for 
providers to be consistent in the data they send to the CIT and VGIN and provider data 
category becomes a quick reference for this consistency.   
 
The naming convention is only for providers who submit census blocks, addresses, 
address ranges, or wireless information.  In the next submission, middle mile, pricing, and 
additional data sets may be used in the update to wireline provider type.  The following 
are categories which refer to the data received by a provider for base data: 

 
Wireline Providers: 
 
Category 1 
‐ Provider sent GIS census blocks (census) 
‐ Provider sent GIS road centerlines (census) 
 
Category 2 
‐ Provider sent census block IDs in tabular form for blocks less than 2 square miles 
‐ Provider sent address ranges in tabular form with TLID (Tiger GIS line ID) 
 
Category 3 
‐ Provider sent census block IDs in tabular form for blocks less than 2 square miles 
‐ Provider sent customer address numbers in tabular form  
 
Category 4 
‐ Provider sent census block IDs in tabular form for blocks less than 2 square miles 
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‐ Provider sent address ranges in tabular form with no TLID 
 
Category 5 
‐ Provider sent census block IDs in tabular form 
‐ Provider did not submit address level data 
 
Category 6 
‐ Provider did not send census block IDs 
‐ Provider sent customer address numbers in tabular form OR provider sent address 
ranges 
 
Wireless Providers: 
 
Category 7 
‐ Provider sent GIS shapefiles of coverage areas 
 
Category 8 
‐ Provider sent customer address numbers in tabular form which represented coverage 
(propagation model developed) 
 
 

Generalized Broadband provider Data Processing 
 
Broadband provider processing was accomplished in using selection set feature classes 
and the appropriate geometry supplied.  Data was reported in many different categories 
and each of these reporting formats was handled differently.  While there were other 
NTIA SBDD data sets that were provided differently from providers (pricing, speed by 
region), they were considered separate use cases than base layer data since the output of 
these secondary data sets was not primarily geospatial.  The following are GIS data layers 
reported in the SBDD data model. 
  
Wireless Service Area Polygon Reporting – Service Area Polygons were reported by 
Wireless Broadband providers and required little processing to be included in the NTIA 
SBDD data model.  Typical inclusion processes included attribute validation and use of the 
ESRI Simple Data Loader or Copy and Paste. 
 
Census Block Reporting – Broadband providers reporting broadband availability on a 
census block basis submitted it in list form a majority of the time.  These lists came in the 
form of spreadsheets and text files.  These lists were normalized into spreadsheets and 
then imported into a provider staging geodatabase table.  Providers who submitted data 
for the fall 2011 release were then asked as a follow up by the CIT what census 
geography they reported their data in and a spreadsheet kept record of all new 
submissions and the geography used.   
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If data was submitted in 2010 census block geography, it was joined directly to the 2010 
selection set block GIS data and checked to make sure reported provider values matched 
100%.   If the data did not match all records in the submitted table, data was inspected to 
see whether there was duplicate transmission technology or if the provider may have 
actually submitted in a different geography than requested.  Attributes were joined to 
the 2010-2000 cross walk table by FIPS with only matching records being kept in the join.  
The data was then exported to a separate feature table and the new feature table was 
joined to 2010 selection set block data using the GEOID value. 
 
Some anomalies were encountered about geometry and are documented in the 
individual provider processing section.  Generally, these anomalies occurred in the 
conversion from 2000 where blocks were less than two square miles in census 2000 
geography but the 2010 blocks were greater than two square miles.    The resulting 
broadband provider specific staging database was validated and attribute anomalies 
were filtered into an error database.   
 
Address Reporting - Providers reporting broadband availability on a service address basis 
submitted it in list form.  These lists were either submitted in the form of spreadsheets or 
text files; no geospatial address data was received.  Once the address number data was 
converted to spreadsheets from text files, the address lists were geocoded using VGINs 
three tiered geocoding process.  Addresses were first geocoded against the statewide 
address point database.  Any service addresses that were tied with the match threshold 
or unmatched on the first pass were rerun using the statewide road centerline geocoding 
web service.  At this point, a majority of the addresses were located and unmatched 
addresses were then exported as a spreadsheet. 
 
Road Segment Address Reporting – Broadband providers reporting broadband availability 
using road address ranges submitted the data in a non-spatial list in a majority of cases, 
although several providers did send in TIGER lines.  These lists were normalized into a 
series of spreadsheets when processing the individual provider. The data was either used 
in joining to census features by Tiger Line ID (TLID) and then selecting by location from 
the selection set RCL data or used raw in geospatial format and selected.  No providers 
from the fall 2011 processing were geocoded by address range.  If data was not usable by 
this format, address data was requested from the provider and geocoded as a reported 
address. 
 
Community Anchor Institutions –   Virginia’s CAI data has additional attribution to the 
NTIA data model due the source of the VA data set.  In conjunction with Virginia Tech 
holding speed tests in 2009 to receive download and upload speeds for locations across 
Virginia,  working with many statewide non spatial data sets, VGIN was able to geocode 
several sources into a singe CAI feature class.  This aggregate feature class was loaded 
into the round 1 NTIA transfer data model.  NTIA requested that the data model not be 
changed so unfortunately speed data was not reported since VT actual values for upload 
and download speeds populated as opposed to the requested advertised speeds.   
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In several joint efforts, CAI ID was added to the Virginia CAI data set by Virginia Tech and 
VGIN.  For the spring 2011 SBDD submission, VT aided in the incorporation of additional 
unreported federal ID values in the data.  VGIN received a CAI update from Virginia Tech 
in early September of 2011 which contained federal ID additions to the data for 
approximately 75 features which were not previously identified.  Theses values were 
conflated to the VGIN SDE CAI feature class by the spatial adjustment toolbar in ArcMap.  
Attributes were mapped in for CAI ID, and edit dates as well as edit comments were 
updated in the VA CAI data.  There were several hundred features in the VA Broadband 
SDE database which did not have appropriate latitude/longitude values so the data set 
was batch calculated with coordinate values for all features. 
 
In order to represent the data with 2010 census geography as requested by the NTIA for 
the fall 2011 SBDD submission, data was spatially joined to the 2010 census block data 
and updated in the SDE layer.  This was loaded to the transfer data model in the NTIA 
SBDD format.   
 
Middle Mile – The majority of providers do not send middle mile data. When it is received 
it is converted into a geodatabase table in the broadband provider’s staging geodatabase.  
An add XY function was performed in ArcMap and XY events were exported as a new 
feature class.  Inside the provider’s staging geodatabase, the NTIA SBDD data model 
feature class named BB_ConnectionPoint_MiddleMile was imported and renamed 
NTIA_middle_mile.  Data was either loaded to this feature class and all appropriate fields 
were calculated based on the XY event in order to load data spatially or if only a handful 
of points were provided the data was manually edited in an edit session.  Census blocks 
for 2010 GEOID value were spatially joined to the middle mile points after all provider 
who submitted middle mile data and carry over middle mile points were loaded. 
 
Pricing - If nominal weighted subscriber speed was available from a broadband provider, 
the data was placed into an excel spreadsheet for the fall 2011 submission which 
followed the format of requested text output information from NTIA.  It was then output 
to a requested tab delimited text file for the release.    All providers who had previously 
sent in pricing data but had not submitted an update for the fall 2011 release were 
carried over into the fall 2011 pricing spreadsheet. 
 
Speed based on CMA/MSA/RSA - If speed was available by cellular market area or 
MSA/RSA and provided to CIT and VGIN, this information was placed into a newly created 
SDE feature class which tracked the most current speed from a provider.  If the provider 
was a new or updated submission, the feature class was updated with the most recent 
speed data.  All archive speed data was located and custom areas of interest were added 
as polygons in this feature class. 
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Processing QC, Batch Calculation, & Loading 
 
While some provider data imported directly, where information for 2010 census 
geography was needed (Census Blocks, Middle Mile, Address Points) the feature of 
interest was imported and processed differently depending on the type of geography 
stored.  A new geodatabase was created called CB_SQ_Mile_Errors and was necessary for 
the storage of census blocks which reported errors in the conversion from 2000 to 2010 
census geography.  Not all providers submitted census blocks to the NTIA but those who 
did were validated with a field in the selection set census block layer which contained 
square mileage calculated on the VA Custom Lambert projection.  Another geodatabase 
was created called REPORTED_ERRORS_2010 and it tracked blocks sent by providers 
which were in fact greater than two square miles. 
 

 
 
For data reported as service addresses, several fields were required that could be 
calculated in batch. The FULLFIPSID was calculated to the address points by spatially 
joining points to the census blocks. Latitude and Longitude were calculated in ArcCatalog 
using the calculate geometry function. 
 
Only a few broadband providers who participated in the spring 2011 NTIA submittal 
provided Middle mile data.  Resultantly, the processing and aggregation of a middle mile 
data set was done outside of standard broadband provider data processing.   
 
Address Points, Road Centerlines, Census blocks, and Wireless Service polygons were 
processed as broadband provider data was received although middle mile information 
was a post processing step.  To create middle mile event data, the broadband providers 
that provided the information to CIT and VGIN generally included latitude and longitude 
of the facility and these values were used in ArcGIS with the add XY function.  After points 
were brought into ArcGIS, data was exported into a separate feature class and values 
were calculated based on information the broadband provider provided. 

 
Specific Broadband Provider Processing Methodology 
 
The following Broadband Providers submitted CIT data for the spring 2011 NTIA 
submission. It is assumed that the participating Broadband providers provided entire 
coverage as opposed to update only data sets unless otherwise noted.  Included are the 
methods used in updating the Virginia Broadband map data: 
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Broadband Provider FCC Registration Number 

AT&T Wireless 
CenturyLink 
Charter Communications, Inc. 
Comcast 
Covad Communications Company 
Cox Communications 
Cricket Communications, Inc. 
Level 3 Communications, LLC 
Northern Neck Wireless Internet Services, LLC 
NTELOS Inc. 
NTELOS (Richmond 20 MHz LLC) 
NTELOS (Virginia PCS Alliance, L.C.) 
NTELOS (West Virginia PCS Alliance, L.C.) 
NTELOS Telephone Inc. 
NTELOS Network Inc. 
Roanoke and Botetourt Telephone Company 
R&B Network Inc. 
RCN 
Shentel Cable Company 
Shentel Service Company 
Sprint Nextel Corporation 
Sunset Digital Communications Inc. 
T-Mobile 
TDS Telecom (Amelia Telephone Corporation) 
TDS Telecom (New Castle Telephone Company) 
TDS Telecom (Virginia Telephone Company) 
Time Warner Cable 
Verizon Wireline 

0004979233 
0018626853 
0017179383 
0004441663 
0003753753 
0001524461 
0002963528 
0003723822 
0017338054 
0005849518 
0001656180 
0002051720 
0002049328 
0002073138 
0003742442 
0003775244 
0003775301 
0003735016 
0018024075 
0013393988 
0003774593 
0000826322 
0006945950 
0002073526 
0003767399 
0002058261 
0013430244 
0002073203 

 
AT&T Wireless 
 
AT&T wireless provided geospatial data in the form of a coverage area shape file.    
Middle mile was included but the values reported were the same as reported in the 
spring 2011 submission.  Weighted speed was included but the document provided was 
for the state of Mississippi so it could not be used.   
 
Inside the shapefile provided by AT&T were over 1700 polygon records and every single 
record contained identical attribution.  The data appeared to be gridded for internal use.  
The data was imported into the provider’s staging geodatabase using the NTIA wireless 
schema. Polygons were merged into a single coverage polygon, and attributes were 
populated to match supporting documentation reported by AT&T.  Upon reviewing the 
documentation, the polygon did have two spectrums so a second polygon was created 



12  Virginia Broadband Data Submission, Fall 2011 

 
http://www.wired.virginia.gov/ 

based on copy and paste and coded to match the appropriate transmission technology 
spectrum.  After completion, the data was loaded into NTIA SBDD transfer data model 
reporting database.   
 
Provider Name:   AT&T Mobility, LLC 
DBA Name: AT&T Mobility, LLC 
FRN: 0004979233 
Transmission Technology 80 
VA Data Category: 7 
Wireless Polygons: 2 
2010 Census Blocks <2 Square miles: 0 
Address Point features: 0 
Road Centerline features: 0 
Middle Mile features: 1 
Community Anchor Institutions reported: 0 

 
Century Link 
 
CenturyLink provided geospatial data in the form of road centerlines and census blocks 
and reported to CIT that the census Geography was in 2010.  Middle mile and subscriber 
weighted speed were not included this round and were carried over from the most 
recent data submission into the speed SDE layer and pricing spreadsheet.  A staging 
geodatabase was created using selection Set Feature Classes for Street Centerlines and 
Census blocks.   
 
Census blocks less than two square miles were joined to the Selection Set Census block 
data using the FULLFIPSID text.  Inspecting the join, all features seemed to successfully 
pass through, signifying that the provider did in fact submit data in 2010 geometry.  The 
joined block data was output to new features.  Since the data associated to the blocks 
were named similarly to the NITA model data, they were calculated in the selection set 
export and then loaded into the NTIA transfer data model. 
 
In order to provide the Road Centerline data in Virginia’s geometry (VBMP RCL Quarter 2, 
2011), the road lines provided by Century Link were used in a select by location analysis.  
The Virginia Road Centerline Selection set was selected if the lines provided by 
CenturyLink were within 5 meters and then exported to a new feature class.  All values 
inside the Century Link roads were then used in select by location queries to conflate 
attributes.  This iteration of the roads was loaded into the NTIA transfer data model. 
 
Provider Name:   CenturyTel, Inc. 
DBA Name: CenturyLink 
FRN: 0018626853 
Transmission Technology 10 
VA Data Category: 1 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 28909 
Address Point features: 0 
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Road Centerline features: 14807 
Middle Mile features: 1 
Community Anchor Institutions reported: 0 

 
Charter 
 
Charter provided Geospatial data in the form of road centerlines and census blocks and 
reported to CIT that the census Geography was in 2010.  Subscriber weighted speed was 
not included this round and was carried over from the most recent data submission.  To 
date, middle mile data has not been received from this provider.  A new Personal 
geodatabase was created to represent the staging of this provider for the fall 2011 
release.  Selection Set Feature Classes for Street Centerlines and Census blocks were 
used.   
 
In order to provide the Road Centerline data in Virginia’s geometry (VBMP RCL Quarter 2, 
2011), the road lines provided by Charter were used in a select by location analysis.  The 
Virginia Road Centerline Selection Set was selected if the lines provided by Charter were 
within 5 meters and then exported to a new feature class.  All values inside the Charter 
roads were then used in select by location queries to conflate attributes.  This iteration of 
the roads was loaded into the reporting database. 
 
Charter also provided geospatial data in the form of census blocks less than two square 
miles.  These values were joined to the Selection Set Census block data by FULLFIPSID and 
after inspected, all features successfully joined signifying that Charter did report data in 
2010 geography.  The data was then output to a new feature class.  Since the data 
associated to the blocks were named similarly to the NITA model data, they were 
calculated in the selection set export and then into the NTIA transfer data model. 
 
Provider Name:   Charter Communications, Inc. 
DBA Name: Charter Communications, Inc. 
FRN: 0017179383 
Transmission Technology 41 
VA Data Category: 1 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 4670 
Address Point features: 0 
Road Centerline features: 804 
Middle Mile features: 0 
Community Anchor Institutions reported: 0 

 
Comcast 
 
Comcast provided census block and address number spreadsheets and reported to CIT 
that the geography used was in Census 2010.  Speed data was provided by region in a 
spreadsheet and the values inside were added to the Speed SDE feature class as regional 
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polygons.    A staging file geodatabase was created for this provider and the census block 
spreadsheet information was imported as a table.   
 
Comparing this submission to the last, there were several thousand blocks less in the 
data but over 35K records which was presumably the entire coverage data set and not an 
update of deltas only.  This FGDB table was joined to the 2010 selection set census blocks 
directly and all blocks did successfully join from the table to the feature, signifying that 
Comcast did report features in 2010 geography.  None of the census blocks reported 
were over two square miles.  The joined data was then exported to a new feature class.  
The features in this new layer were selected by location to the SDE speed feature class in 
order to apply maximum down and upload speeds which were reported in the speed 
spreadsheet. 
 
The address availability import table was geocoded using the VGIN address point geo-
locator.  Matched and Tied results were exported to a separate table and re-geocoded to 
the road centerline locator.  All RCL locator points were spatially joined to the Virginia 
RCL selection set and output to a separate feature class.  The address point and road 
centerline feature classes were then imported into the NTIA transfer data model. 
 
Provider Name:   Comcast Cable Communications, LLC 
DBA Name: Comcast 
FRN: 0004441663 
Transmission Technology 40, 41 
VA Data Category: 3 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 35719 
Address Point features: 12860 
Road Centerline features: 491 
Middle Mile features: 0 
Community Anchor Institutions reported: 0 

 
Covad Communications Company 
 
Covad provided Census Blocks, Address ranges, Middle Mile, subscriber pricing, and 
speed by region as text files. This data was normalized to spreadsheets.  CIT confirmed 
with the provider that the census geography used was in 2010.  A staging geodatabase 
was created and the spreadsheets were imported as feature class tables.  The pricing 
information was added directly from the imported spreadsheet to the provider aggregate 
pricing spreadsheet while the Middle mile and speed data were checked and no updates 
were necessary to make in the Middle mile point and Speed polygon feature classes so 
values were carried over from the spring 2011 submission.    
 
Covad provided different transmission technology speeds within the same geometric 
features so the output product need was stacked geometry.  In order to geographically 
represent the data this way, for Census Block and Address Segment data, transmission 
type was selected and a separate geodatabase table was exported for each.  There were 
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3 tables for Census Blocks created; 10, 20, & 30.  There were 3 tables for address ranges 
created; 10, 20, & 30.   Each of these were joined to the appropriate feature class 
individually, exported as a separate feature class, and then loaded to a single feature 
class per geometry. 
 
The census block text file contained varying transmission technologies. There were more 
records than Microsoft excel 2003 could handle so the import procedure to normalize the 
data was directly into an Access database.  To graphically represent the COVAD data, the 
imported Access table was added as a table in ArcMap and individual table selections 
were output for Transmission Technology type.  There were three output tables created 
and each table was individually joined to the selection set census block layer to verify 
record number counts.  The joins all were successful, signifying that the data was indeed 
in 2010 geography so they were exported to a separate feature class per table.  Typical 
Download and Upload speeds were on the feature through the join but Advertised was 
located in the speed information which was applied to the SDE Speed polygon layer so 
layers were selected individually to conflate the advertised speeds based on select by 
location. The three populated feature classes were loaded into a single feature class to 
represent block geography and this was loaded to the NITA transfer data model.    
 
Address Ranges did have TLID values inside of them so for each Address Table created, 
they were joined to the 2010 TIGER lines and then exported individually to a TIGER 
Feature class.  Each Tiger feature class was used in select by location to be within 5 
meters of the selection set Virginia Road Centerline data.  Three selection set feature 
classes were then output and attributes were populated individually.  The three line 
features were merged into a single feature of stacked geometries and this was loaded to 
the NTIA Transfer data model. 
 
Provider Name:   DIECA Communications, Inc. 
DBA Name: Covad Communications Company 
FRN: 0003753753 
Transmission Technology 10, 20 , 30 
VA Data Category: 2 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 123550 
Address Point features: 0 
Road Centerline features: 1769 
Middle Mile features: 6 
Community Anchor Institutions reported: 0 

 
Cox 
 
Cox provided text files of Address Availability, Census Blocks, Middle mile, weighted 
speeds, and speed by region.   These files were normalized into spreadsheets and 
imported as tables into the provider staging geodatabase. Weighted speed information 
was placed into the pricing spreadsheet directly.  Speed by region was used in creating 
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new polygons in the SDE speed layer.  Middle mile had no changes so values were carried 
over from the spring 2011 submission. 
 
Cox reported to CIT that their blocks were in 2010 census geography but when working 
with the census blocks first, the spreadsheet FIPS value was joined to the 2010 block 
feature class and only 13000 blocks achieved a result.  In total, there were over 25K 
blocks which were preliminarily joined to feature layers of XREF to 2010 block features.  
After this viewing of the data, they were assumed 2000 and the geodatabase table was 
joined to the 2000-2010 XREF table in ArcMap and only matched values were kept.  
These values were exported into a new table and then joined to the 2010 block selection 
set by GEOID.  The new feature class join was then exported to a new feature class and 
values were calculated based on joined features.  Where information was not present, 
the Speed SDE feature class was used by select by location and calculations were 
performed based on block centroid location in provider speed area.   Blocks were then 
exported to two feature classes based on the SQ_MI_VALAMBERT inside the selection set 
feature class; one which represented blocks less than two square miles and one which 
was blocks greater than two square miles. The feature class of blocks less than two 
square miles was loaded to the NTIA transfer data model and the feature class of blocks 
greater than two square miles was loaded to the reported_error block feature class.  
 
The Cox address availability import table was geocoded to the VGIN address point geo-
locator and the output data provided was the same XY as the address point.   Matched 
points were spatially joined to the selection set address point data.  Unmatched and Tied 
results were exported to a separate table and re-geocoded to the road centerline locator.  
All RCL locator points were spatially joined to the Virginia RCL selection set and output to 
a separate feature class.  Using the speed SDE layer, missing values were calculated for 
both address points and road centerlines.  The address point and road centerline feature 
classes were then imported into the NTIA transfer data model. 
 
Provider Name:   CoxCom Inc. 
DBA Name: Cox Communications 
FRN: 0001524461 
Transmission Technology 40 
VA Data Category: 1, 3 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 25140 
Address Point features: 2558 
Road Centerline features: 195 
Middle Mile features: 4 
Community Anchor Institutions reported: 0 
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Cricket 
 
Cricket provided Geospatial data in the form of a coverage area shape file. Middle mile 
data was not included. The shape file had all of the fields needed to load into the NTIA 
model therefore no additional information was needed.  The GIS shape file was copied 
and pasted into the provider staging geodatabase feature class and attributes were 
populated and checked against the source data.  After completion, the data was loaded 
into NTIA SBDD transfer data model reporting database.   
 
Provider Name:   Leap Wireless International, Inc. 
DBA Name: Cricket Communications, Inc. 
FRN: 0002963528 
Transmission Technology 80 
VA Data Category: 7 
Wireless Polygons: 1 
2010 Census Blocks <2 Square miles: 0 
Address Point features: 0 
Road Centerline features: 0 
Middle Mile features: 0 
Community Anchor Institutions reported: 0 

 
Level 3 
 
Level 3 provided text files of address availability and middle mile points for the fall 2011 
submission.  A staging geodatabase was created for the provider and both text files were 
imported for normalization.  Address availability import table was geocoded to the VGIN 
address point geo-locator.  Matched and Tied results were exported to a separate table 
and re-geocoded to the road centerline locator.  All RCL locator points were spatially 
joined to the Virginia RCL selection set and output to a separate feature class.  The 
address point and road centerline feature classes were then imported into the NTIA 
transfer data model. 
 
Middle mile data was added as XY events and exported using the same coordinate system 
as the NTIA SBDD layers.  It was then imported into a feature class which replicated the 
middle mile schema of the NTIA transfer data model and cleaned.  This was then loaded 
into the NTIA Transfer data model.  
 
Provider Name:   Level 3 Communications, LLC 
DBA Name: Level 3 Communications, LLC 
FRN: 0003723822 
Transmission Technology 50 
VA Data Category: 6 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 0 
Address Point features: 581 
Road Centerline features: 106 
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Middle Mile features: 436 
Community Anchor Institutions reported: 0 

 
 
 
Northern Neck Wi-Fi 
 
Northern Neck Wireless provided its submission for the fall 2011 release in the form of 
address level data even though they are a wireline provider.  Based on NTIA feedback and 
the transmission technology type of the provider, Virginia Tech developed a radio tower 
propagation model for the spring 2011 SBDD data release to be used in reporting instead 
of address level point or road centerline data.  For detailed processing information, 
please review the spring 2011 SBDD reporting documentation.  The address level data for 
the fall 2011 release was geocoded and points were used in verification of accuracy of 
the polygon data based on the centroid of the point.   
 
Many addresses that were geocoded fell outside of the model generated for the previous 
release.  All address and RCL point matches through the history of submission of 
Northern Neck Wi-Fi were merged together in a single point layer.  Points were selected 
if their centroid fell within the propagation model polygon, and then results were 
switched to find all features outside of the polygon.  Many customer addresses points 
were found outside of the tower extents (polygons).  Buffers of 500 meters were created 
around the points since the original VA broadband map from 2008 was generated for 
statewide visualization of 500 meter buffers.  The polygon buffers were all merged 
together in a single polygon and loaded to the SBDD wireless polygon feature class in the 
transfer data model.  The carryover polygon information from spring 2011 was loaded 
into the transfer data model as well. 
 
Provider Name:   Northern Neck Wireless Internet Services, LLC 
DBA Name: Northern Neck Wireless Internet Services, LLC 
FRN: 0017338054 
Transmission Technology 70 
VA Data Category: 8 
Wireless Polygons: 2 
2010 Census Blocks <2 Square miles: 0 
Address Point features: 0 
Road Centerline features: 0 
Middle Mile features: 0 
Community Anchor Institutions reported: 0 

 
 
NTELOS Wireless 
 
NTELOS and its numerous provider names submitted to Geospatial data in the form of a 
coverage area shape file. Middle mile data was not included. Inside the shapefile 
provided by NTELOS were four polygon records; one polygon for each different FRN.  The 



19  Virginia Broadband Data Submission, Fall 2011 

 
http://www.wired.virginia.gov/ 

structure had all of the fields needed to load into the NTIA model therefore no additional 
information was needed.  The NTELOS GIS shape file was copied and pasted into the 
provider staging geodatabase feature class and attributes were populated and checked 
against the source data.  After completion, the data was loaded into NTIA SBDD transfer 
data model.   
 
Provider Name:   NTELOS Inc. 
DBA Name: NTELOS 
FRN: 0005849518 
Transmission Technology 80 
VA Data Category: 7 
Wireless Polygons: 1 
2010 Census Blocks <2 Square miles: 0 
Address Point features: 0 
Road Centerline features: 0 
Middle Mile features: 0 
Community Anchor Institutions reported: 0 

 
 
Provider Name:   

 
Richmond 20 MHz LLC 

DBA Name: NTELOS 
FRN: 0001656180 
Transmission Technology 80 
VA Data Category: 7 
Wireless Polygons: 1 
2010 Census Blocks <2 Square miles: 0 
Address Point features: 0 
Road Centerline features: 0 
Middle Mile features: 0 
Community Anchor Institutions reported: 0 

 
Provider Name:   Virginia PCS Alliance, L.C. 
DBA Name: NTELOS 
FRN: 0002051720 
Transmission Technology 80 
VA Data Category: 7 
Wireless Polygons: 1 
2010 Census Blocks <2 Square miles: 0 
Address Point features: 0 
Road Centerline features: 0 
Middle Mile features: 0 
Community Anchor Institutions reported: 0 
 
Provider Name:   West Virginia PCS Alliance, L.C. 
DBA Name: NTELOS 
FRN: 0002049328 
Transmission Technology 80 
VA Data Category: 7 
Wireless Polygons: 1 
2010 Census Blocks <2 Square miles: 0 
Address Point features: 0 
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Road Centerline features: 0 
Middle Mile features: 0 
Community Anchor Institutions reported: 1 

 
 
NTELOS Wireline 
 
NTELOS provided text files of Address Availability, Census Blocks, and subscriber 
weighted speed for the Fall 2011 data inclusion.  These files were normalized into 
spreadsheets for usage. The pricing information was directly placed into the pricing 
spreadsheet. The master address and census blocks spreadsheets were imported into the 
provider staging database as tables. While there were no updates for speed information 
by region, the speed SDE layer was updated with data from the spring 2011 submission to 
use in selections.  Addresses that were reported appeared to be updates only so a master 
spreadsheet of this provider was carried over from the last submission to this new 
submission server directory and the updates were added to the master address 
spreadsheet.  Middle mile information was carried over from the spring 2011 submission. 
 
NTELOS reported to CIT that their blocks were in 2010 census geography but when 
working with the census blocks first, the spreadsheet FIPS value was joined to the 2010 
block feature class and approximately 1000 blocks were unmatched.  This signified that 
the blocks reported may have been sent in 2000 geography or a geography different than 
2010.  Due to the unmatched joins, NTELOS blocks were assumed 2000 geography and 
the geodatabase table was joined to the 2000-2010 XREF table in ArcMap and only 
matched values were kept.  These values were exported into a new table and then joined 
to the 2010 block selection set by GEOID.  The new feature class join was then exported 
to a new feature class and values were calculated based on joined features.  Where 
information was not present, the Speed SDE feature class was used by select by location 
and calculations were performed based on block centroid location in provider speed area.   
Blocks were then exported to two feature classes based on the SQ_MI_VALAMBERT 
inside the selection set feature class; one which represented blocks less than two square 
miles and one which contained a small subset of blocks greater than two square miles. 
The feature class of blocks less than two square miles was loaded to the NTIA transfer 
data model and the feature class of blocks greater than two square miles was loaded to 
the reported_error block feature class.  
 
The address availability import table was updates only so a master spreadsheet carried 
over from the last submission of NTELOS addresses was updated with the changes which 
were provided.  This was geocoded to the VGIN address point geo-locator and the output 
data provided was the same XY as the address point.  Matched and Tied results were 
exported to a separate table and re-geocoded to the road centerline locator.  All RCL 
locator points were spatially joined to the Virginia RCL selection set and output to a 
separate feature class.  Using the speed SDE layer, missing values were calculated for 
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both address points and road centerlines.  The address point and road centerline feature 
classes were then imported into the NTIA transfer data model. 
 
Provider Name:   NTELOS Inc. 
DBA Name: NTELOS Telephone Inc. 
FRN: 0002073138 
Transmission Technology 10, 50 
VA Data Category: 3 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 3260 
Address Point features: 6462 
Road Centerline features: 1263 
Middle Mile features: 2 
Community Anchor Institutions reported: 0 

 
Provider Name:   NTELOS Inc. 
DBA Name: NTELOS Network Inc. 
FRN: 0003742442 
Transmission Technology 10, 50 
VA Data Category: 3 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 1946 
Address Point features: 1768 
Road Centerline features: 295 
Middle Mile features: 50 
Community Anchor Institutions reported: 0 

 
Provider Name:   NTELOS Inc. 
DBA Name: Roanoke and Botetourt Telephone Company 
FRN: 0003775244 
Transmission Technology 10, 50 
VA Data Category: 3 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 1297 
Address Point features: 3508 
Road Centerline features: 121 
Middle Mile features: 1 
Community Anchor Institutions reported: 0 

 
Provider Name:   NTELOS Inc. 
DBA Name: R&B Network Inc. 
FRN: 0003775301 
Transmission Technology 10 
VA Data Category: 3 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 1019 
Address Point features: 469 
Road Centerline features: 171 
Middle Mile features: 13 
Community Anchor Institutions reported: 0 
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RCN 
 
RCN provided a spreadsheet of address availability and middle mile points for the fall 
2011 submission.  A provider staging geodatabase was created and both files were 
imported as tables for normalization.  The Address availability import table was geocoded 
to the VGIN address point geo-locator.  Matched and Tied results were kept, while 
unmatched results were exported to a separate table in the geodatabase.  All RCL locator 
points were spatially joined to the Virginia RCL selection set and output to a separate 
feature class.  The address point and road centerline feature classes were then imported 
into the NTIA transfer data model. 
 
Middle mile data was added as XY events and exported using the same coordinate system 
as the NTIA SBDD layers.  After viewing the data, it appeared the points were not valid 
coordinates so addresses were geocoded and XY points were created and checked to the 
source.  The middle mile data extracted from addresses was then imported into a feature 
class which replicated the middle mile schema of the NTIA transfer data model while data 
was cleaned and calculated.  This was then loaded into the NTIA Transfer data model.  
 
Provider Name:   Starpower Communications, LLC 
DBA Name: RCN 
FRN: 0003735016 
Transmission Technology 40 
VA Data Category: 6 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 0 
Address Point features: 2038 
Road Centerline features: 0 
Middle Mile features: 2 
Community Anchor Institutions reported: 0 

 
Shentel 
 
Shentel provided a spreadsheet for Shentel Cable Company and Shentel Service Company 
and within each spreadsheet was a tab for address availability, a tab for census block 
availability, and a tab for Speed information.  Middle mile and pricing was not submitted 
at this point in time.  The speed information provided was used in updating the SDE 
speed layer.  Two new staging geodatabases were created for both Shentel FRNs and 
tables were imported into the geodatabase of interest from the original excel tab.   
 
Census block information was reported in 2000 geography to CIT so the imported block 
data was joined the 2000-2010 XREF table in ArcMap and only matched values were kept.  
These values were exported into a new table and then joined to the 2010 block selection 
set by GEOID.  The new feature class join was then exported to a new feature class and 
values were calculated based on joined features.  Blocks were then verified for 
appropriate square mileage in the geography conversion and exported to two feature 
classes based on the SQ_MI_VALAMBERT inside the selection set feature class; one which 
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represented blocks less than two square miles and one which was blocks greater than 
two square miles. The feature class of blocks less than two square miles was loaded to 
the NTIA transfer data model and the feature class of blocks greater than two square 
miles was loaded to the Conversion_Error block feature class.  
 
The address import data did have TLID available as a column Shentel’s data.  In order to 
provide the Road Centerline data in Virginia’s geometry (VBMP RCL Quarter 2, 2011), the 
imported tables for address ranges based on Shentel FRN numbers were joined to the 
2009 tiger lines since it was presumed they were not using 2010 geography for lines.  The 
joins were output to new feature classes and they were used in a select by location 
analysis.  The Virginia Road Centerline Selection set was selected if the lines provided by 
Shentel TLID lines were within 5 meters and then exported to a new feature class.  All 
values inside the Shentel roads were then used in select by location queries to conflate 
attributes.  This iteration of the roads was loaded into the reporting database. 
 
Provider Name:   Shentel Cable Company 
DBA Name: Shentel 
FRN: 0018024075 
Transmission Technology 40 
VA Data Category: 2 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 11209 
Address Point features: 0 
Road Centerline features: 3587 
Middle Mile features: 0 
Community Anchor Institutions reported: 0 

 
Provider Name:   Shentel Service Company 
DBA Name: Shentel 
FRN: 0013393988 
Transmission Technology 10 
VA Data Category: 2 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 2153 
Address Point features: 0 
Road Centerline features: 1188 
Middle Mile features: 0 
Community Anchor Institutions reported: 0 

 
Sprint 
 
Sprint provided Geospatial data in the form of a coverage area shape file.    Middle mile 
was included.  The shapefile contained two records and the structure had all of the fields 
needed to load into the NTIA model therefore no additional information was needed. 
 
The GIS shape file was loaded into the provider staging geodatabase feature class and 
FRN information was scrubbed to match the NTIA number reporting format.  The data 
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was then loaded into the Transfer Data Model.   Middle mile information did not appear 
to change any attribution so it was loaded from the spring 2011 transfer data model. 
 
Provider Name:   Sprint Nextel Corporation 
DBA Name: Sprint 
FRN: 0003774593 
Transmission Technology 80 
VA Data Category: 7 
Wireless Polygons: 2 
2010 Census Blocks <2 Square miles: 0 
Address Point features: 0 
Road Centerline features: 0 
Middle Mile features: 2 
Community Anchor Institutions reported: 0 

 
 
Sunset Digital 
 
Sunset Digital was a first time provider for the fall 2011 SBDD submission and provided 
Geospatial data in the form of road centerlines and census blocks.  The provider reported 
to CIT that the census Geography was in 2010 and VGIN provided them a road centerline 
data set for usage in reporting.   Middle mile was included this round as text files 
although there may be potential to receive future middle mile submissions in a geospatial 
format.  A new personal geodatabase was created to represent the staging of this 
provider for the fall 2011 release.  Selection Set Feature Classes for Street Centerlines and 
Census blocks were used.   
 
Census blocks less than two square miles were joined to the Selection Set Census block 
data using the FULLFIPSID text.  Inspecting the join, all features seemed to successfully 
pass through, signifying that the provider did in fact submit data in 2010 geometry.  The 
joined block data was output to new features.  Since the data associated to the blocks 
were named similarly to the NITA model data, they were calculated in the selection set 
export and then into the NTIA transfer data model directly. 
 
Sunset Digital provided road centerline segments to CIT and VGIN in the Virginia Road 
Centerline geometry.  The submission data included the VA unique ID for road segments.  
The V_LEID was joined to the selection set road centerline data V_LEID and only matching 
records were used.  After records were verified, a 100% match rate between the two 
data sets was achieved.  Road centerlines were then output to a staging feature class and 
then calculated.  The staging feature class was then loaded to the transfer data model. 
 
Provider Name:   Sunset Digital Communications Inc. 
DBA Name: Sunset Digital Communications Inc. 
FRN: 0000826322 
Transmission Technology 50 
VA Data Category: 1 
Wireless Polygons: 0 
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2010 Census Blocks <2 Square miles: 1522 
Address Point features: 0 
Road Centerline features: 778 
Middle Mile features: 20 
Community Anchor Institutions reported: 0 

 
 
T-Mobile 
 
T-mobile provided geospatial data in the form of three coverage area shapefiles.    In the 
supporting documentation, T-mobile explained attribute values for each polygon feature 
class.  Middle mile and pricing information was included but the values reported were the 
same as reported in the spring 2011 submission and were carried over into the new 
transfer model.   
 
The shapefiles provided by T-mobile were named UMTS, HSPA 21, & HSP 42 and inside 
each shapefile were several thousand records with every single record in each feature 
class containing identical attribution.  The data appeared to be gridded for internal use.  
The three shapefiles were imported into the provider’s staging geodatabase. The 
polygons were merged into a single coverage polygon in the individual staging feature 
class, and attributes were populated to match supporting documentation provided by T-
mobile.  After completion, each feature class was loaded into the NTIA transfer data 
model.   
 
Provider Name:   T-Mobile USA, Inc. 
DBA Name: T-Mobile 
FRN: 0006945950 
Transmission Technology 80 
VA Data Category: 7 
Wireless Polygons: 3 
2010 Census Blocks <2 Square miles: 0 
Address Point features: 0 
Road Centerline features: 0 
Middle Mile features: 1 
Community Anchor Institutions reported: 0 

 
 
TDS Telecom 
 
TDS Telecom provided text files of Address Availability, Middle mile, and weighted 
speeds.   These files were normalized into spreadsheets.  The master address and middle 
mile spreadsheets were imported into the provider staging geodatabase as tables. The 
weighted speed information was placed into the pricing spreadsheet directly.  
Comparison of the middle mile data to the spring 2011 release, revealed no changes so 
values were carried over from the spring data set.  Review of the address level data 
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revealed there were transmission technologies reported for 10 and 50. Each of these 
technologies was exported into a separate table to geocode. 
 
The address availability import tables for each technology were geocoded to the VGIN 
address point geo-locator and the output data provided is the same XY as the address 
point.  Matched and Tied results were exported to a separate table and re-geocoded to 
the road centerline locator.  All RCL locator points were spatially joined to the Virginia 
RCL selection set and output to a separate feature class.   When previewing the source 
TDS Telecom data, there were many values where max advertised and typical down and 
up were significantly lower than max and typical up so values were standardized based 
on average values.  In the TDS Telecom data, Max advertized seemed to be equal to 
typical up and down so both typical values were calculated based on max advertised.  
Data for points and address ranges were loaded to the transfer data model.  
 
Provider Name:   Amelia Telephone Corporation 
DBA Name: TDS Telecom 
FRN: 0002073526 
Transmission Technology 10, 50 
VA Data Category: 6 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 0 
Address Point features: 0 
Road Centerline features: 568 
Middle Mile features: 1 
Community Anchor Institutions reported: 0 

 
Provider Name:   New Castle Telephone Company 
DBA Name: TDS Telecom 
FRN: 0003767399 
Transmission Technology 10 
VA Data Category: 6 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 0 
Address Point features: 1349 
Road Centerline features: 97 
Middle Mile features: 1 
Community Anchor Institutions reported: 0 

 
Provider Name:   Virginia Telephone Company 
DBA Name: TDS Telecom 
FRN: 0002058261 
Transmission Technology 10, 50 
VA Data Category: 6 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 0 
Address Point features: 997 
Road Centerline features: 72 
Middle Mile features: 1 
Community Anchor Institutions reported: 0 
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Time Warner Cable 
 
Time Warner provided Geospatial data in the form of road centerlines and census blocks 
and reported to CIT that the census Geography was in 2010.  Middle mile and subscriber 
weighted speed were not included this round.   
 
Working in the provider staging database, census blocks less than two square miles were 
joined to the Selection Set Census block data using the FIPS number text fields.  
Inspecting the join, all features seemed to successfully pass through, signifying that the 
provider did in fact submit data in 2010 geometry.  None of the blocks provided were 
over two square miles.  The joined block data was output to a new feature class.  Fields 
were calculated in the selection set export to match Time Warner fields and then the 
feature class was loaded into the NTIA transfer data model. 
 
In order to provide the Road Centerline data in Virginia’s geometry (VBMP RCL Quarter 2, 
2011), the road lines provided by Time Warner were used in a select by location analysis.  
The Virginia Road Centerline Selection set was selected if the lines provided by Time 
Warner were within 5 meters and then exported to a new feature class.  The values for all 
road segments were the same so values from the selection road centerline set were 
manually calculated to match the provided roads.  This iteration of the roads was loaded 
into the reporting database. 
 
Provider Name:   Time Warner Cable 
DBA Name: Time Warner Cable 
FRN: 0013430244 
Transmission Technology 41 
VA Data Category: 1 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 3282 
Address Point features: 0 
Road Centerline features: 2126 
Middle Mile features: 0 
Community Anchor Institutions reported: 0 

 
 
Verizon Wireline 
 
Verizon Wireline provided text files for census block availability, address range availability 
with TLID, and a spreadsheet of Middle Mile information by addresses.   The text files 
were exported to excel files and loaded into the provider staging geodatabase as tables. 
The middle mile information was geocoded to the state address point locator and output 
to a feature class, and then loaded into the transfer data model middle mile feature class.   
Speed data was not reported this round but the SDE speed feature class was updated 
with Verizon’s speed data from the spring 2011 submission.  
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Census block information was reported in 2010 geography to CIT and a Verizon reported 
dual transmission technology types.  An initial join of the Verizon census block table to 
the 2010 blocks showed that several thousand records were filtered out by the join.  A 
frequency was performed on the provided census block FIPS id to see if any duplicate 
records were present signifying potential transmission technology overlap and there 
were several thousand.  Block information was then exported to two Transmission 
technology type tables; one for DLS and one for FIOS.  These tables were individually 
joined to the 2010 census blocks in order to achieve exact record matches. The joins were 
exported to new feature classes and values were calculated based on joined features.  
Blocks were then verified for appropriate square mileage in the geography conversion 
and exported to two feature classes per transmission technology type based on the 
SQ_MI_VALAMBERT inside the selection set feature class.  Blocks greater than two 
square miles that were erroneously reported were exported and loaded to the reported 
error feature class.  The remaining blocks less than two square miles was loaded to the 
NTIA transfer data model. 
 
The address import data did have TLID available as a column Verizon’s data.    Since 
census block transmission technology represented multiple areas, the Transmission 
Technology type for addresses reported was separated into two geodatabase tables for 
DSL and for FIOS.  In order to provide the Road Centerline data in Virginia’s geometry 
(VBMP RCL Quarter 2, 2011), individual transmission technology tables were joined to the 
2010 tiger lines since Verizon reported 2010 data.  The joins were output to new feature 
classes and they were used in a select by location analysis.  The Virginia Road Centerline 
Selection set was selected if the lines provided by Verizon TLID joined lines were within 5 
meters and then exported to a new feature class.  All values inside the Verizon roads 
were then used in select by location queries to conflate attributes.  This iteration of the 
roads was loaded into the reporting database. 
 
Provider Name:   Verizon Virginia Inc. 
DBA Name: Verizon Virginia Inc. 
FRN: 0002073203 
Transmission Technology 10, 50 
VA Data Category: 2 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 110765 
Address Point features: 0 
Road Centerline features: 15635 
Middle Mile features: 12 
Community Anchor Institutions reported: 0 

 
Many providers did not submit updates for the fall 2011 so their data from the spring 
2011 SBDD transfer model was carried over.  A new staging geodatabase was created 
which represented providers who did not send updates and the schema matched the 
transfer data model.  Providers who did not submit an update were selected by FRN from 
the spring 2011 NTIA SBDD submittal.  The following broadband providers are 
participants in the VA SBDD project but did not indicate having updates and were loaded 
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into the address point, road centerline, and middle mile carryover feature classes directly 
without the need of a data rework: 
 

Broadband Provider FCC Registration Number 

BVU OptiNet 
Burkes Garden Telephone Company 

0006823991 
0004942819 

Citizens Cablevision Inc. 0009485343 
Citizens Telephone Cooperative 0004381422 
Highland Telephone Cooperative 0004318846 
FairPoint Communications 0002071116 
MGWnet 
Midatlantic Broadband Cooperative 

0019225366 
0019765304 

New Hope Telephone Cooperative 0002071579 
Roadstar Internet, Inc. 0013445358 
Scott County Telephone Cooperative 0002069862 
Verizon Wireless 0003290673 
Virginia Mountain Micro 0018713800 

 
BVU OptiNet 
Provider Name:   BVU 
DBA Name: OptiNet 
FRN: 0006823991 
Transmission Technology 50 
VA Data Category: 6 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 0 
Address Point features: 2313 
Road Centerline features: 1813 
Middle Mile features: 0 
Community Anchor Institutions reported: 0 

 
Burkes Garden Telephone Company 
Provider Name:   Burke’s Garden Telephone Company, Inc. 
DBA Name: Burke’s Garden Telephone Company, Inc. 
FRN: 0004942819 
Transmission Technology 10 
VA Data Category: 6 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 0 
Address Point features: 107 
Road Centerline features: 68 
Middle Mile features: 1 
Community Anchor Institutions reported: 0 

 
Citizens 
Provider Name:   Citizens Cablevision, Inc. 
DBA Name: Citizens 
FRN: 0009485343 
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Transmission Technology 41 
VA Data Category: 6 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 0 
Address Point features: 525 
Road Centerline features: 245 
Middle Mile features: 0 
Community Anchor Institutions reported: 0 

 
Provider Name:   Citizens Telephone Cooperative 
DBA Name: Citizens 
FRN: 0004381422 
Transmission Technology 10, 41 
VA Data Category: 6 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 0 
Address Point features: 6081 
Road Centerline features: 2408 
Middle Mile features: 0 
Community Anchor Institutions reported: 0 

 
Highland Telephone Cooperative 
Provider Name:   Highland Telephone Cooperative 
DBA Name: Highland Telephone Cooperative 
FRN: 0004318846 
Transmission Technology 10 
VA Data Category: 6 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 0 
Address Point features: 1049 
Road Centerline features: 306 
Middle Mile features: 0 
Community Anchor Institutions reported: 0 

 
FairPoint Communications 
Provider Name:   Peoples Mutual Telephone Company 
DBA Name: FairPoint Communications 
FRN: 0002071116 
Transmission Technology 10 
VA Data Category: 6 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 0 
Address Point features: 6360 
Road Centerline features: 969 
Middle Mile features: 0 
Community Anchor Institutions reported: 0 

 
MGW Networks 
Provider Name:   MGW Networks, LLC 
DBA Name: MGW Networks, LLC 
FRN: 0019225366 



31  Virginia Broadband Data Submission, Fall 2011 

 
http://www.wired.virginia.gov/ 

Transmission Technology 10 
VA Data Category: 6 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 0 
Address Point features: 375 
Road Centerline features: 21 
Middle Mile features: 0 
Community Anchor Institutions reported: 0 

 
MidAtlantic Broadband Cooperative 
Provider Name:   Mid-Atlantic Broadband Cooperative 
DBA Name: MBC 
FRN: 0019765304 
Transmission Technology 50 
VA Data Category: 6 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 0 
Address Point features: 77 
Road Centerline features: 75 
Middle Mile features: 0 
Community Anchor Institutions reported: 0 

 
New Hope Telephone Cooperative 
Provider Name:   New Hope Telephone Cooperative 
DBA Name: New Hope Telephone Cooperative 
FRN: 0002071579 
Transmission Technology 10 
VA Data Category: 6 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 0 
Address Point features: 0 
Road Centerline features: 1210 
Middle Mile features: 0 
Community Anchor Institutions reported: 0 

 
Roadstar Internet, Inc. 
Provider Name:   Roadstar Internet Inc. 
DBA Name: Roadstar Internet Inc. 
FRN: 0013445358 
Transmission Technology 71 
VA Data Category: 8 
Wireless Polygons: 1 
2010 Census Blocks <2 Square miles: 0 
Address Point features: 0 
Road Centerline features: 0 
Middle Mile features: 0 
Community Anchor Institutions reported: 0 

 
Scott County Telephone Cooperative 
Provider Name:   Scott County Telephone Cooperative 
DBA Name: SCTC 



32  Virginia Broadband Data Submission, Fall 2011 

 
http://www.wired.virginia.gov/ 

FRN: 0002069862 
Transmission Technology 10, 50 
VA Data Category: 6 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 0 
Address Point features: 8583 
Road Centerline features: 1847 
Middle Mile features: 0 
Community Anchor Institutions reported: 0 

 
Verizon Wireless 
Provider Name:   Cellco Partnership and its Affiliated Entities 
DBA Name: Verizon Wireless 
FRN: 0003290673 
Transmission Technology 80 
VA Data Category: 7 
Wireless Polygons: 2 
2010 Census Blocks <2 Square miles: 0 
Address Point features: 0 
Road Centerline features: 0 
Middle Mile features: 0 
Community Anchor Institutions reported: 0 

 
Virginia Mountain Micro 
Provider Name:   Virginia Mountain Micro 
DBA Name: VMMicro 
FRN: 0018713800 
Transmission Technology 71 
VA Data Category: 7 
Wireless Polygons: 1 
2010 Census Blocks <2 Square miles: 0 
Address Point features: 0 
Road Centerline features: 0 
Middle Mile features: 0 
Community Anchor Institutions reported: 0 

 
The provider information was seamlessly added although with the 2010 census block 
request from the NTIA, several steps were needed to update point data with the GEOID 
values of 2010 blocks.    
 
To populate the appropriate data with 2010 census block information, carryover address 
point and middle mile point data for theses providers was spatially joined to the 2010 
census block polygons and the FIPS code of the block added to each point was calculated 
with the 2010 GEOID value for the block.  
 
In general, census blocks from carry over providers were assumed to be delivered in 2000 
geography since the 2010 TIGER data was unavailable before these providers would have 
sent data to CIT so they were joined to the 2000 XREF table and output non-spatially.  
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This non-spatial table was joined to the 2010 Selection Set and fields were populated for 
the model.   
 
The following providers were reprocessed using the source data and 2010 block 
conversion methodology or a separate effort to rework their information.  Specific 
processing details are included by provider: 
 

Broadband Provider FCC Registration Number 

Buggs Island 0002031698 
Metrocast Communications 0018547471 
Nelson Cable 0000900287 
Nextlink Wireless, Inc. 0014286934 

The Wired Road 0020153854 
XO Communications, LLC 0006275945 

 
 
BIT Communications 
 
BIT Communications’ had only submitted one piece of data and the receipt was for the 
round 1, spring 2010, submission to the NTIA. The provider sent an excel spreadsheet 
with census blocks.  Although blocks were included in the original submission to CIT and 
VGIN, they had not been included in previous submissions to the NTIA.  The original 
methodology for providing BIT Communications data was selecting all address points and 
road centerlines that fell within the blocks and then send to NTIA.  With some additional 
validation, this provider’s data was worked and submitted in a presumably more accurate 
format.  A new BIT Communications geodatabase was created in a carryover directory for 
providers who needed census block conversion. 
 
The spreadsheet BIT communications submitted was in 2000 geography.  This data was 
joined to the 2010 XREF table by FIPS and then exported to a new table.  The new table 
was joined to the 2010 census blocks by GEOID and the resulting join was exported to a 
new feature class.  There were many blocks included that were greater than two square 
miles so everything greater than two was removed from the feature class based on the 
SQ_MI_VALAMBERT field and loaded to the CB_SQ_MI_Error geodatabase for 
conversions.  Roads that and address points that were carried over from the spring 
submission were selected by location to the new census blocks less than two square 
miles.  If the address point or road centerline’s centroid fell within the feature, it was 
removed completely.  Three feature types were loaded to the carryover geodatabase. 
 
Provider Name:   Buggs Island Telephone Cooperative 
DBA Name: BIT Communications 
FRN: 0002031698 
Transmission Technology 10 
VA Data Category: 5 
Wireless Polygons: 0 
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2010 Census Blocks <2 Square miles: 2290 
Address Point features: 807 
Road Centerline features: 191 
Middle Mile features: 0 
Community Anchor Institutions reported: 0 

 
MetroCast 
 
MetroCast had only submitted one piece of data and the receipt was for the round 1, 
spring 2010, submission to the NTIA. In the preliminary mapping from 2008-2009, the 
provider sent a hard copy map which showed road centerline coverage.  The block 
spreadsheet showed no information so address point and road centerline data was 
initially converted to match coverage area.  This resulted in census blocks less than two 
square miles reporting additional features erroneously 
 
In order to present this provider in census blocks with 2010 geography, the selection set 
census blocks were selected within 1 meter of address points.  These blocks were 
exported to a feature class and all blocks greater than two square miles were filtered out 
based on attribute selection.  Address points and road centerlines were used with the 
blocks less than two square miles.  If a point centroid fell within a block less than two 
square miles, it was removed.  Centerline centroids that fell within a block less than two 
square miles were removed as well.  All new points, roads, and census block features 
were loaded to the carryover geodatabase. 
 
Provider Name:   Gans Communications, LP 
DBA Name: MetroCast Communications 
FRN: 0018547471 
Transmission Technology 41 
VA Data Category: 4 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 368 
Address Point features: 1782 
Road Centerline features: 546 
Middle Mile features: 0 
Community Anchor Institutions reported: 0 
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Nelson Cable 
 
Nelson Cable originally submitted census block data via e-mail for the spring 2010 release 
and also provided actual addresses for where service was provided, duplicating coverage 
efforts.  The original processed submission from Virginia to the NTIA was in address 
points and road centerlines only since these were the most granular data sets although 
the features covered areas where census blocks were less than two square miles.  In 
order to provide data to the NTIA more along the lines of geometric format, the data was 
reworked with 2010 blocks to match coverage area.  A new Nelson Cable geodatabase 
was created in a carryover directory for providers who needed census block conversion. 
 
Blocks provided by Nelson Cable from the spring 2010 submission were selected and 
joined to the 2000 census blocks.  These blocks were joined to the 2000-2010 XREF table 
and only matching records were kept.  These matches were exported to a new table and 
the joined directly to the 2010 census blocks.  All blocks greater than two square miles 
were filtered and exported to the conversion error feature class.  Address points and 
road centerlines were used with the blocks less than two square miles.  If a point centroid 
fell within a block less than two square miles, it was removed.  Centerline centroids that 
fell within a block less than two square miles were removed as well.  All new points, 
roads, and census block features were loaded to the carryover geodatabase. 
 
Provider Name:   Wintergreen Community CableVision 
DBA Name: Nelson Cable Inc. 
FRN: 0000900287 
Transmission Technology 41 
VA Data Category: 3 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 66 
Address Point features: 1318 
Road Centerline features: 64 
Middle Mile features: 0 
Community Anchor Institutions reported: 0 

 
 
Nextlink Wireless, Inc. 
 
NextLink’s original data submission was for the spring 2010 release.  The provider 
originally sent CIT and VGIN a spreadsheet of census block numbers only.  A staging 
geodatabase for this provider was created in the carryover provider directory and the 
original spreadsheet was imported as a table.  The table was joined to the 2000-2010 
cross reference table in ArcMap and results were exported a new table.  The new table 
was joined to the 2010 census block data and exported to a new feature class.  Fields in 
the data were calculated based on previous NTIA submissions.  No reported blocks were 
greater than two square miles so the data was loaded to the provider carryover 
geodatabase. 
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Provider Name:   Nextlink Wireless, Inc. 
DBA Name: Nextlink Wireless, Inc. 
FRN: 0014286934 
Transmission Technology 30 
VA Data Category: 5 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 29 
Address Point features: 0 
Road Centerline features: 0 
Middle Mile features: 0 
Community Anchor Institutions reported: 0 

 
 
The Wired Road 
 
The Wired Road’s provided updates for the fall 2010 release to replace their original data 
submission in the NTIA SBDD transfer data model.  The provider sent a spreadsheet of 
census block numbers as well as addresses outside blocks greater than two square miles 
although the addresses did not need any work for the geometry conversion.  A staging 
geodatabase for this provider was created in the carryover provider directory for the fall 
2011 release and the original spreadsheet was imported as a table.   
 
The table was joined to the 2000-2010 cross reference table in ArcMap and results were 
exported a new table.  The new table was joined to the 2010 census block data and 
exported to a new feature class.  Fields in the data were calculated based on previous 
NTIA submissions.  Several blocks were filtered when selecting on square mileage and 
were exported to the census block conversion error feature class.  The original address 
point and road centerlines were loaded to the carryover database as well ad the newly 
converted blocks less than two square miles.  
 
Provider Name:   The Wired Road 
DBA Name: The Wired Road 
FRN: 0020153854 
Transmission Technology 50, 70 
VA Data Category: 3,7 
Wireless Polygons: 1 
2010 Census Blocks <2 Square miles: 1199 
Address Point features: 1530 
Road Centerline features: 871 
Middle Mile features: 1 
Community Anchor Institutions reported: 0 
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XO Communications 
 
XO Communications’ original data submission was for the spring 2011 release.  The 
provider originally sent a spreadsheet of census block numbers only. This original 
spreadsheet was imported into the provider staging database as a table.  The table was 
joined to the 2000-2010 cross reference table in ArcMap and results were exported a 
new table.  The new table was joined to the 2010 census block data and exported to a 
new feature class.  Fields in the data were calculated based on previous NTIA 
submissions.  No reported blocks were greater than two square miles so the data was 
loaded to the provider carryover geodatabase. 
 
Provider Name:   XO Communications, LLC 
DBA Name: DBA Name: XO Communications Services, Inc. (Affiliated Entity) 
FRN: 0006275945 
Transmission Technology 10, 20, 30 
VA Data Category: 5 
Wireless Polygons: 0 
2010 Census Blocks <2 Square miles: 1206 
Address Point features: 0 
Road Centerline features: 0 
Middle Mile features: 0 
Community Anchor Institutions reported: 0 

 

   
Post Processing Validation and Quality Control 
 
The data included in the NTIA SBDD data model was quality controlled using the topology 
included in the model as well as the python script provided by NTIA.  The topology was 
validated using ESRI ArcGIS Topology validation tools within ArcCatalog.  
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The following is the exported topology summary log: 
 

Class1 Rule Class2 Errors Exceptions 

 Must Be Larger Than Cluster Tolerance  0 0 
BB_Service_CAInstitutions Must Be Properly Inside State_Boundary 0 0 
BB_ConnectionPoint_MiddleMile Must Be Properly Inside State_Boundary 0 0 
BB_ConnectionPoint_LastMile Must Be Properly Inside State_Boundary 0 0 
BB_Service_Address Must Be Properly Inside State_Boundary 0 0 
BB_Service_RoadSegment Must Not Self-Overlap  0 0 
BB_Service_RoadSegment Must Not Self-Intersect  0 0 

 
The spring 2011 SBDD data submission was quality controlled using the available python 
script since VGIN’s ArcGIS environment was not at v10.  In the time gap between the 
spring and fall of 2011, VGIN upgraded its ArcGIS software and service packs and was able 
to use the included ArcGIS geoprocessing model.  The attribution included in the Virginia 
submission was validated using the NTIA provided model and the model interface was 
run repeatedly against the data sets until all attribute errors were identified and 
corrected.   
 
The python script imbedded in the model was altered by VGIN to limit each run to only 
one feature class to speed processing.  Once each feature class was run successfully, the 
entire script was enabled and run in its entirety against the Virginia submission.  
 

 
 
The output of the preliminary run is shown below: 
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* ----------------------------------------------------------------------------- 
* Data Submission Receipt 
* CheckSBDDSubmission.py 
* Created on: 9/21/2011 
* Created by: VA 
* State Broadband Data Development Program 
* NTIA / FCC 
* ----------------------------------------------------------------------------- 
 
******************************************************************************* 
*****                                                                     ***** 
*****                                                                     ***** 
*****                         Submission Receipt File - version 1.2       ***** 
*****                     Check below for any FAILED Statements           ***** 
*****                                                                     ***** 
*****                                                                     ***** 
******************************************************************************* 
 
*Check Layer: LastMile 
      Geometry PASSED:  Layer has 0 records.  
      Field Check:     passed      LastMile_PROVNAME values are good  
      Field Check:     passed      LastMile_DBANAME values are good  
      Field Check:     passed      LastMile_FRN values are good  
      Field Check:     passed      LastMile_OWNERSHIP values are good  
      Field Check:     passed      LastMile_BHCAPACITY values are good  
      Field Check:     passed      LastMile_BHTYPE values are good  
      Field Check:     passed      LastMile_LATITUDE values are good  
      Field Check:     passed      LastMile_LONGITUDE values are good  
      Field Check:     passed      LastMile_STATEABBR values are good  
      Field Check:     passed      LastMile_FULLFIPSID values are good  
 
*Check Layer: MiddleMile 
      Geometry PASSED:  Layer has 557 records.  
      Field Check:     passed      MiddleMile_PROVNAME values are good  
      Field Check:     passed      MiddleMile_DBANAME values are good  
      Field Check:     passed      MiddleMile_FRN values are good  
      Field Check:     FAILED      MiddleMile_OWNERSHIP has UNEXPECTED VALUES 
      Field Check:     passed      MiddleMile_BHCAPACITY values are good  
      Field Check:     passed      MiddleMile_BHTYPE values are good  
      Field Check:     passed      MiddleMile_LATITUDE values are good  
      Field Check:     passed      MiddleMile_LONGITUDE values are good  
      Field Check:     passed      MiddleMile_STATEABBR values are good  
      Field Check:     passed      MiddleMile_FULLFIPSID values are good  
 
*Check Layer: Address 
      Geometry PASSED:  Layer has 63497 records.  
      Field Check:     passed      Address_PROVNAME values are good  
      Field Check:     passed      Address_DBANAME values are good  
      Field Check:     FAILED      Address_PROVIDER_TYPE has UNEXPECTED VALUES  
      Field Check:     passed      Address_FRN values are good  
      Field Check:     passed      Address_ADDRESS values are good  
      Field Check:     passed      Address_BLDGNBR values are good  
      Field Check:     passed      Address_STREETNAME values are good  
      Field Check:     passed      Address_CITY values are good  
      Field Check:     passed      Address_STATECODE values are good  
      Field Check:     passed      Address_ZIP5 values are good  
      Field Check:     passed      Address_LATITUDE values are good  
      Field Check:     passed      Address_LONGITUDE values are good  
      Field Check:     FAILED      Address_ENDUSERCAT has UNEXPECTED VALUES  
      Field Check:     passed      Address_TRANSTECH values are good  
      Field Check:     passed      Address_MAXADDOWN values are good  
      Field Check:     passed      Address_MAXADUP values are good  
      Field Check:     passed      Address_SpeedNotBB values are good  
      Field Check:     passed      Address_OneSpeedAndNotTheOther values are good  
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      Field Check:     passed      Address_FULLFIPSID values are good  
 
*Check Layer: CAInstitutions 
      Geometry PASSED:  Layer has 3591 records.  
      Field Check:     passed      CAInstitutions_ANCHORNAME values are good  
      Field Check:     FAILED      CAInstitutions_ADDRESS has UNEXPECTED VALUES  
      Field Check:     FAILED      CAInstitutions_BLDGNBR has UNEXPECTED VALUES  
      Field Check:     FAILED      CAInstitutions_STREETNAME has UNEXPECTED VALUES  
      Field Check:     passed      CAInstitutions_CITY values are good  
      Field Check:     FAILED      CAInstitutions_STATECODE has UNEXPECTED VALUES  
      Field Check:     FAILED      CAInstitutions_ZIP5 has UNEXPECTED VALUES  
      Field Check:     passed      CAInstitutions_CAICAT values are good  
      Field Check:     passed      CAInstitutions_BBSERVICE values are good  
      Field Check:     FAILED      CAInstitutions_TRANSTECH has UNEXPECTED VALUES  
      Field Check:     passed      CAInstitutions_MAXADDOWN values are good  
      Field Check:     passed      CAInstitutions_MAXADUP values are good  
      Field Check:     passed      CAInstitutions_SpeedNotBB values are good  
      Field Check:     passed      CAInstitutions_OneSpeedAndNotTheOther values are good  
      Field Check:     passed      CAInstitutions_FULLFIPSID values are good  
 
*Check Layer: CensusBlock 
      Geometry PASSED:  Layer has 359947 records.  
      Field Check:     passed      CensusBlock_PROVNAME values are good  
      Field Check:     passed      CensusBlock_DBANAME values are good  
      Field Check:     passed      CensusBlock_PROVIDER_TYPE values are good  
      Field Check:     passed      CensusBlock_FRN values are good  
      Field Check:     passed      CensusBlock_STATEFIPS values are good  
      Field Check:     passed      CensusBlock_COUNTYFIPS values are good  
      Field Check:     passed      CensusBlock_TRACT values are good  
      Field Check:     passed      CensusBlock_BLOCKID values are good  
      Field Check:     passed      CensusBlock_FULLFIPSID values are good  
      Field Check:     passed      CensusBlock_TRANSTECH values are good  
      Field Check:     passed      CensusBlock_MAXADDOWN values are good  
      Field Check:     passed      CensusBlock_MAXADUP values are good  
      Field Check:     FAILED      CensusBlock_SpeedNotBB has UNEXPECTED VALUES  
      Field Check:     passed      CensusBlock_OneSpeedAndNotTheOther values are good  
      Speed Tier Record Check PASSED  
 
*Check Layer: Overview 
      Geometry PASSED:  Layer has 0 records.  
      Field Check:     passed      Overview_PROVNAME values are good  
      Field Check:     passed      Overview_DBANAME values are good  
      Field Check:     passed      Overview_FRN values are good  
      Field Check:     passed      Overview_GEOUNITTYPE values are good  
      Field Check:     passed      Overview_STATECOUNTYFIPS values are good  
      Field Check:     passed      Overview_TRANSTECH values are good  
      Field Check:     passed      Overview_STATEABBR values are good  
 
*Check Layer: RoadSegment 
      Geometry PASSED:  Layer has 54707 records.  
      Field Check:     passed      RoadSegment_PROVNAME values are good  
      Field Check:     passed      RoadSegment_DBANAME values are good  
      Field Check:     FAILED      RoadSegment_PROVIDER_TYPE has UNEXPECTED VALUES  
      Field Check:     passed      RoadSegment_FRN values are good  
      Field Check:     passed      RoadSegment_STATE values are good  
      Field Check:     passed      RoadSegment_TRANSTECH values are good  
      Field Check:     passed      RoadSegment_MAXADDOWN values are good  
      Field Check:     passed      RoadSegment_MAXADUP values are good  
      Field Check:     passed      RoadSegment_SpeedNotBB values are good  
      Field Check:     passed      RoadSegment_OneSpeedAndNotTheOther values are good  
 
*Check Layer: Wireless 
      Geometry FAILED and fixed:  Layer now has 19 records.  
      Field Check:     passed      Wireless_PROVNAME values are good  
      Field Check:     passed      Wireless_DBANAME values are good  
      Field Check:     passed      Wireless_FRN values are good  
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      Field Check:     passed      Wireless_TRANSTECH values are good  
      Field Check:     passed      Wireless_MAXADDOWN values are good  
      Field Check:     passed      Wireless_MAXADUP values are good  
      Field Check:     passed      Wireless_SpeedNotBB values are good  
      Field Check:     passed      Wireless_OneSpeedAndNotTheOther values are good  
      Field Check:     passed      Wireless_STATEABBR values are good 
 
 

There were several areas which yielded errors. These check failures may have resulted 
due to source data issues, processing issues, or loading to the transfer model from 
disparate locations based on individual providers.  In an ArcMap session, the feature 
classes in the transfer data model were edited in conjunction with the NTIA provided 
SBDD_Receipt_Overview.xls check matrix.  Values were calculated to match default 
values in the model.  The following were errors that were located and fixed based on the 
geoprocessing model: 
 
BB_Service_MiddleMile: 
Field Check:     FAILED      MiddleMile_OWNERSHIP has UNEXPECTED VALUES 
Error source: NTIA QC GP model not recognizing -9999 as valid value 
Resolution: None.  NTIA needs to alter model in order for this to be unflagged.  
 
BB_Service_Address: 
Field Check:     FAILED      Address_PROVIDER_TYPE has UNEXPECTED VALUES 
Error source: 0 values present 
Resolution: All ‘0’ values were calculated ‘1’ since there is not currently an ‘unavailable’ domain value 
  
Field Check:     FAILED      Address_ENDUSERCAT has UNEXPECTED VALUES  
Error source: “”, “ “,  and <NULL> values present 
Resolution: 58876 of 63472 values calculated to NTIA default of “ZZ” 

 
BB_Service_CAInstitutions: 
Field Check:     FAILED      CAInstitutions_ADDRESS has UNEXPECTED VALUES 
Error source: 4 records contained  “”, “ “,  and <NULL> values 
Resolution: values calculated as “N/A”. This issue will be followed up between NTIA releases. 
 
Field Check:     FAILED      CAInstitutions_BLDGNBR has UNEXPECTED VALUES  
Error source: 11 records contained 0, “”, “ “,  and <NULL> values 
Resolution: 4 values calculated as “N/A”. This issue will be followed up between NTIA releases. 

 
Field Check:     FAILED      CAInstitutions_STREETNAME has UNEXPECTED VALUES  
Error source: 142 records contained  “ “  values 
Resolution: values calculated as “N/A”. This issue will be followed up between NTIA releases. 
 
Field Check:     FAILED      CAInstitutions_STATECODE has UNEXPECTED VALUES 
Error source: 1 record contained  ““  value 
Resolution: value calculated as “VA” 
 
 Field Check:     FAILED      CAInstitutions_ZIP5 has UNEXPECTED VALUES 
Error source: 7 records contained  “ “  values 
Resolution: values calculated as “N/A”. This issue will be followed up between NTIA releases. 
 
Field Check:     FAILED      CAInstitutions_TRANSTECH has UNEXPECTED VALUES  
Error source: NTIA QC GP model not recognizing -9999 as valid value 
Resolution: None.  NTIA needs to alter model in order for this to be unflagged.  
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BB_Service_CensusBlock: 
Field Check:     FAILED      CensusBlock_SpeedNotBB has UNEXPECTED VALUES 
Error source: "MAXADDOWN" = '2' OR "MAXADDOWN" IS NULL, “MAXADUP” = “1” 
  Covad = 14 <Null> Values, calculated = Typical up/down values 
  XO =  72 (all values of download/2 = 2), calculated minimum download (3) and minimum upload (2) 
Resolution:  Recalculated erroneously entered or missed values 

Covad = Calculated Max Advertised Down/Up as Typical Down/Up values for the 14 records 
  XO =  Calculated as minimum download (3) and minimum upload (2) for the 72 records 

 
BB_Service_RoadSegment: 
Field Check:     FAILED      RoadSegment_PROVIDER_TYPE has UNEXPECTED VALUES 
Error source: 10851 records = 0 
Resolution: values calculated as “1”. This issue will be followed up between NTIA releases based on feedback looping with provdiers. 

 
All failed checks were corrected to valid values and the geoprocessing model was rerun 
with success. The following results output to text file: 
 
***************************************************** 

*********************CONGRATULATIONS***************** 

      It appears you have NO data inegrity issues 

        this file is ready to submit to the FCC 

*********************CONGRATULATIONS***************** 

***************************************************** 

Completed script SBDDCheckSubmission... 

Succeeded at Thu Sep 22 13:11:36 2011 (Elapsed Time: 40 minutes 17 

seconds) 
 
Upon examining the .txt output file there were several items that should have not 
resorted in errors but failed due to the NTIA model yielding errors with default values.  To 
examine these issues directly, please review the text file entitled VA_2011_9_22.txt 
which is included with Virginia’s submission package.  Several items were noted and 
skipped due to inconsistencies in the NTIA GP check model.  There have been several 
posts on the PB works site and it is assumed that for future releases, particularly round 5, 
this issue will be corrected. 
 

Data Issues/Considerations 
 

Broadband providers who only reported address level data did not have any additions or 
subtractions done to their reported data unless they needed to be converted to 2010 
census blocks. The data from previous submission for these carry over providers was 
generally geocoded directly from one of the 3 previous submissions and results were 
loaded into the master data set wholesale.   One thing that may be done or at least need 
to be looked at for the next submission is where these 13 broadband providers report 
addresses that fall in blocks less than two square miles.  There may be many cases where 
these broadband providers actually need a block placed in the report instead of 
centerlines and points.   This may reduce the amount of total address points and road 
segments submitted as well as increase the individual coverage area for a broadband 
provider if we do leave out features that sit on top of these polygons.   There were 6 
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providers that were reworked for 2010 blocks and the reduction of address points from 
the spring 2011 NTIA SBDD submission can be directly attributed to this type of 
processing. 
 
Another major issue with Virginia Broadband data is notable in the QC output script and 
that is the Community Anchor Institution data.  VGIN plans to do a full analysis of this 
data set between NTIA submissions which will correct many attribute issues.  The 
addition of this feature class to the VA SDE database  
 
Feedback looping will hopefully allow providers to conform more to the most desirable 
provider data category as outlined in a previous section.  The most desirable format to 
receive data in from a provider is GIS format and working with the CIT and providers in 
general, there may be many ways to receive the data from all or most providers who are 
a category 2 or category 3 solely in GIS format since these category providers appear to 
have data initially stored geospatially. 
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Project History: Vermont’s Broadband Mapping Initiative (BMI) is a collaborative broadband data 
collection and verification effort involving partners from the public, private and academic sectors 
participating as the Vermont Broadband Mapping Team.  The BMI is supported by grant funds provided 
under the National Telecommunications and Information Administration’s (NTIA) State Broadband Data 
and Development Program (SBDD). 
 
In November 2009 the Vermont Broadband Mapping Team (BMT) initiated the creation and 
development of a comprehensive and verified geographic inventory of broadband service availability in 
the State of Vermont. Landline and wireless services (fixed and mobile) were mapped using information 
from the providers and other sources. The broadband mapping information collected and verified through 
this effort is supporting the broadband development objectives identified in the RUS Broadband 
Initiatives Program (BIP) and NTIA’s Broadband Technology Opportunities Program (BTOP) in 
Vermont. Most importantly, the geographic inventory will further refine our understanding of the 
location of “unserved” and “underserved” areas in the state, thereby supporting targeted future 
investments in these areas. 
 
The BMT includes the following organizations: Vermont Department of Public Service, the Vermont 
Telecommunications Authority, the Center for Rural Studies at the University of Vermont, Vermont’s 
Enhanced 9-1-1 Board and the Vermont Center for Geographic Information.  The BMT is also supported 
by private sector contractors.  
 
Summary of Deliverables:  The BMT’s second broadband data submission (October 1st, 2011) includes 
broadband information as of June 30, 2011 (VT_Package_Oct1_2011_v1.zip).  The data complies with 
the NTIA NOFA requirements and SBDD data model (FGDB) specifications as of 6/30/2011.  A detailed 
description of each dataset is available in the ./metadata folder included with the deliverable package. 
 
Data Development Methodology:   A variety of data source and data collection methods were used to 
identify the characteristics and geographic extent of broadband service in Vermont.  Here is a quick 
breakdown 
       

- Cable: Mapped to street/street-segment level 
- DSL: Mapped as polygons (usually Exchange areas) or address points (list of addresses submitted 

by provider). 
- Fiber Optic: Mapped as address points (list of address submitted by provider) 
- Fixed Wireless (WISP): Mapped as polygons (propagation maps prepared by independent 

contractor using data provided by WISPs) 
- Mobile Wireless: Mapped as polygons (data submitted by provider) 
- Satellite: Mapped as polygons (data submitted by provider).  Providers of satellite-based 

broadband services claimed that they covered the entire state. 
 
The cable, DSL, fiber optic, and fixed wireless (WISP) layers were “intersected” with Vermont’s E911 
address point layer to determine broadband availability at the address-level.  This information was then 
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intersected with Vermont’s 2010 Census Block layer to calculate availability at the block level.  The 
October 1st, 2011 deliverable includes Census block-level data for Census Blocks less than or equal to 2 
sq miles, and address level data for Census blocks greater than 2 sq miles. 
 
Mobile wireless and satellite-based broadband polygons were submitted by providers to VCGI.  They 
were formatted to match NTIA specification, but otherwise forwarded as-is. 
 
Vermont’s broadband providers submitted data which was used to populate a table listing maximum 
advertised and typical speeds by Metropolitan Statistical & Rural Service Areas (Cellular Market Areas).  
This information was used to populate the speed information contained in the submitted broadband, 
including speed information at the census block level.  In numerous cases providers did not submit 
typical speed information. 
 
The initial list of Community Anchor Institutions (CAIs) was derived from existing data sources 
including the VT Critical Facilities Database and Public Libraries Survey from the Institute of Museum 
and Library Services.  Community Anchor Institutions include schools, libraries, medical facilities, 
public safety facilities, universities and colleges, and other community facilities such as town 
halls/offices. An email and hard-copy mailing was sent to every institution in the list.  They were asked 
to fill out an online survey.  Follow-up emails and phone calls were made to increase the response rate.  
The data delivered to the NTIA includes all CAIs, but only includes broadband information for a subset.  
Additional broadband institutions will be added as their information becomes available. 
 
Data Review: No formal confidence interval for provider data submissions has been established.  
Vermont is waiting for clarification from the NTIA on this.  However, each provider submitted dataset is 
evaluated against a minimum standard or expectation of quality. If the data submission is identified by 
the VT Dept of Public Service as not credible based upon their experience, it is not included in the 
inventory. If a provider creates a data submission that cannot be parsed or, resolved, we contact the 
provider to try and work out a method of submission that can be used.  Vermont had 100% participation 
from all 38 broadband providers for the 6/30/2011 data submission.  However, many of these did not 
have any updates to report. 
 
Feedback Loops:  Each broadband provider that supplies broadband service data in some manner to the 
VT broadband data inventory is given the option to view a final version of their data submission as it will 
be represented in the NTIA delivery. However, very few providers have asked for a copy of the final 
version of their data submission for review. Some smaller providers have asked for, and received, a 
hardcopy map or digital map graphic (PDF) of their coverage area. All of the providers that requested to 
see what was being submitted to NTIA representing their coverage area received either a copy of the 
data, a hardcopy map or digital map graphic in accordance with their preference.  
 
Data Verification Methodology:  The BMT used two primary data verification methods: 1) a phone 
survey conducted by the UVM Center for Rural Studies (CRS) to verify the broadband maps, and 2) 
InfoGroup's ISP Connectivity dataset.  Addresses from both datasets were geocoded (mapped to a 
lat/long coordinate), then used to evaluate the "accuracy" of the broadband coverage data.   
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Conclusion:  Vermont’s Broadband Mapping Team is pleased to deliver a robust broadband availability 
inventory to the NTIA.  We are confident that it meets the specifications outlined in the NTIA SBDD 
NOFA.  The broadband data and maps will help Vermonters refine their understanding of “un-served” 
and “underserved” areas of the state, thereby supporting targeted future investments in these areas. 
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1  Introduction 
 
 
This report is submitted along with the fourth data submission for the 
Washington Broadband Mapping Project.  This submission includes all 
data collected so far per the requirements of the National 
Telecommunications and Information Administration (NTIA) State 
Broadband Data and Development Grant Program (Docket No. 0660-
ZA29) Notice of Funds Availability (NOFA) and formal and informal 
clarifications to it.  Specifically, it includes broadband data collected from 
broadband providers and community anchor institutions data compiled 
from various sources for the State of WA.  The State of WA has retained 
a mapping contractor, The Sanborn Map Company to perform the work 
related to the Mapping Grant for this project.  Data from the previous 
submission is now publicly accessible via the WA Broadband Program 
(http://wabroadbandmapping.org/).  
 
This document is a supplement to the three previous reports 
submitted with previous data submissions on May 1, 2010, October 
1, 2010, and April 1, 2011 respectively.  Therefore, it builds on the 
document provided with those submissions.  Rather than repeat the 
contents of the previous report, this document makes incremental 
updates on various topics where changes have been made in the 
methodology or reiterates the methodology used.  Please refer to the 
previous documents for further details. 
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1 Overall Project Status 
 

1.1 DATA COLLECTION 

 
This section details data collection related to NTIA deliverables which 
include broadband data and community anchor institution data.   

1.1.1 Broadband Data 

 
For this submission, Sanborn started data collection efforts on July 13th 
2011 by sending out data update requests and technical data 
specifications after NTIA announced all final changes. These were sent to 
a large list of companies which were compiled from multiple lists (FCC 
477 list (dated June 30th, 2010),  a list provided by the Washington UTC, 
NTIA’s Wireless Internet Service Providers Association (WISPA))and 
from any providers that were identified through other sources such as 
web research, planning meetings, etc.  In our technical document, we 
highlighted the transformation of data from Census 2000 to Census 2010 
and given that change, we requested all providers to submit data in the 
Census 2010 format.  Sanborn also uploaded the final data for each 
provider in NTIA format from the previous submission to the Sanborn 
Provider Portal.  The providers were encouraged to use the provider 
portal and update their information on it.   
 
We followed the same contact and follow-up protocols as the previous 
submissions.  The following are some of the important changes or no 
changes: 

1. All census blocks and road segments are mapped based on 2010 
census data set.  Any data submitted in 2000 or 2009 format was 
converted to 2010 for this submission.   

2. We continued to not collect data from resellers.  
 

3. We are submitting data for satellites in this submission based on 
NTIA clarifications.  All satellite providers who have provided 
speed, FRN number and other technology information have been 
mapped to serve the full state.  At present WA data includes only 
two satellite providers – Hughes and Wildblue.  The other satellite 
providers which operate in WA to the best of our knowledge are 
Starband and Stratos Offshore Services Co. both of which did not 
provide adequate attribute information in order to be included on 
the mapping data. 

1) Additionally, given the topography in WA, we have done 
some Viewshed Analysis to identify areas with no line of 
sight to satellites.  This analysis has been done separately 
for each provider and for now, the analysis has been done 
for Wildblue and Hughes satellites.  We have provided the 
resulting data to Wildblue and are working with them to 
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validate the data at present.  Based on what we find, we 
will decide how to represent such areas of unlikely line of 
sight on the State Broadband Map. 

 
4. We worked hard to get even more Public Utility Districts (PUDs) in 

Washington to participate in the program.  As previously noted, 
PUDs are public entities at the County level that lay broadband 
infrastructure connecting to the end users (i.e. such as fiber to the 
homes) but WA regulations do not allow them to sell directly to the 
customers.  In these PUD deployments, broadband service is 
provided by resellers using the infrastructure owned by the PUDs 
at speeds and costs that the market is capable of bearing.  While 
most PUDs are able to provide their area of availability, it is harder 
for them to provide the speed bundles that their resellers are 
using.  We held a meeting with NTIA (Andrew McRae) and the 
State of Washington Program Manager (Will Saunders) to discuss 
some options for putting PUDs on the map.  We held additional 
meetings with the representatives of several PUDs and made the 
decision that the map and data should represent the highest 
speeds that the PUDs are capable of providing should there be a 
customer willing and able to pay for such a speed.  Therefore, the 
PUD data represents high speeds in rural areas since most of the 
PUDs are in rural areas and have put in fiber connections to 
homes.  It does not take into account the backbone capacity. 
 

5. Due to NDA restrictions and our inability to accurately flag service 
by “category of end user”, address points are not included in this 
submission to NTIA for any commercial provider. 

 
6. Some providers did not submit middle mile elevation or backhaul 

capacity, particularly when they asked us to reuse previous 
submission data.  Wherever possible, we went back to providers 
to obtain that information, but it is not available for every record. 

 
7. Terrestrial Mobile Wireless and Terrestrial Fixed Wireless 

(licensed and unlicensed) were treated as wireless coverage and 
were delivered as a shapefile.  In cases where a provider served 
using the same technology and spectrum but with different 
speeds, overlapping areas were removed and the higher speed 
was assigned. 

 
8. If a cable based wireline provider provides both DOCIS 2.0 and 

DOCIS 3.0 service to the same area, the block or road was listed 
only once with a technology code of 40. 

 
9. Providers were only willing to indicate on a general level if they 

served business, residential or both, so we did not get any 
providers that broke down the type of service by block. Only if the 
provider stated they only serve business to business customers 
did we fill in the “category of end user” with a code of 2, otherwise 
this field was left blank. 
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10. The submission 4 provider data model is currently based on the 

NTIA data model as of 6/30/11. 
 
We added 5 new providers in this submission – Pogo Zone (terrestrial 
fixed wireless unlicensed), PUD Skagit (fiber), Northland Cable 
(cable), Rock Island (wireless) and Tanager (wireline and wireless).  
In this submission, 59% of the providers submitted new or updated 
data whereas for 41% of the providers we reused data from their 
previous submissions.  One of the larger wireline providers in WA, 
Qwest was bought out by Century Link.  Also another provider, 
Megapath merged with Covad.  The Qwest and Megapath data are 
now represented under Century Link and Covad data even though the 
datasets provided were different.  In places where Qwest and Century 
Link’s service overlapped, we used spatial tools to select the highest 
speeds for a given technology of transmission. 

 

1.1.2 Community Anchor Institutions Data 

 
The community anchor institutions data continues to be crowd-sourced 
through the online data gathering application created by the Sanborn 
Team. The State of Washington is doing the PR around this data 
collection and contacting the relevant agencies to request them to fill in 
data.  This has been a slow process and we are getting to a point of 
diminishing returns with this effort.  The numbers of community anchor 
institutions that have responded so far is provided below: 
 

 

Category Name Total 

Total with 
Broadband  
Information 
in 
Submission 
4 

1 School - K through 12 2299 1773

2 Library 356 356

3 Medical/healthcare 135 54

4 Public Safety 1706 105

5 
University, college, other post-
secondary 220 

  180 

6 
Other community support - 
government 343 

32

7 
Other community support - 
nongovernmental 344 

11
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1.2 DATA PROCESSING 

All data received went through the following processing steps: 
 

1. Triage:  All new data was quickly reviewed to understand what 
was received, and in what format. We also made sure we had all 
the required components for NTIA’s data model, such as their 
FRN and advertised speed information. We also screened for any 
known issues that we might have seen before (such as Excel 
2003 spreadsheets that cut off at 32k row). 

2. Ingest:  At this time the data is actually brought into our systems. 
Each provider is set up with a unique file geodatabase to store 
their information. Record counts of what was received is logged so 
that we can validate we did not drop anything in processing. 

3. Data Processing:  This is where the data goes through a number 
of ETL routines to convert the raw proprietary information into a 
format similar to the NTIA format. The exact routine utilized 
depends on how the data is received 

1) When a provider submits a service boundary, we select all 
the blocks and roads inside that shape. 

2) If a provider submits a customer address list, the points are 
geocoded, and then the appropriate block or road segment 
is selected. 

3) If a provider submits block and road information using 
Census data, we just make sure everything is formatted to 
the appropriate specifications. 

4) If the provider submits any type of road or line data that 
does not direct correlate to the TIGER data set, we convert 
the lines to TIGER by selecting the road centroid and 
spatially selecting the closed segment in our data set. If the 
road is in a block less than 2sqmi, than the block is 
selected. Some manual cleanup is also applied to make 
sure we do not accidentally drop any road segments that 
should have been processed. 

5) After each round of processing, we make sure that we only 
keep unique records. A unique record is defined as having 
a unique combination of FRN, Block/Road ID, and 
technology type. If there are multiple records with different 
speeds, but all else is equal, than we select the maximum 
of the advertised speeds. 

4. QC Review: All data is then sent to a different analyst to perform 
a through quality control review on the processed data set. Record 
counts are compared to what was submitted. The QC staff also 
make sure the ETL scripts and routines populated all of the right 
fields. 

5. QA Review:  Data is then sent to another team for Quality 
Assurance Review. In this step the data is not only double 
checked against what was originally submitted, but it is also 
brought up inside standardized MXD templates that allow us to 
make sure our results make sense. This often involves comparing 
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the new data set with prior submissions, as well as looking for any 
possible technology or speed anomalies. 

6. Provider Review:  Processed data is all posted to a customized 
web-mapping tool we commonly refer to as the Provider Portal. All 
providers were notified once their data was available on the site, 
and they were always given 3-5 business days to review the data 
and respond. In this site, providers can log on and visually see 
their processed data in a map format. It also allows them to 
overlay their raw data to help them validate that we did indeed 
process things correctly. The provider portal also has a suite of 
markup tools that will allow the providers to edit their data, 
including adding or removing service areas, and making changes 
to the data attributes. 

7. Comment Processing:  All comments and feedback received 
from the provider portal, is then reviewed and applied to the 
processed data set. This updated data set goes back through our 
QA and QC processes, and if time allows, back out to the Provider 
Portal, for the provider to review and sign off on. 

8. Data Append: After all of the individual data sets are processed 
and approved, we run an append process which merges all of the 
individual provider data sets into one geodatabase. This is also 
the point where our team will do any final transformations to get 
our working data model into the latest NTIA publishing format. 

9. Final QA/QC:  A series of quality checks are run on the final 
appended data sets to ensure it is ready for submission to NTIA. 
We also run the NTIA receipt tool at this time. Any last issues are 
corrected, and the data is sent to the state for their review 

10. Submission to NTIA. 
 

1.2.1 Conversion Process of Data from Census 2000 to 
2010 

 
Due to the changes in census geography, all providers were asked to 
submit new data. In those instances when a provider A) submitted new 
data in Census 2000 format, or B) instructed us to reuse their last data 
submission, we had to convert the blocks and roads into 2010 format. 
 

Basic 2000 to 2010 Conversion Process:   

1. For the blocks, take the 2000 block ID, and select all the 
corresponding 2010 block id’s 

1) using census crosswalk table – not an actual spatial 
process, since this was faster 

2. Look at the new 2010 block ids, and filter on greater than or less 
than 2 sq miles. 

1) If less than or equal to 2 --> bring in the 2010 geometry 
and add that record to the blocks table 

2) If greater than 2 --> select any roads in that area – spatial 
select (using roads gt2 table) 
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3. For the roads, take the 2000 or 2009 TLID and try to match it to 
the 2010 TLID’s 

1) If there is a match,  add that record to the roads table 
2) If there is not a match, select centroid of existing 

2000/2009 segment, and select closest 2010 road 
3) If the road is now in a block LT2, select the block(s) 

instead and drop the road 
4. Remove any duplicate records in both tables 
5. Run some automated checks to catch missed features (i.e. add 

le2smi blocks surrounded by roads that have not already been 
added) 

6. Manual review (QC) and corrections. 
1) There will be some blocks that are selected inappropriately 

(especially at town edges for CT providers, where we know 
their franchise ends at a town line.) 

2) There are some holes in the census crosswalk table 
3) The road conversion process may only select one portion 

of the road if it has now been broken into multiple 
segments 

 

Assumptions 
 

1. If a road was in an area greater than 2smi in s3, and due to 
census re-drawing, is now in an area less than 2smi, we will grab 
blocks (le2smi) on both sides of that road and add them to the 
provider data: 

2. If a new 2010 block, that is less than 2smi, is completely 
surrounded by roads and/or blocks served by that provider, than 
we will add the block to the provider service area. 

1.2.2 Submission 4: Reference Data Creation 

This section describes the reference data used in submission 4.   
 
BLOCK REFERENCE 
For s4, Census 2010 data was utilized.  The data was set up as follows: 
 

1. Block size (AREA) is calculated combining the 2000 land area 
(ALAND) and water area (AWATER) 

2. AREA is converted from square meters to square miles to 
calculate square mileage (SMI). 

3. If the SMI of a block is less than or equal to 2, then the less than 
or equal to 2 square mile indicator (LE2SMI) is set to true. 

 
ROAD REFERENCE 
2010 Tiger Line IDs (TLID) were used for data processing in s4.   The 
data was set up as follows: 
 

1. The GT2SMI (Greater Than 2 Square Mile) indicator is set to True 
when: 
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1) The 2010 road segment is completely within a block that is 
NOT less than 2 square miles 

2. Only minimum and maximum address ranges and a single zip 
code for each road segment is maintained.   

 

1.2.3 Submission 4: NTIA Submission Data Model 
Schema Changes 

 
The data model released on June 30, 2011 contained the following 
changes to the s4 data model: 
 

• The Category of End user field was added back in to the block 

and road tables. In addition the domain values were changed. 1 

still represents residential, but a 2 now represents all non-

residential uses.  

 

o This field is not required, and for many providers, was left 

blank since the data was not provided. 

1.3 DATA VALIDATION 

 
Sanborn has continued to perform the same validation on the data as the 
previous three submissions (details in previous reports).  Some minor 
updates to the validation process are discussed below. 

1) QC of the data at various steps  

2) Spatial checks against public and commercial datasets 

a. For WA, we continued to use the following datasets for 

validation: 

i. Exchange Boundaries:  for DSL boundaries 

ii. MediaPrints:  for Cable boundaries 

iii. Speedtest.net data 

3) Verification by providers 

4) In this Submission, along with the standard verification by providers 

using the Provider Portal, we also identified for providers issues that 

they needed to focus on regarding the findings of our validation team.  

This also included validation and feedback we received through our 

website – this submission we have incorporated and integrated 

several feedback tools in the Interactive Map and information sourced 

from users is evaluated with respect to provider data and any noted 

discrepancies are passed back to the provider for correction.  In 

addition, in this round, we incorporated any feedback provided by 

NTIA for Submission 3.  All of these were done by sending providers a 

letter that identified issues using screenshots and explaining to them 
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what the error was and then asking them to go fix those errors using 

the secure provider portal.  If providers disagreed with the feedback, 

we have documented their response. 

5) Speedtest data collection and other data collection for verification  

a. We continue to use speedtest data and community anchor 

data crowdsourced for validation purposes. 

6) Planning workshops and local validation 
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Overview 
 

The following documentation provides an overview of how the fourth required data set was collected 

and processed for the State Broadband Initiative (SBI) in the states of Alabama, Idaho, Wisconsin, and 

Wyoming.   

Although we could separate this draft into state-specific deliverables, the majority of methodology 

remains intentionally consistent among the states.  As one important validation test is comparability 

across states, we find value in this cross-state approach.  This cross-state approach also helps the 

LinkAMERICA team focus on comparable outcomes across the four states, where appropriate.  Our 

intent is not to make the states look and be the same, rather it is to leverage economies of scope and 

scale among the business processes. 

As expected, this document rests heavily on the prior drafts, but has also been updated and expanded. 

Significant changes include additions covering: 

1. Trends in provider inputs  

2. Expansion in retrieval of WISP coverage  

3. Requested changes based upon NTIA guidance 

a. Modification of Satellite providers as a Type 1 Broadband provider; 

b. Discontinuation of estimating Community Anchor Institution coverage and speed; 

c. Review of submitted speed with respect to NTIA supplied frequency table 

4. Transition planning with respect to capacity building within the State for Broadband map 

development 

5. Development and posting of a provider Type classification rubric 

Treatment of the following subjects has been expanded: 

1. Community anchor institutions and survey methodology 

2. Verification and validation 

3. Data production methods 

4. Conversion to Census 2010 

As anticipated, the SBI program continues to mature and evolve.  Technical leadership and strong 

program office guidance has been appreciated.  We continue to focus resources on establishing stable 

business processes to track submissions, verify received and processed data, test for temporal stability 

and provide reporting deliverables consistent with NTIA expectations. 

In our view,  the mapping deliverable reflects (1) a good faith effort, which results in a reasoned 

response to the NOFA, Technical Appendix A,  as well as supplementary program office guidance and 

modifications offered in phone calls, emails, and webinars, (2) a stable foundation for improvement and 

prioritization of both NTIA and state needs and interests , (3) a valid data processing model to support 
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online mapping, consumer feedback, provider verification and reporting, and finally, (4) a valid use of 

the evolving data transfer model and its intrinsic validation methods.  More importantly, the resulting 

data and online coverage maps that follow from this work are providing good input and context for the 

Broadband planning teams working across the states we have the pleasure to serve. 

We close this methodology document with two Appendices.   Appendix One describes Data Collection 

Challenges.  This section describes some of the open issues, challenges and questions we are exploring.  

Our hope is to receive clarification and counsel from NTIA in how best to confront some of these issues, 

which are likely common across states.  Appendix Two describes the confidentiality framework 

explained by NTIA.   

Purpose of This Manual 
This technical document was developed to provide transparency in our data production process.   

Our goal is to illustrate a thoughtful process designed to meet the intent of the submission.  Our hope is 

that we have developed a process that is reasonable, with respect to the data it deals with, as well as 

flexible enough to change with evolving NTIA requirements and lessons learned from the Broadband 

mapping community.  

Data Sources 

Developing the Provider List 

Provider lists for all states were developed at project inception from the following sources: 

 State lists of regulated telecommunications, cable and wireless service providers 

 State and national industry organizations (i.e. cable associations, wireless service provider 

organizations, telecommunications associations) 

 FCC Form 477 respondents 

 Independent web searches 

 Prior comparable mapping/research efforts 

 Interviews with key state staff members and important community influencers 

After the April 1, 2011 “Round 3” submission, we continued our research and added new providers to 

the program as discovered.  As one would expect in a dynamic marketplace, provider identification is an 

ongoing and important component of our work.  Mergers and acquisitions, the use of multiple regional 

DBAs, the lack of any universal identity management attribute, and the generally complex parent-

subsidiary structure of many telecommunications companies, make provider identification and tracking 

very challenging.   

In early July 2011, we once again initiated an email and telephone outreach campaign to contact all 

known providers. This is an extremely time consuming process, but it is necessary to ensure that the list 

of contact persons remains current, and that providers are aware of data request changes and deadlines 
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associated with each round.  Where necessary, we execute new NDAs with providers.  In “Round 4”, this 

effort continued on a daily basis until we reached our final data submission deadline on August 19, 

2011.   After August 19, we continued to work with providers who were not able to meet the deadline.  

In most cases were able to “crash” our process to accommodate this extra data, but late submissions 

continue to create inefficiencies and add costs to the overall program.  In Round 4 providers that 

responded too late to be included in the final dataset will be included in our Round 5 submission. Once 

again, as contact is made in each round, we verbally qualify each provider by asking a series of questions 

regarding the type of service and speeds offered.  If the provider does not meet the minimum 

specifications for a Broadband provider (as defined in the NOFA) we make a note of their status and 

remove them from the data submitted to NTIA.1  We continue to reach out to them in future rounds in 

the event that their service is upgraded or expanded. 

Provider Outreach 

To meet the program’s aggressive deadlines and participation goals, LinkAMERICA believes it is critical to 

maintain rapport with providers.  To do this, we continued to reach out to providers with regular project 

communications, including a program newsletter and links to the various state mapping websites.  As 

described above, individual e-mails and/or telephone calls were made to all providers explaining the 

status of the program and requesting their continued support in Round Four. We’ve also had the 

opportunity to support providers in their BTOP / BIP applications in certain cases. Through these 

collective outreach initiatives, and our engagement with various industry associations, we continue to 

enjoy a healthy and appropriate relationship with Broadband service providers. 

NDA 

To provide protection for all parties involved, LinkAMERICA continues to honor the terms of our NDA.  If 

providers did not execute the NDA in previous rounds they were offered the opportunity to do so in this 

collection round.   New providers were of course also supplied with a copy of the NDA. 

To facilitate the execution of NDA’s, LinkAMERICA continues to use the DocuSign online document 

management solution.  This system allows providers to review and digitally sign the NDA in a legally 

binding manner, and has been instrumental in achieving rapid approval and execution of NDAs with the 

majority of providers.  In some cases, NDA’s were individually negotiated to address specific provider 

concerns.  In all cases, minimum standards established by the NOFA are honored.  In other cases, 

providers chose to submit data without executing an NDA. 

Provider Survey 

Since three prior rounds of data collection had been completed, the LinkAMERICA team had a solid base 

of coverage and speed information with which to begin Round 4.  This allowed us to provide two 

response options to providers.  The first was for them to review check maps of their coverage and speed 

data – submitting only corrections and additions to the existing dataset.  (For provider convenience the 

                                                           
1
 As with other Grantees, we struggle with appropriate and consistent classification for service providers who 

opportunistically provision Broadband services.  In this submission we continue to bring them into the analysis as a 
provider type “other”.  As the inclusion of this category isn’t our primary goal, we are working to process data as 
we can.  We are similarly categorizing and retaining reseller information.  Our datapackage.xls illustrates the 
categorization of non Broadband providers within our provider tracking and verification systems.  
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check maps were created in both PDF and Google Earth (.KMZ) formats.) The second was to allow 

submittal of completely new datasets, either in tabular form or in multiple other digital formats.  For 

those without sophisticated CAD or GIS systems, we continued to allow the submittal of 

printed/scanned maps and other written materials.    

Survey Methods 

Once again, we used a secure digital survey process (via our provider portal websites) to collect and 

display information for providers.   The Round 4 survey process was designed to accommodate both 

new and returning providers, and the different types of information they would be submitting.  The 

following is a summary of the process encountered by each group: 

New providers:  New providers were routed directly to our standard survey where they were provided 

with templates for uploading data in tabular NTIA-compliant formats.   As in previous rounds,  if 

providers could not supply information in the requested format, alternatives were offered.  These 

alternatives included uploading service-area boundary maps, exchange area maps, CAD drawings or 

customer address lists.  From that information, the LinkAMERICA team developed a geographic 

representation of coverage and was able to build coverage features for each provider.    

Returning providers:  For Round 4 we continued to work with participating providers to improve their 

datasets.  The change in Census Data vintage was explained to providers and links to appropriate files 

were provided to assist with the transition to the new vintage data.   

Check maps continue to be a useful tool to show providers how their area would be displayed on the 

resulting interactive state map and to get constructive feedback regarding corrections and changes that 

need to be made to their coverage and speed data.   Generating these customized documents in each 

round is an extremely time consuming verification process, but it allows us to close many of the gaps 

that might have otherwise persisted. 

Follow Up 

After the release of the Round 4 survey in early July 2011, LinkAMERICA launched an extensive effort to 

encourage responses.  Every known provider was contacted at least twice during the months of July and 

August.  The initial data submission deadline was set for August 19, but, as previously noted, we 

continued to accept “straggler” submissions into September.  

No Response Policy 

As mentioned above, every effort was made to contact each provider who appeared on our initial list.  

However, if no current information could be found on the company (i.e. no website, no valid phone 

number, no contact person identified) they were removed from the list of “known providers”.  We 

believe the vast majority of those we were unable to reach were providers who have simply ceased to 

exist2.  

                                                           
2
The list of known providers and important submission statistics are contained in the datapackage.xls file. 
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Summary 

In summary, an intensive 45-60 day provider outreach and data collection process is initiated at the 

beginning of each round.  In Round 4, given the data vintage of June 30, 2011, we began this process in 

July and the last submissions were accepted in September, 2011.    

While we continue to successfully engage the majority of providers in each round, the amount of 

manpower required to solicit complete and timely responses should not be underestimated.  This 

process is one of the most costly and complex within the entire SBI program.  

Third Party Data Used 
Beyond the data obtained from providers, we acquired the following commercial data products: 

 American Roamer, Coverage Right Advanced Services. This data served two purposes.  The first 

was to verify the provider list and help find Broadband service providers not on other lists.  The 

second was to verify the reasonableness of the Broadband service provider’s submission. 

 MapInfo ExchangeInfo, Professional.  This data was used in the verification of telephone 

Broadband provider data.  Where a public domain exchange boundary wasn’t available, the 

MapInfo boundary was used for coverage containment tests.  

 Media Prints Cable boundaries.  This data was used in the verification of Cable/HFC Broadband 

provider data.  It was used to research valid providers and discover if that provider was offering 

Internet service.  In very rough terms the contained boundaries were used to test the location of 

some provider data.  

 FCC 477 restricted use data were analyzed to find valid providers within a given area. 

We have included third party data sources, which touch on each of the three major technologies 

analyzed within the SBI program.  Each of these data sources tie back to a public domain data source, 

which provides a cross-verification mechanism for the commercial data product. 

Although there are a large number of third party licensed data sources available, we remain 

conservative in our acquisition plans.  From our limited analysis we are concerned about the ability to 

cross-verify additional third party licensed sources against public domain data.  Further, we are unsure 

of how we may be able to integrate another data provider’s view of valid Broadband providers within 

the definitions used by the NOFA (eg. Are they using an FRN/DBA identity view or a marketing view?  

Can the provider supply in a 7-10 day window?  Are they facilities based or not?).  This leads us back to a 

statement we made in a ‘lessons learned’ Webinar (April 2010) about exploring a consortia to lower the 

cost of data acquisition and allow multiple entities to peer review the quality and methodologies behind 

licensed data products.3  

Beyond these commercial data sources, we used a number of public domain sources.  These included: 

a. Geographic Data Files  

                                                           
3
 We also suggested forming a technical standards committee and a consistent system for confidence reporting. 
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i. US Census TIGER data4 

b. Sources that helped isolate providers, identity management or provider service areas 

i. NECA Tariff 4 

ii. State produced exchange boundaries  

iii. Carrier produced wirecenter boundaries 

iv. FCC Coals reports (321/325) 

v. FCC FRN API lookup tool 

vi. FCC/FAA Antenna Registration System 

vii. FCC FRN Lookup Tool (plain text search) 

viii. USAC High Cost FCC Filing Appendices 

c. Sources that helped isolate anchor institutions 

i. USAC Grant lookup tool 

ii. USAC High-Cost FCC Filing Appendices 

iii. HRSA data warehouse 

iv. NCES data lookup 

v. State managed lists of schools (K-12), post-secondary institutions and libraries 

vi. List of museums,  conventions, and visitors bureaus from www.onlineatlas.us 

Finally, challenges exist when dealing with the inevitable conflicts between provider-submitted data and 

third party sources (public or commercial).  There is no guarantee third party sources are more accurate 

or timely than the providers’ own reports.   Indeed, some third party sources are based upon different 

standards than those specified in the NOFA, perhaps making them less reliable than information 

collected directly from providers.  At the very minimum, provider data has a lineage and temporal status 

that we can identify.  A concern we have with increasing use of third party data is that we have no way 

to verify its quality or development methodology.  In other words, we may hit a wall in which we can’t 

determine how the commercial source derived its coverage conclusion.  To us this means that third 

party data sources are beneficial, but represent a supplementary view, not an authoritative one, of the 

NOFA defined Broadband market. 

In short, we have chosen to use provider data as the baseline.  We will challenge provider reports when 

third party data shows major anomalies, when submitted data conflict with prior submissions or when a 

consistent volume of consumer feedback points to a potential error.   

As the program evolves it is also our intention to provide tools that allow end users to evaluate the 

accuracy of the data in their own way.  A confidence score or the presentation of multiple (and 

potentially competing) reports for the same location may be made available. This notion is discussed 

further in the “Validation” section.   

                                                           
4
 Census data were derived from < http://www.census.gov/cgi-bin/geo/shapefiles2010/main>, Census 2010 files.  

Roads were derived from the county faces and edges file downloaded at the same location and tiled for a full state. 
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Confidentiality and the Use of Licensed Materials 
As a mapping vendor, we are reliant upon the cooperation of Broadband service providers.  In large 

part, what underlies this cooperation is trust that we will not violate the proprietary and confidential 

nature of the data provided to us.   

We are thankful for the confidentiality clarification that NTIA shared with us (included as Appendix Two).  

We intend to use this as a guiding document to help us communicate with providers about what 

information NTIA considers to be confidential.  Our suggestion is that NTIA publish this, or something 

comparable, to ensure a consistent interpretation of the NOFA and how it guides NDAs. 

As some providers are non-responsive to requests for information, or lack resources necessary to put 

data into NTIA compliant formats, we have fallen back to the use of commercial data sources in several 

places.   

For instance, some mobile wireless providers were unable to submit coverage information to us.  In 

these circumstances we have generalized the American Roamer coverage.  For incumbent telephone 

providers we have used commercial wirecenter boundary products to filter Census Blocks that are 

clearly out of their exchange areas.   

Public Engagement:   Crowd Sourcing, Surveys and Social Media 
Crowd sourcing (i.e., an intentional and carefully designed effort to tap into the collective intelligence of 

the public at large to expand our knowledge base) continues to be an important element of our data 

collection and validation process. In addition to the various opportunities the public has to provide input 

via the online service coverage maps and the related ‘Broadband story’ process, our crowd sourcing 

efforts are grounded in a time tested telephone survey approach focused on the consumer market. In 

addition, we continue to advance our process to include certain initiatives centered in two social media 

outlets – Facebook and Twitter. These initiatives are discussed below. 

Consumer Surveys 
Working under contract for the state of Alabama in 2009, our initial consumer survey was performed 

before the NTIA SBI grant was in place. Subsequent consumer surveys funded by the SBI grant were 

hosted in 2010 for the states of Idaho, Wisconsin and Wyoming and then again in 2011 for Alabama (as 

noted below). These surveys will be repeated after two years to establish and evaluate trends. To this 

end, in August/September 2011 we are wrapping up a second-round survey in Alabama designed to 

expand our understanding of important adoption issues and to establish important local trends from the 

initial 2009 survey. Survey results from this effort are currently under evaluation. These primarily 

telephone based surveys include two distinct and carefully scripted tracks: one for Internet users and 

one for non-users. The telephone survey approach allows us to reach the non-Internet user group as 

well as the current Internet user. A secondary online approach is also used to augment input from 

current Internet users. In the most recent Alabama survey we added a third tier to our approach as we 

equipped local field survey teams with an iPad-based survey tool and targeted their time to reaching the 

younger market. For non-users, the surveys help determine why they don’t have or don’t use 
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Broadband. For current Broadband users, the survey helps determine the nature of their Broadband 

access and how they use that connectivity in their daily lives. In addition to our state-specific surveys a 

nation-wide survey was also hosted to provide a broader view of consumer views for comparison 

purposes. State-specific surveys are, where possible, framed to match the state’s regional Broadband 

planning structure (e.g., the updated consumer survey in Alabama was designed to produce results 

relevant to the state’s twelve Broadband planning regions). 

The resulting data is helpful on a number of fronts in the SBI’s mission to advance the access and 

adoption to Broadband. Survey data provides an important, albeit broad, gauge for assessing coverage 

information obtained by providers. For example, areas with widely available coverage (according to 

provider information), but lower consumer subscription levels (according to survey results), or perhaps 

where survey results suggest Broadband is not available, can be examined in more detail. Survey results 

are also very important to the Broadband planning (and capacity building) components of the SBI 

program in that they help inform and formulate Broadband advancement priorities. Survey results also 

help inform Broadband policy discussions on both the local and state levels. Finally, survey results 

provide important information to the service provider community regarding market demand and 

specific Internet use in specific communities (i.e., regions).  

Our ongoing consumer survey process adheres to a consistent process. For example, consistent with 

prior practice the 2011 Alabama survey was launched in June 2011 with a test number of survey calls to 

confirm (and adjust as needed) the structure of the survey and the underlying survey process. Our 

surveys typically run for three to four months.  All telephone surveys are completely random beginning 

with the acquisition of a list of state-specific, randomly selected landline telephone numbers.  Mobile 

phones are not typically included in the surveys. Upon evaluation of the survey statistics, auxiliary 

surveys are executed to ensure appropriate representation is achieved on both demographic and 

geographic fronts. For example and as noted above, the recent Alabama survey was augmented with a 

field effort to ensure the younger demographic  (i.e., age 18 – 25) was adequately represented. This 

secondary step is required because of the continued migration (by younger markets) to non-landline 

based communications. This younger market is also surveyed by reaching out through social media 

outlets to encourage their participation in an online survey process. 

Survey statistics from the Alabama update survey are currently being developed and evaluated. Survey 

statistics from our initial surveys in Idaho, Wisconsin and Wyoming were summarized in our last filing.  

Survey volumes are designed to achieve statistical validity.  

As noted above, our telephone survey process is augmented by providing online access to the survey. 

Participation in the online survey is promoted on all of our state-specific public web sites and selected 

social media. 

As a final relevant point with respect to the consumer survey process the length of the survey is 

noteworthy. By survey standards, these tend to be long surveys. The surveys typically average just over 

fifteen minutes.  While this clearly contributes to the number of survey call attempts that were required 

to reach the level of statistical validity, it is not insurmountable.  
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Social Media 
The phenomenon of social media is widely documented and yet still emerging as an effective access 

point for public engagement. We continue to explore appropriate ways to use a variety of social media 

venues in our SBI efforts. All of our efforts are informed by and consistent with relevant state statues 

and guidelines. Different states have different perspectives on if and how the state will participate in the 

use of social media. Some state requirements are well defined and some are still being formed. Where 

appropriate, we use LinkedIn, Facebook and Twitter to support our work. A central focus is on 

promoting awareness. As noted above, we are able to promote additional input on the consumer 

surveys through a social media outreach program aimed at our younger market segments.  

In addition, we continue to evaluate how Facebook and Twitter can be used to drive public input on two 

important crowd sourced issues: online speed tests and input on map accuracy. Based on data obtained 

through our web site traffic monitoring process and readily available social media tracking processes, 

our most recent results are promising.   

Capacity Building and Transitioning to State Partners 
A foundational goal of LinkAMERICA has always been to transfer knowledge and capacity to our State 

partners.  As we move into program year 3, distinct tasks are migrating to the responsibility of our State 

partners.   

Within each State, transition planning and responsibility for specific activities is on a slightly different 

timeline.  Much of this is driven by resource availability and partner identification within the State.  For 

example in round 3, the State of Alabama used interns to validate Community Anchor Institution (CAI)  

data.  In this submission Alabama took on greater responsibility for the CAI submission.  To support this 

LinkAMERICA developed a detailed transition document describing the current CAI efforts. 

Other States are looking more towards program year 3 and the in-State hire of a Broadband Coordinator 

as the initiation point to support their transition efforts. 

Data Production Process 
To support our objective of transitioning the data development process to our State partners, we 

continue to model and document our data production process.   We find this to be a very beneficial step 

for two purposes.  

First, it helps us understand why (and if) a task is being done, and if it is being done efficiently.  Much of 

this program started so quickly that it was difficult to plan logical integration and hand off points among 

the various workgroups.  Further, we are currently in the process of consolidating much of the process 

data (check-ins, check-outs, metadata) and we can use this process model to efficiently plan a cohesive 

information architecture. 

Second, our process documentation and modeling helps explain why resources are being consumed in a 

particular way.  This helps our State partners plan for in-sourcing specific tasks as their time and 
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budgetary constraints allow.   It also helps our LinkAMERICA team better plan and cross-train members 

to deal with the work surge that occurs 30-45 days prior to submission. 

Finally, documenting and modeling our process helps us to take advantage of increasing specialization 

and proficiency with certain types of data and management responsibilities.   In submission 3, we had 

identified data “czars” responsible for check-in and check-out of data.  That data czar helped to bridge 

the gap among receipt functions, provider feedback, production and DBA.  

 

Figure 1—SBI Data Development Business Process Diagram 

 

Data Production Methods 
As raw data were received from the provider community, attention turned to normalizing the disparate 

submission formats5.  The team considered each submission with respect to the following criteria.  

These criteria are important because they perform the basis for our verification and quality assurance 

                                                           
5
 In line with NTIA Best Practices we continue to request and receive a large number of data input formats.  This 

ranges from tabular Block lists to hand drawn maps. 
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process.  In other words, we have to appropriately scale our data verification efforts to match the scale 

or ambiguity of the following: 

 Locational certainty 

 Speed certainty 

 Temporal certainty 

 provider and network ownership certainty 

The team’s goal was NOT to quantify a particular degree of precision with respect to any of these 

criteria.  Rather, we are working to attribute the above “certainty attributes” to each submission, and 

will continue to implement quality assurance and verification mechanisms that are resource-appropriate 

for each. 

Deriving Broadband Coverage Information 
Broadband Coverage6 was normalized into four formats:  

1. Coverage in Census Blocks (2010) of 2.00 or less square miles 

2. Covered Street Segments (2010) in Census Blocks greater than 2 square miles7 

3. Address Level Coverage (point data) 

4. Wireless Service Areas (SHP file format) 

With each submission, the team went through a series of steps to normalize and categorize the data. 

Since data arrived in many different formats, and at many levels of granularity, the following 

normalization procedures were used:  

1. Determining the nature of service being provisioned (who is providing service and what 

technologies are in use) 

2. Planning an attack strategy for the submission –understanding the data and assigning team 

members to various tasks 

3. Geo-referencing the data; QA the geo-referenced data  

4. Geoprocessing the geo-referenced response 

5. Segregating the submission into the correct NOFA-compliant submission formats. 

6. Apply appropriate source metadata8 

                                                           
6 Speed, Anchor institutions and Middle Mile facilities are discussed in later sections. 

7
 To help clarify issues relating to Census block area and vintages in use, our team published a technical paper to 

the Grantee workspace.  Because we were unsure if this standard should be implemented uniformly, this 
document was never distributed to the provider community. 
 
8
 When our team logs a submission into the staging database we record at least two attributes.  One records the 

method used to derive the coverage, the other records the method by which speed was attributed to that object.  
Other attributes carried to NTIA carry source meta values as well. 

https://sbdd-granteeworkspace.pbworks.com/w/file/33293657/Technical%20Reference%20Document%20Final.doc
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Figure 2-Broadband Coverage Process 

Impact of Program Change 
There were several important program changes that impacted how Broadband coverage was developed 

and submitted to NTIA in Round 4. 

Census Conversion 

The first and most obvious change in submission 4 was the conversion to a Census 2010 coverage 

baseline.  This impacted all wireline providers, the data submitted, the appearance of the mapped 

information and the baseline coverage metric comparisons against prior submissions.   

Release of the June 30 Grantee guidance document, allowed LinkAMERICA to communicate this change 

with providers.  LinkAMERICA provided by FTP access appropriately formatted and sized9 TIGER 2010 

Census blocks and Tiger Road Segments.  Given the relatively late release date, we received a mix of 

responses from Broadband providers.  Some easily produced Census 2010 information.  Others 

requested that we do the translation from their supplied blocks and segments.  Others requested that 

we translate their engineering data into appropriate formats.  A small number of providers committed 

to producing Census 2010 data but struggled internally with the conversion in this rapid time frame. 

Census 2010 has significantly more Blocks than Census 2000.  For the most part there are far more small 

Census 2010 blocks (less than 2.0 sq mi) than Census 2000.  As our team worked through the QA 

process, this presented a significant challenge in comparing our converted results to prior submissions.  

We use a block count metric as our first test of consistency across submissions.  Since the block count 

                                                           
9
 In Submission 3 we released a technical note describing how we measure Census block area. Although there 

remains no consensus on this, we used the same process as outlined in the paper. 
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increased it was hard to distinguish coverage area changes from coverage chances resulting only from a 

change in Census shapes.   

The converse side of this challenge was even more precarious to work through.  Because many road 

segments dropped out due to the covered area now being in a small block area it was difficult to 

determine how effective our covered segment process was given the fact that many segments naturally 

dropped out due to changes in Census shapes. 

The tendency for large blocks becoming small was not universal.  We note in some of our very rural 

areas of Wyoming and Idaho, small block covered areas become large.  This created a contrary situation 

where small blocks become road segment areas. The image below shows a coverage area change 

between submission 3 and 4.  The covered number of blocks is comparable but the appearance of the 

coverage is different as a manifestation of the Census change. 

 

Figure 3--Coverage Change across submissions 

This somewhat indeterminate process required our QA analysts to examine a number of submissions in 

detail.  The conclusion was that although the appearance of coverage was significantly different, the 

underlying engineering data was the same (or very similar) but how the coverage was manifested was a 

product of the Census conversion. 
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Census Conversion Practices 

Although we had hoped there would be a single process we could follow for all Census conversions our 

experience has been that it is necessary to be flexible and base the Census conversion process upon the 

data received.   

On a subjective level, we felt the most comfortable converting into Census 2010 where we had facility or 

demand data to guide the block and segment selection process.  In these circumstances we used 

geoprocessing methods like intersections or network analysis Analyst to make an objective 

determination.  The geoprocessing methods mirrored those discussed in the next section.   This was 

probably the majority of our submitted data. 

In circumstances where we were provided Tiger 2010 blocks or segments, we used those as given and 

performed our standard validation process.   Some providers used the TIGER blocks and segments which 

we supplied them and made their own selections. 

Finally, in circumstances where we had either a Census 2000 block list or a geographic file containing 

Census 2000 geographies and were told there was no coverage change for this submission, we used the 

Census crosswalk tables10 to derive a list of candidate blocks.   The output of a conversion process is 

shown below. 

 

                                                           
10

 See http://www.census.gov/geo/www/2010census/rel_blk.html 

http://www.census.gov/geo/www/2010census/rel_blk.html
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Figure 4—Block Conversion Process, Census 2000 black outline, no fill.  Green is 2010 large blocks, so any shading without an 
outline is 2010 block area not covered in 2000 

For the most part it is difficult to discern the impact of a conversion into Census 2010.  We don’t see vast 

changes in areas covered.  Nonetheless because the block shapes do change the overall coverage area 

will look different.  

As the 2010 data gets pushed into public deliverables, our sense is we will receive questions about the 

appearance of the new data.  

Speed Examination 

Given recent concerns about the depiction of speed and what that mapped speed represents, 

LinkAMERICA invested considerable time requesting detailed information on speed which appeared to 

be beyond normal speeds for a given Technology of Transmission given the NTIA supplied frequency 

tables. 

Based upon these conversations we learned 

A) For a large incumbent telephone provider; the speeds beyond the normal DSL range 

represent significantly shortened copper loops. 

B) For a large national cable provider the intermixing of Docsis 3.0 and non 3.0 systems in a 

market area is typical and sometimes reflects a circumstance where segments of plant cannot 
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be upgraded to Docsis 3.0.  This variance can be at a level below the Census block. In these cases 

the maximum advertised speeds remain to represent the market area but the plant variance is 

typical.  This same provider expressed concern with moving reported advertised speeds below 

the market  level. 

C) We have a minority of providers who submit a theoretical speed that is unmatched by their 

web advertising.  In these cases we request clarification from the provider on the inconsistency.  

Our experience has been that providers will modify the speed to be consistent with their web 

coverage. 

Provider Definitions 

Within our provider verification process we work to derive a state level provider match against third 

party data sources.  As discussed in the early pages of this manual, there is no guarantee that a third 

party data source is any more accurate than submitted data, nor does it necessarily reflect the provider 

ecosystem specified in the NOFA, Technical Appendix A.  We devote significant resources to matching 

our submitted data against three, third party data sources.  In many cases this becomes a judgment call 

trying to match provider names across systems.  It is a difficult and somewhat arbitrary process.  

Nonetheless we do believe it has value because it forces a re-examination of who we believe is an 

appropriate provider within a non-NOFA context11. 

The use of a provider match system, as well as the webinar comments (3/17/11) directing grantees to 

estimate, wherever possible, non-participating providers have made us back away from one of our 

fundamental assumptions in data collection.  As discussed in the prior draft of this manual, we had 

developed a certain “hold-out” class of data when a provider’s data wasn’t of sufficient quality to verify, 

or we were unable to put it into the data model (eg. address points submitted for a wireless).  In this 

submission, much of this hold-out data has been included12.  In some cases this means we are using 

simple polygons to capture a wireless ISPs serving area.  Other times, if we are confident in the 

coverage, but can get little clarification on the submitted speeds or frequencies, we release the 

coverage and note in our internal metadata the source issues with the other attributes.   

Finally, we have used the new provider type classification of ‘other’ to bring some aspect of the 

provider’s data into our submission.  There still seems to be confusion on how to handle provider types 

where a provider offers multiple paths to provision Broadband for typically business customers.  Rather 

than waiting for certainty on the answer, we bring the provider in and list them as provider Type 

“other”.  Our sense is provider Type “other” will continue to expand in subsequent submissions.   

                                                           
11

 We have requested from NTIA information on how provider matching is done within their QA process; beyond 
the relatively short whitepaper posted with the national map <http://www.broadbandmap.gov/blog/wp-
content/uploads/2011/02/DataComparison_Methodology2.pdf>, we have not received any more detailed 
information on how providers are cross verified between submitted and third party sources at the national level.  
Our understanding is licensing concerns are holding the release of this information. 
12

 We continue to process older submission data looking for information and methods by which we can estimate 
coverage information.  This will be an ongoing process. 

http://www.broadbandmap.gov/blog/wp-content/uploads/2011/02/DataComparison_Methodology2.pdf
http://www.broadbandmap.gov/blog/wp-content/uploads/2011/02/DataComparison_Methodology2.pdf
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Clearly one challenge is the data, but an equally significant challenge is appropriate messaging around 

this “other” provider type category.  We do not want to leave consumers with the impression that they 

can get a high capacity fiber or microwave link despite the fact that the hospital next to them in the 

same Census block can get this service. 

After the Grantee conference, LinkAMERICA submitted a paper describing our provider classification 

system13.  It is our feeling that understanding the type of provider is essential to appropriate verification 

methods.   

Coverage Geoprocessing Methods 
The next section discusses how data were georeferenced and geoprocessed given a particular 

submission format.  We have yet to find a particular method that works across all submissions.  Rather 

we tend to tailor our geoprocessing to meet the specifics of the service provider and data submitted. 

In most cases, in Round 4 we were still not provided with street segment level information for Blocks 

greater than two square miles (large Blocks).  This necessitated subsidiary geoprocessing.  As stated 

before, our first goal was to derive block level coverage.  Then, for Blocks greater than 2.00 square 

miles, we moved to a segment gathering processing.  The segment process will be described in the last 

section.14  

Block Level Coverage Derivation Using Service Point Data 

A number of providers submitted point level customer data.   

In some cases the submissions themselves were not internally consistent.  For example, in the image 

below, unprojected points are shown, while the Census block polygon to which the points are supposed 

to “belong” is highlighted.  In this case, one of the following scenarios has occurred:  block attribution is 

wrong, the points are not in the location to which they are attributed, or different block shapes were 

used than what is assumed. 

 

                                                           
13

 https://sbdd-granteeworkspace.pbworks.com/w/file/42309493/provider%20ClassificationFINAL.docx 
14

 As has been discussed previously, we note inconsistency in how providers are supplying information at the block 
and segment level.  Beyond the temporal differences, we see that providers are computing area differently, as well 
as including or excluding water areas.  This provides an inconsistent measure across providers for the 2.00 sq mile 
cut off.  Our preference would be to provide guidance to service providers within our states, but our concern is 
that we will inconsistently message this with grantees in other states.  We would appreciate consistent guidance 
from FCC/NTIA on this topic. 
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Figure 5-Internal inconsistency in submitted data 

In other circumstances, we found that inconsistent geocoding standards may produce misleading 

results.  The next image shows point level data, and the Blocks are colored based upon the counts of 

points intersecting Blocks.  The challenge this presents is that if geocoding was performed on a different 

dataset than the block boundaries (the road traces are not coincident with block boundaries) and/or 

geocoding was done without an offset, it becomes problematic to assign coverage to a Census block 

based upon only the point locations. 
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Figure 6-Block Coverage 

For this reason, where we were provided address point data and asked to generate covered  Census 

blocks, we elected to use a 200-foot buffer to select Census Blocks that intersect our points.   

We are also starting to see a number of providers submit customer data and facility data.  Their intent is 

to allow us to have two primary sources from which to derive the most accurate coverage.  In these 

cases we tend to look for clusters of customers in areas where we see no facility based coverage. 

With respect to deriving Block level speed from sub-Block data, we have instituted a business rule where 

the predominant speed in a Block is the speed we attribute to the Block. 

Block Level Coverage Derivation Using Customer Facing Plant Level Point Data 

In other circumstances, providers submitted point level plant data.  From what we could gather, these 

points tended to be customer-dedicated terminals.  Typically, these providers were high speed 

Broadband producers—which may somewhat strain the definition of Broadband as other providers 

supplying comparable services specifically disclaimed the ability to provide high-capacity Broadband 

services in the required 7-10 day interval.  In these plant point data submissions, we had similar 

concerns to the point level customer data, but two factors tended to make us use a more conservative 

intersection buffer.  First, we tended to have far fewer points to work from, so our concern was 

grabbing too many covered Blocks as the Blocks tended to be much smaller in these urban areas.  
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Second, these plant points tended to be dedicated to distinct customers, but it was difficult to know 

which element of the customer’s campus to attach coverage to. 

In the case of the image below, given a small shift to the left, it would be easily possible to gather 1 to 3 

Census Blocks from this point.  Although orthoimagery is helpful in a circumstance such as this, it is still 

indeterminate.   

Thus, in the circumstance of plant level point data, we used a 100-foot intersection buffer. 

 

Figure 7-Plant Point level data 

Coverage Derivation Using Linear Facilities Data 

A number of providers submitted facilities data.  We handled this data in different ways depending upon 

what we believed the facility data represented. 

Most telecommunications networks are divided into two components.  Feeder supplies higher capacity 

nodes (eg. DSLAMs, Fiber Nodes).  Distribution usually supplies customer premises (NIDs, Pedestals, 

Taps, ONTs).  Where we could discern what strand we were provided, we used different methods. 

The next image demonstrates a geo-referenced CAD image as given to us by a Broadband service 

provider.  Note the light and dark green shading.  We would infer that the lighter segments represent 

distribution and the dark green represents the feeder network. 

In the case of a combined strand map, we used a relatively tight buffer of 200 feet to gather covered 

Census Blocks.  Our intersection tolerance is based upon an assumption that our data likely represent a 
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situation comparable to customer point level submission in that we have most of the network footprint 

captured. 

 

Figure 8-Georeferenced CAD information supplied by Broadband provider 

 

In other circumstances, we were provided engineering information that we inferred to be feeder only.  

This inference was typically based upon the presence of fiber optic equipment only.  In these cases, we 

used a more generous 2,000 meter Census block intersection.  The 2,000 meter criteria was based upon 

an informal survey of population in proximity to the geo-referenced strand data, but it could be varied 

based upon a more complete survey. 

Coverage Derivation Using Covered Street Segment Data 

In some cases we were provided with covered street segment data.  Covered segments tended to come 

from two sources. 

In some circumstances, providers gave us CAD data, which was not drawn in a projected manner.  This is 

relatively common for older engineering data derived from hand drawn records.  This meant that our 
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team geo-registered the image into an approximate position.  In this case, the boundary streets were 

selected, and an enclosing polygon was derived.  The intersection of this polygon and the Blocks within 

became the geoprocessing method to derive Blocks. 

 

Figure 9-Coverage derived from street segments 

In a second circumstance, street segment data was developed during coverage estimation.  Handling the 

estimated data is discussed below. 

Coverage Derivation Using Serving Area Point Submission Data 

In other cases we worked with providers to derive service areas based upon point plant data.  In these 

cases we were given a serving node and an appropriate road length service boundary. There is an 

important distinction from the plant data discussed above. In this specific case, the data submitted was 

a node that served many locations--such as a Central Office or DSLAM.  This is contrasted with the 

earlier example in which the point represents a node serving only a few customers.   
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When trying to derive coverage from Central Office or DSLAM nodes, the team used ESRI Network 

Analyst to derive covered road segments honoring these road engineering parameters. 

The figure below shows street level coverage derived from Central Office and remote DSLAM point data.  

 

Figure 10-Coverage derived through road paths 

In response to Provider feedback we revised this process to include a larger variety of TIGER road types.  

In Round 1, unimproved roads were not used.  In the current submission -- particularly to improve 

estimates in areas bordering parks and public lands -- a wider class of TIGER roads was used.15 

The segment level coverage is easily extendable to derivations of Census block level speed.  The figure 

below shows the attributions of block level speed based upon the Maximum Advertised Speed available 

from a DSLAM.  Although the methodology isn’t perfect, it does provide insight into the value of 

granular infrastructure data. 

                                                           
15

Only TIGER features of MTFCC type S1100 and S1200 were excluded from use. 
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Over time we have seen an increase in the number of providers submitting this type of data for our use.  

Our sense is some providers find plant level data easier to generate and are satisfied with the results of 

derived coverage. 
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Coverage Derivation Using Polygon/Polyline Serving Areas 

Broadband service providers sometimes submitted coverage in terms of served areas.  This was either in 

direct geospatial formats, CAD files, or paper maps.  The image below reflects a carrier’s service area.   

Within that service area, there are variations in technology of transmission and served speeds.  When 

polygons with speed data and technology of transmission were available, we used a spatial intersection 

to gather covered Census Blocks.  In many cases, using covered Census Blocks resulted in a loss of the 

speed variation (sometimes the speed variation was at a level smaller than a Block and did not get 

picked up within a spatial query).. 

 

Figure 11-Coverage derived through serving area polygons 

Although we cannot directly solve the loss of speed granularity due to Block shapes, we honor a 

business rule wherein we always select Blocks from the highest speed areas first, and then allow the 

lower speeds to select from the remaining Blocks.  This is an arbitrary rule, but our feeling was that it 

should be a consistent selection, rather than an unordered selection. 

Street Segment Derivation, Large Blocks 

For those calculated Blocks greater than 2.00 square miles (large Blocks), we provided coverage in terms 

of covered street segments and corresponding geography.   

With respect to segments we had four sources of data: 

1. Covered large Blocks 

2. Tabular street segments and address ranges for large Blocks 
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3. Geographic segments either with street attributes or without 

4. Service area boundaries 

A number of providers only provided a list of covered large Blocks without corresponding segment 

information beneath the block.  This provided the dichotomy of either selecting all segments in the 

block, or none.  Because we had little information from which to make the selection, we elected to be 

conservative and did NOT pass any covered segments to NTIA from this submission format.  Some 

Broadband providers submitted covered street names and street ranges.  In these cases we performed a 

manual analysis trying to link to specific segment names and address ranges within covered Blocks.  

Sometimes this was a simple process because a provider used a TIGER derived street database.  In other 

cases we could not determine the source of the provider’s street data.  Street and Address matching 

tended to yield a relatively good result (typically between 30% and 100% of possible segments in the 

Block), but was very time consuming.  Where yield rates were low, our result was a shredded segment 

coverage pattern, like the image shown 
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below.16

 

Figure 12-Blue road segments adjacent to peach covered small Blocks 

A number of providers submitted geographic objects. In this case, our manual process was directed 

toward a conflation of data sources.  The goal was to take provider submitted segments and put these 

segments in terms of our TIGER 2010 basemap.  Although there is a trade-off in the accuracy using non-

provider submitted segments, we felt it was more important to have a road set that would edgematch 

our Block features and remain consistent with the Block size standards we used for other providers.  This 

is important for the appearance of the online maps, as well as potential verification work where we are 

attempting to judge a feature based upon its attachment to a covered small Census block.  The figure 

below shows street segment input data. 

                                                           
16

 We continue to hear providers expressing concern that our request for either a geographic object or TIGER Line 
ID is beyond the scope of the NOFA clarification. Therefore, they cannot supply additional information to us. 
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Figure 13-provider Submitted Street Segment Objects.  The segments don’t edge match the Blocks nor are they continuous. 

The figure following demonstrates the same area after the conflation process.  Blue segments are the 

conflated TIGER roads which will be passed to NTIA. 
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Figure 14-provider submitted segments in gold, selected TIGER  in blue—Conflation result; in many cases what was a 
continuous segment is made discontinuous because even with a distance buffer the TIGER segment doesn’t always intersect 
the provider segment 

 

The final segment process was used when we were supplied with a Broadband covered area polygon.  In 

this case, we found the segments within covered areas and eliminated those segments inside of Blocks 

less than or equal to 2.00 square miles. 

Because there was more control over the format of the inputs (we knew we had a boundary and were 

working with TIGER segments), this was an automated process that followed this general format: 

1. Select large covered Blocks by provider ID (from updated Large Block table) 
2. Select TIGER 2010 road segments (MTFCC like 'S%') that face (CB = CBLeft2010 or CB = 

CBRight2010) covered large Blocks for provider 



SBI Mapping Methodology Page 35 
 

4. Select segments as distinct records, max speed with corresponding technology, join in 
feature names, export selected records to temporary DBMS table  

5. Join TIGER roads feature class to temporary table on TLID 
6. Select covered segments (Python script)  
7. Select service area polygons for provider 
8. Clip selected facing segments with selected service area 
9. Export clipped segments to staging feature class, keyed by providerID 

In this figure, orange represents covered small Blocks; black lines are covered segments in large Census 

Blocks (light blue).  The service area boundary is shown in grey. Based upon feedback from providers, we 

have elected to clip segments at the end of a coverage boundary.17 

 

Figure 15-Output of the Segment Process 

Wireless Coverage Process 

In general, most providers of mobile Broadband submitted coverage information in a NOFA-compliant 

format.  Other than attributions for spectrum and speed, little was done to this coverage.18 

                                                           
17

 An outcome not discussed here is how to handle address ranges on segments.  As NTIA is asking for a Min and 
Max on the segment, deriving theses values for clipped segments is very problematic.  Also the prevalence of 
alphabetic characters in addresses makes the min/max selections very arbitrary.  We are grateful that addresses 
are nullable data elements. 
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LinkAMERICA continues to make aggressive efforts to bring additional WISP coverage into the NTIA 

dataset.  For the most part, our outreach was with providers who were unable to supply sufficiently 

granular data in the past or those that could only submit wireless address points which is no longer a 

valid submission format. 

In Round 4 fixed wireless providers generally either supplied coverage information or infrastructure 

from which coverage estimates could be derived.  Many allowed us to use their tower locations, 

antenna heights and direction/spread of coverage to derive a line of sight coverage estimate.  In our 

experience, this is a conservative and reasonable derivation of coverage. 

Some wireless providers submitted RF studies.  When this was done, there was a request that the signal 

strength be removed from coverage data.  The request was honored.  

Other fixed providers were able to supply us with hand drawn maps or polygons/polylines drawn in 

Google Earth format.  In these cases we did our best to georeference and verify the coverage areas with 

the WISP. 

When we received coverage information in KML format, like the image below, we accepted the data as 

it was presented to us.   

 
                                                                                                                                                                                           
18

 Some polygon data did exceed the node count threshold.  In these cases, data was rasterized to 100m cells and 
then converted back to polygons.  The polygons were dissolved to multi-part geometry.  This addressed the node 
count concern. 
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As the image above shows, in some cases we were provided hand-drawn coverage, as well as 

infrastructure.  Instead of estimating their coverage using a line of sight or RF study, we elected to stick 

with the provider’s supplied information.  Our decision was guided by two primary factors: 

 If the provider is advertising using this coverage they must have specific confidence in its 

accuracy. 

 If the provider can supply coverage, as well as infrastructure that reasonably supports the 

coverage, there is a very high likelihood in the accuracy of the information.   

The downside, of course, is the polygon shown on the map may not represent our notion of how 

wireless coverage should appear.  

In general we note several interesting trends in the wireless data.  First, we can be successful in 

increasing the amount of WISP coverage when we aggressively pursue WISPs.  This means we have to be 

willing to accept data on their terms and convey it into SBI formats.  Some of our WISP submissions have 

taken over 12 hours to normalize into SBI formats.  Second, we have to accept that some WISPs will not 

be able to supply FRNs.  There remains a minority of WISP providers who are not aware of the FCC FRN.  

Third, there appears to be some variation on how the NOFA coverage definition is met.  In other words, 

there seems to be a disparity on the necessary strength (e.g. -80 dB, -98 db, -120 dB, etc) to provide the 

appropriate quality of service for data services.  Fourth, it was very difficult getting providers to identify 

spectra used for Broadband data services19.  We are unsure if this is a competitive concern, or if the 

same coverage pattern is yielded for multiple frequencies.  Typically, the spectra returned were those 

that a provider was licensed for.  At this point, we have no reliable way to locally determine what set of 

frequencies are used to provide Broadband data services in a local area. 

Service Address Point Process 

A handful of providers have requested that customer level, service address point data be submitted to 

NTIA.  In these circumstances we have done minimal processing to preserve the provider’s intent with 

this deliverable and not bias downstream NTIA use. 

Our verification included checks against commercial or Public Utility/Public Service Commission 

exchange boundary maps.  Points not contained within one mile of a boundary are not submitted to 

NTIA.   The percentage of excluded data variesacross providers. 

We retain from the provider the provided latitude and longitude, as well as Census block.  For some 

coverage data, if a provider is unable to supply a longitude, latitude or Census block, we fill in these 

attributes.  In those circumstances where we do not have a Census block, but we do have a longitude 

                                                           
19 One provider responded by email, “This mapping program is to provide the coverage area for 

Broadband provided by a company. Not to keep a detailed account of every aspect of a companies (sic) 

network.” 
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and latitude, we accept the given longitude and latitude and use that as the basis for our Census block 

assignment. 

With point data we have tested for comparable geocoding success rates but do not overwrite provider 

information.20  From this type of analysis we note the amount (usually little more than 10%) of 

addresses that seem to locate with less than street segment certainty.  Deriving a thematic 

representation of the points on speed also illustrates some of the locational certainty issues in this point 

level data.   

Coverage Estimation Process 

Although the derivation of Broadband coverage into Census Blocks, street segments, or wireless 

coverage files is, in itself, a bit of an estimation process, there was an explicit estimation process 

required in cases where a Broadband provider either refused to participate in our survey, or provided 

such a threadbare submission that no carrier-based coverage information could be gleaned21.   

We typically resorted to three possible estimation paths. 

For Cable (HFC) providers who did not provide any coverage information, we fell back to Media Prints 

data.  Rather than using the entire Census Block Group gathered by Media Prints, we used only those 

Census Designated Places carrying the same or similar names to the Media Prints p_com field.  Our 

reasoning was that Cable systems tend to be franchised on a municipal or at least administrative basis 

so the coverage will likely follow a governmental boundary.  As a general rule, cable infrastructure is not 

available in the public domain22 and what could be found was poor in quality and difficult to ascertain 

for validity.  

For DSL providers who did not provide any coverage information, we estimated road-based coverage 

from their Central Offices23.  We only used Central Offices that showed evidence of DSL or fiber-based 

services in the NECA 4 tariff.  Road-based engineering areas were derived via ESRI Network Analyst to 

18kft.  These segments/boundaries were clipped to commercial wirecenter boundary edges.   

For mobile Broadband providers who were non-responsive to our requests, we fell back to American 

Roamer coverage patterns.  We generalized the American Roamer coverage to ½ km in order to protect 

the licensed information. 

For fixed wireless providers who provided no coverage information, we relied on their public websites to 

derive coverage maps.  When these maps were available, we georeferenced them and tried to use the 

                                                           
20

 We will make a second geocoding pass on locations with no longitude or latitude from provider.  We typically 
pick up ~5% from our second geocoding pass.  Typically the issue is address quality but also difficulties in 
geocoding in very rural areas. 
21

 We report estimated submissions to NTIA as a non-responsive provider but we have data in the submission for 
them.  This is the reason for datapackage.xls entries which are non responsive but contain submitted data. 
22

 The team tried to use data from the FCC Coals system and 321/325 fillings but this seemed to be a bit non-
uniform in quality. 
23

 Central Office location was derived from MapInfo ExchangeInfo Professional.  Wirecenter boundaries also came 
from this commercial product. 
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outer polygon boundary to represent their serving area.  In other cases, when only a tower could be 

provided, we used a view shed analysis and estimated coverage at 10mi per tower24.  Because much 

wireless propagation is driven far below the Census Block and much engineering information isn’t 

known (frequency in use, polarization of the signal, coverage pattern of antenna(s), local terrain/land 

cover) this was the most complicated group to estimate.   

Speed 

Speed attributes are reported both at the block (typical) and higher levels (maximum advertised and 

subscriber weighted).  We note that in many cases, providers did not supply typical or subscriber-

weighted speeds.  In some cases, it appears--although we cannot verify--that their maximum advertised 

speeds were used to populate typical speed columns. 

We do have limited testing data on reported speeds, but we have been careful to not use our typical 

reported values with carrier-provided information.  If we do not have a speed value from a provider, we 

report an empty value.   

Several service providers claim they do not have data on typical speeds available, but estimate a 20% 

overhead factor between the advertised speed and what may be experienced by an end user. 

We continue to request advertised speed at the block level.  Nevertheless we appear to be getting 

speeds that do not vary over a large geographic area – leading us to believe that providers may still be 

submitting the maximum speed advertised in local media for the entire market.  For the most part, we 

have been unsuccessful in messaging that advertised speed should not correspond to a market area, but 

instead, the maximum speed, which can be provided to a household—what some may describe as a 

‘qualified speed.’25 

As a general rule, in circumstances where a provider supplies a range of speed attributes, we assign 

NTIA categories based upon the midpoint of the range. We follow this rule unless we can determine 

other grantees are handling the same submitted information differently. 

To support NTIA program office requests, we have also modified the structure of the Service Overview 

table.  Even if Maximum Advertised Speed is supplied at the market or county level, we push that speed 

down to the contained Blocks.  The only records that remain in this table, will be those wireline records 

with either a non NULL nominal weighted speed or ARPU value. 

                                                           
24

 In some cases we had an approximate radius of coverage but no height.  In this case we used a 50’ height 
estimate and then clipped the coverage to the provided coverage range.  We also clipped wireless coverage to 
honor state boundaries but did not look for providers serving coverage with out of study state facilities. 
25

 As an example of a response to our request for Block level advertised speeds, we received the following 
comment from one anonymous provider, “This is and of itself does not require anything new of us – just states the 
NTIA supports efforts focused on getting that information on the CB level.”  It would be helpful to have broader 
messaging so that providers understand this new direction.  
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Community Anchor Institutions 
In the first submission, the Community Anchor Institution (CAI) process was referred to in terms of a 

learning curve.  This continues to be an appropriate metaphor.  The mapping team continues to focus on 

data that will support and help inform policy makers and the SBI planning process. 

In the first submission, the team gathered information on what data was available and what resources 

will be required to engage these categories of important institutions.  In the second submission we 

continued to obtain additional connectivity information.  For the Spring 2011 collection, the team began 

a survey process to directly engage these important organizations.  As the October 2011 submission 

represents a transitional phase, much of the CAI effort encompassed getting this dataset stabilized for 

work outside the LinkAMERICA team.26   

 In the current submission we worked to achieve four goals 

1) Modify the source data so as to no longer pass NTIA any connectivity estimates 

2) Propagate administrative capabilities in our Community Anchor Verification System (CAVS) systems to 

the Regional Planning Teams 

3) Verify the available connectivity information based upon new survey information 

4) Update the Federal record identifiers (NCES codes, etc). 

CAI Philosophy 

Our work with CAIs is guided by three principles. 

First, CAIs are important stakeholders within the planning process.  Our goal is to engage participants in 

regional planning that have strong ties into the CAI categories identified by NTIA.  This has a direct 

benefit of engaging an established stakeholder community.   It also allows Broadband planning to tie 

into existing organizational and planning networks.  In each of our states, key relationships with 

education, public safety, libraries, and economic development sectors are being identified and 

developed. 

Second, we believe that CAIs will likely be one of the primary beneficiaries of targeted Broadband 

funding.  Our belief stems from the sense that many of the benefits of Broadband will extend from these 

community ‘anchor points’.  In other words, it isn’t solely the existence of Broadband at a library that 

provides a benefit.  It is people using applications that work only on a Broadband network to upgrade 

their skills (e.g., online training) and gain access to online content (e.g., job postings, goods and 

services), etc.  The targeted use of a specific application--that can only take place with Broadband 

networks-- is what produces the priority benefit.  Put another way, there seems to be a realization that 

                                                           
26

 LinkAMERICA began transitioning the CAI data collection effort in the state of Alabama to ConnectingALABAMA 
in Round 3.   For Round 4 ConnectingALABAMA assumed full responsibility for the CAI data collection effort in 
Alabama.  To facilitate the reporting process, the ConnectingALABAMA team continued to use the Community 
Anchor Verification System (CAVS) to store CAI data collected or modified.  CostQuest maintained responsibility for 
the CAI data submission for Alabama for round 4. 
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things are less about pure connectivity (for the sake of connectivity) than about connectivity in terms of 

an application (for the sake of the benefit obtained through the application). 

Third, we continue to use a rational and targeted approach to derive information.  This means we will 

utilize our planning teams for as much ground work as possible.  This also means that a goal of our CAI 

process is not an exhaustive Census of anything that could be a CAI; rather, it is the discovery, inventory 

and integration of Broadband planning activities into those CAIs that stand to produce the greatest 

synergies with the SBI planning process.   

The above implies two significant points.  First, the team’s goal is to document community anchor 

institution connectivity within a broader context of regional and statewide planning objectives.  Second, 

if a particular category of CAI has an independent Broadband planning effort underway, we will 

encourage that organization to take the lead, and we will provide relevant expertise and support as 

warranted.  For example, in one of our states, the public safety community is already engaged in a 

mobile Broadband survey effort.  We have aligned our CAI data collection process with that effort and 

are sharing information and expertise (e.g., hosting a survey) to support their mission.  In another state 

we are attempting to glean connectivity information from a municipal government survey.  There may 

be some downside to this collaborative approach in that we may have to work with data spanning 

different times or we may not have all of the location-specific information we need, but this does 

prevent the same user from receiving multiple inquiries. 

 

Anchor Institution Survey  
During the third submission period we designed and developed a simple on-line survey system called 

CAVS (Community Anchor Verification Survey).  The intent of the survey was to both verify received 

connectivity information and garner additional connectivity information from CAIs.  For round 4 we 

continued the use of the on-line survey process.    Although we have found that reaching out to central 

contacts, for specific institution groups, is the most fruitful way of collecting connectivity data we find 

value in inviting individual anchor institutions to participate through means of a survey.  From our 

perspective this approach gives the individual institutions an opportunity to become engaged in the 

broadband planning process.  The link for the survey is housed on the Home Page of the website 

developed for each state, thus providing the added opportunity for responding institutions to learn 

more about activities  in their state.   

The survey remains open between collection periods to provide opportunity for the Regional Planning 

Teams to update information as they engage with the community and to allow responding institutions 

to update their data as necessary.   
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Anchor Institution Trends  
At this point we have focused our CAI attention on schools and libraries, with respect to connectivity.  

We benefit from strong relationships throughout the education sector (K-12 and Post-Secondary).  We 

have also found excellent resources within State librarians in all States. 

To supplement the education and library information we have formed organizational relationships with 

the major hospital associations within each state.  Our goal with this relationship is to cull information 

from their planning process.  We continue to formalize/advance this relationship.   

As in the prior submissions, we rely on public domain sources of information for the public safety-

category .  Collecting connectivity data for this group continues to be one of our most significant 

challenges.  Our hope is that in subsequent submissions, we will reduce the size of this category and 

connectivity information specific to root nodes of the public safety network--such as County Emergency 

Operation Centers.27  At this point we have had minimal success gaining this information. 

Because we have a wide ranging population of CAIs in our data set we have a variety of Broadband 

services that don’t always fit NOFA parameters.  Services like PRI or T1 are classified into “other copper,” 

We also had difficulty obtaining both the upstream and downstream channel capacities.  In most 

instances, when it was logical to do so, we made the speeds symmetrical, but this is an assumption on 

our part.    If a site records bandwidth across several services (eg. video and data), we record the total 

bandwidth to give a picture of available site bandwidth.  We are also working to standardize our 

response to NTIA in circumstances where an entity shares a Broadband connection among a campus 

which is fiber fed.  In this case we use the total campus bandwidth and use the primary campus Internet 

connection. 

As a final verification step, we attempt to screen the CAI data for duplicate values.  Because many CAI 

are closely clustered together we perform the de-duplication based upon the ANCHORNAME within the 

ZIP5. 

Middle Mile 
Middle Mile information was collected directly from providers via survey or interview.  Middle Mile is a 

“chicken or egg” type of challenge in that it is possible to verify that the infrastructure exists, but 

extremely difficult to know what is the site is doing without engineering level assistance.  Although most 

providers submitted “something,” there was a significant variance in what that “something” 

represented.   

The purpose of this section is to record some of the comments and questions we have received about 

Middle Mile.  We hope this provides better context for our data submission. 

                                                           
27

 Within the public safety category, it is also very difficult to derive precise locations as many CAI are addressed to 
PO boxes. 
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Within the NOFA, Middle Mile was defined as (a) a service provider’s network elements (or segments) 

or (b) between a service provider’s network and another provider’s network, including the Internet 

backbone. (Collectively, (a) and (b) are “middle-mile and backbone interconnection points.”)28 

Given the existence of the “or” in this definition, providers submitted a variety of information.  Based 

upon the NOFA example, several fixed wireless providers interpreted Middle Mile in terms of the 

connection points from their towers to their own serving backhaul location.  The topology was 

commonly Microwave from their distribution towers to their NOC.  The NOC and towers were listed as 

the Middle Mile points. This seems to be consistent with the first definition clause (a). 

Telephone, Mobile Wireless, and Cable providers tended to remain either silent on the question, or 

would provide a single location in which Internet peering occurred (clause b).  A number of participants 

explained that the NOFA was quite ambiguous with data traffic moving back and forth over both TDM 

and IP networks--it was unclear where the distinction should be drawn.  As a general rule it seemed like 

many providers listed a single location where Internet Peering occurred. 

A number of providers refused to answer the question on grounds of confidentiality29.  Others would not 

disclose as their Middle Mile points are not owned--another company provides the physical and 

electronic connection to their network.  In other words, the entity providing Broadband is not the entity 

providing Middle Mile. 

Additionally, based upon the new Provider Type classification of “other,” we have started to integrate 

points provided by Broadband service providers not meeting the NOFA definition.  This includes POP 

locations and aggregation points for public / private networks.30 Within a given submission there were 

two final attributes that tended to concern respondents.  First, speed should be measured in terms of 

only data capacity and what exactly is “data” (e.g., can/should you segregate out voice or video), and is 

the relevant capacity of the physical connection, channelized to a specific virtual circuit on their 

network.   

Finally, a number of other providers were unsure of the height above grade measure (is this their floor, 

the street outside, etc).  We seem to have a combination of height above or below grade, as well as 

heights above mean sea level (AMSL).   

To the extent possible in our timeframe, we verified the location of a sample of Middle Mile points.  

Where we could see infrastructure that appeared to be consistent in location with other provider 

                                                           
28

 From http://broadbandusa.gov/files/BroadbandMappingNOFA(FederalRegisterVersion).pdf at 54, visited March 
28, 2010 
29  As received in email 9/30/10, “Due to security concerns and the risk of public disclosure of highly sensitive data, 

whether inadvertent or otherwise, ***REDACT***response to the Middle Mile and backbone interconnection 

request is limited to publicly available information available on {remainder not included}” 

 
30

 As discussed in our readme.txt file, a number of middle mile points were lost in validation due to their location in 
adjacent state.  This will cause a decrease in some providers relative to prior submission. 

http://broadbandusa.gov/files/BroadbandMappingNOFA(FederalRegisterVersion).pdf
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infrastructure, we felt that the location was accurate.  In some cases, the point provided seems sensible 

(is on a road, near other equipment), but using imagery, we couldn’t find a place where this type of 

connection could occur.  This wouldn’t be unforeseen, in that Middle Mile connectivity likely takes place 

in a protected environment much smaller than a standard Central Office installation.  

Mobile Wireless Coverage 
We have received mobile wireless coverage from most mobile Broadband providers in each state.  At 

this point we have cleaned the geometry of the data and attributed it with spectra and FRN as required. 

Provider derived coverage has been reviewed against the commercial licensed product for consistency.  

To a limited extent we also use licensing locations and tower infrastructure to spot-check supplied 

coverage.  This mode of verification remains complex, given the lack of facility-based information with 

mobile wireless. 

Finally with respect to mobile Broadband services, we note several trends. 

First LinkAMERICA used the NTIA supplied frequency tables to report speeds consistent with other 

grantees.  In circumstances where a provider supplied a range of experienced speeds, we used the 

portion of the range consistent with the most frequently reported Grantee value. 

Second where a provider reports multiple frequency bands in use but doesn’t distinguish these bands by 

submitted SHP file, we submit identical geometries but attribute one geometry to each submitted 

spectrum value. 

Third we are seeing a trend toward increasing Broadband speed.  As of this writing, there is not 

consistency across providers in how they attribute the advertised 4G speed values.  In other words, for 

some providers 4G means advertised speed categories increase.  For other providers, the speed value 

did not change. 

Verification 
Almost by definition, data verification is an ongoing and evolving process. Clearly, with each new data 

submission there will be a validation process at hand and at the same time, our team continues to 

expand and improve the efficiency and effectiveness our data verification routines. Consistent with the 

movement toward an fGDB export database and use of a data receipt script, much of our validation 

effort was spent in supporting the ETL processes into the required formats.  In future data submissions 

we will continue our work to stabilize and improve the business process that normalizes provider 

submissions into NOFA formats and expands in more depth on the confidence analysis within the data.  

Verification Standard 
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Our overall verification standard is focused on the level at which we supply processed data to NTIA.  This 

means that the vast majority of our verification process will be focused on ascertaining coverage for 

Census block’s less than 2 square miles and covered road segments. 

We are learning that Verification has multiple dimensions. 

Provider verification is finding providers who supply Broadband and discriminate out providers not 

meeting Technical Appendix A’s definition of Broadband.  

Identity verification is taking the provider’s categorized in the first step and ensuring that the provider 

either has a valid FRN or is assigned a default FRN.  Identity verification is very complicated because of 

the Technical Appendix A’s mandate to record data at the FRN, provider Name and DBA level.  Each of 

these attributes could be unique for a single provider going to market under different or the same 

names.  As a result, rolling up each provider into an identity collection that matches either the FCC data 

integration team or a third party Broadband provider’s data view, is very, very time intensive.  Identity 

verification is discussed in the earlier section-- Developing the provider List. 

Coverage verification is a broad term, but in our definition it boils down to determining if Broadband 

coverage is in the right place.  For a given provider, the question is whether the coverage is assigned to 

appropriate Census Blocks, road segments or area features.  Coverage verification can be further broken 

out into two distinct classes: 

 Technology verification, which is determining if the provider is listed with a technology 

consistent with their marketing information.   

 Speed verification, which is determining if the speed supplied for that block, road segment, 

point area file or market area is consistent with the technology and the marketing information 

received. 

The final verification dimension is consumer feedback and crowd-source verification.  This is a dynamic 

set of steps we are beginning to implement.  One side of this is responding to consumer concerns.  The 

second is using the crowd sourced data to validate provider claims and, if appropriate, update the map 

and the underlying data. 

At this stage, our working hypothesis (confirmed by our experience) is that there will not be a single 

dispositive measure to indicate Broadband coverage availability in a Census block or along a segment.  

From prior work, and examining our current provider submissions, we believe that there is too much 

variation below the submitted record to make a single binary yes/no indication.  Rather, there will be a 

series of measures that combine to provide qualitative confidence (a classification scheme) in our 

indication of Broadband availability at the block, segment, or wireless polygon level. We believe such a 

qualitative confidence scheme is both relevant to and supportive of NTIA interests, as well as the 

interests of our end-user community – that is, the states and citizens we serve through this program. 
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The intent of this section is to illustrate why we are moving toward a particular verification 

methodology.  Our team is learning as we go along, and will adjust and improve this thinking. But given 

our experience to date, this is where we are heading. As stated above: 

 First, coverage verification is at the level of data submitted to NTIA. 

 Second, coverage verification is enhanced when there is a secondary measure of availability 

(such as infrastructure presence or serving area boundaries) 

 Third, given the limited resources of this effort, the most important coverage verification 

process to implement is the erroneous dispersion of coverage.  These are the “islands” of 

coverage isolated by significant distance from other covered areas.  .  In other words, Broadband 

Internet likely doesn’t exist far away from other areas with Broadband Internet access. 

Before explaining our overall verification thought process, we have several examples, which illustrate 

the complexity of coverage verification. 

The first example is taken from a gentleman who requested a map change in Alabama.  His home is near 

the yellow dot.  The darker grey Blocks are covered Census Blocks.  The black lines are covered road 

segments.  He cannot receive DSL from his incumbent provider, although his neighbors can.  The 

incumbent carrier does have at least one structure in that block from which Broadband services can be 

provided; unfortunately his home is not served.   

 

Figure 16--Sub block variation 
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Because the SBI program requires the depiction of coverage at the block level, the above map has been 

correctly generated.  However, from the customer’s point of view, the map is inaccurate.  This requires 

us to explain that the maps are not intended to be a structure-level qualification, at which point some 

consumers question the value of the maps when seeking service information.  Of course, we also share 

this information with the incumbent carrier in the area so they are aware of a potential customer 

market. 

Beyond this type of one-off structure-level qualification, sometimes, as shown below, we have even 

larger gaps in provided coverage.  The image here shows an “outlier” block that could be an error, or it 

could indicate missing Blocks along a major road that should have been filled in.  In this figure, the 

outlier block is highlighted in turquoise. 

 

Figure 17--Dispersion in Submitted Data 

 

In this particular case, we are faced with a different verification question.  Based upon the properties of 

the neighbors, we believe this block should likely be covered (coverage interpolation,) but supplied data 

from the incumbent says otherwise.  

The next example shows where an interpolation process could require some adjustment.  The figure 

below shows a town level.  There are some smaller Blocks that are likely covered by interpolation logic, 

but we also do not want to extend coverage beyond a franchise boundary as in the areas shown in a box 

on the bottom of the map. 
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Figure 18-Where do you stop interpolating? 

From what we can gather from some providers, the submitted data—data with consistently high 

degrees of dispersion or coverage holes—tends to come from geocoded billing records.  In this 

paradigm, this means where there are no customers; service is not identified on a map.  The 

interpolation verification question then takes on two dimensions. 

First, if a provider has no customers in an area, how can we know if they would be able to 

provide service in a 7-10 day interval? 

Second, if we use the properties of neighboring Blocks to interpolate coverage, when should we 

stop (e.g., at a franchise boundary, at a certain distance, etc.)? 

We continue to work with providers to get additional information to help us better understand and 

contend with this type of circumstance.  However, we have not been entirely successful at getting 

franchise boundaries that would address much of the issue. 

The final map shows this dispersion problem, but to an even larger degree.  This solitary large block is 

likely the result of a bad geocode, but we don’t know, given the data that has been submitted by the 

provider and the “single customer in a block standard” set by the NOFA clarification. 
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Figure 19-Dispersion in covered Blocks 

Due to the fact that this situation is quite obvious in display, this type of problem is one that we are 

more aggressively trying to resolve.  Where a single block has no neighbor offering comparable coverage 

and is a specified distance beyond an exchange boundary, our approach has been to filter these Blocks 

out.  As of now, this filter is limited to incumbent DSL providers because we have a good source of 

exchange boundaries.   

The exchange boundary dispersion verification method breaks down when examining smaller providers 

who are more likely to CLEC into neighboring territory. In the figure below, the black line represents the 

exchange boundary, while the continuity in the DSLAMs likely points to coverage extending along a road 

into another provider’s territory. 

 

Figure 20--DSL Coverage outside of exchange boundary 
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In sum, the variability in our source data continues to suggest that our dynamic verification process is 

relevant, appropriate and evolving in a manner consistent with the overall program.  And, as noted 

above, we believe the more meaningful outcome of our verification processes will likely be a series of 

qualitative indicators or expressed confidence levels.  Our concern, as with the development of any sort 

of classification process, is how rigid we should make this classification given the variation in our input 

data and the varied perceptions of service providers, map viewers and down-stream data consumers.   

Verification Work Process 
To support our dynamic multi-factor verification process, we have implemented the following steps. 

First, when data is received, an analyst reviews the submission and any immediate questions or 

concerns are sent back to the provider as quickly as possible.  We have found this gatekeeping step very 

helpful in making sure we understand the intent of the submission.   

Second, for all providers who submitted data to us in the third round, they received both a tabular data 

summary and mapped output31.  Prior to releasing the “check maps” to providers, we had a team of 

analysts visually inspect each provider’s coverage area.  The focus on this QC effort has been to identify 

and flag suspect Blocks.  After this in-house review, we solicited a second level of feedback from 

providers and received a number of requested changes and corrections used in the development of the 

October, 2011 round 4 dataset. 

For those providers who submit only block or segment level coverage (i.e., in those cases where we have 

no infrastructure to test with) we test for coverage containment within known service boundaries.  The 

intent of this validation step is to remove Blocks that are obviously erroneous.  We also verify the 

submitted speeds against the typical speed ranges in the NTIA frequency tables.  If we note a value 

outside of typical range, we ask the provider for clarification. 

As mentioned in the sections above, we have implemented a check on dispersed Blocks, but we have 

implemented less with respect to coverage interpolation (holes in coverage). We continue to work on a 

series of mechanical tools to assist with the inspection process but have run into challenges related to 

geographic basemap and timing. 

As our submissions have moved online, we have also begun to benefit from crowd source feedback.  In 

some cases this has helped us identify and fix errors in our underlying data. In other cases, as we have 

shared with NTIA, we have encountered some perceptual issues rooted in how the data are developed 

and modeled to comply with the NOFA.  Depiction of uniform coverage in small Census Blocks continues 

to be a challenge. Despite our best efforts to explain the full block coverage requirement, we continue 

to receive complaints that the coverage shown on the map is not accurate for a particular location 

within that block.  

                                                           
31

 For the verification of round 3 data, we submitted both PDF and KMZ (Google Earth) format check maps.  Some 
providers prefer to work with the Google format as it supports easier modification.  Others continue to submit 
marked up PDFs. 
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Consumer and Provider Responses to Deliverables 
Here, we segue from internal verification to external verification.  We view responses to our work 

product as a form of validation and verification.  On the one hand, this gives us the opportunity to fix 

mistakes and then generate QA steps to make sure that the problem does not reoccur.  We also learn 

how to improve what we are doing or better explain what we are doing to a community not always 

familiar with the NOFA and program office framework.  On the other hand, listening and learning from 

this feedback helps us better target our mapping deliverable to meet the needs of our external 

customers.  In this second case, external feedback not only provides feedback on perceived qualities (or 

lack of quality) in the data, it helps us to learn if we are developing data that is truly helpful to 

downstream users. 

At this point, our external deliverables take three forms: State Broadband Maps, data transfer to NTIA 

used for the National Broadband Map, and text format data requested by outside parties. 

Online Map Experiences 

With our State maps are online, we continue to harvest viewer feedback and comments.  Because an 

online map allows someone to zoom in far below the scale of the data, a large number of comments 

reflect sub-Census block concerns. While important to the citizens reporting these issues and to our 

Broadband planning teams, this level of data is outside the scope of our core validation process, which 

as noted above, is focused on the level of data submitted to NTIA.  

There are several other themes that our team believes are important to share.  These comments are 

actually quite helpful because they also improve our data processes to better meet the needs of map 

viewers.  For example, we have invested significant time in harvesting more segments from provider 

data.  Because the appearance of segments is so important, we are putting time into ensuring a visually 

appropriate edge match between the roads we harvest and the Blocks/roads we will show online.  On a 

technical level, we also believe that a good segment process will help us understand more about 

dispersion in the data, and what is valid versus what is not valid. 

Online Display of Consumer Feedback 

We have completed development of a consumer feedback layer for our online maps. 

The intent of the new layer is to show viewers the feedback of other map viewers.  We anticipate the 

feedback layer will go live when the Round 4 data is posted on our state maps.  We expect this to be 

prior to the end of October, 2011. 
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Figure 21--Consumer Feedback Layer 

To gather feedback, we use a survey wizard which asks the end users to categorize their concerns.  The 

survey went through several iterations of design and usability testing.  Our experience has been unless 

we get a way to constrain the user feedback into manageable categories, it becomes very difficult to act 

upon. 
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As mentioned by other Grantees we struggle with how to use all of the feedback we receive.  The 

qualified data points seem to fall below a volume in which we can infer significant modifications to the 

map data. Nevertheless, we believe it is important to gather structure and display the feedback  to 

support project transparency.   

Perception of Unfair Treatment Across Technologies 

Several Broadband service providers have expressed strong concerns regarding how wireline services 

are displayed, as contrasted to how wireless coverage is displayed.  This is an artifact of the SBI data 

model. As an example, consider the figure below. 
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Figure 22--Multi Network Coverage portrayal 

In this image, covered Census Blocks are light gold.  Covered road segments are a darker gold and 

wireless coverage is purple.  The concern seems to come down to how a wireline provider’s coverage is 

shown in the large Census Blocks (greater than 2.0 sq mi).  Some wireline providers have expressed 

dissatisfaction because their coverage is only tied to road geography, which leads to a visual “hole” in 

their coverage map.  At the same time, they feel that it is unfair that the wireless provider’s coverage is 

shown to be uniform in the same area.  Put another way, if our maps show wireline in terms of Blocks 

and segments, why don’t our maps show wireless the same way?  

 Perceptions of Carrier of Last Resort (COLR) Obligations 

Some wireline providers have also expressed dissatisfaction because online maps limit the distance of 

coverage from a road segment.  In our current online maps we buffer a wireline carrier’s service 300’ 

from road centerline.  A number of providers have expressed that they are mandated to provide voice 

coverage (which Broadband will accompany) anywhere in the Exchange.  There seem to be many 

dimensions to this argument, but the basic concern comes down to not being able to accurately reflect 

the scope of their COLR obligation within the mixed block/segment view.  Their ability (or lack thereof) 

to actually provision such services for new users within a 7-10 day period adds yet another level of 

complexity when attempting to fairly portray their coverage capabilities. 



SBI Mapping Methodology Page 55 
 

Intentions of Coverage Mapping 

When a viewer of an online map clicks on the map (or zooms to an address), they are provided with a 

pop-up of service provider coverage in the area.  The critical question is this: what is the area to which 

that pop-up window responds to?  In the past, we reported back to the specific Census block, or 

buffered road segment intersected by the user click.  As far as the map was concerned, once we move 

off of that road, or out of that segment, we have a new area to examine.   

Our sense, given feedback received, is that our provider view should be a bit more tilted toward finding 

providers in a general area, rather than finding providers at a single-click location.  If the goal of the map 

is to get someone to call a provider for service, our bias should be to include all of the potential 

providers in the general area, rather than giving potential customers a method to self-disqualify.  That is, 

we want to cast a wider coverage net, rather than one too narrow.  The problem with this approach is 

that it will create a number of false positive Broadband reports.  As of this date we cannot determine if 

the claims of inaccurate coverage in online maps are due to the looser provider view standard or not.  

We keep this looser standard in place to minimize the likelihood of self-disqualifications. 

CAI Survey Fatigue 

We are beginning to note an increase in survey fatigue among CAIs.  Sometimes, as part of a direct 

survey process an end user will tell us how unhappy they are with the repeated Broadband survey 

efforts.  Within several states BTOP grants are in effect that also survey Community Anchor Institutions.. 

As stated earlier we will defer to other Grantees when there are overlapping survey efforts. 
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Appendix One  

Data Collection Challenges 
This section summarizes some of the challenges we have experienced with data collection and 

processing.  The team believes it is important to categorize these challenges as they help inform the 

geoprocessing and verification methods used.  It is also our hope that some of the more global issues 

can be discussed and decided within the Grantee community.  

We begin with several global issues and then continue toward more granular challenges. 

Global Data Collection Issues 

Census Block and Road Standards are not clear 

We receive a variety of Census data.  Some were able to supply 2010 Census blocks.  Others continued 

to provide Census 2000.  Managing this set of heterogeneous inputs has proved to be a challenge. 

There seem to be several methods by which providers are calculating the Census block area.  So the 

distinction between at 2.00 square miles can be uniform, it would be ideal to articulate an operational 

area calculation definition as early as possible. 

Providers Not Wishing for Block Level Aggregation of Their Data 

Both ***REDACT*** have supplied address point level data.  Both carriers want NTIA to have the point 

level information, and they have asked CostQuest/LinkAMERICA not to aggregate their coverage to 

Blocks.  Other than a verification to make sure that point data were contained within, or fell within 1 

mile of exchange boundaries, the only other processing was normalization into NTIA formats. 

Broadband providers not Meeting the NOFA  “provider” Definition 

PBWorks appears to reflect a concern among a number of grantees about what a Broadband provider is-

-and how that definition impacts mapping. 

If the 7-10 day provisioning rule is to be strictly enforced, it would seem to eliminate a number of 

prominent Broadband providers32.  Further, the need for clarification around a facilities-based provider, 

versus the reseller, has injected even more ambiguity into the mix.  Right now we are unclear on how 

strictly to interpret either of these important distinctions, but we are concerned that we are beginning 

to create an NTIA exclusion criteria that is going to confuse downstream consumers of the data.   

                                                           
32

 By email ***REDACT*** informed us they could not provision in 7-10 days, but they also supply information on 
qualified locations to the address point level.  Therefore, we draw a distinction between an incumbent provider 
owning the facility--which terminates at a customer premise--who cannot turn up service at a qualified location, 
versus a provider not reporting any specific qualified locations in which they cannot turnup service in the 7-10 day 
window.  In the first case we have a sense of where service can be offered and verified.  In the second, we have no 
evidence that a service could exist there until a specific location becomes a customer. 
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Again, we do not want to exclude a service provider, but we believe there needs to be further 

clarification around the 7-10 day ”rule,” the definition of a “reseller,” and better interpretation of 

facility-based providers, versus equipping UNEs, SpA or leased lines. 

We have used the provider Type of ”Other” to classify a number of providers who offer Broadband 

services, but we do not offer them in a manner consistent with Technical Appendix A definitions. 

To What Extent Should We Begin “Classifying” the Data and Maps? 

The question immediately preceding gets to the intent of a Broadband provider.  This question gets to 

the intent of the Data and Maps. 

Earlier in this document we discussed the question of what type of bias we should introduce to our 

online map messaging.  In an online environment, do we want to more likely create an overstatement of 

coverage for a provider than an understatement?   In other words, is the larger problem allowing a 

consumer to self-disqualify, versus calling a number of neighboring providers?  There is a related issue 

to this.  Clearly in our maps there is a lot of scatter in data that we believe should be more continuous.  

These are the islands of coverage from an incumbent provider33.  There are a number of processes that 

could be put in place to deal with this type of scatter, but without more information from the service 

provider-- essentially the last mile facilities-- it will be difficult to perform this clean up in an informed 

manner.  On the one hand, we can aesthetically clean the maps up and reduce the scatter, but we have 

little sub-block engineering information upon which to make this decision.  Right now our preference is 

to put out a somewhat aesthetically messier deliverable and work with providers to get better 

information to clean their submission.  If that isn’t forthcoming, we are limited in what can be done 

given the lack of facility level information.  In summary this yields two questions 

1. In our online maps should we error on overstating coverage to prevent consumer self-

disqualification? 

2. In our online maps should we work to clean up a lot of the scatter that we see without having 

facility-based evidence from which to remove it? 

Granular Data Collection Issus 

Non-Uniform Submission Standards  

It is clear among providers that there isn’t a consistent method used to derive Broadband coverage.  

Some providers appear to be use a geocoding approach and then point in polygon or point on segment 

process.  Others may be using GPS locations.  In some cases, it is difficult to infer what reference data 

was used to georeference plant (is it the carrier’s roadbase?).  This leads to uncertainty regarding the 

input data scale or accuracy relative to other base layers.  Although we may be trading off absolute 

                                                           
33

 For a provider who sells opportunistically (not within a franchise area) it becomes even more problematic to 
classify their coverage because the points are more related to the type of consumer purchasing the service than a 
bounded offering.  In a matter of speaking, the ProviderType is more determined by the technology and/or 
location than a type of business.  The core intent of the NOFA and our grant application was centered around the 
7-10 day providers but we believe maintaining information on provider Type “Other” and  “Reseller” is important 
to assist in validation and market segment analysis as resources are available. 
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accuracy, our standard has been to conflate submitted data to TIGER 2010 Blocks and TIGER 2010 roads.  

We perform our verification against this conflated data product. 

Temporal 

We are unsure of how well the data are temporally consistent.  Some providers gave us their best effort 

to control to June 30, 2011. We note that some providers were clear that the submission was as of 

extract date without any way to move back in time.  They have no means to control for time and cannot 

provide any audit support beyond when the data are released to us.  Some data-especially loop 

qualification data-may change from day to day. It will be very difficult to clarify why something was 

changed from a given point in time. 

Perceived Inaccuracy with Respect to Internal Standards 

The NOFA is clear on submitting a list of Blocks in which a provider delivers Broadband service.  This is a 

different objective than perfectly reflecting service territories.  If a firm’s accuracy standard is a 

reflection of their service area, then the data created under the NOFA will not meet their perception of 

accuracy.  This leads to two other issues:  First, using Census Blocks rather than serving area may 

overstate or understate a particular provider’s Broadband serving area.  This was a significant concern of 

***REDACT*** who specifically required us to submit only address-level qualification data.  The second 

issue this brings up is how or if, there should be some standard on how much of a Census Block needs to 

be covered to call it covered.    

Confidentiality  

Several providers have noted concerns with CPNI-related issues and have stated this as a reason for 

non-participation.  We have also heard expressions of comparable concern regarding identifiable 

responses to Anchor Institution information. 

Unclear on Definitions  

As discussed earlier, several providers claimed confusion on several key terms involved in Middle Mile.  

We note a consistent stream of questions around the interpretation of Maximum Advertised Speed.  

Some providers understand this to be the most common speed package bought within the mass market, 

while others view this as a speed that can be purchased for an additional cost above a mass market 

offering (eg. a Turbo option for an additional fee per month).  Others interpret this as the fastest speed 

that is available for that particular location--in terms of xDSL, a structure qualified speed, for example.   

Perception of Data Use 

There seems to be some hesitancy releasing speed information because no one is sure of how the 

information will be used, or what the speed is intended to reflect.  A number of providers have verbally 

indicated that typical speed will be about (on average) 80% of purchased speed due to overhead.  But 

there are many other factors (such as a user’s home network) that influence speeds measures.  

Providers are concerned about introducing statistics without a clear understanding of how those 

statistics are derived and will then be used.  Also, as advertised speed is pushed down to a block level, 

we sense more trepidation to report speed values.  This quickly begins to touch on parity across network 

types (why is wireline down at the block when wireless is half the state, etc.).   Finally we note a 
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significant increase in speed reported to us.  This may be due to network upgrades or competitive 

concerns to match the theoretical network speed. 

Location Uncertainty In Source Data 

Within this document we have noted concerns about the impact of source data accuracy.  Our 

geoprocessing methodology provided what we believe is a relatively conservative tolerance to account 

for the scale issue in the source data, but we are unsure of how this may impact downstream users.  

Clearly, it also impacts the verification process because we can’t attempt to verify received data beyond 

a scale at which it was developed. 

Covered Segment Process 

Deriving those Broadband covered segments in Census Blocks greater than 2 square miles has proved to 

be a challenge.   Moving from a NOFA specified tabular deliverable to a requested  geographic 

deliverable also increases the complexity of the effort.   

Record Level Metadata 

It would be helpful to have one or two additional fields in each feature class transmitted to NTIA.  One 

User Defined field could be helpful as an expression of record level confidence.  The second field could 

be used as a Key between the transfer geodatabase and our systems.  Ideally, both fields could be large 

text fields (50 char) so the Grantee can use them to express a variety of attributes. 

Miscellaneous Data Collection Notes 

 We note the following important observations regarding our data submission: 

1. There are Middle Mile plant records for providers who are not present in the Census block, 

segment or wireless area feature classes.  This is due to classification as non-NOFA Broadband 

providers. 

2. In some cases, we have trimmed wireless coverage estimates to honor state boundaries. 

3. We believe some providers are trimming their coverage to honor license area boundaries. 

4. As a departure from past practice, where a provider submitted Middle Mile points out of state, 

we are no longer passing those points to NTIA as they fail the validation script.  We experienced 

validation errors for BroadbandServed=N records in the CAI table.  These records were 

attributed a Technology of Transfer=0.  This cleared validation. 

5. In tables with mandatory Street and Zip5 attributes(Service Address), if the value is unavailable 

it is filled with N/A. was not available, we have inserted ‘N/A 

6. As with submission three, there remains a tension between the Data Model, Data Model Default 

Values and the Python Validation Script.  As an example the data model allows a NULL for the 

Maximum Advertised speeds in a Census block record.  A default ‘zz’ is available for this 

condition as well but zz will fail the validation script.  In the case where we have data which is 

missing Maximum Advertised Speeds, we are holding that data back to prevent downstream 

validation problems. 

7. We have a significant amount of VDSL, ADSL 2 and ADSL 2+ coverage categorized into the xADSL 

category.  This introduces a variance in speed availability as some providers are using VDSL, 

shortened loops and/or pair bonding to increase speed over 10 Mbps. 
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8. We have left in the data Middle Mile locations with above grade elevations that appear to be 

unreasonable, given review of orthoimagery.  This seems to be confusion between above grade 

request and above sea level readings. 

9. All fGDB have passed validation except in cases where attributed speeds did not agree with 

domains associated with technology of transmission (eg Upstream Speed of 2 with ADSL).  We 

have modified the Python script to allow for conditions in the CAI table in which default data 

model values are disallowed in the Python submission script. 

10. We note a few providers who have speeds seemingly inconsistent with their technology of 

transmission.  This is either very low speeds with optical fiber, or very high speeds with non 

DOCSIS 3.0 systems.  We have verified on provider websites that the reported speeds are 

available in the area but these speeds will fall out of the NTIA frequency table analysis. 

11. We have a small number of providers who serve an area with both a residential and business 

speed tier.  In cases where we cannot distinguish which speed tier offering to use, we use the 

lower of the speed tiers. 

12. Per NTIA request we have modified the manner in which we handle Wireless coverage polygons.  

If a Provider submits a single geometry but specifies multiple spectrum codes in use in that 

polygon, we duplicate the polygon for each spectrum code.  In other words the geographic 

object is identical but the attribute data for the object is unique. 

13. In point level data submissions (Service Address and CAI) we note points that are spatially 

coincident.  With respect to Service Address points our thought is these represent multi-unit 

dwellings or businesses but we don’t have enough address detail to determine if these are 

multi-unit structures or duplicated customers.  Because we cannot determine the reason for the 

duplication we leave spatially coincident records in our submission.  We also leave in our CAI 

submission points which may be the same physical structure but have slight variations in 

addressing. 

14. In point level middle mile data, we are finding a variance in the quality of the geocoded 

longitude and latitude returned.  Given the data received we are unsure if this is an issue where 

the plant address is difficult to geocode or if the longitude and latitude provided to us  is 

different than what would be returned in geocoding. 

15. We note two important issues in our datapackage.xls.  First the number of records in the 

provider tab will not sum up to the total record count.  This is due to the requested grouping 

within the Excel table..  Second for estimated broadband coverage, we internally mark that 

coverage as an estimate but the provider is described as non-responsive within the 

datapackage.xls. 

16. We made one modification to the NTIA supplied verification script.  For the CAI layer we The 

query to check the TRANSTECH field now includes: "AND TRANSTECH <> -9999" 
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Appendix Two 
This appendix contains the confidentiality clarification supplied in a series of emails between CostQuest and NTIA. 

Feature Class Metadata NOFA 
Confidential? 

Online Map Public 
Disclosure 

Exemption 

Last Mile Constraints on accessing and using the data Yes No No None 

  Access constraints: None      

  Use constraints:       

  This data is confidential as defined in the 
NOFA. 

     

            

Middle Mile  Constraints on accessing and using the data Yes No No None 

  Access constraints: None      

  Use constraints:       

  This data is confidential as defined in the 
NOFA. 

     

            

Service Address Constraints on accessing and using the data No No Yes   

  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users.  

     

            

CAI Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 
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  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users.  

     

            

Census Block Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 

  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users. 

     

            

Service Overview Constraints on accessing and using the data No Yes Yes The only 
provider 
who may 
not show 
up this 
table is a 
provider 
who has 
provided 
only 
confidential 
data (last 
mile, 
Middle 
Mile, 
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address 
point with 
provider 
name) 

  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users. 

     

            

Road Segment Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 

  Access constraints: None.      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users. 

     

            

Wireless Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 

  Access constraints: None      

  Use constraints:       
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  There are no restrictions on distribution of 
the data by users 
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Overview 
This document gives a summary of the data collection, normalization and verification processes used by the State of West 
Virginia (State) for the September 2011 data submission to the National Telecommunication and Information Agency (NTIA) in 
accordance with the State Broadband Data Development (SBDD) program.  While the processes used in this data submission 
remained the same as ones for the previous submissions, there were additional challenges overcoming the changes from 
2000 to 2010 census blocks.  Additionally, the State of West Virginia interactive broadband map is now available to the public 
and is able to receive comments and feedback from consumers and citizens of the state. 
 

Purpose 
This documentation was developed to illustrate the processes used during the data collection, normalization and verification 
processes.  The information within this document will provide a background to the development of the provider list and data 
request, and specific issues encountered by West Virginia regarding data collection, normalization and validation.  
 

Data Sources 
Provider List 
The provider list for the fourth round of data collection started during the first round of data collection.  For this round, the list 
was regenerated to include any new providers within the state.  The list was created by contacting the West Virginia Cable 
Telecommunications Association, the West Virginia Public Services Commission (PSC) and the West Virginia Broadband 
Deployment Council.  The state receives an updated provider list from the PSC every six months.  This information was 
compiled and compared against the list from the Federal Communications Commission (FCC).  Providers were then contacted 
using information provided by the FCC’s public information search Web tool.  Providers who were contacted during the first 
round of data were contacted again through the same name and address.  If a provider contacted during the first round had 
given more detailed contact information for a specific individual, those individuals were contacted instead of the contact 
provided by the FCC. 
 
The provider list is updated every six months to reflect any mergers or acquisitions that have occurred.  There are some legal 
issues when a merger occurs, but the data integration does not occur until up to a year later.  In those circumstances, the data 
is kept separate until a full merger occurs. 
 

Data Gathering 
Provider Data Request 

This component of the project was heavily reliant on working with service providers to obtain data.  Each identified provider 
was mailed a standard data request outlining the elements identified in the Notice of Funds Availability (NOFA) Technical 
Appendix that were requested from providers.  This request included information regarding the availability of broadband 
services, technology used to provide them, the location of certain broadband infrastructure and the speed of the service.  Data 
was requested to be submitted in the form of census block lists and service area boundaries, including address level and 
street segment data.  If a provider was unable to fulfill such requirements, the West Virginia Geological and Economic Survey 
(WVGES) worked with those providers to gather the necessary data in an alternative approach.   
 
After the initial data request was mailed, follow up phone calls and emails were made to remind providers of due dates and to 
collect any missing or unclear data.  As of this submission, the response rate from providers is over 90 percent.  After data 
was received, the data was normalized per NTIA standards and placed into the provided geodatabase.  WVGES continued to 
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operate under the same assumption as used in the first round of data gathering.  As the focus was on normalizing, not 
changing the data, WVGES made no core changes without first consulting the provider. 
 
Providers typically submitted only advertised speed data.  A very small percentage of providers are willing to submit typical 
speed data as doing so would be an admission that advertised and typical speeds are not the same.  Advertised speed data 
was given by all providers and then pushed to typical speeds as per NTIA’s advice in the Round 3 data review conference call.  
 
In addition to the data request, each provider was required to sign a Nondisclosure Agreement (NDA) between themselves 
and WVGES.  The NDA outlined how provider data would be handled and what portions of that data would be considered 
confidential, which would be shared with the NTIA and which were to be made publically available. 
 
Coverage Information 

Data was derived and normalized into four formats in accordance with the data model: 
• Census blocks (2000) of two or less square miles 
• Street segments (2000) of census blocks greater than two square miles 
• Address level (geocoded point data) 
• Wireless area (shapefile) 

 
The normalization procedures were as follows: 

• Determine service being provided – what technologies are being used to provide the service 
• Understand data/determine how to process – determine which feature class in the geodatabase data belongs 
• Georeferencing/geocoding necessary data – georeferencing data for wireless area coverage and other service area 

maps, as well as geocoding address level data 
• Segregating data into NOFA compliant formats – completely filling in geodatabase fields, as well as making sure 

topology is correct 
• Quality assurance/quality control (QA/QC) – verification and validation of data 

 
Typically there were two main types of data supplied for normalization – service area maps and flat Excel tables. 
 
Service areas were georeferenced, digitized and then intersected with the master blocks and roads files.  These blocks and 
road segments were then loaded into the geodatabase and the additional company specific data was appended to those 
records. 
 
Flat Excel tables were exported to a database and then joined with the FIPS ID for the block files and the TLID for the roads 
files.  The joined fields were exported and then imported into the database.  NTIA has not required this information and in 
cases where a TLID was not given by the provider there was much greater difficulty and inaccuracy as roads had to be 
geocoded and hand selected. 
 
 

Geocoding Issues 

The West Virginia Statewide Addressing and Mapping Board (SAMB) information is not yet completed across all of the 
counties in West Virginia, leaving areas within the State without complete or verified address information.  This led to low 
geocoding match rates of provider supplied information, especially in rural areas, throughout the data normalization workflows.  
For some of these areas, additional broadband coverage processes were used to derive coverage estimates described in the 
next section. 
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One part of this issue was due to the acquisition of Verizon by Frontier.  When Frontier submitted digital subscriber line access 
multiplexer (DSLAM) locations for the April 1, 2011 deadline it did not include the entire Verizon infrastructure.   Frontier has 
since re-submitted its DSLAM locations, which now should include those missing Verizon DSLAMs and the coverage map has 
been extended into certain area that were not previously included 
 
Additional Data Processing Techniques  

Because of geocoding inconsistencies in certain areas of the State, some provider address information could not be mapped 
and other data processing techniques had to be implemented to create broadband coverage estimates.  In cases where 
DSLAM points were able to be provided, broadband coverage was mapped by loading the DSLAM points into Environmental 
System Research Institute’s (ESRI’s) Network Analyst.  For this processing, the West Virginia State SAMB street centerlines 
were used as the source roads.  DSLAM points were loaded into the facilities point feature class of the service area template 
using a 1000 foot snapping tolerance to help locate points to nearest roadway.  Any points still not connecting to the road 
network were viewed and manually linked to the road network.  Processing was run to create segment lines for each point and 
to create a detailed polygon area around each street segment area for each point.  A 15,000 foot distance parameter was 
used and no impedances were placed on the streets.  
 
Once the process was run, the created segment lines and polygon areas were linked to the original DSLAM point attribute 
table and exported from the analyst dataset into standalone polygon and line feature classes.  These two feature classes were 
clipped to the provided wire center boundaries.  These coverage areas were used to select covered census blocks and street 
segments for the data submission.  Final broadband coverage estimates were reviewed with the provider prior to final 
submission. 
 
Another unique processing issue occurred when providers submitted address-level fixed wireless data which would produce 
error through the new data model.  As per discussion with NTIA, the unlicensed fixed wireless points were plotted and then 
buffered out to 800 feet.  A shapefile was created and moved to the wireless feature class within the geodatabase. 
 
One of the foremost issues of this round of data collection has been converting to 2010 Census Blocks.  NTIA’s decision to 
switch to 2010 Census Blocks did not leave much time to notify providers of the change.  Many providers submitted 2000 
Census Blocks, not 2010 Census Blocks.  The conversion led to multiple inaccuracies between Round 3 and Round 4 
submissions because of the problems intersecting 2000 Census Blocks with 2010 Census Blocks.  Many block boundaries 
had been redrawn and the crosswalk file provided by the Census was in a very unwieldy format and not much help. 
 
 
FRN Number Discrepancies 

Discrepancies between Round 2 and Round 3 data submissions were noticed concerning FCC Registraton Numbers (FRNs).  
Affected providers were contacted directly to clear up these issues.  FRNs that were loaded into the database come from 
direct contact with providers. 
 

Community Anchor Institutions 
The process used to identify the Community Anchor Institutions was based on the information provided by NTIA.  This 
included the categories of schools K-12, libraries, medical/healthcare, Public Safety, higher education and other community 
support consisting of either government or nongovernmental facilities. 
 
All public schools in West Virginia were used for the K-12 category.  Libraries consisted of all public libraries throughout West 
Virginia.  Medical/healthcare included hospitals, nursing homes and primary care centers.  The primary care centers are made 
up of main locations of the primary care centers along with satellite clinics and school-based health centers.  Public Safety 
consisted of West Virginia police departments along with the correctional facilities and juvenile centers, fire departments and 
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9-1-1 centers.  Higher education consisted of public and private universities located across West Virginia.  The community 
support consisted of courthouses, regional development centers and workforce locations. 
 
There was a cutoff created to focus on identifying main facilities as Community Anchor Institutions (CAIs).  However, if there is 
a need to go and include more facilities, the State is open to adding those facilities for future updates. 
 
The following agencies were contacted for information:  West Virginia (WV) Department of Education, WV Library 
Commission, Hospitals located throughout the state, Nursing Homes located throughout the State, WV Division of Primary 
Care, WV Primary Care Association, WV 9-1-1 Center Directors, WV Emergency Management Directors, WV Regional Jail 
Authority, WV Higher Education Policy Commission, WV Courthouse Facility Improvement Authority, WV Workforce, WV 
Regional Development Centers and county addressing coordinators.  
 
Data was collected and verified by the West Virginia Division of Homeland Security.  Surveys were sent out to various facilities 
and included a section where their primary city-style address could be filled in.  For those facilities that returned the survey, 
the statewide addressing and mapping data that the counties provided was used as a way to verify the address.  Once the 
location was verified the latitude and longitude coordinates were added.  In cases where surveys were not returned, the 
statewide addressing and mapping data was used to determine if the information could be matched.  If this wasn’t possible, 
then the Internet was used to find a Webpage with additional information.  If this method was not successful, attempts were 
made to contact the facility directly.  At this point in time, there is approximately a 90-95 percent match rate for the location of 
the CAIs. 

Validation and Verification 
Throughout the data gathering and data preparation processes for each data submission, the data verification has been 
continuous and has evolved based on the evolution of the data model.  The focus has been on getting complete data from all 
providers and assuring that all data can be processed into the required data model for submission.  Where providers did not 
submit data in acceptable formats for data normalization into NOFA formats or where they did not submit complete data or any 
data, there has been continued focus on working with the providers by WVGES to continue to improve the source information 
being provided.  Data verification and validation is an on-going, long term process that will continue to evolve throughout the 
broadband data development program.  With this fourth data submission in September 2011 being a much more complete 
broadband coverage across the State because of additional data supplied by providers, additional data verification methods, 
beyond what has been implemented to date, will continue to be evaluated to refine the map, where applicable.  
 
Validation Processes 

Data validation begins within the data collection process to determine if the data submission by providers is formatted in a way 
that can be normalized into the required NOFA formats.  Where data is deemed incomplete or in non-conforming standards, 
WVGES staff reached out to providers as necessary to improve the data submissions.  After each round of data preparation 
the format for the updates being collected has improved. 
 
Quality assurance and quality control has been a big focus of the data validation of the submittals assuring that the required 
data fields are populated properly and that data fields are populated with values that follow the data model rules.  As the data 
model has evolved over each round of data submission these QA/QC checks have been modified to include the changes in 
fields, values, domains, etc. that are being required for submission.    
 
Validation methods employed include the following: 

• Assuring all applicable providers’ datasets are propagated forward to each round of data collection 
• Verifying that all required fields are populated with valid values and default values are used when appropriate.  This 

includes: 
o Speeds valid for the technologies reported 
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o Latitude/longitude coordinates fall within an acceptable range, given the state boundaries 
o The relationships between maximum and typical, and downstream and upstream speeds are valid 
o Service reported at the block level is done using blocks of the appropriate size (less than two square miles) 
o Speeds and technologies reported per provider are consistent between blocks and segments 
o Administrative information (provider name, doing business as [DBA] Name, FRN) is consistently reported 

per provider in each populated feature class. 
 
Outreach to Providers 

To further assure the providers’ broadband footprints would be accurately represented in data submissions, “check maps” 
depicting each respective provider’s served small census blocks and segments located in large blocks were distributed back 
to providers.  Providers were requested to either approve their check maps as-is, or submit additional changes if their 
coverage was not accurately represented.  Any modifications received as a result of this effort were incorporated into the 
broadband coverage maps.  WVGES plans to incorporate future data reviews with providers using web collaboration tools.  . 
 

 
Figure 1—Example of a portion of a provider check map 

The validation process for the September 2011 submission includes the use of the Python scripts for validation provided by 
NTIA.   
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Third Party Datasets 

As data collections and data normalization processes progressed, additional validation was conducted using commercially 
available datasets.  The following commercially available datasets were used as a reference for the specific technologies that 
their data represented. 

• American Roamer datasets 
• TeleAtlas Exchange boundaries 
• Media Prints Cable boundaries 

 
These datasets were used primarily as a validation source for provider service coverage. 
 
State Broadband Interactive Map  

The State of West Virginia released its interactive broadband mapping Website to the public in May 2011.  The Website 
address is www.wvbroadbandmap.org.  The Website provides consumers the opportunity to review broadband availability 
across the State.  
 
 

 
Figure 2—WVBMP main landing page 

The main landing page for the West Virginia Broadband Mapping Program (WVBMP) provides background information on the 
program, contact information and a frequently asked questions section.  The landing page has the main link to the broadband 
coverage map and a link to an address lookup tool for users with slow internet connections.   This will allow them to view what 
coverage is available around their address or zip code without needing to view the entire map, which might not be feasible for 
users who might still be on dial-up connection speeds.  By having this slow internet connection coverage tool, it allows 
feedback from those consumers even if they do not have the capabilities to bring up the interactive map application. 
 
The Web application has the functionality for consumers and citizens using the State broadband map Web application to 
submit comments and feedback.  The information gathered from that feedback is being reviewed as more potential source 
information for validating and determining confidence levels of the broadband coverage across the regions of the State.  By 

http://www.wvbroadbandmap.org/
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comparing comments supplied by consumers about broadband availability to the broadband coverage, trends could be 
recognized where potential inconsistencies in the existing broadband map could exist.  This could delineate the need for 
further focused validation or verification in specific areas that could refine the broadband coverage information for future data 
submissions. 
 

 
Figure 3—Example of feedback tool interface 

Users browsing the interactive map can click on any location and select to provide specific feedback for that location.  This will 
store the coordinate information of the selected location allowing them to select from a couple of coverage categories for their 
comment or select “other”.  Within the feedback tool, they can type in more specific details about their broadband coverage.  
 
After the initial release of the broadband map, there was some initial feedback and comments mainly pertaining to a few areas 
that were not showing coverage.  The feedback indicated that there should be coverage or scenarios where we were showing 
coverage.  One resident made a comment that there was not cable service on a particular road or area.  Some of the missing 
coverage was due to the acquisition of Verizon by Frontier as discussed above. 
 
During the next six month data collection period leading up to the April 2012 data submission, the State plans to incorporate 
more advertising to the interactive broadband map and feedback tools.  Continuing to work more closely with the regional 
planning councils to review coverage in their communities, a plan to include an advertisement of the interactive broadband 
map into local phone bills is being developed.   
 
A speed test has been developed within the WVBMP interactive Website.   The design of the Website includes links to the 
speed test developed using the Ookla broadband speed test tools.  The speed test is embedded within a broadband survey 
wizard that allows consumers to provide specific information that will help the State analyze information about use and 
demand for broadband within the State.  To get more users to take the speed test to obtain more results for analysis over the 
next six months, the speed test will be advertised along with the interactive Website.  Speed test results and statistics will be 
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leveraged to compare against the existing broadband coverage and help validate speed information.  As stated previously, 
this could assist in determining if there are any trends or patterns in the information that could be an additional tool for 
prioritizing areas where more refined verification and validation might need to occur. 
 
Future Steps for Validation 

Future plans for data validation continue to include establishing confidence levels to assign to broadband coverage based on 
comparisons with other source information collected, such as feedback from crowd sourcing results from the State broadband 
map and the national broadband map.  Confidence rankings will be used to prioritize any areas where additional verification 
techniques might be used (consumer and business surveys).  
 
As part of continued broadband planning activities and future validation of data, a third party dataset from Infogroup is being 
purchased.  For broadband map validation, the Infogroup datasets provide consumer broadband use information including 
coordinate based location information along with provider name and technology that is being used by that particular consumer.  
The Infogroup data will allow the consumer information to be plotted on the map and compared against existing coverage 
maps to determine if there are any trends within the Infogroup data that help to determine where additional validation needs to 
occur.  For example, there may be clusters of consumer points for a particular provider that exists in an area of the State 
where there is no coverage for that provider.  The goal would be to identify the major patterns or trends that might need to be 
re-visited with a provider if data appears to be missing. 
 
Another dataset that is being considered for purchase for broadband planning activities and broadband demand analysis is 
Telogical’s broadband statistical datasets that provide pricing information.  Included in the datasets is information on 
broadband maximum advertised speed by providers which could help validate some of the speed data within the broadband 
mapping datasets. 
 
Throughout the broadband data development program, as addressing information from the State Addressing and Mapping 
Board’s addressing datasets are continually updated, address point information from providers will continually be re-verified 
prior to each submission to NTIA to improve geocoding results and refine the broadband coverage areas.   
 

Providers 
Non-Responsive Providers 

Names of providers who were non responsive will be passed along to the WV Geographic Information Systems (GIS) 
Coordinator’s Office to be contacted again.   
 
Atlantic Broadband LLC 
DBA: Atlantic Broadband, LLC 
FRN: 0009596883 
This provider was contacted eight times.  Data was not provided by the October submittal date.  Further attempts at data 
gathering will be made in the next round of data collection. 
 
Hughes Communications, Inc. 
DBA: HNS Licensuse Sub, LLC 
FRN: 0018483073 
Detailed data was not provided by the October submittal data.  Further attempts at data gathering will be made in the next 
round of data collection. 
StarBand Communications Inc. 
DBA: StarBand Communications Inc. 
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FRN: 0005087457 
Detailed data was not provided by the October submittal data.  Further attempts at data gathering will be made in the next 
round of data collection. 
 
WildBlue Communications, Inc. 
DBA: WildBlue Communications, Inc. 
FRN: 0007843766 
Detailed data was not provided by the October submittal data.  Further attempts at data gathering will be made in the next 
round of data collection. 
 
Skyweb, Inc 
DBA: SKYWEB Inc. 
FRN: 0018516799 
This provider was contacted eight times.  Tower locations were provided along with additional information for each tower site.  
Two computerized propagation studies were performed to approximate coverage for a local provider supplying broadband 
data. The two studies were predicted in the 900 MHz and 2.4 GHz bands that are utilized at these locations. The data was 
received from the provider that defined the tower sites currently utilized to provide coverage. Parameters provided include site 
locations, ground elevation, transmit power, antenna height above ground, and antenna gain. All of these components were 
compiled into EDX Signal software program which calculates the associated link budget and in which the program takes into 
account terrain and land use land clutter (LULC).  Propagation studies show potential coverage throughout the area. 
Additional assumptions made include a predicted reliability of 90 percent for any signal received by a device and no additional 
signal loss was taken into account for signals received inside buildings which may further impact the coverage 
predictions. The coverage area was being reviewed by the provider on the final week prior to submission for October deadline.  
Data was not finalized in time for the October submission and will be included within the April 2012 submission.  
 
 
Satellite Providers 

Data requests sent to Satellite providers were met with the response of “We provide to the entire state.”  Attempts made at 
gathering more detailed data sets were unsuccessful for this round of data collection.  Further attempts will be made for the 
next round of data collection. 
 
Provider that Submitted Data 

Provider Name DBA Name FRN 
Armstrong Holdings, Inc. Armstrong Telephone Company - Northern Division 0004311528 
Armstrong Holdings, Inc. Armstrong Telephone Company-WV 0004379731 
Armstrong Holdings, Inc. Armstrong Utilities, Inc. 0003765617 
AT&T Inc New Cingular Wireless Services, Inc. 0003766532 
Broadview Networks Holdings, Inc. Broadview Networks Holdings, Inc. 0010296853 
Cequel Communications, LLC Suddenlink Communications 0015784663 
Citizens Communications Company Frontier Communications Corporation 0003576352 
City of Philippi City of Phillipi 0001984244 
Comcast Corporation Comcast Cable Communications Inc. 0003768165 
Community Antenna Service, Inc. Community Antenna Service Inc. 0004966131 
Deutsche Telekom AG T-Mobile USA, Inc. 0006945950 
DSL.net, Inc. DSLnet Communications, LLC 0004324851 
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Provider Name DBA Name FRN 
Gateway Telecom, LLC Gateway Telecom LLC 0018536623 
Hardy Telecommunications, Inc. Hardy Telecommunications Inc 0002008043 
Hardy Telecommunications, Inc. Hardy Telecommunications,Inc CLEC 0013169313 
Hickory Tech Corporation Enventis Telecom Inc. 0008394322 
Inter Mountain Cable, Inc. Inter-Mountain Cable Inc 0001789080 
Inter Mountain Cable, Inc. Mikrotec CATV, LLC 0014471288 
JB-Nets JB-Nets 0016474868 
Leap Wireless International, Inc. Cricket Communications, Inc. 0002963528 
Level 3 Communications, LLC Level  3 Communications, LLC 0003723822 
Level 3 Communications, LLC Broadwing Communications, LLC 0008599706 
LightEdge Solutions, Inc LightEdge Solutions, Inc. 0015546443 
Metropolitan Telecommunications Holding Company Metropolitan Telecommunications Holding Company 0009806019 
Micrologic, Inc. Micrologic, Inc. 0018675256 
New Edge Holding Company New Edge Network, Inc. 0003720471 
NTELOS, Inc. NTELOS Communications Inc. 0004342762 
NTELOS, Inc. West Virginia PCS Alliance, L.C. 0002049328 
Otelco Inc. War Acquisition Corp 0018657858 
Qwest Communications International, Inc. Qwest Communications Company, LLC 0003605953 
Shenandoah Telecommunications Company Shentel Cable Company 0018024075 
Sprint Nextel Corporation Sprint Nextel Corporation 0003774593 
Spruce Knob Seneca Rocks Telephone, Inc. Spruce Knob Seneca Rocks Telephone, Inc. 0004337002 
TelAtlantic, Inc. West Side Telecommunications 0002009405 
TelAtlantic, Inc. Communications Plus, Inc. 0009281262 
Time Warner Cable LLC Time Warner Cable LLC 0013430244 
TW Telecom inc. tw telecom holdings inc. 0014942668 
Verizon Communications Inc. Cellco Partnership 0018506568 
Verizon Communications Inc. Verizon Business Global LLC  0010856284 
Verizon Communications Inc. Verizon West Virginia Inc. 0002011278 
Visual Link Internet LLC Visual Link Internet LLC 0017645813 

 
Table 1—Providers That Have Submitted Data for SBDD Program 
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Overview 
 

The following documentation provides an overview of how the fourth required data set was collected 

and processed for the State Broadband Initiative (SBI) in the states of Alabama, Idaho, Wisconsin, and 

Wyoming.   

Although we could separate this draft into state-specific deliverables, the majority of methodology 

remains intentionally consistent among the states.  As one important validation test is comparability 

across states, we find value in this cross-state approach.  This cross-state approach also helps the 

LinkAMERICA team focus on comparable outcomes across the four states, where appropriate.  Our 

intent is not to make the states look and be the same, rather it is to leverage economies of scope and 

scale among the business processes. 

As expected, this document rests heavily on the prior drafts, but has also been updated and expanded. 

Significant changes include additions covering: 

1. Trends in provider inputs  

2. Expansion in retrieval of WISP coverage  

3. Requested changes based upon NTIA guidance 

a. Modification of Satellite providers as a Type 1 Broadband provider; 

b. Discontinuation of estimating Community Anchor Institution coverage and speed; 

c. Review of submitted speed with respect to NTIA supplied frequency table 

4. Transition planning with respect to capacity building within the State for Broadband map 

development 

5. Development and posting of a provider Type classification rubric 

Treatment of the following subjects has been expanded: 

1. Community anchor institutions and survey methodology 

2. Verification and validation 

3. Data production methods 

4. Conversion to Census 2010 

As anticipated, the SBI program continues to mature and evolve.  Technical leadership and strong 

program office guidance has been appreciated.  We continue to focus resources on establishing stable 

business processes to track submissions, verify received and processed data, test for temporal stability 

and provide reporting deliverables consistent with NTIA expectations. 

In our view,  the mapping deliverable reflects (1) a good faith effort, which results in a reasoned 

response to the NOFA, Technical Appendix A,  as well as supplementary program office guidance and 

modifications offered in phone calls, emails, and webinars, (2) a stable foundation for improvement and 

prioritization of both NTIA and state needs and interests , (3) a valid data processing model to support 
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online mapping, consumer feedback, provider verification and reporting, and finally, (4) a valid use of 

the evolving data transfer model and its intrinsic validation methods.  More importantly, the resulting 

data and online coverage maps that follow from this work are providing good input and context for the 

Broadband planning teams working across the states we have the pleasure to serve. 

We close this methodology document with two Appendices.   Appendix One describes Data Collection 

Challenges.  This section describes some of the open issues, challenges and questions we are exploring.  

Our hope is to receive clarification and counsel from NTIA in how best to confront some of these issues, 

which are likely common across states.  Appendix Two describes the confidentiality framework 

explained by NTIA.   

Purpose of This Manual 
This technical document was developed to provide transparency in our data production process.   

Our goal is to illustrate a thoughtful process designed to meet the intent of the submission.  Our hope is 

that we have developed a process that is reasonable, with respect to the data it deals with, as well as 

flexible enough to change with evolving NTIA requirements and lessons learned from the Broadband 

mapping community.  

Data Sources 

Developing the Provider List 

Provider lists for all states were developed at project inception from the following sources: 

 State lists of regulated telecommunications, cable and wireless service providers 

 State and national industry organizations (i.e. cable associations, wireless service provider 

organizations, telecommunications associations) 

 FCC Form 477 respondents 

 Independent web searches 

 Prior comparable mapping/research efforts 

 Interviews with key state staff members and important community influencers 

After the April 1, 2011 “Round 3” submission, we continued our research and added new providers to 

the program as discovered.  As one would expect in a dynamic marketplace, provider identification is an 

ongoing and important component of our work.  Mergers and acquisitions, the use of multiple regional 

DBAs, the lack of any universal identity management attribute, and the generally complex parent-

subsidiary structure of many telecommunications companies, make provider identification and tracking 

very challenging.   

In early July 2011, we once again initiated an email and telephone outreach campaign to contact all 

known providers. This is an extremely time consuming process, but it is necessary to ensure that the list 

of contact persons remains current, and that providers are aware of data request changes and deadlines 
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associated with each round.  Where necessary, we execute new NDAs with providers.  In “Round 4”, this 

effort continued on a daily basis until we reached our final data submission deadline on August 19, 

2011.   After August 19, we continued to work with providers who were not able to meet the deadline.  

In most cases were able to “crash” our process to accommodate this extra data, but late submissions 

continue to create inefficiencies and add costs to the overall program.  In Round 4 providers that 

responded too late to be included in the final dataset will be included in our Round 5 submission. Once 

again, as contact is made in each round, we verbally qualify each provider by asking a series of questions 

regarding the type of service and speeds offered.  If the provider does not meet the minimum 

specifications for a Broadband provider (as defined in the NOFA) we make a note of their status and 

remove them from the data submitted to NTIA.1  We continue to reach out to them in future rounds in 

the event that their service is upgraded or expanded. 

Provider Outreach 

To meet the program’s aggressive deadlines and participation goals, LinkAMERICA believes it is critical to 

maintain rapport with providers.  To do this, we continued to reach out to providers with regular project 

communications, including a program newsletter and links to the various state mapping websites.  As 

described above, individual e-mails and/or telephone calls were made to all providers explaining the 

status of the program and requesting their continued support in Round Four. We’ve also had the 

opportunity to support providers in their BTOP / BIP applications in certain cases. Through these 

collective outreach initiatives, and our engagement with various industry associations, we continue to 

enjoy a healthy and appropriate relationship with Broadband service providers. 

NDA 

To provide protection for all parties involved, LinkAMERICA continues to honor the terms of our NDA.  If 

providers did not execute the NDA in previous rounds they were offered the opportunity to do so in this 

collection round.   New providers were of course also supplied with a copy of the NDA. 

To facilitate the execution of NDA’s, LinkAMERICA continues to use the DocuSign online document 

management solution.  This system allows providers to review and digitally sign the NDA in a legally 

binding manner, and has been instrumental in achieving rapid approval and execution of NDAs with the 

majority of providers.  In some cases, NDA’s were individually negotiated to address specific provider 

concerns.  In all cases, minimum standards established by the NOFA are honored.  In other cases, 

providers chose to submit data without executing an NDA. 

Provider Survey 

Since three prior rounds of data collection had been completed, the LinkAMERICA team had a solid base 

of coverage and speed information with which to begin Round 4.  This allowed us to provide two 

response options to providers.  The first was for them to review check maps of their coverage and speed 

data – submitting only corrections and additions to the existing dataset.  (For provider convenience the 

                                                           
1
 As with other Grantees, we struggle with appropriate and consistent classification for service providers who 

opportunistically provision Broadband services.  In this submission we continue to bring them into the analysis as a 
provider type “other”.  As the inclusion of this category isn’t our primary goal, we are working to process data as 
we can.  We are similarly categorizing and retaining reseller information.  Our datapackage.xls illustrates the 
categorization of non Broadband providers within our provider tracking and verification systems.  
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check maps were created in both PDF and Google Earth (.KMZ) formats.) The second was to allow 

submittal of completely new datasets, either in tabular form or in multiple other digital formats.  For 

those without sophisticated CAD or GIS systems, we continued to allow the submittal of 

printed/scanned maps and other written materials.    

Survey Methods 

Once again, we used a secure digital survey process (via our provider portal websites) to collect and 

display information for providers.   The Round 4 survey process was designed to accommodate both 

new and returning providers, and the different types of information they would be submitting.  The 

following is a summary of the process encountered by each group: 

New providers:  New providers were routed directly to our standard survey where they were provided 

with templates for uploading data in tabular NTIA-compliant formats.   As in previous rounds,  if 

providers could not supply information in the requested format, alternatives were offered.  These 

alternatives included uploading service-area boundary maps, exchange area maps, CAD drawings or 

customer address lists.  From that information, the LinkAMERICA team developed a geographic 

representation of coverage and was able to build coverage features for each provider.    

Returning providers:  For Round 4 we continued to work with participating providers to improve their 

datasets.  The change in Census Data vintage was explained to providers and links to appropriate files 

were provided to assist with the transition to the new vintage data.   

Check maps continue to be a useful tool to show providers how their area would be displayed on the 

resulting interactive state map and to get constructive feedback regarding corrections and changes that 

need to be made to their coverage and speed data.   Generating these customized documents in each 

round is an extremely time consuming verification process, but it allows us to close many of the gaps 

that might have otherwise persisted. 

Follow Up 

After the release of the Round 4 survey in early July 2011, LinkAMERICA launched an extensive effort to 

encourage responses.  Every known provider was contacted at least twice during the months of July and 

August.  The initial data submission deadline was set for August 19, but, as previously noted, we 

continued to accept “straggler” submissions into September.  

No Response Policy 

As mentioned above, every effort was made to contact each provider who appeared on our initial list.  

However, if no current information could be found on the company (i.e. no website, no valid phone 

number, no contact person identified) they were removed from the list of “known providers”.  We 

believe the vast majority of those we were unable to reach were providers who have simply ceased to 

exist2.  

                                                           
2
The list of known providers and important submission statistics are contained in the datapackage.xls file. 
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Summary 

In summary, an intensive 45-60 day provider outreach and data collection process is initiated at the 

beginning of each round.  In Round 4, given the data vintage of June 30, 2011, we began this process in 

July and the last submissions were accepted in September, 2011.    

While we continue to successfully engage the majority of providers in each round, the amount of 

manpower required to solicit complete and timely responses should not be underestimated.  This 

process is one of the most costly and complex within the entire SBI program.  

Third Party Data Used 
Beyond the data obtained from providers, we acquired the following commercial data products: 

 American Roamer, Coverage Right Advanced Services. This data served two purposes.  The first 

was to verify the provider list and help find Broadband service providers not on other lists.  The 

second was to verify the reasonableness of the Broadband service provider’s submission. 

 MapInfo ExchangeInfo, Professional.  This data was used in the verification of telephone 

Broadband provider data.  Where a public domain exchange boundary wasn’t available, the 

MapInfo boundary was used for coverage containment tests.  

 Media Prints Cable boundaries.  This data was used in the verification of Cable/HFC Broadband 

provider data.  It was used to research valid providers and discover if that provider was offering 

Internet service.  In very rough terms the contained boundaries were used to test the location of 

some provider data.  

 FCC 477 restricted use data were analyzed to find valid providers within a given area. 

We have included third party data sources, which touch on each of the three major technologies 

analyzed within the SBI program.  Each of these data sources tie back to a public domain data source, 

which provides a cross-verification mechanism for the commercial data product. 

Although there are a large number of third party licensed data sources available, we remain 

conservative in our acquisition plans.  From our limited analysis we are concerned about the ability to 

cross-verify additional third party licensed sources against public domain data.  Further, we are unsure 

of how we may be able to integrate another data provider’s view of valid Broadband providers within 

the definitions used by the NOFA (eg. Are they using an FRN/DBA identity view or a marketing view?  

Can the provider supply in a 7-10 day window?  Are they facilities based or not?).  This leads us back to a 

statement we made in a ‘lessons learned’ Webinar (April 2010) about exploring a consortia to lower the 

cost of data acquisition and allow multiple entities to peer review the quality and methodologies behind 

licensed data products.3  

Beyond these commercial data sources, we used a number of public domain sources.  These included: 

a. Geographic Data Files  

                                                           
3
 We also suggested forming a technical standards committee and a consistent system for confidence reporting. 



SBI Mapping Methodology Page 10 
 

i. US Census TIGER data4 

b. Sources that helped isolate providers, identity management or provider service areas 

i. NECA Tariff 4 

ii. State produced exchange boundaries  

iii. Carrier produced wirecenter boundaries 

iv. FCC Coals reports (321/325) 

v. FCC FRN API lookup tool 

vi. FCC/FAA Antenna Registration System 

vii. FCC FRN Lookup Tool (plain text search) 

viii. USAC High Cost FCC Filing Appendices 

c. Sources that helped isolate anchor institutions 

i. USAC Grant lookup tool 

ii. USAC High-Cost FCC Filing Appendices 

iii. HRSA data warehouse 

iv. NCES data lookup 

v. State managed lists of schools (K-12), post-secondary institutions and libraries 

vi. List of museums,  conventions, and visitors bureaus from www.onlineatlas.us 

Finally, challenges exist when dealing with the inevitable conflicts between provider-submitted data and 

third party sources (public or commercial).  There is no guarantee third party sources are more accurate 

or timely than the providers’ own reports.   Indeed, some third party sources are based upon different 

standards than those specified in the NOFA, perhaps making them less reliable than information 

collected directly from providers.  At the very minimum, provider data has a lineage and temporal status 

that we can identify.  A concern we have with increasing use of third party data is that we have no way 

to verify its quality or development methodology.  In other words, we may hit a wall in which we can’t 

determine how the commercial source derived its coverage conclusion.  To us this means that third 

party data sources are beneficial, but represent a supplementary view, not an authoritative one, of the 

NOFA defined Broadband market. 

In short, we have chosen to use provider data as the baseline.  We will challenge provider reports when 

third party data shows major anomalies, when submitted data conflict with prior submissions or when a 

consistent volume of consumer feedback points to a potential error.   

As the program evolves it is also our intention to provide tools that allow end users to evaluate the 

accuracy of the data in their own way.  A confidence score or the presentation of multiple (and 

potentially competing) reports for the same location may be made available. This notion is discussed 

further in the “Validation” section.   

                                                           
4
 Census data were derived from < http://www.census.gov/cgi-bin/geo/shapefiles2010/main>, Census 2010 files.  

Roads were derived from the county faces and edges file downloaded at the same location and tiled for a full state. 
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Confidentiality and the Use of Licensed Materials 
As a mapping vendor, we are reliant upon the cooperation of Broadband service providers.  In large 

part, what underlies this cooperation is trust that we will not violate the proprietary and confidential 

nature of the data provided to us.   

We are thankful for the confidentiality clarification that NTIA shared with us (included as Appendix Two).  

We intend to use this as a guiding document to help us communicate with providers about what 

information NTIA considers to be confidential.  Our suggestion is that NTIA publish this, or something 

comparable, to ensure a consistent interpretation of the NOFA and how it guides NDAs. 

As some providers are non-responsive to requests for information, or lack resources necessary to put 

data into NTIA compliant formats, we have fallen back to the use of commercial data sources in several 

places.   

For instance, some mobile wireless providers were unable to submit coverage information to us.  In 

these circumstances we have generalized the American Roamer coverage.  For incumbent telephone 

providers we have used commercial wirecenter boundary products to filter Census Blocks that are 

clearly out of their exchange areas.   

Public Engagement:   Crowd Sourcing, Surveys and Social Media 
Crowd sourcing (i.e., an intentional and carefully designed effort to tap into the collective intelligence of 

the public at large to expand our knowledge base) continues to be an important element of our data 

collection and validation process. In addition to the various opportunities the public has to provide input 

via the online service coverage maps and the related ‘Broadband story’ process, our crowd sourcing 

efforts are grounded in a time tested telephone survey approach focused on the consumer market. In 

addition, we continue to advance our process to include certain initiatives centered in two social media 

outlets – Facebook and Twitter. These initiatives are discussed below. 

Consumer Surveys 
Working under contract for the state of Alabama in 2009, our initial consumer survey was performed 

before the NTIA SBI grant was in place. Subsequent consumer surveys funded by the SBI grant were 

hosted in 2010 for the states of Idaho, Wisconsin and Wyoming and then again in 2011 for Alabama (as 

noted below). These surveys will be repeated after two years to establish and evaluate trends. To this 

end, in August/September 2011 we are wrapping up a second-round survey in Alabama designed to 

expand our understanding of important adoption issues and to establish important local trends from the 

initial 2009 survey. Survey results from this effort are currently under evaluation. These primarily 

telephone based surveys include two distinct and carefully scripted tracks: one for Internet users and 

one for non-users. The telephone survey approach allows us to reach the non-Internet user group as 

well as the current Internet user. A secondary online approach is also used to augment input from 

current Internet users. In the most recent Alabama survey we added a third tier to our approach as we 

equipped local field survey teams with an iPad-based survey tool and targeted their time to reaching the 

younger market. For non-users, the surveys help determine why they don’t have or don’t use 



SBI Mapping Methodology Page 12 
 

Broadband. For current Broadband users, the survey helps determine the nature of their Broadband 

access and how they use that connectivity in their daily lives. In addition to our state-specific surveys a 

nation-wide survey was also hosted to provide a broader view of consumer views for comparison 

purposes. State-specific surveys are, where possible, framed to match the state’s regional Broadband 

planning structure (e.g., the updated consumer survey in Alabama was designed to produce results 

relevant to the state’s twelve Broadband planning regions). 

The resulting data is helpful on a number of fronts in the SBI’s mission to advance the access and 

adoption to Broadband. Survey data provides an important, albeit broad, gauge for assessing coverage 

information obtained by providers. For example, areas with widely available coverage (according to 

provider information), but lower consumer subscription levels (according to survey results), or perhaps 

where survey results suggest Broadband is not available, can be examined in more detail. Survey results 

are also very important to the Broadband planning (and capacity building) components of the SBI 

program in that they help inform and formulate Broadband advancement priorities. Survey results also 

help inform Broadband policy discussions on both the local and state levels. Finally, survey results 

provide important information to the service provider community regarding market demand and 

specific Internet use in specific communities (i.e., regions).  

Our ongoing consumer survey process adheres to a consistent process. For example, consistent with 

prior practice the 2011 Alabama survey was launched in June 2011 with a test number of survey calls to 

confirm (and adjust as needed) the structure of the survey and the underlying survey process. Our 

surveys typically run for three to four months.  All telephone surveys are completely random beginning 

with the acquisition of a list of state-specific, randomly selected landline telephone numbers.  Mobile 

phones are not typically included in the surveys. Upon evaluation of the survey statistics, auxiliary 

surveys are executed to ensure appropriate representation is achieved on both demographic and 

geographic fronts. For example and as noted above, the recent Alabama survey was augmented with a 

field effort to ensure the younger demographic  (i.e., age 18 – 25) was adequately represented. This 

secondary step is required because of the continued migration (by younger markets) to non-landline 

based communications. This younger market is also surveyed by reaching out through social media 

outlets to encourage their participation in an online survey process. 

Survey statistics from the Alabama update survey are currently being developed and evaluated. Survey 

statistics from our initial surveys in Idaho, Wisconsin and Wyoming were summarized in our last filing.  

Survey volumes are designed to achieve statistical validity.  

As noted above, our telephone survey process is augmented by providing online access to the survey. 

Participation in the online survey is promoted on all of our state-specific public web sites and selected 

social media. 

As a final relevant point with respect to the consumer survey process the length of the survey is 

noteworthy. By survey standards, these tend to be long surveys. The surveys typically average just over 

fifteen minutes.  While this clearly contributes to the number of survey call attempts that were required 

to reach the level of statistical validity, it is not insurmountable.  
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Social Media 
The phenomenon of social media is widely documented and yet still emerging as an effective access 

point for public engagement. We continue to explore appropriate ways to use a variety of social media 

venues in our SBI efforts. All of our efforts are informed by and consistent with relevant state statues 

and guidelines. Different states have different perspectives on if and how the state will participate in the 

use of social media. Some state requirements are well defined and some are still being formed. Where 

appropriate, we use LinkedIn, Facebook and Twitter to support our work. A central focus is on 

promoting awareness. As noted above, we are able to promote additional input on the consumer 

surveys through a social media outreach program aimed at our younger market segments.  

In addition, we continue to evaluate how Facebook and Twitter can be used to drive public input on two 

important crowd sourced issues: online speed tests and input on map accuracy. Based on data obtained 

through our web site traffic monitoring process and readily available social media tracking processes, 

our most recent results are promising.   

Capacity Building and Transitioning to State Partners 
A foundational goal of LinkAMERICA has always been to transfer knowledge and capacity to our State 

partners.  As we move into program year 3, distinct tasks are migrating to the responsibility of our State 

partners.   

Within each State, transition planning and responsibility for specific activities is on a slightly different 

timeline.  Much of this is driven by resource availability and partner identification within the State.  For 

example in round 3, the State of Alabama used interns to validate Community Anchor Institution (CAI)  

data.  In this submission Alabama took on greater responsibility for the CAI submission.  To support this 

LinkAMERICA developed a detailed transition document describing the current CAI efforts. 

Other States are looking more towards program year 3 and the in-State hire of a Broadband Coordinator 

as the initiation point to support their transition efforts. 

Data Production Process 
To support our objective of transitioning the data development process to our State partners, we 

continue to model and document our data production process.   We find this to be a very beneficial step 

for two purposes.  

First, it helps us understand why (and if) a task is being done, and if it is being done efficiently.  Much of 

this program started so quickly that it was difficult to plan logical integration and hand off points among 

the various workgroups.  Further, we are currently in the process of consolidating much of the process 

data (check-ins, check-outs, metadata) and we can use this process model to efficiently plan a cohesive 

information architecture. 

Second, our process documentation and modeling helps explain why resources are being consumed in a 

particular way.  This helps our State partners plan for in-sourcing specific tasks as their time and 
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budgetary constraints allow.   It also helps our LinkAMERICA team better plan and cross-train members 

to deal with the work surge that occurs 30-45 days prior to submission. 

Finally, documenting and modeling our process helps us to take advantage of increasing specialization 

and proficiency with certain types of data and management responsibilities.   In submission 3, we had 

identified data “czars” responsible for check-in and check-out of data.  That data czar helped to bridge 

the gap among receipt functions, provider feedback, production and DBA.  

 

Figure 1—SBI Data Development Business Process Diagram 

 

Data Production Methods 
As raw data were received from the provider community, attention turned to normalizing the disparate 

submission formats5.  The team considered each submission with respect to the following criteria.  

These criteria are important because they perform the basis for our verification and quality assurance 

                                                           
5
 In line with NTIA Best Practices we continue to request and receive a large number of data input formats.  This 

ranges from tabular Block lists to hand drawn maps. 
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process.  In other words, we have to appropriately scale our data verification efforts to match the scale 

or ambiguity of the following: 

 Locational certainty 

 Speed certainty 

 Temporal certainty 

 provider and network ownership certainty 

The team’s goal was NOT to quantify a particular degree of precision with respect to any of these 

criteria.  Rather, we are working to attribute the above “certainty attributes” to each submission, and 

will continue to implement quality assurance and verification mechanisms that are resource-appropriate 

for each. 

Deriving Broadband Coverage Information 
Broadband Coverage6 was normalized into four formats:  

1. Coverage in Census Blocks (2010) of 2.00 or less square miles 

2. Covered Street Segments (2010) in Census Blocks greater than 2 square miles7 

3. Address Level Coverage (point data) 

4. Wireless Service Areas (SHP file format) 

With each submission, the team went through a series of steps to normalize and categorize the data. 

Since data arrived in many different formats, and at many levels of granularity, the following 

normalization procedures were used:  

1. Determining the nature of service being provisioned (who is providing service and what 

technologies are in use) 

2. Planning an attack strategy for the submission –understanding the data and assigning team 

members to various tasks 

3. Geo-referencing the data; QA the geo-referenced data  

4. Geoprocessing the geo-referenced response 

5. Segregating the submission into the correct NOFA-compliant submission formats. 

6. Apply appropriate source metadata8 

                                                           
6 Speed, Anchor institutions and Middle Mile facilities are discussed in later sections. 

7
 To help clarify issues relating to Census block area and vintages in use, our team published a technical paper to 

the Grantee workspace.  Because we were unsure if this standard should be implemented uniformly, this 
document was never distributed to the provider community. 
 
8
 When our team logs a submission into the staging database we record at least two attributes.  One records the 

method used to derive the coverage, the other records the method by which speed was attributed to that object.  
Other attributes carried to NTIA carry source meta values as well. 

https://sbdd-granteeworkspace.pbworks.com/w/file/33293657/Technical%20Reference%20Document%20Final.doc


SBI Mapping Methodology Page 16 
 

 

Figure 2-Broadband Coverage Process 

Impact of Program Change 
There were several important program changes that impacted how Broadband coverage was developed 

and submitted to NTIA in Round 4. 

Census Conversion 

The first and most obvious change in submission 4 was the conversion to a Census 2010 coverage 

baseline.  This impacted all wireline providers, the data submitted, the appearance of the mapped 

information and the baseline coverage metric comparisons against prior submissions.   

Release of the June 30 Grantee guidance document, allowed LinkAMERICA to communicate this change 

with providers.  LinkAMERICA provided by FTP access appropriately formatted and sized9 TIGER 2010 

Census blocks and Tiger Road Segments.  Given the relatively late release date, we received a mix of 

responses from Broadband providers.  Some easily produced Census 2010 information.  Others 

requested that we do the translation from their supplied blocks and segments.  Others requested that 

we translate their engineering data into appropriate formats.  A small number of providers committed 

to producing Census 2010 data but struggled internally with the conversion in this rapid time frame. 

Census 2010 has significantly more Blocks than Census 2000.  For the most part there are far more small 

Census 2010 blocks (less than 2.0 sq mi) than Census 2000.  As our team worked through the QA 

process, this presented a significant challenge in comparing our converted results to prior submissions.  

We use a block count metric as our first test of consistency across submissions.  Since the block count 

                                                           
9
 In Submission 3 we released a technical note describing how we measure Census block area. Although there 

remains no consensus on this, we used the same process as outlined in the paper. 
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increased it was hard to distinguish coverage area changes from coverage chances resulting only from a 

change in Census shapes.   

The converse side of this challenge was even more precarious to work through.  Because many road 

segments dropped out due to the covered area now being in a small block area it was difficult to 

determine how effective our covered segment process was given the fact that many segments naturally 

dropped out due to changes in Census shapes. 

The tendency for large blocks becoming small was not universal.  We note in some of our very rural 

areas of Wyoming and Idaho, small block covered areas become large.  This created a contrary situation 

where small blocks become road segment areas. The image below shows a coverage area change 

between submission 3 and 4.  The covered number of blocks is comparable but the appearance of the 

coverage is different as a manifestation of the Census change. 

 

Figure 3--Coverage Change across submissions 

This somewhat indeterminate process required our QA analysts to examine a number of submissions in 

detail.  The conclusion was that although the appearance of coverage was significantly different, the 

underlying engineering data was the same (or very similar) but how the coverage was manifested was a 

product of the Census conversion. 
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Census Conversion Practices 

Although we had hoped there would be a single process we could follow for all Census conversions our 

experience has been that it is necessary to be flexible and base the Census conversion process upon the 

data received.   

On a subjective level, we felt the most comfortable converting into Census 2010 where we had facility or 

demand data to guide the block and segment selection process.  In these circumstances we used 

geoprocessing methods like intersections or network analysis Analyst to make an objective 

determination.  The geoprocessing methods mirrored those discussed in the next section.   This was 

probably the majority of our submitted data. 

In circumstances where we were provided Tiger 2010 blocks or segments, we used those as given and 

performed our standard validation process.   Some providers used the TIGER blocks and segments which 

we supplied them and made their own selections. 

Finally, in circumstances where we had either a Census 2000 block list or a geographic file containing 

Census 2000 geographies and were told there was no coverage change for this submission, we used the 

Census crosswalk tables10 to derive a list of candidate blocks.   The output of a conversion process is 

shown below. 

 

                                                           
10

 See http://www.census.gov/geo/www/2010census/rel_blk.html 

http://www.census.gov/geo/www/2010census/rel_blk.html
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Figure 4—Block Conversion Process, Census 2000 black outline, no fill.  Green is 2010 large blocks, so any shading without an 
outline is 2010 block area not covered in 2000 

For the most part it is difficult to discern the impact of a conversion into Census 2010.  We don’t see vast 

changes in areas covered.  Nonetheless because the block shapes do change the overall coverage area 

will look different.  

As the 2010 data gets pushed into public deliverables, our sense is we will receive questions about the 

appearance of the new data.  

Speed Examination 

Given recent concerns about the depiction of speed and what that mapped speed represents, 

LinkAMERICA invested considerable time requesting detailed information on speed which appeared to 

be beyond normal speeds for a given Technology of Transmission given the NTIA supplied frequency 

tables. 

Based upon these conversations we learned 

A) For a large incumbent telephone provider; the speeds beyond the normal DSL range 

represent significantly shortened copper loops. 

B) For a large national cable provider the intermixing of Docsis 3.0 and non 3.0 systems in a 

market area is typical and sometimes reflects a circumstance where segments of plant cannot 
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be upgraded to Docsis 3.0.  This variance can be at a level below the Census block. In these cases 

the maximum advertised speeds remain to represent the market area but the plant variance is 

typical.  This same provider expressed concern with moving reported advertised speeds below 

the market  level. 

C) We have a minority of providers who submit a theoretical speed that is unmatched by their 

web advertising.  In these cases we request clarification from the provider on the inconsistency.  

Our experience has been that providers will modify the speed to be consistent with their web 

coverage. 

Provider Definitions 

Within our provider verification process we work to derive a state level provider match against third 

party data sources.  As discussed in the early pages of this manual, there is no guarantee that a third 

party data source is any more accurate than submitted data, nor does it necessarily reflect the provider 

ecosystem specified in the NOFA, Technical Appendix A.  We devote significant resources to matching 

our submitted data against three, third party data sources.  In many cases this becomes a judgment call 

trying to match provider names across systems.  It is a difficult and somewhat arbitrary process.  

Nonetheless we do believe it has value because it forces a re-examination of who we believe is an 

appropriate provider within a non-NOFA context11. 

The use of a provider match system, as well as the webinar comments (3/17/11) directing grantees to 

estimate, wherever possible, non-participating providers have made us back away from one of our 

fundamental assumptions in data collection.  As discussed in the prior draft of this manual, we had 

developed a certain “hold-out” class of data when a provider’s data wasn’t of sufficient quality to verify, 

or we were unable to put it into the data model (eg. address points submitted for a wireless).  In this 

submission, much of this hold-out data has been included12.  In some cases this means we are using 

simple polygons to capture a wireless ISPs serving area.  Other times, if we are confident in the 

coverage, but can get little clarification on the submitted speeds or frequencies, we release the 

coverage and note in our internal metadata the source issues with the other attributes.   

Finally, we have used the new provider type classification of ‘other’ to bring some aspect of the 

provider’s data into our submission.  There still seems to be confusion on how to handle provider types 

where a provider offers multiple paths to provision Broadband for typically business customers.  Rather 

than waiting for certainty on the answer, we bring the provider in and list them as provider Type 

“other”.  Our sense is provider Type “other” will continue to expand in subsequent submissions.   

                                                           
11

 We have requested from NTIA information on how provider matching is done within their QA process; beyond 
the relatively short whitepaper posted with the national map <http://www.broadbandmap.gov/blog/wp-
content/uploads/2011/02/DataComparison_Methodology2.pdf>, we have not received any more detailed 
information on how providers are cross verified between submitted and third party sources at the national level.  
Our understanding is licensing concerns are holding the release of this information. 
12

 We continue to process older submission data looking for information and methods by which we can estimate 
coverage information.  This will be an ongoing process. 

http://www.broadbandmap.gov/blog/wp-content/uploads/2011/02/DataComparison_Methodology2.pdf
http://www.broadbandmap.gov/blog/wp-content/uploads/2011/02/DataComparison_Methodology2.pdf
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Clearly one challenge is the data, but an equally significant challenge is appropriate messaging around 

this “other” provider type category.  We do not want to leave consumers with the impression that they 

can get a high capacity fiber or microwave link despite the fact that the hospital next to them in the 

same Census block can get this service. 

After the Grantee conference, LinkAMERICA submitted a paper describing our provider classification 

system13.  It is our feeling that understanding the type of provider is essential to appropriate verification 

methods.   

Coverage Geoprocessing Methods 
The next section discusses how data were georeferenced and geoprocessed given a particular 

submission format.  We have yet to find a particular method that works across all submissions.  Rather 

we tend to tailor our geoprocessing to meet the specifics of the service provider and data submitted. 

In most cases, in Round 4 we were still not provided with street segment level information for Blocks 

greater than two square miles (large Blocks).  This necessitated subsidiary geoprocessing.  As stated 

before, our first goal was to derive block level coverage.  Then, for Blocks greater than 2.00 square 

miles, we moved to a segment gathering processing.  The segment process will be described in the last 

section.14  

Block Level Coverage Derivation Using Service Point Data 

A number of providers submitted point level customer data.   

In some cases the submissions themselves were not internally consistent.  For example, in the image 

below, unprojected points are shown, while the Census block polygon to which the points are supposed 

to “belong” is highlighted.  In this case, one of the following scenarios has occurred:  block attribution is 

wrong, the points are not in the location to which they are attributed, or different block shapes were 

used than what is assumed. 

 

                                                           
13

 https://sbdd-granteeworkspace.pbworks.com/w/file/42309493/provider%20ClassificationFINAL.docx 
14

 As has been discussed previously, we note inconsistency in how providers are supplying information at the block 
and segment level.  Beyond the temporal differences, we see that providers are computing area differently, as well 
as including or excluding water areas.  This provides an inconsistent measure across providers for the 2.00 sq mile 
cut off.  Our preference would be to provide guidance to service providers within our states, but our concern is 
that we will inconsistently message this with grantees in other states.  We would appreciate consistent guidance 
from FCC/NTIA on this topic. 
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Figure 5-Internal inconsistency in submitted data 

In other circumstances, we found that inconsistent geocoding standards may produce misleading 

results.  The next image shows point level data, and the Blocks are colored based upon the counts of 

points intersecting Blocks.  The challenge this presents is that if geocoding was performed on a different 

dataset than the block boundaries (the road traces are not coincident with block boundaries) and/or 

geocoding was done without an offset, it becomes problematic to assign coverage to a Census block 

based upon only the point locations. 
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Figure 6-Block Coverage 

For this reason, where we were provided address point data and asked to generate covered  Census 

blocks, we elected to use a 200-foot buffer to select Census Blocks that intersect our points.   

We are also starting to see a number of providers submit customer data and facility data.  Their intent is 

to allow us to have two primary sources from which to derive the most accurate coverage.  In these 

cases we tend to look for clusters of customers in areas where we see no facility based coverage. 

With respect to deriving Block level speed from sub-Block data, we have instituted a business rule where 

the predominant speed in a Block is the speed we attribute to the Block. 

Block Level Coverage Derivation Using Customer Facing Plant Level Point Data 

In other circumstances, providers submitted point level plant data.  From what we could gather, these 

points tended to be customer-dedicated terminals.  Typically, these providers were high speed 

Broadband producers—which may somewhat strain the definition of Broadband as other providers 

supplying comparable services specifically disclaimed the ability to provide high-capacity Broadband 

services in the required 7-10 day interval.  In these plant point data submissions, we had similar 

concerns to the point level customer data, but two factors tended to make us use a more conservative 

intersection buffer.  First, we tended to have far fewer points to work from, so our concern was 

grabbing too many covered Blocks as the Blocks tended to be much smaller in these urban areas.  
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Second, these plant points tended to be dedicated to distinct customers, but it was difficult to know 

which element of the customer’s campus to attach coverage to. 

In the case of the image below, given a small shift to the left, it would be easily possible to gather 1 to 3 

Census Blocks from this point.  Although orthoimagery is helpful in a circumstance such as this, it is still 

indeterminate.   

Thus, in the circumstance of plant level point data, we used a 100-foot intersection buffer. 

 

Figure 7-Plant Point level data 

Coverage Derivation Using Linear Facilities Data 

A number of providers submitted facilities data.  We handled this data in different ways depending upon 

what we believed the facility data represented. 

Most telecommunications networks are divided into two components.  Feeder supplies higher capacity 

nodes (eg. DSLAMs, Fiber Nodes).  Distribution usually supplies customer premises (NIDs, Pedestals, 

Taps, ONTs).  Where we could discern what strand we were provided, we used different methods. 

The next image demonstrates a geo-referenced CAD image as given to us by a Broadband service 

provider.  Note the light and dark green shading.  We would infer that the lighter segments represent 

distribution and the dark green represents the feeder network. 

In the case of a combined strand map, we used a relatively tight buffer of 200 feet to gather covered 

Census Blocks.  Our intersection tolerance is based upon an assumption that our data likely represent a 
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situation comparable to customer point level submission in that we have most of the network footprint 

captured. 

 

Figure 8-Georeferenced CAD information supplied by Broadband provider 

 

In other circumstances, we were provided engineering information that we inferred to be feeder only.  

This inference was typically based upon the presence of fiber optic equipment only.  In these cases, we 

used a more generous 2,000 meter Census block intersection.  The 2,000 meter criteria was based upon 

an informal survey of population in proximity to the geo-referenced strand data, but it could be varied 

based upon a more complete survey. 

Coverage Derivation Using Covered Street Segment Data 

In some cases we were provided with covered street segment data.  Covered segments tended to come 

from two sources. 

In some circumstances, providers gave us CAD data, which was not drawn in a projected manner.  This is 

relatively common for older engineering data derived from hand drawn records.  This meant that our 
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team geo-registered the image into an approximate position.  In this case, the boundary streets were 

selected, and an enclosing polygon was derived.  The intersection of this polygon and the Blocks within 

became the geoprocessing method to derive Blocks. 

 

Figure 9-Coverage derived from street segments 

In a second circumstance, street segment data was developed during coverage estimation.  Handling the 

estimated data is discussed below. 

Coverage Derivation Using Serving Area Point Submission Data 

In other cases we worked with providers to derive service areas based upon point plant data.  In these 

cases we were given a serving node and an appropriate road length service boundary. There is an 

important distinction from the plant data discussed above. In this specific case, the data submitted was 

a node that served many locations--such as a Central Office or DSLAM.  This is contrasted with the 

earlier example in which the point represents a node serving only a few customers.   
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When trying to derive coverage from Central Office or DSLAM nodes, the team used ESRI Network 

Analyst to derive covered road segments honoring these road engineering parameters. 

The figure below shows street level coverage derived from Central Office and remote DSLAM point data.  

 

Figure 10-Coverage derived through road paths 

In response to Provider feedback we revised this process to include a larger variety of TIGER road types.  

In Round 1, unimproved roads were not used.  In the current submission -- particularly to improve 

estimates in areas bordering parks and public lands -- a wider class of TIGER roads was used.15 

The segment level coverage is easily extendable to derivations of Census block level speed.  The figure 

below shows the attributions of block level speed based upon the Maximum Advertised Speed available 

from a DSLAM.  Although the methodology isn’t perfect, it does provide insight into the value of 

granular infrastructure data. 

                                                           
15

Only TIGER features of MTFCC type S1100 and S1200 were excluded from use. 
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Over time we have seen an increase in the number of providers submitting this type of data for our use.  

Our sense is some providers find plant level data easier to generate and are satisfied with the results of 

derived coverage. 
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Coverage Derivation Using Polygon/Polyline Serving Areas 

Broadband service providers sometimes submitted coverage in terms of served areas.  This was either in 

direct geospatial formats, CAD files, or paper maps.  The image below reflects a carrier’s service area.   

Within that service area, there are variations in technology of transmission and served speeds.  When 

polygons with speed data and technology of transmission were available, we used a spatial intersection 

to gather covered Census Blocks.  In many cases, using covered Census Blocks resulted in a loss of the 

speed variation (sometimes the speed variation was at a level smaller than a Block and did not get 

picked up within a spatial query).. 

 

Figure 11-Coverage derived through serving area polygons 

Although we cannot directly solve the loss of speed granularity due to Block shapes, we honor a 

business rule wherein we always select Blocks from the highest speed areas first, and then allow the 

lower speeds to select from the remaining Blocks.  This is an arbitrary rule, but our feeling was that it 

should be a consistent selection, rather than an unordered selection. 

Street Segment Derivation, Large Blocks 

For those calculated Blocks greater than 2.00 square miles (large Blocks), we provided coverage in terms 

of covered street segments and corresponding geography.   

With respect to segments we had four sources of data: 

1. Covered large Blocks 

2. Tabular street segments and address ranges for large Blocks 



SBI Mapping Methodology Page 31 
 

3. Geographic segments either with street attributes or without 

4. Service area boundaries 

A number of providers only provided a list of covered large Blocks without corresponding segment 

information beneath the block.  This provided the dichotomy of either selecting all segments in the 

block, or none.  Because we had little information from which to make the selection, we elected to be 

conservative and did NOT pass any covered segments to NTIA from this submission format.  Some 

Broadband providers submitted covered street names and street ranges.  In these cases we performed a 

manual analysis trying to link to specific segment names and address ranges within covered Blocks.  

Sometimes this was a simple process because a provider used a TIGER derived street database.  In other 

cases we could not determine the source of the provider’s street data.  Street and Address matching 

tended to yield a relatively good result (typically between 30% and 100% of possible segments in the 

Block), but was very time consuming.  Where yield rates were low, our result was a shredded segment 

coverage pattern, like the image shown 
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below.16

 

Figure 12-Blue road segments adjacent to peach covered small Blocks 

A number of providers submitted geographic objects. In this case, our manual process was directed 

toward a conflation of data sources.  The goal was to take provider submitted segments and put these 

segments in terms of our TIGER 2010 basemap.  Although there is a trade-off in the accuracy using non-

provider submitted segments, we felt it was more important to have a road set that would edgematch 

our Block features and remain consistent with the Block size standards we used for other providers.  This 

is important for the appearance of the online maps, as well as potential verification work where we are 

attempting to judge a feature based upon its attachment to a covered small Census block.  The figure 

below shows street segment input data. 

                                                           
16

 We continue to hear providers expressing concern that our request for either a geographic object or TIGER Line 
ID is beyond the scope of the NOFA clarification. Therefore, they cannot supply additional information to us. 
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Figure 13-provider Submitted Street Segment Objects.  The segments don’t edge match the Blocks nor are they continuous. 

The figure following demonstrates the same area after the conflation process.  Blue segments are the 

conflated TIGER roads which will be passed to NTIA. 
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Figure 14-provider submitted segments in gold, selected TIGER  in blue—Conflation result; in many cases what was a 
continuous segment is made discontinuous because even with a distance buffer the TIGER segment doesn’t always intersect 
the provider segment 

 

The final segment process was used when we were supplied with a Broadband covered area polygon.  In 

this case, we found the segments within covered areas and eliminated those segments inside of Blocks 

less than or equal to 2.00 square miles. 

Because there was more control over the format of the inputs (we knew we had a boundary and were 

working with TIGER segments), this was an automated process that followed this general format: 

1. Select large covered Blocks by provider ID (from updated Large Block table) 
2. Select TIGER 2010 road segments (MTFCC like 'S%') that face (CB = CBLeft2010 or CB = 

CBRight2010) covered large Blocks for provider 
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4. Select segments as distinct records, max speed with corresponding technology, join in 
feature names, export selected records to temporary DBMS table  

5. Join TIGER roads feature class to temporary table on TLID 
6. Select covered segments (Python script)  
7. Select service area polygons for provider 
8. Clip selected facing segments with selected service area 
9. Export clipped segments to staging feature class, keyed by providerID 

In this figure, orange represents covered small Blocks; black lines are covered segments in large Census 

Blocks (light blue).  The service area boundary is shown in grey. Based upon feedback from providers, we 

have elected to clip segments at the end of a coverage boundary.17 

 

Figure 15-Output of the Segment Process 

Wireless Coverage Process 

In general, most providers of mobile Broadband submitted coverage information in a NOFA-compliant 

format.  Other than attributions for spectrum and speed, little was done to this coverage.18 

                                                           
17

 An outcome not discussed here is how to handle address ranges on segments.  As NTIA is asking for a Min and 
Max on the segment, deriving theses values for clipped segments is very problematic.  Also the prevalence of 
alphabetic characters in addresses makes the min/max selections very arbitrary.  We are grateful that addresses 
are nullable data elements. 
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LinkAMERICA continues to make aggressive efforts to bring additional WISP coverage into the NTIA 

dataset.  For the most part, our outreach was with providers who were unable to supply sufficiently 

granular data in the past or those that could only submit wireless address points which is no longer a 

valid submission format. 

In Round 4 fixed wireless providers generally either supplied coverage information or infrastructure 

from which coverage estimates could be derived.  Many allowed us to use their tower locations, 

antenna heights and direction/spread of coverage to derive a line of sight coverage estimate.  In our 

experience, this is a conservative and reasonable derivation of coverage. 

Some wireless providers submitted RF studies.  When this was done, there was a request that the signal 

strength be removed from coverage data.  The request was honored.  

Other fixed providers were able to supply us with hand drawn maps or polygons/polylines drawn in 

Google Earth format.  In these cases we did our best to georeference and verify the coverage areas with 

the WISP. 

When we received coverage information in KML format, like the image below, we accepted the data as 

it was presented to us.   

 
                                                                                                                                                                                           
18

 Some polygon data did exceed the node count threshold.  In these cases, data was rasterized to 100m cells and 
then converted back to polygons.  The polygons were dissolved to multi-part geometry.  This addressed the node 
count concern. 
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As the image above shows, in some cases we were provided hand-drawn coverage, as well as 

infrastructure.  Instead of estimating their coverage using a line of sight or RF study, we elected to stick 

with the provider’s supplied information.  Our decision was guided by two primary factors: 

 If the provider is advertising using this coverage they must have specific confidence in its 

accuracy. 

 If the provider can supply coverage, as well as infrastructure that reasonably supports the 

coverage, there is a very high likelihood in the accuracy of the information.   

The downside, of course, is the polygon shown on the map may not represent our notion of how 

wireless coverage should appear.  

In general we note several interesting trends in the wireless data.  First, we can be successful in 

increasing the amount of WISP coverage when we aggressively pursue WISPs.  This means we have to be 

willing to accept data on their terms and convey it into SBI formats.  Some of our WISP submissions have 

taken over 12 hours to normalize into SBI formats.  Second, we have to accept that some WISPs will not 

be able to supply FRNs.  There remains a minority of WISP providers who are not aware of the FCC FRN.  

Third, there appears to be some variation on how the NOFA coverage definition is met.  In other words, 

there seems to be a disparity on the necessary strength (e.g. -80 dB, -98 db, -120 dB, etc) to provide the 

appropriate quality of service for data services.  Fourth, it was very difficult getting providers to identify 

spectra used for Broadband data services19.  We are unsure if this is a competitive concern, or if the 

same coverage pattern is yielded for multiple frequencies.  Typically, the spectra returned were those 

that a provider was licensed for.  At this point, we have no reliable way to locally determine what set of 

frequencies are used to provide Broadband data services in a local area. 

Service Address Point Process 

A handful of providers have requested that customer level, service address point data be submitted to 

NTIA.  In these circumstances we have done minimal processing to preserve the provider’s intent with 

this deliverable and not bias downstream NTIA use. 

Our verification included checks against commercial or Public Utility/Public Service Commission 

exchange boundary maps.  Points not contained within one mile of a boundary are not submitted to 

NTIA.   The percentage of excluded data variesacross providers. 

We retain from the provider the provided latitude and longitude, as well as Census block.  For some 

coverage data, if a provider is unable to supply a longitude, latitude or Census block, we fill in these 

attributes.  In those circumstances where we do not have a Census block, but we do have a longitude 

                                                           
19 One provider responded by email, “This mapping program is to provide the coverage area for 

Broadband provided by a company. Not to keep a detailed account of every aspect of a companies (sic) 

network.” 
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and latitude, we accept the given longitude and latitude and use that as the basis for our Census block 

assignment. 

With point data we have tested for comparable geocoding success rates but do not overwrite provider 

information.20  From this type of analysis we note the amount (usually little more than 10%) of 

addresses that seem to locate with less than street segment certainty.  Deriving a thematic 

representation of the points on speed also illustrates some of the locational certainty issues in this point 

level data.   

Coverage Estimation Process 

Although the derivation of Broadband coverage into Census Blocks, street segments, or wireless 

coverage files is, in itself, a bit of an estimation process, there was an explicit estimation process 

required in cases where a Broadband provider either refused to participate in our survey, or provided 

such a threadbare submission that no carrier-based coverage information could be gleaned21.   

We typically resorted to three possible estimation paths. 

For Cable (HFC) providers who did not provide any coverage information, we fell back to Media Prints 

data.  Rather than using the entire Census Block Group gathered by Media Prints, we used only those 

Census Designated Places carrying the same or similar names to the Media Prints p_com field.  Our 

reasoning was that Cable systems tend to be franchised on a municipal or at least administrative basis 

so the coverage will likely follow a governmental boundary.  As a general rule, cable infrastructure is not 

available in the public domain22 and what could be found was poor in quality and difficult to ascertain 

for validity.  

For DSL providers who did not provide any coverage information, we estimated road-based coverage 

from their Central Offices23.  We only used Central Offices that showed evidence of DSL or fiber-based 

services in the NECA 4 tariff.  Road-based engineering areas were derived via ESRI Network Analyst to 

18kft.  These segments/boundaries were clipped to commercial wirecenter boundary edges.   

For mobile Broadband providers who were non-responsive to our requests, we fell back to American 

Roamer coverage patterns.  We generalized the American Roamer coverage to ½ km in order to protect 

the licensed information. 

For fixed wireless providers who provided no coverage information, we relied on their public websites to 

derive coverage maps.  When these maps were available, we georeferenced them and tried to use the 

                                                           
20

 We will make a second geocoding pass on locations with no longitude or latitude from provider.  We typically 
pick up ~5% from our second geocoding pass.  Typically the issue is address quality but also difficulties in 
geocoding in very rural areas. 
21

 We report estimated submissions to NTIA as a non-responsive provider but we have data in the submission for 
them.  This is the reason for datapackage.xls entries which are non responsive but contain submitted data. 
22

 The team tried to use data from the FCC Coals system and 321/325 fillings but this seemed to be a bit non-
uniform in quality. 
23

 Central Office location was derived from MapInfo ExchangeInfo Professional.  Wirecenter boundaries also came 
from this commercial product. 
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outer polygon boundary to represent their serving area.  In other cases, when only a tower could be 

provided, we used a view shed analysis and estimated coverage at 10mi per tower24.  Because much 

wireless propagation is driven far below the Census Block and much engineering information isn’t 

known (frequency in use, polarization of the signal, coverage pattern of antenna(s), local terrain/land 

cover) this was the most complicated group to estimate.   

Speed 

Speed attributes are reported both at the block (typical) and higher levels (maximum advertised and 

subscriber weighted).  We note that in many cases, providers did not supply typical or subscriber-

weighted speeds.  In some cases, it appears--although we cannot verify--that their maximum advertised 

speeds were used to populate typical speed columns. 

We do have limited testing data on reported speeds, but we have been careful to not use our typical 

reported values with carrier-provided information.  If we do not have a speed value from a provider, we 

report an empty value.   

Several service providers claim they do not have data on typical speeds available, but estimate a 20% 

overhead factor between the advertised speed and what may be experienced by an end user. 

We continue to request advertised speed at the block level.  Nevertheless we appear to be getting 

speeds that do not vary over a large geographic area – leading us to believe that providers may still be 

submitting the maximum speed advertised in local media for the entire market.  For the most part, we 

have been unsuccessful in messaging that advertised speed should not correspond to a market area, but 

instead, the maximum speed, which can be provided to a household—what some may describe as a 

‘qualified speed.’25 

As a general rule, in circumstances where a provider supplies a range of speed attributes, we assign 

NTIA categories based upon the midpoint of the range. We follow this rule unless we can determine 

other grantees are handling the same submitted information differently. 

To support NTIA program office requests, we have also modified the structure of the Service Overview 

table.  Even if Maximum Advertised Speed is supplied at the market or county level, we push that speed 

down to the contained Blocks.  The only records that remain in this table, will be those wireline records 

with either a non NULL nominal weighted speed or ARPU value. 

                                                           
24

 In some cases we had an approximate radius of coverage but no height.  In this case we used a 50’ height 
estimate and then clipped the coverage to the provided coverage range.  We also clipped wireless coverage to 
honor state boundaries but did not look for providers serving coverage with out of study state facilities. 
25

 As an example of a response to our request for Block level advertised speeds, we received the following 
comment from one anonymous provider, “This is and of itself does not require anything new of us – just states the 
NTIA supports efforts focused on getting that information on the CB level.”  It would be helpful to have broader 
messaging so that providers understand this new direction.  
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Community Anchor Institutions 
In the first submission, the Community Anchor Institution (CAI) process was referred to in terms of a 

learning curve.  This continues to be an appropriate metaphor.  The mapping team continues to focus on 

data that will support and help inform policy makers and the SBI planning process. 

In the first submission, the team gathered information on what data was available and what resources 

will be required to engage these categories of important institutions.  In the second submission we 

continued to obtain additional connectivity information.  For the Spring 2011 collection, the team began 

a survey process to directly engage these important organizations.  As the October 2011 submission 

represents a transitional phase, much of the CAI effort encompassed getting this dataset stabilized for 

work outside the LinkAMERICA team.26   

 In the current submission we worked to achieve four goals 

1) Modify the source data so as to no longer pass NTIA any connectivity estimates 

2) Propagate administrative capabilities in our Community Anchor Verification System (CAVS) systems to 

the Regional Planning Teams 

3) Verify the available connectivity information based upon new survey information 

4) Update the Federal record identifiers (NCES codes, etc). 

CAI Philosophy 

Our work with CAIs is guided by three principles. 

First, CAIs are important stakeholders within the planning process.  Our goal is to engage participants in 

regional planning that have strong ties into the CAI categories identified by NTIA.  This has a direct 

benefit of engaging an established stakeholder community.   It also allows Broadband planning to tie 

into existing organizational and planning networks.  In each of our states, key relationships with 

education, public safety, libraries, and economic development sectors are being identified and 

developed. 

Second, we believe that CAIs will likely be one of the primary beneficiaries of targeted Broadband 

funding.  Our belief stems from the sense that many of the benefits of Broadband will extend from these 

community ‘anchor points’.  In other words, it isn’t solely the existence of Broadband at a library that 

provides a benefit.  It is people using applications that work only on a Broadband network to upgrade 

their skills (e.g., online training) and gain access to online content (e.g., job postings, goods and 

services), etc.  The targeted use of a specific application--that can only take place with Broadband 

networks-- is what produces the priority benefit.  Put another way, there seems to be a realization that 

                                                           
26

 LinkAMERICA began transitioning the CAI data collection effort in the state of Alabama to ConnectingALABAMA 
in Round 3.   For Round 4 ConnectingALABAMA assumed full responsibility for the CAI data collection effort in 
Alabama.  To facilitate the reporting process, the ConnectingALABAMA team continued to use the Community 
Anchor Verification System (CAVS) to store CAI data collected or modified.  CostQuest maintained responsibility for 
the CAI data submission for Alabama for round 4. 



SBI Mapping Methodology Page 41 
 

things are less about pure connectivity (for the sake of connectivity) than about connectivity in terms of 

an application (for the sake of the benefit obtained through the application). 

Third, we continue to use a rational and targeted approach to derive information.  This means we will 

utilize our planning teams for as much ground work as possible.  This also means that a goal of our CAI 

process is not an exhaustive Census of anything that could be a CAI; rather, it is the discovery, inventory 

and integration of Broadband planning activities into those CAIs that stand to produce the greatest 

synergies with the SBI planning process.   

The above implies two significant points.  First, the team’s goal is to document community anchor 

institution connectivity within a broader context of regional and statewide planning objectives.  Second, 

if a particular category of CAI has an independent Broadband planning effort underway, we will 

encourage that organization to take the lead, and we will provide relevant expertise and support as 

warranted.  For example, in one of our states, the public safety community is already engaged in a 

mobile Broadband survey effort.  We have aligned our CAI data collection process with that effort and 

are sharing information and expertise (e.g., hosting a survey) to support their mission.  In another state 

we are attempting to glean connectivity information from a municipal government survey.  There may 

be some downside to this collaborative approach in that we may have to work with data spanning 

different times or we may not have all of the location-specific information we need, but this does 

prevent the same user from receiving multiple inquiries. 

 

Anchor Institution Survey  
During the third submission period we designed and developed a simple on-line survey system called 

CAVS (Community Anchor Verification Survey).  The intent of the survey was to both verify received 

connectivity information and garner additional connectivity information from CAIs.  For round 4 we 

continued the use of the on-line survey process.    Although we have found that reaching out to central 

contacts, for specific institution groups, is the most fruitful way of collecting connectivity data we find 

value in inviting individual anchor institutions to participate through means of a survey.  From our 

perspective this approach gives the individual institutions an opportunity to become engaged in the 

broadband planning process.  The link for the survey is housed on the Home Page of the website 

developed for each state, thus providing the added opportunity for responding institutions to learn 

more about activities  in their state.   

The survey remains open between collection periods to provide opportunity for the Regional Planning 

Teams to update information as they engage with the community and to allow responding institutions 

to update their data as necessary.   
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Anchor Institution Trends  
At this point we have focused our CAI attention on schools and libraries, with respect to connectivity.  

We benefit from strong relationships throughout the education sector (K-12 and Post-Secondary).  We 

have also found excellent resources within State librarians in all States. 

To supplement the education and library information we have formed organizational relationships with 

the major hospital associations within each state.  Our goal with this relationship is to cull information 

from their planning process.  We continue to formalize/advance this relationship.   

As in the prior submissions, we rely on public domain sources of information for the public safety-

category .  Collecting connectivity data for this group continues to be one of our most significant 

challenges.  Our hope is that in subsequent submissions, we will reduce the size of this category and 

connectivity information specific to root nodes of the public safety network--such as County Emergency 

Operation Centers.27  At this point we have had minimal success gaining this information. 

Because we have a wide ranging population of CAIs in our data set we have a variety of Broadband 

services that don’t always fit NOFA parameters.  Services like PRI or T1 are classified into “other copper,” 

We also had difficulty obtaining both the upstream and downstream channel capacities.  In most 

instances, when it was logical to do so, we made the speeds symmetrical, but this is an assumption on 

our part.    If a site records bandwidth across several services (eg. video and data), we record the total 

bandwidth to give a picture of available site bandwidth.  We are also working to standardize our 

response to NTIA in circumstances where an entity shares a Broadband connection among a campus 

which is fiber fed.  In this case we use the total campus bandwidth and use the primary campus Internet 

connection. 

As a final verification step, we attempt to screen the CAI data for duplicate values.  Because many CAI 

are closely clustered together we perform the de-duplication based upon the ANCHORNAME within the 

ZIP5. 

Middle Mile 
Middle Mile information was collected directly from providers via survey or interview.  Middle Mile is a 

“chicken or egg” type of challenge in that it is possible to verify that the infrastructure exists, but 

extremely difficult to know what is the site is doing without engineering level assistance.  Although most 

providers submitted “something,” there was a significant variance in what that “something” 

represented.   

The purpose of this section is to record some of the comments and questions we have received about 

Middle Mile.  We hope this provides better context for our data submission. 

                                                           
27

 Within the public safety category, it is also very difficult to derive precise locations as many CAI are addressed to 
PO boxes. 
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Within the NOFA, Middle Mile was defined as (a) a service provider’s network elements (or segments) 

or (b) between a service provider’s network and another provider’s network, including the Internet 

backbone. (Collectively, (a) and (b) are “middle-mile and backbone interconnection points.”)28 

Given the existence of the “or” in this definition, providers submitted a variety of information.  Based 

upon the NOFA example, several fixed wireless providers interpreted Middle Mile in terms of the 

connection points from their towers to their own serving backhaul location.  The topology was 

commonly Microwave from their distribution towers to their NOC.  The NOC and towers were listed as 

the Middle Mile points. This seems to be consistent with the first definition clause (a). 

Telephone, Mobile Wireless, and Cable providers tended to remain either silent on the question, or 

would provide a single location in which Internet peering occurred (clause b).  A number of participants 

explained that the NOFA was quite ambiguous with data traffic moving back and forth over both TDM 

and IP networks--it was unclear where the distinction should be drawn.  As a general rule it seemed like 

many providers listed a single location where Internet Peering occurred. 

A number of providers refused to answer the question on grounds of confidentiality29.  Others would not 

disclose as their Middle Mile points are not owned--another company provides the physical and 

electronic connection to their network.  In other words, the entity providing Broadband is not the entity 

providing Middle Mile. 

Additionally, based upon the new Provider Type classification of “other,” we have started to integrate 

points provided by Broadband service providers not meeting the NOFA definition.  This includes POP 

locations and aggregation points for public / private networks.30 Within a given submission there were 

two final attributes that tended to concern respondents.  First, speed should be measured in terms of 

only data capacity and what exactly is “data” (e.g., can/should you segregate out voice or video), and is 

the relevant capacity of the physical connection, channelized to a specific virtual circuit on their 

network.   

Finally, a number of other providers were unsure of the height above grade measure (is this their floor, 

the street outside, etc).  We seem to have a combination of height above or below grade, as well as 

heights above mean sea level (AMSL).   

To the extent possible in our timeframe, we verified the location of a sample of Middle Mile points.  

Where we could see infrastructure that appeared to be consistent in location with other provider 

                                                           
28

 From http://broadbandusa.gov/files/BroadbandMappingNOFA(FederalRegisterVersion).pdf at 54, visited March 
28, 2010 
29  As received in email 9/30/10, “Due to security concerns and the risk of public disclosure of highly sensitive data, 

whether inadvertent or otherwise, ***REDACT***response to the Middle Mile and backbone interconnection 

request is limited to publicly available information available on {remainder not included}” 

 
30

 As discussed in our readme.txt file, a number of middle mile points were lost in validation due to their location in 
adjacent state.  This will cause a decrease in some providers relative to prior submission. 

http://broadbandusa.gov/files/BroadbandMappingNOFA(FederalRegisterVersion).pdf
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infrastructure, we felt that the location was accurate.  In some cases, the point provided seems sensible 

(is on a road, near other equipment), but using imagery, we couldn’t find a place where this type of 

connection could occur.  This wouldn’t be unforeseen, in that Middle Mile connectivity likely takes place 

in a protected environment much smaller than a standard Central Office installation.  

Mobile Wireless Coverage 
We have received mobile wireless coverage from most mobile Broadband providers in each state.  At 

this point we have cleaned the geometry of the data and attributed it with spectra and FRN as required. 

Provider derived coverage has been reviewed against the commercial licensed product for consistency.  

To a limited extent we also use licensing locations and tower infrastructure to spot-check supplied 

coverage.  This mode of verification remains complex, given the lack of facility-based information with 

mobile wireless. 

Finally with respect to mobile Broadband services, we note several trends. 

First LinkAMERICA used the NTIA supplied frequency tables to report speeds consistent with other 

grantees.  In circumstances where a provider supplied a range of experienced speeds, we used the 

portion of the range consistent with the most frequently reported Grantee value. 

Second where a provider reports multiple frequency bands in use but doesn’t distinguish these bands by 

submitted SHP file, we submit identical geometries but attribute one geometry to each submitted 

spectrum value. 

Third we are seeing a trend toward increasing Broadband speed.  As of this writing, there is not 

consistency across providers in how they attribute the advertised 4G speed values.  In other words, for 

some providers 4G means advertised speed categories increase.  For other providers, the speed value 

did not change. 

Verification 
Almost by definition, data verification is an ongoing and evolving process. Clearly, with each new data 

submission there will be a validation process at hand and at the same time, our team continues to 

expand and improve the efficiency and effectiveness our data verification routines. Consistent with the 

movement toward an fGDB export database and use of a data receipt script, much of our validation 

effort was spent in supporting the ETL processes into the required formats.  In future data submissions 

we will continue our work to stabilize and improve the business process that normalizes provider 

submissions into NOFA formats and expands in more depth on the confidence analysis within the data.  

Verification Standard 
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Our overall verification standard is focused on the level at which we supply processed data to NTIA.  This 

means that the vast majority of our verification process will be focused on ascertaining coverage for 

Census block’s less than 2 square miles and covered road segments. 

We are learning that Verification has multiple dimensions. 

Provider verification is finding providers who supply Broadband and discriminate out providers not 

meeting Technical Appendix A’s definition of Broadband.  

Identity verification is taking the provider’s categorized in the first step and ensuring that the provider 

either has a valid FRN or is assigned a default FRN.  Identity verification is very complicated because of 

the Technical Appendix A’s mandate to record data at the FRN, provider Name and DBA level.  Each of 

these attributes could be unique for a single provider going to market under different or the same 

names.  As a result, rolling up each provider into an identity collection that matches either the FCC data 

integration team or a third party Broadband provider’s data view, is very, very time intensive.  Identity 

verification is discussed in the earlier section-- Developing the provider List. 

Coverage verification is a broad term, but in our definition it boils down to determining if Broadband 

coverage is in the right place.  For a given provider, the question is whether the coverage is assigned to 

appropriate Census Blocks, road segments or area features.  Coverage verification can be further broken 

out into two distinct classes: 

 Technology verification, which is determining if the provider is listed with a technology 

consistent with their marketing information.   

 Speed verification, which is determining if the speed supplied for that block, road segment, 

point area file or market area is consistent with the technology and the marketing information 

received. 

The final verification dimension is consumer feedback and crowd-source verification.  This is a dynamic 

set of steps we are beginning to implement.  One side of this is responding to consumer concerns.  The 

second is using the crowd sourced data to validate provider claims and, if appropriate, update the map 

and the underlying data. 

At this stage, our working hypothesis (confirmed by our experience) is that there will not be a single 

dispositive measure to indicate Broadband coverage availability in a Census block or along a segment.  

From prior work, and examining our current provider submissions, we believe that there is too much 

variation below the submitted record to make a single binary yes/no indication.  Rather, there will be a 

series of measures that combine to provide qualitative confidence (a classification scheme) in our 

indication of Broadband availability at the block, segment, or wireless polygon level. We believe such a 

qualitative confidence scheme is both relevant to and supportive of NTIA interests, as well as the 

interests of our end-user community – that is, the states and citizens we serve through this program. 



SBI Mapping Methodology Page 46 
 

The intent of this section is to illustrate why we are moving toward a particular verification 

methodology.  Our team is learning as we go along, and will adjust and improve this thinking. But given 

our experience to date, this is where we are heading. As stated above: 

 First, coverage verification is at the level of data submitted to NTIA. 

 Second, coverage verification is enhanced when there is a secondary measure of availability 

(such as infrastructure presence or serving area boundaries) 

 Third, given the limited resources of this effort, the most important coverage verification 

process to implement is the erroneous dispersion of coverage.  These are the “islands” of 

coverage isolated by significant distance from other covered areas.  .  In other words, Broadband 

Internet likely doesn’t exist far away from other areas with Broadband Internet access. 

Before explaining our overall verification thought process, we have several examples, which illustrate 

the complexity of coverage verification. 

The first example is taken from a gentleman who requested a map change in Alabama.  His home is near 

the yellow dot.  The darker grey Blocks are covered Census Blocks.  The black lines are covered road 

segments.  He cannot receive DSL from his incumbent provider, although his neighbors can.  The 

incumbent carrier does have at least one structure in that block from which Broadband services can be 

provided; unfortunately his home is not served.   

 

Figure 16--Sub block variation 
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Because the SBI program requires the depiction of coverage at the block level, the above map has been 

correctly generated.  However, from the customer’s point of view, the map is inaccurate.  This requires 

us to explain that the maps are not intended to be a structure-level qualification, at which point some 

consumers question the value of the maps when seeking service information.  Of course, we also share 

this information with the incumbent carrier in the area so they are aware of a potential customer 

market. 

Beyond this type of one-off structure-level qualification, sometimes, as shown below, we have even 

larger gaps in provided coverage.  The image here shows an “outlier” block that could be an error, or it 

could indicate missing Blocks along a major road that should have been filled in.  In this figure, the 

outlier block is highlighted in turquoise. 

 

Figure 17--Dispersion in Submitted Data 

 

In this particular case, we are faced with a different verification question.  Based upon the properties of 

the neighbors, we believe this block should likely be covered (coverage interpolation,) but supplied data 

from the incumbent says otherwise.  

The next example shows where an interpolation process could require some adjustment.  The figure 

below shows a town level.  There are some smaller Blocks that are likely covered by interpolation logic, 

but we also do not want to extend coverage beyond a franchise boundary as in the areas shown in a box 

on the bottom of the map. 
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Figure 18-Where do you stop interpolating? 

From what we can gather from some providers, the submitted data—data with consistently high 

degrees of dispersion or coverage holes—tends to come from geocoded billing records.  In this 

paradigm, this means where there are no customers; service is not identified on a map.  The 

interpolation verification question then takes on two dimensions. 

First, if a provider has no customers in an area, how can we know if they would be able to 

provide service in a 7-10 day interval? 

Second, if we use the properties of neighboring Blocks to interpolate coverage, when should we 

stop (e.g., at a franchise boundary, at a certain distance, etc.)? 

We continue to work with providers to get additional information to help us better understand and 

contend with this type of circumstance.  However, we have not been entirely successful at getting 

franchise boundaries that would address much of the issue. 

The final map shows this dispersion problem, but to an even larger degree.  This solitary large block is 

likely the result of a bad geocode, but we don’t know, given the data that has been submitted by the 

provider and the “single customer in a block standard” set by the NOFA clarification. 
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Figure 19-Dispersion in covered Blocks 

Due to the fact that this situation is quite obvious in display, this type of problem is one that we are 

more aggressively trying to resolve.  Where a single block has no neighbor offering comparable coverage 

and is a specified distance beyond an exchange boundary, our approach has been to filter these Blocks 

out.  As of now, this filter is limited to incumbent DSL providers because we have a good source of 

exchange boundaries.   

The exchange boundary dispersion verification method breaks down when examining smaller providers 

who are more likely to CLEC into neighboring territory. In the figure below, the black line represents the 

exchange boundary, while the continuity in the DSLAMs likely points to coverage extending along a road 

into another provider’s territory. 

 

Figure 20--DSL Coverage outside of exchange boundary 
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In sum, the variability in our source data continues to suggest that our dynamic verification process is 

relevant, appropriate and evolving in a manner consistent with the overall program.  And, as noted 

above, we believe the more meaningful outcome of our verification processes will likely be a series of 

qualitative indicators or expressed confidence levels.  Our concern, as with the development of any sort 

of classification process, is how rigid we should make this classification given the variation in our input 

data and the varied perceptions of service providers, map viewers and down-stream data consumers.   

Verification Work Process 
To support our dynamic multi-factor verification process, we have implemented the following steps. 

First, when data is received, an analyst reviews the submission and any immediate questions or 

concerns are sent back to the provider as quickly as possible.  We have found this gatekeeping step very 

helpful in making sure we understand the intent of the submission.   

Second, for all providers who submitted data to us in the third round, they received both a tabular data 

summary and mapped output31.  Prior to releasing the “check maps” to providers, we had a team of 

analysts visually inspect each provider’s coverage area.  The focus on this QC effort has been to identify 

and flag suspect Blocks.  After this in-house review, we solicited a second level of feedback from 

providers and received a number of requested changes and corrections used in the development of the 

October, 2011 round 4 dataset. 

For those providers who submit only block or segment level coverage (i.e., in those cases where we have 

no infrastructure to test with) we test for coverage containment within known service boundaries.  The 

intent of this validation step is to remove Blocks that are obviously erroneous.  We also verify the 

submitted speeds against the typical speed ranges in the NTIA frequency tables.  If we note a value 

outside of typical range, we ask the provider for clarification. 

As mentioned in the sections above, we have implemented a check on dispersed Blocks, but we have 

implemented less with respect to coverage interpolation (holes in coverage). We continue to work on a 

series of mechanical tools to assist with the inspection process but have run into challenges related to 

geographic basemap and timing. 

As our submissions have moved online, we have also begun to benefit from crowd source feedback.  In 

some cases this has helped us identify and fix errors in our underlying data. In other cases, as we have 

shared with NTIA, we have encountered some perceptual issues rooted in how the data are developed 

and modeled to comply with the NOFA.  Depiction of uniform coverage in small Census Blocks continues 

to be a challenge. Despite our best efforts to explain the full block coverage requirement, we continue 

to receive complaints that the coverage shown on the map is not accurate for a particular location 

within that block.  

                                                           
31

 For the verification of round 3 data, we submitted both PDF and KMZ (Google Earth) format check maps.  Some 
providers prefer to work with the Google format as it supports easier modification.  Others continue to submit 
marked up PDFs. 
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Consumer and Provider Responses to Deliverables 
Here, we segue from internal verification to external verification.  We view responses to our work 

product as a form of validation and verification.  On the one hand, this gives us the opportunity to fix 

mistakes and then generate QA steps to make sure that the problem does not reoccur.  We also learn 

how to improve what we are doing or better explain what we are doing to a community not always 

familiar with the NOFA and program office framework.  On the other hand, listening and learning from 

this feedback helps us better target our mapping deliverable to meet the needs of our external 

customers.  In this second case, external feedback not only provides feedback on perceived qualities (or 

lack of quality) in the data, it helps us to learn if we are developing data that is truly helpful to 

downstream users. 

At this point, our external deliverables take three forms: State Broadband Maps, data transfer to NTIA 

used for the National Broadband Map, and text format data requested by outside parties. 

Online Map Experiences 

With our State maps are online, we continue to harvest viewer feedback and comments.  Because an 

online map allows someone to zoom in far below the scale of the data, a large number of comments 

reflect sub-Census block concerns. While important to the citizens reporting these issues and to our 

Broadband planning teams, this level of data is outside the scope of our core validation process, which 

as noted above, is focused on the level of data submitted to NTIA.  

There are several other themes that our team believes are important to share.  These comments are 

actually quite helpful because they also improve our data processes to better meet the needs of map 

viewers.  For example, we have invested significant time in harvesting more segments from provider 

data.  Because the appearance of segments is so important, we are putting time into ensuring a visually 

appropriate edge match between the roads we harvest and the Blocks/roads we will show online.  On a 

technical level, we also believe that a good segment process will help us understand more about 

dispersion in the data, and what is valid versus what is not valid. 

Online Display of Consumer Feedback 

We have completed development of a consumer feedback layer for our online maps. 

The intent of the new layer is to show viewers the feedback of other map viewers.  We anticipate the 

feedback layer will go live when the Round 4 data is posted on our state maps.  We expect this to be 

prior to the end of October, 2011. 
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Figure 21--Consumer Feedback Layer 

To gather feedback, we use a survey wizard which asks the end users to categorize their concerns.  The 

survey went through several iterations of design and usability testing.  Our experience has been unless 

we get a way to constrain the user feedback into manageable categories, it becomes very difficult to act 

upon. 
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As mentioned by other Grantees we struggle with how to use all of the feedback we receive.  The 

qualified data points seem to fall below a volume in which we can infer significant modifications to the 

map data. Nevertheless, we believe it is important to gather structure and display the feedback  to 

support project transparency.   

Perception of Unfair Treatment Across Technologies 

Several Broadband service providers have expressed strong concerns regarding how wireline services 

are displayed, as contrasted to how wireless coverage is displayed.  This is an artifact of the SBI data 

model. As an example, consider the figure below. 
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Figure 22--Multi Network Coverage portrayal 

In this image, covered Census Blocks are light gold.  Covered road segments are a darker gold and 

wireless coverage is purple.  The concern seems to come down to how a wireline provider’s coverage is 

shown in the large Census Blocks (greater than 2.0 sq mi).  Some wireline providers have expressed 

dissatisfaction because their coverage is only tied to road geography, which leads to a visual “hole” in 

their coverage map.  At the same time, they feel that it is unfair that the wireless provider’s coverage is 

shown to be uniform in the same area.  Put another way, if our maps show wireline in terms of Blocks 

and segments, why don’t our maps show wireless the same way?  

 Perceptions of Carrier of Last Resort (COLR) Obligations 

Some wireline providers have also expressed dissatisfaction because online maps limit the distance of 

coverage from a road segment.  In our current online maps we buffer a wireline carrier’s service 300’ 

from road centerline.  A number of providers have expressed that they are mandated to provide voice 

coverage (which Broadband will accompany) anywhere in the Exchange.  There seem to be many 

dimensions to this argument, but the basic concern comes down to not being able to accurately reflect 

the scope of their COLR obligation within the mixed block/segment view.  Their ability (or lack thereof) 

to actually provision such services for new users within a 7-10 day period adds yet another level of 

complexity when attempting to fairly portray their coverage capabilities. 
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Intentions of Coverage Mapping 

When a viewer of an online map clicks on the map (or zooms to an address), they are provided with a 

pop-up of service provider coverage in the area.  The critical question is this: what is the area to which 

that pop-up window responds to?  In the past, we reported back to the specific Census block, or 

buffered road segment intersected by the user click.  As far as the map was concerned, once we move 

off of that road, or out of that segment, we have a new area to examine.   

Our sense, given feedback received, is that our provider view should be a bit more tilted toward finding 

providers in a general area, rather than finding providers at a single-click location.  If the goal of the map 

is to get someone to call a provider for service, our bias should be to include all of the potential 

providers in the general area, rather than giving potential customers a method to self-disqualify.  That is, 

we want to cast a wider coverage net, rather than one too narrow.  The problem with this approach is 

that it will create a number of false positive Broadband reports.  As of this date we cannot determine if 

the claims of inaccurate coverage in online maps are due to the looser provider view standard or not.  

We keep this looser standard in place to minimize the likelihood of self-disqualifications. 

CAI Survey Fatigue 

We are beginning to note an increase in survey fatigue among CAIs.  Sometimes, as part of a direct 

survey process an end user will tell us how unhappy they are with the repeated Broadband survey 

efforts.  Within several states BTOP grants are in effect that also survey Community Anchor Institutions.. 

As stated earlier we will defer to other Grantees when there are overlapping survey efforts. 
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Appendix One  

Data Collection Challenges 
This section summarizes some of the challenges we have experienced with data collection and 

processing.  The team believes it is important to categorize these challenges as they help inform the 

geoprocessing and verification methods used.  It is also our hope that some of the more global issues 

can be discussed and decided within the Grantee community.  

We begin with several global issues and then continue toward more granular challenges. 

Global Data Collection Issues 

Census Block and Road Standards are not clear 

We receive a variety of Census data.  Some were able to supply 2010 Census blocks.  Others continued 

to provide Census 2000.  Managing this set of heterogeneous inputs has proved to be a challenge. 

There seem to be several methods by which providers are calculating the Census block area.  So the 

distinction between at 2.00 square miles can be uniform, it would be ideal to articulate an operational 

area calculation definition as early as possible. 

Providers Not Wishing for Block Level Aggregation of Their Data 

Both ***REDACT*** have supplied address point level data.  Both carriers want NTIA to have the point 

level information, and they have asked CostQuest/LinkAMERICA not to aggregate their coverage to 

Blocks.  Other than a verification to make sure that point data were contained within, or fell within 1 

mile of exchange boundaries, the only other processing was normalization into NTIA formats. 

Broadband providers not Meeting the NOFA  “provider” Definition 

PBWorks appears to reflect a concern among a number of grantees about what a Broadband provider is-

-and how that definition impacts mapping. 

If the 7-10 day provisioning rule is to be strictly enforced, it would seem to eliminate a number of 

prominent Broadband providers32.  Further, the need for clarification around a facilities-based provider, 

versus the reseller, has injected even more ambiguity into the mix.  Right now we are unclear on how 

strictly to interpret either of these important distinctions, but we are concerned that we are beginning 

to create an NTIA exclusion criteria that is going to confuse downstream consumers of the data.   

                                                           
32

 By email ***REDACT*** informed us they could not provision in 7-10 days, but they also supply information on 
qualified locations to the address point level.  Therefore, we draw a distinction between an incumbent provider 
owning the facility--which terminates at a customer premise--who cannot turn up service at a qualified location, 
versus a provider not reporting any specific qualified locations in which they cannot turnup service in the 7-10 day 
window.  In the first case we have a sense of where service can be offered and verified.  In the second, we have no 
evidence that a service could exist there until a specific location becomes a customer. 
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Again, we do not want to exclude a service provider, but we believe there needs to be further 

clarification around the 7-10 day ”rule,” the definition of a “reseller,” and better interpretation of 

facility-based providers, versus equipping UNEs, SpA or leased lines. 

We have used the provider Type of ”Other” to classify a number of providers who offer Broadband 

services, but we do not offer them in a manner consistent with Technical Appendix A definitions. 

To What Extent Should We Begin “Classifying” the Data and Maps? 

The question immediately preceding gets to the intent of a Broadband provider.  This question gets to 

the intent of the Data and Maps. 

Earlier in this document we discussed the question of what type of bias we should introduce to our 

online map messaging.  In an online environment, do we want to more likely create an overstatement of 

coverage for a provider than an understatement?   In other words, is the larger problem allowing a 

consumer to self-disqualify, versus calling a number of neighboring providers?  There is a related issue 

to this.  Clearly in our maps there is a lot of scatter in data that we believe should be more continuous.  

These are the islands of coverage from an incumbent provider33.  There are a number of processes that 

could be put in place to deal with this type of scatter, but without more information from the service 

provider-- essentially the last mile facilities-- it will be difficult to perform this clean up in an informed 

manner.  On the one hand, we can aesthetically clean the maps up and reduce the scatter, but we have 

little sub-block engineering information upon which to make this decision.  Right now our preference is 

to put out a somewhat aesthetically messier deliverable and work with providers to get better 

information to clean their submission.  If that isn’t forthcoming, we are limited in what can be done 

given the lack of facility level information.  In summary this yields two questions 

1. In our online maps should we error on overstating coverage to prevent consumer self-

disqualification? 

2. In our online maps should we work to clean up a lot of the scatter that we see without having 

facility-based evidence from which to remove it? 

Granular Data Collection Issus 

Non-Uniform Submission Standards  

It is clear among providers that there isn’t a consistent method used to derive Broadband coverage.  

Some providers appear to be use a geocoding approach and then point in polygon or point on segment 

process.  Others may be using GPS locations.  In some cases, it is difficult to infer what reference data 

was used to georeference plant (is it the carrier’s roadbase?).  This leads to uncertainty regarding the 

input data scale or accuracy relative to other base layers.  Although we may be trading off absolute 

                                                           
33

 For a provider who sells opportunistically (not within a franchise area) it becomes even more problematic to 
classify their coverage because the points are more related to the type of consumer purchasing the service than a 
bounded offering.  In a matter of speaking, the ProviderType is more determined by the technology and/or 
location than a type of business.  The core intent of the NOFA and our grant application was centered around the 
7-10 day providers but we believe maintaining information on provider Type “Other” and  “Reseller” is important 
to assist in validation and market segment analysis as resources are available. 
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accuracy, our standard has been to conflate submitted data to TIGER 2010 Blocks and TIGER 2010 roads.  

We perform our verification against this conflated data product. 

Temporal 

We are unsure of how well the data are temporally consistent.  Some providers gave us their best effort 

to control to June 30, 2011. We note that some providers were clear that the submission was as of 

extract date without any way to move back in time.  They have no means to control for time and cannot 

provide any audit support beyond when the data are released to us.  Some data-especially loop 

qualification data-may change from day to day. It will be very difficult to clarify why something was 

changed from a given point in time. 

Perceived Inaccuracy with Respect to Internal Standards 

The NOFA is clear on submitting a list of Blocks in which a provider delivers Broadband service.  This is a 

different objective than perfectly reflecting service territories.  If a firm’s accuracy standard is a 

reflection of their service area, then the data created under the NOFA will not meet their perception of 

accuracy.  This leads to two other issues:  First, using Census Blocks rather than serving area may 

overstate or understate a particular provider’s Broadband serving area.  This was a significant concern of 

***REDACT*** who specifically required us to submit only address-level qualification data.  The second 

issue this brings up is how or if, there should be some standard on how much of a Census Block needs to 

be covered to call it covered.    

Confidentiality  

Several providers have noted concerns with CPNI-related issues and have stated this as a reason for 

non-participation.  We have also heard expressions of comparable concern regarding identifiable 

responses to Anchor Institution information. 

Unclear on Definitions  

As discussed earlier, several providers claimed confusion on several key terms involved in Middle Mile.  

We note a consistent stream of questions around the interpretation of Maximum Advertised Speed.  

Some providers understand this to be the most common speed package bought within the mass market, 

while others view this as a speed that can be purchased for an additional cost above a mass market 

offering (eg. a Turbo option for an additional fee per month).  Others interpret this as the fastest speed 

that is available for that particular location--in terms of xDSL, a structure qualified speed, for example.   

Perception of Data Use 

There seems to be some hesitancy releasing speed information because no one is sure of how the 

information will be used, or what the speed is intended to reflect.  A number of providers have verbally 

indicated that typical speed will be about (on average) 80% of purchased speed due to overhead.  But 

there are many other factors (such as a user’s home network) that influence speeds measures.  

Providers are concerned about introducing statistics without a clear understanding of how those 

statistics are derived and will then be used.  Also, as advertised speed is pushed down to a block level, 

we sense more trepidation to report speed values.  This quickly begins to touch on parity across network 

types (why is wireline down at the block when wireless is half the state, etc.).   Finally we note a 
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significant increase in speed reported to us.  This may be due to network upgrades or competitive 

concerns to match the theoretical network speed. 

Location Uncertainty In Source Data 

Within this document we have noted concerns about the impact of source data accuracy.  Our 

geoprocessing methodology provided what we believe is a relatively conservative tolerance to account 

for the scale issue in the source data, but we are unsure of how this may impact downstream users.  

Clearly, it also impacts the verification process because we can’t attempt to verify received data beyond 

a scale at which it was developed. 

Covered Segment Process 

Deriving those Broadband covered segments in Census Blocks greater than 2 square miles has proved to 

be a challenge.   Moving from a NOFA specified tabular deliverable to a requested  geographic 

deliverable also increases the complexity of the effort.   

Record Level Metadata 

It would be helpful to have one or two additional fields in each feature class transmitted to NTIA.  One 

User Defined field could be helpful as an expression of record level confidence.  The second field could 

be used as a Key between the transfer geodatabase and our systems.  Ideally, both fields could be large 

text fields (50 char) so the Grantee can use them to express a variety of attributes. 

Miscellaneous Data Collection Notes 

 We note the following important observations regarding our data submission: 

1. There are Middle Mile plant records for providers who are not present in the Census block, 

segment or wireless area feature classes.  This is due to classification as non-NOFA Broadband 

providers. 

2. In some cases, we have trimmed wireless coverage estimates to honor state boundaries. 

3. We believe some providers are trimming their coverage to honor license area boundaries. 

4. As a departure from past practice, where a provider submitted Middle Mile points out of state, 

we are no longer passing those points to NTIA as they fail the validation script.  We experienced 

validation errors for BroadbandServed=N records in the CAI table.  These records were 

attributed a Technology of Transfer=0.  This cleared validation. 

5. In tables with mandatory Street and Zip5 attributes(Service Address), if the value is unavailable 

it is filled with N/A. was not available, we have inserted ‘N/A 

6. As with submission three, there remains a tension between the Data Model, Data Model Default 

Values and the Python Validation Script.  As an example the data model allows a NULL for the 

Maximum Advertised speeds in a Census block record.  A default ‘zz’ is available for this 

condition as well but zz will fail the validation script.  In the case where we have data which is 

missing Maximum Advertised Speeds, we are holding that data back to prevent downstream 

validation problems. 

7. We have a significant amount of VDSL, ADSL 2 and ADSL 2+ coverage categorized into the xADSL 

category.  This introduces a variance in speed availability as some providers are using VDSL, 

shortened loops and/or pair bonding to increase speed over 10 Mbps. 
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8. We have left in the data Middle Mile locations with above grade elevations that appear to be 

unreasonable, given review of orthoimagery.  This seems to be confusion between above grade 

request and above sea level readings. 

9. All fGDB have passed validation except in cases where attributed speeds did not agree with 

domains associated with technology of transmission (eg Upstream Speed of 2 with ADSL).  We 

have modified the Python script to allow for conditions in the CAI table in which default data 

model values are disallowed in the Python submission script. 

10. We note a few providers who have speeds seemingly inconsistent with their technology of 

transmission.  This is either very low speeds with optical fiber, or very high speeds with non 

DOCSIS 3.0 systems.  We have verified on provider websites that the reported speeds are 

available in the area but these speeds will fall out of the NTIA frequency table analysis. 

11. We have a small number of providers who serve an area with both a residential and business 

speed tier.  In cases where we cannot distinguish which speed tier offering to use, we use the 

lower of the speed tiers. 

12. Per NTIA request we have modified the manner in which we handle Wireless coverage polygons.  

If a Provider submits a single geometry but specifies multiple spectrum codes in use in that 

polygon, we duplicate the polygon for each spectrum code.  In other words the geographic 

object is identical but the attribute data for the object is unique. 

13. In point level data submissions (Service Address and CAI) we note points that are spatially 

coincident.  With respect to Service Address points our thought is these represent multi-unit 

dwellings or businesses but we don’t have enough address detail to determine if these are 

multi-unit structures or duplicated customers.  Because we cannot determine the reason for the 

duplication we leave spatially coincident records in our submission.  We also leave in our CAI 

submission points which may be the same physical structure but have slight variations in 

addressing. 

14. In point level middle mile data, we are finding a variance in the quality of the geocoded 

longitude and latitude returned.  Given the data received we are unsure if this is an issue where 

the plant address is difficult to geocode or if the longitude and latitude provided to us  is 

different than what would be returned in geocoding. 

15. We note two important issues in our datapackage.xls.  First the number of records in the 

provider tab will not sum up to the total record count.  This is due to the requested grouping 

within the Excel table..  Second for estimated broadband coverage, we internally mark that 

coverage as an estimate but the provider is described as non-responsive within the 

datapackage.xls. 

16. We made one modification to the NTIA supplied verification script.  For the CAI layer we The 

query to check the TRANSTECH field now includes: "AND TRANSTECH <> -9999" 
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Appendix Two 
This appendix contains the confidentiality clarification supplied in a series of emails between CostQuest and NTIA. 

Feature Class Metadata NOFA 
Confidential? 

Online Map Public 
Disclosure 

Exemption 

Last Mile Constraints on accessing and using the data Yes No No None 

  Access constraints: None      

  Use constraints:       

  This data is confidential as defined in the 
NOFA. 

     

            

Middle Mile  Constraints on accessing and using the data Yes No No None 

  Access constraints: None      

  Use constraints:       

  This data is confidential as defined in the 
NOFA. 

     

            

Service Address Constraints on accessing and using the data No No Yes   

  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users.  

     

            

CAI Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 
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  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users.  

     

            

Census Block Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 

  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users. 

     

            

Service Overview Constraints on accessing and using the data No Yes Yes The only 
provider 
who may 
not show 
up this 
table is a 
provider 
who has 
provided 
only 
confidential 
data (last 
mile, 
Middle 
Mile, 
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address 
point with 
provider 
name) 

  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users. 

     

            

Road Segment Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 

  Access constraints: None.      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users. 

     

            

Wireless Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 

  Access constraints: None      

  Use constraints:       



SBI Mapping Methodology Page 64 
 

  There are no restrictions on distribution of 
the data by users 
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